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Alkuun

Uusien ominaisuuksien yhteenveto
InDesign CC (helmikuun 2015 sekä lokakuun ja kesäkuun 2014 versiot)

Adobe InDesign CC:ssä on useita suunnittelu- ja julkaisukokemustasi rikastuttavia uusia ominaisuuksia ja
parannuksia. Uusiin ominaisuuksiin kuuluvat muun muassa Creative Cloud -kirjastot, aloitusnäyttö, parannettu
Adobe Color -integraatio, Color-teematyökalu, kiinteään asetteluun perustuvien EPUB-julkaisujen uusi
vuorovaikutteisuustoiminto ja EPUB-julkaisujen vuorovaikutteisuuden esikatselu.

Jatka lukemista ja perehdy Adobe InDesignin viimeisimmän päivityksen uusiin ominaisuuksiin sekä lisätietoja
sisältäviin resursseihin viittaaviin linkkeihin.

Adobe InDesign CC:n helmikuun versio sisältää uusia toimintoja, joihin kuuluvat muun muassa Creative Cloud -
kirjastot ja uusi aloitusnäyttö.

Uudet ja muuttuneet ominaisuudet

Adobe InDesign CC 2014.2 | Helmikuu 2015

Adobe InDesign CC 2014 | Lokakuu 2014

Adobe InDesign CC 2014 | Kesäkuu 2014

Adobe InDesign CC 2014.2 | Helmikuu 2015

Creative Cloud -kirjastoihin perustuva yhteistyö

Uudet toiminnot tässä InDesign CC -julkaisussa  

InDesignissa käytettävissä olevien Creative Cloud -kirjastojen avulla voit järjestellä, käyttää ja jakaa luovia
resursseja, kuten värejä, tekstityylejä, siveltimiä ja grafiikkaa. Voit lisätä merkkimääritteitä tekstityyleinä. Voit myös
kopioida alkuperäiset InDesign-kirjastoresurssisi Creative Cloud -kirjastoihin.

Huomautus:

Merkkityylejä ei voi siirtää Creative Cloud -kirjastoihin. Voit kuitenkin siirtää merkkimääritteet tekstityyleinä.
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Eri tietokoneissa:

Kirjastot synkronoidaan niiden luontihetkellä automaattisesti Creative Cloudiin, joten sinun ei tarvitse murehtia
tallennusta tai resurssin poistamista tai korvaamista vahingossa.

Photoshop ja Illustrator CC:

Creative Cloud -kirjastot sisältyvät myös Photoshopiin ja Illustrator CC:hen. InDesignissa tallennetut kirjastot ovat
automaattisesti käytettävissä myös Photoshopissa ja Illustratorissa. Samalla tavalla Photoshopissa ja Illustratorissa
tallennetut kirjastot ovat käytettävissä InDesignissa.

Työskenteleminen offline-tilassa:

Kirjastosi ovat käytettävissä aina, kun tarvitset niitä – ilman Internet-yhteyttä. Voit käyttää paikallista kopiota
työpöydälläsi offline-tilassa.

Alkuperäisten InDesign-kirjastojen sisältöjen siirtäminen Creative Cloud -kirjastoihin:

Siirrä kaikki tai valitut resurssit helposti alkuperäisistä InDesign-kirjastoista Creative Cloud -kirjastoihin. Voit
halutessasi siirtää alkuperäiset kirjastoresurssit uusiin tai olemassa oleviin Creative Cloud -kirjastoihin.

Lisätietoja on artikkelissa Creative Cloud -kirjastot.

Aloitusnäyttö

Uudet toiminnot tässä InDesign CC -julkaisussa  
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InDesign CC:n vuoden 2015 versiossa on uusi toiminto, joka auttaa sinua löytämään, oppimaan ja käyttämään eri
toimintoja sekä tutustumaan niiden ominaisuuksiin perusteellisesti. Aloitusnäyttö esittää sinua kiinnostavat sisällöt
yhdessä paikassa. Näyttö tulee näkyviin aina, kun avaat InDesignin tai valitset Ohje > Aloitusnäyttö.
Aloitusnäytössä näkyy InDesigniin liittyviä opastusohjelmia, videoita, ohjesisältöä ja paljon muuta. Välilehtiä
hyödyntävä näkymä auttaa sinua löytämään mielenkiintoista sisältöä – uusia ominaisuuksia, käytön alkuun
opastavia ohjeita sekä käteviä vinkkejä ja tekniikoita.

Huomautus:

Aloitusnäyttö otetaan käyttöön kaikissa InDesign CC 2014.2:n amerikanenglannin ja brittienglannin versioissa.

Uudemmalla versiolla tehdyn julkaisun avaaminen

Uudet toiminnot tässä InDesign CC -julkaisussa  

Voit nyt lähettää julkaisuja InDesignin vanhemman version käyttäjille ilman ylimääräisiä vaiheita, kuten julkaisujen
manuaalista vientiä IDML-muotoon. Sisäänrakennettu yhteensopivuus takaa, että julkaisut avautuvat aina
odottamallasi tavalla.

Jos avaat InDesignin uudemmalla versiolla luodun julkaisun ja napsautat seuraavassa viestissä OK-painiketta,
InDesign muuntaa julkaisun Creative Cloud -palvelun avulla käyttämääsi InDesign-versiota vastaavaan muotoon.
Tämän jälkeen InDesign tallentaa muunnetun tiedoston takaisin tietokoneeseen.

4



Alkuun

Lisätietoja tästä toiminnosta on artikkelissa InDesign-julkaisujen avaaminen.

Muut tärkeät parannukset

Luo uusi taulukko

Uudet toiminnot tässä InDesign CC -julkaisussa  

InDesignin aikaisemmissa versiossa käyttäjän oli taulukkoa julkaisuun lisättäessä ensin luotava tekstikehys ja sitten
lisättävä taulukko tekstikehykseen. Tämä tarkoitti, että jos kohdistin ei ollut tekstikehyksen sisällä, taulukon
valikkovaihtoehdot oli poistettu käytöstä, ja käyttäjät, jotka eivät tunteneet työnkulkua, eivät pystyneet jatkamaan.

InDesign korjasi tämän ongelman niin, että voit nyt luoda taulukon tarvitsematta luoda tekstikehystä ensin.

Lisätietoja on artikkelissa Luo taulukko -toiminnon käyttäminen.

Poista ryhmitys -toiminto muistaa tasot

Uudet toiminnot tässä InDesign CC -julkaisussa  

InDesignin aikaisemmissa versioissa kohteet sisältävä ryhmä luotiin ylimpään tasoon, kun käyttäjä valitsi useita
kohteita useista tasoista ja ryhmitti ne. Jos käyttäjä valitsi Pura ryhmä -toiminnon, kohteita ei siirretty takaisiin
tasoihin, joista ne olivat peräisin, vaan ne jäivät ylimpään tasoon.

Uusi Poista ryhmitys -toiminto muistaa tasot -toiminto korjaa tämän ongelman. Toiminto varmistaa, että ryhmän
purkamisen jälkeen kaikki ryhmässä olevat kohteet palautetaan niiden alkuperäisiin tasoihin (tasoihin, joista ne
olivat peräisin).

Lisätietoja on artikkelissa Eri tasoilla olevien kohteiden ryhmittäminen ja ryhmityksen purkaminen.

Tulosta nykyinen sivu
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Alkuun

Uudet toiminnot tässä InDesign CC -julkaisussa  

Voit nyt tulostaa julkaisun nykyisen sivun Tulosta-valintaikkunasta. Tämän lisäksi voit tulostaa aukeaman tai valitun
sivualueen Sivut-paneelin valikoista.

Aikaisemmin sinun oli toimittava Tulosta-valintaikkunassa niin, että jos et tiennyt nykyistä sivua, sinun oli ensin
ohitettava valintaikkuna, määritettävä sivu, suoritettava tulostuskomento uudelleen ja sitten kirjoitettava oikea
sivunumero sille varattuun kenttään. Nyt voit valita nykyisen sivun tulostusvaihtoehdon Tulosta-valintaikkunasta.

Lisätietoja on artikkelissa Tulostaminen Sivut-paneelista.

Adobe InDesign CC 2014 | Lokakuu 2014

Adobe Color

Uudet toiminnot tässä InDesign CC -julkaisussa  

Käytä kaikkia luomiasi Adobe Color -teemoja suoraan InDesignista.

Uusi Adobe Color -teemapaneeli – aikaisemmalta nimeltään Kuler-paneeli.
Käytä Adobe Color -teemoja nopeasti ja helposti. Teitpä väriteemat millä ja missä tahansa (Photoshopilla,
Adobe Illustratorilla, Color-verkkopalvelussa tai Adobe Color -sovelluksella), voit käyttää väriteemoja suoraan
InDesignista ja hyödyntää niitä välittömästi suunnitteluprojekteissa.
Käytä suosikeiksi merkittyjä Color-teemoja.

Lisätietoja on artikkelissa Värin käyttäminen.

Color-teematyökalu

Uudet toiminnot tässä InDesign CC -julkaisussa  

Poimi väriteemoja InDesign-julkaisusta

Poimi väriteemoja InDesign-julkaisun valituilta alueilta, kuvista tai objekteista Color-työkalun avulla.
Tallenna väriteemat Adobe Coloriin, joka mahdollistaa niiden käytön muissa sovelluksissa Adobe Color -
integraation ansiosta.
Lisää teemoja Värimallit-paneeliin.

Lisätietoja on artikkelissa Väriteemojen luominen Color-teematyökalun avulla

EPUB-julkaisujen vuorovaikutteisuuteen liittyvät parannukset

Uudet toiminnot tässä InDesign CC -julkaisussa  

Tässä versiossa kiinteään asetteluun perustuvien EPUB-julkaisujen vuorovaikutteisuutta tukevien toimintojen
monipuolisuutta on lisätty entisestään:
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Alkuun

Lisää kiinteään asetteluun perustuvien EPUB-julkaisujen vuorovaikutteisuutta muun muassa diaesityksillä,
animaatioilla ja liipaisinpainikkeilla.
Luo vuorovaikutteisia toimintoja suoraan InDesignista.

EPUB-julkaisujen vuorovaikutteisuuden esikatselu

Uudet toiminnot tässä InDesign CC -julkaisussa  

Voit nyt esikatsella kiinteään asetteluun perustuvan EPUB-julkaisun, ennen kuin viet sen EPUB-tiedostoon. Voit käyttää tätä toimintoa valitsemalla
Ikkunat > Vuorovaikutteisuus > EPUB-julkaisujen vuorovaikutteisuuden esikatselu.

Lisätietoja on artikkelissa Kiinteään asetteluun perustuviin EPUB-tiedostoihin tarkoitetut vuorovaikutteiset julkaisut.

EPUB-tiedostojen parannukset

Parannukset tässä InDesign CC -julkaisussa  

Uudelleenjuoksutettavien EPUB-julkaisujen parannukset:

Hyperlinkit ja ristiviittaukset ovat nyt tuettuja, mikä parantaa navigointia.
Voit säilyttää luomiesi EPUB-tiedostojen sivuasettelun ulkoasun.  

Lisätietoja on artikkelissa Sisällön vieminen EPUB-muotoon.

Typekitin parannukset

Uudet toiminnot tässä InDesign CC -julkaisussa  

InDesign näyttää nyt, onko kirjasimien synkronointi otettu käyttöön tai poistettu käytöstä Creative Cloud -
sovelluksessa. Kun toiminto on poistettu käytöstä, voit ottaa Typekitin käyttöön Puuttuvat kirjasimet -
valintaikkunassa.

Lisätietoja on artikkelissa Puuttuvien kirjasinten käyttäminen.

Sovelluksessa – Uutuudet-valintaikkuna

Parannukset tässä InDesign CC -julkaisussa  

Kun asennat InDesign CC 2014:n ensimmäisen kerran, näyttöön tulee Uutuudet-valintaikkuna, jossa on tietoja
tämän version uusista ominaisuuksista. Lisätietoja ominaisuuksista saat napsauttamalla niiden linkkejä.  

Adobe InDesign CC 2014 | Kesäkuu 2014
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Saumaton päivitys

Pikavalinnat ja asetukset säilyvät, kun päivität InDesignin sen uusimpaan versioon, mikä nopeuttaa ja helpottaa
uusimman version käyttöönottoa.

InDesignin aikaisemman version oletusarvot ja esimääritykset säilyvät. Voit käynnistää esimääritysten ja
oletusarvojen paikallisen siirron myös manuaalisesti valitsemalla Muokkaa > Siirrä aikaisemmat paikalliset
asetukset.
Aikaisemman version asetukset siirretään Creative Cloudista seuraavissa tilanteissa:

Siirrettävissä olevia paikallisia asetuksia ei ole.
Nykyisen version (10.0) asetukset eivät ole käytettävissä Creative Cloudissa.

Tämä takaa, että sinun ei tarvitse muuttaa asetuksiasi aina, kun päivität InDesign CC:n. Varmista asetusten
siirtämisen jälkeen, että synkronointiasetukset on otettu nykyisessä versiossa käyttöön, jotta kaikki viimeisimmät
asetukset tallennetaan nyt pilveen.

EPUB-tiedostojen parannukset

Tässä versiossa InDesigniin on lisätty kiinteään asetteluun perustuvien EPUB-julkaisujen tuki. Voit hallita myös
epub:type-merkintöjen lisäämistä. Tämän version parannukset helpottavat myös CSS:n käsittelyä taulukko- ja
solutyyleissä. Voit päivittää kiinteässä asettelussa ja uudelleenjuoksutettavissa asetteluissa olevat metatiedot, kuten
myös määrittää vietyjä tulosteita Katselusovellukset-välilehdessä.

Kiinteä asettelu: InDesign tukee nyt tätä mielenkiintoista ja vuorovaikutteista muotoa. Tätä muotoa käytetään
yleisesti lasten eBook-kirjoissa ja monimutkaisissa tietojulkaisuissa, kuten keitto- ja tekstikirjoissa. Tavallisista
eBook-tiedostoista poiketen kiinteään asetteluun perustuvissa eBook-tiedostoissa säilytetään niitä vastaavien
painettujen kirjojen sivuasettelu ja muotoilu. Voit viedä InDesign-julkaisun kiinteään asetteluun perustuvassa EPUB-
muodossa. Voit hallita, miltä asettelu näyttäisi digitaalista lukulaitetta ja tätä toimintoa käytettäessä. Valitse
Tallennusmuoto-kohdasta Tiedosto > Vie > EPUB (kiinteä asettelu), jos haluat kokeilla tätä muotoa.

Kiinteään asetteluun perustuva EPUB

Mukautettava objektin leveys ja korkeus CSS:ssä: Voit nyt mukauttaa CSS-tiedostossa olevan objektin
korkeuden ja leveyden Objektin vientiasetukset -valintaikkunassa (koskee vain uudelleenjuoksutettavaa asettelua).

Uusi EPUB-tyypin merkintä: Uusi EPUB-tyyppi parantaa vietyjen EPUB-mallien komponenttien käytettävyyttä.
Tämä uusi epub:type-toiminto (Objektin vientiasetukset > EPUB ja HTML) helpottaa julkaisun elementtien
määrittämistä, ja sen ansiosta EPUB-tiedoston lukija voi suunnitella halutun lukujärjestyksen entistä helpommin.
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CSS:n taulukko- ja solutyylien kirjoittamisen parannus: Taulukko- ja solutyylit määritetään nyt CSS:ään
oikein. Jos taulukkoa ei käytetä, InDesign ei luo tarpeettomia CSS-tiedostoja.

Metatiedot: Voit nyt päivittää tiedoston tiedot tai InDesign-tiedoston metatiedot, jolloin uudelleenjuoksutettavissa
ja kiinteään asetteluun perustuvissa välilehdissä käytetään samoja EPUB-tietoja. 

Katselusovellukset (vienti): Uudelleenjuoksutettavien ja kiinteään asetteluun perustuvien EPUB-tiedostojen
vientiasetuksiin on lisätty Katselusovellukset-välilehti. Katselusovellukset-välilehdessä näkyvät sovellukset, jotka voit
määrittää EPUB-tiedostojen avaamista tai tarkastelemista varten.

A. Lisää EPUB-katseluohjelmia Katselusovellukset-välilehteen

InDesignin EPUB-toimintoon on tehty useita merkittäviä parannuksia. (Kaikkien muutosten luettelon löydät
asiakirjasta InDesign_EPUB_Changes_CC_9.2_to_10.0.pdf.)

B. Valitse katseluohjelma EPUB-julkaisun tarkastelua varten

Katso myös:

Sisällön vieminen EPUB-muotoon
Sisällön vieminen HTML-muotoon

Taulukoiden parannukset

InDesignin taulukkoihin liittyvien parannusten ansiosta voit nyt vetää ja pudottaa taulukoiden rivejä ja sarakkeita
samassa taulukossa paikasta toiseen. Valitse kopioitavat tai monistettavat rivit ja siirry valittujen rivien päälle, niin
näyttöön tulee yksilöllinen kohdistin, joka osoittaa, että valintaa voidaan siirtää. Kohderiviä voidaan siirtää vetämällä
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ja pudottamalla (tai kopioida pitämällä Alt-näppäintä painettuna).

Voit myös kopioida ylä- ja alatunnisterivien sisällön leipätekstiriveiksi (painamalla Alt/Optio-näppäintä).
Leipätekstirivejä voidaan samalla tavalla myös monistaa ja muuntaa ylä- ja alatunnisteriveiksi.

Taulukoiden yksinkertaistettu käyttö

Lisätietoja on ohjeaiheessa Taulukoiden luominen.

Väriryhmät

Voit nyt luoda ja hallita väriryhmiä InDesignissa. Luo väriryhmät Värimallit-paneelissa, jonka voit avata uudella
Väriryhmä-kuvakkeella tai avattavasta valikosta ja pikavalikosta. Voit myös jakaa väriryhmät toisen sovelluksen
kanssa käyttämällä Adobe Swatch Exchange (.ase) -tiedostoja. Voit esimerkiksi ladata värimalleja toisesta
Illustrator-projektista.

Väriryhmissä olevien värimallien luominen ja hallinta

Lisätietoja on ohjeaiheessa Värin käyttäminen.

Parannettu haku – Etsi edellinen

Aikaisemmissa InDesign-versioissa käyttäjät pystyivät suorittamaan haun vain eteenpäin. Se tarkoitti, että jos ohitit
kohteen liian nopeasti ja halusit palata siihen, pystyit tekemään sen vain suorittamalla hakutoiminnon loppuun ja
aloittamalla sen alusta. Tätä työnkulkua on nyt parannettu.

InDesignin Etsi ja muuta -valintaikkunassa on nyt kaksi hakusuuntapainiketta: Eteenpäin ja Taaksepäin. Haku
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eteenpäin on otettu oletusarvoisesti käyttöön, ja voit muuttaa hakusuunnan valitsemalla Taaksepäin. Uusi toiminto
helpottaa Teksti-, GREP- ja Kuvio-välilehdissä olevien merkkijonojen hakemista.

Parannettu haku

Lisätietoja on ohjeaiheessa Etsi ja muuta.

Behancen integrointi

Esittele ja löydä luovia töitä Behancessa. Jäsenenä voit luoda töistäsi portfolion, jonka voit julkaista laajasti ja
tehokkaasti. Voit myös tutustua luoviin hankkeisiin ympäri maailmaa selaamalla eri alojen esiteltyjä tai suosittuja
töitä.

Voit ladata aukeamat keskeneräisinä töinä Behance-sivustoon suoraan InDesignista. Aukeamat muunnetaan kuviksi
ja jaetaan Behancessa arvioiden ja palautteen pyytämistä varten.

Tällä hetkellä voit ladata vain yhden aukeaman InDesignista. Jos haluat jakaa kokonaisen julkaisun, voit suorittaa
jakamisen niin monta kertaa kuin dokumentissa on aukeamia. Jokainen aukeama siirretään Behanceen erillisenä
latauksena ja viestinä.

Jaa Behancessa

Lisätietoja on kohdassa InDesign-töiden jakaminen Behancessa.

Parannettu pakkaus

Tästä versiosta lähtien voit sisällyttää PDF- ja IDML-tiedoston mihin tahansa InDesignilla yksittäisistä julkaisuista
luotuihin paketteihin. InDesign-paketissa on nyt INDD, liitettyjä tiedostoja, kirjasimia, IDML ja PDF (tulostus).
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Lisätietoja on ohjeaiheessa Tiedostojen keräily.

QR-koodien parannettu tietojen yhdistäminen

Voit nyt lisätä QR-koodin sisältävän tietolähteen yhdistettyyn julkaisuun. QR-koodien työnkulku integroidaan
yhdistettyyn julkaisuun. InDesign-julkaisuissa tietojen yhdistämistoiminnolla voidaan liittää seuraavan tyyppisiä QR-
koodeja:

Vain teksti
Web-hyperlinkki
Tekstiviesti
Sähköposti
Käyntikortti

Jos nykyään luot käyntikortteja useille ihmisille (esimerkiksi organisaation sisällä), voit käyttää tietojen
yhdistämistä. QR-koodeja lisättäessä sinun pitäisi luoda QR-koodi manuaalisesti jokaista yksilöllistä käyntikorttia
varten. Tietojen yhdistämistoiminnon uuden päivityksen ansiosta sinun ei tarvitse luoda QR-koodia manuaalisesti
jokaista korttia varten, vaan QR-koodi voidaan luoda automaattisesti tietojen yhdistämisen aikana.

Lisätietoja on ohjeaiheessa Tietojen yhdistäminen.

Alaviitteiden parannukset

Voit nyt käyttää tekstinkierrätystä alaviitteeseen sisältyvässä ankkuroidussa tai irrallisessa objektissa. Tämä
parannus toimii sekä suorakulmaisissa että ei-suorakulmaisissa tekstikehyksissä.

Jos irrallinen objekti (joka ei ole ankkuroitu tai tekstiin sidottu), jossa on käytetty tekstinkierrätystä, liittyy
alaviitteiden tekstiin, silloin käytetään tekstinkierrätystä.

Lisätietoja on ohjeaiheessa Tekstinkierrätys alaviitteissä.

Windowsin HiDPI-tuki

InDesign sisältää nyt Microsoft Windowsissa HiDPI-tuen erilaisia DPI-näyttöasetuksia käytettäessä. Voit tarkastella
teräviä ja selkeitä käyttöliittymän elementtejä, jotka ovat visuaalisesti näyttäviä skaalaussuhteeseen katsomatta.
HiDPI-tuen ansiosta voit tarkastella tekstiä ja yksityiskohtaisia kuvituksia erittäin tarkassa näkymässä, jonka
ansiosta myös värit ja sävyt ovat entistä eloisampia.

Lisätietoja on ohjeaiheessa Windowsin HiDPI-tuki.

Skaalautuvat tehosteet
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InDesignin objekteissa käytettävät läpinäkyvyystehosteet eivät aikaisemmin skaalautuneet objektin mukana. Nyt
voidaan käyttää kaikkia tehosteita. Tehosteet, kuten heittovarjot, skaalautuvat nyt oikein, kun muutat objektin tai
tekstin skaalausta. Uuden Skaalautuvat tehosteet -toiminnon myötä ohjauspaneelin ja Muunnos-paneelin avattaviin
valikkoihin on lisätty mahdollisuus skaalata läpinäkyvyystehosteita objektia skaalattaessa. Tämän toiminnon avulla
voit ottaa skaalauksen käyttöön.

Lisätietoja on ohjeaiheessa Tehosteen skaalautuvuus.

Nykyaikaistaminen – paneelien muutokset

Työkaluvihjeet-paneeli

Osana sovelluksen nykyaikaistamista Työkaluvihjeet-paneeli on muunnettu Flash-tekniikasta HTML5-muotoon.
Tämä paneeli (Ikkuna > Apuohjelmat > Työkaluvihjeet) sisältää tietoja työkalun nimestä, työkaluvihjeen ja valitun
työkalun työkalukuvakkeen. Paneeli oli aikaisemmin APE (Flash) -pohjainen laajennus, mutta se on nyt CEP HTML5
-pohjainen laajennus.

Taustatehtäväpaneeli

Taustatehtävät-paneelia (Ikkuna > Apuohjelmat > Taustatehtävät) käytetään käynnissä olevien taustatehtävien
etenemisen valvontaan. Siinä käyttäjä voi myös peruuttaa käynnissä olevan taustatehtävän. Paneeli oli aikaisemmin
APE (Flash) -pohjainen, mutta se on nyt muunnettu käyttämään käyttöliittymätekniikkaa.

  Creative Commons -lisenssien ehdot eivät koske Twitter™- ja Facebook-viestejä.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö
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Creative Cloud
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Creative Cloud -työpöytäsovellus

Adobe® Creative Cloudin™ avulla voit ladata, asentaa ja päivittää sovelluksia. Voit myös synkronoida tiedostoja ja kirjasimia sekä esitellä ja löytää
luovia töitä Behancesta.

 
Lataa

 

Lataa Creative Cloud -työpöytäsovellus

 

Sovellusten lataaminen ja asentaminen

 

Kirjasimien lisääminen Typekitistä
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Alkuun

 

Tiedostojen ja kansioiden synkronointi
 

 

Behance

 

Creative Cloud Market

 

Aloitussivun syöte ja toimintosyöte

Sovellusten lataaminen ja asentaminen
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Lataa, asenna ja päivitä Creative Cloud -sovelluksia. Tutustu uusiin Creative Cloud -sovelluksiin ja asenna ne tietokoneeseen. Voit selata
sovelluksia suosion ja rakenteellisten segmenttien perusteella.

Creative Cloud -työpöytäsovellus asennetaan automaattisesti, kun lataat tuotteen. Jos Adobe Application Manager on jo asennettu, se päivittää
itsensä automaattisesti Creative Cloud -työpöytäsovellukseksi. Voit ladata sen manuaalisesti Creative Cloud -työpöytäsovellus -sivulta.

1. Avaa Adobe Creative Cloud tehtäväpalkista (Windows) tai Applen työkalupalkista (Mac OS).

Oletusarvoisesti Adobe Creative Cloud käynnistetään, kun kirjaudut tietokoneeseen.

2. Napsauta Sovellukset-paneelia. Tietokoneeseen viimeksi asennetut sovellukset näkyvät paneelin yläosassa. Luettelossa voi olla aikaisemmin
asennettuja -versioita.

3. Löydät uudet sovellukset vierittämällä alaspäin. Voit myös etsiä tarvitsemasi sovellukset suodattamalla luokan mukaan.

4. Valitse Asenna tai Päivitä.

5. Jos haluat ladata ja asentaa sovelluksesta aikaisemman version, valitse Aikaisempi versio ja sitten Asenna-valikosta haluamasi versio.
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Alkuun

Lisätietoja CC- tai CS6-sovellusten asentamisesta on artikkelissa Sovellusten asentaminen.

Sovellukset, kuten Photoshop ja Illustrator, ladataan ja asennetaan tietokoneeseen. Sinun on käynnistettävä ne tietokoneesta. Lisätietoja saat
artikkelista Creative Cloud -sovellusten käynnistäminen.

Tiedostojen ja kansioiden synkronointi

Synkronoi tiedostot tietokoneesta Creative Cloudiin, niin voit käyttää niitä mistä tahansa. Tiedostot ovat välittömästi käytettävissä kaikissa
yhdistetyissä laitteissa, tietokoneissa ja omalla Creative Cloud Files -sivullasi. Jos haluat synkronoida tiedostoja, lataa ja asenna Creative Cloud -
työpöytäsovellus kaikkiin tietokoneisiin.

Voit synkronoida tiedostot jollakin seuraavista tavoista:

Kopioi, liitä tai siirrä tiedostot tietokoneesi Creative Cloud Files -hakemistoon.
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Alkuun

Alkuun

Valitse sovelluksesta Tiedosto > Tallenna tai Tiedosto > Tallenna nimellä ja siirry tietokoneesi Creative Cloud Files -hakemistoon.

Alkuperäiset tiedostot ovat aina tietokoneella tai laitteessa. Tiedostot synkronoidaan Creative Cloudin kautta kaikkiin yhdistettyihin laitteisiin.

Voit tarkastella tiedostoja verkossa Creative Cloud Assets -sivulla. Kun tiedostot on synkronoitu, sinun ei tarvitse olla verkossa, vaan voit
tarkastella tiedostoja tietokoneen Creative Cloud Files -hakemistossa tai -kansiossa.

Jos tarvitset tietoja Creative Cloudiin lähetettyjen tiedostojen käsittelystä, perehdy artikkeliin Tiedostojen hallinta.

Kirjasimien lisääminen Typekitistä

Valitse haluamasi kirjasin Typekitin monista malleista ja synkronoi se työpöydällesi Creative Cloudilla. Synkronoituja kirjasimia voidaan käyttää
kaikissa Creative Cloud -sovelluksissa ja jopa muissa työpöytäohjelmistoissa.

Sinulla on oltava maksullinen Creative Cloud -jäsenyys tai oikeutettu Typekit-tili, jotta voit synkronoida kirjasimia pöytätietokoneeseen.

Kirjasimet-paneelissa on lueteltu tietokoneeseen synkronoidut kirjasimet. Voit synkronoida kirjasimet seuraavalla tavalla:

1. Napsauta Creative Cloud -työpöytäsovelluksessa Kirjasimet-paneelia.
2. Valitse Lisää kirjasimia Typekitistä. Typekit-ikkuna avautuu selaimeesi.
3. Siirrä hiiri Typekit-ikkunassa kirjasinkortin päälle ja valitse + Käytä kirjasimia.
4. Valitse kirjasimet valitusta perheestä ja napsauta Synkronoi valitut kirjasimet -painiketta.

Lyhyen esittelyn löydät kohdasta Kirjasimien synkronointi työpöydälle, kun taas yksityiskohtaiset ohjeet on annettu kohdassa Kirjasimien
synkronointi.

Market
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Alkuun

Creative Cloud Market on luovien käyttäjien luomien laadukkaiden ja valvottujen sisältöjen kokoelma, joka on tarkoitettu luoville ihmisille. Creative
Cloudin tilaajat voivat käyttää Marketissa olevia resursseja ilmaiseksi sekä työasemissa että mobiililaitteissa (Creative Cloudiin yhteydessä olevien
sovellusten kautta) ja valita niistä mieleisensä muun muassa vektorigrafiikoiden, kuvakkeiden, mallien ja käyttöjärjestelmäsarjojen uskomattomasta
valikoimasta. Creative Cloudin tilaajat voivat ladata kuukausittain jopa 500 ainutlaatuista, tekijänoikeusmaksutonta resurssia. Tämän tehokkaan
uuden palvelun ansiosta luovat käyttäjät voivat hakea jatkuvasti resursseja, jotka mahdollistavat luovien prosessien kehittämisen, käsittelyn ja
muokkauksen.

Lisätietoja on ohjeaiheessa Market-resurssit.

Töiden jakaminen ja etsiminen Behancessa

Esittele ja löydä luovia töitä Behancessa. Jäsenenä voit luoda töistäsi portfolion ja esitellä sitä laajalti ja tehokkaasti. Voit myös tutustua uusimpiin
luoviin töihin maailmanlaajuisesti selaamalla esiteltyjä ja suosittuja töitä eri aloilta.

Kirjaudu sisään tai rekisteröidy, niin voit käyttää Behance-toimintosyötettäsi ja portfoliotasi ja jakaa ja löytää uusia töitä. Jos sinulla on jo tili,
sinua kehotetaan kirjautumaan sisään. Jos sinulla ei ole vielä tiliä, rekisteröityminen on nopeaa ja helppoa.

Vaikka sinulla ei olisi Behance-tiliä, voit silti selata esiteltyjä projekteja ja keskeneräisiä töitä paneelista käsin.
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Alkuun

Alkuun

Alkuun

Saat lisätietoja kohdasta Jakaminen Behancessa tai käymällä Adobe Behance -foorumissa.

Aloitussivun syöte ja toimintosyöte

Kotipaneelin toimintovirta sisältää Creative Cloudissa suorittamasi tehtävät. Siinä näytetään myös tapahtumat ja toiminnot, jotka voivat liittyä
esimerkiksi uusien sovellusten saatavuuteen, päivityksiin ja asennuksen tilaan.

Oletusarvot

Avaa Oletusarvot-valintaikkuna valitsemalla  > Oletusarvot.

Voit kirjautua Creative Cloud -työpöytäsovelluksesta ulos valitsemalla Yleiset > Tili ja sitten Kirjaudu Creative Cloudista ulos.
Määritä kunkin välilehden Näytä/piilota ilmoitukset -asetukset.
Määritä sovelluksen kieli ja asennussijainti Sovellukset-välilehdessä.
Ota automaattiset päivitykset käyttöön valitsemalla Pidä Creative Cloud -työpöytäsovellus aina ajan tasalla.
Määritä toimintojen asetukset Tiedostot-, Kirjasimet- ja Behance-välilehdissä.

Tarvitsetko lisää apua?
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Avainsanat: Adobe Creative Cloud, työpöytä, Behance, Typekit, sovellusten asentaminen, sovellusten lataaminen

  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Kysy yhteisöltä

Lähetä viestejä, keskustele ja osallistu mahtavan yhteisömme toimintaan

Ota yhteyttä

Aloita täältä, jos haluat ottaa meihin yhteyttä

Lisää ohjeita

Julkaisutiedot | Creative Cloud -työpöytäsovellus
Creative Cloud -sovellusten käynnistäminen
Sovellusten asentaminen ja päivittäminen
Asennuksen ja lataamisen vianmääritys
Creative Cloudin usein kysytyt kysymykset
Adobe-tunnuksen usein kysytyt kysymykset
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Resurssien selaaminen, synkronointi ja hallinta

Alkuun

Tiedostot

Mobiililuomukset

Kirjastot

Huomautus:

Resurssien selaaminen
Tiedostojen synkronointi tai lähettäminen
Tiedostojen poistaminen
Tallennuspalvelut ja kiintiö
Vianmääritys

Adobe Creative Cloud -tiliisi kuuluu online-tallennustila, jonka ansiosta tiedostosi ovat käytettävissä kaikilla laitteilla tai tietokoneilla paikkaan
katsomatta. Voit esikatsella monia luovia tiedostotyyppejä verkkoselaimella suoraan tietokoneella, tablet-laitteella tai älypuhelimella. Näitä
tiedostotyyppejä ovat muun muassa PSD, AI, INDD, JPG, PDF, GIF, PNG, Photoshop Touch ja Ideas.

Adobe Creative Cloud -työpöytäsovellus huolehtii tiedostojen synkronoinnista. Se varmistaa, että kaikki lisäykset, muutokset tai poistot toteutetaan
kaikissa yhdistetyissä tietokoneissa ja laitteissa. Jos esimerkiksi lähetät .ai-tiedoston Creative Cloudin Resurssit-sivulta, se ladataan
automaattisesti kaikkiin yhdistettyihin tietokoneisiin.

Resurssien selaaminen

Creative Cloudin resurssit muodostuvat muun muassa työpöydän kanssa synkronoiduista tiedostoista, Creative Cloudia tukevilla
mobiilisovelluksilla luoduista resursseista ja Creative Cloud -kirjastoista. Voit selata kaikkia näitä resursseja Creative Cloud Assets -sivulla, jolla
resurssit on järjestelty seuraavasti:

näyttää työpöydällä olevan Creative Cloud Files -hakemiston kanssa synkronoidut resurssit

näyttää Creative Cloudia tukevilla mobiilisovelluksilla luodut resurssit

näyttää luomasi mallikirjastot

Voit suorittaa useita toimintoja, esimerkiksi nimetä uudelleen, jakaa, ladata, korvata ja arkistoida työpöydällä olevia resursseja
(Tiedostot-kohdassa), mutta voit tarkastella resursseja vain Creative Cloud Assets -sivun Mobiililuomukset- ja Kirjastot-kohdissa.

Kun napsautat resurssiluokkaa, se avautuu, ja mahdolliset aliluokat tulevat näyttöön. Esimerkiksi Tiedostot-kohdassa olevat resurssit järjestetään
aliluokkiin Kaikki, Jaetut ja Arkistoidut.
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Alkuun

Huomautus:

Kaikki: näyttää kaikki Creative Cloud Files -hakemiston kanssa synkronoidut resurssit

Jaetut: näyttää sinun ja muiden Creative Cloud -käyttäjien kesken jaetut tiedostot

Arkistoidut: näyttää poistetut tiedostot

Voit vastaavasti selata Creative Cloud -mobiilisovelluksilla luotuja resursseja Mobiililuomukset-kohdassa, jossa resurssit on järjestetty alaluokkiin
niiden luontiin käytetyn mobiilisovelluksen mukaan.

Lisätietoja kirjastoista on artikkelissa Creative Cloud -kirjastot.

Tiedostojen synkronointi tai lähettäminen

Voit synkronoida tiedostot tietokoneesta jollakin seuraavista tavoista:

Kopioi, liitä tai siirrä tiedostot työpöydällä olevaan Creative Cloud Files -hakemistoon.
Valitse sovelluksesta Tiedosto > Tallenna tai Tiedosto > Tallenna nimellä ja siirry Creative Cloud Files -hakemistoon.

Voit avata Creative Cloud Files -hakemiston Creative Cloud -työpöytäsovelluksesta valitsemalla Resurssit > Tiedostot ja sitten Avaa kansio.

Tiedostonimiä, joissa on erikoismerkkejä, kuten |, ", ?, <, >, /, * tai :, ei synkronoida. Varatun nimisiä tiedostoja, kuten AUX tai Com1,
ei myöskään synkronoida. Jos saat virhesanoman, nimeä tiedosto uudelleen, jotta voit synkronoida sen Creative Cloudiin. Lisätietoja saat
artikkelista Virhe: Tiedostoja ei voi synkronoida.
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Alkuun

Voit myös lähettää tiedostot suoraan Creative Cloud Assets -sivulle jollakin seuraavista tavoista.

Lähetä ja hallitse tiedostoja Creative Cloudilla käyttämällä Creative Cloud Assets -sivulla olevaa Toimet-valikkoa.

Vedä ja pudota työpöydällä olevat resurssit Creative Cloud Assets -sivulle.

Tiedoston korvaaminen

Kun lataat tiedoston uudelleen, tiedostosta luodaan versio ja olemassa oleva tiedosto korvataan uudella tiedostolla. Creative Cloud säilyttää myös
kopion jokaisesta muutoksesta, jonka teet tiedostoon ja synkronoit Photoshop Touchin, Adobe Ideasin ja Creative Cloud -työpöytäsovelluksen
kautta.

Voit korvata tiedoston Creative Cloud Assets -sivulla seuraavasti:

Huomautus: Uuden tiedoston on vastattava tiedostotyypiltään korvattavaa tiedostoa. Esimerkiksi .PSD-tiedostoa ei voi korvata .AI-tiedostolla.
 
Tietoja versionhallinnasta on kohdassa Versionhallinnan usein kysytyt kysymykset.

1. Siirry tiedostoon ja avaa se tarkastelua varten.
2. Valitse Toimet > Korvaa tai vedä tiedosto kansiosta selainikkunaan.

Tiedostojen poistaminen

Voit poistaa tiedostoja Creative Cloud -sivustosta tai Adobe Touch Appsista. Voit poistaa tiedostoja Creative Cloudin työpöydällä olevasta
Tiedostot-hakemistosta myös käyttöjärjestelmän komennoilla. Kaikki tiedostojen poistot synkronoidaan tilisi kanssa ja tiedostot arkistoidaan
Creative Cloudiin. Alkuperäiset tiedostot ovat aina tietokoneella ja niistä on kopiot Creative Cloudissa, jotta pystyt käyttämään niitä mistä tahansa.
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Alkuun

Arkistoidut tiedostot vievät edelleen online-tallennustilaa. Voit poistaa tiedostot lopullisesti tai palauttaa ne Arkisto-kansiosta. Tiedostojen lopullinen
poistaminen vapauttaa tallennuskiintiötä.

Tiedostojen lopullinen poistaminen tai palauttaminen

Resurssien lopullinen poistaminen on kaksivaiheinen prosessi:

Voit myös palauttaa arkistoidun tiedoston:

1. Arkistoi tiedosto Creative Cloudin työpöydällä olevasta Tiedostot-hakemistosta, Creative Cloudia tukevista kosketussovelluksista tai Creative
Cloud Assets -sivulta. Arkistoidut tiedostot siirretään hakemiston Omat resurssit > Tiedostot Arkistoidut-luokkaan.

2. Valitse lopullisesti poistettavat tiedostot Arkistoidut-sivulta ja valitse sitten Poista pysyvästi.
3. Valitse vahvistusvalintaikkunasta Poista pysyvästi.

1. Valitse palautettavat tiedostot Arkistoidut-sivulta ja valitse sitten Palauta.
2. Valitse vahvistusvalintaikkunasta Palauta.

Tallennuspalvelut ja kiintiö

Tallennuskiintiö vaihtelee Creative Cloud -jäsenyyden mukaan.

Voit tarkistaa tallennuskiintiön tilan Creative Cloud -työpöytäsovelluksen Resurssit-paneelin Tiedostot-välilehdestä tai Creative Cloud Activity -sivun
Asetukset-sivulta .

Jäsentilaus Vapaa tallennuskiintiö

Vapaana 2 Gt

Creative Cloud (valokuvauspainotteinen) 2 Gt

Creative Cloud (yksi sovellus tai kaikki sovellukset) 20 Gt

Creative Cloud Työryhmille 100 Gt
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Huomautus:

Alkuun

Creative Cloud -työpöytäsovelluksen tallennuskiintiön tila

Tallennuskiintiön tila Asetukset-sivulla

Creative Cloud synkronoi jopa 1 Gt:n ylivuodon mistä tahansa laitteesta. Tämän jälkeen työpöytäsovellus lopettaa uusien tiedostojen synkronoinnin
ja ilmoittaa, että olet ylittänyt kiintiön. Tiedostot, joita ei voi lähettää, on merkitty punaisella huutomerkillä. Voit tästä huolimatta siirtää, nimetä
uudelleen tai poistaa tiedostoja. Jos haluat jatkaa tiedostojen synkronointia, vapauta tilaa poistamalla muut tiedostot lopullisesti.

Pieni osa tallennustilasta käytetään hallinnointiin. Siksi käytettävissä oleva tila on todellisuudessa varattua määrää hieman pienempi.
Sen koko on 100–500 kt käyttäjätiedostojen määrän mukaan.

Vianmääritys

Kysy yhteisöltä

Lähetä viestejä, keskustele ja osallistu mahtavan yhteisömme toimintaan

Ota yhteyttä

Aloita täältä, jos haluat ottaa meihin yhteyttä
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Katso myös

Creative Cloud Assetsin käytön aloittaminen
Tiedostojen ja kansioiden jakaminen
Ryhmätyön tekeminen jakamalla kansioita
Tiedostojen synkronointi ja jakaminen kumppanien kanssa (video, 10 min)
Adobe Creative Cloudin tila
Virhe: Tiedostoja ei voi synkronoida
Versionhallinnan usein kysytyt kysymykset

 

28

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fi_FI/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fi
http://idiom-q-win-1/fi/creative-cloud/how-to/assets-get-started.html
http://idiom-q-win-1/fi/creative-cloud/help/share.html
http://idiom-q-win-1/fi/creative-cloud/help/collaboration.html
http://idiom-q-win-1/fi/creative-cloud/how-to/creative-cloud-share-files-collaborate.html
http://status.creativecloud.com/
http://idiom-q-win-1/fi/creative-cloud/kb/arent-my-files-syncing.html
http://idiom-q-win-1/fi/creative-cloud/help/versioning-faq.html


Kirjasimien lisääminen Typekitistä

Alkuun

Alkuun

Typekit on tilauspalvelu, joka sisältää runsaasti erilaisia työpöytäsovelluksissa ja verkkosivustoissa käytettäviä kirjasimia.

Creative Cloud -tilaukseen sisältyy Typekit Portfolio -tilaus, ja Creative Cloudin maksuttoman version käyttäjät voivat käyttää tiettyjä
verkko- ja työpöytäkäyttöön tarkoitettuja Typekit-kirjasimia.

Tilaa Creative Cloud (kaikki sovellukset, yksi sovellus tai maksuton) tai itsenäinen Typekit-tilaus, jos haluat synkronoida kirjasimia työpöydällesi.
Lisätietoja saat Typekitin tuotesivulta ja Typekitin tilausvaihtoehdoista. 

Käytön aloittaminen
Kirjasimien selaaminen ja lisääminen Typekitistä
Synkronoitujen kirjasimien käyttäminen
Kirjasimien synkronoinnin hallinta

Käytön aloittaminen

Voit valita haluamasi kirjasimen Typekitin monista malleista ja synkronoida sen työpöydällesi Creative Cloudilla tai käyttää sitä verkossa.
Synkronoituja kirjasimia voidaan käyttää kaikissa asennetuissa Creative Cloud -sovelluksissa, kuten Photoshopissa tai InDesignissa, ja myös
muissa työpöytäsovelluksissa, esimerkiksi MS Wordissa.

Tietokoneeseen on asennettava Creative Cloud -työpöytäsovellus kirjasimien synkronointia varten. Jos sitä ei vielä ole asennettu, lataa ja asenna
se. Lisätietoja saat artikkelista Creative Cloud työpöydälläsi.

Typekit otetaan oletusarvoisesti käyttöön, jotta se pystyy synkronoimaan kirjasimet ja tuomaan ne työpöytäsovelluksissa käyttöön.

Jos olet jo valinnut verkkoselaimella synkronoitavat kirjasimet, niiden synkronointi tietokoneen kanssa aloitetaan tässä vaiheessa automaattisesti. 

Kirjasimien selaaminen ja lisääminen Typekitistä

Voit käyttää Typekit-kirjastoa useista paikoista. Etsi työnkulkusi kannalta paras uusi kirjasinvalinta yhdistelemällä näitä menetelmiä
haluamallasi tavalla.

Creative Cloud -työpöytäsovelluksesta:

Valitse Kirjasimet-välilehdestä Lisää kirjasimia Typekitistä. Näyttöön avautuu selainikkuna, ja sinut kirjataan sisään Typekit.comiin.
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Typekitiin integroidusta sovelluksesta:

Valitse sovelluksen kirjasinvalikosta Lisää kirjasimia Typekitistä. Selainikkuna avataan suoraan selaimesta.

Suoraan Typekit.com-sivustosta:

Kirjaudu Adobe-tunnuksellasi ja salasanallasi osoitteeseen Typekit.com.
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Voit selata kirjasimia ja suodattaa haluamasi kirjasimet. Tietyn kirjasimen käytettävyys ilmoitetaan kirjasinkortilla.

Kirjasinkorteilla ilmoitettu käytettävyys

A. Verkko ja työpöytä B. Verkko 

Napsauttamalla yksittäisen kirjasimen korttia saat lisätietoja kirjasimesta, muun muassa malleja kaikista käytettävissä olevista paksuuksista ja
tyyleistä.
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Valitse Käytä kirjasimia. Määritä Käytä tätä perhettä -ikkunassa, mihin työpöydän kohtaan haluat synkronoida kirjasimen, tai lisää se sarjaan,
jotta voit käyttää sitä verkossa.

Valitse tarvitsemasi tyylit kirjasinperheestä ja napsauta sitten Synkronoi valitut kirjasimet -painiketta.

Kirjasimet synkronoidaan kaikkiin tietokoneisiin, joihin Creative Cloud -sovellus on asennettu. Voit näyttää kirjasimet avaamalla Creative Cloud -
sovelluksen ja napsauttamalla Kirjasimet-paneelia.
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Alkuun

Synkronoitujen kirjasimien käyttäminen

Voit käyttää synkronoituja kirjasimia avaamalla minkä tahansa työpöytäsovelluksen ja siirtymällä kirjasinvalikkoon. Näet synkronoidut kirjasimet
vaihtoehtojen luettelossa. Jotkin työpöytäsovellukset, kuten Microsoft Office, voivat vaatia uudelleenkäynnistystä uuden kirjasimen synkronoinnin
jälkeen.

InDesign-kirjasinvalikko, jossa näkyvät Typekitistä synkronoidut kirjasimet

Lisätietoja Typekit-kirjasimien käyttämisestä Creative Cloud -sovelluksessa on seuraavissa artikkeleissa: 
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Alkuun

Typekit-kirjasimien käyttäminen InDesign CC:ssä

Typekit-kirjasimien käyttäminen Premiere Pro CC:ssä

Typekit-kirjasimien käyttäminen Illustrator CC:ssä

Typekit-kirjasimien käyttäminen After Effects CC:ssä

Typekit-kirjasimien käyttäminen Photoshop CC:ssä

Kirjasimien synkronoinnin hallinta

Voit näyttää tietokoneeseen synkronoidut kirjasimet Adobe Creative Cloud -sovelluksen Kirjasimet-paneelissa tai Typekit.com-tilillä.

Synkronoitujen kirjasimien poistaminen
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Voit poistaa synkronoidut kirjasimet tietokoneesta seuraavalla tavalla:

1. Valitse Adobe Creative Cloudin Kirjasimet-paneelista Hallitse kirjasimia. Synkronoidut kirjasimet -sivu avautuu selainikkunaan. Voit myös
kirjautua osoitteeseen Typekit.com ja siirtyä suoraan Synkronoidut kirjasimet -sivulle.

2. Valitse niiden kirjasimien oikealta puolelta Poista, joita et enää halua käyttää.

Typekitin poistaminen käytöstä

Voit ottaa kirjasimien synkronoinnin käyttöön tai poistaa sen käytöstä. Jos poistat kirjasimien synkronoinnin käytöstä, kirjasimien synkronointi
pysäytetään ja synkronoidut kirjasimet poistetaan tietokoneesta.

1. Valitse Creative Cloud -työpöytäsovelluksesta Asetukset ( ) > Oletusarvot.

2. Napsauta Kirjasimet-välilehteä.

3. Jos haluat ottaa kirjasimien synkronoinnin käyttöön tai poistaa sen käytöstä, valitse Typekit käytössä / ei käytössä -asetuksista Kyllä tai Ei.

Typekitin käyttäminen offline-tilassa

Jos siirryt offline-tilaan, kun Creative Cloud -sovellus on käynnissä ja olet kirjautunut sisään, kaikki synkronoidut kirjasimet ovat edelleen
käytettävissä. Osoitteessa Typekit.com kirjasimien synkronointiasetuksiin tehtyjä muutoksia ei oteta käyttöön ennen yhteyden palauttamista.

Jos käynnistät Creative Cloud -sovelluksen offline-tilassa, kirjasimet eivät ole käytettävissä eivätkä ne näy normaaleissa kirjasinvalikoissa.

Aiheeseen liittyvät artikkelit
Kirjasimien synkronointi työpöydälle | Typekit.com

Kirjasimien lisääminen työpöytäsovelluksiin Creative Cloudin kautta
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Creative Cloud Market

Alkuun

Creative Cloud Market on luovien käyttäjien luomien laadukkaiden ja valvottujen sisältöjen kokoelma, joka on tarkoitettu luoville ihmisille. Creative
Cloudin valokuvauspainotteisen tilauksen hankkineita asiakkaita lukuun ottamatta se on kaikkien Creative Cloudin maksullista tilausta käyttävien
jäsenten käytettävissä. Creative Cloud -jäsenet voivat käyttää Marketissa olevia resursseja ilmaiseksi sekä työasemissa että mobiililaitteissa
(Creative Cloudiin yhteydessä olevien sovellusten kautta) ja valita niistä mieleisensä muun muassa vektorigrafiikoiden, kuvakkeiden, mallien ja
käyttöjärjestelmäsarjojen uskomattomasta valikoimasta. Creative Cloudin tilaajat voivat ladata kuukausittain jopa 500 ainutlaatuista,
tekijänoikeusmaksutonta resurssia. Tämän tehokkaan uuden palvelun ansiosta voit hakea jatkuvasti resursseja, jotka mahdollistavat luovien
prosessien kehittämisen, käsittelyn ja muokkauksen.

Marketin käyttöä varten sinun on ensin asennettava Creative Cloud -työpöytäsovellus. Latausohjeet löydät artikkelista Creative Cloud -
työpöytäsovellus. Katso tämä lyhyt video-opastusohjelma ja perehdy aiheeseen tarkemmin: Creative Cloud Marketin suunnitteluresurssien
käyttäminen.

Luovien resurssien hakeminen ja lataaminen

Creative Cloud -työpöytäsovelluksessa voit selata tuhansia laadukkaita resursseja. Valitse Resurssit > Market. Voit myös laajentaa avattavan
valikon ja hakea projektisi kannalta olennaisimmat resurssit luokan tai hakusanojen mukaan.

1. Valitse Creative Cloud -työpöytäsovelluksessa Resurssit > Market.

2. Creative Cloud Marketissa on laadukkaita ja valvottuja sisältöjä, jotka on jaettu seuraaviin luokkiin: 

Sijoiteltavaksi: valokuviin perustuvia ja digitaalisia malleja, joiden ominaisuuksiin kuuluvat järjestellyt tasot ja ammattitasoinen peitto
(PSD-tiedostoja).
Käyttöliittymät: monitasoisia PSD-tiedostoja, muun muassa täydellisiä sarjoja, lomakkeita, kaavioita, navigointisovelluksia ja
pienoisohjelmia sekä mobiili- että verkkokäyttöön (PSD-tiedostoja).
Vektorimuodot: skaalautuvia objekteja ja muotoja, jotka integroituvat Photoshopiin, InDesigniin ja Illustratoriin (SVG-tiedostoja)
Kuvakkeet: sarja merkki- ja ääriviivapohjaisia, litteitä ja kolmiulotteisia symboleita tulostus-, verkko- ja paikannuskäyttöön (PNG- ja SVG-
tiedostoja)
Kuviot: loputtomasti toistettavissa olevia geometrisiä, kuvitettuja ja kuviollisia malleja ja taustoja (PNG- ja SVG-tiedostoja)
Siveltimet: laadukkaita ja luonnollisia, mediakäyttöön tarkoitettuja ja abstrakteja Photoshop-siveltimiä (ABR- ja TPL-tiedostoja).

Jos haluat suodattaa resursseja, valitse luokka Market-ponnahdusvalikosta.
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3. Jos haluat hakea resursseja, valitse  ja anna hakusana.

Voit suodattaa ja järjestellä hakutuloksia.

4. Saat lisätietoja resurssista napsauttamalla sen pienoiskuvaa.
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Alkuun

Miten voin hankkia Creative Cloud Marketin?

Miksi valokuvauspainotteisen tilauksen hankkineet asiakkaat eivät voi käyttää Creative Cloud Marketia?

Tarvitsenko Creative Cloud -jäsenyyden?

Lasketaanko ladatut resurssit tallennuskiintiöön?

Voinko käyttää näitä resursseja projekteissani?

Voinko kopioida tai varmuuskopioida nämä resurssit tulevaa käyttöä varten?

Voinko jakaa nämä resurssit, kun olen ladannut ne?

Mistä Adobe hankkii sisällön Creative Cloud Marketiin?

Voidaanko oma työni lisätä Creative Cloud Marketiin?

5. Valitse Lataa. Resurssit ladataan automaattisesti Creative Cloud Files -pääkansion Market Downloads -kansioon. 

Usein kysytyt kysymykset
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Creative Cloud Extract

Creative Cloud Extractin avulla voit selkeyttää Photoshopin suunnittelu- ja koodaustyönkulkua. Extract yksinkertaistaa prosessia sekä
verkkosuunnittelijoille että -kehittäjille, ja se lisää verkkosisällön toimivaksi koodiksi muuntamisen tehokkuutta.

Photoshop-sommitelmia käytetään yleisesti mallitietojen toimittamiseen verkkosuunnittelijoille, joiden on muunnettava mallisuunnitelma HTML- ja
CSS-koodiksi. Tyypillisessä työnkulussa suunnittelijat luovat Photoshop-sommitelmia verkko- tai mobiililaitekäyttöön. Tuotantoinsinöörit
valmistelevat sitten PSD-tiedoston kehittäjille, jotka jakavat resurssit ja luovat määritykset. Verkkosuunnittelijoiden tehtävänä on muuntaa
suunnitteluelementit ja -resurssit koodiksi.

Extract uudistaa tämän työnkulun antamalla verkkosuunnittelijoille mahdollisuuden viedä optimoidut resurssit ennätysajassa Photoshop CC:hen ja
jakaa PSD-tiedostot kehittäjien kanssa Creative Cloud Assetsilla, jotta he voivat hakea tärkeät suunnittelutiedot ja ladata resurssit selaimillaan.
Kehittäjät voivat tämän jälkeen käyttää ja hyödyntää näitä tietoja, kun he koodaavat Dreamweaver CC:llä.

Extractin toiminta perustuu Creative Cloudiin, ja se on käytettävissä PSD-tiedostojen suunnittelu- ja koodaustyönkulun eri vaiheissa. Extractin
avulla voit vapaasti valita käytettävät työkalut ja tekniikat sekä muuntaa mallisi todellisuudeksi.

Suunnittelijat voivat työskennellä tutussa Photoshop CC -ympäristössä, kun he määrittävät ja purkavat kuvaresursseja tasoista tai
tasoryhmistä.
Verkkosuunnittelijat voivat käyttää PSD-tiedostoa Creative Cloud Assetsilla sekä viedä kuvaresursseja, mittoja ja CSS-tyylejä Extractilla.
Näiden resurssien ja CSS-tyylien avulla mallisommitelmat voidaan sitten muuntaa koodiksi.
Verkkosuunnittelijat ja -kehittäjät voivat käyttää Extractia Dreamweaverista, monipuolisesta ja itsenäisestä ratkaisusta, joka mahdollistaa
kontekstikohtaisten koodivihjeiden käytön ja resurssien purkamisen suoraan koodausympäristössä.
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Resurssien purkaminen Photoshopissa

Photoshop-sommitelmia luovat suunnittelijat voivat nopeasti määrittää ja pakata kuvaresursseja yksittäisistä tasoista tai tasoryhmistä Adobe
Generatoriin perustuvassa yksinkertaisessa visuaalisessa käyttöliittymässä. Tämä nopeuttaa merkittävästi tuotantoaikaa, joten suunnittelijat voivat
käyttää entistä enemmän aikaa suunnitteluun. 

Extract Dreamweaverissa

Verkkosuunnittelijat ja -kehittäjät voivat nyt tarkastella PSD-tiedostoja Dreamweaverissa sekä määrittää CSS-tiedostossa olevat kirjasimet, värit ja
liukuvärit helposti kontekstikohtaisten koodivihjeiden avulla. He voivat myös vetää ja pudottaa optimoidut kuvat Live View -pinnalle, kopioida tekstiä
ja suorittaa muita toimintoja.

Extract Creative Cloud Assetsissa

Verkkosuunnittelijat voivat jakaa Creative Cloud Assetsissa olevat PSD-tiedostot suoraan selaimella, joten kehittäjät pystyvät nopeasti purkamaan
sommitelman koodiksi muuntamiseen tarvittavat suunnittelutiedot, kuten värit, liukuvärit, kirjasimet, tekstin ja CSS-tiedostot. He voivat myös viedä
optimoituja PNG-, SVG- ja JPG-tiedostoja, joita voidaan käyttää verkossa.

Extract for Brackets (Preview)

Bracketsin Extract-integrointi tuo Extractin tehokkaat toiminnot käyttöön kevyessä, nykyaikaisessa koodieditorissa. Extract for Brackets (Preview) -
sovelluksen avulla voit purkaa suunnittelutiedot PSD-tiedostosta selkeän, pienikokoisen CSS-tiedoston muodossa kontekstikohtaisten
koodivihjeiden avulla. Voit myös purkaa tasoja kuvina, käyttää PSD-tiedostossa olevia tietoja esikäsittelytoimintojen muuttujien määrittämiseen ja
selvittää helposti objektien mitat sekä niiden väliset etäisyydet.

Voit yksinkertaistaa suunnittelutyönkulkua entisestään käyttämällä muita Creative Cloud -palveluita, joiden avulla voit synkronoida resurssit, kuten
tiedostot, kirjasimet ja värit. Näin voit varmistaa, että uusimmat mallit ovat kaikkien käytettävissä.

Tiedostojen synkronointi

Synkronoi ja tallenna PSD-tiedostot ja viedyt kuvat Creative Cloud Assetsiin, jotta voit käyttää päivitettyjä tiedostoja kaikissa laitteissa.
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Kansioiden jakaminen

Jaa kansiot Creative Cloud Assetsilla, jotta koko ryhmä käyttää samoja tiedostoja. Voit myös tarkistaa tiedostot ja lisätä niihin kommentteja.
Creative Cloud Assets mahdollistaa myös perustason versionhallinnan.

Kirjasimien synkronointi

Creative Cloud mahdollistaa Typekitin kirjasimien käytön, ja jäsenet voivat ladata kirjasimia Typekitistä mallin tarpeiden mukaan.

Lisätietoja Kysy yhteisöltä Ota meihin yhteyttä

Creative Cloud Extractin
opastusohjelma 

Lähetä viestejä, keskustele ja osallistu
mahtavan yhteisömme toimintaan

Aloita täältä, jos haluat
ottaa meihin yhteyttä

 Katso nyt > Kysy nyt > Aloita nyt >
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Creative Cloud -kirjastot

Creative Cloud -kirjastojen avulla voit käyttää suosikkiresurssejasi missä tahansa. Luo kuvia, värejä, tekstityylejä ja
paljon muuta Adobe Photoshop CC:llä, Adobe Illustrator CC:llä, Adobe InDesign CC:llä ja mobiilisovelluksilla, kuten
Shape CC:llä, ja varmista sen jälkeen luovan työnkulun saumattomuus käyttämällä niitä muissa työpöytä- ja
mobiilisovelluksissa. Creative Cloud -kirjastot luo yhteyden luovaan profiiliisi ja tuo luovat resurssit käyttöösi. Luova
profiilisi kulkee sovelluksissa mukanasi ja mahdollistaa resurssien käytön projektiesi kannalta juuri oikeissa
sovelluksissa ja oikeaan aikaan.

Yleiskatsauksen saat artikkelista Creative Cloud -kirjastojen käytön aloittaminen.

Tallenna

Creative Cloud -kirjastot sisältävät mekanismin, joka mahdollistaa suunnitteluresurssien tallennuksen
työpöytäsovellusten lisäksi myös muista sovelluksista. Voit tallentaa inspiraatiota Creative Cloud -mobiilisovelluksilla
missä tahansa tai jopa ladata resursseja Creative Cloud -markkinoilta.
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Hallitse

Voit järjestää suunnitteluresurssit useisiin Creative Cloud -kirjastoihin. Ne voivat perustua projekteihin,
resurssityyppeihin tai jopa henkilökohtaisiin suosikkeihin, jotka voit käyttää uudelleen muokkaamalla niitä oman
mielesi mukaan.

Käytä uudelleen ja luo

Luo malleja ja kuvia sekä käytä ne uudelleen hyödyntämällä Creative Cloud -kirjastoissa olevia objekteja.

Lisää kirjastoon

Creative Cloud -kirjastot sisältävät mekanismin, joka mahdollistaa suunnitteluresurssien tallennuksen
työpöytäsovellusten lisäksi myös muista sovelluksista. Voit tallentaa inspiraatiota Creative Cloud -mobiilisovelluksilla
missä tahansa tai jopa ladata resursseja Creative Cloud -markkinoilta.

Mobiili

Lisää kirjastoosi resursseja yhä useammilla mobiilisovelluksilla, kuten Adobe Brush CC:llä, Adobe Color CC:llä tai
Adobe Shape CC:llä. Näitä resursseja voidaan käyttää myös mobiililuomusten luomiseen Adobe Illustrator Draw’lla
ja Adobe Photoshop Sketchillä.

Työpöytä

Lisää resursseja Creative Cloud -kirjastoihin pöytätietokoneella Adobe Photoshop CC:n, Adobe Illustrator CC:n ja
InDesign CC:n avulla. Vedä resurssit Kirjastot-paneeliin Illustratorissa, Photoshopissa tai InDesignissa. Voit myös
tarkastella ja selata kirjastoja Creative Cloud -resurssit -sivulla.

Creative Cloud -markkinat

Tutustu Creative Cloud -markkinoiden resursseihin ja lisää ne kirjastoihin. Selaa ja lisää resursseja Creative Cloud -
markkinoilta Creative Cloud -työpöytäsovelluksella. Voit myös lisätä resursseja kirjastoon Creativen
mobiilisovelluksilla.

Käytä uudelleen ja luo

Työpöytä

Avaa Photoshop CC:ssä, Illustrator CC:ssä ja InDesign CC:ssä Kirjastot-paneeli (Ikkunat > Kirjastot) ja vedä
objektit piirtoalueelle.

Mobiili

Valitse kirjastosta objekti ja lisää se projektiisi mobiilisovelluksilla, kuten Photoshop Sketchillä tai Illustrator
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Draw’lla.

Selain

Selaa ja tarkastele kirjastoja Creative Cloud -resurssit -sivulla. Voit myös poistaa kirjaston.

Yhteistyö

Työpöytä 

Avaa Kirjastot-paneeli (Ikkunat > Kirjastot) Photoshop CC:ssä, Illustrator CC:ssä tai InDesign CC:ssä. Valitse sitten
paneelin pikavalikosta Yhteistyö.

Selain

Valitse Creative Cloud Assetsin vasemmasta ruudusta Kirjastot. Valitse sitten kirjastokansion valikosta Yhteistyö.

Usein kysytyt kysymykset

Kuinka monta kohdetta voin lisätä kirjastoon?

Kirjastossa voi olla enintään 1 000 resurssia.

Onko luotavissa olevien kirjastojen määrää rajoitettu?

Ei, luotavissa olevien kirjastojen määrää ei ole rajoitettu. 

Voivatko kaikki tuetut sovellukset käyttää kaikkia kirjastoihin tallennettuja resursseja?

Ei, näet vain kyseisen sovelluksen kannalta olennaiset sovellukset, joita kyseinen sovellus pystyy käyttämään.

Minkä tyyppisiä väritietoja tuetaan?

Kirjastot tukevat yksittäisten värimallien tai väriteemojen väritietoja. Kirjastot tukevat vain prosessivärejä.
Spottivärejä ei tueta, vaan ne lisätään kirjastoihin prosessiväreinä.

Voidaanko kaikki kirjastoihin tallennetut resurssit käyttää Photoshopissa, Illustratorissa ja
InDesignissa uudelleen?

Useimmat resurssit voidaan käyttää Photoshopissa, Illustratorissa ja InDesignissa uudelleen. Poikkeuksen tästä
muodostavat Photoshopin tasotyylit, joita ei tällä hetkellä voi käyttää Illustratorissa tai InDesignissa uudelleen.

Jos käytät InDesignin tekstityyliresurssia Illustratorissa tai PhotoShopissa, kyseiset sovellukset yrittävät määrittää
resurssin ominaisuudet niin, että ne vastaavat isäntäsovelluksessa käytettävissä olevia tekstityylejä. Ominaisuudet,
joita ei löydetä isäntäsovelluksesta, ohitetaan.

Minne resurssit tallennetaan?
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Resurssit tallennetaan paikallisesti laitteeseen ja synkronoidaan Creative Cloudin kanssa.

Voinko jakaa kirjaston muiden kanssa?

Kyllä. Katso Yhteistyö kirjastojen parissa.

Jotkin Creative Cloud -kirjastoihin integroidut mobiilisovellukset (esimerkiksi Brush, Color ja Shape) eivät vielä tue
yhteistyötä kirjastojen parissa. Kanssasi jaetut kirjastot eivät myöskään ole käytettävissä, kun käytät näitä
mobiilisovelluksia. Jos kuitenkin jaoit kirjaston muiden käyttäjien kanssa, kyseinen kirjasto on käytettävissäsi sekä
Creative Cloud -työpöytäsovelluksissa että mobiilisovelluksissa.

Tarvitsenko Creative Cloud -jäsenyyden?

Tarvitset Creative Cloud -kirjastojen käyttöön maksuttoman tai maksullisen Creative Cloud -jäsenyyden.

Mitkä sovellukset antavat minun lisätä tai käyttää kirjaston resursseja?

Creative Cloud -kirjastoja tukevat tällä hetkellä seuraavat sovellukset ja palvelut, ja lisää on tulossa:

 Tallenna resurssit kirjastoihin Luo käyttämällä kirjastossa
olevia resursseja

TYÖPÖYTÄ   

Photoshop Kyllä Kyllä

Illustrator Kyllä Kyllä

InDesign Kyllä Kyllä

CC-markkinat (CC-
työpöytäsovelluksella)

Kyllä -

SELAIN   

CC-resurssit Vain näyttö ja hallinta (uudelleennimeäminen, poisto)

MOBIILI   

Shape CC Vektorimuodot -

Color CC Color-teemat -

Brush CC Siveltimet -

Illustrator Draw - Kuvat ja muodot

Photoshop Sketch - Siveltimet

Mistä saan lisätietoja Creative Cloud -kirjastoista?
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Saat lisätietoja kirjastoista seuraavista resursseista:

Opastusvideot

Creative Cloud -kirjastojen käytön aloittaminen (yleiskatsaus)
Creative Cloud -kirjastot Illustratorissa ja mobiililaitteissa
Creative Cloud -kirjastot Photoshopissa ja mobiililaitteissa

Opastusvideoita, joissa esitellään Creative Cloud -kirjastojen käyttöä mobiilisovelluksissa

Shape CC
Brush CC
Color CC
Illustrator Draw
Photoshop Sketch
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Työtila ja työnkulku

Oman työtilan luominen ja tallentaminen
Jeff Witchel  (15.10.2012)
Opastus - video
Opi mukauttamaan työtilasi.

Työkalujen käyttäminen
Kelly McCathran  (15.5.2012)
Opastus - video
InDesign-työkalupalkissa on lukuisia työkaluja, joista osa on piilotettu tai sijoitettu ensin näkemiesi työkalujen alle. Tässä videossa
esitellään ensisijaiset työkalut, joiden avulla voit valita ja kiertää objekteja sekä muuttaa niiden kokoa. Opit myös muokkaamaan tekstiä
Kirjoita-työkalulla, luomaan reunuksellisia tai reunuksettomia kehyksiä, vaihtamaan työkaluja näppäimistöltä sekä siirtymään Käsi- ja
Zoomaus-työkaluilla.
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Uusien julkaisujen luominen

Alkuun

Alkuun

Julkaisun oletusarvo

Peruste

Sivumäärä

Aloitussivun numero

Vastakkaiset sivut

Uusien julkaisujen luominen
Uuden julkaisun luominen
Uuden julkaisun asetukset
Yleistä julkaisuikkunasta
Luo mukautettuja sivukokoja
Julkaisun oletusarvojen määrittäminen
Julkaisun luominen oletusarvoa käyttämällä

Sivusuunnittelu alkaa perusasioista: uuden julkaisun aloittamisesta, sivujen määrittämisestä ja reunusten ja palstojen sijoittelusta tai
ruudukkoasetusten muuttamisesta.

Uuden julkaisun luominen

1. Valitse Tiedosto > Uusi > Julkaisu.

Uusi julkaisu -valintaikkuna sisältää Julkaisun asetukset- ja Reunukset ja palstat -ikkunat, joten sivukoko, reunukset ja palstat voidaan
määrittää samassa paikassa. Voit muuttaa näitä asetuksia koska tahansa.

2. Julkaisun asetusten määrittäminen. (Katso Uuden julkaisun asetukset.)

Määritä leikkausvara- ja informaatioalueet napsauttamalla ensin Nuoli-painiketta Leikkausvara- ja Informaatio-otsikoiden edessä.
Leikkausvara- ja informaatioalueet ulottuvat määritetyn Sivukoko-asetuksen reunojen ulkopuolelle. Jotta leikkausvara- ja informaatioalueet
ulottuisivat tasaisesti kaikille sivuille, napsauta Määritä kaikki asetukset samoiksi -kuvaketta .

3. (Vain InDesign CC) Esikatselu-valintaruudun avulla voit tarkastella, miltä uusi julkaisu näyttää. Muokkaa asetuksia tarvittaessa.

4. Avaa uusi, määritetyt asetukset sisältävä julkaisu valitsemalla OK.

Uusien julkaisujen sivuasettelun oletusasetukset määritetään valitsemalla Tiedosto > Julkaisun asetukset tai Sivuasettelu > Reunukset ja
palstat. Asetuksia voi määrittää, kun julkaisuja ei ole avoinna.

Uuden julkaisun asetukset

Valitse aikaisemmin tallennettu esimääritys.

Jos olet luomassa julkaisua, joka tulostetaan PDF- tai SWF-muodossa verkkokäyttöä varten, Web-asetuksen valinta muuttaa useita
valintaikkunan asetuksia. Se esimerkiksi poistaa Vastakkaiset sivut käytöstä, muuttaa sivun suunnan pystysuunnasta vaakasuuntaan ja käyttää
näytön tarkkuuteen perustuvaa sivukokoa. Voit muokata näitä asetuksia julkaisun luomisen jälkeen.
CS6 ja sitä uudemmat versiot: Digital Publishing Suite -ratkaisuja varten tarkoitettuihin julkaisuihin on lisätty digitaalisen julkaisun peruste. Voit
muokata julkaisun perustetta myös julkaisun luomisen jälkeen.

Määritä uudessa dokumentissa luotavien sivujen määrä.

Määritä numero, josta julkaisu alkaa. Jos määrität parillisen numeron (kuten 2), kun Vastakkaiset sivut on valittu, julkaisun
ensimmäinen aukeama on kaksisivuinen aukeama. Katso Julkaisun aloittaminen kaksisivuisella aukeamalla.

Kun tämä asetus on valittuna, vasemman- ja oikeanpuoleiset sivut muodostavat kahden sivun aukeaman, kuten kirjoissa ja
aikakauslehdissä. Poista valinta, jos käsittelet sivuja erillisinä. Tämä on tarpeen esimerkiksi silloin, jos tulostat mainoslehtisiä tai julisteita tai jos
haluat objektien leikkausvaran sidontaselkään.
Kun olet luonut julkaisun, voit Sivut-paneelia käyttämällä luoda yli kahden sivun aukeamia tai pakottaa kaksi ensimmäistä sivua samaan
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Tekstikehyspohja

Ensisijainen tekstikehys

Sivukoko

Suunta

Leikkausvara

Informaatioalue

Esikatselu

Huomautus:

Alkuun

aukeamaan. (Katso Aukeaman sivutuksen hallitseminen.)

CS5.5 ja aikaisemmat versiot: Kun valitset tämän asetuksen, voit luoda tekstikehyksen, jonka koko on reunusten apuviivojen
rajaama ja määritettyjä palsta-asetuksia vastaava alue. Tekstikehyspohja lisätään A-sivupohjaan. (Katso Tekstikehysten käyttäminen
sivupohjissa.)
Tekstikehyspohja-asetus on käytettävissä vain, jos olet valinnut Tiedosto > Uusi > Julkaisu.

CS6 ja sitä uudemmat versiot: Valitse tämä asetus, jos haluat lisätä sivupohjaan ensisijaisen tekstikehyksen. Kun
käytät uutta sivupohjaa, ensisijaisen tekstikehyksen juttu juoksutetaan automaattisesti uudella sivupohjalla olevaan ensisijaiseen tekstikehykseen.

Valitse valikosta koko tai määritä Leveys ja Korkeus. Sivukoko on sivun lopullinen haluttu koko leikkausvaran ja muiden sivun
ulkopuolella olevien merkkien poistamisen jälkeen.

Valitse Pysty  (korkea) tai Vaaka  (leveä). Kuvakkeet ovat dynaamisessa vuorovaikutuksessa Sivukoko-kohdan kokojen kanssa. Kun
Korkeus-arvo on suurempi kuin leveys, ohjelma valitsee pystykuvakkeen. Kun Leveys-arvo on suurempi kuin korkeus, ohjelma valitsee
vaakakuvakkeen. Jos napsautat kuvaketta, joka ei ole valittuna, Korkeus- ja Leveys-arvot vaihdetaan keskenään.
Vihje: Voit määrittää leikkausvaran ja informaatioalueiden koon napsauttamalla ensin Nuoli-painiketta Leikkausvara- ja Informaatioalue-otsikoiden
edessä Uusi julkaisu -valintaikkunassa. Jotta leikkausvara- ja informaatioalueet ulottuisivat tasaisesti kaikille sivuille, napsauta Määritä kaikki
asetukset samoiksi -kuvaketta .

Leikkausvara-alueen avulla voit tulostaa määritetyn sivukoon ulkoreunalle sijoitettuja objekteja. Kun objekti sijoitetaan vaadittavan
kokoisen sivun reunaan, tulostusalueen reunassa voi näkyä valkoista, jos tulostusta tai leikkausta ei ole kohdistettu tarkasti kohdalleen. Tämän
vuoksi tarvittavan kokoisen sivun reunassa olevat objektit olisi sijoitettava jonkin verran reunan yli, ja sivu pitäisi viimeistellä tulostuksen jälkeen.
Leikkausvara näkyy julkaisussa punaisena viivana. Voit määrittää leikkausvara-alueen asetukset Tulosta-valintaikkunan Leikkausvara-asetuksissa.

Informaatioalue poistetaan, kun julkaisu viimeistellään lopulliseen sivukokoon. Informaatioalueessa on tietoja tulostuksesta ja
muokatuista väripalkeista tai ohjeita ja kuvauksia muista julkaisun tiedoista. Informaatioalueelle sijoitetut objektit (myös tekstikehykset) tulostetaan,
mutta poistetaan, kun julkaisu viimeistellään lopulliseen sivukokoon.
Leikkausvara- ja informaatioalueiden ulkopuolella olevat objektit (sen mukaan, kumpi ulottuu kauemmaksi) eivät tulostu.

(Vain InDesign CC) Tämän valintaruudun avulla voit tarkastella, miltä uusi julkaisu näyttää. Muuta asetuksia tarvittaessa, jos esikatselu
ei ole tyydyttävä.

Voit tallentaa julkaisun asetukset napsauttamalla Tallenna julkaisun oletusarvo -kuvaketta.

Yleistä julkaisuikkunasta

Kullakin julkaisun sivulla tai aukeamalla on oma taittopöytä ja apuviivat, jotka näkyvät normaalissa näyttötilassa. (Voit vaihtaa normaaliin
näyttötilaan valitsemalla Näytä > Näyttötila > Normaali.) Taittopöytä korvautuu Esikatselu-tilassa harmaalla taustalla. (Katso Julkaisujen
esikatselu.) Voit muuttaa tämän esikatselutaustan ja apuviivojen väriä Apuviivat ja taittopöytä -asetuksissa.

Julkaisu ja apuviivat normaalissa näyttötilassa

A. Aukeama (mustat viivat) B. Sivu (mustat viivat) C. Reunusten apuviivat (magentat viivat) D. Palstojen apuviivat (violetit viivat) E. Leikkausvara-
alue (punaiset viivat) F. Informaatioalue (siniset viivat) 

Julkaisuikkunan huomautukset:
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Alkuun

Alkuun

Alkuun

Muunväriset viivat ovat viivainlinjoja, jotka ovat tasojensa värisiä, kun ne valitaan. Katso Tasot.

Palstojen apuviivat ovat reunusten apuviivojen edessä. Jos palstan apuviiva on aivan reunuksen apuviivan edessä, se peittää reunuksen
apuviivan.

Luo mukautettuja sivukokoja

Voit luoda mukautettuja sivukokoja, jotka näkyvät Uusi julkaisu -valintaikkunan Sivukoko-valikossa.

1. Valitse Tiedosto > Uusi > Julkaisu.

2. Valitse Sivukoko-valikosta Mukautettu sivukoko.

3. Anna sivukoolle nimi, määritä sivukokoasetukset ja valitse sitten Lisää.

New Doc Sizes.txt -tiedosto, jolla voit luoda mukautettuja sivukokoja aikaisemmissa InDesign-versioissa, ei ole käytettävissä InDesign CS5:ssä tai
sitä uudemmissa versioissa.

Julkaisun oletusarvojen määrittäminen

Kun tallennat julkaisun sivukoko-, palsta-, reunus-, leikkausvara- ja informaatioalueasetukset oletusarvoiksi, säästät aikaa ja varmistat julkaisujesi
yhtenäisyyden.

1. Valitse Tiedosto > Julkaisun oletusarvot > Määritä.

2. Valitse näyttöön tulevassa valintaikkunassa Uusi.

3. Määritä oletusarvolle nimi ja valitse Uusi julkaisun oletusarvo -valintaikkunasta perusasetukset. (Katso Uuden julkaisun asetukset, jos haluat
lisätietoja vaihtoehdoista.)

4. Valitse OK kaksi kertaa.

Voit tallentaa julkaisun oletusarvon erilliseen tiedostoon ja lähettää sen muille käyttäjille. Tallenna ja lataa julkaisun oletusarvotiedostot Julkaisun
oletusarvot -valintaikkunan Tallenna- ja Lataa-painikkeiden avulla.

Julkaisun luominen oletusarvoa käyttämällä

1. Tee jokin seuraavista:

Valitse Tiedosto > Julkaisun oletusarvo > [oletusarvon nimi]. (Pidä vaihtopainiketta painettuna oletusarvon valitsemisen aikana, jos
haluat luoda uuden asiakirjan oletusarvon pohjalta avaamatta Uusi julkaisu -valintaikkunaa.)

Valitse Tiedosto > Uusi > Julkaisu ja valitse sitten oletusarvo Uusi julkaisu -valintaikkunan Julkaisun oletusarvo -valikosta.

Oletusarvoasetukset näkyvät Uusi julkaisu -valintaikkunassa.

2. Muuta halutessasi asetuksia ja valitse OK.

Voit ohittaa Uusi julkaisu -valintaikkunan painamalla vaihtonäppäintä, kun valitset oletusarvon Julkaisun oletusarvo -valikosta.
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Asetusten synkronointi Adobe Creative Cloudin avulla

Alkuun

Alkuun

Alkuun

Käsiteltävät aiheet
Johdanto
Asetusten synkronointi ensimmäisellä käynnistyskerralla
Asetusten synkronointitoiminnon käyttäminen
Asetusten synkronointi myöhemmillä käynnistyskerroilla
Synkronoinnin hallinta
Asetukset, joita ei tueta

Johdanto

Kun työskentelet useilla tietokoneilla, kuviojoukkojen, valikon mukautusten, pikanäppäimien, mukautettujen työtilojen ja PDF-esimääritysten hallinta
ja synkronointi eri tietokoneissa voi olla aikaa vievää puuhaa.

Uuden Synkronoi asetukset -toiminnon avulla käyttäjät voivat synkronoida omat asetuksensa Creative Cloudin avulla. Jos käytössä on kaksi
tietokonetta, esimerkiksi yksi kotona ja toinen työpaikalla, Synkronoi asetukset -toiminnon avulla samat asetukset on helppo synkronoida
molempiin tietokoneisiin. Jos vanha tietokone korvataan uudella ja InDesign asennetaan uudelleen, voit määrittää kaikki omat asetukset nopeasti
uuteen tietokoneeseen muutamalla painikkeen painalluksella.

Huomautus: Voit aktivoida InDesignin vain kahdessa tietokoneessa kerrallaan.

Synkronointi tapahtuu Adobe Creative Cloud -tilin kautta. Kaikki asetukset lähetetään tietokoneesta Creative Cloudiin ja ladataan sitten toiseen
tietokoneeseen.

Käyttäjän käynnistettävä synkronointi manuaalisesti. Toimintoa ei voi ajastaa eikä se tapahdu automaattisesti (esimerkiksi käynnistyksen tai
sammutuksen yhteydessä).

Toiminnon toimintaedellytykset:

Tietokoneiden on oltava yhteydessä Internetiin.
Olet kirjautunut Adobe Creative Cloud -tiliin molemmissa tietokoneissa.

Asetusten synkronointi ensimmäisellä käynnistyskerralla

Kun käynnistät sovelluksen ensimmäisen kerran asennuksen jälkeen ja luot julkaisun tai avaat aiemmin luodun julkaisun, näyttöön tulee kehote,
jossa kysytään, haluatko käynnistää synkronoinnin.

Käynnistä synkronointi valitsemalla Synkronoi asetukset nyt.
Voit poistaa toiminnon käytöstä valitsemalla Poista synkronointiasetukset käytöstä.
Valitse Lisäasetukset ja avaa Asetukset-valintaikkuna, jossa voit valita ja mukauttaa synkronoitavat kohteet.

Asetusten synkronointitoiminnon käyttäminen
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Alkuun

Alkuun

Valitse jokin seuraavista vaihtoehdoista:

[Suositus] Napsauta aktiivisen InDesign-julkaisuikkunan vasemmassa alakulmassa olevaa Synkronointiasetukset-kuvaketta ( ) ja valitse
sitten Synkronoi asetukset nyt.
Valitse Muokkaa (Mac: InDesign) > {Kirjautumiseen käytetty Adobe-tunnus} > Synkronoi asetukset nyt.

Asetusten synkronointi myöhemmillä käynnistyskerroilla

Kun käynnistät InDesignin, jossa on aiempia synkronointitietoja, ja luot julkaisun tai avaat aiemmin luodun julkaisun, näyttöön tulee kehote, jossa
kysytään, haluatko käyttää pilveen tallennettuja asetuksia. Jos haluat käynnistää synkronoinnin, valitse Synkronoi asetukset nyt.

Asetukset ladataan paikallisiin tietokoneisiin ja päivitetään sovellukseen. Jos teet muutoksia kuviojoukkoihin, pikanäppäimiin, mukautettuihin
työtiloihin tai PDF-esimäärityksiin, tee synkronointi ennen sovelluksen sulkemista. Voit tarkastella synkronoinnin tilaa julkaisun tilarivin vasemmassa
alakulmassa. Napsauta tilarivillä olevaa asetusten synkronointikuvaketta ( ) ja valitse sitten Synkronoi asetukset nyt.

Synkronoinnin hallinta

Synkronoitavat kohteet

työtilat
valikkoryhmät
PDF-esimääritykset
pikanäppäimet
kuviojoukot.

Synkronoitavien asetusten valitseminen

Valitse Asetukset > Synkronoi asetukset-välilehti:

Valitse Muokkaa (Mac: InDesign) > {Kirjautumiseen käytetty Adobe-tunnus} > Synkronointiasetusten hallinta.
tai 
Valitse Muokkaa (Mac: InDesign) > Asetukset > Synkronoi asetukset.
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Huomautus:

Alkuun

Valitse synkronoitavien asetusten valintaruudut. Voit myös valita, miten sovellus toimii ristiriitatilanteissa.

Jotta asetusten synkronointi onnistuu, muuta asetuksia ainoastaan sovelluksen sisällä. Synkronoi asetukset -toiminto ei synkronoi
tiedostoja, jotka sijoitetaan manuaalisesti kansiosijaintiin.

Toiminta-asetuksen valitseminen ristiriitatilanteita varten

Joissakin tilanteissa järjestelmä saattaa havaita synkronointiristiriitoja. Synkronointiristiriita ilmenee tilanteessa, jossa järjestelmä ei voi määrittää,
haluaako käyttäjä säilyttää Creative Cloudiin vai paikalliseen tietokoneeseen tallennetun asetuksen, kun asetusta on muutettu molemmissa
paikoissa edellisen synkronointikerran jälkeen.

Oletetaan esimerkiksi, että muutat PDF-esimäärityksiä työkoneella ja synkronoit asetukset pilveen. Tämän jälkeen menet kotiin ja muutat samoja
esimäärityksiä kotikoneella synkronoimatta asetuksia ensin pilvestä. Koska sekä pilveen tallennettuja asetuksia että kotikoneen asetuksia on
päivitetty, asetusten synkronointi aiheuttaa ristiriidan. Jos yrität synkronoida asetuksia tässä tilanteessa, näkyviin tulee ilmoitus ristiriidasta.

Synkronoi paikallinen: Synkronoi paikalliset asetukset tietokoneesta pilveen. Pilvessä olevat asetukset korvataan paikallisilla asetuksilla.
Synkronoi pilvi: Synkronoi asetukset pilvestä paikalliseen tietokoneeseen. Paikallisiin asetuksiin tehdyt muutokset ohitetaan ja ne korvataan
pilveen tallennetuilla asetuksilla.

Asetukset, joita ei tueta

Windowsissa luodut pikanäppäimet synkronoidaan vain Windows-tietokoneisiin. Mac-pikanäppäimet synkronoidaan vain Mac-tietokoneisiin.
Mukautettuihin sijainteihin tallennettuja kohteita ei synkronoida.
Työtilan luonnin jälkeen siihen tehtyjä muokkauksia (esimerkiksi paneelin järjesteleminen uudelleen) ei synkronoida. Jos haluat synkronoida
työtiloja, määritä ensin työskentely-ympäristö, luo työtila ja käynnistä sitten synkronointiprosessi.
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Hallittavan tiedoston perustyönkulku

Alkuun

Alkuun

Sisällön jakaminen
Tapoja käsitellä sisältöä InCopyssa
Hallitut tiedostot
Hallittujen tiedostojen parhaat käsittelykäytännöt
Esimerkkejä hallittujen tiedostojen työnkulusta
Käyttäjätunnuksen määrittäminen
Työnkulun kuvakkeet

Sisällön jakaminen

Adobe InCopy LiveEdit -työnkulun laajennusten ansiosta kirjoittajat ja toimittajat voivat muokata tekstiä InCopyssa samaan aikaan kuin
suunnittelijat valmistelevat asetteluita Adobe InDesignissa. Tähän työnkulkuun sisältyy artikkeleiksi kutsuttuja säilötiedostoja, joiden avulla
ryhmitellään toisiinsa liittyviä sisällön osia, sekä tiedostojen lukitus- ja kommentointivälineitä, joilla jaetaan ja päivitetään tiedostoja InCopyssa tai
InDesignissa jaetun verkon kautta tai käyttämällä sähköpostitse jaettavia pakkauksia.

Jaettuun verkkoon perustuvassa työnkulussa InDesign-käyttäjät vievät tekstiä ja kuvia jaettuun paikkaan tiedostojärjestelmässä. Näin tiedostot ovat
niiden InCopy-käyttäjien saatavilla, jotka kirjoittavat ja muokkaavat sisältöä. Valitut teksti- ja grafiikkakehykset viedään joko artikkeliin tai ne
viedään erillisinä InCopy-tiedostoina, jolloin ne muuttuvat hallitun prosessin osaksi ja InDesign-julkaisuun linkitetyiksi. Tällaisia jaettuja tiedostoja
kutsutaan hallituiksi tiedostoiksi. Kun käyttäjät käsittelevät paikallisessa palvelimessa sijaitsevaa artikkeli- tai InDesign-tiedostoa, sivuasettelun tai
sisällön muutokset viestitetään kaikille julkaisun työnkulkuun osallistuville käyttäjille.

Useat InCopy- tai InDesign-käyttäjät voivat avata saman sisältötiedoston samanaikaisesti. Myös useat InCopy-käyttäjät voivat avata saman
artikkelitiedoston samanaikaisesti. Kuitenkin ainoastaan yksi käyttäjä kerrallaan voi uloskirjata InCopy-tiedoston muokattavaksi. Muilla käyttäjillä on
ainoastaan tiedoston lukuoikeus. Hallitun InCopy-tiedoston uloskirjannut käyttäjä voi jakaa työnsä muiden kanssa tallentamalla tiedoston jaettuun
palvelimeen tai palauttamalla tiedoston InDesign-käyttäjälle. Muut käyttäjät eivät kuitenkaan voi tehdä muutoksia tiedostoon, ennen kuin se on
sisäänkirjattu takaisin. Tämän järjestelmän ansiosta useat käyttäjät voivat käsitellä samaa tiedostoa, mutta he eivät pysty vahingossa korvaamaan
toistensa töitä.

Lisätietoja on InCopy LiveEdit -työnkulun oppaassa (PDF) osoitteessa www.adobe.com/go/learn_liveedit_fi.

Tapoja käsitellä sisältöä InCopyssa

Sisältö on joko vähintään yhden kehyksen läpi kulkeva tekstiosa tai tuotu kuva. InCopyssa voidaan käsitellä sisältöä viidellä tavalla: avaamalla
artikkelitiedosto, avaamalla artikkelipakkaus, avaamalla linkitetty InCopy-tiedosto, avaamalla InDesign-tiedosto, jossa on linkitettyjä InCopy-
tiedostoja, tai koostamalla sisältö kokonaan InCopyssa

InDesignilla luotujen artikkelitiedostojen avaaminen

InDesign-käyttäjä voi luoda artikkelitiedoston ja määrittää sisällön jaettavaksi. Näin hän voi yhdistää toisiinsa liittyvät osat (esimerkiksi otsikot,
leipätekstin, kuvat ja kuvatekstit) ja sitten luovuttaa ne eri InCopy-käyttäjille kirjoittamista ja muokkaamista varten. InCopy-käyttäjät avaavat
artikkelitiedoston ja käsittelevät vain heille luovutettuja osia. Todellinen Sivuasettelu-näkymä näyttää, millaisia käyttäjien muokkaaman kopion
muutokset ovat suhteessa InDesign-asetteluun. Siksi koko InDesign-julkaisua ei tarvitse avata. Jos sivuasettelu muuttuu, InDesign-käyttäjän on
päivitettävä artikkelit, jotta InCopy-käyttäjät saavat tiedon muutoksista. Artikkelitiedostoja voidaan jakaa palvelimen tai artikkelipakkausten avulla.

55

http://www.adobe.com/go/learn_liveedit_fi


InDesign-julkaisu (.indd), jonka artikkelitiedosto (.icml) koostuu kolmesta linkitetystä sisältötiedostosta (.incx). Artikkeli ja sen osat näkyvät
Artikkelit-paneelissa, ja ne avataan InCopylla.

Artikkelipakkausten avaaminen

Artikkelipakkauksiin perustuva työnkulku on kätevä erityisesti silloin, kun suunnittelijat ja kirjoittajat toimivat samassa projektissa, mutta heillä ei ole
yhteyttä paikalliseen palvelimeen. Tässä tilanteessa InDesign-käyttäjä voi luoda yhden tai useita pakkauksia ja lähettää pakatut tiedostot
sähköpostitse asianomaisille InCopy-käyttäjille. InCopy-käyttäjät voivat avata artikkelipakkaukset, muokata sisältöä ja palauttaa pakkaukset
InDesign-käyttäjälle, joka voi sitten päivittää julkaisun.

InDesignista vietyjen linkitettyjen InCopy-tiedostojen avaaminen

Tietyissä työnkuluissa InDesign-käyttäjät saattavat viedä tekstiä ja kuvia erillisinä tiedostoina sen sijaan, että he sisällyttäisivät ne
artikkelitiedostoon. Erillisten tiedostojen viemisestä on hyötyä, jos käsiteltävät kuvat tai tekstiosat eivät liity toisiinsa. InCopy-käyttäjät eivät
kuitenkaan näe, miten sisältö sopii InDesign-asetteluun.
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InDesign-julkaisu (.indd), jossa kolme InCopyssa avattua linkitettyä, mutta määrittelemätöntä sisältötiedostoa (.icml)

Linkitettyjä InCopy-tiedostoja sisältävien InDesign-julkaisujen avaaminen

InCopy-käyttäjät voivat tarkastella kaikkia sivun osia koko sivuasettelussa avaamalla InDesign-julkaisun InCopyssa. Tästä menetelmästä voi olla
hyötyä toimitus- ja copyfit-työssä, jos yleisen asettelun näkeminen on tärkeää, tai muokattaessa suurinta osaa julkaisun sisältämistä jutuista vain
muutaman jutun sijasta. Kun InCopy-käyttäjä on muokannut juttuja, InDesign-käyttäjä voi päivittää muokattuihin tiedostoihin johtavat linkit. Jos
InDesign-käyttäjä muuttaa asettelua, InCopy-käyttäjä saa tästä ilmoituksen InDesign-julkaisua tallennettaessa.

Sisällön koostaminen kokonaan InCopyssa

InCopyssa voidaan luoda sisältöä, joka ei liity InDesign-tiedostoon. Näissä itsenäisissä julkaisuissa voidaan parannella tekstiä kirjoittamalla sitä
lisää, määrittämällä kirjasimia ja tyylejä sekä tuomalla kuvia muista sovelluksista (kuten Adobe Illustratorista ja Adobe Photoshopista). Niihin
voidaan myös lisätä nimiöt tulevaa XML-käyttöä varten. Tämä on hyvä vaihtoehto toimitustyössä, jossa sisältö tulee ennen muotoilua. On myös
mahdollista määrittää InCopy-julkaisujen tekstialue, sivukoko ja suunta sekä tehdä niihin muutoksia. Jos juttu linkitetään myöhemmin InDesign-
julkaisuun, InDesign-asetukset korvaavat InCopyssa käytetyt asetukset.

Hallitut tiedostot

Jotta tiedosto olisi hallittavissa, se on lisättävä artikkelitiedostoon, vietävä InDesignista InCopy-sisältönä tai sijoitettava InCopy-sisällöksi
InDesigniin. Hallitusta tiedostosta näkyy sekä sisällön tila että omistaja. Hallittujen tiedostojen avulla voidaan

lukita ja vapauttaa juttuja, jotta tiedoston eheys säilyy

ilmoittaa InCopy-käyttäjille, kun tiedostoon liittyvä InDesign-asettelu on vanhentunut

tunnistaa tiedoston käsittelijä

ilmoittaa käyttäjille, kun InCopy-sisältötiedosto on vanhentunut, jonkun käytössä tai käytettävissä muokkausta varten. Ilmoittaminen tapahtuu
varoitusviesteillä, kehyskuvakkeilla sekä Linkit- ja Artikkelit-paneelien tilakuvakkeilla.

Vain luku -tiedostot
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Kun sisältötiedostosta tulee hallittu tiedosto, kaikki työnkulun käyttäjät sisältötiedoston uloskirjaajaa lukuun ottamatta käsittelevät sitä aina vain luku
-tilassa. Ohjelma luo idlk-tunnisteisen lukitustiedoston, kun käyttäjä uloskirjaa sisältötiedoston. Sitten vain hän voi muokata sitä. Vain luku -
tiedostoilla on seuraavia ominaisuuksia:

InCopy-käyttäjä ei voi manuaalisesti muotoilla tiedoston tekstiä. Jos tekstissä on käytetty merkki- tai kappaletyylejä, InDesign-käyttäjä voi
muuttaa niiden määrityksiä ja siten muuttaa tekstin muotoilua, vaikka joku muu olisi uloskirjannut tiedoston. Tyylimääritysten muutokset
näkyvät tekstissä, kun InDesign-käyttäjä päivittää tiedoston.

InCopy- tai InDesign-käyttäjä ei yleensä voi muuttaa lukitun InCopy-sisällön objekteja, kuten tekstiä ja käytettyjä tyylejä. Sisältö vain käyttää
tiettyjä objekteja, kuten merkki- ja kappaletyylejä. Et voi esimerkiksi muuttaa tapaa, jolla merkkityyli vaikuttaa lukitun sisällön objekteihin,
mutta voit muuttaa itse merkkityyliä, jolloin tekstin ulkoasu muuttuu.

InDesign-käyttäjä voi muuttaa tekstisisällön reunuksia ja palstoja sekä jutun tekstikehysten muotoa, sijaintia ja määrää.

InDesign-käyttäjä voi muuttaa grafiikkakehyksen geometriaa ja muotoilua kuvaa uloskirjaamatta. InCopy-käyttäjä ei voi vaihtaa
grafiikkakehystä eikä muuttaa sen muotoilua. Sekä InDesign- että InCopy-käyttäjien on kuitenkin uloskirjattava grafiikkakehys, jos he haluavat
muokata (esimerkiksi kiertää tai skaalata) itse kuvaa.

Hallittujen tiedostojen parhaat käsittelykäytännöt

Varmista seuraavilla käytännöillä, että käsittelet uusinta sisältöä ja että et korvaa jonkun muun tekemää työtä:

Tallenna artikkelitiedostot palvelimeen, johon kaikilla työryhmän jäsenillä on käyttöoikeus. Jos työryhmän jäsenillä ei ole palvelimeen
käyttöoikeutta, voit luoda ja jakaa artikkelipakkauksia.

Kun artikkeli luodaan, artikkelitiedostoa ja sen sisältöä varten luodaan erikoiskansio. Artikkelikansioita käytetään artikkeli- ja sisältötiedostojen
ylläpitoon. Ne yksinkertaistavat jaettujen tiedostojen hallintaa työryhmässä ja auttaa varmistamaan, että käyttäjät avaavat oikeat tiedostot.

Avaa InCopyssa artikkelitiedosto InCopy-jutun sijasta. Näin voit nähdä copyfit- ja sivuasettelutiedot Raakateksti- ja Sivuasettelu-näkymissä.
Jos olet vienyt sisällön ilman artikkelitiedostoja, voit nähdä copyfit- ja sivuasettelutiedot ainoastaan avaamalla InDesign-tiedoston.

Kun olet avannut artikkelitiedoston, avaa InDesign-julkaisu tai uloskirjaa sisältö joko InDesignissa tai InCopyssa, varmista, että kehyksen
reunat näkyvät (Näytä > Ekstrat > Näytä kehyksen reunat), jotta näet kehyskuvakkeet, kun ne tulevat esiin.

Jos sinun on poistettava tiedostoja työnkulusta (esimerkiksi tuotannon määräajan vuoksi) InDesignissa, voit poistaa niiden linkityksen tai
peruuttaa artikkelipakkauksen.

Esimerkkejä hallittujen tiedostojen työnkulusta

Kun luot InCopyn ja InDesignin välisen työnkulun hallinnan, julkaisun kirjoittajat ja toimittajat voivat koostaa, kirjoittaa uudelleen, laajentaa ja
muokata julkaisuja samalla, kun suunnittelijat valmistelevat sivuasettelua. Tavallisiin työnkulkuihin sisältyy tiedostojen hallinta paikallisella
palvelimella, tiedostojen jakaminen sähköpostipakkausten kautta tai näiden menetelmien yhdistelmä.

Tämä työnkulku perustuu siihen, että käytössä on sivuasettelugeometrian, tyylit ja paikkamerkkitekstin sisältävä InDesign-perusmalli.
Sivuasettelugeometria sisältää sivun mitat sekä teksti- ja grafiikkakehykset. InCopy näyttää näiden kohteiden avulla sopivat copyfit-tiedot.

Paikallisen palvelimen työnkulku

1. Luo artikkelit ja lisää niihin sisältö InDesignissa.

Tämä vaihe sisällyttää viedyn tekstin ja grafiikkakehykset hallittuun prosessiin, jossa ne tulevat InCopy-käyttäjien käyttöön kirjoittamista ja
muokkaamista varten.

2. Tuo artikkelitiedostot InCopy-käyttäjien käyttöön.

Tallenna tiedostot palvelimelle, jota kaikki työnkulun käyttäjät voivat käyttää.
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3. Avaa artikkelitiedosto InCopyssa ja tarkista ja muokkaa juttua tai grafiikkaa.

InCopyn Artikkeli-paneelissa näkyvät sinulle määritettyä sisältöä sisältävät tiedostot. Kun tallennat tiedoston paikalliselle palvelimelle, muutokset
tallentuvat tiedostojärjestelmään, jolloin kaikki julkaisua (InDesign-sivuasettelu tai muu julkaisun hallittu sisältötiedosto) käsittelevät saavat
ilmoituksen muutoksista. Nämä käyttäjät voivat tarkastella uusia muutoksia päivittämällä sisällön. Sisältö pysyy uloskirjattuna, kunnes sisäänkirjaat
sen.

4. Käsittele sivuasettelua InDesignissa.

Riippumatta siitä muokataanko sisältötiedostoja InCopyssa, InDesign-käyttäjät voivat käsitellä julkaisun sivuasettelua. Heidän ei siis tarvitse ensin
uloskirjata julkaisua. Kun InCopy-käyttäjä tallentaa uloskirjatun sisällön, InDesign-käyttäjä voi nähdä uusimmat muutokset päivittämällä
sivuasettelun sisällön.

5. Jatka työskentelyä InCopyssa.

Kun saat muutokset valmiiksi, sisäänkirjaa sisältö. Muut käyttäjät voivat sitten uloskirjata sisällön ja käsitellä sitä. Jos joku käyttäjä muokkaa
sivuasettelua InDesignissa samanaikaisesti, voit päivittää ja tarkastella sivuasettelugeometriaa työskennellessäsi.

6. Varmista InDesignissa, että kaikki sisältö on sisäänkirjattu.

Hallitun työnkulun ansiosta tiedostojen uloskirjaaja voidaan tunnistaa. Kun sisältötiedostot on sisäänkirjattu, InDesign-käyttäjät voivat tarvittaessa
viimeistellä sivuasettelun uloskirjaamalla tiedostot.

Sähköpostipakkauksen työnkulku

1. Luo ja lähetä artikkelipakkaukset InDesignissa.

Voit luoda artikkelipakkauksia ja määrittää sisältöjä asiaankuuluville InCopy-käyttäjille. Tämän jälkeen voit lähettää pakkaukset kyseisille InCopy-
käyttäjille. Pakatut tiedostot uloskirjataan automaattisesti, jotta toimitusristiriidat voidaan välttää.

2. Avaa artikkelipakkaus InCopyssa ja tarkista ja muokkaa juttua tai grafiikkaa.

Jos saat artikkelipaketin sähköpostitse, voit avata pakkauksen InCopyssa kaksoisnapsauttamalla sitä. Tiedostoon tekemäsi muutokset tallennetaan
vain paikallisesti. Muille käyttäjille ei ilmoiteta siitä, kun teet muutoksia.

3. Käsittele sivuasettelua InDesignissa.

Riippumatta siitä ovatko sisältötiedot pakattuja, InDesign-käyttäjät voivat käsitellä julkaisun sivuasettelua. Heidän ei siis tarvitse ensin uloskirjata
julkaisua. Jos asettelua tai artikkeleita täytyy päivittää, voit lähettää päivitetyn pakkauksen InCopy-käyttäjille.

4. Palauta muokattu pakkaus InCopyssa.

Kun olet saanut muokkauksen valmiiksi, tarkista sisältö ja palauta muokattu pakkaus. Muut käyttäjät voivat tämän jälkeen uloskirjata sisällön,
tarkastella uusimpia muutoksia ja käsitellä tiedostoa.

5. Varmista InDesignissa, että kaikki sisältö on sisäänkirjattu.

Hallitun työnkulun ansiosta tiedostojen uloskirjaaja voidaan tunnistaa. Kun artikkelipakkaukset on palautettu, artikkelipakkausten jutut
sisäänkirjataan. InDesign-käyttäjät voivat tarkistaa tiedostot ja viimeistellä asettelun tarpeen mukaan.
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Huomautus:

Huomautus:
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Huomautus:

Käyttäjätunnuksen määrittäminen

Työnkulun kaikilla käyttäjillä on oltava käyttäjänimi. Käyttäjänimestä muut käyttäjät näkevät, kuka on uloskirjannut tietyn tiedoston. Se vaaditaan,
jotta tiedosto voitaisiin uloskirjata muokattavaksi.

Jos haluat muuttaa määrittämääsi käyttäjänimeä, sinun on sisäänkirjattava kaikki uloskirjaamasi sisältö. Jos muutat käyttäjänimeä muokkaamisen
aikana, et enää voi muokata uloskirjaamaasi sisältöä – se on uloskirjattu sinulle toisella nimellä.

Käyttäjätunnus on sovelluskohtainen. Käyttäjällä ei voi olla samassa sovelluksessa useita käyttäjätunnuksia.

Myös InCopyn Huomautukset- ja Jäljitä muutokset -toiminnot tunnistavat huomautuksen tai jäljitetyn muutoksen tekijän käyttäjänimen
avulla.

1. Tee jompikumpi seuraavista:

Valitse Tiedosto > Käyttäjä.

Valitse Artikkelit-paneelin valikosta Käyttäjä.

2. Kirjoita yksilöllinen nimi ja napsauta OK-painiketta.

Jos unohdat määrittää käyttäjänimen tällä tavalla, ohjelma kehottaa antamaan sen, kun yrität aloittaa ensimmäistä työnkulun toimintoa.

Tämän valintaikkunan Väri-valikon avulla voidaan yksilöidä muokkaushuomautuksia ja jäljitettyjä muutoksia. Voit halutessasi valita
värin nyt, mutta se ei vaikuta siihen, mitä teet hallitussa työnkulussa.

Työnkulun kuvakkeet

Teksti- ja grafiikkakehyksissä, Artikkelit-paneelissa sekä juttupalkissa (vain InCopy) voi näkyä kuvakkeita. Hallitun tiedoston vieressä on Linkit- ja
Artikkelit-paneelissa muokkaustilakuvakkeita, joista ilmenee sisällön tila. Kuvakkeet näkyvät kehyksissä, joissa on linkitetty InCopy-juttu (sekä
InDesignin että InCopyn sivuasettelunäkymä). Näistä kuvakkeista ilmenee myös sisällön tila, ja niillä voidaan erottaa hallittu ja hallitsematon sisältö
toisistaan. Niihin liittyvä työkaluvihje ilmaisee muokkaustilan ja omistajan. Jotta voisit tarkastella kehyskuvakkeita, varmista, että kehyksen reunat
näkyvät InDesignissa ja InCopyssa (Näytä > Ekstrat > Näytä kehyksen reunat).

(InDesign) InDesign-julkaisuikkunan on oltava normaalitilassa, jotta kehyksen reunat näkyisivät. (Napsauta työkalupaneelin
vasemmassa alakulmassa olevaa Normaalitila-painiketta .)

Kuvake Nimi Sijainti

Käytettävissä Artikkelit-paneeli (InDesign ja InCopy),
tekstikehykset ja grafiikkakehykset

Käytössä [nimi] Artikkelit-paneeli, tekstikehykset ja
grafiikkakehykset

Muokataan Artikkelit-paneeli, tekstikehykset ja
grafiikkakehykset

Käytettävissä ja vanhentunut Teksti- ja grafiikkakehykset

Nimi käyttää kohdetta, joka on
vanhentunut

Teksti- ja grafiikkakehykset

Muokataan ja vanhentunut Teksti- ja grafiikkakehykset

Vanhentunut Artikkelit-paneeli

Tekstisisältö vanhentunut Artikkelit-paneeli ja tekstikehykset
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Huomautus: Käytettävissä-, Käytössä-, Muokataan-, Tekstisisältö- ja Graafinen sisältö -kuvakkeissa näkyvä Vanhentunut-kuvake ilmaisee, että
sisältö on vanhentunut eli tiedostojärjestelmässä oleva versio on uudempi kuin tietokoneessasi näkyvä versio.

Lisää ohjeaiheita
Erillisten julkaisujen käsitteleminen

Muokkaushuomautusten käyttäminen

Tekstisisältö päivitetty Artikkelit-paneeli ja tekstikehykset

Graafinen sisältö vanhentunut Artikkelit-paneeli ja grafiikkakehykset

Graafinen sisältö päivitetty Artikkelit-paneeli ja grafiikkakehykset

Pakattu sisältö Artikkelit-paneeli
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Perustietoja työtilasta

Alkuun

Työtilan yleiskuvaus
Ikkunoiden ja paneelien hallinta
Työtilojen tallentaminen ja niiden välillä siirtyminen
Tietoja näyttötiloista
Tilarivin käyttäminen
Ohjauspaneelin yleiskuvaus
Tietoja Navigaattori-paneelista
Pikavalikkojen käyttäminen
Käyttöliittymän asetusten muuttaminen

Napsauttamalla seuraavia linkkejä saat lisätietoja.

Työtilan yleiskuvaus

Julkaisuja ja tiedostoja luodaan ja niitä käsitellään paneelien, palkkien ja ikkunoiden kaltaisten elementtien avulla. Mitä tahansa näiden elementtien
järjestelyä kutsutaan työtilaksi. Adobe® Creative Suite® 5 -sovellusten työtilat ovat ulkoasultaan samankaltaiset, joten sovellusten välillä
siirtyminen on helppoa. Voit myös mukauttaa sovellukset työtapojesi mukaan joko valitsemalla useista valmiista työtiloista tai luomalla oman
työtilasi.

Oletustyötilan asettelu vaihtelee tuotekohtaisesti, mutta voit silti mukauttaa asetuksia pitkälti samalla tavoin.

Yläreunan sovelluspalkki sisältää työtilanvaihtajan, valikot (vain Windows) ja muut sovelluksen ohjausobjektit. Mac-käyttöjärjestelmässä voit
tietyissä tuotteissa näyttää tai piilottaa sen Ikkuna (Window) -valikon avulla.

Työkalupaneeli sisältää työkalut kuvien, sivun elementtien ja muiden osien luomista ja muokkaamista varten. Toisiinsa liittyvät työkalut on
ryhmitetty.

Ohjauspaneelissa näkyvät valittuna olevan työkalun asetukset. Illustratorissa Ohjauspaneelissa näkyvät valittuna olevan objektin asetukset.
(Adobe Photoshopissa® tätä kutsutaan myös asetusriviksi. Adobe Flashissa®, Adobe Dreamweaverissa® ja Adobe Fireworksissa® tämä
tunnetaan Property inspector -ominaisuutena ja se sisältää valittuna olevan elementin asetukset.

Dokumentti-ikkunassa näkyy käsiteltävänä oleva tiedosto. Dokumentti-ikkunat voivat sisältää välilehtiä, ja ne voidaan tarvittaessa ryhmitellä ja
kiinnittää.

Paneelien avulla voit seurata ja muokata työtäsi. Esimerkkejä paneeleista ovat Flashin Timeline-paneeli, Illustratorin Sivellin-paneeli, Adobe
Photoshopin® Tasot-paneeli ja Dreamweaverin CSS Styles -paneeli. Paneeleja voi ryhmittää, asettaa päällekkäin tai kiinnittää.

Sovelluskehys ryhmittää kaikki työtilan elementit yhteen integroituun ikkunaan, jossa sovellusta voi käsitellä yhtenä yksikkönä. Kun
sovelluskehystä tai jotakin sen osaa siirretään tai kehyksen tai jonkin sen osan kokoa muutetaan, kaikki osat muuttuvat siten, että ne eivät
asetu päällekkäin. Paneelit eivät poistu näkyvistä vaihdettaessa sovellusten välillä tai poistuttaessa sovelluksesta vahingossa. Jos käytät
kahta tai useampaa sovellusta, voit sijoittaa sovellukset näyttöön vierekkäin tai useaan eri näyttöön.

Jos sinulla on Mac OS -käyttöjärjestelmä ja käytät mieluummin perinteistä käyttöliittymää, voit poistaa sovelluskehyksen käytöstä. Esimerkiksi
Adobe Illustratorissa® voit poistaa kehyksen käytöstä ja ottaa sen käyttöön valitsemalla Window > Application Frame. (Macin Flashissa
sovelluskehys on pysyvästi käytössä ja Macin Dreamweaver ei käytä sovelluskehystä.)
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Illustratorin oletustyötila

A. Välilehdillä olevat dokumentti-ikkunat B. Sovelluspalkki C. Työtilanvaihtaja D. Paneelin otsikkorivi E. Ohjauspaneeli F. Työkalupaneeli G. Kutista
kuvakkeiksi -painike H. Neljä paneeliryhmää pystysuuntaisesti kiinnitettyinä 

Kaikkien paneelien näyttäminen tai piilottaminen

(Illustrator, Adobe InCopy®, Adobe InDesign®, Photoshop, Fireworks) Voit piilottaa tai näyttää kaikki paneelit työkalupaneeli ja ohjauspaneeli
mukaan luettuina painamalla sarkainnäppäintä.

(Illustrator, InCopy, InDesign, Photoshop) Voit piilottaa tai näyttää kaikki paneelit lukuun ottamatta työkalupaneelia ja ohjauspaneelia
painamalla näppäinyhdistelmää Vaihto+Sarkain.

Voit tuoda piilotetut paneelit tilapäisesti näkyviin, jos Näytä piilotetut paneelit automaattisesti on valittu Liittymän oletusasetuksissa.
Illustratorissa ne ovat aina käytössä. Vie osoitin sovellusikkunan reunaan (Windows®) tai näytön reunaan (Mac OS®) ja pysäytä se näkyviin
tulevan nauhan päälle.

(Flash, Dreamweaver, Fireworks) Voit piilottaa tai näyttää kaikki paneelit painamalla F4-näppäintä.

Näyttö-paneelin asetukset

Napsauta paneelin oikeassa yläkulmassa näkyvää paneelivalikon kuvaketta .

Voit avata paneelin valikon, vaikka paneeli olisi pienennettynä.

Photoshopissa voit muuttaa paneelien ja työkaluvihjeiden tekstin kirjasimen kokoa. Valitse koko yleisten oletusarvojen Käyttöliittymän
kirjasinkoko -valikosta.

(Illustrator) Paneelin kirkkauden säätäminen

Siirrä kirkkauden liukusäädintä käyttöliittymän asetuksissa. Tämä säätö vaikuttaa kaikkiin paneeleihin, myös ohjauspaneeliin.

Työkalut-paneelin määrittäminen uudelleen

Voit tuoda Työkalut-paneelin työkalut näkyviin yhtenä sarakkeena tai rinnakkain kahtena sarakkeena. (Tämä ominaisuus ei ole käytettävissä
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Alkuun

Huomautus:

Huomautus:

Huomautus:

Huomautus:

Huomautus:

Fireworksin ja Flashin Tools-paneelissa.)

InDesignissa ja InCopyssa voit vaihtaa yhden sarakkeen näytöstä kahden sarakkeen (tai yhden rivin) näyttöön määrittämällä asetuksen
liittymän oletusarvoissa.

Napsauta työkalupaneelin yläosassa olevaa kaksinkertaista nuolta.

Ikkunoiden ja paneelien hallinta

Voit luoda mukautetun työtilan siirtämällä ja muokkaamalla dokumentti-ikkunoita ja paneeleja. Voit myös tallentaa työtiloja ja siirtyä niiden välillä.
Fireworksissa mukautettujen työtilojen nimeäminen uudelleen voi johtaa odottamattomaan käyttäytymiseen.

Seuraavissa esimerkeissä käytetään Photoshopia. Työtila toimii samoin kaikissa tuotteissa.

Julkaisuikkunoiden järjestäminen uudelleen, kiinnittäminen tai kelluttaminen

Kun avaat useamman kuin yhden tiedoston, dokumentti-ikkunat näkyvät välilehtinä.

Voit järjestää välilehtinä näkyvät dokumentti-ikkunat uudelleen vetämällä kunkin ikkunan välilehden uuteen paikkaan ryhmässä.
Voit poistaa dokumentti-ikkunan kiinnityksen (kelluta tai poista välilehditys) ikkunaryhmässä vetämällä ikkunan välilehden pois ryhmästä.

Jos haluat kelluttaa yksittäisen dokumentti-ikkunan Photoshopissa, valitse Ikkuna > Järjestä > Kelluva ikkunassa, tai Ikkuna >
Järjestä > Kaikki kelluvia ikkunassa, jos haluat kelluttaa kaikki dokumentti-ikkunat samalla kertaa. Lisätietoja on teknisessä julkaisussa
kb405298.

Dreamweaver ei tue dokumentti-ikkunoiden kiinnittämistä tai kiinnityksen poistamista. Jos haluat luoda kelluvia ikkunoita
(Windowsissa), käytä dokumentti-ikkunan Pienennä-painiketta, tai valitse Ikkuna > Pystysuuntaiset ruudut, jos haluat luoda rinnakkaisia
dokumentti-ikkunoita. Tee Dreamweaverin ohjeessa haku sanoilla "pystysuuntaiset ruudut", jos haluat lisätietoja tästä aiheesta. Macintosh-
käyttäjien työnkulku on hieman erilainen.

Voit kiinnittää dokumentti-ikkunan erilliseen dokumentti-ikkunoiden ryhmään vetämällä ikkunan ryhmään.

Luo limittäin tai vierekkäin näytettävien dokumenttien ryhmiä vetämällä ikkuna johonkin toisen ikkunan yläreunan, alareunan tai sivujen
pudotusvyöhykkeistä. Voit myös valita ryhmälle asettelun sovelluspalkin Asettelu-painikkeella.

Kaikki tuotteet eivät tue tätä toimintoa. Tuotteessa saattaa kuitenkin Ikkuna-valikossa olla Limittäin- ja Vierekkäin-komennot
helpottamassa dokumenttien asettelua.

Jos haluat vaihtaa toiseen dokumenttiin välilehtiä sisältävässä ryhmässä valintaa vetäessäsi, vedä valinta dokumentin välilehden kohdalle
hetkeksi.

Kaikki tuotteet eivät tue tätä toimintoa.

Paneelien kiinnittäminen ja irrottaminen

Paneelit tai paneeliryhmät voidaan näyttää yhdessä kiinnittämällä ne. Yleensä paneelit kiinnitetään pystysuoraan. Voit kiinnittää paneelit ja irrottaa
ne siirtämällä ne kiinnityskohtaan ja pois siitä.

Voit kiinnittää paneelin vetämällä sitä kielekkeestä kiinnityskohtaan muiden paneelien ylä- tai alaosaan tai muiden paneelien väliin.

Voit kiinnittää paneeliryhmän vetämällä sen kiinnityskohtaan otsikkorivistään (kielekkeiden yläpuolella oleva yksiosainen tyhjä rivi).

Voit irrottaa paneelin tai paneeliryhmän vetämällä sen pois paneelistaan kielekkeestään tai otsikkorivistään. Voit vetää sen toiseen
kiinnityskohtaan tai tehdä siitä vapaasti kelluvan.
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Huomautus:

Navigointipaneelia vedetään uuteen kiinnityskohtaan, joka ilmaistaan sinisellä pystysuoralla korostuksella.

Navigointipaneeli kiinnitettynä.

Voit estää paneeleita täyttämästä kiinnityksen koko tilaa. Vedä kiinnityksen alareunaa ylöspäin, kunnes se ei enää osu työtilan reunaan.

Paneelien siirtäminen

Kun siirrät paneeleita, näytössä näkyy sinisiä korostettuja pudotusalueita, joihin voit siirtää paneelin. Voit esimerkiksi siirtää paneelia ylös tai alas
kiinnityskohdassaan vetämällä sen toisen paneelin ylä- tai alapuolella olevalle kapealle siniselle vyöhykkeelle. Jos vedät sen alueelle, joka ei ole
pudotusvyöhyke, paneeli kelluu vapaasti työtilassa.

Hiiren sijainti (pikemminkin kuin paneelin sijainti) aktivoi pudotusalueen, joten jos et näe pudotusaluetta, kokeile vetää hiiri siihen
kohtaan, jossa pudotusalueen pitäisi olla.

Voit siirtää paneelia vetämällä sitä kielekkeestään.

Voit siirtää paneeliryhmää vetämällä otsikkoriviä.

Kapea sininen pudotusvyöhyke ilmaisee, että Väri-paneeli kiinnitetään yksinään Tasot-paneeliryhmän yläpuolelle.

A. Otsikkorivi B. Sarkain C. Pudotusvyöhyke 

Voit estää paneelin kiinnittymisen painamalla Ctrl-näppäintä (Windows) tai Komento-osoittamalla (Mac OS) paneelin siirtämisen aikana. Voit
peruuttaa toiminnon painamalla paneelin siirtämisen aikana Esc-näppäintä.

Paneelien lisääminen ja poistaminen

Jos poistat kaikki paneelit kiinnityskohdasta, se häviää näytöstä. Voit luoda kiinnityksen siirtämällä paneelit työtilan oikeaan reunaan ja
odottamalla, kunnes pudotusalue tulee näkyviin.
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Huomautus:

Voit poistaa paneelin napsauttamalla hiiren kakkospainikkeella (Windows) tai Control-osoittamalla (Mac) paneelin välilehteä ja valitsemalla
sitten Sulje tai poistamalla paneelin valinnan Ikkuna-valikosta.

Voit lisätä paneelin valitsemalla sen Ikkuna-valikossa ja kiinnittämällä sen haluamaasi kohtaan.

Paneeliryhmien muokkaaminen

Voit siirtää paneelin ryhmään vetämällä paneelin välilehden ryhmässä olevaan korostettuun pudotusvyöhykkeeseen.

Paneelin lisääminen paneeliryhmään.

Voit järjestää ryhmän paneelit uudelleen vetämällä paneelin välilehden uuteen kohtaan ryhmässä.

Voit poistaa paneelin ryhmästä siten, että se kelluu, vetämällä paneelin kielekkeestään ryhmän ulkopuolelle.

Voit siirtää ryhmää vetämällä otsikkoriviä (välilehtien yläpuolella olevaa aluetta).

Kelluvien paneelien pinoaminen

Kun vedät paneelin irti kiinnityksestään, mutta et vedä sitä pudotusvyöhykkeelle, paneeli kelluu vapaasti. Voit sijoittaa kelluvan paneelin mihin
tahansa työtilan kohtaan. Voit pinota kelluvat paneelit tai paneeliryhmät siten, että ne liikkuvat yksikkönä, kun vedät päällimmäistä otsikkoriviä.

Kelluvat pinotut paneelit

Voit pinota kelluvat paneelit vetämällä paneelia kielekkeestään toisen paneelin alaosassa olevalle pudotusvyöhykkeelle.

Voit muuttaa pinoamisjärjestystä vetämällä paneelia kielekkeestään ylös tai alas.

Varmista, että vapautat välilehden ennen paneelien välissä olevaa kapeaa pudotusvyöhykettä otsikkorivin leveän vyöhykkeen sijaan.

Voit poistaa paneelin tai paneeliryhmän pinosta siten, että se kelluu yksinään, vetämällä sitä välilehdestä tai otsikkorivistä.

Paneelien koon muuttaminen

Voit pienentää tai suurentaa paneelin, paneeliryhmän tai paneelien pinon kaksoisnapsauttamalla välilehteä. Voit myös kaksoisnapsauttaa
välilehtialuetta (tyhjää kohtaa välilehtien vieressä) kerran.

Voit muuttaa paneelin kokoa vetämällä paneelin mitä tahansa reunaa. Joidenkin paneelien, kuten Photoshopin Väri-paneelin, kokoa ei voi
muuttaa vetämällä.

Paneelikuvakkeiden supistaminen ja laajentaminen

Jos tarvitset enemmän työskentelytilaa, voit supistaa paneelit kuvakkeiksi. Joissakin tapauksissa paneelit on kutistettu kuvakkeiksi oletustyötilassa.
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Alkuun

Kuvakkeiksi kutistetut paneelit

Kuvakkeista laajennetut paneelit

Voit supistaa tai laajentaa kaikki palstan paneelikuvakkeet napsauttamalla kiinnityskohdan yläosassa olevaa kaksipäistä nuolta.
Voit laajentaa yksittäisen paneelin kuvakkeen napsauttamalla sitä.
Voit muuttaa paneelikuvakkeiden kokoa siten, että vain kuvakkeet (eivät selitteet) näkyvät, säätämällä kiinnityskohdan leveyttä, kunnes
tekstiä ei enää näy. Voit tuoda kuvakkeen tekstin uudelleen näkyviin leventämällä kiinnityskohtaa.
Voit kutistaa laajennetun paneelin takaisin kuvakkeeksi napsauttamalla sen kielekettä, kuvaketta tai paneelin otsikkorivin kaksipäistä nuolta.

Joissakin tuotteissa liittymän oletusasetuksissa on valittavissa Kutista kuvakepaletit automaattisesti -asetus, joka kutistaa laajennetun
paneelikuvakkeen, kun sen ulkopuolella napsautetaan.

Voit lisätä kelluvan paneelin tai paneeliryhmän kuvakkeen kiinnityskohtaan vetämällä sen siihen välilehdestä tai otsikkorivistä. (Paneelit
kutistetaan automaattisesti kuvakkeiksi, kun ne lisätään kuvakkeen kiinnityskohtaan.)

Voit siirtää paneelikuvaketta (tai paneelikuvakkeiden ryhmää) vetämällä kuvaketta. Voit vetää paneelikuvakkeita ylös ja alas kiinnityskohtaan,
muihin kiinnityskohtiin (joissa ne näkyvät kyseisen kiinnityskohdan paneelin tyylisenä) tai kiinnityskohdan ulkopuolelle (jolloin ne näkyvät
kelluvina kuvakkeina).

Työtilojen tallentaminen ja niiden välillä siirtyminen

Kun tallennat paneelien koon ja sijainnin nimettynä työtilana, voit palauttaa kyseisen työtilan, vaikka siirtäisit paneelia tai sulkisit sen. Tallennettujen
työtilojen nimet tulevat näkyviin sovelluspalkin työtilanvaihtajaan.

Mukautetun työtilan tallentaminen

1. Kun työtila on haluamasi kaltainen ja haluat tallentaa sen, tee jokin seuraavista:

(Illustrator) Valitse Window > Workspace > Save Workspace.

(Photoshop, InDesign, InCopy) Valitse Ikkuna > Työtila > Uusi työtila.

(Dreamweaver) Valitse Window > Workspace > New Workspace.

(Flash) Valitse sovelluspalkin työtilanvaihtajasta New Workspace.

(Fireworks) Valitse sovelluspalkin työtilanvaihtajasta Save Current.

2. Kirjoita työtilan nimi.

3. (Photoshop, InDesign) Valitse Sieppaa-kohdasta vähintään yksi asetus:
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Paneelien sijainnit

Pikanäppäimet

Valikot tai Valikoiden mukauttaminen

Huomautus:

Alkuun

Tallentaa paneelien nykyiset sijainnit (vain InDesign).

Tallentaa käytössä olevan pikanäppäinryhmän (vain Photoshop).

Tallentaa käytössä olevan valikkoryhmän.

Eri työtilojen näyttäminen tai työtilasta toiseen siirtyminen

Valitse sovelluspalkin työtilanvaihtajasta työtila.

Photoshopissa voit määrittää kullekin työtilalle pikanäppäimen, jonka avulla työtilojen välillä siirtyminen on helppoa.

Mukautetun työtilan poistaminen

Valitse sovelluspalkin työtilanvaihtajasta Hallitse työtiloja, valitse työtila ja valitse sitten Poista. (Vaihtoehto ei ole käytettävissä Fireworksissä.)

(Photoshop, InDesign, InCopy) Valitse työtilanvaihtajasta Poista työtila.

(Illustrator) Valitse Ikkuna > Työtila > Hallitse työtiloja, valitse työtila ja napsauta sitten Poista-kuvaketta.

(Photoshop, InDesign) Valitse Ikkuna > Työtila > Poista työtila, valitse työtila ja napsauta sitten Poista-kuvaketta.

Oletusarvoisen työtilan palauttaminen

1. Valitse Oletusarvoinen- tai Olennaiset-työtila sovelluspalkin työtilanvaihtajasta. Fireworks-lisätietoja on artikkelissa
http://www.adobe.com/devnet/fireworks/articles/workspace_manager_panel.html.

Dreamweaverin oletusarvoinen työtila on Designer.

2. Poista Fireworksissa (Windows) seuraavat kansiot:

Windows Vista

\\Käyttäjät\<käyttäjänimi>\AppData\Roaming\Adobe\Fireworks CS4\

Windows XP

\\Documents and Settings\<käyttäjänimi>\Application Data\Adobe\Fireworks CS4

3. (Photoshop, InDesign, InCopy) Valitse Ikkuna > Työtila > Palauta [työtilan nimi].

(Photoshop) Palauta tallennettu työtilajärjestys

Photoshopissa työtilat ilmestyvät automaattisesti samassa järjestyksessä, mihin ne viimeksi järjestit, mutta voit palauttaa paneelien alkuperäisen
tallennetun järjestyksen.

Jos haluat palauttaa yksittäisen työtilan, valitse Ikkuna > Työtila > Palauta työtilan nimi.

Jos haluat palauttaa kaikki Photoshopin mukana asennetut työtilat, valitse Käyttöliittymän asetuksissa Palauta oletusarvoiset työtilat.

Voit järjestää sovelluspalkin työtilat uudelleen vetämällä niitä.

Tietoja näyttötiloista

Voit muuttaa julkaisuikkunan näkyvyyttä työkalupaneelin alareunassa olevilla Tila-painikkeilla tai valitsemalla komentoja Näytä > Näyttötila -
valikosta. Kun työkalupaneeli näkyy yhtenä sarakkeena, voit valita näyttötiloja napsauttamalla nykyisen tilan painiketta ja valitsemalla avautuvasta
valikosta toisen tilan.
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Normaalitila 

Esikatselutila 

Leikkausvaratila 

Informaatioaluetila 

Esitystila 

Alkuun

Alkuun

Näyttää kuvan vakioikkunassa niin, että kaikki näkyvät ruudukot ja apuviivat sekä tulostumattomat kohteet näkyvät ja että ikkunassa
on valkoinen taittopöytä.

Näyttää kuvan tulostettuna niin, että tulostumattomat elementit (ruudukot, apuviivat ja tulostumattomat objektit) eivät näy ja
taittopöydän väriksi on määritetty Asetukset-valikosta valittu esikatselun taustaväri.

Näyttää kuvan niin, että tulostumattomat elementit (ruudukot, apuviivat ja tulostumattomat objektit) eivät näy, taittopöydän
väriksi on määritetty Asetukset-valikosta valittu esikatselun taustaväri ja kaikki julkaisun leikkausvara-alueella olevat tulostuselementit (määritetty
kohdassa Julkaisun asetukset) näkyvät.

Näyttää kuvan tulostettuna niin, että tulostumattomat elementit (ruudukot, apuviivat ja tulostumattomat objektit) eivät näy,
taittopöydän väriksi on määritetty Asetukset-valikossa valittuna oleva esikatselun taustaväri ja kaikki julkaisun informaatioalueella olevat
tulostuselementit (määritetty kohdassaJulkaisun asetukset) näkyvät.

Näyttää kuvat kuin ne olisivat diaesitys, ilman valikoita, paneeleja tai työkaluja. Katso Esitystilan käyttäminen.

Tilarivin käyttäminen

Tilarivi (julkaisuikkunan vasemmassa alakulmassa) näyttää tiedoston tilan ja sen avulla voidaan vaihtaa sivua. Tee jokin seuraavista
napsauttamalla tilarivivalikkoa:

Valitse nykyinen tiedosto tiedostojärjestelmästä valitsemalla Näytä Resurssienhallinnassa (Windows®) tai Näytä Finderissa (Mac OS®).

Näytä nykyinen tiedosto Adobe® Bridgessä® valitsemalla Näytä Bridgessä.

Näytä nykyinen tiedosto Adobe Mini Bridgessä valitsemalla Näytä Mini Bridgessä.

Mac OS -käyttöjärjestelmässä voit näyttää suurennuskertoimen tilarivillä piilottamalla sovelluspalkin (Ikkuna > Sovelluspalkki). Windowsissa et
voi piilottaa sovelluspalkkia.

Ohjauspaneelin yleiskuvaus

Ohjauspaneelin avulla (Ikkuna > Ohjaus) voit käyttää nopeasti nykyiseen sivukohteeseen tai valittuihin objekteihin liittyviä asetuksia, komentoja ja
muita paneeleja. Ohjauspaneeli on normaalisti kiinnitetty julkaisuikkunan yläreunaan. Voit kiinnittää sen myös ikkunan alareunaan, muuttaa sen
kelluvaksi paneeliksi tai kätkeä sen kokonaan.

Ohjauspaneelissa näkyvät asetukset vaihtelevat valitun objektin tyypin mukaan:

Kun esimerkiksi valitaan kehys, Ohjauspaneelissa on kehyksen koon ja sijainnin muuttamiseen, kallistamiseen ja kiertämiseen liittyviä
asetuksia.

Kun valitaan teksti kehyksen sisältä, Ohjauspaneeli näyttää merkki- tai kappaleasetukset. Voit Ohjauspaneelin vasemmassa reunassa olevia
kappale- tai merkkikuvakkeita napsauttamalla valita, näkyvätkö merkki- vai kappaleasetukset. Ohjauspaneeli sisältää lisäasetuksia, jos näytön
koko ja resoluutio tämän sallivat. Jos esimerkiksi merkkikuvake on valittu, kaikki merkkiasetukset näkyvät ja Ohjauspaneelin oikeassa
reunassa näkyy osa kappaleasetuksista. Jos napsautat kappalekuvaketta, kaikki kappaleasetukset näkyvät ja oikealla näkyy osa
merkkiasetuksista.

Kun valitaan taulukon solu, Ohjauspaneeli näyttää asetuksia, joilla muutetaan rivien ja sarakkeiden mittoja, yhdistetään soluja, tasataan
tekstiä ja lisätään viivoja.
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Alkuun

Alkuun

Koska Ohjauspaneelin asetukset ovat tilannekohtaisia, saat lisätietoja kustakin asetuksesta työkaluvihjeestä eli kuvauksesta, joka tulee näkyviin,
kun osoitin siirretään kuvakkeen tai asetuksen nimen kohdalle.

Ohjauspaneeli, jossa näkyy työkaluvihje

Ohjauspaneelin valikko

Jos haluat avata Ohjauspaneelin kuvakkeeseen liittyvän valintaikkunan, Alt-napsauta (Windows) tai optio-osoita (Mac OS) kuvaketta. Kun
esimerkiksi kehys on valittu, voit avata Kierrä-valintaikkunan Alt-napsauttamalla tai optio-osoittamalla Kiertokulma-kuvaketta .

Paneelin valikon näyttäminen

Napsauta Ohjauspaneelin oikealla puolella olevaa kuvaketta .

Ohjauspaneelin muuttaminen kiinnitetyksi tai kelluvaksi

Tee jokin seuraavista:

Vedä Ohjauspaneelin vasemmassa reunassa olevaa pystypalkkia, kunnes työkalupaneeli kiinnittyy sovellusikkunan (Windows) tai näytön
(Mac OS) ylä- tai alareunaan.

Valitse Ohjauspaneelin valikosta Kiinnitä ylös, Kiinnitä alas tai Kelluva.

Mukauta Ohjauspaneeli

1. Valitse Mukauta Ohjauspaneelivalikosta, joka on Ohjauspaneelin oikealla puolella.

2. Valitse vaihtoehdot, jotka haluat piilottaa tai näyttää ja napsauta sitten OK.

Tietoja Navigaattori-paneelista

Jos tunnet InDesignin aikaisempia versioita, saatat ihmetellä missä Navigaattori-paneeli on. Navigaattori-paneelia ei ole InDesign CS5:ssä.
Tehokas zoomaus -ominaisuus korvaa Navigaattori-paneelin. Katso Tehokkaan zoomauksen käyttäminen.

Pikavalikkojen käyttäminen

Toisin kuin näytön yläreunassa olevat valikot, pikavalikoissa on aktiiviseen työkaluun tai valintaan liittyviä komentoja. Pikavalikoiden avulla voit
valita nopeasti usein käytettyjä komentoja.
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Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Huomautus:

Alkuun

Työkaluvihjeet

Näytä miniatyyrikuvat sijoitettuina

Näytä muunnosarvot

Ota Multi-Touch Gestures -toiminto käyttöön

Korosta valintatyökalun alla oleva objekti

Kelluva työkalupaneeli

Kutista kuvakepaneelit automaattisesti

Näytä kätketyt paneelit automaattisesti

Avaa julkaisut välilehtinä

Salli kelluvien julkaisuikkunoiden kiinnitys

Käsityökalu

Näytöllä oleva piirros

1. Siirrä osoitin julkaisun, objektin tai paneelin päälle.

2. Napsauta hiiren kakkospainiketta.

(Mac OS) jos käyttämässäsi hiiressä ei ole kahta painiketta, saat pikavalikon näkyviin painamalla Ctrl-näppäintä osoittaessasi.

Käyttöliittymän asetusten muuttaminen

1. Valitse Muokkaa > Asetukset > Liittymä (Windows) tai InDesign > Asetukset > Liittymä (Mac OS).

2. Valitse asetukset, jotka haluat määrittää, ja valitse sitten OK.

Työkaluvihjeet näkyvät näytössä, kun asetat hiiren osoittimet liittymäkohteiden, kuten työkalurivin työkalujen ja ohjauspaneelin
asetusten, päälle. Poista työkaluvihjeet käytöstä valitsemalla Ei mitään.

Kun sijoitat grafiikan, kuvan miniatyyrikuva näkyy ladatussa grafiikkakohdistimessa. Vastaavasti
ensimmäisten tekstirivien miniatyyrikuva näkyy ladatussa tekstikohdistimessa. Poista tämän asetuksen valinta, jos et haluat miniatyyrikuvien
näkyvän grafiikkaa tai tekstiä sijoitettaessa.

Kun luot objektia tai muutat sen kokoa tai kierrät sitä, kohdistin näyttää [x,y]-koordinaatit, leveyden ja korkeuden tai
kiertotiedot.

Valitse tämä asetus, jos haluat Windowsin ja Mac OS:n Multi-Touch Gestures -toimintojen
toimivat InDesignissa. Jos käytät esimerkiksi Mac OS:n Magic Mousea, pyyhkäisytoiminto vierittää ylös tai alas tai siirtyy edelliselle tai seuraavalle
sivulle ja kiertotoiminto kiertää aukeamaa.

Valitse tämä asetus, jos haluat korostaa objektien kehysten reunat, kun suoravalintatyökalu siirretään
niiden päälle.

Määritä, näkyykö työkalurivi yhtenä sarakkeena, kahtena sarakkeena vai yhtenä rivinä.

Kun asetus on valittu, julkaisun ikkunan napsauttaminen sulkee avoimen paneelin automaattisesti.

Kun piilotat paneeleja painamalla sarkainta, hiiren osoittimen pitäminen julkaisuikkunan sivussa näyttää
paneelit tilapäisesti, jos tämä asetus on valittu. Jos tätä asetusta ei ole valittu, tuo paneelit näkyviin painamalla sarkainnäppäintä uudelleen.

Kun tämän asetuksen valinta on poistettu, luomasi tai avaamasi julkaisut näytetään kelluvina ikkunoina eikä välilehtiä
sisältävinä ikkunoina.

Jos tämä asetus on valittu, voit kiinnittää kelluvia julkaisuikkunoita toisiinsa välilehdellisiksi
ikkunoiksi. Jos tätä asetusta ei ole valittu, kelluvat julkaisuikkunat eivät kiinnity muihin julkaisuikkunoihin, paitsi jos pidät Ctrl-painiketta (Windows)
tai Komento-painiketta (Mac OS) painettuna vetäessäsi.

Voit määrittää, näytetäänkö teksti ja kuvat metatekstinä julkaisua vieritettäessä, kun vedät käsityökalun liukusäätimen haluamasi
suorituskyky–laatu-suhteen kohdalle.

Valitse asetus, joka määrittää piirretäänkö kuva uudelleen, kun vedät objektia. Jos valitset Heti, kuva piirretään uudelleen
sitä vedettäessä. Jos valitset Ei koskaan, kuvan vetäminen siirtää vain kehystä ja kuva siirtyy sitten, kun vapautat hiiren painikkeen. Jos valitset
Viivästetysti, kuva piirretään uudelleen vain jos pidät tauon, ennen kuin vedät. Viivästetysti tarjoaa saman toiminnallisuuden kuin InDesign CS4:ssä.

Lisää ohjeaiheita
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Oletuspikanäppäimet

Alkuun

Alkuun

Vuorovaikutteinen pikanäppäinopas
Työkalujen näppäimet
Kohteiden valinta- ja siirtonäppäimet
Objektien muuntonäppäimet
Reittien ja kehysten muokkausnäppäimet
Taulukoiden näppäimet
Tekstin etsimiseen ja muuttamiseen käytettävät näppäimet
Tekstin käsittelemisessä käytettävät näppäimet
Tekstin selaamisessa ja valitsemisessa käytettävät näppäimet
Julkaisujen ja niiden työtilojen katselussa käytettävät näppäimet
XML:n käsittelemisessä käytettävät näppäimet
Hakemistonäppäimet
Paneelinäppäimet
Ohjauspaneelin näppäimet
Paneelien ja valintaikkunoiden näppäimet
Merkki- ja kappaletyylien näppäimet
Sarkaimet-paneelin näppäimet
Tasot-paneelin näppäimet
Sivut-paneelin näppäimet
Väri-paneelin näppäimet
Erottelujen esikatselupaneelin käyttönäppäimet
Värimallit-paneelin näppäimet
Muunnos-paneelin näppäimet
Mac OS 10.3x:n ja 10.4:n välisten ristiriitojen ratkaisemisessa käytettävät näppäimet

Adobe InDesign CS5:ssä on monenlaisia pikanäppäimiä, jotka auttavat käsittelemään julkaisuja nopeasti ilman hiirtä. Useat pikanäppäimet ovat
valikoissa komentojen nimien vieressä. Voit käyttää InDesignin oletuspikanäppäinjoukkoa, QuarkXPress 4.0:n tai Adobe PageMaker 7.0:n
pikanäppäinjoukkoa tai itse luomaasi pikanäppäinjoukkoa. Voit jakaa pikanäppäinjoukkoja muiden saman käyttöympäristön InDesign-käyttäjien
kanssa.

InDesignissa on monenlaisia pikanäppäimiä, jotka auttavat käsittelemään julkaisuja nopeasti ilman hiirtä. Useat pikanäppäimet ovat valikoissa
komentojen nimien vieressä. Voit käyttää InDesignin oletuspikanäppäinyhdistelmää tai itse luomaasi pikanäppäinyhdistelmää. Voit jakaa
pikanäppäinjoukkoja muiden saman käyttöympäristön InDesign-käyttäjien kanssa.

Vuorovaikutteinen pikanäppäinopas

Työkalujen näppäimet

Voit luoda nykyisen pikanäppäinluettelon valitsemalla Pikanäppäimet-valintaikkunasta Näytä yhdistelmä. Tästä asetuksesta on hyötyä varsinkin
tulostettaessa mukautettujen pikanäppäinten kopiota.

Vuorovaikutteinen pikanäppäinopas, jonka
avulla löydät pikanäppäimet helposti.
Tarkastele verkossa tai lataa AIR-
sovelluksena.... Lue lisää

http://goo.gl/80wvo

tekijä: Marijan Tompa 
http://tomaxxi.com/

Jaa asiantuntemustasi
Adobe Community Help
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Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Valitse Ikkuna > Apuohjelmat > Työkaluvihjeet ja valitse sitten työkalu, jos haluat nähdä sen pikanäppäimet ja muokkausnäppäimet.

Työkalu Windows Mac OS

Valintatyökalu V, Esc V, Esc

Suoravalintatyökalu A A

Vuorottelu valinta- ja
suoravalintatyökalun välillä

Ctrl+sarkain Komento+Control+sarkain

Sivutyökalu Vaihto+P Vaihto+P

Välityökalu U U

Kynätyökalu P P

Tukipisteen lisäystyökalu = =

Tukipisteen lisäystyökalu = = (numeronäppäimistössä)

Tukipisteen poistotyökalu - -

Tukipisteen poistotyökalu -

Suuntapisteen muuntotyökalu Vaihto+C Vaihto+C

Tekstityökalu T T

Reittitekstityökalu Vaihto+T Vaihto+T

Lyijykynätyökalu (huomautustyökalu) N N

Viivatyökalu* \ \

Suorakulmiokehystyökalu F F

Suorakulmiotyökalu M M

Ellipsityökalu L L

Kiertotyökalu R R

Skaalaustyökalu S S

Kallistustyökalu O O

Vapaa muunto -työkalu E E

Pipettityökalu I I

Mittatyökalu K K

Liukuvärityökalu H H

Saksityökalu C C

Käsityökalu H H

Käsityökalun valinta tilapäisesti Välinäppäin (asettelutila), Alt (tekstitila)
tai Alt+välinäppäin (molemmat)

Välinäppäin (asettelutila), optio
(tekstitila) tai optio+välinäppäin
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Alkuun

Kohteiden valinta- ja siirtonäppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

(molemmat)

Zoomaustyökalu Z Z

Lähentämistyökalun valinta tilapäisesti Ctrl+välinäppäin Komento+välinäppäin

Täytön ja viivan vuorottelu X X

Täytön ja viivan vaihtaminen Vaihto+X Vaihto+X

Vuorottelu Muotoilu vaikuttaa säilöön-
ja Muotoilu vaikuttaa tekstiin -
asetusten välillä

J J

Ota käyttöön väri , [pilkku] , [pilkku]

Liukuvärin käyttäminen . [piste] . [piste]

Väriä ei käytetä / /

Vuorottelu normaalin näyttötilan ja
esikatselutilan välillä

V V

Kehysruudukkotyökalu (vaaka) Y Y

Kehysruudukkotyökalu (pysty) Q Q

Liukuväripehmennystyökalu Vaihto+G Vaihto+G

Toiminto Windows Mac OS

Valinta- tai suoravalintatyökalun
(viimeksi käytetty) valinta tilapäisesti

Mikä tahansa työkalu (ei
valintatyökalut)+Ctrl

Mikä tahansa työkalu (ei
valintatyökalut)+komento

Ryhmävalintatyökalun valinta
tilapäisesti

Suoravalintatyökalu+Alt tai kynä-, lisää
ankkuripiste- tai poista ankkuripiste -
työkalu+Alt+Ctrl

Suoravalintatyökalu+optio tai kynä-,
lisää ankkuripiste- tai poista
ankkuripiste -työkalu+optio+komento

Valitse valitun sisällön säilö Esc tai kaksoisnapsautus Esc tai kaksoisnapsautus

Valitse valitun säilön sisältö Vaihto+Esc tai kaksoisnapsautus Vaihto+Esc tai kaksoisnapsautus

Lisääminen usean objektin valinnasta
tai vähentäminen siitä

Valinta-, suoravalinta- tai
ryhmävalintatyökalu+vaihto-osoita
(poista valinta osoittamalla
keskipistettä)

Valinta-, suoravalinta- tai
ryhmävalintatyökalu+vaihto-osoita
(poista valinta osoittamalla
keskipistettä)

Valinnan monistaminen Valinta-, suoravalinta- tai
ryhmävalintatyökalu+Alt-vedä*

Valinta-, suoravalinta- tai
ryhmävalintatyökalu+optio-vedä*

Valinnan monistaminen ja siirtäminen Alt+vasen, oikea, ylä- tai
alanuolinäppäin

Optio+vasen, oikea, ylä- tai
alanuolinäppäin

Valinnan monistaminen tai siirtäminen
10 kertaa**

Alt+vaihto+vasen, oikea, ylä- tai
alanuolinäppäin

Optio+vaihto+vasen, oikea, ylä- tai
alanuolinäppäin
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Alkuun

Objektien muuntonäppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Valinnan siirtäminen** Vasen, oikea, ylä- tai alanuolinäppäin Vasen, oikea, ylä- tai alanuolinäppäin

Valinnan siirtäminen
kymmenesosalla**

Ctrl+vaihto+vasen, oikea, ylä- tai
alanuolinäppäin

Komento+vaihto+vasen, oikea, ylä- tai
alanuolinäppäin

Valinnan siirtäminen 10 kertaa** Vaihto+vasen, oikea, ylä- tai
alanuolinäppäin

Vaihto+vasen, oikea, ylä- tai
alanuolinäppäin

Sivupohjakohteen valitseminen
julkaisun sivulta

Valinta- tai
suoravalintatyökalu+Ctrl+vaihto-
napsauta

Valinta- tai
suoravalintatyökalu+komento+vaihto-
osoita

Seuraavan takana tai edessä olevan
objektin valinta

Valintatyökalu+Ctrl-napsauta tai
valintatyökalu+Alt+Ctrl-napsauta

Valintatyökalu+komento-osoita tai
valintatyökalu+optio+komento-osoita

Seuraavan jutun tai edellisen
kehyksen valinta

Alt+Ctrl+Page Down/ Alt+Ctrl+Page
Up

Optio+komento+Page Down/
optio+komento+Page Up

Jutun ensimmäisen tai viimeisen
kehyksen valinta

Vaihto+Ctrl+Page Down/
vaihto+Ctrl+Page Up

Vaihto+optio+komento+Page Down/
vaihto+optio+komento+Page Up

*Rajoita liike 45 asteen kulmiin painamalla vaihtonäppäintä.

**Määrä määritetään valitsemalla Muokkaa > Asetukset > Yksiköt ja lisäykset (Windows) tai InDesign > Asetukset > Yksiköt ja
lisäykset (Mac OS).

Toiminto Windows Mac OS

Monista tai muunna valinta Muunnostyökalu+Alt-vedä* Muunnostyökalu+optio-vedä*

Näytä muunnostyökalun valintaikkuna Valitse objekti+kaksoisnapsauta
skaalaus-, kierto- tai kallistustyökalua
työkalupaneelissa

Valitse objekti+kaksoisnapsauta
skaalaus-, kierto- tai kallistustyökalua
työkalupaneelissa

Pienennä skaalaa 1 % Ctrl+, Komento+,

Pienennä skaalaa 5 % Ctrl+Alt+, Komento+optio+,

Suurenna skaalaa 1 % Ctrl+. Komento+.

Suurenna skaalaa 5 % Ctrl+Alt+. Komento+optio+.

Muuta kehyksen ja sisällön kokoa Valintatyökalu+Ctrl-vedä Valintatyökalu+komento-vedä

Muuta kehyksen ja sisällön kokoa
säilyttäen mittasuhteet

Valintatyökalu+vaihto+Ctrl-vedä Valintatyökalu+vaihto+komento-vedä

Pakota mittasuhteet Ellipsi-, monikulmio- tai
suorakulmiotyökalu+vaihto-vedä

Ellipsi-, monikulmio- tai
suorakulmiotyökalu+vaihto-vedä

Vaihda kuva laadukkaasta näytöstä
nopeaksi näytöksi

Ctrl+Alt+vaihto+Z Komento+optio+vaihto+Z

*Kun olet valinnut muunnostyökalun, pidä hiiren painiketta painettuna. Pidä sitten Alt- (Windows) tai optionäppäintä (Mac OS)
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Alkuun

Alkuun

Reittien ja kehysten muokkausnäppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Taulukoiden näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

painettuna ja vedä. Rajoita liike 45 asteen kulmiin painamalla vaihtonäppäintä.

Toiminto Windows Mac OS

Valitse tilapäisesti muunna suuntapiste
-työkalu

Suoravalintatyökalu+Alt+Ctrl tai
kynätyökalu+Alt

Suoravalintatyökalu+optio+komento tai
kynätyökalu+optio

Vuorottele tilapäisesti lisää
ankkuripiste- ja poista ankkuripiste -
työkalua

Alt Optio

Valitse tilapäisesti lisää ankkuripiste -
työkalu

Saksityökalu+Alt Saksityökalu+optio

Pidä kynätyökalu valittuna, kun osoitin
on reitin tai ankkuripisteen päällä

Kynätyökalu+vaihto Kynätyökalu+vaihto

Siirrä ankkuripistettä ja kahvoja
piirtämisen aikana

Kynätyökalu+välinäppäin Kynätyökalu+välinäppäin

Näytä Viiva-paneeli F10 Komento+F10

Toiminto Windows Mac OS

Lisää tai poista rivejä tai sarakkeita
vetämisen aikana

Aloita rivin tai sarakkeen reunan
vetäminen ja pidä sitten vetäessäsi
Alt-näppäintä alhaalla

Aloita rivin tai sarakkeen reunan
vetäminen ja pidä sitten vetäessäsi
optionäppäintä alhaalla

Muuta rivien tai sarakkeiden kokoa
taulukon kokoa muuttamatta

Vedä sisäriviä tai sarakkeen reunaa
vaihtonäppäin painettuna

Vedä sisäriviä tai sarakkeen reunaa
vaihtonäppäin painettuna

Rivien tai sarakkeiden koon
muuttaminen oikeassa suhteessa

Vedä taulukon oikeaa tai alareunaa
vaihtonäppäin painettuna

Vedä taulukon oikeaa tai alareunaa
vaihtonäppäin painettuna

Siirry seuraavaan tai edelliseen soluun Sarkain/vaihto+sarkain Sarkain/vaihto+sarkain

Siirry sarakkeen ensimmäiseen tai
viimeiseen soluun

Alt+Page Up/ Alt+Page Down Optio+Page Up/ optio+Page Down

Siirry rivin ensimmäiseen tai
viimeiseen soluun

Alt+Home/ Alt+End Optio+Home/ optio+End

Siirrä kehyksen ensimmäiselle tai
viimeiselle riville

Page Up/Page Down Page Up/Page Down
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Alkuun

Alkuun

Tekstin etsimiseen ja muuttamiseen käytettävät näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Tekstin käsittelemisessä käytettävät näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Siirry ylös tai alas yksi solu Ylä-/alanuolinäppäin Ylä-/alanuolinäppäin

Siirry vasemmalle tai oikealle yksi solu Vasen/oikea nuolinäppäin Vasen/oikea nuolinäppäin

Valitse nykyisen solun ylä- tai
alapuolella oleva solu

Vaihto+ylänuolinäppäin/
vaihto+alanuolinäppäin

Vaihto+ylänuolinäppäin/
vaihto+alanuolinäppäin

Valitse nykyisen solun oikealla tai
vasemmalla puolella oleva solu

Vaihto+oikea nuolinäppäin/
vaihto+vasen nuolinäppäin

Vaihto+oikea nuolinäppäin/
vaihto+vasen nuolinäppäin

Aloita rivi seuraavasta sarakkeesta Enter (numeronäppäimistö) Enter (numeronäppäimistö)

Aloita rivi seuraavasta kehyksestä Vaihto+Enter (numeronäppäimistö) Vaihto+Enter (numeronäppäimistö)

Vuorottele tekstivalinnan ja
soluvalinnan välillä

Esc Esc

Toiminto Windows Mac OS

Lisää valittu teksti Etsittävä-ruutuun Ctrl+F1 Komento+F1

Lisää valittu teksti Etsittävä-ruutuun ja
etsi seuraava

Vaihto+F1 Vaihto+F1

Etsi seuraava Etsittävä-tekstin
esiintymä

Vaihto+F2 tai Alt+Ctrl+F Vaihto+F2 tai optio+komento+F

Lisää valittu teksti Korvaava-ruutuun Ctrl+F2 Komento+F2

Vaihda valinta korvaavaan tekstiin Ctrl+F3 Komento+F3

Toiminto Windows Mac OS

Lihavointi (vain lihavoidut kirjasimet) Vaihto+Ctrl+B Vaihto+komento+B

Kursivoitu (vain kursivoidut kirjasimet) Vaihto+Ctrl+I Vaihto+komento+I

Normaali Vaihto+Ctrl+Y Vaihto+komento+Y

Alleviivaus Vaihto+Ctrl+U Vaihto+komento+U

Yliviivaus Vaihto+Ctrl+¨ Control+vaihto+komento+/
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Isot kirjaimet (käytössä / ei käytössä) Vaihto+Ctrl+K Vaihto+komento+K

Aasialaisten kielten tavutus Vaihto+Ctrl+K Vaihto+komento+K

Kapiteelikirjaimet (käytössä / ei
käytössä)

Vaihto+Ctrl+H Vaihto+komento+H

Tate-chu-yoko-asetus Vaihto+Ctrl+H Vaihto+komento+H

Yläindeksi Vaihto+Ctrl+(+) [plusmerkki] Vaihto+komento+(+) [plusmerkki]

Alaindeksi Vaihto+Alt+Ctrl+(+) [plusmerkki] Vaihto+optio+komento+(+) [plusmerkki]

Palauta vaaka- tai pystyskaalaus
arvoon 100 %

Vaihto+Ctrl+X tai vaihto+Alt+Ctrl+X Vaihto+komento+X tai
vaihto+optio+komento+X

Peruskirjainten ryhmäasetus tai
yksityiskohta-asetus

Vaihto+Ctrl+X tai vaihto+Alt+Ctrl+X Vaihto+komento+X tai
vaihto+optio+komento+X

Tasaa vasemmalle tai oikealle tai
keskitä

Vaihto+Ctrl+L, R tai C Vaihto+komento+L, R tai C

Pakota tasapalstaan Vaihto+Ctrl+F (kaikki rivit) tai J (kaikki
paitsi viimeinen rivi)

Vaihto+komento+F (kaikki rivit) tai J
(kaikki paitsi viimeinen rivi)

Tasaa molemmat päät tai tasainen
välistys

Vaihto+Ctrl+F (tasaa molemmat päät)
tai J (tasainen välistys)

Vaihto+komento+F (tasaa molemmat
päät) tai J (tasainen välistys)

Suurenna tai pienennä pistekokoa* Vaihto+Ctrl+> tai < Vaihto+komento+> tai <

Suurenna tai pienennä pistekokoa
viisinkertaiseksi*

Vaihto+Ctrl+Alt+> tai < Vaihto+komento+optio+> tai <

Suurenna tai pienennä rivivälistystä
(vaakateksti)*

Alt+ylänuolinäppäin/
alt+alanuolinäppäin

Optio+ylänuolinäppäin/
optio+alanuolinäppäin

Suurenna tai pienennä rivivälistystä
(pystyteksti)*

Alt+oikea nuolinäppäin/ Alt+vasen
nuolinäppäin

Optio+oikea nuolinäppäin/ optio+vasen
nuolinäppäin

Suurenna tai pienennä rivivälistystä
viisinkertaiseksi (vaakateksti)*

Alt+Ctrl+ylänuolinäppäin/
Alt+Ctrl+alanuolinäppäin

Optio+komento+ylänuolinäppäin/
optio+komento+alanuolinäppäin

Suurenna tai pienennä rivivälistystä
viisinkertaiseksi (pystyteksti)*

Alt+Ctrl+oikea nuolinäppäin/
Alt+Ctrl+vasen nuolinäppäin

Optio+komento+oikea nuolinäppäin/
optio+komento+vasen nuolinäppäin

Automaattinen rivivälistys Vaihto+Alt+Ctrl+A Vaihto+optio+komento+A

Tasaa ruudukkoon (käytössä / ei
käytössä)

Vaihto+Alt+Ctrl+G Vaihto+optio+komento+G

Automaattinen tavutus (käytössä / ei
käytössä)

Vaihto+Alt+Ctrl+H Vaihto+optio+komento+H

Suurenna tai pienennä parivälistystä ja
merkkiväliä (vaakateksti)

Alt+vasen nuolinäppäin/ Alt+oikea
nuolinäppäin

Optio+vasen nuolinäppäin/ optio+oikea
nuolinäppäin

Suurenna tai pienennä parivälistystä ja
merkkiväliä (pystyteksti)

Alt+ylänuolinäppäin/
alt+alanuolinäppäin

Optio+ylänuolinäppäin/
optio+alanuolinäppäin

Suurenna tai pienennä parivälistystä ja
merkkiväliä viisinkertaisesti
(vaakateksti)

Alt+Ctrl+vasen nuolinäppäin/
Alt+Ctrl+oikea nuolinäppäin

Optio+komento+vasen nuolinäppäin/
optio+komento+oikea nuolinäppäin

Suurenna tai pienennä parivälistystä ja
merkkiväliä viisinkertaisesti

Alt+Ctrl+ylänuolinäppäin/
Alt+Ctrl+alanuolinäppäin

Optio+komento+ylänuolinäppäin/
optio+komento+alanuolinäppäin
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Tekstin selaamisessa ja valitsemisessa käytettävät näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

(pystyteksti)

Suurenna parivälistystä sanojen
välillä*

Alt+Ctrl+\ Optio+komento+\

Pienennä parivälistystä sanojen välillä* Alt+Ctrl+askelpalautin Optio+komento+Delete

Poista manuaalinen parivälistys ja
palauta merkkivälin arvoksi 0

Alt+Ctrl+Q Optio+komento+Q

Suurenna tai pienennä perusviivan
siirtoa** (vaakateksti)

Vaihto+Alt+ylänuolinäppäin/
vaihto+Alt+alanuolinäppäin

Vaihto+optio+ylänuolinäppäin/
vaihto+optio+alanuolinäppäin

Suurenna tai pienennä perusviivan
siirtoa** (pystyteksti)

Vaihto+Alt+oikea nuolinäppäin/
vaihto+Alt+vasen nuolinäppäin

Vaihto+optio+oikea nuolinäppäin/
Vaihto+optio+vasen nuolinäppäin

Suurenna tai pienennä perusviivan
siirtoa viisinkertaisesti (vaakateksti)

Vaihto+Alt+Ctrl+ylänuolinäppäin/
vaihto+Alt+Ctrl+alanuolinäppäin

Vaihto+optio+komento+ylänuolinäppäi
n/
vaihto+optio+komento+alanuolinäppäin

Suurenna tai pienennä perusviivan
siirtoa viisinkertaisesti (pystyteksti)

Vaihto+Alt+Ctrl+oikea nuolinäppäin/
vaihto+Alt+Ctrl+vasen nuolinäppäin

Vaihto+optio+komento+oikea
nuolinäppäin/
vaihto+optio+komento+vasen
nuolinäppäin

Sijoita juttu automaattisesti Osoita ladatun tekstin kuvaketta
vaihtonäppäin painettuna

Osoita ladatun tekstin kuvaketta
vaihtonäppäin painettuna

Sijoita juttu puoliautomaattisesti Alt-napsauta ladatun tekstin kuvaketta Osoita ladatun tekstin kuvaketta
optionäppäin painettuna

Koosta kaikki jutut uudelleen Alt+Ctrl+/ Optio+komento+/

Lisää nykyinen sivunumero Alt+Ctrl+N Optio+komento+N

*Suurenna tai pienennä parivälistystä sanojen välillä viisinkertaisesti painamalla vaihtonäppäintä.

**Määrä määritetään valitsemalla Muokkaa > Asetukset > Yksiköt ja lisäykset (Windows) tai InDesign > Asetukset > Yksiköt ja
lisäykset (Mac OS).

Toiminto Windows-toiminto Mac OS -toiminto

Siirry oikealle tai vasemmalle yksi
merkki

Oikea/vasen nuolinäppäin Oikea/vasen nuolinäppäin

Siirry ylös- tai alaspäin yksi rivi Ylä-/alanuolinäppäin Ylä-/alanuolinäppäin

Siirry oikealle tai vasemmalle yksi
sana

Ctrl+oikea nuolinäppäin/ Ctrl+vasen
nuolinäppäin

Komento+oikea nuolinäppäin/
komento+vasen nuolinäppäin

Siirry rivin alkuun tai loppuun Home/End Home/End

Siirry edelliseen tai seuraavaan
kappaleeseen

Ctrl+ylänuolinäppäin/
Ctrl+alanuolinäppäin

Komento+ylänuolinäppäin/
komento+alanuolinäppäin
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Julkaisujen ja niiden työtilojen katselussa käytettävät näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Siirry jutun alkuun tai loppuun Ctrl+Home/ Ctrl+End Komento+Home/ komento+End

Valitse yksi sana Kaksoisosoita sanaa Kaksoisosoita sanaa

Valitse yksi merkki oikealta tai
vasemmalta

Vaihto+oikea nuolinäppäin/
vaihto+vasen nuolinäppäin

Vaihto+oikea nuolinäppäin/
vaihto+vasen nuolinäppäin

Valitse yksi rivi ylöspäin tai alaspäin Vaihto+ylänuolinäppäin/
vaihto+alanuolinäppäin

Vaihto+ylänuolinäppäin/
vaihto+alanuolinäppäin

Valitse rivin alku tai loppu Vaihto+Home/ vaihto+End Vaihto+Home/ vaihto+End

Valitse yksi kappale Napsauta kappaletta kolme tai neljä
kertaa Tekstiasetukset-valinnan
mukaan

Napsauta kappaletta kolme tai neljä
kertaa Tekstiasetukset-valinnan
mukaan

Valitse yksi kappale ennen tai jälkeen Vaihto+Ctrl+ylänuolinäppäin/
vaihto+Ctrl+alanuolinäppäin

Vaihto+komento+ylänuolinäppäin/
vaihto+komento+alanuolinäppäin

Valitse nykyinen rivi Vaihto+Ctrl+Å Vaihto+komento+Å

Valitse merkkejä kohdistimesta Napsauta vaihtonäppäin painettuna Napsauta vaihtonäppäin painettuna

Valitse jutun alku tai loppu Vaihto+Ctrl+Home/ vaihto+Ctrl+End Vaihto+komento+Home/
vaihto+komento+End

Valitse kaikki jutussa Ctrl+A Komento+A

Valitse ensimmäinen tai viimeinen
kehys

Vaihto+Alt+Ctrl+Page Up/
vaihto+Alt+Ctrl+Page Down

Vaihto+optio+komento+Page Up/
vaihto+optio+komento+Page Down

Valitse edellinen tai seuraava kehys Alt+Ctrl+Page Up/ Alt+Ctrl+Page
Down

Optio+komento+Page Up/
optio+komento+Page Down

Poista sana kohdistimen edestä
(juttueditori)

Ctrl+askelpalautin tai Delete Komento+Delete tai Del
(numeronäppäimistö)

Päivitä puuttuvien kirjasimien luettelo Ctrl+Alt+vaihto+/ Komento+optio+vaihto+/

Toiminto Windows Mac OS

Valitse tilapäisesti käsityökalu Välinäppäin (ei tekstikohdistinta), Alt-
vedä (tekstikohdistin) tai
Alt+välinäppäin (tekstitilassa ja ei-
tekstitilassa)

Välinäppäin (ei tekstikohdistinta),
optio-vedä (tekstikohdistin) tai
optio+välinäppäin (tekstitilassa ja ei-
tekstitilassa)

Valitse tilapäisesti lähentämistyökalu Ctrl+välinäppäin Komento+välinäppäin

Valitse tilapäisesti loitontamistyökalu Alt+Ctrl+välinäppäin tai
Alt+lähentämistyökalu

Optio+komento+välinäppäin tai
optio+lähentämistyökalu

Zoomaus 50 %, 200 % tai 400 % Ctrl+5, 2 tai 4 Komento+5, 2 tai 4

Päivitä näyttö Vaihto+F5 Vaihto+F5
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XML:n käsittelemisessä käytettävät näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Avaa uusi oletusjulkaisu Ctrl+Alt+N Komento+optio+N

Vuorottele nykyistä ja aikaisempaa
zoomaustasoa

Alt+Ctrl+2 Optio+komento+2

Vaihda seuraavaan tai edelliseen
julkaisuikkunaan

Ctrl+~ [aaltoviiva]/vaihto+Ctrl+F6 tai
Ctrl+vaihto+~ [aaltoviiva]

Ctrl+F6/vaihto+Ctrl+F6

Vieritä yksi näyttö ylös- tai alaspäin Page Up/Page Down Page Up/Page Down

Siirry takaisin- tai eteenpäin viimeksi
katsellulle sivulle

Ctrl+Page Up/ Ctrl+Page Down Komento+Page Up/ komento+Page
Down

Siirry edelliselle tai seuraavalle
aukeamalle

Alt+Page Up/ Alt+Page Down Optio+Page Up/ optio+Page Down

Sovita aukeama ikkunaan Kaksoisnapsauta käsityökalulla Kaksoisnapsauta käsityökalulla

Aktivoi Siirry-komento Ctrl+J Komento+J

Sovita valinta ikkunaan Ctrl+Alt+(+) [plusmerkki] Komento+optio+(+) [plusmerkki]

Koko objektin näyttäminen Ctrl+Alt+(+) [plusmerkki] Komento+optio+(+) [plusmerkki]

Siirry sivupohjaan, kun paneeli on
suljettu

Ctrl+J, kirjoita sivupohjan etuliite,
paina Enter-näppäintä

Komento+J, kirjoita sivupohjan etuliite,
paina Return-näppäintä

Selaa mittayksiköitä Vaihto+Alt+Ctrl+U Vaihto+optio+komento+U

Tartu viivainlinjojen lisäyksiin Vedä apuviivaa vaihtonäppäin
painettuna

Vedä apuviivaa vaihtonäppäin
painettuna

Vuorottele sivun ja aukeaman
apuviivoja (vain luonti)

Ctrl-vedä apuviivaa Komento-vedä apuviivaa

Poista kohdista kohteeseen
väliaikaisesti käytöstä tai ota se
väliaikaisesti käyttöön

Pidä Ctrl painettuna ja vedä objektia

Luo pysty- ja vaakaviivainlinjat
aukeamalle

Ctrl-vedä nollakohdasta Komento-vedä nollakohdasta

Valitse kaikki apuviivat Alt+Ctrl+G Optio+komento+G

Lukitse tai vapauta nollakohta Napsauta nollakohtaa hiiren
kakkospainikkeella ja valitse asetus

Control-osoita nollakohtaa ja valitse
asetus

Käytä nykyistä suurennusta uuden
viivan kynnyksen katselussa

Alt-vedä apuviivaa Optio-vedä apuviivaa

Valitse varoitusvalintaikkunoiden
painikkeita

Paina painikkeen nimen ensimmäistä
kirjainta, jos se on alleviivattu

Paina painikkeen nimen ensimmäistä
kirjainta

Näytä asennettujen laajennusten ja
InDesign-komponenttien luettelo

Ctrl+Ohje > Tietoja Designista Komento+InDesign-valikko > Tietoja
InDesignista
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Alkuun

Hakemistonäppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Paneelinäppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Toiminto Windows Mac OS

Laajenna tai kutista elementtiä Oikea/vasen nuolinäppäin Oikea/vasen nuolinäppäin

Kutista tai laajenna elementti ja
alemman tason elementit

Alt+oikea nuolinäppäin/ Alt+vasen
nuolinäppäin

Optio+oikea nuolinäppäin/ optio+vasen
nuolinäppäin

Laajenna XML-valintaa ylös tai alas Vaihto+ylänuolinäppäin/
vaihto+alanuolinäppäin

Vaihto+ylänuolinäppäin/
vaihto+alanuolinäppäin

Siirrä XML-valintaa ylös tai alas Ylä-/alanuolinäppäin Ylä-/alanuolinäppäin

Vieritä rakenneruutua yksi näyttö ylös-
tai alaspäin

Page Up/Page Down Page Up/Page Down

Valitse ensimmäinen tai viimeinen
XML-solmu

Home/End Home/End

Laajenna valinta ensimmäiseen tai
viimeiseen XML-solmuun

Vaihto+Home/ vaihto+End Vaihto+Home/ vaihto+End

Siirry edelliseen tai seuraavaan
vahvistusvirheeseen

Ctrl+vasen nuolinäppäin/ Ctrl+oikea
nuolinäppäin

Komento+vasen nuolinäppäin/
komento+oikea nuolinäppäin

Nimiöi automaattisesti tekstikehykset
ja taulukot

Ctrl+Alt+vaihto+F7 Komento+optio+vaihto+F7

Toiminto Windows Mac OS

Luo hakemistoviittaus ilman
valintaikkunaa

(vain aakkosnumeerinen)

Vaihto+Ctrl+Alt+Ö Vaihto+komento+optio+Ö

Avaa hakemistoviittausvalintaikkuna Ctrl+7 Komento+7

Luo hakemistoviittaus erisnimestä
(sukunimi, etunimi)

Vaihto+Ctrl+Alt+Ä Vaihto+komento+optio+Ä

Toiminto Windows Mac OS

Poista vahvistamatta Alt-napsauta Poista-kuvaketta Optio-osoita Poista-kuvaketta
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Ohjauspaneelin näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Luo kohde ja määritä asetukset Alt-napsauta Uusi-painiketta Optio-osoita Uusi-painiketta

Ota arvo käyttöön ja säilytä kohdistus
asetuksessa

Vaihto+Enter Vaihto+Enter

Aktivoi viimeksi käytetyn paneelin
viimeksi käytetty asetus

Ctrl+Alt+< Komento+optio+<

Valitse paneelista tyyli-, taso-, linkki-,
alue, värimalli- tai kirjasto-objektialue

Osoita vaihtonäppäin painettuna Osoita vaihtonäppäin painettuna

Valitse paneelista muita kuin
vierekkäisiä tyylejä, tasoja, linkkejä,
värimalleja tai kirjasto-objekteja

Ctrl-napsauta Komento-osoita

Ota arvo käyttöön ja valitse seuraava
arvo

Sarkain Sarkain

Siirrä kohdistus valittuun objektiin,
tekstiin tai ikkunaan

Esc Esc

Näytä tai kätke kaikki paneelit,
työkalupaneeli ja ohjauspaneeli (ei
kohdistinta)

Sarkain Sarkain

Näytä tai kätke kaikki paneelit paitsi
työkalupaneeli ja ohjauspaneeli
(kiinnitetty tai ei kiinnitetty)

Vaihto+sarkain Vaihto+sarkain

Avaa tai sulje kaikki kätketyt paneelit Ctrl+Alt+sarkain Komento+optio+sarkain

Kätke paneeliryhmä Alt-vedä paneelin välilehti (ryhmässä)
näytön reunaan

Optio-vedä paneelin välilehti
(ryhmässä) ikkunan reunaan

Valitse kohde nimen mukaan Alt+Ctrl-napsauta luetteloa ja valitse
kohde sitten nimen mukaan
näppäimistöllä

Optio+komento-osoita luetteloa ja
valitse kohde sitten nimen mukaan
näppäimistöllä

Avaa Heittovarjo-paneeli Alt+Ctrl+M Komento+optio+M

Toiminto Windows Mac OS

Siirrä kohdistus Ohjauspaneeliin tai
pois paneelista

Ctrl+6 Komento+6

Vuorottele merkkien ja kappaleiden
tekstimääritetilaa

Ctrl+Alt+7 Komento+optio+7

Muuta viitekohtaa, kun valitsin on
kohdistettu

Jokin numeronäppäimistön näppäin tai
näppäimistön numero

Jokin numeronäppäimistön näppäin tai
näppäimistön numero

Näytä valikko, jossa kohdistus on Alt+alanuoli

Yksiköt ja lisäykset -asetukset Alt-napsauta Parivälistys-kuvaketta Optio-osoita Parivälistys-kuvaketta
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Paneelien ja valintaikkunoiden näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Avaa Tekstikehyksen asetukset -
valintaikkuna

Alt-napsauta Sarakkeiden määrä -
kuvaketta

Optio-osoita Sarakkeiden määrä -
kuvaketta

Avaa Siirrä-valintaikkuna Alt-napsauta X- tai Y-kuvaketta Optio-osoita X- tai Y-kuvaketta

Avaa Kierrä-valintaikkuna Alt-napsauta Kulma-kuvaketta Optio-osoita Kulma-kuvaketta

Avaa Skaalaus-valintaikkuna Alt-napsauta X- tai Y-
skaalauskuvaketta

Optio-osoita X- tai Y-
skaalauskuvaketta

Avaa Kallista-valintaikkunaa Alt-napsauta Kallista-kuvaketta Optio-osoita Kallista-kuvaketta

Avaa Tekstiasetukset-valintaikkuna Alt-napsauta Yläindeksi-, Alaindeksi-
tai Kapiteeli-painiketta

Optio-osoita Yläindeksi-, Alaindeksi-
tai Kapiteeli-painiketta

Avaa Alleviivausasetukset-
valintaikkuna

Alt-napsauta Alleviivaus-painiketta Optio-osoita Alleviivaus-painiketta

Avaa Yliviivausasetukset-valintaikkuna Alt-napsauta Yliviivaus-painiketta Optio-osoita Yliviivaus-painiketta

Avaa Ruudukkoasetukset-
valintaikkuna

Alt-napsauta Tasaa rivirekisteriin- tai
Älä tasaa rivirekisteriin -painiketta

Optio-osoita Tasaa rivirekisteriin- tai
Älä tasaa rivirekisteriin -painiketta

Avaa Anfangit ja sisäkkäistyylit -
valintaikkuna

Alt-napsauta Anfangin rivimäärä- tai
Anfangin merkkien määrä -kuvaketta

Optio-osoita Anfangin rivimäärä- tai
Anfangin merkkien määrä -kuvaketta

Avaa Palstaan sovitus -valintaikkuna Alt-napsauta Rivivälistys-kuvaketta Optio-osoita Rivivälistys-kuvaketta

Avaa Nimetty ruudukko -valintaikkuna Kaksoisnapsauta Nimetty ruudukko -
kuvaketta

Kaksoisnapsauta Nimetty ruudukko -
kuvaketta

Avaa Uuden nimetyn ruudukon
asetukset -valintaikkuna

Alt-napsauta Nimetty ruudukko -
kuvaketta

Optio-osoita Nimetty ruudukko -
kuvaketta

Avaa Kehysruudukon asetukset -
valintaikkuna

Alt-napsauta Vaakasuuntaisten
merkkien määrä-, Pystysuuntaisten
merkkien määrä-, Aki-merkki-, Aki-
viiva-, Pystyskaalaus-,
Vaakaskaalaus-, Ruudukkonäkymä-,
Kirjasinkoko-, Sarakkeiden määrä- tai
Palstojen väli -kuvaketta

Optio-napsauta Vaakasuuntaisten
merkkien määrä-, Pystysuuntaisten
merkkien määrä-, Aki-merkki-, Aki-
viiva-, Pystyskaalaus-, Vaakaskaalaus-
, Ruudukkonäkymä-, Kirjasinkoko-,
Sarakkeiden määrä- tai Palstojen väli -
kuvaketta

Toiminto Windows Mac OS

Avaa Palstaan sovitus -valintaikkuna Alt+Ctrl+vaihto+J Optio+komento+vaihto+J

Avaa Kappaleviivat-valintaikkuna Alt+Ctrl+J Optio+komento+J

Avaa Pitoasetukset-valintaikkuna Alt+Ctrl+K Optio+komento+K

Aktivoi Merkki-paneeli Ctrl+T Komento+T

Aktivoi Kappale-paneeli Ctrl+Alt+T Komento+optio+T
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Alkuun

Alkuun

Merkki- ja kappaletyylien näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Sarkaimet-paneelin näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Tasot-paneelin näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Toiminto Windows Mac OS

Määritä merkkityylin kuvaus tekstiä
vastaavaksi

Valitse teksti ja paina
vaihto+Alt+Ctrl+C

Valitse teksti ja paina
vaihto+optio+komento+C

Määritä kappaletyylin kuvaus tekstiä
vastaavaksi

Valitse teksti ja paina
vaihto+Alt+Ctrl+R

Valitse teksti ja paina
vaihto+optio+komento+R

Muuta asetuksia käyttämättä tyyliä Vaihto+Alt+Ctrl-kaksoisnapsauta tyyliä Vaihto+optio+komento-kaksoisosoita
tyyliä

Poista tyyli ja paikallinen muotoilu Alt-napsauta kappaletyylin nimeä Optio-osoita kappaletyylin nimeä

Poista ohitukset kappaletyylistä Alt+vaihto-napsauta kappaletyylin
nimeä

Optio+vaihto-osoita kappaletyylin
nimeä

Näytä tai kätke Kappaletyylit- tai
Merkkityylit-paneeli

F11, vaihto+F11 Komento+F11, komento+vaihto+F11

Toiminto Windows Mac OS

Aktivoi Sarkaimet-paneeli Vaihto+Ctrl+T Vaihto+komento+T

Vuorottele tasausasetuksia Alt-napsauta sarkainta Optio-osoita sarkainta

Toiminto Windows Mac OS

Valitse kaikki tason objektit Alt-napsauta tasoa Optio-osoita tasoa

Kopioi valinta uudelle tasolle Alt-vedä pieni neliö uudelle tasolle Optio-vedä pieni neliö uudelle tasolle

Lisää uusi taso valitun tason alle Napsauta Luo uusi taso Ctrl-näppäin
alhaalla

Napsauta Luo uusi taso
komentonäppäin alhaalla
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Sivut-paneelin näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Väri-paneelin näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Erottelujen esikatselupaneelin käyttönäppäimet

Lisää uusi taso tasoluettelon
ensimmäiseksi

Napsauta Luo uusi taso vaihto+Ctrl-
näppäin alhaalla

Napsauta Luo uusi taso
vaihto+komentonäppäin alhaalla

Lisää uusi taso tasoluettelon
ensimmäiseksi ja avaa Uusi taso -
valintaikkuna

Napsauta Luo uusi taso
vaihto+Alt+Ctrl-näppäin alhaalla

Napsauta Luo uusi taso
Cmd+optionäppäin+vaihtonäppäin
alhaalla

Lisää uusi taso ja avaa Uusi taso -
valintaikkuna

Napsauta Luo uusi taso Alt-näppäin
alhaalla

Napsauta Luo uusi taso optionäppäin
alhaalla

Toiminto Windows Mac OS

Ota pohja käyttöön valitulla sivulla Alt-napsauta pohjaa Optio-osoita pohjaa

Käytä valittua pohjaa toisen
sivupohjan perustana

Napsauta valitun pohjan perustana
käytettävää pohjaa Alt-näppäin
painettuna

Osoita valitun pohjan perustana
käytettävää pohjaa optionäppäin
painettuna

Luo sivupohja Ctrl-napsauta Luo uusi sivu -painiketta Osoita Luo uusi sivu -painiketta
komentonäppäin painettuna

Avaa Lisää sivuja -valintaikkuna Alt-napsauta Uusi sivu -painiketta Optio-osoita Uusi sivu -painiketta

Lisää uusi sivu viimeisen sivun perään Vaihto+Ctrl+P Vaihto+komento+P

Toiminto Windows Mac OS

Siirrä väriliukusäätimiä yhdessä Vedä liukusäädintä vaihtonäppäin
painettuna

Vedä liukusäädintä vaihtonäppäin
painettuna

Valitse väri ei-aktiiviselle täytölle tai
viivalle

Alt-napsauta väripalkkia Osoita väripalkkia optionäppäin
painettuna

Siirry väritilasta toiseen (CMYK, RGB,
LAB)

Osoita väripalkkia vaihtonäppäin
painettuna

Osoita väripalkkia vaihtonäppäin
painettuna
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Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Värimallit-paneelin näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Muunnos-paneelin näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Toiminto Windows-toiminto Mac OS -toiminto

Ota päällepainatuksen esikatselu
käyttöön

Ctrl+Alt+vaihto+Y Komento+optio+vaihto+Y

Näytä kaikki osavärit Vaihto+Ctrl+Alt+< Komento+optio+vaihto+<

Näytä syaani Ctrl+Alt+vaihto+1 Komento+optio+vaihto+1

Näytä magenta Ctrl+Alt+vaihto+2 Komento+optio+vaihto+2

Näytä keltainen Ctrl+Alt+vaihto+3 Komento+optio+vaihto+3

Näytä musta Ctrl+Alt+vaihto+4 Komento+optio+vaihto+4

Näytä 1. spottiosaväri Ctrl+Alt+vaihto+5 Komento+optio+vaihto+5

Näytä 2. spottiosaväri Ctrl+Alt+vaihto+6 Komento+optio+vaihto+6

Näytä 3. spottiosaväri Ctrl+Alt+vaihto+7 Komento+optio+vaihto+7

Toiminto Windows Mac OS

Luo uusi värimalli nykyisen värimallin
perusteella

Alt-napsauta Uusi värimalli -painiketta Optio-osoita Uusi värimalli -painiketta

Luo spottivärimalli nykyisen värimallin
perusteella

Alt+Ctrl-napsauta Uusi värimalli -
painiketta

Optio+komento-osoita Uusi värimalli -
painiketta

Muuta asetuksia käyttämättä värimallia Vaihto+Alt+Ctrl-kaksoisnapsauta
värimallia

Vaihto+optio+komento-kaksoisosoita
värimallia

Toiminto Windows Mac OS

Ota arvo käyttöön ja kopioi objekti Alt+Enter Optio+Enter

Ota leveyden, korkeuden tai
skaalauksen arvo käyttöön säilyttäen
mittasuhteet

Ctrl+Enter Komento+Enter
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Mac OS 10.3x:n ja 10.4:n välisten ristiriitojen ratkaisemisessa käytettävät näppäimet

Tämä ei ole täydellinen pikanäppäinten luettelo. Siinä on mainittu vain ne pikanäppäimet, jotka eivät näy valikkokomennoissa tai työkaluvihjeissä.

Toiminto Mac OS

Avaa Asetukset-valintaikkuna Komento+K

Avaa Kappaletyylit-paneeli Komento+F11

Avaa Merkkityylit-paneeli Komento+vaihto+F11

Avaa Värimallit-paneeli F5

Avaa Sivut-paneeli Komento+F12

Pienennä aktiivinen sovellusikkuna Komento+M

Kätke sovellus Komento+H
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Tiedostojen ja kansioiden käsitteleminen

Alkuun

Suositeltava InDesign-julkaisujen työnkulku
InDesign-julkaisujen avaaminen
InDesign-julkaisujen aikaisempien versioiden muuntaminen
Adobe Bridgen käyttäminen InDesignissa
Adobe Version Cue
Julkaisumallien käyttäminen
InDesign-julkaisujen tarkistaminen
Kalenterien ja käyntikorttien luominen malleista

Suositeltava InDesign-julkaisujen työnkulku

Voit parantaa suorituskykyä ja estää monia ongelmia luomalla Adobe InDesignin yhteyteen hyvän työnkulun.

Puhtaan tietokonejärjestelmän ylläpitäminen

Ajan kuluessa ohjelmistoissa ja laitteistoissa esiintyy muutoksia, jotka voivat heikentää suorituskykyä ja aiheuttaa järjestelmäongelmia. Kiintolevyn
eheyttäminen, vanhojen ohjelmistoversioiden poistaminen, laiteohjainten päivittäminen, muistin optimointi, virustorjuntaohjelmien käyttäminen ja
muiden vastaavien ylläpitotehtävien suorittaminen voi estää sovelluksia ja tiedostoja vahingoittumasta. Näiden tehtävien säännöllinen suorittaminen
auttaa varmistamaan, että InDesign avaa, näyttää ja tulostaa julkaisut odotetusti.

Projektikansion luominen

Määritä ennen projektin aloittamista, mitä tiedostoja tarvitset ja kuinka tallennat ne. Jos rikkinäiset linkit aiheuttavat ongelmia, sinun kannattaa ehkä
tallentaa linkitetyt tiedostot samaan kansioon julkaisun kanssa. InDesign säilyttää linkit tiedostoihin, jotka sijoitat julkaisuun. Jos linkki katkeaa,
InDesign etsii tiedostoa julkaisun kansiosta. Kun julkaisu ja sen linkitetyt tiedostot tallennetaan samaan kansioon, niiden siirtäminen tietokoneesta
toiseen on helppoa. Tiedostojen tallentaminen samaan kansioon varmistaa myös sen, että InDesign löytää alkuperäisen grafiikan julkaisua
tulostettaessa. Jos InDesign ei löydä linkitettyä grafiikkaa, se ei näytä alkuperäiseen grafiikkaan tekemiäsi muutoksia ja grafiikka voi tulostua
heikkotasoisesti tai jäädä kokonaan tulostumatta.

Jos projekti koostuu useista julkaisuista (kuten kirjan luvuista), kannattaa ehkä luoda projektikansio, joka sisältää kansion jokaiselle julkaisulle ja
niiden linkitetyille tiedostoille.

Mallien käyttäminen

Käytä mallia, jos luot säännöllisesti samantyyppisiä projekteja. Mallien avulla voit luoda yhdenmukaisia julkaisuja nopeammin ja samalla suojata
alkuperäistä tiedostoa. Jos esimerkiksi teet kuukausittaista uutiskirjettä, malli voi sisältää viivainlinjat, sivunumerot, nimipalkin ja tyylit, joita haluat
käyttää jokaisessa kirjeessä. (Katso Julkaisumallien käyttäminen.)

Julkaisujen avaaminen paikallisesti

Ennen kuin avaat verkkoasemaan tai siirrettävälle tallennusvälineelle tallennetun julkaisun, kopioi julkaisu ja linkitetty grafiikka paikalliselle
kiintolevylle. Verkkoaseman tai siirrettävän tallennusvälineen hitaampi käyttöyhteys ja tiedonsiirtonopeus voivat aiheuttaa tietojen häviämistä tai
vioittumista ja vahingoittaa siten julkaisua. Muista kuitenkin varmistaa, ettet korvaa toisten tekemiä muokkauksia, jos kopioit paikalliset tiedostot
takaisin verkkopalvelimeen.

Ongelmien ratkaiseminen ennen tiedoston muuntamista
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Vahingoittuneet Adobe PageMaker- ja QuarkXPress®-tiedostot ovat yleensä viallisia myös InDesignissa. Jos muunnetussa tiedostossa esiintyy
virhe tai muuta odottamatonta toimintaa, avaa alkuperäinen tiedosto lähdesovelluksessa ja määritä vika.

Jos muunnetussa tiedostossa on ongelmia, vie se IDML-muodossa, avaa sitten IDML-tiedosto ja tallenna se InDesign-julkaisuna.

Julkaisujen tallentaminen

Tallenna julkaisut usein ja luo tärkeistä tiedostoista varmuuskopioita. Voit poistaa tarpeettomat tiedot julkaisusta käyttämällä Tallenna nimellä -
komentoa. Kun käytät Tallenna-komentoa, InDesign liittää uudet tiedot julkaisuun mutta ei poista vanhentuneita tietoja, kuten poistettuun
grafiikkaan liittyviä tietoja. Kun sen sijaan käytät Tallenna nimellä -komentoa, InDesign kirjoittaa julkaisun uudelleen ja sisällyttää siihen vain
julkaisussa parhaillaan olevien objektien ja sivujen tiedot. Julkaisu, joka sisältää vain tarpeelliset tiedot, käyttää vähemmän kiintolevytilaa ja
päivittyy ja tulostuu nopeammin.

Hyvien suunnittelutapojen harjoittelu

Luo julkaisuun tyylejä. Jos luot tyylejä, kun julkaisuja ei ole avoimina, uutta julkaisua luotaessa näkyviin voi tulla monistuneita tyylejä. Jos
haluat jakaa tyylejä julkaisuissa, tallenna tyylit ja lataa ne.

Käytä sopivia kirjasimia. Kun valitset julkaisuun kirjasimia, mieti, kuinka aiot muotoilla ja tulostaa tekstin. InDesign toimii hyvin OpenType®-,
Type 1- (PostScript) ja TrueType-kirjasinten kanssa. Vahingoittuneet tai huonosti muodostetut kirjasimet voivat vahingoittaa InDesign-
julkaisua tai saada aikaan odottamattomia tulostustuloksia. Käytä vakiintuneiden kirjasintoimittajien luomia luotettavia kirjasimia. Jos
työskentelet palvelukeskuksessa, ota selvää sen kirjasinvaatimuksista.

Vältä liian monien tekstikehysten käyttöä. Käytä mahdollisimman vähän tekstikehyksiä, jotta julkaisutiedoston koko pysyy pienempänä ja
sivuasettelua on helpompi käsitellä.

Järkevä kuvituksen käyttö

Käytä sopivaa grafiikkatiedostomuotoa. Kun luot projektia varten grafiikkaa, mieti, kuinka aiot tulostaa julkaisun. Jos aiot tulostaa julkaisun
palvelukeskuksessa, kysy keskukselta, mitkä grafiikkamuodot toimivat sen käyttämässä tulostuslaitteessa parhaiten. Palvelukeskus voi myös
antaa sinulle ohjeita kuvien optimaalisesta resoluutiosta.

Tallenna grafiikka ulkoisesti. Kun tuot grafiikkatiedoston, InDesign luo oletusarvoisesti grafiikkaan linkin. Linkittäminen pienentää julkaisun
tiedostokokoa ja parantaa InDesignin suorituskykyä. Kun tulostat julkaisun, alkuperäisen grafiikkatiedoston täytyy olla käytettävissä ja
linkitettynä. Jos InDesign ei löydä alkuperäistä tiedostoa, grafiikka voi tulostua matalaresoluutioisena esikatselukuvana tai harmaana
laatikkona.

Linkkien ja kirjasinten vahvistaminen ennen tulostamista

Jotta julkaisu tulostuisi oikein, varmista, että kaikki linkit ovat ehjiä ja kaikki kirjasimet käytettävissä. Linkki katkeaa, jos poistat, siirrät tai
uudelleennimeät alkuperäisen grafiikan. Käytä esitarkastus- ja keräilytoimintoja ennen kuin toimitat tiedostot palvelukeskukselle.

InDesign-julkaisujen avaaminen

Yleensä julkaisut ja mallitiedostot avataan samalla tavoin kuin muissa ohjelmissa. InDesign-malli avautuu oletusarvoisesti uutena ja nimettömänä
julkaisuna. Julkaisutiedostojen tunniste on .indd, mallitiedostojen .indt, katkelmatiedostojen .idms, kirjastotiedostojen .indl, Interchange-tiedostojen
.inx, Markup-tiedostojen .idml ja kirjatiedostojen .indb.

Voit myös avata aiemmilla versioilla luotuja InDesign-, InDesign Interchange (.inx)- ja InDesign Markup (.idml) -tiedostoja, Adobe PageMaker 6.0
(ja aiemmat versiot) -tiedostoja, QuarkXPress 3.3- ja 4.1-tiedostoja sekä QuarkXPress Passport 4.1 -tiedostoja valitsemalla Tiedosto > Avaa.
Lisäksi muut ohjelmistovalmistajat saattavat kehittää laajennusohjelmistoja, joilla voidaan avata muita tiedostomuotoja.

Jos haluat nähdä lisätietoja InDesign-julkaisusta, pidä Ctrl-näppäintä alhaalla ja valitse Ohje > Tietoja InDesignista (Windows) tai pidä
komentonäppäintä alhaalla ja valitse InDesign > Tietoja InDesignista (Mac OS).

Avaa-komennon käyttäminen
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1. Valitse ensin Tiedosto > Avaa ja sitten vähintään yksi julkaisu.

2. Tee jokin seuraavista ja valitse sitten Avaa:

Avaa alkuperäinen julkaisu tai mallin kopio valitsemalla Normaali (Windows) tai Avaa normaali (Mac OS).

Avaa alkuperäinen julkaisu tai malli valitsemalla Alkuperäinen (Windows) tai Avaa alkuperäinen (Mac OS).

Avaa julkaisun tai mallin kopio valitsemalla Kopio (Windows) tai Avaa kopio (Mac OS).

Kun avaat InDesign-julkaisun, saatat kohdata jonkin seuraavista viesteistä:

Viesti, jossa ilmoitetaan InDesignin uudemmasta versiosta

InDesign CS6:ssa ja CC:ssa voit lähettää julkaisuja InDesignin vanhemman version käyttäjille ilman ylimääräisiä vaiheita, kuten julkaisujen
manuaalista vientiä IDML-muotoon. Sisäänrakennettu yhteensopivuus takaa, että julkaisut avautuvat aina odottamallasi tavalla.

Jos avaat InDesignin uudemmalla versiolla luodun julkaisun, näyttöön tulee toisesta versiosta ilmoittava viesti. Voit muuntaa julkaisun InDesignin
nykyiseen versioon seuraavasti:

1. Voit muuntaa julkaisun InDesignin nykyiseen versioon valitsemalla Muunna.

Julkaisu lähetetään Adobe Creative Cloudiin ja sitten muunnetaan InDesignin nykyiseen muotoon.

Sinun on muodostettava Internet-yhteys muunnoksen suorittamista varten.

2. Kun julkaisu on muunnettu nykyiseen versioon, sinua kehotetaan Tallenna nimellä -valintaikkunassa tallentamaan asiakirja.

Viesti, jossa ilmoitetaan, että julkaisun väriasetukset eivät vastaa sovelluksen väriasetuksia

Jos näyttöön tulevassa varoituksessa ilmoitetaan, että julkaisun väriasetukset eivät vastaa sovelluksen väriasetuksia, valitse sopiva asetus ja
valitse OK.

Värejä koskevia varoitusviestejä ei oletusarvoisesti näytetä, mutta voit ottaa ne käyttöön muuttamalla oletusasetuksia Väriasetukset-
valintaikkunassa (Muokkaa >Väriasetukset).

Viesti, jossa ilmoitetaan puuttuvista tai muuttuneista linkeistä

Jos näyttöön tulevassa varoituksessa ilmoitetaan puuttuvista tai muokatuista linkeistä, korjaa linkit Linkit-paneelin avulla. Katso Linkkien
päivittäminen, palauttaminen ja korvaaminen.

Viesti, jossa ilmoitetaan puuttuvista kirjasimista

Jos näyttöön tulevassa varoituksessa ilmoitetaan julkaisusta puuttuvista kirjasimista, tee jokin seuraavista:

Valitse OK. InDesign muotoilee tekstin automaattisesti korvaavalla kirjasimella.

Voit etsiä ja luetella julkaisussa käytetyt kirjasimet valitsemalla Etsi kirjasin.

Lisätietoja puuttuvien kirjasinten etsimisestä saat artikkelista Kirjasinten etsiminen ja korvaaminen.

Äskettäin käytetyn julkaisun avaaminen

Valitse Tiedosto > Avaa äskeinen ja valitse jokin äskettäin tallentamistasi julkaisuista.

Jos haluat määrittää, kuinka monta äskettäistä julkaisua näytetään, valitse Muokkaa > Asetukset > Tiedoston käsittely (Windows) tai InDesign >
Asetukset > Tiedoston käsittely ja määritä sitten Näytettävien viimeksi käytettyjen kohteiden määrä -kohtaan jokin numero. Enimmäismäärä on 30.
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Sanaluetteloiden valitseminen julkaisuja avattaessa

Kun julkaisu avataan, näkyviin voi tulla ilmoitus, jossa kysytään, haluatko käyttää julkaisussa olevaa sanaluetteloa vai sanastossa olevaa
poikkeussanaluetteloa. Poikkeussanaluettelo sisältää sanoja, jotka on lisätty käyttäjän sanastoon julkaisua käsiteltäessä. Jos tiedät, kumpaa
luetteloa haluat käyttää, napsauta sen painiketta. Jos et ole varma, napsauta jompaakumpaa painiketta, valitse Muokkaa > Oikoluku > Sanasto ja
tutustu sanaluetteloihin. Valitse sitten tarvittaessa Muokkaa > Asetukset > Sanasto (Windows) tai InDesign > Asetukset > Sanasto (Mac OS).
Tämä valinta palauttaa koostamiseen käytetyn sanaluettelon. Katso Tavutus ja oikolukusanastot.

InDesign-julkaisujen aikaisempien versioiden muuntaminen

Muunna InDesign-julkaisujen aikaisemmat versiot nykyiseen versioon valitsemalla Tiedosto > Avaa ja avaamalla tiedosto.

Muista seuraavat asiat:

Jos loit julkaisun aikaisemman version muiden valmistajien laajennuksilla, varmista ennen julkaisun muuntamista ohjelman valmistajalta,
että laajennukset on asennettu oikein InDesign CS5:ä varten ja että ne ovat InDesign CS5 -yhteensopivia.

Julkaisua muunnettaessa näkyviin voi tulla ilmoitus, jossa kysytään, haluatko käyttää käyttäjän sanaston vai julkaisun
poikkeussanaluetteloa. Lisätietoja tästä varoituksesta on artikkelissa Sanaluetteloiden valitseminen julkaisuja avattaessa.

InDesignin aiemmissa versioissa luotuja kirjastotiedostoja voi avata ja muuntaa InDesign CS5:ssä, vaikka kirjasto olisi lukittu. Sinun on
määritettävä muunnettujen kirjastotiedostojen nimi ja sijainti. Oletusnimeämistapa on tiedostonimi-X.indl.

InDesignin aikaisemmat versiot eivät pysty avaamaan uusimpia InDesign-julkaisuja suoraan. InDesign CS5 -julkaisun avaaminen
InDesign CS4:ssä edellyttää esimerkiksi seuraavia toimia. Tallenna ensin julkaisu IDML-muodossa valitsemalla InDesign CS5:ssä
Tiedosto > Vie. Päivitä tämän jälkeen InDesign CS4 erityisellä laajennuksella, jotta voit avata IDML-tiedoston. (Katso Tallentaminen
takaisin aikaisempaan InDesign-versioon.)

Jos aikaisemmalla InDesign-versiolla luodun julkaisun käytössä esiintyy ongelmia, tallenna julkaisu InDesign Markup (IDML) -muodossa
InDesign CS5:n Vie-valintaikkunassa. Avaa sitten IDML-tiedosto ja tallenna se InDesign-julkaisuna.

Adobe Bridgen käyttäminen InDesignissa

Adobe Bridge on eri ympäristöissä toimiva sovellus, joka sisältyy Adobe Creative Suite -sovelluksiin ja jonka avulla voit etsiä, järjestää ja selata
paino-, Web-, video- ja äänisisällön luonnissa tarvittavia resursseja. Voit käynnistää Adobe Bridgen mistä tahansa Creative Suite -sovelluksesta
(lukuun ottamatta Adobe Acrobat® -sovellusta) ja käyttää sen avulla sekä Adobe-resursseja että muita kuin Adobe-resursseja.

Adobe Bridgessä voit tehdä seuraavia toimia:

Voit hallita kuvia, videoaineistoa ja äänitiedostoja: voit esikatsella, etsiä, lajitella ja käsitellä tiedostoja Adobe Bridgessä joutumatta avaamaan
yksittäisiä sovelluksia. Voit muokata tiedostojen metatietoja ja sijoittaa tiedostoja dokumentteihin, projekteihin ja sommitelmiin Adobe Bridgen
avulla.

Näytä InDesign-julkaisun linkit miniatyyreinä Adobe Bridgessä ilman, että sinun täytyy avata InDesign-julkaisua InDesignissa.

Voit luoda katkelmia vetämällä resursseja Adobe Bridgestä InDesign-julkaisuikkunaan tai vetämällä resursseja julkaisuikkunasta Adobe
Bridgeen. Katso Katkelmien käyttäminen.

Voit suorittaa automatisoituja tehtäviä, kuten eräkäsittelykomentoja.

Voit synkronoida väriasetuksia kaikissa värinhallintaa tukevissa Creative Suite -sovelluksissa.

Voit käynnistää reaaliaikaisen Web-neuvottelun työpöydän jakamista ja tiedostojen tarkistamista varten.

Adobe Version Cue

Adobe Creative Suite 5 ei sisällä Adobe Version Cue®- tai Adobe Drive -tuotetta, eikä Creative Suite -sovelluksen tulevia versioita. Adobe
panostaa jatkossakin resurssienhallintaan avointen alan standardien ja kumppanuuksien kautta. Lisätietoja on osoitteessa
www.adobe.com/go/learn_vc_end_fi.
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Julkaisumallien käyttäminen

Mallit ovat hyviä apuvälineitä vakiojulkaisujen luomiseen, koska niihin voi määrittää valmiiksi sivuasettelun, grafiikkaa ja tekstiä. Jos vaikkapa
valmistat kerran kuussa ilmestyvää lehteä, voit luoda mallin, joka sisältää toistuvien kohteiden asettelun, kuten viivainlinjat, ruudukot, sivupohjat,
mukautetut tyylit ja värimallit, paikkamerkkien kehykset, tasot sekä vakiografiikan ja -tekstin. Sinun ei tarvitse kuin avata malli kerran kuukaudessa
ja tuoda uusi sisältö.

Malli luodaan tavallisen julkaisun tavoin, mutta se tallennetaan eri tavalla. Kun valmistat mallin toisten käytettäväksi, voit lisätä tason, joka sisältää
ohjeita mallista. Kätke tai poista taso ennen julkaisun tulostamista. Katso Tasot.

InDesignin kiinalaisissa versioissa voit avata erikoismalleja, jotka sisältävät mukautettuja mojikumi-joukkoja.

Julkaisun tallentaminen mallina

1. Valitse Tiedosto > Tallenna nimellä ja määritä sijainti ja tiedostonimi.

2. Valitse Tallennusmuoto- (Windows) tai Muoto-kohdassa (Mac OS) InDesign CS5 -malli ja valitse Tallenna.

Uuden julkaisun käynnistäminen mallista

1. Valitse Tiedosto > Avaa.

2. Etsi ja valitse malli.

3. Valitse ensin Normaali (Windows) tai Avaa normaali (Mac OS) ja sitten Avaa.

4. Tallenna uusi julkaisu uudella nimellä.

Olemassa olevan mallin muokkaaminen

1. Valitse Tiedosto > Avaa.

2. Etsi ja valitse malli.

3. Valitse ensin Alkuperäinen (Windows) tai Avaa alkuperäinen (Mac OS) ja sitten Avaa.

InDesign-julkaisujen tarkistaminen

Adobe tarjoaa useita tapoja katselmoida InDesign-julkaisuja.

Muokkausmuutosten jäljittäminen

Kun sinä tai joku toinen henkilö muokkaa tekstiä, InDesign korostaa lisätyn tekstin ja yliviivaa poistetun tekstin, kun Jäljitä muutokset on käytössä.
Voit katsella muutoksia juttueditorissa. Julkaisun omistaja voi katsella muokkauksia ja hyväksyä tai hylätä muutokset. Katso Muutosten jäljittäminen
ja tarkasteleminen.

PDF-tiedoston katselmointi Acrobatissa

Voit viedä InDesign-julkaisun PDF-muotoon ja järjestää Adobe Acrobatilla sähköpostikatselmoinnin tai jaetun katselmoinnin Acrobat.comissa tai
jossain toisessa palvelimessa. Katselmoijat voivat lisätä kommentteja Kiinteä huomautus -työkalulla ja muilla merkkaustavoilla. Julkaisun omistaja
voi sitten käydä läpi PDF-katselmointikommentit ja muokata alkuperäistä InDesign-julkaisua. Lisätietoja on Acrobatin Ohjeessa.

CS Review'n käyttäminen
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CS Review on online-tilauspalvelu, jolla voit jakaa töitäsi Internetissä siten, että muut voivat antaa niistä välitöntä palautetta. Kun luot katselmoinnin
CS Review -paneelista, lataat yhden tai useita tiedoston tilannekuvia Acrobat.com -työtilaan. Katselmoijat voivat sitten lisätä kommenttejaan.

Kun luot katselmoinnin, voit jakaa katselmoinnin osiin, joilla voit erotella katselmoijille kommentoitavat alueet. Katselmointi voi koostua eri
tiedostoista ja sovelluksista peräisin olevista osista. Katselmoinnin edetessä voit lisätä ja poistaa katselmoinnin osia osana dynaamista
katselmointiprosessia.

Kalenterien ja käyntikorttien luominen malleista

Eräs tapa luoda kalentereita, käyntikortteja, ansioluetteloita ja muita erikoisjulkaisuja on käyttää malleja.

Adobelta saat erilaisia malleja Adobe Marketplace- ja Exchange-sivustoilta:

www.adobe.com/go/exchange_fi

Käytä hakua etsiessäsi lisäresursseja erikoisjulkaisuille.

Lisää ohjeaiheita
Adobe Bridge

Mini Bridge

CS Review
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Valikkojen mukauttaminen
Puuttuvat valikkokomennot
Pikanäppäinyhdistelmien käyttäminen

Valikkojen mukauttaminen
Valikkokomentojen piilottaminen ja värittäminen on tapa selkeyttää valikkoja ja korostaa usein käytetyt komennot. Huomaa, että piilotettu
valikkokomento on vain poissa näkyvistä; sen toiminnot ovat edelleen käytettävissä. Voit halutessasi tarkastella piilotettuja komentoja valitsemalla
valikon alaosasta asetuksen Näytä kaikki valikkokohteet. Vaihtoehtoisesti voit myös näyttää kaikki valitun työtilan valikot valitsemalla Ikkuna >
Työtila > Näytä täydelliset valikot. Voit sisällyttää mukautetut valikot tallentamiisi työtiloihin.

Voit mukauttaa päävalikkoa, pikavalikkoja ja paneelivalikkoja. Pikavalikko avautuu, kun aluetta napsautetaan hiiren kakkospainikkeella (Windows)
tai Control-osoitetaan (Mac OS). Paneelivalikko avautuu, kun paneelin oikean yläkulman kuvaketta napsautetaan.

Huomautus: Jos valitset jonkin toisen työtilan, kuten Aloittaminen, tietyt valikkokomennot piilotetaan. Voit näyttää kaikki valikkokomennot
valitsemalla valikon alaosasta asetuksen Näytä kaikki valikkokohteet tai valita toisen työtilan, kuten Laajennettu.

Mukautetun valikkojoukon luominen
1. Valitse Muokkaa > Valikot.

Oletusvalikkojoukkoa ei voi muokata.

2. Valitse Tallenna nimellä, kirjoita valikkojoukon nimi ja napsauta OK-painiketta.
3. Valitse mukautettavat valikot valitsemalla Luokka-valikosta Ohjelmavalikot tai Pika- ja paneelivalikot.
4. Näytä aliluokat tai valikkokomennot napsauttamalla valikkoluokkien vasemmalla puolella olevia nuolia. Voit näyttää tai kätkeä komennon

napsauttamalla Näkyvyys-kohdassa olevaa silmäkuvaketta. Napsauta Väri-alueen kohtaa Ei mitään, jos haluat valita värin valikosta.
5. Valitse Tallenna ja sitten OK.

Mukautetun valikkojoukon valitseminen
1. Valitse Muokkaa > Valikot.
2. Valitse Joukko-valikosta valikkojoukko ja napsauta sitten OK-painiketta.

Mukautetun valikkojoukon muokkaaminen tai poistaminen
1. Valitse Muokkaa > Valikot.
2. Valitse Joukko-valikosta valikkojoukko ja tee sitten yksi seuraavista:

Jos haluat muokata valikkojoukkoa, muuta valikkokomentojen näkyvyyttä tai väriä ja napsauta sitten Tallenna-painiketta ja sitten OK-
painiketta.

Jos haluat poistaa valikkojoukon, valitse Poista ja Kyllä. Jos olet muokannut valikkojoukkoa, mutta et ole tallentanut sitä, näyttöön tulee
nykyisen valikkojoukon tallentamista koskeva kehote. Tallenna valikkojoukko valitsemalla Kyllä tai hylkää muutokset valitsemalla Ei.

Kätkettyjen valikkokomentojen näyttäminen
Valitse Ikkuna > Työtila > Näytä täydelliset valikot. Tämä komento ottaa käyttöön kaikki valitun työtilan valikot. Voit piilottaa valikot
palauttamalla työtilan.
Valitse kätkettyjä komentoja sisältävän valikon alaosasta Näytä kaikki valikkokohteet.

Jos haluat tilapäisesti näyttää komennot, jotka olet kätkenyt mukauttamalla valikkoja, pidä Ctrl-näppäintä (Windows) tai komentonäppäintä
(Mac OS) painettuna ja napsauta valikon nimeä.

Puuttuvat valikkokomennot
Jos et löydä valikkokomentoa, se saattaa olla piilotettu. Jos valitset jonkin muun työtilan kuin Laajennettu, jotkin valikkokomennot piilotetaan. On
myös mahdollista, että sinä tai joku muu käyttäjä on piilottanut valikkokohteita Valikot-komennolla.

Jos et löydä hakemaasi komentoa, voit yrittää hakea sitä seuraavilla tavoilla:

Valitse Näytä kaikki valikkokohteet -vaihtoehto valikon alaosasta.
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Valitse Ikkuna > Työtila > Näytä täydelliset valikot.

Valitse Ikkuna > Työtila ja valitse jokin toinen työtila (Laajennettu näyttää kaikki valikkokohteet).

Valitse Muokkaa > Valikot, hae valikkokomento ja varmista, ettei sitä ole piilotettu.

Jos valikon komentoja puuttuu yhä, yritä palauttaa asetukset.

Pikanäppäinyhdistelmien käyttäminen
Voit tarkistaa pikanäppäimet myös työkaluvihjeistä. InDesignissa on myös pikanäppäineditori, jolla voit luoda luettelon pikanäppäimistä ja
tarkastella sitä. Voit myös muokata ja luoda omia pikanäppäimiä. Pikanäppäineditorissa on kaikki komennot, jotka hyväksyvät pikanäppäinten
käytön, mutta joitakin näistä komennoista ei ole määritelty oletuspikanäppäinjoukossa.

Voit myös liittää pikanäppäimiä kappale- tai merkkityyleihin (lisätietoja: Kappale- ja merkkityylien lisääminen) tai komentosarjoihin.

Voit katsoa pikanäppäinten käyttämistä käsittelevän videon osoitteessa http://www.adobe.com/go/vid0066_fi.

Mike Witherell on tehnyt viiteoppaan pikanäppäimistä. Se on osoitteessa Ilmaisia pikanäppäimiä (vain englanniksi).

Aktiivisen pikanäppäinjoukon vaihtaminen
1. Jos haluat pikanäppäimien olevan käytössä kaikissa julkaisussa, varmista ettei julkaisuja ole avoinna.
2. Valitse Muokkaa > Pikanäppäimet.
3. Valitse Yhdistelmä-valikosta pikanäppäinjoukko. Valitse esimerkiksi QuarkXPress® 4.0 -pikanäppäimet.
4. Valitse OK.

Pikanäppäinten tarkasteleminen
1. Valitse Muokkaa > Pikanäppäimet.
2. Valitse Yhdistelmä-valikosta pikanäppäinjoukko.
3. Valitse Tuotealue-asetukseksi alue, jossa on haluamasi komennot.
4. Valitse haluamasi komento. Pikanäppäin näkyy Nykyiset pikanäppäimet -osiossa.

Tulostettavan pikanäppäinluettelon luominen
1. Valitse Muokkaa > Pikanäppäimet.
2. Valitse Yhdistelmä-valikosta pikanäppäinjoukko.
3. Napsauta Näytä yhdistelmä -painiketta.

Näyttöön avautuu tekstitiedosto, jossa ovat joukon kaikki nykyiset ja määrittämättömät pikanäppäimet.

Uuden pikanäppäinjoukon luominen
1. Valitse Muokkaa > Pikanäppäimet.
2. Napsauta Uusi yhdistelmä -painiketta.
3. Kirjoita uuden joukon nimi, valitse pikanäppäinjoukko Perustuu-valikosta ja napsauta OK-painiketta.

Pikanäppäimen luominen tai uudelleen määrittäminen
1. Valitse Muokkaa > Pikanäppäimet.
2. Luo uusi pikanäppäinjoukko napsauttamalla Uusi yhdistelmä -painiketta tai valitse pikanäppäinjoukko.

Huomautus: Et voi muokata oletus- tai QuarkXPress-pikanäppäinjoukkoa. Luo sen sijaan uusi joukko jonkin vanhan joukon pohjalta ja
muokkaa sitä.

3. Valitse Tuotealue-asetukseksi alue, jossa on määritettävät tai uudelleen määritettävät komennot.
4. Valitse Komennot-luettelosta komento, jonka haluat määrittää tai määrittää uudelleen.
5. Paina Uusi näppäinkomento -ruudussa uuden pikanäppäimen näppäimiä. Jos pikanäppäin on jo käytössä toisessa komennossa, InDesign

näyttää kyseisen komennon nykyisissä pikanäppäimissä. Voit vaihtaa alkuperäisen pikanäppäimen tai valita uuden pikanäppäimen.
Huomautus: Älä määritä yksinäppäimisiä pikanäppäimiä valikon komennoille, koska ne häiritsevät tekstin kirjoittamista. Jos kohdistin on
aktiivinen, kun näppäilet yksinäppäimisen pikanäppäimen, InDesign aktivoi pikanäppäimen eikä lisää merkkiä tekstiin.

6. Valitse kontekstiluettelosta pikanäppäimelle konteksti. Konteksti varmistaa, että pikanäppäin toimii haluamallasi tavalla. Voit määrittää
esimerkiksi, että Ctrl+G yhdistää kaksi solua (taulukkokonteksti) ja Ctrl+G lisää erikoismerkin (tekstikonteksti).
Huomautus: Määritä pikanäppäimet oletuskontekstiin, kun haluat niiden toimivan julkaisun sen hetkisestä tilasta riippumatta. Muihin
konteksteihin, kuten taulukko- tai tekstikontekstiin, määritetyt pikanäppäimet kumoavat oletuskontekstiin määritetyt pikanäppäimet.

7. Tee jokin seuraavista:

Luo täysin uusi pikanäppäin napsauttamalla Määritä-painiketta.

Lisää komennolle uusi pikanäppäin napsauttamalla Määritä-painiketta. Valikkokomennoilla voi olla useita pikanäppäimiä.
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8. Sulje valintaikkuna napsauttamalla OK-painiketta tai pidä valintaikkuna avoinna ja määritä lisää pikanäppäimiä napsauttamalla Tallenna-
painiketta.

Pikanäppäinyhdistelmien kopioiminen
Pikanäppäinyhdistelmät (.indk) on tallennettu kahteen sijaintiin. Oletusarvoiset pikanäppäinyhdistelmät ovat sovelluksen pääkansion Oletusarvot-
kansiossa. Luomasi pikanäppäinyhdistelmät ovat Shortcut Sets -kansiossa seuraavissa sijainneissa:

Windows XP Documents and Settings\[käyttäjätunnus]\Application Data\Adobe\InDesign\[versio]\[kieli]InDesign Shortcut Sets
Windows Vista ja Windows 7 Users\[käyttäjätunnus]\AppData\Roaming\Adobe\InDesign\[versio]\[kieli]\InDesign Shortcut Sets
Mac OS Käyttäjät/[käyttäjätunnus]/Kirjasto/Preferences/Adobe InDesign/[versio]/[kieli]/InDesign Shortcut Sets
Jos loit pikanäppäinyhdistelmän yhdellä tietokoneella ja haluat käyttää sitä myös jollakin toisella tietokoneella, kopioi indk-tiedosto samaan
kansioon toisessa tietokoneessa.

Voit siirtää pikanäppäinyhdistelmän mukautettujen pikanäppäinten kansiosta sovelluskansioon. Tällöin mukautetut pikanäppäimet ovat tietokoneen
kaikkien käyttäjien käytettävissä. Varmista kuitenkin, ettei samannimisiä pikanäppäinyhdistelmiä ole kahta, yhtä kummassakin kansiossa. Varmista,
että sovelluksen pikanäppäinyhdistelmillä ja mukautetuilla pikanäppäinyhdistelmillä on eri nimet.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Julkaisujen palauttaminen
Virheiden kumoaminen

Julkaisujen palauttaminen
InDesign suojaa tiedot odottamattomien sähkökatkosten ja järjestelmävirheiden varalta automaattisella palautustoiminnolla. Automaattisesti
palautetut tiedot tallennetaan tilapäistiedostoon levylle erilleen alkuperäisestä julkaisutiedostosta. Näitä tietoja ei yleensä tarvita. Automaattiseen
palautustiedostoon tallennetut julkaisupäivitykset lisätään automaattisesti alkuperäiseen julkaisutiedostoon, kun valitaan Tallenna- tai Tallenna
nimellä -komento tai InDesign-ohjelma lopetetaan normaalisti. Automaattisesti palautetut tiedostot ovat tärkeitä vain silloin, kun tietoja ei ole
tallennettu ennen sähkökatkosta tai järjestelmävirhettä.

Muista tallentaa tiedostot usein ja luo niistä odottamattomien sähkökatkosten tai järjestelmävirheiden varalta varmuuskopioita.

Palautettujen julkaisujen etsiminen
1. Käynnistä tietokone uudelleen.
2. KäynnistäInDesign.

Jos automaattisesti palautettuja tietoja löytyy, InDesign näyttää palautetun julkaisun automaattisesti. Julkaisuikkunan otsikkorivillä lukee
tiedostonimen jälkeen [Palautettu], mikä osoittaa, että julkaisussa on tallentamattomia automaattisesti palautettuja muutoksia.

Huomautus: jos InDesign ei onnistu avaamaan julkaisua käyttämällä automaattisesti palautettuja muutoksia, automaattisesti palautetut
tiedot voivat olla vahingoittuneita.

3. Tee jokin seuraavista:

Tallenna palautetut tiedot valitsemalla Tiedosto >Tallenna nimellä, määrittämällä kohde ja uusi nimi sekä napsauttamalla Tallenna-
painiketta. Tallenna nimellä -komento säilyttää palautetun version, joka sisältää automaattisesti palautetut tiedot. Sana [Palautettu]
häviää otsikkoriviltä.

Jos et halua käyttää automaattisesti palautettuja tietoja, vaan viimeistä ennen sähkökatkosta tai järjestelmävirhettä levylle tallennettua
versiota, sulje tiedosto sitä tallentamatta ja avaa se levyltä tai valitse Tiedosto > Palauta.

Palautettujen julkaisujen sijainnin muuttaminen
1. Valitse Muokkaa > Asetukset > Tiedoston käsittely (Windows) tai InDesign > Asetukset > Tiedoston käsittely (Mac OS).
2. Valitse Julkaisun palautustiedot -kohdassa Selaa (Windows) tai Valitse (Mac OS).
3. Määritä palautetulle julkaisulle uusi sijainti, valitse Valitse ja napsauta lopuksi OK-painiketta.

Virheiden kumoaminen
Voit tarvittaessa keskeyttää aikaa vievän operaation, kumota äskettäiset muutokset tai palata aiemmin tallennettuun versioon. Voit kumota tai
tehdä uudelleen useita satoja viimeksi suoritettuja toimenpiteitä (määrää rajoittaa muistin määrä ja toimenpiteiden laatu). Toimintosarja poistetaan,
kun valitset Tallenna nimellä, suljet julkaisun tai lopetat ohjelman.

 Tee jokin seuraavista:

Jos haluat kumota viimeksi tehdyn muutoksen, valitse Muokkaa > Kumoa [toiminto]. (Eräitä toimia, kuten vieritystä, ei voi kumota.)

Jos haluat tehdä muutoksen uudelleen, valitse Muokkaa > Tee uudelleen [toiminto].

Kumoa kaikki edellisen tallennuksen jälkeen tehdyt muutokset valitsemalla Tiedosto > Palauta (InDesign) tai Tiedosto > Palauta sisältö
(InCopy).

Sulje valintaikkuna ottamatta muutoksia käyttöön valitsemalla Peruuta.

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Hallittujen tiedostojen käsitteleminen
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Jaetun julkaisun avaaminen
Sisällön uloskirjaaminen
Hallittujen tiedostojen avaaminen (InCopy)
Artikkelitiedostojen päivittäminen (InDesign)
Sisällön päivittäminen
Työn päivittäminen vahingossa
InDesign-asettelun päivittäminen
Sisällön sisäänkirjaaminen
Muutosten tallentaminen (InDesign)
Muutosten tallentaminen (InCopy)

Jaetun julkaisun avaaminen
Ainoastaan InCopy-käyttäjät voivat avata artikkelitiedostoja (.inca). Jos InCopy-käyttäjä avaa artikkeleita sisältävän InDesign-tiedoston, hän voi
käsitellä kaikkea hallittua sisältöä artikkeleista riippumatta.

 Tee jokin seuraavista:

Valitse InCopyssa Tiedosto > Avaa, valitse artikkelitiedosto (.icma tai .inca) ja napsauta Avaa-painiketta.

Valitse InDesignissa tai InCopyssa Tiedosto > Avaa, valitse määritetyn sisällön sisältävä InDesign-tiedosto (.indd) ja napsauta Avaa-
painiketta.

Avaa artikkelipakkaus. Lisätietoja: Pakkausten vastaanottaminen (InCopy).

Artikkeleiden nimet ja sisällöt näkyvät Artikkelit-paneelissa.

Sisällön uloskirjaaminen
Kun uloskirjaat kohteen, tiedostojärjestelmään lisätään kätketty lukitustiedosto (.idlk). Uloskirjaamisen jälkeen sisältö on yksin sinun hallinnassa;
muut eivät voi tehdä siihen muutoksia. Voit uloskirjata ainoastaan InCopy-sisältöä. Et voi uloskirjata sivuasettelutietoja sisältäviä InDesign-
julkaisuja.

Jos yrität sulkea vähintään yhden uloskirjaamasi InCopy-sisältötiedoston sisältävän InDesign-julkaisun, näyttöön tulee varoitus, jossa ohjelma
pyytää sisäänkirjaamaan kaiken sisällön. Jos suljet julkaisun sisäänkirjaamatta sisältötiedostoja, ne ovat edelleen sinun uloskirjaamiasi, kun avaat
InDesign-julkaisun seuraavan kerran. InDesign-julkaisua tallennettaessa kaikki muokattavat InCopy-sisältötiedostot tallentuvat automaattisesti.

Sisällön uloskirjaaminen (InDesign)
 Tee jokin seuraavista:

Valitse muokattavat teksti- tai grafiikkakehykset sivuasettelusta ja valitse Muokkaa > InCopy > Uloskirjaa.

Valitse Artikkelit-paneelista tiedostot ja valitse paneelivalikosta Uloskirjaa.

Kun uloskirjaat käytettävissä olevan sisällön InDesignissa, näet Muokataan-kuvakkeen  InDesign-kehyksessä. InCopyssa Käytössä-kuvake 
näkyy InCopy-kehyksessä ja Artikkelit-paneelissa, jos artikkelitiedostot on tallennettu paikalliseen palvelimeen.

Sisällön uloskirjaaminen (InCopy)
1. Tee jokin seuraavista:

Jos haluamasi sisältö on artikkelin osa, valitse Tiedosto > Avaa ja valitse artikkelitiedosto (.icma tai .inca).

Jos tarvitsemasi sisältö on viety erillisinä tiedostoina, valitse Tiedosto > Avaa ja valitse InCopy-tiedosto (.icml tai .incx). Jos haluat
tarkastella sivuasettelua ja valita copyfit-toiminnon, avaa myös InDesign-julkaisu.

2. Tee jokin seuraavista:

Voit uloskirjata yhden InCopy-sisältötiedoston valitsemalla Tiedosto > Uloskirjaa.

Voit uloskirjata artikkelin kaiken sisällön kerralla valitsemalla ensin Artikkelit-paneelista artikkelin ja sitten paneelivalikosta Uloskirjaa.

Voit uloskirjata artikkelin erillisiä osia avaamalla artikkeliluettelon Artikkelit-paneelista, valitsemalla vähintään yhden kohteen ja
valitsemalla paneelivalikosta Uloskirjaa.
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Artikkelit-paneelin kohteiden vieressä näkyy Muokkaa-kuvake , joka ilmaisee, että olet uloskirjannut sisällön omaan käyttöön.

3. Jos ohjelma kehottaa päivittämään sisällön muutoksineen, napsauta OK-painiketta.

Kun uloskirjaat käytettävissä olevan sisällön InCopyssa, näet Muokkaa-kuvakkeen  InCopy-kehyksessä ja Artikkelit-paneelissa. InDesignissa
näkyy Käytössä-kuvake  InDesign-kehyksessä.

Hallittujen tiedostojen avaaminen (InCopy)
Hallitun sisältötiedoston (.icml tai .incx) avaaminen suoraan InCopyssa ja sen käsitteleminen Juttu-näkymässä saattaa olla paras tapa kirjoittaa ja
muokata tiedostoa nopeasti. Sinun ei tarvitse uloskirjata hallittua tiedostoa halutessasi muokata sitä, koska InCopy uloskirjaa sen automaattisesti.
Kun haluat tallentaa ja sulkea tiedoston, InCopy sisäänkirjaa sisällön automaattisesti. Tallennuskomennot ovat erilaisia, kun avaat yksittäisiä
tiedostoja.

Artikkelitiedostojen päivittäminen (InDesign)
Voit tallentaa artikkelien muutokset manuaalisesti tai sulkiessasi nykyisen julkaisun. Ainoastaan päivittämällä artikkelitiedoston voit luovuttaa
sivuasettelumuutokset InCopy-käyttäjille.

 Tee jokin seuraavista:

Voit päivittää valitsemasi artikkelit valitsemalla ne Artikkelit-paneelista ja valitsemalla Artikkelit-paneelivalikosta Päivitä valitut artikkelit.

Voit päivittää nykyisen julkaisun kaikki vanhentuneet artikkelit valitsemalla Artikkelit-paneelivalikosta Päivitä vanhentuneet artikkelit. Vain
vanhentuneet artikkelit päivitetään.

Voit päivittää nykyisen julkaisun kaikki artikkelit valitsemalla Artikkelit-paneelivalikosta Päivitä kaikki artikkelit.

Huomautus: jos jollain InCopy-käyttäjällä on artikkeli avoinna, kun päivität sen, artikkelin vieressä näkyy Vanhentunut-kuvake  InCopyn
Artikkelit-paneelissa.

Sisällön päivittäminen
Voit varmistaa, että käsittelet aina uusinta sisältöä, seuraamalla Artikkelit-paneelin Vanhentunut-kuvakkeita ja päivittämällä sitten sisällön
vastaavasti. Kun InCopy-artikkelitiedosto ja sen sisältö tai erillisiä sisältötiedostoja päivitetään, ohjelma kopioi tiedot uusimmasta
tiedostojärjestelmässä olevasta kopiosta niin, että tietokoneessasi näkyvä versio vastaa tiedostojärjestelmässä olevaa versiota. Päivittäminen ei
edellytä sisään- tai uloskirjaamista, eikä se anna muokkausoikeuksia. Päivittäminen voi kuitenkin aiheuttaa ongelmia, jos joku muu on poistanut
lukituksesi.

Huomautus: sisällön päivittäminen ei vaikuta palauttamattomien artikkelipakkausten sisältöön.
Tyypillinen päivitystyönkulku on seuraavanlainen:

1. InCopy-käyttäjä avaa artikkelitiedoston tai uloskirjaa sisältötiedoston ja muokkaa sen sisältöä.

2. InCopy-käyttäjä tallentaa sisältötiedoston, jolloin tiedostojärjestelmässä oleva kopio päivittyy, ja jatkaa työskentelemistä.

3. InDesign-käyttäjä näkee Vanhentunut-kuvakkeen  sekä Artikkelit-paneelissa että Linkit-paneelissa valinnan vieressä sekä Käytössä-
kuvakkeen  ja Tekstisisältö on vanhentunut- kuvakkeen  tai Grafiikkasisältö vanhentunut -kuvakkeen  liittyvässä kehyksessä.

Käytössä- ja Vanhentunut-kuvakkeet (vasemmalla) sisältävä Artikkelit-paneeli sekä sisällöltään vanhentunut sivuasettelu (oikealla)

4. InDesign-käyttäjä päivittää sisällön.

Sisällön päivittäminen hallittua julkaisua avattaessa (InDesign)
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1. Valitse Tiedosto > Avaa, etsi tiedosto, jonka haluat avata, ja napsauta Avaa-painiketta.
2. Napsauta Kyllä-painiketta, kun ohjelma pyytää päivittämään julkaisun tiedostojärjestelmässä olevalla muutetulla sisällöllä.
3. Tee jokin seuraavista:

Valitse Korjaa linkit automaattisesti, jos haluat InDesignin päivittävän linkit.

Jos haluat korjata linkit manuaalisesti, napsauta Älä korjaa -painiketta, valitse päivitettävä tiedosto Linkit-paneelista ja valitse
paneelivalikosta Päivitä linkki.

Sisällön päivittäminen työskentelemisen aikana (InDesign)
 Tee jokin seuraavista:

Valitse sivuasettelusta teksti- tai grafiikkakehykset ja valitse Muokkaa > InCopy > Päivitä sisältö.

Valitse Linkit-paneelista teksti- tai grafiikkakehykset ja napsauta Päivitä linkki -painiketta  tai valitse Artikkelit-paneelivalikosta Päivitä
linkki.

Sisällön päivittäminen työskentelemisen aikana (InCopy)
 Tee jokin seuraavista:

Valitse kehys napsauttamalla ja valitse sitten Tiedosto > Päivitä sisältö.

Valitse Artikkelit-paneelista sisältö ja napsauta sitten Päivitä sisältö -painiketta  tai valitse Artikkelit-paneelivalikosta Päivitä sisältö.

Sisällön voi päivittää myös Linkit-paneelin kautta.

Työn päivittäminen vahingossa
Useimmissa tapauksissa päivityskomennot eivät toimi uloskirjaamassasi sisällössä, koska se on muutenkin aina ajan tasalla. Ongelmallinen tilanne
saattaa kuitenkin syntyä, jos toinen käyttäjä poistaa uloskirjatun sisällön lukituksen (vetämällä lukitustiedoston (.idlk) Roskakoriin) ja muokkaa
sisältöä. Tässä tapauksessa päivityskomennot voivat olla käytettävissä, vaikka sisältö on uloskirjattu, joten kaksi henkilöä voi muokata sisältöä
samanaikaisesti. Sisällön päivittäminen aiheuttaa tietojen menetyksen. Saat parhaat tulokset, kun et poista lukitustiedostoja.

InDesign-asettelun päivittäminen
InDesign-käyttäjät voivat muokata sivuasettelua (esimerkiksi muuttaa jutun tekstikehysten kokoa tai sijaintia) ja tallentaa muutokset samaan aikaan
kuin InCopy-käyttäjät muokkaavat näiden tekstikehysten tekstiä. Jaettuun palvelimeen perustuvassa työnkulussa tapa, jolla InCopy-käyttäjille
ilmoitetaan sivuasettelun muutoksista, määräytyy sen mukaan, ovatko he avanneet artikkelitiedoston vai uloskirjanneet erillisiä sisältötiedostoja ja
myös avanneet linkitetyn InDesign-tiedoston.

Ota huomioon seuraavat seikat:

Jos InDesign-käyttäjä muuttaa artikkelin kehysten sivuasettelua, käyttäjän on päivitettävä artikkeli, jotta muotoilumuutokset olisivat InCopy-
käyttäjien käytettävissä. InDesign ei päivitä artikkelitiedostoja automaattisesti, kun julkaisu tallennetaan.

Kun InDesign-käyttäjä on päivittänyt jaettuun palvelimeen tallennetun artikkelin, InCopyn Artikkelit-paneelissa näkyy Vanhentunut-kuvake 
artikkelin vieressä. InCopy-käyttäjän on päivitettävä muotoilu nähdäkseen nykyisen sivuasettelun.

Jos InDesign-käyttäjä muuttaa artikkeliin kuulumattoman, viedyn sisällön asettelua, Vanhentunut-kuvake näkyy InDesign-julkaisun nimen
vieressä Artikkelit-paneelissa, ja julkaisun otsikkorivillä näkyy, että asettelu on vanhentunut. InCopy-käyttäjät voivat päivittää kulloinkin
aktiivisen InDesign-julkaisun uusimmilla sivuasettelun ja tyylin muutoksilla.

Sivuasettelun päivittämisestä InCopyssa on hyötyä copyfit-tehtävissä, koska uusimmat ulkoasun muutokset ja rivinvaihdot näkyvät Sivuasettelu- ja
Raakateksti-näkymissä.

 Tee jokin seuraavista:

Jos avointa artikkelitiedostoa käsitellessäsi Artikkelit-paneelissa näkyy Vanhentunut-kuvake  artikkelin nimen vieressä, napsauta Päivitä
Design -painiketta  tai valitse Tiedosto > Päivitä Design. Tätä komentoa ei voi kumota.

Jos et käsittele artikkelitiedostoja ja jos sinulla on useita avoimia InDesign-julkaisuja, valitse aktivoitava julkaisu ja valitse Tiedosto > Päivitä
Design.

Sisällön sisäänkirjaaminen
Kun sisäänkirjaat hallitun sisältötiedoston, se tallentuu tiedostojärjestelmässä olevaan jaettuun paikkaan, josta muut voivat uloskirjata
sisältötiedoston muokatakseen sitä tai tehdäkseen siihen muita muutoksia. Myös InDesignista vietävä teksti- tai grafiikkakehys sisäänkirjautuu
automaattisesti.

Vaikka sisäänkirjattu tiedosto on käytettävissä muokkaamista varten, sitä voi todella muokata vasta, kun se uloskirjataan, paitsi jos sisältöä
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muokataan erillistilassa InCopyssa. Sisällön sisäänkirjaaminen lopettaa muokkauskäytön, mutta ei sulje tiedostoa. Sisältö pysyy auki näytössä,
mutta se on vain luku -tilassa.

LiveEdit-työnkulun laajennukset eivät luo useita tiedostoversioita. Sen sijaan tiedostot korvautuvat, kun niitä päivitetään joko InCopyssa tai
InDesignissa.

Jos käsittelet artikkelipakkausta, palauta tai välitä se sisäänkirjaamisen jälkeen.

Hallitun sisällön sisäänkirjaaminen (InDesign)
 Tee jokin seuraavista:

Valitse sivuasettelusta sisältö ja valitse Muokkaa > InCopy > Sisäänkirjaa.

Valitse Artikkelit-paneelista sisältö ja valitse paneelivalikosta Sisäänkirjaa.

Hallitun sisällön sisäänkirjaaminen (InCopy)
 Tee jokin seuraavista:

Valitse Sivuasettelu-näkymästä sisältö ja valitse Tiedosto > Sisäänkirjaa.

Valitse Artikkelit-paneelista sisältö ja valitse paneelivalikosta Sisäänkirjaa.

Huomautus: voit kumota viimeiset muutokset, ennen kuin sisäänkirjaat sisällön.
Kun olet sisäänkirjannut tiedoston, InDesign-sivuasettelun teksti- tai grafiikkakehyksessä, Artikkelit-paneelissa, InCopyn Sivuasettelu-
näkymässä ja juttupalkissa (InCopy) näkyy Käytettävissä-kuvake.

Muutosten tallentaminen (InDesign)
Kun käsittelet uloskirjaamaasi sisältöä, voit tallentaa muutokset ja päivittää tiedostojärjestelmässä olevan kopion.

 Tee jokin seuraavista:

Voit tallentaa valitsemasi sisällön tallentamatta muutoksia InDesign-julkaisuun tai siihen linkitettyihin tiedostoihin valitsemalla sivuasettelusta
sisällön ja valitsemalla Muokkaa > InCopy > Tallenna sisältö.

Voit tallentaa kaikki uloskirjaamasi sisältötiedostot valitsemalla Tiedosto > Tallenna. Tämäntyyppinen tallentaminen ei päivitä automaattisesti
artikkelitiedostoja tai uloskirjattuja sisältötiedostoja InCopyssa. InCopyssa uloskirjattujen tiedostojen kohdalla näkyy kuitenkin Vanhentunut-
kuvake  Artikkelit-paneelissa.

Voit tallentaa InDesign-julkaisun uudella nimellä ja säilyttää linkit valmiisiin InCopy-tiedostoihin valitsemalla Tiedosto > Tallenna nimellä.
Tämä toiminto saa InDesign-tiedoston artikkelit näyttämään puuttuneilta niiden päivitykseen saakka.

Voit tallentaa kopion kulloinkin aktiivisesta julkaisusta valitsemalla Tiedosto > Tallenna kopio. Voit määrittää kopiolle uuden nimen ja sijainnin
sekä säilyttää linkit InCopy-tiedostoihin.

Muutosten tallentaminen (InCopy)
 Tee jokin seuraavista:

Voit tallentaa InCopy-tiedoston samalla nimellä ja samaan paikkaan tiedostojärjestelmässä valitsemalla Tiedosto > Tallenna sisältö. Tiedosto
on edelleen sinun uloskirjaamasi.

Voit tallentaa InCopy-sisältötiedoston uudella nimellä valitsemalla Tiedosto > Tallenna sisältö nimellä. Juuri luotua sisältötiedostoa ei hallita
työnkulussa. Tallenna sisältö nimellä -komento on käytettävissä ainoastaan, jos InCopy-sisältötiedosto (.icml tai .incx) on avattu suoraan.

Voit tallentaa kopion kulloinkin aktiivisesta InCopy-sisältötiedostosta valitsemalla Tiedosto > Tallenna sisältökopio. Voit määrittää kopiolle
uuden nimen ja sijainnin. Tallennettua kopiota ei hallita työnkulussa. Tallenna sisältökopio -komento on käytettävissä ainoastaan, jos InCopy-
sisältötiedosto (.incx) on avattu suoraan.

Voit tallentaa kaikki avoimet ja uloskirjatut InCopy-sisältötiedostot valitsemalla Tiedosto > Tallenna kaikki sisältö. Tällöin kaikki tiedostot
tallentuvat niiden nykyisiin paikkoihin. Tallenna kaikki sisältö -komento on käytettävissä ainoastaan, jos artikkeli tai InDesign-tiedosto on
avattu.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Lähentäminen ja loitontaminen
Näkymän säätäminen
Sivujen kääntäminen
Lisäikkunoiden käsitteleminen
Reunojen tasoittaminen pehmentämällä
Himmennetty teksti
Arvojen laskeminen paneeleissa ja valintaikkunoissa
Arvojen kirjoittaminen paneeleihin ja valintaikkunoihin

Lähentäminen ja loitontaminen
Zoomaustyökalulla tai Zoomaus-komennoilla suurennetaan julkaisun kokoa näytössä.

Lähentäminen tai loitontaminen
Valitse zoomaustyökalu  ja napsauta aluetta, jonka haluat suurentaa. Napsautus suurentaa näkymää seuraavaan esiasetettuun prosenttiin
ja keskittää näkymän napsauttamaasi kohtaan. Kun suurennussuhde on suurin mahdollinen, zoomaustyökalun keskusta muuttuu tyhjäksi.
Pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) painettuna ja napsuta aluetta, jonka haluat pienentää. Jokainen napsautus
pienentää näkymää.
Jos haluat suurentaa seuraavan oletusprosenttiarvon mukaisesti, aktivoi ikkuna, jota haluat katsoa, ja valitse Näytä > Lähennä. Jos haluat
pienentää seuraavan oletusprosenttiarvon mukaisesti, aktivoi ikkuna, jota haluat katsoa, ja valitse Näytä > Loitonna.
Voit määrittää tietyn suurennustason kirjoittamalla tai valitsemalla arvon sovelluspalkin Zoomauksen taso -ruutuun.

Mac OS -käyttöjärjestelmässä voit näyttää suurennuskertoimen tilarivillä piilottamalla sovelluspalkin (Ikkuna > Sovelluspalkki).
Windowsissa et voi piilottaa sovelluspalkkia.

Voit suurentaa tai pienentää pitämällä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) painettuna samalla, kun käytät hiiren
rullanäppäintä tai tunnistinta.
Voit suurentaa valitsemalla zoomaustyökalun ja vetämällä sen suurennettavan alueen ympäri.

Tehokkaan zoomauksen käyttäminen
Tehokkaalla zoomauksella voit selata nopeasti julkaisun sivuja. Tartuntakäden avulla voit lähentää tai loitontaa ja selata koko julkaisua. Tämä
toiminto on hyödyllinen etenkin pitkiä julkaisuja käsiteltäessä.

1. Valitse käsityökalu .

Voit ottaa tartuntatyökalun käyttöön myös pitämällä välilyöntinäppäintä tai Alt/Optio-näppäinyhdistelmää painettuna tekstitilassa.

2. Kun tartuntatyökalu on aktiivisena, paina hiiripainiketta ja pidä sitä painettuna.

Julkaisua loitonnetaan siten, että näet enemmän aukeamasta. Punainen ruutu ilmaisee näkymäalueen.

3. Voit selata julkaisun sivuja vetämällä punaista ruutua hiiripainike painettuna. Voit muuttaa punaisen ruudun kokoa nuolinäppäimillä tai hiiren
rullanäppäimellä.

4. Vapauta hiiripainike, kun haluat lähentää uuteen alueeseen julkaisussa.

Julkaisuikkuna palautuu alkuperäiseen zoomausprosenttiin tai punaisen ruudun kokoon.

Zoomaaminen todelliseen kokoon
Kaksoisnapsauta zoomaustyökalua.
Valitse Näytä > Todellinen koko.
Kirjoita suurennustaso 100 % sovelluspalkin Zoomauksen taso -ruutuun tai valitse arvo luettelosta.

Näkymän säätäminen
Kohdista haluamaasi julkaisun osaan sovittamalla sivut ja aukeamat aktiiviseen ikkunaan ja vierittämällä näkymää.

Sivun, aukeaman tai taittopöydän sovittaminen aktiiviseen ikkunaan
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Valitse Näytä > Sovita sivu ikkunaan.
Valitse Näytä > Sovita aukeama ikkunaan.
Valitse Näytä > Koko taittopöytä.

Näkymän vierittäminen
Voit helposti säätää, kuinka sivut tai objektit keskitetään julkaisuikkunaan. Tämä on kätevää myös siirryttäessä sivulta toiselle.

 Tee jokin seuraavista toimista:

Valitse työkalupaneelista käsityökalu   ja napsauta ja vedä sitä julkaisuikkunassa. Voit aktivoida käsityökalun tilapäisesti pitämällä Alt-
näppäintä (Windows) tai optionäppäintä (Mac OS) painettuna ja painamalla välinäppäintä.

Napsauta vaaka- tai pystyvierityspalkkia tai vedä vieritysruutua.

Paina Page Up- tai Page Down -näppäintä.

Vieritä näyttöä ylös tai alas käyttämällä hiiren rullanäppäintä tai tunnistinta. Voit panoroida vasemmalle tai oikealle pitämällä Alt-näppäintä
(Windows) tai optionäppäintä (Mac OS) painettuna ja käyttämällä hiiren rullanäppäintä tai tunnistinta.

Sivujen kääntäminen
InDesignissa on helppo siirtyä julkaisun sivulta toiselle. Useimpien Web-selainten tavoin voit liikkua sivuilla Edellinen- ja Seuraava-painikkeilla.
InDesign muistaa, missä järjestyksessä julkaisun sivut on avattu.

 Tee jokin seuraavista toimista:

Jos haluat siirtyä julkaisun sivuilla siinä järjestyksessä kuin ne on avattu nykyisen istunnon aikana, valitse Sivuasettelu >Siirry taaksepäin tai
Siirry eteenpäin.

Jos haluat siirtyä seuraavalle tai edelliselle sivulle, napsauta julkaisuikkunan alareunassa olevaa Seuraava sivu -painiketta   tai Edellinen
sivu -painiketta  tai valitse Sivuasettelu > Seuraava sivu tai Edellinen sivu.

Jos haluat siirtyä ensimmäiselle tai viimeiselle sivulle, napsauta julkaisuikkunan vasemmassa alakulmassa olevaa Ensimmäinen aukeama -
painiketta  tai Viimeinen aukeama -painiketta  tai valitse Sivuasettelu > Ensimmäinen sivu tai Viimeinen sivu.

Jos haluat siirtyä tietylle sivulle, valitse Sivuasettelu > Siirry sivulle, määritä sivunumero ja napsauta OK-painiketta. Napsauta sivuruudun
oikealla puolella alanuolta ja valitse sitten sivu.

Siirtyminen tietylle sivulle valitsemalla sivu sivuruudusta

Voit siirtyä sivupohjaan napsauttamalla julkaisuikkunan vasemmassa alareunassa olevaa sivuruutua. Kirjoita sivupohjan nimen pari
alkukirjainta ja paina Enter (Windows) tai Return (Mac OS). Voit myös kaksoisnapsauttaa sivupohjan kuvaketta Sivut-paneelissa.

Lisäikkunoiden käsitteleminen
Voit avata lisäikkunoita samaan tai muihin InDesign-julkaisuihin. Lisäikkunoiden avulla voit vertailla aukeamia, varsinkin muita kuin peräkkäisiä
aukeamia. Voit myös tarkastella sivua eri suurennuskertoimilla sekä syventyä yksityiskohtiin ja nähdä samalla, kuinka muutokset vaikuttavat
sivuasetteluun Voit myös näyttää sivupohjan yhdessä ikkunassa ja siihen perustuvat sivut muissa ikkunoissa, jotta näet, miten sivupohjan
muokkaaminen vaikuttaa julkaisun eri osiin.

Kun avaat julkaisun uudelleen, vain viimeisin ikkuna avautuu.

Jos haluat luoda uuden ikkunan samaa julkaisua varten, valitse Ikkuna > Järjestä > Uusi ikkuna.
Järjestä ikkunat porrastetuksi pinoksi valitsemalla Ikkuna > Järjestä > Limittäin. Valitse Ikkuna > Järjestä > Vierekkäin, jos et halua
ikkunoiden peittävän toisiaan.
Aktivoi ikkuna napsauttamalla sen välilehteä tai otsikkoriviä. Voit myös vaihtoehtoisesti valita Ikkuna-valikosta näkymän nimen. Saman
julkaisun ikkunat on numeroitu luontijärjestyksessä.
Voit sulkea kaikki aktiivisen julkaisun ikkunat painamalla vaihto+Ctrl+W (Windows) tai vaihto+komento+W (Mac OS).
Voit sulkea kaikkien avoimien julkaisujen kaikki ikkunat painamalla vaihto+Ctrl+Alt+W (Windows) tai vaihto+komento+optio+W (Mac OS).
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Reunojen tasoittaminen pehmentämällä
Pehmennys tasoittaa tekstin ja bittikarttojen epätasaisia reunoja pehmentämällä reuna- ja taustapikselien värivaihtelua. Yksityiskohdat eivät katoa,
koska ainoastaan reunapikselit muuttuvat.

1. Valitse Muokkaa > Asetukset > Näytä suoritus (Windows) tai InDesign > Asetukset > Näytä suoritus (Mac OS).
2. Valitse Säädä näkymäasetuksia -valikosta näkymäasetus, jossa haluat ottaa käyttöön pehmennyksen.

Voit valita kussakin näkymässä, onko pehmennys käytössä. Voit esimerkiksi käyttää pehmennystä Laadukas-näkymässä ja poistaa sen
käytöstä Nopea-näkymässä.

3. Valitse Ota pehmennys käyttöön.

Himmennetty teksti
Kun näytön ominaisuudet eivät riitä pienen tekstin näyttämiseen, teksti näkyy himmennettynä palkkina. Tätä sanotaan paikkamerkkitekstiksi.
Määritetyn kokoinen tai pienempi teksti ei näy näytössä kirjoitettuna. Tämä vastaa grafiikan paikkamerkkejä.

1. Valitse Muokkaa > Asetukset > Näytä suoritus (Windows) tai InDesign > Asetukset > Näytä suoritus (Mac OS).
2. Valitse Säädä näkymäasetuksia -valikosta näkymäasetus, jonka osalta haluat muuttaa Teksti ei näy -asetusta.

Voit määrittää eri Teksti ei näy -arvon kutakin näkymäasetusta varten.

3. Jos haluat käyttää Teksti ei näy, kun alle -ominaisuutta, anna arvo ja napsauta OK.

Jos haluat määrittää, näytetäänkö teksti ja kuvat metatekstinä julkaisua vieritettäessä, avaa Asetukset-valintaikkunan Liittymä-osio, vedä
käsityökalun liukusäädin haluamasi suorituskyky–laatu-suhteen kohdalle ja napsauta OK.

Arvojen laskeminen paneeleissa ja valintaikkunoissa
Voit suorittaa pieniä laskutehtäviä missä tahansa numeroja hyväksyvässä muokkausruudussa. Jos haluat esimerkiksi siirtää valittua objektia
3 yksikköä oikealle nykyisillä mittayksiköillä, sinun ei tarvitse laskea uutta vaakasijaintia, vaan voit kirjoittaa Muunnos-paneeliin arvon +3 nykyisen
arvon jälkeen.

Paneeleissa käytetään Asetukset-valintaikkunassa valittua mittajärjestelmää. Voit tarvittaessa määrittää arvoja myös muina mittayksikköinä.

1. Tee numeroita hyväksyvässä tekstiruudussa jokin seuraavista:

Korvaa nykyinen arvo matemaattisella lauseella valitsemalla koko nykyinen arvo.

Käytä nykyistä arvoa osana matemaattista lausetta siirtämällä kohdistin nykyisen arvon eteen tai jälkeen.

2. Kirjoita yksinkertainen matemaattinen lauseke, jossa on yksi operaattori, esimerkiksi + (yhteenlasku), - (vähennyslasku), * (kertolasku),
/ (jakolasku) tai % (prosentti).

Esimerkiksi 0p0+3 tai 5mm + 4.

3. Suorita laskutoimitus painamalla Enter- tai Return-näppäintä.

Voit monistaa valitun objektin Ohjaus- ja Muunnos-paneelissa ja lisätä laskutoimituksen kopioon (alkuperäisen sijasta). Kirjoita laskutoimitus ja
paina Alt+Enter (Windows) tai optio+Return (Mac OS).

Arvojen kirjoittaminen paneeleihin ja valintaikkunoihin
Paneeleissa ja valintaikkunoissa käytetään Muokkaa > Asetukset > Yksiköt ja lisäykset -ikkunassa (Windows) tai InDesign > Asetukset > Yksiköt ja
lisäykset -ikkunassa (Mac OS) määritettyjä mittayksiköitä ja lisäyksiä. Voit kuitenkin määrittää koska tahansa arvoksi minkä tahansa mittayksikön
ohittamalla tilapäisesti nykyiset asetukset.

 Tee jokin seuraavista toimista:

Kirjoita arvo ruutuun ja paina Enter- tai Return-näppäintä.

Vedä liukusäädintä.

Vedä valitsinta.

Muuta arvoa napsauttamalla paneelin nuolipainikkeita.

Napsauta ruutua ja muuta arvoa ylä- tai alanuolinäppäimellä.

Valitse arvo ruudun valikosta.

Huomautus: kun teet muutoksia nuolipainikkeilla ja nuolinäppäimillä tai valitset arvon valikosta, InDesign käyttää uutta arvoa heti.
Lisää ohjeaiheita
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Työkalupaneeli

Alkuun

Työkalupaneelin yleiskuvaus
Työkalujen yleiskuvaus
Valintatyökalujen valikoima
Piirto- ja tekstityökalujen valikoima
Muunnostyökalujen valikoima
Muokkaus- ja navigointityökalujen valikoima

Työkalupaneelin yleiskuvaus
Eräillä työkalupaneelin työkaluilla valitaan, muokataan ja luodaan sivuelementtejä. Toisilla työkaluilla taas valitaan tekstiä, kuvioita, viivoja ja
liukuvärejä. Voit muuttaa työkalupaneelin yleisasettelun muiden ikkunoiden ja paneelien asetteluun sopivaksi. Työkalupaneelin työkalut ovat
oletusarvoisesti yhdessä pystysarakkeessa. Voit muuttaa asettelun kahdeksi pystysarakkeeksi tai vaakariviksi. Työkalujen järjestystä ei kuitenkaan
voi muuttaa. Voit siirtää työkalupaneelia vetämällä sitä paneelin yläosasta.

Valitse työkalu perustyökaluista napsauttamalla sitä. Työkalupaneelin näkyviin työkaluihin liittyy myös useita kätkettyjä työkaluja. Niiden merkkinä
on työkalukuvakkeen oikealla puolella oleva nuoli. Valitse kätketty työkalu napsauttamalla ensin nykyistä työkalua ja valitsemalla sitten haluamasi
työkalu.

Työkalun nimi ja pikanäppäin tulevat näkyviin, kun osoitin on työkalun päällä. Tätä tekstiä kutsutaan työkaluvihjeeksi. Voit poistaa työkaluvihjeet
käytöstä valitsemalla Asetukset-valintaikkunan Liittymä-kohdasta Työkaluvihjeet-asetukseksi Ei mitään.

Avaa Työkaluvihjeet-paneeli (valitse Ikkuna > Apuohjelmat > Työkaluvihjeet) niin näet, mitkä pikanäppäimet ja muuntonäppäimet toimivat
kunkin työkalun kanssa.

Huomautus: Sisällön keräys- ja sijoittelutyökaluja ei ole CS5.5:ssä ja sitä aiemmissa versioissa.

Työkalupaneelin näyttäminen
 Valitse Ikkuna > Työkalut.
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Työkaluvihjeiden näyttäminen
 Kaksoisnapsauta työkalua työkalupaneelissa.

Tämä menetelmä koskee vai osaa työkaluista, esimerkiksi pipetti-, kynä- ja monikulmiotyökalua.

Kätkettyjen työkalujen näyttäminen ja valitseminen

1. Siirrä osoitin työkalupaneelissa sellaisen työkalun päälle, johon kuuluu kätkettyjä työkaluja, ja pidä hiiren painiketta painettuna.

2. Valitse kätketty työkalu, kun se tulee näkyviin.

Valitse työkalut tilapäisesti
1. Kun työkalu on valittuna, pidä eri työkalun pikanäppäintä painettuna.
2. Pidä pikanäppäin yhä painettuna ja tee jokin toimenpide.
3. Vapauta pikanäppäin, kun haluat palata edelliseen työkaluun.

Jos esimerkiksi Väli-työkalu on valittuna, paina V-näppäintä, kun haluat vaihtaa väliaikaisesti Valintatyökaluun. Kun vapautat V-näppäimen, Väli-
työkalu on valittuna.

Työkaluvihjeiden näyttäminen
Työkaluvihjeet-paneelissa kuvataan kuinka muokkausnäppäimet toimivat valitun työkalun kanssa.

1. Avaa Työkaluvihjeet-paneeli valitsemalla Ikkuna > Apuohjelmat > Työkaluvihjeet.

2. Valitse työkalu työkalupaneelista, jos haluat nähdä työkalun kuvauksen ja sen muokkausnäppäimet ja pikanäppäimet.

Työkalupaneelin asettelun muuttaminen

1. Valitse Muokkaa > Asetukset > Liittymä (Windows) tai InDesign > Asetukset > Liittymä (Mac OS).

2. Valitse asetteluvaihtoehto Kelluva työkalupaneeli -valikosta ja napsauta OK-painiketta.

Voit muuttaa työkalupaneelin asettelua myös sen yläreunassa olevalla kaksoisnuolikuvakkeella.

Työkalujen yleiskuvaus
Tekstityökalut Luo ja muokkaa tekstiä tavallisissa tai mukautetuissa lohkoissa tai reiteissä. (Lisätietoja: Tekstikehysten luominen.)
Piirtotyökalut Piirrä yksinkertaisia tai monimutkaisia objekteja, kuten suorakulmioita, ellipsejä, monikulmioita ja vapaamuotoisia kuvioita ja määritä
niille tyylit. (Lisätietoja: Piirtäminen.)
Valintatyökalut Valitse (aktivoi) objekteja, pisteitä tai rivejä. (Lisätietoja: Objektien valitseminen.)
Muunnostyökalut Muuta objektien muotoa, suuntaa ja kokoa. (Lisätietoja: Kohteiden muuntaminen.)
Siirtymistyökalut Siirry paikasta toiseen, hallitse näkymää ja mittaa etäisyyksiä julkaisussa. (Lisätietoja: Lähentäminen ja loitontaminen ja
Viivaimet ja mittayksiköt.)
Saksityökalu Jaa reittejä ja kehyksiä. (Lisätietoja: Reitin katkaiseminen.)

Valintatyökalujen valikoima

Valintatyökalulla valitaan
kokonaisia objekteja.

Suoravalintatyökalulla valitaan
pisteitä reitiltä tai sisältö
kehyksestä.

Sivu-työkalulla voit luoda
useita sivukokoja julkaisuun.

Välityökalulla voit säätää
objektien välisiä tiloja.

Piirto- ja tekstityökalujen valikoima
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Kynätyökalulla piirretään
suoria ja käyriä reittejä.

Lisää ankkuripiste -työkalulla
lisätään reitille ankkuripisteitä.

Poista ankkuripiste -työkalulla
poistetaan reitiltä
ankkuripisteitä.

Muunna suuntapiste -työkalulla
muunnetaan kulma- ja
tasoituspisteitä.

Tekstityökalulla luodaan
tekstikehyksiä ja valitaan
tekstiä.

Reittitekstityökalulla luodaan ja
muokataan reittitekstejä

Lyijykynätyökalulla piirretään
vapaamuotoinen reitti.

Tasoitustyökalulla poistetaan
reitiltä ylimääräisiä kulmia.

Pyyhekumityökalulla
poistetaan reitiltä pisteitä.

Viivatyökalulla piirretään viivan
segmentti.

Suorakulmiokehystyökalulla
luodaan neliömäinen tai
suorakulmainen paikkamerkki.

Ellipsikehystyökalulla luodaan
pyöreä tai soikea
paikkamerkki.

Monikulmiokehystyökalulla
luodaan monikulmainen
paikkamerkki.

Suorakulmiotyökalulla luodaan
neliö tai suorakulmio.

Ellipsityökalulla luodaan
ympyrä tai soikio.

Monikulmiotyökalulla luodaan
monikulmio.

Muunnostyökalujen valikoima

Vapaa muunto -työkalulla
kierretään, skaalataan tai
kallistetaan objektia.

Kiertotyökalulla kierretään
objekteja kiintopisteen ympäri.

Skaalaustyökalulla muutetaan
objektien kokoa kiintopisteen
suhteen.

Kallistustyökalulla kallistetaan
objekteja kiintopisteen
suhteen.
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Pipettityökalulla kerätään
objekteista väri- ja
tekstimääritteitä sekä liitetään
niitä toisiin objekteihin

Mittatyökalu mittaa kahden
pisteen välisen etäisyyden.

Liukuvärimallityökalu säätää
liukuvärien alku- ja
loppupisteitä sekä kulmaa
objektien sisällä

Liukuväripehmennystyökalu
häivyttää objektin taustalle.

Saksityökalu leikkaa reittejä
määritetyistä pisteistä.

Käsityökalu siirtää
sivunäkymää
julkaisuikkunassa.

Zoomaustyökalu suurentaa tai
pienentää näkymää
julkaisuikkunassa.

Muistiinpanotyökalulla voit
lisätä kommentteja.

Lisää ohjeaiheita
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Sisällön jakaminen

Alkuun

Alkuun

Sisällön vieminen InDesignista
Artikkelit-paneelin yleiskuvaus
Artikkelitiedostot
Artikkelien luominen ja sisällön lisääminen (InDesign)
Sisällön vieminen erillisinä InCopy-tiedostoina (InDesign)

Sisällön vieminen InDesignista
Viemällä sisältöä InDesignista InCopyyn muodostetaan linkki näiden sovellusten välille. InDesign-tekstikehyksiä, -grafiikkakehyksiä ja niiden
sisältöä voidaan viedä InCopyyn jommallakummalla seuraavista menetelmistä:

Luo säilötiedosto (.icma-tunniste), jota kutsutaan artikkeliksi, ja lisää artikkeliin liittyvät julkaisukohteet (esimerkiksi jutun teksti ja kuvat), jotta
niitä voidaan käsitellä yhdessä. Artikkeleiden sisältö viedään .icml-tiedostoina.

Vie teksti- ja grafiikkakehykset (mukaan lukien paikkamerkkikehykset) erikseen Muokkaa > InCopy > Vie -valikon komennoilla. Viety sisältö
tallentuu .icml-tiedostoihin.

Kun sisältöä on viety, vietyjen kehysten vasemmalla puolella ylhäällä näkyy pieniä kuvakkeita InDesignissa ja InCopyssa sekä Artikkelit-
paneelissa. Viedyn tiedoston linkki näkyy Linkit-paneelissa. Nämä kuvakkeet ilmaisevat hallittujen kehysten tilan ja erottavat ne työnkulkuun
kuulumattomista kehyksistä. Kaikki viety sisältö näkyy Artikkelit-paneelissa. Vie-valikon komennoilla viety sisältö näkyy Artikkelit-paneelin luettelon
Määrittelemätön InCopy-sisältö -osassa. Kummallakin menetelmällä luodaan hallittu yhteys InCopy-sisällön ja InDesign-julkaisun välille, mutta
sisällön linkittäminen tapahtuu ensisijaisesti artikkelitiedostoja käyttämällä.

Viemällä sisältö luovutetaan käyttäjille, jotta he voivat uloskirjata sen muokkaamista varten ja säilyttää linkin alkuperäiseen InDesign-julkaisuun.
(Tämä linkki luodaan InDesignissa, eikä sitä voi luoda InCopysta.)

Kun sisältö on viety, InCopy-käyttäjät voivat tarkastella esimerkiksi sivuasetteluja ja tyylejä sellaisina kuin ne näkyvät InDesign-julkaisussa. He
eivät voi kuitenkaan muuttaa niitä.

Huomautus: voit luoda myös tekstiä tai sidottua grafiikkaa InCopyn avulla ja sijoittaa niitä sitten InDesigniin.

Artikkelit-paneelin yleiskuvaus
Ensisijainen artikkelityökalu on Artikkelit-paneeli (Ikkuna > Artikkelit InCopyssa, Ikkuna > Pääkirjoitus > Artikkelit InDesignissa). Kulloinkin
aktiivisesta InDesign-julkaisusta viedyt tiedostot näkyvät Artikkelit-paneelissa, ja kuvake ilmaisee niiden tilan. Artikkelit-paneelivalikossa on myös
komentoja, joilla hallitaan InCopyn ja InDesignin välisiä tuontiversiota ja tiedostonhallintatoimintoja. Kun avaat artikkelin InCopyssa, sen nimi ja
sisältö näkyvät Artikkelit-paneelissa. Voit valita teksti- ja grafiikkakehyksiä julkaisuikkunasta kaksoisnapsauttamalla niitä Artikkelit-paneelissa.
Huomautus: Kaikki InCopyyn viety tai artikkeliin lisätty sisältö näkyy myös Linkit-paneelin luettelossa. Vaikka voit tehdä Linkit-paneelissa joitakin
työkulun hallintatehtäviä, kuten ulos- tai sisäänkirjata sisältöä, nämä tehtävät kannattaa tehdä Artikkelit-paneelin avulla.

InDesignin Artikkelit-paneeli
A. InCopy-sisällön nimet B. InDesign-julkaisun nimi C. Artikkeli vanhentunut -tila D. Käytettävissä- ja Teksti on päivitetty -tila E. Käytössä- ja
Teksti vanhentunut -tila F. Muokataan- ja Teksti päivitetty -tila G. Määrittelemätön sisältö H. Käyttäjänimi I. Päivitä sisältö -
painike J. Uloskirjaa valinta- tai Sisäänkirjaa valinta -painike K. Uusi artikkeli -painike L. Poista valitut artikkelit- tai Poista-painike
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InCopyn Artikkelit-paneeli
A. InCopy-sisällön nimet B. Artikkeli vanhentunut -tila C. Artikkelin nimi D. Käytettävissä- ja Teksti on päivitetty -tila E. Käytössä- ja Teksti
vanhentunut -tila F. Muokataan- ja Teksti päivitetty -tila G. Käyttäjänimi H. Päivitä Design -painike I. Päivitä sisältö -painike J. Uloskirjaa
valinta- tai Sisäänkirjaa valinta -painike

Artikkelitiedostot
Artikkelitiedostoja käytetään InDesignissa säilöinä sivukohteiden järjestämiseen. Voit esimerkiksi valita jutun kaikki kohteet (otsikkorivin, kirjoittajan
nimirivin, kopion, grafiikan ja kuvatekstit) ja luovuttaa ne samalle InCopy-käyttäjälle. Kun nämä kohteet lisätään artikkeliin, InCopy-käyttäjät voivat
kätevästi käsitellä ainoastaan sitä sisältöä, josta he ovat vastuussa. Artikkelitiedostot (*.icma) näkyvät tiedostojärjestelmässä, InCopyn juttupalkissa
ja tilailmoituksissa. Vain InDesign-käyttäjät voivat luoda artikkelitiedostoja ja vain InCopy-käyttäjät voivat avata niitä.

Kun artikkeli luodaan, InDesign luo kansion normaalisti samaan paikkaan, jossa InDesign-julkaisu sijaitsee. Tämä artikkelikansio sisältää .icma-
tunnisteiset artikkelitiedostot ja sisällön alikansion. Tässä kansiossa ovat viedyt InCopyn juttutiedostot (.icml-muodossa), jotka ovat osa kuvia tai
muita resursseja. Kun olet luonut artikkelin, tallenna projektikansio paikkaan, joka on kaikkien käyttäjien saatavilla, tai luo ja jaa artikkelipakkaus.
Jos sisältö viedään ennen lisäämistä artikkeliin, levytiedostot eivät siirry artikkelitiedoston sisältökansioon.

Artikkelitiedostoissa on seuraavat osat:

Linkit tai osoittimet artikkeliin liittyviin sivukohteisiin, myös paikkamerkkikehyksiin. Näiden ansiosta InCopy-käyttäjä voi avaamalla yhden
tiedoston InCopyssa ottaa toimitettavaksi useita sivukohteita.

Artikkeliin sisältyvien kuvien muunnokset, kuten siirtäminen, skaalaaminen, kiertäminen tai kallistaminen.

Sivugeometria, jotta InCopy-käyttäjät pystyvät koko InDesign-tiedostoa avaamatta tarkastelemaan muokkaamansa kehyksen ja sen sisällön
sivuasettelua.

Julkaisun määritettyjen kehysten värikoodit.

Kuva InCopyn sivusta, jossa näkyy sivugeometria ja värikoodit

Artikkelien luominen ja sisällön lisääminen (InDesign)
Ainoastaan InDesign-käyttäjät pystyvät luomaan artikkeleita ja lisäämään niihin sisältöä. Artikkeleita voidaan luoda monella tavalla. Tapa valitaan
yleensä sen perusteella, onko lisättävää sisältöä käytettävissä artikkelin luontihetkellä.

Luo tyhjiä artikkelitiedostoja. Voit luoda InDesign-julkaisusta sarjan tyhjiä artikkeleita, jotka toimivat myöhemmin lisättävän sisällön malleina.

Luo artikkelit ja lisää sisältö samanaikaisesti.

Lisää sisältö valmiiseen artikkelitiedostoon. Voit lisätä linkitettyä sisältöä eli tekstiä ja kuvia, jotka on jo viety InCopy-sisältönä. Voit myös
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lisätä valitsemasi sivukohteet linkitetyksi InCopy-sisällöksi. Jos vähintään yhdessä valituista kehyksistä on jo InCopy-sisältötiedostoja eikä
mikään sisältötiedostoista kuulu artikkeliin, voit lisätä niitä uuteen tai valmiiseen artikkelitiedostoon.

Luomasi artikkelikansio tallentuu normaalisti samaan kansioon kuin InDesign-julkaisu. Voit sitten siirtää kansion palvelimeen tai luoda ja lähettää
pakkauksen.

Huomautus: jos et halua InCopy-käyttäjien sijoittavan ja sovittavan kuvia, älä lisää grafiikkakehyksiä artikkeliin.

Tyhjien artikkelitiedostojen luominen (InDesign)
1. Tallenna julkaisu InDesignissa.
2. Valitse Artikkelit-paneelivalikosta Uusi artikkeli.
3. Määritä artikkelitiedoston asetukset Uusi artikkeli -valintaikkunassa ja napsauta OK-painiketta.

Artikkelien luominen ja sisällön lisääminen samanaikaisesti (InDesign)
1. Luo InDesignissa vähintään yhden teksti- tai grafiikkakehyksen tai paikkamerkkikohteen sisältävä julkaisu ja tallenna se.
2. Valitse lisättävät teksti- ja grafiikkakehykset.
3. Tee jokin seuraavista:

Valitse Artikkelit-paneelivalikosta Lisää artikkeliin ja valitse sitten Uusi.

Valitse Muokkaa > InCopy > Lisää [vaihtoehto] artikkeliin > Uusi.

4. Määritä artikkelitiedoston asetukset Uusi artikkeli -valintaikkunassa ja napsauta OK-painiketta.

Juuri luotu artikkelitiedosto sisältää julkaisuikkunassa mahdollisesti valitut kehykset.

Sisällön lisääminen artikkeleihin (InDesign)
1. Tallenna InDesign-julkaisu.
2. Valitse lisättävät teksti- ja grafiikkakehykset.
3. Tee jokin seuraavista:

Valitse Artikkelit-paneelivalikosta Lisää artikkeliin ja valitse sitten artikkeli.

Vedä sisältö Artikkelit-paneelin Määrittelemätön InCopy-sisältö -osasta artikkeliin.

Valitse sivukohteita valintatyökalulla ja vedä ne Artikkelit-paneelissa näkyvään artikkeliin.

Valitse Muokkaa > InCopy > Lisää [vaihtoehto] artikkeliin ja valitse sitten artikkeli.

4. Luovuta sisältötiedostot InCopy-käyttäjille valitsemalla Artikkelit-paneelivalikosta Päivitä kaikki artikkelit.

Huomautus: Voit lisätä sisältöä ainoastaan saman julkaisun artikkeleihin. Voit kuitenkin tuoda saman sisällön useisiin julkaisuihin ja lisätä sen
kussakin julkaisuissa artikkeliin.

Artikkelitiedoston asetukset (InDesign)
Artikkelitiedostoa luotaessa tai muokattaessa voidaan määrittää seuraavia asetuksia:

Artikkelin nimi Artikkelin yksilöllinen tunnus Artikkelit-paneelissa, esimerkiksi "Valtameriartikkeli". Tämän nimen on oltava käyttöjärjestelmän
nimeämissääntöjen mukainen.
Määritetty Tiedostoille määritetyn käyttäjän yksilöllinen tunnus. Käyttäjän nimi näkyy Artikkelit-paneelissa sulkeissa artikkelin nimen jälkeen. Tähän
kirjoitettu nimi on vain tiedoksi; sillä ei myönnetä käyttäjälle erityisiä oikeuksia tai lupia.
Väri Näyttää värimallin, jonka avulla voidaan lisätä erottuva korostus nykyisen artikkelin kehyksiin julkaisuikkunassa ja artikkelien nimiin Artikkelit-
paneelissa. Tämä värikoodaus erottaa toisistaan eri artikkeleihin kuuluvat kehykset sekä määrittämättömät kehykset. Voit näyttää tai kätkeä tämän
värikoodin valitsemalla Näytä > Ekstrat > Näytä/Kätke määritetyt kehykset. Värikoodi näkyy InCopyssa ainoastaan Sivuasettelu-näkymässä.
Huomautus: Jos määritettyjen kehysten näyttäminen tai kätkeminen aiheuttaa yllättäviä tuloksia, kyseiset kehykset on ehkä nimiöity XML:ää
varten ja Näytä > Rakenne > Näytä nimiöidyt kehykset -asetus on ehkä valittu. Määritettyjä kehyksiä ja nimiöityjä kehyksiä ei voi näyttää
samanaikaisesti.
Vaihda Napsauta Vaihda-painiketta, jos haluat määrittää artikkelikansion sijainnin. Artikkelikansio luodaan normaalisti samaan paikkaan kuin
InDesign-tiedosto.
Paikkamerkkikehykset InCopy-käyttäjät näkevät teksti- ja grafiikkakehykset artikkelissa sekä InDesign-sivujen kaikkia muita kehyksiä edustavina
ruutuina (tai muina kuvioina). Kaikki kehykset ja paikkamerkit vastaavat kooltaan, muodoltaan ja sijainniltaan täsmälleen alkuperäisiä InDesign-
kohteita. Paikkamerkkikehykset ovat tyhjiä kuvioita, joissa ei näy mitään InDesign-julkaisun sisällöstä. Paikkamerkkikehykset-asetusta käytettäessä
näytön sisältö poikkeaa eniten todellisesta, mutta suorituskyky on paras mahdollinen. InCopyssa paikkamerkkikehykset näkyvät vain Sivuasettelu-
näkymässä. InCopy-käyttäjät eivät voi uloskirjata ja muokata paikkamerkkikehyksiä.
Määritetyt aukeamat InCopy-käyttäjät näkevät samalla aukeamalla kaikki määritetyt kehykset ja artikkeliin kuulumattomien muiden kehysten
kaikki sisällöt. InCopyssa artikkelin ulkopuolella olevien kehysten sisältö ei ole muokattavissa ja näkyy vain Sivuasettelu-näkymässä.
Kaikki aukeamat Vie InDesign-julkaisun koko sisällön artikkelitiedostoon. Tätä asetusta käytettäessä näytön sisältö vastaa parhaiten todellisuutta.
Toisaalta suorituskyky heikkenee, koska artikkelitiedosto näyttää jokaisen sivun rakenteen ja asettelun, myös niiden sivujen, jotka eivät liity
käyttäjän muokkaamaan osaan.
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Kuvatiedostot linkitettiin pakattaessa Sisällyttää linkitettyjen kuvien kopion artikkelipakkaukseen. Kun tämä asetus on valittu, InCopy-käyttäjät
voivat käsitellä kuvia, mutta pakkaustiedosto suurenee. InCopy-käyttäjät voivat sisällyttää kuvia palauttaessaan pakkauksen.

Sisällön vieminen erillisinä InCopy-tiedostoina (InDesign)
Jos työryhmäsi käsittelee mieluummin erillisiä tiedostoja kuin artikkeleita, voit viedä InCopy-sisällön käyttämättä artikkelitiedostoa. Sen sijaan että
luotaisiin yksi artikkelitiedosto, jossa on viitteitä useisiin sisältötiedostoihin ja sivuasettelutietoihin, tällä menetelmällä luodaan erillinen tiedosto
(.icml) kullekin julkaisussa määritettävälle teksti- tai grafiikkakehykselle. Kun haluat tarkastella muokkaamasi sisällön asiayhteyttä, sinun on
avattava myös sisältöön liittyvä InDesign-julkaisu (.indd).

Muokkaa InDesign-julkaisu vastaamaan työnkulun tarpeita. Jos esimerkiksi haluat, että kaikki toimittajan huomautukset viedään yhteen tiedostoon,
luo erillinen taso toimittajan huomautuksia varten. Tämän jälkeen voit viedä koko valitun tason sisällön.

Huomautus: nopea tapa viedä sisältöä erillisenä InCopy-tiedostona on vetää valitut kehykset valintatyökalulla Artikkelit-paneelin Määrittelemätön
InCopy-sisältö -osaan.

1. Luo InDesignissa vähintään yhden teksti- tai grafiikkakehyksen tai paikkamerkkikohteen sisältävä julkaisu ja tallenna se.
2. Tee jompikumpi seuraavista:

Valitse yhden jutun teksti- tai grafiikkakehys tai valitse useita kehyksiä pitämällä vaihtonäppäintä painettuna.

Aseta kohdistin juttuun tai valitse tekstikehyksestä teksti.

3. Valitse Muokkaa > InCopy > Vie ja valitse sitten jokin seuraavista asetuksista:
Valinta Vie kaikki valitut teksti- ja grafiikkakehykset.

Taso Vie valitun tason kaiken sisällön.

Kaikki jutut Vie kaikki jutut, joita ei ole vielä viety.

Kaikki grafiikka Vie kaikki kuvat, joita ei ole vielä viety.

Kaikki grafiikka ja jutut Vie kaikki jutut ja kuvat, joita ei ole vielä viety.

Jos viet julkaisun kaiken sisällön ja lisäät sitten teksti- tai grafiikkakehyksiä samaan julkaisuun, voit säästää aikaa uuden aineiston
viennissä antamalla uudelleen komennon Vie > Kaikki jutut (tai Kaikki grafiikka tai Kaikki grafiikka ja jutut). InDesign vie ainoastaan uuden
sisällön.

4. Määritä tiedostojen nimet ja sijainnit ja napsauta sitten Tallenna-painiketta.

Määrittämääsi tiedoston nimeä käytetään etuliitteenä, jonka perusteella kukin viety sisältötiedosto tunnistetaan tiedostojärjestelmässä. Jos
viet useita tekstikehyksiä, tiedoston nimeen lisätään automaattisesti tekstin alussa olevia merkkejä, esimerkiksi "omajuttu-tulevat
pyöräilytapahtumat.icml". Jos viet useita grafiikkakehyksiä, tiedostojen nimet muodostuvat seuraavasti: omajuttu-grafiikka, omajuttu-grafiikka-
1, jne. Tiedoston nimi näkyy tiedostojärjestelmässä, InCopyn juttupalkissa ja tilailmoituksissa.

5. Tallenna InDesign-tiedosto pyydettäessä.

InCopy-sisältö on nyt hallittu, ja työnkulun muut käyttäjät voivat uloskirjata sen ja muokata sitä.

Jaettu sisältö näkyy Linkit-paneelissa samanlaisena kuin tuodut kuvat. Jos siirrät jaetun tiedoston manuaalisesti, voit päivittää sen linkin Linkit-
paneelin avulla.

Sisältöä vietäessä tekstikehyksessä (InDesign ja InCopy) ja Artikkelit-paneelissa (InCopy) näkyy Käytettävissä-kuvake . Juttupalkissa (InCopy)
näkyy sana [Muokkaa].

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Tiedostojen tallentaminen
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Julkaisujen tallentaminen
Tallentaminen takaisin aikaisempaan InDesign-versioon
Metatietojen käsitteleminen

Julkaisujen tallentaminen

Julkaisuun tallennetaan nykyinen sivuasettelu, lähdetiedostoviittaukset, tiedot avoimesta sivusta ja zoomaustaso. Varmista työsi säilyminen
tallentamalla se usein. Voit tallentaa julkaisun

tavallisena julkaisuna

julkaisun kopiona, jolloin siitä luodaan kopio eri nimellä kopio ja alkuperäinen jää aktiiviseksi

mallina, joka yleensä avautuu nimettömänä julkaisuna ja jossa on asetuksia, tekstiä ja grafiikkaa muiden julkaisujen pohjaksi.

Julkaisua tallennettaessa myös InDesign-julkaisun metatiedot (eli tiedoston tiedot) päivittyvät. Nämä metatiedot sisältävät miniatyyrikuvan,
julkaisussa käytetyt kirjasimet, värimallit ja kaikki Tietoja tiedostosta -valintaikkunassa olevat metatiedot. Nämä kaikki helpottavat etsimistä.
Voit esimerkiksi etsiä kaikki julkaisut, joissa käytetään tiettyä väriä.

Metatietoja voi tarkastella Bridgessä ja Tiedoston tiedot -valintaikkunan Lisäasetukset-kohdassa. Voit määrittää, päivitetäänkö esikatselu
tallennuksen yhteydessä. Muut metatiedot (kirjasimet, värit ja linkit) päivitetään aina, kun julkaisu tallennetaan.

Tallenna-, Tallenna nimellä- ja Tallenna kopio -komennot tallentavat julkaisut InDesign-muotoisina. Lisätietoja julkaisujen tallentamisesta
muissa tiedostomuodoissa on hakemistossa.

Jos viet tallennetun julkaisun tulostuspalveluun tulostettavaksi, InDesign osaa automaattisesti kerätä samaan kansioon kaikki tarvittavat
tiedostot, kuten linkitetyn grafiikan ja kirjasimet. (Katso Tiedostojen keräily.)

Tiedosto > Tiedoston tiedot -valintaikkunassa annetut tiedot päivitetään Metatiedot-välilehdessä, kun viet EPUB-julkaisun
seuraavissa muodoissa:

Kiinteään asetteluun perustuva EPUB
Uudelleenjuoksutettava EPUB

Tee jokin seuraavista:

Tallenna julkaisu uudella nimellä valitsemalla Tiedosto > Tallenna nimellä ja määrittämällä sijainti ja tiedostonimi. Valitse lopuksi Tallenna.
Uusi tiedosto muuttuu aktiiviseksi tiedostoksi. Tallenna nimellä -komennon käyttäminen voi pienentää tiedoston kokoa.

Tallenna nykyinen julkaisu samalla nimellä valitsemalla Tiedosto > Tallenna.

Tallenna kaikki avoimet julkaisut nykyisiin sijainteihin ja nykyisillä nimillä painamalla Ctrl+Alt+vaihto+S (Windows) tai
komento+optio+vaihto+S (Mac OS).

Tallenna julkaisun kopio uudella nimellä valitsemalla Tiedosto > Tallenna kopio ja määrittämällä sijainti ja tiedostonimi. Valitse lopuksi
Tallenna. Tallennettu kopio ei muutu aktiiviseksi julkaisuksi.

Älä käytä varattuja merkkejä, joilla on joissakin käyttöjärjestelmissä erityismerkityksiä. Älä esimerkiksi käytä tiedostonimiä, jotka
sisältävät välilyöntejä, sarkaimia, kolme pistettä tai seuraavia merkkejä: / \ : ; * ? < > , $ %. Älä myöskään käytä merkkejä, joissa on aksentti
(esimerkiksi ü, ñ tai é). Pyri välttämään näitä merkkejä, vaikka käyttäisit muuta kuin englanninkielistä InDesign-versiota. Voit kohdata ongelmia, jos
tiedosto avataan eri käyttöympäristössä.

Jos työskentelet usein monien julkaisujen parissa, jotka ovat avoinna samaan aikaan ja haluat tallentaa ne kaikki samalla kertaa, käytä
pikanäppäintä. Valitse Muokkaa > Pikanäppäimet ja valitse Kohde-valikosta Näkymät, navigointi ja valitse komentoluettelosta Tallenna kaikki.
Nyt voit muokata pikanäppäintä tai lisätä sellaisen. Voit määrittää Tallenna kaikki -komennon Nopealla käytöllä.

Esikatseluiden sisällyttäminen tallennettuihin julkaisuihin

117

http://idiom-q-win-1/fi/indesign/using/preflighting-files-handoff.html#package_files


Huomautus:

Alkuun

Huomautus:

Julkaisujen ja mallien esikatselu miniatyyreinä helpottaa näiden tiedostojen tunnistamista Adobe Bridgessä ja Adobe Mini Bridgessä.
Esikatselukuva luodaan, kun julkaisu tai malli tallennetaan. Julkaisun esikatselussa on JPEG-kuva vain ensimmäisestä aukeamasta, kun taas
mallin esikatselussa on JPEG-kuva mallin jokaisesta sivusta. Voit määrittää esikatselun sivukoon ja näytettävien sivujen määrän haluamaksesi.
Esimerkiksi Hyvin suuri (1024 x 1024) -kuvakoolla voi nopeasti silmäillä sivun sisällön korkealla resoluutiolla ennen tiedoston avaamista.

Asetuksen voi ottaa käyttöön Asetukset- tai Tallenna nimellä -valintaikkunassa. Esikatselut suurentavat tiedoston kokoa ja julkaisun tallentamiseen
kuluvaa aikaa, joten asetus kannattaa ehkä ottaa käyttöön Tallenna nimellä -valintaikkunassa vain tarvittaessa.

1. Tee jokin seuraavista:

Jos haluat sisällyttää esikatselun aina, kun tallennat julkaisun, valitse Muokkaa > Asetukset > Tiedoston käsittely (Windows) tai
InDesign > Asetukset > Tiedoston käsittely (Mac OS).

Tiettyyn julkaisuun voi sisällyttää esikatselun valitsemalla Tiedosto >Tallenna nimellä.

Tiettyyn julkaisuun voi sisällyttää esikatselun valitsemalla Tiedosto > Tallenna sisältö nimellä.

2. Valitse Tallenna aina esikatselukuvat julkaisujen kanssa.

3. Jos teet esikatseluasetuksia Asetukset-valintaikkunasta, valitse näytettävien sivujen määrä Sivut-valikosta ja valitse jokin asetus
Esikatselukoko-valikosta.

Jos Esikatselu-asetus valitaan Tallenna nimellä -valintaikkunassa, valinta siirtyy myös Asetukset-valintaikkunaan ja esikatselun
kokona ja sivumääränä käytetään oletusasetusta.

InDesign Markup (IDML) -julkaisun tallentaminen

Toisinaan InDesign-tiedostot kannattaa ehkä tallentaa Interchange Markup -muotoon. Tämä tallennusmuoto on hyödyllinen erityisesti avattaessa
QuarkXPress- tai PageMaker-julkaisua InDesignissa, avattaessa aiemmassa InDesign-versiossa luotua julkaisua tai jos julkaisussa esiintyy
esimerkiksi värimallien poistamiseen liittyviä ongelmia.

1. Valitse Tiedosto > Tallenna (CS6) tai Tiedosto > Vie (CS5).

2. Valitse Tallennusmuoto-luettelosta (Windows) tai Muoto-luettelosta (Mac OS) InDesign Markup (IDML).

3. Valitse Tallenna.

Voit avata tallennetun IDML-tiedoston InDesign CS5:ssä ja CS4:ssä, mutta et voi avata sitä aiemmissa InDesign-versioissa.

Lisätietoja IDML-muodon käyttämisestä kehitystarkoituksiin on sivulla www.adobe.com/go/learn_id_indesignmarkup_cs4_fi.

Tallentaminen takaisin aikaisempaan InDesign-versioon

Jos haluat avata InDesign CS6 -asiakirjan InDesign CS5:ssä, tallenna (Tiedosto > Tallenna) ensin InDesign CS6:ssä julkaisu InDesign Markup
Language (IDML) -muodossa. (IDML-muoto korvaa Interchange INX -muodon, jota aikaisemmissa versioissa käytettiin tallentamiseen takaisin
aikaisempaan InDesign-versioon.)

Jos haluat avata InDesign CS5 -asiakirjan InDesign CS4:ssä, tallenna (Tiedosto > Vie) ensin InDesign CS5:ssä julkaisu InDesign Markup
Language (IDML) -muodossa. (IDML-muoto korvaa Interchange INX -muodon, jota aikaisemmissa versioissa käytettiin tallentamiseen takaisin
aikaisempaan InDesign-versioon.)

Varmista, että tietokoneeseen, jossa InDesignin edellinen versio on käynnissä, on päivitetty asianmukaiset laajennukset, jotta viety IDML-tiedosto
voidaan avata. Edellisen InDesign-version käyttäjä voi hakea yhteensopivuuslaajennukset valitsemalla Ohje > Päivitykset ja seuraamalla ohjeita.
Laajennukset voidaan asentaa myös Adoben sivustosta. Siirry Adoben sivuston Tuotepäivitykset-sivulle ja valitse tuoteluettelosta InDesign.

Julkaisun avaamista aikaisemmassa InDesign-versiossa kutsutaan myös ”alastallentamiseksi”.

Joitakin InDesignin uudemman version toiminnoilla luotuja sisältöjä voidaan muokata tai ne voidaan ohittaa, kun avaat julkaisun
InDesignin aikaisemmalla versiolla.

1. Valitse Tiedosto > Tallenna (CS6) tai Tiedosto > Vie (CS5).

2. Valitse Tiedostotyyppi- (Windows) tai Muoto-valikosta (Mac OS) InDesign Markup (IDML).

3. Valitse Tallenna.
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Voit muuntaa .idml-tiedoston nimettömäksi InDesign-julkaisuksi avaamalla sen edellisessä InDesign-versiossa.

Jos haluat avata InDesign CS5 -julkaisun InDesign CS3:ssa, avaa viety IDML-tiedosto InDesign CS4:ssä, tallenna se ja vie se
InDesign CS3 Interchange (INX) .muodossa, ja avaa viety INX-tiedosto InDesign CS3:ssa. Varmista, että kaikki InDesign-versiot ovat ajan tasalla.

Metatietojen käsitteleminen

Metatiedot ovat standardoitu tietojoukko, joka sisältää tiedostoa koskevia tietoja, esimerkiksi tekijän nimen, tarkkuuden, väriavaruuden,
tekijänoikeustiedot ja tiedostolle määritetyt hakusanatiedot. Metatietojen avulla voit parantaa työnkulkua ja järjestellä tiedostoja.

Tietoja XMP-standardista

Metatiedot tallennetaan Extensible Metadata Platform (XMP) -standardin avulla. Adobe Bridge, Adobe Illustrator, Adobe InDesign ja Adobe
Photoshop perustuvat tähän standardiin. XMP perustuu XML-kieleen ja useimmissa tapauksissa metatiedot on tallennettu tiedostoon. Jos
metatietoja ei voi tallentaa itse tiedostoon, metatiedot tallennetaan erilliseen tiedostoon, jota kutsutaan oheistiedostoksi. XMP:n avulla metatietoja
voidaan siirtää Adoben sovellusten ja julkaisutyönkulkujen välillä. Voit esimerkiksi tallentaa yhden tiedoston metatiedot mallina ja tuoda ne muihin
tiedostoihin.

Muissa, kuten EXIF-, IPTC- (IIM), GPS- ja TIFF-muodoissa tallennetut metatiedot synkronoidaan ja kuvataan XMP:llä, joten niitä voidaan
tarkastella ja hallita helposti. Myös muut sovellukset ja toiminnot käyttävät XMP:tä kommunikointiin ja tallentamaan versiokommenttien kaltaisia
tietoja, joita voidaan etsiä Adobe Bridgen avulla.

Useimmissa tapauksissa metatiedot säilyvät, vaikka tiedostomuoto muuttuu esimerkiksi PSD:stä JPG:ksi. Metatiedot säilytetään myös sijoitettaessa
tiedostot Adobe-julkaisuun tai -projektiin.

Metatietojen luomista, käsittelemistä ja siirtämistä voidaan mukauttaa XMP Software Development Kit -paketin avulla. XMP SDK:n avulla voi
esimerkiksi lisätä kenttiä Tiedoston tiedot -valintaikkunaan. Saat lisätietoja XMP:stä ja XMP SDK:sta vierailemalla Adoben Web-sivustolla.

Metatietojen käyttäminen Adobe Bridgessä ja Adobe Creative Suiten komponenteissa

Useat tehokkaat Adobe Bridgen toiminnot antavat mahdollisuuden järjestää, hakea ja jäljittää tiedostoja ja versioita tiedostojen XMP-metatietojen
mukaan. Metatietoja voi käsitellä Adobe Bridgessä kahdella eri tavalla: Metatiedot-paneelin Tiedoston tiedot -valintaikkunan kautta (InDesign) tai
Sisältötiedoston tiedot -valintaikkunan kautta (InCopy).

Joissakin tapauksissa samaa metatieto-ominaisuutta varten on useita näkymiä. Jonkin ominaisuuden nimi voi jossakin näkymässä olla esimerkiksi
Tekijä, kun taas toisessa näkymässä nimi on Laatija, mutta kumpikin viittaa samaan ominaisuuteen. Vaikka mukauttaisit näitä näkymiä tiettyjä
työnkulkuja varten, näkymät säilyvät standardimuotoisina XMP:ssä.

Metatietojen lisääminen käyttämällä Tiedoston tiedot -valintaikkunaa

Tiedoston tiedot -valintaikkunassa näkyvät kameran tiedot, tiedoston ominaisuudet, muokkaushistoria, tekijänoikeustiedot ja tekijän tiedot. Lisäksi
Tietoja tiedostosta -valintaikkunassa näkyvät muokatut metatietopaneelit. Voit lisätä metatietoja suoraan Tiedoston tiedot -valintaikkunassa.
Kenttiin kirjoittamasi tiedot korvaavat olemassa olevat metatiedot, ja uudet arvot koskevat kaikkia valittuja tiedostoja.

1. Valitse Tiedosto >Tietoja tiedostosta (InDesign) tai Tiedosto > Sisältötiedoston tiedot (InCopy).

2. Valitse valintaikkunan yläreunassa olevilta välilehdiltä jokin seuraavista:

Voit selata välilehtiä vasemman- ja oikeanpuoleisen nuolen avulla tai napsauttamalla alaspäin osoittavaa nuolta ja valitsemalla luettelosta
luokan.

Tämän vaihtoehdon avulla voit määrittää tiedostoa koskevia julkaisutietoja, kuten julkaisun otsikon, tekijän, kuvauksen ja julkaisun
hakuun käytettävät avainsanat. Voit määrittää tekijänoikeustiedot valitsemalla Tekijänoikeustila-ponnahdusvalikosta Tekijänoikeus. Kirjoita
sitten tekijänoikeuden haltija, ilmoitusteksti ja tekijänoikeuden haltijan – henkilön tai yrityksen – URL-osoite.

Ikkunassa on neljä aluetta: IPTC-sisältö kuvaa kuvan visuaalista sisältöä. IPTC-yhteyshenkilö-kohdassa on valokuvaajan yhteystiedot.
IPTC-kuva-kohdassa on kuvaavia tietoja kuvasta. IPTC-tila-kohdassa on työnkulku- ja tekijänoikeustietoja.
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Kameran tiedot

Videotiedot

Äänitiedot

Mobiili-SWF

Luokat

Alkuperä

DICOM

Historia

Illustrator

Lisäasetukset

Raw-tiedot

Ikkunassa on kaksi aluetta: Kameran tiedot 1 -kohdassa on kameraa ja kuvattaessa käytettyjä kuvausasetuksia koskevia
tietoja, esimerkiksi valmistaja, malli, valotusaika ja himmenninaukko. Näitä tietoja ei voi muuttaa. Kameran tiedot 2 -kohdassa on
kuvatiedostoa koskevia tietoja, kuten koko pikseleinä ja resoluutio. Näitä tietoja ei voi muuttaa

Videotiedostoa koskevia tietoja, esimerkiksi videoruudun leveys ja korkeus. Voit kirjoittaa nauhan nimen, kohtauksen nimen ja
muita lisätietoja.

Voit kirjoittaa äänitiedostoa koskevia tietoja, esimerkiksi kappaleen nimen, esittäjän, bittitaajuuden ja silmukka-asetukset.

Mobiilimediatiedostoja koskevia tietoja, kuten otsikko, tekijä, kuvaus ja sisältötyyppi.

Tämän vaihtoehdon avulla voidaan määrittää Associated Press -luokkiin pohjautuvat tiedot.

Tämän vaihtoehdon avulla voit määrittää uutiskäyttöön soveltuvia tietoja, kuten tiedoston luontiajankohta ja -paikka, siirtotiedot,
erikoiskäsittelyohjeet ja otsikkotiedot.

Näyttää DICOM-kuvien sisältämät potilas-, tutkimus-, sarja- ja laitetiedot.

Tuo Adobe Photoshop -ohjelmalla tallennettujen kuvien historiatiedot näkyviin. Historia-välilehti on näkyvissä vain, jos Adobe
Photoshop on asennettu.

Voit määrittää tiedostolle profiilin tulostusta, Web-käyttöä tai mobiilikäyttöä varten.

Näyttää metatietojen tallennuskentät ja -rakenteet käyttäen nimiavaruuksia ja ominaisuuksia, kuten tiedostomuotoa sekä
XMP-, EXIF- ja PDF-ominaisuuksia.

Näyttää XMP-tekstietoja tiedostosta.

3. Kirjoita näkyvissä oleviin kenttiin lisättävät tiedot.

4. Toteuta muutokset napsauttamalla OK.

Metatietojen vieminen XMP-tiedostona

Voit tallentaa metatietoja XMP-tiedostoksi, jolloin ne ovat muiden käyttäjien käytettävissä. Näitä XMP-tiedostoja voidaan käyttää malleina
täytettäessä InDesign-julkaisuja ja muita XMP-yhteensopivilla sovelluksilla luotuja tiedostoja. Viedyt mallit tallentuvat jaettuun sijaintiin, jotta ne
olisivat muiden XMP-sovellusten käytettävissä. Lisäksi ne näkyvät Tiedoston tiedot -valintaikkunan alaosan ponnahdusvalikossa.

1. Valitse Tiedosto >Tietoja tiedostosta (InDesign) tai Tiedosto > Sisältötiedoston tiedot (InCopy).

2. Valitse valintaikkunan alaosassa olevasta ponnahdusvalikosta Vie.

3. Kirjoita tiedostonimi, valitse tiedoston sijainti ja napsauta Tallenna.

Voit näyttää metatietomallit Resurssienhallinnassa (Windows) tai Finderissa (Mac OS) valitsemalla Tiedoston tiedot -valintaikkunan
alaosan ponnahdusvalikosta Näytä mallipohjien kansio.

Metatietojen tuominen XMP-tiedostosta

Kun tuot metatietoja viedystä XMP-mallitiedostosta julkaisuun, voit määrittää, poistetaanko kaikki nykyisen julkaisun metatiedot, jolloin uudet
metatiedot lisätään, säilytetäänkö kaikki muut paitsi toisiaan vastaavat metatiedot vai lisätäänkö kaikki vastaavat metatiedot olemassa oleviin
metatietoihin.
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Valitse Tiedosto >Tietoja tiedostosta (InDesign) tai Tiedosto > Sisältötiedoston tiedot (InCopy).

Valitse XMP-tiedosto valintaikkunan alaosan ponnahdusvalikosta, valitse tuontiasetus ja valitse sitten OK.

Valitse valintaikkunan alaosan ponnahdusvalikosta Tuo, valitse tuontiasetus ja valitse sitten OK. Kaksoisnapsauta sitten XMP-
mallitiedostoa, jonka haluat tuoda.

Kuvatiedoston metatietojen muokkaaminen

Kun tuotat kuvatekstit sijoitettujen kuvien metatiedoista InDesignissa, käytetään sijoitetun kuvan metatietoja. Vaikka voitkin muokata InDesign-
julkaisujen metatietoja, et voi muokata InDesigniin sijoitettujen tiedostojen metatietoja. Muuta sen sijaan sijoitettujen kuvien metatietoja niiden
alkuperäisessä sovelluksessa Finderilla, Resurssienhallinnalla, Adobe Bridgellä tai Adobe Mini Bridgellä.

1. Napsauta InDesignissa kuvaa hiiren kakkospainikkeella (Windows) tai paina Ctrl-näppäintä napsauttamisen aikana (Mac OS) ja valitse sitten
Muokkaa alkuperäistä.

Voit myös valita Muokkaa sovelluksella ja valita sitten sovelluksen, kuten Adobe Illustrator tai Adobe Photoshop.

2. Valitse alkuperäisessä sovelluksessa Tiedosto > Tietoja tiedostosta.

3. Muokkaa metatietoja ja valitse sitten OK.

Voit myös valita kuvan Adobe Bridgessä ja muokata kuvan metatietoja valitsemalla Tiedosto > Tietoja tiedostosta. Katso Metatietojen lisääminen
käyttämällä Tiedoston tiedot -valintaikkunaa.

Lisää ohjeaiheita
Adoben metatietojen käsitteleminen
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PageMakerin valikkokomennot

Alkuun

PageMakerin Arkisto-valikon komennot
PageMakerin Muokkaus-valikon komennot
PageMakerin Asettelu-valikon komennot
PageMakerin Muotoilu-valikon komennot
PageMakerin Elementti-valikon komennot
PageMakerin Apuvälineet-valikon komennot
PageMakerin Näkymä-valikon komennot
PageMakerin Ikkunat-valikon komennot

Selaamalla näitä taulukoita voit selvittää, missä Adobe PageMaker -komennot ovat AdobeInDesign CS5:ssä.

PageMakerin Arkisto-valikon komennot

PageMaker-komento Vastaava InDesign-komento Lisätietoja

Arkisto > Uusi Tiedosto > Uusi > Julkaisu  

Tiedosto > Avaa Tiedosto > Avaa  

Arkisto > Äskeiset julkaisut Tiedosto > Avaa äskeinen (Windows®)  

Arkisto > Sulje Arkisto > Sulje  

Tiedosto > Tallenna Tiedosto > Tallenna InDesignissa ei ole asetusta, jolla
valittaisiin nopea tai pieneen kokoon
tallennus. Tallenna-komennolla voit
tallentaa nopeasti, ja Tallenna nimellä -
komennolla voit tallentaa julkaisun
pienimpään mahdolliseen kokoon.

Arkisto > Tallenna nimellä Arkisto > Tallenna nimellä Katso edellistä huomautusta.

Tiedosto > Palauta Tiedosto > Palauta InDesign ei palauta julkaisujen
"minitallennettuja" versioita kuten
PageMaker, vaan siinä on käytettävissä
rajoittamaton määrä Kumoa-tasoja.

Tiedosto > Sijoita Tiedosto > Sijoita  

Arkisto > Hae Vastinetta ei ole Skannaa kuvia skannerin mukana
toimitetulla ohjelmistolla ja sijoita ne sitten
InDesigniin.

Arkisto > Vie Arkisto > Vie  

Arkisto > Linkkien hallinta Ikkuna > Linkit  

Arkisto > Julkaisun asetukset Arkisto > Julkaisun asetukset  

Arkisto > Tulostintyylit Tiedosto > Tulostuksen oletusarvot  

Tiedosto > Tulosta Tiedosto > Tulosta  

Arkisto > Asetukset > Yleiset Muokkaa > Asetukset (Windows) tai
InDesign > Asetukset (Mac OS)

Vastaavat asetukset löytyvät
Koostaminen-, Yksiköt ja lisäykset-,
Apuviivat ja taittopöytä- ja Näytön
suorituskyky -asetusvalintaikkunoista.

Arkisto > Asetukset > Online Vastinetta ei ole Voit vetää objekteja Web-selaimesta
InDesigniin määrittämättä välityspalvelinta.
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Arkisto > Asetukset > Asemoinnin säätö Sivuasettelu > Sivuasettelun säätö Sivuasettelun säädön asetukset
määritetään ja otetaan käyttöön
samanaikaisesti. InDesignin asetukset
ovat melkein samat kuin PageMakerin.
Viivainlinjat noudattavat normaalisti niihin
liittyvien sarakkeiden ja reunusten
apuviivoja. Voit muuttaa tätä asetusta
poistamalla Salli viivainlinjojen siirtyminen -
asetuksen valinnan.

Arkisto > Asetukset > Lihotus Ikkuna > Tuloste > Lihotusoletusarvot Jos haluat määrittää uudet
lihotusasetukset, luo uusi
lihotusoletusarvo.

Arkisto > Lopeta (Windows) tai Arkisto >
Lopeta (Mac OS)

Tiedosto > Lopeta (Windows) tai
InDesign > Lopeta InDesign (Mac OS)

 

PageMakerin Muokkaus-valikon komennot

PageMaker-komento Vastaava InDesign-komento Lisätietoja

Muokkaus > Kumoa Muokkaus > Kumoa InDesignissa on käytettävissä
rajoittamaton määrä Kumoa-tasoja.

Muokkaus > Leikkaa Muokkaus > Leikkaa  

Muokkaus > Kopioi Muokkaus > Kopioi  

Muokkaus > Liitä Muokkaus > Liitä InDesign ei tue OLE-menetelmää, mutta
vastaavia asetuksia voi määrittää Linkit-
paneelin avulla.

Muokkaa > Tyhjennä Muokkaa > Tyhjennä  

Muokkaus > Valitse kaikki Muokkaus > Valitse kaikki  

Muokkaus > Poista kaikkien valinta Muokkaus > Poista kaikkien valinta  

Muokkaa > Julkaisut (Mac OS) Vastinetta ei ole InDesign ei tue Publish/Subscribe-
menetelmää, mutta vastaavia asetuksia
voi määrittää Linkit-paneelin avulla.

Muokkaus > Sijoita monta Muokkaa > Askel ja toisto  

Muokkaus > Sijoita määräten Muokkaa > Liitä ilman muotoiluja  

Muokkaa > Lisää kohde (Windows) Tiedosto > Sijoita  

Muokkaus > Muokkaa juttua Muokkaa > Muokkaa juttueditorissa  

Muokkaus > Muokkaa alkuperäistä Muokkaus > Muokkaa alkuperäistä Voit myös valita Linkit-paneelivalikosta
Muokkaa alkuperäistä.

Muokkaus > Näytä apupöytä (Mac OS) Vastinetta ei ole  

PageMakerin Asettelu-valikon komennot

PageMaker-komento Vastaava InDesign-komento Lisätietoja

Asemointi > Siirry sivulle Asemointi > Siirry sivulle Voit siirtyä sivulle myös
kaksoisnapsauttamalla sivukuvaketta
Sivut-paneelissa.
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Asemointi > Lisää sivu Asettelu > Sivut > Lisää sivut  

Asemointi > Poista sivut Asettelu > Sivut > Poista sivut  

Asemointi > Lajittele sivut Ikkuna > Sivut Lajittele sivut napsauttamalla ja vetämällä
niitä Sivut-paneelissa.

Asettelu > Palaa takaisin Asettelu > Palaa takaisin  

Asettelu > Siirry eteenpäin Asettelu > Siirry eteenpäin  

Asemointi > Palstalinjat Asettelu > Reunukset ja palstat  

Asemointi > Kopioi sivupohjalinjat Vastinetta ei ole InDesignin kaikkien sivupohjien apuviivat
kopioituvat aina sivuille, joilla sivupohjaa
käytetään.

Asemointi > Automaattijuoksutus Kun ladatun tekstin kuvake  on
näkyvissä, paina vaihtonäppäintä.

Voit juoksuttaa tekstin manuaalisesti,
automaattisesti (automaattisella
juoksutuksella) tai puoliautomaattisesti.

PageMakerin Muotoilu-valikon komennot

PageMaker-komento Vastaava InDesign-komento Lisätietoja

Muotoilu > Kirjasin Muotoilu > Kirjasin  

Teksti > Koko Teksti > Koko  

Muotoilu > Riviväli Teksti > Merkki tai Ohjauspaneeli Merkki-
tilassa (Ikkuna > Ohjaus)

InDesign käyttää normaalisti perusviivan
rivivälistystä eikä suhteellista rivivälistystä,
joka on PageMakerin oletusarvo.

Muotoilu > Kirjasintyyli Teksti > Merkki tai Ohjauspaneeli Merkki-
tilassa (Ikkuna > Ohjaus)

InDesign näyttää valitulle kirjasimelle
käytettävissä olevat kirjasintyylit. Voit valita
myös Nopea käyttö -toiminnon.

Muotoilu > Erikoisparivälistys Teksti > Merkki tai Ohjauspaneeli Merkki-
tilassa (Ikkuna > Ohjaus)

PageMakerin erikoisparivälistys vastaa
InDesignin optista parivälistystä.

Muotoilu > Vaakaskaalaus Ohjauspaneeli Merkki-tilassa (Ikkuna >
Ohjaus)

 

Teksti > Merkki Teksti > Merkki  

Teksti > Kappale Teksti > Kappale  

Muotoilu > Sisennys/sarkain Teksti > Sarkaimet  

Muotoilu > Tavutus Teksti > Kappale Valitse Kappale-välilehden valikosta
Tavutus.

Muotoilu > Linjaus Teksti > Kappale tai Ohjauspaneeli
Kappale-tilassa (Ikkuna > Ohjaus)

 

Muotoilu > Tyyli Teksti > Kappaletyylit tai Teksti >
Merkkityylit

InDesign tukee sekä kappale- että
merkkityylejä.

Muotoilu > Tyylimäärittelyt Teksti > Kappaletyylit tai Teksti >
Merkkityylit

Luo kappaletyyli valitsemalla Kappaletyylit-
paneelista Uusi kappaletyyli. Luo
merkkityyli valitsemalla Merkkityylit-
paneelista Uusi merkkityyli.

PageMakerin Elementti-valikon komennot
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PageMaker-komento Vastaava InDesign-komento Lisätietoja

Elementti > Täyttö Ikkuna > Väri > Värimallit tai Ikkuna > Väri
> Väri

InDesign ei tue kuvioituja täyttöjä.
InDesignin Värimallit-paneeli vastaa
PageMakerin Värit-palettia.

Elementti > Viiva Ikkuna > Viiva Valitse viivatyyli Viiva-paneelista tai
määritä mukautettu viivatyyli.

Elementti > Täyttö ja viiva Ikkuna > Väri > Värimallit, Ikkuna > Viiva
ja Ikkuna > Tuloste > Määritteet

Luo sävyjä Värimallit-paneelin avulla.
Määritä päällepainatus Määritteet-
paneelissa.

Elementti > Kehys > Liitä sisällys Vastinetta ei ole InDesign luo automaattisesti kehyksen
tuoduille tekstitiedostoille ja grafiikalle. Jos
haluat liittää sisällön aiemmin luotuun
kehykseen, valitse kehys ja liitä tai sijoita
sisältö siihen.

Elementti > Alue > Alueen asetukset Objekti > Tekstikehyksen asetukset (vain
tekstikehykset) tai Objekti > Täyttö

Määritä tekstikehysten palstat, pystytasaus
ja vieruksen leveys Tekstikehyksen
asetukset -valintaikkunassa. Määritä
vaakatasaus Kappale-paneelissa (Teksti >
Kappale). Sovita grafiikka- tai
tekstikehysten sisältö kehykseen (tai
päinvastoin) Objekti > Sovita -valikon
komennoilla.

Elementti > Kehys > Vaihda kehykseksi Objekti > Sisältö > [sisältötyyppi]  

Elementti > Alue> Seuraava alue Näytä > Ekstrat > Näytä tekstiketjut  

Elementti > Alue> Edellinen alue Näytä > Ekstrat > Näytä tekstiketjut  

Elementti > Alue > Poista ketjuista Ketju katkaistaan kaksoisnapsauttamalla
sisä- tai ulkoporttia.

 

Elementti > Alue > Poista sisällys Valitse kehyksen sisältö ja paina Delete-
näppäintä.

Valitse teksti tekstityökalulla. Valitse
grafiikka suoravalintatyökalulla.

Elementti > Järjestä Objekti > Järjestä  

Elementti > Linjaa kohteet (Windows) tai
Elementti > Linjaa (Mac OS)

Ikkuna > Objekti ja asettelu > Tasaa  

Elementti > Tekstin kierrätys Ikkuna > Tekstinkierrätys  

Elementti > Ryhmitä Objekti > Ryhmitä  

Elementti > Pura ryhmitys Objekti > Pura ryhmä  

Elementti > Lukitse paikka Objekti > Lukitse paikka  

Elementti > Poista lukitus Objekti > Poista paikan lukitus  

Elementti > Maskaus Objekti > Rajaava reitti Voit peittää kuvan myös luomalla
maskikuvion, kopioimalla maskattavan
kuvan ja liittämällä sen sitten kuvioon
(Muokkaa > Liitä kohteeseen) tai
säätämällä kuvan grafiikkakehystä.

Elementti > Peru maskaus Objekti > Rajaava reitti Katso edellistä huomautusta.

Elementti > Kuva> Kuvan hallinta Vastinetta ei ole Voit valita Muokkaa alkuperäistä -
komennon ja sitten muuttaa kuvan
ohjausasetuksia lähdesovelluksessa.

Elementti > Kuva > CMS-lähde Objekti > Kuvan väriasetukset  

Elementti > Kuva > Photoshop-tehosteet Objekti > Tehosteet  
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Elementti > Monikulmion asetukset Kaksoisnapsauta työkalupaneelin
monikulmiotyökalua.

 

Elementti > Pyöreät kulmat Objekti > Kulma-asetukset  

Elementti > Linkkitiedot Ikkuna > Linkit Valitse Linkit-paneelivalikosta Linkkitiedot.

Elementti > Linkitysasetukset Tekstiasetukset tai Ikkuna > Linkit Valitse tiedoston käsittelyasetuksissa Luo
linkit tekstiä ja laskentataulukkotiedostoja
sijoitettaessa -asetus tai poista sen valinta.
Voit myös valita Linkit-paneelivalikosta
Poista linkitys.

Elementti > Tulostumattomat Ikkuna > Tuloste > Määritteet  

Elementti > Poista muutos Vastinetta ei ole  

PageMakerin Apuvälineet-valikon komennot

PageMaker-komento Vastaava InDesign-komento Lisätietoja

Apuvälineet > Plug-init Ohje > Määritä laajennukset (Windows) tai
InDesign > Määritä laajennukset (Mac OS)

 

Apuvälineet > Etsi Muokkaa > Etsi/Muuta Voit käyttää Etsi- ja Muuta-toimintoja
asettelunäkymässä ja juttueditorissa.

Apuvälineet.> Etsi seuraava Muokkaa > Etsi seuraava Katso edellistä huomautusta.

Apuvälineet > Muuta Muokkaa > Etsi/Muuta Katso edellistä huomautusta.

Apuvälineet > Oikoluku Muokkaa > Oikeinkirjoitus >
Oikeinkirjoituksen tarkistaminen

Voit tarkistaa oikeinkirjoituksen
asettelunäkymässä tai juttueditorissa.

Apuvälineet > Kirja Tiedosto > Uusi > Kirja Voit lisätä, poistaa ja lajitella kirjan
julkaisuja Kirja-paneelin avulla.

Apuvälineet > Hakemistoviittaus Ikkuna > Teksti ja taulukot > Hakemisto Lisää hakemistoviittaus napsauttamalla
Hakemisto-paneelin Uusi-painiketta.

Apuvälineet > Näytä hakemisto Hakemisto-paneeli Viittaus-tilassa
(Ikkuna > Teksti ja taulukot > Hakemisto)

 

Apuvälineet > Luo hakemisto Ikkuna > Teksti ja taulukot > Hakemisto Valitse Hakemisto-paneelin valikosta Luo
hakemisto.

Apuvälineet > Luo sisällysluettelo Sivuasettelu > Sisällysluettelo  

Apuvälineet > Anna värimäärittelyt Ikkuna > Väri > Värimallit Valitse Värimallit-paneelivalikosta Uusi
värimalli.

PageMakerin Näkymä-valikon komennot

PageMaker-komento Vastaava InDesign-komento Lisätietoja

Näkymä > Näytä sivupohjan kohteet Valitse Sivut-paneelivalikosta Kätke/näytä
sivupohjakohteet

 

Näkymä > Näytä tulostumattomat kohteet Näytä tulostumattomat kohteet
valitsemalla työkalupaneelista Normaali
näyttötila . Kätke tulostumattomat
kohteet valitsemalla Esikatselutila .

Voit myös luoda tason objekteille, joiden
et halua tulostuvan, ja sitten näyttää tai
kätkeä tason tulostamisen tai viemisen
yhteydessä.
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Näkymä > Lähennä Näkymä > Lähennä  

Näkymä > Loitonna Näkymä > Loitonna  

Näytä > Todellinen koko Näytä > Todellinen koko  

Näkymä > Sovita ikkunaan Näytä > Sovita sivu ikkunaan tai Näytä >
Sovita aukeama ikkunaan

 

Näkymä > Koko taittopöytä Näkymä > Koko taittopöytä  

Näkymä > Zoomaa kokoon Valitse julkaisuikkunan alareunassa
olevasta zoomausvalikosta
suurennusprosentti.

 

Näkymä > Näytä/Kätke viivaimet Näkymä > Näytä/Kätke viivaimet  

Näkymä > Tartu viivaimiin Vastinetta ei ole  

Näkymä > Origon lukitus Napsauta hiiren kakkospainikkeella
(Windows) tai Control-osoita (Mac OS)
nollakohtaa ja valitse pikavalikosta Lukitse
nollakohta.

 

Näkymä > Näytä/Kätke apuviivat Näytä > Ruudukot ja apuviivat >
Näytä/Kätke apuviivat

 

Näkymä > Tartu apuviivoihin Näytä > Ruudukot ja apuviivat > Tartu
apuviivoihin

 

Näkymä > Lukitse apuviivat Näytä > Ruudukot ja apuviivat > Lukitse
apuviivat ja Näytä > Ruudukot ja
apuviivat > Lukitse sarakeapuviivat

 

Näkymä > Pyyhi viivainlinjat Valitse kaikki nykyisen aukeaman
apuviivat painamalla Ctrl+Alt+G
(Windows) tai komento+optio+G (Mac OS)
ja paina sitten Delete-näppäintä.

 

Näkymä > Vie apuviivat taakse Muokkaa > Asetukset > Apuviivat ja
taittopöytä (Windows) tai InDesign >
Asetukset > Apuviivat ja taittopöytä
(Mac OS)

Valitse Apuviivat taustalla -asetus.

Näkymä > Kätke/Näytä vierityspalkit Vastinetta ei ole  

PageMakerin Ikkunat-valikon komennot

PageMaker-komento Vastaava InDesign-komento Lisätietoja

Ikkunat > Järjestä symbolit (Windows) Vastinetta ei ole  

Ikkunat > Vierekkäin Ikkuna > Järjestä > Vierekkäin  

Ikkunat > Limittäin Ikkuna > Järjestä > Limittäin  

Ikkunat > Kätke/Näytä työkalut Ikkuna > Työkalut  

Ikkunat > Kätke/Näytä Ohjauspaneeli Ikkuna > Ohjaus  

Ikkunat > Kätke/Näytä värit Ikkuna > Väri > Värimallit tai Ikkuna > Väri
> Väri

 

Ikkunat > Kätke/Näytä tyylit Ikkuna > Tyylit > Kappaletyylit tai
Merkkityylit

 

Ikkunat > Kätke/Näytä tasot Ikkuna > Tasot  
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Ikkunat > Kätke/Näytä sivupohjat Ikkuna > Sivut  

Ikkunat > Kätke/Näytä hyperlinkit Ikkuna > Vuorovaikutteinen > Hyperlinkit  

Ikkunat > Plug-in-paletit Vastinetta ei ole Laajennukset näkyvät lisävaihtoehtoina
InDesignin valikoissa, paneeleissa ja
valintaikkunoissa.

Ikkuna > [avoimen julkaisun nimi] Ikkuna > [avoimen julkaisun nimi]  

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma

128

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fi/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fi


QuarkXPress- ja PageMaker-julkaisujen muuntaminen

Alkuun

QuarkXPress-tiedostojen avaaminen InDesignissa
PageMaker-julkaisujen muuntaminen

QuarkXPress-tiedostojen avaaminen InDesignissa
InDesign voi muuntaa QuarkXPress 3.3- ja 4.1x-ohjelmien julkaisu- ja mallitiedostoja. InDesign voi myös muuntaa julkaisu- ja mallitiedostoja
monikielisistä QuarkXPress Passport 4.1x -tiedostoista, joten tiedostoja ei enää tarvitse tallentaa ensin yksikielisiksi. (Voit muuntaa
QuarkXPress 5.0:n tai myöhemmän version julkaisuja avaamalla julkaisut uudelleen QuarkXPress-ohjelmassa ja tallentamalla ne 4.0-muotoon.)

Lisätietoja on QuarkXPress Conversion Guide -muuntamisoppaassa (PDF-tiedosto) osoitteessa www.adobe.com/go/learn_quarkconv_fi.

QuarkXPress-julkaisun tai -mallin avaaminen
1. Varmista, että tiedosto on suljettu alkuperäisessä sovelluksessa.
2. Varmista linkkien säilyminen kopioimalla kaikki linkitetyt tiedostot samaan PageMaker- tai QuarkXPress-julkaisukansioon.
3. Valitse InDesignissa Tiedosto > Avaa.
4. Valitse Windowsissa tiedostotyypiksi QuarkXPress (3.3-4.1x) tai QuarkXPress Passport (4.1x).
5. Valitse tiedosto ja napsauta Avaa-painiketta.

Huomautus: jos InDesign ei pysty muuntamaan tiedostoa tai tiedoston osaa, näyttöön tulee ilmoitus, jossa ilmoitetaan muunnoksen tulokset
ja selitetään, miksi muuntaminen epäonnistui.

6. Jos ilmoitus tulee esiin, toimi seuraavasti:

Jos haluat tallentaa ilmoituksen kopion tekstitiedostona, valitse Tallenna ja avaa tiedosto sitten InDesignissa.

Sulje ilmoitus valitsemalla Sulje ja avaa tiedosto InDesignissa.

7. QuarkXPress-ohjelmassa käytetty tekstinkierrätys muuntuu tarkasti, kun toimit seuraavasti InDesignissa:

Valitse Asetukset-valintaikkunan Koostaminen-kohdasta Tekstinkierrätys vaikuttaa vain alla olevaan tekstiin.

Liitä Adoben yksirivinen koostaja Kappale-paneelivalikossa vähintään yhteen kappaleeseen.

Jos muunnetun QuarkXPress-julkaisun käytössä esiintyy ongelmia, tallenna julkaisu InDesign Markup (IDML) -muodossa Vie-valintaikkunassa.
Avaa sitten IDML-tiedosto ja tallenna se InDesign-julkaisuna.

QuarkXPress-mallin tallentaminen InDesign-mallina
1. Avaa malli InDesignissa.
2. Valitse Tiedosto > Tallenna nimellä ja määritä sijainti ja tiedostonimi.
3. Valitse Tallennusmuoto- (Windows) tai Muoto-kohdassa (Mac OS) InDesign -malli ja valitse Tallenna.

QuarkXPressistä muunnettavat kohteet
Kun avaat QuarkXPress-tiedoston, InDesign muuntaa alkuperäisen tiedoston tiedot alkuperäisiksi InDesign-tiedoiksi:

Tekstiruudut muunnetaan InDesign-tekstikehyksiksi.

Voit muuntaa QuarkXPress-ohjelmassa käytetyn tekstinkierrätyksen tarkasti valitsemalla Asetukset-valintaikkunan Koostaminen-kohdasta
Tekstinkierrätys vaikuttaa vain alla olevaan tekstiin.

Tyylit muunnetaan InDesign-tyyleiksi.

QuarkXPress käyttää eri väriprofiileja, joten InDesign ohittaa ne.

Teksti- ja grafiikkalinkit säilytetään, ja ne näkyvät Linkit-paneelissa.

Huomautus: Alkuperäiseen julkaisuun Liitä-komennolla upotettua kuvaa ei muunneta. Lisätietoja upotetuista kuvista: Tietoja linkeistä ja
upotetuista kuvista.

InDesign ei tue OLE- tai Quark XTensions -objekteja. Avatun OLE- tai Quark XTensions -grafiikkaa sisältävän tiedoston grafiikka ei näy
InDesign-julkaisussa. Jos QuarkXPress-julkaisun muuntaminen ei onnistu, tarkista alkuperäinen julkaisu ja poista kaikki XTensionilla
luodut objektit. Tallenna julkaisu ja yritä muuntaa se uudelleen.

Kaikki sivupohjat ja tasot muunnetaan InDesign-sivupohjiksi ja -tasoiksi.

Kaikki sivupohjaobjektit ja QuarkXPress-apuviivat sijoitetaan vastaavaan InDesign-sivupohjaan.
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Ryhmitetyt objektit pysyvät ryhmitettyinä. Poikkeuksen muodostavat ryhmän tulostumattomat objektit.

Kaikki viivat (myös kappaleviivat) muunnetaan viivaa lähinnä muistuttavaksi viivatyyliksi. Mukautetut viivat ja katkoviivat muunnetaan
mukautetuiksi InDesign-viivoiksi ja -katkoviivoiksi.

Värit muunnetaan tarkasti InDesign-väreiksi seuraavia poikkeuksia lukuun ottamatta:

QuarkXPressin moniväriset painovärit muunnetaan sekoitetuiksi InDesign-painoväreiksi, ellei monivärinen painoväri sisällä vähintään yhtä
spottiväriä. Tässä tapauksessa monivärinen painoväri muunnetaan prosessiväriksi.

Värikirjaston QuarkXPress 4.1 -värit muunnetaan CMYK-arvojen mukaan.

QuarkXPress 3.3 HSB -värit muunnetaan RGB-väreiksi ja värikirjaston värit muunnetaan CMYK-arvojen mukaan.

QuarkXPress 4.1 HSB- ja LAB-värit muunnetaan RGB-väreiksi ja värikirjaston värit muunnetaan RGB-/CMYK-arvojen mukaan.

Voit etsiä lisätietoja muuntamiseen liittyvistä kysymyksistä Adobe-tukisivustosta osoitteessa www.adobe.com/fi/support.

PageMaker-julkaisujen muuntaminen
InDesign voi muuntaa julkaisu- ja mallitiedostoja Adobe PageMaker 6.0:sta ja sitä uudemmista versioista. InDesign muuntaa alkuperäisen
PageMaker -tiedoston tiedot alkuperäisiksi InDesign-tiedoiksi. InDesign-tiedostot tallennetaan .indd-tiedostotunnisteella.

Lisätietoja on PageMaker Conversion Guide -muuntamisoppaassa (PDF-tiedosto) osoitteessa www.adobe.com/go/learn_pmconv_fi.

Toimi seuraavasti, ennen kuin avaat julkaisun InDesignissa:

Jos PageMaker-tiedosto tai siihen linkitetty grafiikka sijaitsee verkkopalvelimella, levykkeellä tai siirrettävässä, sen avaaminen ei ehkä
onnistu, jos tiedonsiirto keskeytyy. Jotta tiedonsiirto-ongelmia ei esiintyisi, kopioi julkaisut ja niiden linkit kiintolevylle mieluiten samaan
kansioon, johon PageMaker-julkaisu on tallennettu, ennen kuin avaat ne InDesignissa.

Tarpeettomat piilotiedot kannattaa poistaa käyttämällä PageMakerin Tallenna nimellä -toimintoa.

Linkkien säilymisen voi varmistaa kopioimalla kaikki linkitetyt tiedostot siihen kansioon, johon PageMaker-julkaisu on tallennettu.

Varmista, että kaikki tarvittavat kirjasimet ovat käytettävissä InDesignissa.

Korjaa katkenneet grafiikkalinkit PageMaker-julkaisussa.

Jos suuren PageMaker-julkaisun muuntamisessa esiintyy ongelmia, etsi ongelmakohta muuntamalla julkaisu osa kerrallaan.

Jos vahingoittunutta PageMaker-julkaisua ei voi avata PageMakerissa, sen avaamista kannattaa yrittää InDesignissa, InDesign voi palauttaa
useimmat julkaisut, joita PageMaker ei voi avata.

PageMaker-julkaisun tai -mallin avaaminen

1. Varmista, että tiedosto on suljettu alkuperäisessä sovelluksessa.

2. Valitse InDesignissa Tiedosto > Avaa.

3. Valitse Windowsissa tiedostomuodoksi PageMaker (6.0-7.0).

4. Valitse tiedosto ja napsauta Avaa-painiketta.

Huomautus: jos InDesign ei pysty muuntamaan tiedostoa tai tiedoston osaa, näyttöön tulee ilmoitus, jossa ilmoitetaan muunnoksen tulokset
ja selitetään, miksi muuntaminen epäonnistui.

5. Jos ilmoitus tulee esiin, toimi seuraavasti:

Jos haluat tallentaa ilmoituksen kopion tekstitiedostona, valitse Tallenna ja avaa tiedosto sitten InDesignissa.

Avaa tiedosto InDesignissa tallentamatta tekstitiedostoa napsauttamalla Sulje-painiketta.

Jos muunnetun PageMaker-julkaisun käytössä esiintyy ongelmia, tallenna julkaisu InDesign Markup (IDML) -muodossa Vie-valintaikkunassa.
Avaa sitten IDML-tiedosto ja tallenna se InDesign-julkaisuna.

PageMaker-mallin tallentaminen InDesign-mallina

1. Avaa malli InDesignissa.

2. Valitse Tiedosto > Tallenna nimellä ja määritä sijainti ja tiedostonimi.

3. Valitse Tallennusmuoto- (Windows) tai Muoto-kohdassa (Mac OS) InDesign -malli ja valitse Tallenna.

Tietoja PageMakerin muunto-ongelmista
Pidä mielessä seuraavat:

Kaikki sivupohjat ja tasot muunnetaan InDesign-sivupohjiksi ja -tasoiksi. PageMakerin sivupohjat muunnetaan InDesignin sivupohjiksi, joissa
säilyvät kaikki objektit, myös sivunumerointi ja apuviivat. Säilyttääkseen limittäisten kohteiden järjestyksen InDesign luo PageMaker-julkaisua

130

http://www.adobe.com/fi/support
http://www.adobe.com/go/learn_pmconv_fi


muuntaessaan kaksi tasoa: oletussivun ja oletussivupohjan. Oletussivupohja sisältää sivupohjan kohteet.

PageMaker-julkaisun apuviivat sijoitetaan InDesignin oletustasolle.

Kaikki PageMakerin taittopöydän kohteet näytetään InDesign-julkaisun ensimmäisen aukeaman taittopöydällä.

PageMakerissa tulostumattomiksi määritetyt objektit muunnetaan niin, että InDesignin Määritteet-paneelissa on valittuna Tulostumaton-
vaihtoehto.

Ryhmitetyt objektit pysyvät ryhmitettyinä. Poikkeuksen muodostavat ryhmän tulostumattomat objektit.

Tietoja tekstin ja taulukoiden muuntamisesta
Pidä mielessä seuraavat:

Teksti muunnetaan InDesign-tekstikehykseksi.

PageMaker-tiedostojen taulukot muunnetaan InDesign-taulukoiksi.

Tyylit muunnetaan InDesign-tyyleiksi. PageMakerin [Ei tyyliä] vastaa InDesignin [Ei kappaletyyliä] -asetusta. [Ei kappaletyyliä] kuitenkin poimii
nimetyn tyylin määritteet, jos tyyli oli valittuna, ennen kuin PageMaker-julkaisussa kirjoitettiin.

InDesign käyttää Adoben kappaleiden koostajaa kaikkiin kappaleisiin, jolloin osa tekstistä siirtyy. Jos haluat luoda PageMakerin
koostamislaajennuksen tyylisiä rivivaihtoja, voit määrittää Adoben yksirivisen koostajan yhteen tai useaan kappaleeseen, mutta osa tekstistä
voi silti siirtyä.

InDesign käyttää vain perusviivan rivivälistystä. PageMakerin suhteellinen ja versaalikorkeuden rivivälistys muunnetaan InDesignissa
perusviivan rivivälistykseksi, jolloin osa tekstistä voi siirtyä.

Muunnetun tekstin ensimmäinen perusviiva voi näyttää erilaiselta kuin InDesignissa luotu teksti. Muunnetun tekstin Ensimmäinen perusviiva -
asetuksena on Rivivälistys, mutta InDesignissa luodun tekstin Ensimmäinen perusviiva -oletusasetuksena on Yläpidennys.

InDesign käyttää erilaista tavutustapaa kuin PageMaker, ja siksi rivivaihdot voivat olla erilaiset.

Varjostettu teksti muunnetaan pelkäksi tekstiksi. Ääriviivateksti muunnetaan tekstiksi, jossa on 0,25 tuuman viiva ja täyttönä Paperi.

Tietoja kirjojen, hakemistojen ja sisällysluetteloiden muuntamisesta
Pidä mielessä seuraavat:

InDesign ohittaa kirjaluettelot avatessaan PageMaker-julkaisuja. Jos haluat avata kaikki kirjaluettelon julkaisut yhdessä, valitse asetteluksi Ei
mitään ja käytä PageMakerin Tee kirjanen -laajennusta. Huomaa, että tekstilohkoja ja -kehyksiä ei ketjuteta.

PageMaker-julkaisun hakemistoviittaukset näkyvät InDesignin Hakemisto-paneelissa. Katso tässä- ja Katso tässä myös -asetuksia käyttäviä
ristiviittauksia sisältävä teksti osoitetaan Katso- ja Katso myös -asetuksiin.

Sisällysluettelon teksti muunnetaan sisällysluetteloksi, ja PageMakerin sisällysluettelotyyli on käytettävissä InDesignin
sisällysluettelovalintaikkunan tyylivalikossa.

Tietoja linkitettyjen ja upotettujen sisältöjen muuntamisesta
Pidä mielessä seuraavat:

Teksti- ja grafiikkalinkit säilytetään, ja ne näkyvät Linkit-paneelissa.

Jos InDesign ei löydä alkuperäistä grafiikkalinkkiä, esiin tulee ilmoitus, joka pyytää korjaamaan linkin PageMakerissa.

InDesign ei tue OLE-menetelmää, ja siksi OLE-grafiikkaa sisältävän avattavan tiedoston grafiikka ei näy InDesign-julkaisussa.

Tietoja värien ja lihotuksen muuntamisesta
Pidä mielessä seuraavat:

Värit muunnetaan tarkasti InDesign-väreiksi. PageMakerin HLS-värit muunnetaan RGB-väreiksi ja muiden värikirjastojen värit muunnetaan
niiden CMYK-arvojen mukaan.

Sävyt muunnetaan perusvärin prosentuaalisiksi arvoiksi. Jos perusväriä ei ole Värimallit-paneelissa, se lisätään sinne muuntamisen aikana.
Kun sävyä käyttävä objekti valitaan, perusväri valitaan Värimallit-paneelista ja sävyn arvo näkyy valikossa.

PageMaker-tiedostojen väriprofiilit muunnetaan suoraan. Kaikki Hexachrome-värit muunnetaan RGB-arvoiksi. Jos profiili ei ole ICC-
yhteensopiva, se korvataan käyttämällä värienhallinnan oletusasetuksia ja InDesignissa määritettyjä profiileja.

Kaikki viivat (myös kappaleviivat) muunnetaan viivaa lähinnä muistuttavaksi oletusviivatyyliksi. Mukautetut viivat ja katkoviivat muunnetaan
mukautetuiksi InDesign-viivoiksi ja -katkoviivoiksi.

InDesign ei tue Kuvan hallinta -toiminnolla TIFF-kuviin käytettyjä rasterimalleja tai -kulmia vaan jättää ne pois tuoduista TIFF-tiedostoista.

Kun PageMakerin Lihotusoletukset-valintaikkunasta valitaan Mustien viivojen tai täyttöjen automaattinen päälletulostus (tai molemmat), asetus
siirtyy myös InDesigniin, mutta Määritteet-paneelin Viivan päällepainatus- tai Täytön päällepainatus -toiminnon valinta poistetaan.

Lisätietoja PageMaker-muuntamiseen liittyvistä seikoista on Adoben Web-sivuston teknisen tuen ohjeissa.

Lisää ohjeaiheita
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Artikkelipakkaukset

Alkuun

Pakkausten luominen ja lähettäminen (InDesign)
Pakkausten vastaanottaminen (InCopy)
Palautuspakkausten vastaanottaminen (InDesign)

Pakkausten luominen ja lähettäminen (InDesign)
Ihannetapauksessa kaikilla InDesign- ja InCopy-käyttäjillä on yhteys palvelimeen, johon artikkelitiedostot on tallennettu. Jos kuitenkin yhdellä tai
usealla käyttäjällä ei ole yhteyttä yhteiseen palvelimeen, voit luoda ja jakaa tiivistettyjä artikkelipakkauksia. Käsiteltyään artikkelia InCopy-käyttäjä
pakkaa artikkelin uudelleen ja palauttaa sen integroitavaksi InDesign-julkaisuun. InDesignissa luodut pakkaustiedostot sisältävät tiedostopäätteen
.icap. InCopyssa luodut palautuspakkaustiedostot sisältävät tiedostopäätteen .idap.

Tiedostojen pakkaamista varten on kaksi komentoa: Paketti: InCopy ja Pakkaa ja sähköpostita. Paketti: InCopy -komennolla luodaan tiivistetty
pakkaus, joka voidaan jakaa manuaalisesti. Pakkaa ja sähköpostita -komennolla luodaan tiivistetty pakkaus, joka liitetään sähköpostiviestiin
automaattisesti.

Huomautus: Älä sekoita artikkelipakkausta InDesignin Tiedosto > Keräily -komennon kanssa, jolla voit kerätä ja lähettää julkaisun ja sen kohteet
tulostimelle.

Pakkauksen luominen manuaalista jakelua varten
1. Luo artikkeli ja lisää pakettiin kuuluva sisältö.

Vain sisäänkirjattu sisältö voidaan liittää pakattuun artikkeliin. Jos jokin osa sisällöstä on uloskirjattu, InDesign kehottaa sisäänkirjaamaan
sen.

2. Valitse artikkeli Artikkelit-paneelista ja valitse paneelivalikosta Pakkaa InCopya varten.
3. Määritä pakkaustiedoston nimi ja sijainti ja napsauta Tallenna-painiketta.

Voit liittää pakkaustiedoston sähköpostiviestiin, lähettää sen FTP-palvelimeen tai kopioida sen levylle tai muuhun ulkoiseen tallennusvälineeseen.

Huomautus: jos valitset pakkauksen luomisen jälkeen Muokkaa > Kumoa, InDesign peruuttaa pakkauksen ja avaa artikkelin osien lukituksen,
mutta ei poista pakkaustiedostoa tietokoneesta eikä estä sähköpostin lähettämistä.

Pakkauksen luominen sähköpostia varten (InDesign)
1. Luo artikkeli ja lisää pakettiin kuuluva sisältö.

Vain sisäänkirjattu sisältö liitetään pakattuun artikkeliin. Jos jokin osa sisällöstä on uloskirjattu, InDesign kehottaa sisäänkirjaamaan sen.

2. Valitse artikkeli Artikkelit-paneelista ja valitse paneelivalikosta Pakkaa InCopya varten ja sähköpostita.

InCopy luo tiivistetyn artikkelipakkauksen ja liittää sen sähköpostiviestiin oletussähköpostiohjelmassa.

Huomautus: Jos haluat käyttää toista sähköpostiohjelmaa, vaihda oletussähköpostiohjelma. Lisätietoja on järjestelmän oppaissa.
3. Muokkaa sähköpostiviestiä lisäämällä vastaanottaja ja kirjoittamalla mahdolliset ohjeet. Lähetä viesti.

Artikkelin kaikki osat uloskirjataan määritetylle käyttäjälle. Itse pakkauksen sisältöä ei kuitenkaan lukita, joten kuka tahansa voi avata pakkauksen ja
muokata sisältöä.

Pakkauksen peruuttaminen
Toisinaan lähettämääsi pakkausta ei palauteta. Viesti on voinut kadota tai vastaanottaja ei ehkä enää osallistu projektiin. Tässä tilanteessa voit
peruuttaa pakkauksen.

1. Valitse pakattu artikkeli Artikkelit-paneelista ja valitse paneelivalikosta Peruuta pakkaus.
2. Peruuta pakkaus napsauttamalla OK-painiketta.

Vaikka pakkaus peruutetaan, pakkaustiedosto ei katoa tietokoneesta.

Peruuttamisen jälkeen pakkauksen sisältö on muokattavissa. Huomaa, että jos joku palauttaa peruutetun pakkauksen, voi ilmetä ristiriitoja.

Pakkauksen päivittäminen
Kun olet luonut pakkauksen, haluat ehkä lisätä tai poistaa osia tai muuttaa niiden kokoa.

1. Lisää tai poista pakatun artikkelin juttuja tai muuta niiden kokoa.
2. Valitse artikkeli Artikkelit-paneelivalikosta ja tee jokin seuraavista toimista:
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Valitse Artikkelit-paneelivalikosta Päivitä pakkaus. Määritä tiedoston nimi ja sijainti. Luovuta päivitetty pakkaus käyttäjille sijoittamalla se
jaettuun palvelimeen tai lähettämällä se sähköpostitse. Muista ilmoittaa InCopy-käyttäjille pakkauksen päivittämisestä.

Valitse Artikkelit-paneelivalikosta Päivitä ja sähköpostita ja lähetä sitten viesti.

Kun InCopy-käyttäjät avaavat päivitetyn pakkauksen, vain uusi sisältö lisätään automaattisesti artikkeliin; InCopy-käyttäjät voivat valita,
korvataanko aiempi sisältö, jotta aiemmat muutokset säilyvät.

Pakkausten vastaanottaminen (InCopy)
Saatat vastaanottaa pakkauksen sen luoneelta InDesign-käyttäjältä tai pakkauksen sinulle välittäneeltä InCopy-käyttäjältä. Kun avaat
artikkelipakkauksen, se puretaan ja sen sisältö kopioidaan uuteen alikansioon InCopyn Artikkelit-kansiossa.

Pakkauksen avaaminen (InCopy)
 Kun haluat avata InCopy-pakkauksen (.icap tai .incp), tee jokin seuraavista:

Avaa pakkaus sähköpostiohjelmalla. Voit esimerkiksi kaksoisnapsauttaa liitetiedostoa.

Avaa tiedosto Resurssienhallinnalla tai Finderilla. Voit esimerkiksi kaksoisnapsauttaa tiedostoa tai vetää sen InCopy-sovelluskuvakkeeseen.

Valitse InCopyssa Tiedosto > Avaa ja kaksoisnapsauta pakattua artikkelitiedostoa.

Valitse InCopyn Artikkelit-paneelivalikosta Avaa pakkaus ja kaksoisnapsauta sitten pakkaustiedostoa.

Sitten voit muokata pakkauksen juttuja. Kun ryhdyt muokkaamaan juttua, ohjelma kehottaa uloskirjaamaan kehyksen sisällön. Kun olet tehnyt
muutokset, tallenna koko sisältö ja palauta pakkaus tai välitä se edelleen.

Pakkauksen palauttaminen tai välittäminen (InCopy)
Kun olet avannut pakkauksen ja muokannut sitä, voit lähettää sen toiselle InCopy-käyttäjälle tai palauttaa sen InDesign-käyttäjälle, joka loi
pakkauksen. Muita InCopy-käyttäjiä varten luotujen pakkaustiedostojen tunniste on .icap ja InDesign-käyttäjiä varten luotujen
palautuspakkaustiedostojen tunniste on .idap.

1. Muokkaa pakkaukseen liitettävää sisältöä ja sisäänkirjaa se.
2. Valitse Artikkelit-paneelivalikosta jokin seuraavista:

Välitä: InCopy Luo pakkauksen toista InCopy-käyttäjää varten. Määritä pakkaustiedoston nimi ja sijainti ja luovuta se InCopy-käyttäjälle.

Välitä: InCopy ja sähköposti Luo ja lähetä pakkaus toiselle InCopy-käyttäjälle sähköpostitse. Pakkaus näkyy uuden viestin liitteenä
oletussähköpostiohjelmassa. Määritä vastaanottaja, lisää ohjeet ja lähetä sähköpostiviesti.

Palauta: InDesign Luo pakkauksen InDesign-käyttäjälle palautettavaksi.

Palauta: InDesign ja sähköposti Luo ja palauta pakkaus InDesign-käyttäjälle sähköpostitse. Pakkaus näkyy uuden viestin liitteenä
oletussähköpostiohjelmassa. Määritä vastaanottaja, lisää ohjeet ja lähetä sähköpostiviesti.

Palautuspakkausten vastaanottaminen (InDesign)
 Kun haluat avata InDesign-pakkauksen (.idap tai .indp), tee jokin seuraavista:

Avaa pakkaus sähköpostiohjelmalla. Voit esimerkiksi kaksoisnapsauttaa liitetiedostoa.

Avaa tiedosto Resurssienhallinnalla tai Finderilla. Voit esimerkiksi kaksoisnapsauttaa tiedostoa tai vetää sen InCopy-sovelluskuvakkeeseen.

Valitse InDesignissa Tiedosto > Avaa ja kaksoisnapsauta pakattua artikkelitiedostoa.

Valitse InDesignin Artikkelit-paneelivalikosta Avaa pakkaus ja kaksoisnapsauta sitten pakkaustiedostoa.

Kun avaat pakkauksen, ohjelma kehottaa päivittämään kaikki linkit. Jos juttua on muokattu artikkelin pakkaamisen jälkeen, voit valita, päivitetäänkö
InDesign-tiedoston sisältö vai poistetaanko linkitys. Kun tiedostojen jutut on palautettu ja sisäänkirjattu, voit uloskirjata ja muokata sisältöä.

Lisää ohjeaiheita
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Työnkulun muuttaminen

Alkuun

Alkuun

Alkuun

Sisällön siirtäminen artikkelista toiseen (InDesign)
Artikkeleiden poistaminen (InDesign)
Puuttuvien artikkelitiedostojen uudelleenlinkittäminen (InDesign)
Virheiden korjaaminen
Lukitustiedostojen ohittaminen (InDesign)
Sisältötiedostojen linkityksen poistaminen (InDesign)
InCopy-tiedostojen sijoittaminen InDesign-julkaisuihin

Sisällön siirtäminen artikkelista toiseen (InDesign)
InDesign-käyttäjät voivat siirtää sisältöä valmiiden artikkelien välillä ja Artikkelit-paneelin Määrittelemätön InCopy-sisältö -kohdasta. On myös
mahdollista luoda uusi artikkeli ja siirtää siihen sisältöä.

1. Tallenna InDesign-julkaisu.
2. Näytä artikkelin sisältö napsauttamalla Artikkelit-paneelissa artikkelin nimen vasemmalla puolella olevaa nuolta.
3. Valitse artikkelista sisältöä.
4. Tee jokin seuraavista:

Vedä sisältö artikkelista toiseen.

Jos haluat siirtää sisällön toiseen artikkeliin, valitse Artikkelit-paneelivalikosta Lisää artikkeliin ja valitse sitten kohdeartikkeli.

Jos haluat luoda uuden artikkelin siirtäessäsi sisältöä, valitse Artikkelit-paneelivalikosta Lisää artikkeliin > Uusi ja määritä sitten asetukset
Uusi artikkeli -valintaruudussa.

5. Valitse Artikkelit-paneelivalikosta Päivitä kaikki artikkelit.

Jos artikkeliluettelot ovat lyhyitä, on ehkä helpompi vetää sisältökohteita artikkeleiden ja Määrittelemätön InCopy-sisältö -kohdan välillä.

Artikkeleiden poistaminen (InDesign)
 Valitse Artikkelit-paneelista vähintään yksi artikkeli ja valitse paneelivalikosta Poista artikkeli.

Artikkelin poistaminen

poistaa artikkelitiedot julkaisusta

poistaa artikkelitiedoston tiedostojärjestelmästä

poistaa artikkelin nimen luettelosta

siirtää InCopy-sisällön Artikkelit-paneelin Määrittelemätön InCopy-sisältö -kohtaan.

Huomautus: Jos InDesignista poistetaan InCopy-käyttäjällä avoinna oleva artikkeli, hänelle ilmoitetaan varoituksella siitä, että artikkeli on
poistettu. Sisältötiedostot eivät kuitenkaan katoa, ja niitä voidaan päivittää ilman, että muutokset häviävät.

Puuttuvien artikkelitiedostojen uudelleenlinkittäminen (InDesign)
Jos siirrät tai poistat artikkelitiedoston ja avaat sitten InDesign-julkaisun, josta artikkelitiedosto on luotu, InDesign ei löydä artikkelitiedostoa. Sinun
on luotava artikkelitiedosto uudelleen, jotta InDesign löytää sen.

Artikkelitiedoston luominen uudelleen alkuperäiseen paikkaan
 Tee Artikkelit-paneelissa jokin seuraavista:

Valitse puuttuva artikkeli (se on edelleen paneelin luettelossa) ja valitse paneelivalikosta Päivitä valitut artikkelit.

Valitse paneelivalikosta Päivitä kaikki artikkelit.

Artikkelin sijainnin muuttaminen
 Voit luoda artikkelitiedoston uudelleen uuteen paikkaan tekemällä Artikkelit-paneelissa jommankumman seuraavista:

Valitse artikkeli ja valitse paneelivalikosta Vaihda artikkelin paikkaa. Määritä uuden tiedoston sijainti ja nimi.
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Kaksoisnapsauta artikkelin nimeä. Napsauta Artikkeliasetukset-valintaikkunassa Muuta-painiketta ja määritä uuden tiedoston sijainti ja nimi.

Virheiden korjaaminen
Jos teet virheen, voit hylätä edellisen Tallenna-komennon jälkeen tekemäsi muutokset ja palauttaa sisällön tiedostojärjestelmästä.

Koska InDesign tallentaa automaattisesti kaikki muokattavat InCopy-sisältötiedostot tallentaessasi InDesign-julkaisun, Peruuta uloskirjaus -
komento palauttaa ainoastaan julkaisun edellisen muutoksen jälkeiset versiot.

 Tee jokin seuraavista:

Jos haluat kumota viimeksi tehdyn muutoksen, valitse Muokkaa > Kumoa [toiminto].

Voit kumota kaikki julkaisun edellisen tallennuksen jälkeiset muutokset valitsemalla Tiedosto > Palauta sisältö.

Voit kumota version edellisen tallennuksen jälkeiset muutokset ja poistaa lukitustiedoston valitsemalla Artikkelit-paneelista sisällön ja
valitsemalla paneelivalikosta Peruuta uloskirjaus. Tämä toiminto määrittää sisällön vain luku -muotoon, jolloin toiset voivat kuitata sen ulos.

Lukitustiedostojen ohittaminen (InDesign)
Käyttäjät eivät ehkä heti huomaa, miten heidän toimenpiteensä vaikuttavat työnkulun muiden käyttäjien töihin. Siksi he saattavat vahingossa luoda
tilanteita, joissa sisällön tilan ja omistusoikeuden välillä on ristiriitoja. InDesign-käyttäjä voi tarvittaessa selvittää ristiriidat poistamalla toisen
käyttäjän uloskirjaaman, lukitun tiedoston linkityksen ja ottamalla tiedoston hallintaansa. Kun tiedoston linkitys poistetaan, sisältö tallentuu
InDesign-julkaisuun, mutta sitä ei enää jaeta InCopyn avulla.

Sisältötiedostojen linkityksen poistaminen (InDesign)
Tarvittaessa (esimerkiksi tuotannon määräajan vuoksi) InDesign-käyttäjät voivat poistaa sisältötiedoston hallitusta työnkulusta ja Linkit-paneelista
poistamalla linkityksen. Jos haluat, että sisältö on jälleen muokattavissa, vie se uudelleen InCopy-sisältönä eri tiedostonimellä. Tämä varmistaa
sen, että vanha lukitustiedosto ei estä käyttäjiä muokkaamasta tiedostoa.
Huomautus: Kun poistat itse uloskirjaamasi tiedoston linkityksen, tiedosto häviää työnkulusta ja lukitustiedosto häviää levyltä. Voit viedä sisällön
uudelleen ja korvata tiedostonimen aiheuttamatta ristiriitaa.

 Voit poistaa InCopy-sisältötiedoston linkityksen valitsemalla tiedoston (.imcl- tai .incx-tunniste) Linkit-paneelista ja valitsemalla paneelivalikosta
Poista linkitys. Linkitystä poistettaessa sisältö upotetaan julkaisuun ja InCopy-tiedostoon johtava linkki poistetaan.
Voit linkittää tiedoston uudelleen valitsemalla Muokkaa > Kumoa linkityksen poisto.

Voit poistaa linkityksen myös poistamalla kehyksen tai linkittämällä sisältötiedoston uudelleen toiseen tiedostoon InDesignin Linkit-paneelin
avulla. Voit myös valita jutun Artikkelit-paneelista ja vetää sen roskakorikuvakkeen päälle.

InCopy-tiedostojen sijoittaminen InDesign-julkaisuihin
Tyypillinen työnkulku alkaa InDesignissa, jossa määritetään perussivuasettelu ja tekstin ja kuvien paikkamerkit sekä viedään ne InCopyyn.
Toisenlainen työnkulku voi alkaa erillisestä InCopy-sisältötiedostosta (.icml tai .incx), joka sijoitetaan InDesigniin komennolla Tiedosto > Sijoita.

Ota huomioon seuraavat riippuvuudet, kun sijoitat InCopy-sisältötiedostoja InDesign-julkaisuun:

Tyylit Jos InCopy-tekstitiedostossa on käytetty tyylejä, ne lisätään julkaisun InDesign-tyyliluetteloon. Jos tyylien nimistä aiheutuu ristiriita, InDesign
korvaa tuodun tyylin olemassa olevalla tyylillä.
Sivuasettelun Voit luoda sisällön perussivuasettelugeometrian InDesignissa ja luoda tai tuoda sitten tekstin ja tyylit tekstinkäsittelysovelluksen
avulla. (InCopyyn sijoitettavat tekstitiedostot upotetaan InCopy-julkaisuun, eikä niitä linkitetä ulkoiseen tiedostoon.)
Sijoittaminen/monistaminen Jos sijoitat InCopy-sisältötiedoston useita kertoja, sisällön kukin esiintymä näkyy InDesignin Linkit-paneelissa, mutta
kaikkia esiintymiä hallitaan yhtenä sisältötiedostona. Sama koskee kaikkia sisältötiedoston identtisiä kopioita (kaikkea monistamista).
Huomautus: Jos kopioit ja liität hallitun InCopy-sisältötiedoston tekstin osia, mutta et koko tiedostoa, tuloksena on uusi sisältötiedosto, joka ei ole
yhteydessä alkuperäiseen tiedostoon ja jossa ei ole linkkiä ulkoiseen tiedostoon (InCopyssa tai muutoin). Alkuperäisiä ja liitettyjä osia voidaan
muokata toisistaan riippumatta.
Päivitykset/hallinta Jos InDesign-julkaisussa on useita hallitun sisältötiedoston esiintymiä, ne toimivat kuin ne olisivat auki kahdessa
sovelluksessa. Esimerkiksi yhden sisältötiedoston esiintymän uloskirjaaminen lukitsee kaikki muut esiintymät, jolloin voit muokata ainoastaan
uloskirjattua esiintymää. Tässä tapauksessa sinun pitää päivittää sisällön muut (avoimet) esiintymät sopivalla päivityskomennolla.
Lisää ohjeaiheita
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Tietoja asetuksista ja oletuksista
Yleisasetusten määrittäminen
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Kaikkien asetusten ja oletusasetusten palauttaminen
Tietoja InDesign-tyyleistä ja -oletusarvoista

Tietoja asetuksista ja oletuksista
Asetuksia ovat esimerkiksi paneelin sijainti, mittayksikköasetukset sekä grafiikkaan ja typografiaan liittyvät näyttöasetukset. Oletusarvoasetusten
muuttaminen määrittää, kuinka InDesign-julkaisut ja -objektit käyttäytyvät aluksi.

Yleisasetusten määrittäminen
Tässä osiossa on kuvaus Asetukset-valintaikkunan Yleiset-välilehden oletusasetuksista. Saat lisätietoja muista asetuksista hakemalla
asianmukaista asetusta.

1. Valitse Muokkaa > Asetukset > Yleiset (Windows) tai InDesign > Asetukset > Yleiset (Mac OS) ja valitse sitten, millaisia asetuksia haluat
määrittää.

2. Valitse Sivunumerointi-osan Näytä-valikosta sivunumerointitapa. (Lisätietoja: Absoluuttisen tai osion numeroinnin näyttäminen Sivut-
paneelissa.)

3. Määritä Kirjasinten lataaminen ja upottaminen -osioissa kynnys, jonka ylitys aiheuttaa kirjasinten jakamisen osajoukkoihin kirjasimen
sisältämän kuviomäärän perusteella. Tämä asetus vaikuttaa Tulosta- ja Vie-valintaikkunoiden kirjasinlatausasetuksiin.

4. Skaalattaessa-osassa voit määrittää, miten skaalatut objektit näytetään paneeleissa ja miten skaalattujen kehysten sisältöä käsitellään.

Valitse Käytä sisällössä, jos haluat pistekoon muuttuvan, kun tekstikehystä skaalataan. (Lisätietoja: Kirjasimen skaalaaminen.) Jos tämä
asetus on valittu, kun grafiikkakehys on skaalattu, kuvan prosentuaalinen koko muuttuu, mutta kehys palautuu 100 %:n kokoon.
(Lisätietoja: Objektien skaalaaminen.)

Valitse Säädä skaalausprosentti -vaihtoehto, jos haluat näyttää alkuperäisen pistekoon ja uuden pistekoon suluissa, kun skaalaat tekstiä.
Jos tämä asetus on valittu, kun skaalaat grafiikkakehyksiä, sekä kehyksen että kuvan prosentuaalinen koko muuttuu.

5. Tuo näyttöön kaikki varoitukset valitsemalla Palauta kaikki varoitusikkunat, vaikka olisitkin estänyt tiettyjen varoituksen näkymisen. (Kun
varoituksia tulee näkyviin, voit valita valintaruudun, joka estää varoituksen toistumisen.)

Oletusten määrittäminen
Jos muutat asetuksia, kun julkaisuja ei ole avoinna, uusien julkaisujen oletusasetukset muuttuvat. Jos muutat asetuksia avoimessa julkaisussa,
muutokset koskevat vain tätä julkaisua.

Jos muutat asetuksia silloin, kun objekteja ei ole valittu, kaikkien uusien objektien oletusasetukset muuttuvat.

Uusien julkaisujen oletusasetusten muuttaminen
1. Sulje kaikki julkaisut.
2. Muuta haluamiesi valikkokohteiden, paneelien tai valintaikkunoiden asetuksia.

Jos käytät julkaisuissa yleensä samaa kieltä ja sivukokoa, vaihda nämä oletusasetukset, kun julkaisuja ei ole avoinna. Voit vaihtaa esimerkiksi
oletussivukoon sulkemalla kaikki julkaisut ja valitsemalla ensin Tiedosto > Julkaisun asetukset ja sitten haluamasi sivukoon. Määritä
oletussanasto sulkemalla kaikki julkaisut, valitsemalla Muokkaa > Asetukset > Sanasto (Windows) tai InDesign > Asetukset > Sanasto
(Mac OS) ja valitsemalla sopiva vaihtoehto Kieli-valikosta.

Julkaisun uusien objektien oletusasetusten määrittäminen
1. Valitse avoimessa julkaisussa Muokkaa >Poista kaikkien valinta.
2. Muuta haluamiesi valikkokohteiden, paneelien tai valintaikkunoiden asetuksia.

Kaikkien asetusten ja oletusasetusten palauttaminen
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Jos InDesign toimii odottamattomalla tavalla, asetusten poistaminen (sama kuin asetusten siirtäminen roskakoriin) ratkaisee ongelman useimmissa
tapauksissa.

Suosittelemme varmuuskopioiden ottamista oletusarvotiedostoista nimeltään InDesign Defaults ja InDesign SavedData. Sen sijaan että poistaisit
oletusarvot, voit kopioida nämä varmuuskopiotiedostot vioittuneiden oletusarvotiedostojen päälle. Näin et menetä tekemiäsi mukautuksia.

Mike Witherell on tehnyt tarkan luettelon tiedostoista, joihin oletusarvojen palauttaminen vaikuttaa. Se on osoitteessa Adobe InDesignn oletusarvot
(PDF, vain englanniksi).

 Tee jokin seuraavista:

(Windows) Käynnistä InDesign ja paina näppäinyhdistelmää vaihto+Ctrl+Alt. Valitse Kyllä, jos haluat poistaa oletustiedostot.

(Mac OS) Paina näppäinyhdistelmää vaihto+optio+komento+Ctrl pitkään käynnistäessäsi InDesignin. Valitse Kyllä, jos haluat poistaa
oletustiedostot.

Adobe InDesign -asetustiedostoihin on tallennettu erilaisia ohjelma-asetuksia ja oletusasetuksia. Nämä tiedostot, InDesignin oletukset sisältävä
tiedosto mukaan lukien, tallennetaan aina, kun lopetat InDesignin. Asetustiedostojen sijainnit ovat manuaalisen poistamisen ja
uudelleennimeämisen tapauksessa seuraavat:

Mac OS

InDesign SavedData Users/[user]/Library/Caches/Adobe InDesign/Version [versio]/InDesign SavedData

InDesign Defaults Users/[käyttäjä]/Library/Preferences/Adobe InDesign/Version [versio]/InDesign Defaults

Windows XP

InDesign SavedData \Documents and Settings\[käyttäjätunnus]\Local Settings\Application Data\Adobe\InDesign\Version [versio]\Caches

InDesign Defaults \Documents and Settings\[käyttäjätunnus]\Application Data\Adobe\InDesign\Version [versio]

Windows Vista tai Windows 7

InDesign SavedData Users\[käyttäjätunnus]\AppData\Roaming\Adobe\InDesign\Version [versio]\Caches\InDesign SavedData

InDesign Defaults C:\Users\[käyttäjätunnus]\AppData\Roaming\Adobe\InDesign\Version [versio]\InDesign Defaults

Tietoja InDesign-tyyleistä ja -oletusarvoista
Voit tallentaa asetuksia tulevaa käyttöä varten, esimerkiksi seuraavien kohteiden asetuksia:

Kappale- ja merkkityylien luominen. (Lisätietoja: Kappale- ja merkkityylien lisääminen.)

Objektityylien luominen. (Lisätietoja: Objektityylit.)

Taulukko- ja solutyylien luominen. (Lisätietoja: Taulukko- ja solutyylit.)

PDF-viennin oletusarvojen luominen. (Lisätietoja: Adobe PDF -oletusarvojen mukauttaminen.)

Tulostuksen oletusarvojen luominen. Kaikki Tulosta-valintaikkunan määritteet sisältyvät tyyliin. (Lisätietoja: Julkaisun tai kirjan tulostaminen.)

Lihotuksen oletusarvojen luominen. (Lisätietoja: Värien lihotus.)

Läpinäkyvyyden yhdistämisen oletusarvojen luominen. (Lisätietoja: Läpinäkyvän kuvan tasojen yhdistäminen.)

Sisällysluettelotyylien luominen. (Katso Sisällysluettelotyylien luominen useille luetteloille.)

Työtilan asetusten tallentaminen.

Julkaisun oletusarvojen luominen. (Lisätietoja: Julkaisun oletusten määrittäminen.)

Viivatyylien luominen. (Lisätietoja: Mukautettujen viivatyylien määrittäminen.)

Toimintoasetukset kannattaa ensin vaihtaa valintaikkunassa ja tallentaa vasta sitten. Tyylit ja oletusarvot tallentuvat siinä julkaisussa, jossa ne on
luotu. Voit käyttää toisen julkaisun asetuksia tuomalla tai lataamalla kyseisen julkaisun tyylit ja oletusasetukset. Lisäksi useimmat oletusarvot
voidaan viedä tai tallentaa erillisenä tiedostona, jolloin ne on mahdollista ottaa käyttöön toisissa tietokoneissa.

Mike Witherell on tehnyt tarkan luettelon oletusarvoista. Se on osoitteessa Adobe InDesignn oletusarvot (PDF, vain englanniksi).

Voit myös jakaa tyylejä ja oletusarvoja kirjatiedoston kaikkien julkaisujen välillä. Lisätietoja on kohdassa Kirjan julkaisujen synkronoiminen.

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma

138

http://www.indesignusergroup.com/chapters/washingtondc/files/729/21_presets-Mike_Witherell.pdf
http://www.indesignusergroup.com/chapters/washingtondc/files/729/21_presets-Mike_Witherell.pdf
http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fi/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fi


Työkalupaneeli

Alkuun

Työkalupaneelin yleiskuvaus
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Piirto- ja tekstityökalujen valikoima
Muunnostyökalujen valikoima
Muokkaus- ja navigointityökalujen valikoima

Työkalupaneelin yleiskuvaus
Eräillä työkalupaneelin työkaluilla valitaan, muokataan ja luodaan sivuelementtejä. Toisilla työkaluilla taas valitaan tekstiä, kuvioita, viivoja ja
liukuvärejä. Voit muuttaa työkalupaneelin yleisasettelun muiden ikkunoiden ja paneelien asetteluun sopivaksi. Työkalupaneelin työkalut ovat
oletusarvoisesti yhdessä pystysarakkeessa. Voit muuttaa asettelun kahdeksi pystysarakkeeksi tai vaakariviksi. Työkalujen järjestystä ei kuitenkaan
voi muuttaa. Voit siirtää työkalupaneelia vetämällä sitä paneelin yläosasta.

Valitse työkalu perustyökaluista napsauttamalla sitä. Työkalupaneelin näkyviin työkaluihin liittyy myös useita kätkettyjä työkaluja. Niiden merkkinä
on työkalukuvakkeen oikealla puolella oleva nuoli. Valitse kätketty työkalu napsauttamalla ensin nykyistä työkalua ja valitsemalla sitten haluamasi
työkalu.

Työkalun nimi ja pikanäppäin tulevat näkyviin, kun osoitin on työkalun päällä. Tätä tekstiä kutsutaan työkaluvihjeeksi. Voit poistaa työkaluvihjeet
käytöstä valitsemalla Asetukset-valintaikkunan Liittymä-kohdasta Työkaluvihjeet-asetukseksi Ei mitään.

Avaa Työkaluvihjeet-paneeli (valitse Ikkuna > Apuohjelmat > Työkaluvihjeet) niin näet, mitkä pikanäppäimet ja muuntonäppäimet toimivat
kunkin työkalun kanssa.

Huomautus: Sisällön keräys- ja sijoittelutyökaluja ei ole CS5.5:ssä ja sitä aiemmissa versioissa.

Työkalupaneelin näyttäminen
 Valitse Ikkuna > Työkalut.
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Työkaluvihjeiden näyttäminen
 Kaksoisnapsauta työkalua työkalupaneelissa.

Tämä menetelmä koskee vai osaa työkaluista, esimerkiksi pipetti-, kynä- ja monikulmiotyökalua.

Kätkettyjen työkalujen näyttäminen ja valitseminen

1. Siirrä osoitin työkalupaneelissa sellaisen työkalun päälle, johon kuuluu kätkettyjä työkaluja, ja pidä hiiren painiketta painettuna.

2. Valitse kätketty työkalu, kun se tulee näkyviin.

Valitse työkalut tilapäisesti
1. Kun työkalu on valittuna, pidä eri työkalun pikanäppäintä painettuna.
2. Pidä pikanäppäin yhä painettuna ja tee jokin toimenpide.
3. Vapauta pikanäppäin, kun haluat palata edelliseen työkaluun.

Jos esimerkiksi Väli-työkalu on valittuna, paina V-näppäintä, kun haluat vaihtaa väliaikaisesti Valintatyökaluun. Kun vapautat V-näppäimen, Väli-
työkalu on valittuna.

Työkaluvihjeiden näyttäminen
Työkaluvihjeet-paneelissa kuvataan kuinka muokkausnäppäimet toimivat valitun työkalun kanssa.

1. Avaa Työkaluvihjeet-paneeli valitsemalla Ikkuna > Apuohjelmat > Työkaluvihjeet.

2. Valitse työkalu työkalupaneelista, jos haluat nähdä työkalun kuvauksen ja sen muokkausnäppäimet ja pikanäppäimet.

Työkalupaneelin asettelun muuttaminen

1. Valitse Muokkaa > Asetukset > Liittymä (Windows) tai InDesign > Asetukset > Liittymä (Mac OS).

2. Valitse asetteluvaihtoehto Kelluva työkalupaneeli -valikosta ja napsauta OK-painiketta.

Voit muuttaa työkalupaneelin asettelua myös sen yläreunassa olevalla kaksoisnuolikuvakkeella.

Työkalujen yleiskuvaus
Tekstityökalut Luo ja muokkaa tekstiä tavallisissa tai mukautetuissa lohkoissa tai reiteissä. (Lisätietoja: Tekstikehysten luominen.)
Piirtotyökalut Piirrä yksinkertaisia tai monimutkaisia objekteja, kuten suorakulmioita, ellipsejä, monikulmioita ja vapaamuotoisia kuvioita ja määritä
niille tyylit. (Lisätietoja: Piirtäminen.)
Valintatyökalut Valitse (aktivoi) objekteja, pisteitä tai rivejä. (Lisätietoja: Objektien valitseminen.)
Muunnostyökalut Muuta objektien muotoa, suuntaa ja kokoa. (Lisätietoja: Kohteiden muuntaminen.)
Siirtymistyökalut Siirry paikasta toiseen, hallitse näkymää ja mittaa etäisyyksiä julkaisussa. (Lisätietoja: Lähentäminen ja loitontaminen ja
Viivaimet ja mittayksiköt.)
Saksityökalu Jaa reittejä ja kehyksiä. (Lisätietoja: Reitin katkaiseminen.)

Valintatyökalujen valikoima

Valintatyökalulla valitaan
kokonaisia objekteja.

Suoravalintatyökalulla valitaan
pisteitä reitiltä tai sisältö
kehyksestä.

Sivu-työkalulla voit luoda
useita sivukokoja julkaisuun.

Välityökalulla voit säätää
objektien välisiä tiloja.

Piirto- ja tekstityökalujen valikoima
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Kynätyökalulla piirretään
suoria ja käyriä reittejä.

Lisää ankkuripiste -työkalulla
lisätään reitille ankkuripisteitä.

Poista ankkuripiste -työkalulla
poistetaan reitiltä
ankkuripisteitä.

Muunna suuntapiste -työkalulla
muunnetaan kulma- ja
tasoituspisteitä.

Tekstityökalulla luodaan
tekstikehyksiä ja valitaan
tekstiä.

Reittitekstityökalulla luodaan ja
muokataan reittitekstejä

Lyijykynätyökalulla piirretään
vapaamuotoinen reitti.

Tasoitustyökalulla poistetaan
reitiltä ylimääräisiä kulmia.

Pyyhekumityökalulla
poistetaan reitiltä pisteitä.

Viivatyökalulla piirretään viivan
segmentti.

Suorakulmiokehystyökalulla
luodaan neliömäinen tai
suorakulmainen paikkamerkki.

Ellipsikehystyökalulla luodaan
pyöreä tai soikea
paikkamerkki.

Monikulmiokehystyökalulla
luodaan monikulmainen
paikkamerkki.

Suorakulmiotyökalulla luodaan
neliö tai suorakulmio.

Ellipsityökalulla luodaan
ympyrä tai soikio.

Monikulmiotyökalulla luodaan
monikulmio.

Muunnostyökalujen valikoima

Vapaa muunto -työkalulla
kierretään, skaalataan tai
kallistetaan objektia.

Kiertotyökalulla kierretään
objekteja kiintopisteen ympäri.

Skaalaustyökalulla muutetaan
objektien kokoa kiintopisteen
suhteen.

Kallistustyökalulla kallistetaan
objekteja kiintopisteen
suhteen.
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AlkuunMuokkaus- ja navigointityökalujen valikoima

Pipettityökalulla kerätään
objekteista väri- ja
tekstimääritteitä sekä liitetään
niitä toisiin objekteihin

Mittatyökalu mittaa kahden
pisteen välisen etäisyyden.

Liukuvärimallityökalu säätää
liukuvärien alku- ja
loppupisteitä sekä kulmaa
objektien sisällä

Liukuväripehmennystyökalu
häivyttää objektin taustalle.

Saksityökalu leikkaa reittejä
määritetyistä pisteistä.

Käsityökalu siirtää
sivunäkymää
julkaisuikkunassa.

Zoomaustyökalu suurentaa tai
pienentää näkymää
julkaisuikkunassa.

Muistiinpanotyökalulla voit
lisätä kommentteja.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Sivuasettelu ja muotoilu

Sisällön linkittäminen
Anne-Marie Concepcion  (15.5.2012)
Opastus - video
Katso tämä video-opastusohjelma ja ota selvää, miten voit luoda samassa julkaisussa ja muissa julkaisuissa oleviin objekteihin viittaavia
linkkejä ja päivittää ne.

Lomaketyökalujen esittely
Anne-Marie Concepcion  (15.5.2012)
Opastus - video
InDesignin lomakekenttiin liittyvien painikkeiden, valintaikkunoiden ja valikkokomentojen yleiskatsaus. Vertaile vanhoja ja uusia tapoja
luoda vuorovaikutteisia lomakkeita.

Lomakkeen testaaminen Acrobatissa
Anne-Marie Concepcion  (15.5.2012)
Opastus - video
Tässä opastusohjelmassa näytetään, miltä InDesignin lomakekentät näyttävät Acrobatissa tai Readerissä. Sen jälkeen perehdytään
Acrobatin vuorovaikutteisten kenttien muokkaamiseen, jolla saat lisätoimintoja käyttöön, ja lomakkeen käyttäytymiseen Acrobatissa.

Kehysten käyttäminen
Kelly McCathran  (15.5.2012)
Opastus - video
Kaikki InDesigniin lisätyt sisällöt sijoitetaan kehyksiin. Voit luoda kehyksiä aivan alusta, tai jos ”sijoitat” (tuot) tekstin tai kuvat julkaisuun,
InDesign luo kehyksen automaattisesti.

Ristiviittausten luominen (video 5:45), CS4–CS6
David Blatner  (1.1.2011)
Opastus - video
Käy ristiviittausten lisäysmenettely läpi. Luo ristiviittauksia, jotka voidaan päivittää nopeasti, kun kohdeteksti tai sivutus muuttuu. Luo
mukautettu ristiviittausmuoto.

Kuvatekstien luominen metatiedoista (PDF, 148 kt)
Viittaus  (1.1.2011)
Lyhyt opastusvideo kuvien metatietojen käyttämisestä ja automaattisten kuvatekstien luomisesta sivuasetteluun.

Ruudukkotila ja Live Distribute -työkalu (video 2:48)
Michael Ninness  (1.1.2011)
Opastus - video
Katso, miten voit nopeasti luoda ruudukkoja kehyksen luontityökalujen avulla.

Käytettävät kuvatekstit (video 3:04)
Michael Ninness  (1.1.2011)
Opastus - video
Katso, miten käytettäviä kuvatekstejä voidaan luoda InDesign CS5:ssä ja sitä uudemmissa versioissa kuvaan upotetuista metatiedoista ja
miten kuvatekstejä voidaan sijoittaa sivuasetteluun automaattisesti ja joustavasti.

Kiiltävän grafiikan luominen (PDF, 203 kt)
Mike Rankin  (1.1.2011)
Viittaus
Tämän opastusohjelman avulla opit luomaan kiiltäviä ja hohtavia tehosteita sivuasettelussa oleviin objekteihin.

Useita sivukokoja sisältävien julkaisujen hallinta (PDF, 136 kt)
Viittaus  (1.1.2011)
Lyhyt opastusvideo, jossa käsitellään useita sivukokoja sisältävien julkaisujen hallintaa InDesign CS5:ssä ja sitä uudemmissa versioissa.

Mini Bridge: Aineistojen käyttäminen kätevästi (PDF, 180 kt)
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Viittaus  (1.1.2011)
Käytä Bridgeä kelluvana paneelina InDesignissa. kyllä Mini Bridge.

Sivukokojen muokkaaminen uuden Sivutyökalun avulla (video 8:03)
Anne-Marie Concepcion  (1.1.2011)
Opastus - video
Luo kokonainen esite tai sisällytä kirjan kansilehdet ja teksti samaan julkaisuun muokkaamalla julkaisun sivukokoja.

Sarakkeiden rajat ylittävät ja sarakkeet jakavat kappaleet (video 2:01)
Michael Ninness  (1.1.2011)
Opastus - video
Katso, miten voit luoda monimutkaisia sivuasetteluita entistä vähemmillä napsautuksilla käyttämällä kappaleita, jotka ylittävät sarakkeiden
rajat tai jakavat sarakkeita InDesign CS5:ssä ja sitä uudemmissa versioissa.

Kääntyvä aukeamanäkymä (video 3:31), CS4–CS6
David Blatner  (1.1.2011)
Opastus - video
Opi kääntämään aukeamanäkymä, jolloin käännettyjen objektien muokkaaminen on helppoa. Tutustu myös useisiin aikaa säästäviin
siirtymisvinkkeihin.

Palstojen ylittäminen ja jakaminen palstoihin (video 6:15)
Anne-Marie Concepcion  (1.1.2011)
Opastus - video
Määritä useita palstoja ylittäviä otsikoita tai luo lisää tilaa jakamalla kappaleita useisiin alipalstoihin.
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Uusien julkaisujen luominen

Alkuun

Alkuun

Julkaisun oletusarvo

Peruste

Sivumäärä

Aloitussivun numero

Vastakkaiset sivut

Uusien julkaisujen luominen
Uuden julkaisun luominen
Uuden julkaisun asetukset
Yleistä julkaisuikkunasta
Luo mukautettuja sivukokoja
Julkaisun oletusarvojen määrittäminen
Julkaisun luominen oletusarvoa käyttämällä

Sivusuunnittelu alkaa perusasioista: uuden julkaisun aloittamisesta, sivujen määrittämisestä ja reunusten ja palstojen sijoittelusta tai
ruudukkoasetusten muuttamisesta.

Uuden julkaisun luominen

1. Valitse Tiedosto > Uusi > Julkaisu.

Uusi julkaisu -valintaikkuna sisältää Julkaisun asetukset- ja Reunukset ja palstat -ikkunat, joten sivukoko, reunukset ja palstat voidaan
määrittää samassa paikassa. Voit muuttaa näitä asetuksia koska tahansa.

2. Julkaisun asetusten määrittäminen. (Katso Uuden julkaisun asetukset.)

Määritä leikkausvara- ja informaatioalueet napsauttamalla ensin Nuoli-painiketta Leikkausvara- ja Informaatio-otsikoiden edessä.
Leikkausvara- ja informaatioalueet ulottuvat määritetyn Sivukoko-asetuksen reunojen ulkopuolelle. Jotta leikkausvara- ja informaatioalueet
ulottuisivat tasaisesti kaikille sivuille, napsauta Määritä kaikki asetukset samoiksi -kuvaketta .

3. (Vain InDesign CC) Esikatselu-valintaruudun avulla voit tarkastella, miltä uusi julkaisu näyttää. Muokkaa asetuksia tarvittaessa.

4. Avaa uusi, määritetyt asetukset sisältävä julkaisu valitsemalla OK.

Uusien julkaisujen sivuasettelun oletusasetukset määritetään valitsemalla Tiedosto > Julkaisun asetukset tai Sivuasettelu > Reunukset ja
palstat. Asetuksia voi määrittää, kun julkaisuja ei ole avoinna.

Uuden julkaisun asetukset

Valitse aikaisemmin tallennettu esimääritys.

Jos olet luomassa julkaisua, joka tulostetaan PDF- tai SWF-muodossa verkkokäyttöä varten, Web-asetuksen valinta muuttaa useita
valintaikkunan asetuksia. Se esimerkiksi poistaa Vastakkaiset sivut käytöstä, muuttaa sivun suunnan pystysuunnasta vaakasuuntaan ja käyttää
näytön tarkkuuteen perustuvaa sivukokoa. Voit muokata näitä asetuksia julkaisun luomisen jälkeen.
CS6 ja sitä uudemmat versiot: Digital Publishing Suite -ratkaisuja varten tarkoitettuihin julkaisuihin on lisätty digitaalisen julkaisun peruste. Voit
muokata julkaisun perustetta myös julkaisun luomisen jälkeen.

Määritä uudessa dokumentissa luotavien sivujen määrä.

Määritä numero, josta julkaisu alkaa. Jos määrität parillisen numeron (kuten 2), kun Vastakkaiset sivut on valittu, julkaisun
ensimmäinen aukeama on kaksisivuinen aukeama. Katso Julkaisun aloittaminen kaksisivuisella aukeamalla.

Kun tämä asetus on valittuna, vasemman- ja oikeanpuoleiset sivut muodostavat kahden sivun aukeaman, kuten kirjoissa ja
aikakauslehdissä. Poista valinta, jos käsittelet sivuja erillisinä. Tämä on tarpeen esimerkiksi silloin, jos tulostat mainoslehtisiä tai julisteita tai jos
haluat objektien leikkausvaran sidontaselkään.
Kun olet luonut julkaisun, voit Sivut-paneelia käyttämällä luoda yli kahden sivun aukeamia tai pakottaa kaksi ensimmäistä sivua samaan
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Tekstikehyspohja

Ensisijainen tekstikehys

Sivukoko

Suunta

Leikkausvara

Informaatioalue

Esikatselu

Huomautus:

Alkuun

aukeamaan. (Katso Aukeaman sivutuksen hallitseminen.)

CS5.5 ja aikaisemmat versiot: Kun valitset tämän asetuksen, voit luoda tekstikehyksen, jonka koko on reunusten apuviivojen
rajaama ja määritettyjä palsta-asetuksia vastaava alue. Tekstikehyspohja lisätään A-sivupohjaan. (Katso Tekstikehysten käyttäminen
sivupohjissa.)
Tekstikehyspohja-asetus on käytettävissä vain, jos olet valinnut Tiedosto > Uusi > Julkaisu.

CS6 ja sitä uudemmat versiot: Valitse tämä asetus, jos haluat lisätä sivupohjaan ensisijaisen tekstikehyksen. Kun
käytät uutta sivupohjaa, ensisijaisen tekstikehyksen juttu juoksutetaan automaattisesti uudella sivupohjalla olevaan ensisijaiseen tekstikehykseen.

Valitse valikosta koko tai määritä Leveys ja Korkeus. Sivukoko on sivun lopullinen haluttu koko leikkausvaran ja muiden sivun
ulkopuolella olevien merkkien poistamisen jälkeen.

Valitse Pysty  (korkea) tai Vaaka  (leveä). Kuvakkeet ovat dynaamisessa vuorovaikutuksessa Sivukoko-kohdan kokojen kanssa. Kun
Korkeus-arvo on suurempi kuin leveys, ohjelma valitsee pystykuvakkeen. Kun Leveys-arvo on suurempi kuin korkeus, ohjelma valitsee
vaakakuvakkeen. Jos napsautat kuvaketta, joka ei ole valittuna, Korkeus- ja Leveys-arvot vaihdetaan keskenään.
Vihje: Voit määrittää leikkausvaran ja informaatioalueiden koon napsauttamalla ensin Nuoli-painiketta Leikkausvara- ja Informaatioalue-otsikoiden
edessä Uusi julkaisu -valintaikkunassa. Jotta leikkausvara- ja informaatioalueet ulottuisivat tasaisesti kaikille sivuille, napsauta Määritä kaikki
asetukset samoiksi -kuvaketta .

Leikkausvara-alueen avulla voit tulostaa määritetyn sivukoon ulkoreunalle sijoitettuja objekteja. Kun objekti sijoitetaan vaadittavan
kokoisen sivun reunaan, tulostusalueen reunassa voi näkyä valkoista, jos tulostusta tai leikkausta ei ole kohdistettu tarkasti kohdalleen. Tämän
vuoksi tarvittavan kokoisen sivun reunassa olevat objektit olisi sijoitettava jonkin verran reunan yli, ja sivu pitäisi viimeistellä tulostuksen jälkeen.
Leikkausvara näkyy julkaisussa punaisena viivana. Voit määrittää leikkausvara-alueen asetukset Tulosta-valintaikkunan Leikkausvara-asetuksissa.

Informaatioalue poistetaan, kun julkaisu viimeistellään lopulliseen sivukokoon. Informaatioalueessa on tietoja tulostuksesta ja
muokatuista väripalkeista tai ohjeita ja kuvauksia muista julkaisun tiedoista. Informaatioalueelle sijoitetut objektit (myös tekstikehykset) tulostetaan,
mutta poistetaan, kun julkaisu viimeistellään lopulliseen sivukokoon.
Leikkausvara- ja informaatioalueiden ulkopuolella olevat objektit (sen mukaan, kumpi ulottuu kauemmaksi) eivät tulostu.

(Vain InDesign CC) Tämän valintaruudun avulla voit tarkastella, miltä uusi julkaisu näyttää. Muuta asetuksia tarvittaessa, jos esikatselu
ei ole tyydyttävä.

Voit tallentaa julkaisun asetukset napsauttamalla Tallenna julkaisun oletusarvo -kuvaketta.

Yleistä julkaisuikkunasta

Kullakin julkaisun sivulla tai aukeamalla on oma taittopöytä ja apuviivat, jotka näkyvät normaalissa näyttötilassa. (Voit vaihtaa normaaliin
näyttötilaan valitsemalla Näytä > Näyttötila > Normaali.) Taittopöytä korvautuu Esikatselu-tilassa harmaalla taustalla. (Katso Julkaisujen
esikatselu.) Voit muuttaa tämän esikatselutaustan ja apuviivojen väriä Apuviivat ja taittopöytä -asetuksissa.

Julkaisu ja apuviivat normaalissa näyttötilassa

A. Aukeama (mustat viivat) B. Sivu (mustat viivat) C. Reunusten apuviivat (magentat viivat) D. Palstojen apuviivat (violetit viivat) E. Leikkausvara-
alue (punaiset viivat) F. Informaatioalue (siniset viivat) 

Julkaisuikkunan huomautukset:
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Alkuun

Alkuun

Alkuun

Muunväriset viivat ovat viivainlinjoja, jotka ovat tasojensa värisiä, kun ne valitaan. Katso Tasot.

Palstojen apuviivat ovat reunusten apuviivojen edessä. Jos palstan apuviiva on aivan reunuksen apuviivan edessä, se peittää reunuksen
apuviivan.

Luo mukautettuja sivukokoja

Voit luoda mukautettuja sivukokoja, jotka näkyvät Uusi julkaisu -valintaikkunan Sivukoko-valikossa.

1. Valitse Tiedosto > Uusi > Julkaisu.

2. Valitse Sivukoko-valikosta Mukautettu sivukoko.

3. Anna sivukoolle nimi, määritä sivukokoasetukset ja valitse sitten Lisää.

New Doc Sizes.txt -tiedosto, jolla voit luoda mukautettuja sivukokoja aikaisemmissa InDesign-versioissa, ei ole käytettävissä InDesign CS5:ssä tai
sitä uudemmissa versioissa.

Julkaisun oletusarvojen määrittäminen

Kun tallennat julkaisun sivukoko-, palsta-, reunus-, leikkausvara- ja informaatioalueasetukset oletusarvoiksi, säästät aikaa ja varmistat julkaisujesi
yhtenäisyyden.

1. Valitse Tiedosto > Julkaisun oletusarvot > Määritä.

2. Valitse näyttöön tulevassa valintaikkunassa Uusi.

3. Määritä oletusarvolle nimi ja valitse Uusi julkaisun oletusarvo -valintaikkunasta perusasetukset. (Katso Uuden julkaisun asetukset, jos haluat
lisätietoja vaihtoehdoista.)

4. Valitse OK kaksi kertaa.

Voit tallentaa julkaisun oletusarvon erilliseen tiedostoon ja lähettää sen muille käyttäjille. Tallenna ja lataa julkaisun oletusarvotiedostot Julkaisun
oletusarvot -valintaikkunan Tallenna- ja Lataa-painikkeiden avulla.

Julkaisun luominen oletusarvoa käyttämällä

1. Tee jokin seuraavista:

Valitse Tiedosto > Julkaisun oletusarvo > [oletusarvon nimi]. (Pidä vaihtopainiketta painettuna oletusarvon valitsemisen aikana, jos
haluat luoda uuden asiakirjan oletusarvon pohjalta avaamatta Uusi julkaisu -valintaikkunaa.)

Valitse Tiedosto > Uusi > Julkaisu ja valitse sitten oletusarvo Uusi julkaisu -valintaikkunan Julkaisun oletusarvo -valikosta.

Oletusarvoasetukset näkyvät Uusi julkaisu -valintaikkunassa.

2. Muuta halutessasi asetuksia ja valitse OK.

Voit ohittaa Uusi julkaisu -valintaikkunan painamalla vaihtonäppäintä, kun valitset oletusarvon Julkaisun oletusarvo -valikosta.
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QR-koodien luominen | CC

Alkuun

Alkuun

Tietoja QR-koodeista
QR-koodien hallinta InDesignissa

Tietoja QR-koodeista

QR-koodit ovat alun perin teollisuuden käyttöön kehitettyjä tulostettuja koodeja, joiden sisältämät tiedot voidaan lukea eri laitteilla. Niiden
käyttäminen kuluttajamainonnassa on yleistynyt. Kuluttajat voivat asentaa älypuhelimiinsa QR-koodinlukijan eli sovelluksen, joka lukee ja purkaa
koodin URL-tiedot ja ohjaa puhelimen selaimen esimerkiksi yrityksen sivustoon.

Lukemalla QR-koodin käyttäjät voivat esimerkiksi vastaanottaa tekstiviestejä, lisätä käyntikorttitietoja laitteisiinsa, avata web-hyperlinkkejä tai
kirjoittaa sähköposteja tai tekstiviestejä.

QR-koodien hallinta InDesignissa

Voit luoda ja muokata korkealaatuista QR-koodigrafiikkaa suoraan InDesignissa. Luotu QR-koodikohde on suuren tarkkuuden grafiikkaobjekti, joka
toimii samalla tavalla kuin InDesignin vektorikuvat. Objektit ovat helposti skaalattavissa ja niihin voidaan käyttää värejä. Voit lisätä objektiin myös
tehosteita, läpinäkyvyyden ja tulostusmääritteitä, kuten päällepainatuksen, spottivärit ja lihotuksen. Voit kopioida ja liittää koodigrafiikan
vektorigrafiikkaobjektina yleisiin graafisiin muokkaustyökaluihin, kuten Adobe Illustratoriin.

QR-koodin luominen

1. Valitse valikosta Objekti > Luo QR-koodi. Näkyviin tulee Luo QR-koodi -valintaikkuna.

Luo QR-koodi / Muokkaa QR-koodia -valintaikkunassa on kaksi välilehteä: Sisältö ja Väri.

2. Valitse Sisältö-välilehden avattavasta Tyyppi-luettelosta jokin seuraavista tietotyypeistä:

Web-hyperlinkki
Vain teksti
Tekstiviesti
Sähköposti
Käyntikortti

148



Valitun tyypin mukaan näkyviin tulee lisää kenttiä luotavan QR-koodin sisällön määrittämistä varten.

3. Väri-välilehdessä on Värimallien luettelo. Jos haluat käyttää QR-koodissa tiettyä väriä, avaa Väri-välilehti ja valitse koodissa käytettävä väri.
Oletusarvoisesti luodun QR-koodin väri on Musta ja tausta on läpinäkyvä.

4. Valitse OK.

5. Jos olet valinnut kehyksen ennen QR-koodin luomista, koodi sijoitetaan suoraan valittuun kehykseen ja kehyksen aiempi sisältö korvataan.

Jos et ole valinnut kehystä, QR-koodi ladataan Sijoitustyökaluun, jonka avulla se voidaan sijoittaa perinteisten EPS-objektien tapaan:

Kun napsautat julkaisun alueella, objekti sijoitetaan alkuperäisessä/oletuskoossa – 30 x 30 cm.
Kun napsautat julkaisussa olevaa kehystä, koodi sijoitetaan kehykseen oletuskoossa. (Koodi korvaa aiemman sisällön, jos napsautat
kehystä painamalla samalla Alt-näppäintä.)
Kun napsautat ja vedät hiirellä, voit piirtää uuden kehyksen kiinteillä mittasuhteilla. Kun vapautat hiiren, koodi sijoitetaan kehykseen.

Kun QR-koodi sijoitetaan julkaisuun, sitä käsitellään perinteisenä EPS-objektina, paitsi että sisältötiedot upotettuna koodina näyttävä työkaluvihje
tulee näyttöön, kun osoitin viedään objektin päälle.

QR-koodin sisällön ja värin muokkaaminen

1. Valitse QR-koodiobjekti tai kehys kaksoisnapsauttamalla kehyksen sisäpuolella.

2. Valitse valikosta Objekti > Muokkaa QR-koodia. Voit myös napsauttaa hiiren kakkospainiketta ja valita pikavalikosta Muokkaa QR-koodia.

3. Muokkaa QR-koodia -valintaikkunassa näkyy koodin nykyinen sisältö ja väritiedot.

4. Muuta tietotyyppiä ja sisältöä Sisältö-välilehdessä tarpeen mukaan.

5. Voit muuttaa QR-koodin väriä napsauttamalla Väri-välilehteä ja valitsemalla halutun värin.

6. Valitse OK.

QR-koodin kehysmääritteen muuttaminen

QR-koodikehyksen tausta on oletusarvoisesti läpinäkyvä. Voit kuitenkin muuttaa kehyksen Täyttö- ja Viiva-määritteitä, kuten Väri-, Viivan tyyli- ja
Paksuus-asetuksia perinteisten säätimien avulla.

QR-koodiobjektin muuntaminen

Voit siirtää sijoitettua QR-koodia, muuttaa sen kokoa tai kääntää sitä Valintatyökalun avulla. Kun vedät kehyksen reunoja, vain kehyksen koko
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muuttuu. Vetämisen aikana:

Jos painat vaihtonäppäintä, kehyksen mittasuhteet säilytetään.
Jos painat Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac), sekä kehys että sisältö skaalautuvat samassa mittasuhteessa.
Jos painat vaihto- ja Alt-näppäintä (Windows) tai optionäppäintä (Mac), kehys skaalataan sen keskustasta eikä mittasuhteita säilytetä. Voit
säilyttää mittasuhteet painamalla vaihtonäppäintä.
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Alaviitteet

Alkuun

Alkuun

Alaviitteiden luominen
Alaviitteiden numeroinnin ja asettelun muuttaminen
Alaviitteiden tekstin käsitteleminen
Tekstinkierrätys alaviitteissä
Alaviitteiden poistaminen 

Alaviitteiden luominen

Alaviite koostuu kahdesta linkitetystä osasta: tekstissä näkyvästä alaviitteen viittauksen numerosta ja palstan alareunassa olevasta
alaviitetekstistä. Voit luoda alaviitteitä tai tuoda niitä Word- tai RTF-tiedostoista. Alaviitteet numeroidaan automaattisesti, kun niitä lisätään
julkaisuun. Numerointi alkaa uudelleen jokaisessa jutussa. Voit määrittää numeroinnin tyylin ja ulkoasun sekä alaviitteiden asettelun. Alaviitteitä ei
voi lisätä taulukoihin tai alaviitetekstiin. Alaviitetekstin leveys perustuu sen palstan leveyteen, jossa alaviitemerkki on.

InDesignissa ei voi luoda loppuviitteitä. Microsoft Word -julkaisuista muunnetut loppuviitteet muotoillaan tekstiksi, ei alaviitteiksi. Jos haluat tietää,
miten loppuviitteiden luonti voidaan kiertää, perehdy Bob Bringhurstin InDesignin loppuviitteitä käsittelevään artikkeliin. 

Voit luoda alaviitteitä seuraavasti:

1. Sijoita kohdistin paikkaan, jossa haluat alaviitteen viittauksen numeron näkyvän.

2. Valitse Teksti > Lisää alaviite.

3. Kirjoita alaviiteteksti.

Alaviite lisätty julkaisuun

A. Viittauksen numero B. Alaviiteteksti 

Kun kirjoitat tekstiä, alaviitealue laajenee mutta tekstikehys pysyy entisen kokoisena. Alaviitealue laajenee ylöspäin, kunnes se ulottuu alaviitteen
viittauksen riville. Tämän jälkeen alaviite jaetaan seuraavaan tekstikehyksen palstaan tai ketjutettuun kehykseen. Jos alaviitettä ei voida jakaa ja
tekstiä on enemmän kuin alaviitealueelle mahtuu, alaviitteen viittauksen sisältävä rivi siirretään seuraavalle palstalle tai näyttöön ilmestyy
ylijuoksevan tekstin kuvake. Voit korjata tämän muuttamalla kehyksen kokoa tai tekstin muotoilua.

Voit palata kirjoituskohtaan valitsemalla Teksti > Siirry alaviitteen viittaukseen, kun kohdistin on alaviitteessä. Jos käytät tätä asetusta usein,
sille kannattaa luoda pikanäppäin.

Alaviitteiden numeroinnin ja asettelun muuttaminen

Alaviitteiden numerointiin ja asetteluun tehtävät muutokset vaikuttavat sekä olemassa oleviin että uusiin alaviitteisiin.

1. Valitse Teksti > Julkaisun alaviiteasetukset.
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Numerointityyli

Aloita kohdasta

Aloita numerointi uudestaan joka

Näytä etu- tai jälkiliite kohteessa

Sijainti

Merkkityyli

Kappaletyyli

Erotin

Pienin väli ennen ensimmäistä alaviitettä

Alaviitteiden väli

2. Valitse Numerointi ja muotoilu -välilehdessä asetukset, jotka määrittävät viittauksen numeron ja alaviitetekstin numeroinnin rakenteen ja
muotoilun ulkoasun.

3. Valitse Sivuasettelu ja sivun alaviiteosion ulkoasua määrittävät asetukset.

4. Napsauta OK-painiketta.

Alaviitteiden numerointi- ja muotoiluasetukset

Seuraavat Numerointi ja muotoilu -asetukset näkyvät Alaviiteasetukset-valintaikkunassa:

Valitse numerointityyli alaviitteen viittausten numeroille.

Määritä jutun ensimmäisen alaviitteen numero. Jokainen julkaisun juttu alkaa samalla Aloituskohta-numerolla. Jos kirjassa on
useita julkaisuja jatkuvalla sivunumeroinnilla, aloita alaviitteiden numerointi jokaisessa luvussa siitä, mihin edellinen luku päättyy.
Aloita kohdasta -valinnasta on hyötyä etenkin käsiteltäessä kirjan julkaisuja. Alaviitteiden numerointia ei jatketa kirjan julkaisujen välillä.

Jos haluat numeroinnin alkavan julkaisun sisällä uudestaan, valitse tämä vaihtoehto ja sitten Sivu, Aukeama
tai Osio määrittääksesi, milloin alaviitteiden numerointi aloitetaan uudestaan. Tietyt numerointityylit, kuten asteriskit (*), toimivat parhaiten, kun ne
palautetaan jokaisella sivulla.

Valitse tämä asetus, jos haluat näyttää etu- tai jälkiliitteet alaviitteen viittauksessa, alaviitetekstissä tai
molemmissa. Etuliitteet näkyvät numeron edessä (kuten [1) ja jälkiliitteet näkyvät numeron perässä (kuten 1]). Tämä asetus on erityisen
hyödyllinen, jos alaviitteitä halutaan sijoittaa merkkien sisään, esimerkiksi [1]. Kirjoita merkki tai merkkejä tai valitse Etuliite- ja/tai Jälkiliite-asetus.
Jos haluat valita erikoismerkkejä, näytä valikko napsauttamalla etu- ja takaliitesäätimien vieressä olevia kuvakkeita.

Jos alaviitteen viittauksen numero on liian lähellä edeltävää tekstiä, yhden välilyöntimerkin lisääminen etuliitteeksi parantaa ulkoasua. Voit
käyttää viittauksen numerossa myös merkkityyliä.

Tämä asetus määrittää alaviitteen viittauksen numeron näkymisen. Oletusarvo on yläindeksi. Jos haluat muotoilla numeron käyttämällä
merkkityyliä (esimerkiksi OpenTypen yläindeksiasetukset sisältävä merkkityyli), valitse Ota käyttöön normaali ja määritä merkkityyli.

Muotoile alaviitteen viittauksen numeroa merkkityylillä. Valitse esimerkiksi yläindeksin sijaan merkkityyli normaalissa sijainnissa ja
kohotetulla perusviivalla. Valikosta näkee Merkkityyli-paneelissa käytettävissä olevat merkkityylit.

Valitse kappaletyyli, joka muotoilee julkaisun kaikkien alaviitteiden alaviitetekstin. Valikosta näkee Kappaletyyli-paneelissa
käytettävissä olevat kappaletyylit. Oletuksena käytetään [Peruskappale]-tyyliä. [Peruskappale]-tyylin ja julkaisun oletuskirjasinasetusten ulkoasu ei
välttämättä ole samanlainen.

Erotin määrittää alaviitteen numeron ja alaviitetekstin alun välisen tyhjän tilan. Jos haluat muuttaa erotinta, valitse tai poista ensin nykyinen
erotin ja valitse sitten uusi erotin. Voit käyttää useita merkkejä. Jos haluat lisätä välilyöntimerkkejä, käytä sopivaa metamerkkiä (esimerkiksi ^m, jos
haluat em-välin).

Alaviitteiden asetteluasetukset

Seuraavat Sivuasettelu-asetukset näkyvät Alaviiteasetukset-valintaikkunassa:

Tämä asetus määrittää palstan alareunan ja ensimmäisen alaviiterivin välisen pienimmän välin arvon.
Negatiivista arvoa ei voi käyttää. Mikä tahansa alaviitteen kappaleen Väli ennen -asetus ohitetaan.

Tämä asetus määrittää palstan yhden alaviitteen viimeisen kappaleen ja seuraavan alaviitteen ensimmäisen kappaleen välisen
etäisyyden. Negatiivista arvoa ei voi käyttää. Alaviitteen kappaleen Väli ennen- ja Väli jälkeen -arvot ovat käytössä vain, jos alaviitteessä on useita
kappaleita.
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Ensimmäisen perusviivan siirtymä

Sijoita jutun lopun alaviitteet tekstin alareunaan

Salli alaviitteiden jakaminen

Viiva yläpuolella

Alkuun

Tämä asetus määrittää alaviitealueen alun (kohta, jossa alaviitteen erotin oletusarvoisesti näkyy) ja
alaviitetekstin ensimmäisen rivin välisen etäisyyden.
Tietoja ensimmäisen perusviivan asetuksista on kohdassa Tekstikehyksen ominaisuuksien muuttaminen.

Valitse tämä asetus, jos haluat viimeisen palstan alaviitteiden näkyvän aivan jutun viimeisen
kehyksen tekstin alapuolella. Jos asetus ei ole valittuna, jutun viimeisen kehyksen alaviitteet näkyvät palstan alareunassa.

Valitse tämä asetus, jos haluat alaviitteen jakautuvan, kun se ylittää sen käytössä olevan tilan palstalla. Jos
jakaminen ei ole sallittu, alaviitteen viittauksen numeron sisältävä rivi siirtyy seuraavalle palstalle tai tekstistä tulee ylijuoksevaa.

Vaikka Salli alaviitteiden jakaminen -asetus on käytössä, voit estää yksittäisten alaviitteiden jakautumisen sijoittamalla kohdistimen
alaviitetekstiin. Valitse Kappale-paneelin valikosta Pitoasetukset ja sieltä sitten vaihtoehdot Pidä rivit yhdessä ja Kaikki kappaleen rivit. Jos
alaviitteessä on useita kappaleita, käytä Sido seuraavat X riviä -asetusta alaviitetekstin ensimmäisessä kappaleessa. Voit määrittää alaviitteen
jakamiskohdan valitsemalla Teksti > Lisää vaihtomerkki > Palstanvaihto.

Kahdelle palstalle jaettu alaviite

Määritä alaviitetekstin yläpuolella olevan, alaviitteen muusta tekstistä erottavan viivan sijainti ja ulkoasu. Erottava viiva (jota
kutsutaan myös erotinviivaksi) on myös erillisessä palstassa jatkuvan alaviitetekstin yläpuolella. Valitsemasi asetukset koskevat joko Palstan
ensimmäinen alaviite- tai Jatketut alaviitteet -kohtaa sen mukaan, kumpi niistä on valittu valikosta. Nämä asetukset ovat samankaltaisia
kappaleviivan määrittämisessä käytettävien asetusten kanssa. Jos haluat poistaa alaviitteen erotinviivan kokonaan, poista valinta kohdasta Viiva
käytössä.

Alaviitteiden tekstin käsitteleminen

Huomioi seuraavat seikat, kun muokkaat alaviitetekstiä:

Valitse nykyisen alaviitteen teksti valitsemalla Muokkaa > Valitse kaikki, kun kohdistin on alaviitteen tekstissä. Tällöin toiminto ei valitse muita
alaviitteitä tai muuta tekstiä.
Voit siirtyä alaviitteestä toiseen nuolinäppäimillä.
Alaviitteiden numerointia ei jatketa kirjan julkaisujen välillä. Jos et halua numeroinnin alkavan alusta jokaisessa kirjan julkaisussa, muuta
Aloita kohdasta -arvoa manuaalisesti jokaisessa julkaisussa muokkauksen päätteeksi.
Voit laajentaa ja kutistaa alaviitteen napsauttamalla juttueditorissa alaviitekuvaketta. Voit laajentaa tai kutistaa kaikki alaviitteet valitsemalla
Näytä > Juttueditori > Laajenna kaikki alaviitteet tai Kutista kaikki alaviitteet.
Voit laajentaa tai kutistaa alaviitteet Raakateksti- ja Juttu-näkymissä napsauttamalla alaviitekuvaketta. Voit laajentaa tai kutistaa kaikki
alaviitteet napsauttamalla alaviitettä hiiren kakkospainikkeella (Windows) tai Ctrl-osoittamalla (Mac OS) alaviitettä ja valitsemalla Laajenna
kaikki alaviitteet tai Kutista kaikki alaviitteet.

Voit käyttää alaviitetekstissä merkki- ja kappalemuotoiluja. Voit myös valita alaviitteen viittauksen numeron ulkoasun ja muuttaa sitä.
Suositeltavaa on kuitenkin käyttää Julkaisun alaviiteasetukset -valintaikkunaa.

Kun leikkaat tai kopioit tekstiä, joka sisältää alaviitteen viittauksen numeron, myös alaviiteteksti lisätään leikepöydälle. Jos kopioit tekstin
toiseen julkaisuun, tekstin alaviitteet käyttävät uuden julkaisun numerointi- ja asetteluominaisuuksia.

Voit palauttaa vahingossa poistetun alaviitteen numeron alaviitetekstin alusta. Sijoita kohdistin alaviitetekstin alkuun, napsauta sitä hiiren
kakkospainikkeella (Windows) tai napsauta sitä Ctrl-näppäin alhaalla (Mac OS) ja valitse sitten Lisää erikoismerkki > Merkit > Alaviitteen
numero.
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Alkuun

Jos poistat ohitukset ja merkkityylit kappaleesta, joka sisältää alaviitteen viittauksen merkin, alaviitteen viittauksen numerot menettävät
Julkaisun alaviiteasetukset -valintaikkunassa annetut määritteet.

Tekstinkierrätys alaviitteissä

Voit käyttää tekstinkierrätystä alaviitteeseen sisältyvässä ankkuroidussa tai irrallisessa objektissa.

Alaviitteissä olevien objektien sisäinen tekstinkierrätys

Voit lisätä alaviitteeseen tekstiin sidotun tai ankkuroidun objektin, jossa on käytetty tekstinkierrätystä. Teksti kierrätetään ja säädetään
saumattomasti objektin ympärille.

Sisäisessä tekstinkierrätyksessä teksti kierrätetään vain sen pisteen alapuolella, johon objekti on ankkuroitu alaviitteessä.

Sisäinen tekstinkierrätys

Alaviitteissä olevien objektien ulkoinen tekstinkierrätys

Jos irrallinen objekti (joka ei ole tekstiin sidottu tai ankkuroitu), jossa on käytetty tekstinkierrätystä, liittyy alaviitteiden tekstiin, silloin käytetään
tekstinkierrätystä. Teksti säädetään dynaamisesti objektin ympärille.

Alla olevassa esimerkissä valokuva ei kuulu alaviitteeseen, mutta teksti säädetään saumattomasti objektin ympärille.
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Alkuun

Ulkoinen tekstinkierrätys

Alaviitteet ei-suorakulmaisissa kehyksissä

Ei-suorakulmaisissa tekstikehyksissä, kuten kulmiltaan pyöristetyissä kehyksissä, soikioissa ja ympyröissä, alaviitteet pysyvät objektin muotojen
rajoissa.

Alaviitteiden poistaminen 

Jos haluat poistaa alaviitteen, valitse tekstissä näkyvä alaviitteen viittauksen numero ja paina askelpalautinta tai Delete-näppäintä. Jos poistat vain
alaviitetekstin, alaviitteen viittauksen numero ja alaviitteen rakenne jäävät ennalleen.
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Tekstimuuttujat

Alkuun

Tekstimuuttujien luominen ja muokkaaminen
Tekstimuuttujien lisääminen
Tekstimuuttujien poistaminen, muuntaminen ja tuominen

Tekstimuuttujien luominen ja muokkaaminen
Tekstimuuttuja on kohde, joka lisätään julkaisuun ja joka vaihtelee kontekstin mukaan. Esimerkiksi Viimeisen sivun numero -muuttuja näyttää
julkaisun viimeisen sivun numeron. Jos lisäät tai poistat sivuja, muuttuja päivittyy tämän mukaisesti.

InDesign sisältää useita valmiiksi määritettyjä tekstimuuttujia, joita voit lisätä julkaisuun. Voit muokata näiden muuttujien muotoilua tai luoda omia
muuttujia. Eräitä muuttujia (esimerkiksi juokseva ylätunniste ja lukunumero) on erityisen hyödyllistä lisätä sivupohjiin, sillä ne varmistavat
yhdenmukaisen muotoilun ja numeroinnin. Toisia muuttujia (esimerkiksi luontipäivämäärä ja tiedostonimi) on hyödyllistä lisätä esimerkiksi
tulostuksen informaatioalueeseen.

Huomautus: Jos muuttujaan lisätään liikaa tekstiä, teksti voi muuttua ylijuoksevaksi tai pakatuksi. Muuttujan teksti ei vaihda riviä.

Tekstimuuttujien luominen tai muokkaaminen
Muuttujan luomisessa käytettävissä olevat asetukset riippuvat määrittämästäsi muuttujatyypistä. Jos esimerkiksi valitset lukunumerotyypin, voit
määrittää tekstin näkymään sekä ennen numeroa että sen jälkeen, ja voit myös määrittää numerointityylin. Voit luoda useita samaan
muuttujatyyppiin perustuvia erilaisia muuttujia. Voit esimerkiksi luoda muuttujan, joka näyttää tekstin "1. luku", ja toisen muuttujan, joka näyttää
tekstin "Luku 1".

Jos valitset juoksevan ylätunnistetyypin, voit määrittää, mitä tyyliä ylätunnisteen perustana käytetään, ja voit valita virkkeiden lopun välimerkkien
poistamiseen ja kirjainkoon muuttamiseen liittyviä asetuksia.

1. Jos haluat luoda kaikissa uusissa julkaisussa käytettäviä tekstimuuttujia, sulje kaikki julkaisut. Muussa tapauksessa luomasi tekstimuuttujat
näkyvät vain nykyisessä julkaisussa.

2. Valitse Teksti > Tekstimuuttujat > Määritä.

3. Napsauta Uusi-painiketta tai valitse olemassa oleva muuttuja ja valitse Muokkaa.

4. Kirjoita muuttujan nimi (esimerkiksi "Täysi luku" tai "Juokseva otsikko").

5. Valitse Teksti-valikosta muuttujatyyppi, määritä sen asetukset ja valitse OK.

Käytettävissä olevat asetukset vaihtelevat valitsemasi muuttujatyypin mukaan.

Teksti ennen / Teksti jälkeen Voit määrittää kaikille muuttujatyypeille (mukautettua tekstiä lukuun ottamatta) tekstin, joka lisätään muuttujan
eteen tai jälkeen. Voit esimerkiksi lisätä sanan "yhteensä" Viimeisen sivun numero -muuttujan eteen ja sanan "sivusta" muuttujan jälkeen,
jolloin muodostuisi esimerkiksi kokonaisuus "yhteensä 12 sivusta". Voit myös liittää ruutuihin tekstiä, mutta erikoismerkit, kuten sarkaimet ja
automaattiset sivunumerot, poistetaan. Jos haluat lisätä erikoismerkkejä, napsauta tekstiruudun oikealla puolella olevaa kolmiota.

Tyyli Voit määrittää kaikille numeroiduille muuttujatyypeille numerointityylin. Jos [Nykyinen numerointityyli] on valittuna, muuttuja käyttää
julkaisun Numerointi- ja osioasetukset -valintaikkunassa valittua numerointityyliä.

Muuttujatyypit

Luvun numero
Lukunumerotyypillä luotu muuttuja lisää luvun numeron. Voit lisätä tekstiä lukunumeron eteen tai jälkeen ja määrittää numerointityylin.

Jos julkaisun lukunumeron on määrä jatkaa kirjan aikaisemmasta julkaisusta, saatat joutua päivittämään kirjan numeroinnin, jotta oikea lukunumero
tulee näkyviin.

Luontipäivämäärä, muokkauspäivämäärä ja tulostuspäivämäärä
Luontipäivämäärä lisää päivämäärän tai kellonajan, jolloin julkaisu tallennettiin ensimmäisen kerran. Muokkauspäivämäärä lisää päivämäärän tai
kellonajan, jolloin julkaisu tallennettiin viimeksi levylle. Tulostuspäivämäärä lisää päivämäärän tai kellonajan, jolloin julkaisu tulostettiin, vietiin PDF-
muotoon tai pakattiin. Voit lisätä tekstiä päivämäärän eteen ja jälkeen ja voit muokata kaikkien päivämäärämuuttujien päiväyksen muotoa.

Päiväyksen muoto Voit kirjoittaa päiväysmuodot suoraan Päiväyksen muoto -ruutuun tai valita muotoasetukset napsauttamalla ruudun oikealla
puolella olevaa kolmiota. Esimerkiksi päiväyksen muoto "MM/dd/yy" näkyy seuraavasti: 12/22/07. Jos muutat muodoksi "MMM. d, yyyy",
päivämäärä näkyy seuraavasti: Dec. 22, 2007.
Päivämäärämuuttujat käyttävät tekstissä käytettyä kieltä. Luontipäivämäärä voi esimerkiksi suomalaisessa tekstissä olla "1. joulukuuta 2007" ja
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saksalaisessa tekstissä "01 Dezember 2007."

Lyhenne Kuvaus Esimerkki

M Kuukauden numero, ei etunollaa 8

MM Kuukauden numero, etunolla 08

MMM Lyhennetty kuukauden nimi Elo

MMMM Kuukauden koko nimi Elokuu

d Päivän numero, ei etunollaa 5

dd Päivän numero, etunolla 05

E Viikonpäivän lyhennetty nimi Pe

EEEE Viikonpäivän koko nimi Perjantai

yy tai YY Vuosi, viimeiset kaksi numeroa 07

v (V) tai vvvv (VVVV) Vuoden koko numero 2007

G tai GGGG Aikakausi, lyhennetty tai kokonaan AD tai Anno Domini

h Tunti, ei etunollaa 4

hh Tunti, etunolla 04

H Tunti, ei etunollaa, 24 tunnin muoto 16

HH Tunti, etunolla, 24 tunnin muoto 16

m Minuutti, ei etunollaa 7

mm Minuutti, etunolla 07

s Sekunti, ei etunollaa 7

ss Sekunti, etunolla 07

a AM tai PM, kaksi merkkiä PM

z tai zzzz Aikavyöhyke, lyhennetty tai koko nimi PST tai Pacific Standard Time

Tiedostonimi
Tämä muuttuja lisää nykyisen tiedoston nimen julkaisuun. Muuttuja lisätään usein julkaisun informaatioalueeseen, tai sitten sitä käytetään ylä- ja
alatunnisteissa. Voit Teksti ennen- ja Teksti jälkeen -asetusten lisäksi valita seuraavia asetuksia.

Sisällytä kansion koko polku Valitse tämä asetus, jos haluat sisällyttää tiedostonimeen kansion koko polun. Ohjelma käyttää Windows- ja
Mac OS -käyttöjärjestelmien normaaleja polunmerkintätapoja.
Sisällytä tiedostotunniste Valitse tämä asetus, jos haluat sisällyttää tiedostonimitunnisteen.
Tiedostonimi-muuttuja päivittyy aina, kun tallennat tiedoston uudella nimellä tai uuteen sijaintiin. Polku tai tunniste ei näy julkaisussa, ennen kuin
julkaisu on tallennettu.

Kuvan nimi
Kuvan nimi -muuttujalla voit tuottaa automaattisia kuvatekstejä metatiedoista. Kuvan nimi -muuttuja sisältää muuttujatyypin Metatieto-otsikko. Jos
tämän muuttujan sisältämä tekstikehys on kuvan vieressä tai ryhmitetty sen kanssa, muuttuja näyttää kyseisen kuvan metatiedot. Voit muokata
Kuvan nimi -muuttujaa ja määrittää, mitä metatietokenttää käytetään.

Katso Kuvatekstimuuttujien määrittäminen.

Viimeisen sivun numero
Viimeisen sivun numero -tyyppi on hyödyllinen, jos haluat lisätä julkaisun kokonaissivumäärän ylä- ja alatunnisteisiin käyttämällä yleistä "sivu 3/12"
-muotoa. Tässä tapauksessa Viimeisen sivun numero -muuttuja luo numeron 12. Luku päivittyy aina, kun sivuja lisätään tai poistetaan. Voit lisätä
tekstiä viimeisen sivun numeron eteen tai jälkeen ja määrittää numerointityylin. Valitse Käyttöala-valikosta asetus ja määritä, käytetäänkö osion tai
julkaisun viimeisen sivun numeroa.
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Huomaa, että Viimeisen sivun numero -muuttuja ei laske julkaisun sivuja.

Juokseva ylätunniste (kappale- tai merkkityyli)
Juokseva ylätunniste -muuttujat lisäävät sivun ensimmäisen tai viimeisen esiintymän tekstistä, jossa määritettyä tyyliä käytetään. Jos sivulla ei ole
valitulla tyylillä muotoiltua tekstiä, käytetään edellisen sivun tekstiä.

Lisätietoja: Muuttujien luominen juokseville ylä- ja alatunnisteille.

Mukautettu teksti
Tällä muuttujalla lisätään yleensä paikkamerkkitekstiä tai tekstijono, jota voidaan joutua muuttamaan nopeasti. Jos esimerkiksi käsittelet projektia,
joka käyttää yhtiöstä koodinimeä, voit luoda koodinimelle mukautetun tekstimuuttujan. Kun voit myöhemmin käyttää yhtiön oikeaa nimeä, voit
muuttujaa muuttamalla päivittää kaikki esiintymät kerralla.

Jos haluat lisätä tekstimuuttujaan erikoismerkkejä, napsauta tekstiruudun oikealla puolella olevaa kolmiota.

Tekstimuuttujien lisääminen
1. Sijoita lisäyskohta paikkaan, johon haluat muuttujan.

2. Valitse Teksti > Tekstimuuttujat > Lisää muuttuja ja valitse haluamasi muuttuja.

Muuttuja näkyy sivulla kuin olisit kirjoittanut sen julkaisuun. Luontipäivämäärämuuttuja voi esimerkiksi näkyä muodossa 22. joulukuuta 2007. Jos
valitset Teksti > Näytä piilomerkit, muuttujan esiintymää ympäröi nykyisen tason värinen ruutu.

Huomautus: Tekstimuuttujat eivät tee rivinvaihtoja.

Tekstimuuttujien poistaminen, muuntaminen ja tuominen
Poista, muunna ja tuo tekstimuuttujia Tekstimuuttujat-valintaikkunassa.

Tekstimuuttujien poistaminen
Jos haluat poistaa julkaisuun lisätyn tekstimuuttujan esiintymän, valitse muuttuja ja paina askelpalautinta tai Delete-näppäintä. Voit myös poistaa
itse muuttujan. Kun teet niin, voit päättää, kuinka julkaisuun lisätyt muuttujat korvataan.

1. Valitse Teksti > Tekstimuuttujat > Määritä.

2. Valitse ensin muuttuja ja sitten Poista.

3. Määritä, kuinka muuttuja korvataan: määritä toinen muuttuja, muunna muuttujan esiintymät tekstiksi tai poista muuttujan esiintymät
kokonaan.

Tekstimuuttujien muuntaminen tekstiksi

Jos haluat muuntaa yhden esiintymän, valitse ensin tekstimuuttuja julkaisuikkunasta ja sitten Teksti > Tekstimuuttujat > Muunna muuttuja
tekstiksi.

Jos haluat muuntaa tekstimuuttujan kaikki esiintymät julkaisussa, valitse Teksti > Tekstimuuttujat > Määritä ja valitse sitten muuttuja ja
Muunna tekstiksi.

Tekstimuuttujien tuominen toisesta julkaisusta

1. Valitse Teksti > Tekstimuuttujat > Määritä.

2. Valitse Lataa ja kaksoisnapsauta julkaisua, joka sisältää haluamasi muuttujat.

3. Varmista Lataa tekstimuuttujat -valintaikkunassa, että haluamiesi muuttujien vieressä on valintamerkki. Jos jollakin olemassa olevista
muuttujista on sama nimi kuin tuodulla muuttujalla, valitse ensin jokin seuraavista Ristiriita nykyisen tekstimuuttujan kanssa -kohdan
asetuksista ja sitten OK:

Käytä saapuvaa määritystä  Korvaa nykyisen muuttujan ladatulla muuttujalla ja käyttää uusia määritteitä kaikissa nykyisen julkaisun
teksteissä, joissa aikaisemmin käytettiin vanhaa muuttujaa. Voit vertailla muuttujia keskenään, sillä tuotavien ja nykyisten muuttujien
määritykset näkyvät Lataa tekstimuuttujat -valintaikkunan alareunassa.

Nimeä uudelleen automaattisesti Nimeää ladatun muuttujan uudelleen.

4. Valitse OK ja valitse sitten Valmis.

Voit myös kopioida muuttujia toisiin julkaisuihin, kun synkronoit kirjatiedoston.

Lisää ohjeaiheita
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Hakemiston luominen
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Tietoja hakemistoista
Hakemisto-paneelin yleiskuvaus
Aiheluettelon luominen hakemistoa varten
Hakemistoviittausten lisääminen
Sivualueen asetukset hakemistoissa
"Katso"- tai "Katso myös" -viitteiden lisääminen hakemistoon
Hakemiston luominen
Hakemistojen lajittelujärjestyksen muuttaminen
Hakemiston hallinta

Tietoja hakemistoista
Voit luoda hakemistosta yksinkertaisen avainsanaluettelon tai kattavan oppaan kirjan sisältöön. Voit luoda julkaisulle tai kirjalle vain yhden
hakemiston. Luo hakemisto merkitsemällä ensin hakemistoviittaukset tekstiin. Liitä jokainen hakemistomerkki sanaan eli aiheeseen, jonka haluat
näkyvän hakemistossa.

Kun luot hakemiston, ohjelmaa näyttää siinä luettelona kaikki aiheet ja niiden sivunumerot. Aiheet lajitellaan aakkosjärjestyksessä, tavallisesti osien
otsikoiden alle (A, B, C ja niin edelleen). Hakemistoviittauksessa on aihe (käyttäjän hakema termi) ja sivuviittaus (sivunumero tai -alue) tai
ristiviittaus. Ristiviittausta edeltää Katso- tai Katso myös -viittaus, joka ohjaa lukijan muihin hakemiston viittauksiin, ei numeroiduille sivuille.

Hakemiston osat
A. Otsikko B. Osan otsikko C. Hakemistoviittaus D. Alakohta E. Aihe F. Sivuviittaus G. Ristiviittaus

Voit katsoa hakemiston luomista käsittelevän videon osoitteessa www.adobe.com/go/vid0220_fi.

Hakemiston luomiseen liittyviä vihjeitä
Hyvin suunniteltu ja täydellinen hakemisto tuo julkaisun sisältämät tiedot heti lukijoiden ulottuville. Noudata näitä hyödyllisiä ohjeita:

Mieti, miltä haluat hakemiston näyttävän. Kuinka monta aihetasoa siinä on? Sisältääkö se viittauksia muihin asiaan liittyviin aiheisiin? Onko
yksinkertainen hakusanahakemisto riittävä vai haluatko monimutkaisemman hakemiston, jossa on ristiviittauksia läheisiin aiheisiin ja
vastaaviin termeihin?

Ennakoi eri tapoja, joilla lukijat etsivät tietoja. Joku saattaa etsiä tietoa eläimistä katsomalla kohtaa eläimet, joku toinen etsii kohdista luonto
tai eläimistö.

Lisää hakemistoviittaukset, kun julkaisun sisältö on jo melko valmis. Jos poistat myöhemmin suuria osia tekstistä, hakemistotyö menee
hukkaan.

Hyvin suunnitellussa hakemistossa aiheet esitetään johdonmukaisesti. Yleisiä ongelmia ovat isot ja pienet kirjaimet (kissat ja Kissat) sekä
yksikkö- ja monikkomuodot (kissa ja kissat). Pidä termit yhdenmukaisina aiheluettelon avulla.

Tarkista hakemisto useita kertoja ennen lopullisen hakemiston luomista. Etsi kahteen kertaan lisättyjä aiheita, huonoja aihealueita,
kirjoitusvirheitä ja epäjohdonmukaista isojen kirjainten käyttöä ja sananvalintaa. InDesign tulkitsee esimerkiksi sanat Gepardi, gepardi ja
gepardit eri sanoiksi.

Hakemiston luomisen työnkulku
Hakemiston luominen

1. Aiheluettelon luominen (valinnainen) Hakemistoviittaukset on helpompi pitää yhdenmukaisina aiheluettelon avulla. (Lisätietoja: Aiheluettelon
luominen hakemistoa varten.)
2. Lisää hakemistomerkit. Lisää hakemistomerkit julkaisun sivuille, joihin haluat hakemistoviittausten viittaavan. (Lisätietoja: Hakemistoviittausten
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lisääminen.)
3. Luo hakemisto. Hakemiston luominen kokoaa viittaukset ja niiden sivunumerot yhteen merkkien perusteella. (Lisätietoja: Hakemiston
luominen.)
4. Juoksuta hakemistojuttu. Juoksuta hakemisto tekstikehykseen ladatun tekstin kohdistimen avulla. Hakemisto halutaan yleensä alkavan
uudelta sivulta. Kun olet juoksuttanut hakemiston, voit muotoilla sivuja ja hakemistoa.
Joudut luultavasti toistamaan nämä vaiheet useita kertoja, kun muokkaat hakemistoa ennen julkaisua.

Hakemisto-paneelin yleiskuvaus
Hakemisto-paneelin (Ikkuna > Teksti ja taulukot > Hakemisto) avulla voi luoda hakemiston sekä muokata ja esikatsella sitä. Paneelissa on kaksi
tilaa: Viittaus ja Aihe. Viittaus-tilassa nykyisen julkaisun tai kirjan hakemistoviittaukset näkyvät kokonaisuudessaan esikatselussa. Aihe-tilassa
esikatselussa näkyvät vain aiheet, ei sivu- tai ristiviittauksia. Aihe-tilaa käytetään pääasiassa hakemiston rakenteen luomiseen, kun taas Viittaus-
tilassa lisätään hakemistoviittauksia.

Viittaus-tilassa hakemistoviittaukset ovat aakkosjärjestyksessä, ja ne on jaettu osiin kirjaimittain. Viittausten viereisten kolmioiden avulla voit
laajentaa tai kutistaa viittauksen sekä katsella alakohtia, sivunumeroita ja ristiviittauksia.

Sivuviittausten tilalla näkyvät seuraavat koodit. Ne osoittavat hakemistoviittaukset, joita ei voi sisällyttää luotuun hakemistoon. Hakemistopaneelin
Päivitä esikatselu -toiminto on ehkä suljettava koodien tarkastelua varten.

TP Ilmaisee taittopöydällä olevia hakemistoviittauksia. Nämä viittaukset eivät näy valmiissa hakemistossa.
KT Ilmaisee kätketyllä tasolla olevia viittauksia. Kun luot hakemistot, voit sisällyttää hakemistoviitteet piilotettuun kerrokseen.
PT Ilmaisee, että hakemistoviitteet ovat piilotettuja. Piilotettuja hakemistoviitteitä ei sisällytetä hakemistoon.
YJ Ilmaisee ylijuoksevassa tekstissä olevia hakemistoviittauksia. Kun sisällytät nämä viittaukset luotuun hakemistoon, ne näkyvät ilman
sivunumeroita.
Sivupohja Ilmaisee sivupohjassa olevia hakemistoviittauksia. Nämä viittaukset eivät näy valmiissa hakemistossa.
Avaa tai sulje kohta napsauttamalla kolmiota. Laajenna tai kutista kaikki viittauksen alakohdat napsauttamalla kolmiota Ctrl-näppäin (Windows) tai
optionäppäin (Mac OS) alhaalla. Laajenna tai kutista kaikki viittaukset napsauttamalla kolmiota Alt-näppäin (Windows) tai komentonäppäin
(Mac OS) alhaalla.

Päivitä esikatselualue valitsemalla Hakemisto-paneelivalikosta Päivitä esikatselu. Toiminto on erityisen hyödyllinen, jos julkaisuun on tehty
paljon muutoksia tai hakemistomerkkejä on siirretty.

Aiheluettelon luominen hakemistoa varten
Voit luoda tai tuoda aiheluettelon, jota voit käyttää lähtökohtana hakemistoviittausten luomiselle. Kun tämän jälkeen lisäät viittauksia hakemistoon,
voit valita aiheita aiheluettelosta sen sijaan, että kirjoittaisit ne aina uudelleen. Näin hakemiston tiedot ovat yhdenmukaisia koko julkaisussa tai
kirjassa.

Voit luoda ja muokata aiheluettelon Hakemisto-paneelin avulla Aihe-tilassa. Huomaa, että Aihe-tilassa näkyvät vain aiheet. Jos haluat esikatsella
hakemistoviittauksia ja niihin liittyviä sivunumeroita ja ristiviittauksia, käytä Viittaus-tilaa.

Hakemisto-paneeli Viittaus-tilassa (vasen) ja Aihe-tilassa (oikea)

Aiheluettelon aiheet näkyvät myös Uusi sivuviittaus -valintaikkunassa. Voit luoda hakemistoviittauksen valitsemalla aiheen ja liittämällä sen sivun
tai ristiviittauksen avulla. Käyttämättömät aiheet (ei sivua tai ristiviittausta) ohitetaan, kun luot hakemiston.

Aiheluettelo on luotava ennen hakemistoviittausten lisäämistä. Luodun hakemistoviittauksen aihe lisätään automaattisesti aiheluetteloon.

Aiheluetteloon lisäämäsi aiheet eivät oletusarvoisesti näy viiteluettelossa, joka sisältää vain sivuun liitetyt aiheet. Jos kuitenkin haluat lisätä
aiheet viiteluetteloon, voit valita Viittaus-tilassa Hakemisto-paneelivalikosta asetuksen Näytä käyttämättömät aiheet.
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Aiheiden lisääminen aiheluetteloon
1. Avaa Hakemisto-paneeli valitsemalla Ikkuna > Teksti ja taulukot > Hakemisto.
2. Valitse Aihe.
3. Valitse Hakemisto-paneelivalikosta Uusi aihe tai napsauta paneelin alaosassa olevaa Luo uusi hakemistoviittaus -kuvaketta.
4. Tee jokin seuraavista:

Kirjoita aiheen nimi (esimerkiksi eläimet) Aihetasot-kohdan ensimmäiseen ruutuun. Luo ala-aihe kirjoittamalla nimi (kissat) toiseen
ruutuun. Tässä esimerkissä "kissat" on tarkoitettu "eläimet" -aiheen alle. Luo toisen tason ala-aihe kirjoittamalla nimi (siamilaiset)
kolmanteen ruutuun ja niin edelleen.

Valitse aiempi aihe. Kirjoita ala-aiheet toiseen, kolmanteen ja neljänteen ruutuun.

5. Lisää aihe valitsemalla Lisää. Aihe näkyy Uusi aihe -ikkunassa ja Hakemisto-paneelissa.
6. Valitse Valmis, kun olet lisännyt kaikki aiheet.

Poista juuri lisäämäsi aihe valitsemalla Valmis, valitsemalla aihe Hakemisto-paneelista ja napsauttamalla Poista valittu viittaus -painiketta.

Aiheiden tuominen toisesta InDesign-julkaisusta
1. Valitse Hakemisto-paneelivalikosta Tuo aiheita.
2. Valitse julkaisu, joka sisältää tuotavat hakemistoaiheet, ja valitse Avaa.

Hakemiston aiheen muokkaaminen
Voit muokata viittauksia Hakemisto-paneelissa ennen hakemiston luomista tai sen jälkeen. Hakemisto-paneelissa viittauksiin tekemäsi muutokset
näkyvät seuraavassa luomassasi hakemistossa, mutta luotuun hakemistojuttuun tekemäsi muutokset menetetään, kun luot hakemiston uudelleen.

1. Avaa julkaisu, joka sisältää hakemistoaiheet.
2. Valitse Hakemisto-paneelissa Aihe.
3. Kaksoisnapsauta muokattavaa aihetta esikatselualueella.
4. Muokkaa aihetta haluamallasi tavalla ja valitse OK.

Hakemistoviittausten lisääminen
Voit luoda hakemistoviittauksia Hakemisto-paneelin Viittaus-tilassa. Hakemistoviittaus koostuu kahdesta osasta: aiheesta ja viittauksesta. Aiheet
voidaan määrittää etukäteen aiheluettelon avulla. Viittaukset voivat olla sivunumeroita tai ristiviittauksia muihin aiheisiin.

Hakemisto-paneeli Viittaus-tilassa
A. Teksti B. Alakohta C. Sivuviittaus D. Ristiviittaus

Hakemistomerkki lisätään valitun tekstin ensimmäisen sanan eteen tai kohdistimen kohdalle. Hakemistomerkit saa näkyviin valitsemalla
vaihtoehdon Teksti > Näytä piilomerkit.

Hakemistoviittauksen lisääminen
1. Vie kohdistin tekstityökalulla  kohtaan, johon haluat lisätä hakemistomerkin, tai valitse hakemistoviittauksena käytettävä julkaisun teksti.

Jos valittu teksti sisältää sidottua grafiikkaa tai erikoismerkkejä, jotkin merkit (kuten hakemistomerkit ja sidottu grafiikka) poistetaan Aihetaso-
ruudussa. Muita merkkejä, kuten pitkiä ajatusviivoja ja tekijänoikeusmerkkejä, muunnetaan metamerkeiksi (kuten ^_ tai ^2).
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2. Avaa Hakemisto-paneeli valitsemalla Ikkuna > Teksti ja taulukot > Hakemisto.
3. Valitse Viittaus.

Jos Aihe-luetteloon lisätyt kirjaukset eivät näy Viittaus-luettelossa, valitse Hakemisto-paneelivalikosta asetus Näytä käyttämättömät
aiheet. Voit käyttää näitä aiheita viitteitä lisätessäsi.

4. Voit tarkastella minkä tahansa kirjatiedostossa olevan julkaisun hakemistoviittauksia valitsemalla Kirja.
5. Valitse Hakemisto-paneelivalikosta Uusi sivuviittaus. (Jos tätä komentoa ei ole, varmista, että Viittaus on valittuna ja että julkaisussa ei ole

kohdistinta tai valittua tekstiä.)
6. Lisää teksti Aihetasot-ruutuun jollakin seuraavista tavoista:

Jos haluat luoda yksinkertaisen hakemistokohdan (kuten kissat), kirjoita sana ensimmäiseen Aihetasot-ruutuun. (Jos tekstiä on valittuna,
se näkyy Aihetasot-ruudussa.)

Jos haluat lisätä sanoja kahteen tasoon, kirjoita ylätermi (kuten eläimet) ensimmäiseen Aihetasot-ruutuun ja alemman tason termit (kissat
ja siamilaiset) seuraaviin ruutuihin. Vaihda tarvittaessa sanojen paikkoja napsauttamalla nuolipainikkeita.

Aihetasot-ruudun hakemistotermi (vasen) ja valmis hakemistoviittaus (oikea)

Kaksoisnapsauta jotakin valintaikkunan alaosassa olevan luetteloruudun aihetta.

7. Voit muuttaa viittauksen lajittelua lopullisessa hakemistossa Lajitteluperuste-ruuduilla. Jos esimerkiksi haluat aiheen de la VegaV:n (eikä
D:n) alle, kirjoita Lajitteluperuste-ruutuun Vega ja Aihetaso-ruutuun de la Vega.

Voit myös valita numeroiden, symbolien ja kielten lajittelujärjestyksen ja muokata kiinan merkkien lajittelutietoja. (Lisätietoja: Hakemistojen
lajittelujärjestyksen muuttaminen.)

8. Määritä hakemistoviittauksen tyyppi:

Jos haluat luoda hakemistoviittauksia, jotka sisältävät sivunumeron tai sivualueen (kuten kissat 82–87), valitse Tyyppi-valikosta
viittauksen laajuutta kuvaava vaihtoehto. (Lisätietoja: Sivualueen asetukset hakemistoissa.)

Luo hakemistoviittaus ilman sivunumeroa valitsemalla Tyyppi-valikosta Ei sivualuetta. Vaikka sivunumero ei näy valmiissa hakemistossa,
se näkyy Hakemisto-paneelissa sulkeissa.

Luo toiseen viittaukseen viittaava hakemistoviittaus valitsemalla Tyyppi-valikosta jokin ristiviittausvaihtoehto (kuten Katso tai Katso myös)
ja kirjoittamalla viittauksen nimi Viitattu-ruutuun tai vetämällä olemassa oleva viittaus alla olevasta luettelosta Viitattu-ruutuun. Voit
mukauttaa ristiviittausten yhteydessä näkyvät Katso- ja Katso myös -tekstit valitsemalla Tyyppi-valikosta vaihtoehdon Mukautettu
ristiviittaus. (Katso "Katso"- tai "Katso myös" -viitteiden lisääminen hakemistoon.)

9. Lisää korostus tiettyyn hakemistoviittaukseen valitsemalla Numerotyylin ohitus ja määrittämällä merkkityyli.
10. Lisää viittaus hakemistoon tekemällä jokin seuraavista toimista:

Lisää nykyinen viittaus valitsemalla Lisää ja jätä valintaikkuna auki lisäviittauksia varten.

Etsi kaikki julkaisuikkunasta valitun tekstin esiintymät ja luo automaattisesti niille hakemistomerkit valitsemalla Lisää kaikki. Lisää kaikki -
vaihtoehto on käytettävissä vain, jos tekstiä on valittuna julkaisussa.

Lisää hakemistoviittaus ja sulje ikkuna valitsemalla OK.

Huomautus: Jos valitset Lisää-komennon jälkeen Peruuta, juuri lisättyjä hakemistoviittauksia ei poisteta. Poista nämä viittaukset
Kumoa-komennolla.

11. Sulje valintaikkuna valitsemalla OK tai Valmis.

Sanan, lauseen ja luettelon lisääminen hakemistoon nopeasti
Hakemiston pikanäppäinten avulla voit lisätä hakemistoon nopeasti yksittäisiä sanoja, lauseen tai sana- tai lauseluettelon. Adobe InDesign
tunnistaa kaksi hakemistoon liittyvää pikanäppäinkomentoa: toinen liittyy tavallisiin hakemistoviittauksiin ja toinen erisnimiin. Erisnimien
pikanäppäinkomento luo hakemistoviittauksia siten, että nimen osien paikat vaihdetaan ja viittaukset lajitellaan aakkosittain sukunimen mukaan.
Näin voit lisätä luetteloon nimen, jossa etunimi tulee ensin, mutta saat sen hakemistoon lajiteltuna sukunimen mukaan. Esimerkiksi nimi Jaakko
Pekka Salminen näkyy hakemistossa muodossa Salminen, Jaakko Pekka.

Valmista luettelo hakemistoa varten erottamalla jokainen hakemistoon tuleva kohde jollain seuraavista merkeistä: kappalemerkki, pakotettu

164



Alkuun

rivinvaihto (vaihto+Return), sarkain, oikealle tasaava sarkain (vaihto+sarkain), puolipiste tai pilkku. Hakemiston pikanäppäin lisää merkin jokaisen
hakemistoviittauksen eteen ja sijoittaa kaikki kohteet hakemistoon.

1. Valitse julkaisuikkunasta sanat, jotka haluat sisällyttää hakemistoon.
2. Tee jokin seuraavista:

Valitse tavalliset sanat tai lauseet painamalla näppäinyhdistelmää vaihto+Alt+Ctrl+[ (Windows) tai vaihto+optio+komento+[ (Mac OS).

Valitse sukunimen mukaan lajiteltavat nimet painamalla vaihto+Alt+Ctrl+] (Windows) tai vaihto+optio+komento+] (Mac OS).

Valinnan tai jokaisen valitun kohteen alkuun lisätään hakemistomerkki, jossa käytetään oletusasetuksia.

Jos haluat lisätä hakemistoon kaksiosaisia sukunimiä tai arvonimiä, lisää sanojen väliin vähintään yksi sitova välilyönti. Jos
esimerkiksi haluat sijoittaa nimen "Jaakko Pekka Salminen nuorempi" hakemistosanaksi "Salminen", ei "nuorempi", lisää Salminen- ja
nuorempi-sanojen väliin sitova välilyönti. (Lisää sitova välilyönti valitsemalla Teksti > Lisää tyhjä tila > Sitova välilyönti.)

Uuden viittauksen luominen aiemmasta
Usein hakemistoon lisättävä aihe esiintyy julkaisussa tai kirjassa useissa kohdissa. Tässä tapauksessa voit luoda useita hakemistoviittauksia
muiden hakemistossa jo olevien viittausten avulla. Näin taataan hakemiston yhdenmukaisuus.

1. Napsauta kohdistin julkaisuun tai valitse teksti, jossa hakemistomerkki näkyy.
2. Valitse Hakemisto-paneelista Viittaus ja etsi kopioitava viittaus esikatselusta.
3. Tee jokin seuraavista:

Lisää hakemistomerkki lisäyskohtaan tai valitun tekstin alkuun vetämällä viittaus uuden kirjauksen luontipainikkeen  päälle.

Valitse viittaus esikatselusta, pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) alhaalla ja valitse Uusi viittaus. Näyttöön tulee
Uusi sivuviittaus -valintaikkuna, jossa on tietoja valitusta viittauksesta. Tee tarvittavat muutokset ja valitse Lisää tai OK.

Voit myös luoda aiheluettelon ja valita aiheet luettelosta, kun luot hakemistoviittauksia.

Sanan kaikkien esiintymien lisääminen hakemistoon automaattisesti
Lisää kaikki -komennolla hakemistoon voidaan lisätä kaikki termin esiintymät julkaisusta tai kirjasta. Kun valitset Lisää kaikki, InDesign luo
hakemistomerkit kaikille julkaisusta valittujen sanojen esiintymille, ei valintaikkunassa määritetylle tekstille. (Voit myöhemmin poistaa viittauksia,
jotka viittaavat vähemmän tärkeään tietoon.)

Kun InDesign etsii esiintymiä valitusta tekstistä, se huomioi vain kokonaiset sanat ja hauissa erotellaan isot ja pienet kirjaimet. Jos valitset
esimerkiksi sanan gepardi, sanoja gepardit ja Gepardi ei lisätä hakemistoon.

1. Valitse julkaisusta etsittävä teksti.
2. Valitse Hakemisto-paneelista Viittaus.
3. Jos haluat luoda viittaukset kaikista kirjan avoimista julkaisuista, valitse Kirja.
4. Valitse Hakemisto-paneelivalikosta Uusi sivuviittaus.
5. Valitse Lisää kaikki. InDesign lisää hakemistomerkit kaikkiin valittua tekstiä vastaaviin kohtiin, vaikka ne olisi jo lisätty hakemistoon. Sama

kohta voidaan siis lisätä hakemistoon useita kertoja.

Hakemistoviittauksen muokkaaminen
Muuta aihe (esimerkiksi nimeä se uudelleen tai käytä uutta lajittelujärjestystä) ja päivitä automaattisesti kaikki aihetta käyttävät viittaukset
Hakemisto-paneelin Aihe-tilassa. Jos haluat muuttaa viittauksia yksitellen, käytä Viittaus-tilaa. Viittaus-tilassa voit myös lisätä ristiviittauksia tai
sijoittaa sivuviittaukseen liittyvän hakemistomerkin.

1. Avaa julkaisu, joka sisältää viittaukset.
2. Tee Hakemisto-paneelissa jokin seuraavista toimista:

Muokkaa aihetta ja päivitä automaattisesti kaikki aihetta käyttävät viittaukset valitsemalla Aihe.

Muokkaa yksittäistä viittausta valitsemalla Viittaus.

3. Valitse esikatselusta aihe tai sivuviittaus. Valitse sivuviittaus valitsemalla aiheen alla näkyvä sivukuvake.
4. Kaksoisnapsauta muokattavaa viittausta tai sivuviittausta.
5. Muokkaa viittausta ja valitse OK.

Sivualueen asetukset hakemistoissa
Voit luoda hakemistoviittauksia, joissa on yhden sivunumeron sijasta sivualue (esimerkiksi kissat 82–87). Uusi sivuviittaus -valintaikkunan Tyyppi-
valikko sisältää seuraavat sivualueasetukset:

Nykyinen sivu Sivualue ei ulotu nykyisen sivun ulkopuolelle.
Seuraavaan tyylin muutokseen Sivualue ulottuu hakemistomerkistä seuraavaan kappaletyylin muutokseen.
Seuraavaan tyylin esiintymään Sivualue ulottuu hakemistomerkistä sivulle, jossa käytetään seuraavan kerran viereisessä kappaletyylien
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valikossa määritettyä tyyliä.
Jutun loppuun Sivualue ulottuu hakemistomerkistä nykyisen tekstiä sisältävän tekstikehysketjun loppuun.
Julkaisun loppuun Sivualue ulottuu hakemistomerkistä julkaisun loppuun.
Osion loppuun Sivualue ulottuu hakemistomerkistä nykyisen osan loppuun. Osio on määritetty Sivut-paneelissa. (Lisätietoja: Julkaisun
numerointiasetukset.)
Seuraaviin # kappaleisiin Sivualue ulottuu hakemistomerkistä viereisessä ruudussa määritetyn kappalemäärän päähän tai viimeisen kappaleen
loppuun.
Seuraaville # sivuille Sivualue ulottuu hakemistomerkistä viereisessä ruudussa määritetyn sivumäärän päähän tai viimeisen sivun loppuun.
Ei sivualuetta Sivualuetta ei käytetä.

"Katso"- tai "Katso myös" -viitteiden lisääminen hakemistoon
Ristiviittaukset ovat hakemistoviittauksia, jotka viittaavat niihin liittyviin viittauksiin, eivät sivunumeroihin. Voit luoda ristiviittauksia Hakemisto-
paneelin avulla. Ristiviittaukset voivat toimia hakemistossa eri tehtävissä:

Ristiviittaukset liittävät toisiinsa julkaisussa tai kirjassa olevia toisiaan vastaavia termejä. Esimerkiksi eläimistö. Katso eläimet. Tällaiset
ristiviittaukset eivät sisällä sivuviittauksia, vaan ne viittaavat hakemistossa oleviin samaa tarkoittaviin termeihin.

Ristiviittaukset viittaavat aiheeseen liittyviin, ei samaa tarkoittaviin, viittauksiin. Esimerkiksi kissat. Katso myös villikissat. Tässä tapauksessa
ristiviittauksen sisältävä hakemistoviittaus sisältää myös sivunumerot ja/tai alakohdat, jotka liittyvät suoraan aiheeseen.

Kaksi ristiviittaustyyppiä
A. Ristiviittaus aiheeseen liittyvään kohtaan (Katso myös) B. Ristiviittaus vastaavaan termiin (Katso)

Kun luot ristiviittauksen InDesignissa, voit myös valita ristiviittauksen etuliitteen. "Katso" ja "katso myös" ovat kiinteää tekstiä. Kun valitset "katso
[myös]", InDesign määrittää ristiviittaukselle automaattisesti oikean etuliitteen aina, kun hakemisto luodaan:

Viittauksiin, joissa on sivunumeroita, alakohtia tai molempia, lisätään "katso myös".

Viittauksiin, joissa ei ole sivunumeroita tai alakohtia, lisätään "katso".

"Katso [myös]" -vaihtoehdon ansiosta ristiviittauksia ei tarvitse päivittää manuaalisesti, kun hakemistoviittausten sisältö muuttuu.

1. Valitse Ikkuna > Teksti ja taulukot > Hakemisto.
2. Valitse Viittaus.
3. (Valinnainen) Voit katsoa kaikkien kirjatiedoston avoimien julkaisujen hakemistoviittauksia valitsemalla Kirja.
4. Valitse Hakemisto-paneelivalikosta Uusi sivuviittaus.
5. Kirjoita aihe tai aiheet Aihetasot-ruutuihin.
6. Valitse Tyyppi-valikon alaosasta ristiviittauksen etuliite (kuten Katso myös).
7. Kirjoita aihe Viitattu-ruutuun tai vedä aiempi aihe alareunan aiheluettelosta.
8. Lisää ristiviittaus hakemistoon valitsemalla Lisää.

Ristiviittaukset näkyvät Hakemisto-paneelissa ja luodussa hakemistossa, mutta ohjelma ei liitä niitä julkaisun hakemistoviittauksiin.

Ristiviittaukset, joihin liittyy "Katso [myös]", näkyvät samoin Hakemisto-paneelissa. Oikea etuliite näkyy kuitenkin luodussa hakemistojutussa.

Hakemiston luominen
Kun olet lisännyt hakemistoviittaukset ja esikatsellut niitä Hakemisto-paneelissa, voit luoda julkaisuun sijoitettavan hakemistojutun.

Hakemistojuttu voi olla erillinen julkaisu tai julkaisun osa. Kun luot hakemistojutun, InDesign kokoaa hakemistoviittaukset ja päivittää julkaisun tai
kirjan sivunumerot. Jos lisäät tai poista hakemistoviittauksia tai päivität julkaisun numeroinnin, hakemisto on päivitettävä luomalla se uudelleen.

Jos ylijuoksevassa tekstissä on hakemistomerkki, kun hakemisto luodaan, käyttäjältä kysytään, lisätäänkö merkki hakemistoon. Jos valitset Kyllä,
viittaus näkyy hakemistossa ilman sivunumeroa. Jos hakemistomerkki näkyy piilotetussa ehdollisessa tekstissä, merkki ohitetaan hakemistosta.

Voit katsoa hakemiston luomista käsittelevän videon osoitteessa www.adobe.com/go/vid0220_fi.

1. Tee jokin seuraavista:

Kun luot hakemiston yksittäisestä julkaisusta, julkaisun loppuun on ehkä lisättävä uusi sivu.
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Kun luot hakemiston useista kirjaksi kootuista julkaisuista, luo tai avaa hakemistolle tiedosto ja varmista, että se on liitetty kirjaan.

2. Valitse Hakemisto-paneelivalikosta Luo hakemisto. Määritä seuraavat asetukset:

Kirjoita Otsikko-kohtaan teksti, joka näkyy hakemiston otsikkona. Määritä otsikon muotoilu valitsemalla tyyli Otsikkotyyli-valikosta.

Päivitä hakemisto valitsemalla Korvaa nykyinen hakemisto. Asetus ei ole käytössä, jos hakemistoa ei ole vielä luotu. Kun poistat tämän
asetuksen valinnan, voit luoda useita hakemistoja.

Valitse Sisällytä kirjan julkaisut, jos haluat luoda yhden hakemiston kaikista kirjan julkaisuluettelon julkaisuista ja numeroida sivut
uudelleen. Poista valinta, jos haluat luoda hakemiston vain nykyisestä julkaisusta.

Valitse Sisällytä viitteitä kätketyille tasoille, jos haluat sisällyttää hakemistoon kätketyillä tasoilla olevat hakemistomerkit.

Määritä muita hakemistoasetuksia valitsemalla Lisää asetuksia.

3. Valitse OK. Jos Korvaa nykyinen hakemisto ei ole valittuna, näyttöön tulee ladatun tekstin kuvake. Sijoita hakemistojuttu muiden tekstien
tapaan.

Jos muokkaat hakemistojuttua, muutokset ohitetaan, kun luot hakemiston uudelleen. Saat parhaat tulokset muokkaamalla hakemistoa
Hakemisto-paneelissa ja luomalla hakemiston uudelleen.

Hakemiston muotoiluasetukset
Kun valitset Luo hakemisto -ikkunassa Lisää asetuksia, näyttöön tulee tyylin ja luodun hakemiston ulkoasun asetuksia. InDesign sisältää useita
valmiita kappale- ja merkkityylejä, joilla voit muotoilla luotua hakemistoa. Voit luoda ja valita myös omia tyylejä. Kun hakemisto on luotu, tyylejä voi
muokata Kappaletyylit- ja Merkkityylit-paneeleissa.

Hakemisto, jossa on sisäkkäisiä viittauksia
A. Otsikko B. Osan otsikko C. Tason 1 viite D. Tason 2 alakohta E. Aihe F. Ristiviittaus

Korvaa viitteiden erottimet (kuten Seuraava aihe- ja Viitteiden välissä -arvot) valitsemalla nykyinen erotin ja kirjoittamalla tai valitsemalla sen
tilalle korvaava merkki.

Sisäkkäiset tai Jatkuva Valitse Sisäkkäiset, jos haluat, että hakemisto muotoillaan oletusasetuksen mukaisesti siten, että hakemistoviittauksen
alakohdat ovat erillisiä sisennettyjä kappaleita. Valitse Jatkuva, jos haluat, että kaikki kohdan tasot ovat samassa kappaleessa. Viitteiden välissä -
asetuksella määritetään viittausten erotinmerkit.
Sisällytä hakemisto-osan otsikot Valitse tämä, jos haluat käyttää osien otsikkoina aakkosia.
Sisällytä tyhjät hakemisto-osat Valitse tämä, jos haluat luoda osien otsikot kaikista aakkosten kirjaimista, vaikka hakemistossa ei olisi kyseisellä
kirjaimella alkavia ensimmäisen tason kohtia.
Tason tyyli Valitse jokaiselle hakemiston tasolle kappaletyyli. Tyylejä voi muokata Kappaletyylit-paneelissa hakemiston luomisen jälkeen.
Osion otsikko Valitse kappaletyyli, joka määrittää valmiissa hakemistossa käytettävien osioiden otsikoiden (A, B, C jne.) ulkoasun.
Sivunumero Valitse merkkityyli, joka määrittää valmiin hakemiston sivunumeroiden ulkoasun. Asetus ei vaikuta Numerotyylin ohitus -asetuksella
muotoiltuihin kohtiin.
Huomautus: jos haluat lisätä hakemiston sivunumeroihin etuliitteitä (kuten B-1 tai II-1), katso lisätietoja kohdasta Osion numeroinnin
määrittäminen.
Ristiviittaus Valitse merkkityyli, joka määrittää ristiviittauksen etuliitteiden ulkoasun (kuten Katso tai Katso myös) valmiissa hakemistossa.
Ristiviitattu aihe Valitse merkkityyli, joka määrittää viittauksen kohteena olevan aiheen (kuten eläimet kohdassa Katso myös eläimet) ulkoasun
valmiissa hakemistossa.
Seuraava aihe Kirjoita tai valitse erikoismerkki, joka erottaa aiheen sivunumerosta (esimerkiksi Eläimet 38). Oletus on kaksi välilyöntiä. Määritä
merkin muotoilu muokkaamalla vastaavaa tason tyyliä tai valitsemalla jokin muu tyyli.
Sivunumeroiden välissä Kirjoita tai valitse erikoismerkki, joka erottaa sivunumerot tai -alueet toisistaan. Oletus on pilkku ja en-väli.
Viitteiden välissä Jos Jatkuva-asetus on valittuna, kirjoita tai valitse erikoismerkki, joka erottaa viitteet ja alakohdat toisistaan. Jos Sisäkkäiset-
asetus on valittuna, asetuksella määritetään samassa kohdassa olevien ristiviittausten erotinmerkki.
Ennen ristiviittausta Kirjoita tai valitse erikoismerkki, joka erottaa viitteen ja ristiviitteen toisistaan, esimerkiksi Villieläimet. Katso myös eläimet.
Oletus on piste ja välilyönti. Määritä merkin muotoilu muuttamalla tai muokkaamalla vastaavaa tason tyyliä.
Sivualue Kirjoita tai valitse erikoismerkki, joka erottaa sivualueen ensimmäisen ja viimeisen luvun (esimerkiksi Eläimet 38–43). Oletus on lyhyt
ajatusviiva. Määritä merkin muotoilu muuttamalla tai muokkaamalla sivunumeroiden tyyliä.
Viittauksen loppu Kirjoita tai valitse erikoismerkki, joka näkyy viittauksen lopussa. Jos Jatkuva-asetus on valittu, merkki näkyy viimeisen
ristiviittauksen lopussa. Oletus on ei merkkiä.

167



Alkuun

Alkuun

Hakemistojen lajittelujärjestyksen muuttaminen
Voit muuttaa kielten ja symbolien lajittelujärjestystä. Tästä on hyötyä varsinkin kreikan kielen sekä kyrillisten ja aasialaisten kielten yhteydessä. Se
on myös käytännöllinen, kun haluat muuttaa symbolien esityspaikkoja hakemistossa. Jos haluat symbolien olevan hakemiston lopussa, voit siirtää
Symboli-luokan järjestysluettelon alimmaiseksi.

Lajittelujärjestyksen muuttaminen vaikuttaa lajittelujärjestykseen Hakemisto-paneelissa ja jälkeenpäin luotavissa hakemistojutuissa. Voit luoda
useita hakemistoja, joissa käytetään eri lajittelujärjestyksiä. Voit esimerkiksi luoda hakemiston saksaksi, muuttaa hakemiston lajittelujärjestystä ja
luoda sitten toisen hakemiston ruotsiksi. Varmista hakemistoa luodessasi, että Korvaa nykyinen hakemisto -asetus ei ole käytössä.

1. Valitse Hakemisto-paneelivalikosta Lajitteluasetukset.
2. Varmista, että lajiteltavat kohteet ovat valittuina.
3. Määritä käytettävän kielimerkistön tyyppi napsauttamalla kohtaa Otsikkotyyppi-valinnan alla ja valitsemalla toisen vaihtoehdon valikosta.

Esimerkiksi kyrillistä merkistöä varten voit valita venäjän, valkovenäjän, bulgarian tai ukrainan. Kiinaa varten voit valita pinyinin, jota käytetään
pääasiassa yksinkertaistettua kiinaa varten, tai viivamäärän, jota käytetään tavallisesti perinteistä kiinaa varten.

4. Jos haluat muuttaa kielen tai symbolin järjestystä, valitse kieli tai symboli luettelosta ja napsauta sitten luettelon oikeassa alaosassa olevaa
ylä- tai alanuolipainiketta.

Ohjelma lajittelee luettelon kohteet ylhäältä alaspäin. Lisäksi ohjelma lajittelee symboleina sellaiset merkit, joiden kieli ei ole
Lajitteluasetukset-valintaikkunassa. Esimerkiksi jos julkaisussa on kreikankielistä tekstiä, mutta kreikka ei ole valittavissa Lajitteluasetuksissa,
kaikki hakemistoon lisätty kreikankielinen teksti näkyy luettelossa symboleina.

Japanin- ja koreankielisten hakemistojen lajittelujärjestys
Ota huomioon seuraavat seikat, kun luot hakemistokirjauksia aasialaisilla kielillä:

Aasialaiset kielet käyttävät eri lajittelukäytäntöjä niiden omien typografisten sääntöjen mukaisesti.

Kun teet hakemiston japaninkielisestä tekstistä, Aihetasot-ruudun hakemistokirjausten yomi on kirjoitettava Yomi-kenttään täysilevyisillä
hiragana- ja katakana-merkeillä. Yomia ei tarvitse syöttää täysilevyisille hiragana- tai katakana-merkeille, aakkosnumeerisille merkeille,
tietyille symboleille, puolileveille aakkosnumeerisille merkeille tai hakemistokirjauksille, joissa Yomi-kentässä on vain symboleja. Aihetaso-
kenttään kirjoitetut kirjaukset lajitellaan järjestykseen. Tietyissä tapauksissa, kun kirjauksessa on sekä täysilevyisiä että puolileveitä
symboleja, lajittelujärjestys ei ehkä vastaa odotuksia. Syötä tällöin asianmukainen yomi.

Yomi-tekstikenttään ei voi syöttää puolileveitä katakana- tai kanji-merkkejä. Kenttään voi kuitenkin syöttää täysilevyisiä symboleita, kuten ja 
.

Hiragana- ja katakana-merkit erotetaan toisistaan ja hiraganat lajitellaan ennen katakana-merkkejä. Lisäksi isot ja pienet kirjaimet erotellaan
siten, että isot kirjaimet tulevat järjestyksessä ennen pieniä kirjaimia.

Aihetasot-ruutuun lisättyjä samoja merkkejä käsitellään erillisinä kirjauksina, jos niille syötetään eri yomi. Jos hakemistokirjaukseksi syötetään
aihe "Cat", eli sana "neko" kirjoitettuna katakanoilla ja sama sana syötetään uudelleen kirjoitettuna hiraganoilla, aiheelle "Cat" luodaan kaksi
hakemistokirjausta. Tämän toiminnon avulla voidaan myös luokitella sama termi kahden erillisen hakemistoaiheen alle. Jos esimerkiksi
hakemistoon syötetään termi "The Cats", Yomi-tekstikenttään syötetään sana "Cats" ja kaksi hakemistokirjausta luodaan ilman syötettä, termi
"The Cats" luodaan hakemistoaiheiden T ja C alle.

Voit valita koreankieliseksi lajittelujärjestykseksi korean konsonantit tai korean konsonantit ja vokaalit.

Kiinankielisten hakemistojen lajittelujärjestys
Voit määrittää kiinan merkkien lajittelujärjestyksen kahdessa kohdassa: Lajittelu-asetukset-valikossa ja Lajitteluperuste:-kentässä
hakemistokirjauksen luonnin yhteydessä.

Lajittelu-asetukset-valintaikkuna Valitsemalla Hakemisto-paneelivalikosta Lajittelu-asetukset voit muuttaa lajittelujärjestystä ja määrittää,
käytetäänkö Pinyin- vai Viiva-määrää.
Lajitteluperuste Kun luot hakemistokirjauksen tai muokkaat sitä, voit muokata kiinankielisen hakemiston lajittelutietoja kirjoittamalla Aihetasot-
kenttään kiinankielistä tekstiä.
Jos käytössä on Pinyin-asetus ja useilla sanoilla on sama Pinyin-arvo, järjestys määräytyy nousevassa järjestyksessä (1) sävyn ja (2) viivamäärän
mukaan. Kun käytössä on Viivamäärä-asetus, merkit lajitellaan (1) viivamäärän, (2) ensimmäisen viivan ja (3) toisen viivan mukaan. Voit muokata
lajittelutietoja joko suoraan Lajitteluperuste-kentässä tai avata Pinyin-kirjaus- tai Viivamäärän mukainen kirjaus -valintaikkunan napsauttamalla
nuolta Lajittelujärjestys-kentän oikealla puolella. Muokkaa kenttiä tarpeen mukaan ja valitse OK. Toista nämä vaiheet kunkin aihetason kohdalla.

Hakemiston hallinta
Kun olet määrittänyt hakemiston ja lisännyt hakemistomerkit julkaisuun, voit hallita hakemistoa eri tavoin. Voit tarkastella kaikkia kirjan
hakemistoaiheita, poistaa Aihe-luettelosta aiheita, joita ei käytetä Viite-luettelossa, etsiä viittauksia Viite- tai Aiheet-luettelosta ja poistaa
hakemistomerkkejä julkaisusta.
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Kirjan hakemiston kaikkien aiheiden näyttäminen
Kun Kirja-vaihtoehto on valittuna, Hakemisto-paneelissa näkyvät koko kirjan viittaukset, eivät pelkästään nykyisen julkaisun viittaukset.

1. Avaa kirjatiedosto ja kaikki sen sisältämät julkaisut.
2. Valitse Hakemisto-paneelin yläosasta Kirja.

Jos muiden on käytettävä kirjassa olevaa julkaisua, kun hakemistoa luodaan, voit luoda aiheiden pohjaluettelon erilliseen julkaisuun ja tuoda
aiheita luettelosta jokaiseen kirjan julkaisuun. Huomaa, että jos pohjaluettelo muuttuu, aiheet on tuotava uudelleen jokaiseen julkaisuun.

Kun luot hakemiston kirjasta, jossa on useita julkaisuja, voit näyttää kaikkien julkaisujen hakemistoaiheet luomalla hakemiston kirjasta ja
sisällyttämällä hakemistoon kaikki kirjan julkaisut. Tällöin sinun ei tarvitse tuoda aiheita kuhunkin julkaisuun manuaalisesti Hakemisto-valikon
Tuo aiheita -valinnan avulla.

Käyttämättömien aiheiden poistaminen Aihe-luettelosta
Kun olet luonut hakemiston, voit poistaa aiheet, joita ei käytetä hakemistossa.

1. Avaa Hakemisto-paneeli valitsemalla Ikkuna > Teksti ja taulukot > Hakemisto.
2. Valitse Hakemisto-paneelivalikosta Poista käyttämättömät aiheet. Kaikki aiheet, joihin ei liity sivunumeroita, poistetaan.

Hakemistomerkkien poistaminen
 Tee jompikumpi seuraavista:

Valitse Hakemisto-paneelista viittaus tai aihe, jonka haluat poistaa. Napsauta Poista valittu viittaus -painiketta .

Huomautus: jos valittu viite on useiden alaotsikoiden otsikko, myös kaikki alaotsikot poistetaan.

Valitse hakemistomerkki julkaisusta ja paina askelpalautinta tai Delete-näppäintä.

Huomautus: voit näyttää hakemistomerkit julkaisuikkunassa valitsemalla vaihtoehdon Teksti > Näytä piilomerkit.

Hakemistoviittauksen etsiminen Hakemisto-paneelissa
1. Valitse Hakemisto-paneelivalikosta Näytä Etsi-kenttä.
2. Kirjoita etsittävän viittauksen nimi Etsi-ruutuun ja napsauta sitten ylä- tai alanuolipainiketta.

Hakemistomerkkien etsiminen julkaisusta
1. Näytä hakemistomerkit julkaisuikkunassa valitsemalla Teksti > Näytä piilomerkit.
2. Valitse Hakemisto-paneelista Viittaus ja valitse sitten etsittävä viittaus.
3. Valitse Hakemisto-paneelivalikosta Siirry valittuun merkkiin. Hakemistomerkin oikealla puolella näkyy kohdistin. Valitse merkki leikkaamista,

kopioimista tai poistamista varten painamalla näppäinyhdistelmää vaihto+vasen nuoli.

Isojen alkukirjainten lisääminen hakemistoviittauksiin
Kirjoita isolla alkukirjaimella -ikkunassa voit lisätä isot alkukirjaimet kaikkiin hakemistokohtiin yhdellä kertaa. Jos osa sanoista on lisätty
hakemistoon pienellä kirjoitettuna (kissat) ja osa isolla kirjoitettuna (Kissat), niitä käsitellään erillisinä aiheina. Tämä ongelma voidaan korjata
lisäämällä valittuihin kohtiin isot alkukirjaimet.

1. Valitse viite Hakemisto-paneelin esikatselusta.
2. Valitse Hakemisto-paneelivalikosta Kirjoita isolla alkukirjaimella.
3. Valitse, haluatko lisätä ison alkukirjaimen vain valittuun aiheeseen, myös sen alakohtiin, kaikkiin tason 1 aiheisiin vai kaikkiin aiheisiin. Valitse

sitten OK.

Lisää ohjeaiheita
Hakemiston luomista käsittelevä video
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Reittitekstin luominen

Alkuun

Alkuun

Reittitekstin luominen
Reittitekstin muokkaaminen ja poistaminen
Reittitekstin sijainnin säätäminen
Tehosteen lisääminen reittitekstiin
Ankkuroitujen objektien lisääminen reittitekstiin

Reittitekstin luominen
Tekstin voi määrittää myötäilemään kaikenmuotoisia avoimia ja suljettuja reittejä. Reittitekstille voi valita asetuksia ja tehosteita. Tekstiä voi
esimerkiksi liu'uttaa reittiä pitkin sekä peilata reitin toiselle puolelle tai merkkejä voi vääristää reitin muodon mukaan. Reittitekstissä on sisä- ja
ulkoportti samalla tavoin kuin muissakin tekstikehyksissä, joten tekstin voi ketjuttaa.

Koska reitillä näkyy vain yksi tekstirivi, reitille liian pitkä teksti muuttuu ylijuoksevaksi (ei näy), ellei sitä ole ketjutettu toiseen reittiin tai
tekstikehykseen. Voit lisätä tekstiin sidottuja tai rivin yläpuolella olevia ankkuroituja objekteja reittitekstiin. Reittitekstiä ei voi luoda käyttämällä
yhdistelmäreittejä, jotka on tehty esimerkiksi Luo ääriviivat -komennolla.

Reittiteksti
A. Alkumerkki B. Sisäportti C. Keskimerkki D. Loppumerkki E. Ulkoportti ilmaisee sijoittamattoman tekstin

1. Valitse reittitekstityökalu . (Voit avata reittitekstityökalun sisältävän valikon napsauttamalla tekstityökalua ja pitämällä hiiren painikkeen
alhaalla.)

2. Pidä osoitinta reitillä, kunnes sen viereen tulee pieni plusmerkki . Tee sitten jokin seuraavista:

Jos haluat kirjoittaa käyttämällä oletusasetuksia, napsauta reittiä. Kohdistin on oletusarvoisesti reitin alussa. Jos nykyisissä kappaleen
asetuksissa on määritetty sisennys tai muu kuin vasen tasaus, kohdistin voi olla muuallakin kuin reitin alussa.

Jos haluat kirjoittaa tekstin reitin tiettyyn osaan, napsauta reittiä kohdassa, josta haluat tekstin alkavan. Vedä osoitinta reittiä pitkin
kohtaan, jossa haluat tekstin päättyvän, ja vapauta hiiren painike. (Lisätietoja tekstin alku- ja loppukohdan muuttamisesta on kohdassa
Reittitekstin sijainnin säätäminen.)

Reittitekstin sijainnin muuttaminen

Huomautus: jos napsauttaminen tai vetäminen ei onnistu, tarkista, että reittitekstityökalun vieressä näkyy plusmerkki.

3. Kirjoita haluamasi teksti. Jos reittiä napsautetaan, teksti näkyy koko reitin alueella. Jos osoitinta vedetään reittiä pitkin, teksti sijoittuu vain
tälle reitin osalle.

Huomautus: Näkyvä reitti on näkyvä myös tekstin lisäämisen jälkeen. Voit kätkeä reitin valitsemalla sen valinta- tai suoravalintatyökalulla ja
valitsemalla viivaksi ja täytöksi Ei mitään.

Reittitekstin muokkaaminen ja poistaminen
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Reittitekstissä voi käyttää merkki- ja kappaleasetuksia. Sen sijaan kappaleen viiva- ja väliasetukset eivät vaikuta reittitekstiin. Kappale-paneelista
valittu tasausasetus vaikuttaa reittitekstin tasaukseen.

Reittitekstin merkkien muokkaaminen ja muotoileminen
1. Valitse reittitekstityökalu ja tee jokin seuraavista:

Jos haluat lisätä kohdistimen, napsauta jotakin kohtaa reittitekstin kahden merkin välissä.

Jos haluat valita merkkejä, vedä osoitinta reittitekstissä.

2. Muokkaa ja muotoile tekstiä haluamallasi tavalla.

Tekstin poistaminen reitiltä
1. Valitse vähintään yksi reittitekstiobjekti valintatyökalulla  tai suoravalintatyökalulla .
2. Valitse Teksti > Teksti reitillä > Poista teksti reitiltä.

Ketjutettu reittiteksti siirtyy seuraavaan ketjutettuun tekstikehykseen tai reittitekstiobjektiin. Ketjuttamaton teksti poistetaan. Reitti säilyy, mutta
reittitekstimääritteet (sulkeet, sisä- ja ulkoportit sekä ketjutus) poistetaan.

Huomautus: Jos reitin viivaksi ja täytöksi on valittu Ei mitään, reitti ei näy tekstin poiston jälkeen. Muuta reitti näkyväksi painamalla D-näppäintä
heti, kun olet valinnut Teksti > Teksti reitillä > Poista teksti reitiltä. Valittu reitti muuttuu oletusviivan ja -täytön mukaiseksi.

Merkkivälin pienentäminen jyrkkien käännösten ja terävien kulmien kohdalla
1. Valitse reittiteksti valinta- tai tekstityökalulla.
2. Valitse Teksti > Reittiteksti > Asetukset tai kaksoisnapsauta reittitekstityökalua.
3. Määritä Väli-asetus pisteinä. Mitä suurempi arvo, sitä enemmän poistetaan jyrkissä kaarteissa merkkien väliin jäävää tilaa.

Reittiteksti ennen merkkivälin muuttamista (vasen) ja muuttamisen jälkeen (oikea).

Huomautus: Väli-asetuksella estetään merkkien leviäminen käyrällä tai terävässä kulmassa. Asetus ei vaikuta suoralla viivalla oleviin merkkeihin.
Jos haluat muuttaa reitillä olevien merkkien välejä, valitse merkit ja määritä merkkipariväli tai merkkiväli.

Reittitekstin sijainnin säätäminen
Voit muuttaa reittitekstin alku- ja loppukohtaa, liu'uttaa tekstiä ja vaihtaa reitin sijaintia myös muilla tavoin.

Reittitekstin alku- tai loppukohdan muuttaminen
1. Valitse reittiteksti valintatyökalulla .

2. Pidä osoitinta reittitekstin alku- tai loppumerkin päällä, kunnes sen viereen tulee pieni kuvake . Älä aseta osoitinta merkin sisä- tai
ulkoportin päälle.

Merkin valitseminen on helpompaa, kun lähennät reittinäkymää.

3. Vedä alku- tai loppumerkkiä reittiä pitkin.

Aseta osoitin alku- tai loppumerkin päälle. Siirrä reittitekstin rajaa vetämällä.
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Huomautus: kappaleen sisennys lasketaan alku- tai loppumerkistä.

Reittitekstin liu'uttaminen reittiä pitkin
1. Valitse reittiteksti valintatyökalulla .
2. Pidä osoitinta reittitekstin keskimerkin päällä, kunnes sen viereen tulee keskimerkkikuvake .

Merkin valitseminen on helpompaa, kun lähennät reittinäkymää.

3. Vedä keskimerkkiä reittiä pitkin.

Huomautus: Teksti ei siirry, jos sekä alku- että loppumerkki ovat reitin päissä. Voit varata tilaa tekstin vetämistä varten vetämällä alku- tai
loppumerkin kauemmaksi reitin päästä.

Reittitekstin peilaaminen
1. Napsauta valintatyökalua  ja valitse reittiteksti.
2. Pidä osoitinta reittitekstin keskimerkin päällä, kunnes sen viereen tulee keskimerkkikuvake .
3. Vedä keskimerkki reitin yli.

Vie osoitin keskimerkin kohdalle ja peilaa teksti vetämällä osoitin reitin yli.

Voit peilata reittitekstin myös valintaikkunan avulla. Valitse reittiteksti valinta- tai tekstityökalulla. Valitse Teksti > Teksti reitillä > Asetukset.
Valitse Peilaa-asetus ja sitten OK.

Tehosteen lisääminen reittitekstiin
1. Valitse reittiteksti valinta- tai tekstityökalulla.
2. Valitse Teksti > Reittiteksti > Asetukset tai kaksoisnapsauta reittitekstityökalua.
3. Valitse Tehoste-valikosta ensin jokin seuraavista vaihtoehdoista ja sitten OK:

Jos haluat pitää jokaisen merkin peruslinjan keskikohdan reitin tangentin suuntaisena, valitse Sateenkaari. Tämä on oletusasetus.

Reittitekstin tehosteet
A. Sateenkaari-tehoste B. Viistotus-tehoste C. 3D-nauha-tehoste D. Askelma-tehoste E. Painovoima-tehoste
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Jos haluat pitää merkkien pystyreunat tarkasti pystysuorassa reitin muodosta huolimatta ja kääntää merkkien vaakareunat reitin
suuntaisiksi, valitse Viistotus. Syntyvä vaakavääristymä soveltuu aaltoilevalle tai sylinterin ympärille kierretylle tekstille (kuten juomatölkin
etikettiin).

Jos haluat pitää merkkien vaakareunat tarkasti vaakasuorassa reitin muodosta huolimatta ja kääntää merkkien pystyreunat kohtisuoraan
reittiä vastaan, valitse 3D-nauha.

Jos haluat pitää jokaisen merkin peruslinjan vasemman reunan reitillä kiertämättä merkkejä, valitse Askelma.

Jos haluat pitää jokaisen merkin peruslinjan keskikohdan reitillä ja jokaisen pystyreunan yhdensuuntaisena reitin keskipisteen suhteen,
valitse Painovoima. Voit muuttaa tämän asetuksen perspektiivivaikutelmaa säätämällä reitin kaarta.

Ankkuroitujen objektien lisääminen reittitekstiin
1. Napsauta teksti- tai reittitekstityökalulla tekstiä kohdassa, johon haluat lisätä objektin ankkurin.
2. Lisää ankkuroitu objekti. Voit lisätä reittiin tekstiin sidottuja tai rivin yläpuolelle ankkuroituja objekteja tai kehyksiä. (Lisätietoja: Ankkuroidut

objektit.)

Huomautus: Tekstireitillä olevien ankkuroitujen objektien asetusvaihtoehdot poikkeavat hieman tavallisessa tekstikehyksessä olevien
ankkuroitujen objektien asetuksista. Tasaus-asetus tasaa objektin suhteessa sen ankkurimerkkiin ja Väli ennen -asetus ei ole käytettävissä.
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Linkitetty sisältö | CC, CS6
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Sisällön keräystyökalu

Sisällön sijoitustyökalu

Luo linkki

Yhdistä tyylit

Muokkaa mukautettua tyyliosoitusta

Sisällön keräystyökalut
Sijoittaminen ja linkittäminen
Linkkiasetusten määrittäminen
Mukautettu tyyliosoitus
Linkitetyn kohteen päivittäminen

Sisältöjen kopiointi eri sivuille ei ole mikään helppo tehtävä. Kopiointi ja liittäminen voi olla vaikeaa ja aikaa vievää. Linkitetyn sisällön toimintojen
avulla voidaan hallita sisällön eri versioita. Sisältöä voi sijoittaa ja linkittää saman julkaisun sisällä tai jopa eri julkaisujen kesken. Linkitetty sisältö
tukee kehittyviä työnkulkuja, joissa esimerkiksi suunnitellaan pysty- ja vaakasuuntaisia sivuasetteluita. Linkitetty sisältö toimii hyvin myös
perinteisissä tulostus- ja julkaisutyönkuluissa, joissa synkronoidaan eri sivuilla tai eri julkaisuissa oleva pohjateksti.

Linkitetty sisältö toimii perinteisten linkkien tapaan. Jos haluat lukea asian yleiskuvauksen, katso Linkit-paneelin käyttäminen. Objekti voidaan
määrittää pääkohteeksi ja sitten sijoittaa se eri paikkoihin aliobjektiksi. Kun pääobjekti päivitetään, aliobjektit merkitään Linkit-paneelissa, ja ne
voidaan päivittää synkronoimalla ne pääkohteen kanssa.

Voit sijoittaa ja linkittää objekteja joko Sisällön keräystyökaluilla tai valikkokomennolla Muokkaa > Sijoita ja linkitä.

-kuvake näkyy linkitetyn objektin vasemmassa yläkulmassa. Objekti näytetään Linkit-paneelissa linkitettynä juttuna.

Sisällön keräystyökalut
Sisällön keräys- ja sijoittelutyökalujen avulla voidaan monistaa ja sijoittaa sivukohteita avattuihin InDesign-julkaisuihin. Kerätty sisältö näytetään
Content Conveyorissa. Content Conveyorin avulla voit helposti ja nopeasti sijoittaa ja linkittää useita sivukohteita avattuihin asiakirjoihin.

Avaa Content Conveyor kaksoisnapsauttamalla työkalupaneelissa  -työkalua.

Sisällön keräystyökalulla  voit valita objektin ja lisätä sen kuljettimeen.

Sisällön sijoitustyökalulla  voit sijoittaa sivuobjektin sivulle.

Painamalla B voit vaihtaa sisällön keräys- ja sijoitustyökalun välillä.

 
Content Conveyor 
A. Sisällön keräystyökalu B. Sisällön sijoitustyökalu C. Luo linkki D. Yhdistä tyylit E. Muokkaa mukautettua tyyliosoitusta F. Sijoitusasetukset G.
Selaa  H. Kerää kaikki ketjutetut kehykset I. Lataa kuljetin 

Sisällön keräystyökalulla voidaan lisätä sivukohteita Content Conveyoriin.

Sisällön keräystyökalulla voidaan sijoittaa kohteita Content Conveyorista julkaisuun. Kun tämä työkalu valitaan, nykyinen
kohde lisätään sijoitustyökaluun.

Jos haluat linkittää sijoitetun kohteen kerätyn kohteen alkuperäiseen sijaintiin, ota käyttöön Luo linkki -toiminto. Voit hallita linkkejä
Linkit-paneelissa.

Yhdistä alkuperäisten ja sijoitettujen nimikkeiden kappale-, merkki-, taulukko- tai solutyylit. Yhdistämiseen käytetään oletusarvoisesti
tyylien nimiä. Katso Mukautetut tyyliosoitukset.

Tällä asetuksella voit mukauttaa alkuperäisen ja sijoitettujen nimikkeiden tyylien yhdistämistä. Kun
tyylit yhdistetään, sijoitetun kohteen tyylit korvataan automaattisesti.
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Sijoitusasetukset

Selaa

Kerää kaikki ketjutetut kehykset

Lataa kuljetin

Alkuun

Alkuun

Määritä Conveyorin asetukset kohteiden sijoittamisen yhteydessä.

Poista kohteet kuljettimesta sen jälkeen, kun kohteet on sijoitettu.
Sijoita nykyinen kohde moneen kertaan. Kohde jää edelleen sijoitustyökaluun.
Sijoita kohde ja siirry sitten seuraavaan kohteeseen. Kohde pysyy edelleen kuljettimessa.

Selaa sisältökuljettimessa olevia kohteita.

Ota tämä asetus käyttöön, jos haluat kerätä kaikki ketjutetut kehykset. Juttu ja kaikki kehykset kerätään. Jos
tämä asetus ei ole käytössä, juttu kerätään yhteen kehykseen.

Voit ladata kuljettimeen kohteita käyttämällä -toimintoa.
Valinta: Lataa kaikki valitut kohteet

Sivut: Lataa kaikki määrätyillä sivuilla olevat kohteet
Kaikki: Lataa kohteet kaikilta sivuilta ja taittopöydältä

Jos haluat ryhmittää yhden sarjan kaikki kohteet, ota käyttöön Luo yksi sarja -asetus.

Voit kerätä yksittäisiä sivukohteita tai kerätä toisiinsa liittyviä kohteita ”joukoiksi”. Joissakin tapauksissa InDesign luo joukkoja automaattisesti
suojatakseen sivukohteiden suhteiden eheyttä.

Alla on kerrottu muutama tapa kerätä kohteita ryhmiksi. Osa näistä tavoista on manuaalisia ja osa automaattisia:

Valitaan useita kohteita valitsimella.
Kun valitaan Lataa kuljetin -vaihtoehto ja sitten tietyt sivut tai koko julkaisun sisältö tai valitut kohteet, niin kohteet kerätään joukoksi.
Kerätään kohde, johon liittyy muuta sisältöä. Tällainen kohde voi olla esimerkiksi vuorovaikutteisen painikkeen osa, johon liittyy muita kohteita
tai tiloja. Nämä kohteet kerätään joukoksi, joka voidaan pudottaa yhdellä eleellä.
Kerätään tekstiruutu, jossa on muihin objekteihin ulottuvaa ketjutettua tekstiä. Kun kuljettimen ”kerää kaikki ketjutetut tekstikehykset” -
valintaruutu on valittu, kaikki ketjutetut tekstiruudut kerätään joukoksi.

Sijoittaminen ja linkittäminen

1. Valitse sivukohde valitsemalla kehys tai aseta lisäyskohdistin tekstiin. Voit valita myös useita kohteita vaihtonapsauttamalla.

2. Valitse Muokkaa > Sijoita ja linkitä. Kohteet ladataan kohdistimeen, ja kohteet näytetään sisältökuljettimessa.

3. Jos haluat sijoittaa linkitetyn kohteen, napsauta sivua tai piirrä kehys.

Linkin asetusten määrittäminen

1. Valitse linkitetty kohde Linkit-paneelista.

2. Valitse Linkit-paneelivalikosta Linkkiasetukset.

 

Voit muuttaa Peruuta-painikkeen Palauta-painikkeeksi painamalla Alt-näppäintä (Windows) tai optionäppäintä (Mac OS). Voit palauttaa
oletusasetukset valitsemalla Palauta.
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Päivitä linkki julkaisua tallennettaessa

Varoita, jos linkin päivitys korvaa paikalliset muokkaukset

Säilytä paikalliset muokkaukset objektilinkkejä päivitettäessä

Poista jutusta pakotetut rivinvaihdot

Määritä mukautettu tyyliosoitus

Alkuun

3. Valitse asetukset tarpeen mukaan:

Ota tämä asetus käyttöön, jos haluat linkkien päivittyvän, kun julkaisu tallennetaan.

Ota tämä asetus käyttöön, jos haluat, että InDesign näyttää varoitusviestin,
kun linkin päivittäminen korvaa linkitettyyn objektiin tehdyt paikalliset muokkaukset.

Valitse jokin valittavissa olevista luokista, jos haluat säilyttää paikalliset
muokkaukset linkkejä päivitettäessä.

Ota käyttöön, jos haluat poistaa pakotetut rivinvaihdot jutusta. Kun rivinvaihdot on poistettu, teksti
sijoittuu tasaisesti linkitettyyn kehykseen aina uudelleen, kun sen kokoa tai muotoilua muutetaan.

Ota tämä asetus käyttöön, jos haluat tehdä tyyliosoituksen ja käyttää linkitettyyn sisältöön jotain toista
tyyliä. Katso Mukautetut tyyliosoitukset.

Jos haluat määrittää oletusarvoiset linkkiasetukset kaikkien julkaisujen ollessa suljettuina, avaa Linkit-paneelin valikko ja valitse Linkkiasetukset.

Mukautettu tyyliosoitus
Tekstityylit (kappale, merkki, taulukko, solu) tai tyyliryhmät voidaan osoittaa linkitettäessä eri tyyleihin. Osoitettuja tyylejä käytetään automaattisesti
linkitettyyn sisältöön ylemmällä tasolla käytettyjen alkuperäisten tyylien sijasta. Mukautetuista tyyliosoituksista on hyötyä esimerkiksi silloin, kun
digitaalijulkaisuissa halutaan käyttää päätteettömiä kirjasimia ja painotuotejulkaisuissa päätteellisiä kirjasimia. Sitä voi käyttää myös silloin, jos
vaaka- ja pystysuuntaisille sivuasetteluille halutaan erilaiset tekstityylit.

Voit määrittää mukautetun tyyliosoituksen jollakin seuraavista tavoista:

Ota Linkkiasetukset-valintaikkunassa (Linkit-paneeli > Linkkiasetukset) Määritä mukautettu tyyliosoitus käyttöön ja valitse Asetukset.

Napsauta -työkalua sisältökuljettimessa.

Luokka Esimerkit

Ulkoasu

Objektin tyylimääritteet, kuten viiva, täyttö tai tehosteet. Näihin
eivät kuulu tekstiin tai tekstikehykseen liittyvät määritteet, kuten
päällepainatus tai tulostukseen liittymättömät asetukset.

Koko ja muoto
Korkeus, leveys, muutokset, tekstikehyksen määritteet ja muut
palstan koon määritteet

Vuorovaikutteisuus Animaatio, objektien tilat, painikkeen toiminnot

Kehyksen sisältö
Kehyksiin liitetyt kuvat, videot tai muu sisältö ja tällaisissa
objekteissa suoraan käytetyt tehosteet tai asetukset.

Muut

Muihin luokkiin kuulumattomat määritteet, kuten
tekstinkierrätys kehyksissä, objektien vientiasetukset sekä
tekstikehyksen määritteet, kuten perusviivan asetukset,
automaattisen koon määrittämisen asetukset, pystytasaus jne.
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Alkuun

 
Mukautettu tyyliosoitus

1. Valitse lähdedokumentti ja tyylin tyyppi. 
2. Valitse Uusi tyyliosoitus.
3. Valitse luettelosta lähde ja osoitetut tyylit tai tyyliryhmät.

Voit muuttaa Peruuta-painikkeen Palauta-painikkeeksi painamalla Alt-näppäintä (Windows) tai optionäppäintä (Mac OS). Voit palauttaa
oletusasetukset valitsemalla Palauta.

Linkitetyn kohteen päivittäminen
Jos alkuperäistä kohdetta muutetaan, kehyksen yläpuolelle ja Linkit-paneeliin tulee näkyviin -symboli. Voit tehdä päivityksen jollakin seuraavista
tavoista:

Napsauta lähellä kehyksen vasenta yläkulmaa olevaa -kuvaketta.
Kaksoisnapsauta Linkit-paneelissa olevaa -symbolia.

Jos olet tehnyt alikohteeseen paikallisia muutoksia, muutokset korvataan alkuperäisen kohteen sisällöllä. Jos valitset Varoita, jos linkin päivitys
korvaa paikalliset muokkaukset, näytölle tulee varoitusviesti.

Linkkitiedot-ruudussa voit määrittää, onko juttuun tehty paikallisia muokkauksia. Jutun tilana on ”Muokattu teksti”, jos paikallisia muokkauksia on
tehty.
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Perussivunumeroinnin lisääminen

Alkuun

Alkuun

Sivunumeroinnin lisääminen
Sivunumeron merkin lisääminen sivupohjaan
Sivunumerointityylin muuttaminen
Yleisiä sivunumerointitehtäviä

Sivuille voidaan lisätä nykyisen sivun numero, joka määrittää, mihin sivun kohtaan sivunumero sijoitetaan ja miltä se näyttää. Sivunumeron merkki
päivittyy automaattisesti ja näyttää oikean numeron silloinkin, kun julkaisun sivuja lisätään, poistetaan tai järjestellään uudelleen. Sivunumeron
merkit voidaan muotoilla tekstiksi.

Sivunumeron merkin lisääminen sivupohjaan

Sivunumeromerkit lisätään yleensä sivupohjaan. Kun sivupohjia käytetään julkaisun sivuilla, sivunumerointi päivittyy ylä- ja alatunnisteiden lailla
automaattisesti.

Sivunumeron merkki sivupohjassa A (vasen) ja sivulla 5, joka perustuu samaan sivupohjaan (oikea)

Automaattinen sivunumerointi näyttää sivupohjassa sivupohjan etuliitteen. Julkaisun sivulla automaattinen sivunumerointi näyttää sivun numeron.
Taittopohjalla näkyvät kirjaimet TP.

1. Kaksoisnapsauta Sivut-paneelissa sivupohjaa, johon haluat lisätä sivunumeron. Jos haluat luoda sivupohjia, katso Sivupohjien luominen.

2. Luo uusi tekstikehys, johon mahtuu pisin sivunumero ja teksti, jonka haluat näkyvän numeron vieressä. Sijoita tekstikehys kohtaan, johon
haluat sivunumeron.

Jos julkaisussasi on vastakkaisia sivuja, luo erilliset tekstikehykset vasemmalle ja oikealle sivupohjalle.

3. Lisää sivunumeron tekstikehykseen teksti, joka tulee ennen sivunumeroa tai numeron jälkeen (kuten ”Sivu”).

4. Sijoita lisäyskohta paikkaan, jossa haluat sivunumeron näkyvän, ja valitse Teksti > Lisää erikoismerkki > Merkit > Nykyinen sivunumero.

5. Käytä sivupohjaa julkaisun sivuilla, joilla haluat sivunumeroinnin näkyvän. Jos haluat käyttää sivupohjia, katso Sivupohjien käyttäminen.

Jos haluat poistaa sivunumeron julkaisun ensimmäiseltä sivulta, sinulla on kaksi vaihtoehtoa. Käytä toista tai Ei mitään -sivupohjaa tai ohita ja
poista julkaisusivulla oleva tekstikehyspohja. Voit ohittaa tekstikehyspohjan näppäinyhdistelmällä Ctrl/Cmd+Vaihto-napsautus.

Sivunumerointityylin muuttaminen

Sivut numeroidaan oletuksena arabialaisilla numeroilla (1, 2, 3...). Voit kuitenkin käyttää myös isoja tai pieniä roomalaisia numeroita (i, ii, iii...) tai
aakkosnumeerista (a, b, c...) numerointia. Voit myös numeroida sivuja käyttämällä nollia sivunumeroiden alussa. Jokaista erilaista numerointityyliä
käyttävää julkaisun osaa kutsutaan osioksi. Jos haluat lisätietoa osioista, katso Osioiden numeroinnin määrittäminen.

Sivunumerointigalleria
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Alkuun

Japanin-, kiinan- ja koreankielisissä versioissa sivunumeroihin käytetään oletusarvoisesti arabialaisia numeroita. Jos kuitenkin käytät Numerointi- ja
osioasetukset -komentoa, voit määrittää numeroinnin tyyliksi esimerkiksi roomalaiset tai arabialaiset numerot tai kanji-merkistön. Tyyli-asetuksen
avulla voidaan valita sivunumeroissa näytettävien numeroiden määrä, kuten 001 tai 0001. Jokaista erilaista numerointityyliä käyttävää julkaisun
osaa kutsutaan osioksi. Jos haluat lisätietoa osioista, katso Osioiden numeroinnin määrittäminen.

Voit vaihtaa sivunumerointityylin muodon Numerointi- ja osioasetukset -valintaikkunasta. Tästä valintaikkunasta voit aloittaa sivunumeroinnin
uudelleen tai aloittaa sivunumeroinnin haluamastasi numerosta.

1. Valitse Sivut-paneelista sivu, josta haluat uuden numerointityyliosion alkavan.

2. Valitse Sivuasettelu > Numerointi- ja osioasetukset

3. Määritä asetukset ja valitse OK. Katso Julkaisun numerointiasetukset.

Sivut-paneelissa sivukuvakkeen yläpuolella näkyy osion ilmaisinkuvake , joka osoittaa uuden osion alun.

Jos ennen lisäämääsi sivunumeroa näkyy numero tai kirjain, osan etuliite on sisällytetty. Jos et halua käyttää tätä etuliitettä, poista
Numerointi- ja osioasetukset -valintaikkunassa Sisällytä etuliite sivuja numeroitaessa -asetuksen valinta.

Yleisiä sivunumerointitehtäviä

InDesignissa on useita erilaisia ominaisuuksia, joilla voit luoda sivunumerointitehosteita.

Visuaalinen galleria ja sivunumeroiden
lisäämiseen liittyviä pikavihjeitä.... Lue lisää

http://goo.gl/KKJvd

tekijä: Bob Bringhurst

Jaa asiantuntemustasi
Adobe Community Help

Kun haluat: Toimi näin:

Lisätä sivunumeroinnin kirjan julkaisuihin. Katso Kirjan sivujen, lukujen ja kappaleiden numerointi.

Lisätä osio- ja kappalenumeroita. Katso Osien ja lukujen numeroinnin lisääminen.

Luoda juoksevia ylä- tai alatunnisteita, joissa on
tekstimuuttujia, kuten luontipäivä, tiedoston nimi, tai nykyinen
otsikko.

Katso Ylä- ja alatunnisteiden luominen ja Tekstimuuttujat.

Luoda ”Sivu x/y” -numeroinnin, jossa x on nykyinen sivu ja y
on sivujen kokonaismäärä.

Lisää nykyisen sivun numero merkille x, ja lisää viimeisen
sivun numeron tekstimuuttuja merkille y (valitse Teksti >
Tekstimuuttujat > Lisää muuttuja > Viimeisen sivun numero).

Luoda juttuun ”Jatkuu sivulla x” -hypyn. Katso Automaattinen sivunumeroiden lisääminen jutun
hyppyihin.
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Tietoja sivuista ja aukeamista

Alkuun

Sivujen ja aukeamien näyttötavan muuttaminen
Sivun tai aukeaman valitseminen tai määrittäminen kohteeksi
Uusien sivujen lisääminen julkaisuun
Värin tunnusten luominen sivuminiatyyreille

Jos valitset Tiedosto > Julkaisun asetukset -ikkunasta Vastakkaiset sivut, julkaisun sivut järjestetään aukeamiksi. Aukeama on yhdistelmä sivuja,
joita tarkastellaan yhdessä: esimerkiksi kaksi sivua, jotka näkyvät, kun kirja tai lehti avataan. Jokaisella InDesignin aukeamalla on oma
taittopöytänsä, joka on sivun ulkopuolella oleva alue. Voit säilyttää taittopöydällä objekteja, joita ei ole vielä sijoitettu sivulle. Taittopöydällä on myös
tilaa objekteille, jotka ylittävät alueen eli ulottuvat sivun reunan ylitse.

Sivut-välilehti

A. Sivukuvakkeet B. Sivulla käytetty A-sivupohjaa C. Valittu aukeama 

Kun määrität Sidonta-asetuksen arvoksi Oikealta vasemmalle Julkaisun asetukset -valintaikkunassa, numerot liitetään kuva sivukuvakkeisiin
oikealta vasemmalle Sivut-paneelivalikossa.

Pitkässä julkaisussa voidaan siirtyä tietylle sivulle nopeasti valitsemalla Sivuasettelu > Siirry sivulle.

Sivujen ja aukeamien näyttötavan muuttaminen

Sivut-paneelissa hallitaan sivuja, aukeamia ja sivupohjia (sivuja tai aukeamia, jotka muotoilevat automaattisesti toisia sivuja tai aukeamia). Sivut-
paneeli näyttää oletusarvoisesti miniatyyrin jokaisen sivun sisällöstä.

1. Jos Sivut-paneeli ei ole näkyvissä, valitse Ikkuna > Sivut.

2. Valitse Sivut-paneeli valikosta Paneeliasetukset.

3. Määritä Kuvakkeet-osassa kuvakkeet, jotka näkyvät Sivut-paneelissa sivujen miniatyyrien vieressä. Nämä kuvakkeet osoittavat, onko
aukeamaan lisätty läpinäkyvyys tai sivujen siirtymiä ja onko aukeamanäkymää käännetty.

4. Sivut- ja Pohjat-osioissa:

Valitse sivujen ja sivupohjien kuvakkeen koko.

Näytä aukeamat yhdellä pystypalstalla valitsemalla Näytä pystysuunnassa. Poista asetuksen valinta, jos haluat näyttää aukeamat
vierekkäin.

Valitse Näytä miniatyyrikuvat, jos haluat näyttää miniatyyrin kunkin sivun tai sivupohjan sisällöstä. (Tämä asetus ei ole käytettävissä, jos
tietyt kuvakekoon asetukset on valittu.)

5. Valitse Paneelin asettelu -osiosta Sivut päällä, jos haluat näyttää sivukuvakeosion sivupohjakuvakeosion päällä. Valitse Pohjat päällä, jos
haluat näyttää sivupohjakuvakeosion sivukuvakeosion päällä.
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6. Määritä Muuta kokoa -valikossa, kuinka osiot näytetään paneelin kokoa muutettaessa:

Jos haluat muuttaa sekä paneelin Sivut- että Pohjat-osioiden kokoa, valitse Suhteellinen.

Jos haluat säilyttää Sivut-osion nykyisen koon ja muuttaa Pohjat-osion kokoa, valitse Vakiokokoiset sivut.

Jos haluat säilyttää Pohjat-osion koon ja muuttaa Sivut-osion kokoa, valitse Vakiokokoiset pohjat.

Sivun tai aukeaman valitseminen tai määrittäminen kohteeksi

Sivuja tai aukeamia voi joko valita tai määrittää kohteeksi tehtävän mukaan. Tietyt komennot vaikuttavat valittuun sivuun tai aukeamaan ja tietyt
vaikuttavat kohdesivuun tai -aukeamaan. Voit esimerkiksi vetää viivainlinjoja vain kohdesivulle tai -aukeamalle, mutta sivukohtaiset komennot,
kuten Monista aukeama tai Poista sivu, vaikuttavat vain Sivut-paneelista valittuun sivuun tai aukeamaan. Kun sivu tai aukeama määritetään
kohteeksi, se muuttuu aktiiviseksi. Tästä on hyötyä esimerkiksi, jos julkaisuikkunassa näkyy useita aukeamia ja haluat liittää objektin tietylle
aukeamalle.

Sivut-paneelissa:

Jos haluat sekä määrittää sivun tai aukeaman kohteeksi että valita sen, kaksoisnapsauta sen kuvaketta tai sivunumeroita kuvakkeen alla.
Jos sivua tai aukeama ei ole näkynyt julkaisuikkunassa, se tulee näkyviin.

Vihje: Voit määrittää sivun tai aukeaman kohteeksi ja valita sen myös napsauttamalla sivua, jotakin objektia sivulla tai taittopöytää
julkaisuikkunassa.

Pystyviivain näkyy himmeänä kaikilla muilla paitsi kohteeksi määritetyllä sivulla tai aukeamalla.

Valitse sivu napsauttamalla sen kuvaketta. (Älä kaksoisnapsauta sivua, jollet halua valita sitä ja siirtää sitä näkyviin.)

Valitse aukeama napsauttamalla sivunumeroita aukeamakuvakkeen alla.

eräät aukeama-asetukset, kuten Sivut-paneelivalikon asetukset, ovat käytettävissä vain, kun koko aukeama on valittu.

Uusien sivujen lisääminen julkaisuun

Tee jokin seuraavista toimista:

Jos haluat lisätä sivun aktiivisen sivun tai aukeaman perään, napsauta Sivut-paneelin Uusi sivu -painiketta tai valitse Sivuasettelu >
Sivut > Lisää sivu. Uudella sivulla käytetään samaa sivupohjaa kuin nykyisellä aktiivisella sivulla.

Jos haluat lisätä useita sivuja julkaisun loppuun, valitse Tiedosto > Julkaisun asetukset. Määritä julkaisun sivumäärä Julkaisun asetukset -
valintaikkunassa. InDesign lisää sivut viimeisen sivun tai aukeaman jälkeen.

Jos haluat lisätä sivuja ja määrittää julkaisun sivupohjan, valitse Sivut-paneelivalikosta Lisää sivuja, tai valitse Sivuasettelu > Sivut >
Lisää sivuja. Valitse kohta, johon sivut lisätään, ja käytettävä sivupohja.

Värin tunnusten luominen sivuminiatyyreille

Voit määrittää värin tunnuksia sivuminiatyyreille Sivut-paneelissa. Voit käyttää värin tunnuksia esimerkiksi ilmaisemaan sivujen tilaa. Vihreä tunnus
voi ilmaista valmiin aukeaman, keltainen tunnus kesken olevan aukeaman ja punainen tunnus aukeaman, jota ei ole vielä aloitettu.

1. Valitse Sivut-paneelista sivut, joilla haluat käyttää värin tunnuksia.

2. Valitse Sivut-paneelista Värin tunnus ja valitse sitten asetettava väri.

Värin tunnus näkyy miniatyyrin alla Sivut-paneelissa.

Värin tunnuksen käyttäminen sivupohjassa vaikuttaa kaikkiin sivuihin, joihin sivupohjaa käytetään. Kun käytät värin tunnusta yksittäisillä julkaisun
sivuilla, käytetään kuitenkin julkaisun sivujen värin tunnusta. Jos haluat käyttää värin tunnusta sivupohjan sivuilla, valitse muokattavat julkaisun
sivut ja valitse Sivut-paneelista Värin tunnus > Käytä pääväriä.
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Joustavat sivuasettelut ja vaihtoehtoiset sivuasettelut | CC, CS6
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Alkuun

Alkuun

Käsiteltävät aiheet
Suositeltu työnkulku
Joustavat sivuasettelut

Joustavat sivusäännöt
Vaihtoehtoiset sivuasettelut

Vaihtoehtoisten sivuasetteluiden luominen

Vaihtoehtoisten sivuasettelujen ja joustavien sivuasettelujen sivusääntöjen avulla voidaan tehokkaasti suunnitella useita sivukokoja, sivun suuntia
tai sivusuhteita.

Kun halutaan julkaista useisiin muotoihin ja kokoihin, voidaan valita kuhunkin projektiin parhaiten sopiva suunnittelustrategia: käsityö,
puoliautomaattisuus tai täysi automaattisuus. Oma suunnittelun hallinta vähenee käytettäessä automaattisia työnkulkuja. InDesign sisältää useita
parannuksia kustannusten ja hallinnan tasapainottamiseen.

Automaattinen joustaviin sivuasetteluihin perustuva julkaiseminen ei ole vielä mahdollista, koska sopivia katselutekniikoita ei ole vielä
käytettävissä. 

Suositeltu työnkulku

 
A. Vaihtoehtoisen sivuasettelun työnkulku B. Vaihtoehtoiset sivuasettelut ja joustavat sivusäännöt 

VAIHE 1: Valitse kohdelaite ja sen vastaava mitta ja suunta. Luo sitten ensisijainen sivuasettelu kaikkia sivuja varten.

VAIHE 2: Toinen vaihtoehto on lisätä Adoben joustavien sivupohjien sivusäännöt, jotka helpottavat sisällön sovittamista eri sivusuhteisiin ja
kokoihin. Joustavista sivusäännöistä on hyötyä, jos teet sisältöä useille erilaisille laitteille. Ellet käytä joustavia sivusääntöjä, joudut manuaalisesti
luomaan eri sivuasettelun jokaiselle mahdolliselle koolle ja suunnalle. Katso Joustavat sivuasettelut.

VAIHE 3: Luo julkaisuun uusia sivuja Luo vaihtoehtoinen sivuasettelu -toiminnon avulla. Sivuasettelua on ehkä hienosäädettävä manuaalisesti
ensisijaisen sivuasettelun ja joustavien sivusääntöjen mukaan. Toista tämä vaihe jokaiselle uudelle koolle ja suunnalle. Katso Vaihtoehtoiset
sivuasettelut.

Joustavat sivuasettelut
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Skaalaa

 
Joustavat sivuasettelut

Joustavat sivuasettelut helpottavat sisällön suunnittelua useita sivukokoja, suuntia tai laitteita varten. Käyttämällä joustavia sivusääntöjä voit
määrittää, miten sivulla olevia objekteja mukautetaan, kun luot vaihtoehtoisia sivuasetteluja ja muutat kokoa, suuntaa tai sivusuhteita.

Voit käyttää eri sivuille eri sääntöjä sivuasettelun ja tavoitteiden mukaan. Sivulla voidaan käyttää kerralla vain yhtä joustavaa sivusääntöä.
Joustava sivuasettelu on yleinen termi, joka kattaa joustavien sivusääntöjen sarjan: skaalaus-, uudelleenkeskitys-, apuviivapohjaiset ja
objektipohjaiset säännöt.

Joustavien sivusääntöjen avulla sisältö voidaan sovittaa tulostuskokoja varten.

Voit sovittaa sivuasettelut luodessasi julkaisuun uusia sivuja vaihtoehtoisten sivuasettelujen avulla.
Voit sovittaa sivuasettelut tehdessäsi muutoksia olemassa oleviin sivukokoihin. Tämä on tehokkaampi menetelmä kuin aiempi Sivuasettelun
säätö -toiminto.

Voit käyttää joustavaa sivusääntöä valitsemalla Sivu-työkalun  ja napsauttamalla sivua. Valitse sen jälkeen joustava sivusääntö säätöpalkista.
Toinen vaihtoehto on valita Sivuasettelu > Joustavat sivuasettelut.

Jos haluat esikatsella käytetyn säännön vaikutuksia, muuta sivun kokoa vetämällä sivun kulmia Sivu-työkalun avulla. Sivu palautuu takaisin
alkuperäiseen kokoonsa, kun vapautat hiiren.

Jos haluat muuttaa sivun kokoa, paina Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) ja vedä. Sivun koon muuttaminen hiirellä on
kuitenkin tapa, jolla sivuista voi tulla hieman eri kokoisia kuin on tarkoitettu. Tarkempi tapa on muuttaa sivun kokoa säätöpalkin korkeus- ja
leveysasetusten avulla.

 
Joustavat sivusäännöt 
A. Sivu-työkalu B. Joustavat sivusäännöt säätöpalkin kautta C. Sivun kulmat D. Nastat objektipohjaisia sääntöjä varten E. Joustavan sivuasettelun
paneeli 

Joustavat sivusäännöt
Voit käyttää eri sivuilla eri sääntöjä. Sivulla voidaan käyttää kerralla vain yhtä joustavaa sivusääntöä.

Katso tämä video ja ota selvää, miten voit käyttää Ei mitään-, Skaalaa- ja Keskitä-sääntöjä sivuasettelun kokoa muutettaessa. Selvitä myös, mitä
”sivupohjan perusteella” tarkoittaa. Perustason joustavien sivuasettelusääntöjen käyttäminen: Skaalaa, Keskitä ja Sivupohjan perusteella.

Kaikkea sivun sisältöä käsitellään ryhmänä. Kun sivun koko muuttuu, kaikkien elementtien kokoa muutetaan samassa suhteessa. Tämä
vastaa mustien palkkien näyttämistä HD-televisioruudun reunoissa.

184

http://tv.adobe.com/watch/learn-indesign-cs6/using-basic-liquid-layout-rules-scale-recenter-and-based-on-master/


Keskitä uudelleen

Apuviivapohjainen

 
Joustavat sivusäännöt: skaalaus

Kaikki sivun sisältö keskitetään automaattisesti leveydestä riippumatta. Toisin kuin skaalauksessa, sisältö pysyy
alkuperäisessä koossaan. Saat saman tuloksen kuin videotuotannon turva-alueilla, kun suunnittelet uudelleenkeskityssäännön käytön huolellisesti
ja käytät sivuasettelua.

 
Joustavat sivusäännöt: keskitä uudelleen

Apuviivat muodostavat suoran linjan sivun poikki ja osoittavat alueen, jonne sisältö voidaan sovittaa.
Tyhjän tilan lisääminen on mahdollista.
Tekstikehysten koko muutetaan ja teksti juoksutetaan uudelleen (mutta skaalausta ei tehdä).
Sijoitettujen kuvakehysten koko muutetaan, samoin niitä ympäröivän kehyksen rajausreunojen mitat.

Jos haluat lisätä joustavan apuviivan, valitse ensin Sivu-työkalu ja vedä apuviivat ulos viivaimesta.
Apuviivapohjaiset säännöt vastaavat 3- ja 9-osaista skaalausta Illustratorissa, Fireworksissa ja Flashissa. Katso tämä video, jonka aiheena
on Apuviivapohjaisten joustavien sivuasettelusääntöjen käyttäminen.

Jos haluat muuntaa viivainlinjan joustavaksi apuviivaksi, valitse Sivu-työkalu ja napsauta Muunna joustavaksi apuviivaksi -kuvaketta apuviivan
kohdalla. Joustava apuviiva näkyy katkoviivana, kun taas viivainlinja on yhtenäinen viiva.

 
Joustavat sivusäännöt: apuviivapohjainen
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Objektipohjainen

Alkuun

Voit määrittää joustavan käyttäytymisen (kiinteä tai suhteellinen) kunkin objektin koolle ja sijainnille suhteessa sivun reunaan.
Objektin muokkausalueen tai kehyksen kukin reuna voi olla määritelty kiinteästi tai suhteessa sivun reunaan. Esimerkiksi kehyksen
vasemmalle reunalle voidaan haluttaessa määritellä suhde vain sivun vasempaan reunaan.
Korkeus ja leveys voivat olla kiinteitä tai sivun koon mukaan mukautuvia. 

Katso tämä video, jonka aiheena on Objektipohjaisten joustavien sivuasettelusääntöjen käyttäminen.

 
Joustavat sivusäännöt: objektipohjainen

Vaihtoehtoiset sivuasettelut
Käytä vaihtoehtoisia sivuasetteluita, jos tarvitset painotuote- tai digitaalijulkaisuissa eri sivukokoja saman julkaisun sisällä. Vaihtoehtoisten
sivuasettelujen avulla painettavasta mainoksesta voidaan luoda useita eri kokoja. Niitä voidaan käyttää myös esimerkiksi Apple iPad- tai Android-
tablet-laitteiden vaaka- tai pystyasettelujen suunnitteluun.

 
Vaihtoehtoiset sivuasettelut ja Sivut-paneeli

Joustavan sivuasettelun avulla voit merkittävästi vähentää sisällön uudelleenasetteluun liittyvää manuaalista työtä uusia sivukokoja ja suuntia
käytettäessä.

Jos haluat lyhyen yleiskatsauksen, katso Lynda.comin Vaihtoehtoiset sivuasettelut -video.

Vaihtoehtoisten sivuasetteluiden luominen
Vaihtoehtoinen sivuasettelu voidaan luoda seuraavilla tavoilla:

Valitse Sivuasettelu > Luo vaihtoehtoinen sivuasettelu
Valitse Sivut-paneelivalikosta Luo vaihtoehtoinen sivuasettelu
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Nimi

Lähdesivuilta

Sivukoko

Leveys ja korkeus

Suunta

Joustava sivusääntö

Linkitä jutut

Kopioi tekstityylit uuteen tyyliryhmään

Älykäs tekstin sijoittelu

 
Vaihtoehtoisten sivuasetteluiden luominen

Määritä Luo vaihtoehtoisia sivuasetteluita -valintaikkunassa seuraavat asetukset:

Anna vaihtoehtoiselle sivuasettelulle nimi.

Valitse lähteenä käytettävä sivuasettelu, joka sisältää haluamasi sisällöt.

Valitse sivukoko tai anna vaihtoehtoiselle sivuasettelulle haluamasi koko.

Nämä kentät näyttävät vaihtoehtoisen sivuasettelun koon. Voit muuttaa arvot, mutta silloin sivun koko muuttuu mukautetuksi.

Valitse vaihtoehtoiselle sivuasettelulle suunta. Jos siirryt pysty- ja vaakasuunnan välillä, korkeus ja leveys päivitetään.

Valitse vaihtoehtoiseen sivuasetteluun käytettävä joustava sivusääntö. Valitse Säilytä nykyinen, jos haluat käyttää
lähdesivuihin käytettyjä joustavia sivusääntöjä. Valitse toinen sääntö, jos haluat käyttää uusia joustavia sivusääntöjä.

Ota tämä asetus käyttöön, jos haluat sijoittaa objekteja ja linkittää ne lähteenä käytettävän sivuasettelun alkuperäisiin objekteihin.
Kun päivität alkuperäisen objektin, on helpompi hallita linkitettyjen objektien päivityksiä. Katso Linkitetty sisältö.

Ota tämä asetus käyttöön, jos haluat kopioida kaikki tekstityylit ja tehdä niistä uuden ryhmän. Asetus on
hyödyllinen myös silloin, jos on tarve tehdä eri sivuasetteluille erilaisia tekstityylejä.

Ota tämä asetus käyttöön, jos haluat poistaa tekstin pakotetut rivinvaihdot ja muut tyylien ohitukset.  
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Objektien tasaaminen ja jakaminen

Alkuun

Alkuun

Tasaus-välilehden yleiskuvaus
Objektien tasaaminen tai jakaminen
Objektien tasaaminen välityökalulla
Objektien jakaminen Live Distribute -työkalulla

Tasaus-välilehden yleiskuvaus
Tasaus-välilehden (Ikkuna > Objektin asettelu > Tasaa) avulla tasataan tai jaetaan objekteja vaaka- tai pystysuunnassa suhteessa valintaan,
reunuksiin, sivuun tai aukeamaan. Ota huomioon seuraavat seikat, kun käytät Tasaus-välilehteä:

Tasaus-välilehti ei vaikuta objekteihin, joihin on käytetty Lukitse paikka -komentoa, eikä muuta kehyksissä olevien tekstikappaleiden tasausta.

Tasaa objektit -asetukset eivät vaikuta tekstin tasaukseen. (Lisätietoja: Tekstin tasaaminen tai palstaan sovittaminen.)

Pikanäppäimet-valintaikkunan (Muokkaa > Pikanäppäimet) avulla voidaan luoda mukautettuja tasaus- ja jakopikanäppäimiä. (Valitse Kohde-
valikosta Objektin muokkaus.)

Tasaus-välilehti
A. Pystytasauspainikkeet B. Pystyjakopainikkeet C. Käytä välejä -asetus D. Vaakatasauspainikkeet E. Vaakajakopainikkeet F. Tasauspaikka-
asetukset

Objektien tasaaminen tai jakaminen
Tasaus-välilehden avulla voit tasata tai sijoittaa valitut objektit vaaka- tai pystysuunnassa suhteessa valintaan, reunuksiin, sivuun tai aukeamaan.

Objektit jaettuina vaakasuunnassa valintaan (ylinnä) ja reunuksiin (alinna)

1. Valitse tasattavat tai jaettavat objektit.
2. Avaa Tasaus-välilehti valitsemalla Ikkuna > Objektin asettelu > Tasaa.

Voit tuoda esiin tai kätkeä lisää välilehden asetuksia valitsemalla välilehden valikosta Näytä asetukset tai Kätke asetukset.

3. Määritä välilehden alareunan valikosta, haluatko tasata tai jakaa objektit valinnan, reunusten, sivun vai aukeaman perusteella.
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4. Tee jokin seuraavista:

Jos haluat tasata objektit, napsauta haluamaasi tasaustyyppiä vastaavaa painiketta.

Jos haluat jakaa objektit, napsauta haluamaasi jakotyyppiä vastaavaa painiketta. Jos esimerkiksi napsautat Jaa vasemmat reunat -
painiketta, kun Tasaa valintaan -asetus on valittuna, InDesign varmistaa, että kunkin valitun objektin vasemman reunan väli on yhtä
suuri.

Jaa vaakasuunnassa keskelle -asetuksen käyttäminen tasaisessa välistyksessä
A. Luo tasaiset välit objektien keskipisteiden välille B. Pitää kokonaisleveyden samana kuin ennen muunnosta

Määritä objektien välit (joko keskipisteestä keskipisteeseen tai reunasta vastaavaan reunaan) valitsemalla Jaa objektit -kohdassa Käytä
välejä ja kirjoittamalla haluamasi välin arvo. Napsauta painiketta, jolla jaetaan valitut objektit vaaka- tai pystyakselilla.

Jaa vaakasuunnassa keskelle -asetuksen käyttäminen ja Käytä välejä -arvon lisääminen
A. Luo määritetyn arvon mukaisen tasaisen välin objektien keskipisteiden välille B. Muuttaa objektien kokonaisleveyttä

Määritä objektien välit (vastakkaisesta reunasta toiseen) valitsemalla Jaa välit -kohdassa Käytä välejä ja kirjoittamalla haluamasi välin
arvo. (Jos Jaa välit -asetus ei ole näkyvissä, valitse Tasaus-välilehden valikosta Näytä asetukset.) Jaa objektit vaaka- tai pystyakselia
pitkin napsauttamalla sitten Jaa välit -painiketta.
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Alkuun

Alkuun

Jaa vaakaväli -asetuksen käyttäminen ja Käytä välejä -arvon lisääminen
A. Luo määritetyn arvon mukaiset välit jokaisen objektin välille B. Muuttaa objektien kokonaisleveyttä

Käytettäessä välistystä pystyjaolla, valittujen objektien välit säädetään ylhäältä alas ylimmästä objektista alkaen. Käytettäessä välistystä
vaakajaolla, valittujen objektien välit säädetään vasemmalta oikealle äärivasemmalla olevasta objektista alkaen.

Voit myös käyttää Älykkäät välit -ominaisuutta objektien kohdistamiseen tai jakamiseen niiden siirtämisen aikana. Jos kaksi pystysuoraa
objektia on 12 pisteen etäisyydellä toisistaan, kolmannen objektin siirtäminen 12 pistettä toisen objektin alapuolelle tuo näyttöön tilapäiset
apuviivat, joiden avulla objekti voidaan tasata paikalleen.

Objektien tasaaminen välityökalulla
Välityökalulla voit nopeasti säätää välin kokoa kahden tai useamman objektin välissä. Sillä voit myös muuttaa samalla kertaa useiden sellaisten
objektien kokoa, joilla on samalla tavalla tasatut reunat, ja pitää niiden välit kiinteinä. Tämä on yksivaiheinen tapa säätää asettelua muokkaamalla
suoraan objektien välistä tyhjää tilaa.

Välityökalu ei huomioi lukittuja objekteja eikä sivupohjan kohteita.

Voit katsoa välityökalun käyttämistä käsittelevän videon osoitteessa www.adobe.com/go/lrvid5155_id_fi.

1. Valitse välityökalu .

2. Siirrä osoitin kahden objektin väliin ja tee jokin seuraavista toimista:

Vetämällä voit siirtää väliä ja muuttaa kaikkien väliin tasattujen objektien kokoa.

Pitämällä Vaihtonäppäimen painettuna ja vetämällä voit siirtää pelkästään kahden lähimmän objektin väliä.

Pitämällä Ctrl-näppäimen (Windows) tai Komento-näppäimen (Mac OS) painettuna ja vetämällä voit muuttaa välin kokoa siirtämättä sitä.
Vaihtonäppäimen lisääminen muuttaa pelkästään kahden lähimmän objektin kokoa.

Pitämällä Alt-näppäimen (Windows) tai Optio-näppäimen (Mac OS) painettuna ja vetämällä voit siirtää väliä ja objekteja samaan
suuntaan. Vaihtonäppäimen lisääminen siirtää pelkästään kahta lähintä objektia.

Pitämällä Ctrl+Alt-näppäimen (Windows) tai Komento+Optio-näppäimen (Mac OS) painettuna ja vetämällä voit muuttaa välin kokoa ja
siirtää objekteja. Vaihtonäppäimen lisääminen muuttaa välin kokoa ja siirtää pelkästään kahta lähintä objektia.

Jos haluat katsella vihjeitä välityökalun käyttämisestä, valitse välityökalu ja avaa Työkaluvihjeet-paneeli (Ikkuna > Apuohjelmat >
Työkaluvihjeet).

Objektien jakaminen Live Distribute -työkalulla
Kun muunnat useita valittuja objekteja, voit muuttaa valittujen objektien väliä suhteessa sen sijaan, että muuttaisit itse objektien kokoa. Jos haluat
esimerkiksi muuttaa viiden tasatun suorakulmion välejä, voit muuttaa niitä käyttämättä Jaa-komentoja.

Voit katsella Live Distribute -työkalun käyttöä käsittelevän videon osoitteessa http://tv.adobe.com/go/4949/.

1. Valitse objektit.

2. Aloita vetäminen valintakahvasta ja pidä välilyöntinäppäin painettuna vetäessäsi. Jatka vetämistä, jos haluat muuttaa objektien välistystä.

Lisää ohjeaiheita
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Uusien julkaisujen luominen (vain kiina, japani ja korea)

Alkuun

Huomautus:

Alkuun

Uusien julkaisujen luominen
Uuden julkaisun luominen
Uuden julkaisun luominen sivuasetteluruudukon avulla
Uuden julkaisun luominen reunusten ja palstojen avulla
Uuden julkaisun asetukset
Yleistä julkaisuikkunasta
Mukautettujen sivukokojen luominen
Julkaisun oletusarvojen määrittäminen
Julkaisun luominen oletusarvoa käyttämällä

Sivusuunnittelu alkaa perusasioista: uuden julkaisun aloittamisesta, sivujen määrittämisestä ja reunusten ja palstojen sijoittelusta tai
ruudukkoasetusten muuttamisesta.

Kun luodaan julkaisua, työnkuluksi voidaan valita joko Sivuasetteluruudukko tai Reunukset ja palstat.

Huomautus: Julkaisun tiedostomuoto on kummassakin työnkulussa sama. Reunukset ja palstat -työnkulussa julkaisuun luotu sivuasetteluruudukko
näytetään, kun taas Sivuasetteluruudukko-näkymässä se piilotetaan.

Työnkulku, joka perustuu ladonnan koostamiseen Sivuasetteluruudukko-näkymässä, on käytettävissä vain aasialaisissa kieliversioissa. Kun
valitaan Sivuasetteluruudukko, julkaisussa näytetään neliöistä koostuva ruudukko. Sivukokoasetusten kautta voidaan määrittää neliöiden
lukumäärä (rivien tai merkkien määrä). Tällä perusteella määräytyvät myös sivujen reunukset. Sivuasetteluruudukon solujen avulla objekti voidaan
sijoittaa tarkasti sivulle.

Reunukset ja palstat -työnkulku on sama kuin länsimaalaisissa työnkuluissa. Länsimaalaiset työnkulut määritellään Reunukset ja palstat -
asetuksissa, ja objektit järjestetään sivuille ilman sivuasetteluruudukoita. Reunukset ja palstat- tai Sivuasetteluruudukko-työnkulkujen avulla
kirjoitussuunta voidaan määrittää vaaka- tai pystysuuntaiseksi.

 
Julkaisu, jossa näytetään sivuasetteluruudukko (vasemmalla) Julkaisu, jossa näytetään reunukset ja palstat (oikealla)

Uuden julkaisun luominen

1. Valitse Tiedosto > Uusi > Julkaisu.

Uusi julkaisu -ikkunassa on Julkaisun asetukset- ja Reunukset ja palstat -ikkunat, joten sivukoko, reunukset ja palstat voidaan määrittää
samassa paikassa. Voit muuttaa näitä asetuksia koska tahansa.

2. Julkaisun asetusten määrittäminen. (Katso Uuden julkaisun asetukset.)

Määritä leikkausvara- ja informaatioalueet valitsemalla Lisää asetuksia. Leikkausvara- ja informaatioalueet ulottuvat määritetyn sivukoon
reunojen ulkopuolelle. Jotta leikkausvara- ja informaatioalueet ulottuisivat tasaisesti kaikille sivuille, napsauta Määritä kaikki asetukset
samoiksi -kuvaketta .

3. Avaa uusi, määritetyt asetukset sisältävä julkaisu valitsemalla OK.

Uusien julkaisujen sivuasettelun oletusasetukset määritetään valitsemalla Tiedosto > Julkaisun asetukset tai Sivuasettelu >
Reunukset ja palstat. Asetuksia voi määrittää, kun julkaisuja ei ole avoinna.

Uuden julkaisun luominen sivuasetteluruudukon avulla

1. Valitse Tiedosto > Uusi > Julkaisu.
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Alkuun

Alkuun

Julkaisun oletusarvo

Peruste

Sivumäärä

Aloitussivun numero

Vastakkaiset sivut

Tekstikehyspohja

Ensisijainen tekstikehys

Sivukoko

Suunta

Leikkausvara

2. Muuta sivujen määrää, sivun kokoa ja muita asetuksia. Määritä leikkausvara- ja informaatioalueet valitsemalla Lisää asetuksia.

3. Napsauta Sivuasetteluruudukko-valintaikkunaa ja määritä sitten sivuasetteluruudukon asetukset. (Katso Sivuasetteluruudukon asetukset.)

4. Avaa uusi, määritetyt asetukset sisältävä julkaisu valitsemalla OK.

Sivuasetteluruudukkoa käytetään vain sivuasetteluun. Jos haluat lisätä julkaisuun tekstiä, lisää kehysruudukkoja tai tekstikehyksiä.

Uuden julkaisun luominen reunusten ja palstojen avulla
Kun luot julkaisua länsimaalaisella työnkululla, valitse Reunukset ja palstat. Jos julkaisun yleiset sivuasetteluasetukset kuten reunukset ja palstojen
määrä ovat jo tiedossa, on helpointa käyttää Reunukset ja palstat -valintaikkunaa.

1. Valitse Tiedosto > Uusi > Julkaisu.

2. Määritä asetukset Uusi julkaisu -valintaikkunassa. Asetukset ovat samat kuin luotaessa julkaisua sivuasetteluruudukon avulla.

3. Valitse Reunukset ja palstat ja määritä sitten asetukset Uudet reunukset ja palstat -valintaikkunan kautta. Asetukset ovat samat kuin
Reunukset ja palstat -valintaikkunassa. (Katso Julkaisun asetusten, reunusten ja palstojen muuttaminen.)

4. Valitse OK.

Myös silloin, kun julkaisu on luotu Reunukset ja palstat -työnkulussa, sen sivuasetteluruudukkoa voidaan katsella valitsemalla Näytä > Ruudukot ja
apuviivat > Näytä sivuasetteluruudukko. Sivuasetteluruudukon asetuksia voi muuttaa valitsemalla Sivuasettelu > Sivuasetteluruudukko.

Kaikkien uusien julkaisujen oletusasetukset määritetään valitsemalla Tiedosto > Julkaisun asetukset, Sivuasettelu > Reunukset ja palstat tai
Sivuasettelu > Reunukset ja palstat. Asetuksia voi määrittää, kun julkaisuja ei ole avoinna.

Uuden julkaisun asetukset

Valitse aikaisemmin tallennettu esimääritys.

Jos olet luomassa julkaisua, joka tulostetaan PDF- tai SWF-muodossa web-käyttöä varten, Web-asetuksen valinta muuttaa useita
valintaikkunan asetuksia. Se esimerkiksi poistaa Vastakkaiset sivut -asetuksen käytöstä, muuttaa sivun suunnan pystysuunnasta vaakasuuntaan ja
käyttää näytön tarkkuuteen perustuvaa sivukokoa. Voit muokata näitä asetuksia, mutta et voi muuttaa Peruste-asetusta julkaisun luomisen
jälkeen.
CS6: Digital Publishing Suitea varten tarkoitettuihin julkaisuihin on lisätty digitaalisen julkaisun peruste.

Määritä uudelle julkaisulle luotavien sivujen määrä.

Määritä numero, josta julkaisu alkaa. Jos määrität parillisen numeron (kuten 2), kun Vastakkaiset sivut -asetus on
käytössä, julkaisun ensimmäinen aukeama on kaksisivuinen aukeama. Katso Julkaisun aloittaminen kaksisivuisella aukeamalla.

Kun tämä asetus on valittuna, vasemman- ja oikeanpuoleiset sivut muodostavat kahden sivun aukeaman, kuten kirjoissa ja
aikakauslehdissä. Poista valinta, jos käsittelet sivuja erillisinä. Tämä on tarpeen esimerkiksi silloin, jos tulostat mainoslehtisiä tai julisteita tai jos
haluat objektien leikkausvaran sidontaselkään.
Kun olet luonut julkaisun, voit Sivut-paneelia käyttämällä luoda yli kahden sivun aukeamia tai pakottaa kaksi ensimmäistä sivua samaan
aukeamaan. (Katso Aukeaman sivutuksen hallitseminen.)

CS5.5 ja aikaisemmat versiot: Kun valitset tämän asetuksen, voit luoda tekstikehyksen, jonka koko on reunusten apuviivojen
rajaama ja määritettyjä palsta-asetuksia vastaava alue. Tekstikehyspohja lisätään A-sivupohjaan. (Katso Tekstikehysten käyttäminen
sivupohjissa.)
Tekstikehyspohja-asetus on käytettävissä vain, jos olet valinnut Tiedosto > Uusi > Julkaisu.

Vain CS6: Valitse tämä asetus, jos haluat lisätä sivupohjaan ensisijaisen tekstikehyksen. Kun käytät uutta sivupohjaa,
ensisijaisen tekstikehyksen juttu juoksutetaan automaattisesti uudella sivupohjalla olevaan ensisijaiseen tekstikehykseen.

Valitse valikosta koko tai määritä leveys ja korkeus. Sivukoko on sivun lopullinen haluttu koko leikkausvaran ja muiden sivun
ulkopuolella olevien merkkien poistamisen jälkeen.

Valitse Pysty  (korkea) tai Vaaka  (leveä). Kuvakkeet ovat dynaamisessa vuorovaikutuksessa Sivukoko-kohdan kokojen kanssa. Kun
korkeus on suurempi kuin leveys, ohjelma valitsee pystykuvakkeen. Kun leveys on suurempi kuin korkeus, ohjelma valitsee vaakakuvakkeen. Jos
napsautat kuvaketta, joka ei ole valittuna, korkeuden ja leveyden arvot vaihdetaan keskenään.
Vihje: Voit määrittää leikkausvaran ja informaatioalueiden koon valitsemalla Lisää asetuksia Uusi julkaisu -valintaikkunasta. Jotta leikkausvara- ja
informaatioalueet ulottuisivat tasaisesti kaikille sivuille, napsauta Määritä kaikki asetukset samoiksi -kuvaketta .

Leikkausvaran avulla voit tulostaa määritetyn sivukoon ulkoreunalle sijoitettuja objekteja. Kun objekti sijoitetaan vaadittavan
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Informaatioalue

Huomautus:

Alkuun

Alkuun

Alkuun

kokoisen sivun reunaan, tulostusalueen reunassa voi näkyä valkoista, jos tulostusta tai leikkausta ei ole kohdistettu tarkasti kohdalleen. Tämän
vuoksi tarvittavan kokoisen sivun reunassa olevat objektit olisi sijoitettava jonkin verran reunan yli, ja sivu pitäisi viimeistellä tulostuksen jälkeen.
Leikkausvara näkyy julkaisussa punaisena viivana. Voit määrittää leikkausvara-alueen asetukset tulostusikkunan Leikkausvara-asetuksissa.

Informaatioalue poistetaan, kun julkaisu viimeistellään lopulliseen sivukokoon. Informaatioalueessa on tietoja tulostuksesta ja
muokatuista väripalkeista tai ohjeita ja kuvauksia muista julkaisun tiedoista. Informaatioalueelle sijoitetut objektit (myös tekstikehykset) tulostetaan,
mutta poistetaan, kun julkaisu viimeistellään lopulliseen sivukokoon.
Leikkausvara- ja informaatioalueiden ulkopuolella olevat objektit (sen mukaan, kumpi ulottuu kauemmaksi) eivät tulostu.

Voit tallentaa julkaisun asetukset napsauttamalla Tallenna julkaisun oletusarvo -kuvaketta.

Yleistä julkaisuikkunasta
Kullakin julkaisun sivulla tai aukeamalla on oma taittopöytä ja apuviivat, jotka näkyvät normaalissa näyttötilassa. (Voit vaihtaa normaaliin
näyttötilaan valitsemalla Näytä > Näyttötila > Normaali.) Taittopöytä korvautuu esikatselutilassa harmaalla taustalla. (Katso Julkaisujen esikatselu.)
Voit muuttaa tämän esikatselutaustan ja apuviivojen väriä Apuviivat ja taittopöytä -asetuksissa.

 
Julkaisu ja apuviivat normaalissa näyttötilassa 
A. Aukeama (mustat viivat) B. Sivu (mustat viivat) C. Reunusten apuviivat (magentat viivat) D. Palstojen apuviivat (violetit viivat) E. Leikkausvara-
alue (punaiset viivat) F. Informaatioalue (siniset viivat) 

Julkaisuikkunan huomautukset:

Muunväriset viivat ovat viivainlinjoja, jotka ovat tasojensa värisiä, kun ne valitaan. Katso Tasot.

Palstojen apuviivat ovat reunusten apuviivojen edessä. Jos palstan apuviiva on aivan reunuksen apuviivan edessä, se peittää reunuksen
apuviivan.

Mukautettujen sivukokojen luominen
Voit luoda mukautettuja sivukokoja, jotka näkyvät Uusi julkaisu -valintaikkunan Sivukoko-valikossa.

1. Valitse Tiedosto > Uusi > Julkaisu.

2. Valitse Sivukoko-valikosta Mukautettu sivukoko.

3. Anna sivukoolle nimi, määritä sivukokoasetukset ja napsauta sitten Lisää.

New Doc Sizes.txt -tiedosto, jolla voit luoda mukautettuja sivukokoja aikaisemmissa InDesign-versioissa, ei ole käytettävissä InDesign CS5:ssä tai
sitä uudemmissa versioissa.

Julkaisun oletusarvojen määrittäminen
Kun tallennat julkaisun sivukoko-, palsta-, reunus-, leikkausvara- ja informaatioalueasetukset oletusarvoiksi, säästät aikaa ja varmistat julkaisujesi
yhtenäisyyden.

1. Valitse Tiedosto > Julkaisun oletusarvot > Määritä.

2. Valitse näyttöön tulevasta valintaikkunasta Uusi.

3. Määritä oletusarvolle nimi ja valitse Uusi julkaisun oletusarvo -ikkunasta perusasetukset. (Katso Uuden julkaisun asetukset, jos haluat
lisätietoja vaihtoehdoista.)

4. Valitse OK kaksi kertaa.

Voit tallentaa julkaisun oletusarvon erilliseen tiedostoon ja lähettää sen muille käyttäjille. Tallenna ja lataa julkaisun oletusarvotiedostot Julkaisun
oletusarvot -valintaikkunan Tallenna- ja Lataa-painikkeiden avulla.
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AlkuunJulkaisun luominen oletusarvoa käyttämällä

1. Tee jokin seuraavista:

Valitse Tiedosto > Julkaisun oletusarvo > [oletusarvon nimi]. (Pidä vaihtopainiketta alhaalla oletusarvon valitsemisen aikana, jos haluat
luoda uuden asiakirjan oletusarvon pohjalta avaamatta Uusi julkaisu -valintaikkunaa.)

Valitse Tiedosto > Uusi > Julkaisu ja valitse sitten oletusarvo Uusi julkaisu -valintaikkunan Julkaisun oletusarvo -valikosta.

Oletusarvoasetukset näkyvät Uusi julkaisu -valintaikkunassa.

2. Muuta halutessasi asetuksia ja valitse OK.

Voit ohittaa Uusi julkaisu -ikkunan painamalla vaihtonäppäintä, kun valitset oletusarvon Julkaisun oletusarvo -valikosta.

Suositeltava InDesign-julkaisujen työnkulku

Julkaisumallien käyttäminen

Julkaisun lisääminen kirjatiedostoon

Julkaisun asetusten, reunusten ja palstojen muuttaminen
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Formatting grids
Named Grids panel overview
Create named grid formats
Apply a named grid to a frame
Edit named grids
Delete named grids
Import grid formats from other documents

Named Grids panel overview

Use the Named Grids panel (Window > Type & Tables > Named Grids) to save frame grid settings in named grid
format, and apply those settings to other frame grids. You can apply or change frame grid formats efficiently, and
easily keep the appearance of a document consistent, using grid formats.

Named Grids panel

A. Grid name B. New Grid Format button C. Delete icon 

In the Named Grids panel, the Layout Grid format is shown by default. The layout grid setting for the currently
selected page is reflected in this grid format. When more than one layout grid is set for a single document, the
settings shown in Layout Grid in the Named Grids panel vary depending on the selected page layout grid contents.

When a frame grid with grid formatting is selected, the current grid format name is highlighted in the Named Grids
panel.

Create named grid formats

Like styles, named grid formats let you save a collection of frame grid settings and apply those settings to other
frame grids.

1. To define a new grid format in accordance with the existing frame grid format, select the frame grid with
the selection tool.

2. Choose Window > Type & Tables > Named Grids.
3. Choose New Named Grid from the Named Grids panel menu.
4. Specify options in the Edit Grid Format dialog box, and click OK.
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If the named grid format you want to use is already saved in another InDesign document, you can import that grid
format into the current document.

When a new frame grid format is created based on an existing frame grid, changes to format attribute options also
are applied to the selected frame grid. If you do not want to modify the selected frame grid format, deselect the
frame grid before showing the Edit Grid Format dialog box.

Named Grid options

Named Grid options appear when you choose Window > Type & Tables > Named Grids.

Grid Name

Enter the name of the grid format.

Font

Select the font family and font style, and set the default font for the text to be placed in the grid.

Size

Specify individual grid sizes.

Vertical and Horizontal

Specify the grid scale for full-width Asian characters in %.

Char Aki

Specify the spacing between grid cells in the frame grid. This value will be the grid cell size.

Line Aki

Enter a value to specify the grid line spacing. The value used here is the distance between the bottom (or left)
edge of the character embox for the first line to the top (or right) edge of the character embox for the next line.

Line Align

Select an option to specify line alignment for the frame grid. For example, if Align Left/Top is selected, the
beginning of each line for a vertical type frame grid will be aligned with the top edge of the frame grid. (See Align
or justify text.)

Grid Align

Select an option to specify whether to align the text to the embox, ICF box, or roman baseline. See Align
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paragraphs to a baseline grid.

Char Align

Select an option to specify the method of aligning small characters to larger characters in a line. (See Align text of
different sizes.)

Apply a named grid to a frame

You can apply a custom named grid or the Layout Grid to a frame grid. If you apply the Layout Grid, the same
settings defined in the Layout Grid dialog box are used in the frame grid.

1. Select the frame grid using the Selection tool. You can also use the Type tool to click on the frame and
position the text insertion point or select text.

2. Click on the name of the format to be applied in the Named Grids panel or Control panel.

Applying a grid format causes grid format attributes to be set for text in the frame grid, but grid format
attributes will not be set for text which has been given Character or Paragraph styles, or text which has had
settings individually modified from the Character panel or Paragraph panel.

Note:

Priority is given to character style, paragraph style and grid format in that order in the frame grid.
Accordingly, when grid formatting is applied to text that has been given paragraph or character styles, a '+'
mark is shown next to each applied style name. (See Text formatting precedence.)

Before and after applying a grid format to the frame grid

3. To apply grid format attributes to the entire story, select the frame grid using the Selection tool and select
Edit > Apply Grid Format.

You can also add named grids to object styles. If you add a named grid to the default object style for grid frames,
all grid frames you create appear formatted according to the named grid you specify. (See About object styles.)

Edit named grids

You can change the grid format definitions at any time. When you change the definition of a grid format, all of the
frame grids formatted with that style change to conform with the newly defined style.

1. Using the Named Grids panel, select the grid format to be edited, and choose Named Grid Options from the
panel menu, or double-click the grid format you want to edit in the Named Grids panel.

2. Change the settings in the Modify Named Grid dialog box. (See Create named grid formats.)
3. Click OK.
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This modifies the grid format given to the currently selected frame grid. To modify settings for frame grids which
are not currently selected, perform the above operation without selecting any objects in the document, or double-
click the grid format name in the Named Grids panel while holding down Shift+Ctrl+Alt (Windows) or
Shift+Command+Option (Mac OS).

Delete named grids

The formatting applied to text in a frame is unchanged even if a grid format is deleted, but the link to the grid
format is removed.

1. Select the name of the grid format you want to delete in the Named Grids panel.
2. Choose Delete Named Grids from the panel menu, or click the Delete icon  at the bottom of the Named

Grids panel.

When you delete grid formats, the frame grid to which the grid format was applied doesn’t appear to change, but
the format is no longer connected with the grid format.

Import grid formats from other documents

1. Choose Load All Named Grids from the Named Grids panel menu.
2. Double-click the InDesign document containing the grid formats you want to import.

When you import a grid format from another document that has the same name as a grid format in the current
document, the existing grid format in the import destination will be overwritten, and when this grid format is
applied the grid format for all the frame grids will be changed.

Adobe also recommends

Customize layout and frame grids
Override character and paragraph styles
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Tekstin ja tekstikehysten luominen
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Tekstikehysten luominen
Tekstikehysten siirtäminen ja koon muuttaminen
Tekstikehysten käyttäminen sivupohjissa
Tekstikehyksen ominaisuuksien muuttaminen
Sana- ja merkkimäärien määrittäminen
Lisäkielien käyttäminen

Tekstikehysten luominen
InDesignissa teksti on tekstikehyksiksi kutsutuissa säilöissä. (Tekstikehys vastaa QuarkXPressin tekstilaatikkoa ja Adobe PageMakerin
tekstilohkoa.) Voit katsoa tekstikehyksen tekemistä käsittelevän videon osoitteessa www.adobe.com/go/lrvid4274_id_fi.

Tekstikehyksiä voidaan grafiikkakehysten tavoin siirtää ja käsitellä eri tavoin, ja myös niiden kokoa voidaan muuttaa. Käytettävissä olevat toiminnot
vaihtelevat käytössä olevan työkalun mukaan:

Tekstityökalulla  lisätään tekstiä kehykseen tai muokataan kehyksessä olevaa tekstiä.

Valintatyökalua  käytetään yleisiin asemointitehtäviin, kuten kehyksen sijoittamiseen ja sen koon muuttamiseen.

Käytä suoravalintatyökalua  kehyksen muodon muuttamiseen.

Tekstikehykset voi myös yhdistää muihin tekstikehyksiin niin, että teksti jatkuu toisessa kehyksessä. Tällä tavalla yhdistetyt kehykset ovat
ketjutettuja. Tekstiä, joka jatkuu vähintään yhden ketjutetun kehyksen läpi, kutsutaan jutuksi. Kun esimerkiksi sijoitat (tuot) tekstitiedoston, se tulee
julkaisuun yhtenä juttuna kehysten määrästä riippumatta.

Tekstikehyksissä voi olla useita palstoja. Vaikka tekstikehykset voivat perustua sivun palstoihin, ne ovat kuitenkin sivun palstoista riippumattomia.
Kaksipalstainen tekstikehys voi siis olla nelipalstaisella sivulla. Tekstikehykset voidaan myös sijoittaa sivupohjiin, ja niihin voidaan lisätä tekstiä
julkaisun sivuilla.

Jos käytät toistuvasti samantyyppistä tekstikehystä, voit luoda objektityylin, joka sisältää tekstikehyksen muotoilun (esimerkiksi viiva- ja
täyttövärit, tekstikehyksen asetukset sekä tekstinkierrätys- ja läpinäkyvyystehosteet).

Tekstikehystä ei tarvitse luoda tekstin sijoittamisen tai liittämisen yhteydessä, sillä InDesign lisää kehykset automaattisesti sivun palsta-asetusten
mukaisesti.

 Tee jokin seuraavista toimista:

Valitse tekstityökalu  ja määritä uuden tekstikehyksen leveys ja korkeus vetämällä. Jos pidät vaihtonäppäintä alhaalla, kun vedät,
kehyksestä tulee neliö. Kun vapautat hiiren painikkeen, kehykseen tulee tekstikohdistin.

Uuden tekstikehyksen luominen vetämällä

Napsauta toisen tekstikehyksen sisäporttia tai ulkoporttia valintatyökalulla ja luo sitten uusi kehys napsauttamalla tai vetämällä.

Sijoita tekstitiedosto Sijoita-komennon avulla.

Napsauta jonkin tyhjän kehyksen sisäosaa tekstityökalulla . Jos Tekstiasetukset-valintaikkunassa on valittu tekstityökalu muuttaa kehykset
tekstikehyksiksi -vaihtoehto, tyhjä kehys muunnetaan tekstikehykseksi.

Tekstikehysten siirtäminen ja koon muuttaminen
Siirrä tekstikehyksiä ja muuta niiden kokoa valintatyökalulla.

Jos haluat siirtää tekstikehyksiä tai muuttaa niiden kokoa vaihtamatta tekstityökalua  valintatyökaluun, vedä kehystä pitämällä Ctrl-näppäintä
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(Windows) tai komentonäppäintä (Mac OS) alhaalla.

Tekstikehyksen siirtäminen
Vedä kehystä valintatyökalulla.
Valitse tekstityökalu, pidä Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) alhaalla ja vedä kehystä. Tekstityökalu on vielä valittuna,
kun vapautat näppäimen.

Tekstikehyksen koon muuttaminen
 Tee jokin seuraavista toimista:

Jos haluat käyttää tekstityökalua , pidä Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) alhaalla ja vedä jotakin kehyksen
kahvaa. Jos pidät hiiren painiketta painettuna alhaalla sekunnin ajan, ennen kuin alat vetää, teksti rivittyy uudelleen, kun muutat kehyksen
kokoa.

Huomautus: jos napsautat tekstikehystä vetämisen sijaan, kadotat tekstivalinnan tai tekstikohdistimen.

Jos haluat käyttää valintatyökalua , vedä jotakin kehyksen reunassa olevaa kahvaa. Voit skaalata kehyksessä olevaa tekstiä pitämällä
alhaalla Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS). (Lisätietoja: Kirjasimen skaalaaminen.)

Jos haluat sovittaa kehyksen sisältöön nopeasti, valitse tekstikehys valintatyökalulla ja kaksoisnapsauta jotakin sen kahvaa. Jos esimerkiksi
kaksoisnapsautat alareunan keskellä olevaa kahvaa, kehyksen alareuna tarttuu tekstin alareunaan. Jos taas kaksoisnapsautat oikean reunan
keskimmäistä kahvaa, sisällön leveys sovitetaan kehyksen leveyden mukaiseksi muuttamatta korkeutta.

Kaksoisnapsauttamalla ylijuoksevan tekstikehyksen kahvaa voit muuttaa sisällön korkeammaksi tai leveämmäksi niin, että koko teksti
mahtuu kehykseen. Tekstikehyksen koko ei muutu, jos kehyksessä on enemmän ylijuoksevaa tekstiä kuin sivulle kohtuudella mahtuu.

Muuta tekstikehyksen kokoa kaksoisnapsauttamalla kahvaa.

Sovita tekstikehys sisältöön valitsemalla valintatyökalulla Objekti > Sovitus > Sovita kehys sisältöön. Tekstikehyksen alareuna sovitetaan
tekstisisällön mukaiseksi. Tekstikehyksen koko ei muutu, jos kehyksessä on enemmän ylijuoksevaa tekstiä kuin sivulle kohtuudella mahtuu.

Jos haluat muuttaa kehyksen kokoa käyttämällä skaalaustyökalua , vedä kehystä. (Lisätietoja: Kirjasimen skaalaaminen.)

Tekstikehysten käyttäminen sivupohjissa
Uudessa julkaisussa voi ottaa käyttöön Tekstikehyspohja-vaihtoehdon. Tällöin oletussivupohjaan lisätään tyhjä tekstikehys. Kehyksen palstan ja
reunusten asetukset ovat samat kuin Uusi julkaisu -valintaikkunassa.

Noudata seuraavia ohjeita, kun käytät tekstikehyksiä sivupohjissa:

Määritä tekstikehyspohja, jos haluat, että julkaisun kukin sivu sisältää sivunkokoisen tekstikehyksen, johon voi juoksuttaa tai kirjoittaa tekstiä.
Jos julkaisuun tarvitaan enemmän vaihtelua, kuten sivuja, joiden kehysten määrä vaihtelee, tai kehyksiä, joiden pituus vaihtelee, älä valitse
Tekstikehyspohja-asetusta, vaan luo tekstikehykset sivupohjiin tekstityökalulla.

Tekstikehyspohja-valinnasta riippumatta sivupohjaan voi lisätä tekstikehyksiä paikkamerkeiksi. Tyhjät paikkamerkkikehykset voi ketjuttaa.

Teksti juoksutetaan tekstikehyspohjiin samalla tavalla kuin julkaisun sivuilla oleviin kehyksiin.

Julkaisun sivulla olevaan tekstikehyspohjaan voi kirjoittaa tekstiä napsauttamalla kehystä ja painamalla Ctrl+vaihtonäppäimiä (Windows) tai
komento+vaihtonäppäimiä (Mac OS). Napsauta sitten kehystä tekstityökalulla ja kirjoita teksti.

Voit käyttää älykästä tekstin uudelleenjuoksutusta sivujen automaattiseen lisäämiseen ja poistamiseen tekstiä kirjoittaessasi tai muokatessasi.
Kun kirjoitat tekstiä sivupohjaan perustuvan ketjutetun tekstikehyksen loppuun, uusi sivu lisätään oletusarvoisesti. Voit jatkaa kirjoittamista
uuteen tekstikehykseen. Voit muokata älykkään tekstin uudelleenjuoksutuksen asetuksia.

Jos muutat sivun reunuksia, tekstikehykset mukautetaan uusiin reunuksiin vain, jos Salli sivuasettelun säätö -asetus on valittuna.

Tekstikehyspohja-asetus ei vaikuta uusien sivujen lisäämiseen automaattisen juoksuttamisen yhteydessä.
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AlkuunTekstikehyksen ominaisuuksien muuttaminen
Tekstikehyksen asetuksilla voi muokata esimerkiksi kehyksen palstojen lukumäärää, tekstin pystytasausta ja vieruksen leveyttä eli tekstin ja
kehyksen välistä etäisyyttä.

Ennen (vasen) ja jälkeen (oikea) sisennyksen määrittämistä ja kahden palstan luomista tekstikehykseen.

Jos tarvitset samoja tekstikehyksen ominaisuuksia useissa tekstikehyksissä, luo objektityyli, jota voit käyttää tekstikehyksissä.

1. Valitse kehys valintatyökalulla  tai valitse tekstikehys tai teksti tekstityökalulla .
2. Valitse Objekti > Tekstikehyksen asetukset tai pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) alhaalla ja kaksoisnapsauta

tekstikehystä valintatyökalulla.
3. Muuta tekstikehyksen asetuksia ja valitse OK.

Nämä tekstikehyksen asetukset ovat käytettävissä, kun määrität tekstiruutujen objektityyliä. Lisätietoja: Objektityylit.

Palstojen lisääminen tekstikehykseen
Voit luoda tekstikehykseen palstoja Tekstikehyksen asetukset -ikkunan vaihtoehtojen avulla.

Et voi luoda erilevyisiä palstoja tekstikehykseen. Jos haluat luoda erilevyisiä ja -korkeuksisia palstoja, lisää ketjutetut tekstikehykset sivuttain
julkaisun sivulle tai sivupohjaan.

1. Valitse kehys valintatyökalulla tai valitse tekstikehys tai teksti tekstityökalulla.
2. Valitse Objekti > Tekstikehyksen asetukset.
3. Määritä tekstikehyksen palstojen lukumäärä ja kunkin palstan leveys ja palstaväli.
4. (Valinnainen) Jos haluat säilyttää palstan leveyden samana kehyksen koon muuttuessa, valitse Kiinteä palstaleveys. Tällöin kehyksen koon

muuttaminen saattaa vaikuttaa palstojen määrään mutta ei leveyteen.

Kiinteä palstaleveys
A. Alkuperäinen 2-palstainen tekstikehys B. Kokoa muutettu, kun Kiinteä palstaleveys -asetus ei ole valittuna (yhä kaksi palstaa) C. Kokoa
muutettu, kun Kiinteä palstaleveys -asetus on valittuna (4 palstaa)

5. (Valinnainen) Valitse Tasapainota palstat, jos haluat tekstin olevan tasaista monipalstaisen tekstikehyksen alalaidassa.
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Ennen kuin tasapainotat palstat ja sen jälkeen

Tekstikehyksen vieruksen leveyden muuttaminen (reunukset)
1. Valitse kehys valintatyökalulla tai valitse tekstikehys tai teksti tekstityökalulla.
2. Valitse Objekti > Tekstikehyksen asetukset.
3. Määritä Yleiset-välilehden Vieruksen leveys -osiossa siirtymät ylös, alas, oikealle ja vasemmalle. (Käytä samaa leveyttä kaikille puolille

napsauttamalla Määritä kaikki asetukset samoiksi -kuvaketta .)

Jos valittu kuvio on muu kuin suorakulmio, siirtymiä (ylös, alas, oikealle ja vasemmalle) ei voi määrittää, mutta Vierus-toiminto on käytettävissä.

Ensimmäisen perusviivan siirtymäasetukset
Jos haluat muuttaa valitun tekstikehyksen ensimmäisen perusviivan asetuksia, valitse Objekti > Tekstikehyksen asetukset ja sitten Perusviivan
asetukset -välilehti. Siirtymä-valikon Ensimmäinen perusviiva -kohdassa on seuraavat asetukset:

Yläpidennys d-kirjaimen ylin kohta jää tekstikehyksen ylävieruksen alapuolelle.
Isojen kirjainten korkeus Isojen kirjainten yläreuna koskettaa tekstikehyksen ylävierusta.
Rivivälistys Ensimmäisen rivin peruslinjan ja kehyksen ylävieruksen välinen etäisyys määräytyy rivivälin mukaan.
X-korkeus x-kirjaimen ylin kohta jää kehyksen ylävieruksen alapuolelle.
Kiinteä Määritä ensimmäisen rivin peruslinjan ja kehyksen ylävieruksen välinen etäisyys manuaalisesti.
Väh Valitse peruslinjan minimisiirtymä. Esimerkki: Jos valittuna on Rivivälistys ja määrität minimiarvoksi 1p, InDesign käyttää vain rivivälistysarvoja,
jotka ovat yli 1picaa.

Jos haluat tekstikehyksen yläreunan tarttuvan ruudukkoon, valitse Rivivälistys tai Kiinteä, jotta voit määrittää tekstin ensimmäisen peruslinjan
sijainnin tekstikehyksissä.

Rivirekisterin määrittäminen tekstikehykseen
Voit joissakin tapauksissa haluta käyttää rivirekisteriä vain yhdessä kehyksessä koko julkaisun sijaan. Valitse Tekstikehyksen asetukset -
valintaikkuna, kun haluat käyttää rivirekisteriä tekstikehyksessä. Kun määrität tekstikehyksen rivirekisterin, ota huomioon seuraavat seikat:

Julkaisun rivirekisteri ei näy tekstikehysten takana tai edessä, jos kehykset käyttävät omia rivirekisterejä.

Jos Asetusten Ruudukot-osassa on valittu Ruudukot taustalla -asetus, kehyksiin perustuvia rivirekisterejä noudatetaan ennen julkaisuun
perustuvia rivirekisterejä. Jos Ruudukot taustalla -asetus ei ole valittuna, julkaisuun perustuvia rivirekisterejä noudatetaan ennen kehyksiin
perustuvia rivirekisterejä

1. Valitse Näytä > Ruudukot ja apuviivat > Näytä rivirekisteri, jos haluat näyttää kaikki rivirekisterit, mukaan lukien tekstikehyksissä olevat.
2. Valitse tekstikehys tai sijoita kohdistin tekstikehykseen. Valitse sitten Objekti > Tekstikehyksen asetukset.

Jos haluat käyttää rivirekisteriä ketjun kaikkiin kehyksiin (vaikka vähintään yksi ketjutettu ruudukko ei sisältäisi tekstiä), aseta kohdistin
tekstiin, valitse Muokkaa > Valitse kaikki ja käytä sitten rivirekisteriasetuksia Tekstikehyksen asetukset -ikkunan avulla.

3. Valitse Perusviivan asetukset -välilehti.
4. Valitse Rivirekisteri-kohdassa Käytä mukautettua rivirekisteriä ja tee jokin seuraavista toimista:

Alku Kirjoita arvo ruudukon siirtymälle sivun yläreunasta, sivun yläreunuksesta, kehyksen yläreunasta tai kehyksen ylävieruksesta
Suhteessa-valikossa tehtävien valintojen perusteella.

Suhteessa Määritä, haluatko rivirekisterin alkavan sivun yläreunasta, sivun yläreunuksesta, tekstikehyksen yläreunasta vai tekstikehyksen
ylävieruksesta.

Lisäysväli Kirjoita arvo ruudukon viivojen välille. Yleensä on kirjoitettava arvo, joka on sama kuin leipätekstin rivivälin arvo, jotta tekstirivit
voidaan kohdistaa ruudukkoon täydellisesti.

Väri Valitse ruudukon viivojen väri. Jos haluat käyttää samaa väriä kuin taso, jolla tekstikehys näkyy, valitse Tason väri.

Jos tekstikehyksessä ei näy rivirekisteriä, varmista valitsemalla Näytä > Ruudukot ja apuviivat > Näytä rivirekisteri, että niitä ei ole kätketty. Jos
rivirekisteriä ei vieläkään näy, tarkista rivirekisterien näyttökynnys Asetukset-valintaikkunan Ruudukot-osiosta. Sinun on ehkä lähennettävä
kehystä tai pienennettävä kynnyksen tasoa nähdäksesi ruudukon.
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Sana- ja merkkimäärien määrittäminen
1. Aseta kohdistin tekstikehykseen, jos haluat nähdä koko kehysketjun (jutun) tiedot, tai valitse teksti, jonka tiedot haluat nähdä.
2. Avaa Tieto-paneeli valitsemalla Ikkuna > Tietoja.

Tieto-paneeli näyttää tekstikehyksen merkkien, sanojen, rivien ja kappaleiden määrän. Esiin tulee myös kohdistimen sijainti tekstikehyksessä.

Lisäkielien käyttäminen
Voit määrittää erilaisten tekstien kielen. Oikean kielen määrittäminen tekstille on erityisen hyödyllistä oikoluvun ja tavutuksen kannalta. (Lisätietoja:
Tekstin kielen määrittäminen.)

Jos sinun täytyy käyttää aasialaista tekstiä, InDesignista on saatavana erityisversioita japanin, yksinkertaistetun kiinan, perinteisen kiinan ja korean
kielille. Näillä versioilla voit luoda sivuasetteluruudukkoja ja kehysruudukkoja monitavuisten merkkien käyttöä varten ja niissä on joukko
ominaisuuksia, joilla voi muokata monitavuisia merkkejä, sekä lisäkirjasimia.

InDesignista on vastaavasti saatavana erityisversio Lähi-idän kielille, kuten heprea, arabia, farsi ja urdu. Tässä versiossa käytetään oikealta
vasemmalle etenevää tekstimuotoilua. Tämän version nimi on InDesign ME.

Lisätietoja InDesign ME:n tai InDesignin aasialaisen kieliversion ostamisesta on Adoben WWW-sivustolla.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Kirjatiedoston luominen
Julkaisun lisääminen kirjatiedostoon
Kirjatiedostojen hallinta
Kirjan julkaisujen synkronoiminen
Kirjatiedostojen muuntaminen InDesignin aiemmista versioista
Kirjan sivujen, lukujen ja kappaleiden numeroiminen
Kirjatiedoston tulostaminen

Kirjatiedoston luominen
Kirjatiedosto on joukko julkaisuja, joilla voi olla yhteisiä tyylejä, värimalleja, sivupohjia ja muita kohteita. Kirjaksi yhdistettyjen julkaisujen sivut voi
numeroida. Kirjasta voi tulostaa valittuja julkaisuja, tai ne voi viedä PDF-muotoon. Yksi julkaisu voi kuulua useisiin kirjatiedostoihin.

Yksi kirjatiedoston julkaisuista toimii tyylilähteenä. Oletuksena on, että kirjan ensimmäinen julkaisu on tyylilähde. Tyylilähde voidaan tarvittaessa
vaihtaa. Kun kirjan julkaisut synkronoidaan, tyylilähteen tyylit ja värimallit korvaavat muiden julkaisujen vastaavat määritykset.

Michael Murphy on tehnyt video-opetusohjelman kirjojen luonnista. Se on osoitteessa Kirjojen perusteet.

1. Valitse Tiedosto > Uusi > Kirja.
2. Kirjoita kirjalle nimi, määritä sijainti ja valitse Tallenna.

Näyttöön tulee Kirja-paneeli. Tallennetun kirjatiedoston tiedostotunniste on .indb.

3. Lisää julkaisut kirjatiedostoon.

Julkaisun lisääminen kirjatiedostoon
Kun luot kirjatiedoston, se avautuu Kirja-paneelissa. Kirja-paneeli on kirjatiedoston työskentelyalue, jossa julkaisuja voi lisätä, poistaa ja järjestellä.

1. Valitse Kirja-paneelivalikosta Lisää julkaisu tai napsauta paneelin alaosassa olevaa +-painiketta .
2. Valitse lisättävät Adobe InDesign -julkaisut ja valitse sitten Avaa.

Voit vetää ja pudottaa tiedostoja Kirja-paneeliin Resurssienhallinnasta (Windows) tai Finderista (Mac OS). Voit myös vetää julkaisun
kirjasta toiseen. Kopioi julkaisu painamalla Alt-näppäintä (Windows) tai optionäppäintä (Mac OS).

3. Jos sisällytät kirjaan InDesignin aiemmissa versioissa luotuja julkaisuja, ohjelma muuntaa ne lisättäessä Adobe InDesign CS5 -muotoon.
Määritä Tallenna nimellä -valintaikkunassa uusi nimi muunnetulle julkaisulle (tai jätä nimi ennalleen) ja valitse sitten Tallenna.
Huomautus: Muunna Adobe PageMaker- ja QuarkXPress-julkaisut ennen kirjatiedostoon lisäämistä.

4. Muuta tarvittaessa julkaisujen järjestystä paneelissa vetämällä julkaisuja luettelossa ylös- tai alaspäin haluamaasi kohtaan.
5. Jos haluat määrittää julkaisun tyylilähteeksi, napsauta paneelissa julkaisun nimen vieressä olevaa ruutua.

Jos haluat avata julkaisun kirjatiedostossa, kaksoisnapsauta julkaisun nimeä Kirja-paneelissa.

Kirjatiedostojen hallinta
Avoimet kirjatiedostot näkyvät omissa välilehdissään Kirja-paneelissa. Jos samaan aikaan on avoinna useita kirjoja, voit tuoda jonkin kirjan eteen
ja avata sen paneelivalikon napsauttamalla kirjan välilehteä.

Julkaisun tila näkyy Kirja-paneelin kuvakkeista, ja se voi olla jokin esimerkiksi jokin seuraavista: avoinna , puuttuu  (julkaisu siirretty, nimetty
uudelleen tai poistettu), muokattu  (julkaisua on muokattu tai sen sivu- tai osionumeroita on muutettu kirjan ollessa suljettuna) tai käytössä 
(joku toinen on avannut julkaisun hallitussa työnkulussa). Suljetun julkaisun vieressä ei ole kuvaketta.

Jos haluat nähdä kirjassa olevan julkaisun hakemistonimen, pidä hiiriosoitinta julkaisun nimen päällä, kunnes näkyviin tulee työkaluvihje. Voit
vaihtoehtoisesti valita Kirja-paneelivalikosta vaihtoehdon Julkaisun tiedot.

Kirjatiedoston tallentaminen
Kirjatiedostot ovat erillään julkaisutiedostoista. Kun esimerkiksi valitset Tallenna kirja, InDesign tallentaa kirjaan tehdyt muutokset, ei julkaisuja.

 Tee jokin seuraavista:

Tallenna kirja uudella nimellä valitsemalla Kirja-paneelivalikosta Tallenna kirja nimellä, määritä sijainti sekä tiedostonimi ja valitse Tallenna.

Tallenna kirja samalla nimellä valitsemalla Kirja-paneelivalikosta Tallenna kirja tai napsauttamalla Kirja-paneelin alaosassa olevaa -painiketta 
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.

Huomautus: jos kirjatiedostot jaetaan palvelimen kautta, varmista, että käytössä on tiedostonhallintajärjestelmä, joka estää käyttäjiä tuhoamasta
toisten tekemiä muutoksia.

Kirjatiedoston sulkeminen
Sulje yksittäinen kirja valitsemalla kirjan paneelivalikosta Sulje kirja.
Sulje jonkin paneelin kaikki avoimet kirjat napsauttamalla Kirja-paneelin otsikkorivin Sulje-painiketta.

Kirjan julkaisujen poistaminen
1. Valitse korvattava julkaisu Kirja-paneelissa.
2. Valitse Kirja-paneelivalikosta Poista julkaisu.

Kun julkaisu poistetaan, sitä ei poisteta tietokoneesta, vaan ainoastaan kirjatiedostosta.

Kirjan julkaisujen korvaaminen
1. Valitse korvattava julkaisu Kirja-paneelissa.
2. Valitse Kirja-paneelivalikosta Korvaa julkaisu, etsi korvaava julkaisu ja valitse sitten Avaa.

Avaa kirjatiedosto Resurssienhallinnassa tai Finderissa

1. Valitse julkaisu Kirjat-paneelista.

2. Valitse Kirjat-paneelista Näytä Resurssienhallinnassa (Windows) tai Näytä Finderissa (Mac OS).

Valitun tiedoston näyttävä selainikkuna avautuu.

Kirjan julkaisujen synkronoiminen
Kun synkronoit kirjan julkaisut, ohjelma kopioi määritetyt tyylit, muuttujat, sivupohjat, lihotusoletusarvot, ristiviittausten muodot, ehdollisen tekstin
asetukset, numeroidut luettelot ja värimallit tyylilähteestä määritettyihin kirjan julkaisuihin, joissa ne korvaavat samannimiset kohteet.

Jos synkronoitavissa julkaisuissa ei ole valittuja kohteita, ohjelma lisää ne julkaisuihin. Ohjelma ei muuta sellaisia synkronoitavien julkaisujen
kohteita, jotka eivät kuulu tyylilähteeseen.

Voit katsoa kirjajulkaisujen synkronoimista käsittelevän videon osoitteessa www.adobe.com/go/vid0216_fi.

Synkronoitavien kohteiden valitseminen
1. Valitse Kirja-paneelivalikosta Synkronointiasetukset.
2. Valitse kohteet, jotka haluat kopioida tyylilähteestä muihin kirjan julkaisuihin.

Varmista, että olet valinnut kaikki muiden tyylien määrittelyyn sisältyvät tyylit. Esimerkiksi objektin tyyli voi sisältää kappale- ja merkkityylit,
jotka puolestaan sisältävät värimalleja.

3. Valitse Tyyliryhmien älykäs yhdistäminen, jos haluat välttää sellaisten ainutlaatuisesti nimettyjen tyylien kopioimisen, jotka on siirretty
tyyliryhmiin tai niistä pois.

Oletetaan, että tyylin lähteeseen sisältyy tyyliryhmään kuuluva merkkityyli ja synkronoitaviin julkaisuihin sisältyy sama merkkityyli, joka ei
kuulu tyyliryhmään. Jos tämä asetus on valittuna, merkkityyli siirretään synkronoiduissa julkaisuissa tyyliryhmään.

Jos tätä asetusta ei ole valittu, merkkityylin toinen esiintymä luodaan tyyliryhmään, jonka asetukset vastaavat tyylin lähdettä. Tyyliryhmän
ulkopuolinen merkkityyli ei muutu.

Huomautus: Jos julkaisu sisältää useita samannimisiä tyylejä (esimerkiksi Merkkityyli 1 tyyliryhmässä ja tyyliryhmän ulkopuolinen
Merkkityyli 1), InDesign toimii samoin kuin jos asetusta ei ole valittu. Ohjelma toimii parhaiten, jos luot tyyleille aina omat ainutlaatuiset nimet.

4. Valitse OK.

Kirjatiedoston julkaisujen synkronoiminen
Voit synkronoida kirjan, kun kirjan julkaisut ovat suljettuina. InDesign avaa suljetut julkaisut, tekee tarvittavat muutokset sekä tallentaa ja sulkee
julkaisut. Kun synkronoit kirjan, avoimet julkaisut muutetaan, mutta niitä ei tallenneta.

1. Napsauta Kirja-paneelissa tyylilähteeksi valittavan julkaisun nimen vieressä olevaa ruutua. Tyylilähde-kuvake  ilmaisee, mikä julkaisu on
valittu tyylilähteeksi.
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Valittu tyylilähde

2. Varmista, että tyylilähteestä kopioitavat kohteet on valittu Synkronointiasetukset-valintaikkunassa.
3. Valitse Kirja-paneelissa julkaisut, jotka haluat synkronoida tyylilähdejulkaisun kanssa. Jos yhtään julkaisua ei valita, ohjelma synkronoi koko

kirjan.
Jos haluat varmistaa, että yksikään julkaisu ei ole valittuna, napsauta julkaisujen alla olevaa harmaata aluetta. Vieritä Kirja-paneelia tai
muuta sen kokoa tarvittaessa. Voit myös pitää Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) alhaalla ja poistaa valitun
julkaisun napsauttamalla sitä.

4. Valitse Kirja-paneelivalikosta Synkronoi valitut julkaisut tai Synkronoi kirja. Vaihtoehtoisesti voit napsauttaa Kirja-paneelin alaosassa olevaa
Synkronoi-painiketta .

Huomautus: Muokkaa > Kumoa -komennon valitseminen kumoaa muutokset vain julkaisuista, jotka ovat auki synkronoinnin aikana.

Sivupohjien synkronoiminen
Sivupohjat synkronoidaan niin kuin muutkin kohteet: ohjelma korvaa sivupohjat, joilla on sama nimi (kuten A-sivupohja) kuin tyylilähteen
sivupohjilla. Sivupohjien synkronoimisesta on hyötyä julkaisuissa, joissa käytetään samoja muotoiluelementtejä, kuten juoksevia ylätunnisteita ja
alatunnisteita. Jos kuitenkin haluat säilyttää sivupohjakohteita muissa julkaisuissa kuin tyylilähteessä, älä synkronoi sivupohjia äläkä luo
muunnimisiä sivukohteita.

Ohjelma vapauttaa sivupohjasta sellaiset sivupohjakohteet, jotka ohitetaan julkaisun sivuilla, kun sivupohjat on synkronoitu ensimmäisen kerran.
Jos siis aiot synkronoida kirjan sivupohjat, kirjan kaikki julkaisut kannattaa synkronoida muotoilun aluksi. Tämä takaa sen, että ohitettujen
sivupohjakohteiden yhteys sivupohjaan säilyy ja että nämä kohteet edelleen päivittyvät tyylilähteen muokattujen sivupohjakohteiden perusteella.

Lisäksi sivupohjat kannattaa synkronoida vain yhden tyylilähteen avulla. Jos käytät eri tyylilähteitä, ohitetut sivupohjakohteet saattavat vapautua
sivupohjasta. Jos käytät synkronoinnissa eri tyylilähteitä, poista ennen sen aloittamista Sivupohjat-asetuksen valinta Synkronointisasetukset-
valintaikkunassa.

Kirjatiedostojen muuntaminen InDesignin aiemmista versioista
Voit muuntaa InDesignin aiemmassa versiossa luodun kirjatiedoston avaamalla ja tallentamalla sen InDesign CS5:ssä. Kun synkronoit, tulostat,
keräilet tai viet muunnetun kirjan tai päivität sen numeroinnin, ohjelma muuntaa myös kirjan sisältämät julkaisut InDesign CS5 -muotoon. Voit
valita, haluatko korvata vai säilyttää alkuperäiset julkaisutiedostot.

Kirjatiedostojen muuntaminen InDesign CS5 -ohjelman käyttöön
1. Valitse InDesign CS5:ssä Tiedosto > Avaa.
2. Valitse InDesignin aiemmassa versiossa luotu kirjatiedosto ja valitse sitten OK.

Ohjelma varoittaa, jos kirjatiedosto sisältää aiemmassa InDesign-muodossa tallennettuja julkaisuja.

3. Valitse Kirja-paneelivalikosta Tallenna kirja nimellä. Määritä muunnetulle kirjatiedostolle uusi nimi ja valitse Tallenna.

Kirjatiedoston julkaisujen muuntaminen
1. Avaa kirjatiedosto InDesign CS5 -ohjelmassa.
2. Valitse Kirja-paneelivalikosta haluamasi vaihtoehto:

Jos haluat korvata alkuperäiset julkaisut muuntamisen aikana, valitse Automaattinen julkaisun muunto.

Jos haluat säilyttää alkuperäiset julkaisut ja tallentaa muunnetut julkaisut uusilla nimillä, poista Automaattinen julkaisun muunto -
asetuksen valinta. (Kirjaluettelo päivittyy niin, että se sisältää muunnetut tiedostot, ei alkuperäisiä tiedostoja.)

3. Voit muuntaa julkaisut seuraavilla tavoilla:

Valitse Kirja-paneelivalikosta Synkronoi kirja. (Lisätietoja: Kirjan julkaisujen synkronoiminen.)

Valitse Kirja-paneelivalikosta Päivitä numerointi > Päivitä kaikki numerot.

4. Jos Automaattinen julkaisun muunto -asetusta ei ole valittu, InDesign kehottaa tallentamaan jokaisen muunnetun julkaisun uudella nimellä.

Huomautus: julkaisut muunnetaan myös silloin, kun tulostat tai viet kirjan Adobe PDF -muotoon.

Kirjan sivujen, lukujen ja kappaleiden numeroiminen
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Voit määrittää kirjan sivujen, lukujen ja kappaleiden numerointitavan. Kirjatiedoston sivujen ja lukujen numerointityylit ja aloitusnumerot määräytyvät
niiden kunkin julkaisun asetusten mukaan, jotka on määritetty Numerointi- ja osioasetukset- tai Julkaisun numerointiasetukset -valintaikkunassa.
Voit avata nämä valintaikkunat valitsemalla julkaisussa Sivuasettelu > Numerointi- ja osioasetukset tai valitsemalla Kirja-paneelivalikosta Julkaisun
numerointiasetukset.

Lisätietoja sivunumeroinnin lisäämisestä julkaisuun: Perussivunumeroinnin lisääminen.

Numeroitujen kappaleiden (kuten kuvaluettelojen) numerointi määräytyy kappaletyyliin sisältyvän numeroiden luettelon tyylimäärityksen mukaan.

Sivualue näkyy Kirja-paneelissa kunkin julkaisun vieressä. Oletusarvon mukaan InDesign päivittää sivu- ja osionumeroinnin Kirja-paneelissa, kun
lisäät tai poistat sivuja kirjaksi yhdistetyissä julkaisuissa tai kun teet muutoksia kirjatiedostoon. Niihin kuuluvat esimerkiksi julkaisujen järjestäminen
uudelleen, lisääminen ja poistaminen. Jos poistat sivu- ja osionumeroinnin automaattisen päivityksen käytöstä, voit päivittää kirjan numeroinnin
manuaalisesti.

Jos numerointi vaikuttaa kirjan päivityksen jälkeen virheelliseltä, vika saattaa olla siinä, että yleisasetuksissa on valittu näytettäväksi absoluuttinen
numerointi osionumeroinnin sijasta. Lisätietoja: Absoluuttisen tai osion numeroinnin näyttäminen Sivut-paneelissa.

Jos jokin julkaisu puuttuu tai jos sitä ei voi avata, julkaisun ja sen jälkeen tulevien julkaisujen sivualueen kohdalla näkyy kysymysmerkki, joka
ilmaisee, että sivualue on tuntematon. Poista tai korvaa puuttuva julkaisu ennen numeroinnin päivitystä. Jos näyttöön tulee Käytössä-kuvake ,
joku on avannut julkaisun hallitussa työnkulussa. Julkaisun numerointi voidaan päivittää vasta, kun toinen käyttäjä on sulkenut julkaisun.

Voit katsoa kirjan sivujen numerointia käsittelevän videon osoitteessa www.adobe.com/go/vid0217_fi.

Julkaisujen sivu- ja lukunumerointiasetusten muuttaminen
1. Valitse korvattava julkaisu Kirja-paneelissa.
2. Valitse Kirja-paneelivalikosta Julkaisun numerointiasetukset tai kaksoisnapsauta julkaisun sivunumeroja Kirja-paneelissa.
3. Määritä sivu-, osio- ja lukunumerointiasetukset. (Lisätietoja: Julkaisun numerointiasetukset.)
4. Valitse OK.

Huomautus: Jos määrität julkaisulle aloitussivun numeron etkä valitse Automaattinen sivunumerointi -asetusta, sivujen numerointi aloitetaan
määritetystä sivusta. Loput kirjan julkaisut numeroidaan uudelleen sen mukaan.

Sivunumeroinnin aloittaminen parittomista tai parillisista sivuista
Julkaisujen sivunumerointi voidaan aloittaa parittomista tai parillisista sivuista.

1. Valitse Kirja-paneelivalikosta Kirjan sivunumerointiasetukset.
2. Valitse Jatka seuraavalta parittomalta sivulta tai Jatka seuraavalta parilliselta sivulta.
3. Valitse Lisää tyhjä sivu, jos haluat, että julkaisun loppuun lisätään tarvittaessa tyhjä sivu. Valitse OK.

Kirjan automaattisen numeroinnin poistaminen käytöstä
1. Valitse Kirja-paneelivalikosta Kirjan sivunumerointiasetukset.
2. Poista Päivitä sivu- ja osionumerot automaattisesti -asetuksen valinta ja valitse sitten OK.
3. Jos haluat päivittää sivunumeroinnin manuaalisesti, valitse Kirja-paneelivalikosta Päivitä numerointi > Päivitä kaikki numerot.

Voit myös päivittää vain sivu- ja osionumerot tai vain luku- ja kappalenumerot.

Kirjojen peräkkäisen kappalenumeroinnin käyttäminen
Jos haluat käyttää peräkkäistä numerointia esimerkiksi kuvaluetteloissa tai taulukoissa, määritä ensin jossakin kappaletyylissä käytetty numeroitu
luettelo. Luettelo määrittää sen, noudattaako kappalenumerointi peräkkäistä numerointia kirjan julkaisujen kesken.

1. Avaa julkaisu, joka toimii kirjan tyylilähteenä.
2. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
3. Määritä uusi luettelo valitsemalla Uusi tai valitse luettelo ja valitse sitten Muokkaa.
4. Valitse sekä Jatka numerointia juttujen välillä että Jatka numerointia kirjan edellisestä julkaisusta.
5. Valitse OK.
6. Määritä numeroitua luetteloa käyttävä kappaletyyli ja käytä sitä niiden julkaisujen tekstiin, jotka sisältävät luettelon. (Lisätietoja: Kappaletyylin

luominen jatkuvia luetteloita varten.)

Valitse Synkronointiasetukset-valintaikkunassa Kappaletyylit- ja Numeroidut luettelot -vaihtoehdot ja synkronoi kirja. Näin varmistat, että sama
numeroidun luettelon asetus on käytössä kirjan kaikissa julkaisuissa.

Kirjatiedoston tulostaminen
Eräs kirjatiedoston eduista on, että valitut julkaisut tai koko kirja voidaan julkaista (tulostaa, esitarkastaa, keräillä tai viedä EPUB- tai PDF-muotoon)
yhdellä komennolla.

1. Tee Kirja-paneelissa jokin seuraavista toimista:
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Tulosta tietyt julkaisut valitsemalla haluamasi julkaisut.

Tulosta koko kirja poistamalla kaikkien julkaisujen valinnat.

2. Valitse Kirja-paneelivalikosta tulostuskomento (kuten Tulosta kirja tai Tulosta valitut julkaisut).

Lisää ohjeaiheita
Kirjajulkaisujen synkronoimista käsittelevä video

Sivutuksen määrittämistä käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Sisällysluettelon luominen

Alkuun

Alkuun

Tietoja sisällysluetteloista
Kirjan sisällysluettelon luominen
Sisällysluettelon luominen
Sisällysluettelotyylien luominen useille luetteloille
Sisällysluettelon muotoiluasetukset
Sarkaimen täytemerkkejä käyttävien sisällysluettelon viitteiden luominen
Sarkaimen täytemerkillä varustetun kappaletyylin luominen
Sisällysluettelon päivittäminen ja muokkaaminen

Tietoja sisällysluetteloista

Sisällysluettelossa voi olla kirjan, lehden tai muun julkaisun sisältö tai kuvien, mainostajien tai valokuvaajien luettelo. Sisällysluettelo voi sisältää
myös muita tietoja, jotka auttavat lukijaa löytämään tietoja julkaisusta tai kirjatiedostosta. Yhdellä julkaisulla voi olla useita sisällysluetteloita,
esimerkiksi kappaleiden ja kuvien luettelot.

Jokainen sisällysluettelo on erillinen juttu, joka sisältää otsikon ja joko sivunumeron tai aakkosten mukaan järjestetyn luettelon. Viitteet, myös
sivunumerot, otetaan suoraan julkaisun sisällöstä ja voidaan päivittää koska tahansa – jopa kirjatiedoston useiden julkaisujen välillä.

Sisällysluettelon luominen koostuu kolmesta vaiheesta. Ensiksi luo ja ota käyttöön kappaletyylit, joita käytät sisällysluettelon pohjana. Toiseksi
määritä sisällysluettelossa käytettävät tyylit ja sisällysluettelon muotoilu. Kolmanneksi juoksuta sisällysluettelo julkaisuun.

Sisällysluettelon viitteet voi lisätä automaattisesti Kirjanmerkit-paneeliin, jotta niitä voi käyttää Adobe PDF -muotoon viedyissä julkaisuissa.

Sisällysluettelon suunnitteluun liittyviä vihjeitä

Ota sisällysluettelon suunnittelussa huomioon seuraavat seikat:

Jotkin sisällysluettelot (esimerkiksi lehden mainostajien luettelo) on tehty sisällöstä, joka ei näy julkaistussa asiakirjassa. Jotta tämän voi
tehdä InDesignissa, kirjoita sisältö kätketylle tasolle ja ota se mukaan sisällysluetteloon.

Voit ladata sisällysluettelotyylejä muista julkaisuista tai kirjoista ja rakentaa uusia sisällysluetteloita, joissa on samat asetukset ja muotoilu.
(Saatat joutua muokkaamaan tuotua sisällysluettelotyyliä, jos julkaisun kappaletyylien nimet eivät vastaa lähdejulkaisun kappaletyylien nimiä.)

Voit luoda kappaletyylejä sisällysluetteloiden otsikoille ja viitteille sekä tarvittaessa myös sarkaimille. Tämän jälkeen voit käyttää näitä
kappaletyylejä, kun luot sisällysluetteloa.

Voit luoda merkkityylejä sivunumeroiden ja merkkien muotoiluun, jotta ne erottuisivat viitteistä. Jos sivunumerot halutaan lihavoida, luodaan
merkkityyli, johon sisältyy lihavointi. Tämä merkkityyli valitaan sisällysluetteloa luotaessa.

Kirjan sisällysluettelon luominen

Jotta tulos olisi paras mahdollinen, toimi seuraavasti ennen kuin luot kirjan sisällysluettelon:

Varmista ennen sisällysluettelon luomista, että kirjan julkaisuluettelo on täydellinen, julkaisujen järjestys on oikea ja otsikoissa on käytetty
oikeita kappaletyylejä.

Varmista, että käytät samoja kappaletyylejä johdonmukaisesti koko kirjassa. Älä käytä tyylejä, joilla on sama nimi mutta eri määritykset. Jos
useilla tyyleillä on sama nimi mutta eri määritykset, InDesign käyttää nykyisen julkaisun tyylimäärityksiä (jos ne on valittu) tai tyylin
ensimmäistä esiintymää kirjassa.

Jos tarvittavat tyylit eivät näy Sisällysluettelo-valintaikkunan valikoissa, kirja on ehkä synkronoitava, jotta tyylit kopioituvat sisällysluettelon
julkaisuun.
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Alkuun

Huomautus:

Alkuun

Jos haluat, että sisällysluettelossa näkyy numeroetuliitteitä (kuten 1-1, 1-3 ja niin edelleen), käytä osion numerointia kappalenumeroinnin
sijaan. Osion numeroinnin etuliitteet voidaan sisällyttää sisällysluetteloon.

Sisällysluettelon luominen

Päätä ennen sisällysluettelon luontia, mitkä kappaleet (kuten lukujen ja osien otsikot) otetaan mukaan, ja määritä sitten niiden kappaletyylit.
Varmista, että tyylejä käytetään kaikissa tarvittavissa julkaisun tai julkaisujen kohdissa.

Kun luot sisällysluettelon, voit muotoilla sen myös kappale- ja merkkityylien avulla.

Sisällysluettelo ilman kappaletyylejä (vasen) ja viitteet, joissa on käytetty kappaletyylejä (oikea)

Jos sisällysluetteloon sisällytettäviä kappaleita esiintyy eri jutuissa samalla sivulla, niiden järjestyksen sisällysluettelossa määrää niiden sijainti
sivulla.

1. Tee jokin seuraavista:

Jos luot sisällysluettelon yhtä julkaisua varten, julkaisun alkuun on ehkä lisättävä sivu.

Jos luot sisällysluetteloa useita kirjaksi koottuja julkaisuja varten, luo tai avaa sisällysluettelon julkaisu, varmista, että se sisältyy kirjaan,
ja avaa sitten kirjatiedosto.

2. Valitse Sivuasettelu > Sisällysluettelo.

Jos olet jo määrittänyt sisällysluettelotyylin, jonka asetukset sopivat luotavaan sisällysluetteloon, voit valita tyylin Sisällysluettelotyyli-valikosta.

3. Kirjoita Otsikko-ruutuun sisällysluettelon nimi (kuten Sisältö tai Kuvat). Kirjoittamasi nimi tulee näkyviin sisällysluettelon alkuun. Muotoile
otsikkoa valitsemalla tyyli Tyyli-valikosta.

4. Valitse Sisällytä kirjan julkaisut, jos haluat luoda yhden sisällysluettelon kaikista kirjan julkaisuluettelon julkaisuista ja numeroida kirjan sivut
uudelleen. Poista valinta, jos haluat luoda sisällysluettelon vain nykyisestä julkaisusta. (Tämä asetus ei ole käytettävissä, jos nykyinen
julkaisu ei ole kirjatiedoston osa.)

5. Määritä sisällysluettelon sisältö lisäämällä haluamasi kappaletyylit Sisällytä kappaletyylit -luetteloon kaksoisnapsauttamalla niitä Muut tyylit -
luettelossa.

6. Voit korvata kaikki julkaisun olemassa olevat juttujen sisällysluettelot valitsemalla Korvaa nykyinen sisällysluettelo. Poista tämän asetuksen
valinta, jos haluat luoda uuden sisällysluettelon, esimerkiksi kuvaluettelon.

7. Määritä asetusten avulla, miten sisällysluettelon kappaletyylit muotoillaan.

Kannattaa luoda sisällysluettelon muotoilun ja muut asetukset sisältävä sisällysluettelotyyli, etenkin jos julkaisussa on tarkoitus käyttää
useita sisällysluetteloita. Valitse tätä varten Tallenna tyyli. Voit luoda sisällysluettelotyylejä myös valitsemalla vaihtoehdon Sivuasettelu >
Sisällysluettelotyylit.

8. Napsauta OK-painiketta.

Näyttöön tulee ladatun tekstin kohdistin . Voit ennen napsauttamista tai vetämistä siirtyä toiselle sivulle tai luoda uuden sivun
menettämättä ladattua tekstiä.

9. Napsauta ladatun tekstin kohdistinta tai vedä se sivulle, jolle haluat sijoittaa uuden sisällysluettelojutun.

Sisällysluettelon kehystä ei kannata ketjuttaa julkaisun muihin tekstikehyksiin. Kun sisällysluettelo korvataan, koko juttu korvautuu
päivitetyllä sisällysluettelolla.

Sisällysluettelotyylien luominen useille luetteloille
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Huomautus:

Huomautus:

Alkuun

Huomautus:

Kohteen tyyli

Sivunumero

Käytä sisällysluettelotyylejä, jos sinun täytyy luoda useita erilaisia sisällysluetteloja julkaisuun tai kirjaan. Voit esimerkiksi käyttää yhtä
sisällysluettelotyyliä sisällysluettelossa ja toista tyyliä mainostajien, kuvien tai valokuvatietojen luettelossa. Luo oma sisällysluettelotyyli jokaiselle
luettelotyypille.

Sisällysluettelotyylien luominen on myös hyödyllistä, jos haluat käyttää samaa sisällysluettelomuotoilua jossakin toisessa julkaisussa.

Älä sekoita sisällysluettelotyylejä sisällysluettelon kappaletyyleihin. Sisällysluettelon kappaletyylejä (kuten sisällysluettelon otsikkoa)
käytetään sisällysluetteloviitteiden muotoiluun. Sisällysluettelotyyli puolestaan on joukko asetuksia, joilla sisällysluettelo luodaan automaattisesti.

Sisällysluettelotyylin luominen

1. Valitse Sivuasettelu > Sisällysluettelon tyylit.

2. Valitse Uusi.

3. Kirjoita luotavan sisällysluettelotyylin nimi.

4. Kirjoita Otsikko-ruutuun sisällysluettelon nimi (kuten Sisältö tai Kuvat). Kirjoittamasi nimi tulee näkyviin sisällysluettelon alkuun. Määritä
otsikon tyyli valitsemalla tyyli Tyyli-valikosta.

5. Valitse Muut tyylit -luettelosta kappaletyylit, jotka haluat sisällyttää sisällysluetteloon. Lisää ne Sisällytä kappaletyylit -luetteloon valitsemalla
Lisää.

6. Määritä kappaletyylien muotoiluasetukset.

Sisällysluettelotyylien tuominen toisesta julkaisusta

1. Valitse Sivuasettelu > Sisällysluettelon tyylit.

2. Valitse ensin Lataa, sitten kopioitavat sisällysluettelotyylit sisältävä InDesign-tiedosto ja lopuksi Avaa.

3. Napsauta OK-painiketta.

jos julkaisun kappaletyylit eivät vastaa tuotuja sisällysluettelon kappaletyylejä, sisällysluettelotyylejä on muokattava ennen
sisällysluettelon luomista.

Sisällysluettelon muotoiluasetukset

Näiden asetusten avulla voit sisällysluetteloa luodessasi tai muokatessasi määrittää luodun sisällysluettelon tekstin ulkoasun. Osa näistä
asetuksista on käytettävissä vain silloin, kun valintaikkunasta valitaan Lisää asetuksia.

Tyyli-osan asetukset koskevat vain nykyistä Sisällytä kappaletyylit -kohdassa valittua tyyliä. Voit määrittää eri muotoiluasetuksia
jokaiselle tyylille.

Valitse kappaletyyli, jolla ohjelma muotoilee Sisällytä kappaletyylit -kohdan tyyleillä merkityt sisällysluetteloviitteet.

Sivunumeroa varten tarvitaan ehkä merkkityyli. Voit valita tyylin sivunumeron oikealla puolella olevasta Tyyli-valikosta. (Katso
Kappale- ja merkkityylien lisääminen.)
Jos haluat liittää sisällysluettelon sivunumeroihin etuliitteet tai käyttää eri numerointitapaa, katso lisätietoja kohdasta Osion numeroinnin
määrittäminen.

Kohteen ja numeron välillä Määritä, mitä merkkejä käytetään sisällysluettelon viitteen ja sivunumeron välillä. Oletuksena on ^t, joka kehottaa
InDesignia lisäämään sarkaimen. Voit valita valikosta muita erikoismerkkejä, kuten oikealle tasatun sarkaimen tai em-välin.

Valitse ruudussa oleva teksti ennen toisen erikoismerkin valitsemista, jotta et valitse molempia merkkejä.

Kun sisällysluettelon viitteen ja sivunumeron välistä tilaa muotoillaan, saatetaan tarvita merkkityyli. Valitse tyyli Kohteen ja numeron välillä -kohdan
oikealla puolella olevasta Tyyli-valikosta. (Katso Kappale- ja merkkityylien lisääminen.)
Jos kohdan kappaletyyli sisältää täytemerkkiasetuksen ja sarkainmerkki (^t) on valittuna, täytemerkki näkyy muodostetussa sisällysluettelossa.
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Lajittele viitteet aakkosjärjestyksessä

Huomautus:

Taso

PDF-kirjanmerkkien luominen

Jatkuva

Sisällytä teksti kätkettyihin tasoihin

Numeroidut kappaleet

Kehyssuunta

Alkuun

Voit määrittää sisällysluettelon viitteen ja sivunumeron erottavan merkin ja merkin tyylin.

Valitse tämä asetus, jos haluat lajitella valitun tyylin sisällysluetteloviitteet aakkosjärjestykseen. Käytä
asetusta luodessasi yksinkertaisia luetteloita, kuten mainostajaluetteloa. Sisäkkäiset viitteet (taso 2 tai 3) lajitellaan aakkosjärjestykseen ryhmien
sisällä (taso 1 tai 2).

Sisällysluettelon lajittelujärjestys määräytyy julkaisun oletuskieliasetuksen mukaan. Jos haluat muuttaa oletuskieliasetusta, varmista,
että mitään ei ole valittuna ja valitse sitten kieli Merkki-paneelin Kieli-valikosta.

Oletuksena on, että kukin Sisällytä kappaletyylit -ruutuun lisätty kohta lisätään yhtä tasoa alemmas kuin edellinen kohta. Voit poistaa tämän
hierarkian määrittämällä uuden tasonumeron valitulle kappaletyylille. Tämä valinta säätää vain valintaikkunan näkymää. Se ei vaikuta lopulliseen
sisällysluetteloon, jos luetteloa ei järjestetä aakkosjärjestykseen. Tällöin kirjaukset järjestetään tason mukaan.

Valitse tämä asetus, jos haluat sisällysluettelon viitteiden näkyvät Adobe Acrobat- tai Adobe Reader® -ikkunan
Kirjanmerkit-paneelissa, kun julkaisu viedään PDF-tiedostoon.

Valitse tämä asetus, jos haluat sisällyttää kaikki sisällysluettelon viitteet yhteen kappaleeseen. Kohtia erottavat puolipiste ja välilyönti.

Valitse tämä asetus vain, jos haluat lisätä sisällysluetteloon kätketyillä tasoilla olevat kappaleet. Tämä on
käytännöllistä, kun luodaan mainostajien luettelo, joka ei välttämättä esiinny näkyvänä tekstinä itse julkaisussa. Poista valinta, jos olet käyttänyt
tasoja saman tekstin eri versioiden tai käännösten säilyttämiseen.

Jos sisällysluettelossa on numerointia käyttävä kappaletyyli, määritä, sisältääkö sisällysluettelon viite koko kappaleen
(numerot ja tekstin), vain numerot vai vain kappaleen.

Määritä sisällysluettelon luomiseen käytettävän tekstikehyksen kirjoitussuunta.

Sarkaimen täytemerkkejä käyttävien sisällysluettelon viitteiden luominen

Sisällysluettelon viitteet on usein muotoiltu pisteillä tai sarkaimen täytemerkeillä, jotka erottavat viitteen ja siihen liittyvän sivunumeron.

Pistetäytemerkeillä varustettu sisällysluettelo
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Alkuun

Alkuun

1. Sarkaimen täytemerkillä varustetun kappaletyylin luominen.

2. Päivitä sisällysluettelon asetukset jommallakummalla tavalla:

Valitse Sivuasettelu > Sisällysluettelon tyylit. Valitse ensin sisällysluettelon tyyli ja sitten Muokkaa.

Valitse Sivuasettelu > Sisällysluettelo (jos et käytä sisällysluettelotyyliä).

3. Valitse Sisällytä kappaletyylit -kohdassa kohde, jonka haluat näkyvän sarkaimen täytemerkin kanssa sisällysluettelossa.

4. Valitse Kohteen tyyli -kohdassa kappaletyyli, joka sisältää sarkaimen täytemerkin.

5. Valitse Lisää asetuksia.

6. Varmista, että Kohteen ja numeron välillä -asetukseksi on määritetty ^t (tarkoittaa sarkainta). Poistu valitsemalla OK tai Tallenna.

7. Päivitä tarvittaessa sisällysluettelo valitsemalla Asettelu > Päivitä sisällysluettelo. Muussa tapauksessa käytä uutta sisällysluettelojuttua.

Sarkaimen täytemerkillä varustetun kappaletyylin luominen

1. Avaa Kappaletyylit-paneeli valitsemalla Ikkuna > Tyylit > Kappaletyylit.

2. Tee Kappaletyylit-paneelissa jompikumpi seuraavista toimista:

Kaksoisnapsauta sisällysluettelon viitteissä käytettyjen kappaletyylien nimeä.

Valitse paneelivalikosta Uusi kappaletyyli.

3. Kirjoita kappaletyylille tarvittaessa nimi.

4. Valitse Sarkaimet.

5. Valitse oikealle tasaava sarkain  ja määritä sitten sarkaimen paikka napsauttamalla viivainta.

Jos käytät tyyliä kappaleissa, jotka sisältävät numeroitujen luetteloiden kohteita, varmista, että sisällytät mukaan kaksi sarkainasetusta:
sisennetyn numeron asetuksen ja täytemerkin asetuksen.

6. Kirjoita täytemerkiksi piste (.).

7. Valitse muut haluamasi tyyliasetukset ja valitse OK.

Sisällysluettelon päivittäminen ja muokkaaminen

Sisällysluettelo on kuin tilannekuva julkaisun sisällöstä. Jos julkaisun sivunumerot muuttuvat, tai jos muokkaat otsikoita tai muita sisällysluetteloon
liittyviä osia, sisällysluettelo on päivitettävä luomalla se uudelleen.

Sisällysluettelon päivittäminen

1. Avaa julkaisu, joka sisältää sisällysluettelon.

2. Tee jokin seuraavista toimista:

Tee muutoksia sisällysluetteloviitteisiin muokkaamalla julkaisua tai kirjan julkaisuja, ei itse jutun sisällysluetteloa.

Muuta sisällysluettelon otsikon, viitteiden tai sivunumeroiden muotoilua muokkaamalla niihin liittyviä kappale- tai merkkityylejä.

Muuta sivujen numerointia (esimerkiksi 1, 2, 3 tai i, ii, iii), muuttamalla julkaisun tai kirjan osan numerointia. (Katso Kirjan sivujen, lukujen
ja kappaleiden numerointi.)

Määritä uusi otsikko sisällyttämällä muut kappaletyylit sisällysluetteloon tai muotoile edelleen sisällysluettelon viitteitä ja muokkaa
sisällysluettelotyylejä.

3. Sijoita lisäyskohta tekstikehykseen, joka sisältää sisällysluettelon, tai valitse se, ja valitse sitten Sivuasettelu > Päivitä sisällysluettelo.

4. Jos julkaisussasi on useita sisällysluetteloja, kuten kuvaluetteloita ja mainostajaluetteloita, valitse luettelon sisältävä tekstikehys ja valitse
sitten Sivuasettelu > Päivitä sisällysluettelo.
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Sisällysluettelon muokkaaminen

Jos sisällysluetteloa on muokattava, muokkaa julkaisun kappaleita, älä sisällysluetteloa. Luo sisällysluettelo sitten uudelleen. Jos sisällysluetteloa
muokataan suoraan, muutokset menetetään, kun sisällysluettelo luodaan uudelleen. Muokkaa samoin mieluummin sisällysluettelon tyylejä sen
sijaan, että muuttaisit sisällysluettelon muotoiluja suoraan.

Lisää ohjeaiheita
Sisällysluettelon luomista käsittelevä video
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Julkaisujen luominen

Alkuun

Reunukset

Palstat

Leikkausvara

Informaatioalue

Esikatselutausta

Alkuun

Taittopöydän ja apuviivojen mukauttaminen
Julkaisun asetusten, reunusten ja palstojen muuttaminen

Taittopöydän ja apuviivojen mukauttaminen

Voit valita, minkä värisinä sivun reunusten ja palstojen apuviivat sekä leikkausvara- ja informaatioalueiden apuviivat näkyvät taittopöydällä. Voit
vaihtaa esikatselutaustan väriä, jotta normaalin näyttötilan ja esikatselutilan erottaa helpommin toisistaan.

InDesignissa voit myös määrittää, miten lähellä apuviivaa objektin on oltava, ennen kuin se tasautuu, ja näkyvätkö apuviivat objekteiden edessä
vai takana. Lisäksi voit muokata taittopöydän kokoa.

1. Valitse Muokkaa > Asetukset > Apuviivat ja taittopöytä (Windows) tai InDesign > Asetukset > Apuviivat ja taittopöytä (Mac OS).

2. Valitse Väri-kohdassa haluamasi värit jokaisesta seuraavasta valikosta tai valitse Mukautettu ja määritä väri värinvalitsimella.

Määrittää sivujen reunusten värin.

Määrittää sivun palstojen apuviivojen värin.

MäärittääJulkaisun asetukset -ikkunassa määritettävän leikkausvara-alueen värin.

MäärittääJulkaisun asetukset -ikkunassa määritettävän informaatioalueen värin.

Määrittää esikatselutilassa käytettävän taittopöydän värin.

3. Kirjoittamalla arvon pikseleinä Tarttumisalue-kohtaan voit määrittää, miten lähellä apuviivaa tai ruudukkoa objektin on oltava, ennen kuin se
tasautuu.

4. Jos haluat näyttää apuviivat objektien takana, valitse Apuviivat taustalla.

5. Kirjoittamalla arvot Vaakasuuntaiset marginaalit- ja Pystysuuntaiset marginaalit -kohtiin voit määrittää, miten paljon sivun tai aukeaman (tai
mahdollisesti määritettyjen leikkausvara- ja informaatioalueiden) ulkopuolelle taittopöytä ulottuu.

6. Sulje Asetukset-valintaikkuna valitsemalla OK.

Voit muuttaa näytössä näkyvän paperin väriä. Kaksoisnapsauta Värimallit-paneelin (Ikkuna > Värimallit) Paperin väri -painiketta, kun tekstiä tai
objekteja ei ole valittu. Väri näkyy vain näytössä, eikä se vaikuta tulostukseen. Väri havainnollistaa suunnittelua muunväriselle kuin valkoiselle
paperille.

Julkaisun asetusten, reunusten ja palstojen muuttaminen

Kun olet luonut julkaisun, haluat ehkä muuttaa sen asetuksia. Haluatkin esimerkiksi käyttää yksittäisiä sivuja aukeamien sijaan tai muuttaa
sivukokoa tai reunusten asetuksia.

Julkaisun asetusten muuttaminen

216



Huomautus:

Reunukset

Palstat

Huomautus:

Asetusten muuttaminen Julkaisun asetukset -ikkunassa vaikuttaa julkaisun kaikkiin sivuihin. Jos muutat sivukokoa tai suuntaa sen jälkeen, kun olet
lisännyt sivuille objekteja, voit vähentää objektien uudelleenryhmittelyaikaa käyttämällä Sivuasettelun säätöä. Katso Tietoja automaattisesta
sivuasettelun säädöstä.

1. Valitse Tiedosto > Julkaisun asetukset.

2. Määritä julkaisun asetukset ja valitse OK. (Katso Uuden julkaisun asetukset.)

Sivun reunus- ja palsta-asetusten muuttaminen

Voit muuttaa sivujen tai aukeamien reunusten ja palstojen asetuksia. Kun muutat palstojen ja sivun reunusten asetuksia sivupohjassa, asetukset
muuttuvat kaikissa sivupohjaan perustuvissa sivuissa. Palstojen ja sivun reunusten muuttaminen tavallisissa sivuissa vaikuttaa vain sivuihin, jotka
on valittu Sivut-paneelista.

Reunukset ja palstat -valintaikkuna ei muuta tekstikehysten sisällä olevia palstoja. Tekstikehyspalstoja on vain yksittäisissä
tekstikehyksissä, ei varsinaisella sivulla. Voit määrittää yksittäisten tekstikehysten palsta-asetukset Tekstikehyksen asetukset -valintaikkunassa.
(Katso Palstojen lisääminen tekstikehykseen.) Myös Sivuasettelun säätö -toiminto voi vaikuttaa tekstikehyspalstoihin.

1. Tee jokin seuraavista:

Jos haluat muuttaa yhden aukeaman tai sivun reunus- ja palsta-asetuksia, siirry aukeamalle, jota haluat muuttaa, tai valitse sivu tai
aukeama Sivut-paneelista.

Jos haluat muuttaa useiden sivujen reunus- ja palsta-asetuksia, valitse sivut Sivut-paneelista tai valitse sivupohja, johon muutettavat
sivut perustuvat.

2. Valitse Sivuasettelu > Reunukset ja palstat, määritä seuraavat asetukset ja valitse OK.

Kirjoita arvot, jotka määrittävät reunusten apuviivojen etäisyyden sivun reunoista. Jos Uusi julkaisu- tai Julkaisun asetukset -
valintaikkunassa on valittu Vastakkaiset sivut, Vasen reunus- ja Oikea reunus -asetukset muuttuvat Sisäreunus- ja Ulkoreunus-asetuksiksi.
Tämän jälkeen voit määrittää suuremman sisäreunuksen sidontaa varten.

Määritä palstojen määrä.

Määritä sarakkeen suunnaksi Vaakasuuntainen tai Pystysuuntainen. Tämä määrittää myös julkaisun rivirekisterin kirjoitussuunnan.

Erilevyisten palstojen luominen

Jos sivulla on useampi kuin yksi palsta, sivun keskellä olevia palstojen ohjausviivoja on aina parillinen määrä. Jos siirrät yhtä palsta-apuviivaa,
molemmat viivat siirtyvät. Palsta-apuviivojen välissä olevan tilan määrää Palstaväli-kohdassa määrittämäsi arvo. Molemmat apuviivat liikkuvat
yhdessä, jotta määritetty väli säilyisi.

Et voi luoda erilevyisiä palstoja tekstikehykseen. Luo sen sijaan ketjutettuja vierekkäisiä tekstikehyksiä, joilla on eri palstaleveys.

1. Siirry sivupohjaan tai aukeamalle, jota haluat muuttaa.

2. Jos palstan apuviivat on lukittu, poista asetuksen valinta valitsemalla Näytä > Ruudukot ja apuviivat > Lukitse palsta-apuviivat.

3. Vedä palstan apuviivaa valintatyökalulla . Et voi siirtää sitä viereisen palstan apuviivan tai sivun reunan ylitse.

Erilevyisten palstojen luominen palstan apuviivaa siirtämällä

Jos haluat luoda palstoja, joilla on erisuuruiset välit, luo tasaväliset viivainlinjat ja siirrä yksittäiset apuviivat haluamaasi paikkaan. (Katso
Viivaohjainten luominen.)
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Rajaavat reitit

Alkuun

Alkuun

Rajaavat reitit
Rajaaminen kuvan reittiä tai alfakanavaa käyttäen
Rajaavan reitin luominen automaattisesti
Rajaavan reitin asetukset
Rajaavan reitin muuntaminen grafiikkakehykseksi

Rajaavat reitit
Rajaavilla reiteillä rajataan kuvaa siten, että vain osa kuvasta näkyy luotujen muotojen lomasta. Voit kätkeä rajaavien reittien avulla haluamasi
kuvan osat luoden samalla kuvalle niin reitin kuin kehyksenkin. Kun pidät rajaavan reitin ja grafiikkakehyksen erillään toisistaan, voit
suoravalintatyökalun ja muiden piirtotyökalujen avulla muokata rajaavaa reittiä vapaasti grafiikkakehystä muuttamatta.

Voit luoda rajaavia reittejä seuraavasti:

Sijoita kuvia, joissa jo on reittejä tai alfakanavia (peitteitä). InDesign käyttää niitä automaattisesti. Lisää reittejä ja alfakanavia kuviin
Photoshopin tai muun vastaavan ohjelman avulla.

Rajaava reitti -valintaikkunan Tunnista reunat -asetuksen avulla voit luoda rajaavan reitin kuvalle, jolla sellaista ei ole.

Voit piirtää kynätyökalulla haluamasi muotoisen reitin, johon voit sitten liittää kuvan valitsemalla Liitä kohteeseen.

Kun luot rajaavan reitin jollakin InDesignin automaattisista menetelmistä, kuvaan liitetään rajaava reitti, jolloin kuvaa leikkaa reitti ja rajaa kehys.

Huomautus: Grafiikkakehyksessä näkyy sen tason väri, jolla kehys sijaitsee. Rajaava reitti piirretään tason vastavärillä. Jos tason väri on sininen,
grafiikkakehys on sininen ja rajaava reitti oranssi.

Rajaaminen kuvan reittiä tai alfakanavaa käyttäen
InDesign voi rajata tuodun EPS-, TIFF- tai Photoshop-kuvan käyttämällä tiedostoon tallennettua rajaavaa reittiä tai alfakanavaa. Jos tuotu kuva
sisältää useita reittejä tai alfakanavia, voit valita, mitä niistä käytetään rajaavassa reitissä.

Alfakanava on näkymätön kanava, joka määrittää kuvan läpinäkyvät alueet. Se on tallennettu kuvaan RGB- tai CMYK-kanavien kanssa.
Alfakanavia käytetään usein videotehostesovelluksissa. InDesign tunnistaa automaattisesti Photoshopin oletusläpinäkyvyyden (shakkilautatausta)
alfakanavaksi. Jos kuvassa on läpinäkymätön tausta, sinun on poistettava se tai luotava ja tallennettava vähintään yksi alfakanava Photoshopilla.
Voit luoda alfakanavia Adobe Photoshopin taustan poistotoiminnoilla, kuten tasopeitteillä, Kanava-välilehden avulla, taustanpoistotyökalulla ja
pyyhekumilla.

Alfakanavien ja upotettujen reittien käytön tulokset
A. Alkuperäinen kuva B. Alfakanava C. Sijoitettu kuva D. Alkuperäinen kuva E. Kuva ja upotettu reitti F. Sijoitettu kuva

Kun sijoitat Photoshop-tiedoston, voit ottaa käyttöön Kuvan tuontiasetukset -valintaikkunassa oletusarvoisen rajaavan reitin tai valita
alfakanavan rajaamista varten.

1. Valitse tuotu kuva ja sitten Objekti > Rajaava reitti.
2. Valitse Rajaava reitti -valintaikkunan Tyyppi-valikosta joko Photoshop-reitti tai Alfakanava.
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3. Valitse haluamasi reitti tai alfakanava Reitti- tai Alfa-valikosta.
Huomautus: jos Alfakanava-valikkokomento ei ole käytettävissä, kuvaan ei ole tallennettu alfakanavia.

4. Jos haluat siirtää rajaavaa reittiä, määritä arvo Siirrä kehys -kohdassa.
5. Jos haluat vaihtaa näkyvät ja kätketyt alueet päinvastaisiksi, valitse Käännä.
6. Jos valitsit alfakanavan, määritä muut haluamasi rajaavan reitin asetukset ja valitse OK.

Jos haluat poistaa rajaavan reitin käytöstä, valitse tuotu kuva ja sitten Objekti > Rajaava reitti. Valitse Tyyppi-valikosta Ei mitään ja sitten OK.

Rajaavan reitin luominen automaattisesti
Jos haluat poistaa taustan kuvasta, johon ei ole tallennettu rajaavaa reittiä, voit tehdä sen automaattisesti valitsemalla Rajaava reitti -
valintaikkunasta Tunnista reunat. Asetus kätkee kuvan vaaleimmat tai tummimmat alueet, joten se toimii parhaiten, jos kuva-aiheen tausta on
tasaisen valkoinen tai musta.

Hyvä (vasen) ja huono (oikea) tapa käyttää automaattista rajaavaa reittiä

1. Valitse tuotu kuva ja sitten Objekti > Rajaava reitti.
2. Valitse Rajaava reitti -valintaikkunan Tyyppi-valikosta Tunnista reunat. Vaaleimmat sävyt kätketään oletusarvoisesti. Jos haluat kätkeä

tummimmat sävyt, valitse myös Käännä.
3. Määritä rajaavan reitin asetukset ja valitse OK.

Rajaavan reitin asetukset
Kynnys Määrittää tummimman pikseliarvon, joka määrittää syntyvän rajaavan reitin. Jos arvo suurenee, lisää pikseleitä muuttuu läpinäkyväksi,
sillä kätkettyyn alueeseen sisältyvien vaaleusarvojen alue suurenee. Aloitusarvo on 0 (valkoinen). Jos esimerkiksi haluat poistaa erittäin vaalean
heittovarjon Tunnista reunat -asetusta käyttäessäsi, suurenna Kynnys-asetusta, kunnes varjo katoaa. Jos liikaa vaaleita pikseleitä katoaa
näkyvistä, Kynnys-asetus on liian suuri.

Kynnys-asetuksena 25 (vasen) ja 55 (oikea)

Tarkkuus Määrittää, kuinka samanlainen pikselin vaaleusarvo voi olla Kynnys-arvon kanssa, ennen kuin rajaava reitti kätkee pikselin. Asetuksen
suurennus kannattaa, jos haluat poistaa vain hiukan Kynnys-asetusta tummemmat ei-toivotut pullistumat, jotka aiheutuvat yksittäisistä pikseleistä.
Jos asetus on suuri, rajaava reitti on tasainen ja väljä, sillä tällöin asetuksen lähellä olevien kuvaan sisältyvien yksittäisten tummahkojen
pikseleiden määrä on tavallista suurempi. Asetuksen pienennystä voidaan verrata rajaavan reitin tiukennukseen arvoalueen ympärillä. Kun asetus
on pieni, rajaava reitti on epätasaisempi, sillä siinä on enemmän ankkuripisteitä, jotka voivat vaikeuttaa tulostusta.

Vaihteluväli 0 (vasen) ja 5 (oikea)

Siirrä kehys Pienentää syntyvää rajaavaa reittiä suhteessa Kynnys- ja Vaihteluväli-arvojen määrittämään reittiin. Toisin kuin Kynnys ja
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Vaihteluväli, Siirrä kehys ei huomioi vaaleusarvoja vaan pienentää rajaavan reitin muotoa tasaisesti. Siirrä kehys -arvon hienovarainen säätäminen
voi auttaa kätkemään yksittäisiä pikseleitä, joita ei voinut poistaa Kynnys- ja Vaihteluväli-arvojen avulla. Kirjoita negatiivinen arvo, jos haluat tehdä
rajaavasta reitistä suuremman kuin Kynnys- ja Vaihteluväli-asetusten määrittämä reitti.

Siirrä kehys -asetus -0p1 (vasen) ja 0p3 (oikea)

Käänteinen Vaihtaa näkyvät ja kätketyt alueet päinvastaisiksi. Rajaava reitti aloitetaan tummimmilla sävyillä.
Sisällytä sisäreunat Määrittää alueet läpinäkyviksi, jos ne ovat alkuperäisen rajaavan reitin sisäpuolella ja jos niiden vaaleusarvot sijoittuvat
Kynnys- ja Vaihteluväli-alueille. Oletusarvoisesti Rajaava reitti -komento tekee läpinäkyväksi vain uloimmat alueet. Jos siis haluat kuvaan "reikiä",
käytä Sisällytä sisäreunat -asetusta. Tämä asetus toimii parhaiten, kun läpinäkyviksi tehtävien alueiden kirkkausarvot eivät vastaa näkyviksi
jätettävien alueiden arvoja. Jos esimerkiksi valitset Sisällytä sisäreunat -asetuksen hopeisten silmälasien kuvalle ja linsseistä tulee läpinäkyvät,
kehysten vaaleimmat alueet voivat myös muuttua läpinäkyviksi. Jos alueet muuttuvat läpinäkyviksi vahingossa, säädä Kynnys-, Vaihteluväli- ja
Siirrä kehys -asetuksia.
Rajoita kehykseen Luo rajaavan reitin, joka pysähtyy kuvan näkyvään reunaan. Reitistä voi tulla yksinkertaisempi, jos käytät kuvan kehystä kuvan
rajaamiseen.
Käytä korkearesoluutiokuvaa Laskee läpinäkyvät alueet todellisen tiedoston avulla, mikä takaa parhaan mahdollisen tarkkuuden. Poista valinta,
jos haluat laskea ne näyttöresoluution avulla. Tämä on nopeampaa mutta epätarkempaa. Asetus ei ole käytössä, jos valittuna on Alfakanava-
asetus, sillä InDesign käyttää aina alfakanavan todellista resoluutiota. (Lisätietoja: Tietoja läpinäkyvyydestä.)

Rajaavan reitin muuntaminen grafiikkakehykseksi
 Valitse Objekti > Rajaava reitti > Muunna rajaava reitti kehykseksi.

Lisää ohjeaiheita
  Alfakanavapeitteiden luominen ja muokkaaminen

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Formatting grids
Named Grids panel overview
Create named grid formats
Apply a named grid to a frame
Edit named grids
Delete named grids
Import grid formats from other documents

Named Grids panel overview

Use the Named Grids panel (Window > Type & Tables > Named Grids) to save frame grid settings in named grid
format, and apply those settings to other frame grids. You can apply or change frame grid formats efficiently, and
easily keep the appearance of a document consistent, using grid formats.

Named Grids panel

A. Grid name B. New Grid Format button C. Delete icon 

In the Named Grids panel, the Layout Grid format is shown by default. The layout grid setting for the currently
selected page is reflected in this grid format. When more than one layout grid is set for a single document, the
settings shown in Layout Grid in the Named Grids panel vary depending on the selected page layout grid contents.

When a frame grid with grid formatting is selected, the current grid format name is highlighted in the Named Grids
panel.

Create named grid formats

Like styles, named grid formats let you save a collection of frame grid settings and apply those settings to other
frame grids.

1. To define a new grid format in accordance with the existing frame grid format, select the frame grid with
the selection tool.

2. Choose Window > Type & Tables > Named Grids.
3. Choose New Named Grid from the Named Grids panel menu.
4. Specify options in the Edit Grid Format dialog box, and click OK.
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If the named grid format you want to use is already saved in another InDesign document, you can import that grid
format into the current document.

When a new frame grid format is created based on an existing frame grid, changes to format attribute options also
are applied to the selected frame grid. If you do not want to modify the selected frame grid format, deselect the
frame grid before showing the Edit Grid Format dialog box.

Named Grid options

Named Grid options appear when you choose Window > Type & Tables > Named Grids.

Grid Name

Enter the name of the grid format.

Font

Select the font family and font style, and set the default font for the text to be placed in the grid.

Size

Specify individual grid sizes.

Vertical and Horizontal

Specify the grid scale for full-width Asian characters in %.

Char Aki

Specify the spacing between grid cells in the frame grid. This value will be the grid cell size.

Line Aki

Enter a value to specify the grid line spacing. The value used here is the distance between the bottom (or left)
edge of the character embox for the first line to the top (or right) edge of the character embox for the next line.

Line Align

Select an option to specify line alignment for the frame grid. For example, if Align Left/Top is selected, the
beginning of each line for a vertical type frame grid will be aligned with the top edge of the frame grid. (See Align
or justify text.)

Grid Align

Select an option to specify whether to align the text to the embox, ICF box, or roman baseline. See Align
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paragraphs to a baseline grid.

Char Align

Select an option to specify the method of aligning small characters to larger characters in a line. (See Align text of
different sizes.)

Apply a named grid to a frame

You can apply a custom named grid or the Layout Grid to a frame grid. If you apply the Layout Grid, the same
settings defined in the Layout Grid dialog box are used in the frame grid.

1. Select the frame grid using the Selection tool. You can also use the Type tool to click on the frame and
position the text insertion point or select text.

2. Click on the name of the format to be applied in the Named Grids panel or Control panel.

Applying a grid format causes grid format attributes to be set for text in the frame grid, but grid format
attributes will not be set for text which has been given Character or Paragraph styles, or text which has had
settings individually modified from the Character panel or Paragraph panel.

Note:

Priority is given to character style, paragraph style and grid format in that order in the frame grid.
Accordingly, when grid formatting is applied to text that has been given paragraph or character styles, a '+'
mark is shown next to each applied style name. (See Text formatting precedence.)

Before and after applying a grid format to the frame grid

3. To apply grid format attributes to the entire story, select the frame grid using the Selection tool and select
Edit > Apply Grid Format.

You can also add named grids to object styles. If you add a named grid to the default object style for grid frames,
all grid frames you create appear formatted according to the named grid you specify. (See About object styles.)

Edit named grids

You can change the grid format definitions at any time. When you change the definition of a grid format, all of the
frame grids formatted with that style change to conform with the newly defined style.

1. Using the Named Grids panel, select the grid format to be edited, and choose Named Grid Options from the
panel menu, or double-click the grid format you want to edit in the Named Grids panel.

2. Change the settings in the Modify Named Grid dialog box. (See Create named grid formats.)
3. Click OK.
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This modifies the grid format given to the currently selected frame grid. To modify settings for frame grids which
are not currently selected, perform the above operation without selecting any objects in the document, or double-
click the grid format name in the Named Grids panel while holding down Shift+Ctrl+Alt (Windows) or
Shift+Command+Option (Mac OS).

Delete named grids

The formatting applied to text in a frame is unchanged even if a grid format is deleted, but the link to the grid
format is removed.

1. Select the name of the grid format you want to delete in the Named Grids panel.
2. Choose Delete Named Grids from the panel menu, or click the Delete icon  at the bottom of the Named

Grids panel.

When you delete grid formats, the frame grid to which the grid format was applied doesn’t appear to change, but
the format is no longer connected with the grid format.

Import grid formats from other documents

1. Choose Load All Named Grids from the Named Grids panel menu.
2. Double-click the InDesign document containing the grid formats you want to import.

When you import a grid format from another document that has the same name as a grid format in the current
document, the existing grid format in the import destination will be overwritten, and when this grid format is
applied the grid format for all the frame grids will be changed.

Adobe also recommends

Customize layout and frame grids
Override character and paragraph styles
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Frame grid properties
Change frame grid properties
Convert text frames and frame grids
View or hide the frame grid character count

Change frame grid properties

1. Using the Selection tool , select the frame whose properties you want to modify. You can also use the
Type tool to click on the frame, and position the text insertion point or select text.

2. Choose Object > Frame Grid Options, and then specify the frame grid options. (See Frame grid properties.)

3. Click OK.

Select Preview to confirm options before applying the changes, and then confirm changes in the document.

Frame grid properties

Use the Frame Grid dialog box to change frame grid settings such as the font, character size, character spacing,
lines, and characters.

The values in the Text Frame Option dialog box and the number of columns in the Frame Grid settings dialog box
interact dynamically. Column number settings in Text Frame Options are also reflected in the frame grid settings.
Furthermore, First Baseline Offset and Ignore Text Wrapping can be set only from Text Frame Options.

Font

Select the font family and font style. These font settings will be applied in frame grids based on the layout grid.

Size

Specify the font size. This value will be the grid cell size.

Vertical and Horizontal

Specify the grid scaling for full-width Asian characters in %.

Char Aki

Specify the spacing between grid cells in the frame grid. This value is used for the grid mesh spacing.
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Line Aki

Specify the grid spacing. This value is used as the distance from underneath (or left of) the grid mesh on the first
line to the top (or right) of the grid mesh on the next line. If a negative value is set here, Auto Leading value
under Justification in the Paragraph panel menu is set automatically to 80% (the default is 100%), since grid
alignment will only increase line spacing above the spacing already set by the leading amount in the text
attributes. Changing the leading value set in the text will change how the grid alignment spreads the text lines out
to match the nearest grid line.

Line Align

Select an option to specify line alignment for the text. For example, if you select Top for a vertical frame grid, the
start of each line will be aligned to the top of the frame grid. (See Align or justify text.)

Grid Align

Select an option to specify whether to align the text to the embox, ICF box, or roman baseline. (See Align
paragraphs to a baseline grid.)

Char Align

Select an option to specify the method of aligning small characters to larger characters in a line.

Char Count

Select an option to determine where the frame grid’s dimensions and character count appears. (See View or hide
the frame grid character count.)

View

Select an option to specify how to show the frame. Grid shows frame grids with grids and lines. N/Z View shows
the frame grid direction in dark blue diagonal lines; these lines disappear when you insert text. Alignment View
shows frame grid with only lines. Alignment shows the frame line alignment. Grid With N/Z shows a combination of
both.

Grid views

A. Grid view B. N/Z view C. Assignment view with text inserted D. Grid with N/Z view 

Characters

Specifies the number of characters in a line.

Lines

Specifies the number of lines in a column.
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Columns

Specifies the number of columns in a frame grid.

Gutter

Specifies the spacing between columns.

Note:

If you make changes in the Frame Grid settings dialog box when nothing is selected in the frame grid, that setting
becomes the default for the frame grid.

You can also use grid setting to adjust character spacing. (See Using grid tracking to adjust character spacing.)

Convert text frames and frame grids

You can convert plain text frames into frame grids or frame grids into plain text frames.

When plain text frames are converted into frame grids, for text that has not had a character style or paragraph
style applied in the story, the frame grid's document defaults are applied.

You cannot apply grid format directly to plain text frames. After converting a plain text frame into a frame grid,
you can apply grid format attributes by applying a predetermined grid format to a frame grid using text that has
not been given a paragraph style.

Also, when a text frame is converted to a frame grid, blank space may be created at the top, bottom, left or right
of the frame. This space is shown when the text frame width or height is not divisible by the font size or leading
values set in the grid format. This spacing can be removed by dragging the frame grid handle and adjusting with
the Selection tool. When converting text frames to frame grids, edit the text after adjusting any insets created
during conversion.

Convert a plain text frame into a frame grid

1. Select the text frame and do one of the following:

Choose Object > Frame Type > Frame Grid.

Choose Type > Story to show the Story panel. Select Frame Grid in Frame Type.

2. To reformat story text according to grid attributes, select Edit > Apply Grid Format when the frame grid is
selected.

Remove a grid from a frame grid

Select the frame grid, and do one of the following:

Choose Object > Frame Type > Text Frame.

Choose Type > Story to show the Story panel. Select Text Frame in Frame Type.
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The frame grid character count is shown at the bottom of the grid. Shown here are the values for characters, lines,
total number of cells and the actual number of characters.

In this frame the value for characters per line is 10, the value for lines is 5, and the total number of cells is 50. 29 characters have been
placed in the frame grid.

Choose View > Grids & Guides > Show Character Count or Hide Character Count.

To specify the size and position of the character count view, select the text frame and choose Object > Frame Grid
Options. Under View Options, specify the Char Count, view, and size, and click OK.

Adobe also recommends

Create frame grids
Formatting grids
Customize layout and frame grids
Differences between frame grids and plain text frames
Change the text direction
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Grids
Use grids
Snapping objects to grids

Use grids

Two kinds of nonprinting grids are available: a baseline grid for aligning columns of text, and a document grid for
aligning objects. On the screen, a baseline grid resembles ruled notebook paper, and a document grid resembles
graph paper. You can customize both kinds of grids.

Baseline grid (left) and document grid (right)

When a grid is visible, you can observe the following characteristics:

The baseline grid covers entire spreads, but the document grid covers the entire pasteboard.

Baseline grids and document grids appear on every spread and cannot be assigned to any master.

The document grid can appear in front of or behind all guides, layers, and objects, but cannot be assigned
to any layer.

Set up a baseline grid

Use Grid Preferences to set up a baseline grid for the entire document.

You can set up a baseline grid for a frame by using the Text Frame Options. (See Change text frame properties.)

1. Choose Edit > Preferences > Grids (Windows) or InDesign > Preferences > Grids (Mac OS).

2. Specify a baseline grid color by choosing a color in the Color menu. You can also choose Custom in the
Color menu.

3. For Relative To, specify whether you want the grid to start at the top of the page or the top margin.

4. For Start, type a value to offset the grid from either the top of the page or the top margin of the page,
depending on the option you choose from the Relative To menu. If you have trouble aligning the vertical
ruler to this grid, try starting with a value of zero.

5. For Increment Every, type a value for the spacing between grid lines. In most cases, type a value that
equals your body text leading, so that lines of text align perfectly to this grid.
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Baseline grid in document window

A. First grid line B. Increment between grid lines 

6. For View Threshold, type a value to specify the magnification below which the grid does not appear.
Increase the view threshold to prevent crowded grid lines at lower magnifications.

Baseline grid at magnification below view threshold (left) and above view threshold (right)

7. Click OK.

Note:

The Snap To Guides command controls both snapping to guides and snapping to the baseline grid.

Set up a document grid

1. Choose Edit > Preferences > Grids (Windows) or InDesign > Preferences > Grids (Mac OS).

2. Specify a document grid color by choosing a color in the Color menu. You can also choose Custom in the
Color menu.

3. To set horizontal grid spacing, specify a value for Gridline Every in the Horizontal section of the Document
Grid section, and then specify a value for Subdivisions between each grid line.

4. To set vertical grid spacing, specify a value for Gridline Every in the Vertical section of the Document Grid
section, and then specify a value for Subdivisions between each grid line.

5. Do one of the following, and click OK:

To put the document and baseline grids behind all other objects, make sure that Grids In Back is
selected.

To put the document and baseline grids in front of all other objects, deselect Grids In Back.

To put guides behind all other objects, you can also choose Guides In Back in the context menu that appears
when you right-click (Windows) or Control-click (Mac OS) an empty area of the document window.

Show or hide grids

To show or hide the baseline grid, choose View > Grids & Guides > Show/Hide Baseline Grid.

To show or hide the document grid, choose View > Grids & Guides > Show/Hide Document Grid.

Snapping objects to grids

When snapping is enabled, moving an object within the snap zone of a grid location will cause the object to snap
to that location.
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Snap objects to the document grid

1. Choose View > Grids & Guides and make sure that Snap To Document Grid is selected (checked). If it is
not selected, click it.

Note:

The Snap to Guides command controls both snapping to guides and snapping to the baseline grid.

2. To specify the snap-to zone, choose Edit > Preferences > Guides & Pasteboard (Windows) or InDesign >
Preferences > Guides & Pasteboard (Mac OS), type a value for Snap to Zone, and click OK. The Snap to
Zone value is always in pixels.

To snap an object to a grid, drag an object toward a grid until one or more of the object’s edges is within the
grid’s snap-to zone.

Adobe also recommends

Ruler guides
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Grouping, locking, and duplicating objects
Group or ungroup objects
Group and ungroup objects on different layers
Lock or unlock objects
Hide objects
Duplicate objects
Duplicate an object using the Duplicate command
Duplicate a selected object as you transform
Use Step and Repeat to duplicate objects
Duplicate objects into a grid
Create nonprinting objects

Group or ungroup objects

You can combine several objects into a group so that they are treated as a single unit. You can then move or
transform the objects without affecting their individual positions or attributes. For example, you might group the
objects in a logo design so that you can move and scale the logo as one unit.

Groups can also be nested—grouped into subgroups within larger groups. Use the Selection, Direct Selection, and
Group Selection tools to select different levels of a nested group’s hierarchy.

If you’re working with a stack of overlapping objects, and you group some objects that aren’t adjacent in the
stacking order, the selected objects will be pulled together in the stacking order, right behind the frontmost
selected object. (For example, when objects are stacked as A, B, C, D from front to back, and you group B and D
together, the stacking order becomes A, B, D, C.) If you group objects that exist on different named layers, all of
the objects move to the frontmost layer on which you selected an object. Also, the objects you select must either
be all locked or all unlocked.

Grouped object

1. Select multiple objects to be grouped or ungrouped.

If your selection includes part of an object (for example, an anchor point), the group or ungroup operation
will group or ungroup the entire object.

2. To group the selected objects, choose Object > Group.

To ungroup the selected objects, Object > Ungroup.

If you’re not sure if an object is part of a group, select it using the Selection tool and look at the Object menu. If
the Object > Ungroup command is available, you’ve selected a group.

Group and ungroup objects on different layers
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You can also use the Layers panel to group objects that are placed on different layers of a document. For more
details on layers, click here.

When you group objects on different layers, InDesign groups the objects on the topmost layer containing at least
one object in the group. However, InDesign remembers the layers to which each object belongs. This implies that,
by default, if you then ungroup the objects, all the objects are restored back to their original layers.

You can also choose to leave the ungrouped objects on the topmost layer. To do this, uncheck the Ungroup Remembers Layers option in the Layers
panel flyout menu.

Note:

This option is an application-level setting. This implies that this option is applied to all documents.

Lock or unlock objects

You can use the Lock command to specify that you don’t want certain objects to move in your document. Locked
objects stay locked when a document is saved, closed, and then reopened.

As long as an object is locked, it cannot be moved. However, you can select locked objects if you turn off the
Prevent Selection Of Locked Objects option in General preferences. When you select a locked object, you can
change attributes such as color.

1. Select the object or objects that you want to lock in place.
2. Do any of the following:

To lock the objects, choose Object > Lock.

To unlock an object, click the lock icon.

To unlock the objects on the current spread, choose Object > Unlock All On Spread.

You can also use the Layers panel to lock or unlock both objects and layers. When you lock a layer, the positions
of all objects on a layer are locked, and the objects cannot be selected. See Layers.

Hide objects

Hidden objects are not printed or exported, and they cannot be selected.

Do any of the following:

To hide an object, select it and choose Object > Hide.

To show hidden objects, choose Object > Show All On Spread.

Duplicate objects

You can duplicate objects using a number of different methods.
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Duplicate an object using the Duplicate command

Use the Duplicate command to replicate a selected object instantly. The new copy appears on the layout slightly
offset down and to the right from the original.

Select an object or objects, and choose Edit > Duplicate.

Duplicate a selected object as you transform

You can duplicate an object each time you change its position, orientation, or proportions. For example, you can
create a flower by drawing one petal, setting its reference point at the base of the petal, and repeatedly rotating at
incremental angles, simultaneously duplicating to leave behind a new copy of the petal at each angle.

During a transformation, do one of the following:

If you’re dragging the Selection tool , the Rotate tool , the Scale tool , or the Shear tool ,
start dragging, and then hold down Alt (Windows) or Option (Mac OS) after you begin dragging. To
constrain the duplicate’s transformation, Alt+Shift-drag (Windows) or Option+Shift-drag (Mac OS).

If you’re specifying a value in the Transform or Control panel, press Alt+Enter (Windows) or
Option+Return (Mac OS) after you’ve typed the value.

If you’re pressing arrow keys to move objects, hold down Alt (Windows) or Option (Mac OS) as you
press the keys.

Use Step and Repeat to duplicate objects

Use the Step and Repeat command to instantly create rows or columns of duplicates. For example, you can fill a
page with evenly spaced duplicates of a single business card design.

1. Select the object or objects you want to duplicate.

2. Choose Edit > Step and Repeat.

3. For Repeat Count, specify how many duplicates you want to make, not counting the original.

4. For Horizontal Offset and Vertical Offset, specify how far to shift the position of each new duplicate from
the previous duplicate along the  x and y axes, respectively, and click OK.

To create a page full of duplicates, first use Step and Repeat with Vertical Offset set to 0 (zero); this will create
one row of duplicates. Then select the entire row and use Step and Repeat with Horizontal Offset set to 0; this will
repeat the row down the page.

Duplicate objects into a grid

By dragging and using modifier keys, you can create a grid of object identical to the object being duplicated.

235



To the top

For a video on using grid mode, see http://tv.adobe.com/go/4949/.

1. Select an object.

2. Using the Selection tool, hold down Alt (Windows) or Option (Mac OS) and begin dragging.

3. While still dragging, release the Alt or Option key. Press the Left Arrow and Right Arrow keys to change the
number of columns. Press the Up Arrow and Down Arrow keys to change the number of rows. Drag a
rectangle to specify the size of the grid.

4. Release the mouse button.

Create nonprinting objects

You might want to create objects that appear onscreen, but will not be printed or appear in portable versions of
the document.

You can also use layers to selectively hide or show elements in a document, and you can assign layers a non-
printing status.

1. Select the object or text frame that you don’t want to be printed.
2. Open the Attributes panel (Window > Output > Attributes).
3. In the Attributes panel, select Nonprinting.

Adobe also recommends

Arrange objects in a stack
Select nested or overlapping objects
Lock or unlock layers
Set a layer as nonprinting
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Importing files from other applications
Importing Adobe Illustrator graphics
Importing Adobe Photoshop (.PSD) files
Importing PDF pages
Importing InDesign (.indd) pages
Importing other graphics formats

Importing Adobe Illustrator graphics

How you import Illustrator graphics depends on how much editing the graphics require after you import them. You
can import Illustrator graphics into InDesign in their native (.ai) format.

If you want to adjust layer visibility in InDesign...

Import the graphic using the Place command, and when you want to edit it, choose Edit > Edit Original to open
the graphic in Illustrator. For example, for a multilanguage publication, you can create a single illustration that
includes one text layer for each language. You can transform the illustration as a single object in InDesign but you
cannot edit the paths, objects, or text within the illustration.

Layered file with Spanish and English layers

If you want to edit objects and paths in InDesign...

Copy the art from Illustrator and paste it into your InDesign document. For example, in a magazine, you might use
the same design element in each issue, but change its color every month. By pasting a graphic into InDesign, you
can change objects’ color, path, and transparency using the InDesign tools designed for that purpose.

Importing Illustrator graphics with multiple artboards

Illustrator CS4 graphics can include multiple artboards. When you import an Illustrator graphic with multiple
artboards, you can use Import Options to specify which artboard, or “page,” will be imported.

Create a layered PDF in Adobe Illustrator
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You can save an Illustrator graphic as a layered PDF and control the visibility of layers in InDesign. Adjusting layer
visibility in InDesign lets you vary an illustration depending on context. Rather than create multiple versions of the
same illustration, say for a multilanguage publication, you can place the same illustration where needed and adjust
the visibility of the layers as appropriate.

You can transform a PDF as a single object (you can rotate or resize it, for example), but you cannot edit the
paths, objects, or text within the illustration.

If you’re placing an Illustrator file that includes multiple artboards, you can specify which artboard is used, as
when placing multipage PDF files.

Note:

Don’t place layers in nested layer sets if you want to adjust layers in InDesign.

1. In Illustrator, choose File > Save As.

2. In the Save As dialog box, type a filename and choose a location for the file.

3. For Format, choose Adobe PDF (.pdf), and click Save.

4. In the Adobe PDF Options dialog box, choose Acrobat 6 (1.5) or later for Compatibility.

5. Select Create Acrobat Layers From Top-Level Layers, and click Save PDF.

Pasting Illustrator graphics into InDesign

When you paste a graphic from Illustrator 8.0 or later into an InDesign document, the artwork appears in InDesign
as a grouped collection of editable objects. For example, if you paste an Illustrator drawing of a soccer ball with
individually created patches into InDesign, the patches are pasted as a group, which can be ungrouped and edited
using tools in InDesign. You cannot change the visibility of layers within the illustration.

Illustration of soccer ball in Illustrator (left) and same illustration pasted into InDesign (right)

Note:

Before pasting a graphic, make sure that Illustrator is configured to copy as AICB (see Illustrator Help). In
InDesign, make sure that Prefer PDF When Pasting isn’t selected in the Clipboard Handling preferences. If these
options aren’t set properly, the Illustrator graphic cannot be edited in InDesign.

Issues you may encounter when pasting or dragging art from Illustrator to InDesign

Color

Illustrator supports the Grayscale, RGB, HSB, CMYK, and Web Safe RGB color models. InDesign supports LAB,
CMYK and RGB. When you paste or drag artwork from Illustrator into InDesign, RGB and CMYK colors convert in
the expected color model. Grayscale colors are converted to the appropriate K value in a CMYK color in InDesign.
HSB and Web Safe RGB objects are converted to RGB color in InDesign. Colors in smooth shades and gradients
can be edited in InDesign.

Gradients

Linear or radial gradients created in Illustrator can be modified using the Gradient tool or Gradient panel in
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InDesign. Gradients with multiple spot colors or complex patterns may appear as non-editable items in InDesign. If
your illustration contains complex gradients, import it using the Place command instead.

Transparency

Transparency is flattened when Illustrator art is pasted or dragged into InDesign.

Graphic styles

Illustrator Graphic Styles don’t become InDesign Object Styles when art is pasted or dragged into InDesign.

Patterns

Illustrator objects filled or stroked with patterns become embedded EPS images when pasted or dragged into
InDesign.

Text

If you drag text from Illustrator into InDesign, it’s converted to outlines and isn’t editable with the Text tool. If you
select text using the Text tool in Illustrator, and then copy it into a text frame in InDesign, the text loses its
formatting but is editable. If you drag the text into InDesign without a frame selected, the text loses all formatting
and isn’t editable.

When you paste text from Illustrator, the text is imported as one or more objects that can be transformed and
colorized in InDesign, but not edited. For example, if you create text on a path in Illustrator and paste it into
InDesign, the text can be colorized, rotated, and scaled, but it cannot be edited using the Type tool. If you want
to edit the text, use the Type tool and paste it into a text frame.

Artwork

Artwork copied from Illustrator and pasted into InDesign is embedded in the InDesign document. No link to the
original Illustrator file is created.

Importing Adobe Photoshop (.PSD) files

You can place graphics created in Adobe Photoshop 4.0 and later directly into an InDesign layout.

Layers and layer comps

You can adjust the visibility of the top-level layers in InDesign, as well as view different layer comps. Changing
layer visibility or layer comps in InDesign does not alter the original Photoshop file.

Paths, masks, or alpha channels

If you save paths, masks, or alpha channels in a Photoshop file, InDesign can use them to remove backgrounds, or
to wrap text around graphics. Graphics that contain paths, masks, or alpha channels act as transparent objects
when imported.
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ICC color management profile

If you place a Photoshop image with an embedded ICC color management profile, InDesign reads the embedded
profile, provided that color management is active. You can override the embedded profile for the image using the
Import Options dialog box or assign a different color profile to the graphic in InDesign. Overriding the color profile
in InDesign will not remove or alter the profile embedded in the Photoshop image.

Spot-color channels

Spot-color channels in Adobe Photoshop PSD or TIFF files appear in InDesign as spot colors in the Swatches panel.
If the image uses a spot color that InDesign does not recognize, the spot color may appear gray in the InDesign
document and print incorrectly as a composite. (The image will print correctly on color separations, however.) To
simulate the graphic as a composite, you can create a spot color with the correct color values, and then alias the
PSD color to this new spot color. The graphic will then print correctly as composite and display correctly on-screen
when Overprint Previewis turned on (choose View > Overprint Preview). Be sure to remove the alias before
printing separations, so that the image prints on the plate you expect.

Importing PDF pages

Using the Place command, you can specify which pages you want to import from a multipage PDF or an Illustrator
file with multiple artboards. You can place a single page, a range of pages, or all pages. Multipage PDF files let
designers combine illustrations for a publication into a single file.

The page range options appear when you select Show Import Optionsin the Place dialog box. See Acrobat (.pdf)
and Illustrator (.ai) import options. The dialog box includes a preview, so you can view a thumbnail of the pages
before you place them. If you place multiple pages, InDesign reloads the graphics icon with the next page, letting
you place the pages one after the next. InDesign doesn’t import movies, sound, links, or buttons when you place a
PDF file.

Comparing screen and device resolution in placed PDF pages

A placed PDF page displays at the best resolution possible for the given scale and screen resolution. When printed
on a PostScript output device, a placed PDF page always prints at the resolution of the device. When printed on a
non-PostScript printer, a placed PDF page prints at the same resolution as the other InDesign objects in the
document. For example, vector (drawn) objects will print at the same resolution as other vector objects in the
document. Bitmap images will print at the best resolution supplied in the placed PDF.

Linking to placed PDFs

A placed PDF page appears in the InDesign document as an on-screen preview, which is linked to a specific page
in the original PDF. After placing a PDF page, you may break links by doing any of the following:

If you add a password to the original PDF that has been placed in an InDesign document, and you update
the link, you’ll be prompted to enter the password.

If you delete pages in the original PDF and update the link, the placed PDF page changes to the page that
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now falls on the originally placed page number.

If you reorder the pages in the original PDF file and update the link, the placed PDF page may be different
from what you expect. When that happens, place the page again.

Color in placed PDF pages

InDesign preserves colors embedded in PDF pages, even if the color comes from a color library not installed with
InDesign (such as the PANTONE Hexachrome® library). In addition, any color traps included in a placed PDF page
are preserved.

When color management is active, InDesign displays the placed PDF using its embedded ICC or output intent
profile (PDF/X only). When color management is turned off, or when you place a PDF that doesn’t contain an ICC
or output intent profile, colors in the placed PDF are calibrated using the color profile in the InDesign document.

When you export or print the document, you can preserve the ICC profile embedded in the placed PDF or replace
it with the document profile instead. Output intent profiles are used for display and are included when you export
as PDF/X; they aren’t used when you print the document, and they aren’t included when you export to any other
format.

Security settings in placed PDF pages

Because a placed PDF page is linked to the original PDF, the placed page also includes the security settings of the
original file. If someone later changes the security settings in the original file, the security settings are updated in
the placed PDF page when you update the links.

If you correctly enter a required master password when placing a PDF page, you override any restrictions in the
PDF page, enabling the placed PDF page to export as expected.

Importing InDesign (.indd) pages

Using the Place command, you can import pages from one InDesign document into another. You can import a
page, a page range, or all of the pages in the document. The pages are imported as objects (much the same way
that PDFs are imported).

Add pages in your document to hold the pages you want to import. After you choose File > Place and select an
INDD file, you can choose Show Import Options and then choose which pages to import, which layers to make
visible, and how to crop the imported pages. You can scroll in the Preview window to examine the thumbnail
pages closely. The page or pages you select are loaded in the graphics icon. If you place multiple pages, InDesign
loads the graphics icon with the following page so you can import pages one after the other.

Note:

The Links panel lists the names of each page you imported. If a page you imported contains a graphic or other
item that was imported into it, this item is listed as well in the Links panel. The names of these secondary
imported items are listed under a disclosure triangle in the Links panel to distinguish them from imported pages.

Importing other graphics formats
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InDesign supports a variety of graphics formats, including bitmap formats such as TIFF, GIF, JPEG, and BMP, and
vector formats such as EPS. Other supported formats include DCS, PICT, WMF, EMF, PCX, PNG, and Scitex CT
(.sct). You can import an SWF file as a movie file.

TIFF (.tif) files

TIFF is a flexible bitmap image format supported by virtually all painting, image-editing, and page-layout
applications. Also, virtually all desktop scanners can produce TIFF images.

The TIFF format supports CMYK, RGB, grayscale, Lab, indexed-color, and bitmap files with alpha and spot-color
channels. You can select an alpha channel when you place a TIFF file. Spot-color channels appear in InDesign as
spot colors in the Swatches panel.

You can use an image-editing program such as Photoshop to create a clipping path to create a transparent
background for a TIFF image. InDesign supports clipping paths in TIFF images and recognizes encoded OPI
comments.

Graphics Interchange Format (.gif) files

Graphics Interchange Format (GIF) is a standard for displaying graphics on the World Wide Web and other online
services. Because it compresses image data without losing detail, its compression method is called lossless. Such
compression works well with graphics that use a limited number of solid colors such as logos and charts; however,
GIF cannot display more than 256 colors. For this reason it is less effective for displaying photographs online (use
JPEG instead) and is not recommended for commercial printing. If an imported GIF file contains transparency, the
graphic interacts only where the background is transparent.

JPEG (.jpg) files

The Joint Photographic Experts Group (JPEG) format is commonly used to display photographs and other
continuous-tone images in HTML files over the web and in other online media. The JPEG format supports CMYK,
RGB, and grayscale color modes. Unlike GIF, JPEG retains all of the color information in an RGB image.

JPEG uses an adjustable, lossy compression scheme that effectively reduces file size by identifying and discarding
extra data not essential to the display of the image. A higher level of compression results in lower image quality; a
lower level of compression results in better image quality, but a larger file size. In most cases, compressing an
image using the Maximum quality option produces a result that is indistinguishable from the original. Opening a
JPEG image automatically decompresses it.

Note:

JPEG encoding, which can be performed on an EPS or DCS file in an image-editing application such as Photoshop,
does not create a JPEG file. Instead, it compresses the file using the JPEG compression scheme explained above.

JPEG works well for photographs, but solid-color JPEG images (images that contain large expanses of one color)
tend to lose sharpness. InDesign recognizes and supports clipping paths in JPEG files created in Photoshop. JPEG
can be used for both online and commercially printed documents; work with your prepress service provider to
preserve JPEG quality in printing.
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Bitmap (.bmp) files

BMP is the standard Windows bitmap image format on DOS and Windows-compatible computers. However, BMP
does not support CMYK, and its color support is limited to 1, 4, 8, or 24 bits. It is less than ideal for commercially
printed or online documents, and it is not supported by some web browsers. BMP graphics can provide acceptable
quality when printed on low-resolution or non-PostScript printers.

Encapsulated PostScript (.eps) files

The Encapsulated PostScript (EPS) file format is used to transfer PostScript language artwork between applications,
and is supported by most illustration and page-layout programs. Typically, EPS files represent single illustrations or
tables that are placed into your layout, but an EPS file can also represent a complete page.

Because they are based on the PostScript language, EPS files can contain text, vector, and bitmap graphics. Since
PostScript cannot normally be displayed on-screen, InDesign creates a bitmap preview for an EPS file for on-screen
display. InDesign recognizes clipping paths in Photoshop-created EPS files.

When you import an EPS file, any spot colors it contains are added to the Swatches panel in InDesign. EPS allows
for prepress-quality resolution, precision, and color. This format includes all of the color and image data required
to color-separate DCS images embedded in the EPS graphic. EPS isn’t ideal for online publishing in HTML, but it
works well for online publishing in PDF.

EPS files can contain Open Prepress Interface (OPI) comments, which let you use fast, low-resolution versions
(proxies) of images for positioning on a page. For final output, either InDesign or your prepress service provider
can automatically replace the proxies with high-resolution versions.

Desktop Color Separations (.dcs) files

Desktop Color Separations (DCS), developed by Quark, is a version of the standard EPS format. The DCS 2.0
format supports multichannel CMYK files with multiple spot channels. (These spot channels appear as spot colors in
the Swatches panel in InDesign.) The DCS 1.0 format supports CMYK files without spot channels. InDesign
recognizes clipping paths in Photoshop-created DCS 1.0 and DCS 2.0 files.

DCS files are intended to be used in a preseparated, host-based workflow. In most cases, color separations files
associated with a DCS image are excluded when you export or print a composite to a PDF, EPS, or PostScript file.
(The sole exception is made for 8-bit DCS files that were created in Photoshop and that do not contain vector
graphics.)

InDesign can rebuild a composite image from DCS 2.0 or 1.0 separations files, if the files were created in
Photoshop. For best results, do not include DCS 1.0 files or DCS 2.0 files created in programs other than Photoshop
when you are creating high-resolution color composite proofs or separating a document in-RIP or from a composite
file.

Macintosh PICT (.pict) files

The Macintosh PICT (or Picture) format is used for Mac OS graphics and page-layout applications, and for
transferring files between applications. The PICT format compresses images that contain large areas of solid color.
InDesign can import PICT files created from Mac OS screenshots and a variety of other applications, including clip
art collections. However, PICT files are not recommended for high-resolution commercial printing.
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InDesign supports RGB PICT images with variable resolutions and embedded QuickTime images. PICT graphics do
not support color separations, are device-dependent, and are not recommended for high-resolution commercial
printing. The PICT format can provide acceptable quality only when printed on low-resolution or non-PostScript
printers.

Windows Metafile Format (.wmf) and Enhanced Metafile Format (.emf) files

Windows Metafile Format (WMF) and Windows Enhanced Metafile Format (EMF) are native Windows formats used
primarily for vector graphics, such as clip art, shared between Windows applications. Metafiles may contain raster
image information; InDesign recognizes the vector information and provides limited support for raster operations.
Color support is limited to 16-bit RGB, and neither format supports color separations. As a general rule, avoid using
Metafile formats for commercially printed documents.

PCX (.pcx) files

The PCX format is commonly used in Windows systems. Most Windows software supports version 5 of the PCX
format.

The PCX format supports RGB, indexed-color, grayscale, and bitmap color modes, as well as the RLE compression
method, which is lossless. It does not support alpha channels. Images can have a bit depth of 1, 4, 8, or 24 bits.
However, PCX is not ideal for commercially printed or online documents. PCX graphics can provide acceptable
quality only when printed on low-resolution or non-PostScript printers.

Portable Network Graphics (.png) files

The Portable Network Graphics (PNG) format uses adjustable, lossless compression to display 24-bit photographs
or solid-color images on the World Wide Web and in other online media. PNG was developed as a patent-free
alternative to the GIF file format. It supports transparency in an alpha channel or a designated color. PNG is best
used for online documents. Color PNG graphics placed in an InDesign document are RGB bitmap images.

Scitex CT (.sct) files

The Scitex Continuous Tone (CT) format is used for high-end image processing on Scitex computers. Scitex CT files
often come from Scitex scanners, which produce high-quality scans for commercial printing. The Scitex CT format
supports CMYK, RGB, and grayscale files, but does not support alpha channels. Contact Scitex to obtain utilities for
transferring files saved in the Scitex CT format to a Scitex system.

Adobe also recommends

Control graphics’ display performance
Acrobat (.pdf) and Illustrator (.ai) import options
Control layer visibility in imported images
Importing, exporting, and saving
Paste or drag graphics
Import options for graphics
Place (import) graphics
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Color management
Create an ink alias for a spot color
Saving and exporting images
Acrobat (.pdf) and Illustrator (.ai) import options
Control layer visibility in imported images
Import options for graphics
Place (import) graphics
Control layer visibility in imported images
Place (import) graphics
Import options for graphics
Exporting
Exporting artwork
Import swatches
Movies and sounds
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Layers
About layers
Create layers
Add objects to layers
Duplicate a layer
Change the order of layers
Show or hide layers and objects
Set a layer as nonprinting
Lock or unlock layers
Delete layers
Merge layers in a document

About layers

Each document includes at least one named layer. By using multiple layers, you can create and edit specific areas
or kinds of content in your document without affecting other areas or kinds of content. For example, if your
document prints slowly because it contains many large graphics, you can use one layer for just the text in your
document; then, when it’s time to proofread the text, you can hide all other layers and quickly print the text layer
only. You can also use layers to display alternate design ideas for the same layout, or versions of advertisements
for different regions.

Think of layers as transparent sheets stacked on top of each other. If a layer doesn’t have objects on it, you can
see through it to any objects on layers behind it.

Additional layer notes:

Each document layer has a disclosure triangle that can be expanded to reveal the objects and their stacking
order on that layer for the active spread. Groups, buttons, and multi-state objects also have disclosure
triangles that can be expanded to display their contained objects. You can re-order these objects, lock and
unlock them, and add or remove them from groups.

Objects on masters appear at the bottom of each layer. Master items can appear in front of document page
objects if the master page objects are on a higher layer. (See About masters, stacking order, and layers.)

Layers involve all pages of a document, including masters. For example, if you hide Layer 1 while editing
page 1 of your document, the layer is hidden on all pages until you decide to show it again.

For information on converting layers from Adobe PageMaker® or QuarkXPress, see Converting QuarkXPress
and PageMaker documents.

The Layers panel lists layers with the frontmost layer appearing at the top of the panel.

For a video tutorial on using layers, see http://tv.adobe.com/go/4953/.
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To the topCreate layers

You can add layers at any time using the New Layer command on the Layers panel menu or the New Layer button
at the bottom of the Layers panel. The number of layers a document can have is limited only by the RAM available
to InDesign.

Create layers

1. Choose Window > Layers.
2. To create a new layer, do any of the following:

To create a new layer above the selected layer, click the New Layer button.

To create a new layer below the selected layer, hold down Ctrl (Windows) or Command (Mac OS) as
you click the New Layer button.

To create a new layer at the top of the list, hold down Ctrl+Shift (Windows) or Command+Shift
(Mac OS) as you click the New Layer button.

To create a new layer and open the New Layer dialog box, hold down Alt (Windows) or Option
(Mac OS) as you click the New Layer button.

Specify layer options

1. Choose New Layer in the Layers panel menu, or double-click an existing layer.
2. Specify the layer options, and then click OK.

Color

Assign a color to identify the objects on that layer.

Show Layer

Select this option to make a layer visible. Selecting this option is the same as making the eye icon visible in
the Layers panel.

Show Guides

Select this option to make the guides on the layer visible. When this option is not selected for a layer, the
guides cannot be made visible, even by selecting View > Show Guides for the document.

Lock Layer

Select this option to prevent changes to any objects on the layer. Selecting this option is the same as
making the crossed-out pencil icon visible in the Layers panel.

Lock Guides

Select this option to prevent changes to all ruler guides on the layer.
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Print Layer

Select this option to allow the layer to be prevented from printing. When printing or exporting to PDF, you
can determine whether to print hidden and nonprinting layers.

Suppress Text Wrap When Layer Is Hidden

Select this option if you want text on other layers to flow normally when the layer is hidden and it contains
objects with text wrap applied.

Assign a layer color

Assigning a color to a layer makes it easier to distinguish the layers of different selected objects. For each layer
that contains a selected object, the Layers panel displays a dot in the layer’s color. On the page, each object
displays the color of its layer in its selection handles, bounding box, text ports, text wrap boundary (if used), frame
edges (including the X displayed by an empty graphics frame), and hidden characters. The layer color does not
appear for a deselected frame if its edges are hidden.

1. In the Layers panel, double-click a layer or select a layer and choose Layer Options for [layer name].
2. For Color, choose a color or choose Custom to specify a color in the system color picker.

Add objects to layers

Any new object is placed on the target layer, the layer currently displaying the pen icon in the Layers panel.
Targeting a layer also selects it. If multiple layers are selected, targeting one of them doesn’t change the selection,
but targeting a layer outside the selection deselects the other layers.

You can add objects to the target layer by any of the following methods:

Creating new objects with the Type tool or drawing tools.

Importing, placing, or pasting text or graphics.

Selecting objects on other layers, and then moving them to the new layer.

You cannot draw or place a new object on a hidden or locked layer. When you select a drawing tool or the
Type tool, or place a file when the target layer is hidden or locked, the pointer changes to the crossed-out-
pencil icon when it is positioned over the document window. Either show or unlock the target layer, or
target a visible, unlocked layer. If you choose Edit > Paste when the target layer is hidden or locked, an
alert message gives you the choice of showing or unlocking the target layer.

When you click a layer in the Layers panel to target it, the pen icon appears on the layer you clicked, and the layer
also highlights to indicate that it is targeted.

Changing the target layer for the next new object
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Select, move, and copy objects on layers

By default, you can select any object on any layer. In the Layers panel, dots mark layers that contain selected
objects. The layer’s selection color helps you identify an object’s layer. To prevent selecting objects on a specific
layer, lock the layer.

Do any of the following:

To select individual objects on a layer, click the triangle icon next to the layer to display all, and
select the target object. You can also drag the target object to a different location without selecting
it.

Dragging objects from one layer to another

To select all objects on a specific layer, hold down Alt (Windows) or Option (Mac OS) as you click a
layer in the Layers panel.

To move or copy objects to another layer, use the Selection tool to select one or more objects on a
document page or master. In the Layers panel, drag the colored dot on the right side of the layer list
to move the selected objects to the other layer.

Moving an object to a new layer

To move selected objects to a locked layer, hold down Ctrl (Windows) or Command (Mac OS) as you drag the
colored dot. To copy selected objects to another layer, hold down Alt (Windows) or Option (Mac OS) as you drag
the colored dot on the right side of the layer list to the other layer. To copy selected objects to a locked layer, hold
down Ctrl+Alt (Windows) or Command+Option (Mac OS) as you drag the colored dot.
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Paste objects into different layers

The Paste Remembers Layers command affects how objects pasted from other locations interact with existing
layers.

If the Paste Remembers Layers command is selected, objects cut or copied from different layers retain their layer
assignments when pasted to the new page or position. If you paste objects to a document that doesn’t have the
same layers as the document from which they were copied, InDesign adds the objects’ layer names to the Layers
panel in the second document, and pastes each object on its layer.

If the Paste Remembers Layers command is deselected, objects cut or copied from different layers are pasted
together on the target layer.

1. Make sure that Paste Remembers Layers is deselected in the Layers panel menu.

2. Select objects and choose Edit > Copy or Edit > Cut.

3. In the Layers panel, click the other layer to target it.

4. Choose Edit > Paste.

Duplicate a layer

When you duplicate a layer, you copy its contents and settings. The duplicate layer then appears above the
original layer in the Layers panel. Any duplicated frames that were threaded to other frames on the layer remain
threaded. Duplicated frames whose originals were threaded to frames on other layers are no longer threaded to
those frames.

In the Layers panel, do one of the following:

Select the layer name and choose Duplicate Layer [layer name] in the Layers panel menu.

Drag a layer name and drop it on the New Layer button.

Change the order of layers

Change the stacking order of layers in your document by rearranging the layers on the Layers panel. Rearranging
layers changes the order of layers on every page, not just on the target spread.

You can also change the stacking order of objects within a layer by repositioning objects within the layer. See
Arrange objects in a stack.

In the Layers panel, drag a layer up or down in the list. You can also drag multiple selected layers.

Reordering layers

Show or hide layers and objects
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You can hide or display any layer at any time, and you can hide or display objects on a layer. Hidden layers and
objects can’t be edited, and don’t appear on screen or in print. Hiding layers can be useful when you want to do
any of the following:

Hide parts of a document that are not meant to appear in the final document.

Hide alternate versions of a document.

Simplify the display of a document, to make it easier to edit other parts of the document.

Prevent a layer from printing.

Speed up screen redraw when a layer contains high-resolution graphics.

By default, text continues to wrap around objects on hidden layers. To ignore text wrap settings for hidden
objects, choose Layer Options from the Layers panel menu, and then select the Suppress Text Wrap When Layer
Is Hidden option.

Do any of the following:

To hide or show one layer at a time, in the Layers panel, click the square at the far left of a layer
name to hide or show the eye icon for that layer.

To show or hide individual objects in a layer, click the disclosure triangle to view all objects in a
layer, and then click the eye icon to show or hide the object.

To hide all layers except the selected layer, or to hide all objects on a layer except the selected
object, choose Hide Others in the Layers panel menu. Or, Alt-click (Windows) or Option-click (Mac
OS) the square on the far left side of the layer or object you want to remain visible.

To show all layers, choose Show All Layers in the Layers panel menu. Or, Alt-click (Windows) or
Option-click (Mac OS) the square on the far left side of a visible layer or object to show all layers or
all objects in a layer.

Set a layer as nonprinting

1. Select the layer in the Layers panel.
2. Choose Layer Options from the Layers panel menu.
3. To prevent the layer from being printed, deselect Print Layer, and then click OK.

Note:

When you print or export to PDF, you will still have the option of printing hidden and nonprinting layers.

Lock or unlock layers

Locking is useful for preventing accidental changes to a layer. A locked layer displays a crossed-out pencil icon in
the Layers panel. Objects on locked layers cannot be selected or edited directly; however, if objects on locked
layers have attributes that can be edited indirectly, they will change. For example, if you edit a tint swatch, objects
on locked layers using that tint swatch will reflect the change. Similarly, putting a series of threaded text frames on
both locked and unlocked layers will not prevent text on locked layers from recomposing.

You can also use the Layers panel to lock or unlock objects in a layer. See Lock or unlock objects.
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Do any of the following:

To lock or unlock one layer at a time, in the Layers panel, click a square in the second column from
the left to show (lock) or hide (unlock) the layer.

To lock all layers except the target layer, choose Lock Others in the Layers panel menu. Or, Alt-click
(Windows) or Option-click (Mac OS) the the square left of the layer you want to remain unlocked.

To unlock all layers, choose Unlock All Layers in the Layers panel menu.

Delete layers

Remember that each layer is document-wide—it appears on every page of a document. Before deleting a layer,
consider hiding all other layers first, and then turn to each page of the document to verify that it is safe to delete
the remaining objects.

Do any of the following:

To delete a layer, drag a layer from the Layers panel to the Delete icon  or choose Delete Layer
[layer name] from the Layers panel menu.

To delete multiple layers, hold Ctrl (Windows) or Command (Mac OS) while you click the layers to
select them. Then drag the layers from the Layers panel to the Delete icon or choose Delete Layers
from the Layers panel menu.

To delete all empty layers, choose Delete Unused Layers in the Layers panel menu.

To delete an object on a layer, select the object in the Layers panel, and then click the Delete icon.

Merge layers in a document

You can reduce the number of layers in a document without deleting any objects by merging layers. When you
merge layers, objects from all selected layers are moved to the target layer. Of the layers you merge, only the
target layer remains in the document; the other selected layers are deleted. You can also flatten a document by
merging all layers.

Note:

If you merge layers containing a mix of page objects and master items, the master items move to the back of the
resulting merged layer.

1. In the Layers panel, select any combination of layers. Be sure to include the layer you want to target as the
merged layer. If you’re flattening the document, select all layers in the panel.

2. Click any selected layer to make it the target layer, indicated by the pen.
3. Choose Merge Layers in the Layers panel menu.

You can also merge identically named layers for exporting a book to PDF.

Adobe also recommends

Show or hide frame edges
Prepare layers before exporting a book to PDF
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Laying out frames and pages
About paths and frames
Show or hide frame edges
Using placeholders to design pages
Redefine the purpose of paths and frames
About automatic layout adjustment

For detailed information and instructions, click the links below.

About paths and frames

You can draw objects in a document and use them as paths or as frames. Paths are vector graphics like those you
create in a drawing program such as Adobe Illustrator®. Frames are identical to paths, with only one difference—
they can be containers for text or other objects. A frame can also exist as a placeholder—a container without
contents. As containers and placeholders, frames are the basic building blocks for a document’s layout.

Paths and frames

A. Path B. Frame as graphic container C. Frame with placed graphic 

You can draw both paths and frames using tools in the Toolbox. You can also create frames by simply placing
(importing) or pasting contents into a path.

Note:

In QuarkXPress, paths are referred to as lines, and frames are referred to as boxes.

Because a frame is just a container version of a path, you can do anything to a frame that you can do to a path,
such as add a color or a gradient to its fill or stroke, or edit the shape of the frame itself with the Pen tool. You
can even use a frame as a path, or a path as a frame, at any time. This flexibility makes it easy to change your
design and provides a wide range of design choices.

Frames can contain text or graphics. A text frame determines the area to be occupied by text and how text will
flow through the layout. You can recognize text frames by the text ports in their respective upper left and lower
right corners.

A frame grid is a text frame, with a basic grid to determine character size and spacing within the frame attached.

A graphics frame can function as a border and background, and can crop or mask a graphic. When acting as an
empty placeholder, a graphics frame displays a crossbar.
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Text frame (left) and empty graphics frame (right)

If you don’t see the crossbar inside an empty graphics frame, the frame edges display may be turned off.

Show or hide frame edges

Unlike paths, you can see the nonprinting strokes (outlines) of frames by default even when the frames aren’t
selected. If the document window is getting crowded, use the Show/Hide Frame Edges command to simplify the
screen display by hiding the frame edges. Doing this also hides the crossbar in a graphics placeholder frame. The
display setting for frame edges doesn’t affect the display of the text ports on text frames.

Note:

The frame edge is defined as a frame’s stroke, not the outer edge of the stroke’s weight.

Do any of the following:

To show or hide frame edges, choose View > Extras > Show/Hide Frame Edges.

To hide frame edges, click Preview Mode  at the bottom of the Toolbox.

To show or hide a frame grid, choose View > Grids & Guides > Show Frame Grid, or View > Grids &
Guides > Hide Frame Grid.

Using placeholders to design pages

When your final text and graphics are available, you can simply add them to a document; InDesign automatically
creates frames when you import them (unless you’re importing text or graphics directly into existing frames).
However, when you don’t have the content yet or you want to block out the design before adding text and
graphics, you can use frames as placeholders.

Types of placeholders

A. Graphics frame placeholder B. Text frame placeholder 

For example, you might use any of these strategies:

Draw text frames using the Type tool, and draw graphics frames using the drawing tools. Thread empty
text frames together so that importing final text takes just one step.

Draw empty placeholder shapes using drawing tools. When you’re ready to start designating areas for text
and graphics, redefine the placeholders as either text or graphics frames.

Set frame fitting options for a placeholder frame so that when you place an image in the frame, the image
is cropped and fit accordingly.
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Redefine the purpose of paths and frames

To use a path or text frame as a graphics placeholder frame, select a path or an empty text frame, and
then choose Object > Content > Graphic.
To use a path or graphics frame as a text placeholder frame, select a path or an empty graphics frame, and
then choose Object > Content > Text.
To use a text or graphics frame as a path only, select an empty frame, and then choose Object >
Content > Unassigned.

Note:

When a frame contains text or graphics, you cannot redefine it using the Object > Content menu. However, if you
replace a graphic with text, the content type is automatically redefined.

About automatic layout adjustment

If you use the Document Setup or Margins and Columns commands to make changes to an existing layout, such
as altering column widths or page orientation, you could spend considerable time and effort in rearranging objects
to fit the new layout. The Layout Adjustment feature can do much of that work automatically. For example, you
can quickly reformat a wide four-column document designed for an A4-size page to a tall two-column format on a
U.S. legal-size page. With Layout Adjustment, text and graphics frames are moved and resized as necessary based
on the new relative positions of column guides, page margins, and page edges.

Note:

Dragging column guides does not trigger layout adjustment.

The Layout Adjustment feature produces more predictable results when a layout is tightly based on a framework of
margins, page columns, and ruler guides, and where objects are snapped to guides. Results are less predictable
when objects don’t adhere to margins, columns, and guides, or when extraneous ruler and column guides clutter a
page. Layout adjustment is not affected by the document grid or the baseline grid.

Page designed vertically, for print (left); page orientation changed for on-screen viewing, with layout automatically refitted by the Layout
Adjustment feature (right)

You can modify the rules in the Layout Adjustment dialog box. The Layout Adjustment feature attempts to
approximate the proportions of the old layout in the new layout by doing the following:

Adding or removing column guides, if the new layout specifies a different number of columns.

If the page size changes, moving ruler guides to maintain proportional distances from page edges, margins,
or column guides.

Moving objects already aligned to any margin, column, bleed/slug, or ruler guide, or to any two guides
perpendicular to each other, so that the objects stay with those guides if the guides move during layout
adjustment. Also, objects already aligned to any page edge or to any page edges perpendicular to each
other are moved.

Proportionally resizing objects already aligned to two parallel margin, column, bleed/slug, or ruler guides or
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to guides on three sides, so that the objects stay with those guides if the guides move during layout
adjustment. Also, objects aligned to two parallel page edges or to page edges on three sides are moved.

Maintain the relative position of objects that are anchored to the text as specified in the Anchored Object
Options dialog box.

Moving objects to keep them in the same relative position on the page, if the page size changes.

Note:

Layout Adjustment affects columns inside a text frame differently than it does page columns. If the frame itself is
resized by Layout Adjustment and the Fixed Column Width option is not selected in the Object > Text Frame
Options dialog box, text frame columns are resized proportionally. If the Fixed Column Width option is selected,
columns are added or removed as necessary.

Set options for layout adjustment

Note that changing options in the Layout Adjustment dialog box does not immediately change anything. Layout
adjustment is triggered only by changes to page size, page orientation, margins, or column settings, or when a
new master is applied. When you want to restore a layout to its previous state, you must undo the action that
triggered the layout adjustment.

1. Choose Layout > Layout Adjustment.

2. Select Enable Layout Adjustment.

3. Specify the layout adjustment options, and click OK.

Layout Adjustment options

Enable Layout Adjustment

Select this option so that layout adjustment will occur whenever you change page size, page orientation, margins,
or columns.

Snap Zone

Type a value to specify how near an object must be to the closest margin guide, column guide, or page edge to
snap to that element during layout adjustment.

Allow Graphics And Groups To Resize

Select this option to let the Layout Adjustment feature scale graphics, frames, and groups. When deselected,
graphics and groups can be moved by Layout Adjustment, but not resized.

Allow Ruler Guides To Move

Select this option when you want ruler guides to be repositioned by the Layout Adjustment feature.
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Ignore Ruler Guide Alignments

Select this option when ruler guides are not well positioned for layout adjustment. Objects will still align to column
and margin guides and to page edges.

Ignore Object And Layer Locks

Select this option when you want the Layout Adjustment feature to reposition objects that are locked individually,
or locked as a result of being on a locked layer.

Adobe also recommends

Understanding paths and shapes
Use document templates
Draw a placeholder shape
Set frame fitting options
Use multiple page sizes

  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.

Legal Notices   |   Online Privacy Policy

258

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
https://www.adobe.com/go/gffooter_online_privacy_policy


To the top

To the top

Layout grids
Layout grid overview
Change layout grid settings
Placing an object in a layout grid
Document windows with layout grids

Layout grid overview

For workflow, editorial designers for magazines tend to use paper-based workflows with layout sheets. InDesign’s
layout grid functions in the same way as this type of paper-based layout. In addition, InDesign's Layout Grid
differs from paper-based layout in that you can modify font size, stroke width, page count and other elements as
necessary in order to create customized layouts.

You can set a character grid (character size) using the Layout Grid and also arrange the grid to fit horizontal text
going from left to right, and vertical text starting from the top right hand corner.

A 2 paragraph vertical layout grid (left) A 2 paragraph horizontal layout grid (right)

With the Layout Grid you can snap an object into position in the same way as with a Document Grid or Baseline
Grid.

When creating a new document, click Layout Grid in the New Document dialog box and you can specify layout
settings in the New Layout Grid dialog box displayed. You can change the layout grid of an existing document or
apply a layout grid to a document created using Margins and Columns.

The page margins are determined by the outer edges of the layout grid (left) An object placed in a grid (right)

Change layout grid settings

When changing layout grid settings, note the following:

To specify application default settings for a document with layout grid, choose Layout > Layout Grid without
opening any documents, and modify the settings. These settings will be applied to new documents created
thereafter. Altering the default settings on the layout grid will also cause the frame layout application default
settings to change accordingly.

Changing settings in the Layout Grid dialog box can affect settings in the Margins and Columns dialog box.
The opposite can also occur. For example, when you change the number of columns in the Layout Grid
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dialog box, the new column setting will be reflected in the Margins and Columns settings. However, if the
values for Margins and Paragraphs is not divisible by the number of characters or lines designated in the
Layout Grid, gaps may appear in the Layout Grid or Column Margin Guide. To show no spaces around the
layout grid, open the Layout Grid dialog box, and click OK. The grid is adjusted as closely as possible to the
character grid border.

The Layout Grid option displayed in the Grid Format panel will be affected by the grid attributes from the
Layout Grid settings applied to the current page. If you apply several layout grids to one document, the
contents of Layout Grid settings will change according to the settings of the Layout Grid of the selected
page.

Change layout grid settings

1. Do any of the following:

To change the layout grid settings for one spread or page, move to the spread you want to change
or, select the spread or page in the Page panel.

To change the layout grid settings for multiple pages, select the pages in the Page panel, or select
the master page that controls the pages you want to change.

Layout grid settings can be set on individual pages, thus one document may contain a number of
different layout grids.

2. Choose Layout > Layout Grid, and change the settings.

3. Click OK.

Layout Grid options

The following options appear when you choose Layout Grid in the New Document dialog box or when you choose
Layout > Layout Grid.

Direction

Select Horizontal for text to flow left to right horizontally, and Vertical for text to flow top to bottom vertically.

Font

Select font family and font style.The font selected will become the Frame Grid default setting. Furthermore, if the
grid is set as ICF in the Character Grid in Preferences, the grid size varies depending on the ICF of the font
selected. (See Customize layout and frame grids.)

Size

Specify the font size to be used as a base for the body text in the layout grid. This determines the size of
individual grid cells within the layout grid.

Vertical and Horizontal

Specify the transformation ratio as a percentage for the font defined in the grid. The size of the grid will alter
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according to these settings.

Char Aki

Specify the letter spacing for the font defined in the grid. If a negative value is entered, the grids will appear
overlapping. When a positive value is set, a gap will appear between the grids.

Line Aki

Specify the line gap for the font defined in the grid. The grid line gaps will change according to the value entered.

With the exception of Direction, the values set for Font, Size, Horizontal, Vertical, Char Aki, Line Aki in the Grid
Attributes section will all become Frame Grid default settings. (See Create frame grids.)

Characters

Sets a Line Character (Grid) count.

Lines

Specifies the number of lines in 1 column.

Columns

Specifies the number of columns in 1 page.

Gutter

Specifies the distance between columns.

A. Columns B. Gutters 

Starting Point

Select the Starting Point option from the pop-up menu, and select the Top, Bottom, Right (or Outside) and Left (or
Inside) margins in each text box. The grid will be arranged from the selected position options according to the
values set in Grid Attributes and Lines and Columns. Any space left on the other side of the Starting Point becomes
the margin. For this reason, it is not possible to enter values into the text box outside the points forming the Grid
Base starting points. The margin opposite the starting point can be modified by changing the Grid Attributes and
Lines and Columns options values. When you select Center Completely and add a line or character, a layout grid
with the number of characters or lines set will be created from the center.

Inside is specified as the inside of the facing page, but when no facing page is specified, Inside is the left hand
side. Similarly, Outside is specified as the outside of the facing page, but when no facing page is designated,
Outside is the right hand side.  

Note:

If the values you specify for columns and gutters are such that the layout grid is larger than the page size, the
values for characters, gutters, and columns will be adjusted so that it fits on the page. To change the settings,
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choose Layout > Layout Grid after creating a new document, and specify different values.

A. Top/Outside starting point (right page) B. Center Horizontally starting point C. Bottom/Outside starting point (right page) D. Center
Completely starting point 

Show or hide the layout grid

Choose View > Grids & Guides > Show Layout Grid or View > Grids & Guides > Hide Layout Grid.

If you hide the Layout Grid, the appearance will be the same as a document created in the Margins and
Columns option. Each margin will be determined by values in the Starting Point settings.

Placing an object in a layout grid

Place the text, graphic, or sample text after setting the layout grid. Keep the following guidelines in mind when you
are designing pages for a layout grid:

You can place text frames, frame grids, and graphic frames in a document. You can also place text or
graphics in placeholder frames. For more information, see About paths and frames and Create text frames.

You cannot enter text directly in a layout grid. Use the Horizontal Grid tool  or Vertical Grid tool   to
create a frame grid and enter text. When Layout Grid is selected in the grid format panel, frame grids
created will use the character and spacing attributes of the layout grid. See Create frame grids.

When you drag an object in a layout grid, the object corner closest to the grid will snap to one of the four
corners of the grid. See Snapping objects to grids.

Document windows with layout grids

Each document or spread has a Pasteboard and Guide. This is displayed in Normal View mode. (To switch to
normal view, click Normal View Mode  in the Tools panel). When the document is displayed in any preview mode,
the Paste Board will be replaced by a gray background. You can alter the color of the preview background and
guide.

In a document window, structural areas of a page are marked by the following default colors:
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Black lines describe the size of each page in a spread. A thin drop shadow helps distinguish a spread from
its pasteboard. You can’t change the color of these lines.

Magenta lines are margin guides.

Violet lines are column guides.

The green box and lines are the layout grid.

The red line around the edge of the page shows the bleed area.

The blue line around the page shows the slug area.

Lines of different colors are the ruler guides. Ruler guides will be displayed in the color of the selected layer.

Column guides appear in front of margin guides. When a column guide is exactly in front of a margin guide,
it hides the margin guide.

Adobe also recommends

Create new documents
Create frame grids
Customize layout and frame grids
Change the grid display
CJK composition
Assign a layer color
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Managing graphics links
About links and embedded graphics
Links panel overview
Embed an image within the document
Update, restore, and replace links
Edit original artwork

About links and embedded graphics

When you place a graphic, you see a screen-resolution version of the file in the layout so that you can view and
position it. However, the actual graphic file may be either linked or embedded.

Linked artwork is connected to, but remains independent of, the document, resulting in a smaller document.
You can modify linked artwork using transformation tools and effects; however, you cannot select and edit
individual components in the artwork. You can use the linked graphic many times without significantly
increasing the size of the document; you can also update all links at once. When you export or print, the
original graphic is retrieved, creating the final output from the full resolution of the originals.

Embedded artwork is copied into the document at full resolution, resulting in a larger document. You can
control versions and update the file whenever you like; as long as the artwork is embedded, your document
is self-sufficient.

To determine if artwork is linked or embedded, or change its status from one to the other, use the Links panel.

If the bitmap image you place is 48K or smaller, InDesign automatically embeds the full-resolution image instead
of the screen-resolution version in your layout. InDesign displays these images in the Links panel, so that you can
control versions and update the file whenever you like; however, the link is not necessary for optimal output.

Note:

If you move a document to another folder or disk (for example, if you take it to a service provider), be sure that
you also move the linked graphics files; they are not stored inside the document. You can copy all related files
automatically, using the Preflight and Package features.

Links panel overview

All files placed in a document are listed in the Links panel. These include both local (on disk) files and assets that
are managed on a server. However, files that are pasted from a website in Internet Explorer do not display in this
panel.

In InCopy, the Links panel also displays linked stories. When you select a linked story in the Links panel, the Link
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Info section displays information such as the number of notes, the managed status, and the status of tracked
changes.

Links panel

A. Category columns B. Show/Hide Link Information C. One or more instances modified icon D. Modified icon E. Missing-link icon F.
Embedded-link icon 

When the same graphic appears several times in the document, the links are combined under a disclosure triangle
in the Links panel. When a linked EPS graphic or InDesign document contains links, the links are also combined
under a disclosure triangle.

A linked file can appear in the Links panel in any of the following ways:

Up to Date

An up-to-date file is blank in the Status column.

Modified

This icon means that the version of the file on disk is more recent than the version in your document. For example,
this icon appears if you import a Photoshop graphic into InDesign, and then you or someone else edits and saves
the original graphic in Photoshop.

A slightly different version of the Modified icon appears when a graphic is modified and one or more instances are
updated while others are not.

Missing

The graphic is no longer in the location from which it was imported, although it may still exist somewhere. Missing
links can happen if someone deletes the original file or moves it to a different folder or server after it’s been
imported. You can’t know whether a missing file is up to date until its original is located. If you print or export a
document when this icon is displayed, the file may not print or export at full resolution.

Embedded

Embedding the contents of a linked file suspends management operations for that link. If the selected link is
currently in an “edit in place” operation, this option is not enabled. Unembedding the file restores management
operations to the link.

If a linked object does not appear on a specific document page, the following codes indicate where the object
appears: PB (pasteboard), MP (master page), OV (overset text), and HT (hidden text).

For a video tutorial on using the Links panel, see www.adobe.com/go/lrvid4027_id.

InDesign Secrets provides a videocast on Links panel tips and techniques at Saving time with the Links panel.

Use the Links panel
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To display the Links panel, choose Window > Links. Each linked file and automatically embedded file is
identified by name.
To select and view a linked graphic, select a link in the Links panel and then click the Go To Link button 

, click the page number of the link in the Page column, or choose Go To Link in the Links panel menu.
InDesign centers the display around the selected graphic. To view a hidden object, you show the layer (or
condition if it’s an anchored object).
To expand or collapse nested links, click the triangle icon to the left of the link. Nested links occur when the
same graphic appears several times in the document or when the linked EPS graphic or InDesign document
contains links.
To sort links in the panel, click the category title at the top of the Links panel to sort by that category. Click
the same category again to reverse the order. For example, if you click the Page category, the links appear
in their order from the first page to the last page. If you click Page again, the links are sorted from last
page to first. Use Panel Options to add columns to the Links panel.

Work with Links panel columns

You can display additional categories, such as Creation Date and Layer, in the Links panel to display more
information about the graphics. For each category, you can determine whether the information appears as a
column in the Links panel and in the Link Info section at the bottom of the Links panel.

1. Choose Panel Options from the Links panel menu.
2. Select the check boxes under Show Column to add columns in the Links panel.

Folder 0 is the folder that contains the linked file; Folder 1 is the folder that contains Folder 0, and so on.

3. Select the check boxes under Show In Link Info to display the information in the Link Info section at the
bottom of the Links panel.

4. Click OK.

You can change the order of columns by selecting a column and dragging it to a different location. Drag the
column boundaries to change the column width. Click a category title to sort the links by that category in
ascending order. Click again to sort in descending order.

Change the Links panel rows and thumbnails

1. Choose Panel Options from the Links panel menu.
2. For Row Size, select Small Rows, Regular Rows, or Large Rows.
3. For Thumbnails, determine whether thumbnail representations of the graphics appear in the Name column

and in the Link Info section at the bottom of the Links panel.
4. Click OK.

Display link information

The Link Info section of the Links panel lists information about the selected linked file.

To change the information displayed in the Link Info section of the Links panel, choose Panel Options from the
Links panel menu, and select check boxes in the Show In Link Info column.

Double-click a link, or select a link and click the Show/Hide Link Information icon, which is a triangle on the
left side of the panel.
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View metadata via the Links panel

If a linked or embedded file contains metadata, you can view the metadata using the Links panel. You cannot edit
or replace metadata associated with a linked file.

Select a file in the Links panel and choose Utilities > XMP File Info from the panel menu.

Embed an image within the document

Rather than link to a file that you’ve placed in a document, you can embed (or store) the file within the document.
When you embed a file, you break the link to the original. Without the link, the Links panel doesn’t alert you when
the original has changed, and you cannot update the file automatically.

Embedding a file increases the document file size.

Embed a linked file

1. Select a file in the Links panel.
2. Do any of the following:

Choose Embed Link in the Links panel menu.

If there are multiple instances of the file, choose Embed All Instances Of [Filename] in the Links
panel menu. To embed only one instance, select it and choose Embed Link.

The file remains in the Links panel marked with the embedded-link icon .

Note:

For a text file that appears in the Links panel, select Unlink in the Links panel menu. When you embed a text file,
its name is removed from the Links panel.

Unembed a linked file

1. Select one or more embedded files in the Links panel.
2. Do one of the following:

Select Unembed Link in the Links panel menu. If there are multiple instances of the file, choose
Unembed All Instances Of [Filename] in the Links panel menu.

Click the Relink button  or select Relink in the Links panel menu.

3. Choose to link the file to the original file or to a folder InDesign creates from the embedded data stored in
the document.

Update, restore, and replace links
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Use the Links panel to check the status of any link, or to replace files with updated or alternate files.

When you update or reestablish (relink) a link to a file, any transformations performed in InDesign are preserved
(if you choose Relink Preserved Dimensions in the File Handling preferences). For example, if you import a square
graphic and rotate it 30°, and then you relink it to an unrotated graphic, InDesign rotates it 30° to match the
layout of the graphic it’s replacing.

Note:

Placed EPS files may contain OPI links, which appear in the Links panel. Don’t relink OPI links to files other than
those originally intended by the creator of the EPS file; doing so can cause problems with font downloading and
color separations.

Choose how relinked graphics are scaled

When you relink to replace one graphic with a different source file, you can keep the image dimensions of the file
that’s being replaced, or you can display the incoming file in its actual dimensions.

1. Choose Edit > Preferences > File Handling (Windows) or InDesign > Preferences > File Handling (Mac OS).

2. Choose Preserve Image Dimensions When Relinking if you want images to appear at the same size as the
images they’re replacing. Deselect this option to have relinked images appear at their actual size.

Update modified links

InDesign first looks for a missing link in the folder in which another file has been relinked in the current session.
Next, it looks for a link in the same folder where the document is located. If it’s still not found, it looks in the
parent folder of the document.

Modified links are also called “out of date” links.

In the Links panel, do one of the following:

To update specific links, select one or more links marked with the modified-link icon . Then click
the Update Link button , or choose Update Link from the Links panel menu.

To update all modified links, choose Update All Links from the Links panel menu, or select a modified
link and Alt-click (Windows) or Option-click (Mac OS) the Update Link button.

To update only one link to a graphic that appears in several places in the document, select only the
sublink and choose Update Link. If you select the “parent” link, you can update all links to the
modified graphic.

Replace a link with a different source file

1. Select any link in the Links panel, and click the Relink button  or choose Relink from the Links panel
menu. If a “parent” link of multiple instances is selected, choose Relink All Instances Of [Filename] from the
Links panel menu.

Relink is disabled in managed stories unless a story is checked out.

2. In the dialog box that appears, select Search For Missing Links In This Folder if you want InDesign to
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search the folder for files that have the same names as other missing linked files. If this option is not
selected, only the selected image is relinked.

3. Choose Show Import Options to control how the new source file is imported.
4. Locate and double-click the new source file.
5. Choose import options if you clicked the Show Import options option. (See Import options for graphics.)

Restore missing links

1. To restore a missing link, select any link marked with the missing link icon  in the Links panel, and click
the Relink button .

2. In the dialog box that appears, select Search For Missing Links In This Folder to relink any missing file that
appears in the specified folder. Locate and double-click a file.

Find missing links

By default, InDesign checks for missing links and tries to resolve them when you open a document. Two
preference options let InDesign check for and find missing links automatically when you open a document.

Check Links Before Opening Document

If you turn off this option, InDesign opens the document immediately, and the link statuses remain pending until
links are determined to be up-to-date, missing, or modified. If you turn on this option, InDesign checks for
modified or missing links.

Find Missing Links Before Opening Document

If you turn off this option, InDesign does not attempt to resolve the missing links. You may want to turn off this
option if links slow performance to a server or if unexpected linkings occur. This option is dimmed if Check Links
Before Opening Document is turned off.

Search For Missing Links

Use the Search For Missing Links command to search for and resolve missing links in your document. This
command is useful if you turned off the preferences option that checks for missing links when you open a
document, and now you have missing links. This command is also useful if you mount a server where images are
stored after opening a document.

To change link settings, open the File Handling section of the Preferences dialog box, and determine
whether the Check Links Before Opening Document and Find Missing Links Before Opening Document
options are selected.
To let InDesign attempt to resolve missing links, choose Utilities > Search For Missing Links from the Links
panel menu.

This command is dimmed if the document contains no missing links.

Specify a default Relink folder

1. In the Preferences dialog box, select File Handling.
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2. From the Default Relink Folder menu, choose either of the following options, and then click OK:

Most Recent Relink Folder

This option displays the most recently used folder you selected when relinking, matching InDesign CS3
behavior.

Original Link Folder

This option displays the original location of the linked file, matching the behavior of InDesign CS2 and
earlier.

Copy links to a different folder

Use the Copy Link(s) To command to copy graphics files to a different folder and redirect the links to the copied
files. This command is especially useful for moving files to a different drive, such as moving files from a DVD to a
hard drive.

1. Select the links to the files you want to copy, and choose Utilities > Copy Link(s) To from the Links panel
menu.

2. Specify the folder where the linked files will be copied and choose Select (Windows) or Choose (Mac OS).

Relink to a different folder

When you use the Relink To Folder command, you can point to a folder that contains files with the same names as
your out-of-date links. For example, if your current links point to low-resolution images, you can specify a different
folder that contains high-resolution images. You can specify a different extension for the files, allowing you to
change links from .jpg to .tiff, for example.

The Relink To Folder command is dimmed in a managed InCopy story unless the story is checked out.

1. Select one or more links in the Links panel.
2. Choose Relink To Folder from the Links panel menu.
3. Specify the location of the new folder.
4. To use a different extension, select Match Same Filename But This Extension, and specify the new

extension (such as AI, TIFF, or PSD).
5. Click Select (Windows) or Choose (Mac OS).

Relink files with different file extensions

The Relink File Extension command lets you replace images based on file extensions. For example, if you have
several JPEG images in your document, you can replace them with PSD files. The files with different extensions
must be in the same folder as the linked files being replaced.

1. Make sure the files with different file extensions appear in the same folder as the original files.
2. Select one or more links in the Links panel.
3. Choose Relink File Extensions from the Links panel menu.
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4. Specify the file extension to replace the selected files, and click Relink.

Replace an imported file using the Place command

1. Do one of the following:

To replace the contents of a graphics frame, such as an imported graphic, use the Selection tool  to
select the frame.

To replace the contents of a graphics frame, such as an imported graphic, use the Position tool to
select the image.

To replace the contents of a text frame, use the Type tool to click an insertion point in a text frame,
and choose Edit > Select All.

2. Choose File > Place.
3. Locate and select the new file.
4. Make sure that Replace Selected Item is selected, and then click Open.
5. Click Open.

Copy the link pathname

You can copy either the full path of the linked image or the platform style path. Copying the full path of the image
is useful for notifying team members where art is located. For example, you can copy the full path and paste it into
an email message. Copying the platform path is useful for scripting or for specifying image fields in a data merge.

1. Select a link in the Links panel.
2. From the Links panel menu, choose Copy Info > Copy Full Path or Copy Platform Style Path.
3. Paste the path.

Edit original artwork

The Edit Original command lets you open most graphics in the application in which you created them so that you
can modify them as necessary. Once you save the original file, the document in which you linked it is updated with
the new version.

Note:

In InDesign, if you check out and select a managed graphics frame (one that has been exported to InCopy), rather
than the graphic itself, the graphic opens in InCopy.

Edit original artwork using the default application

By default, InDesign relies on the operating system to determine which application is used when opening the
original.

1. Select one or more images on the page or in the Links panel.
2. Do any of the following:
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In the Links panel, click the Edit Original button .

Choose Edit > Edit Original.

3. After making changes in the original application, save the file.

Edit original artwork using a different application

1. Select the image.
2. Choose Edit > Edit With, and then specify the application you want to use to open the file. If the application

does not appear, choose Other, and browse to locate the application.

Adobe also recommends

Define preflight profiles
Package files
Links panel video
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Managing pages and spreads
Move, duplicate, and delete pages and spreads

Control spread pagination
Rotate the spread view
Use multiple page sizes

Move, duplicate, and delete pages and spreads

You can use the Pages panel to freely arrange, duplicate, and recombine pages and spreads. Keep the following
guidelines in mind when adding, arranging, duplicating, or removing pages within a document:

InDesign preserves the threads between text frames.

InDesign redistributes pages according to how the Allow Document Pages To Shuffle command is set.

An object that spans multiple pages stays with the page on which the object’s bounding box covers the
most area.

Move pages using Move Pages command

1. Choose Layout > Pages > Move Pages, or choose Move Pages from the Pages panel menu.
2. Specify the page or pages you want to move.
3. For Destination, choose where you want to move the pages, and specify a page if necessary. Click OK.

Move pages by dragging

As you drag, the vertical bar indicates where the page will appear when you drop it. If the black rectangle
or bar touches a spread when Allow Pages to Shuffle is turned off, the page you’re dragging will extend
that spread; otherwise, document pages will be redistributed to match the Facing Pages setting in the File >
Document Setup dialog box.

In the Pages panel, drag a page icon to a new position within the document.

Moving a page’s position using the Pages panel

Duplicate a page or spread

In the Pages panel, do one of the following:
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Drag the page range numbers under a spread to the New Page button. The new spread appears at
the end of the document.

Select a page or spread, and then choose Duplicate Page or Duplicate Spread in the Pages panel
menu. The new page or spread appears at the end of the document.

Press Alt (Windows) or Option (Mac OS) as you drag the page icon or page range numbers under a
spread to a new location.

Note:

Duplicating a page or spread also duplicates all objects on the page or spread. Text threads from the duplicated
spread to other spreads are broken, but all text threads within the duplicated spread remain intact—as do all text
threads on the original spread.

Remove a page from a spread while keeping it in the document

1. Select the spread and deselect Allow Selected Spread To Shuffle in the Pages panel menu.
2. In the Pages panel, drag a page out of the spread until the vertical bar is not touching any other pages.

Delete a page or spread from the document

Do one of the following:

In the Pages panel, drag one or more page icons or page-range numbers to the Delete icon.

Select one or more page icons in the Pages panel, and click the Delete icon.

Select one or more page icons in the Pages panel, and then choose Delete Page(s) or Delete
Spread(s) in the Pages panel menu.

When you move or copy a page or spread from one document to another, all of the items on the page or spread,
including graphics, links, and text, are copied to the new document. Section markers are preserved. Threaded text
frames are also included, but text that is threaded to pages outside the spread does not transfer. If the page or
spread you are copying contains styles, layers, or masters with the same names as their counterparts in the
destination document, the destination document’s settings are applied to the page or spread.

If you copy a page from a document that has a different size than the document you are copying to, the page and
page item positions may not match exactly.

If you want to move or copy a multiple-page spread, deselect Allow Document Pages To Shuffle in the destination
document to keep the spread together.

Move or copy pages between documents

1. To move pages from one document to another, open both documents.
2. Choose Layout > Pages > Move Pages, or choose Move Pages from the Pages panel menu.
3. Specify the page or pages you want to move.
4. Choose the destination document name from the Move To menu.
5. For Destination, choose where you want to move the pages, and specify a page if necessary.
6. If you want to remove the pages from the original document, select Delete Pages After Moving.

Note:
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When you copy pages between documents, their associated masters are copied automatically. If the new
document contains a master with the same name as the master applied to the copied page, however, the master
of the new document is applied to the copied page instead.

Move or copy pages between documents by dragging

1. To move pages from one document to another, make sure that both documents are open and visible.

You can choose Window > Arrange > Tile to display documents side-by-side.

2. Drag the original document’s page icon to the new document.
3. In the Insert Pages dialog box, specify where the pages will be added.
4. If you want to remove the pages from the original document, select Delete Pages After Inserting.

Control spread pagination

Most documents use two-page spreads exclusively. When you add or remove pages before a spread, the pages
shuffle by default. However, you may want to keep certain pages in a spread together. For example, you can
create gatefold or accordion foldouts by creating a multiple-page spread (also called an island spread) and adding
pages to it. By not allowing pages to shuffle, you can ensure that pages are kept in the same spread.

Pages panel

A. One-page spread B. Four-page spread, identified by brackets around page numbers C. Entire two-page spread selected 

Create a multiple-page spread

1. Do one of the following:

To keep a single spread together, select a spread in the Pages panel, and then deselect Allow
Selected Spread To Shuffle in the Pages panel menu. You can identify an island spread in the Pages
panel by the brackets around its page numbers.

To allow the creation of spreads of more than two pages in the entire document and to preserve
those spreads when you add, remove, or arrange preceding pages, deselect Allow Document Pages
To Shuffle on the Pages panel menu. InDesign will preserve spreads of more than two pages while
letting two-page spreads repaginate normally.

2. Add pages to the selected spread either by using Insert Pages to insert a new page in the middle of a
spread or by dragging an existing page to the spread in the Pages panel. To drag an entire spread, drag its
page numbers.

Adding a page to a spread using the Pages panel

Note:

You can include up to ten pages in a spread. When you have reached the limit, the black vertical bar will not
appear.
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Redistribute pages

You can redistribute a spread’s pages to match the Facing Pages setting in the File > Document Setupdialog box.

Do either of the following:

If an individual spread has been allowed to shuffle, select the spread, and choose Allow Selected
Spread To Shuffle in the Pages panel menu to select it.

If document pages have been allowed to shuffle and you added pages to a spread, choose Allow
Document Pages To Shuffle from the Pages panel menu to select it. Click No to redistribute pages. If
you click Yes to maintain the multiple-page spreads, brackets surround the numbers on those
spreads in the Pages panel, indicating that those spreads are not allowed to shuffle.

Start a document with a two-page spread

Instead of beginning the document with a single page, you can begin your document with a two-page spread.

1. Do either of the following actions:

To create a document, choose File > New Document.

To edit an existing document, choose File > Document Setup.

2. For Start Page #, specify an even number, such as 2, and then click OK.

Rotate the spread view

In some instances, you need to edit rotated content. Instead of turning your head sideways to look at the rotated
content, you can rotate the spread view. This option is especially useful for working on rotated calendars and
tables.

Rotating the spread view does not affect printing or output.

Rotating the spread

A. Before rotating spread B. Rotated spread view C. Rotate icon in Pages panel 

1. In the Pages panel, select the page or spread that you want to rotate.

2. Do any of the following:

From the Pages panel menu, choose Rotate Spread View > 90° CW, 90° CCW, or 180°.

Choose View > Rotate Spread > 90° CW, 90° CCW, or 180°.

A rotation icon  appears next to the rotated spread in the Pages panel.

Objects you place or create mirror the rotated view. For example, if you create a text frame when the spread view
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is rotated 90 degrees, the text frame is also rotated. However, objects you paste are not rotated.

When transforming objects, keep in mind that you’re working on a rotated page view. For example, if you’re
editing a table on a rotated spread view, changing the “left” side of the table will change what appears to be the
top of the table in the rotated view.

Before you output the file or send it to someone else, it’s a good idea to avoid confusion by clearing the spread
rotation. Choose View > Rotate Spread > Clear Rotation.

Use multiple page sizes

You can define different page sizes for pages within a single document. This feature is especially useful when you
want to manage related designs in one file. For example, you can include business card, postcard, letterhead, and
envelope pages in the same document. Using multiple page sizes is also useful for creating gate-fold layouts in
magazines.

For video tutorials on creating multiple page sizes in a document, see www.adobe.com/go/lrvid5153_id_en and
http://tv.adobe.com/go/4950/.

Multiple page sizes in same document

A. Magazine page B. Gate-fold page C. Spine page 

Create different page sizes within a document

Use the Page tool to select the master page or layout page you want to resize, and then use the Control panel to
change the settings. A page inherits its page size from its master page, but you can change the size of a layout
page so that it’s different from the master page applied to it. A master page can be based on another master page
of a different size, so that a range of pages of mixed sizes can share the same master content.

To apply a different page size quickly, select the page in the Pages panel, and then choose a page size from the
Edit Page Size button .

1. Using the Page tool , select one or more master pages or layout pages that you want to resize.

Make sure that the entire page is selected in the layout, not only in the Pages panel.

2. Specify settings in the Control panel to change the page size of the selected pages:

X and Y values

Change the Y value to determine the vertical position of the page in relation to other pages in the spread.

W and H page size values

Change the width and height of the selected pages. You can also specify a page size preset from the menu.
To create a custom page size that appears in this list, choose Custom Page Size from the menu, specify the
page size settings, and click OK.
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Orientation

Select a landscape or portrait page orientation.

Enable Layout Adjustment

Select this option if you want the objects on the page to be adjusted automatically when the page size
changes. See About automatic layout adjustment.

Show Master Page Overlay

Select this option to display a master page overlay on top of any page that is selected with the Page tool.

Objects Move With Page

Select this option to make the objects move along with the page when you adjust the X and Y values.

Use master page overlays

When you use the Page tool to select a page and turn on the Show Master Page Overlay option, a shaded box
appears over the selected page. You can move the master page overlay so that master page items appear in the
proper location. The Show Master Page Overlay option is especially useful if the master page and document page
have different page sizes.

Aligning the master page overlay to a smaller layout page

1. Using the Page tool, select a page.

2. In the Control panel, select Show Master Page Overlay.

3. Drag the edge of the master page overlay to position the page items.

  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.
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Sivupohjat

Alkuun

Alkuun

Tietoja sivupohjista, pinoamisjärjestyksestä ja tasoista
Sivupohjien luominen
Sivupohjien käyttäminen
Sivupohjien kopioiminen
Sivupohjan poistaminen julkaisusta
Sivupohjakohteiden ohittaminen tai vapauttaminen
Sivupohjan tuominen toisesta julkaisusta

Katso lisätietoja ja ohjeita napsauttamalla seuraavia linkkejä.

Tietoja sivupohjista, pinoamisjärjestyksestä ja tasoista
Sivupohja on tausta, jota voi käyttää nopeasti useilla sivuilla. Sivupohjan objektit näkyvät kaikilla sivuilla, joilla pohjaa käytetään. Julkaisun sivuilla
näkyviä sivupohjakohteita ympäröi pisteviiva. Sivupohjiin tehdyt muutokset tulevat automaattisesti sivuille, joilla sivupohjaa käytetään. Sivupohjat
sisältävät yleensä toistuvia logoja, sivunumeroita sekä ylä- ja alatunnisteita. Ne voivat sisältää myös tyhjiä teksti- tai grafiikkakehyksiä, joita
käytetään paikkamerkkeinä julkaisun sivuilla. Sivupohjan kohdetta ei voi valita julkaisusivulla, ellei sitä ohiteta.

Sivupohjissa voi olla useita tasoja samalla tavoin kuin julkaisun sivuissa. Yksittäisen tason objekteilla voi olla oma pinoamisjärjestyksensä tason
sisällä. Sivupohjan tason objektit näkyvät julkaisun sivulla samalle tasolle määritettyjen objektien takana.

Jos haluat sivupohjakohteen näkyvän julkaisusivulla objektien edessä, sijoita objekti ylemmälle tasolle sivupohjassa. Ylemmällä tasolla oleva
sivupohjakohde näkyy kaikkien alemmilla tasoilla olevien objektien edessä. Kaikkien tasojen yhdistäminen siirtää sivupohjakohteet julkaisun
sivuobjektien taakse.

Sivupohjakohteet (ylävasemmalla) näkyvät saman tason sivuobjektien takana (alavasemmalla). Sivupohjakohteen siirtäminen ylemmälle tasolle
(yläoikealla) siirtää sen kaikkien alemman tason objektien eteen (alaoikealla).

Sivupohjiin liittyviä vihjeitä ja ohjeita

Voit vertailla muotoiluideoita toisiinsa luomalla eri sivupohjia ja käyttämällä niitä esimerkkisivuissa, joilla on julkaisulle tyypillistä sisältöä.

Voit asetella nopeasti uusia julkaisuja tallentamalla sivupohjia julkaisumalliin. Voit tallentaa myös kappale- ja merkkityylejä, värikirjastoja sekä
muita tyylejä ja oletusarvoja.

Jos muutat sivupohjan palsta- ja reunusasetuksia tai käytät uutta sivupohjaa, jossa on erilaiset palsta- ja reunusasetukset, voit pakottaa sivun
objektit automaattisesti uuteen asetteluun. (Lisätietoja: Tietoja automaattisesta sivuasettelun säädöstä.)

Sivupohjaan lisätyt automaattiset sivunumerot näyttävät oikean sivunumeron julkaisun kaikissa sivupohjaan perustuvissa osioissa. (Katso
Lisää perussivunumerointi.)

Sivupohjien luominen
Kaikilla luomillasi sivuilla on oletusarvoisesti sivupohja. Voit luoda muita sivupohjia alusta lähtien tai nykyisen sivupohjan tai julkaisun sivun
perusteella. Kun käytät sivupohjia muihin sivuihin, lähdepohjaan tehdyt muutokset siirtyvät siihen perustuviin sivupohjiin ja julkaisun sivuihin. Tällä
tavoin voit helposti muuttaa asettelua useilla sivuilla koko julkaisussa.

Voit katsoa sivupohjien käyttöä käsittelevän video-opastusohjelman osoitteessa www.adobe.com/go/vid0069_fi.
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Sivupohjan luominen alusta lähtien
1. Valitse Sivut-paneelivalikosta Uusi sivupohja.
2. Määritä seuraavat asetukset ja valitse OK:

Kirjoita Etuliite-kohtaan etuliite, jolla käytetty sivupohja tunnistetaan jokaisella Sivut-paneelin sivulla. Kirjoita enintään neljä merkkiä.

Kirjoita Nimi-ruutuun aukeamapohjan nimi.

Valitse Perustuu sivupohjaan -kohdassa olemassa oleva aukeamapohja, johon tämä aukeamapohja perustuu, tai valitse Ei mitään.

Kirjoita Sivumäärä-kohtaan sivupohjan sivumäärä (enintään 10).

Sivupohjan luominen olemassa olevasta sivusta tai aukeamasta
Vedä koko aukeama Sivut-paneelin Sivut-osiosta Pohjat-osioon.
Valitse aukeama Sivut-paneelista ja valitse Sivut-paneelivalikosta Tallenna sivupohjana.

Kaikki alkuperäisen sivun tai aukeaman objektit tulevat osaksi uutta sivupohjaa. Jos alkuperäinen sivu käyttää sivupohjaa, uusi sivupohja perustuu
alkuperäisen sivun sivupohjaan.

Toiseen sivuun tai aukeamaan perustuvan uuden aukeamapohjan luominen

Toiseen sivupohjaan perustuvan sivupohjan luominen
Voit luoda aukeamapohjasta muunnelman, joka perustuu saman julkaisun sisältämään toiseen aukeamapohjaan ja jota päivitetään samalla sen
(yläaukeamapohja) kanssa. Yläaukeamapohjaan perustuvat aukeamapohjat ovat aliaukeamapohjia. Jos julkaisussa on esimerkiksi kymmenen
lukua, joissa käytetään toisistaan hyvin vähän poikkeavia aukeamapohjia, voit ottaa niiden pohjaksi aukeamapohjan, jonka sivuasettelu ja objektit
ovat kaikille kymmenelle luvulle yhteiset. Jos haluat muuttaa perusmuotoilua, muokkaa vain yläaukeamapohjaa sen sijaan, että muokkaisit kaikkia
kymmentä erikseen. Vaihtele aliaukeamapohjien muotoilua. Yläaukeamapohjakohteet voidaan ohittaa aliaukeamapohjassa, aivan kuten julkaisun
sivuilla ohitetaan sivupohjakohteita. Näin aukeamapohjasta voidaan luoda muunnelmia. Näin voit pitää yhdenmukaisen ja samalla vaihtelevan
muotoilun ajan tasalla.

Alkuperäiset ylä- ja aliaukeamapohjat (vasen). Kun yläaukeamapohjaa muokataan, aliaukeamapohja päivittyy automaattisesti (oikea).

 Jos haluat luoda toiseen sivupohjaan perustuvan sivupohjan, tee Sivut-paneelin Pohjat-osiossa jokin seuraavista:

Valitse ensin aukeamapohja ja sitten Sivut-paneelivalikosta Pohjan asetukset kohteelle [aukeamapohjan nimi]. Valitse kohdassa Perustuu
sivupohjaan jokin toinen sivupohja ja valitse OK.

Valitse perustana käytettävän aukeamapohjan nimi ja ota se käyttöön vetämällä se toisen aukeamapohjan nimen päälle.

A-sivupohjaan perustuva B-sivupohja

Sivupohjan asettelun muokkaaminen
Voit muokata sivupohjien asettelua koska tahansa. Tehdyt muutokset tulevat automaattisesti kaikille sivuille, joissa sivupohjaa käytetään.
Esimerkiksi kaikki sivupohjaan lisäämäsi teksti tai grafiikka näkyy niillä julkaisun sivuilla, joissa sivupohjaa on käytetty.
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Huomautus: jos ohitat tai vapautat sivupohjan objektin jollakin sivulla, objekti ei ehkä päivity sivupohjaan tehtyjen muutosten mukaan.
1. Kaksoisnapsauta muokattavan sivupohjan kuvaketta Sivut-paneelissa tai valitse sivupohja julkaisuikkunan alaosan luettelosta.

Aukeamapohja näytetään julkaisuikkunassa.
2. Tee muutokset sivupohjaan.

InDesign päivittää automaattisesti kaikki sivupohjaa käyttävät sivut.

Jos haluat muuttaa sivupohjan kokoa, valitse se Sivutyökalulla ja muuta sitten sivun mittoja Ohjauspaneelin asetuksista. Katso Useiden
sivukokojen käyttäminen.

Tarkastele sivupohjan muokkausta useissa näkymissä. Valitse Ikkuna > Järjestä > Uusi ikkuna ja valitse sitten Ikkuna > Järjestä > Vierekkäin.
Aseta sivu yhteen näkymään ja sivupohja toiseen näkymään. Muokkaa sivupohjaa, niin näet, miten sivu päivittyy.

Sivupohjan asetusten muuttaminen
Voit muokata sivupohjan asetuksia. Voit muuttaa sivupohjan nimen tai etuliitteen, perustaa sivupohjan toiselle sivupohjalle tai muuttaa
aukeamapohjan sivujen määrää.

1. Valitse Sivut-paneelista aukeamapohja napsauttamalla sen nimeä.
2. Valitse Sivut-paneelin valikosta Pohjan asetukset kohteelle [sivupohjan nimi].
3. Muuta haluamasi asetukset ja valitse sitten OK.

Sivupohjien käyttäminen
Jos julkaisussa on mukautettuja aukeamia (esimerkiksi aikakauslehdessä kolme- tai nelisivuinen taitettava sivu), käytettävissä sivupohjissa on
oltava sama sivumäärä.

Jos sivupohjassasi on eri sivukoko kuin asettelusivussa, sivupohjan käyttäminen muuttaa asettelusivun kokoa. Jos asettelusivussa on mukautettu
sivukoko, voit määrittää pidetäänkö mukautettu koko asettelusivussa vai käytetäänkö sivupohjan kokoa.

Huomautus: Julkaisusivun sivupohjakohteilla on pisteviivareunat. Jos et näe sivupohjakohteita julkaisun sivulla, sivupohjakohde voi olla kätketty
alemmalle tasolle tai sivupohjakohteet voi olla kätketty. Valitse Sivut-paneelivalikosta Näytä sivupohjakohteet.

Sivupohjan käyttäminen julkaisun sivulla tai aukeamalla
Jos haluat käyttää sivupohjaa yhdellä sivulla, vedä sivupohjakuvake Sivut-paneelin sivukuvakkeen päälle. Vapauta hiiren painike, kun musta
suorakulmio ympäröi haluamasi sivun.
Jos haluat käyttää sivupohjaa aukeamalla, vedä sivupohjakuvake Sivut-paneelissa aukeaman kulmaan. Vapauta hiiren painike, kun musta
suorakulmio ympäröi haluamasi sivut.

Sivupohjan käyttäminen sivulla (vasen) ja aukeamalla (oikea)

Sivupohjan käyttäminen usealla sivulla
 Tee jokin seuraavista:

Valitse Sivut-paneelista sivut, joilla haluat käyttää uutta sivupohjaa. Paina sitten Alt- (Windows) tai optionäppäintä (Mac OS) napsauttaessasi
sivupohjaa.

Valitse Sivut-paneelin valikosta Käytä sivupohjaa sivuilla, ja valitse sitten sivupohja kohdasta Käytä sivupohjaa. Varmista, että Sivuilla-
kohdassa on haluttu sivualue, ja valitse OK. Voit käyttää sivupohjaa heti usealla sivulla. Voit esimerkiksi käyttää samaa sivupohjaa sivuilla 5,
7 - 9 ja 13 - 16 kirjoittamalla 5, 7-9, 13-16. (Lisätietoja: Absoluuttisen tai osion numeroinnin näyttäminen Sivut-paneelissa.)

Sivupohjan käyttäminen erillisillä sivualueilla

Sivupohjien määrityksen poistaminen julkaisun sivuilta
 Valitse Sivut-paneelin Pohjat-osiosta sivupohjaksi Ei mitään.

Kun poistat sivupohjan määrityksen sivulta, sivupohjan asettelu ja kohteet eivät ole enää voimassa kyseisellä sivulla. Jos sivupohja sisältää
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suurimman osan tarvitsemistasi elementeistä, mutta haluat vielä mukauttaa joidenkin sivujen ulkonäköä, voit ohittaa sivupohjakohteet ja muokata
niitä kyseisillä julkaisun sivuilla sen sijaan, että poistaisit sivupohjan määrityksen.

Sivupohjien kopioiminen
Voit kopioida sivupohjia saman julkaisun sisällä tai julkaisusta toiseen uuden sivupohjan perustaksi. Voit myös kopioida sivupohjia toisiin
julkaisuihin synkronoidessasi kirjan julkaisuja tai tuoda sivupohjia toisesta julkaisusta.

Sivupohjan kopioiminen julkaisussa
 Tee Sivut-paneelissa jokin seuraavista:

Vedä aukeamapohjan sivun nimi paneelin alaosan Uusi sivu -painikkeeseen.

Valitse ensin aukeamapohjan sivun nimi ja sitten paneelivalikosta Monista aukeamapohja [aukeaman nimi].

Kun kopioit sivupohjan, kopioidun sivupohjan sivun etuliitteestä tulee aakkosten seuraava kirjain.

Sivupohjan kopioiminen tai siirtäminen toiseen julkaisuun
1. Avaa ensin julkaisu, johon haluat lisätä sivupohjan. Avaa sitten julkaisu, jonka sivupohjan haluat kopioida.
2. Tee lähdejulkaisun Sivut-paneelissa jokin seuraavista:

Kopioi aukeamapohja napsauttamalla ja vetämällä se kohdejulkaisun ikkunaan.

Valitse sivupohja, jonka haluat siirtää tai kopioida. Valitse Sivuasettelu > Sivut > Siirrä sivupohjaa ja valitse kohdejulkaisun nimi Siirrä-
valikosta. Jos haluat poistaa sivut lähdejulkaisusta, valitse Poista sivut siirron jälkeen ja valitse OK.

Jos kohdejulkaisulla on jo samaa etuliitettä käyttävä sivupohja, siirretylle sivupohjalle määritetään aakkosjärjestyksessä seuraava käytettävissä
oleva kirjain.

Sivupohjan poistaminen julkaisusta
1. Valitse vähintään yksi sivupohjakuvake Sivut-paneelista.

Valitse kaikki käyttämättömät sivupohjat valitsemalla Sivut-paneeli valikosta Valitse käyttämättömät sivupohjat.

2. Tee jokin seuraavista:

Vedä valitun sivupohjan tai aukeamapohjan kuvake paneelin alaosan Poista-kuvakkeen päälle.

Napsauta paneelin alaosassa Poista-kuvaketta.

Valitse paneelivalikosta Poista aukeamapohja [aukeaman nimi].

Kun poistat sivupohjan, sivupohjaa [ei mitään] käytetään julkaisun kaikilla sivuilla, joilla poistettua sivupohjaa oli käytetty.

Sivupohjakohteiden ohittaminen tai vapauttaminen
Kun käytät sivupohjaa julkaisun sivulla, kaikki sivupohjalla olevat objektit eli sivupohjakohteet näkyvät julkaisun sivulla. Joskus jonkin sivun on
oltava vain hieman erilainen kuin sivupohja. Tällöin ei tarvitse luoda uudelleen sivupohjan asettelua sivulle tai luoda uutta sivupohjaa. Kun ohitat tai
vapautat sivupohjakohteen, julkaisusivun muut sivupohjakohteet päivittyvät edelleen sivupohjan mukana.

Huomaa julkaisusivun sivupohjakohteiden ohittamisen ja vapauttamisen välinen ero:

Sivupohjakohteiden määritteiden ohittaminen Sivupohjakohteen ohittaminen sijoittaa kohteesta kopion julkaisusivulle ilman, että kohteen yhteys
sivupohjaan katkeaa. Kun itse kohde on ohitettu, voit mukauttaa sitä ohittamalla valikoivasti kohteen määritteitä. Voit esimerkiksi muuttaa
paikallisen kopion täyttöväriä. Tämän jälkeen täyttövärin muutokset itse sivupohjassa eivät päivity paikalliseen kopioon. Muut määritteet, kuten
koko, päivittyvät kuitenkin edelleen, koska niitä ei ole ohitettu paikallisessa kopiossa. Ohitukset voidaan poistaa myöhemmin, jotta objekti linkittyisi
sivupohjaan.
Sivupohjaobjektin ohitettavia määritteitä ovat viivat, täytöt, kehyksen sisältö, muunnokset (kuten kierto, skaalaus, kallistaminen ja koon
muuttaminen), kulma-asetukset, tekstikehyksen asetukset, lukitustila, läpinäkyvyys ja objektin tehosteet.

Sivupohjakohteiden vapauttaminen sivupohjasta Julkaisun sivupohjakohde voidaan vapauttaa (irrottaa) sivupohjasta. Kohde täytyy ennen
vapauttamista ohittaa julkaisusivulla, jolloin siitä luodaan paikallinen kopio. Vapautettu kohde ei päivity sivupohjan mukana, sillä sen yhteys
sivupohjaan on katkennut.

Sivupohjakohteen ohittaminen
1. Varmista, että sivupohjakohde voidaan ohittaa.

Sivupohjakohteen voi ohittaa vain, jos kyseistä kohtaa koskeva Salli sivupohjan kohteiden ohitukset valitulla alueella -asetus on valittu Sivut-
paneelin valikosta.

2. Tee jompikumpi seuraavista:
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Jos haluat ohittaa tietyt sivupohjakohteet julkaisun sivulla, paina näppäinyhdistelmää Ctrl+vaihto (Windows) tai komento+vaihto
(Mac OS) ja napsauta kohdetta (tai valitse useita kohteita vetämällä). Muuta valittuja sivupohjakohteita haluamallasi tavalla. Kohteen voi
nyt valita kuten minkä tahansa muun sivukohteen, mutta sen yhteys sivupohjaan säilyy.

Jos haluat ohittaa kaikki sivupohjakohteet julkaisuaukeamalla, määritä aukeama kohteeksi ja valitse Sivut-paneelivalikosta Ohita kaikki
sivupohjakohteet. Voit nyt valita haluamasi sivupohjakohteet ja muokata niitä.

Kun olet ohittanut sivupohjakohteen, sen pisteviivareunat muuttuvat kiinteiksi viivoiksi, mikä osoittaa, että kohteesta on luotu paikallinen
kopio.

Huomautus: jos ohitat ketjutetun tekstikehyksen, kaikki ketjun näkyvät kehykset ohitetaan, vaikka ne olisivat aukeaman toisella sivulla.

Sivupohjakohteen vapauttaminen
Jos haluat vapauttaa yksittäisen sivupohjakohteen sivupohjasta, ohita se ensin painamalla näppäinyhdistelmää Ctrl+vaihto (Windows) tai
komento+vaihto (Mac OS) ja napsauttamalla kohdetta julkaisun sivulla. Valitse sitten Sivut-paneelivalikosta Vapauta valinta pohjasta.
Jos haluat vapauttaa aukeaman kaikki ohitetut sivupohjakohteet, ohita vapautettavat sivupohjakohteet ja määritä aukeama kohteeksi
julkaisussa. (Älä siirry alkuperäiseen sivupohjaan.) Valitse Sivut-paneelivalikosta Vapauta kaikki objektit pohjasta. Jos komento ei ole
käytettävissä, aukeamalla ei ole yhtään ohitettua objektia.

Sivupohjakohteen ohituksen estäminen
Voit joissakin tapauksissa haluta ohittaa kaikki sivupohjakohteet muutamaa lukuun ottamatta. Voit esimerkiksi haluta ohittaa julkaisusivun
taustakuvien kaltaiset sivupohjakohteet mutta estää samalla sivunumeroinnin ylätunnisteen ohituksen. Voit ylätunnisteen ohituksen estämällä
määrittää Ohita kaikki sivupohjakohteet -asetuksen ohittamaan kaikki sivupohjakohteet ylätunnistetta lukuun ottamatta.

1. Valitse kohde sivupohjassa.
2. Poista Salli sivupohjan kohteiden ohitukset valitulla alueella -asetuksen valinta Sivut-paneelivalikosta.

Sivupohjakohteilla, jotka eivät salli ohituksia, ei ole kehyksen reunaa julkaisusivulla. Jos estät ketjutetun tekstikehyksen ohituksen, kaikissa
kyseisen ketjun tekstikehyksissä käytetään samaa asetusta.

Sivupohjakohteiden käyttäminen uudelleen
Ohitetut sivupohjakohteet voidaan palauttaa vastaamaan sivupohjaa. Tällöin objektit palautuvat sivupohjan määritteisiin ja päivittyvät, kun
muokkaat pohjaa. Kohteen paikallinen kopio poistetaan, eikä sivupohjakohdetta voi valita. Tästä ovat merkkinä kohteen pisteviivareunat. Ohitukset
voidaan poistaa valituista objekteista tai kaikista aukeaman ohitetuista objekteista, mutta ei koko julkaisusta samalla kertaa.

 Tee jokin seuraavista:

Jos haluat poistaa sivupohjaohitukset yhdestä tai useammasta objektista, valitse objektit, jotka olivat alunperin sivupohjakohteita. Määritä
aukeama kohteeksi Sivut-paneelissa ja valitse Sivut-paneelivalikosta Poista valitut paikalliset ohitukset.

Jos haluat poistaa aukeamalta kaikki ohitukset, määritä Sivut-paneelista kohteeksi aukeama (tai aukeamapohja), josta haluat poistaa kaikki
sivupohjan ohitukset. Varmista, ettei objekteja ole valittu valitsemalla Muokkaa >Poista kaikkien valinta. Valitse Sivut-paneelivalikosta Poista
kaikki paikalliset ohitukset.

Vapautettuja sivupohjaobjekteja ei voi palauttaa sivupohjaan. Voit kuitenkin poistaa vapautetut objektit ja käyttää sivupohjaa uudelleen.

Jos käytät sivupohjaa uudelleen sivulla, jolla on ohitettuja sivupohjaobjekteja, ohitetut objektit vapautetaan ja kaikkia sivupohjaobjekteja käytetään
uudelleen. Tällöin joitakin objekteja voi olla sivulla kaksi kappaletta. Vapautetut objektit on poistettava, jotta ne vastaisivat tarkasti sivupohjan
ulkoasua.

Sivupohjan kohteiden kätkeminen
Kätke sivupohjakohteet -komennolla voit piilottaa sivupohjakohteet julkaisun sivuilta. Piilotettuja sivupohjakohteita ei tulosteta.

1. Valitse Sivut-paneelista sivut ja aukeamat, joilta haluat piilottaa sivupohjakohteet.
2. Valitse Sivut-paneelin valikosta Kätke sivupohjakohteet.

Voit tuoda sivupohjakohteet näkyviin uudelleen valitsemalla aukeamat Sivut-paneelista ja Näytä sivupohjakohteet Sivut-paneelin valikosta.

Sivupohjan tuominen toisesta julkaisusta
Voit tuoda aktiiviseen julkaisuun sivupohjia muista InDesign-julkaisuista (kaikki versiot). Jos kohdejulkaisu sisältää sivupohjia, joilla on eri nimi kuin
lähdejulkaisun sivupohjilla, kyseiset pohjat ja niiden julkaisusivuohitukset pysyvät muuttumattomina.

1. Valitse Sivut-paneelivalikosta Lataa sivupohjat.
2. Paikanna InDesign-julkaisu, joka sisältää tuotavat sivupohjat, ja kaksoisnapsauta sitä.
3. Määritä, mitä tapahtuu, jos ladatulla sivupohjalla on sama nimi kuin nykyisen julkaisun sivupohjalla.

Valitse Korvaa sivupohjat, jos haluat lähdejulkaisun sivupohjien ohittavan samannimiset kohdejulkaisun sivupohjat. Jos kohdejulkaisussa
ei ole ohitettavia kohteita, voit turvallisesti käyttää Korvaa sivupohjat -asetusta tuonnin yhteydessä.
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Valitse Nimeä sivupohjat uudelleen, jos haluat muuttaa sivun etuliitteet aakkosten seuraavaksi käytettävissä olevaksi kirjaimeksi.

Kun olet tuonut sivupohjat lähdejulkaisusta, lähde- ja kohdejulkaisun välille asennetaan linkki. Kun myöhemmin lataat sivupohjia samasta
lähdejulkaisusta, ohitettujen kohteiden ja niiden yläkohteiden välinen yhteys uudelleenladatuilla sivupohjilla säilyy. Tämän yhteyden avulla voit pitää
eri julkaisujen sivupohjat yhdenmukaisina asettamatta kyseisiä julkaisuja kirjaan.

Jos haluat pitää sivupohjat yhdenmukaisina tällä menetelmällä, lataa sivupohjat lähdejulkaisusta ennen kuin ohitat mitään sivupohjan objekteja.
Jos julkaisussa on ohitettuja kohteita, etkä ole koskaan tuonut sivupohjia mistään lähteestä, ohitetut kohteet vapautetaan heti ensimmäisellä
kerralla, kun lataat lähdejulkaisusta ja korvaat sivupohjat samalla nimellä kuin ohitettujen kohteiden yläsivupohja.

Jos kuitenkin tuot myöhemmin sivupohjia eri lähdejulkaisusta ja valitset Korvaa sivupohjat, ohitetuista kohteista voi tulla vapautettuja. Uudesta
lähdejulkaisusta tuotavia samannimisiä sivupohjia käytetään ohitetut kohteet sisältävällä julkaisusivulla, mikä luo kaksi objektijoukkoa.

Lisää ohjeaiheita
Sivupohjia käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Numbering pages, chapters, and sections
Add section and chapter numbering
Define section numbering
Document numbering options
Create headers and footers
Add automatic page numbers for story jumps

For detailed information and instructions, click the links below.

Add section and chapter numbering

Determine what kind of numbering you want to use for your document or book. For long documents, you can
assign chapter numbers. Each document can be assigned only one chapter number. If you want to use different
numbering within a document, you can define ranges of pages as sections; these sections can be numbered
differently. For example, the first ten pages of a document (the front matter) might use Roman numerals, and the
rest of the document might use Arabic numerals.

A single InDesign document can contain up to 9,999 pages, but page numbers can be as large as 999,999. (For
example, you can correctly number a 100-page document that starts on page 9,949.) By default, the first page is a
recto (right) page numbered 1. Odd-numbered pages always appear on the right; if you use the Section Options
command to change the first page number to an even number, the first page becomes a verso (left) page.

For information on creating basic page numbering in a document, see Add basic page numbering.

Add an automatically updated chapter number

You can add a chapter number variable to your document. Like page numbers, chapter numbers can be updated
automatically and formatted and styled as text. A chapter number variable is commonly used in documents that
are part of a book. A document can have only one chapter number assigned to it; if you want to divide a single
document into chapters, you can create sections instead.

Note:

Chapter numbers cannot be included as a prefix in a generated index or table of contents (such as 1-3, 1-4, and
so on). If you want chapter numbers to be included as prefixes, use section prefixes instead of chapter numbers.

1. If necessary, create a text frame where you want a chapter number to appear. If you want a chapter
number to appear on several pages, create the text frame on a master page, and apply that master page to
the document pages.

2. In the chapter number text frame, add any text that will come before or after the chapter number.
3. Place the insertion point where you want the chapter number to appear, and then choose Type > Text

Variables > Insert Text Variable > Chapter Number.
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You can update the starting number and format of chapter numbering by choosing Layout > Numbering & Section
Options.

Add an automatically updated section marker

1. Define sections in your document. (See Define section numbering.)
2. On a page or master that you’re using in a section, drag the Type tool to create a text frame large enough

for the section marker text, or click in an existing frame.
3. Choose Type > Insert Special Character > Markers > Section Marker.

On master page A, section marker (left) and section marker with page number marker inserted (right)

Change the format of page and chapter numbering

1. Choose Layout > Numbering & Section Options.
2. Under Page Numbering or Document Chapter Numbering, select a new number format for Style. (See

Document numbering options.)
3. Click OK.

Define section numbering

By default, page and chapter numbers in a book are numbered consecutively. Using Numbering & Section Options,
you can restart page numbering at a specified page, add prefixes to page numbers, and change the numbering
style of both pages and chapters.

You can define a section prefix to label section pages automatically. For example, if you specify A– for Section
Prefix on page 16 of a document and include the section prefix, the page will appear in the table of contents or
index as A–16. Text you type for a section marker appears when you choose Type > Insert Special Character >
Markers > Section Marker.

Pages panel

A. Section indicator icon shows start of section B. Page number is changed for new section C. Status bar displays document length 

Define sections in a document

1. In the Pages panel, select the first page in the section you want to define.
2. Choose Layout > Numbering & Section Options, or choose Numbering & Section Options in the Pages panel.
3. If you’re changing the numbering options for any page other than the first page of the document, make

sure that Start Section is selected. This option marks the selected page as the beginning of a new section.
4. As necessary, specify the numbering and section options (see Document numbering options), and then

click OK.

A section indicator icon  appears above the page icon in the Pages panel, indicating the start of a new
section.

5. To end the section, repeat the section numbering steps on the first page that follows the section.
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Edit or remove section numbering

1. In the Pages panel, double-click the section indicator icon  that appears above the page icon in the Pages
panel. Or, select a page that uses a section marker, and choose Numbering & Section Options in the Pages
panel menu.

2. Do any of the following, and then click OK:

To change the style or starting number, change section and numbering options.

To remove a section, deselect the Start Section option.

To quickly identify a section in the Pages panel, position the pointer precisely over any section indicator icon . A
tool tip appears, displaying the starting page number or section prefix.

Display absolute or section numbering in the Pages panel

The Pages panel can display absolute numbering (labeling all pages with consecutive numbers, starting at the first
page of the document) or section numbering (labeling pages by section, as specified in the Section Options dialog
box).

Changing the numbering display affects how pages are indicated in the InDesign document, as in the Pages panel
and in the page box at the bottom of a document window. The numbering display also affects how you specify
page ranges when printing and exporting the document. However, the numbering display does not change the
appearance of page numbers on document pages.

1. Choose Edit > Preferences > General (Windows) or InDesign > Preferences > General (Mac OS).
2. For Page Numbering, choose a numbering method in the View menu.

Pages panel showing absolute numbering (left) and section numbering (right)

Document numbering options

You can change document numbering options when you select a document page (not a master page) and choose
Layout > Numbering & Section Options. You can also change these options when you choose Document
Numbering Options from the Book panel menu.

Automatic Page Numbering

Select if you want the page numbers of the current section to follow the numbering of the previous section. Using
this option, the page numbers in the document or section update automatically when you add pages prior to it.

Start Page Numbering At

Type the starting number for your document or for the first page of the current section. For example, if you want
to restart the numbering for a section, type 1 . The remaining pages in the section will be renumbered accordingly.

Note:

If you chose a non-Arabic page-numbering style (such as Roman numerals), you still must type an Arabic numeral
in this box.
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Section Prefix

Type a label for the section. Include the spaces or punctuation you want to appear between the prefix and the
page number (for example, A–16 or A 16). The prefix is limited to eight characters.

You cannot enter a blank space by pressing the spacebar—copy and paste a fixed-width space character from the
document window instead. Note that plus (+) or comma (,) symbols cannot be used in section prefixes. (See
Insert white space characters.)

Style (Page Numbering)

Choose a page-numbering style from the menu. The style applies to all pages in this section only.

Section Marker

Type a label that InDesign inserts on the page at the location of a section marker character that appears when you
choose Type > Insert Special Character > Markers > Section Marker.

Include Prefix When Numbering Pages

Select if you want the section prefix to appear when you generate a table of contents or index, or when you print
pages that contain automatic page numbers. Deselect this option to display the section prefix in InDesign but hide
the prefix in the printed document, index, and table of contents.

Section prefix in document window

A. Section prefix in the page box at the bottom of the document window B. Section marker and prefix on the page itself 

Style (Document Chapter Numbering)

Choose a chapter-numbering style from the menu. This chapter style is used throughout the document.

Automatic Chapter Numbering

Select this option to number chapters sequentially in a book.

Start Chapter Numbering At

Specify the starting number of the chapter numbering. This option is useful if you don’t want chapters to be
numbered sequentially in the book.

Same As Previous Document In The Book

The same chapter number as the previous document in a book is used. Select this option if the current document
is part of the same chapter as the previous document in a book.
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Headers and footers run through the top and bottom of the pages in your document, providing important
background information. To create a simple header or footer that includes page numbering, see Add basic page
numbering.

Headers and footers can include such items as page, chapter, or section numbers; title or heading text; the
author’s name; and the document’s filename and creation or modification date.

You can add many of these items by using text variables. InDesign includes several preset variables, such as
Creation Date and File Name. You can modify these variables, and you can create your own. For example, you can
create a variable that displays the first use of a Heading paragraph style in the header or footer. Once you create
or edit the variables you need, you assemble them on the master page to create your header and footer, and then
you apply the master page to the appropriate document pages.

Using page numbers and variables to create a footer

A. Footer variable inserted on master page B. Variable text on document page that grabs text from the first heading on the page 

For a video tutorial on creating headers and footers, see www.adobe.com/go/vid0078.

Create a header or footer on a master page

1. If necessary, create or edit the variables you want to use in your header or footer. (See Create variables for
running headers and footers.)

2. Go to the master page where you want to add the header or footer.

The header or footer will appear on any document page to which the master page is applied.

3. Create a text frame large enough to include all the header or footer information. Place the text frame above
or below where the content of the document pages will appear.

4. Add text, page numbers, and variables as needed.
5. Apply the master page to document pages where you want the header or footer to appear.
6. If necessary, create headers and footers for additional master pages.

Create variables for running headers and footers

By default, the Running Header variables insert the first occurrence (on the page) of the text to which the
specified style is applied. Running Header variables are especially useful for displaying the current heading or title
in the header or footer.

1. If your content is not already formatted, create and apply the paragraph style or character style for the text
you want to appear in the header (such as a title or heading style).

2. Choose Type > Text Variables > Define.
3. Click New, and then type a name for the variable.
4. From the Type menu, choose Running Header (Paragraph Style) or Running Header (Character Style).
5. Specify the following options:

Style

Choose the style to display in your header or footer.
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Use

Decide whether you want the first or last occurrence of the style that’s applied on the page. First On Page is
the first paragraph (or character) that begins on a page. If there is no occurrence of the style on the page,
the previous occurrence of the applied style is used. If there is no previous occurrence in the document, the
variable is empty.

Delete End Punctuation

If selected, the variable displays the text minus any end punctuation (periods, colons, exclamation points,
and question marks).

Change Case

Select this option to change the case of the text that appears in the header or footer. For example, you may
want to use sentence case in your footer, even though the heading on the page appears in title case.

6. Click OK, and then click Done in the Text Variables dialog box.

You can now insert the variable in a header or footer you create on the master page.

If a header or footer text frame has been created on the master page of the InDesign document, you can
insert the variable in the header or footer. (See Edit text on a master page.)

Add automatic page numbers for story jumps

You can easily maintain the jump lines of stories that continue to other pages, such as a line that says “Continued
on page 42.” Use a jump line page number to automatically update the number of the page containing a story’s
next or previous threaded text frame when you move or reflow the story’s threaded text frames.

Usually the jump line page number should be in a separate text frame from the story it tracks. That way, the jump
line page number remains in position even if the story’s text reflows.

If you insert a Current Page Number character in the Find/Change dialog box, jump line page numbers can also be
found.

1. With the Type tool, drag to create a new text frame where you want the jump line to appear.
2. With the Selection tool , position the new text frame so that it touches or overlaps the frame containing

the story you want to track.

Make sure text frame touches or overlaps the story you want it to track.

3. Select the Type tool and click an insertion point in the new text frame. Then type the text that you want to
appear before the page number, such as “Continued on” or “Continued from”.

4. Then choose Type > Insert Special Character > Marker and one of the following options:

Next Page Number

Inserts the number of the page containing the story’s next frame. Use this character when creating a
“continued on” jump line.
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Previous Page Number

Inserts the number of the page containing the story’s previous frame. Use this character when creating a
“continued from” jump line.

The page number automatically updates to reflect the current location of the next or previous frame of the
story.

5. To prevent the story from being moved without its jump line, Shift-select the frames with the Selection tool,
then choose Object > Group.

6. If necessary, repeat this procedure to add more jump lines.

Note:

If an unwanted character appears at the beginning of the page number (so that, for example, a jump line reads
“Cont’d on page A16” instead of “Cont’d on page 16”), you probably included a section prefix in the Numbering &
Section Options dialog box. Turn off or edit the prefix.

Adobe also recommends

Number pages, chapters, and paragraphs in a book
Add basic page numbering
Number pages, chapters, and paragraphs in a book
Master pages
Text variables
Cross-references
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Placing graphics
Place (import) graphics
Import options for graphics
Place multiple graphics
Control layer visibility in imported images
Paste or drag graphics
Fixing low-resolution images
Control graphics’ display performance
Create contact sheets

Place (import) graphics

The Place command is the primary method used to insert graphics into InDesign because it provides the highest
level of support for resolution, file formats, multipage PDF and INDD files, and color. To place graphics is also
referred to as import images and insert pictures.

If you’re creating a document in which those characteristics aren’t critical, you can copy and paste to import
graphics InDesign. Pasting, however, embeds a graphic in a document; the link to the original graphic file is broken
and doesn’t appear in the Links panel, and you can’t update the graphic from the original file. However, pasting
Illustrator graphics allows you to edit paths in InDesign. See Importing Adobe Illustrator graphics.

The options available to you when you place a graphics file depend on the type of graphic. These options appear
when you select Show Import Options in the Place dialog box. If you don’t select Show Import Options, InDesign
applies the default settings or the last settings used in placing a graphics file of that type.

The names of graphics you’ve placed (imported) appear in the Links panel.

Note:

If you place or drag a graphic from a removable media, such as a CD-ROM, the link will break when you remove
that media from your system.

For a video tutorial on placing an image, see www.adobe.com/go/lrvid4279_id.

1. Do one of the following:

To import a graphic without first creating a frame, make sure that nothing in the document is
selected.

To import a graphic into an existing frame, select the frame. If the new image is larger than the
frame, you can refit the frame later by choosing Object > Fitting > [fitting command].

To replace an existing image, select its graphics frame.

2. Choose File > Place and select one or more graphics files of any available format.

If you select multiple files, you can click or drag in the document to place the selected files one at a time.
(See Place multiple graphics.)
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3. To replace an object you selected, select Replace Selected Item.
4. To add a caption based on the image metadata, select Create Static Captions. See Generate a caption from

an image.
5. To set format-specific import options, do one of the following:

Select Show Import Options, and then click Open.

Hold down Shift as you click Open or Shift-double-click a file name.

Note:

When you place a graphic created in Illustrator 9.0 or later by using the Show Import Options dialog box,
the options are identical to those for PDFs. When you place an Illustrator 5.5–8.x graphic, the options are
identical to those for EPS files.

6. If the Image Import Options dialog box appears (because you chose to set format-specific import options),
select import options and click OK. (See Import options for graphics.)

7. Do one of the following:

To import into a new frame, drag to create a frame. Or, click the loaded graphics icon  in the
layout at the place where you want the upper left corner of the graphic to appear.

Note:

When you drag to create a frame, the frame has the same proportions as the graphic unless you Shift-drag.

To import into an existing, unselected frame, click the loaded graphics icon anywhere in that frame.
To import into an existing selected frame, you don’t need to do anything if Replace Selected Item is
selected. The image automatically appears in that frame.
To replace an existing graphic, hold down Alt (Windows) or Option (Mac OS) and click the loaded
graphics icon on the graphic you want to replace.
To place all the specified pages of a multipage file (such as a PDF or INDD file) at the same time,
one overlapping another, hold down Alt (Windows) or Option (Mac OS) and click the loaded graphics
icon where you want the pages to appear.

If you accidently replace an existing graphic with an image you’re placing, press Ctrl+Z (Windows) or
Command+Z (Mac OS) to return the original image to the frame and display the loaded graphics icon.

8. To place the next graphic or the next page of a multipage PDF, click the loaded graphics icon in the layout
where desired. If necessary, you can scroll to a different location or change pages without losing the loaded
graphics icon.

Note:

The image you place may appear to have a low resolution, depending on your settings. The display setting of an
image does not affect final output of the file. To change your image display settings, see Control graphics’ display
performance.

Import options for graphics

The options for importing graphics vary depending on the type of image being imported. To display import options,
make sure that Show Import Options is selected in the Place dialog box.

Encapsulated PostScript (.eps) import options

When you place an EPS graphic (or a file saved with Illustrator 8.0 or earlier) and select Show Import Options in
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the Place dialog box, you’ll see a dialog box containing these options:

Read Embedded OPI Image Links

This option tells InDesign to read links from OPI comments for images included (or nested) in the graphic.

Deselect this option if you’re using a proxy-based workflow and plan to have your service providers perform the
image replacement using their OPI software. When this option is deselected, InDesign preserves the OPI links but
does not read them. When you print or export, the proxy and the links are passed on to the output file.

Select this option if you’re using a proxy-based workflow and you want InDesign, instead of your service provider,
to perform image replacement when you output the final file. When you select this option, the OPI links appear in
the Links panel.

Also select this option when you import EPS files containing OPI comments that are not part of a proxy-based
workflow. For example, if you import an EPS file containing OPI comments for an omitted TIFF or bitmap image,
you’ll want to select this option so that InDesign can access the TIFF information when you output the file.

Apply Photoshop Clipping Path

Regardless of whether this option is selected, a placed EPS file includes a clipping path in InDesign. However,
deselecting this option may result in a different bounding box size.

Proxy Generation

This creates a low-resolution bitmap representation of an image when drawing the file to the screen. The following
settings control how the proxy will be generated:

Use TIFF Or PICT Preview

Some EPS images contain an embedded preview. Select this option to generate the proxy image of the existing
preview. If a preview does not exist, the proxy will be generated by rasterizing the EPS to an offscreen bitmap.

Rasterize The PostScript

Select this option to ignore the embedded preview. This option is typically slower but provides the highest-quality
results.

Note:

When you import more than one single file into the same document, all instances share the proxy setting of the
first instance of the imported file.

Bitmap import options

You can apply color-management options to individual imported graphics when using color-management tools with
a document. You can also import a clipping path or an alpha channel saved with an image created in Photoshop.
Doing so lets you directly select an image and modify its path without changing the graphics frame.
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When you place a PSD, TIFF, GIF, JPEG, or BMP file and select Show Import Options in the Place dialog box, you’ll
see a dialog box containing these options:

Apply Photoshop Clipping Path

If this option isn’t available, the image wasn’t saved with a clipping path, or the file format doesn’t support clipping
paths. If the bitmap image doesn’t have a clipping path, you can create one in InDesign.

Alpha channel

Select an alpha channel to import the area of the image saved as an alpha channel in Photoshop. InDesign uses
the alpha channel to create a transparent mask on the image. This option is available only for images that contain
at least one alpha channel.

Click the Color tab to view the following options:

Image imported without clipping path (left) and with clipping path (right)

Profile

If Use Document Default is selected, leave this option unchanged. Otherwise, choose a color source profile that
matches the gamut of the device or software used to create the graphic. This profile enables InDesign to properly
translate its color to the gamut of the output device.

Rendering Intent

Choose a method for scaling the color range of the graphic to the color range of the output device. Typically, you’ll
choose Perceptual (Images) because it accurately represents colors in photographs. The Saturation (Graphics),
Relative Colorimetric, and Absolute Colorimetric options are better for areas of solid color; they don’t reproduce
photographs well. Rendering Intent options aren’t available for bitmap, grayscale, and index-color mode images.

Portable Network Graphics (.png) import options

When you place a PNG image and select Show Import Options in the Place dialog box, you’ll see a dialog box with
three sections of import settings. Two sections contain the same options available for other bitmap image formats.
The other section, PNG Settings, contains the following settings:

Use Transparency Information

This option is enabled by default when a PNG graphic includes transparency. If an imported PNG file contains
transparency, the graphic interacts only where the background is transparent.

White Background

If a PNG graphic does not contain a file-defined background color, this option will be selected by default. However,
it is only enabled if Use Transparency Information is activated. If this option is selected, white is used as the
background color when applying transparency information.
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File Defined Background Color

If a PNG graphic was saved with a non-white background color, and Use Transparency Information is selected, this
option is selected by default. If you don’t want to use the default background color, click White Background to
import the graphic with a white background, or deselect Use Transparency Information to import the graphic
without any transparency (displaying areas of the graphic that are currently transparent). Some image-editing
programs can’t specify a non-white background color for PNG graphics.

Apply Gamma Correction

Select this option to adjust the gamma (midtone) values of a PNG graphic as you place it. This option lets you
match image gamma to the gamma of the device you will use to print or display the graphic (such as a low-
resolution or non-PostScript printer or computer monitor). Deselect this option to place the image without applying
any gamma correction. By default, this option is selected if the PNG graphic was saved with a gamma value.

Gamma Value

This option, available only if Apply Gamma Correction is selected, displays the gamma value that was saved with
the graphic. To change the value, type a positive number from 0.01 to 3.0.

When PNG files are imported, the settings in the Image Import Options dialog box are always based on the
selected file, not on the default or last-used settings.

Acrobat (.pdf) and Illustrator (.ai) import options

The layout, graphics, and typography in a placed PDF are preserved. As with other placed graphics, you cannot
edit a placed PDF page within InDesign. You can control the visibility of layers in a layered PDF. You can also place
more than one page of a multipage PDF.

When you place a PDF that was saved with passwords, you’ll be prompted to enter the required passwords. If the
PDF file was saved with usage restrictions (for example, no editing or printing), but no passwords, you can place
the file.

When you place a PDF (or a file saved with Illustrator 9.0 or later) and select Show Import Options in the Place
dialog box, you’ll see a dialog box containing the following options:

Show Preview

Preview a page in the PDF before you place it. If you’re placing a page from a PDF that contains multiple pages,
click the arrows, or type a page number under the preview image to preview a specific page.

Pages

Specify the pages you want to place: the page displayed in the preview, all pages, or a range of pages. For
Illustrator files, you can specify which artboard to place.

If you specify multiple pages, hold down Alt (Windows) or Option (Mac OS) while placing the file to place them all
at the same time, overlapping each other.
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Crop To

Specify how much of the PDF page to place:

Bounding Box

Places the PDF page’s bounding box, or the minimum area that encloses the objects on the page, including page
marks. The Bounding Box (Visible Layers Only) option uses the bounding box only of the visible layers of the PDF
file. The Bounding Box (All Layers) option places the bounding box of the entire layer area of the PDF file, even if
layers are hidden.

Art

Places the PDF only in the area defined by a rectangle that the author created as a placeable artwork (for
example, clip art).

Crop

Places the PDF only in the area that is displayed or printed by Adobe Acrobat.

Trim

Identifies the place where the final produced page will be physically cut in the production process, if trim marks are
present.

Bleed

Places only the area that represents where all page content should be clipped, if a bleed area is present. This
information is useful if the page is being output in a production environment. Note that the printed page may
include page marks that fall outside the bleed area.

Media

Places the area that represents the physical paper size of the original PDF document (for example, the dimensions
of an A4 sheet of paper), including page marks.

Options for cropping placed PDFs

A. Media B. Trim C. Bleed D. Content E. Crop F. Art 

Transparent Background

Select this option to reveal text or graphics that fall beneath the PDF page in the InDesign layout. Deselect this
option to place the PDF page with an opaque white background.

If you make the background transparent in a frame containing a PDF graphic, you can make it opaque later by
adding a fill to the frame.

297



To the top

InDesign (.indd) import options

InDesign preserves the layout, graphics, and typography in a placed INDD file. However, the file is treated as an
object, and you can’t edit it, although you can control the visibility of layers and choose which pages of a multi-
page INDD file to import.

When you place an InDesign file and select Show Import Options in the Place dialog box, you’ll see a dialog box
containing the following options:

Show preview

Preview a page before you place it. You can type a page number or click the arrows to preview a page in a multi-
page document.

Pages

Specify the pages you want to place: the page displayed in the preview, all pages, or a range of pages.

Crop to

Specify how much of the page or pages to place, the page itself or the bleed or slug areas on the pasteboard.

Place multiple graphics

The Place command lets you import more than one item at a time.

1. Create frames for the graphics if you want to place some or all of them in frames.
2. Choose File > Place, and select files.

You can select graphics files, text files, InDesign files, and other files you can add to InDesign documents.

3. Optionally, select Show Import Options, click Open, and specify the import options for each file. (See
Import options for graphics.)

A thumbnail image of the first graphic you selected appears next to the loaded graphics icon. A number
next to the loaded graphics icon tells you how many graphics are ready for importing. The names of the
graphics appear in the Links panel, with the letters LP (for “loaded in place cursor”) next to the frontmost
graphic.

Placing four files into placeholder frames

Press an arrow key to cycle through the graphics; press Esc to unload the frontmost graphic from the
loaded graphics icon without placing it in InDesign.

Note:

You can keep thumbnail images from appearing in the loaded graphics icon if displaying the images slows
down your computer. In the Interface area of the Preferences dialog box, deselect Show Thumbnails On
Place.
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4. Do one of the following:

To import into a new frame, click the loaded graphics icon where you want the upper left corner of
the graphic to appear.

To create a frame of a certain size and import the graphic into the frame, drag to define the frame.
The frame conforms to the proportions of the graphic being placed.

To import into an existing frame, click the loaded graphics icon in the frame. Alt-click (Windows) or
Option-click (Mac OS) to replace the contents of an existing frame.

To import all the loaded graphics in a grid, start dragging, and press the arrow keys to determine the
number of rows and columns. Use the Up Arrow and Down Arrow keys to change the number of
rows and the Left Arrow and Right Arrow keys to change the number of columns. Release the mouse
button to place the grid of images.

To change the spacing between frames, press Page Up or Page Down or hold down Ctrl (Windows)
or Command (Mac OS) while pressing the arrow keys.

To change the spacing between frames, hold down Ctrl (Windows) or Command (Mac OS) while
pressing the arrow keys.

Note:

You can load more graphics by choosing File > Place while the graphics icon is displayed.

Control layer visibility in imported images

When you import Photoshop PSD files, layered PDFs, and INDD files, you can control the visibility of top-level
layers. Adjusting layer visibility in InDesign lets you vary an illustration depending on context. For example, in a
multilanguage publication, you can create a single illustration that includes one text layer for each language.

You can adjust layer visibility either when you place a file or by using the Object Layer Options dialog box. In
addition, if the Photoshop file contains layer comps, you can display the desired comp.

Set layer visibility

1. Do one of the following:

To import a graphic without first creating a frame, make sure that nothing in the document is
selected.

To import a graphic into an existing frame, select the frame.

To replace an existing image, select the graphics frame.

2. Choose File > Place and select a graphics file.
3. To replace a selected object, select Replace Selected Item.
4. Select Show Import Options, and then click Open.
5. In the Image Import Options or Place dialog box, click the Layers tab.
6. To view a preview of the image, click Show Preview.
7. (PDFs only) If you’re placing a page from a multipage PDF, click the arrows, or type a page number under

the preview image to preview a specific page.
8. (Photoshop PSD files only) If the image contains layer comps, choose the layer comp you want to display

from the Layer Comp pop-up menu.
9. Do one of the following:

To open or close a layer set, click the triangle to the left of the folder icon.
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To hide a layer or layer set, click the eye icon next to the layer or layer set.

To display the layer or layer set, click the empty eye column next to the layer or layer set.

To display only the content of a particular layer or layer set, Alt-click (Windows) or Option-click
(Mac OS) its eye icon. Alt-click or Option-click the eye icon again to restore the original visibility
settings of the other layers.

To change the visibility of multiple items, drag through the eye column.

10. Set the When Updating Link option as desired:

Use Photoshop’s/PDF’s Layer Visibility

Matches the layer visibility settings to those of the linked file when you update the link.

Keep Layer Visibility Overrides

Maintains the layer visibility settings as they were when the file was originally placed.

11. Click OK.
12. Click OK, and do one of the following:

To import into a new frame, click the loaded graphics icon  in the layout at the place where you
want the upper left corner of the graphic to appear.

To import into an existing, unselected frame, click the loaded graphics icon anywhere in that frame.

To import into an existing selected frame, you don’t need to do anything. The image automatically
appears in that frame.

If you accidently replace an existing graphic with an image you’re placing, press Ctrl+Z (Windows) or
Command+Z (Mac OS) to return the original image to the frame and display the loaded graphics icon.

Set layer visibility for placed AI, PSD, PDF, and INDD files

After you place a Photoshop PSD or layered PDF, an Illustrator AI file, or an InDesign INDD file, you can control
the visibility of its layers by using the Object Layer Options dialog box. If the Photoshop PSD file contains layer
comps, you can choose which comp you want to display. In addition, you can choose whether to maintain the
visibility settings or match the settings of the original file each time you update the link.

1. Select the file in the InDesign document.
2. Choose Object > Object Layer Options.
3. To view a preview of the image, select Preview.
4. (Photoshop PSD files only) If the image contains layer comps, choose the layer comp you want to display

from the Layer Comp pop-up menu.
5. Do one of the following:

To open or close a layer set, click the triangle to the left of the folder icon.

To hide a layer or layer set, click the eye icon next to the layer or layer set.

To display the layer or layer set, click the empty eye column next to the layer or layer set.

To display only the content of a particular layer or layer set, Alt-click (Windows) or Option-click
(Mac OS) its eye icon. Alt-click or Option-click the eye icon again to restore the original visibility
settings of the other layers.
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To change the visibility of multiple items, drag through the eye column.

6. Set the Updating Link Options as desired:

Use Layer Visibility

Matches the layer visibility settings to those of the linked file when you update the link.

Keep Layer Visibility Overrides

Maintains the layer visibility settings as they were when the file was originally placed.

7. Click OK.

Paste or drag graphics

When you copy and paste or drag a graphic into an InDesign document, some attributes of the original object may
be lost, depending on the limitations of the operating system and the range of data types the other application
makes available for transfer, and the InDesign Clipboard preferences. Pasting or dragging Illustrator graphics lets
you select and edit paths within the graphic.

Copying and pasting or dragging between two InDesign documents, or within a single document, however,
preserves all of the graphics attributes that were imported or applied. For example, if you copy a graphic from one
InDesign document and paste it into another, the new copy will be an exact duplicate of the original, even
including the original’s link information, so that you can update the graphic when the file on disk changes.

Copy and paste graphics

When copying and pasting a graphic from another document into an InDesign document, InDesign does not create
a link to the graphic in the Links panel. The graphic may be converted by the system clipboard during the transfer,
so both image quality and print quality may be lower in InDesign than in the graphic’s original application.

1. In InDesign or another program, select the original graphic, and choose Edit > Copy.
2. Switch to an InDesign document window, and choose Edit > Paste.

Drag and drop graphics

The drag-and-drop method works like the Place command, with images appearing in the Links panel after they’re
imported. You cannot set import options for the files you drag and drop; however, you can drag and drop multiple
files at once (the files are loaded in the graphics icon when you drag and drop more than one).

Select a graphic from Adobe Illustrator, Adobe Bridge, Explorer (Windows), the Finder (Mac OS), or your desktop,
and drag it into InDesign. The image must be in a format that InDesign can import.

After dragging and dropping a file from any location other than Illustrator, it appears in the Links panel in
InDesign. Using the Links panel, you can control versions and update as necessary.

1. Select the original graphic.
2. Drag the graphic into an open InDesign document window.
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Note:

In Windows, if you try to drag an item from an application that does not support drag and drop, the pointer
displays the Prohibited icon.

To cancel dragging a graphic, drop the graphic onto any panel title bar or the document title bar.

Fixing low-resolution images

Graphics you place in your document may appear pixelated or fuzzy or grainy. In most cases, it’s because InDesign
displays images in low-resolution by default to improve performance.

Check the display settings

To display graphics in high resolution, choose View > Display Performance > High Quality Display. For more details
on changing these display performance settings, see Control graphics’ display performance.

Use Place instead of Paste

The image may still be low resolution even though you changed the display performance settings. For these
images, make sure that you use the Place command to insert the image into InDesign. In some instances, pasting
an image from another application may result in the preview image being inserted instead of the original file.

Check your print settings

If your image appears in low resolution in print, check your print settings to make sure graphics are printing
properly. In the Graphics section of the Print dialog box, choose Send Data > All.

Avoid transformations in images of borderline quality

In addition, scaling or rotating an image could reduce its quality. You may want to choose Clear Transformations
from the Control panel menu.

Improve the image resolution

In some cases, such as with an image copied from a web page, you may need to replace a low-resolution image
with a high-resolution image.
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You can control the resolution of graphics placed in your document. You can change the display settings for the
entire document or for individual graphics. You can also change a setting that either allows or overrides the display
settings for individual documents.

Change a document’s display performance

A document always opens using the default Display Performance preferences. You can change the display
performance of a document while it is open, but the setting won’t be saved with the document.

If you’ve set the display performance of any images separately, you can override the settings so all objects use the
same settings.

1. Choose View > Display Performance, and select an option from the submenu.
2. To force objects that you have set individually to display using the document setting, deselect View >

Display Performance > Allow Object-Level Display Settings. (A check mark indicates it is selected.)

Change an object’s display performance

1. To preserve the display performance for individual objects when the document is closed and reopened,
make sure Preserve Object-Level Display Settings is selected in Display Performance preferences.

2. Choose View > Display Performance, and make sure Allow Object-Level Display Settings is selected.
3. With the Selection tool  or Direct Selection tool , select an imported graphic.
4. Do one of the following:

Select Object > Display Performance, and choose a display setting.

Right-click (Windows) or Control-click (Mac OS) the image, and choose a display setting from the
Display Performance submenu.

To remove an object’s local display setting, choose Use View Setting in the Display Performance submenu. To
remove local display settings for all graphics in the document, select Clear Object-Level Display Settings in the
View > Display Performance submenu.

Display performance options

These options control how graphics are displayed on the screen, but they do not affect the print quality or
exported output.

Use Display Performance preferences to set the default option used to open all documents, and customize the
settings that define those options. Each display option has separate settings for displaying raster images, vector
graphics, and transparencies.

Fast

Draws a raster image or vector graphic as a gray box (default). Use this option when you want to quickly page
through spreads that have lots of images or transparency effects.
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Typical

Draws a low-resolution proxy image (default) appropriate for identifying and positioning an image or vector
graphic. Typical is the default option, and is the fastest way to display an identifiable image.

High Quality

Draws a raster image or vector graphic at High Resolution (default). This option provides the highest quality but
the slowest performance. Use this option when you want to fine-tune an image.

Note:

Image display options don’t affect output resolution when exporting or printing images within a document. When
printing to a PostScript device, exporting to XHTML, or exporting to EPS or PDF, the final image resolution depends
on the output options you choose when you print or export the file.

Set default display performance

The Display Performance preferences let you set the default display option, which InDesign uses for every
document. You can change a document’s display performance using the View menu, or change the setting for
individual objects using the Object menu. For example, if you work on projects that contain numerous high-
resolution photos (such as a catalog), you may prefer to have all your documents open quickly. You can set the
default display option to Fast. When you want to see the images in more detail, you can switch the document view
to Typical or High Quality (leaving the preference set to Fast).

You can also choose to view or override display settings applied to individual objects. If Preserve Object-Level
Display Settings is selected, any settings applied to objects are saved with the document.

1. Select Edit > Preferences > Display Performance (Windows) or InDesign > Preferences > Display
Performance (Mac OS).

2. For Default View, select Typical, Fast, or High Quality. The display option you choose applies to all
documents you open or create.

3. Do one of the following:

To save display settings applied to individual objects, select Preserve Object-Level Display Settings.

To display all graphics using the default display option, deselect Preserve Object-Level Display
Settings.

4. For Adjust View Settings, choose the display option you want to customize, and then move the slider for
Raster Images or Vector Graphics to the desired setting.

5. Click OK.

Each display option has separate settings for raster (bitmap) images, vector graphics, and transparency effects.

Create contact sheets

A contact sheet is a grid of thumbnail images, often used for pre-press analysis. You can use a number of different
Adobe applications to create a contact sheet. In Photoshop, you can use either the Contact Sheet or Picture
Package command.
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In previous versions of Adobe Bridge (CS2 and CS3), you can create a contact sheet for InDesign pages using the
Create InDesign Contact Sheet feature. This feature does not appear in later versions of Adobe Bridge. Instead,
you can use the Adobe Output Module in Adobe Bridge to create a PDF contact sheet.

You can also create a simple contact sheet in InDesign by placing multiple images in a grid.

1. Choose File > Place, select multiple images, and choose Open.

If you want to include captions with your images, select Create Static Captions. See Generate a caption
from an image.

2. Start dragging, and press the arrow keys to determine the number of rows and columns. Use the Up Arrow
and Down Arrow keys to change the number of rows and the Left and Right arrow keys to change the
number of columns.

To change the spacing between frames, press Page Up or Page Down or hold down Ctrl (Windows) or
Command (Mac OS) while pressing the arrow keys.

To change the spacing between frames, hold down Ctrl (Windows) or Command (Mac OS) while pressing
the arrow keys.

3. Release the mouse button to place the grid of images.

Adobe also recommends
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Reusing graphics and text
Ways to reuse graphics and text
Use snippets
Use object libraries

Ways to reuse graphics and text

InDesign offers several different ways to repurpose graphics and text.

Snippets

A snippet is a file that contains objects and describes their location relative to one another on a page or spread.
(See Use snippets.)

Object libraries

An object library provides a convenient place to store items such as logos, sidebars, pull-quotes, and other
repeating items. (See Use object libraries.)

Templates

A template is a document that includes placeholder text and graphics. (See Use document templates.)

Use snippets

A snippet is a file that holds objects and describes their location relative to one another on a page or page spread.
Use snippets to conveniently reuse and position page objects. Create a snippet by saving objects in a snippet file,
which has the .IDMS extension. (Previous InDesign versions use the .INDS extension.) When you place the snippet
file in InDesign, you can determine whether the objects land in their original positions or where you click. You can
store snippets in the Object library and in Adobe Bridge as well as on your hard disk.

Snippets contents retain their layer associations when you place them. When a snippet contains resource
definitions and these definitions are also present in the document to which it is copied, the snippet uses the
resource definitions in the document.

Snippets you create in InDesign CS5 can be opened in InDesign CS4 but not in any other previous version of
InDesign.

Create snippets
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Do one of the following:

Using a selection tool, select one or more objects, and then choose File > Export. From the Save As
Type (Windows) or Format (Mac OS) menu, choose InDesign Snippet. Type a name for the file and
click Save.

Using a selection tool, select one or more objects, and then drag the selection to your desktop. A
snippet file is created. Rename the file.

Select one or more objects, and then drag the selection to the Mini Bridge panel. A snippet file is
created. Rename the file.

Drag an item from Structure View to your desktop.

Add snippets to a document

1. Choose File > Place.
2. Select one or more snippet (*.IDMS or *.INDS) files.
3. Click the loaded snippet cursor where you want the upper-left corner of the snippet file to be.

If you placed the insertion point in a text frame, the snippet is placed in the text as an anchored object.

All objects remain selected after you place the snippet. By dragging, you can adjust the position of all
objects.

4. If you loaded more than one snippet, scroll and click the loaded snippet cursor to place the others.

You can drag a snippet file from your desktop into the InDesign document and click where you want the upper-left
corner of the snippet to be.

Choose how to place snippets

Rather than place snippet objects according to where you click on a page, you can place them in their original
locations. For example, a text frame that appeared in the middle of a page when it was made part of a snippet can
appear in the same location when you place it as a snippet.

In File Handling preferences, choose Original Location from the Position At menu to preserve objects’
original locations in snippets. Choose Cursor Location from the Position At menu to place snippets according
to where you click a page.

You can press Alt (Windows) or Option (Mac) to override the Position setting you selected for handling snippets.
For example, if you selected Position At Cursor Location but you want to place snippet objects in their original
locations, hold down the Alt/Option key when you click the loaded snippet cursor on the page.

Use object libraries

Object libraries help you organize the graphics, text, and pages you use most often. You can also add ruler guides,
grids, drawn shapes, and grouped images to a library. You can create as many libraries as you need—for example,
you can create different object libraries for varied projects or clients.

During a work session, you can open as many libraries as system memory will allow. Object libraries can be shared
across servers, and across platforms, but only one person can have the library open at a time. If an object library
includes text files, make sure that the file’s fonts are available and active on all systems that will access the library.
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When you add a page element, such as a graphic, to an object library, InDesign preserves all attributes that were
imported or applied. For example, if you add a graphic from an InDesign document to a library, the library copy
will duplicate the original, including the original’s link information, so that you can update the graphic when the file
on disk changes.

If you delete the object from the InDesign document, the object’s thumbnail will still appear in the Library panel,
and all of the link information will remain intact. If you move or delete the original object, a missing link icon will
appear next to the object’s name in the Links panel the next time you place it in your document from the Library
panel.

Within each object library, you can identify and search for an item by title, by the date it was added to the library,
or by keywords. You can also simplify the view of an object library by sorting the library items and displaying their
subsets. For example, you can hide all items except EPS files.

Object library in Library panel

A. Object thumbnail and name B. Library Item Information button C. Show Library Subset button D. New Library Item button E. Delete
Library Item button 

When adding an item to an object library, InDesign saves all page, text, and image attributes, and maintains
interrelationships among library objects and other page elements in the following ways:

Elements grouped in an InDesign document when dragged to the Library panel stay grouped when dragged
out of the Library panel.

Text retains its formatting.

Paragraph styles, character styles, and object styles that have the same name as styles used in the
destination document are converted to the destination document’s styles; those that have different names
are added to the document.

The original layers of an object are preserved when the Paste Remembers Layers option is selected in the
Layers panel menu.

Create an object library

An object library exists as a named file on disk. When you create an object library, you specify where to store it.
When you open a library, it appears as a panel that you can group with any other panel; the object library’s file
name appears in its panel tab. Closing an object library removes it from the current session, but doesn’t delete its
file.

You can add or remove objects, selected page elements, or an entire page of elements to or from an object
library. You can also add or move library objects from one library to another.

1. Choose File > New > Library.
2. Specify a location and name for the library, and click Save. Remember that the name you specify becomes

the name of the library’s panel tab.

Open an existing library

Do one of the following:
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If you’ve already opened a library in the current session (and haven’t closed it), choose the library
file in the Window menu.

If you have not opened a library, choose File > Open, and select one or more libraries. In Windows,
library files use the INDL extension. InDesign converts newly opened libraries from previous versions
of the program to the new library format; you are asked to save these libraries under a new name.

Close a library

1. Click the tab for the library you want to close.
2. Do one of the following:

Choose Close Library in the Object Library panel menu.

Choose the library file name on the Window menu.

Delete a library

In Explorer (Windows) or Finder (Mac OS), drag a library file to the Recycle Bin (Windows) or Trash
(Mac OS). In Windows, library files have the INDL extension.

Add an object or page to a library

Do any of the following:

Drag one or more objects from a document window to an active Object Library panel.

Select one or more objects in a document window, and click the New Library Item button in the
Object Library panel.

Select one or more objects in a document window, and choose Add Item in the Object Library panel
menu.

Choose Add Items On Page [number] As Separate Objects in the Object Library panel menu to add
all the objects as separate library objects.

Choose Add Items On Page [number] in the Object Library panel menu to add all the objects as one
library object.

Drag an element from the Structure pane to an active Object Library panel.

If you hold down Alt (Windows) or Option (Mac OS) while you perform any of the above commands, the Item
Information dialog box appears as the item is added to the library.

Add an object from a library to a document

Do one of the following:

Drag an object from the Object Library panel to a document window.

In the Object Library panel, select an object, and choose Place Item(s) in the Object Library panel
menu. This method places the object at its original X,Y coordinates.

Drag an XML element to a parent element in the Structure pane or to the page.
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Manage library objects

Use the Object Library panel to manage objects.

Update a library object with a new item

1. In the document window, select the item you want to add to the Library panel.
2. In the Library panel, select the object you want to replace, and then choose Update Library Item from the

Object Library panel menu.

Copy or move an object from one library to another

1. Drag one library’s panel tab out of the Object Library panel group to separate them, so you can see both
libraries at the same time.

2. Do one of the following:

To copy an object from one library to another, drag an item from one Library panel tab to the other.

To move an object out of one library into another, hold down Alt (Windows) or Option (Mac OS),
and drag an item from one Library panel tab to the other.

Delete an object from an object library

In the Object Library panel, select an object, and do one of the following:

Click the Delete Library Item button.

Drag the item to the Delete Library Item button.

Choose Delete Item(s) in the Object Library panel menu.

Change the object library display

The object library displays objects as thumbnails or as a text list. You can sort the thumbnails or list by object
name, age, or type. The list view and sorting options work best if you’ve cataloged the objects.

Do any of the following:

To view objects as thumbnails, choose Thumbnail View or Large Thumbnail View from the Object
Library panel menu.

To view objects as a text list, choose List View from the Object Library panel menu.

To sort the objects, choose Sort Items from the Object Library panel menu, and choose a sort
method.

View all objects
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Choose Show All in the Object Library panel menu.

View, add, or edit library information

With large or numerous object libraries, library information can be cataloged using the display objects’ names, by
type of object, or words in a description.

1. In the Object Library panel, do one of the following:

Double-click any object.

Select an object, and click the Library Item Information button.

Select an object, and choose Item Information in the Object Library panel menu.

2. View or change the Item Name, Object Type, or Description options as necessary, and click OK.

Find objects in a library

When you search for objects, all objects except the results of your search are hidden from view. You can also use
the search feature to show and hide specific categories of objects. For example, you can display only object items
with the word “star” in their names.

1. Choose Show Subset in the Object Library panel menu, or click the Show Library Subset button.
2. Do one of the following:

To search all objects in the library, select Search Entire Library.

To search only within the objects currently listed in the library (refining a previous search), select
Search Currently Shown Items.

3. Choose a category in the first menu in the Parameters section.
4. In the second menu, specify whether the category you chose in the first menu must be contained in or

excluded from the search.
5. To the right of the second menu, type a word or phrase you want to search for within the category you

specified.
6. To add search criteria, click More Choices up to five times; each click adds one search term. To remove

search criteria, click Fewer Choices as necessary; each click removes one search term.
7. To display only those objects that match all search criteria, select Match All. To display objects that match

any of the criteria, select Match Any One.
8. Click OK to begin the search.

To show all objects again, choose Show All in the Object Library panel menu.

Adobe also recommends

Exporting
Working with XML
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Ruler guides
Create ruler guides
Work with ruler guides
Use smart guides

Create ruler guides

Ruler guides are different from grids in that they can be positioned freely on a page or on a pasteboard. You can
create two kinds of ruler guides: page guides, which appear only on the page on which you create them, or spread
guides, which span all pages and the pasteboard of a multiple-page spread. You can drag any ruler guide to the
pasteboard. A ruler guide is displayed or hidden with the layer on which it was created.

New ruler guides always appear on the target spread. For example, if several spreads are visible in the document
window and you drag a new guide into the window, the new guide becomes visible only on the target spread.

Guides in the document window

A. Spread guide B. Page guide 

Create a ruler guide

1. Make sure that both rulers and guides are visible, make sure the correct spread is targeted, and view the
document in Normal View mode, not Preview mode.

2. If the document contains multiple layers, click a layer name in the Layers panel to target the layer.
3. Do one of the following:

To create a page guide, position the pointer inside a horizontal or vertical ruler and then drag to the
desired location on the target spread. If you drop the guide onto the pasteboard, it spans the
pasteboard and spread; it will act as a page guide if you later drag it onto a page.

To create a spread guide, drag from the horizontal or vertical ruler, keeping the pointer in the
pasteboard but positioning the guide at the desired location on the target spread.

To toggle between horizontal and vertical guides, select the guide and hold down Alt (Windows) or
Option (Mac OS).

To create a spread guide when the pasteboard is not visible (for example, when you’ve zoomed in),
press Ctrl (Windows) or Command (Mac OS) as you drag from the horizontal or vertical ruler to the
target spread.

To create a spread guide without dragging, double-click a specific position on the horizontal or
vertical ruler. If you want to snap the guide to the nearest tick mark, hold down the Shift key when
you double-click the ruler.

To create vertical and horizontal guides simultaneously, press Ctrl (Windows) or Command (Mac OS)
as you drag from the target spread’s ruler intersection to the desired location.
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A vertical and horizontal guide created concurrently

To reposition a ruler guide numerically, select the guide and enter values for X and Y in the Control panel.

Create a set of evenly spaced page guides

1. If the document contains multiple layers, click a layer name in the Layers panel to target the layer.
2. Choose Layout > Create Guides.
3. For Number, type a value to specify the number of rows or columns you want to create.
4. For Gutter, type a value to specify the spacing between rows or columns. Start with a low value, such as 1

pica; large gutters leave little space for columns.

Columns created with the Create Guides command are not the same as those created with the Layout >
Margins And Columns command. For example, columns created using Create Guides cannot control text flow
when a text file is placed. Use the Margins And Columns command to create major column divisions
appropriate for autoflow text, and use the Create Guides command to create column grids and other layout
aids.

5. For Fit Guides To, click Margins to create the guides within the page margins, or click Page to create the
guides within the page edges.

Ruler guides evenly spaced within page margins (left) and page edges (right)

6. To delete any existing guides (including guides on locked or hidden layers), select Remove Existing Ruler
Guides.

7. If you like, select Preview to see the effect of your settings on the page, and then click OK.

Note:

The Create Guides command can create page guides only; it cannot create spread guides.

To space existing guides a uniform distance apart, select the guides (by dragging or pressing Shift as you click with
the mouse). Then, select Use Spacing from the Control panel, type the space value in the text box, and press
Enter or Return to confirm. Click either Distribute Horizontal Centers  or Distribute Vertical Centers  to the left of
the Use Spacing option.

Show or hide guides

To show or hide all margin, column, and ruler guides, choose View > Grids & Guides > Show/Hide Guides.
To show or hide ruler guides on one layer only without changing the visibility of the layer’s objects, double-
click the layer name in the Layers panel, select or deselect Show Guides, and then click OK.
To show or hide guides and all other non-printing elements, click the Preview Mode icon  at the bottom
of the Toolbox.

Work with ruler guides

You can change the attributes of individual ruler guides, and you can move, cut, copy, paste, or delete multiple
ruler guides simultaneously. Cut or copied ruler guides can be pasted to other pages or documents, but not to
other programs. To change attributes of specific guides, you must select the guides you want to change. When no
guides are selected, the Ruler Guides command sets the defaults for new guides only.
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Select ruler guides

Unselected ruler guides appear light blue by default. Selected ruler guides are highlighted in their layer color.
When a guide is selected, the Reference Point icon in the Control panel changes to  or , representing the
selected guide.

To select a single ruler guide, use the Selection tool  or the Direct Selection tool  and click the guide to
highlight it in its layer color.

If you can’t select a ruler guide and the View > Grids & Guides > Lock Guides command is already deselected, the
guide might be on that page’s master, or on a layer where guides are locked.

To select multiple ruler guides, hold down Shift as you click guides using the Selection or Direct Selection
tool. You can also drag over multiple guides, as long as the selection marquee doesn’t touch or enclose any
other object.
To select all ruler guides on the target spread, press Ctrl+Alt+G (Windows) or Command+Option+G (Mac
OS).

Move ruler guides

Using Selection tool  or the Direct Selection tool , do any of the following:

To move a ruler guide, drag it.

To move multiple ruler guides, shift-select the guides you want to move, and then drag them.

Move selected guides just as you would any other selected object, including nudging with the arrow
keys and using the Control or Transform panels.

To make a guide snap to a ruler tick mark, press Shift as you drag it. Or select the guide, press and
hold down the Shift key, and then click the mouse button.

To move a spread guide, drag the part of the guide that’s on the pasteboard, or press Ctrl
(Windows) or Command (Mac OS) as you drag the guide from within the page.

To move guides to another page or document, select one or more guides, choose Edit > Copy or
Edit > Cut, go to another page, and then choose Edit > Paste. If you’re pasting onto a page of the
same size and orientation as the guides’ original page, the guides appear in the same position.

Note:

The Paste Remembers Layers option affects the layer on which pasted guides appear.

Delete ruler guides

To delete individual guides, select one or more ruler guides and then press Delete. (You can also drag ruler
guides and drop them on a ruler to delete them.)
To delete all ruler guides on the target spread, right-click (Windows) or Ctrl-click (Mac OS) a selected guide
or ruler, and choose Delete All Guides On Spread.
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If you cannot delete a guide, it may be locked, it may be on a master page, or it may be on a locked layer.

Customize ruler guides

1. Do one of the following:

To change options for one or more existing ruler guides, select those ruler guides.

To set default options for new ruler guides, deselect all guides by clicking in an empty area.

2. Choose Layout > Ruler Guides.
3. For View Threshold, specify the magnification below which ruler guides do not appear. This prevents ruler

guides from appearing too close together at lower magnifications.
4. For Color, choose a color or choose Custom to specify a custom color in the system color picker. Then

click OK.

You can set the current magnification as the view threshold for new ruler guides by pressing Alt (Windows) or
Option (Mac OS) as you drag the ruler guides you’ve selected.

Lock or unlock ruler guides

To lock or unlock all ruler guides, choose View > Grids & Guides > Lock Guides to select or deselect the
menu command.
To lock or unlock ruler guides on one layer only, without changing the visibility of the layer’s objects,
double-click the layer name in the Layers panel, select or deselect Lock Guides, and then click OK.

Change ruler guide stacking order

By default, ruler guides appear in front of all other guides and objects. However, some ruler guides may block your
view of such objects as lines with narrow stroke widths. You can change the Guides in Back preference to display
ruler guides in front of or behind all other objects. However, regardless of the Guides in Back setting, objects and
ruler guides are always in front of margin and column guides. Also, although putting guides on different layers
organizes them structurally, it does not affect their visual stacking order—the Guides in Back preference stacks all
ruler guides as a single set in relation to all page objects.

Default stacking order

A. Ruler guides B. Page objects C. Margin and column guides D. Page 

1. Choose Edit > Preferences > Guides & Pasteboard (Windows) or InDesign > Preferences > Guides &
Pasteboard (Mac OS).

2. Select Guides in Back, and click OK.

Snap objects to guides and grids

To precisely align objects to guides, use the Snap To Guides and Snap To Document Grid commands. Object

315



To the top

edges will snap to (be pulled toward) the nearest grid intersection or guide when you draw, move, or resize the
objects.

The exact range within which an object snaps to guides is called the snap-to zone, which you can adjust. When
you select both the Snap To Guides and the Snap To Document Grid commands, the grid takes precedence.

Keep the following guidelines in mind as you align objects to guides and grids:

To snap an object to a guide, drag an object toward a guide until one or more of the object’s edges is
within the guide’s snap-to zone.

Guides must be visible for objects to snap to them. However, objects can snap to the document and
baseline grids whether the grids are visible or not.

Objects on one layer snap to ruler guides visible on any other layer. If you don’t want objects to snap to
guides on a certain layer, hide that layer’s guides.

To snap the text baseline to the baseline grid, choose Grid Alignment > Roman Baseline from the Control
panel menu or Paragraph panel menu. Alternatively, set Grid Alignment to Roman Baseline from the column
style Grid Settings.

For the baselines of text to snap to the baseline grid, press the Align to Baseline Grid button  for
individual paragraphs or paragraph styles.

1. Choose View > Grids & Guides and make sure that Snaps To Guides is selected (checked).

Note:

The Snap To Guides command controls both snapping to guides and snapping to the baseline grid.

2. To specify the snap-to zone, choose Edit > Preferences > Guides & Pasteboard (Windows) or InDesign >
Preferences > Guides & Pasteboard (Mac OS), type a value for Snap To Zone, and click OK. The Snap To
Zone value is always in pixels.

Use smart guides

The Smart Guides feature makes it easy to snap objects to items in your layout. As you drag or create an object,
temporary guides appear, indicating that the object is aligned with an edge or center of the page or with another
page item.

By default, the Smart Guides feature is selected. You can turn off smart guides, or you can turn off any of the
smart guide categories:

Smart Object Alignment

Smart object alignment allows for easy snapping to page item centers or edges. In addition to snapping, smart
guides dynamically draw to indicate which object is being snapped to.

Smart Dimensions

Smart dimension feedback appears when you’re resizing, creating, or rotating page items. For example, if you
rotate one object on your page 24 degrees, a rotation icon appears as you rotate another object close to 24
degrees. This hint lets you snap the object to the same rotation angle of the adjacent object. Similarly, as you
resize an object next to another object, a line segment with arrows at each end lets you snap the object to the
same width or height as the adjacent object.
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Smart Spacing

Smart spacing lets you quickly arrange page items with the help of temporary guides that indicate when the
spacing between objects is even.

Smart Cursors

Smart cursor feedback appears in a gray box as X and Y values when you’re moving or resizing object or as a
measurement when you’re rotating values. The Show Transformation Values option in Interface preferences lets
you turn smart cursors on and off.

For a video tutorial on using smart guides, see www.adobe.com/go/lrvid4029_id.

Turn smart guides on or off

Choose View > Grids & Guides > Smart Guides.

Turn smart guide categories on or off

1. Open the Guides & Pasteboard preferences.
2. Indicate whether you want Align To Object Center, Align To Object Edge, Smart Dimensions, and Smart

Spacing turned on or off, and click OK.

To turn off smart cursors, which displays the X and Y values of objects you mouse over, deselect Show
Transformation Values in Interface preferences.

Change the appearance of smart guides

1. Open the Guides & Pasteboard section of the Preferences dialog box.
2. Choose a different color from the Smart Guides menu, and click OK.

Tips for using Smart Guides

Smart Guides take effect only on page items and intersections that are in the current page view. If you
have many objects on a page and are trying to align an object to another object or objects in particular,
zoom in on that area specifically.If you don’t want Smart Guides to snap to column guides, turn off Snap To
Guides temporarily by choosing View > Grids & Guides > Snap To Guides.The Smart Guides feature is
accurate regardless of zoom percentage, so it isn’t necessary to zoom in to see if two objects are really
aligned at their left edges, for example.

Adobe also recommends

Layers
Customize the pasteboard and guides
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Viivaimet ja mittayksiköt

Alkuun

Viivainten ja mittayksiköiden muuttaminen
Nollakohdan muuttaminen
Objektien mittaaminen
Yleistä Tietoja-paneelista

Katso lisätietoja ja ohjeita napsauttamalla seuraavia linkkejä.

Viivainten ja mittayksiköiden muuttaminen
Voit muuttaa paneelien ja valintaikkunoiden sekä näytössä näkyvien viivainten mittayksiköitä. Voit myös muuttaa asetuksia milloin tahansa ja
tilapäisesti ohittaa nykyiset mittayksiköt antamalla uuden arvon. Oletusarvoisesti viivaimilla mittaaminen aloitetaan sivun tai aukeaman vasemmasta
yläkulmasta. Voit muuttaa aloituskohtaa siirtämällä nollakohtaa. (Lisätietoja: Nollakohdan muuttaminen.)

Yksikön muuttaminen ei siirrä apuviivoja, ruudukoita tai objekteja. Jos viivaimen jakomerkit muuttuvat, niiden kohdistus vanhojen merkkien mukaan
kohdistettuihin objekteihin voi olla väärä.

Julkaisuikkunan viivaimet
A. Merkityt jakomerkit B. Pääjakomerkit C. Apujakomerkit

Voit käyttää vaaka- ja pystyviivaimissa eri mittajärjestelmiä. Vaakaviivaimessa käytettävää järjestelmää käytetään myös sarkaimissa, reunuksissa,
sisennyksissä ja muissa mitoissa. Jokaisella aukeamalla on oma pystyviivaimensa. Kaikilla pystyviivaimilla on kuitenkin samat asetukset, jotka
määritetään Yksiköt ja lisäykset -valintaikkunassa.

Viivainten oletusmittayksikkö on pica (yksi pica vastaa 12:ta pistettä). Mukautettujen mittayksiköiden käyttäminen viivaimessa vaikuttaa viivaimessa
näkyviin pääjakomerkkeihin. Jos määrität esimerkiksi pystyviivaimen mukautetuksi mittayksiköksi 12 pistettä, viivaimen pääjakomerkit näkyvät 12
pisteen välein (jos se on mahdollista nykyisellä suurennuksella). Myös merkityt jakomerkit kuuluvat mukautettuihin pääjakomerkkeihin, joten
edellisessä esimerkissä viivaimen kolmannen 12 pisteen lisäyksen kohdalla on merkintä 36 pistettä.

Viivainten näyttäminen ja kätkeminen
 Valitse normaalissa näyttötilassa (Näytä > Näyttötila > Normaali) Näytä > Näytä viivaimet tai Kätke viivaimet.

Mittayksiköiden ja viivainten muuttaminen

1. Valitse Muokkaa > Asetukset > Yksiköt ja lisäykset (Windows) tai InDesign > Asetukset > Yksiköt ja lisäykset (Mac OS).

2. Voit muuttaa nollakohdan lähtöpistettä Viivaimen yksiköt -osan Nollakohta-valikosta jollakin seuraavista tavoista:

Jos haluat määrittää viivaimen nollakohdan kunkin aukeaman vasempaan yläkulmaan, valitse Aukeama. Vaakaviivain mittaa koko
aukeamaa.

Jos haluat määrittää viivaimen nollakohdan kunkin sivun vasempaan yläkulmaan, valitse Sivu. Vaakaviivain alkaa nollasta aukeaman
jokaisen sivun kohdalla.

Määritä viivaimen lähtöpiste selän keskelle valitsemalla Selkä. Vaakaviivaimen arvot ovat negatiivisia selän vasemmalla puolella ja
positiivisia selän oikealla puolella.

3. Voit muuttaa viivainten, valintaikkunoiden ja paneelien mittajärjestelmän valitsemalla haluamasi järjestelmän Vaaka- ja Pysty-kohtiin tai
valitsemalla Mukautettu ja määrittämällä pistemäärän, jonka mukaan viivaimen pääjakomerkkien välit määräytyvät.

Jos otat käyttöön jonkin muun mittajärjestelmän kuin pisteet, Lisäysväli-perusruudukkoarvo näytetään silti pisteinä. Tämä helpottaa pisteinä
näytettävien tekstin koon ja rivivälitysarvojen määrittämistä sopiviksi.

4. Jos haluat muuttaa tekstin koolle käyttämääsi arvoa, valitse Tekstin koko -valikosta Pisteet tai Pikselit. Tämä valinta on erityisen hyödyllinen,
kun suunnittelet web-julkaisua.
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5. Jos haluat muuttaa viivan paksuudelle käyttämääsi arvoa, valitse Viivan paksuus -valikosta Millimetrit tai Pikselit. Tämä valinta on erityisen
hyödyllinen, kun suunnittelet web-julkaisua.

6. Voit muuttaa pisteiden laskemissa käytettävän arvon määrittämällä haluamasi pistekoon tuumaa kohden kohdassa Pistettä tuumalla.

7. Määritä seuraavat asetukset Näppäimistön lisäykset -kohdassa:

Kohdistinnäppäin Määrittää lisäyksen siirrettäessä objekteja nuolinäppäimillä.

Koko/rivivälistys Määrittää lisäyksen, jolla pistekokoa tai rivivälistystä kasvatetaan tai pienennetään pikanäppäinten avulla.

Peruslinjan siirto Määrittää lisäyksen siirrettäessä peruslinjaa pikanäppäinten avulla.

Välistys/merkkiväli Määrittää lisäyksen muutettaessa välistystä ja merkkiväliä pikanäppäinten avulla.

8. Napsauta OK-painiketta.

Viivaimen yksikköjä voi muuttaa myös napsauttamalla viivainta hiiren kakkospainikkeella (Windows) tai Ctrl-näppäin alhaalla (Mac OS) ja
valitsemalla yksiköt pikavalikosta. Voit muuttaa vaaka- ja pystyviivainten yksiköt samanaikaisesti napsauttamalla viivainten leikkauskohtaa hiiren
kakkospainikkeella tai Ctrl-näppäin alhaalla.

Oletusmittayksiköiden ohittaminen
Voit määrittää mittayksikön, joka poikkeaa oletusarvosta.

 Valitse nykyinen arvo paneelista tai valintaikkunasta ja määritä uusi arvo seuraavassa taulukossa esitetyllä tavalla:

Määritä Kirjoita nämä kirjaimet arvon
jälkeen

Esimerkit Toiminto

tuumaa i

in

tuumaa

"

5,25 i

5,25 tuumaa

5,25 tuumaa

5,25"

5 1/4 tuumaa

millimetriä mm 48 mm 48 millimetriä

senttimetriä cm 12 cm 12 senttimetriä

picaa pica 3 p 3 picaa

pistettä pt

p (ennen arvoa)

6 pt

p6

6 pistettä

Picat ja pisteet p (arvojen välillä) 3p6 3 picaa, 6 pistettä

pikseliä pikseliä 5 pikseliä 5 pikseliä

ciceroa c 5 c 5 ciceroa

agaattia ag 5 ag 5 agaattia

Nollakohdan muuttaminen
Vaaka- ja pystyviivainten nollat leikkaavat nollakohdassa. Nollakohtaoletuksena on aukeaman ensimmäisen sivun vasen yläkulma. Nollakohdan
oletussijainti on näin ollen aina sama suhteessa aukeamaan, mutta se voi näyttää vaihtelevan suhteessa taittopöytään.

Ohjauspaneelin, Tietoja-paneelin ja Muunnos-paneelin X- ja Y-koordinaatit näytetään suhteessa nollakohtaan. Nollakohtaa siirtämällä voit mitata
välimatkoja, luoda uuden viitekohdan mittoja varten tai asetella suurikokoisia sivuja vierekkäin. Oletusarvoisesti jokaisen aukeaman ensimmäisen
sivun vasemmassa yläkulmassa on yksi nollakohta, mutta voit sijoittaa sen myös sidontaselkään. Voit myös määrittää jokaiselle sivulle oman
nollakohdan.

Nollakohdan säätäminen
Kun siirrät nollakohtaa, se siirtyy suhteessa samaan kohtaan kaikilla aukeamilla. Jos siirrät nollakohdan esimerkiksi sivuaukeaman toisen sivun
vasempaan yläkulmaan, nollakohta näkyy samassa paikassa julkaisun kaikkien muiden aukeamien toisilla sivuilla.

 Tee jokin seuraavista:

Voit siirtää nollakohtaa vetämällä se vaaka- ja pystyviivainten leikkauskohdasta paikkaan, johon haluat siirtää nollakohdan.
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Alkuun

Alkuun

Uuden nollakohdan määrittäminen

Voit palauttaa nollakohdan alkuperäiseen paikkaansa kaksoisnapsauttamalla vaaka- ja pystyviivainten leikkauskohtaa .

Voit lukita nollakohdan tai poistaa sen lukituksen napsauttamalla viivainten nollakohtaa hiiren kakkospainikkeella (Windows) tai Ctrl-näppäin
alhaalla (Mac OS) ja valitsemalla sitten pikavalikosta Lukitse nollakohta.

Oletusnollakohdan muuttaminen
Voit määrittää viivainten oletusnollakohdan ja vaakaviivaimen käyttöalan Asetukset-valintaikkunan Lähtöpiste-asetuksen avulla. Alue määrittää,
mittaako viivain sivun reunasta reunaan, koko arkin reunasta reunaan vai, jos kyseessä on monisivuinen aukeama, selän keskeltä sivun reunaan.

Jos määrität viivaimen nollakohdan kunkin aukeaman sidontaselkään, nollakohta lukkiutuu paikalleen. Tällöin et voi siirtää viivaimen nollakohtaa
vetämällä sitä viivainten leikkauskohdasta, ellet ensin valitse nollakohdalle jotakin toista asetusta.

1. Valitse Muokkaa > Asetukset > Yksiköt ja lisäykset (Windows) tai InDesign > Asetukset > Yksiköt ja lisäykset (Mac OS).
2. Valitse Viivaimen yksiköt -osan Nollakohta-valikosta jokin seuraavista vaihtoehdoista:

Jos haluat määrittää viivaimen nollakohdan kunkin aukeaman vasempaan yläkulmaan, valitse Aukeama. Vaakaviivain mittaa koko
aukeamaa.

Jos haluat määrittää viivaimen nollakohdan kunkin sivun vasempaan yläkulmaan, valitse Sivu. Vaakaviivain alkaa nollasta aukeaman
jokaisen sivun kohdalla.

Määritä viivaimen lähtöpiste selän keskelle valitsemalla Selkä. Vaakaviivaimen arvot ovat negatiivisia selän vasemmalla puolella ja
positiivisia selän oikealla puolella.

Voit muuttaa vaakaviivaimen nollakohdan asetuksia myös pikavalikosta. Avaa valikko napsauttamalla vaakaviivainta hiiren kakkospainikkeella
(Windows) tai Ctrl-näppäin alhaalla (Mac OS).

Objektien mittaaminen
Mittatyökalu laskee minkä tahansa kahden pisteen välisen etäisyyden julkaisuikkunassa. Kun mittaat etäisyyden pisteestä toiseen, etäisyys näkyy
Tietoja-paneelissa. Kaikki muut mittaukset paitsi kulman mittaus lasketaan julkaisuun määritetyillä mittayksiköillä.

Kun olet mitannut kohteen mittatyökalulla, viivat pysyvät näkyvissä, kunnes teet uuden mittauksen tai valitset toisen työkalun.

Mittaa kahden pisteen välisen etäisyyden
1. Varmista, että Tietoja-paneeli on näkyvissä (Ikkuna > Tietoja).

2. Valitse mittatyökalu . (Voit avata mittatyökalun napsauttamalla pipettityökalua ja pitämällä hiiren painikkeen alhaalla.)
3. Napsauta ensimmäistä pistettä ja vedä toiseen pisteeseen. Jos haluat työkalun liikkeen muuttuvan 45 asteen välein, pidä vaihtonäppäintä

alhaalla vetäessäsi. Et voi vetää taittopöydän ja aukeaman ulkopuolelle.

Leveys- ja korkeusmitat näkyvät Tietoja-paneelissa.

Kulmien mittaaminen
1. Varmista, että Tietoja-paneeli on näkyvissä (Ikkuna > Tietoja).

2. Valitse mittatyökalu . (Voit avata mittatyökalun napsauttamalla pipettityökalua ja pitämällä hiiren painikkeen alhaalla.)
3. Tee jokin seuraavista:

Mittaa kulma x-akselista lukien vetämällä työkalua.

Jos haluat mitata mukautetun kulman, luo kulman ensimmäinen viiva vetämällä. Kohdista työkalu mittausviivan aloitus- tai lopetuspisteen
päälle. Luo kulman toinen viiva joko kaksoisnapsauttamalla ja vetämällä tai pitämällä Alt- (Windows) tai optionäppäintä (Mac OS)
alhaalla ja vetämällä.

Kun mittaat mukautetun kulman, ensimmäisen linjan pituus on Tietoja-paneelissa D1 ja toisen D2.

Yleistä Tietoja-paneelista
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Tietoja-paneelissa on tietoja valituista objekteista, nykyisestä julkaisusta tai valitun työkalun alla olevasta alueesta. Tietoja-paneeli näyttää myös
sijaintia, kokoa ja kiertoa koskevat tiedot. Kun siirrät objektia, Tietoja-paneeli näyttää sen sijainnin myös suhteessa alkuperäiseen sijaintiin.

Tiedot-paneelista voit myös helposti tarkastaa juttujen sana- ja merkkimäärät.

Toisin kuin muut InDesign-paneelit, Tietoja-paneeli on vain katselua varten. Siihen ei voi määrittää arvoja, eikä sen näyttämiä arvoja voi muokata.
Voit tarkastella lisätietoja valitusta objektista valitsemalla paneelivalikosta Näytä asetukset.

Tietoja-paneeli
A. Kohdistimen vaakasijainti (X) B. Kohdistimen pystysijainti (Y) C. Objektin tai työkalun siirtymisetäisyys suhteessa aloituskohtaan D. Leveys
nykyisinä yksikköinä E. Korkeus nykyisinä yksikköinä F. Kiertoaste

Tietoja-paneelin näyttäminen
 Valitse Ikkuna > Tietoja.

Voit muuttaa nykyistä mittajärjestelmää napsauttamalla pluskuvakkeen vieressä olevaa pientä kolmiota.

Laske sanamäärä
1. Sijoita tekstin lisäyskohta tekstikehykseen tai valitse teksti.
2. Valitse Ikkuna > Tietoja.

Tiedot-paneeli näyttää jutussa tai valitussa tekstissä olevien sanojen ja merkkien määrän. Jos osa tekstistä on ylijuoksevaa, näkyviin tulee
plusmerkki (+) ja sen jälkeen luku, joka ilmaisee ylijuoksevien merkkien, sanojen tai rivien määrän.

Tietoja-paneelin lisäasetusten tarkasteleminen
 Valitse Tietoja-paneelivalikosta Näytä asetukset.

Valitun työkalun tai objektin mukaan lisätiedot voivat olla seuraavanlaisia:

Valitun objektin täytön ja viivan väriarvot sekä tiedot liukuväreistä .

Värimallien nimet. Voit myös näyttää väriavaruuden arvot napsauttamalla täyttö- tai viivakuvakkeen vieressä olevaa pientä kolmiota.

Tiedot nykyisestä julkaisusta, jos julkaisusta ei ole mitään valittuna, kuten sijainti, viimeinen muokkauspäivämäärä, tekijä ja tiedostokoko.

Merkkien, sanojen, rivien ja kappaleiden määrä, kun luot tekstinlisäyskohtia tai valitset tekstiä tekstityökalulla. (Jos osa tekstistä on
ylijuoksevaa, näkyviin tulee plusmerkki (+) ja sen jälkeen luku, joka ilmaisee ylijuoksevien merkkien, sanojen tai rivien määrän.)

Tiedostotyyppi, tarkkuus ja väriavaruus, kun valittuna on kuvatiedosto. Tarkkuus näkyy sekä todellisina kuvapisteinä tuumaa kohti
(alkuperäisen kuvatiedoston tarkkuus) ja käytössä olevina kuvapisteinä tuumaa kohti (kuvatiedoston tarkkuus sen jälkeen, kun sen kokoa on
muutettu InDesignissa). Jos värienhallinta on käytössä, näyttöön tulee myös ICC-värienhallintaprofiili.

Kallistuskulma tai vaaka- ja pystyskaalaus, jos kallistustyökalu, skaalaustyökalu tai vapaa muunto -työkalu on valittuna.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Transforming objects
Transform panel overview
Change transformation settings
Transform objects
Rotate objects
Move objects
Scaling vs. resizing objects
Resize objects
Scale objects
Reflect (flip) objects
Shear (skew) objects
Repeat transformations
Clear transformations

Transform panel overview

Use the Transform panel to view or specify geometric information for any selected object, including values for
position, size, rotation, and shearing. Commands in the Transform panel menu provide additional options and quick
ways to rotate or reflect objects.

Note:

The buttons and panel menu commands in the Transform panel are also available in the Control panel.

Transform panel

A. Reference point locator B. Constrain Proportions icon C. Panel menu 

Display the Transform panel

Choose Window > Object & Layout > Transform.

View geometric information about objects

When you select an object, its geometric information appears in the Transform and Control panels. If you select
multiple objects, the information represents all selected objects as a unit.

Select one or more objects, and display the Transform panel (Window > Object & Layout > Transform).

Position information is relative to the ruler origin and the reference point of the object. Angle information is
relative to the pasteboard, where a horizontal line has an angle of 0°.
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To the topChange transformation settings

The Transform panel includes several options that determine how objects are transformed and how
transformations are displayed in the Transform and Control panels.

Change the reference point for selected objects

All transformations originate from a fixed point on or near the object, called the reference point. An icon  is
displayed at the reference point when a transformation tool, such as the Scale tool, is active.

Reference point moved to center (left), and object scaled (right)

Do one of the following:

To specify a different reference point for the selected object, click any of the nine points on the
reference point locator  in the Transform or Control panel.

As you click different reference points on the Transform or Control panel (top left and right), the
reference point for the selected object changes (bottom left and right).

To move the selected object’s reference point to a specific location, select the Rotate tool , the
Scale tool , or the Shear tool , position the tool over the reference point icon, and then drag it
to a new location. Or, with one of these tools selected, click anywhere on the object or page. The
reference point moves to that location.

Note:

When a transform tool is selected, clicking away from the object does not deselect it— it moves the reference
point. Choose Edit > Deselect All to deselect an object.

The last-selected reference point on the reference point locator becomes the new default reference point for all
tools and objects. If you drag an object’s reference point icon to a custom location (not on an anchor point), the
panel reference point returns to the default position once the current object is no longer selected. InDesign
preserves the default reference point position for new documents so you don’t have to reset it.
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Change the information displayed for nested objects

The Transform panel orients an object to a spread’s pasteboard, where a horizontal line has a rotation angle of 0°.
By default, this is true even if the object is nested inside a transformed container object (that is, if the object is
part of a transformed group or pasted inside a transformed frame). For example, if you paste an unrotated graphic
inside a frame, rotate the frame 10° with the graphic inside, and then select the graphic using the Direct Selection
tool, the Transform panel displays the graphic’s rotation angle as 10°.

Object’s rotation angle displayed relative to pasteboard

If you prefer, you can deselect the Transformations Are Totals command to see the same information relative to
the nested object’s container. In the example above, if you deselect Transformations Are Totals, the Transform
panel displays the graphic’s rotation angle as zero (the angle it has relative to its rotated container).

Object’s rotation angle displayed relative to container object

1. Open the Transform panel or Control panel.
2. In the Transform or Control panel menu, do one of the following:

Leave Transformations Are Totals selected (the default) to display transformation values for nested
objects relative to the pasteboard.

Deselect Transformations Are Totals to display rotate, scale, and shear values for nested objects
relative to the container object.

Measure the position of selected objects

The Show Content Offset command determines the appearance of the X and y values in the Transform panel for
nested objects selected with the Direct Selection tool . The selected reference point in the reference point locator
of the Transform and Control panels determines which of the nine reference points on the selected object is being
compared to the zero point of the document or to the zero point of a container frame. The zero point of a
container frame is always its upper-left corner.

The position of selected objects is measured from three positions:

The position of the container frame in relation to the zero point of the document. With Show Content Offset
turned on or off, select the container frame using the Selection tool.

The position of the nested object in relation to the zero point of the document. Turn off Show Content
Offset and select the nested object using the Direct Selection tool.

The position of the nested object in relation to the zero point (upper-left corner) of its container frame. Turn
on Show Content Offset and select the nested object using the Direct Selection tool.

Parent frame’s position displayed relative to zero point of document

Nested object’s position displayed relative to zero point of document
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Nested object’s position displayed relative to container frame

If Show Content Offset is selected, the X and Y values of the embedded object appear relative to the container
object, and the X/Y icons in the Transform panel change to X+/Y+. If this command is deselected, the nested
object values appear relative to the rulers.

In the Transform or Control panel menu, select or deselect Show Content Offset.

Include or exclude stroke weight in measurements

Stroke weight can affect an object’s size and position. You can change the stroke’s alignment and then choose
whether the Transform panel measures an object’s size and position from the center or from the edge of its stroke.
For information on changing stroke alignment, see Stroke panel options.

Note:

This option does not change how stroke weights are affected when scaling a frame, only whether any changes
affect measurements.

In the Transform or Control panel menu, do one of the following:

Select Dimensions Include Stroke Weight when you want panel measurements to represent the outer
edge of an object’s stroke. For example, if one frame is 2 points shorter than the other, but the
shorter frame’s stroke is 2 points thicker, this setting will cause both frames to display the same
height values in the Transform and Control panels.

Deselect Dimensions Include Stroke Weight when you want the panel measurements to represent an
object’s path or frame regardless of its stroke weight. For example, two frames of the same height
will display the same height values in the Transform and Control panels, regardless of differences in
their stroke weights.

Transform objects

You can modify an object’s size or shape, and change its orientation on the pasteboard, by using tools and
commands. The toolbox includes four transformation tools—the Rotate, Scale, Shear, and Free Transform tools. In
addition, you can use the Selection tool to transform objects. All transformations, with the addition of reflection,
are available in the Transform and Control panels, where you can precisely specify transformations.

Transformation tools (top) compared to Transform panel (bottom)

A. Rotation options B. Shearing options C. Scaling options 

When transforming objects, note the following:

The results of a transformation can differ significantly, depending on what is selected. For example, when
you rotate an image, what gets rotated depends on whether you select the image, the frame, or the frame

326



and the image. Use the Selection tool  to transform (rotate, scale, or shear) an entire path and its content
(click outside the content grabber); use the Direct Selection tool  to transform just the path without its
content or the content without its path. To transform the content without its path, make sure that all
anchor points are selected.

To resize both the frame and content, use the Scale X Percentage and Scale Y Percentage fields, not the W and H
fields. The W and H fields change only the selected frame or content, not both. Keep in mind that you’re not
limited to specifying percentages in the Scale fields. You can type dimensions by including the unit of
measurement, such as “6p.”

A transformation affects all selected objects as a single unit. For example, if you select multiple objects and
rotate them 30°, they all rotate around one reference point. If you want to rotate each selected object 30°
around its own reference point, you must select and rotate them individually.

When transforming type, you can use either of two selection methods: Use the Selection or Direct Selection
tool to select an entire text frame or text converted to outlines, and then use the transformation tools; or
use the Type tool to select text or to click an insertion point in a text frame, and then specify
transformations in the Transform panel, Control panel, or dialog boxes available when you double-click a
tool. In both cases, the transformation affects the entire text frame.

When you rotate, skew, or scale a group, the settings apply to the entire group, as well as to the individual
objects in the group. For example, if you rotate a group 30°, the rotation value in the Transform or Control
panel is 30° whether you select the group itself or direct-select an object in the group.

Transform objects with the Transform panel

Use the selection tools to determine whether the content and frame are transformed together or separately.

1. Select an object to transform.

To transform both the frame and its content, use the Selection tool to select the frame.

To transform the content without transforming its frame, use the Direct Selection tool  to direct-
select the object, or use the Selection tool to click the content grabber of an image.

To transform a frame without transforming the content, direct-select the frame, and select all the
anchor points.

2. In the Transform panel or Control panel, specify the reference point for the transformation.

All values in the panel refer to the bounding boxes of the objects. X and Y values refer to the selected
reference point on the bounding box relative to the ruler origin.

3. Do any of the following:
Enter new values in the text boxes.
Choose values from available pop-up menus.
Choose commands from the panel menu

Note:

To maintain the object’s proportions when using the Scale X Percentage and Scale Y Percentage options,
click the Constrain Proportions icon  in the panel. When the option is not selected, dots appear on both
sides of the icon (like a broken chain link). You can also specify dimensions rather than percentages by
specifying the unit of measurement, such as 6p.

4. Press Tab, Enter (Windows), or Return (Mac OS) to apply the change.

327



To the top

Transform objects with the Selection tool

Use the Selection tool to move, resize, and rotate objects.

1. Using the Selection tool , select an object. To transform an image within a frame, click the content
grabber that appears when you hold the pointer over an image.

2. Do any of the following:

To move objects, click anywhere within the bounding box, and then drag.

To scale objects, hold down Ctrl (Windows) or Command (Mac OS), and drag any bounding box
handle until the object is the desired size. Include the Shift key to preserve the selection’s
proportions. Include the Alt (Windows) or Option (Mac OS) key to scale objects from the center.

To rotate objects, position the pointer anywhere outside a bounding box handle. When the pointer
changes to , drag until the selection is at the desired angle of rotation.

To reflect objects, drag a handle of the bounding box past the opposite edge or handle, until the
object is at the desired level of reflection.

Transform objects with the Free Transform tool

The Free Transform tool works the same way it does in Adobe Photoshop and Adobe Illustrator, by providing a
way to perform any transformation with just one tool. You can combine transformations, such as rotating and
scaling, while the Free Transform tool is active.

You can use keyboard shortcuts to instantly switch among the Free Transform tool (press E), the Selection tool (V),
and the Direct Selection tool (A).

1. Using the appropriate selection tool, select the object or objects to transform.
2. Select the Free Transform tool .

To move objects, click anywhere within the bounding box, and then drag.

To scale objects, drag any bounding box handle until the object is the desired size. Shift-drag the
handle to preserve the selection’s proportions.

To scale objects from the center of the bounding box, Alt-drag (Windows) or Option-drag (Mac OS).

To rotate objects, position the pointer anywhere outside the bounding box. When the pointer
changes to , drag until the selection is at the desired angle of rotation.

To reflect objects, drag a handle of the bounding box past the opposite edge or handle, until the
object is at the desired level of reflection.

To shear objects, begin dragging a handle, and then hold down Ctrl (Windows) or Command
(Mac OS). Hold down Alt+Ctrl (Windows) or Command+Option to shear from both sides of the
object.

Rotate objects

You can rotate objects using any of several methods.
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Rotate an object using the Rotate tool

1. Select an object to rotate. To rotate both the frame and its content, use the Selection tool to select the
frame. To rotate the content without rotating its frame, click the Content Grabber or use the Direct
Selection tool to select the object. To rotate a frame without rotating the content, direct-select the frame,
and select all the anchor points.

2. Select the Rotate tool .
3. If you want to use a different reference point for the rotation, click where you want the reference point to

appear.
4. Position the tool away from the reference point, and drag around it. To constrain the tool to multiples of

45°, hold down Shift as you drag. For finer control, drag farther from the object’s reference point.

You can also rotate by using the Free Transform tool.

If Smart Guides (and Smart Dimensions) are turned on, visual clues indicate when you’re rotating an object the
same degree as a nearby rotated object. For example, if you rotate one object on your page 24 degrees, a rotation
icon appears as you rotate another object close to 24 degrees.

Rotate an object using the Selection tool

Using the Selection tool, position the pointer anywhere outside a selection handle. When the pointer
changes to , drag until the selection is at the desired angle of rotation.

Rotate an object using the Transform or Control panel

1. Select an object to rotate. To rotate both the frame and its content, use the Selection tool  to select the
frame. To rotate the content without rotating its frame, click the Content Grabber or use the Direct
Selection tool to select the object. To rotate a frame without rotating the content, direct-select the frame,
and select all the anchor points.

2. Do any of the following:

To rotate clockwise or counterclockwise in 90° increments, click either of the Rotate buttons in the
Control panel.

To rotate by a preset angle, choose an angle from the Rotation Angle  pop-up menu in the
Transform or Control panel.

In the Rotation Angle  box on the Transform or Control panel, type a positive angle to rotate
selected objects counterclockwise, or type a negative angle to rotate selected objects clockwise, and
then press Enter (Windows) or Return (Mac OS).

To create a copy of the object with the new rotation applied to the copy, type a value in the Rotation
Angle box on the Transform panel and then hold down Alt (Windows) or Option (Mac OS) as you
press Enter.

When you rotate a single object, the specified value remains displayed in the Transform or Control panel. When
you rotate multiple objects, the Rotation Angle is reset to 0 degrees, even though the objects are rotated.

Rotate an object using the Rotate command
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You can use the Rotate command to rotate an object by a specific amount. This command also lets you rotate a
copy of the selected object, leaving the original in place.

1. Select an object to rotate. To rotate both the frame and its content, use the Selection tool to select the
frame. To rotate the content without rotating its frame, direct-select the object. To rotate a frame without
rotating the content, direct-select the frame, and select all the anchor points.

2. Do one of the following to open the Rotate dialog box:

Choose Object > Transform > Rotate.

Double-click the Rotate tool .

Select the Rotate tool and Alt-click (Windows) or Option-click (Mac OS) on or near the object to
select a new reference point.

3. Enter the rotation angle, in degrees, in the Angle box. Enter a negative angle to rotate the object clockwise;
enter a positive angle to rotate the object counterclockwise.

4. Do one of the following:

To preview the effect before you apply it, select Preview.

To rotate the object, click OK.

To rotate a copy of the object, click Copy.

Move objects

You can move objects by cutting them from one spot and pasting them into another, by entering new horizontal
and vertical coordinates, or by dragging them. Dragging also allows you to move a copy of an object or to copy
objects between software applications.

The Smart Guides feature makes it easy to move objects to precise locations in your layout. As you drag an object,
temporary guides appear, indicating that the object you’re moving is aligned with an edge or center of the page or
with another page item.

Move objects

For best results, use the Selection tool to move multiple objects. If you use the Direct Selection tool to select
multiple objects or paths, dragging moves only the selected graphic, path, or anchor points.

1. Select an object to move. To move both the frame and its content, use the Selection tool  to select the
frame. To move the content without moving its frame, direct-select the object, or click the content grabber
when you mouse over an image. To move a frame without moving the content, direct-select the frame, and
select all the anchor points.

2. Do one of the following:
To paste the object (or a copy of it) in a new location, choose Edit > Cut or Edit > Copy. Target the
destination spread, and choose Edit > Paste. The objects appear in the center of the target spread.
To paste a copy at the same position as the original, choose Edit > Copy. Then, choose Edit > Paste
In Place. (To offset the copy from the original, nudge it using the arrow keys.)

If you want an object to appear in the same position on many pages, consider creating a master page and
paste the object on it.

To move an object to a specific numeric location, type a value for each of the X (horizontal) or Y
(vertical) position options in the Transform or Control panel. Then press Enter (Windows) or Return
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(Mac OS).

To nudge an object slightly in one direction, press or hold an arrow key; to nudge an object ten
times as far, hold down Shift as you press an arrow key.

To move an object by dragging, drag the object to a new position. Shift-drag to constrain the
movement of the object horizontally, vertically, or diagonally (in multiples of 45°).

Drag the content grabber to move an image within its frame.

Move objects by a precise amount

You can use the Move command to move an object by a specific amount. This command also lets you move a
copy of the selected object, leaving the original in place.

1. Select an object to move. To move both the frame and its content, use the Selection tool to select the
frame. To move the content without moving its frame, direct-select the object. To move a frame without
moving the content, direct-select the frame, and select all the anchor points.

2. Choose Object > Transform > Move, or double-click the icon for the Selection or Direct Selection tool in the
toolbox.

3. In the Move dialog box, do one of the following:

Enter the horizontal and vertical distances that you want the object to move. Positive values move
the object down and to the right of the x axis; negative values move the object up and to the left.

To move an object a precise distance and angle, enter the distance and angle for the move. The
angle you enter is calculated in degrees from the x axis. Positive angles specify a counterclockwise
move; negative angles specify a clockwise move. You can also enter values between 180° and 360°;
these values are converted to their corresponding negative values (for example, a value of 270° is
converted to –90°).

4. Do any of the following:

To preview the effect before you apply it, select Preview.

To move the object, click OK.

To move a copy of the object, click Copy.

Move objects to a precise location

1. Select an object to move.
2. If you want to use a different reference point for the move, click where you want the reference point to

appear.

For example, if you want to move the object to the upper-left corner of the page, select the upper-left
reference point.

3. In the X and Y fields on the Transform panel, enter the coordinates where you want the selection to be
moved.

Specify the distance objects move when nudged

1. Choose Edit > Preferences > Units & Increments (Windows) or InDesign > Preferences > Units &
Increments (Mac OS).

2. For Cursor Key, specify the distance you want each press of an arrow key to move selected objects, and
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then click OK.

If you hold down Shift while moving a selection, the selection moves ten times the distance you specify here.

Scaling vs. resizing objects

Resizing and scaling are different actions in InDesign. Resizing is simply changing the Width and Height values of
an object. Scaling involves using a percentage value related to the original scale (100%) of the frame.

The difference between resizing and scaling isn’t always apparent. A good way to see the difference is to resize
and scale a text frame that has a stroke applied to it. When you double the size of the text frame, the text size
and stroke weight remain the same. When you double the scale of the text frame, the text size and stroke weight
also double.

Resizing a frame

By default, when the frame (and not the frame contents) is selected, changing the values of the Width and Height
fields changes only the frame, not its contents, regardless of which selection tool is active.

Scaling a frame and its contents

When the frame is selected with the Selection tool, changing the values of the Scale X Percentage and Scale Y
Percentage fields changes the frame and its contents. If Auto-Fit is selected, the frame and its contents are
resized together.

Resizing or scaling frame contents

If you want to change only the content (resize or scale) of a frame, click the Content Grabber or use the Direct
Selection tool to select the contents. Once selected, you can use the Width and Height fields or the Scale fields,
depending on your preference.

Overriding defaults

If you want to scale the frame or its contents by a percentage and have the results returned in the current
measurement system, you can enter in a number with the percent sign to override the default measurement
system. For example, if the current width is 12p, and you want the new width to be 75% of the current value, you
can enter 75% in the Width field. After you press Enter, the new value for the Width displays as 9p.

Similarly, you can use other measurement system values if you want to scale to a specific increment but have the
results display in percent of the original. For example, you can replace 100% with 9p, and InDesign figures out
which percentage is required to make it that width/height.
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Resize objects

Dragging the handle of a frame that includes contents, such as an imported graphic, does not resize the contents
by default. It’s important to understand that the content and the container frame are separate items, each with its
own bounding box. Simply dragging the frame of an imported graphic will either crop the graphic or leave a blank
space outside the graphic, depending on which direction you drag. Being able to modify the frame apart from the
contents adds flexibility, but it takes some time to get used to.

The Smart Guides feature makes it easy to resize objects based on other items in your layout. As you resize an
object, temporary guides appear, indicating that the object is aligned with an edge or center of the page or is the
same height or width as another page item.

Resizing an imported graphic

A. Frame selected with Selection tool B. Frame resized C. Frame and content scaled 

To resize a frame, drag any handle using the Selection tool. If you hold down Ctrl (Windows) or Command
(Mac OS) while dragging, the frame and the content are scaled. Adding the Shift key scales proportionally.

Note:

If Auto-Fit is selected, resizing the frame resizes the image within the frame.

To resize the content of a graphics frame, use the Selection tool to click the content grabber or direct-select
the graphic, and then drag any of the graphics frame handles.
To resize a frame or its content to a precise size, select the object and enter the size in the width (W) or
height (H) fields on the Control panel.

To maintain the original proportions of the object when using the Control panel, make sure the Constrain
Proportions icon  is selected.

To resize both the frame and content, use the Scale X Percentage and Scale Y Percentage fields, not the W
and H fields. The W and H fields change only the selected frame or content, not both. Rather than
specifying percentages, you can type dimensions by including the unit of measurement, such as “6p.”
To resize a frame or its content to a percentage of its current size, select the object and enter the
percentage in the width or height fields on the Transform panel.
To create a copy of the selected object with the new size applied to the copy, type a value in the width or
height fields on the Transform panel and then hold down Alt (Windows) or Option (Mac OS) as you press
Enter.

After you resize a frame or object, you can use a fitting option (Object > Fitting) to fit the content to the frame or
the frame to the content.

Scale objects

Scaling an object enlarges or reduces it horizontally (along the x-axis), vertically (along the y-axis), or both
horizontally and vertically, relative to the reference point you specify.

By default, InDesign scales strokes. For example, if you scale a selected object with a 4-point stroke by 200%, the
Stroke panel indicates an 8-point stroke and the stroke visibly doubles in size. You can change the default stroke
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behavior by deselecting Adjust Stroke Weight When Scaling in the Transform or Control panel menu.

Scale an object using the Selection tool

To scale the content and frame simultaneously, use the Selection tool to select the object and hold down
Ctrl (Windows) or Command (Mac OS). Add the Shift key to resize the object proportionally.

Scale an object using the Scale tool

1. Select an object to scale. To scale both the frame and its content, use the Selection tool to select the
frame. To scale the content without scaling its frame, click the Content Grabber to direct-select the object.
To scale a frame without scaling the content, direct-select the frame, and select all the anchor points.

2. Select the Scale tool .
3. Position the Scale tool away from the reference point and drag. To scale the x or y axis only, start dragging

the Scale tool along one axis only. To scale proportionally, hold down Shift as you drag the Scale tool. For
finer control, start dragging farther from the object’s reference point.

You can also scale by using the Free Transform tool.

Scale an object using the Transform panel

To maintain the original proportions of the object when using the Transform panel, make sure the Constrain
Proportions icon  is selected.

1. Select an object to scale. To scale both the frame and its content, use the Selection tool to select the
frame. To scale the content without scaling its frame, direct-select the object. To scale a frame without
scaling the content, direct-select the frame, and select all the anchor points.

2. In the Transform or Control panel, do one of the following:

Choose a preset percentage value in the Scale X Percentage  or Scale Y Percentage  pop-up
menu.

Type a percentage value (such as 120%), or a specific distance (such as 10p) in the Scale X
Percentage or Scale Y Percentage box, and then press Enter or Return.

Scale an object using the arrow keys

1. Select or direct-select the object or frame.
2. In the Transform panel, click in the Scale X Percentage  or Scale Y Percentage  box.
3. Press the Up or Down Arrow Keys to scale the object by 1% increments. By pressing the Shift key at the

same time as the arrow keys you can scale the object by increments of 10%.

If you use this method to scale up by a percentage and scale down by that same percentage, the object returns to
the original scale value if Adjust Scaling Percentage is selected in General preferences. For example, if you scale a
20-mm circle up 10% and then down 10%, the circle returns to 20 millimeters (not 19.8 mm).

Scale an object using the Scale command
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1. Select an object to scale. To scale both the frame and its content, use the Selection tool to select the
frame. To scale the content without scaling its frame, direct-select the object. To scale a frame without
scaling the content, direct-select the frame, and select all the anchor points.

2. Do one of the following to open the Scale dialog box:

Choose Object > Transform > Scale.

Double-click the Scale tool .

Select the Scale tool and Alt-click (Windows) or Option-click (Mac OS) on or near the object to select
a new reference point.

3. Type a percentage value in the Scale X or Scale Y box.

To maintain the original proportions of the object when using the Transform panel, make sure the Constrain
Proportions icon  is selected.

4. Do any of the following:

To preview the effect before you apply it, select Preview.

To scale the object, click OK.

To scale a copy of the object, click Copy.

Determine how scaling is tracked

You can determine how scaling is tracked in the interface. If the Apply To Content preference option is selected in
General preferences, scaling values are reset to 100% in the Transform panel after the object is scaled. If Adjust
Scaling Percentage is selected, scaling values remain as specified (such as 125%).

With multiple objects selected, the scaling value will always display as 100%. However, you can select objects
individually to see the applied effect of the transform (such as 125%) if Adjust Scaling Percentage is selected.

1. Choose Edit > Preferences > General (Windows) or InDesign > Preferences > General (Mac OS).
2. Under When Scaling, select Apply To Content or Adjust Scaling Percentage, and then click OK.

If Adjust Scaling Percentage is selected and you scale an object, you can choose Redefine Scaling As 100% from
the Transform or Control panel menu to reset the scaling percentages to 100%.

Adjust stroke weight when objects are scaled

Select the Adjust Stroke Weight When Scaling option in the Transform or Control panel menu.

For example, if you scale a 4-point stroke by 200% when this option is turned on, the stroke weight becomes 8
points. If you turn off this option, the object doubles in size but its stroke weight remains 4 points.

If this option is turned on and you scale an object disproportionally, InDesign applies the smallest stroke weight to
all sides. For example, suppose that you scale a selected object with a 4-point stroke only in the X direction by
200%. Instead of applying an 8-point stroke in the X direction and a 4-point stroke in the Y direction, InDesign
applies the smaller value (4 points) to all sides.

Scalability of an effect
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If you created an object, and apply an effect, the effect scales consistently in proportion to the object scaling. The
proportion in which you scale the object, the effect gets scaled in the same proportion.

In preferences, General > Apply to content > Include Effects. Deselect this option if you want only the objects to
scale and not the effects.

Preferences - Include Effects

Or

Window > Object & Layout > Transform. From the flyout menu, select Adjust Effects when Scaling to turn the
effect scalability on or off.

Adjust Scaling

This works similar to the way stroke effects work. So you can scale effects just like you scale strokes.

Reset scaling value to 100%

In some cases, if you want to reset the Scale X and Scale Y values of an object to 100% without resizing the
object. For example, if you opened a document from a previous version of InDesign that has non-100% scaling
values, or you have scaled an object with the Adjust Scaling Percentage preference setting selected. When you
choose this command, the scaling values for all selected frames are reset to 100%. Choosing this command does
not change the size or appearance of objects.

1. Select one or more objects that have non-100% scaling values.

This command is dimmed if you direct-select an imported image or if an object has 100% scaling values.

2. Choose Redefine Scaling As 100% from the Transform or Control panel menu.

Note:

Choosing this command may result in unexpected behavior with objects in transformed groups.

Reflect (flip) objects

Reflecting an object flips the object across an invisible axis at the reference point you specify. (See Change
transformation settings.)

Original object (top) reflected using Flip Horizontal (middle) and Flip Vertical (bottom)

The flip/rotate indicator (P) in the middle of the Control panel appears white with a black outline if an object is
flipped. If the object is not flipped, the indicator is solid black.
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1. Select an object to flip. To flip both the frame and its content, use the Selection tool to select the frame. To
flip the content without its frame, direct-select the object. To flip a frame without its content, direct-select
the frame, and select all the anchor points.

2. Do one of the following:

To reflect using the reference point as a horizontal axis, click the Flip Horizontal button in the Control
panel.

To reflect using the reference point as a vertical axis, click the Flip Vertical button in the Control
panel.

You can also reflect objects by using the Selection tool or Free Transform tool to pull one side of an object’s
bounding box past the opposite side, or by typing negative values into the Scale X Percentage or Scale Y
Percentage options in the Transform or Control panel.

Shear (skew) objects

Shearing an object slants or skews it along its horizontal or vertical axis, and can also rotate both of the object’s
axes. Shearing is useful for:

Simulating some types of perspective, such as isometric projection.

Slanting a text frame.

Creating cast shadows when you shear a copy of an object.

Shear an object

1. Select an object to shear. To shear both the frame and its content, use the Selection tool to select the
frame. To shear the content without its frame, click the Content Grabber to direct-select the object. To
shear a frame without scaling the content, direct-select the frame, and select all the anchor points.

2. Do one of the following:

To shear selected objects by dragging, select the Shear tool . Then position the Shear tool away
from the reference point, and drag. Shift-drag to constrain shearing to a perpendicular vertical or
horizontal axis. If you start to drag at a non-perpendicular angle and then hold down the Shift key,
shearing is constrained to that angle.

Object being sheared by dragging Shear tool with reference point placed in center

If you want to use a different reference point for the shearing, click where you want the reference point to
appear.

To shear using a preset value, in the Transform or Control panel, choose an angle from the Shear
pop-up  menu.
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To shear using a specific value, in the Transform or Control panel, type a positive or negative angle
in the Shear box, and press Enter or Return.
To create a copy of the object with the new shear applied to the copy, type a value in the Shear box
in the Transform panel, and then hold down Alt (Windows) or Option (Mac OS) as press Enter.

When you shear a single object, the specified value remains displayed in the Transform or Control panel. When
you shear multiple objects, the Shear Angle value is reset to 0 degrees, even though the objects are sheared.

You can also shear by using the Free Transform tool.

Shear an object using the Shear command

You can shear an object by a specific amount by using the Shear command. This command also lets you shear a
copy of the selected object, leaving the original in place.

1. Select an object to shear. To shear both the frame and its content, use the Selection tool to select the
frame. To shear the content without its frame, click the Content Grabber to direct-select the object. To
shear a frame without scaling the content, direct-select the frame, and select all the anchor points.

2. Do one of the following to open the Shear dialog box:

Select Object > Transform > Shear.

Double-click the Shear tool .

Select the Shear tool and Alt-click (Windows) or Option-click (Mac OS) to select a new reference
point.

3. Type a new shear angle.

The shear angle is the amount of slant to be applied to the object, relative to a line perpendicular to the
shear axis. (Shear angle is calculated clockwise from the current axis.)

4. Specify the axis along which the object is to be sheared. You can shear an object along a horizontal or
vertical axis.

5. Do any of the following:

To preview the effect before you apply it, select Preview.

To shear the object, click OK.

To shear a copy of the object, click Copy.

Repeat transformations

You can repeat transformations, such as moving, scaling, rotating, resizing, reflecting, shearing, and fitting. You
can repeat either a single transformation or a sequence of transformations, and you can apply those
transformations to more than one object at a time. InDesign remembers all transformations until you select a
different object or perform a different task.

Note:

Not all transformations are recorded. For example, modifying a path or its points is not recorded as a
transformation.
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1. Select one or more objects, and perform all the transformations you want to repeat.
2. Select the object or objects to which you want to apply the same transformations.
3. Choose Object > Transform Again and then select one of the following options:

Transform Again

Applies the last single transform operation to the selection.

Transform Again Individually

Applies the last single transform operation to each selected object individually, rather than as a group.

Transform Sequence Again

Applies the last sequence of transform operations to the selection.

Transform Sequence Again Individually

Applies the last sequence of transform operations to each selected object individually.

Clear transformations

1. Select the object or objects that have been transformed.
2. Choose Clear Transformations from the Transform or Control panel menu.

Unless all values are the default values, clearing transformations results in a change of appearance for the
objects.

Note:

If the Scale values were reset at 100%, clearing the transformations will not change the scale.

Adobe also recommends

Keys for transforming objects
Gallery of transformation tools
Keys for transforming objects
Use smart guides
Create masters
Use smart guides
Scale type
Keys for transforming objects
Duplicate objects
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Understanding graphics formats
Choosing the right graphics format
About vector graphics
About bitmap images
Image resolution guidelines for final output

Choosing the right graphics format

InDesign can import a wide range of graphics file formats. Consult with the service providers who will help you
produce your document to clarify which formats to use. You can then plan your document around those formats
and the options that best apply to your project.

The following table summarizes what graphics formats would work best for the kind of document you’re designing.

Final output Graphics type Format

High resolution (>1000 dpi) Vector drawings Illustrator, EPS, PDF

Bitmap images Photoshop, TIFF, EPS, PDF

Process-color separations Vector drawings Illustrator, EPS, PDF

Color bitmap images Photoshop, CMYK TIFF, DCS, EPS,
PDF

Color-managed graphics Illustrator, Photoshop, RGB TIFF,
RGB EPS, PDF

Low-resolution printing, or PDF for
online viewing

All Any (BMP images only)

Web All Any (InDesign converts graphics to
JPEG and GIF when exporting to
HTML)

About vector graphics
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Vector graphics (sometimes called vector shapes or vector objects) are made up of lines and curves defined by
mathematical objects called vectors, which describe an image according to its geometric characteristics.

You can freely move or modify vector graphics without losing detail or clarity, because they are resolution-
independent—they maintain crisp edges when resized, printed to a PostScript printer, saved in a PDF file, or
imported into a vector-based graphics application. As a result, vector graphics are the best choice for artwork, such
as logos, that will be used at various sizes and in various output media.

The vector objects you create using the drawing and shape tools in Adobe Creative Suite are examples of vector
graphics. You can use the Copy and Paste commands to duplicate vector graphics betweenCreative Suite
components.

About bitmap images

Bitmap images—technically called raster images—use a rectangular grid of picture elements (pixels) to represent
images. Each pixel is assigned a specific location and color value. When working with bitmap images, you edit
pixels rather than objects or shapes. Bitmap images are the most common electronic medium for continuous-tone
images, such as photographs or digital paintings, because they can more efficiently represent subtle gradations of
shades and color.

Bitmap images are resolution-dependent—that is, they contain a fixed number of pixels. As a result, they can lose
detail and appear jagged if they are scaled to high magnifications on-screen or if they are printed at a lower
resolution than they were created for.

Example of a bitmap image at different levels of magnification

Bitmap images sometimes require large amounts of storage space, and often need to be compressed to keep file
sizes down when used in certain Creative Suite components. For instance, you compress an image file in its
original application before you import it into a layout.

Note:

In Adobe Illustrator, you can create bitmap effects in your artwork using effects and graphic styles.

Image resolution guidelines for final output

Bitmap images contain a fixed number of pixels, usually measured in pixels per inch (ppi). An image with a high
resolution contains more, and therefore smaller, pixels than an image of the same printed dimensions with a low
resolution. For example, a 1-inch-by-1-inch image with a resolution of 72 ppi contains a total of 5184 pixels (72
pixels wide x 72 pixels high = 5184). The same 1-inch-by-1-inch image with a resolution of 300 ppi would contain
a total of 90,000 pixels.

For imported bitmap images, image resolution is determined by the source file. For bitmap effects, you can specify
a custom resolution. To determine the image resolution to use, consider the medium of final distribution for the
image. The following guidelines can help you determine your requirements for image resolution:

Commercial printing
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Commercial printing requires 150 to 300 ppi (or more) images, depending on the press (dpi) and screen frequency
(lpi) you’re using; always consult your prepress service provider before making production decisions. Because
commercial printing requires large, high-resolution images, which take more time to display while you’re working
with them, you may want to use low-resolution versions for layout and then replace them with high-resolution
versions at print time.

In Illustrator and InDesign, you can work with low resolution versions by using the Links panel. In InDesign you
can choose either Typical or Fast Display from the View > Display Performance menu; in Illustrator you can choose
View > Outline. Alternatively, if your service provider supports Open Prepress Interface (OPI), they may provide
low-resolution images to you.

Desktop printing

Desktop printing usually requires images within the range of 72 ppi (for photographs printed on a 300 ppi printer)
to 150 ppi (for photographs printed on devices up to 1000 ppi). For line art (1-bit images), make sure that the
resolution of your graphics matches the resolution of the printer.

Web publishing

Because online publishing generally requires images with pixel dimensions that fit the intended monitor, the images
are usually less than 500 pixels wide and 400 pixels tall, to leave room for browser window controls or such layout
elements as captions. Creating an original image at screen resolution—96 ppi for Windows–based images, and
72 ppi for Mac OS–based images—lets you see the image as it will likely appear when viewed from a typical web
browser. When you’re publishing online, the only times you’re likely to need resolutions above those ranges are
when you want viewers to be able to zoom in for more detail in a PDF document, or when you’re producing a
document for printing on demand.
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Working with files and templates
Recommended workflow for InDesign documents
Open InDesign documents
Convert earlier versions of InDesign documents
Using Adobe Bridge with InDesign
Adobe Version Cue
Use document templates
Reviewing InDesign documents
Designing calendars and business cards from templates

Recommended workflow for InDesign documents

You can improve performance and prevent many problems by establishing a good workflow to use with Adobe
InDesign.

Maintain a clean computer system

Over time, changes occur to software and hardware that can lead to performance loss and system problems.
Defragmenting the hard disk, removing older versions of software, updating device drivers, optimizing memory,
running virus protection utilities, and performing other maintenance tasks can prevent applications and files from
becoming damaged. Performing these tasks regularly helps ensure that InDesign opens, displays, and prints
documents as expected.

Create a project folder

Before you begin a project, determine which files you’ll need and how you’ll store them. If you’ve experienced
problems with broken links, consider storing your linked files in the same folder as your document. InDesign
maintains links to files you place in a document, but if a link is broken, InDesign looks for the file in the
document’s folder. Storing a document and its linked files in the same folder makes it easy to move them from one
computer to another. Storing files in one folder also ensures that InDesign finds the original graphics when printing
a document. If InDesign cannot locate a linked graphic, it won’t reflect changes you make to the original graphic,
and it may print the graphic poorly or not at all.

If your project consists of multiple documents (for example, chapters in a book), you may find it useful to create a
project folder that contains a folder for each document and its linked files.

Consider using a template

Use a template if you frequently create similar projects. Templates let you create consistent documents more
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quickly while protecting the original file. For example, if you create a monthly newsletter, your template might
include ruler guides, page numbers, the newsletter masthead, and styles you want to use in each issue. (See Use
document templates.)

Open documents locally

Before you open a document stored on a network volume or on removable media, copy the document and any
linked graphics to your local hard disk. The slower access time and data transfer rate of a network volume or
removable media can cause data to become lost or corrupted, possibly damaging the document. However, be
aware of overriding someone else’s work if you copy the local files back to a network server.

Solve problems before converting a file

Damaged Adobe PageMaker or QuarkXPress® files usually remain damaged when opened in InDesign. If an error
or other unexpected behavior occurs with a converted file, open the original file in the source application and
troubleshoot it for damage.

If the converted file has problems, export it to IDML format, and then open the IDML file and save it as an
InDesign document.

Save documents

Save documents frequently, and create backup copies of important files. You can clear unnecessary data from a
document by using the Save As command. When you use the Save command, InDesign appends new information
to the document but doesn’t remove outdated data, such as information about a deleted graphic. When you use
the Save As command, however, InDesign completely rewrites the document, including only information about
objects and pages currently in the document. A document that contains only necessary data occupies less hard
drive space and redraws and prints more quickly.

Practice good design habits

Create styles in a document. Creating styles with no documents open can cause duplicate styles to appear
when you create a new document. To share styles in documents, save the styles and load them.

Use appropriate fonts. When choosing fonts for a document, consider how you intend to format and print
the text. InDesign works well with OpenType®, Type 1 (also called PostScript), and TrueType fonts.
Damaged or poorly constructed fonts can damage an InDesign document or cause it to print with
unexpected results, so use reliable fonts created by established font vendors. If you work with a service
bureau, find out its font requirements.

Avoid using too many text frames. Use as few text frames as possible to keep the document file size
smaller and the layout easier to manipulate.

Be smart with art

Use the appropriate graphics file format. When you create graphics for a project, consider how you plan to
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print the document. If you intend to print the document at a service bureau, ask the service bureau which
graphic formats work best with the output device it uses. The service bureau can also advise you on the
optimal resolution for images.

Store graphics externally. When you import a graphic file, InDesign creates a link to the graphic by default.
Linking helps minimize the file size of the document and improves the performance of InDesign. When you
print the document, the original graphic file must be available and linked. If InDesign can’t find the original,
the graphic may print as a low resolution preview or as a gray box.

Verify links and fonts before you print

To ensure that a document prints correctly, verify that all links are intact and all fonts are available. A link
becomes broken if you delete, move, or rename the original graphic. Use the Preflight and Package features before
handing off files to a service bureau.

Open InDesign documents

In general, you open document and template files the same way you do in other programs. When you open an
InDesign template, it opens as a new, untitled document by default. Document files use the extension .indd,
template files use the extension .indt, snippet files use the extension .idms, library files use the extension .indl,
interchange files use the extension .inx, markup files use the extension .idml, and book files use the extension
.indb.

You can also use the File > Open command to open files from earlier versions of InDesign, InDesign Interchange
(.inx) files, InDesign Markup (.idml) files, Adobe PageMaker 6.0 and later, QuarkXPress 3.3 and 4.1, and
QuarkXPress Passport 4.1 files. In addition, other software vendors may make plug-in software that lets you open
other file formats.

To view additional information about an InDesign document, hold down Ctrl and choose Help > About InDesign
(Windows) or hold down Command and choose InDesign > About InDesign (Mac OS).

Use the Open command

1. Choose File > Open and select one or more documents.

2. Do one of the following, and then click Open:

Select Normal (Windows) or Open Normal (Mac OS) to open the original document or a copy of a
template.

Select Original (Windows) or Open Original (Mac OS) to open an original document or template.

Select Copy (Windows) or Open Copy (Mac OS) to open a copy of a document or template.

3. If a warning message appears telling you that the color settings in the document are different from the
color settings in the application, select an option, and click OK.

Note:

Color warning messages are off by default, but you can show warnings if you change the default settings in
the Color Settings dialog box (Edit >Color Settings.)

4. If a warning message appears telling you that the document contains missing fonts, do one of the
following:
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Click OK. InDesign will automatically format the text with a substitute.

Click Find Font to search for and list fonts used throughout your document.

For more information on finding missing fonts, see Find and change fonts.

5. If a warning message appears telling you that the document contains missing or modified links, use the
Links panel to fix the links. See Update, restore, and replace links.

Open recent document

Choose File > Open Recent, and select one of the documents you saved recently.

To specify how many recent documents are displayed, choose Edit > Preferences > File Handling (Windows), or
InDesign > Preferences > File Handling, and then specify a number for Number Of Recent Items To Display. The
maximum number is 30.

Choosing word lists when opening documents

When opening a document, you may see an alert message asking if you want to use the word list in the document
or an exception word list in the user dictionary. An exception word list includes words that were added to the User
Dictionary while the document was worked on. If you know which exception word list you use, click its button. If
you’re not sure, click either button, choose Edit > Spelling > Dictionary to inspect the word lists, and then, if
necessary, choose Edit > Preferences > Dictionary (Windows) or InDesign > Preferences > Dictionary (Mac OS) to
reset the word list used for composition. See Hyphenation and spelling dictionaries.

Convert earlier versions of InDesign documents

To convert previous versions of InDesign documents to the current version, choose File > Open and open
the file.

Keep in mind the following points:

If you used third-party plug-ins to create an earlier version of a document, check with the
manufacturer to make sure that they are installed correctly for and are compatible with
InDesign CS5 before you convert the document.

When you convert a document, you may see an alert message asking if you want to use the
exception word list in the user dictionary or the one in the document. For information about this alert
message, see Choosing word lists when opening documents.

Library files created in earlier versions of InDesign will open and convert in InDesign CS5, even if the
library is locked. You have to specify a name and location for the converted library files; the default
naming convention is filename-X.indl.

Previous versions of InDesign can’t open latest InDesign documents directly. For example, to open an
InDesign CS5 document in InDesign CS4, you must do two things. First, choose File > Export in
InDesign CS5 to save the document in IDML format. Second, update InDesign CS4 with special
plug-ins that let you open the IDML file. (See Save backwards to the previous InDesign version.)

If you’re experiencing problems with a document that was created in a previous version of InDesign, use the
Export dialog box in InDesign CS5 to save the document in InDesign Markup (IDML) format. Then open the IDML
file and save it as an InDesign document.
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Using Adobe Bridge with InDesign

Adobe Bridge is a cross-platform application included with AdobeCreative Suite components that helps you locate,
organize, and browse the assets you need to create print, web, video, and audio content. You can start Adobe
Bridge from any Creative Suitecomponent (except Adobe Acrobat®), and use it to access both Adobe and non-
Adobe asset types.

From Adobe Bridge, you can:

Manage image, footage, and audio files: Preview, search, sort, and process files in Adobe Bridge without
opening individual applications. You can also edit metadata for files, and use Adobe Bridge to place files into
your documents, projects, or compositions.

View the links inside an InDesign document as thumbnails while in Adobe Bridge, without actually having to
open the InDesign document in InDesign.

Drag assets from Adobe Bridge into the InDesign document window, or drag assets from the document
window into Adobe Bridge to create snippets. See Use snippets.

Perform automated tasks, such as batch commands.

Synchronize color settings across color-managed Creative Suite components.

Start a real-time web conference to share your desktop and review documents.

Adobe Version Cue

Adobe Version Cue® and Adobe Drive are not included in Adobe Creative Suite 5, nor any future version of the
Creative Suite. Adobe continues to invest in asset management enablement through open industry standards and
partnerships. For more information, see www.adobe.com/go/learn_vc_end_en.

Use document templates

Templates are useful starting points for standard documents because you can preset them with layout, graphics,
and text. For example, if you prepare a monthly magazine, you can create a template that contains the layout of a
typical issue, including ruler guides, grids, master pages, custom styles and swatches, placeholder frames, layers,
and any standard graphics or text. That way you can simply open the template each month and import new
content.

You create a template the same way you create a regular document; the only difference occurs when you save the
document. When you prepare a template for others to use, you may want to add a layer containing instructions
about the template; hide or delete the layer before printing the document. See Layers.

Note:

For Chinese versions of InDesign, you can open specially designed templates that include custom mojikumi sets.

Save a document as a template

347

http://www.adobe.com/go/learn_vc_end_en


To the top

1. Choose File > Save As, and specify a location and filename.
2. Choose InDesign CS5 Template for Save As Type (Windows) or Format (Mac OS), and then click Save.

Start a new document from a template

1. Choose File > Open.
2. Locate and select a template.
3. Select Normal (Windows) or Open Normal (Mac OS), and then click Open.
4. Save the new document with its own name.

Edit an existing template

1. Choose File > Open.
2. Locate and select a template.
3. Select Original (Windows) or Open Original (Mac OS), and then click Open.

Reviewing InDesign documents

Adobe offers several methods for reviewing InDesign documents.

Tracking editing changes

As you or another person edits text, InDesign highlights added text and strikes through deleted text when Track
Changes is turned on. Use the Story Editor to view changes. The document owner can go through the edits and
accept or reject changes. See Tracking and reviewing changes.

Using Acrobat to review a PDF file

You can export the InDesign document to PDF and use Adobe Acrobat to set up an e-mail review or a shared
review on Acrobat.com or another server. Reviewers can add comments using the Sticky Note tool and other
markup methods. The document owner can then go through the PDF review comments and edit the original
InDesign document. For more information, see Acrobat Help.

Using CS Review

CS Review is an online subscription service that lets you share your designs on the web so that others can provide
immediate feedback. When you create a review using the CS Review panel, you upload one or more snapshots of
the file to the Acrobat.com workspace. Reviewers can then add comments.

When you create a review, you can divide the review into parts that offer separate areas for review commenting. A
review can consist of parts from different files and applications. As the review progresses, you can add and remove
review parts as part of a dynamic review process.
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To the topDesigning calendars and business cards from templates

One way to create a calendars, business cards, resumes or CVs, and other specialized documents is to use
templates.

Adobe provides several templates at the Adobe Marketplace and Exchange site:

www.adobe.com/go/exchange

Use search to locate additional resources for specialty documents.

Adobe also recommends

Save backwards to the previous InDesign
Add documents to a book file
Hyphenation and spelling dictionaries
Save backwards to the previous InDesign
Plug-ins
Reusing graphics and text
Adobe Bridge
Mini Bridge
CS Review

  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.
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Working with frames and objects
Modifying objects using graphics frames
Paste an object into a frame
Remove a frame’s content
Fitting objects to frames
Move a graphics frame or its content
Create a border or background
Crop or mask objects
Object export options

Modifying objects using graphics frames

Adobe InDesign objects include any item you can add or create in the document window, including open paths,
closed paths, compound shapes and paths, type, rasterized artwork, 3D objects, and any placed file, such as an
image.

If a graphic exists inside a frame (as all imported graphics do), you can modify it by changing its relationship to its
frame, as in the following examples:

Crop a graphic by making its frame smaller.

Create various masking and layout effects by pasting an object into a frame.

Add a keyline or outline to a graphic by changing the stroke weight and color of its frame.

Center a graphic against a background rectangle by enlarging its frame and setting the frame’s fill color.

Paste an object into a frame

Use the Paste Into command to nest graphics within container frames. You can even nest graphics into nested
frames.

Background image pasted into a frame

1. Do one of the following:

To paste one object inside a frame, select the object.

To paste two or more objects inside a frame, group them first, because a frame can contain only
one object.

To paste a text frame inside another frame and preserve its current appearance, select the entire
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text frame using the Selection tool  or Direct Selection tool , not the Type tool.

2. Choose Edit > Copy (or Edit > Cut, if you don’t want to keep the original).
3. Select a path or frame, and then choose Edit > Paste Into.

Remove a frame’s content

1. Do one of the following:

If you’re removing a graphic or a text frame, select the object with the Direct Selection tool . Or,
use the Selection tool to click the content grabber of the image.

If you’re removing text characters, select them with the Type tool .

2. Do one of the following:

To permanently remove the content, press Delete or Backspace.

To place the content elsewhere on the layout, choose Edit > Cut, deselect the frame, and then
choose Edit > Paste.

Note:

An imported image cannot exist without a frame. If you cut an imported image from its frame and paste it
elsewhere within a document, a new frame is created for it automatically.

Fitting objects to frames

If the frame and its content are different sizes, you can use the Fitting commands to achieve a perfect fit.

Frame alignment options apply to frames that contain either a graphic or another text frame (text frames nested
within another frame), but they do not affect paragraphs inside a text frame—you control alignment and
positioning of text itself using the Text Frame Options command and the Paragraph, Paragraph Styles, and Story
panels.

Fit an object to its frame

1. Select the frame of the object.

2. Choose Object > Fitting and one of the following options:

Fit Content To Frame

Resizes content to fit a frame and allows the content proportions to be changed. The frame will not change,
but the content may appear to be stretched if the content and the frame have different proportions.

Fit Frame To Content

Resizes a frame to fit its content. The frame’s proportions are altered to match the content proportions, if
necessary. This is useful for resetting a graphics frame that you accidentally altered.
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To fit a frame to its content quickly, double-click any corner handle on the frame. The frame resizes away
from the point you click. If you click a side handle, the frame resizes only in that dimension.

Aligning an object within a graphics frame

A. Original B. Frame resized to fit content C. Content resized to fit frame 

Center Content

Centers content within a frame. The proportions of the frame and its content are preserved. The size of the
content and frame are unaltered.

Fit Content Proportionally

Resizes content to fit a frame while preserving the content proportions. The frame’s dimensions are not
changed. If the content and the frame have different proportions, some empty space will result.

Fill Frame Proportionally

Resizes content to fill the entire frame while preserving the content’s proportions. The frame’s dimensions
are not changed. If the content and the frame have different proportions, some of the content will be
cropped by the bounding box of the frame.

Note:

The Fitting commands fit the outer edges of the content to the center of the frame’s stroke. If the frame
has a thick stroke weight, outer edges of the content will be obscured. You can adjust the frame’s stroke
alignment to the center, inside, or outside of a frame edge. (See Set strokes.)

To remove undesired fitting settings applied using Auto-Fit, choose Object > Fitting > Clear Frame Fitting
Options.

Using Auto Fit

If you resize an image frame when Auto-Fit is not selected, the frame resizes while the image size remains the
same. If you select Auto-Fit, the image resizes with the frame. If you decide to crop or transform the image, use
the Direct Selection tool to transform the image itself. Or, deselect Auto-Fit, transform the image, and select Auto-
Fit again.

You can select the Auto-Fit option in the Control bar and in the Frame Fitting Options dialog box.

Set frame fitting options

You can associate a fitting option to a placeholder frame so that whenever new content is placed in that frame, the
fitting command is applied.

1. Select a frame.

2. Choose Object > Fitting > Frame Fitting Options.
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3. Specify the following options, and then click OK:

Auto-Fit

Select this option if you want the image to resize automically when you resize the frame.

Reference Point

Specify a reference point for the cropping and fitting actions. For example, if you select the upper-right
corner for a reference point and choose Fit Content Proportionally, the image may be cropped on either the
left or bottom side (away from the reference point).

Crop Amount

Specify the location of the image’s bounding box in relation to the frame. Use positive values to crop the
image. For example, you may want to exclude a border that surrounds the placed image. Use negative
values to add space between the image’s bounding box and the frame. For example, you may want white
space to appear between the image and the frame.

If you enter crop values that cause the image not to be visible, those values are ignored, but the fitting
option is still implemented.

Fitting On Empty Frame

Specify whether you want to fit the content to the frame (which may cause the image to be skewed), fit
the content proportionally (some empty space may result), or fill the frame proportionally (one or more
sides may be cropped).

The fitting action is applied only when content is placed into a frame. If you resize the frame, the fitting option is
automatically reapplied only if Auto-Fit is selected.

Move a graphics frame or its content

When you use the Selection tool to select a graphics frame, you can select either the frame or the image within
the frame. If you click outside the content grabber and drag the selection, the frame’s content moves with the
frame. If you drag the content grabber, the image moves within the frame.

The following techniques include ways to move a frame or its content independent of each other. These
techniques are useful for adjusting a graphic when cropped or masked in its frame.

If a selection tool doesn’t work the way you expect it to, try deselecting everything first. Do this by pressing
Ctrl+Shift+A (Windows) or Command+Shift+A (Mac OS).

Do any of the following:

To move a frame together with its content, use the Selection tool  to click the image outside the
content grabber.

To move imported content without moving the frame (that is, to pan content behind its frame), drag
the content grabber. You can also use the Direct Selection tool  to select and drag the image.
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Moving the content, but not its frame

Note:

If you hold down the mouse button on a graphic before you move it, a dynamic graphics preview (a
ghosted-back image) of the outside of the frame appears, but the preview of the image that moves inside
the frame is not ghosted. This makes it easier to see how you are positioning the entire image within a
frame.

To move a frame without moving its content, click the frame using the Selection tool, switch to the
Direct Selection tool, and then drag the center point.

Moving the frame, but not its content

To move multiple frames, use the Selection tool to select the objects, and then drag them. If you
use the Direct Selection tool to select multiple objects, only the item you drag is affected.

Create a border or background

A graphics frame is ideally suited for use as a border or background for its content, because you can change the
frame’s stroke and fill independent of the content.

Adding borders to graphics frames

A. Photo in graphics frame B. Frame with stroke applied C. Frame enlarged with both stroke and fill applied 

1. Using the Selection tool , click an imported graphic outside the content grabber to select its frame.
2. To enlarge the frame without resizing the graphic, drag any bounding box handle outward. To maintain

frame proportions, hold down Shift as you drag.
3. Use the Swatches panel and the toolbox to apply a stroke and fill color.
4. Use the Stroke panel to adjust the frame’s stroke weight, style, or alignment.

You can quickly enlarge a frame equally around all sides by using the Transform or Control panel. Select the frame
with the Direct Selection tool , set the panel reference point locator  to the center point, and enter new values for
the width and height.

Crop or mask objects

Cropping and masking are both terms that describe hiding part of an object. In general, the difference is that
cropping uses a rectangle to trim the edges of an image, and masking uses an arbitrary shape to make an object’s
background transparent. A common example of a mask is a clipping path, which is a mask made for a specific
image.

Use graphics frames to crop or mask objects. Because an imported graphic is automatically contained within a
frame, you can crop or mask it immediately without having to create a frame for it. If you haven’t created a frame
for an imported graphic manually, the frame is automatically created at the same size as the graphic, so it is not
obvious that the frame is there.

Note:
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For efficient printing, only the data for the visible parts of cropped or masked images is sent when you output the
document. However, you still save disk space and RAM if you crop or mask images to their desired shapes and
sizes before importing them into your document.

To crop an imported image or any other graphic already inside a rectangular frame, click the object using
the Selection tool  and drag any handle on the bounding box that appears. Press Shift as you drag to
preserve the frame’s original proportions.

Cropping an image using a graphics frame

To crop or mask any object, use the Selection or Direct Selection tool  to select one object you want to
mask. Choose Edit > Copy, select an empty path or frame smaller than the object, and choose Edit > Paste
Into.
To crop frame content precisely, select the frame with the Direct Selection tool, and use the Transform or
Control panel to change the size of the frame.
To specify crop settings for an empty placeholder frame, choose Object > Fitting > Frame Fitting Options,
and then specify the crop amount.

With an imported graphic, you can also create a mask by using the drawing tools to change the shape of the
graphic’s existing frame.

Creating see-through text

Learn how to make see-through text in this quick tutorial.... Read More

http://goo.gl/pY2e0

by David Blatner

Turn any object into a transparency mask

Learn how to make any object, text, or path into a transparency mask.... Read More

http://goo.gl/yQeIz
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by David Blatner

Object export options

Introduction to object export options

Object export options can be used to specify export parameters required when you export to different formats such
as EPUB, HTML, or accessible PDFs.

Object export options can be applied to both text frames and graphic frames, as well as groups. Use Object export
options to:

Define Alt text for placed images and graphics.

Apply tags and actual text settings for tagged PDFs.

Create different conversion settings on each object, so that they render well on different screen sizes and
pixel densities. Use these options to control the quality of rasterization applied to text effects such as drop
shadow and bevel when you export the layout to HTML or EPUB.

Note:

If an object is hyperlinked, it would be supported on export.

Apply Object export options

1. Select the frame or group in the layout.

2. Choose Object > Object Export Options.

or

Right-click on the object and select Object Export Options.

3. Apply the settings.

You can leave the Object Export Options dialog box while you select other objects on the layout to apply the
settings.

Alt-text options

Alternative text (Alt text) is a brief text-based description of an image or graphic. This text is used in situations
where the image is not rendered or to help screen-readers.
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Alt-text Source

Select the source to assign the Alt text for the selected frames or groups.

Note:

When you import content from Microsoft Word, InDesign also imports alt-text applied to images.

Custom

Enter text manually.

From Structure

Use text as specified in the structure. See Label graphics for use with screen-reader software.

From XMP (Title |Description |Headline)

Use data stored in common XMP fields. If XMP data is updated using another application such as Adobe Bridge,
when you update the link, text is updated automatically.

From Other XMP

If text string is stored in some other XMP field, enter the complete namespace and property name in
<ns>:<property> format. For example, the Adobe Bridge user interface supports IPTC Core, which contains a field
titled “IPTC Subject Code”. If this field was used to store the text string, then the Property value would be
“Iptc4xmpCore:SubjectCode[1].”

Tagged PDF options

Apply Tag

Select the source to assign the PDF Tag for the selected frames or groups.

From Structure

Use text as specified in the structure.

Artifact

Use for graphic elements that have no important meaning when they are read aloud by a screen reader.

Based on Object

Automatically determines the content of the frame and applies “Story” or “Figure” tag.
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Actual Text Source

PDF also supports actual text, in addition to Alt text. Actual text can be applied to graphic elements that visually
look like text. For example, a scanned TIFF image. Actual text is used to represent words that were converted to
artwork. Actual text is only applicable for tagged PDFs.

Custom

Enter text manually.

From Structure

Use text as specified in the structure. See Label graphics for use with screen-reader software.

From XMP (Title |Description |Headline)

Use data stored in common XMP fields. If XMP data is updated using another application such as Adobe Bridge,
when you update the link, text is updated automatically.

From Other XMP

If text string is stored in some other XMP field, enter the complete namespace and property name in
<ns>:<property> format. For example, the Bridge user interface supports IPTC Core, which contains a field titled
“IPTC Subject Code”. If this field was where the text string is stored, then the Property value would be
“Iptc4xmpCore:SubjectCode[1].”

EPUB and HTML options

Use the EPUB and HTML options to specify image conversion settings for individual objects. If these settings are
not specified, the EPUB export image conversion settings are used. See EPUB Images options.

Objext Export Options

epub: type

Click the arrow icon to choose the order in which the reader can read the document.

Preserve Appearance From Layout

Check to specify custom image conversion settings for selected frames.

Default

Deafult settings mapped to the Export dialog settings dialog.
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Use Existing Image for Graphic Objects

Uses an existing image for graphic objects

Rasterize Container

Convert the object into an image. For example, a text frame gets converted to an image.

Rasterize Content

The appearance is preserved via CSS. 

Custom Rasterization

Check to specify custom image conversion settings for selected frames.

Format

Lets you choose whether the optimized images in your document are converted to GIF, JPEG, or PNG.

Resolution (ppi)

Specify the resolution of the images in pixels per inch (ppi). While operating systems have standardized on either
72 ppi or 96 ppi, mobile devices range from 132 ppi (iPad), to 172 ppi (Sony Reader), to over 300 ppi (iPhone 4).
You can specify a ppi value for each object selected. Values include 72, 96, 150 (average for all eBook devices
today), and 300.

Palette

Lets you control how InDesign handles colors when optimizing GIF files. The GIF format uses a limited color
palette, which cannot exceed 256 colors.

Choose Adaptive to create a palette using a representative sample of colors in the graphic without any dithering
(mixing of small spots of colors to simulate additional colors). Choose Web to create a palette of web-safe colors
that are a subset of Windows and Mac OS system colors. Choose System (Win) or System (Mac) to create a
palette using the built-in system color palette. This choice may cause unexpected results.

Select Interlace to display a slowly loaded image gradually by filling in missing lines. If this option is not select, an
image looks fuzzy and gradually becomes clear as the image reaches full resolution.

Quality

Determines the trade-off between compression (for smaller file sizes) and image quality for each JPEG image
created. Low produces the smallest file and lowest image quality.

Method

Determines how quickly JPEG graphics display when the file containing the image is opened on the web. Choose
Progressive to make the JPEG images display gradually and in increasing detail as they are downloaded. (Files
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created with this option are slightly larger and require more RAM for viewing.) Choose Baseline to make each JPEG
file display only after it has been downloaded; a placeholder appears in its place until the file displays.

Custom Layout

Select the layout preference from the drop-down list.

Alignment and Spacing: Specify the image alignment, left, center, right, and the top and bottom
padding.
Float Left: Select this option for floating left alignment.
Float Right: Select this option for floating right alignment.

Insert Page Break

Select this option to insert page breaks with images. Page breaks can be inserted Before Image, After Image, or
Before and After Image.

Size

Choose the custom CSS width and height from the following options:

None: No CSS width or height is applied on the object.
Default: The default CSS width and height are used.
Fixed: A fixed CSS width and height are applied.
Relative to Text Flow: Applies to CSS width only. The CSS width adapts to the text flow.
Relative to Text Size: Applies to CSS width only. The CSS width adapts to the text flow.
Custom Width: Select this option to enter the custom value for width.
Custom Height: Select this option to enter the custom value for height.

Note:

The Size drop-down list is applicable for the EPUB Reflowable and HTML Layout only. This is not applicable for
EPUB Fixed Layout.

Adobe also recommends

Using placeholders to design pages
Object styles
Applying line (stroke) settings
Apply color
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Teksti

Ehdollisen tekstin luominen (video 6:48), CS4–CS6
David Blatner  (1.1.2011)
Video-opastusohjelma
Opi käyttämään ehdollista tekstiä InDesignissa.

Tekstijuttujen linkittäminen (PDF, 217 kt)
Artikkeli  (1.1.2011)
InDesign CS5.5:n Sijoita ja linkitä juttu -toimintoa käsittelevä lyhyt opastusohjelma.

Sarakkeiden rajat ylittävät ja sarakkeet jakavat kappaleet (video 2:01)
Michael Ninness  (1.1.2011)
Video-opastusohjelma
Katso, miten voit luoda monimutkaisia sivuasetteluita entistä vähemmillä napsautuksilla käyttämällä kappaleita, jotka ylittävät sarakkeiden
rajat tai jakavat sarakkeita InDesign CS5:ssä ja sitä uudemmissa versioissa.

Tekstimuutosten seuraaminen (video 2:01)
Michael Ninness  (1.1.2011)
Video-opastusohjelma
Opi tekemään yhteistyötä entistä tehokkaammin uudella Seuraa tekstimuutoksia -toiminnolla InDesign CS5:ssä ja sitä uudemmissa
versioissa.

Luettelomerkkien ja numeroinnin luominen (video 12:16), CS3–CS6
Anne-Marie Concepcion  (1.1.2011)
Video-opastusohjelma
Katso, miten voit luoda luettelomerkkejä ja lisätä ne sivuasetteluusi.

Alaviitteiden luominen (video 2:44), CS3–CS6
David Blatner  (1.1.2011)
Video-opastusohjelma
Tämän lyhyen videon avulla voit opetella alaviitteiden lisäämisen perusteet.
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Tekstin ketjuttaminen

Alkuun

Tekstikehysten ketjuttaminen
Ketjutettujen tekstikehyksien leikkaaminen ja poistaminen
Tekstin juoksuttaminen manuaalisesti tai automaattisesti
Älykkään tekstin uudelleenjuoksutuksen käyttäminen

Tekstikehysten ketjuttaminen
Kehyksessä oleva teksti voi olla riippumaton muista kehyksistä, tai se voi juosta muihin yhdistettyihin kehyksiin. Jos haluat tekstin sijoittuvan
yhdistettyjen kehysten (joita kutsutaan myös tekstilaatikoiksi) väliin, sinun täytyy ensin yhdistää kehykset. Yhdistetyt kehykset voivat olla samalla
sivulla tai aukeamalla tai jollain muulla julkaisun sivulla. Tekstin yhdistämistä tekstikehysten välillä kutsutaan ketjuttamiseksi. Se tunnetaan myös
nimellä tekstikehysten linkittäminen ja tekstilaatikoiden linkittäminen.

Jokaisessa tekstikehyksessä on sisäportti ja ulkoportti. Tekstikehykset yhdistetään porttien kautta. Tyhjä sisä- tai ulkoportti osoittaa jutun alku- ja
loppukohdan. Portissa oleva nuoli osoittaa, että kehys on linkitetty toiseen kehykseen. Punainen plusmerkki (+) ulkoportissa osoittaa, että jutussa
on vielä tekstiä, mutta jäljellä ei ole tekstikehyksiä, joihin sen voisi sijoittaa. Jäljellä oleva teksti, joka ei näy, on ylijuoksevaa tekstiä.

 
Ketjutetut kehykset 
A. Sisäportti jutun alussa B. Ulkoportti, joka osoittaa ketjutuksen seuraavaan kehykseen C. Tekstiketju D. Sisäportti, joka osoittaa ketjutuksen
edellisestä kehyksestä E. Ulkoportti, joka ilmaisee ylijuoksevan tekstin 

Voit näyttää ketjutetut kehykset visuaalisesti valitsemalla Näytä > Ekstrat > Näytä tekstiketjut. Tekstikehyksiä voi ketjuttaa, vaikka kehyksessä ei
olisi tekstiä.

Uuden kehyksen lisääminen ketjuun
1. Valitse tekstikehys valintatyökalulla  ja lataa tekstikuvake napsauttamalla kehyksen sisä- tai ulkoporttia.

Voit lisätä kehyksen ennen valittua kehystä napsauttamalla sisäporttia ja kehyksen jälkeen napsauttamalla ulkoporttia.

2. Sijoita ladatun tekstin kuvake  paikkaan, johon haluat lisätä uuden tekstikehyksen. Luo uusi tekstikehys napsauttamalla tai vetämällä
kohtaa.

Kun ladatun tekstin kuvake on aktiivinen, käytettävissä on useita toimintoja, kuten sivujen kääntäminen, uusien sivujen luominen ja zoomaus.
Kahden kehyksen välisen ketjutuksen voi peruuttaa kesken toiminnon napsauttamalla jotakin työkalupaneelin työkalua. Kaikki teksti säilyy.

Valmiin kehyksen lisääminen ketjuun
1. Valitse tekstikehys valintatyökalulla ja lataa tekstikuvake napsauttamalla sisä- tai ulkoporttia.
2. Sijoita ladatun tekstin kuvake sen kehyksen päälle, johon haluat liittää kehyksen. Ladatun tekstin kuvake muuttuu ketjukuvakkeeksi.

 
Valmiin kehyksen lisääminen ketjuun

3. Ketjuta toinen kehys ensimmäiseen kehykseen napsauttamalla toista kehystä.
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Kun ketjutat kehysruudukon tyhjään tekstikehykseen tai toiseen kehysruudukkoon, jolla on eri ruudukkoasetukset, ketjutetun kehyksen tekstikehys
määritetään uudelleen sen tekstikehyksen asetusten mukaiseksi, josta ketjutus tehtiin.

Kehyksiin voi lisätä automaattisesti jatkuu sivulla- tai jatkoa sivulta -hyppyrivit, jotka ilmaisevat, miten juttu etenee kehysten välillä. (Katso
Automaattisten sivunumeroiden lisääminen juttusiirtymiin.)

Kehyksen lisääminen ketjutettujen kehysten väliin
1. Valitse valintatyökalu ja napsauta ulkoporttia jutun siinä kohdassa, johon haluat lisätä kehyksen. Kun vapautat hiiren painikkeen, näyttöön

tulee ladatun tekstin kuvake.
2. Luo uusi kehys vetämällä tai valitse eri tekstikehys. InDesign ketjuttaa kehyksen osaksi jutun muodostavaa linkitettyjen kehysten joukkoa.

 
Kehyksen lisääminen ketjun väliin (yllä) ja lopputulos (alla)

Tekstikehysten ketjutuksen poistaminen
Kun poistat tekstikehyksen ketjutuksen, katkaiset yhteyden kehyksen ja kaikkien ketjussa seuraavana olevien kehysten väliltä. Kehyksissä aiemmin
näkynyt teksti muuttuu ylijuoksevaksi tekstiksi (tekstiä ei poisteta). Kaikki myöhemmät kehykset ovat tyhjiä.

Käytä valintatyökalua ja tee jokin seuraavista:
Katkaise kehysten välinen yhteys kaksoisnapsauttamalla sisä- tai ulkoporttia.

Napsauta toiseen kehykseen johtavaa ketjutusta kuvaavaa sisä- tai ulkoporttia. Napsauta esimerkiksi kahden kehyksen ketjussa joko
ensimmäisen kehyksen ulkoporttia tai jälkimmäisen kehyksen sisäporttia. Näytä ketjutuksen poistokuvake  viemällä ladatun tekstin
kuvake edellisen tai seuraavan kehyksen päälle. Napsauta kehystä, jonka haluat poistaa ketjusta.

 
Kehyksen poistaminen ketjusta

Voit jakaa jutun kahdeksi jutuksi leikkaamalla toiseen juttuun tulevan tekstin, katkaisemalla kehysten välisen yhteyden ja liittämällä tekstin
toisen jutun ensimmäiseen kehykseen.

Ketjutettujen tekstikehyksien leikkaaminen ja poistaminen
Kun tekstikehyksiä leikataan tai poistetaan, tekstiä ei poisteta vaan säilytetään ketjussa.

Kehyksen leikkaaminen ketjusta
Voit leikata kehyksen ketjusta ja liittää sen toiseen kohtaan. Kehys poistetaan ja teksti kopioituu sen mukana, mutta tekstiä ei poisteta
alkuperäisestä jutusta. Leikatun ja liitetyn kehyssarjan sisäiset ketjutukset säilyvät, mutta kaikki yhteydet jutun muihin kehyksiin poistuvat.

1. Valitse vähintään yksi kehys valintatyökalulla (voit valita useita kohteita pitämällä vaihtonäppäimen alhaalla).
2. Valitse Muokkaa > Leikkaa. Näyttöön tulee seuraava kehys, ja sen mahdollinen teksti juoksee jutun seuraavaan kehykseen. Jos jutun

viimeinen kehys poistetaan, sen teksti tallentuu edelliseen kehykseen ylijuoksevana tekstinä.
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Huomautus:

3. Jos haluat käyttää irrotettua kehystä julkaisun eri kohdassa, siirry uuteen kohtaan ja valitse Muokkaa > Liitä.

Kehyksen poistaminen ketjusta
Kun poistat ketjuun kuuluvan tekstikehyksen, tekstiä ei poisteta. Teksti muuttuu ylijuoksevaksi, tai se juoksutetaan järjestyksessä seuraavaan
kehykseen. Jos tekstikehystä ei ole kytketty mihinkään muuhun kehykseen, kehys ja teksti poistetaan.

1. Valitse tekstikehys jollakin seuraavista tavoista:
Valitse valintatyökalu ja napsauta kehystä.

Valitse tekstityökalu, pidä Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) alhaalla ja napsauta kehystä.

2. Paina askelpalautinta tai Delete-näppäintä.

Tekstin juoksuttaminen manuaalisesti tai automaattisesti

Kohdistin muuttuu ladatun tekstin kuvakkeeksi , kun teksti on sijoitettu tai sisä- tai ulkoporttia napsautettu. Ladatun tekstin kuvakkeen avulla voit
juoksuttaa tekstiä sivuille. Jos pidät muokkauspainiketta alhaalla, voit määrittää, miten teksti juoksutetaan. Ladatun tekstin kuvake muuttaa
ulkoasuaan sijaintinsa mukaan.

Kun viet ladatun tekstin kuvakkeen tekstikehyksen päälle, kuvakkeen  ympärillä on sulkumerkit. Kun viet ladatun tekstin kuvakkeen apuviivan tai
ruudukon tarttumispisteen viereen, musta osoitin muuttuu valkoiseksi .

Voit juoksuttaa tekstiä neljällä tavalla:

InDesign havaitsee vaaka- tai pystysuuntaisuuden tekstin juoksuttamista varten. Jos tekstiä juoksutetaan puoliautomaattisesti tai automaattisesti,
se juoksutetaan Juttu-paneelissa määritettyjen kehyksen tyypin ja suunnan mukaan. Kuvake kertoo käyttäjälle siitä, mihin suuntaan tekstiä
juoksutetaan.

Tekstin sijoittamista ja juoksuttamista koskeva video on nähtävissä osoitteessa www.adobe.com/go/lrvid4278_id_fi.

Tekstin juoksuttaminen manuaalisesti
1. Valitse tiedosto Sijoita-toiminnolla tai napsauta valitun tekstikehyksen ulkoporttia. 
2. Tee jokin seuraavista:

Sijoita ladatun tekstin kuvake kehykseen tai reitille ja napsauta. Teksti juoksee kehykseen ja siihen linkitettyihin kehyksiin. Juokseva
teksti alkaa aina vasemman palstan yläreunasta, vaikka napsauttaisit eri palstaa.

Luo palstan levyinen kehys sijoittamalla ladatun tekstin kuvake palstan alueelle. Kehyksen yläreuna tulee napsautuskohtaan.

Luo haluamasi kokoinen tekstikehys vetämällä ladatun tekstin kuvaketta.

3. Voit sijoittaa lisää tekstiä napsauttamalla ulkoporttia ja toistamalla vaiheet 1 ja 2.

ketjutettuun kehykseen lisätty teksti juoksee kehyksestä toiseen automaattisesti valitusta juoksutusmenetelmästä riippumatta.

Tekstin juoksuttaminen puoliautomaattisesti
Napsauta sivua tai kehystä ladatun tekstin kuvakkeella pitäen Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) alhaalla.

Teksti juoksee palsta kerrallaan, kuten manuaalisessa juoksutuksessa, mutta kuvake latautuu automaattisesti kunkin palstan jälkeen.

Tekstin juoksuttaminen automaattisesti
Kun ladatun tekstin kuvake on näytössä, paina vaihtonäppäintä ja tee jokin seuraavista:

Menetelmä Kuvaus

Tekstin juoksuttaminen manuaalisesti Lisää tekstiä kehys kerrallaan. Juoksuttamista voi jatkaa
lataamalla tekstikuvakkeen.

Puoliautomaattinen juoksutus:  paina Alt-näppäintä (Windows)
tai optionäppäintä (Mac OS) napsauttaessasi.

Puoliautomaattinen juoksutus toimii kuten manuaalinen juoksutus,
mutta osoitin muuttuu aina kehyksen lopussa ladatun tekstin
kuvakkeeksi, kunnes kaikki teksti on juoksutettu julkaisuun.

Automaattijuoksutus : paina vaihtonäppäintä napsauttaessasi. Automaattinen juoksutus lisää sivuja ja kehyksiä, kunnes kaikki
teksti on juoksutettu julkaisuun.

Kiinteä automaattinen juoksutus : paina Alt-näppäintä
(Windows) tai vaihto+optionäppäimiä (Mac OS) napsauttaessasi.

Kaikki teksti juoksutetaan julkaisuun, kehyksiä lisätään tarpeen
mukaan, mutta sivuja ei lisätä. Kaikki jäljelle jäävä teksti on
ylijuoksevaa.
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Alkuun

Lisää sivut

Rajoita koskemaan tekstikehyspohjia

Säilytä vastakkaisten sivujen aukeamat

Poista tyhjät sivut

Luo palstan levyinen kehys napsauttamalla ladatun tekstin kuvaketta. InDesign luo uusia tekstikehyksiä ja julkaisusivuja, kunnes teksti on
lisätty kokonaan.

Napsauta tekstikehyspohjaan perustuvaa tekstikehystä. Teksti juoksee automaattisesti ja ohjelma luo tarvittaessa uusia sivuja
kehyspohjan määritteiden mukaisesti. (Katso Tietoja sivupohjista, pinoamisjärjestyksestä ja tasoista.)

Tekstin juoksuttaminen automaattisesti lisäämättä sivuja
Valitse ladatun tekstin kuvake ja pidä alhaalla Alt+vaihtonäppäimiä (Windows) tai vaihto+optionäppäimiä (Mac OS).

Älykkään tekstin uudelleenjuoksutuksen käyttäminen
Älykäs tekstin uudelleenjuoksutus -toiminnolla voit lisätä tai poistaa sivuja tekstiä kirjoittaessasi tai muokatessasi. Tämä toiminto on käytännöllinen,
kun käytät InDesignia tekstieditorina ja haluat, että uusi sivu lisätään aina, kun kirjoittamasi teksti ei mahdu nykyiselle sivulle. Toiminto auttaa myös
ylijuoksevan·tekstin tai tyhjien sivujen välttämisessä, kun tekstin juoksutus muuttuu tekstin muokkaamisen, ehdollisen tekstin näyttämisen tai
piilottamisen tai muiden tekstin juoksutukseen tehtävien muutosten vuoksi.

Oletusarvon mukaan älykäs tekstin uudelleenjuoksutus on rajattu tekstikehyspohjiin eli sivupohjan tekstikehyksiin. Jos asiakirjassa on vastakkaisia
sivuja, tekstikehyspohjien pitää näkyä sekä vasemmalla että oikealla sivupohjalla ja ne on ketjutettava, jotta älykäs tekstin uudelleenjuoksutus
toimii.

Voit muuttaa asetuksia siten, että sivuja voidaan lisätä tai poistaa muita kuin sivupohjiin perustuvia tekstikehyksiä käsiteltäessä. Tekstikehys on
kuitenkin ketjutettava vähintään yhteen muuhun, jollakin toisella sivulla olevaan tekstikehykseen, jotta älykäs tekstin uudelleenjuoksutus toimii.

Älykkään tekstin uudelleenjuoksutuksen asetukset tulevat näkyviin Teksti-asetuksiin. Nämä asetukset ovat voimassa valitussa julkaisussa. Jos
haluat muuttaa kaikkien uusien julkaisujen oletusasetuksia, sulje kaikki julkaisut ja määritä asetukset.

1. Valitse Muokkaa > Asetukset > Teksti (Windows) tai InDesign > Asetukset > Teksti (Mac OS).

2. Valitse Älykäs tekstin uudelleenjuoksutus.

3. Valitse jokin seuraavista vaihtoehdoista ja valitse sitten OK.

Tällä asetuksella voit määrittää, mihin uusi sivu luodaan. Esimerkki: Sinulla on kolmesivuinen julkaisu, jossa ensimmäisellä kahdella
sivulla on tekstikehyksiä ja kolmannella koko sivun kokoinen kuvitus. Jos kirjoitat tekstiä toisen sivun lopussa, voit määrittää, lisätäänkö uusi sivu
kolmannen sivun (grafiikkasivu) eteen vai sen jälkeen. Voit lisätä uuden sivun sivun 2 jälkeen valitsemalla Jutun loppuun. Valitse Julkaisun
loppuun, jos haluat lisätä sivun grafiikkasivun jälkeen.
Jos julkaisussa on useita osioita, voit lisätä sivun osion loppuun valitsemalla Osion loppuun.

Jos tämä asetus on poistettu käytöstä, voit myös tekstikehyksiä muokkaamalla lisätä tai poistaa sivuja,
jotka eivät perustu sivupohjiin. Älykäs tekstin uudelleenjuoksutus estää tarpeetonta tekstin uudelleenjuoksutusta siten, että se tulee voimaan vain,
kun muokattava tekstikehys ketjutetaan vähintään yhteen muuhun jollakin toisella sivulla olevaan tekstikehykseen.
Huomautus: Kun älykästä tekstin uudelleenjuoksutusta käytetään tekstikehyksissä, jotka eivät perustu sivupohjiin, sivuille lisätään koko sivun
kattavat, yksisarakkeiset tekstikehykset. Tämä tehdään huolimatta siitä, millaiset sen tekstikehyksen määritteet ovat, johon uusi kehys ketjutetaan.

Tämä asetus määrittää, säilytetäänkö vastakkaisten sivujen aukeamat, kun tekstiä juoksutetaan
uudelleen julkaisun keskellä. Jos tämä asetus on valittuna, kun tekstiä juoksutetaan uudelleen julkaisun keskellä, julkaisuun lisätään uusi
kaksisivuinen aukeama. Jos tätä asetusta ei ole valittu, julkaisuun lisätään uusi yksittäinen sivu ja sitä seuraavat sivut "sekoitetaan".
Jos asetteluun kuuluu erityisesti aukeaman oikealle tai vasemmalle puolelle kuuluvia elementtejä, ota tämä asetus käyttöön. Jos vasemman ja
oikean sivun voi vaihtaa keskenään, voit poistaa tämän asetuksen käytöstä. Tämä asetus näkyy himmennettynä, jos julkaisussa ei ole vastakkaisia
sivuja.

Tämä asetuksen valitsemalla voit poistaa sivuja tekstiä muokatessasi tai ehtoja piilottaessasi. Sivut poistetaan vain, jos
tyhjennetty tekstikehys on ainoa sivulla oleva objekti.

Jos haluat nähdä, miten InDesignia voi käyttää tekstieditorina älykkään tekstin uudelleenjuoksutuksen avulla, luo julkaisu siten, että
vastakkaiset sivut on poistettu käytöstä ja tekstikehyspohja on valittuna. Varmista Teksti-asetuksista, että Älykäs tekstin uudelleenjuoksutus ja
Poista tyhjät sivut on valittu. Pidä ensimmäisellä sivulla näppäinyhdistelmää Ctrl+vaihto (Windows) tai komento+vaihto (Mac OS) painettuna ja
korvaa tekstikehyspohja valitsemalla se. Kun kirjoitat tekstikehyksen täyteen, uusi sivu ja tekstikehys lisätään automaattisesti. Jos poistat
riittävästi tekstiä, sivu poistetaan.
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Tekstin kierrättäminen objektien ympäri

Alkuun

Kierto muokkausalueen ympäri 

Kierto objektin muodon ympäri 

Hyppää objektin ohi 

Hyppää seuraavaan palstaan  

Tekstin kierrättäminen objektien ympäri
Tekstinkierrätyksen muodon muuttaminen
Tekstinkierrätyksen käyttäminen sivupohjakohteissa
Tekstin kierrättäminen ankkuroitujen objektien ympäri
Tekstinkierrätyksen poistaminen kätketyiltä tasoilta
Kierrätysobjektien vieressä olevan tekstin kohdistaminen
Tekstinkierrätyksen ohittaminen tekstikehyksessä

Tekstin kierrättäminen objektien ympäri

Tekstin voi kierrättää kaikkien objektien, kuten tekstikehysten, tuotujen kuvien ja InDesignissa luotujen objektien ympärille. InDesign luo näiden
objektien ympärille rajan, joka estää tekstin sijoittamisen objektin päälle. Objektia, jonka ympäri teksti kiertää, kutsutaan kierrätysobjektiksi.
Tekstinkierrätyksestä käytetään myös nimeä kierrätysteksti.

Muista, että tekstinkierrätysasetukset koskevat kierrätysobjektia eivätkä itse tekstiä. Kierrätysrajan muutokset säilyvät, jos siirrät kierrätysobjektin
lähelle toista tekstikehystä.

Tekstin kierrättäminen yksinkertaisten objektien ympäri

1. Avaa Tekstinkierrätys-paneeli valitsemalla Ikkuna > Tekstinkierrätys.

2. Valitse valintatyökalulla tai suoravalintatyökalulla objekti, jonka ympärille haluat kierrättää tekstin.

3. Valitse haluamasi kierrätysmuoto Tekstinkierrätys-paneelista:

Luo suorakulmaisen kierrätysalueen, jonka leveys ja korkeus määräytyvät valitun objektin
muokkausalueen perusteella, mukaan lukien määrittämäsi siirtymät.

Tunnetaan myös nimellä muotokierto. Luo tekstinkierrätysrajan, jonka muoto vastaa valitun kehyksen
muotoa (siirtymät huomioiden).

Kierto muokkausalueen ympäri- (vasen) ja Kierto objektin muodon ympäri (oikea) -asetuksien vertailu

Estää tekstin näkymisen kehyksen vasemmalla tai oikealla puolella.

Pakottaa ympäröivän kappaleen seuraavan palstan tai tekstikehyksen yläreunaan.

4. Määritä Tekstinkierrätys-valikossa, käytetäänkö kierrätystä tietyllä reunalla (esimerkiksi oikea reuna tai suurin alue), kohti selkää vai poispäin

366



selästä. (Jos Tekstinkierrätys-valikko ei ole näkyvissä, valitse Tekstinkierrätys-paneelivalikosta Näytä asetukset.)

Tämä asetus on käytettävissä vain, jos olet valinnut Kierto muokkausalueen ympäri- tai Kierto objektin muodon ympäri -vaihtoehdon.

Kierrätysasetukset

A. Oikea ja vasen reuna B. Reuna selkää kohden C. Reuna poispäin selästä 

5. Määritä siirtymien arvot. Positiiviset arvot siirtävät kiertoa kehyksestä poispäin ja negatiiviset arvot siirtävät kierron kehyksen sisäpuolelle.

Jos et saa tekstiä kiertymään kuvan ympärille, varmista, että Ohita tekstinkierrätys -asetusta ei ole määritetty kyseiselle kehykselle. Jos olet
valinnut Koostamisasetuksista asetuksen Tekstinkierrätys vaikuttaa vain alla olevaan tekstiin, varmista, että tekstikehys on kierrätysobjektin alla.

Ryhmään käyttämäsi tekstinkierrätys ei vaikuta ryhmän sisällä oleviin tekstikehyksiin.

Voit määrittää kaikkien uusien objektien tekstinkierrätysasetukset poistamalla objektien valinnan ja määrittämällä haluamasi asetukset.

Tekstin kierrättäminen tuotujen kuvien ympäri

Jos haluat kierrättää tekstin tuodun kuvan ympärille, tallenna (jos mahdollista) rajaava reitti sovellukseen, jossa kuva on luotu. Kun sijoitat kuvan
InDesigniin, valitse Kuvan tuontiasetukset -valintaikkunasta asetus Käytä Photoshopin rajaavaa reittiä.

1. Avaa Tekstinkierrätys-paneeli valitsemalla Ikkuna > Tekstinkierrätys.

2. Valitse tuotu kuva ja valitse Tekstinkierrätys-paneelista Kierto objektin muodon ympäri .

3. Määritä siirtymien arvot. Positiiviset arvot siirtävät kiertoa kehyksestä poispäin ja negatiiviset arvot siirtävät kierron kehyksen sisäpuolelle.

4. Saat näkyviin lisäasetuksia, kun valitset Tekstinkierrätys-paneelivalikosta Näytä asetukset.

5. Valitse rajaviivan asetus Teksti-valikosta:

Muokkausalue

Kierrättää tekstin kuvan korkeuden ja leveyden mukaisen suorakulmion ympärille.

Tunnista reunat

Luo rajan käyttämällä automaattista reunojen tunnistusta. (Jos haluat säätää reunojen tunnistusta, valitse ensin objekti ja sitten Objekti >
Rajaava reitti > Asetukset.)

Alfakanava

Luo rajan kuvaan tallennetusta alfakanavasta. Jos asetus ei ole käytettävissä, kuvaan ei ole tallennettu alfakanavia. InDesign tunnistaa
Adobe Photoshopin oletusläpinäkyvyyden (shakkilautakuvio) alfakanavaksi. Muussa tapauksessa tausta täytyy poistaa Photoshopilla tai
luoda ja tallentaa kuvaan vähintään yksi alfakanava.

Photoshop-reitti

Luo rajan kuvaan tallennetusta reitistä. Valitse Photoshop-reitti ja sitten haluamasi reitti Reitti-valikosta. Jos Photoshop-reitti-asetus ei ole
käytettävissä, kuvaan ei ole tallennettu nimettyjä reittejä.

Grafiikkakehys

Luo rajan pääkehyksestä.

Sama kuin leikkaus
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Luo rajan tuodun kuvan rajaavasta reitistä.

6. Jos haluat tekstin näkyvän kuvan "aukkojen" (kuten autonrenkaan) sisäpuolella, valitse Sisällytä sisäreunat.

Sisällytä sisäreunat -asetus ei käytössä (vasen) ja käytössä (oikea)

Käännetyn tekstinkierrätyksen käyttäminen

1. Valitse valintatyökalulla  tai suoravalintatyökalulla  objekti, jonka sisäpuolella voi kierrättää tekstiä. Tällainen on esimerkiksi yhdistelmäreitti.

2. Avaa Tekstinkierrätys-paneeli valitsemalla Ikkuna > Tekstinkierrätys.

3. Kierrätä teksti objektin ympäri ja valitse Käännä. Käännä-toimintoa käytetään usein muodon mukaisessa kierrätyksessä.

Muodon mukainen tekstinkierrätys (vasemmalla) ja Käännä-toiminto (oikealla)

Tekstinkierrätyksen muodon muuttaminen

1. Valitse suoravalintatyökalulla objekti, jossa käytetään tekstinkierrätystä. Jos tekstinkierrätysraja on samanmuotoinen kuin objekti, raja
asetetaan objektin päälle.

2. Tee jokin seuraavista toimista:

Voit muuttaa tekstin ja kierrätysobjektin välistä etäisyyttä määrittämällä siirtymien arvot Tekstinkierrätys-paneelissa.

Voit muokata tekstinkierrätyksen rajaa kynätyökalulla  ja suoravalintatyökalulla.

Tekstinkierrätysrajan muokkaaminen

Jos muutat tekstinkierrätysreitin muotoa manuaalisesti, Teksti-valikosta valitaan Käyttäjän muokkaama reitti. Valinta näkyy valikossa himmeänä.
Tämä osoittaa, että muodon reitti on muuttunut.

Jos haluat käyttää alkuperäistä rajaavaa reittiä muokatun tekstinkierrätysrajan sijaan, valitse Tekstinkierrätys-paneelin Teksti-valikosta Sama
kuin leikkaus.

Tekstinkierrätyksen käyttäminen sivupohjakohteissa

368



Alkuun

Alkuun

Alkuun

Huomautus:

Jos Käytä vain sivupohjassa -asetus on valittuna, sinun täytyy ohittaa julkaisusivun sivupohjakohde, jos haluat kierrättää sen ympärille tekstiä. Jos
valinta on poistettu, sekä sivupohjien että julkaisusivujen tekstiä voidaan kierrättää sivupohjakohteiden ympärille ilman, että sivupohjakohteita
ohitetaan.

1. Valitse sivupohjaobjekti.

2. Valitse Tekstinkierrätys-paneelin valikosta Käytä vain sivupohjassa -asetus tai poista valinta.

Tämä asetus on käytettävissä vain, kun sivupohjaobjekti on valittuna ja siihen on käytetty tekstinkierrätystä.

Tekstin kierrättäminen ankkuroitujen objektien ympäri

Jos käytät tekstinkierrätystä ankkuroidun objektin kanssa, kierrätys vaikuttaa jutun ankkurimerkkiä seuraavien rivien tekstiin. Kierrätys ei
kuitenkaan vaikuta tekstiriviin, jolla ankkurimerkki on, eikä sitä edeltäviin riveihin.

Kun liität objektin tekstiin sidottuna objektina, sen tekstinkierrätysrajat säilytetään.

Tekstinkierrätyksen poistaminen kätketyiltä tasoilta

Kun kätket kierrätysobjektin sisältävän tason, muiden tasojen tekstikehykset kiertävät objektin. Voit estää tämän valitsemalla Tason asetukset -
valintaikkunasta asetuksen Ei tekstinkierrätystä, kun taso on kätketty. Jos tämä asetus on valittu, tason kätkeminen voi aiheuttaa muiden tasojen
tekstin koostamisen uudelleen.

1. Kaksoisnapsauta Tasot-paneelissa tasoa, joka sisältää kierrätysobjektin.

2. Valitse Ei tekstinkierrätystä, kun taso on kätketty.

Kierrätysobjektien vieressä olevan tekstin kohdistaminen

Kun määrität, kuinka teksti kohdistetaan kierrätysobjektien vieressä, muutos koskee koko julkaisua.

1. Valitse Muokkaa > Asetukset > Koostaminen (Windows) tai InDesign > Asetukset > Koostaminen (Mac OS).

2. Valitse jokin seuraavista asetuksista ja valitse sitten OK:

Kohdista kohteen vieressä oleva teksti

Kohdistaa tekstipalstoja erottavien kierrätysobjektien vieressä olevan tekstin. Tämä asetus vaikuttaa vain silloin, kun tekstinkierrätys
katkaisee tekstirivit täysin siten, että kukin rivi jakautuu vähintään kahteen osaan.

Kun kohteen vieressä olevalle tekstille valitaan asetus Tasaa vasemmalle, teksti tasataan kohteen vasemmalle puolelle tai sen
yläpuolelle. Kun valitaan Tasaa oikealle, teksti tasataan kohteen oikealle puolelle tai sen alapuolelle. Kun taas valitaan Täysi tasaus, teksti
asetellaan tasaisesti molempiin reunoihin.
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Kohdista kohteen vieressä oleva teksti

Ohita rivivälistyksen mukaan

Siirtää kierrätetyn tekstin seuraavaan vapaaseen rivivälistyskohtaan kierrätysobjektin jälkeen. Jos tätä asetusta ei ole valittu, tekstirivit voivat
siirtyä objektin alle niin, että ne eivät ole viereisten palstojen tai tekstikehysten rivien tasalla. Tästä valinnasta on hyötyä etenkin silloin, kun
haluat varmistaa, että teksti on tasattu rivirekisteriin.

Tekstinkierrätys vaikuttaa vain alla olevaan tekstiin

Tekstinkierrätys ei vaikuta kierrätysobjektin yläpuolelle pinottuun tekstiin. Pinoamisjärjestys määräytyy Tasot-paneeliin määritetyn tasojen
järjestyksen sekä tason objektien välisen pinoamisjärjestyksen mukaan.

Tekstinkierrätyksen ohittaminen tekstikehyksessä

Joissakin tapauksissa tekstinkierrätys halutaan poistaa käytöstä tekstikehyksessä. Voit esimerkiksi haluta yhden tekstikehyksen kiertyvän kuvan
ympäri ja toisen tekstikehyksen näkyvän kuvan sisällä.

1. Valitse ensin tekstikehys ja sitten Objekti > Tekstikehyksen asetukset.

2. Valitse Ohita tekstinkierrätys ja valitse sitten OK.

Yhdistelmäreitit ja -muodot

Tietoja maskeista ja alfakanavista

Sivupohjat
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Adobe World-Ready -koostajat
Tekstin suunta
Jutun suunta
Automaattinen kashida-lisäys
Ligatuurit
Aksenttimerkit
Kopiointi ja liittäminen Microsoft Wordista
Oletuskirjasimet
Vanhojen kirjasinten tuki
Lukutyypit
Tavutus
Etsi ja korvaa
Kuviot
Palstaan tasauksen vaihtoehdot
Lähi-idän erikoismerkkien lisääminen
Taulukon suunta
Sidontasuunnat
Oikealta vasemmalle -kirjoituksen asetukset
Sivu- ja kappalenumerointi
Kirjoitussuunta gallerianäkymässä ja juttueditorissa
Aksenttimerkkien väritys

Ohjelmiston Lähi-itään ja Pohjois-Afrikkaan suunnatuissa versioissa on uusia ja parannettuja toimintoja, jotka helpottavat työskentelyä arabian ja
heprean kielellä.

Adobe World-Ready -koostajat

Adobe World-Ready -koostajan ansiosta sisältöä voi luoda Lähi-idän kielillä. Tekstiä voi luoda arabiaksi, hepreaksi, englanniksi, ranskaksi,
saksaksi, venäjäksi ja muilla latinalaisilla kielillä. Kieltä voi myös vaihtaa.

Voit valita haluamasi koostajan Kappale-paneelivalikosta (Ikkuna > Kappale > paneelivalikko). Esimerkiksi InDesignissa voit käyttää Adoben
World-Ready Paragraph -koostajaa. Illustratorissa voit käyttää Middle Eastern Single-line Composeria.

Adobe World-Ready -koostajat

Tiedostot voi lisäksi tallentaa arabian- tai hepreankielisellä nimellä.

Tekstin suunta

Voit asettaa tekstin oletussuunnaksi oikealta vasemmalle, jotta voit luoda arabian- ja hepreankielistä sisältöä. Jos dokumentissa kuitenkin on myös
vasemmalta oikealle kirjoitettua tekstiä, suunnasta toiseen voi nyt vaihtaa saumattomasti.

Valitse kappaleen suunta Kappale-paneelista.

Kappaleen suunnan valinta
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Jos samassa kappaleessa on useita eri kieliä, voit määrittää tekstin suunnan merkkien tasolla. Myös päivämäärien ja numeroiden kohdalla tekstin
suunta määritetään merkkien tasolla.

Valitse Merkki-paneelin valikosta Merkkisuunta ja haluamasi suunta.

Merkkisuunta

Jutun suunta

Kun käytät arabian ja heprean kieliä, jutun suunta on tavallisesti oikealta vasemmalle. Ensimmäisen kehyksen on oltava kehyksen oikealla
puolella, seuraavat sarakkeet lisätään vasemmalle. Jos asettelu sisältää erilaisia sisältöjä, eri juttujen on oltava erisuuntaisia.

Valitse Juttu-paneelista (Ikkuna > Tyyppi ja taulukot > Juttu) jutun suunta.

Jutun suunta

Automaattinen kashida-lisäys

Arabiankielinen teksti tasataan kashida-lisäyksin. Arabiankielisiin merkkeihin lisättävät kashidat pidentävät merkkejä. Tyhjän tilan merkit eivät
muutu. Arabiankieliset tekstikappaleet voi tasata käyttämällä automaattista kashida-lisäystä.

Valitse kappale ja sitten Kappale-paneelin (Ikkuna > Teksti ja taulukot > Kappale) Lisää Kashida-tasaus -valikosta sopiva asetus. Vaihtoehdot ovat
Ei mitään, Lyhyt, Keski, Pitkä ja Tyylillinen. Kashidat lisätään vain, jos kappale tasataan. Asetusta ei voi käyttää kappaleissa, joissa on käytetty
tasausasetuksia.

Jos haluat lisätä kashidat merkkiryhmään, valitse merkit ja valitse Merkki-paneelivalikosta kashidat.

Automaattiset kashidat

Ligatuurit

Ligatuureja voi lisätä arabian- ja hepreankielisiin merkkipareihin automaattisesti. Ligatuurit ovat tiettyjen kirjainparien typografisia korvausmerkkejä,
jos ne ovat saatavilla Open Type -kirjasimessa.

Kun Merkki-paneelivalikosta tai Ohjauspaneelin valikosta valitaan Ligatuurit, kirjasimeen määritetty vakioligatuuri tuodaan näkyviin.

1. Valitse teksti.
2. Valitse Merkki-paneelin tai Ohjauspaneelin valikosta Ligatuurit.

Jotkin Open Type -kirjasimet sisältävät kuitenkin koristeellisia, valinnaisia ligatuureja, jotka saa käyttöön valitsemalla Valinnaiset ligatuurit. Näitä
ligatuureja käytetään valitsemalla Merkki-paneeli > OpenType > Valinnaiset ligatuurit.

Ota automaattiset ligatuurit käyttöön

Aksenttimerkit
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Arabiankielisessä tekstissä aksenttimerkillä tarkoitetaan kuviota, joka ilmaisee konsonantin pituuden tai lyhyen vokaalin. Aksenttimerkki asettuu
tekstin ylä- tai alapuolelle. Aksenttimerkkien vaaka- ja pystysuuntaista sijaintia voi muuttaa tekstin tyylillisten ominaisuuksien vuoksi tai kirjasimen
luettavuuden helpottamiseksi.

1. Valitse aksenttimerkkejä sisältävä teksti.
2. Siirry Merkki-paneeliin ja muuta aksenttimerkkien sijaintia tekstiin nähden. Muutettavia arvoja ovat Säädä aksenttimerkkien paikkaa

vaakasuunnassa ja Säädä aksenttimerkkien paikkaa pystysuunnassa.

Aksenttimerkkien sijainnin muuttaminen

Kopiointi ja liittäminen Microsoft Wordista

Voit kopioida tekstiä Microsoft Wordista ja liittää sen suoraan dokumenttiin. Liitetyn tekstin tasaus ja suunta määräytyvät automaattisesti arabian-
tai hepreankielisen tekstin perusteella.

Oletuskirjasimet

Kun Lähi-itään tai Pohjois-Afrikkaan suunnattu versio asennetaan, oletuskirjasin asetetaan oletusarvoisesti asennukseen liittyvän kielen mukaan.
Jos esimerkiksi olet asentanut version, joka sisältää englannin ja arabian kielet, oletuskirjasimena on Adobe Arabic. Jos olet vastaavasti asentanut
version, joka sisältää englannin ja heprean kielet, oletuskirjasimena on Adobe Hebrew (tai Photoshopissa Myriad Hebrew).

Vanhojen kirjasinten tuki

Perinteisiä kirjasimia (esimerkkinä AXT-kirjasimet) voidaan edelleen käyttää tässä ohjelmistoversiossa. Tekstipohjaisissa elementeissä suositellaan
kuitenkin uudempien Open Type -kirjasinten käyttöä.

Puuttuvien kuvioiden suojaus (Muokkaa > Oletusasetukset > Tekstin lisäasetukset) on käytössä oletusarvoisesti. Teksti käsitellään automaattisesti,
jos kuviota ei ole käytetyssä kirjasimessa.

Lukutyypit

Kun kirjoitat arabian- tai hepreankielistä tekstiä, voit valita käytettävän lukutyypin. Vaihtoehdot ovat arabian-, hindin- ja persiankieliset numerot.

Kun kyseessä on arabia, hindinkieliset numerot valitaan oletusarvoisesti, ja kun kyseessä on heprea, valitaan arabiankieliset numerot. Voit
kuitenkin vaihtaa arabiankielisiin numeroihin tarpeen mukaan.

1. Valitse numerot kirjoitetusta tekstistä.
2. Valitse Merkki-paneelista (Ctrl+T) Numerot-luettelo ja valitse kirjasin, jota haluat käyttää numeroissa.

Voit varmistaa arabiankielisten numeroiden käytön ottamalla Käytä tavanomaisia numeroita arabiaa kirjoitettaessa -asetuksen käyttöön. Asetusta
voi käyttää valitsemalla Muokkaa > Oletusasetukset > Tekstin lisäasetukset.

Lukutyypin valinta

Tavutus

373



Alkuun

Alkuun

Alkuun

Jos virkkeen sanat eivät mahdu yhdelle riville, teksti asetetaan automaattisesti kahdelle riville. Rivityksen yhteydessä teksti tasataan, mikä tuottaa
joskus riville ylimääräisiä välejä. Välit eivät näytä hyviltä eivätkä ole kieliopin mukaisia. Tavutus-toimintoa käyttämällä voit jakaa sanan rivin lopussa
tavuviivalla. Näin virke asettuu seuraavalle riville paremmin.

Sekatekstit: Kashida-lisäys vaikuttaa sekatekstien tavutukseen. Jos toiminto on käytössä, kashidat lisätään sopiviin kohtiin ja muu kuin
arabiankielinen teksti jätetään tavuttamatta. Kun kashida-toiminto on poistettu käytöstä, vain muu kuin arabiankielinen teksti tavutetaan.

Hepreankielinen teksti: Tavutus on sallittu. Jos haluat ottaa tavutuksen käyttöön ja mukauttaa asetuksia, valitse Kappale-paneeli > Paneelivalikko
> Tavutusasetukset.

Tavutusvaihtoehdot

Etsi ja korvaa

Arabian- ja hepreankielisen version käyttäjät voivat suorittaa tekstihaun ja korvauksen. Yksinkertaisen tekstin haun ja korvauksen lisäksi voit myös
hakea ja korvata tiettyjä ominaisuuksia vastaavaa tekstiä. Näihin ominaisuuksiin kuuluvat muun muassa aksenttimerkit, Kashida-merkit,
erikoismerkit (esimerkiksi Alef) ja erikieliset merkit (esimerkiksi hindinkieliset merkit).

Voit suorittaa tekstin haun ja korvauksen seuraavasti:

InDesign: Muokkaa > Etsi/Muuta

InDesignin Translitteroi-välilehdessä (Muokkaa > Etsi/Muuta) voit etsiä arabian-, hindin- ja farsinkielisiä merkkejä ja korvata ne. Voit esimerkiksi
etsiä hindinkielisiä merkkejä ja muuntaa ne arabiankielisiksi.

Kuviot

Arabian- ja hepreankielisen version käyttäjät voivat käyttää oletusmerkistön kuvioita. Jos haluat selata, valita ja käyttää oletusmerkistön tai toisen
kielen merkistön kuvioita, sinun on käytettävä Kuviot-paneelia:

InDesign: Ikkuna > Teksti ja taulukot > Kuviot
Illustrator: Ikkuna > Teksti > Kuviot

Kuvioiden selaaminen, valitseminen ja käyttäminen

Palstaan tasauksen vaihtoehdot

Kirjasimessa voi olla vaihtoehtoisia muotoja tietyille kirjaimille. Kirjainten muotovaihtoehdot tarjotaan yleensä tyylisyistä tai kalligrafisiin tarkoituksiin.
Joissakin harvoissa erityistapauksissa tasausvaihtoehtoja käytetään kappaleiden tasaamiseen.

Tasausvaihtoehdot voidaan ottaa käyttöön kappaleen tasolla, jolloin vaihtoehtoja käytetään aina kun mahdollista. Toiminnon voi ottaa käyttöön tai
poistaa käytöstä myös merkkien tasolla. Tasausvaihtoehdot ovat saatavilla vain, jos toiminto kuuluu kirjasimeen. Näin ollen käyttöönottovaihtoehto
tarjotaan vain tuettujen kirjasinten kohdalla.

Arabian kielen kirjasimet, joissa on tasausvaihtoehtoja: Adobe Arabic, Myriad Arabic ja Adobe Naskh. Heprean kielen kirjasimet joissa on
tasausvaihtoehtoja: Adobe Hebrew ja Myriad Hebrew.

InDesign

Kappaleen taso: Ikkuna > Kappale-paneeli > paneelivalikko > Palstaan sovitus ja valitse sitten Palstaan sovitus -luettelosta sopiva
vaihtoehto.

Merkkien taso: Ikkuna > Merkki-paneeli > paneelivalikko > Palstaan tasauksen vaihtoehdot.

374



Alkuun

Alkuun

Alkuun

Alkuun

Photoshop

Merkkien taso: Ikkuna > Merkki-paneeli > Palstaan tasauksen vaihtoehdot -valintaruutu.

Lähi-idän erikoismerkkien lisääminen

Joitakin arabian- ja hepreankielisiä merkkejä on vaikea lisätä tekstiin. Arabialaiset ja heprealaiset näppäimistöasettelut myös vaikeuttavat näiden
merkkien kirjoittamista tai lisäämistä. Jos haluat lisätä heprealaisen heittomerkin (Geresh) tai Maqafin kaltaisia merkkejä, valitse merkki kohdasta
Merkkipaneeli > paneelivalikko > Lisää ME-erikoismerkki.

ME-erikoismerkin lisääminen

Taulukon suunta

Arabian- ja hepreankielisen version käyttäjät voivat määrittää dokumenttiin lisätyn taulukon suunnan. Solujen ja sarakkeiden järjestys, oletuskieli ja
tekstin tasaus määräytyvät vastaavasti tämän perusteella. Arabiankielisen version käyttäjillä oikeassa reunassa oleva sarake on ensimmäinen
sarake, ja uudet sarakkeet lisätään taulukon vasemmassa reunassa olevan sarakkeen ulkopuolelle. Juttueditori (Ctrl + Y) tukee myös taulukon
suuntaa.

Voit määrittää uuden taulukon suunnan seuraavasti:

1. Valitse Taulukko > Lisää taulukko.
2. Valitse taulukon suunta Lisää taulukko -valintaikkunan Suunta-luettelosta.

Voit muuttaa olemassa olevan taulukon suunnan seuraavasti:

1. Siirrä kohdistin taulukkoon.
2. Avaa Taulukko-paneeli (Vaihto + F9) ja määritä taulukon suunta valitsemalla Taulukko vasemmalta oikealle tai Taulukko oikealta

vasemmalle.

Oikealta vasemmalle -taulukoissa arabialaiset ja pohjoisafrikkalaiset versiot käyttävät oletusarvoisesti arabian kieltä. Heprealainen versio on
määritetty käyttämään heprean kieltä. Vasemmalta oikealle -taulukoissa arabialaiset ja heprealaiset versiot käyttävät oletusarvoisesti englannin
kieltä. Pohjoisafrikkalaisessa versiossa käytetään oletusarvoisesti ranskaa.

Sidontasuunnat

Sidontasuunta määrittää kirjan sitomiseen käytettävän reunan. Vasemmalta oikealle luettavalla kielellä kirjoitetut kirjat sidotaan vasemmasta
reunasta. Oikealta vasemmalle luettavalla kielellä kirjoitetut dokumentit sidotaan kirjan oikeasta reunasta.

Oikeasta reunasta sidotun kirjan sivuasettelu

Oikealta vasemmalle -kirjoituksen asetukset

Neutraalit merkit

Joidenkin arabian- ja hepreankielisten merkkien suunta voi vaikuttaa epäselvältä. Merkkien suunnan epäselvyys voi aiheuttaa epävarmuutta
merkkien suunnan ja järjestyksen suhteen. Voit varmistaa merkkien suunnan selvyyden ja yksiselitteisyyden seuraavasti:

1. Valitse Muokkaa > Asetukset > Oikealta vasemmalle.
2. Valitse Pakota neutraali merkkien suunta näppäimistösyötteen mukaan -ruutu.

Kohdistimen hallinta
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Arabian- ja hepreankielisen version käyttäjät voivat hallita, mihin suuntaan kohdistin liikkuu näppäimistön nuolinäppäimiä painettaessa.
Kohdistimen liike -luettelossa (Muokkaa > Asetukset > Oikealta vasemmalle) on kaksi asetusvaihtoehtoa:

Visuaalinen: Kohdistin liikkuu nuolinäppäimen suuntaan. Oikeaa nuolinäppäintä painettaessa näytössä oleva kohdistin liikkuu oikealle.
Looginen: Kohdistin liikkuu kirjoitetun kielen suuntaan. Arabiassa ja hepreassa kohdistin liikkuu oikeaa nuolinäppäintä painettaessa
vasemmalle (oikealta vasemmalle luettavassa kielessä seuraavaan merkkiin).

Sivu- ja kappalenumerointi

Arabian- ja hepreankielisen version käyttäjät käyttävät alueen yleisimmin käytettyjä numerojärjestelmiä. Yleisimmin käytetyt numerojärjestelmät
ovat seuraavat:

Arabia: arabialainen Abjad ja Alef-Ba-Tah
Ranska: heprealainen raamatullinen standardi ja ei-standardi desimaalijärjestelmä

Voit valita numerojärjestelmän tai vaihtaa sen valitsemalla Asettelu > Numerointi- ja osa-asetukset ja sitten haluamasi vaihtoehdon Tyyli-
luettelosta.

Sivujen, osien ja kappaleiden numerointi

Kirjoitussuunta gallerianäkymässä ja juttueditorissa

Kun kirjoitat arabian- tai hepreankielistä tekstiä, voit osoittaa kirjoitussuunnan. Voit ottaa tämän toiminnon käyttöön valitsemalla Muokkaa >
Asetukset > Juttueditorinäyttö ja sitten Osoita kirjoitussuunta -ruudun. Kun tämä toiminto on käytössä, kohdistimessa on nuoli, joka osoittaa
kirjoitussuunnan.

Aksenttimerkkien väritys

Arabiankielisessä tekstissä aksenttimerkit voidaan tyyli- tai muista syistä merkitä eri värein. Aksenttimerkeillä voidaan esimerkiksi korostaa sanan
tai lauseen tiettyä merkitystä. Löydät aksenttimerkkien värit ja voit muuttaa niitä Muuta arabialaisten aksenttimerkkien väriä -kohdassa.

1. Valitse Muokkaa > Etsi/Muuta.
2. Valitse Kysely-luettelosta Muuta arabialaisten aksenttimerkkien värejä.
3. Korvaa vanhat aksenttimerkit uusilla värillisillä aksenttimerkeillä valitsemalla Muuta-, Muuta kaikki- tai Etsi/Muuta-painikkeilla.

Voit muokata kyselyä ja tallentaa sen tarpeen mukaan.

376

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fi_FI/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fi


Alaviitteet

Alkuun

Alkuun

Alaviitteiden luominen
Alaviitteiden numeroinnin ja asettelun muuttaminen
Alaviitteiden tekstin käsitteleminen
Tekstinkierrätys alaviitteissä
Alaviitteiden poistaminen 

Alaviitteiden luominen

Alaviite koostuu kahdesta linkitetystä osasta: tekstissä näkyvästä alaviitteen viittauksen numerosta ja palstan alareunassa olevasta
alaviitetekstistä. Voit luoda alaviitteitä tai tuoda niitä Word- tai RTF-tiedostoista. Alaviitteet numeroidaan automaattisesti, kun niitä lisätään
julkaisuun. Numerointi alkaa uudelleen jokaisessa jutussa. Voit määrittää numeroinnin tyylin ja ulkoasun sekä alaviitteiden asettelun. Alaviitteitä ei
voi lisätä taulukoihin tai alaviitetekstiin. Alaviitetekstin leveys perustuu sen palstan leveyteen, jossa alaviitemerkki on.

InDesignissa ei voi luoda loppuviitteitä. Microsoft Word -julkaisuista muunnetut loppuviitteet muotoillaan tekstiksi, ei alaviitteiksi. Jos haluat tietää,
miten loppuviitteiden luonti voidaan kiertää, perehdy Bob Bringhurstin InDesignin loppuviitteitä käsittelevään artikkeliin. 

Voit luoda alaviitteitä seuraavasti:

1. Sijoita kohdistin paikkaan, jossa haluat alaviitteen viittauksen numeron näkyvän.

2. Valitse Teksti > Lisää alaviite.

3. Kirjoita alaviiteteksti.

Alaviite lisätty julkaisuun

A. Viittauksen numero B. Alaviiteteksti 

Kun kirjoitat tekstiä, alaviitealue laajenee mutta tekstikehys pysyy entisen kokoisena. Alaviitealue laajenee ylöspäin, kunnes se ulottuu alaviitteen
viittauksen riville. Tämän jälkeen alaviite jaetaan seuraavaan tekstikehyksen palstaan tai ketjutettuun kehykseen. Jos alaviitettä ei voida jakaa ja
tekstiä on enemmän kuin alaviitealueelle mahtuu, alaviitteen viittauksen sisältävä rivi siirretään seuraavalle palstalle tai näyttöön ilmestyy
ylijuoksevan tekstin kuvake. Voit korjata tämän muuttamalla kehyksen kokoa tai tekstin muotoilua.

Voit palata kirjoituskohtaan valitsemalla Teksti > Siirry alaviitteen viittaukseen, kun kohdistin on alaviitteessä. Jos käytät tätä asetusta usein,
sille kannattaa luoda pikanäppäin.

Alaviitteiden numeroinnin ja asettelun muuttaminen

Alaviitteiden numerointiin ja asetteluun tehtävät muutokset vaikuttavat sekä olemassa oleviin että uusiin alaviitteisiin.

1. Valitse Teksti > Julkaisun alaviiteasetukset.
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Numerointityyli

Aloita kohdasta

Aloita numerointi uudestaan joka

Näytä etu- tai jälkiliite kohteessa

Sijainti

Merkkityyli

Kappaletyyli

Erotin

Pienin väli ennen ensimmäistä alaviitettä

Alaviitteiden väli

2. Valitse Numerointi ja muotoilu -välilehdessä asetukset, jotka määrittävät viittauksen numeron ja alaviitetekstin numeroinnin rakenteen ja
muotoilun ulkoasun.

3. Valitse Sivuasettelu ja sivun alaviiteosion ulkoasua määrittävät asetukset.

4. Napsauta OK-painiketta.

Alaviitteiden numerointi- ja muotoiluasetukset

Seuraavat Numerointi ja muotoilu -asetukset näkyvät Alaviiteasetukset-valintaikkunassa:

Valitse numerointityyli alaviitteen viittausten numeroille.

Määritä jutun ensimmäisen alaviitteen numero. Jokainen julkaisun juttu alkaa samalla Aloituskohta-numerolla. Jos kirjassa on
useita julkaisuja jatkuvalla sivunumeroinnilla, aloita alaviitteiden numerointi jokaisessa luvussa siitä, mihin edellinen luku päättyy.
Aloita kohdasta -valinnasta on hyötyä etenkin käsiteltäessä kirjan julkaisuja. Alaviitteiden numerointia ei jatketa kirjan julkaisujen välillä.

Jos haluat numeroinnin alkavan julkaisun sisällä uudestaan, valitse tämä vaihtoehto ja sitten Sivu, Aukeama
tai Osio määrittääksesi, milloin alaviitteiden numerointi aloitetaan uudestaan. Tietyt numerointityylit, kuten asteriskit (*), toimivat parhaiten, kun ne
palautetaan jokaisella sivulla.

Valitse tämä asetus, jos haluat näyttää etu- tai jälkiliitteet alaviitteen viittauksessa, alaviitetekstissä tai
molemmissa. Etuliitteet näkyvät numeron edessä (kuten [1) ja jälkiliitteet näkyvät numeron perässä (kuten 1]). Tämä asetus on erityisen
hyödyllinen, jos alaviitteitä halutaan sijoittaa merkkien sisään, esimerkiksi [1]. Kirjoita merkki tai merkkejä tai valitse Etuliite- ja/tai Jälkiliite-asetus.
Jos haluat valita erikoismerkkejä, näytä valikko napsauttamalla etu- ja takaliitesäätimien vieressä olevia kuvakkeita.

Jos alaviitteen viittauksen numero on liian lähellä edeltävää tekstiä, yhden välilyöntimerkin lisääminen etuliitteeksi parantaa ulkoasua. Voit
käyttää viittauksen numerossa myös merkkityyliä.

Tämä asetus määrittää alaviitteen viittauksen numeron näkymisen. Oletusarvo on yläindeksi. Jos haluat muotoilla numeron käyttämällä
merkkityyliä (esimerkiksi OpenTypen yläindeksiasetukset sisältävä merkkityyli), valitse Ota käyttöön normaali ja määritä merkkityyli.

Muotoile alaviitteen viittauksen numeroa merkkityylillä. Valitse esimerkiksi yläindeksin sijaan merkkityyli normaalissa sijainnissa ja
kohotetulla perusviivalla. Valikosta näkee Merkkityyli-paneelissa käytettävissä olevat merkkityylit.

Valitse kappaletyyli, joka muotoilee julkaisun kaikkien alaviitteiden alaviitetekstin. Valikosta näkee Kappaletyyli-paneelissa
käytettävissä olevat kappaletyylit. Oletuksena käytetään [Peruskappale]-tyyliä. [Peruskappale]-tyylin ja julkaisun oletuskirjasinasetusten ulkoasu ei
välttämättä ole samanlainen.

Erotin määrittää alaviitteen numeron ja alaviitetekstin alun välisen tyhjän tilan. Jos haluat muuttaa erotinta, valitse tai poista ensin nykyinen
erotin ja valitse sitten uusi erotin. Voit käyttää useita merkkejä. Jos haluat lisätä välilyöntimerkkejä, käytä sopivaa metamerkkiä (esimerkiksi ^m, jos
haluat em-välin).

Alaviitteiden asetteluasetukset

Seuraavat Sivuasettelu-asetukset näkyvät Alaviiteasetukset-valintaikkunassa:

Tämä asetus määrittää palstan alareunan ja ensimmäisen alaviiterivin välisen pienimmän välin arvon.
Negatiivista arvoa ei voi käyttää. Mikä tahansa alaviitteen kappaleen Väli ennen -asetus ohitetaan.

Tämä asetus määrittää palstan yhden alaviitteen viimeisen kappaleen ja seuraavan alaviitteen ensimmäisen kappaleen välisen
etäisyyden. Negatiivista arvoa ei voi käyttää. Alaviitteen kappaleen Väli ennen- ja Väli jälkeen -arvot ovat käytössä vain, jos alaviitteessä on useita
kappaleita.
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Ensimmäisen perusviivan siirtymä

Sijoita jutun lopun alaviitteet tekstin alareunaan

Salli alaviitteiden jakaminen

Viiva yläpuolella

Alkuun

Tämä asetus määrittää alaviitealueen alun (kohta, jossa alaviitteen erotin oletusarvoisesti näkyy) ja
alaviitetekstin ensimmäisen rivin välisen etäisyyden.
Tietoja ensimmäisen perusviivan asetuksista on kohdassa Tekstikehyksen ominaisuuksien muuttaminen.

Valitse tämä asetus, jos haluat viimeisen palstan alaviitteiden näkyvän aivan jutun viimeisen
kehyksen tekstin alapuolella. Jos asetus ei ole valittuna, jutun viimeisen kehyksen alaviitteet näkyvät palstan alareunassa.

Valitse tämä asetus, jos haluat alaviitteen jakautuvan, kun se ylittää sen käytössä olevan tilan palstalla. Jos
jakaminen ei ole sallittu, alaviitteen viittauksen numeron sisältävä rivi siirtyy seuraavalle palstalle tai tekstistä tulee ylijuoksevaa.

Vaikka Salli alaviitteiden jakaminen -asetus on käytössä, voit estää yksittäisten alaviitteiden jakautumisen sijoittamalla kohdistimen
alaviitetekstiin. Valitse Kappale-paneelin valikosta Pitoasetukset ja sieltä sitten vaihtoehdot Pidä rivit yhdessä ja Kaikki kappaleen rivit. Jos
alaviitteessä on useita kappaleita, käytä Sido seuraavat X riviä -asetusta alaviitetekstin ensimmäisessä kappaleessa. Voit määrittää alaviitteen
jakamiskohdan valitsemalla Teksti > Lisää vaihtomerkki > Palstanvaihto.

Kahdelle palstalle jaettu alaviite

Määritä alaviitetekstin yläpuolella olevan, alaviitteen muusta tekstistä erottavan viivan sijainti ja ulkoasu. Erottava viiva (jota
kutsutaan myös erotinviivaksi) on myös erillisessä palstassa jatkuvan alaviitetekstin yläpuolella. Valitsemasi asetukset koskevat joko Palstan
ensimmäinen alaviite- tai Jatketut alaviitteet -kohtaa sen mukaan, kumpi niistä on valittu valikosta. Nämä asetukset ovat samankaltaisia
kappaleviivan määrittämisessä käytettävien asetusten kanssa. Jos haluat poistaa alaviitteen erotinviivan kokonaan, poista valinta kohdasta Viiva
käytössä.

Alaviitteiden tekstin käsitteleminen

Huomioi seuraavat seikat, kun muokkaat alaviitetekstiä:

Valitse nykyisen alaviitteen teksti valitsemalla Muokkaa > Valitse kaikki, kun kohdistin on alaviitteen tekstissä. Tällöin toiminto ei valitse muita
alaviitteitä tai muuta tekstiä.
Voit siirtyä alaviitteestä toiseen nuolinäppäimillä.
Alaviitteiden numerointia ei jatketa kirjan julkaisujen välillä. Jos et halua numeroinnin alkavan alusta jokaisessa kirjan julkaisussa, muuta
Aloita kohdasta -arvoa manuaalisesti jokaisessa julkaisussa muokkauksen päätteeksi.
Voit laajentaa ja kutistaa alaviitteen napsauttamalla juttueditorissa alaviitekuvaketta. Voit laajentaa tai kutistaa kaikki alaviitteet valitsemalla
Näytä > Juttueditori > Laajenna kaikki alaviitteet tai Kutista kaikki alaviitteet.
Voit laajentaa tai kutistaa alaviitteet Raakateksti- ja Juttu-näkymissä napsauttamalla alaviitekuvaketta. Voit laajentaa tai kutistaa kaikki
alaviitteet napsauttamalla alaviitettä hiiren kakkospainikkeella (Windows) tai Ctrl-osoittamalla (Mac OS) alaviitettä ja valitsemalla Laajenna
kaikki alaviitteet tai Kutista kaikki alaviitteet.

Voit käyttää alaviitetekstissä merkki- ja kappalemuotoiluja. Voit myös valita alaviitteen viittauksen numeron ulkoasun ja muuttaa sitä.
Suositeltavaa on kuitenkin käyttää Julkaisun alaviiteasetukset -valintaikkunaa.

Kun leikkaat tai kopioit tekstiä, joka sisältää alaviitteen viittauksen numeron, myös alaviiteteksti lisätään leikepöydälle. Jos kopioit tekstin
toiseen julkaisuun, tekstin alaviitteet käyttävät uuden julkaisun numerointi- ja asetteluominaisuuksia.

Voit palauttaa vahingossa poistetun alaviitteen numeron alaviitetekstin alusta. Sijoita kohdistin alaviitetekstin alkuun, napsauta sitä hiiren
kakkospainikkeella (Windows) tai napsauta sitä Ctrl-näppäin alhaalla (Mac OS) ja valitse sitten Lisää erikoismerkki > Merkit > Alaviitteen
numero.
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Alkuun

Jos poistat ohitukset ja merkkityylit kappaleesta, joka sisältää alaviitteen viittauksen merkin, alaviitteen viittauksen numerot menettävät
Julkaisun alaviiteasetukset -valintaikkunassa annetut määritteet.

Tekstinkierrätys alaviitteissä

Voit käyttää tekstinkierrätystä alaviitteeseen sisältyvässä ankkuroidussa tai irrallisessa objektissa.

Alaviitteissä olevien objektien sisäinen tekstinkierrätys

Voit lisätä alaviitteeseen tekstiin sidotun tai ankkuroidun objektin, jossa on käytetty tekstinkierrätystä. Teksti kierrätetään ja säädetään
saumattomasti objektin ympärille.

Sisäisessä tekstinkierrätyksessä teksti kierrätetään vain sen pisteen alapuolella, johon objekti on ankkuroitu alaviitteessä.

Sisäinen tekstinkierrätys

Alaviitteissä olevien objektien ulkoinen tekstinkierrätys

Jos irrallinen objekti (joka ei ole tekstiin sidottu tai ankkuroitu), jossa on käytetty tekstinkierrätystä, liittyy alaviitteiden tekstiin, silloin käytetään
tekstinkierrätystä. Teksti säädetään dynaamisesti objektin ympärille.

Alla olevassa esimerkissä valokuva ei kuulu alaviitteeseen, mutta teksti säädetään saumattomasti objektin ympärille.
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Alkuun

Ulkoinen tekstinkierrätys

Alaviitteet ei-suorakulmaisissa kehyksissä

Ei-suorakulmaisissa tekstikehyksissä, kuten kulmiltaan pyöristetyissä kehyksissä, soikioissa ja ympyröissä, alaviitteet pysyvät objektin muotojen
rajoissa.

Alaviitteiden poistaminen 

Jos haluat poistaa alaviitteen, valitse tekstissä näkyvä alaviitteen viittauksen numero ja paina askelpalautinta tai Delete-näppäintä. Jos poistat vain
alaviitetekstin, alaviitteen viittauksen numero ja alaviitteen rakenne jäävät ennalleen.
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Ankkuroidut objektit

Alkuun

Tekstiin sidottu

Rivin yläpuolella

Mukautettu

Huomautus:

Tietoja ankkuroiduista objekteista
Ankkuroidun objektin luominen
Mukautettuja sijaintiasetuksia käyttävän ankkuroidun objektin sijoittaminen
Ankkuroitujen objektien käyttäminen vetämällä ja pudottamalla (CS5.5)
Ankkuroitujen objektien valitseminen ja kopioiminen
Objektien ankkurimerkkien näyttäminen sivulla
Ankkuroidun objektin siirtäminen sivulla manuaalisesti
Ankkuroidun objektin koon muuttaminen
Ankkuroidun objektin vapauttaminen

Tietoja ankkuroiduista objekteista

Ankkuroidut objektit ovat esimerkiksi kuvien tai tekstikehysten kaltaisia kohteita, jotka on kiinnitetty, eli ankkuroitu, tiettyyn tekstiin. Kun ankkurin
sisältävä teksti sijoitetaan uudelleen, ankkuroitu objekti siirtyy sen mukana. Käytä ankkuroituja objekteja, kun haluat liittää objektin tiettyyn
tekstiriviin tai kappaleeseen. Voit ankkuroida esimerkiksi sivupalkkeja, tekstileikkeitä, kuvia ja tiettyyn sanaan liittyviä kuvakkeita.

Voit luoda ankkuroidun objektin liittämällä tai sijoittamalla objektin (tai kehyksen) tekstiin tekstityökalulla tai käyttämällä Lisää ankkuroitu objekti -
komentoa. Kun sijoitat objektin, Adobe InDesign CS4 lisää lisäyskohtaan ankkurimerkin. Ankkuroidut objektit saavat samat kierto- ja viisto-
ominaisuudet kuin tekstikehykset, joihin ne on ankkuroitu, huolimatta siitä ovatko objektit tekstikehysten sisällä vai ulkopuolella. Voit valita objektin
ja muuttaa näitä asetuksia.

Voit luoda ankkuroituja objekteja seuraaviin kohtiin:

Tasaa ankkuroidun objektin kohdistimen perusviivan mukaisesti. Voit sijoittaa objektin perusviivan ylä- tai alapuolelle säätämällä
Y-siirtymää. Tämä on ankkuroitujen objektien oletustyyppi. InDesignin aikaisemmissa versioissa tällaisia objekteja kutsuttiin sidotuksi grafiikaksi.

Sijoittaa ankkuroidun objektin rivin yläpuolelle, jolloin tasaukseksi voidaan valita Vasen, Keskitetty, Oikea, Kohti selkää, Pois
selästä tai (Tekstin tasaus). Tekstin tasauksella tarkoitetaan ankkurimerkin sisältävän kappaleen tasausasetusta.

Sijoittaa ankkuroidun objektin kohtaan, joka on määritetty Ankkuroidun objektin asetukset -valintaikkunassa. Voit sijoittaa objektin
minne tahansa tekstikehyksen sisä- tai ulkopuolella.

Voit käyttää tekstiin sidottuja tai rivin yläpuolelle sijoitettuja ankkuroituja objekteja reittitekstien kanssa. (Katso Ankkuroitujen
objektien lisääminen reittitekstiin.)

Esimerkkijulkaisu, jossa ankkuroituja objekteja
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Alkuun

Sisältö

Huomautus:

Objektin tyyli

Kappaletyyli

Huomautus:

Korkeus ja leveys

A. Tekstiin sidottu sijainti B. Sijainti rivin yläpuolella (tasattu vasemmalle) C. Mukautettu sijainti (tasattu tekstikehyksen reunaan) 

Tim Cole kertoo pikanäppäimestä, jolla voi lisätä ankkuroituja kehyksiä osoitteessa Ankkuroitujen kehyksien tuottavuuspikanäppäin.

Ankkuroidun objektin luominen

Jos julkaisuun sijoitettava objekti ei ole käytettävissä (jos sivupalkin tekstiä ei esimerkiksi ole vielä kirjoitettu), voit luoda tyhjän ankkuroidun
kehyksen paikkamerkiksi myöhemmin lisättävälle sisällölle. Voit muokata ankkuroidun kehyksen kokoa koska tahansa. Tällöin kehyksen
sijaintiasetukset päivitetään automaattisesti.

1. Tee jokin seuraavista:

Lisää ankkuroitu objekti sijoittamalla ankkurin lisäyskohta haluamaasi kohtaan tekstityökalulla ja sijoittamalla tai liittämällä objekti.

Jos objektin kehys on korkeampi kuin tekstirivi, johon se sijoitetaan, teksti saattaa mennä tuodun kuvan päälle tai rivin yläpuolella saattaa
näkyä suurempi väli. Tällöin voit valita ankkuroidulle objektille eri sijainnin, lisätä rivinvaihdon, muuttaa tekstiin sidotun objektin kokoa tai
määrittää ympäröiville riveille eri rivinvälistysarvon.

Ankkuroi olemassa oleva objekti valitsemalla ensin se ja sitten Muokkaa > Leikkaa. Sijoita objektin lisäyskohta haluamaasi kohtaan
tekstityökalulla ja valitse Muokkaa > Liitä. Ankkuroidun objektin sijainnin oletusasetuksena on Tekstiin sidottu.

Jos objekti ei ole käytettävissä (jos sivupalkin tekstiä ei esimerkiksi ole vielä kirjoitettu), lisää paikkamerkkikehys sijoittamalla objektin
ankkurin lisäyskohta haluamaasi kohtaan tekstityökalulla ja valitsemalla sitten Objekti > Ankkuroitu objekti > Lisää.

Voit ankkuroida tekstimerkkejä muuntamalla tekstin ääriviivoiksi. Ääriviivojen luominen muuntaa automaattisesti tekstin jokaisen merkin
tekstiin sidotuksi ankkuroiduksi objektiksi.  

2. Sijoita objekti valitsemalla se ensin valintatyökalulla ja sitten Objekti > Ankkuroitu objekti > Asetukset. Määritä haluamasi asetukset.

Ankkuroitu objekti -valintaikkunan sijaan voit käyttää Lisää ankkuroitu objekti tai siirry ankkurimerkkiin -pikanäppäintä. Tämän
pikanäppäinkomennon näppäimet on määritettävä Pikanäppäimet-ikkunassa (komento on Teksti ja taulukot -luettelossa). Pikanäppäimien
painaminen kahdesti poistaa objektin valinnan ja siirtää kohdistimen takaisin päätekstiin. (Katso Pikanäppäinyhdistelmien käyttäminen.)

Lisättävien ankkuroitujen objektien asetukset

Kun lisäät ankkuroidun objektin paikkamerkin, voit määrittää seuraavat sen sisältöä koskevat asetukset:

Määrittää paikkamerkkikehykseen lisättävän objektin tyypin.

Jos valitset Teksti-asetuksen, kohdistin tulee näkyviin tekstikehyksessä. Jos valitset Grafiikka- tai Määrittelemätön-asetuksen,
InDesign valitsee objektin kehyksen.

Määrittää objektin muotoilussa käytettävän tyylin. Jos olet määritellyt ja tallentanut objektin tyylejä, ne näkyvät tässä valikossa.

Määrittää kappaleen muotoilussa käytettävän tyylin. Jos olet määritellyt ja tallentanut kappaletyylejä, ne näkyvät tässä valikossa.

jos tietty kappaletyyli on käytössä objektin tyylissä ja valitset Kappaletyyli-valikosta eri tyylin tai jos muutat Ankkuroitu sijainti -
asetuksia tyylin osalta, Objektin tyyli -valikossa näkyvä plusmerkki (+) osoittaa, että asetuksia on ohitettu.

Määrittää paikkamerkkikehyksen mitat.

Tekstiin sidottu- ja Rivin yläpuolella -sijaintiasetukset

Kun valitset Ankkuroidun objektin asetukset -valintaikkunan Sijainti-valikosta vaihtoehdon Tekstiin sidottu tai Rivin yläpuolella, voit määrittää
ankkuroidun objektin sijainnin seuraavien asetusten avulla. (Voit muokata näitä asetuksia myös Lisää ankkuroitu objekti -valintaikkunassa.)
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Tekstiin sidottu

Y-siirtymä

Rivin yläpuolella

Tasaus

Vasen, Oikea ja Keskitetty

Kohti selkää ja Pois selästä

(Tekstin tasaus)

Tila ennen

Tila jälkeen

Huomautus:

Suhteessa selkään

Tasaa ankkuroidun objektin alareunan perusviivaan. Tekstiin sidottuja objekteja koskevat tietyt rajoitukset, kun niitä siirretään y-
akselilla: objektin yläreunaa ei voi siirtää rivivälin informaatioalueen alapuolelle eikä objektin alareunaa voi siirtää rivivälin informaatioalueen
yläpuolelle.

Säätää perusviivan sijaintia. Voit myös vetää objektia hiirellä pystysuunnassa sivulla.

Tasaa objektin ankkurimerkin sisältävän tekstirivin ja sen yläpuolella olevan tekstirivin väliin.

Valittavana on seuraavat asetukset:

Kohdistaa objektin suhteessa palstan leveyteen. Nämä asetukset ohittavat kappaleen sisennysarvot ja
tasaavat objektin koko palstaan.

Tasaavat objektin vasemmalle tai oikealle sen mukaan, kummalla puolella aukeamaa objekti on. Nämä
asetukset ohittavat kappaleen sisennysarvot ja tasaavat objektin koko palstaan.

Tasaa objektin kappaleen tasausasetusten mukaisesti. Tämä asetus käyttää objektin tasauksessa kappaleen
sisennysarvoja.

Määrittää objektin sijainnin suhteessa edeltävän tekstirivin rivivälin informaatioalueen alareunaan. Positiiviset arvot laskevat sekä
objektia että sen alla olevaa tekstiä. Negatiiviset arvot siirtävät objektin alla olevaa tekstiä ylöspäin objektia kohti. Objektin korkeus on suurin
mahdollinen negatiivinen arvo.

Määrittää objektin sijainnin suhteessa objektin alla olevan rivin ensimmäisen merkin versaalikorkeuteen (eli ison kirjaimen
korkeuteen). Kun arvo on 0, objektin alareuna on rivin versaalikorkeudella. Positiiviset arvot siirtävät objektin alla olevaa tekstiä alaspäin (poispäin
objektin alareunasta). Negatiiviset arvot siirtävät objektin alla olevaa tekstiä ylöspäin (objektia kohti).

Väli ennen- ja Väli jälkeen -asetusten käyttäminen

A. Kun Väli ennen -arvo on 0P10, objekti ja siihen liittyvä teksti siirtyvät kauemmas niitä edeltävästä tekstirivistä. B. Kun Väli jälkeen -arvo on
0p10, objekti ja sitä edeltävä tekstirivi siirtyvät kauemmas objektiin liittyvästä tekstirivistä (rivi objektin alla). 

Rivin yläpuolella -asetusta käyttävät ankkuroidut objektit ovat aina sidottuja riviin, jossa ankkuri on. Teksti ei koostu siten, että
objekti on sivun alalaidassa ja ankkurimerkin sisältävä rivi on seuraavan sivun ylälaidassa.

Mukautetut sijaintiasetukset

Voit käyttää seuraavia asetuksia sijoittaessasi ankkuroidun objektin, jonka sijainti on mukautettu. Voit määrittää nämä asetukset Lisää ankkuroitu
objekti- tai Ankkuroidun objektin asetukset -valintaikkunassa. Katso vaiheittaiset ohjeet näiden asetusten käytöstä kohdasta Mukautettuja
sijaintiasetuksia käyttävän ankkuroidun objektin sijoittaminen.

Määrittää, tasataanko objekti suhteessa julkaisun selkään. Kun valitset tämän asetuksen, sijaiskuva ankkuroidun objektin
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Huomautus:

Ankkuroidun objektin viitepiste 

Ankkuroidun sijainnin viitepiste 

Huomautus:

X suhteessa

viitepisteistä näkyy kaksisivuisena aukeamana. Sivut ovat toistensa peilikuvia. Kun asetus on valittu, aukeaman toiselle puolelle, esimerkiksi
ulkoreunukseen, sijoitetut objektit pysyvät ulkoreunuksessa, vaikka ne siirtyisivät vastakkaiselle sivulle tekstiä uudelleen sijoitettaessa.

Suhteessa selkään -asetuksen käyttö

A. Suhteessa selkään -asetusta ei ole valittu: objekti pysyy tekstikehyksen vasemmalla puolella, kun teksti siirtyy aukeaman oikeanpuoleiselle
sivulle. B. Suhteessa selkään -asetus on valittu: objekti pysyy sivun ulkoreunassa, kun teksti siirtyy aukeaman oikeanpuoleiselle sivulle. 

Jos säädät X-siirtymän arvoa valittuasi Suhteessa selkään -asetuksen, objektin siirtosuunta saattaa muuttua. Muutos tapahtuu,
koska siirtosuunta määräytyy osittain sen mukaan, kummalla puolella aukeamaa objekti on.

Määrittää objektin kohdan, joka halutaan tasata sijaintiin sivulla (ankkuroidun sijainnin viitepisteen määrittämä).
Jos esimerkiksi haluat tasata objektin oikean reunan sivukohteen (kuten tekstikehyksen) kanssa, napsauta sijaiskuvassa reunimmaisena oikealla
olevaa pistettä. Lisätietoja viitepisteen käytöstä on kohdassa Mukautettuja sijaintiasetuksia käyttävän ankkuroidun objektin sijoittaminen.

Määrittää sivulla sijainnin (määritelty X/Y suhteessa -asetuksissa), jonka kanssa objekti tasataan. Jos esimerkiksi valitset X suhteessa -asetukseksi
Tekstikehys ja Y suhteessa -asetukseksi Rivi (Perusviiva), sijaiskuvassa näkyy tekstikehyksen vaakasuora alue ja objektin ankkurimerkin

sisältävän tekstirivin pystysuora alue. Jos napsautat sijaiskuvassa reunimmaisena vasemmalla olevaa pistettä, objektin viitepiste  tasataan
tekstikehyksen vasemman reunan ja tekstin perusviivan kanssa.

Objektin oikea reuna on tasattu tekstikehyksen vasemman reunan kanssa.

Sijaiskuvassa ankkuroidun sijainnin viitepisteestä näkyy joko kolme tai yhdeksän sijaintia X suhteessa- ja Y suhteessa -asetusten
mukaan. Riviasetuksissa, kuten Rivi (Perusviiva), on vain kolme vaihtoehtoa: keskellä vasemmalla, keskellä ja keskellä oikealla, koska tekstissä
oleva ankkurimerkki määrittää pystysijainnin.

Määrittää, mihin vaakatasaus perustuu. Jos valitset esimerkiksi Tekstikehys-asetuksen, voit tasata objektin tekstikehyksen
vasempaan tai oikeaan reunaan tai sen keskelle. Tarkka vaakatasaus määräytyy valitsemiesi viitepisteiden ja määrittämäsi X-siirtymän mukaan.
Jos esimerkiksi haluat sijoittaa objektin sivun reunaan siten, että sen oikea reuna on tasattu sivun reunuksen kanssa, valitse X suhteessa -
kohdassa Sivun reunus. Määritä sitten reunimmaisena oikealla oleva piste ankkuroidun objektin viitepisteen sijaiskuvassa ja reunimmaisena
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X-siirtymä

Y suhteessa

Y-siirtymä

Pidä palstan ylä- tai alarajojen sisällä

Huomautus:

vasemmalla oleva piste ankkuroidun sijainnin viitepisteen sijaiskuvassa.

X suhteessa -asetus

A. Objektin oikean reunan tasaaminen tekstikehyksen vasempaan reunaan&nbsp; B. Objektin oikean reunan tasaaminen sivun reunuksen
vasempaan reunaan

Siirtää objektia vasemmalle tai oikealle. Siirtosuunta määräytyy viitepisteen mukaan. Jos objekti on tasattu sivukohteen keskelle,
positiiviset arvot siirtävät sitä oikealle. Siirtosuuntaan vaikuttaa myös se, onko Suhteessa selkään -asetus valittuna.

Määrittää, mihin pystytasaus perustuu. Jos valitset esimerkiksi Sivun reuna -asetuksen, voit määrittää objektin sivun reunan
perusteella sivun yläreunaan, keskelle tai alareunaan. Ankkuroidun sijainnin viitepiste määrittää, tasataanko objekti sivukohteen yläreunaan,
keskelle vai alareunaan. Jos valitset riviasetuksen, kuten Rivi (Perusviiva), ankkuroidun sijainnin viitepisteen voi valita vain keskimmäisestä
vaakarivistä.

Y suhteessa -asetus

A. Objektin yläreunan tasaaminen sivun yläreunaan B. Objektin alareunan tasaaminen sivun alareunaan 

Siirtää objektia ylös tai alas. Positiiviset arvot siirtävät objektia alaspäin.

Pitää objektin tekstipalstan sisällä, kun tekstin sijoittaminen uudelleen siirtäisi sen rajojen ulkopuolelle.
Tällöin objektin alareuna tasataan alavierukseen tai sen yläreuna tasataan ylävierukseen. Ankkuroitu objekti on esimerkiksi sijoitettu sopivaan
kohtaan tekstirivin viereen palstan keskelle, mutta jos tätä asetusta ei ole valittu ja ankkurimerkki siirtyy palstan alaosaan, objekti saattaa siirtyä
palstan reunan alapuolelle tai osittain sivun ulkopuolelle. Kun tämä asetus on valittuna, objektia ei voi vetää palstan rajojen ylä- tai alapuolelle. Jos
muokkaat objektin kokoa, se tasataan tarvittaessa automaattisesti palstan ylä- tai alarajaan. Tämä asetus on käytössä vain, jos olet valinnut
Y suhteessa -kohdassa riviasetuksen, kuten Rivi (Perusviiva).

kun InDesign ohittaa objektin sijaintiasetuksen, jotta se pysyy palstan rajojen sisällä, määrittämäsi Y-siirtymän arvon kohdalla näkyy
valintaikkunassa plusmerkki (+).
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Estä manuaalinen sijoittelu

Esikatselu

Alkuun

Varmistaa, että et voi siirtää ankkuroitua objektia sivulla vetämällä tai siirtämällä sitä nuolinäppäimillä.

Näyttää sijainnin säädöt sivulla, kun muokkaat niitä.

Mukautettuja sijaintiasetuksia käyttävän ankkuroidun objektin sijoittaminen

Huomaa seuraavat seikat, kun sijoitat mukautettuja asetuksia käyttäviä ankkuroituja objekteja Ankkuroidun objektin asetukset -valintaikkunassa.

Mukautetut sijaintiasetukset sisältävät neljä pääasetusta: kaksi viitepistesijaiskuvaa sekä X suhteessa- ja Y suhteessa -valikot. Objektin sijainti
määritetään yhdessä kaikilla näillä asetuksilla. Esimerkiksi valitsemasi X suhteessa- ja Y suhteessa -asetukset määrittelevät, mitä
ankkuroidun sijainnin viitepiste kuvaa. Viitepiste voi olla tekstikehys, palstan sisällä oleva tekstirivi tai koko sivu. Seuraavasta kuvasta näet,
miten voit muuttaa objektin sijaintia valitsemalla eri viitepisteen muuttamatta X suhteessa- ja Y suhteessa -asetuksia.

Ankkuroidun objektin sijainnin muuttaminen (X suhteessa -asetus: Tekstikehys, Y suhteessa -asetus: Rivi (Perusviiva))

A. Valittuna ankkuroidun objektin sijaiskuvassa piste oikealla alhaalla ja ankkuroidun sijainnin sijaiskuvassa piste vasemmalla keskellä. B.
Ankkuroidun objektin sijaiskuvan piste on muutettu vasempaan yläkulmaan ja ankkuroidun sijainnin sijaiskuvan piste on jätetty vasemmalle
keskelle. C. Ankkuroidun objektin sijaiskuvan piste on jätetty vasempaan yläkulmaan ja ankkuroidun sijainnin sijaiskuvan piste on muutettu oikealle
keskelle.

Jos haluat luoda ankkuroidun objektin, joka pysyy sivulla paikallaan tekstin siirtyessä (esimerkiksi vasemmassa yläkulmassa) ja siirtyy vain
tekstin siirtyessä seuraavalle sivulle, ankkuroi objekti sivun reunuksiin tai reunoihin. Määritä esimerkiksi X suhteessa- ja Y suhteessa -

asetuksiksi Sivun reunus ja napsauta sitten objektin vasemman yläkulman viitepistettä  ja sivukohteen vasemman yläkulman viitepistettä 

. Kun teksti siirtyy, objekti pysyy vasemmassa yläkulmassa sivun reunusten sisäpuolella. Objekti siirtyy seuraavan sivun vasempaan
yläkulmaan vasta, kun ankkurin sisältävä tekstirivi siirtyy toiselle sivulle.
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Alkuun

Ankkuroidun objektin sijoittaminen tiettyyn sivun kohtaan

A. Objektin sijoittaminen valitsemalla X/Y suhteessa -asetuksiksi Sivun reunus tai Sivun reuna B. Tekstin siirtyessä objekti pysyy paikoillaan,
kunnes teksti siirtyy toiselle sivulle.

Jos haluat objektin pysyvän tasattuna tiettyyn tekstiriviin siten, että objekti seuraa tekstiä sen siirtyessä, valitse Y suhteessa -valikosta Rivi.

Jos haluat objektin pysyvän tekstikehyksen sisällä, mutta ei seuraavan tiettyä tekstiriviä sen siirtyessä, valitse X suhteessa -valikosta
Tekstikehys.

Jos haluat, että objekti tasataan suhteessa reunukseen (esimerkiksi sivupalkki, joka pysyy tekstin siirtyessä aina sivun ulkoreunassa), valitse
Suhteessa selkään.

1. Valitse ensin objekti ja sitten Objekti > Ankkuroitu objekti > Asetukset.

2. Valitse Sijainti-valikosta Mukautettu.

Jos haluat nähdä, miten objekti siirtyy sivulla määrittäessäsi asetuksia, valitse valintaikkunan alareunasta Esikatselu.

3. Jos haluat pitää objektin sivun samassa reunassa julkaisun selkään nähden, valitse Suhteessa selkään. Valitse tämä asetus, jos haluat, että
objekti on aina esimerkiksi sivun ulkoreunassa huolimatta siitä, kummalla aukeaman sivulla se on.

4. Napsauta ankkuroidun objektin viitepisteen sijaiskuvassa  pistettä, joka vastaa objektin kohtaa, jonka haluat tasata sivulla.

5. Valitse X suhteessa -valikosta sivukohde, jonka perusteella haluat määrittää objektin vaakatasauksen. Valitse esimerkiksi Tekstikehys ja
tasaa objekti tekstikehyksen vasempaan tai oikeaan reunaan tai sen keskelle.

6. Valitse Y suhteessa -valikosta sivukohde, jonka perusteella haluat määrittää objektin pystytasauksen. Jos esimerkiksi haluat tasata objektin
sen ankkurimerkin sisältävän tekstin perusviivaan, valitse Rivi (Perusviiva).

7. Napsauta ankkuroidun sijainnin viitepisteen sijaiskuvassa  pistettä, joka vastaa X/Y suhteessa -valikossa valittujen sivukohteiden sisällä
olevaa objektin tasauskohtaa.

8. Siirrä objektia poispäin tasauspisteestä määrittämällä X-siirtymä tai Y-siirtymä.

9. Jos haluat varmistaa, että objekti ei ylitä palstan ylä- tai alarajaa tekstin siirtyessä, valitse Pidä palstan ylä- tai alarajojen sisällä. Tämä asetus
on käytössä vain, jos olet valinnut Y suhteessa -valikosta riviasetuksen, kuten Rivi (Perusviiva).

10. Napsauta OK-painiketta.

Ankkuroitujen objektien käyttäminen vetämällä ja pudottamalla (CS5.5)

Ankkuroitujen objektien käyttäminen vetämällä ja pudottamalla (CS5.5)
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Alkuun

Huomautus:

Alkuun

Alkuun

Huomautus:

Voit vetää olemassa olevan objektin tekstikehykseen ankkurointia tai siirtämistä varten. Valitse objekti valintatyökalulla  tai suoravalintatyökalulla 
 ja vedä sen jälkeen tekstikehyksen oikean yläkulman lähellä olevaa sinistä ruutua. Tee jokin seuraavista:

Ankkuroi olemassa oleva objekti vetämällä sininen ruutu paikkaan, jossa haluat objektin ankkurin näkyvän.

Jos haluat luoda sidotun objektin, paina Vaihto-näppäintä ja vedä sininen ruutu paikkaan, jossa haluat objektin näkyvän.

Jos haluat määrittää ankkuroidun objektin asetukset, paina Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) ja vedä sininen ruutu
paikkaan, jossa haluat objektin ankkurin näkyvän.

Ankkuroitujen objektien valitseminen ja kopioiminen

Voit valita valintatyökalulla vain yhden ankkuroidun objektin kerrallaan. Voit valita tekstityökalulla tekstialueen, joka sisältää useita ankkurimerkkejä.
Kun valitset tekstityökalulla useita ankkurimerkkejä, voit muuttaa kaikkien ankkuroitujen objektien sijaintiasetuksia samanaikaisesti.

jos samassa paikassa on useita ankkuroituja objekteja (jos esimerkiksi yhdellä tekstirivillä on kaksi ankkuroitua objektia, joilla on
samat ankkurointiominaisuudet), objektit menevät päällekkäin.

Kun kopioit objektin ankkurimerkin sisältävän tekstin, kopioit samalla ankkuroidun objektin. Jos kopioit ankkuroidun objektin ja liität sen tekstin
ulkopuolelle, ankkuroitu objekti muuttuu itsenäiseksi kuvaksi, jota ei ole linkitetty tekstiin.

Objektien ankkurimerkkien näyttäminen sivulla

Jos haluat tarkastella ankkureita ja niiden suhdetta sivun tekstiin, voit näyttää objektien merkit. Tee jokin seuraavista:

Näytä ankkurimerkit  tekstissä valitsemalla Teksti > Näytä piilomerkit.
Näytä katkoviiva ankkurimerkistä siihen liittyvään mukautettuja asetuksia käyttävään objektiin valitsemalla ensin objekti ja sitten Näytä >
Ekstrat > Näytä tekstiketjut. Viiva yhdistää ankkurimerkin ja ankkuroidun objektin sijaiskuvapisteeseen.
Näytä ankkurisymbolit  ankkuroiduissa objekteissa valitsemalla Näytä > Ekstrat > Näytä kehyksen reunat. Kun ankkurisymbolit ovat
näkyvissä, voit todeta helposti, mitkä objektit on ankkuroitu.

Ankkuroidun objektin siirtäminen sivulla manuaalisesti

Kehyksen siirtäminen siirtää myös sen ankkuroituja objekteja, mikäli objektia ei ole sijoitettu suhteessa reunuksiin tai sivuihin.

varmista ennen ankkuroidun objektin siirtämistä, että olet poistanut objektin Estä manuaalinen sijoittelu -asetuksen valinnan
Ankkuroidut objektit -valintaikkunasta tai valinnut Objekti > Poista paikan lukitus.

Tee jokin seuraavista:

Siirrä tekstiin sidottuja ankkuroituja objekteja valitsemalla objekti valintatyökalulla  tai suoravalintatyökalulla  ja vetämällä sitä
pystysuunnassa. Tekstiin sidottuja objekteja voi siirtää vain pystysuunnassa, ei vaakasuunnassa.

Jos haluat siirtää tekstiin sidotun tai rivin yläpuolella olevan objektin kehyksen ulkopuolelle, muunna se mukautetuksi objektiksi ja siirrä se
haluamaasi kohtaan.

Siirrä tekstiin sidottuja ankkuroituja objekteja valitsemalla objekti valintatyökalulla tai suoravalintatyökalulla ja vetämällä sitä
pystysuunnassa vaakasuuntaisessa kehyksessä tai vaakasuunnassa pystysuuntaisessa kehyksessä. Vaakasuuntaisessa tekstissä
tekstiin sidottuja objekteja voi siirtää vain pystysuunnassa, ei vaakasuunnassa. Pystysuuntaisessa tekstissä tekstiin sidottuja objekteja voi
siirtää vain vaakasuunnassa.
Siirrä tekstiin sidottua ankkuroitua objektia perusviivan suuntaisesti siirtämällä kohdistin objektin eteen tai taakse ja määrittämällä uusi
välistysarvo.

Jos haluat siirtää tekstiin sidotun tai rivin yläpuolella olevan objektin kehyksen ulkopuolelle, muunna se mukautetuksi objektiksi ja siirrä se
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Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Alkuun

Huomautus:

Alkuun

Huomautus:

haluamaasi kohtaan.

Siirrä mukautettuja ankkuroituja objekteja valitsemalla objekti valintatyökalulla tai suoravalintatyökalulla ja vetämällä sitä pysty- tai
vaakasuunnassa.

Voit myös kiertää tai muuntaa ankkuroitua objektia. (Katso Objektien muuntaminen ja Objektien kiertäminen.)

Ankkuroidun objektin koon muuttaminen

Varmista ennen ankkuroidun objektin koon muuttamista, että olet poistanut Estä manuaalinen sijoittelu -asetuksen valinnan Ankkuroidun objektin
asetukset -valintaikkunasta.

Valitse objekti valintatyökalulla  tai suoravalintatyökalulla  ja vedä sen sivu- tai kulmakahvaa.

Jos tekstiin sidottujen tai rivin yläpuolella olevien ankkurimerkkien kokoa muokataan pystysuunnassa, objekti saattaa muuttua
ylijuoksevaksi. Jos ankkurimerkki on ylijuokseva, objekti on ylijuokseva.

Ankkuroidun objektin koon muuttaminen saattaa myös siirtää objektia. Jos esimerkiksi olet tasannut objektin oikean reunan tekstikehyksen
vasempaan reunaan ja vedät sitten objektin oikeaa sivukahvaa 1 pican vasemmalle (poispäin tekstikehyksen rajasta), objektin koko muuttuu ja se
siirtyy 1 pican oikealle.

Ankkuroidun objektin vapauttaminen

Jos et halua, että objekti siirtyy suhteessa siihen yhdistettyyn tekstiin, voit poistaa objektin ankkurin vapauttamalla sen.

Valitse ankkuroitu ensin objekti valintatyökalulla ja sitten Objekti > Ankkuroitu objekti > Vapauta.

Objektin sijainti sivulla ei muutu.

Vapauttaminen ei toimi tekstiin sidottujen tai rivin yläpuolella olevien objektien kohdalla. Jos et voi käyttää vapautustoimintoa,
valitse ankkuroitu objekti ja leikkaa ja liitä se. Voit myös valita ja leikata ankkuroidun objektin tekstityökalulla.
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Artikkelit (CS 5.5)

Alkuun

Huomautus:

Alkuun

Alkuun

Johdanto artikkeleihin
Artikkelin luominen ja sisällön lisääminen siihen
Julkaisun kaikkien sivukohteiden lisääminen artikkeliin
Artikkeleiden hallinta
Artikkeleiden sisällyttäminen vientiä varten

Johdanto artikkeleihin

Artikkelit tarjoavat helpon tavan luoda sivukohteiden välisiä suhteita. Näiden suhteiden avulla voidaan määrittää EPUB- ja HTML-muotoon tai
helppokäyttöisiin PDF-tiedostoihin vietävä sisältö ja sisällön järjestys. Voit luoda artikkeleita sivuasettelussa olevista sivukohteista, kuten kuvista,
grafiikasta tai tekstistä. Artikkelin luonnin jälkeen sivukohteita voidaan lisätä, poistaa tai järjestellä. Artikkeleita voidaan luoda manuaalisesti
vetämällä yksi tai useampi sivukohde Artikkelit-paneelissa olevaan artikkeliin.

Voit myös lisätä sisältöjoukon artikkeliin. Artikkeliin voidaan lisätä valikoitua sisältöä tai dokumentin koko sisältö.

XML-rakennepaneeli sisältää toisen mekanismin EPUB- ja HTML-muotoisiin tai helppokäyttöisiin PDF-tiedostoihin vietävän sisällön
järjestyksen määrittämiseen. Artikkelit-paneeli on suunniteltu XML:ään perehtymättömiä käyttäjiä ajatellen entistä yksinkertaisemmaksi,
helppokäyttöisemmäksi ja helppopääsyisemmäksi. XML-rakennepaneelin käyttömahdollisuutta ei ole poistettu, mutta se on nyt valinnainen toiminto,
kuten artikkelipaneelin käyttö vientiprosessin aikana. Katso Julkaisun jäsenteleminen XML-muotoon.

Artikkelin luominen ja sisällön lisääminen siihen

1. Avaa Artikkelit-paneeli valitsemalla Ikkuna > Artikkelit.

2. Valitse artikkeliin lisättävät sivukohteet.

Jos haluat luoda tyhjän artikkelin, älä valitse sivuasettelusta sivukohdetta.

3. Tee jokin seuraavista:

Valitse Artikkelit-paneelin valikosta Uusi artikkeli.

Napsauta Artikkelit-paneelin alaosassa Luo uusi artikkeli -painiketta.

Vedä juttu tai sivuelementti Artikkelit-paneeliin.

4. Kirjoita Uusi Artikkeli -valintaikkunaan artikkelin nimi.

5. Valitse Sisällytä vietäessä, jos haluat lisätä artikkelin EPUB/HTML-vientitiedostoon.

Julkaisun kaikkien sivukohteiden lisääminen artikkeliin

Lisää kaikki sivukohteet artikkeliin seuraavasti:

1. Avaa Artikkelit-paneeli valitsemalla Ikkuna > Artikkelit.

2. Valitse artikkeli, johon haluat lisätä kohteet. Jos et valitse artikkelia, luodaan uusi artikkeli.

3. Paina Command (Mac OS) tai Ctrl (Windows) ja valitse sitten Artikkelit-paneelista .

4. Jos Uusi Artikkeli -valintaikkuna avautuu, anna artikkelin nimi.

5. Valitse Sisällytä vietäessä, jos haluat lisätä artikkelin EPUB/HTML-vientitiedostoon.

Jos olet valinnut artikkelin, valitse Artikkelit-paneelin valikosta Lisää julkaisun sisältö valittuihin artikkeleihin.
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Alkuun

Alkuun

Artikkeleiden hallinta

Voit hallita artikkeleita Artikkelit-paneelissa. Voit lisätä sivuelementtejä artikkeliin vetämällä ne Artikkelit-paneeliin. Vedä kohteet Artikkelit-paneeliin,
jos haluat muuttaa niiden järjestystä tai siirtää ne yhdestä artikkelista toiseen.

Artikkelit-ponnahdusvalikko sisältää myös sisällön hallintaan tarkoitettuja toimintoja.

Artikkeleiden sisällyttäminen vientiä varten

Voit luoda artikkeleita ja valita, mitkä niistä sisällytetään EPUB- tai HTML-muotoon vietäessä. Oletusarvoisesti kaikki artikkelit valitaan vientiä
varten.

Jos haluat sisällyttää artikkelin vientiin, valitse artikkeli Artikkelit-paneelista ja tee jokin seuraavista toimista:

Valitse artikkelin vieressä oleva valintaruutu.

Valitse Artikkelit-paneeliponnahdusvalikosta Artikkelin asetukset ja sitten Sisällytä vietäessä.
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Alkuun

Alkuun

Leveydeltään joustavat sarakkeet
Pysyvät tekstikehyksen sovitusasetukset

Leveydeltään joustavat sarakkeet

Joustava leveys -asetuksen avulla voidaan säätää sarakkeiden määrää ja leveyttä tekstikehyksen kokoa muutettaessa. Sarakkeita lisätään tai
poistetaan automaattisesti, kun sarakkeiden enimmäisleveys saavutetaan tekstikehyksen kokoa muutettaessa.

A. Alkuperäinen tekstikehys B. Tekstikehyksen leveys lisääntyy C. Tekstikehykseen lisätään sarake 

Valitse asetus Joustava leveys Tekstikehyksen asetukset -valintaikkunan Sarakkeet-luettelosta (Objekti > Tekstikehyksen asetukset).

Leveydeltään joustavat sarakkeet

Pysyvät tekstikehyksen sovitusasetukset

Automaattisesti kokoaan muuttavien tekstikehysten asetusten avulla voit määrittää tekstikehyksen niin, että sen kokoa muutetaan automaattisesti,
kun lisäät, poistat tai muokkaat tekstiä. Voit avata automaattisesti kokoaan muuttavien tekstikehysten asetukset seuraavasti:

1. Valitse tekstikehys ja sitten Objekti > Tekstikehyksen asetukset.
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2. Valitse Muuta kokoa automaattisesti.

Autom. koon muuttamisen asetukset

3. Valitse tekstiä lisättäessä tai poistettaessa käytettävä automaattinen kokoasetus:

Ei käytössä
Vain korkeus
Vain leveys
Korkeus ja leveys
Korkeus ja leveys (säilytä mittasuhteet)

4. Valitse ankkurivälityspalvelimesta viitesijainti, johon nähden kokoa muutetaan. Ankkurivälityspalvelin näyttää myös sen, miten tekstikehyksen
kokoa muutetaan.

5. Määritä vähimmäiskorkeuteen ja -paksuuteen sekä rivinvaihtoihin liittyvät rajoitukset.
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Oikeinkirjoituksen tarkistaminen ja sanastot

Alkuun

Oikeinkirjoituksen tarkistaminen
Tavutus ja oikolukusanastot

Oikeinkirjoituksen tarkistaminen

Oikeinkirjoituksen tarkistuksen voi kohdistaa valittuun tekstiin, jutun koko tekstiin, julkaisun kaikkiin juttuihin tai kaikkien avoimien julkaisujen kaikkiin
juttuihin. Tuntemattomat, väärin kirjoitetut ja peräkkäin toistuvat sanat (ei ei) sekä mahdolliset isojen kirjainten käyttövirheet korostetaan.
Oikeinkirjoituksen tarkistuksen lisäksi voit käyttää dynaamista oikolukua, joka alleviivaa mahdollisesti väärin kirjoitetut sanat jo tekstiä
kirjoittaessasi.

Kun tarkistat oikeinkirjoituksen, toiminto käyttää tekstille määritetyn kielen sanastoa. Voit lisätä sanoja sanastoon nopeasti.

Oikeinkirjoitusasetusten määrittäminen

1. Valitse Muokkaa > Asetukset > Oikoluku (Windows) tai InDesign > Asetukset > Oikoluku (Mac OS).

2. Tee jokin seuraavista toimista:

Valitse Kirjoitusvirheet, jos haluat etsiä sanat, jotka eivät esiinny käytetyn kielen sanastossa.

Valitse Toistuvat sanat, jos haluat etsiä kahteen kertaan kirjoitetut sanat, kuten on on.

Valitse Pienellä kirjoitetut sanat, jos haluat etsiä sanat (kuten saksa), jotka esiintyvät sanastossa vain isolla alkukirjaimella kirjoitettuna
(Saksa).

Valitse Pienellä kirjaimella alkavat lauseet, jos haluat etsiä pisteen, huutomerkin tai kysymysmerkin jälkeen esiintyvät pienellä kirjoitetut
sanat.

3. Valitse Ota käyttöön dynaaminen oikoluku, jos haluat, että mahdollisesti väärin kirjoitetut sanat alleviivataan tekstiä kirjoittaessasi.

4. Määritä alleviivausväri väärin kirjoitetuille sanoille (sanat joita ei löydy käyttäjän sanastoista), toistuville sanoille (on on) sekä virheellisesti
pienellä kirjaimella alkaville sanoille (nigeria eikä Nigeria) ja virkkeille.

Oikeinkirjoituksen tarkistaminen

1. Jos julkaisu sisältää vieraskielistä tekstiä, valitse teksti ja määritä sitten tekstin kieli Merkki-paneelin Kieli-valikosta.

2. Valitse Muokkaa > Oikeinkirjoitus > Oikeinkirjoituksen tarkistaminen

Oikeinkirjoituksen tarkistaminen alkaa.

3. Jos haluat muuttaa oikeinkirjoituksen tarkistamisaluetta, tee jokin seuraavista toimista ja aloita sitten toiminto valitsemalla Aloita:

Valitse Julkaisu, jos haluat tarkistaa koko julkaisun.Valitse Kaikki julkaisut, jos haluat tarkistaa kaikki avoinna olevat julkaisut.

Valitse Juttu, jos haluat tarkistaa valittuna olevan kehyksen koko tekstin (myös muiden ketjutettujen tekstikehysten tekstin sekä
ylijuoksevan tekstin). Valitse Jutut, jos haluat tarkistaa kaikkien valittujen kehysten jutut.

Valitse Jutun loppuun, jos haluat aloittaa tarkistuksen kohdistimesta.

Valitse Valinta, jos haluat tarkistaa vain valitun tekstin. Tämä vaihtoehto on käytettävissä vain, jos tekstiä on valittuna.

4. Kun ohjelma havaitsee tuntemattoman tai väärin kirjoitetun sanan tai muun virheen, tee jokin seuraavista:

Jatka oikeinkirjoituksen tarkistamista muuttamatta korostettua sanaa valitsemalla Ohita. Jos haluat ohittaa kaikki korostetun sanan
esiintymät, kunnes InDesign käynnistetään uudelleen, valitse Ohita kaikki.

Muuta vain nykyinen esiintymä valitsemalla sana Korjausehdotukset-luettelosta tai kirjoittamalla se Korvaava-kohtaan ja valitsemalla
Muuta. Muuta kaikki sanan esiintymät valitsemalla Muuta kaikki.
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Alkuun

Jos haluat lisätä sanan sanastoon, valitse ensin sanasto Lisää kohteeseen -valikosta ja sitten Lisää.

Valitse Sanasto, jos haluat näkyviin Sanasto-valintaikkunan, jossa voit määrittää kohdesanaston, kielen sekä lisätyn sanan
tavutuskohdat. Jos haluat lisätä sanan kaikkiin sanoihin, valitse Kieli-valikosta Kaikki kielet. Valitse Lisää.

Kirjoitusvirheiden korjaaminen kirjoittamisen aikana

Kun otat käyttöön automaattisen korjauksen, ohjelma voi korjata tyypillisiä kirjoitusvirheitä ja isojen kirjainten käyttöön liittyviä virheitä jo
kirjoittamisen aikana. Automaattinen korjaus ei ole käytössä, ennen kuin olet luonut luettelon usein väärin kirjoitetuista sanoista ja liittänyt niihin
oikean kirjoitusasun.

1. Valitse Muokkaa > Asetukset > Yleiset (Windows) tai InDesign > Asetukset > Yleiset (Mac OS).

2. Valitse Ota automaattinen korjaus käyttöön. (Voit ottaa toiminnon helposti käyttöön tai poistaa sen käytöstä myös valitsemalla Muokkaa >
Oikoluku > Automaattinen korjaus.)

3. Valitse Kieli-valikosta, minkä kielisessä tekstissä automaattisia korjauksia käytetään.

4. Jos haluat korjata isojen kirjainten käyttöön liittyviä virheitä (esimerkiksi Saksa eikä saksa), valitse Korjaa automaattisesti virheet isojen
kirjainten käytössä. Sinun ei tarvitse lisätä isolla alkukirjaimella kirjoitettuja sanoja automaattisen korjausten luetteloon.

5. Jos haluat lisätä luetteloon usein väärin kirjoittamasi sanan, valitse Lisää, kirjoita väärin kirjoitettu sana (kuten "sielä") ja sen oikea
kirjoitusasu ("siellä") ja valitse OK.

6. Jatka väärin kirjoitettujen sanojen lisäämistä ja valitse lopuksi OK.

Jos kirjoitat tekstiin myöhemmin jonkin luetteloon lisätyistä väärin kirjoitetuista sanoista, se korjataan automaattisesti oikean kirjoitusasun
mukaiseksi.

Voit poistaa lisäämäsi automaattisen korjauksen sanat valitsemalla sanan luettelosta ja valitsemalla Poista. Voit muokata automaattisesti korjattuja
sanoja valitsemalla sanan, napsauttamalla Muokkaa-painiketta, kirjoittamalla korjauksen uudelleen ja valitsemalla OK.

Dynaamisen oikoluvun käyttäminen

Kun dynaaminen oikoluku on käytössä, voit korjata kirjoitusvirheitä pikavalikkoa käyttämällä. Mahdollisesti väärin kirjoitetut sanat on alleviivattu
(tekstin kieleen liitetyn sanaston tietojen perusteella). Jos kirjoitat tekstiä eri kielillä, valitse teksti ja määritä oikea kieli.

1. Ota dynaaminen oikoluku käyttöön valitsemalla Muokkaa > Oikoluku > Dynaaminen oikoluku.

Mahdollisesti väärin kirjoitetut sanat alleviivataan julkaisussa.

2. Napsauta alleviivattua sanaa hiiren kakkospainikkeella (Windows) tai napsauta sitä Ctrl-näppäin alhaalla (Mac OS) ja tee jokin seuraavista
toimista:

Valitse korjausehdotus. Jos sana on toistuva tai se on kirjoitettava isolla alkukirjaimella, valitse Poista toistuva sana [sana] tai Kirjoita
isolla alkukirjaimella [sana].

Valitse Lisää [sana] käyttäjän sanastoon. Sana on nyt lisätty automaattisesti nykyiseen sanastoon Sanasto-valintaikkunaa avaamatta,
eikä sana ole muuttunut tekstissä.

Valitse Sanasto. Tämä avaa Sanasto-valintaikkunan, jossa voit valita kohdesanaston, muuttaa tavutuskohtia ja määrittää kielen. Jos
haluat lisätä sanan kaikkiin kieliin, valitse Kaikki kielet kielivalikosta ja valitse sitten Lisää. Sana lisätään valittuun sanastoon, ja se pysyy
tekstissä muuttumattomana.

Valitse Ohita kaikki, jos haluat ohittaa kyseisen sanan esiintymät kaikissa julkaisuissa. Kun InDesign käynnistetään uudelleen, sana
merkitään jälleen väärin kirjoitetuksi.

Jos valitset Ohita kaikki, mutta päätät myöhemmin, ettet haluakaan ohittaa kyseistä sanaa, valitse Sanasto-valintaikkunan
Sanastoluettelo-valikosta Ohitetut sanat ja poista sana luettelosta.

Tavutus ja oikolukusanastot

InDesign tarkistaa useimpien kielten oikeinkirjoituksen ja tavuttaa sanat käyttämällä Proximity-sanastoja. Sanastoja voi mukauttaa lisäämällä niihin
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sanoja. Tekstille voi määrittää eri kieliä. Tällöin InDesign tarkistaa tekstin oikeinkirjoituksen ja tavuttaa tekstin käyttämällä määritetyn kielen
sanastoa. Voit luoda omia sanastoja ja tuoda tai viedä tekstimuotoon tallennettuja sanaluetteloita.

Kun muokkaat sanastoa, luot itse asiassa lisättyjen sanojen (sanat, joita ei vielä ole sanastossa) ja poistettujen sanojen (nykyiset sanaston sanat,
jotka haluat merkitä mahdollisesti väärin kirjoitetuiksi) luetteloita. Voit tarkastella ja muokata lisättyjä, poistettuja ja ohitettuja sanoja (sanat jotka
ohitetaan käynnissä olevassa istunnossa, koska valitsit Ohita kaikki) Sanasto-valintaikkunassa. Voit lisätä sanoja, jotka liittyvät kaikkiin kieliin.
Tästä on hyötyä erityisesti käsiteltäessä sukunimiä, osoitteita ja muita ei-kielikohtaisia asioita.

Jos haluat käyttää InDesignin tai InCopyn aiemman version kielisanastoja, etsi käyttäjän sanastotiedostot (.udc) järjestelmän Etsi-komennolla ja
lisää ne Sanastoasetukset-ikkunassa sanastoluetteloosi.

Sanastojen sanaluetteloiden tallennuspaikat

Oletusarvoisesti tavutus- ja oikolukusääntöjen poikkeukset sijaitsevat julkaisusta erilleen tallennetuissa käyttäjän sanastotiedostoissa
tietokoneessa, johon InDesign on asennettu (sanastotiedostojen tunniste on .clam tai .not). Poikkeusluettelon voi tallentaa myös InDesign-julkaisun
osaksi. Voit lisäksi tallentaa sanaluetteloita julkaisuun, ulkoiseen käyttäjän sanastoon tai molempiin. Aiemmin luotujen sanakirjojen sijainti
näytetään Sanastoasetukset-kohdassa.

Kun tavutuksen poikkeukset tallennetaan julkaisuun, tekstin asettelu on helpompi säilyttää, jos julkaisu siirretään toiseen tietokoneeseen. Tämän
vuoksi voit yhdistää käyttäjän sanaston julkaisuun Sanastoasetuksissa. Voit myös määrittää poikkeusten sijainnin Luo keräilykansio -
valintaikkunassa. (Lisätietoja: Tiedostojen keräily). Tiedoston ulkopuolelle tallennettua poikkeusluetteloa on helppo käyttää monessa julkaisussa.

Jos käyttäjän sanasto on yhdistetty poikkeusluetteloon, koko sanasto lisätään julkaisuun, vaikka sanoja ei käytettäisi siinä. Tämä
kasvattaa julkaisun tiedostokokoa.

Kielten määrittäminen tekstille

Merkki-paneelin Kieli-valikon avulla voit määrittää valitun tekstin kielen. Voit myös määrittää oletuskielen koko julkaisulle tai kaikille uusille
julkaisuille. InDesign sisältää myös kielen lukitustoiminnon, joka estää aasialaisen tekstin kieliasetuksen muuttamisen, kun teksti kuuluu valintaan
ja Kieli-valikosta valitaan muu kuin aasialainen kieli. (Lisätietoja: Tekstin kielen määrittäminen.)

Poikkeussanaluettelot

Voit jättää sanoja tarkistuksen ulkopuolelle. Jos esimerkiksi haluat käyttää vaihtoehtoista kirjoitusasua yleisen sanan (kuten polkupyörä)
kirjoittamiseen esimerkiksi yrityksen nimessä tai jossakin tietyssä julkaisussa, voit oikeinkirjoituksen tarkistusta varten lisätä sanan ohitettavien
sanojen luetteloon. InDesigniin voi luoda erilliset lisäys- ja poistoluettelot kutakin asennettua kieltä varten.

Käyttäjän sanastojen luominen tai lisääminen

Voit luoda käyttäjän sanaston tai lisätä käyttäjän sanastoja aikaisemmista InDesignin tai InCopyn versioista, toisten lähettämistä tiedostoista tai
palvelimelta, johon työryhmäsi käyttäjän sanasto on tallennettu. Lisäämääsi sanastoa käytetään kaikissa InDesign-julkaisuissasi.

1. Valitse Muokkaa > Asetukset > Sanasto (Windows) tai InDesign > Asetukset > Sanasto (Mac OS).

2. Valitse Kieli-valikosta kieli, johon haluat liittää sanaston.

3. Tee jokin seuraavista:

Luo uusi sanasto napsauttamalla Kieli-valikon alapuolella olevaa Uusi käyttäjän sanasto -kuvaketta  . Määritä käyttäjän sanaston (joka
sisältää .udc-tunnisteen) nimi ja sijainti. Valitse Tallenna.

Lisää olemassa oleva sanasto napsauttamalla Lisää käyttäjän sanasto -kuvaketta ja valitsemalla sitten käyttäjän sanastotiedosto,
jonka tunnus on .udc tai .not. Valitse lopuksi Avaa.

Jos et löydä sanastotiedostoa, voit etsiä .udc-tiedostoja järjestelmäsi Etsi-komennolla (käytä hakusanaa *.udc). Kirjoita sijainti ylös ja
yritä uudelleen.

Sanasto lisätään Kieli-valikossa olevaan luetteloon. Voit lisätä sanoja sanastoon oikeinkirjoituksen tarkistuksen aikana tai kun käytät Sanasto-
valintaikkunaa.
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Nykyisen julkaisun oletussanaston määrittäminen

Voit muuttaa oletussanastoa yhdessä julkaisussa tai kaikissa luomissasi uusissa julkaisuissa. Jos aiemmin luodun julkaisun oletussanastoa
muutetaan, muutos ei vaikuta jo luotuun tekstiin tai tekstiin, joka kirjoitetaan aiemmin luotuun tekstikehykseen.

Valitse haluamasi sanasto tietylle tyylille Merkkityyli- tai Kappaletyyli-paneelin avulla. Merkin lisämuotoilut -osiossa näytetään Kieli-valikko.

1. Avaa julkaisu.

2. Valitse työkaluriviltä valintatyökalu ja varmista, että julkaisussa ei ole valittu yhtään kohdetta.

3. Valitse Teksti > Merkki.

4. Valitse haluamasi sanasto Merkki-paneelin avattavasta Kieli-valikosta. Jos Merkki-paneelissa ei näy kielivaihtoehtoa, valitse Näytä asetukset
ja valitse sitten kieli luettelosta.

Oletussanaston valitseminen kaikille uusille julkaisuille

1. Käynnistä InDesign, mutta älä avaa julkaisua.

2. Valitse Teksti > Merkki.

3. Valitse haluamasi sanasto Merkki-paneelin avattavasta Kieli-valikosta. Jos Merkki-paneelissa ei näy kielivaihtoehtoa, valitse Näytä asetukset
ja valitse sitten kieli luettelosta.

Käyttäjän sanastojen poistaminen sekä uudelleen linkittäminen ja järjestäminen

1. Valitse Muokkaa > Asetukset > Sanasto (Windows) tai InDesign > Asetukset > Sanasto (Mac OS).

2. Valitse Kieli-valikosta kieli, johon sanasto kuuluu.

3. Tee jokin seuraavista toimista:

Voit poistaa sanaston luettelosta valitsemalla sen ja napsauttamalla Poista käyttäjän sanasto -kuvaketta . Kullakin kielellä on oltava
vähintään yksi sanasto.

Jos sanaston vieressä on kysymysmerkkikuvake, valitse sanasto, napsauta Linkitä käyttäjän sanasto uudelleen -kuvaketta sekä etsi
ja avaa käyttäjän sanasto.

Voit muuttaa käyttäjän sanastojen järjestystä vetämällä ja pudottamalla sanastoja. Sanastoja tarkistetaan siinä järjestyksessä kuin ne
ovat luettelossa.

Sanojen lisääminen sanastoihin

Jos InDesign näyttää oikeinkirjoituksen tarkistuksen aikana tuntemattoman sanan Tarkista oikeinkirjoitus -valintaikkunassa, valitse ensin sanasto
Lisää kohteeseen -valikosta ja sitten Lisää. Voit myös käyttää Sanasto-valintaikkunaa, kun haluat valita kohdesanaston ja kielen tai kun haluat
ilmaista, kuinka sanat lisätään poikkeusten sanaluetteloon.

1. Valitse Muokkaa > Oikoluku > Käyttäjän sanasto.

2. Valitse Kieli-valikosta kieli. Jokainen kieli sisältää ainakin yhden sanaston. Jos haluat, että sana lisätään kaikkiin kieliin, valitse Kaikki kielet.

3. Valitse Kohde-valikosta, mihin sanastoon sana lisätään. Kohde-valikossa voit tallentaa muutokset ulkoiseen käyttäjän sanastoon tai
avoimeen julkaisuun.

4. Valitse Sanastoluettelo-valikossa Lisätyt sanat.

5. Kirjoita tai muokkaa sanaluetteloon lisättäviä sanoja Sana-kentässä.

6. Näytä sanan oletustavutuskohta valitsemalla Tavutus. Tilde (~) osoittaa mahdolliset tavutuskohdat.

7. Tavutusehdotuksista voi poiketa seuraavasti:

Merkitse sanan paras tai ainoa tavutuskohta yhdellä tildellä (~).
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Merkitse toiseksi paras tavutuskohta kahdella tildellä (~~).

Merkitse huono mutta hyväksyttävä tavutuskohta kolmella tildellä (~~~).

Estä sanan taivuttaminen lisäämällä tilde sanan alkuun.

Lisää varsinaiseen tekstiin tulevien tilde-merkkien eteen kenoviiva (\~).

8. Valitse ensin Lisää ja sitten Valmis. Sana lisätään valittuun Sanastoluetteloon.

Muista, että julkaisujen tavutusasetukset vaikuttavat tavutuskohtiin. Tämän vuoksi sana ei välttämättä katkea odottamastasi
kohdasta. Voit säätää näitä asetuksia valitsemalla Kappale-paneelin valikosta Tavutus-vaihtoehdon. (Lisätietoja: Tekstin tavuttaminen.)

Sanastojen sanojen poistaminen ja muokkaaminen

1. Valitse Muokkaa > Oikoluku > Käyttäjän sanasto.

2. Valitse Kieli-valikosta kieli.

3. Valitse Kohde-valikosta sanasto, josta sana poistetaan. Kohde-valikossa voit valita ulkoisen käyttäjän sanaston tai avoimen julkaisun.

4. Tee Sanastoluettelo-valikossa jokin seuraavista:

Muokkaa valitun Kohde-sanaluettelon lisäysluetteloa valitsemalla Lisätyt sanat.

Muokkaa väärin kirjoitetuiksi merkittyjen sanojen luetteloa valitsemalla Poistetut sanat.

Muokkaa käynnissä olevassa InDesign-istunnossa ohitettavien sanojen luetteloa valitsemalla Ohitetut sanat. Tämä luettelo sisältää kaikki
sanat, joille on valittu Ohita kaikki -asetus.

5. Muokkaa sanaa sanaluettelossa tai valitse ensin sana ja sitten Poista.

6. Valitse Valmis.

Sanaluettelon vieminen

Voit viedä sanaluetteloita tekstitiedostoon (.txt) ja sitten viedä luettelon käyttäjän sanastoon InDesignissa. Tekstitiedoston sanat on erotettava
toisistaan välilyönnillä, sarkaimella tai kappaleen loppumerkillä. Lisättyjä ja poistettuja sanoja voi viedä, mutta ei ohitettuja sanoja, sillä tämä asetus
vaikuttaa vain käynnissä olevaan istuntoon.

1. Valitse Muokkaa > Oikoluku > Käyttäjän sanasto.

2. Valitse Kieli-valikosta kieli ja Kohde-valikosta sanasto, joka sisältää vietäväksi suunnitellun sanaluettelon.

3. Valitse Vie, määritä tiedostonimi ja kohde. Valitse lopuksi Tallenna.

Sanaluettelo tallennetaan tekstitiedostoon. Voit muokata sanaluetteloa millä tahansa tekstieditorilla ja tuoda sitten sanaluettelon. Voit myös lähettää
sanaluettelon toisille käyttäjille, jotka voivat tuoda sen käyttäjän sanastoihinsa.

Sanaluettelon tuominen

1. Valitse Muokkaa > Oikoluku > Käyttäjän sanasto.

2. Valitse Kieli-valikosta kieli ja Kohde-valikosta sanasto.

3. Valitse Tuo, etsi oikolukupoikkeuksien luettelon sisältävä tekstitiedosto ja valitse lopuksi Avaa.

Sanastoasetusten muuttaminen

Sanastoasetuksissa voit määrittää, miten InDesign käsittelee tavutus- ja oikeinkirjoitussanastoja. Useimmat InDesignin kielet tarkistavat
oikeinkirjoituksen ja tavuttavat sanat käyttämällä Proximity-sanastoja. Jos tietokoneeseen on asennettu muun valmistajan tavutus- ja
oikolukukomponentit, käytettävän sanaston voi valita kielikohtaisesti.

Sanastoasetukset-ikkunassa ei voi määrittää tekstin oikeinkirjoituksen tarkistamiseen ja tavuttamiseen käytettävää sanastoa. Sen
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Huomautus:

sijaan ikkunassa määritetään, mitä tavutus- ja oikolukulaajennuksia InDesign käyttää Kieli-kentässä määritetyn kielen yhteydessä. Jos käytössä on
vain oletusarvoinen tavutus- ja oikolukulaajennus, Sanastoasetukset-ikkunassa ei tarvitse muuttaa mitään asetuksia. Jos asennat muiden
valmistajien tavutus- ja oikolukulaajennuksia, ne näytetään ikkunan tavutussovellus- ja oikolukusovellus-valikoiden vaihtoehtoina. Tällöin voit valita
yhdelle kielelle yhden toimittajan tavutus- tai oikolukutoiminnon ja toiselle kielelle toisen toimittajan tuotteet.

1. Valitse Muokkaa > Asetukset > Sanasto (Windows) tai InDesign > Asetukset > Sanasto (Mac OS).

2. Määritä Kieli-kohdassa kieli, jonka asetuksia tai tavutus- tai kielitoimittajaa haluat muuttaa.

3. Luo, lisää tai poista käyttäjän sanastoja. (Lisätietoja: Käyttäjän sanastojen luominen tai lisääminen.)

4. Jos tietokoneeseen on asennettu muu kuin Adoben valmistama tavutuskomponentti, valitse komponentti Tavutus-valikosta.

5. Jos tietokoneeseen on asennettu muu kuin Adoben valmistama oikolukusanastokomponentti, valitse komponentti Oikoluku-valikosta.

6. Valitse jokin seuraavista vaihtoehdoista Tavutuksen poikkeukset -valikon Koosta käyttäen -valikosta:

Jos haluat koostaa tekstin käyttämällä ulkoiseen käyttäjän sanastoon tallennettua tavutuksen poikkeusluetteloa, valitse Käyttäjän
sanasto.

Jos haluat koostaa tekstin käyttämällä julkaisuun tallennettua tavutuksen poikkeusluetteloa, valitse Julkaisu.

Jos haluat koostaa tekstin käyttämällä molempia luetteloita, valitse Käyttäjän sanasto ja julkaisu. Tämä on oletusasetus.

7. Jos haluat lisätä julkaisun poikkeusluetteloon sellaisen poikkeusluettelon, joka on tallennettu ulkoiseen käyttäjän sanastoon, valitse Yhdistä
käyttäjän sanasto julkaisuun.

Jos työskentelet useiden eri kumppaneiden tai asiakkaiden kanssa, haluat ehkä poistaa Yhdistä käyttäjän sanasto julkaisuun -
asetuksen valinnan. Jos esimerkiksi toimit palveluntarjoajana, et varmaankaan halua yhdistää käyttäjän sanastoasi jokaisen asiakkaan
tiedostoon.

8. Jos haluat koostaa kaikki jutut uudelleen asetusten muuttamisen jälkeen, valitse Koosta kaikki jutut uudelleen muutosten jälkeen. Tällöin
InDesign koostaa jutut uudelleen, kun Koosta käyttäen -asetusta on muutettu (vaiheessa 6) tai kun sanoja on lisätty tai poistettu Sanasto-
toiminnolla. Kaikkien juttujen koostaminen uudelleen voi kestää jonkin aikaa sen mukaan, miten paljon julkaisussa on tekstiä.

9. Napsauta OK-painiketta.

Sanastojen käyttäminen työryhmissä

Jos julkaisu tuotetaan ryhmätyönä, kaikkien käyttäjien tietokoneisiin on asennettava ja lisättävä samat mukautetut käyttäjän sanastot, jotta tekstin
tavutus ja oikolukuasetukset olisivat yhdenmukaiset. Voit joko varmistaa, että kaikki lisäävät tietokoneelleen samat sanastot, tai sitten jakaa
käyttäjän sanaston verkkopalvelimen kautta.

Lukkokuvake  osoittaa, että sanasto on lukittu, jolloin sitä voi käyttää, mutta ei muokata. Kun käyttäjän sanasto on tallennettu palvelimelle,
sanaston ensimmäisenä lataava käyttäjä lukitsee tiedoston. Kaikki seuraavat käyttäjät näkevät, että sanasto on lukittu. Tiedostoja voidaan lukita
myös käyttöjärjestelmän kautta, jos tiedosto on vain luku -tyyppiä. Jos jaat käyttäjän sanaston verkkopalvelimen kautta, haluta ehkä lukita
tiedoston, jolloin se on kyllä luettavissa mutta vain järjestelmänvalvoja voi lisätä siihen sanoja.

Varmista, että työryhmässä kaikki käyttävät samaan työasemaan asennettua mukautettua käyttäjän sanastoa eivätkä julkaisun mukana
tallennettua sanastoa. Käyttäjän sanaston voi kuitenkin yhdistää julkaisuun, ennen kuin julkaisu toimitetaan palveluntarjoajalle.

Jos käytössä ei ole verkon samaan työasemaan tallennettua, jaettua käyttäjän sanastoa, etsi käyttäjän sanastotiedostot ja kopioi ne työasemasta
toiseen. Käyttäjän sanakirjojen sijainti näytetään Sanastoasetukset-kohdassa.

Kun jaetun työaseman käyttäjäsanasto on päivitetty, muutokset eivät näy yksittäisissä työasemissa, ennen kuin työasemien käyttäjät
käynnistävät InDesignin uudelleen tai koostavat koko tekstin uudelleen painamalla Ctrl+Alt+/-näppäimiä (Windows) tai komento+ optio+/-
näppäimiä (Mac OS).

Lisää ohjeaiheita
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Tekstin muokkaaminen

Alkuun

Alkuun

Valitse teksti
Piilomerkkien (tulostumattomien merkkien) näyttäminen
Palstan-, kehyksen- ja sivunvaihtojen lisääminen
Juttueditorin käyttäminen
Ehdollisen tekstin käyttäminen

Valitse teksti
 Valitse tekstityökalu ja tee jokin seuraavista toimista:

Valitse merkki, sana tai kokonainen tekstilohko vetämällä palkkikohdistin valittavan kohteen päälle.

Valitse sana kaksoisnapsauttamalla. Sanan ympärillä olevia välilyöntejä ei valita.

Valitse rivi kolmoisnapsauttamalla sitä. Jos Valitse rivi kolmoisnapsauttamalla -asetusta ei ole valittu, kolmoisnapsautus valitsee koko
kappaleen.

Jos Valitse rivi kolmoisnapsauttamalla -asetus on valittu, voit valita koko kappaleen napsauttamalla sitä neljä kertaa.

Koko jutun voi valita viidellä napsautuksella tai napsauttamalla mitä tahansa jutun kohtaa ja valitsemalla Muokkaa > Valitse kaikki.

Jos kehyksen tekstiä ei voi valita, tekstikehys saattaa olla sivupohjan lukitulla tasolla. Yritä poistaa tason lukitus tai käyttää sivupohjaa. Tekstikehys
voi myös olla toisen tekstikehyksen tai läpinäkyvän objektin alla. Lisätietoja: Tekstin valitseminen peitetystä kehyksestä.

Kolmoisnapsauttamisen vaikutusten muuttaminen
1. Valitse Muokkaa > Asetukset > Teksti (Windows) tai InDesign > Asetukset > Teksti (Mac OS)
2. Valitse Valitse rivi kolmoisnapsauttamalla -asetus, jos haluat valita kolmoisnapsauttamalla rivin (oletus). Poista valinta, jos haluat valita

kolmoisnapsauttamalla koko kappaleen.

Tekstin valitseminen peitetystä kehyksestä
1. Ota valintatyökalu  käyttöön, pidä Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) alhaalla ja valitse tekstikehys napsauttamalla

sitä.
2. Valitse tekstityökalu ja napsauta kehystä tai valitse teksti.

Piilomerkkien (tulostumattomien merkkien) näyttäminen
1. Valitse Teksti > Näytä piilomerkit.
2. Jos piilotetut merkit eivät vieläkään näy, poista esikatselutila käytöstä. Valitse Näkymä > Näyttötila > Normaali ja valitse Näkymä

>Päällepainatuksen esikatselu, kun haluat poistaa sen käytöstä.

Tulostumattomat merkit, kuten välilyöntien, sarkainten, kappaleenvaihtojen, hakemistojen ja juttujen loppujen merkit, tulevat näkyviin. Nämä
erikoismerkit näkyvät vain julkaisuikkunassa ja juttueditori-ikkunassa. Ne eivät tulostu paperille eivätkä PDF- tai XML-tiedostoon. Piilomerkit ovat
samanvärisiä kuin tason väri.
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Tulostumattomat merkit piilotettuina (yllä) ja näkyvissä (alla)

Anne Marie Concepcion on tehnyt kattavan erikoismerkkiluettelon. Se on osoitteessa Ilmainen opas InDesignin erikoismerkeistä.

Piilomerkkien luettelo

Piilomerkki Merkitys

Kappaleen loppu

Pakotettu rivinvaihto (rivin loppu)

Väli

Jutun loppu

Tavutusvihje

Sitova yhdysmerkki

Sarkain

Oikealle tasaava sarkain

Sisennä tähän

Lopeta sisäkkäistyyli tähän

Erottaja

em-väli

en-väli

Sitova välilyönti

Sitova välilyönti (kiinteä leveys)

Hieno väli

Kuudennesväli

Kapea väli

Neljännesväli

Kolmannesväli

Välimerkkiväli

Numeroväli

Tasausvälilyönti

Palstanvaihto

Kehyksenvaihto

Sivunvaihto

Pariton sivunvaihto

Parillinen sivunvaihto

Pakotettu rivinvaihto

InCopy-huomautus
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Alkuun

InCopy-huomautus (juttueditorissa)

Sijaintimerkki (vain InCopy)

Hakemistomerkki

Hakemistomerkki (juttueditorissa)

Piilotettu ehdollinen teksti

Piilotettu ehdollinen teksti (juttueditorissa)

Kirjanmerkki tai hyperlinkin kohteen merkki (usein tekstiankkuri)

Kirjanmerkki tai hyperlinkin kohteen merkki (juttueditorissa)

Hyperlinkin kohde (juttueditorissa)

Ristiviitattu kappale

Ristiviittaushyperlinkki (juttueditorissa)

Ankkuroitu objekti

Ankkuroitu objekti (juttueditorissa)

XML-nimiö

XML-nimiö (juttueditorissa)

Alaviite (juttueditorissa)

Taulukko (juttueditorissa)

Muuttuja (juttueditorissa)

Hakemistomerkki (juttueditorissa)

Palstan-, kehyksen- ja sivunvaihtojen lisääminen
Palstan-, kehyksen- ja sivunvaihdot määritetään lisäämällä tekstiin niitä vastaavat erikoismerkit.

1. Napsauta tekstityökalulla kohtaa, johon haluat lisätä vaihdon.
2. Valitse Teksti > Lisää vaihtomerkki ja valitse vaihtomerkki alivalikosta.

Voit lisätä vaihtoja myös numeronäppäimistön Enter-näppäimellä. Lisää palstanvaihto painamalla Enter-näppäintä, kehyksenvaihto painamalla
Enter+vaihtonäppäimiä Ctrl+Enter-näppäimiä (Windows) tai Return+komentonäppäimiä (Mac OS).

Jos haluat poistaa vaihtomerkin, valitse Teksti > Näytä piilomerkit. Tulostumattomat merkit ovat nyt näkyvissä, ja voit valita ja poistaa vaihtomerkin.

Huomautus: Jos vaihto luodaan kappaleasetuksia muuttamalla (esimerkiksi Pitoasetukset-valintaikkunassa), vaihto lisätään käsiteltävän
kappaleen eteen. Jos vaihto lisätään kirjoittamalla erikoismerkki, vaihto sijoittuu heti erikoismerkin jälkeen.

Vaihtoasetukset
Seuraavat asetukset näkyvät Teksti > Lisää vaihtomerkki -valikossa:

Palstanvaihto Tämä siirtää tekstin nykyisen tekstikehyksen seuraavan palstan alkuun. Jos kehyksessä on vain yksi palsta, teksti siirtyy
seuraavaan ketjutettuun kehykseen.
Kehyksenvaihto Tämä siirtää tekstin seuraavaan ketjutettuun tekstikehykseen riippumatta nykyisen tekstikehyksen palsta-asetuksista.
Sivunvaihto Tämä siirtää tekstin seuraavalle sivulle, joka sisältää nykyiseen tekstikehykseen ketjutetun tekstikehyksen.
Pariton sivunvaihto Tämä siirtää tekstin seuraavalle parittomalle sivulle, joka sisältää nykyiseen tekstikehykseen ketjutetun tekstikehyksen.
Parillinen sivunvaihto Tämä siirtää tekstin seuraavalle parilliselle sivulle, joka sisältää nykyiseen tekstikehykseen ketjutetun tekstikehyksen.
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Alkuun

Kappaleen loppu Lisää kappaleen loppumerkin (sama toiminto kuin Enter/Return-näppäimen painaminen).
Pakotettu rivinvaihto Pakottaa rivin vaihtumaan kohdasta, johon merkki lisätään, jolloin aloitetaan uusi rivi, mutta ei uutta kappaletta (vastaa
näppäinkomentoa vaihto+Enter tai vaihto+Return). Pakotettua rivinvaihtoa kutsutaan myös manuaaliseksi rivinvaihdoksi.

Harkinnanvarainen rivinvaihto Osoittaa, mistä kohtaa tekstirivi voidaan katkaista tarvittaessa. Harkinnanvarainen rivinvaihto muistuttaa
tavutusvihjettä, mutta rivinvaihtokohtaan ei lisätä tavuviivaa.
Vaihtoasetukset näkyvät Pitoasetukset-valintaikkunassa ja Kappaletyyliasetukset-valintaikkunassa.

Juttueditorin käyttäminen
Voit muokata tekstiä InDesign-ohjelmassa joko asettelusivulla tai juttueditori-ikkunassa. Kun kirjoitat ja muokkaat tekstiä juttueditori-ikkunassa,
koko jutussa käytetään Asetukset-kohdassa määrittämääsi kirjasinta, kokoa ja välistystä ilman häiritseviä asetteluja tai muotoiluja. Juttueditorissa
voit myös katsella tekstiin tehtyjä jäljitettyjä muutoksia.

Kukin juttu näkyy erillisessä juttueditori-ikkunassa. Kaikki jutun teksti näkyy juttueditorissa, myös ylijuokseva teksti. Voit avata useita juttueditori-
ikkunoita samanaikaisesti, myös saman jutun useaan kertaan. Pystysyvyysviivain ilmaisee kehystä täyttävän tekstin määrän, ja viiva puolestaan
osoittaa, missä teksti on ylijuoksevaa.

Kun muokkaat juttua, muutokset näkyvät asetteluikkunassa. Avoinna olevat jutut näkyvät Ikkuna-valikossa. Et voi luoda uutta juttua juttueditori-
ikkunassa.

Juttueditori-ikkuna
A. Kappaletyylit B. Säädä palstanleveyttä vetämällä jakajaa C. Pystysyvyysviivain D. Ylijuoksevan tekstin osoitin

Voit tarkastella ja muokata taulukoita juttueditorissa, jossa teksti näytetään jaksotetuissa sarakkeissa ja riveillä, jotta sitä on helppo muokata. Voit
laajentaa tai kutistaa taulukoita nopeasti ja päättää, haluatko tarkastella niitä rivi- vai sarakekohtaisesti.

Juttueditorissa näkyy myös lisätty, poistettu tai muokattu teksti, jos otat Jäljitä muutokset -ominaisuuden käyttöön. Lisätietoja on kohdassa
Muutosten jäljittäminen ja tarkasteleminen.

Juttueditorin avaaminen
1. Valitse tekstikehys, sijoita napsauttamalla kohdistin tekstikehykseen tai valitse useita kehyksiä eri jutuista.
2. Valitse Muokkaa > Muokkaa juttueditorissa.

Jos haluat avata toisen samanlaisen juttueditori-ikkunan, aktivoi juttueditori ja valitse Ikkuna > Järjestä > Uusi ikkuna.

Asetteluikkunaan palaaminen
 Tee juttueditorissa yksi seuraavista toimista:

Valitse Muokkaa > Muokkaa sivuasettelunäkymässä. Tätä tapaa käytettäessä asettelunäkymässä näkyy sama tekstin valinta tai kohdistimen
sijainti kuin viimeksi juttueditorissa. Juttueditori-ikkuna jää avoimeksi mutta siirtyy asetteluikkunan taakse.

Napsauta asetteluikkunaa. Juttueditori-ikkuna jää avoimeksi, mutta siirtyy asetteluikkunan taakse.

Sulje juttueditori-ikkuna.

Valitse julkaisun nimi Ikkuna-valikon lopusta.
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Alkuun

Juttueditorin kohteiden näyttäminen tai kätkeminen
Voit näyttää tai piilottaa tyylin nimisarakkeen ja syvyysviivaimen, laajentaa tai kutistaa alaviitteet ja näyttää tai piilottaa uusien kappaleiden alut
ilmaisevat kappalejakomerkit. Nämä asetukset vaikuttavat kaikkiin avoimiin juttueditori-ikkunoihin sekä myöhemmin avattuihin ikkunoihin.

Kun juttueditori on aktiivinen, valitse Näytä > Näytä tyylin nimisarake tai Kätke tyylin nimisarake. Voit myös säätää tyylin nimisarakkeen
leveyttä vetämällä pystysuoraa palkkia. Myöhemmin avatuissa juttueditori-ikkunoissa on sama sarakeleveys.
Kun juttueditori on aktiivinen, valitse Näytä > Juttueditori > Näytä syvyysviivain tai Kätke syvyysviivain.
Kun juttueditori on aktiivinen, valitse Näytä > Juttueditori > Laajenna kaikki alaviitteet tai Kutista kaikki alaviitteet.
Kun juttueditori on aktiivinen, valitse Näytä > Juttueditori > Näytä kappalejakomerkit tai Kätke kappalejakomerkit.

Juttueditorin asetukset
Voit muuttaa juttueditorin ulkoasua Juttueditorin näyttö -asetusten avulla. Vaikka juttueditori näyttää vain tekstin perusmuotoilumääritteet,
esimerkiksi seuraavat objektit ja määritteet kuitenkin näytetään:

Määrite Kuvake

Taulukko

Tekstiin sidotut objektit

XML-nimiöt

Muuttujat

Hyperlinkkien lähteet

Hyperlinkkiankkurit

Ristiviittaus

Piilotettu ehdollinen teksti

Huomautus

Alaviitteet

Hakemistomerkit

Poistettu teksti

Lisätty teksti

Siirretty teksti

Tekstin näyttöasetukset Valitse kirjasin, koko, riviväli, tekstiväri ja tausta. Voit myös valita erilaisen teeman. Jos valitset esimerkiksi Klassinen
Järjestelmä -vaihtoehdon, keltainen teksti näytetään mustalla taustalla. Nämä asetukset vaikuttavat tekstin näyttämiseen juttueditori-ikkunassa. Ne
eivät vaikuta asettelunäkymään.
Ota pehmennys käyttöön Tasoita tekstin epätasaisia reunoja. Valitse jokin seuraavista pehmennystyypeistä: LCD-optimoitu, Pehmeä tai Oletus,
joka käyttää tekstin tasoittamiseen harmaan sävyjä. LCD-optimoitu käyttää tekstin tasoittamiseen värejä harmaan sävyjen sijaan ja toimii parhaiten
vaalealla taustalla sijaitsevan mustan tekstin kanssa. Pehmeä käyttää harmaan sävyjä mutta tuottaa vaaleamman ja sumeamman ulkoasun kuin
oletusasetus.
Kohdistinasetukset Muuta tekstikohdistimen ulkoasua. Valitse esimerkiksi Vilkuta, jos haluat kohdistimen vilkkuvan.
Sisäisten kehysten teksti ei näy ylemmän tason juttueditori-ikkunassa, mutta se voi näkyä omassa juttueditori-ikkunassaan.

Ehdollisen tekstin käyttäminen
Ehdollinen teksti on kätevä tapa luoda eri versioita samasta julkaisusta. Kun olet luonut ehdot, voit ottaa niitä käyttöön tekstin eri alueilla. Voit
sitten luoda eri versioita julkaisuista näyttämällä ja piilottamalla ehtoja. Jos olet esimerkiksi luomassa tietokoneen käyttöopasta, voit luoda eri ehdot
Mac OS- ja Windows-järjestelmille. Ennen käyttöoppaan Mac OS -version tulostamista voit näyttää kaiken "Mac"-ehdolla määritetyn tekstin ja
piilottaa kaiken "Windows"-ehdolla määritetyn tekstin. Voit sitten vaihtaa valinnat toisin päin, kun tulostat Windows-käyttöoppaan.
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Ehdollinen teksti näkyvissä
A. Kaikki ehdot näkyvissä B. Ehtoilmaisimet

Ehdollinen teksti piilotettu
A. "Mac"-ehto piilotettu B. Piilotetut ehtosymbolit

Ehtoja voi soveltaa vain tekstiin. Voit tehdä ankkuroiduista objekteista ehdollisia, mutta vain valitsemalla ankkuroidun objektin merkin. Voit ottaa
ehdot käyttöön taulukon soluissa olevassa tekstissä, mutta ehtoja ei voi ottaa käyttöön taulukon soluissa, sarakkeissa tai riveillä. Et voi ottaa ehtoja
käyttöön lukittujen InCopy-juttujen tekstissä.

Voit katsoa ehdollista tekstiä käsittelevän videon osoitteessa www.adobe.com/go/lrvid4026_id_fi.

Ehdollisten julkaisujen suunnitteleminen
Kun suunnittelet projekteihin ehdollista tekstiä, tutustu materiaalin luonteeseen ja perehdy siihen, miten useat henkilöt voivat käyttää sitä, jos
julkaisu jaetaan. Käsittele ehdollista tekstiä yhdenmukaisesti, jotta julkaisua on helpompi käyttää ja ylläpitää. Noudata seuraavia ohjeita.

Versioiden määrä Määritä, kuinka monta versiota viimeistellyssä projektissa on. Jos esimerkiksi luot käyttöopasta, jossa on kuvaus sekä
Windows- että Mac OS -järjestelmässä toimivasta ohjelmasta, voit halutessasi laatia oppaasta vähintään kaksi versiota: Windows-version ja Mac
OS -version. Jos haluat lisätä näihin versioihin toimituskommentteja tarkistusvaiheessa, tarvitset vielä enemmän versioita: Mac OS ja kommentit,
Mac OS ilman kommentteja, Windows ja kommentit ja Windows ilman kommentteja.
Jos julkaisussa on paljon ehtoja, voit määrittää ehtoyhdistelmiä, jotka voidaan ottaa käyttöön julkaisussa pikaista versiointia varten.

Tarvittavien ehdollisten nimiöiden määrä Päätä, kuinka monta ehdollisten nimiötä tarvitset halutun versiomäärän laatimiseksi. Julkaisun versio
määritetään ainutkertaisella ehdollisten nimiöiden yhdistelmällä. Esimerkiksi viimeistelty Windows-oppaan versio voidaan määrittää näyttämällä
ehdollinen Windows-nimiö, piilottamalla ehdollinen Mac OS -nimiö ja piilottamalla ehdollinen Kommentit-nimiö. Tässä esimerkissä on päätettävä,
käytetäänkö yhtä ehdollista nimiötä Windows-kommenteille ja toista Mac OS -kommenteille vai käytetäänkö yksittäistä ehdollista nimiötä sekä
Windows- että Mac OS -kommenteille.
Sisällön järjestäminen Arvioi, kuinka pitkälle julkaisua voi ehdollistaa ja miten voit järjestää materiaalin kehitystä ja ylläpitoa helpottavalla tavalla.
Voit esimerkiksi järjestää kirjan siten, että ehdollinen teksti on rajoitettu muutamaan julkaisuun. Voit myös halutessasi pitää tietyn kappaleen versiot
eri tiedostoissa ehdollisen tekstin sijaan ja käyttää sitten eri kirjatiedostoa kullekin kirjan eri versiolle.
Joissakin tilanteissa, kuten useita kieliä käsiteltäessä, voi olla kätevämpää luoda ehtojen käyttämisen sijaan erillisiä tasoja siten, että kukin taso
sisältää yhden kieliversion ja voit näyttää tai piilottaa tasoja tarpeen mukaan.

Nimiöintistrategia Määritä ehdollisen tekstin pienin yksikkö. Jos esimerkiksi julkaisu käännetään toiselle kielelle, yhden kokonaisen lauseen
kannattaa olla pienin tekstimäärä, josta tehdään ehdollista. Koska sanajärjestys usein vaihtuu käännöksessä, lauseen osan käyttäminen
ehdollisena tekstinä saattaa vaikeuttaa kääntämistä.
Jos ehtoja ei käytetä yhdenmukaisesti välilyönteihin ja välimerkkeihin, tuloksena voi olla ylimääräisiä välilyöntejä tai väärinkirjoitettuja sanoja.
Päätä, teetkö välilyönneistä ja välimerkeistä ehdollisia. Jos ehdollinen teksti alkaa tai loppuu välimerkkiin, tee myös välimerkeistä ehdollisia. Tämä
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helpottaa tekstin lukemista, kun tarkastelet useita versioita.

Voit välttää sanojen välitysongelmat, kuten ehdollista väliä seuraavan ehdottoman välilyönnin, määrittämällä standardeja ehdollista tekstiä
seuraavien välilyöntien käsittelemiseen (joko aina ehdollisia tai aina ehdottomia).

Voit välttää sekaannukset päättämällä, missä järjestyksessä ehdollinen teksti näkyy, ja käyttämällä tätä järjestystä koko julkaisussa.

Hakemistot ja ristiviittaukset Kun luot hakemistoa julkaisulle, kiinnitä huomiota siihen, onko hakemistomerkit asetettu ehdollisen tekstin sisä- vai
ulkopuolelle. Muista, että piilotetussa ehdollisessa tekstissä olevia hakemistomerkkejä ei lisätä muodostettuun hakemistoon.
Jos luot ristiviittauksen ehdolliseen tekstiin, varmista, että lähdetekstillä on sama ehto. Jos esimerkiksi lisäät ristiviittauksen Windows-kappaleeseen
ja tekstiankkuri näkyy Mac-ehdossa, ristiviittaus jää ratkaisematta, kun Mac-ehto on piilotettu. Merkintä PT tulee näkyviin ristiviittauksen viereen
Hyperlinkit-paneeliin.

Jos luot ristiviittauksen kappaleeseen, jossa osa tekstistä on ehdollista, ja sitten muutat kyseisen ehdon näkyvyysasetuksia, päivitä ristiviittaus.

Ehtojen luominen
Luomasi ehdot tallennetaan valittuun julkaisuun. Jos julkaisuja ei ole avoinna, kun luot ehdon, kyseinen ehto tulee näkyviin kaikkiin uusiin luomiisi
julkaisuihin.

Ehdollinen teksti on helppo tunnistaa määrittämällä ehdon osoittimia, kuten punaisia aaltoviivoja alaviivoina.

1. Voit tuoda Ehdollinen teksti -paneelin näyttöön valitsemalla Ikkuna > Teksti ja taulukot > Ehdollinen teksti.
2. Valitse Uusi ehto Ehdollinen teksti -paneelin valikosta ja kirjoita ehdolle nimi.
3. Määritä Osoitin-ryhmässä sen osoittimen ulkoasu, johon ehtoa sovelletaan.

Osoittimet (kuten punaiset aaltoviivat) näkyvät oletusarvoisesti julkaisussa, mutta niitä ei tulosteta. Voit valita Ehdollinen teksti -paneelin
Osoittimet-valikosta asetuksen, jolla voit piilottaa osoittimet tai tulostaa ne, mistä voi olla hyötyä tarkistusvaiheessa.

4. Valitse OK.

Ehtojen käyttäminen tekstissä
Samaan tekstiin voi soveltaa useita ehtoja. Ehto-osoittimet ilmaisevat oletusarvoisesti ehdollisen tekstin. Jos osoittimet on kuitenkin piilotettu, voit
tarkistaa Ehdollinen teksti -paneelista, mitkä ehdot on otettu käyttöön valitussa tekstissä. Valintamerkki ilmaisee, että ehto on otettu käyttöön
valitussa tekstissä. Jos valintamerkki on himmennetty, ehto on otettu käyttöön vain osassa valintaa.

1. Valitse teksti, johon haluat soveltaa ehtoa.
2. Tee Ehdollinen teksti -paneelissa (Ikkuna > Teksti ja taulukot > Ehdollinen teksti) jokin seuraavista toimenpiteistä:

Jos haluat ottaa ehdon käyttöön, valitse ehto tai ehdon nimen vieressä oleva ruutu.

Jos haluat ottaa ehdon käyttöön ja poistaa muut tekstiin sovelletut ehdot, valitse ehto pitämällä Alt-näppäintä (Windows) tai Optio-
näppäintä (Mac OS) painettuna.

Voit poistaa ehdon poistamalla ehdon nimen viereisessä ruudussa olevan valintamerkin. Voit myös poistaa kaikki ehdot valitusta
tekstistä valitsemalla vaihtoehdon [Ehdoton].

Huomautus: Ehdoille ei voi määrittää pikanäppäimiä. Voit kuitenkin ottaa ehtoja käyttöön Nopea käyttö -toiminnolla.

Ehtojen näyttäminen ja piilottaminen
Kun piilotat ehdon, kaikki teksti, johon kyseistä ehtoa sovelletaan, piilotetaan. Ehtojen piilottaminen muuttaa usein julkaisun tai kirjan
sivunumerointia. Älykäs tekstin uudelleenjuoksutus -toiminnolla voit lisätä ja poistaa sivuja automaattisesti ehtoja piilottaessasi ja näyttäessäsi.

Piilotettu ehdollinen teksti ohitetaan yleensä julkaisussa. Piilotettua tekstiä ei esimerkiksi tulosteta eikä viedä, ehdollisesta tekstistä piilotettuja
hakemistomerkkejä ei lisätä muodostettuun hakemistoon eikä piilotettua ehdollista tekstiä sisällytetä tekstihakuihin eikä oikeinkirjoituksen
tarkistukseen.

Kun piilotat ehdon, piilotettu teksti tallennetaan piilotetun ehdon symboliin . Jos valitset piilotetun ehdon symbolin sisältävää tekstiä ja yrität
poistaa sitä, InDesign kehottaa sinua vahvistamaan, että haluat poistaa piilotetun ehdollisen tekstin. Et voi soveltaa muita ehtoja, tyylejä tai
muotoilua piilotetussa ehdollisessa tekstissä.

Jos tekstiin on sovellettu useita ehtoja ja vähintään yksi kyseisistä ehdoista näkyy, kun jokin toinen on piilotettuna, tekstiä ei piiloteta.

Voit näyttää tai piilottaa yksittäisiä ehtoja napsauttamalla ehdon viereistä näkyvyysruutua. Silmäkuvake ilmaisee, että ehto on näkyvissä.
Voit näyttää tai piilottaa kaikki ehdot valitsemalla Ehdollinen teksti -paneelin valikosta Näytä kaikki tai Kätke kaikki.

Ehtojoukkojen käyttäminen
Ehtoyhdistelmä sisältää kaikkien ehtojen näkyvyysasetukset, mikä tarkoittaa, että voit ottaa eri julkaisuversiot käyttöön nopeasti. Oletetaan
esimerkiksi, että käsittelet monimutkaista asiakirjaa, jossa on Mac OS-, Windows XP-, Windows Vista- ja UNIX-alustaehdot, englannin, ranskan,
saksan ja espanjan kieliehdot sekä toimitusehtoja, kuten tarkistusta ja sisäisiä kommentteja. Jos haluat tarkistaa ranskankielisen Vista-version, voit
luoda ehtojoukon, joka näyttää vain Vistan, ranskan kielen ja tarkistustietojen ehdot ja piilottaa muut osat.

Vaikka joukkoja ei välttämättä tarvita tämän tekemiseen, ne nopeuttavat eri ehtojen näkyvyysasetusten muuttamista ja tekevät siitä
luotettavampaa.
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1. Sovella ehtoja tekstiin tarpeen mukaan.
2. Jos Joukko-valikko ei ole näkyvissä Ehdollinen teksti -paneelissa, valitse Ehdollinen teksti -paneelin valikosta Näytä asetukset.
3. Tuo ehdot näkyviin tai piilota ne Ehdollinen teksti -paneelissa tarpeen mukaan.
4. Valitse Joukko-valikosta Luo uusi joukko, määritä joukolle nimi ja valitse OK.

Uudesta joukosta tulee aktiivinen joukko.

5. Tee jokin seuraavista toimista:

Jos haluat soveltaa ehtojoukkoa julkaisussa, valitse ehtojoukon nimi Joukko-valikosta.

Jos haluat ohittaa ehtojoukon, aktivoi joukko valitsemalla se ja muuta minkä tahansa ehdon näkyvyysasetusta. Ehtojoukon viereen tulee
plusmerkki (+). Voit poistaa ohitukset käytöstä valitsemalla ehtojoukon uudelleen. Valitse Määritä [ehtojoukko] uudelleen, jos haluat
päivittää ehtojoukon uusilla näkyvyysasetuksilla.

Jos haluat poistaa ehtojoukon, valitse ehtojoukko ja sitten Poista [ehtojoukko]. Ehtojoukon poistaminen ei poista joukon ehtoja eikä se
poista ehtoja mistään, missä niitä on käytetty.

Ehtojen hallitseminen
 Tee jokin seuraavista toimista:

Ehdon poistaminen Valitse ehto ja napsauta Ehdollinen teksti -paneelin alaosassa olevaa Poista ehto -kuvaketta. Määritä poistetun ehdon
korvaava ehto ja valitse OK. Määrittämääsi ehtoa sovelletaan kaikkeen tekstiin, johon poistettua ehtoa sovellettiin.
Jos haluat poistaa useita ehtoja, pidä vaihtonäppäintä painettuna ja valitse vierekkäisiä ehtoja tai pidä Ctrl-näppäintä (Windows) tai
komentonäppäintä (Mac OS) painettuna ja valitse muita kuin vierekkäisiä ehtoja. Napsauta sitten Poista ehto -kuvaketta.

Ehdon poistaminen tekstistä Ehtonimiön poistaminen tekstistä poikkeaa julkaisun nimiön poistamisesta. Kun poistat nimiön tekstistä, nimiö
pysyy julkaisussa, jotta se voidaan myöhemmin ottaa uudelleen käyttöön.
Jos haluat poistaa ehdon tekstistä, valitse teksti ja poista valintamerkki napsauttamalla ehdon vieressä olevaa ruutua. Voit myös valita [Ehdoton]-
vaihtoehdon, jos haluat poistaa kaikki ehdot valitusta tekstistä.

Ehtojen lataaminen (tuominen) Valitse Ehdollinen teksti -paneelin valikosta Lataa ehdot (jos haluat ladata vain ehdot) tai Lataa ehdot ja joukot.
Valitse InDesign-julkaisu, josta haluat tuoda ehdot ja valitse Avaa. Ladatut ehdot ja joukot korvaavat kaikki samannimiset ehdot ja joukot.
Et voi ladata ehtoja InDesignissa olevasta InCopy-tiedostosta, mutta voit ladata ehtoja sekä InDesignissa että InCopyssa olevasta InDesign-
tiedostosta.

Ladatut joukot ohittavat Ehdollinen teksti -paneelissa olevat ehtojen näkyvyysasetukset.

Kirjan ehtojen synkronoiminen Voit varmistaa, että käytät samoja ehtoja kaikissa kirjan julkaisuissa, luomalla haluamasi ehdot
tyylilähdejulkaisuun, valitsemalla Synkronointiasetukset-valintaikkunasta Ehdollisen tekstin asetukset -vaihtoehdon ja synkronoimalla kirjan sen
jälkeen.
Ehto-osoittimien näyttäminen ja piilottaminen Voit näyttää tai piilottaa ehto-osoittimet valitsemalla Ehdollinen teksti -paneelin Osoittimet-
valikosta Näytä tai Kätke. Jos näkyvissä on yksi versio ja haluat nähdä, mitkä alueet siitä ovat ehdollisia, näytä ehto-osoittimet. Jos ehto-osoittimet
häiritsevät asettelun tarkastelua, voit piilottaa ne. Valitse Näytä ja tulosta, jos haluat, että ehto-osoittimet tulostetaan.
Ehdon nimen muuttaminen Napsauta Ehdollinen teksti -paneelissa ehtoa, odota hetki ja napsauta sen nimeä uudelleen. Kirjoita jokin toinen
nimi.
Ehto-osoittimien muokkaaminen Kaksoisnapsauta ehtoa Ehdollinen teksti -paneelissa tai valitse ehto ja valitse paneelin valikosta Ehtoasetukset.
Määritä osoitinasetukset ja valitse OK.

Ehdollisen tekstin etsiminen ja muuttaminen
Etsi ja muuta -valintaikkunassa voit etsiä tekstiä, johon on sovellettu vähintään yhtä ehtoa, ja korvata ehdot muilla ehdoilla.

1. Voit näyttää kaiken hakuun sisällytettävän ehdollisen tekstin.

Piilotettu teksti jätetään pois hausta.

2. Valitse Muokkaa > Etsi/Muuta.
3. Jos Etsi muotoilu- tai Muuta muotoilu -kentät eivät näy valintaikkunan alaosassa, napsauta Lisää asetuksia -vaihtoehtoa.
4. Avaa Etsi muotoiluasetukset -valintaikkuna napsauttamalla Etsi muotoilu -kenttää. Kun valitset Ehdot-kohdasta [Mikä tahansa ehto], voit etsiä

tekstiä, johon on sovellettu jotakin ehtoa. Vaihtoehdon [Ehdoton] valitsemalla voit etsiä tekstiä, johon ei ole sovellettu mitään ehtoa. Voit
myös valita tietyn ehdon tai ehdot, joita haluat etsiä. Napsauta OK-painiketta.

Tämä toiminto löytää tekstin, joka vastaa valittuja ehtoja täsmällisesti. Jos valitset esimerkiksi sekä ehdon 1 että 2, tekstiä, johon sovelletaan
vain toista näistä ehdoista, ei löydy. Haku ei myöskään löydä tekstiä, johon sovelletaan näitä kahta ehtoa sekä jotakin muuta ehtoa.

5. Avaa Muuta muotoiluasetukset -valintaikkuna napsauttamalla Muuta muotoilu -kenttää. Määritä jokin toinen muotoiluasetus, kuten ehto tai
merkkityyli, ja valitse sitten OK.

Jos valitset Ehdot-osion Muuta muotoiluasetuksia -valintaikkunasta, [Mikä tahansa ehto] -valinta ei muuta löytynyttä ehdollista tekstiä. Tämä
asetus on hyödyllinen, jos haluat ottaa käyttöön jonkin toisen muotoilun, kuten merkkityylin. Valitse [Ehdoton], jos haluat poistaa kaikki ehdot
löytyneestä tekstistä. Jos valitset jonkin tietyn ehdon, määritä, haluatko sen korvaavan jonkin löytyneeseen tekstiin sovellettavan ehdon vai
haluatko lisätä sen tekstiin.
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6. Napsauta Etsi-painiketta ja korvaa ehto napsauttamalla Vaihda-, Muuta/Etsi- tai Muuta kaikki -painiketta.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Kuvatekstit

Alkuun

Alkuun

Kuvatekstin luominen kuvasta
Kuvatekstin asetusten määrittäminen
Kuvatekstien luominen muuttujilla
Kuvatekstimuuttujien määrittäminen

Kuvateksti on kuvaava teksti, joka näkyy kuvan alla. InDesignissa on useita tapoja luoda kuvatekstejä, joissa näkyy määrittämiäsi kuvan
metatietoja. InDesignissa on erityinen kuvatekstimuuttuja, joka näyttää määrittämiäsi kuvan metatietoja. Jos muuttujan sisältämä tekstikehys on
kuvan vieressä tai ryhmitetty sen kanssa, muuttuja näyttää kyseisen kuvan metatiedot. Voit tuottaa kuvatekstin olemassa olevasta kuvasta tai
samalla, kun sijoitat sen, ja voit luoda kuvatekstimuuttujan sisältävän tekstikehyksen.

Voit katsoa kuvatekstien tuottamista metatiedoista käsitteleviä videoita osoitteissa www.adobe.com/go/lrvid5156_id_fi ja
http://tv.adobe.com/go/4958/.

Kuvatekstin luominen kuvan metatiedoista

Kuvatekstin luominen kuvasta
Kun luot kuvatekstin olemassa olevasta kuvasta, voit tuottaa joko pysyvän kuvatekstin, jota voi muokata vain manuaalisesti, tai käytettävän otsikon,
joka päivittyy automaattisesti, jos kuva tai kuvan metatiedot muuttuvat. Jos esimerkiksi siirrät käytettävän otsikon eri kuvan viereen, kuvateksti
näyttää metatiedot eri kuvasta.

Kun valitset Luo käytettävä otsikko -vaihtoehdon, luodaan automaattisesti uusi muuttuja käytössä olevien kuvatekstiasetusten pohjalta. Jos
esimerkiksi Kuvaus-metatietotyyppi on valittuna Kuvatekstiasetukset-valintaikkunassa, luodaan muuttuja nimeltään Käytettävä metatieto-otsikko:
Kuvaus.

1. Jos haluat määrittää tuottamasi kuvatekstin sisällön ja ulkoasun, valitse Objekti > Kuvatekstit > Kuvatekstiasetukset ja määritä asetukset.
Katso Kuvatekstin asetusten määrittäminen.

2. Valitse Objekti > Kuvatekstit > Luo käytettävä otsikko tai Tuota pysyvä kuvateksti.

Huomautus: Kun luot pitkän tekstijonon sisältävän käytettävän otsikon, kuten Kuvauksen, kuvateksti ei tee rivinvaihdoksia, koska se on muuttuja.
Jos kuvateksti tulee yhdelle riville, harkitse käytettävän otsikon muuntamista pysyväksi kuvatekstiksi. Jos haluat muuntaa käytettävän otsikon
pysyväksi kuvatekstiksi, valitse käytettävä otsikko ja valitse Objekti > Kuvatekstit > Muunna pysyväksi kuvatekstiksi.
Voit myös luoda pysyvän kuvatekstin sijoittaessasi kuvaa. Valitse Sijoita-valintaikkunassa Luo pysyvät kuvatekstit ja sijoita kuvatekstin tekstikehys
kuvan sijoittamisen jälkeen.

Kuvatekstin asetusten määrittäminen
Voit määrittää tuottamasi kuvatekstin sisällön ja muotoilun Kuvatekstiasetukset-valintaikkunassa. Nämä kuvatekstitasetukset vaikuttavat vai
jatkossa luomiisi kuvateksteihin, eivät aikaisemmin luotuihin.

1. Valitse Objekti > Kuvatekstit > Kuvatekstiasetukset.

2. Valitse metatiedot, jotka haluat sisällyttää ja määritä sitten teksti, joka näkyy ennen metatietoja ja niiden jälkeen.

3. Jos haluat sisällyttää useita metatietorivejä, napsauta plus-kuvaketta.

4. Määritä seuraavat asetukset ja valitse OK.

Teksti ennen / Teksti jälkeen Teksti, joka näkyy ennen määritettyjä metatietoja tai niiden jälkeen

Metatiedot Valitse luettelosta metatietovaihtoehto, kuten Kuvaus tai Kaupunki.
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Alkuun

Alkuun

Tasaus Määritä minne haluat sijoittaa kuvatekstin suhteessa kuvaan.

Siirtymä Määritä kuinka kaukana kuvatekstin tulee olla kuvan vieressä olevan tekstikehyksen reunasta.

Kappaletyyli Määritä kuvatekstissä käytettävä kappaletyyli. Jos haluat kuvateksiin automaattisen numeroinnin, kuten "Kuva 1", "Kuva 2" ja
niin edelleen, sisällytä numerointi kappaletyyliin. Lisätietoja: Jatkuvien kuvatekstien luominen kuville ja taulukoille.

Taso Määritä taso, jolle kuvateksti kuuluu.

Ryhmitä kuvateksti kuvaan Määritä ovatko kuvakehys ja kuvatekstin tekstikehys samassa ryhmässä.

Kuvatekstien luominen muuttujilla
Kun kuvatekstimuuttujan sisältämä tekstikehys on kuvan vieressä tai ryhmitetty sen kanssa, kuvatekstimuuttuja näyttää kyseisen kuvan metatiedot.

Kuvatekstimuuttujat
A. Kuvatekstimuuttujan sisältävä tekstikehys, joka ei ole kuvan vieressä B. Kuvan viereen siirretty tekstikehys

1. Määritä tarvittaessa kuvatekstimuuttuja, jota haluat käyttää. Katso Kuvatekstimuuttujien määrittäminen.

2. Luo kuvatekstille tekstikehys.

3. Kun lisäyskohta on tekstikehyksessä, valitse Teksti > Tekstimuuttujat > Lisää muuttuja ja valitse sitten kuvatekstimuuttuja, jonka haluat
sisällyttää. Lisää niin monta kuvatekstimuuttujaa kuin tarvitset.

4. Siirrä kuvatekstin tekstikehystä siten, että se on kuvakehyksen vieressä, tai ryhmitä kuvatekstin tekstikehys kuvakehyksen kanssa.

Jos kuvatekstimuuttuja on tyhjä, muokkaa kuvan metatietoja ja päivitä sitten kuva Linkit-paneelista. Jos haluat muokata kuvan metatietoja, katso
Kuvatiedoston metatietojen muokkaaminen.

Kuvatekstimuuttujien määrittäminen
Kuvatekstimuuttujat päivitetään automaattisesti, kun kuvatekstimuuttujan sisältävä tekstikehys siirretään kuvan viereen. Muuttujatyyppinä käytetään
oletusarvoisesti Nimi-metadataa, kun valitset Teksti > Tekstimuuttujat > Lisää muuttuja > Kuvan nimi. Voit muokata Kuvan nimi -muuttujaa tai voit
luoda uusia muuttujia, jotka määrittävät kuvan metatietoja.

1. Valitse Teksti > Tekstimuuttujat > Määritä.

2. Valitse Uusi, jos haluat luoda muuttujan tai Muokkaa, jos haluat muokata aiemmin luotua muuttujaa.

3. Valitse tekstiksi Metatieto-otsikko.

4. Valitse haluamasi asetus Metatiedot-valikosta.

5. Valitse teksti, joka näkyy ennen metatietoja tai niiden jälkeen, ja valitse OK.

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Tekstin lisääminen kehyksiin

Alkuun

Alkuun

Tekstin lisääminen julkaisuun
Tekstin liittäminen
Tekstin vetäminen ja pudottaminen
Tekstin sijoittaminen (tuominen)
Buzzword-julkaisujen tuominen
Tuotujen tekstitiedostojen linkittäminen tai upottaminen

Tekstin lisääminen julkaisuun
Julkaisuun voi lisätä tekstiä kirjoittamalla tai liittämällä ja sijoittamalla tekstinkäsittelyohjelmasta. Jos tekstinkäsittelyohjelma tukee vedä ja pudota -
toimintoa, tekstiä voi vetää InDesign-kehyksiin. Suuret tekstilohkot voi lisätä julkaisuun tehokkaasti ja joustavasti Sijoita-komennolla. InDesign
tukee useita tekstinkäsittely-, laskentataulukko- ja tekstitiedostomuotoja.

Tekstikehystä ei tarvitse ensin luoda, kun sijoitat tai liität tekstiä, sillä InDesign luo sen automaattisesti.

Kun sijoitat tekstiä, voit Näytä tuontiasetukset -kohdan avulla määrittää, säilyttääkö tuotava teksti tyylinsä ja muotoilunsa. Jos haluat määrittää,
sisältääkö liitettävä teksti lisätietoja (kuten tyylejä tai värimalleja), valitse ennen tekstin liittämistä leikepöydän käsittelyasetuksista Kaikki tiedot- tai
Vain teksti -vaihtoehto.

Jos julkaisuun tuomassasi tekstissä näkyy vaaleanpunaista, vihreää tai muunväristä korostusta, joitakin koostamisasetuksia on todennäköisesti
otettu käyttöön. Avaa Asetukset-valintaikkunassa Koostaminen ja katso, mitkä Korosta-asetukset on valittu. Jos liitetty teksti on esimerkiksi
muotoiltu kirjasimilla, joita ei ole käytettävissä, teksti korostetaan vaaleanpunaisella.

Tekstin kirjoittaminen julkaisuun
1. Kun haluat sijoittaa kohdistimen tekstikehyksen sisälle, tee jokin seuraavista toimista:

Valitse tekstityökalu  ja luo uusi tekstikehys vetämällä tai napsauta valmista tekstikehystä.

Valitse valintatyökalu ja kaksoisnapsauta valmista tekstikehystä. Tekstityökalu valitaan automaattisesti.

2. Kirjoita teksti.

Jos sivupohjassa on tekstikehys, paina Ctrl+vaihtonäppäimiä (Windows) tai komento+vaihtonäppäimiä (Mac OS) ja napsauta samalla kehystä
julkaisun sivulla. Tämä tekee sivupohjan kehyksestä kopion julkaisun sivulle. Voit lisätä valittuun kehykseen tekstiä tekstityökalulla.

Aasialaisen tekstin kirjoittaminen tekstisyötöllä
1. Valitse Muokkaa > Asetukset> Tekstin lisäasetukset (Windows) tai InDesign > Asetukset > Tekstin lisäasetukset (Mac OS).
2. Valitse Käytä tekstisyöttöä muussa kuin latinalaisessa merkistössä -asetus ja valitse sitten OK.

Jos järjestelmän tukema syöttömenetelmä on käytettävissä, voit käyttää sitä kaksi- ja nelitavuisten merkkien kirjoittamiseen. Tämä menetelmä on
erityisen hyödyllinen aasialaisten merkkien kirjoittamiseen.

Paikkamerkkitekstin lisääminen
InDesignilla voi lisätä paikkamerkkitekstin, joka on helppo korvata myöhemmin todellisella tekstillä. Paikkamerkkitekstin lisääminen voi auttaa sinua
ymmärtämään kokonaisvaltaisemmin julkaisun asettelua.

1. Valitse vähintään yksi tekstikehys valintatyökalulla tai napsauta tekstikehyksen sisäosaa tekstityökalulla.
2. Valitse Teksti > Täytä paikkamerkkitekstillä.

Jos lisäät paikkamerkkitekstin kehykseen, joka on ketjutettu muihin kehyksiin, paikkamerkkiteksti lisätään ensimmäisen tekstikehyksen alkuun (jos
kaikki kehykset ovat tyhjiä) tai nykyisen tekstin loppuun (jos ketjutetuissa kehyksissä on jo tekstiä) aina viimeisen ketjutetun kehyksen loppuun
saakka.

Jos haluat poistaa tai korvata paikkamerkkitekstin, kaksoisnapsauta ketjun jotakin kehystä, valitse Muokkaa > Valitse kaikki ja poista sitten teksti.

Jos haluat muuttaa paikkamerkkitekstinä käytettyä tekstiä, luo haluamastasi tekstistä tekstitiedosto, anna sille nimeksi Paikkamerkki.txt ja
tallenna se sovelluksen kansioon.

Tekstin liittäminen
Jos tekstikehyksessä ei ole kohdistinta liittäessäsi tekstiä InDesigniin, ohjelma luo uuden tekstikehyksen. Jos tekstikehyksessä on kohdistin, teksti
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liitetään kehykseen. Jos tekstiä on valittuna liittäessäsi tekstiä, liitetty teksti korvaa valitun tekstin.

Tekstin liittäminen toisesta sovelluksesta
1. Jos haluat säilyttää muotoiluja ja tietoja (kuten tyylejä ja hakemistomerkkejä), avaa Asetukset-ikkunan Leikepöydän käsittely -osio ja valitse

Liitä-kohdasta Kaikki tiedot. Jos haluat poistaa tällaiset tiedot ja muotoilun liittäessäsi tekstiä, valitse Vain teksti.
2. Leikkaa tai kopioi tekstiä toiseen ohjelmaan tai InDesign -julkaisuun.
3. Voit valita tekstiä tai napsauttaa tekstikehystä. Muutoin teksti liitetään uuteen erilliseen kehykseen.
4. Tee jokin seuraavista:

Valitse Muokkaa > Liitä. Jos liitetty teksti ei sisällä kaikkea muotoilua, Tuontiasetukset-valintaikkunan Word- tai RTF-asetuksia on ehkä
muutettava.

Valitse Muokkaa > Liitä ilman muotoiluja. (Liitä ilman muotoilua -asetus ei ole käytettävissä liittäessäsi tekstiä toisesta sovelluksesta, jos
leikepöydän käsittelyasetuksissa on valittu Vain teksti.)

Voit myös vetää tekstiä toisesta sovelluksesta ja pudottaa sen InDesign-julkaisuun. Lisäksi voit lisätä teksti- tai tekstinkäsittelytiedoston
InDesign-julkaisuun suoraan Windowsin Resurssienhallinnasta tai Macintoshin Finder-ikkunasta. Teksti lisätään uuteen kehykseen. Jos vedät
tekstiä pitämällä vaihtonäppäintä alhaalla, tekstin muotoilu poistetaan. Asetukset-ikkunan Leikepöydän käsittely -osiossa valittu asetus
määrittää, säilytetäänkö tekstiin liittyviä tietoja, kuten hakemistomerkit ja värimallit.

Välistyksen automaattinen säätäminen tekstiä liitettäessä
Välejä lisätään tai poistetaan joissakin tapauksissa automaattisesti tekstin liittämisen yhteydestä. Jos esimerkiksi leikkaat sanan ja liität sen kahden
muun sanan väliin, liitetyn sanan eteen ja sen jälkeen tulee väli. Jos liität sanan virkkeen loppuun, väliä ei lisätä pisteen edelle.

1. Valitse Muokkaa > Asetukset > Teksti (Windows) tai InDesign > Asetukset > Teksti (Mac OS)
2. Valitse Säädä välistys automaattisesti leikattaessa ja liitettäessä sanoja. Valitse sitten OK.

Tekstin vetäminen ja pudottaminen
Voit vetää ja pudottaa tekstiä hiirellä juttueditorissa tai Sivuasettelu-näkymässä. Voit myös vetää tekstiä juttueditorista asetteluikkunaan (ja
päinvastoin) tai joihinkin valintaikkunoihin, kuten Etsi/Muuta-ikkunaan. Tekstin vetäminen lukitusta tai sisäänkirjatusta jutusta ei siirrä tekstiä vaan
kopioi sen. Voit myös kopioida tekstiä tai luoda uuden kehyksen tekstiä vedettäessä ja pudotettaessa.

Jeff Witchel on tehnyt opetusvideon vedä ja pudota -tekstistä. Se on osoitteessa Vedä ja pudota tekstiä InDesignissa.

1. Jos haluat sallia vetämisen ja pudottamisen, valitse Muokkaa > Asetukset > Teksti (Windows) tai InDesign > Asetukset > Teksti (Mac OS).
Valitse sitten Ota käyttöön Sivuasettelu-näkymässä, Ota käyttöön juttueditorissa (InDesign) tai Ota käyttöön Raakateksti- ja Juttu-näkymässä
(InCopy). Valitse lopuksi OK.

2. Valitse teksti, jota haluat siirtää tai kopioida.

3. Pidä kohdistinta valitun tekstin päällä, kunnes vedä ja pudota -kuvake  tulee esiin. Vedä sitten tekstiä.

Valittu teksti pysyy vetämisen aikana paikoillaan, mutta pystypalkki ilmaisee, mihin teksti siirtyy, kun vapautat hiiren painikkeen. Pystypalkki
näkyy kaikissa tekstikehyksissä, joiden yllä vedät hiirtä.

4. Tee jokin seuraavista toimista:

Kun haluat pudottaa tekstin uuteen paikkaan, sijoita pystypalkki siihen kohtaan, johon haluat tekstin siirtyvän, ja vapauta hiiren painike.

Jos haluat pudottaa tekstin uuteen kehykseen, pidä Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) alhaalla aloitettuasi
vetämisen ja vapauta hiiripainike ennen näppäintä.

Jos haluat vetää ja pudottaa tekstiä ilman muotoilua, paina vaihtonäppäin alas aloitettuasi vetämisen ja vapauta hiiripainike ennen
vaihtonäppäintä.

Jos haluat kopioida tekstin, pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) alhaalla vetämisen ajan ja vapauta hiiripainike
ennen näppäintä.

Voit myös käyttää näiden muokkauspainikkeiden yhdistelmiä. Jos esimerkiksi haluat kopioida muotoilematonta tekstiä uuteen kehykseen, pidä
alhaalla Alt+vaihto+Ctrl-näppäimiä (Windows) tai optio+vaihto+komentonäppäimiä (Mac OS) aloitettuasi vetämisen.

Jos pudotetussa tekstissä ei ole oikeaa välistystä, valitse tekstiasetuksista Säädä välistys automaattisesti.

Tekstin sijoittaminen (tuominen)
Tekstiä tai laskentataulukkotiedoston sijoittaessasi voit määrittää, miten tuotu teksti muotoillaan.

Voit katsella sisällön InDesigniin tuomista koskevan videon osoitteessa www.adobe.com/go/vid0067_fi. Voit katsoa tekstin sijoittamista ja
sijoittumista käsittelevän videon osoitteessa www.adobe.com/go/lrvid4278_id_fi.

1. (Valinnainen) Jos haluat luoda linkkejä sijoitettaviin tiedostoihin, valitse Asetukset-ikkunasta Tiedoston käsittely ja sitten Luo linkit tekstiä ja
laskentataulukkotiedostoja sijoitettaessa.
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Tällöin sijoitettuun tiedostoon luodaan linkki. Linkit-paneelin avulla voit päivittää, poistaa ja luoda uudelleen tekstitiedostojen linkkejä. Jos
linkitettyä tekstiä kuitenkin muotoillaan InDesignissa, muotoilu ei ehkä säily, kun linkki päivitetään. Jos tätä vaihtoehtoa ei ole valittu, tuotu
teksti ja laskentataulukkotiedostot upotetaan (eikä linkitetä).

2. Tee jokin seuraavista:

Jos haluat luoda uuden kehyksen sijoitettavalle tekstille, varmista, että kohdistinta, tekstiä tai kehystä ei ole valittu.

Jos haluat lisätä tekstin kehykseen, valitse teksti tai sijoita kohdistin tekstityökalulla .

Jos haluat korvata olemassa olevan kehyksen sisällön, valitse kehys valintatyökalulla. Jos kehys on ketjutettu, esiin tulee ladatun tekstin
kohdistin.

Jos korvaat tekstitiedoston tai kuvan vahingossa tällä menetelmällä, valitse Muokkaa > Kumoa > Korvaa. Luo sitten tekstikehys
napsauttamalla tai vetämällä.

3. Valitse Tiedosto > Sijoita.
4. Valitse Korvaa valittu kohde, jos haluat, että tuotu tiedosto korvaa valitun kehyksen sisällön tai valitun tekstin, tai jos haluat lisätä sen

tekstikehykseen lisäyskohtaan. Poista tämän asetuksen valinta, jos haluat juoksuttaa tuodun tiedoston uuteen kehykseen.
5. Valitse Näytä tuontiasetukset ja kaksoisnapsauta sitten tiedostoa, jonka haluat tuoda.
6. Määritä tuontiasetukset ja valitse OK.

Jos tekstin kohdekehystä ei ole valittu, osoitin muuttuu ladatun tekstin kuvakkeeksi. Juoksuta teksti napsauttamalla tai vetämällä.

Jos näyttöön tuleva sanoma ilmoittaa, ettei vaadittavaa suodinta löytynyt, yrität ehkä sijoittaa eri tekstinkäsittelysovelluksen tai aiemman Microsoft®
Word -version (esimerkiksi Word 6:n) tiedostoa. Kun tiedosto avataan alkuperäisessä sovelluksessa ja tallennetaan RTF-muodossa, suurin osa
muotoilusta säilyy.

Jos tuodun Microsoft Excel -tiedoston soluissa on punaisia pisteitä, säädä solun kokoa tai tekstin asetuksia niin, että ylijuokseva teksti tulee
näkyviin. Tiedoston voi sijoittaa myös muotoilemattomana sarkaintekstinä, jonka voi sitten muuntaa taulukoksi.

Tietoja tuontisuotimista
InDesign voi tuoda useimmat merkki- ja kappalemuotoilumääritteet, mutta ohittaa yleensä sivuasettelutiedot, kuten reunukset ja palsta-asetukset.
(Nämä voi määrittää InDesignissa). Pidä mielessä seuraavat:

InDesign tuo normaalisti kaikki tekstinkäsittelyohjelman muotoilutiedot lukuun ottamatta niitä, joita vastaavat toiminnot puuttuvat InDesignista.

InDesign voi lisätä tuodut tyylit julkaisun tyyliluetteloon. Tuotujen tyylien vieressä näkyy levykkeen kuvake . (Lisätietoja: Word-tyylien
muuntaminen InDesign-tyyleiksi.)

Tuontiasetukset näkyvät, kun valitset Sijoita-valintaikkunan Näytä tuontiasetukset -vaihtoehdon tai kun tuot Excel-tiedoston. Jos Näytä
tuontiasetukset -vaihtoehtoa ei ole valittu, InDesign käyttää edellisen samantyyppisen tiedoston tuontiasetuksia. Asetukset ovat voimassa,
kunnes ne kumotaan.

Näyttöön tulee virheilmoitus, jos InDesignissa ei ole suodinta, joka tunnistaa tiedoston sen tyypin tai tunnisteen perusteella. Windowsissa
tuotavissa tiedostoissa kannattaa käyttää vakiotunnisteita (kuten .doc, .docx, .txt, .rtf, .xls tai .xlsx). Joskus tiedosto täytyy avata
alkuperäisessä ohjelmassa ja tallentaa eri muodossa, kuten RTF- tai tekstitiedostona.

Lisätietoja tuontisuodattimista on suodatinten PDF-muotoisessa lueminut-tiedostossa osoitteessa www.adobe.com/go/lr_indesignfilters_cs5_fi.

Microsoft Word - ja RTF-tuontiasetukset
Jos käytät Word-tiedoston sijoittamisen yhteydessä Näytä tuontiasetukset -asetusta, voit valita seuraavat asetukset:

Sisällysluetteloteksti Asetus tuo sisällysluettelon jutun tekstin osana, ja kohteet tuodaan vain teksti -muodossa.
Hakemistoteksti Asetus tuo hakemiston jutun osana, ja kohteet tuodaan vain teksti -muodossa.
Alaviitteet Tuo Word-alaviitteitä. Alaviitteet ja viittaukset säilytetään, mutta ne numeroidaan uudelleen julkaisun alaviiteasetusten mukaisesti. Jos
Wordin alaviitteitä ei tuoda oikein, tallenna Word-asiakirja RTF-muodossa ja tuo se.
Loppuviitteet Asetus tuo loppuviitteet tekstin osana jutun lopussa.
Käytä typografisia lainausmerkkejä Asetus varmistaa, että tuodussa tekstissä käytetään vasemman- ja oikeanpuoleisia lainausmerkkejä (“ ”) ja
heittomerkkejä (’) suorien lainausmerkkien (" ") ja heittomerkkien sijaan (').
Tyylien ja muotoilun poistaminen tekstistä ja taulukoista Tämä asetus poistaa tuodusta tekstistä (mukaan lukien taulukoiden teksti) muotoilut,
kuten kirjasimen, värin ja tyylin. Kappaletyylejä ja sidottua grafiikkaa ei tuoda, jos tämä asetus on valittu.
Säilytä paikalliset ohitukset Jos poistat tyylit ja muotoilun tekstistä ja taulukoista, voit säilyttää tietyssä osassa kappaletta käytetyn
merkkimuotoilun (kuten lihavoinnin tai kursivoinnin) valitsemalla Säilytä paikalliset ohitukset -vaihtoehdon. Poista tämän asetuksen valinta, jos
haluat poistaa kaiken muotoilun.
Muunna taulukot: Jos päätät poistaa tyylit ja muotoilun tekstistä ja taulukoista, voit muuntaa taulukot joko muotoilemattomiksi perustaulukoiksi tai
muotoilemattomaksi sarkainerotelluksi tekstiksi.
Jos haluat tuoda muotoilematonta tekstiä ja muotoiltuja taulukoita, tuo teksti ilman muotoilua ja kopioi sitten taulukot Wordista kohteeseen
InDesign.

Tyylien ja muotoilun säilyttäminen tekstissä ja taulukoissa Asetus säilyttää Word-asiakirjan muotoilun InDesign- tai InCopy-julkaisussa. Voit
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määrittää muilla Muotoilu-asetuksilla, miten tyylit ja muotoilu säilytetään.
Manuaaliset sivunvaihdot Asetus määrittää, miten Word-tiedoston sivunvaihdot muotoillaan InDesignissa tai InCopyssa. Valitse Säilytä
sivunvaihdot, jos haluat käyttää samat sivunvaihdot kuin Wordissa, tai valitse Muunna palstanvaihdoiksi tai Ei vaihtoja.
Tuo sidottu grafiikka Asetus säilyttää Word-asiakirjan sidotun grafiikan InDesign-sovelluksessa.
Tuo käyttämättömät tyylit Asetus tuo kaikki tyylit Word-asiakirjasta, vaikka niitä ei käytettäisi tekstissä.
Muunna luettelomerkit ja numerot tekstiksi Tuo luettelomerkit ja numerot merkkeinä. Kappaleen ulkoasu säilyy muuttumattomana.
Numeroiduissa luetteloissa numeroita ei kuitenkaan päivitetä automaattisesti, kun luettelon kohtia muutetaan.
Jäljitä muutokset Tämän valinnan seurauksena Word-asiakirjan jäljitä muutokset -merkinnät näkyvät InDesign-julkaisussa. Voit katsella jäljitettyjä
muutoksia InDesignin juttueditorissa.
Tuo tyylit automaattisesti Asetus tuo tyylit Word-asiakirjasta InDesign- tai InCopy-julkaisuun. Jos Tyylinimien ristiriidat -kohdan vieressä on
keltainen varoituskolmio, vähintään yhdellä Word-asiakirjan kappale- tai merkkityylillä on sama nimi kuin InDesign-tyylillä.
Valitse asetus Kappaletyylien ristiriidat- ja Merkkityylien ristiriidat -valikosta, kun haluat määrittää tyylinimien ristiriitojen ratkaisutavat. Jos valitset
Käytä InDesignin tyylin määritystä -asetuksen, tuodun tyylin teksti muotoillaan InDesignin tyylin pohjalta. Jos valitset Määritä InDesign-tyyli
uudelleen -asetuksen, tuodun tyylin teksti muotoillaan Word-tyylin pohjalta ja myös kyseisellä Word-tyylillä muotoiltu nykyinen InDesign-teksti
muuttuu. Jos valitset Automaattinen uudelleen nimeäminen -asetuksen, tuodut Word-tyylit nimetään uudelleen. Jos sekä InDesignssa että
Wordissa on esimerkiksi tyyli Alaotsikko, tuodulle Word-tyylille annetaan nimi Alaotsikko_wrd_1, kun automaattinen uudelleen nimeäminen on
valittuna.

Huomautus: InDesign muuntaa kappale- ja merkkityylit, mutta ei luettelomerkittyjen ja numeroitujen luetteloiden tyylejä.
Mukauta tyylien tuontia Voit valita Tyylin osoittaminen -valintaikkunassa, mitä InDesign-tyyliä tuodussa asiakirjassa kunkin Word-tyylin kohdalla
käytetään.
Tallenna oletusarvo Asetus tallentaa nykyiset Wordin tuontiasetukset myöhempää käyttöä varten. Määritä tuontiasetukset, valitse Tallenna
oletusarvo, kirjoita oletusarvon nimi ja valitse OK. Kun seuraavan kerran tuot Word-tyylin, voit valita Oletusarvo-valikosta luomasi oletusarvon. Jos
haluat, että valittu oletusarvo toimii oletuksena Word-asiakirjojen tuleville tuonneille, valitse Määritä oletukseksi.

Tekstitiedoston tuontiasetukset
Jos valitset tekstitiedostoa sijoitettaessa Näytä tuontiasetukset, voit valita jonkin seuraavista asetuksista:

Merkistö Asetus määrittää tekstitiedoston luomisessa käytetyn tietokonemerkistön (esimerkiksi ANSI, Unicode UTF8 tai Windows CE).
Oletusarvoinen merkistö on InDesign- tai InCopy-oletuskielen ja -oletusalustan merkistö.
Ympäristö Tämä asetus määrittää, onko tiedosto luotu Windowsissa vai Macintoshissa.
Määritä sanasto Asetus määrittää, mitä sanastoa tuodussa tekstissä käytetään.
Ylimääräiset rivinvaihdot Määrittää, miten ylimääräiset rivinvaihdot tuodaan. Valitse Poista jokaisen rivin lopusta tai Poista kappaleiden välistä.
Korvaa Korvaa määritetyn määrän välilyöntejä sarkaimella.
Käytä typografisia lainausmerkkejä Asetus varmistaa, että tuodussa tekstissä käytetään vasemman- ja oikeanpuoleisia lainausmerkkejä (“ ”) ja
heittomerkkejä (’) suorien lainausmerkkien (" ") ja heittomerkkien sijaan (').

Microsoft Excel -tuontiasetukset
Seuraavat asetukset ovat valittavissa Excel-tiedostoa tuotaessa:

Arkki Asetus määrittää tuotavan taulukkosivun.
Näytä Asetus määrittää, tuodaanko mukautetut tai käyttäjäkohtaiset näkymät.
Solualue Asetus määrittää solualueen kaksoispisteen (:) avulla (esimerkiksi A1:G15). Jos taulukossa on nimettyjä alueita, nimet näkyvät Solualue-
valikossa.
Tuo kätketyt solut, joita ei ole tallennettu näkymään Asetus koskee kaikkia Excel-taulukon kätkettyjä soluja.
Taulukko Asetus määrittää, miten laskentataulukkotiedot näkyvät julkaisussa.

Muotoiltu taulukko  InDesign Ohjelma yrittää säilyttää Excelissä käytetyn muotoilun, mutta joidenkin solujen muotoilu saattaa hävitä. Jos
laskentataulukko on linkitetty eikä upotettu, linkin päivittäminen ohittaa taulukkoon InDesign -sovelluksessa käytetyt muotoilut.
Muotoilematon taulukko  Taulukko tuodaan ilman laskentataulukon muotoiluja. Jos tämä vaihtoehto valitaan, taulukkotyyliä voidaan
käyttää tuotuun taulukkoon. Jos muotoilet tekstiä kappale- ja merkkityylejä käyttämällä, muotoilu säilytetään, vaikka päivittäisit
laskentataulukkoon osoittavan linkin.
Muotoilematon sarkainteksti  Taulukko tuodaan sarkaineroteltuna tekstinä, joka voidaan sitten muuntaa taulukoksi InDesignissa tai
InCopyssa.
Muotoiltu vain kerran  InDesign säilyttää Excelissä käytetyn muotoilun alkuperäisessä tuonnissa. Jos laskentataulukko on linkitetty eikä
upotettu, laskentataulukkoon tehdyt muotoilumuutokset ohitetaan linkitetyssä taulukossa, kun päivität linkin. Vaihtoehto ei ole käytettävissä
InCopyssa.

Taulukon tyyli Käytä määrittämääsi taulukkotyyliä tuotuun julkaisuun. Tämä vaihtoehto on käytettävissä vain, jos Muotoilematon taulukko -
vaihtoehto on valittu.
Solun tasaus Tämä asetus määrittää tuodun julkaisun solujen tasauksen.
Sisällytä avoin grafiikka Asetus säilyttää Excel-julkaisun sidotun grafiikan InDesignssa.
Sisällytettävien desimaalipaikkojen määrä Määritä laskentataulukon lukujen desimaalipaikkojen määrä.
Käytä typografisia lainausmerkkejä Asetus varmistaa, että tuodussa tekstissä käytetään vasemman- ja oikeanpuoleisia lainausmerkkejä (“ ”) ja
heittomerkkejä (’) suorien lainausmerkkien (" ") ja heittomerkkien sijaan (').
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Nimiöidyn tekstin tuontiasetukset
InDesignin muotoilutoimintoja käyttäviä tekstitiedostoja voi tuoda ja viedä nimiöity teksti -muodossa. Nimiöidyt tekstitiedostot ovat tekstitiedostoja,
joissa on tietoja InDesignssa käytettävistä muotoiluista. Nimiöille voi määrittää lähes kaikki InDesign-jutun ominaisuudet, kuten kappale- ja
merkkitason määritteet sekä erikoismerkit.

Lisätietoja tunnisteiden määrittämisestä on nimiöityä tekstiä käsittelevässä PDF-tiedostossa osoitteessa
www.adobe.com/go/learn_id_taggedtext_cs5_fi (PDF).

Jos tuotava tiedosto on nimiöity tekstitiedosto ja Näytä tuontiasetukset -asetus on valittuna, valittavana on seuraavat asetukset:

Käytä typografisia lainausmerkkejä Asetus varmistaa, että tuodussa tekstissä käytetään vasemman- ja oikeanpuoleisia lainausmerkkejä (“ ”) ja
heittomerkkejä (’) suorien lainausmerkkien (" ") ja heittomerkkien sijaan (').
Poista tekstin muotoilu Tämä asetus poistaa tuodusta tekstistä muotoilut, kuten kirjasimen, värin ja tyylin.
Tekstityylien ristiriitojen selvittäminen Asetus määrittää, mitä merkki- tai kappaletyyliä käytetään, jos nimiöidyn tekstitiedoston ja InDesign-
julkaisun tyylit ovat ristiriitaisia. Valitse Julkaisun määritys, jos haluat käyttää InDesign-julkaisun tyyliä. Valitse Merkityn tiedoston määritys, jos
haluat käyttää nimiöidyssä tekstissä määritettyä tyyliä.
Näytä luettelo ongelmanimiöistä ennen sijoitusta Näytä tunnistamattomien nimiöiden luettelo. Jos luettelo avautuu, voit peruuttaa toiminnon tai
jatkaa tuontia. Jos jatkat, tiedoston ulkoasu saattaa poiketa suunnitellusta.

Tallenna Word- tai RTF-tuontiasetukset oletusarvoina
1. Varmista Word- tai RTF-tiedostoa sijoittaessasi, että Näytä tuontiasetukset -vaihtoehto on valittu ja valitse sitten Avaa.
2. Määritä haluamasi asetukset Tuontiasetukset-ikkunassa.
3. Valitse Tallenna oletusarvo, kirjoita oletusarvon nimi ja valitse OK.
4. (Valinnainen) Jos haluat käyttää oletusarvoa aina tuodessasi tämän muotoisia tiedostoja, valitse Määritä oletukseksi.

Voit valita mukautettuja oletusarvoja Tuontiasetukset-ikkunan Oletusarvot-valikosta aina, kun avaat Word- tai RTF-tiedoston.

Buzzword-julkaisujen tuominen
Buzzword on web-pohjainen tekstieditori, jolla voi luoda ja tallentaa tekstitiedostoja web-palvelimelle. InDesign CS5:ssä voit tuoda ja viedä tekstejä
Buzzword-julkaisuista.

Kun tuot Buzzword-julkaisun, luodaan URL-pohjainen linkki palvelimella olevaan Buzzword-julkaisuun. Kun Buzzword-julkaisua päivitetään
InDesign-tuotteen ulkopuolella, voit päivittää tuodun version InDesign-tuotteen Linkit-paneelista. Jos teet näin, kaikki Buzzword-tekstiin InDesign-
tuotteessa tekemäsi muutokset poistetaan.

Huomautus: Acrobat.comin Buzzword.sovellus on saatavana vain englanniksi, ranskaksi ja saksaksi.

1. Valitse Tiedosto > Tuo Buzzwordista.

2. Jos et ole vielä kirjautunut CS Liveen, napsauta Kirjaudu, anna sähköpostiosoitteesi ja salasanasi ja valitse Kirjaudu.

Kun olet kirjautunut sisään, Buzzword-julkaisujen tuominen -valintaikkunassa näkyy Buzzword-julkaisut, jotka voit tuoda.

3. Valitse yksi tai useita tuotavia julkaisuja tai liitä Buzzword-julkaisun URL-osoite Liitä URL -kenttään.

4. Valitse jokin seuraavista vaihtoehdoista ja valitse sitten OK.

Näytä tuontiasetukset Jos valitset tämän vaihtoehdon, Buzzwordin tuontiasetukset -valintaikkuna avautuu, ennen kuin tuot tiedoston.

Korvaa valittu kohde Valitsemalla tämän vaihtoehdon voit korvata julkaisussa käytössä olevan objektin.

Linkki julkaisuun Valitsemalla tämän vaihtoehdon voit luoda linkin Buzzword-julkaisun ja sijoitetun tekstin välille. Jos luot linkin ja päivität
Buzzword-julkaisua, tiedoston muokkaaminen ilmaistaan Linkit-paneelissa. Jos päivität linkin, InDesign-tuotteen teksti päivitetään. Kaikki
tekstiin InDesign-tuotteessa tekemäsi muutokset kuitenkin poistetaan

5. Jos valitsit Näytä tuontiasetukset -asetuksen, määritä asetukset Buzzwordin tuontiasetukset -valintaikkunaan.

Tämä valintaikkuna sisältää lähestulkoon samat valinnat kuin RTF-tuontiasetukset -valintaikkuna. Katso Microsoft Word - ja RTF-
tuontiasetukset. Buzzwordissa ei ole tällä hetkellä tyyliominaisuuksia, joten tyylivalinnat eivät ole nyt käytettävissä.

6. Voit luoda tekstikehyksen napsauttamalla tai vetämällä ladatun tekstin osoitinta.

Tuotujen tekstitiedostojen linkittäminen tai upottaminen
InDesigniin sijoittamaasi tekstiä ei oletusarvoisesti ole linkitetty alkuperäiseen tekstitiedostoon. Jos valitset Tiedoston käsittely -asetuksista Luo
linkit tekstiä ja taulukkolaskentatiedostoja sijoitettaessa -asetuksen ennen tiedoston sijoittamista, tekstitiedoston nimi tulee näkyviin Linkit-paneeliin.
Voit päivittää ja hallita tiedostoa paneelin avulla. Kun linkitetty tekstitiedosto päivitetään, kaikki InDesignissa käytetyt muokkaukset ja muotoilut
poistetaan. Tämän vuoksi linkitettyjä tekstitiedostoja ei päivitetä automaattisesti, kun alkuperäistä tiedostoa muokataan. Voit kuitenkin käyttää
kätevästi Linkit-paneelia, jos haluat päivittää sisältöä tai poistaa tiedostolinkin (upottaa tiedoston).

1. Tee jokin seuraavista:
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Jos haluat ottaa tämän muutoksen käyttöön julkaisussa, avaa julkaisu.

Jos haluat ottaa tämän muutoksen käyttöön jossakin luomassasi uudessa julkaisussa, sulje kaikki julkaisut.

2. Valitse Muokkaa > Oletusarvot > Tiedoston käsittely (Windows) tai Photoshop > Oletusarvot > Tiedoston käsittely (Mac OS).
3. Jos haluat luoda linkit sijoitettuihin tiedostoihin, valitse Luo linkit tekstiä ja laskentataulukkotiedostoja sijoitettaessa. Jos tämä asetus on

valittu, voit päivittää tai poistaa linkit tai linkittää uudelleen Linkit-paneelin avulla. Jos asetusta ei ole valittu, tekstitiedostot upotetaan (eikä
linkitetä).

Jos haluat poistaa linkin tekstitiedostoon (upottaa sen), valitse tiedosto Linkit-paneelista ja valitse sitten Linkit-paneelivalikosta Poista linkitys.

Lisää ohjeaiheita
Sisällön tuomista käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Tekstin ja tekstikehysten luominen
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Tekstikehysten luominen
Tekstikehysten siirtäminen ja koon muuttaminen
Tekstikehysten käyttäminen sivupohjissa
Tekstikehyksen ominaisuuksien muuttaminen
Sana- ja merkkimäärien määrittäminen
Lisäkielien käyttäminen

Tekstikehysten luominen
InDesignissa teksti on tekstikehyksiksi kutsutuissa säilöissä. (Tekstikehys vastaa QuarkXPressin tekstilaatikkoa ja Adobe PageMakerin
tekstilohkoa.) Voit katsoa tekstikehyksen tekemistä käsittelevän videon osoitteessa www.adobe.com/go/lrvid4274_id_fi.

Tekstikehyksiä voidaan grafiikkakehysten tavoin siirtää ja käsitellä eri tavoin, ja myös niiden kokoa voidaan muuttaa. Käytettävissä olevat toiminnot
vaihtelevat käytössä olevan työkalun mukaan:

Tekstityökalulla  lisätään tekstiä kehykseen tai muokataan kehyksessä olevaa tekstiä.

Valintatyökalua  käytetään yleisiin asemointitehtäviin, kuten kehyksen sijoittamiseen ja sen koon muuttamiseen.

Käytä suoravalintatyökalua  kehyksen muodon muuttamiseen.

Tekstikehykset voi myös yhdistää muihin tekstikehyksiin niin, että teksti jatkuu toisessa kehyksessä. Tällä tavalla yhdistetyt kehykset ovat
ketjutettuja. Tekstiä, joka jatkuu vähintään yhden ketjutetun kehyksen läpi, kutsutaan jutuksi. Kun esimerkiksi sijoitat (tuot) tekstitiedoston, se tulee
julkaisuun yhtenä juttuna kehysten määrästä riippumatta.

Tekstikehyksissä voi olla useita palstoja. Vaikka tekstikehykset voivat perustua sivun palstoihin, ne ovat kuitenkin sivun palstoista riippumattomia.
Kaksipalstainen tekstikehys voi siis olla nelipalstaisella sivulla. Tekstikehykset voidaan myös sijoittaa sivupohjiin, ja niihin voidaan lisätä tekstiä
julkaisun sivuilla.

Jos käytät toistuvasti samantyyppistä tekstikehystä, voit luoda objektityylin, joka sisältää tekstikehyksen muotoilun (esimerkiksi viiva- ja
täyttövärit, tekstikehyksen asetukset sekä tekstinkierrätys- ja läpinäkyvyystehosteet).

Tekstikehystä ei tarvitse luoda tekstin sijoittamisen tai liittämisen yhteydessä, sillä InDesign lisää kehykset automaattisesti sivun palsta-asetusten
mukaisesti.

 Tee jokin seuraavista toimista:

Valitse tekstityökalu  ja määritä uuden tekstikehyksen leveys ja korkeus vetämällä. Jos pidät vaihtonäppäintä alhaalla, kun vedät,
kehyksestä tulee neliö. Kun vapautat hiiren painikkeen, kehykseen tulee tekstikohdistin.

Uuden tekstikehyksen luominen vetämällä

Napsauta toisen tekstikehyksen sisäporttia tai ulkoporttia valintatyökalulla ja luo sitten uusi kehys napsauttamalla tai vetämällä.

Sijoita tekstitiedosto Sijoita-komennon avulla.

Napsauta jonkin tyhjän kehyksen sisäosaa tekstityökalulla . Jos Tekstiasetukset-valintaikkunassa on valittu tekstityökalu muuttaa kehykset
tekstikehyksiksi -vaihtoehto, tyhjä kehys muunnetaan tekstikehykseksi.

Tekstikehysten siirtäminen ja koon muuttaminen
Siirrä tekstikehyksiä ja muuta niiden kokoa valintatyökalulla.

Jos haluat siirtää tekstikehyksiä tai muuttaa niiden kokoa vaihtamatta tekstityökalua  valintatyökaluun, vedä kehystä pitämällä Ctrl-näppäintä
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(Windows) tai komentonäppäintä (Mac OS) alhaalla.

Tekstikehyksen siirtäminen
Vedä kehystä valintatyökalulla.
Valitse tekstityökalu, pidä Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) alhaalla ja vedä kehystä. Tekstityökalu on vielä valittuna,
kun vapautat näppäimen.

Tekstikehyksen koon muuttaminen
 Tee jokin seuraavista toimista:

Jos haluat käyttää tekstityökalua , pidä Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) alhaalla ja vedä jotakin kehyksen
kahvaa. Jos pidät hiiren painiketta painettuna alhaalla sekunnin ajan, ennen kuin alat vetää, teksti rivittyy uudelleen, kun muutat kehyksen
kokoa.

Huomautus: jos napsautat tekstikehystä vetämisen sijaan, kadotat tekstivalinnan tai tekstikohdistimen.

Jos haluat käyttää valintatyökalua , vedä jotakin kehyksen reunassa olevaa kahvaa. Voit skaalata kehyksessä olevaa tekstiä pitämällä
alhaalla Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS). (Lisätietoja: Kirjasimen skaalaaminen.)

Jos haluat sovittaa kehyksen sisältöön nopeasti, valitse tekstikehys valintatyökalulla ja kaksoisnapsauta jotakin sen kahvaa. Jos esimerkiksi
kaksoisnapsautat alareunan keskellä olevaa kahvaa, kehyksen alareuna tarttuu tekstin alareunaan. Jos taas kaksoisnapsautat oikean reunan
keskimmäistä kahvaa, sisällön leveys sovitetaan kehyksen leveyden mukaiseksi muuttamatta korkeutta.

Kaksoisnapsauttamalla ylijuoksevan tekstikehyksen kahvaa voit muuttaa sisällön korkeammaksi tai leveämmäksi niin, että koko teksti
mahtuu kehykseen. Tekstikehyksen koko ei muutu, jos kehyksessä on enemmän ylijuoksevaa tekstiä kuin sivulle kohtuudella mahtuu.

Muuta tekstikehyksen kokoa kaksoisnapsauttamalla kahvaa.

Sovita tekstikehys sisältöön valitsemalla valintatyökalulla Objekti > Sovitus > Sovita kehys sisältöön. Tekstikehyksen alareuna sovitetaan
tekstisisällön mukaiseksi. Tekstikehyksen koko ei muutu, jos kehyksessä on enemmän ylijuoksevaa tekstiä kuin sivulle kohtuudella mahtuu.

Jos haluat muuttaa kehyksen kokoa käyttämällä skaalaustyökalua , vedä kehystä. (Lisätietoja: Kirjasimen skaalaaminen.)

Tekstikehysten käyttäminen sivupohjissa
Uudessa julkaisussa voi ottaa käyttöön Tekstikehyspohja-vaihtoehdon. Tällöin oletussivupohjaan lisätään tyhjä tekstikehys. Kehyksen palstan ja
reunusten asetukset ovat samat kuin Uusi julkaisu -valintaikkunassa.

Noudata seuraavia ohjeita, kun käytät tekstikehyksiä sivupohjissa:

Määritä tekstikehyspohja, jos haluat, että julkaisun kukin sivu sisältää sivunkokoisen tekstikehyksen, johon voi juoksuttaa tai kirjoittaa tekstiä.
Jos julkaisuun tarvitaan enemmän vaihtelua, kuten sivuja, joiden kehysten määrä vaihtelee, tai kehyksiä, joiden pituus vaihtelee, älä valitse
Tekstikehyspohja-asetusta, vaan luo tekstikehykset sivupohjiin tekstityökalulla.

Tekstikehyspohja-valinnasta riippumatta sivupohjaan voi lisätä tekstikehyksiä paikkamerkeiksi. Tyhjät paikkamerkkikehykset voi ketjuttaa.

Teksti juoksutetaan tekstikehyspohjiin samalla tavalla kuin julkaisun sivuilla oleviin kehyksiin.

Julkaisun sivulla olevaan tekstikehyspohjaan voi kirjoittaa tekstiä napsauttamalla kehystä ja painamalla Ctrl+vaihtonäppäimiä (Windows) tai
komento+vaihtonäppäimiä (Mac OS). Napsauta sitten kehystä tekstityökalulla ja kirjoita teksti.

Voit käyttää älykästä tekstin uudelleenjuoksutusta sivujen automaattiseen lisäämiseen ja poistamiseen tekstiä kirjoittaessasi tai muokatessasi.
Kun kirjoitat tekstiä sivupohjaan perustuvan ketjutetun tekstikehyksen loppuun, uusi sivu lisätään oletusarvoisesti. Voit jatkaa kirjoittamista
uuteen tekstikehykseen. Voit muokata älykkään tekstin uudelleenjuoksutuksen asetuksia.

Jos muutat sivun reunuksia, tekstikehykset mukautetaan uusiin reunuksiin vain, jos Salli sivuasettelun säätö -asetus on valittuna.

Tekstikehyspohja-asetus ei vaikuta uusien sivujen lisäämiseen automaattisen juoksuttamisen yhteydessä.
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AlkuunTekstikehyksen ominaisuuksien muuttaminen
Tekstikehyksen asetuksilla voi muokata esimerkiksi kehyksen palstojen lukumäärää, tekstin pystytasausta ja vieruksen leveyttä eli tekstin ja
kehyksen välistä etäisyyttä.

Ennen (vasen) ja jälkeen (oikea) sisennyksen määrittämistä ja kahden palstan luomista tekstikehykseen.

Jos tarvitset samoja tekstikehyksen ominaisuuksia useissa tekstikehyksissä, luo objektityyli, jota voit käyttää tekstikehyksissä.

1. Valitse kehys valintatyökalulla  tai valitse tekstikehys tai teksti tekstityökalulla .
2. Valitse Objekti > Tekstikehyksen asetukset tai pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) alhaalla ja kaksoisnapsauta

tekstikehystä valintatyökalulla.
3. Muuta tekstikehyksen asetuksia ja valitse OK.

Nämä tekstikehyksen asetukset ovat käytettävissä, kun määrität tekstiruutujen objektityyliä. Lisätietoja: Objektityylit.

Palstojen lisääminen tekstikehykseen
Voit luoda tekstikehykseen palstoja Tekstikehyksen asetukset -ikkunan vaihtoehtojen avulla.

Et voi luoda erilevyisiä palstoja tekstikehykseen. Jos haluat luoda erilevyisiä ja -korkeuksisia palstoja, lisää ketjutetut tekstikehykset sivuttain
julkaisun sivulle tai sivupohjaan.

1. Valitse kehys valintatyökalulla tai valitse tekstikehys tai teksti tekstityökalulla.
2. Valitse Objekti > Tekstikehyksen asetukset.
3. Määritä tekstikehyksen palstojen lukumäärä ja kunkin palstan leveys ja palstaväli.
4. (Valinnainen) Jos haluat säilyttää palstan leveyden samana kehyksen koon muuttuessa, valitse Kiinteä palstaleveys. Tällöin kehyksen koon

muuttaminen saattaa vaikuttaa palstojen määrään mutta ei leveyteen.

Kiinteä palstaleveys
A. Alkuperäinen 2-palstainen tekstikehys B. Kokoa muutettu, kun Kiinteä palstaleveys -asetus ei ole valittuna (yhä kaksi palstaa) C. Kokoa
muutettu, kun Kiinteä palstaleveys -asetus on valittuna (4 palstaa)

5. (Valinnainen) Valitse Tasapainota palstat, jos haluat tekstin olevan tasaista monipalstaisen tekstikehyksen alalaidassa.
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Ennen kuin tasapainotat palstat ja sen jälkeen

Tekstikehyksen vieruksen leveyden muuttaminen (reunukset)
1. Valitse kehys valintatyökalulla tai valitse tekstikehys tai teksti tekstityökalulla.
2. Valitse Objekti > Tekstikehyksen asetukset.
3. Määritä Yleiset-välilehden Vieruksen leveys -osiossa siirtymät ylös, alas, oikealle ja vasemmalle. (Käytä samaa leveyttä kaikille puolille

napsauttamalla Määritä kaikki asetukset samoiksi -kuvaketta .)

Jos valittu kuvio on muu kuin suorakulmio, siirtymiä (ylös, alas, oikealle ja vasemmalle) ei voi määrittää, mutta Vierus-toiminto on käytettävissä.

Ensimmäisen perusviivan siirtymäasetukset
Jos haluat muuttaa valitun tekstikehyksen ensimmäisen perusviivan asetuksia, valitse Objekti > Tekstikehyksen asetukset ja sitten Perusviivan
asetukset -välilehti. Siirtymä-valikon Ensimmäinen perusviiva -kohdassa on seuraavat asetukset:

Yläpidennys d-kirjaimen ylin kohta jää tekstikehyksen ylävieruksen alapuolelle.
Isojen kirjainten korkeus Isojen kirjainten yläreuna koskettaa tekstikehyksen ylävierusta.
Rivivälistys Ensimmäisen rivin peruslinjan ja kehyksen ylävieruksen välinen etäisyys määräytyy rivivälin mukaan.
X-korkeus x-kirjaimen ylin kohta jää kehyksen ylävieruksen alapuolelle.
Kiinteä Määritä ensimmäisen rivin peruslinjan ja kehyksen ylävieruksen välinen etäisyys manuaalisesti.
Väh Valitse peruslinjan minimisiirtymä. Esimerkki: Jos valittuna on Rivivälistys ja määrität minimiarvoksi 1p, InDesign käyttää vain rivivälistysarvoja,
jotka ovat yli 1picaa.

Jos haluat tekstikehyksen yläreunan tarttuvan ruudukkoon, valitse Rivivälistys tai Kiinteä, jotta voit määrittää tekstin ensimmäisen peruslinjan
sijainnin tekstikehyksissä.

Rivirekisterin määrittäminen tekstikehykseen
Voit joissakin tapauksissa haluta käyttää rivirekisteriä vain yhdessä kehyksessä koko julkaisun sijaan. Valitse Tekstikehyksen asetukset -
valintaikkuna, kun haluat käyttää rivirekisteriä tekstikehyksessä. Kun määrität tekstikehyksen rivirekisterin, ota huomioon seuraavat seikat:

Julkaisun rivirekisteri ei näy tekstikehysten takana tai edessä, jos kehykset käyttävät omia rivirekisterejä.

Jos Asetusten Ruudukot-osassa on valittu Ruudukot taustalla -asetus, kehyksiin perustuvia rivirekisterejä noudatetaan ennen julkaisuun
perustuvia rivirekisterejä. Jos Ruudukot taustalla -asetus ei ole valittuna, julkaisuun perustuvia rivirekisterejä noudatetaan ennen kehyksiin
perustuvia rivirekisterejä

1. Valitse Näytä > Ruudukot ja apuviivat > Näytä rivirekisteri, jos haluat näyttää kaikki rivirekisterit, mukaan lukien tekstikehyksissä olevat.
2. Valitse tekstikehys tai sijoita kohdistin tekstikehykseen. Valitse sitten Objekti > Tekstikehyksen asetukset.

Jos haluat käyttää rivirekisteriä ketjun kaikkiin kehyksiin (vaikka vähintään yksi ketjutettu ruudukko ei sisältäisi tekstiä), aseta kohdistin
tekstiin, valitse Muokkaa > Valitse kaikki ja käytä sitten rivirekisteriasetuksia Tekstikehyksen asetukset -ikkunan avulla.

3. Valitse Perusviivan asetukset -välilehti.
4. Valitse Rivirekisteri-kohdassa Käytä mukautettua rivirekisteriä ja tee jokin seuraavista toimista:

Alku Kirjoita arvo ruudukon siirtymälle sivun yläreunasta, sivun yläreunuksesta, kehyksen yläreunasta tai kehyksen ylävieruksesta
Suhteessa-valikossa tehtävien valintojen perusteella.

Suhteessa Määritä, haluatko rivirekisterin alkavan sivun yläreunasta, sivun yläreunuksesta, tekstikehyksen yläreunasta vai tekstikehyksen
ylävieruksesta.

Lisäysväli Kirjoita arvo ruudukon viivojen välille. Yleensä on kirjoitettava arvo, joka on sama kuin leipätekstin rivivälin arvo, jotta tekstirivit
voidaan kohdistaa ruudukkoon täydellisesti.

Väri Valitse ruudukon viivojen väri. Jos haluat käyttää samaa väriä kuin taso, jolla tekstikehys näkyy, valitse Tason väri.

Jos tekstikehyksessä ei näy rivirekisteriä, varmista valitsemalla Näytä > Ruudukot ja apuviivat > Näytä rivirekisteri, että niitä ei ole kätketty. Jos
rivirekisteriä ei vieläkään näy, tarkista rivirekisterien näyttökynnys Asetukset-valintaikkunan Ruudukot-osiosta. Sinun on ehkä lähennettävä
kehystä tai pienennettävä kynnyksen tasoa nähdäksesi ruudukon.
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Alkuun

Alkuun

Sana- ja merkkimäärien määrittäminen
1. Aseta kohdistin tekstikehykseen, jos haluat nähdä koko kehysketjun (jutun) tiedot, tai valitse teksti, jonka tiedot haluat nähdä.
2. Avaa Tieto-paneeli valitsemalla Ikkuna > Tietoja.

Tieto-paneeli näyttää tekstikehyksen merkkien, sanojen, rivien ja kappaleiden määrän. Esiin tulee myös kohdistimen sijainti tekstikehyksessä.

Lisäkielien käyttäminen
Voit määrittää erilaisten tekstien kielen. Oikean kielen määrittäminen tekstille on erityisen hyödyllistä oikoluvun ja tavutuksen kannalta. (Lisätietoja:
Tekstin kielen määrittäminen.)

Jos sinun täytyy käyttää aasialaista tekstiä, InDesignista on saatavana erityisversioita japanin, yksinkertaistetun kiinan, perinteisen kiinan ja korean
kielille. Näillä versioilla voit luoda sivuasetteluruudukkoja ja kehysruudukkoja monitavuisten merkkien käyttöä varten ja niissä on joukko
ominaisuuksia, joilla voi muokata monitavuisia merkkejä, sekä lisäkirjasimia.

InDesignista on vastaavasti saatavana erityisversio Lähi-idän kielille, kuten heprea, arabia, farsi ja urdu. Tässä versiossa käytetään oikealta
vasemmalle etenevää tekstimuotoilua. Tämän version nimi on InDesign ME.

Lisätietoja InDesign ME:n tai InDesignin aasialaisen kieliversion ostamisesta on Adoben WWW-sivustolla.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Etsi ja muuta

Alkuun

Teksti

GREP

Kuvio

Objekti

Alkuun

Yleistä Etsi/Muuta-toiminnosta
Tekstin etsiminen ja muuttaminen
Etsiminen GREP-lausekkeiden avulla
Etsiminen metamerkkien avulla
Objektien etsiminen ja muuttaminen
Kuvioiden etsiminen ja muuttaminen
Kirjasinten etsiminen ja korvaaminen
Kohteiden etsiminen ja muuttaminen kyselyiden avulla

Yleistä Etsi/Muuta-toiminnosta

Etsi/Muuta-ikkunan välilehtien avulla voit määrittää, mitä haluat etsiä ja muuttaa.

Etsi/Muuta-ikkuna

A. Etsi/Muuta-välilehdet B. Etsi sarkainmerkki C. Korvaa se pitkällä ajatusviivalla D. Etsi asetukset E. Metamerkki-valikko F. Haku eteen- ja
taaksepäin 

Etsi/Muuta-toiminnolla voi etsiä ja muuttaa merkkejä, sanoja, sanaryhmiä tai tietyllä tavalla muotoiltua tekstiä. Voit myös etsiä ja korvata
erikoismerkkejä, kuten symboleita, paikkamerkkejä ja välilyöntimerkkejä Voit laajentaa hakua yleismerkeillä.

Voit etsiä ja korvata tekstiä ja muotoilua käyttämällä edistyneitä muotoperustaisia hakutekniikoita.

Voit etsiä ja korvata kuvioita käyttämällä Unicode-arvoja tai kuvioiden ja merkkien tunnusarvoja. Tästä toiminnosta on hyötyä erityisesti
kuvioiden etsimisessä ja korvaamisessa aasialaisia kieliä käytettäessä.

Voit etsiä ja korvata objektien ja kehysten muotoiluja ja määritteitä. Voit esimerkiksi etsiä 4 pisteen viivan objekteja ja korvata viivan
varjolla.

Tekstin etsiminen ja muuttaminen

Jos haluat luetteloida, etsiä tai korvata julkaisun kirjasimia, voit käyttää Etsi kirjasin -komentoa Etsi/Muuta-komennon sijaan.

Tekstin etsiminen ja muuttaminen

424



1. Voit etsiä tekstialueen tai jutun valitsemalla tekstin tai sijoittamalla kohdistimen juttuun. Voit laajentaa haun useampaan tiedostoon avaamalla
haluamasi tiedostot.

2. Valitse Muokkaa > Etsi/Muuta ja valitse sitten Teksti-välilehti.

3. Määritä hakuehdot Etsi-valikossa. Voit sisällyttää hakuun lukitut tasot, sivupohjat, alaviitteet ja muita kohteita napsauttamalla kuvakkeita.

4. Kuvaile Etsittävä-kentässä, mitä haluat etsiä:

Kirjoita tai liitä teksti, jonka haluat löytää.

Jos haluat etsiä tai korvata sarkaimia, välilyöntejä tai muita erikoismerkkejä, valitse etsittävää merkkiä edustava merkki (metamerkki)
Etsittävä-kentän oikealla puolella olevasta ponnahdusvalikosta. Voit myös valita yleismerkkejä, kuten Mikä tahansa numeromerkki tai
Mikä tahansa merkki.

Käytä metamerkkejä, kun haluat etsiä erikoismerkkejä, kuten sarkaimia.

Voit etsiä ja korvata tekstiä käyttämällä valmiiksi määritettyä kyselyä. (Katso Kohteiden etsiminen ja muuttaminen kyselyiden avulla.)

5. Kirjoita tai liitä korvaava teksti Korvaava-kohtaan. Voit myös valita edustavan merkin Korvaava-kentän oikealla puolella olevasta
ponnahdusvalikosta.

6. Valitse Etsi.

7. Jatka hakua valitsemalla Etsi seuraava, Muuta (muuttaa nykyisen esiintymän), Muuta kaikki (näyttöön tuleva viesti ilmoittaa muutosten
kokonaismäärän) tai Etsi/Muuta (muuttaa nykyisen esiintymän ja etsii seuraavan).

8. InDesignin Etsi ja muuta -valintaikkunassa on kaksi hakusuuntapainiketta: Eteenpäin ja Taaksepäin. Haku eteenpäin on otettu
oletusarvoisesti käyttöön, ja voit muuttaa hakusuunnan valitsemalla Taaksepäin. Uusi toiminto helpottaa Teksti-, GREP- ja Kuvio-välilehdissä
olevien merkkijonojen hakemista.

9. Valitse Valmis.

Jos hakutulokset eivät vastaa odotuksia, kannattaa tarkistaa, että edellisten hakujen muotoilut on poistettu käytöstä. Hakua täytyy ehkä laajentaa.
Saatat esimerkiksi tehdä hakua valinnasta tai jutusta julkaisun sijaan. Saatat myös hakea tekstiä, joka esiintyy kohteessa (esimerkiksi lukitulla
tasolla, alaviitteessä tai piilotetussa ehdollisessa tekstissä), joka ei sisälly hakuun.

Korvaukset voi peruuttaa valitsemalla Muokkaa > Peruuta Korvaa teksti (tai Peruuta Korvaa koko teksti).

Voit hakea seuraavan esiintymän, joka vastaa edellistä hakua valitsemalla Muokkaa > Etsi seuraava. Etsi/Muuta-valintaikkunaa ei tarvitse avata.
Lisäksi aiemmat hakuehdot tallentuvat Etsi/Muuta-valintaikkunaan. Voit valita hakuehdon asetuksen oikealla puolella olevasta valikosta.
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Huomautus:

Yleismerkkihaut

Leikepöytä metamerkkihakuja varten

Leikepöydän sisällöllä korvaaminen

Virheellisen tekstin etsiminen ja poistaminen

XML-nimiöiden käyttäminen

Haku eteen- ja taaksepäin

Etsi-valikko

Muotoillun tekstin etsiminen ja muuttaminen

1. Valitse Muokkaa > Etsi/Muuta.

2. Jos Etsi muotoilu- tai Muuta muotoilu -vaihtoehdot eivät tule esiin, napsauta Lisää asetuksia -vaihtoehtoa. Voit vastaavasti valita Vähemmän
asetuksia, jolloin näyttöön tulee vähemmän vaihtoehtoja.

3. Napsauta Etsi muotoilu -kenttää tai napsauta Etsi muotoiluasetukset -osion oikealla puolella olevaa Määritä etsittävät määritteet -kuvaketta.

4. Valitse muotoilutyyppi ja -määritteet Etsi muotoiluasetukset -valintaikkunan vasemmasta reunasta ja valitse sitten OK.

Eräät OpenType-muotoiluasetukset näkyvät sekä OpenType-ominaisuudet- että Perusmerkkimuotoilut-kohdissa (Sijainti-valikko). Lisätietoja
OpenTypesta ja muista muotoilumääritteistä on InDesignin Ohjeessa.

Muotoiluhaussa (tai muotoilun korvaamisessa) Etsittävä- tai Korvaava-ruutu jää tyhjäksi.

5. Jos haluat käyttää etsimääsi tekstiin muotoilua, napsauta Muuta muotoilu -kenttää tai napsauta Muuta muotoiluasetukset -osion Määritä
muutettavat määritteet -kuvaketta. Valitse sitten muotoilutyyppi ja määritä muotoilumääritteet. Valitse lopuksi OK.

6. Muotoile tekstiä haku- ja muutospainikkeilla.

Kun hakuperusteeksi on valittu muotoilu, Etsittävä- tai Korvaava-ruudun yläpuolella on tietokuvakkeet. Kuvakkeet ilmaisevat, että
muotoilumääritteet on määritetty, joten haku- ja muutostoiminnot ovat käytettävissä rajoitetusti.

Poista kaikki muotoilumääritteet Etsi muotoiluasetukset- tai Muuta muotoiluasetukset -kohdasta valitsemalla Tyhjennä.

Yleisiä Etsi/Muuta-tekniikoita

Voit laajentaa hakua määrittämällä yleismerkkejä, kuten Mikä tahansa numeromerkki tai Mikä tahansa tyhjä tila. Esimerkiksi jos
Etsittävä-kentässä on ka?a, haku koskee sanoja, joiden alussa on ka ja lopussa a (kuten kana, kala ja kasa). Voit joko kirjoittaa yleismerkit tai
valita vaihtoehdon Etsittävä-tekstikentän vieressä olevan ponnahdusvalikon Yleismerkit-alivalikosta.

Etsittäessä metamerkkejä, kuten pitkiä ajatusviivoja tai luettelomerkkejä, ensin kannattaa valita teksti ja
liittää se Etsittävä-kenttään. Tällöin metamerkkejä ei tarvitse kirjoittaa. InDesign muuntaa liitetyt erikoismerkit metamerkkivastaavuuksiin
automaattisesti.

Hakukohteita voi korvata leikepöydältä kopioidulla sisällöllä joko muotoiluineen tai ilman muotoiluja. Tekstiä
voi korvata myös kopioidulla grafiikalla. Kopioi kohde ja valitse sitten Etsi/Muuta-valintaikkunassa jokin vaihtoehto Korvaava-kentän oikealla
puolella olevan ponnahdusvalikon Muu-alivalikosta.

Voit poistaa virheellistä tekstiä määrittämällä poistettavan tekstin Etsittävä-kentässä. Jätä
Korvaava-kenttä tyhjäksi (varmista, ettei tässä kentässä ole määritetty muotoiluja).

Etsittävässä tekstissä voi käyttää XML-nimiöitä.

Voit hakea eteen- tai taaksepäin. Näin voit hakea tekstin, jos haun aikana vahingossa ohitat sen. Hakemalla eteen- ja
taaksepäin voit siis hakea tekstin helpommin kuin suorittamalla haun uudelleen.

Hakuehdot tekstin etsimiselle ja muuttamiselle

Näiden vaihtoehtojen avulla voit määrittää hakuehdot.
Julkaisut
Etsi koko julkaisusta. Valitse Kaikki julkaisut, jos haluat etsiä kaikista avoinna olevista julkaisuista.
Juttu
Etsi valitun kehyksen koko tekstistä, mukaan lukien muiden ketjutettujen tekstikehysten teksti sekä ylijuokseva teksti. Valitse Jutut, jos haluat
etsiä kaikkien valittujen kehysten jutuista. Tämä vaihtoehto on näkyvissä vain, jos tekstikehys on valittu tai kohdistin määritetty.
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Sisällytä lukitut tasot 

Sisällytä lukitut jutut 

Sisällytä kätketyt tasot 

Sisällytä sivupohjat 

Sisällytä alaviitteet 

Huomioi kirjainkoko 

Koko sana 

Alkuun

Jutun loppuun
Etsi kohdistimesta eteenpäin. Vaihtoehto on näkyvissä vain, jos kohdistin on määritetty.
Valinta
Etsi vain valitusta tekstistä. Tämä asetus on käytettävissä vain, jos tekstiä on valittuna.

Etsi tekstistä, jotka on lukittu Tason asetukset -ikkunan vaihtoehtojen avulla. Lukittujen tasojen tekstiä ei voi korvata.

Etsi tekstiä jutuista, jotka on kirjattu ulos InCopy-työnkulussa. Lukittujen juttujen tekstiä ei voi korvata.

Etsi tekstistä, jotka on kätketty Tason asetukset -ikkunan vaihtoehtojen avulla. Kun hakutoiminto löytää kätketyn tason
tekstiä, tekstin kohdalla näytetään korostus mutta itse tekstiä ei näytetä. Kätkettyjen tasojen tekstiä ei voi korvata.
Piilotettu ehdollinen teksti jätetään aina pois hausta.

Etsi tekstiä sivupohjista.

Etsi alaviitteiden tekstistä.

Hakutuloksiin otetaan vain sana tai sanat, joiden kirjoitusasu vastaa täsmälleen Etsittävä-ruudun hakuavaimen
kirjoitusasua. Esimerkiksi hakusanalla PrePress ei löydy tuloksia Prepress, prepress tai PREPRESS.

Ohittaa haettavat merkit, jos ne ovat osa toista sanaa. Jos hakusana on on esimerkiksi ala, InDesign ohittaa sanan kala.

Etsiminen GREP-lausekkeiden avulla

GREP-välilehdellä tai Etsi/Muuta-ikkunassa voit luoda GREP-lausekkeita, joilla voit etsiä aakkosnumeerisia tekstijonoja ja kuvioita pitkistä
julkaisuista ja useista avoimista julkaisuista. Voit kirjoittaa GREP-metamerkkejä manuaalisesti tai valita ne Erikoismerkit Etsi/Muuta-toiminnossa -
luettelosta. GREP-haut erottelevat oletusarvoisesti isot ja pienet kirjaimet.

InDesign Secrets sisältää luettelon GREP-resursseista osoitteessa InDesign GREP.

1. Valitse Muokkaa > Etsi/Muuta ja valitse sitten GREP-välilehti.

2. Määritä hakuehdot valintaikkunan alareunassa olevassa Etsi-valikossa. Voit sisällyttää hakuun lukitut tasot, sivupohjat, alaviitteet ja muita
kohteita napsauttamalla kuvakkeita.

3. Luo GREP-lauseke Etsittävä-kentässä seuraavasti:

Kirjoita lauseke manuaalisesti. (Katso Etsiminen metamerkkien avulla.)

Jos tarvitset apua hakulausekkeen luomiseen, napsauta Etsittävä-kohdan oikealla puolella olevaa Erikoismerkit Etsi-toiminnossa -
kuvaketta ja valitse haluamasi vaihtoehdot Sijainnit-, Toisto-, Sovita-, Muokkaajat- ja Posix-alivalikoista.

4. Kirjoita tai liitä korvaava teksti Korvaava-kohtaan.

5. Valitse Etsi.

6. Jatka hakua valitsemalla Etsi seuraava, Muuta (muuttaa nykyisen esiintymän), Muuta kaikki (näyttöön tuleva viesti ilmoittaa muutosten
kokonaismäärän) tai Etsi/Muuta (muuttaa nykyisen esiintymän ja etsii seuraavan).

7. InDesignin Etsi ja muuta -valintaikkunassa on kaksi hakusuuntapainiketta: Eteenpäin ja Taaksepäin. Haku eteenpäin on otettu
oletusarvoisesti käyttöön, ja voit muuttaa hakusuunnan valitsemalla Taaksepäin. Uusi toiminto helpottaa Teksti-, GREP- ja Kuvio-välilehdissä
olevien merkkijonojen hakemista.
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Voit myös lisätä GREP-tyylien avulla merkkityylejä tekstiin, joka vastaa GREP-lauseketta. GREP-tyylit-valintaikkuna onkin kätevä tapa testata
määrittämääsi GREP-lauseketta. Lisää kappaleeseen esimerkit, jotka haluat löytää, ja määritä sitten merkkityyli ja GREP-lauseke GREP-tyylit-
valintaikkunassa. Kun otat esikatselun käyttöön, voit muokata lauseketta, kunnes se vaikuttaa oikein kaikkiin esimerkkeihin.

GREP-hakujen muotoiluvihjeitä

Nämä vihjeet helpottavat GREP-lausekkeiden luomista.

Monet GREP-välilehden haut ovat samankaltaisia kuin Teksti-välilehden haut, mutta muista, että eri välilehdissä käytetään eri koodeja.
Yleisesti Teksti-välilehden metamerkkien alussa on ^ (esimerkiksi sarkaimen merkintä on ^t) ja GREP-välilehden metamerkkien alussa on \
(esimerkiksi sarkaimen merkintä on \t). Kaikki metamerkit eivät kuitenkaan ole tämän säännön mukaisia. Esimerkiksi kappaleen loppu on ^p
Teksti-välilehdessä ja \r GREP-välilehdessä. Teksti- ja GREP-välilehden metamerkkien luettelo on kohdassa Etsiminen metamerkkien avulla.

Jos haluat etsiä merkkiä, jolla on symbolinen merkitys GREP-tekniikassa, kirjoita ennen merkkiä kenoviiva (\) osoittamaan, että kenoviivaa
seuraava hakuehto on itse merkki. Jos kirjoitat esimerkiksi pisteen ( .  ), GREP-toiminto etsii mitä tahansa merkkiä. Jos taas haluat etsiä
pistettä, kirjoita "\."

Tallenna GREP-haku kyselynä, jos haluat käyttää sitä usein tai luovuttaa sen muiden käyttöön. (Katso Kohteiden etsiminen ja muuttaminen
kyselyiden avulla.)

Voit jakaa haun alilausekkeisiin sulkeiden avulla. Jos esimerkiksi haluat etsiä sanaa "kissa" tai "kassa", voit käyttää lauseketta k(i|a)ssa.
Sulkeet helpottavat erityisesti ryhmitysten määrittämistä. Jos haet esimerkiksi lausekkeella "(kissa) ja (koira)", kissa on löytynyt teksti 1 ja
koira löytynyt teksti 2. Löytynyt teksti -lausekkeilla (kuten $1 - löytynyt teksti 1) voit muuttaa ainoastaan osan löytyneestä tekstistä.

GREP-hakuesimerkkejä

Näiden esimerkkien avulla voit hyödyntää GREP-lausekkeita tehokkaammin.

Esimerkki 1: Lainausmerkeissä olevan tekstin hakeminen

Oletetaan, että haluat etsiä lainausmerkeissä olevia sanoja (kuten ”Espanja”), poistaa lainausmerkit ja käyttää sanassa tyyliä (Espanja vs.
”Espanja”). Lauseke (")(\W+)(") sisältää kolme ryhmitystä, jotka osoitetaan sulkeilla ( ). Lausekkeen ensimmäinen ja kolmas ryhmitys hakee
lainausmerkkejä ja toinen ryhmitys vähintään yhtä sanamerkkiä.

Voit viitata ryhmityksiin löytynyt teksti -lausekkeilla. Esimerkiksi $0 viittaa kaikkeen löytyneeseen tekstiin ja $2 vain toiseen ryhmitykseen.
Lisäämällä lausekkeen $2 Korvaava-kenttään ja määrittämällä merkkityylin Muuta muotoilu -kentässä voit hakea lainausmerkeissä olevan sanan ja
korvata sen merkkityylillä. Koska vain $2 on määritetty, $1- ja $3-ryhmitykset poistetaan. (Kun $0 tai $1$2$3 määritetään Korvaava-kentässä,
merkkityyliä käytetään myös lainausmerkeissä.)
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GREP-esimerkki

A. Hakee kaikki lainausmerkeissä olevat sanamerkit B. Merkkityyliä käytetään myös toisessa ryhmittelyssä (sana), kun ensimmäinen ja kolmas
ryhmittely (avaavat ja sulkevat lainausmerkit) on poistettu C. Merkkityylin määritelmä  

Tämä esimerkki hakee vain lainausmerkkeihin kirjoitettuja yksittäisiä sanoja. Jos haluat hakea lainausmerkeissä olevia ilmauksia, käytä
yleismerkkilausekkeita, kuten (\s*.*\w*\d*), joka hakee välejä, merkkejä, sanamerkkejä ja numeroita.

Esimerkki 2: Puhelinnumerot

InDesign sisältää valmiiksi määritettyjä hakuja, joita voit valita Kyselyt-valikossa. Voit valita esimerkiksi puhelinnumeron muuntokyselyn, joka
näyttää tältä:

\(?(\d\d\d)\)?[-. ]?(\d\d\d)[-. ]?(\d\d\d\d)

Yhdysvaltain puhelinnumerot voidaan kirjoittaa useissa muodoissa, kuten 206-555-3982, (206) 555-3982, 206.555.3982 ja 206 555 3982.
Merkkijono hakee niitä kaikkia. Puhelinnumeron kolme ensimmäistä numeroa (\d\d\d) saattavat olla sulkeissa, joten sulkeiden perässä on
kysymysmerkki: \(? ja \)?. Kenoviiva \ osoittaa, että lauseke hakee todellista suljetta, joka ei siis kuulu alilausekkeeseen. Hakasulkeet [ ] hakevat
kaikkia niiden sisälle merkittyjä merkkejä, joten tässä tapauksessa [-. ] hakee yhdysmerkkiä, pistettä tai väliä. Hakasulkeiden perässä oleva
kysymysmerkki osoittaa, että sulkeissa olevat kohteet ovat valinnaisia haussa. Lisäksi numerot on merkitty sulkeisiin, jotka viittaavat ryhmityksiin,
joihin voidaan viitata Korvaava-kentässä.

Korvaava-kentän ryhmitysviittauksia voi muuttaa tarpeen mukaan. Kentässä voi käyttää esimerkiksi seuraavia lausekkeita:

206.555.3982 = $1.$2.$3

206-555-3982 = $1-$2-$3

(206) 555-3982 = ($1) $2-$3

206 555 3982 = $1 $2 $3

Lisää GREP-esimerkkejä

Voit opetella GREP-hakujen tekemistä tämän taulukon esimerkeillä.

Lauseke Hakumerkkijono Näyteteksti Vastineet (lihavoituna)
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Merkkiluokka

[ ]

[abc]

Hakee merkkiä a, b tai c.

Maria cuenta bien. Maria cuenta bien.

Kappaleen alku

^

^~_.+

Tämä hakee kappaleen
alusta (^) pitkää
ajatusviivaa (~_), jonka
perässä voi esiintyä mikä
tahansa merkki ( . )
vähintään kerran (+).

”Näimme—tai ainakin
luulimme nähneemme—
purppuranvärisen lehmän.”

—Konrad Yoes

”Näimme—tai ainakin
luulimme nähneemme—
purppuranvärisen lehmän.”

—Konrad Yoes

Negatiivinen Lookahead

(?!kuvio)

InDesign (?!CS.*?)

Negatiivinen Lookahead
vastaa hakumerkkijonoa
ainoastaan, jos sen
perässä ei ole tietty kuvio.

InDesign, InDesign 2.0,
InDesign CS ja
InDesign CS2

InDesign, InDesign 2.0,
InDesign CS ja
InDesign CS2

Positiivinen Lookahead

(?=kuvio)

InDesign (?=CS.*?)

Positiivinen Lookahead
vastaa hakumerkkijonoa
ainoastaan, jos sen
perässä on tietty kuvio.

Samojen kuvioiden avulla
voi muodostaa negatiivisia
(?<!kuvio) ja positiivisia
Lookbehind -komentoja (?
<=kuvio).

InDesign, InDesign 2.0,
InDesign CS ja
InDesign CS2

InDesign, InDesign 2.0,
InDesign CS ja
InDesign CS2

Ryhmitykset

( )

(nopea) (ruskea) (kettu) Nopea ruskea kettu
hyppelee ylös ja alas.

Nopea ruskea kettu
hyppelee ylös ja alas.

Kaikki löytynyt teksti =
nopea ruskea kettu;
löydetty teksti 1= nopea;
löydetty teksti 2 = ruskea;
löydetty teksti 3= kettu

Ei-merkitsevät sulkeet

(?:lauseke)

(nopea) ($:ruskea) (kettu) Nopea ruskea kettu
hyppelee ylös ja alas.

Nopea ruskea kettu
hyppelee ylös ja alas.

Kaikki löytynyt teksti =
nopea ruskea kettu;
löydetty teksti 1= nopea;
löydetty teksti 2 = kettu

Ei kirjainkoon erottelua

(?i)

(?i)omena

Toinen vaihtoehto on (?
i:omena)

Omena omena OMENA Omena omena OMENA

Kirjainkoon erottelu
käytössä

(?-i)

(?-i)omena Omena omena OMENA Omena omena OMENA

Monirivisyys käytössä

(?m)

(?m)^\w+

Tässä esimerkissä lauseke
hakee vähintään yhtä (+)
sanamerkkiä (\w) rivin
alusta (^). Käytettäessä
lauseketta (?m) kaikkia
löytyneen tekstin rivejä
voidaan käsitellä erillisinä
riveinä.

(?m)^\w vastaa kunkin

Yksi Kaksi Kolme Neljä
Viisi Kuusi Seitsemän
Kahdeksan

Yksi Kaksi Kolme Neljä
Viisi Kuusi Seitsemän
Kahdeksan
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Etsiminen metamerkkien avulla

Metamerkit vastaavat jotakin merkkiä tai symbolia InDesign-ohjelmassa. Etsi/Muuta-ikkunan tekstiosiossa metamerkkien alussa on sirkumfleksi (^)
ja GREP-osiossa tilde (~) tai kenoviiva (\). Metamerkkejä voi kirjoittaa Etsi/Muuta-ikkunan Teksti- tai GREP-välilehdelle.

Voit säästää välimerkkivirheiden korjaamiseen kuluvaa aikaa tallentamalla hakuehdot kyselyinä.

kappaleen alkua. (?-m)^\w
vastaa vain jutun alkua.

Monirivisyys ei käytössä

(?-m)

(?-m)^\w+ Yksi Kaksi Kolme Neljä
Viisi Kuusi Seitsemän
Kahdeksan

Yksi Kaksi Kolme Neljä
Viisi Kuusi Seitsemän
Kahdeksan

Yksirivisyys käytössä

(?s)

(?s)c.a

Lauseke hakee mitä
tahansa merkkiä ( . ), joka
on merkkien c ja a välissä.
Lauseke (?s) vastaa
kaikkia merkkejä, vaikka
ne olisivat seuraavalla
rivillä.

(.) vastaa mitä tahansa
muuta paitsi
kappalevaihtoa. (?s)(.)
vastaa mitä tahansa
kappalevaihdot mukaan
lukien.

abc abc abc abc abc abc abc abc

Yksirivisyys ei käytössä (?-s)c.a abc abc abc abc abc abc abc abc

Toistojen määrä

{ }

b{3} vastaa tasan kolmea
kertaa

b(3,} vastaa vähintään
kolmea kertaa

b{3,}? vastaa vähintään
kolmea kertaa (lyhyin
vastine)

b{2,3} vastaa vähintään
kahta ja enintään kolmea
kertaa

b{2,3}? vastaa vähintään
kahta ja enintään kolmea
kertaa (lyhyin vastine)

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

abbc abbbc abbbbc
abbbbbc

Merkki: Metamerkki Teksti-välilehdellä: Metamerkki GREP-välilehdellä

Sarkainmerkki ^t I.

Kappaleen loppu ^pica \r

Pakotettu rivinvaihto ^n \n

Mikä tahansa sivunumero ^# ~#

Nykyinen sivunumero ^N ~N
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Seuraava sivunumero ^X ~X

Edellinen sivunumero ^V ~V

* Mikä tahansa muuttuja ^v ~v

Osion merkki ^x ~x

* Ankkuroidun objektin merkki ^a ~a

* Alaviitteen viittauksen merkki ^F ~F

* Hakemistomerkki ^I ~I

Luettelomerkki ^8 ~8

Japanilainen luettelomerkki ^5 ~5

Sirkumfleksi ^^ \^

Kenoviiva \ \\

Copyright-merkki ^2 ~2

Kolme pistettä ^e ~e

Tilde ~ \~

Kappalemerkki ^7 ~7

Rekisteröity-merkki ^r ~r

Pykälämerkki ^6 ~6

Tavaramerkin symboli ^d ~d

Vasen sulkumerkki ( \(

Oikea sulkumerkki ) \)

Vasen aaltosulkumerkki { \{

Oikea aaltosulkumerkki } \}

Vasen hakasulkumerkki [ \[

Oikea hakasulkumerkki ] \]

em-viiva ^_ ~_

en-viiva ^= ~=

Tavutusvihje ^- ~-

Sitova yhdysmerkki ^~ ~~

Ideographic Space ^( ~(

em-väli ^m ~m

en-väli ^> ~>

Kolmannesväli ^3 ~3

Neljännesväli ^4 ~4

432



Kuudennesväli ^% ~%

Tasausvälilyönti ^f ~f

Hieno väli ^| ~|

Sitova välilyönti ^s ~s

Sitova välilyönti (kiinteä leveys) ^S ~S

Kapea väli ^< ~<

Numeroväli ^/ ~/

Välimerkkiväli ^. ~.

^ Leikepöydän sisältö, muotoiltu ^c ~c

^ Leikepöydän sisältö, muotoilematon ^C ~C

Mikä tahansa lainausmerkki " "

Mikä tahansa puolilainausmerkki
(heittomerkki)

' '

Suora lainausmerkki ^" ~"

Vasen lainausmerkki ^{ ~{

Oikea lainausmerkki ^} ~}

Suora puolilainausmerkki
(heittomerkki)

^' ~'

Vasen puolilainausmerkki ^[ ~[

Oikea puolilainausmerkki ^] ~]

Tavallinen rivinvaihto ^b ~b

Palstanvaihto ^M ~M

Kehyksenvaihto ^R ~R

Sivunvaihto ^P ~P

Pariton sivunvaihto ^L ~L

Parillinen sivunvaihto ^E ~E

Harkinnanvarainen rivinvaihto ^k ~k

Oikealle tasaava sarkain ^y ~y

Sisennä tähän ^i ~i

Lopeta sisäkkäistyyli tähän ^h ~h

Erottaja ^j ~j

* Juokseva ylätunniste (kappaletyyli) -
muuttuja

^Y ~Y

* Juokseva ylätunniste (merkkityyli) -
muuttuja

^Z ~Z
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* Mukautettu teksti -muuttuja ^u ~u

* Viimeinen sivunumero -muuttuja ^T ~T

* Lukunumero-muuttuja ^H ~H

* Luontipäivä-muuttuja ^S ~S

* Muokkauspäivä-muuttuja ^o ~o

* Tulostuspäivä-muuttuja ^D ~D

* Tiedostonimi-muuttuja ^l (pieni L) ~l (pieni L)

* Mikä tahansa numero ^9 \d

* Mikä tahansa merkki, joka ei ole
numero

\D

* Mikä tahansa kirjain ^$ [\l\u]

* Mikä tahansa merkki ^? . (lisää piste Korvaava-kenttään)

* Tyhjä tila (välilyöntimerkki tai sarkain) ^w \s (lisää väli Korvaava-kenttään)

* Mikä tahansa merkki, joka ei ole
tyhjä tila

\S

* Mikä tahansa kirjain \w

* Mikä tahansa merkki, joka ei ole
sanamerkki

\V

* Mikä tahansa iso kirjain \u

* Mikä tahansa merkki, joka ei ole iso
kirjain

\U

* Mikä tahansa pieni kirjain \l

* Mikä tahansa merkki, joka ei ole
pieni kirjain

\L

^ Kaikki löytynyt teksti $0

Löytynyt teksti 1-9 $1 (määrittää löydetyn ryhmityksen
numeron, kuten $3 kolmannelle
ryhmitykselle. Ryhmitykset merkitään
sulkeisiin)

* Kanji ^K ~K

* Sanan alku \<

* Sanan loppu \>

* Sanaraja \b

* Sanarajan vastakohta \B

* Kappaleen alku ^

* Kappaleen loppu [sijainti] $

* Ei kertaakaan tai kerran ?
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* Vähintään nolla kertaa *

* Vähintään kerran +

* Ei kertaakaan tai kerran (lyhin
vastaavuus)

??

* Vähintään nolla kertaa (lyhin
vastaavuus)

*?

* Vähintään kerran (lyhin vastaavuus) +?

* Merkitsevä ali-ilmaus ( )

* Merkitsemätön ali-ilmaus (?: )

* Merkistö [ ]

* tai |

* Positiivinen Lookbehind (?<= )

* Negatiivinen Lookbehind (?<! )

* Positiivinen Lookahead (?= )

* Negatiivinen Lookahead (?! )

* Kirjainkoon ohitus käytössä (?i)

* Kirjainkoon ohitus pois käytöstä (?-i)

* Monirivisyys käytössä (?m)

* Monirivisyys pois käytöstä (?-m)

* Yksirivisyys käytössä (?s)

* Yksirivisyys pois käytöstä (?-s)

* Mikä tahansa aakkosnumeerinen
merkki

[[:alnum:]]

* Mikä tahansa kirjain [[:alpha:]]

* Mikä tahansa tyhjä merkki, väli tai
sarkain

[[:blank:]]

* Mikä tahansa ohjausmerkki [[:control:]]

* Mikä tahansa graafinen merkki [[:graph:]]

* Mikä tahansa tulostettava merkki [[:tulosta:]]

* Mikä tahansa välimerkki [[:punct:]]

* Mikä tahansa merkki, jonka koodi on
suurempi kuin 255 (koskee ainoastaan
leveitä merkkiluokkia)

[[:unicode:]]

* Kaikki heksadesimaalimerkit 0-9, a-f
ja A-F

[[:xdigit:]]

* Kaikki tiettyyn kuviojoukkoon
kuuluvat merkit, kuten a, à, á, â, ã, ä,

[[=a=]]

435



Alkuun
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* Voidaan kirjoittaa vain Etsittävä-kenttään mutta ei Korvaava-kenttään.

^ Voidaan syöttää Korvaava-kenttään, ei Etsittävä-kenttään.

Objektien etsiminen ja muuttaminen

Etsi/Muuta-toiminnon avulla voit etsiä ja korvata objekteihin, grafiikkakehyksiin ja tekstikehyksiin käytettyjä määritteitä ja tehosteita. Jos esimerkiksi
haluat määrittää varjoille yhtenäisen värin, läpinäkyvyyden tai vieruksen leveyden, tällä toiminnolla voit etsiä ja korvata koko julkaisun varjot.

1. Valitse Muokkaa > Etsi/Muuta.

2. Valitse Objekti-välilehti.

3. Napsauta Etsittävä objektin muotoilu -kenttää tai napsauta Määritä etsittävät määritteet -kuvaketta.

4. Valitse muotoilutyyppi ja -määritteet Etsi objektin muotoiluasetukset -ikkunan vasemmasta reunasta ja valitse sitten OK.

Varmista, että haussa käyttämiesi luokkien tila on oikea. Kussakin Tehoste-luokassa voi käyttää näitä kolmea tilaa: käytössä, poissa
käytöstä tai ohitettu. Jos esimerkiksi Varjo-asetuksen tilana on käytössä, haku sisältää varjomuotoilun. Jos tilana on poissa käytöstä, haku
etsii objektit, joissa varjomuotoilu on poistettu käytöstä. Jos taas tilana on ohitettu, haku ei huomioi varjomuotoilua.

5. Jos haluat käyttää etsimääsi objektiin muotoilua, napsauta Muuta objektin muotoilu -kenttää tai napsauta Muuta muotoiluasetukset -osion
Määritä muutettavat määritteet -kuvaketta. Valitse sitten muotoilutyyppi ja määritä muotoilumääritteet. Valitse lopuksi OK.

6. Muotoile objekteja haku- ja muutospainikkeilla.

Kuvioiden etsiminen ja muuttaminen

Etsi/Muuta-ikkunan Kuvio-osio on erityisen hyödyllinen, jos saman unicode-arvon kuvioita korvataan muilla vastaavilla kuvioilla, kuten
vaihtoehtoisilla kuvioilla.

InDesign Secrets sisältää selkeän esimerkin kuvioiden etsimisestä ja korvaamisesta. Se on osoitteessa Kuvioiden etsiminen ja korvaaminen.

1. Valitse Muokkaa > Etsi/Muuta.

2. Määritä ikkunan alareunassa olevassa Etsi-valikossa hakualue ja määritä hakuun sisällytettävät kohteet (kuten lukitut tasot, sivupohjat ja
alaviitteet) napsauttamalla vastaavia kuvakkeita.

3. Valitse Etsittävä kuvio -kohdasta kuvion kirjasinperhe ja -tyyli.

Kirjasinperhe-valikossa näytetään vain kyseisen julkaisun tekstissä käytetyt kirjasimet. Käyttämättömien tyylien kirjasimia ei näytetä.

4. Etsi haluamasi kuvio määrittämällä se seuraavasti Kuvio-kenttään:

Napsauta Kuvio-kentän vieressä olevaa painiketta ja kaksoisnapsauta sitten jotakin paneelin kuviota. Paneeli toimii samoin kuin Kuvio-
paneeli.

Valitse Unicode tai Kuvion tai merkin tunnus ja kirjoita kuvion koodi.

Etsittävän kuvion voi määrittää myös muilla tavoilla. Valitse kuvio julkaisuikkunasta ja valitse sitten pikavalikosta Lataa valittu kuvio
etsittäviin -vaihtoehto. Voit myös valita kuvion Kuvio-paneelista ja sitten pikavalikosta Lataa valittu kuvio etsittäviin -vaihtoehdon.

5. Määritä Muuta kuvio -kohdassa korvaava kuvio samalla tavalla.

6. Valitse Etsi.

7. Jatka hakua valitsemalla Etsi seuraava, Muuta (muuttaa viimeisen esiintymän), Muuta kaikki (näyttöön tuleva viesti ilmoittaa muutosten
kokonaismäärän) tai Muuta/Etsi (muuttaa nykyisen esiintymän ja etsii seuraavan).

8. InDesignin Etsi ja muuta -valintaikkunassa on kaksi hakusuuntapainiketta: Eteenpäin ja Taaksepäin. Haku eteenpäin on otettu
oletusarvoisesti käyttöön, ja voit muuttaa hakusuunnan valitsemalla Taaksepäin. Uusi toiminto helpottaa Teksti-, GREP- ja Kuvio-välilehdissä
olevien merkkijonojen hakemista.

å, A, À, Á, Â, Ã, Ä ja Å
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Huomautus:

9. Valitse Valmis.

Kirjasinten etsiminen ja korvaaminen

Julkaisussa käytettyjä kirjasimia voi etsiä ja luetteloida Etsi kirjasin -toiminnolla. Minkä tahansa kirjasimen (ei kuitenkaan tuodussa grafiikassa
käytettyä kirjasinta) voi korvata millä tahansa toisella järjestelmään asennetulla kirjasimella. Voit korvata myös kirjasimia, jotka eivät sisälly
tekstityyliin. Pidä mielessä seuraavat:

Kirjasimen nimi esiintyy kerran luettelossa. Tuodun grafiikan osalta nimi luetellaan kerran kutakin esiintymiskertaa kohden. Jos esimerkiksi
käytät samaa kirjasinta kolme kertaa sekä asettelussa että tuoduissa kuvissa, se näkyy Etsi kirjasin -valintaikkunassa neljä kertaa: kerran
kaikkien asetteluesiintymien ja kolmesti kuvien johdosta. Jos kirjasimia ei ole upotettu grafiikkaan kokonaan, kirjasimen nimi ei ehkä näy Etsi
kirjasin -valintaikkunassa.

Etsi kirjasin -toiminto ei ole käytettävissä juttueditori-ikkunassa.

Etsi kirjasin -valintaikkunassa kuvakkeilla ilmaistaan kirjasinten tyyppiä ja tilaa, kuten Type 1 -kirjasimet , tuodut kuvat , TrueType-
kirjasimet , OpenType-kirjasimet  ja puuttuvat kirjasimet .

Voit etsiä yhdistelmäkirjasimet ja muuttaa niitä, mutta et voi muuttaa yhdistelmäkirjasimiin sisältyviä komponenttikirjasimia.

Teksti > Etsi kirjasin -toiminnon avulla voit varmistaa tulosteiden yhdenmukaisuuden tutkimalla, miten kirjasimia käytetään sivuilla ja tuodussa
grafiikassa. Jos haluat etsiä ja muuttaa tekstin määritteitä, merkkejä tai tyylejä, valitse Muokkaa > Etsi/Muuta.

1. Valitse Teksti > Etsi kirjasin.

2. Valitse Kirjasimia julkaisussa -luettelosta kirjasimen nimi (tai useita nimiä).

3. Tee jokin seuraavista:

Jos haluat etsiä asettelusta paikan, jossa luettelosta valittu kirjasin esiintyy ensimmäisen kerran, valitse Etsi ensimmäinen. Näyttöön
tulee teksti, jossa kirjasin on käytössä. Etsi ensimmäinen -painike ei ole käytettävissä, jos kirjasinta on käytetty tuodussa grafiikassa tai
jos luettelosta on valittu useita kirjasimia.

Valitse Etsi Grafiikka, jos haluat valita tuodun kuvan, jossa käytetään luettelossa kuvakkeella  merkittyä kirjasinta. Kuva tulee näkyviin.
Etsi grafiikka -painike ei ole käytettävissä, jos kirjasinta on käytetty asettelussa tai jos luettelosta on valittu useita kirjasimia.

4. Saat lisätietoja valitusta kirjasimesta valitsemalla Enemmän tietoja. Voit kätkeä lisätiedot valitsemalla Vähemmän tietoja. Tietoalue on tyhjä,
jos luettelosta on valittu useita kirjasimia.

Kirjasin saattaa esiintyä luettelossa tuntemattomana, jos valitussa grafiikassa ei ole kirjasintietoja. Bittikarttakuvan (esimerkiksi TIFF-kuvan)
kirjasimet eivät näy luettelossa, koska ne eivät ole merkkejä.

5. Jos haluat vaihtaa kirjasimen, valitse uusi kirjasin Korvaava-luettelosta ja tee jokin seuraavista toimista:

Jos haluat muuttaa valitun kirjasimen yhden esiintymän, valitse Muuta. Tämä asetus ei ole käytettävissä, jos valittuna on useita
kirjasimia.

Jos haluat muuttaa esiintymän kirjasimen ja etsiä seuraavan, valitse Muuta/Etsi. Tämä asetus ei ole käytettävissä, jos valittuna on useita
kirjasimia.

Jos haluat muuttaa luettelosta valitun kirjasimen kaikki esiintymät, valitse Muuta kaikki. Jos haluat määrittää uudelleen haettavan
kirjasimen sisältäviä kappale- tai merkkityylejä, valitse Määritä tyyli uudelleen, kun muutetaan kaikki.

Kun kirjasinta ei enää esiinny tiedostossa, sen nimi häviää Kirjasimet julkaisussa -luettelosta.

jos haluat muuttaa tuodun grafiikan kirjasinta, käytä ohjelmaa, jolla kirjasin on luotu ja korvaa sitten grafiikka päivitetyllä
versiolla tai päivitä linkki Linkit-paneelin avulla.

6. Jos valitsit Muuta, etsi kirjasimen seuraava esiintymä napsauttamalla Etsi seuraava.

7. Valitse Valmis.

Etsi kirjasin -valintaikkuna on käytettävissä julkaisun esitarkastuksessa. Valitse Esitarkastus-valintaikkunasta Kirjasimet-välilehti ja valitse Etsi
kirjasin.

Jos haluat näyttää kirjasimen järjestelmäkansion, valitse kirjasin Etsi kirjasin -ikkunassa ja valitse sitten Näytä Resurssienhallinnassa (Windows)
tai Näytä Finderissa (Mac OS).
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Mac OS

Kohteiden etsiminen ja muuttaminen kyselyiden avulla

Voit etsiä ja muuttaa tekstiä, objekteja ja kuvioita käyttämällä kyselyä tai luomalla kyselyn. Kysely on määritetty etsimis- ja muuttamistoiminto.
InDesignissa on useita valmiita kyselyitä, joiden avulla voi muuttaa välimerkkien muotoa ja tehdä muita hyödyllisiä toimia, kuten muuttaa
puhelinnumeroiden muotoa. Jos tallennat luomasi kyselyn, voit käyttää sitä uudelleen ja tarjota sen muidenkin käyttöön.

Etsiminen kyselyiden avulla

1. Valitse Muokkaa > Etsi/Muuta.

2. Valitse kysely Kysely-luettelosta.

Kyselyt ryhmitellään tyypeittäin.

3. Määritä hakualue Etsi-valikossa.

Hakualue ei tallennu kyselyn mukana.

4. Valitse Etsi.

5. Voit jatkaa etsimistä valitsemalla Etsi seuraava, Muuta (muuta viimeksi löydetty teksti tai välimerkki), Muuta kaikki (sanoma ilmoittaa
muutosten kokonaismäärän), tai Muuta/Etsi (muuta teksti tai välimerkki ja jatka hakua).

Kun olet valinnut hakukyselyn, voit tarkentaa hakua säätämällä parametreja.

Kyselyiden tallentaminen

Jos haluat käyttää kyselyä uudelleen tai tarjota sen muiden käyttöön, tallenna se Etsi/Muuta-ikkunassa. Tallennettujen kyselyiden nimet näytetään
Etsi/Muuta-ikkunan Kysely-luettelossa.

1. Valitse Muokkaa > Etsi/Muuta.

2. Suorita haluamasi haku valitsemalla Teksti, GREP tai muu välilehti.

3. Määritä hakuun sisältyvät kohteet (kuten lukitut tasot, sivupohjat ja alaviitteet) napsauttamalla Etsi-valikon alla olevia vastaavia kuvakkeita.

Nämä tiedot sisältyvät tallennettuun kyselyyn, mutta Hakualuetta ei kuitenkaan tallenneta kyselyn mukana.

4. Määritä tarvittavat tiedot Etsittävä- ja Korvaava-kentissä. (Katso Etsiminen metamerkkien avulla ja Etsiminen GREP-lausekkeiden avulla.)

5. Napsauta Etsi/Muuta-ikkunan Tallenna kysely -painiketta ja kirjoita kyselyn nimi.

Jos kirjoitat jo käytössä olevan nimen, toiminto pyytää uuden nimen. Valitse Kyllä, jos haluat päivittää aiemmin luodun kyselyn.

Kyselyiden poistaminen

Valitse kysely Kysely-luettelosta ja napsauta Poista kysely -painiketta.

Kyselyiden lataaminen

Mukautetut kyselyt tallennetaan XML-tiedostoina. Mukautettujen kyselyiden nimet näytetään Etsi/Muuta-ikkunan Kysely-luettelossa.

Jos haluat ladata jonkun muun luoman kyselyn ja lisätä sen Kysely-luetteloon, kopioi kyselytiedosto seuraavaan sijaintiin:

Käyttäjät\[käyttäjätunnus]\Kirjasto\Preferences\Adobe InDesign\[versio]\[kieli]\Find-Change Queries\[kyselyn tyyppi]
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Windows XP

Windows Vista ja Windows 7

Documents and Settings\[käyttäjätunnus]\Application Data\Adobe\InDesign\[versio]\[kieli]\Find-Change Queries\[kyselyn tyyppi]

Käyttäjät\[käyttäjätunnus]\AppData\Roaming\Adobe\InDesign\[versio]\[kieli]\Find-Change Queries\[kyselyn
tyyppi]

Lisää ohjeaiheita
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Luettelomerkit ja numerointi

Alkuun

Luettelomerkittyjen tai numeroitujen luetteloiden luominen
Luettelomerkityn tai numeroidun luettelon muotoileminen
Luettelomerkin vaihtaminen
Numeroidun luettelon asetusten muuttaminen
Luetteloiden määrittäminen
Kappaletyylin luominen jatkuvia luetteloita varten
Monitasoisten luetteloiden luominen
Jatkuvien kuvatekstien luominen kuville ja taulukoille
Luettelon numeroinnin aloittaminen uudelleen tai jatkaminen
Luettelomerkkien tai numeroiden muuntaminen tekstiksi

Luettelomerkittyjen tai numeroitujen luetteloiden luominen
Luettelomerkityissä luetteloissa jokaisen kappaleen alussa on luettelomerkki. Numeroiduissa luetteloissa kappaleet alkavat ilmaisulla, joka sisältää
numeron tai kirjaimen ja erottimen, kuten pisteen tai sulkumerkin. Numeroidun luettelon numerot päivittyvät automaattisesti, kun luettelon
kappalemäärä muuttuu. Voit muuttaa luettelomerkin tai numeroinnin tyyliä, erotinta, kirjasinmääritteitä ja merkkityylejä sekä sisennyksen tyyliä ja
syvyyttä.

Luettelomerkkejä ja numeroita ei voi valita tekstityökalulla. Voit muokata muotoilua ja sisennystä Luettelomerkit ja numerointi -valintaikkunassa,
Kappale-välilehdessä tai Kappaletyylit-valintaikkunan Luettelomerkit ja numerointi -osassa (jos luettelomerkit tai numerot liittyvät johonkin tyyliin).

Luettelomerkityt ja numeroidut luettelot

Luettelomerkityn tai numeroidun luettelon voi luoda kätevästi kirjoittamalla luettelo, valitsemalla se ja valitsemalla sitten Ohjaus-välilehdestä
Luettelomerkitty luettelo tai Numeroitu luettelo. Näillä painikkeilla voit ottaa luettelon käyttöön tai poistaa sen käytöstä sekä vaihdella
luettelomerkkien ja numeroiden välillä. Voit myös liittää luettelomerkit ja numeroinnit kappaletyyliin ja koota luetteloita määrittämällä tyylejä
kappaleisiin.

Huomautus: Automaattisesti luotuja luettelo- ja numeromerkkejä ei lisätä tekstiin, joten ne eivät näy tekstihakutuloksissa eikä niitä voi valita
tekstityökalulla, ellei niitä muunneta tekstiksi. Luettelomerkit ja numerointi eivät näy myöskään juttueditorissa (paitsi kappaletyylisarakkeessa).
Voit katsoa luettelomerkittyjen ja numeroitujen luetteloiden luomista käsittelevän videon osoitteessa www.adobe.com/go/vid0077_fi.

InDesign-dokumentaatio sisältää joukon juttuja, jotka käsittelevät ääriviivojen, monitasoisten luetteloiden, kuvatekstien, ja numeroitujen vaiheiden
luomista luettelomerkeillä ja numeroinnilla.

1. Valitse luettelon muodostavat kappaleet tai napsauta kohtaa, josta haluat luettelon alkavan.
2. Tee jokin seuraavista toimista:

Napsauta Ohjaus-välilehden Luettelomerkitty luettelo -painiketta  tai Numeroitu luettelo -painiketta  (Kappale-tilassa). Avaa
Luettelomerkit ja numerointi -valintaikkuna pitämällä Alt- (Windows) tai optionäppäin (Mac OS) alhaalla napsauttaessasi painiketta.

Valitse Kappale-välilehdestä tai Komento-paneelista Luettelomerkit ja numerointi. Valitse luettelotyypiksi joko Luettelomerkit tai Numerot.
Määritä haluamasi asetukset ja valitse OK.

Käytä luettelomerkit ja numeroinnin sisältävää kappaletyyliä.
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3. Voit jatkaa luetteloa seuraavaan kappaleeseen siirtämällä lisäyskohdan luettelon loppuun ja painamalla Enter- tai Return-näppäintä.
4. Päätä luettelo (tai luettelon osa, jos luettelon on tarkoitus jatkua jäljempänä jutussa) valitsemalla uudelleen Luettelomerkitty luettelo tai

Numeroitu luettelo Ohjauspaneelista tai valitsemalla Luettelomerkit ja numerointi Kappale-paneelivalikosta.

Luettelomerkityn tai numeroidun luettelon muotoileminen
1. Valitse muokattavat luettelomerkityt tai numeroidut kappaleet tekstityökalulla .
2. Avaa Luettelomerkit ja numerointi -valintaikkuna jollakin seuraavista tavoista:

Valitse Kappale-tilassa olevan Ohjaus-välilehden tai Kappale-välilehden Luettelomerkit ja numerointi.

Napsauta joko Luettelomerkitty luettelo -painiketta  tai Numeroitu luettelo -painiketta  pitäen Alt- (Windows) tai optionäppäintä
(Mac OS) alhaalla.

3. Tee jokin seuraavista toimista Luettelomerkit ja numerointi -valintaikkunassa:

Vaihda luettelomerkki.

Muuta numeroidun luettelon asetusta.

Valitse numero- tai luettelomerkkityyli Merkkityyli-luettelosta.

4. Voit muuttaa luettelomerkin tai numeron paikkaa määrittämällä jonkin seuraavista:
Tasaus Tasaa luettelomerkit tai numerot vasemmalle, keskelle tai oikealle numeroille varatun vaakasuuntaisen tilan puitteissa. (Jos tämä tila
on kapea, näiden kolmen asetuksen välinen ero on mitätön.)

Vasen sisennys Määrittää, miten kauas ensimmäisen rivin jälkeen tulevat rivit sisennetään.

Ensirivin sisennys Määrittää, mihin luettelomerkki tai numero tulee.

Suurenna ensirivin sisennysarvoa, jos haluat pitkien luetteloiden välimerkkien olevan tasattu. Jos haluat esimerkiksi luettelonumeroinnissa
numeroiden 9. ja 10. olevan tasattu pisteeseen, vaihda tasaus oikealle ja kasvata vähitellen ensirivin sisennystä, kunnes numerot on tasattu
haluamallasi tavalla (varmista, että esikatselu on käytössä).

Jos haluat luoda riippuvan sisennystehosteen, määritä positiivinen arvo (kuten 2p0) vasemmalle tasaukselle ja määritä sitten vastaava
negatiivinen arvo (kuten -2p0) ensirivin sisennykselle.

Sijaintiasetukset

A.  Riippuva sisennys B.  Vasemmalle tasattu luettelo

Huomautus: Luettelomerkit ja numerointi -valintaikkunan Vasen sisennys-, Ensirivin sisennys- ja Sarkaimen sijainti -asetukset ovat
kappalemääritteitä. Tämän vuoksi näiden asetusten muuttaminen Kappale-välilehdessä muuttaa myös luettelomerkityn ja numeroidun
luettelon muotoilua.

Sarkaimen sijainti Aktivoi sarkaimen sijainnin ja luo tilan luettelomerkin tai numeron ja luettelokohdan alun välille.

Luettelomerkit ja numerot perivät oletusarvoisesti osan tekstimuotoilustaan sen kappaleen ensimmäisestä merkistä, johon ne liitetään. Jos jonkin
kappaleen ensimmäinen merkki poikkeaa muiden kappaleiden ensimmäisistä merkeistä, numerointi tai luettelomerkki on erilainen kuin muussa
luettelossa. Jos tämä ei ole haluamasi muotoilu, luo numeroille tai luettelomerkeille merkkityyli ja määritä se luetteloon Luettelomerkit ja numerointi
-valintaikkunan kautta.
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Jos vaiheen 3 ensimmäinen sana on kursivoitu, myös numerointi kursivoituu, ellet luo numeroille merkkityyliä ja määritä sitä luetteloon.

Luettelomerkin vaihtaminen
Jos et halua käyttää valmiita luettelomerkkejä, voit lisätä uusia luettelomerkkejä Luettelomerkki-ruudukkoon. Luettelomerkit vaihtelevat
kirjasinlajeittain. Voit määrittää, muistetaanko lisäämäsi luettelomerkin kirjasin.

Jos haluat käyttää luettelomerkissä tiettyä kirjasinta (kuten Dingbat-merkkien osoittavaa kättä), varmista, että luettelomerkki muistaa tämän
kirjasimen. Perusluettelomerkin kirjasinta sen sijaan ei kannata muistaa, koska useimmissa kirjasimissa on oma perusluettelomerkki. Jos valitset
luettelomerkkiasetukseksi Muista kirjasin, lisäämäsi luettelomerkki voi käyttää joko Unicode-arvoa ja tiettyä kirjasinperhettä tai pelkkää Unicode-
arvoa.

Huomautus: vain Unicode-arvoon viittaavien luettelomerkkien (ei muistettua kirjasinta) yhteydessä näkyy punainen "u"-merkki.

Luettelomerkit ja numerointi -valintaikkuna
A. Luettelomerkki, kirjasinta ei muisteta B. Luettelomerkki, kirjasin muistetaan

Luettelomerkin vaihtaminen
1. Valitse Ohjaus- tai Kappale-paneelivalikosta Luettelomerkit ja numerointi.
2. Valitse Luettelomerkit ja numerointi -valintaikkunassa luettelotyypiksi Luettelomerkit.
3. Valitse jokin muu luettelomerkki ja sitten OK.

Luettelomerkin lisääminen
1. Valitse Luettelomerkit ja numerointi -valintaikkunassa luettelotyypiksi Luettelomerkit. Valitse sitten Lisää.
2. Valitse kuvio, jota haluat käyttää luettelomerkkinä. (Eri kirjasinperheet ja kirjasintyylit sisältävät eri kuvioita.)
3. Jos haluat uuden luettelomerkin muistavan valitun kirjasimen ja tyylin, valitse Muista luettelomerkin kirjasin.
4. Valitse Lisää.

Huomautus: Luettelomerkkien luettelo tallennetaan julkaisuun kappale- ja merkkityylien tavoin. Kun liität tai lataat kappaletyylejä toisesta
julkaisusta, näissä tyyleissä käytetyt luettelomerkit näkyvät Luettelomerkit ja numerointi -valintaikkunassa muiden nykyiseen julkaisuun
määritettyjen luettelomerkkien ohella.

Luettelomerkin poistaminen
1. Valitse Luettelomerkit ja numerointi -valintaikkunassa luettelotyypiksi Luettelomerkit.
2. Valitse poistettava luettelomerkki. Valitse Poista. (Ensimmäistä oletusluettelomerkkiä ei voi poistaa.)
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Numeroidun luettelon asetusten muuttaminen
Numeroidun luettelon numerot päivittyvät automaattisesti, kun luettelon kappalemäärä muuttuu. Kappaleet, jotka kuuluvat samaan luetteloon,
numeroidaan järjestyksessä. Näiden kappaleiden ei tarvitse olla peräkkäisiä, kun kappaleille määritetään luettelo.

Voit myös luoda monitasoisia luetteloita, joissa luettelokohdat numeroidaan jäsennysmuodossa ja sisennetään eri asteilla.

1. Avaa Luettelomerkit ja numerointi -valintaikkuna.
2. Valitse haluamasi numerointitapa Numerointityyli-kohdan Muoto-valikosta.
3. Käytä Numero-ruudussa joko oletusilmausta, eli pistettä (.) ja sarkainta (^t), tai koosta oma numeroilmaisu. Jos haluat luoda numeroilmaisun,

poista numeron metamerkin (^#) jäljessä oleva piste ja tee jokin seuraavista:

Kirjoita merkki (esimerkiksi loppusulkumerkki) tai enemmän kuin yksi merkki pisteen tilalle.

Valitse jokin vaihtoehto (kuten Em-viiva tai Ellipsit) Lisää erikoismerkki -valikosta.

Kirjoita sana tai merkki numeron metamerkin edelle. Jos esimerkiksi haluat numeroida kysymyksiä luetteloon, voit lisätä sanan Kysymys.

4. Valitse ilmauksen merkkityyli. (Valitsemaasi tyyliä käytetään koko numeroilmaisussa, ei vain numerossa.)
5. Valitse Tila-kohdasta jokin seuraavista asetuksista:

Jatka edellisestä numerosta Numeroi luettelot järjestyksessä.

Aloita kohdasta Aloittaa numeroinnin tekstikenttään kirjoittamastasi numerosta tai muusta arvosta. Kirjoita numero, älä kirjainta, vaikka
luettelossa käytettäisiin numeroinnissa kirjaimia tai roomalaisia numeroita.

6. Määritä muut haluamasi asetukset ja valitse sitten OK.

Luetteloiden määrittäminen
Määritetty luettelo voidaan keskeyttää muilla kappaleilla tai luetteloilla, ja luettelo voi jatkua eri juttuihin ja eri julkaisuihin kirjassa. Määritettyjen
luetteloiden avulla voit esimerkiksi luoda koko julkaisun kattavan monitasoisen jäsennyksen tai juoksevan luettelon numeroitujen taulukoiden
nimistä. Voit määrittää luetteloita myös keskenään sekoitettaville erikseen numeroiduille tai luettelomerkityille kohteille. Esimerkiksi kysymys- ja
vastausluettelossa voit määrittää yhden luettelon kysymysten numerointia varten ja toisen vastausten numerointia varten.

Määritettyjen luetteloiden avulla seurataan kappaleita numerointitarkoituksessa. Kun luot numeroinnille kappaletyylin, voit määrittää tyylin
määritettyyn luetteloon. Tällöin kappaleet numeroidaan tällä tyylillä sen perusteella, missä ne ovat määritetyssä luettelossa. Ensimmäiseksi
näkyvälle kappaleelle annetaan numero 1 (Taulukko 1) ja seuraavalle kappaleelle annetaan numero 2 (Taulukko 2), vaikka se olisi vasta monen
sivun päässä. Koska kumpikin kappale kuuluu samaan määritettyyn luetteloon, ne voidaan numeroida järjestyksessä riippumatta siitä, kuinka
kaukana toisistaan ne ovat julkaisussa tai kirjassa.

Määritä uusi luettelo jokaiselle numeroitavalle kohdetyypille, esimerkiksi vaiheittaisille ohjeille, taulukoille ja kuville. Määrittämällä useita luetteloita
voit keskeyttää yhden luettelon toisella luettelolla ja säilyttää numeroinnin kummassakin luettelossa.

Jos luettelokohteita esiintyy ketjuttamattomissa kehyksissä samalla sivulla, kohteet numeroidaan siinä järjestyksessä, jossa tekstikehykset
lisätään sivulle. Jos haluat järjestää tekstikehykset uudelleen, leikkaa ja liitä kehykset yksitellen luetteloon haluamassasi järjestyksessä.
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Määritettyjen luetteloiden avulla voit katkaista yhden luettelon toisella.

Voit katsoa luettelomerkittyjen ja numeroitujen luetteloiden luomista käsittelevän videon osoitteessa www.adobe.com/go/vid0077_fi.

Luettelon määrittäminen
1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse Määritä luetteloita -valintaikkunasta Uusi.
3. Anna luettelolle nimi ja valitse, haluatko jatkaa numerointia eri juttujen välillä ja jatkaa numerointia kirjan aiemmista julkaisuista.
4. Valitse OK kaksi kertaa.

Kun olet määrittänyt luettelon, voit käyttää sitä kappaletyylissä, kuten taulukkojen, kuvien tai järjestyksessä olevien luetteloiden tyylissä. Voit
käyttää sitä myös Ohjaus- ja Kappale-välilehtien kautta.

Huomautus: Jotkut luettelot määritetään automaattisesti. Kun esimerkiksi tuot numeroidun luettelon Microsoft Word -asiakirjasta, InDesign
määrittää automaattisesti luettelon julkaisullesi.

Määritetyn luettelon muokkaaminen
1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse luettelo ja sitten Muokkaa.
3. Anna luettelolle uusi nimi tai muuta Jatka numerointia -asetusta.

Luetteloon määritetyt kappaletyylit määritetään luetteloon uudelleen uudella nimellä.

Määritetyn luettelon poistaminen
1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse luettelo.
3. Valitse Poista ja valitse sitten eri luettelo tai [Oletus]-luettelo, jolla luettelo korvataan.

Kappaletyylin luominen jatkuvia luetteloita varten
Jos haluat luoda jatkuvan luettelon (luettelo, jonka muut kappaleet keskeyttävät, tai joka jatkuu useisiin juttuihin tai julkaisuihin), luo kappaletyyli ja
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käytä tätä tyyliä kappaleissa, joiden haluat kuuluvan luetteloon. Kun haluat luoda julkaisuun esimerkiksi jatkuvan taulukkoluettelon, luo kappaletyyli
nimeltä Taulukot, liitä määritetty luettelo osaksi tyyliä ja käytä sitten Taulukko-kappaletyyliä kaikissa kappaleissa, jotka haluat mukaan
taulukkoluetteloon.

InDesign-dokumentaatio sisältää joukon juttuja, jotka käsittelevät kuvatekstien ja numeroitujen vaiheiden luomista luettelomerkeillä ja numeroinnilla.

1. Valitse Kappaletyylit-välilehden valikosta Uusi kappaletyyli.
2. Kirjoita tyylille nimi.
3. Valitse Uusi kappaletyyli -valintaikkunan vasemmasta reunasta Luettelomerkit ja numerointi.
4. Valitse luettelotyypiksi Luettelomerkit tai Numerointi.
5. Jos luot tyyliä numeroituja luetteloita varten, valitse määritetty luettelo Luettelo-valikosta tai valitse Uusi luettelo, ja määritä luettelo.
6. Määritä luettelomerkin tai numeroinnin ominaisuudet.
7. Voit muuttaa sisennystä Uusi kappaletyyli -valintaikkunan Luettelomerkin tai numeron sijainti -osassa. Jos haluat esimerkiksi luoda

negatiivisen sisennyksen, kirjoita vasemmaksi sisennykseksi 2p ja ensirivin sisennykseksi -2p.
8. Määritä tyylin muut kappaletyylimääritteet ja valitse OK.

Monitasoisten luetteloiden luominen
Monitasoinen luettelo on luettelo, jossa on useita kappaleluettelon välisiä suhteita kuvailevia hierarkkisia tasoja. Näitä luetteloita kutsutaan myös
jäsennysluetteloiksi, koska ne muistuttavat hahmotelmia. Luettelon numerointi (ja sisennykset) osoittavat arvoaseman ja sen, miten osat ovat
alistussuhteessa toisiinsa nähden. Luettelosta näkyy, miten kukin kappale sijoittuu luettelossa suhteessa sitä edeltäviin ja sen jäljessä oleviin
kappaleisiin. Monitasoisessa luettelossa voi olla enintään yhdeksän tasoa.

Monitasoinen luettelo, jossa numerot ja kirjaimet osoittavat hierarkiatasot

Jos haluat luoda monitasoisen luettelon, määritä luettelo ja luo sitten kappaletyyli kullekin haluamallesi tasolle. Esimerkiksi nelitasoinen luettelo
vaatii neljä kappaletyyliä (jokainen tyyli määritetään samaan luetteloon). Aina kun luot tyylin, määrität sen numerointimuodon ja kappalemuotoilun.

Gabriel Powell on tehnyt ääriviivojen ja monitasoisten luetteloiden luomista koskevan videon. Se löytyy osoitteesta Automaattisen numeroidun
luettelon luominen.

Bob Bringhurst on kirjoittanut joukon juttuja, jotka käsittelevät ääriviivojen, monitasoisten luetteloiden, kuvatekstien, ja numeroitujen vaiheiden
luomista luettelomerkeillä ja numeroinnilla.

1. Valitse Kappaletyylit-välilehden valikosta Uusi kappaletyyli.
2. Kirjoita tyylille nimi.
3. Jos olet jo luonut tyylin monitasoiseen luetteloosi, valitse Perustuu-valikosta tyyli, jonka haluat määrittää tätä ylemmille tasoille. Valitse

muussa tapauksessa Ei kappaletyyliä tai Peruskappale.
4. Valitse Uusi kappaletyyli -valintaikkunan vasemmasta reunasta Luettelomerkit ja numerointi..
5. Valitse Luettelotyyppi-valikosta Numerot.
6. Valitse määrittämäsi luettelo Luettelo-valikosta. Jos et ole vielä määrittänyt luetteloa, voit määrittää sen nyt valitsemalla valikosta Uusi

luettelo..
7. Kirjoita Taso-ruutuun numero, joka kuvaa mille monitasoisen luettelon tasolle luotava tyyli on tarkoitettu.
8. Valitse haluamasi numerointityyppi Muoto-valikosta.
9. Kuvaile tämän tason luettelokohdissa käytettävä numeromuotoilu kirjoittamalla metamerkkejä Numero-ruutuun tai valitsemalla metamerkkejä

valikoista.
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Jos haluat lisätä numeroinnin etuliitteitä korkeammilta tasoilta, kirjoita teksti tai napsauta Numero-ruudun alkua ja valitse Lisää numeron
paikkamerkki. Valitse sitten Taso-asetus (esimerkiksi Taso 1) tai kirjoita ^ ja sitten luettelotaso (esimerkiksi ^1). Kun luettelossa
ensimmäisten tasojen numerointi on 1, 2, 3, ja niin edelleen, ja toisten tasojen numerointi on a, b, c, ja niin edelleen, ensimmäisen tason
etuliitteen lisääminen toiseen tasoon tuottaa toisen tason numeroinniksi 1a, 1b, 1c; 2a, 2b, 2c; 3a, 3b, 3c..

Jos haluat luoda numeroilmaisun, lisää välimerkit, lisää metamerkkejä tai valitse asetuksia Lisää erikoismerkki -luettelosta.

10. Valitsemalla Aloita tämän tason numerointi uudelleen seuraavan kohdan jälkeen voit aloittaa numeroinnin uudelleen numerosta 1, kun tämän
tason kappale tulee korkeamman tason kappaleen jälkeen. Poista tämän asetuksen valinta, jos haluat numeroida tämän tason kappaleet
peräkkäin koko luettelossa riippumatta siitä, mihin kappaleet sijoittuvat luettelon hierarkiassa.

Jos haluat aloittaa numerot uudelleen tietyn tason tai tasoalueen jälkeen, kirjoita tason numero tai alue (esimerkiksi 2-4) Aloita tämän tason
numerointi uudelleen seuraavan kohdan jälkeen -kenttään.

11. Voit sisentää tämän tason luettelokohdat korkeampien tasojen luettelokohtia syvemmälle valitsemalla Luettelomerkin tai numeron sijainti -
alueelta Sisennyksen tai sarkaimen sijainti -asetuksia. Sisentäminen auttaa erottamaan luettelon alistussuhteiset kohdat.

12. Valitse OK.

Joskus, kuten numeroitujen vaiheiden yhteydessä, saatat joutua aloittamaan numeroinnin uudelleen saman jutun sisällä. Jos haluat välttyä
luettelonumeroinnin aloittamisesta uudelleen manuaalisesti, luo tason 1 tyyliä vastaava erillinen tyyli, jossa on yksi poikkeus. Valitse Tilaksi Aloita
kohdasta ja määritä 1. Anna tyylille nimeksi esimerkiksi Taso 1 aloita uudelleen.

Jatkuvien kuvatekstien luominen kuville ja taulukoille
Jatkuvat kuvatekstit numeroivat kuvat, taulukot ja muut kohteet järjestyksessä julkaisussa. Esimerkiksi ensimmäinen kuvateksti alkaa sanoilla
"Kuva 1", toinen sanoilla "Kuva 2", ja niin edelleen. Voit varmistaa, että kuvat, taulukot ja vastaavat kohteet numeroidaan järjestyksessä,
määrittämällä kohteelle luettelon ja luomalla sitten kappaletyylin, joka sisältää luettelomääritelmän. Voit lisätä kappaletyylin numerointiin myös
kuvaavia sanoja, kuten "Kuva" tai "Taulukko".

Bob Bringhurst on kirjoittanut jutun kuvatekstien luomisesta. Se löytyy osoitteesta Numeroidut luettelot osa III - Kuvatekstit.

Luettelokohteet numeroidaan siinä järjestyksessä, jossa ne lisätään sivulle. Jos haluat järjestää kohteet uudelleen, leikkaa ja liitä kohteet
yksitellen luetteloon haluamassasi järjestyksessä.

1. Luo uusi kappaletyyli ja valitse Kappaletyylit-valintaikkunan Luettelomerkit ja numerointi -osan Luettelotyyppi-valikosta Numerot.
2. Valitse määritetty luettelo Luettelo-valikosta (tai määritä luettelo valitsemalla Uusi luettelo).
3. Valitse haluamasi numerointitapa Numerointityyli-kohdan Muoto-valikosta.

Voit esimerkiksi luoda luettelon "Kuva A", "Kuva B" ja niin edelleen valitsemalla A, B, C, D... -asetuksen.

4. Kirjoita Numero-ruutuun kuvaava sana sekä (tarvittaessa) välilyönnit ja välimerkit sekä numeroinnin metamerkit.

Jos haluat luoda esimerkiksi "Kuva A" -tehosteen, kirjoita sana "Kuva" ja välilyönti numeroinnin metamerkkien edelle (esimerkiksi Kuva ^#.^t).
Tämä lisää sanan "Kuva", jota seuraavat järjestysnumero (^#), piste ja sarkain (^t).

Huomautus: jos haluat lisätä lukujen numeroita jatkuviin kuvateksteihin, valitse Numero-luettelosta Lisää numeron paikkamerkki >
Lukunumero tai kirjoita ^H kohtaan, jossa haluat luvun numeron näkyvän numeroinnissa.

5. Päätä tyylin luominen ja valitse OK.

Kun olet luonut tyylin, käytä sitä kuvateksteissä tai taulukoiden otsikoissa.

Voit luoda taulukko- tai kuvaluettelon Sisällysluettelo-ominaisuuden avulla.

Luettelon numeroinnin aloittaminen uudelleen tai jatkaminen
InDesign sisältää komentoja, joilla voidaan aloittaa luettelo uudelleen tai jatkaa luetteloa:

Numeroidun luettelon aloittaminen uudelleen Aseta lisäyskohta kappaleeseen ja valitse pikavalikosta Aloita numerointi uudelleen tai valitse
Teksti > Luettelomerkityt ja numeroidut luettelot > Aloita numerointi uudelleen. Tavallisissa luetteloissa tämä komento määrittää numeron 1 (tai
kirjaimen A) johonkin kappaleeseen ja tekee siitä luettelon ensimmäisen kappaleen. Monitasoisissa luetteloissa tämä komento määrittää
ensimmäisen alemman tason numeron sisäkkäiseen kappaleeseen.
Numeroidun luettelon jatkaminen Valitse pikavalikosta Jatka numerointia tai valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Jatka
numerointia. Tämä komento jatkaa huomautuksen, kuvan tai sisäkkäisten luettelokohtien katkaiseman luettelon numerointia. InDesign sisältää
myös komentoja, joilla voidaan numeroida luetteloita, jotka alkavat yhdessä jutussa tai kirjassa ja jatkuvat seuraavassa jutussa tai kirjassa.

Aiemman tai nykyisen jutun luettelon numeroiminen
Luettelon numeroinnin jatkuminen aiemmasta jutusta tai numeroinnin alkaminen uudelleen nykyisessä jutussa määräytyy luettelon määritysten
perusteella.

1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse luettelo ja napsauta Muokkaa-painiketta.
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Älä valitse oletusluetteloa, sillä se ei voi jatkua jutusta toiseen.

3. Jos haluat jatkaa luettelon numerointia aiemmasta jutusta, valitse Jatka numerointia juttujen välillä. Jos haluat aloittaa luettelon nykyisessä
jutussa numerosta 1 (tai kirjaimesta A), poista tämän asetuksen valinta.

4. Valitse OK kaksi kertaa.

Luettelon numerointi kirjan aiemmasta tai nykyisestä julkaisusta
Luettelon numeroinnin jatkuminen kirjan aiemmasta julkaisusta tai numeroinnin alkaminen uudelleen nykyisessä julkaisussa määräytyy luettelon
määritysten perusteella.

1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse luettelo ja napsauta Muokkaa-painiketta.
3. Jos haluat jatkaa luettelon numerointia aiemmasta julkaisusta, valitse Jatka numerointia kirjan edellisestä julkaisusta (tämän asetuksen

käyttö edellyttää, että Jatka numerointia juttujen välillä -asetus on valittuna). Jos haluat aloittaa luettelon nykyisessä julkaisussa numerosta 1
(tai kirjaimesta A), poista tämän asetuksen valinta.

4. Valitse OK kaksi kertaa.

Varmista, että kirjan numerointi päivitetään kunnolla synkronoimalla kirjan sisältämät julkaisut ja valitsemalla Kirjat-paneelivalikosta Päivitä
numerointi > Päivitä kaikki numerot.

Luettelomerkkien tai numeroiden muuntaminen tekstiksi
1. Valitse kappaleet, joissa on luettelomerkittyjä tai numeroituja luetteloita.
2. Tee jokin seuraavista:

Valitse Kappale-välilehden valikosta Muunna numerointi tekstiksi tai Muunna luettelomerkit tekstiksi.

Napsauta valintaa hiiren kakkospainikkeella (Windows) tai Ctrl-näppäin alhaalla (Mac OS) ja valitse Muunna numerointi tekstiksi tai
Muunna luettelomerkit tekstiksi.

Huomautus: jos haluat poistaa luettelon numerot tai luettelomerkit, poista luettelomuotoilu valitusta tekstistä napsauttamalla Numeroitu
luettelo -painiketta tai Luettelomerkitty luettelo -painiketta.

Lisää ohjeaiheita
Luettelomerkittyjä ja numeroituja luetteloita käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma

447

http://www.adobe.com/go/vid0077_fi
http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fi/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fi


Muutosten jäljittäminen ja tarkasteleminen
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Muutosten jäljittäminen
Muutosten hyväksyminen ja hylkääminen
Jäljitä muutokset -asetusten määrittäminen
Käyttäjänimen ja käyttäjän värin muuttaminen

Muutosten jäljittäminen
Yksi hyödyllinen ominaisuus on mahdollisuus jäljittää muutokset, joita eri tekijät ovat tehneet juttuun kirjoitus- ja muokkausprosessin aikana. Aina
kun joku lisää, poistaa tai siirtää jutussa olevaa tekstiä, muutos merkitään InDesignin juttueditoriin tai InCopyn Raakateksti- ja Juttu-näkymiin. Voit
sitten hyväksyä tai hylätä muutokset.

InDesignin Jäljitä muutokset -paneelista tai InCopyn Jäljitä muutokset -työkalurivistä voit valita, onko muutosten jäljitys käytössä, sekä näyttää,
kätkeä, hyväksyä tai hylätä tehdyt muutokset.

Muutosten jäljittäminen juttueditorissa (InDesign)
A. Muutospalkit B. Lisätty teksti C. Poistettu teksti D. Siirretty teksti (poistettu) E. Siirretty teksti (lisätty)

Muutosten jäljittämisen ottaminen käyttöön

1. Avaa Jäljitä muutokset -paneeli valitsemalla Valitse Ikkuna > Pääkirjoitus > Jäljitä muutokset (InDesign) tai avaa Jäljitä muutokset -työkalurivi
valitsemalla Ikkuna > Jäljitä muutokset -työkalurivi (InCopy).

2. Kun tekstin lisäyskohta on tekstissä, tee jokin seuraavista:

Jos haluat ottaa muutosten jäljittämisen käyttöön vain nykyisessä jutussa, napsauta Ota Jäljitä muutokset -toiminto käyttöön nykyisessä
jutussa -kuvaketta .

(InDesign) Jos haluat ottaa muutosten jäljittämisen käyttöön kaikissa jutuissa, valitse Jäljitä muutokset -paneelivalikosta Ota jäljitys
käyttöön kaikissa jutuissa.

(InCopy) Jos julkaisussa on useita juttuja, ota muutosten jäljittäminen käyttöön kaikissa avoinna olevissa jutuissa valitsemalla Muutokset
> Ota jäljitys käyttöön kaikissa jutuissa.

3. Lisää, poista tai siirrä jutun tekstiä tarpeen mukaan.

Jäljitettyjen muutosten merkitseminen
Kun Jäljitä muutokset -toiminto on käytössä, kaikki muutokset merkitään oletuksena seuraavasti juttueditorissa (InDesign) ja Raakateksti- ja Juttu-
näkymissä (InCopy):

Asetukset-valintaikkunan Jäljitä muutokset -osiosta voit valita värin, jolla tekemäsi muutokset ilmaistaan. Voit myös valita, mitä muutoksia
(lisäykset, poistot tai tekstin siirrot) haluat jäljitettävän ja jäljityksen ulkoasun.

Lisätty teksti Korostettu.
Poistettu teksti Korostettu ja yliviivattu.
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Siirretty (leikattu ja liitetty) teksti Alkuperäisessä sijainnissa korostettu ja yliviivattu, uudessa sijainnissa korostettu ja merkitty kehyksellä.
Huomautus: Jos leikkaat tekstin yhdestä julkaisusta ja liität sen toiseen, teksti näkyy alkuperäisessä julkaisussa poistettuna ja kohdejulkaisussa
lisättynä tekstinä.
Kopioitu teksti Korostettu uudessa sijainnissa. Alkuperäinen teksti ei ole muuttunut.
Muutospalkit Muutospalkki on pystysuora viiva, joka näkyy muutetun tekstirivin vasemmalla puolella. Voit valita, ovatko muutospalkit
työskennellessä näkyvissä vai kätkettyinä. Voit myös määrittää muutospalkkien värin.

Muutosten näyttäminen ja kätkeminen
Kun muutokset on kätketty, teksti näkyy samanlaisena kuin silloin, kun muutosten jäljittäminen ei ole käytössä. Tällöin lisätty teksti näkyy, poistettu
teksti ei näy ja siirretty tai liitetty teksti näkyy lisäyskohdassa.

(InDesign) Kun muutosten jäljitys on käytössä, muokkausta jäljitetään riippumatta siitä, työskenteletkö juttueditorissa tai julkaisun sivuasettelussa.
Voit katsella muutoksia vain juttueditorissa, et sivuasettelunäkymässä.

(InCopy) Kun muutosten jäljitys on käytössä, muokkausta jäljitetään riippumatta siitä, työskenteletkö Raakateksti-, Juttu- vai Sivuasettelu-
näkymässä. Muutoksia voi tarkastella vain Raakateksti- ja Juttu-näkymissä, ei Sivuasettelu-näkymässä.

 Napsauta Jäljitä muutokset -paneelissa (InDesign) tai Jäljitä muutokset -työkalurivillä (InCopy) Näytä/Kätke muutokset -painiketta .

Muutosten jäljittämisen poistaminen käytöstä
 Kun tekstin lisäyskohta on tekstissä, tee jokin seuraavista:

Jos haluat poistaa muutosten jäljittämisen käytöstä vain nykyisessä jutussa, napsauta Poista Jäljitä muutokset -toiminto käytöstä -kuvaketta 

.

(InDesign) Jos haluat poistaa muutosten jäljittämisen käytöstä kaikissa jutuissa, valitse Jäljitä muutokset -paneelivalikosta Poista jäljitys
käytöstä kaikissa jutuissa.

(InCopy) Jos julkaisussa on useita juttuja, poista muutosten jäljittäminen käytöstä kaikissa avoinna olevissa jutuissa valitsemalla Muutokset >
Poista jäljitys käytöstä kaikissa jutuissa.

Huomautus: Kun otat jäljityksen pois käytöstä, uusia muutoksia ei jäljitetä. Tämä ei vaikuta aikaisemmin jäljitettyihin muutoksiin.

Muutosten hyväksyminen ja hylkääminen
Kun juttuun on tehty muutoksia, muutosten jäljittämisen avulla voit tarkastella kaikkia muutoksia ja päättää, sisällytetäänkö ne juttuun. Tämä koskee
niin omia muutoksiasi kuin muiden tekemiä muutoksia. Voit hyväksyä tai hylätä yksittäisiä jäljitettyjä muutoksia, muutosten osia tai kaikki muutokset
samalla kertaa.

Kun hyväksyt muutoksen, se muuttuu tavalliseksi tekstiksi, jota ei enää korosteta muutoksena. Kun hylkäät muutoksen, teksti palaa muotoon, jossa
se oli ennen muutoksen tekemistä.

1. Aseta lisäyskohta jutun alkuun juttueditorissa (InDesign) tai raakateksti- tai juttunäkymässä (InCopy).

2. Napsauta Jäljitä muutokset -paneelissa (InDesign) tai Jäljitä muutokset -työkalurivillä (InCopy) Seuraava muutos -painiketta .

3. Tee jokin seuraavista toimista:

Hyväksy korostettu muutos ja sisällytä se tekstiin napsauttamalla Hyväksy muutos -painiketta .

Hylkää muutos ja palauta alkuperäinen teksti napsauttamalla Hylkää muutos -painiketta .

Jos haluat hyväksyä tai hylätä muutoksen ja siirtyä seuraavaan muutokseen, napsauta Hyväksy muutos- tai Hylkää muutos -painiketta
Ctrl-näppäin (Windows) tai optionäppäin (Mac OS) alhaalla.

Jos palata edelliseen muutokseen tai hypätä muutoksen yli ja siirtyä seuraavaan muutokseen, napsauta Edellinen muutos-  tai
Seuraava muutos -painiketta .

Jos haluat hyväksyä tai hylätä kaikki muutokset, napsauta Hyväksy kaikki tämän jutun muutokset -painiketta  tai Hylkää kaikki tämän
jutun muutokset -painiketta .

Jos haluat hyväksyä tai hylätä kaikki jutun tai julkaisun muutokset tai hyväksyä tai hylätä kaikki tietyn osallistujan tekemät muutokset,
valitse soveltuva vaihtoehto Jäljitä muutokset -paneelivalikosta (InDesign) tai Muutokset-valikosta (InCopy).

Huomautus: jos muutat mielesi muutoksen hyväksymisestä tai hylkäämisestä, voit kumota toiminnon valitsemalla Muokkaa > Kumoa tai
painamalla näppäinyhdistelmää Ctrl+Z (Windows) tai komento+Z (Mac OS).
Hyväksy kaikki muutokset- tai Hylkää kaikki muutokset -komennon valinta vaikuttaa myös piilotettuun ehdolliseen tekstiin.

Jäljitä muutokset -asetusten määrittäminen
Asetuksissa voit määrittää useita jäljityksen asetuksia. Voit määrittää muutosten värin ja valita, mitä muutoksia jäljitetään: tekstin lisäyksiä, poistoja
vai siirtoja. Voit määrittää myös jokaisen jäljitettävän muutostyypin ulkoasun ja ottaa käyttöön värilliset muutospalkit, jotka osoittavat sivun
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reunuksissa muutoksia.

1. Valitse Muokkaa > Asetukset > Jäljitä muutokset (Windows) tai InDesign > Asetukset > Jäljitä muutokset (Mac OS).

2. Valitse kaikki muutostyypit, joita haluat jäljittää.

3. Määritä jokaiselle muutostyypille tekstin väri, tausta, taustan väri ja merkintätapa.

4. Valitse Estä päällekkäisten värien käyttö, jos haluat varmistaa, että kaikille käyttäjille on määritetty eri väri.

5. Jos haluat näyttää muutospalkit, valitse Muutospalkit-asetus. Valitse väri Muutospalkin väri -valikosta ja määritä, näytetäänkö palkit
vasemmassa vai oikeassa reunuksessa.

6. Valitse Sisällytä poistettu teksti oikolukuun, jos haluat tarkistaa poistetuksi merkityn tekstin oikeinkirjoituksen.

7. Napsauta OK-painiketta.

Käyttäjänimen ja käyttäjän värin muuttaminen
1. Valitse Tiedosto > Käyttäjä.
2. Määritä käyttäjänimi sekä muutosten jäljittämisessä ja huomautuksissa käytettävä väri. Valitse lopuksi OK.

Lisää ohjeaiheita
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Tekstimuuttujien luominen ja muokkaaminen
Tekstimuuttujien lisääminen
Tekstimuuttujien poistaminen, muuntaminen ja tuominen

Tekstimuuttujien luominen ja muokkaaminen
Tekstimuuttuja on kohde, joka lisätään julkaisuun ja joka vaihtelee kontekstin mukaan. Esimerkiksi Viimeisen sivun numero -muuttuja näyttää
julkaisun viimeisen sivun numeron. Jos lisäät tai poistat sivuja, muuttuja päivittyy tämän mukaisesti.

InDesign sisältää useita valmiiksi määritettyjä tekstimuuttujia, joita voit lisätä julkaisuun. Voit muokata näiden muuttujien muotoilua tai luoda omia
muuttujia. Eräitä muuttujia (esimerkiksi juokseva ylätunniste ja lukunumero) on erityisen hyödyllistä lisätä sivupohjiin, sillä ne varmistavat
yhdenmukaisen muotoilun ja numeroinnin. Toisia muuttujia (esimerkiksi luontipäivämäärä ja tiedostonimi) on hyödyllistä lisätä esimerkiksi
tulostuksen informaatioalueeseen.

Huomautus: Jos muuttujaan lisätään liikaa tekstiä, teksti voi muuttua ylijuoksevaksi tai pakatuksi. Muuttujan teksti ei vaihda riviä.

Tekstimuuttujien luominen tai muokkaaminen
Muuttujan luomisessa käytettävissä olevat asetukset riippuvat määrittämästäsi muuttujatyypistä. Jos esimerkiksi valitset lukunumerotyypin, voit
määrittää tekstin näkymään sekä ennen numeroa että sen jälkeen, ja voit myös määrittää numerointityylin. Voit luoda useita samaan
muuttujatyyppiin perustuvia erilaisia muuttujia. Voit esimerkiksi luoda muuttujan, joka näyttää tekstin "1. luku", ja toisen muuttujan, joka näyttää
tekstin "Luku 1".

Jos valitset juoksevan ylätunnistetyypin, voit määrittää, mitä tyyliä ylätunnisteen perustana käytetään, ja voit valita virkkeiden lopun välimerkkien
poistamiseen ja kirjainkoon muuttamiseen liittyviä asetuksia.

1. Jos haluat luoda kaikissa uusissa julkaisussa käytettäviä tekstimuuttujia, sulje kaikki julkaisut. Muussa tapauksessa luomasi tekstimuuttujat
näkyvät vain nykyisessä julkaisussa.

2. Valitse Teksti > Tekstimuuttujat > Määritä.

3. Napsauta Uusi-painiketta tai valitse olemassa oleva muuttuja ja valitse Muokkaa.

4. Kirjoita muuttujan nimi (esimerkiksi "Täysi luku" tai "Juokseva otsikko").

5. Valitse Teksti-valikosta muuttujatyyppi, määritä sen asetukset ja valitse OK.

Käytettävissä olevat asetukset vaihtelevat valitsemasi muuttujatyypin mukaan.

Teksti ennen / Teksti jälkeen Voit määrittää kaikille muuttujatyypeille (mukautettua tekstiä lukuun ottamatta) tekstin, joka lisätään muuttujan
eteen tai jälkeen. Voit esimerkiksi lisätä sanan "yhteensä" Viimeisen sivun numero -muuttujan eteen ja sanan "sivusta" muuttujan jälkeen,
jolloin muodostuisi esimerkiksi kokonaisuus "yhteensä 12 sivusta". Voit myös liittää ruutuihin tekstiä, mutta erikoismerkit, kuten sarkaimet ja
automaattiset sivunumerot, poistetaan. Jos haluat lisätä erikoismerkkejä, napsauta tekstiruudun oikealla puolella olevaa kolmiota.

Tyyli Voit määrittää kaikille numeroiduille muuttujatyypeille numerointityylin. Jos [Nykyinen numerointityyli] on valittuna, muuttuja käyttää
julkaisun Numerointi- ja osioasetukset -valintaikkunassa valittua numerointityyliä.

Muuttujatyypit

Luvun numero
Lukunumerotyypillä luotu muuttuja lisää luvun numeron. Voit lisätä tekstiä lukunumeron eteen tai jälkeen ja määrittää numerointityylin.

Jos julkaisun lukunumeron on määrä jatkaa kirjan aikaisemmasta julkaisusta, saatat joutua päivittämään kirjan numeroinnin, jotta oikea lukunumero
tulee näkyviin.

Luontipäivämäärä, muokkauspäivämäärä ja tulostuspäivämäärä
Luontipäivämäärä lisää päivämäärän tai kellonajan, jolloin julkaisu tallennettiin ensimmäisen kerran. Muokkauspäivämäärä lisää päivämäärän tai
kellonajan, jolloin julkaisu tallennettiin viimeksi levylle. Tulostuspäivämäärä lisää päivämäärän tai kellonajan, jolloin julkaisu tulostettiin, vietiin PDF-
muotoon tai pakattiin. Voit lisätä tekstiä päivämäärän eteen ja jälkeen ja voit muokata kaikkien päivämäärämuuttujien päiväyksen muotoa.

Päiväyksen muoto Voit kirjoittaa päiväysmuodot suoraan Päiväyksen muoto -ruutuun tai valita muotoasetukset napsauttamalla ruudun oikealla
puolella olevaa kolmiota. Esimerkiksi päiväyksen muoto "MM/dd/yy" näkyy seuraavasti: 12/22/07. Jos muutat muodoksi "MMM. d, yyyy",
päivämäärä näkyy seuraavasti: Dec. 22, 2007.
Päivämäärämuuttujat käyttävät tekstissä käytettyä kieltä. Luontipäivämäärä voi esimerkiksi suomalaisessa tekstissä olla "1. joulukuuta 2007" ja
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saksalaisessa tekstissä "01 Dezember 2007."

Lyhenne Kuvaus Esimerkki

M Kuukauden numero, ei etunollaa 8

MM Kuukauden numero, etunolla 08

MMM Lyhennetty kuukauden nimi Elo

MMMM Kuukauden koko nimi Elokuu

d Päivän numero, ei etunollaa 5

dd Päivän numero, etunolla 05

E Viikonpäivän lyhennetty nimi Pe

EEEE Viikonpäivän koko nimi Perjantai

yy tai YY Vuosi, viimeiset kaksi numeroa 07

v (V) tai vvvv (VVVV) Vuoden koko numero 2007

G tai GGGG Aikakausi, lyhennetty tai kokonaan AD tai Anno Domini

h Tunti, ei etunollaa 4

hh Tunti, etunolla 04

H Tunti, ei etunollaa, 24 tunnin muoto 16

HH Tunti, etunolla, 24 tunnin muoto 16

m Minuutti, ei etunollaa 7

mm Minuutti, etunolla 07

s Sekunti, ei etunollaa 7

ss Sekunti, etunolla 07

a AM tai PM, kaksi merkkiä PM

z tai zzzz Aikavyöhyke, lyhennetty tai koko nimi PST tai Pacific Standard Time

Tiedostonimi
Tämä muuttuja lisää nykyisen tiedoston nimen julkaisuun. Muuttuja lisätään usein julkaisun informaatioalueeseen, tai sitten sitä käytetään ylä- ja
alatunnisteissa. Voit Teksti ennen- ja Teksti jälkeen -asetusten lisäksi valita seuraavia asetuksia.

Sisällytä kansion koko polku Valitse tämä asetus, jos haluat sisällyttää tiedostonimeen kansion koko polun. Ohjelma käyttää Windows- ja
Mac OS -käyttöjärjestelmien normaaleja polunmerkintätapoja.
Sisällytä tiedostotunniste Valitse tämä asetus, jos haluat sisällyttää tiedostonimitunnisteen.
Tiedostonimi-muuttuja päivittyy aina, kun tallennat tiedoston uudella nimellä tai uuteen sijaintiin. Polku tai tunniste ei näy julkaisussa, ennen kuin
julkaisu on tallennettu.

Kuvan nimi
Kuvan nimi -muuttujalla voit tuottaa automaattisia kuvatekstejä metatiedoista. Kuvan nimi -muuttuja sisältää muuttujatyypin Metatieto-otsikko. Jos
tämän muuttujan sisältämä tekstikehys on kuvan vieressä tai ryhmitetty sen kanssa, muuttuja näyttää kyseisen kuvan metatiedot. Voit muokata
Kuvan nimi -muuttujaa ja määrittää, mitä metatietokenttää käytetään.

Katso Kuvatekstimuuttujien määrittäminen.

Viimeisen sivun numero
Viimeisen sivun numero -tyyppi on hyödyllinen, jos haluat lisätä julkaisun kokonaissivumäärän ylä- ja alatunnisteisiin käyttämällä yleistä "sivu 3/12"
-muotoa. Tässä tapauksessa Viimeisen sivun numero -muuttuja luo numeron 12. Luku päivittyy aina, kun sivuja lisätään tai poistetaan. Voit lisätä
tekstiä viimeisen sivun numeron eteen tai jälkeen ja määrittää numerointityylin. Valitse Käyttöala-valikosta asetus ja määritä, käytetäänkö osion tai
julkaisun viimeisen sivun numeroa.
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Alkuun

Alkuun

Huomaa, että Viimeisen sivun numero -muuttuja ei laske julkaisun sivuja.

Juokseva ylätunniste (kappale- tai merkkityyli)
Juokseva ylätunniste -muuttujat lisäävät sivun ensimmäisen tai viimeisen esiintymän tekstistä, jossa määritettyä tyyliä käytetään. Jos sivulla ei ole
valitulla tyylillä muotoiltua tekstiä, käytetään edellisen sivun tekstiä.

Lisätietoja: Muuttujien luominen juokseville ylä- ja alatunnisteille.

Mukautettu teksti
Tällä muuttujalla lisätään yleensä paikkamerkkitekstiä tai tekstijono, jota voidaan joutua muuttamaan nopeasti. Jos esimerkiksi käsittelet projektia,
joka käyttää yhtiöstä koodinimeä, voit luoda koodinimelle mukautetun tekstimuuttujan. Kun voit myöhemmin käyttää yhtiön oikeaa nimeä, voit
muuttujaa muuttamalla päivittää kaikki esiintymät kerralla.

Jos haluat lisätä tekstimuuttujaan erikoismerkkejä, napsauta tekstiruudun oikealla puolella olevaa kolmiota.

Tekstimuuttujien lisääminen
1. Sijoita lisäyskohta paikkaan, johon haluat muuttujan.

2. Valitse Teksti > Tekstimuuttujat > Lisää muuttuja ja valitse haluamasi muuttuja.

Muuttuja näkyy sivulla kuin olisit kirjoittanut sen julkaisuun. Luontipäivämäärämuuttuja voi esimerkiksi näkyä muodossa 22. joulukuuta 2007. Jos
valitset Teksti > Näytä piilomerkit, muuttujan esiintymää ympäröi nykyisen tason värinen ruutu.

Huomautus: Tekstimuuttujat eivät tee rivinvaihtoja.

Tekstimuuttujien poistaminen, muuntaminen ja tuominen
Poista, muunna ja tuo tekstimuuttujia Tekstimuuttujat-valintaikkunassa.

Tekstimuuttujien poistaminen
Jos haluat poistaa julkaisuun lisätyn tekstimuuttujan esiintymän, valitse muuttuja ja paina askelpalautinta tai Delete-näppäintä. Voit myös poistaa
itse muuttujan. Kun teet niin, voit päättää, kuinka julkaisuun lisätyt muuttujat korvataan.

1. Valitse Teksti > Tekstimuuttujat > Määritä.

2. Valitse ensin muuttuja ja sitten Poista.

3. Määritä, kuinka muuttuja korvataan: määritä toinen muuttuja, muunna muuttujan esiintymät tekstiksi tai poista muuttujan esiintymät
kokonaan.

Tekstimuuttujien muuntaminen tekstiksi

Jos haluat muuntaa yhden esiintymän, valitse ensin tekstimuuttuja julkaisuikkunasta ja sitten Teksti > Tekstimuuttujat > Muunna muuttuja
tekstiksi.

Jos haluat muuntaa tekstimuuttujan kaikki esiintymät julkaisussa, valitse Teksti > Tekstimuuttujat > Määritä ja valitse sitten muuttuja ja
Muunna tekstiksi.

Tekstimuuttujien tuominen toisesta julkaisusta

1. Valitse Teksti > Tekstimuuttujat > Määritä.

2. Valitse Lataa ja kaksoisnapsauta julkaisua, joka sisältää haluamasi muuttujat.

3. Varmista Lataa tekstimuuttujat -valintaikkunassa, että haluamiesi muuttujien vieressä on valintamerkki. Jos jollakin olemassa olevista
muuttujista on sama nimi kuin tuodulla muuttujalla, valitse ensin jokin seuraavista Ristiriita nykyisen tekstimuuttujan kanssa -kohdan
asetuksista ja sitten OK:

Käytä saapuvaa määritystä  Korvaa nykyisen muuttujan ladatulla muuttujalla ja käyttää uusia määritteitä kaikissa nykyisen julkaisun
teksteissä, joissa aikaisemmin käytettiin vanhaa muuttujaa. Voit vertailla muuttujia keskenään, sillä tuotavien ja nykyisten muuttujien
määritykset näkyvät Lataa tekstimuuttujat -valintaikkunan alareunassa.

Nimeä uudelleen automaattisesti Nimeää ladatun muuttujan uudelleen.

4. Valitse OK ja valitse sitten Valmis.

Voit myös kopioida muuttujia toisiin julkaisuihin, kun synkronoit kirjatiedoston.

Lisää ohjeaiheita
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Linkitetty sisältö | CC, CS6

Alkuun

Sisällön keräystyökalu

Sisällön sijoitustyökalu

Luo linkki

Yhdistä tyylit

Muokkaa mukautettua tyyliosoitusta

Sisällön keräystyökalut
Sijoittaminen ja linkittäminen
Linkkiasetusten määrittäminen
Mukautettu tyyliosoitus
Linkitetyn kohteen päivittäminen

Sisältöjen kopiointi eri sivuille ei ole mikään helppo tehtävä. Kopiointi ja liittäminen voi olla vaikeaa ja aikaa vievää. Linkitetyn sisällön toimintojen
avulla voidaan hallita sisällön eri versioita. Sisältöä voi sijoittaa ja linkittää saman julkaisun sisällä tai jopa eri julkaisujen kesken. Linkitetty sisältö
tukee kehittyviä työnkulkuja, joissa esimerkiksi suunnitellaan pysty- ja vaakasuuntaisia sivuasetteluita. Linkitetty sisältö toimii hyvin myös
perinteisissä tulostus- ja julkaisutyönkuluissa, joissa synkronoidaan eri sivuilla tai eri julkaisuissa oleva pohjateksti.

Linkitetty sisältö toimii perinteisten linkkien tapaan. Jos haluat lukea asian yleiskuvauksen, katso Linkit-paneelin käyttäminen. Objekti voidaan
määrittää pääkohteeksi ja sitten sijoittaa se eri paikkoihin aliobjektiksi. Kun pääobjekti päivitetään, aliobjektit merkitään Linkit-paneelissa, ja ne
voidaan päivittää synkronoimalla ne pääkohteen kanssa.

Voit sijoittaa ja linkittää objekteja joko Sisällön keräystyökaluilla tai valikkokomennolla Muokkaa > Sijoita ja linkitä.

-kuvake näkyy linkitetyn objektin vasemmassa yläkulmassa. Objekti näytetään Linkit-paneelissa linkitettynä juttuna.

Sisällön keräystyökalut
Sisällön keräys- ja sijoittelutyökalujen avulla voidaan monistaa ja sijoittaa sivukohteita avattuihin InDesign-julkaisuihin. Kerätty sisältö näytetään
Content Conveyorissa. Content Conveyorin avulla voit helposti ja nopeasti sijoittaa ja linkittää useita sivukohteita avattuihin asiakirjoihin.

Avaa Content Conveyor kaksoisnapsauttamalla työkalupaneelissa  -työkalua.

Sisällön keräystyökalulla  voit valita objektin ja lisätä sen kuljettimeen.

Sisällön sijoitustyökalulla  voit sijoittaa sivuobjektin sivulle.

Painamalla B voit vaihtaa sisällön keräys- ja sijoitustyökalun välillä.

 
Content Conveyor 
A. Sisällön keräystyökalu B. Sisällön sijoitustyökalu C. Luo linkki D. Yhdistä tyylit E. Muokkaa mukautettua tyyliosoitusta F. Sijoitusasetukset G.
Selaa  H. Kerää kaikki ketjutetut kehykset I. Lataa kuljetin 

Sisällön keräystyökalulla voidaan lisätä sivukohteita Content Conveyoriin.

Sisällön keräystyökalulla voidaan sijoittaa kohteita Content Conveyorista julkaisuun. Kun tämä työkalu valitaan, nykyinen
kohde lisätään sijoitustyökaluun.

Jos haluat linkittää sijoitetun kohteen kerätyn kohteen alkuperäiseen sijaintiin, ota käyttöön Luo linkki -toiminto. Voit hallita linkkejä
Linkit-paneelissa.

Yhdistä alkuperäisten ja sijoitettujen nimikkeiden kappale-, merkki-, taulukko- tai solutyylit. Yhdistämiseen käytetään oletusarvoisesti
tyylien nimiä. Katso Mukautetut tyyliosoitukset.

Tällä asetuksella voit mukauttaa alkuperäisen ja sijoitettujen nimikkeiden tyylien yhdistämistä. Kun
tyylit yhdistetään, sijoitetun kohteen tyylit korvataan automaattisesti.
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Sijoitusasetukset

Selaa

Kerää kaikki ketjutetut kehykset

Lataa kuljetin

Alkuun

Alkuun

Määritä Conveyorin asetukset kohteiden sijoittamisen yhteydessä.

Poista kohteet kuljettimesta sen jälkeen, kun kohteet on sijoitettu.
Sijoita nykyinen kohde moneen kertaan. Kohde jää edelleen sijoitustyökaluun.
Sijoita kohde ja siirry sitten seuraavaan kohteeseen. Kohde pysyy edelleen kuljettimessa.

Selaa sisältökuljettimessa olevia kohteita.

Ota tämä asetus käyttöön, jos haluat kerätä kaikki ketjutetut kehykset. Juttu ja kaikki kehykset kerätään. Jos
tämä asetus ei ole käytössä, juttu kerätään yhteen kehykseen.

Voit ladata kuljettimeen kohteita käyttämällä -toimintoa.
Valinta: Lataa kaikki valitut kohteet

Sivut: Lataa kaikki määrätyillä sivuilla olevat kohteet
Kaikki: Lataa kohteet kaikilta sivuilta ja taittopöydältä

Jos haluat ryhmittää yhden sarjan kaikki kohteet, ota käyttöön Luo yksi sarja -asetus.

Voit kerätä yksittäisiä sivukohteita tai kerätä toisiinsa liittyviä kohteita ”joukoiksi”. Joissakin tapauksissa InDesign luo joukkoja automaattisesti
suojatakseen sivukohteiden suhteiden eheyttä.

Alla on kerrottu muutama tapa kerätä kohteita ryhmiksi. Osa näistä tavoista on manuaalisia ja osa automaattisia:

Valitaan useita kohteita valitsimella.
Kun valitaan Lataa kuljetin -vaihtoehto ja sitten tietyt sivut tai koko julkaisun sisältö tai valitut kohteet, niin kohteet kerätään joukoksi.
Kerätään kohde, johon liittyy muuta sisältöä. Tällainen kohde voi olla esimerkiksi vuorovaikutteisen painikkeen osa, johon liittyy muita kohteita
tai tiloja. Nämä kohteet kerätään joukoksi, joka voidaan pudottaa yhdellä eleellä.
Kerätään tekstiruutu, jossa on muihin objekteihin ulottuvaa ketjutettua tekstiä. Kun kuljettimen ”kerää kaikki ketjutetut tekstikehykset” -
valintaruutu on valittu, kaikki ketjutetut tekstiruudut kerätään joukoksi.

Sijoittaminen ja linkittäminen

1. Valitse sivukohde valitsemalla kehys tai aseta lisäyskohdistin tekstiin. Voit valita myös useita kohteita vaihtonapsauttamalla.

2. Valitse Muokkaa > Sijoita ja linkitä. Kohteet ladataan kohdistimeen, ja kohteet näytetään sisältökuljettimessa.

3. Jos haluat sijoittaa linkitetyn kohteen, napsauta sivua tai piirrä kehys.

Linkin asetusten määrittäminen

1. Valitse linkitetty kohde Linkit-paneelista.

2. Valitse Linkit-paneelivalikosta Linkkiasetukset.

 

Voit muuttaa Peruuta-painikkeen Palauta-painikkeeksi painamalla Alt-näppäintä (Windows) tai optionäppäintä (Mac OS). Voit palauttaa
oletusasetukset valitsemalla Palauta.
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Päivitä linkki julkaisua tallennettaessa

Varoita, jos linkin päivitys korvaa paikalliset muokkaukset

Säilytä paikalliset muokkaukset objektilinkkejä päivitettäessä

Poista jutusta pakotetut rivinvaihdot

Määritä mukautettu tyyliosoitus

Alkuun

3. Valitse asetukset tarpeen mukaan:

Ota tämä asetus käyttöön, jos haluat linkkien päivittyvän, kun julkaisu tallennetaan.

Ota tämä asetus käyttöön, jos haluat, että InDesign näyttää varoitusviestin,
kun linkin päivittäminen korvaa linkitettyyn objektiin tehdyt paikalliset muokkaukset.

Valitse jokin valittavissa olevista luokista, jos haluat säilyttää paikalliset
muokkaukset linkkejä päivitettäessä.

Ota käyttöön, jos haluat poistaa pakotetut rivinvaihdot jutusta. Kun rivinvaihdot on poistettu, teksti
sijoittuu tasaisesti linkitettyyn kehykseen aina uudelleen, kun sen kokoa tai muotoilua muutetaan.

Ota tämä asetus käyttöön, jos haluat tehdä tyyliosoituksen ja käyttää linkitettyyn sisältöön jotain toista
tyyliä. Katso Mukautetut tyyliosoitukset.

Jos haluat määrittää oletusarvoiset linkkiasetukset kaikkien julkaisujen ollessa suljettuina, avaa Linkit-paneelin valikko ja valitse Linkkiasetukset.

Mukautettu tyyliosoitus
Tekstityylit (kappale, merkki, taulukko, solu) tai tyyliryhmät voidaan osoittaa linkitettäessä eri tyyleihin. Osoitettuja tyylejä käytetään automaattisesti
linkitettyyn sisältöön ylemmällä tasolla käytettyjen alkuperäisten tyylien sijasta. Mukautetuista tyyliosoituksista on hyötyä esimerkiksi silloin, kun
digitaalijulkaisuissa halutaan käyttää päätteettömiä kirjasimia ja painotuotejulkaisuissa päätteellisiä kirjasimia. Sitä voi käyttää myös silloin, jos
vaaka- ja pystysuuntaisille sivuasetteluille halutaan erilaiset tekstityylit.

Voit määrittää mukautetun tyyliosoituksen jollakin seuraavista tavoista:

Ota Linkkiasetukset-valintaikkunassa (Linkit-paneeli > Linkkiasetukset) Määritä mukautettu tyyliosoitus käyttöön ja valitse Asetukset.

Napsauta -työkalua sisältökuljettimessa.

Luokka Esimerkit

Ulkoasu

Objektin tyylimääritteet, kuten viiva, täyttö tai tehosteet. Näihin
eivät kuulu tekstiin tai tekstikehykseen liittyvät määritteet, kuten
päällepainatus tai tulostukseen liittymättömät asetukset.

Koko ja muoto
Korkeus, leveys, muutokset, tekstikehyksen määritteet ja muut
palstan koon määritteet

Vuorovaikutteisuus Animaatio, objektien tilat, painikkeen toiminnot

Kehyksen sisältö
Kehyksiin liitetyt kuvat, videot tai muu sisältö ja tällaisissa
objekteissa suoraan käytetyt tehosteet tai asetukset.

Muut

Muihin luokkiin kuulumattomat määritteet, kuten
tekstinkierrätys kehyksissä, objektien vientiasetukset sekä
tekstikehyksen määritteet, kuten perusviivan asetukset,
automaattisen koon määrittämisen asetukset, pystytasaus jne.
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Alkuun

 
Mukautettu tyyliosoitus

1. Valitse lähdedokumentti ja tyylin tyyppi. 
2. Valitse Uusi tyyliosoitus.
3. Valitse luettelosta lähde ja osoitetut tyylit tai tyyliryhmät.

Voit muuttaa Peruuta-painikkeen Palauta-painikkeeksi painamalla Alt-näppäintä (Windows) tai optionäppäintä (Mac OS). Voit palauttaa
oletusasetukset valitsemalla Palauta.

Linkitetyn kohteen päivittäminen
Jos alkuperäistä kohdetta muutetaan, kehyksen yläpuolelle ja Linkit-paneeliin tulee näkyviin -symboli. Voit tehdä päivityksen jollakin seuraavista
tavoista:

Napsauta lähellä kehyksen vasenta yläkulmaa olevaa -kuvaketta.
Kaksoisnapsauta Linkit-paneelissa olevaa -symbolia.

Jos olet tehnyt alikohteeseen paikallisia muutoksia, muutokset korvataan alkuperäisen kohteen sisällöllä. Jos valitset Varoita, jos linkin päivitys
korvaa paikalliset muokkaukset, näytölle tulee varoitusviesti.

Linkkitiedot-ruudussa voit määrittää, onko juttuun tehty paikallisia muokkauksia. Jutun tilana on ”Muokattu teksti”, jos paikallisia muokkauksia on
tehty.
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Kuviot ja erikoismerkit

Alkuun

Alkuun

Yleistä Kuviot-paneelista
Kuvioiden ja erikoismerkkien lisääminen
Mukautettujen kuviojoukkojen luominen ja muokkaaminen
Lainausmerkkien käyttäminen
Välilyöntimerkkien lisääminen

Yleistä Kuviot-paneelista
Kuviot-paneelin avulla voit käyttää kuvioita. Paneelissa näytetään aluksi sen kirjasimen kuviot, jossa kohdistin sijaitsee. Voit näyttää myös toisen
kirjasimen tai kirjasimen kirjasintyylin (esimerkiksi Ohut, Tavallinen tai Lihavoitu). Paneelin voi määrittää näyttämään kirjasimen kuvioiden
osajoukon, kuten matemaattiset symbolit, numerot tai välimerkkisymbolit.

Kuviot-paneeli
A. Näytä kuvioiden osajoukko B. Työkaluvihje C. Kirjasinluettelo D. Kirjasintyyli

Voit näyttää kirjasimen kuvion tai merkin tunnusarvon, Unicode-arvon ja nimen työkaluvihjeessä asettamalla kohdistimen kuvion kohdalle.

Kuviot-paneelin avaaminen
 Valitse Teksti > Kuviot tai Ikkuna > Teksti ja taulukot > Kuviot.

Kuviot-paneelinäkymän muuttaminen
Muuta paneelin näyttötapaa napsauttamalla selauspainiketta (Kuviot-sanan vasemmalla puolella Kuviot-paneelissa). Kun painat
selauspainiketta, näet seuraavat vaihtoehdot tässä järjestyksessä: kutistettu paneeli, koko paneeli ja paneeli ilman viimeksi käytettyjä
kuvioita.
Napsauta Kuviot-paneelin oikeassa alakulmassa olevia Lähennä- ja Suurenna-painikkeita.
Muuta Kuviot-paneelin kokoa vetämällä sen oikeaa kulmaa.

Kuvioiden suodattaminen
 Määritä Kuviot-paneelissa näytettävät kuviot Näytä-luettelossa seuraavasti:

Näytä kirjasimen kaikki käytettävissä olevat kuviot valitsemalla Koko kirjasin.

Näytä kuvioiden osajoukko valitsemalla jokin Koko kirjasin -kohdan alla oleva vaihtoehto. Jos esimerkiksi valitset Välimerkit-vaihtoehdon, vain
välimerkit näytetään, ja jos valitset Matemaattiset symbolit -vaihtoehdon, vain matemaattiset symbolit näytetään.

Kuvioiden lajitteleminen Kuviot-paneelissa
 Määritä kuvioiden lajittelutapa Kuviot-paneelissa valitsemalla CID / GID tai Unicode.

Kuvioiden ja erikoismerkkien lisääminen
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Erikoismerkkimuotoja kutsutaan kuvioiksi. Esimerkiksi joissakin kirjasimissa iso A-kirjain on määritetty erikoismerkkinä ja kapiteelina. Kuviot-
paneelin avulla voit etsiä minkä tahansa kirjasimeen kuuluvan kuvion.

OpenType-kirjasimissa, kuten Adobe Caslon™ Prossa, on useita kuvioita monille merkeille. Vaihtoehtoiset kuviot voi lisätä julkaisuun käyttämällä
Kuviot-paneelia. Paneelin avulla voit myös näyttää ja lisätä OpenType-määritteitä, kuten koristeita, erikoismerkkejä, murtolukuja ja ligatuureja.

Erikoismerkkien lisääminen
Voit lisätä julkaisuun tavallisia merkkejä, kuten eripituisia ajatusviivoja, rekisteröidyn tavaramerkin symboleja ja kolme pistettä.

1. Sijoita kohdistin tekstityökalulla siihen kohtaan, johon haluat lisätä merkin.
2. Valitse Teksti > Lisää erikoismerkki ja valitse sitten haluamasi vaihtoehto valikon jostakin luokasta.

Jos toistuvasti käyttämäsi erikoismerkit eivät näy erikoismerkkien luettelossa, lisää ne luomaasi kuviojoukkoon.

Valitun kirjasintyypin kuvion lisääminen
1. Sijoita kohdistin tekstityökalulla siihen kohtaan, johon haluat lisätä merkin.
2. Näytä Kuviot-paneeli valitsemalla Teksti > Kuviot.
3. Voit vaihtaa Kuviot-paneelissa näkyvän merkkijoukon seuraavilla tavoilla:

Valitse eri kirjasin ja tekstityyli, jos käytettävissä on vaihtoehtoja. Valitse Näytä-valikosta Koko kirjasin. Jos valitsit OpenType-kirjasimen,
valitse haluamasi OpenType-luokka.

Valitse Näytä-valikosta mukautettu kuviojoukko. (Lisätietoja: Mukautettujen kuviojoukkojen luominen ja muokkaaminen.)

4. Etsi haluamasi kuvio selaamalla. Jos valitset OpenType-kirjasimen, voit näyttää vaihtoehtoisia kuvioita avattavassa valikossa napsauttamalla
kuvioruutua ja pitämällä hiiripainikkeen alhaalla.

5. Kaksoisnapsauta lisättävää merkkiä. Merkit näkyvät lisäyskohdassa.

Viimeksi käytetyn kuvion lisääminen
InDesign muistaa viimeiset 35 käyttäjän lisäämää kuviota, jotka ovat käytettävissä Kuviot-paneelin ensimmäisen rivin Viimeksi käytetyt -kohdassa
(jos haluat nähdä kaikki kuviot, laajenna paneelia).

 Tee jokin seuraavista:

Kaksoisnapsauta haluamaasi kuviota Viimeksi käytetyt -kohdassa.

Näytä kaikki viimeksi käytetyt kuviot valitsemalla Näytä-luettelosta Viimeksi käytetyt kuviot ja kaksoisnapsauta sitten haluamaasi kuviota.

Viimeksi käytettyjen kuvioiden poistaminen
Jos haluat poistaa valitun kuvion Viimeksi käytetyt -osiosta, napsauta kuviota hiiren kakkospainikkeella (Windows®) tai Control-osoita (Mac
OS) Viimeksi käytetyt -osiossa. Valitse sitten Poista kuvio viimeksi käytettyjen luettelosta.
Jos haluat poistaa kaikki äskettäin käytetyt kuviot, valitse Tyhjennä viimeksi käytettyjen luettelo.

Merkin korvaaminen vaihtoehtoisella kuviolla
Kun jollakin merkillä on vaihtoehtoisia kuvioita, sen kohdalla Kuviot-paneelissa näkyy kolmiokuvake oikeassa alakulmassa. Voit avata
vaihtoehtoisten kuvioiden ponnahdusvalikon napsauttamalla merkkiä Kuviot-paneelissa pitäen painikkeen alhaalla. Voit myös näyttää
vaihtoehtoiset kuviot Kuviot-paneelissa.

Vaihtoehtoisten kuvioiden valitseminen OpenType-kirjasimessa

1. Näytä Kuviot-paneeli valitsemalla Teksti > Kuviot.
2. Valitse Näytä-luettelosta Valintavaihtoehdot.
3. Valitse julkaisusta merkki tekstityökalulla.
4. Voit korvata julkaisussa valitun merkin jollakin seuraavista tavoista:

Kaksoisnapsauta kuviota Kuviot-paneelissa.

Valitse kuvio valikosta.

OpenType-kuviomääritteiden näyttäminen Kuviot-paneelissa
Valinnan helpottamiseksi Kuviot-paneelissa voidaan näyttää vain valittujen OpenType-määritteiden merkit. Voit valita vaihtoehtoja Kuviot-paneelin
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Näytä-valikossa.

Kuviot-paneelin Näytä-valikkoasetukset

1. Valitse Kuviot-paneelin kirjasinluettelosta OpenType-kirjasin.
2. Valitse haluamasi asetus Näytä-valikosta.

Näytettävät vaihtoehdot määräytyvät valitun kirjasimen perusteella. Tietoja OpenType-kirjasinmääritteistä on kohdassa OpenType-kirjasinten
määritteiden käyttäminen. Lisätietoja OpenType-kirjasimista on osoitteessa www.adobe.com/go/opentype_fi.

Vaihtoehtoisten kuvioiden korostaminen tekstissä
1. Valitse Muokkaa > Asetukset > Koostaminen (Windows) tai InDesign > Asetukset > Koostaminen (Mac OS).
2. Valitse Korvatut kuviot ja sitten OK. Korvatut kuviot korostetaan tekstissä tulostumattomalla keltaisella värillä.

Mukautettujen kuviojoukkojen luominen ja muokkaaminen
Kuviojoukko on nimetty sarja kuvioita, jotka voivat olla peräisin useasta eri kirjasimesta. Jos tallennat usein käyttämäsi kuviot kuviojoukkoon, sinun
ei tarvitse etsiä niitä joka kerta, kun tarvitse niitä. Kuviojoukkoja ei liitetä tiettyyn julkaisuun, vaan ne tallennetaan muiden InDesign-asetusten lailla
erilliseen tiedostoon, joka voidaan jakaa.

Voit valita, muistetaanko kirjasin lisätyn kuvion yhteydessä. Kirjasinten muistaminen on hyödyllistä esimerkiksi käytettäessä Dingbat-merkkejä,
jotka eivät ehkä esiinny muissa kirjasimissa. Jos kuvion kirjasin muistetaan mutta kirjasin puuttuu, kirjasimen neliö näkyy vaaleanpunaisena Kuviot-
paneelissa ja Muokkaa kuviojoukkoa -valintaikkunassa. Jos lisätyn kuvion kirjasinta ei muisteta, kuvion vieressä näkyy u-kirjain, joka tarkoittaa, että
kirjasimen Unicode-arvo määrää kuvion ulkoasun.

Mukautetun kuviojoukon luominen
1. Valitse Teksti > Kuviot.
2. Tee jokin seuraavista:

Valitse Kuviot-paneelin valikosta Uusi kuviojoukko.

Avaa pikavalikko Kuviot-paneelissa ja valitse Uusi kuviojoukko.

3. Kirjoita kuviojoukon nimi.
4. Valitse järjestys, jossa kuviot lisätään kuviojoukkoon. Valitse sitten OK:

Lisää alkuun Kukin uusi kuvio lisätään luetteloon ensimmäiseksi.

Lisää loppuun Kukin uusi kuvio lisätään luetteloon viimeiseksi.

Unicode-järjestys Kuviot lisätään luetteloon niiden Unicode-arvojen mukaisessa järjestyksessä.

5. Jos haluat lisätä kuvioita mukautettuun joukkoon, valitse kuvion sisältävä kirjasin Kuviot-paneelin alareunasta, napsauta kuviota ja valitse
mukautetun kuviojoukon nimi paneelivalikon Lisää kuviojoukkoon -valikosta.

Mukautetun kuviojoukon näyttäminen
 Toimi seuraavasti Kuviot-paneelissa:

Valitse Näytä-luettelosta kuviojoukko.
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Valitse Kuviot-paneelin valikosta Näytä kuviojoukko ja sitten kuviojoukon nimi.

Mukautetun kuviojoukon muokkaaminen
1. Valitse Kuviot-paneelin valikosta Muokkaa kuviojoukkoa ja valitse sitten mukautettu kuviojoukko.
2. Valitse muokattava kuvio, tee jokin seuraavista toimista ja valitse lopuksi OK:

Jos haluat sitoa kuvion kirjasimeen, valitse Muista kirjasin ja kuvio. Jos kuvion kirjasin muistetaan, kuvio ei käytä julkaisussa valitulle
tekstille määritettyä kirjasinta, kun se lisätään tekstiin. Siinä myöskään käytetä Kuviot-paneelissa määritettyä kirjasinta. Jos poistat tämän
vaihtoehdon valinnan, käytetään valitun kirjasimen Unicode-arvoa.

Jos haluat nähdä lisäkuvioita, valitse eri kirjasin tai tyyli. Jos kuvion mukana ei ole määritetty kirjasinta, et voi valita uutta kirjasinta.

Jos haluat poistaa kuvion mukautetusta kuviojoukosta, valitse Poista joukosta.

Valitse jokin Lisäysjärjestys-vaihtoehto, jos haluat muuttaa järjestystä, jolla kuviot lisätään joukkoon. Unicode-järjestys-vaihtoehto ei ole
käytettävissä, jos Lisää alkuun- tai Lisää loppuun -vaihtoehto oli valittu, kun kuviojoukko luotiin.

Kuvioiden poistaminen mukautetuista kuviojoukoista
1. Valitse Mukautettu kuviojoukko Kuviot-paneelin Näytä-valikosta.
2. Napsauta kuviota hiiren kakkospainikkeella (Windows) tai Control-osoita (Mac OS) ja valitse Poista kuvio joukosta.

Mukautettujen kuviojoukkojen poistaminen
1. Tee jokin seuraavista:

Valitse Kuviot-paneelin valikosta Poista kuviojoukko.

Valitse pikavalikosta Poista kuviojoukko.

2. Napsauta mukautetun kuviojoukon nimeä.
3. Vahvista toiminto valitsemalla Kyllä.

Kuviojoukkojen tallentaminen ja lataaminen
Mukautetut kuviojoukot tallennetaan tiedostoina Tiedostojoukot-kansioon, joka on Oletusarvot-kansion alikansio. Kuviojoukkotiedostoja voi kopioida
toisiin tietokoneisiin, jolloin niitä voivat käyttää myös muut käyttäjät. Jos haluat tarjota kuviojoukkotiedostot muiden käyttöön, kopioi ne näihin
kansioihin:

Mac OS Käyttäjät\[käyttäjätunnus]\Kirjasto\Preferences\Adobe InDesign\[versio]\[kieli]\Glyph Sets
Windows XP Documents and Settings\[käyttäjätunnus]\Application Data\Adobe\InDesign\[versio]\[kieli]\Glyph Sets
Windows Vista ja Windows 7 Users\[käyttäjätunnus]\AppData\Roaming\Adobe\InDesign\[versio]\[kieli]\Glyph Sets

Lainausmerkkien käyttäminen
Voit määrittää erilaiset lainausmerkit eri kieliä varten. Nämä lainausmerkit näkyvät kirjoitettaessa automaattisesti, jos Asetukset-valintaikkunassa
Teksti-osiosta on valittu Käytä typografisia lainausmerkkejä.

Käytettävien lainausmerkkien määrittäminen
1. Valitse Muokkaa > Asetukset > Sanasto (Windows) tai InDesign > Asetukset > Sanasto (Mac OS).
2. Valitse Kieli-valikosta haluamasi kieli.
3. Voit tehdä seuraavat toiminnot. Valitse lopuksi OK:

Valitse Lainausmerkit-kohdasta käytettävä tyyppi tai kirjoita merkit.

Valitse Puolilainausmerkit-kohdasta käytettävä tyyppi tai kirjoita merkit.

Suorien lainausmerkkien lisääminen
 Tee jokin seuraavista:

Valitse Teksti > Lisää erikoismerkki > Lainausmerkit > Suora lainausmerkki tai Suora puolilainausmerkki (heittomerkki).

Poista Käytä typografisia lainausmerkkejä -asetuksen valinta Asetukset-valintaikkunassa Teksti-osiosta ja kirjoita sitten lainaus- tai
heittomerkki.

Voit ottaa Käytä typografisia lainausmerkkejä -asetuksen käyttöön ja poistaa sen käytöstä painamalla vaihto+Ctrl+Alt+'-näppäimiä (Windows)
tai vaihto+komento+optio+'-näppäimiä (Mac OS).

Merkki, jota usein käytetään ilmaisemaan jalkaa, kaariminuuttia, tai aikaminuuttia on nimeltään yläpuolinen indeksointipilkku. Se näyttää
kallellaan olevalta heittomerkiltä. Merkki, jota usein käytetään ilmaisemaan tuumaa, kaarisekuntia, tai aikasekunti on nimeltään kaksinkertainen
yläpuolinen indeksointipilkku. Näitä symboleita ei tule sekoittaa heittomerkin ja kokolainausmerkin kanssa. Joissakin kirjasimissa on yläpuolinen
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indeksointipilkku ja kaksinkertainen yläpuolinen indeksointipilkku. Voit lisätä näitä merkkejä Kuviot-paneelista. Jos kirjasimessa ei ole yläpuolista
indeksointipilkkua eikä kaksinkertaista yläpuolinen indeksointipilkkua, käytä suoraa kursivoitua lainausmerkkiä.

Välilyöntimerkkien lisääminen
Välilyöntimerkki on tyhjä väli, joka esiintyy muiden merkkien välissä. Voit käyttää välilyöntimerkkejä erilaisiin tarkoituksiin, kuten estämään kahden
sanan katkeamisen eri riveille rivin lopussa.

1. Sijoita kohdistin tekstityökalulla kohtaan, johon haluat lisätä välilyönnin.
2. Valitse Teksti > Lisää tyhjä tila ja valitse pikavalikosta haluamasi välilyöntimerkki (kuten Em-väli).

Välilyöntimerkkejä vastaavat symbolit näytetään, kun valitset Teksti > Näytä piilomerkit.

Tyhjä tila -asetukset
Teksti > Lisää tyhjä tila -valikon vaihtoehdot:

em-väli Vastaa leveydeltään kirjasimen kokoa. 12 pisteen kirjasinta käytettäessä em-väli on 12 pistettä leveä.
en-väli En-väli on puolet em-välistä.
Sitova välilyönti Tämä joustava leveys on sama kuin välinäppäintä painettaessa, mutta rivi ei voi katketa välilyönnin kohdalta.
Sitova välilyönti (kiinteä leveys) Kiinteä välileveys estää riviä katkeamasta välilyöntimerkin kohdalta, mutta ei laajenna eikä kutista tasattua
tekstiä. Kiinteälevyinen väli vastaa täysin InDesign CS2 -version sitovaa välilyöntimerkkiä.
Kolmannesväli Kolmasosa em-välin leveydestä.
Neljännesväli Neljäsosa em-välin leveydestä.
Kuudennesväli Kuudesosa em-välin leveydestä.
Tasausvälilyönti Lisää vaihtelevan määrän tyhjää tilaa molempiin reunoihin tasatun kappaleen viimeiselle riville. Tämä on hyödyllistä viimeisen
rivin tekstin tasaamiseksi. (Lisätietoja: Palstaan sovituksen asetusten muuttaminen.)

Hieno väli Kahdeskymmenesneljäsosa em-välin leveydestä.
Kapea väli Kahdeksasosa em-välin leveydestä. Kapeaa väliä voi käyttää em- tai en-viivan molemmilla puolilla.

Numeroväli Samanlevyinen kuin kirjasimen numerot. Numerovälin avulla voit tasata numerot lukuja sisältävissä taulukoissa.
Välimerkkiväli Samanlevyinen kuin kirjasimen huutomerkki, piste tai kaksoispiste.
Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Formatting CJK characters
Apply shatai to text
Rotate characters
Adjust aki before and after characters
Use tate-chu-yoko
Add Ruby to text
Apply kenten
Align text of different sizes

Apply shatai to text

In traditional typesetting technology, characters were slanted by using a lens to distort the glyphs when being set
on film. This oblique style is known as shatai. Shatai is distinct from a simple slant of the glyphs, because it also
scales the glyphs. You can adjust the magnification or angle of text you want to slant from the center point,
without changing the height of the glyph, using the shatai feature in InDesign.

Shatai

A. No scale applied B. Magnification 30%, 45 shatai C. Selecting the Adjust Tsume option D. Selecting the Adjust Rotation option 

1. Select text.
2. Select Shatai from the Character panel menu or Control panel menu.
3. Specify the following options, and click OK:

Specify the degree of skew in Magnification (In traditional typesetting technology terms, 10%
magnification is lens 1, and 40% magnification is lens 4).

Set the angle of obliqueness to 30, 45, or 60, in Angle.

Select Adjust Rotation to rotate the glyphs, and display horizontal lines horizontally for horizontal
text, and vertical lines vertically for vertical text.

Select Adjust Tsume to apply jidori.

You can fine tune the rotated oblique effect for individual characters, after applying shatai to text.

Rotate characters

1. Select the characters.
2. In the Character panel, type a value for Character Rotation  Specify a minus value to rotate the character
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to the right (clockwise).

Adjust aki before and after characters

1. Select opening parenthesis or closing parenthesis with the type tool.
2. Choose the amount of aki you want to add from the Mojikumi Before Character  or Mojikumi After

Character  pop-up menu, in the Character panel.

For example, if you specify 2bu, half a full-width space is added, and if you specify 4bu, a quarter of a full-width
space is added. This aki will not be adjusted when the line is set to full justification. Adjusting aki is especially
useful to override Mojikumi Akiryo Settings for certain characters.

Adding aki before opening parenthesis

Use tate-chu-yoko

Using tate-chu-yoko (also known as kumimoji or renmoji) is an option to make a part of the text horizontal, in
vertical text. It is easier to read half-width characters such as numbers, dates, and short foreign words in a vertical
text frame, by rotating the text.

Before and after applying tate-chu-yoko

You can move text left, right, up, and down when you turn on the Tate-chu-yoko option. You can also set Auto
Tate-chu-yoko for special half-width characters. Auto Tate-chu-yoko is set in the paragraph attributes.

Use tsume or tracking in the Character panel to adjust the character spacing for Tate-chu-yoko.

Apply tate-chu-yoko

1. Select the text to which you want to apply tate-chu-yoko.
2. Do one of the following:

Choose Tate-chu-yoko from the Character panel menu or Control panel menu.
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Choose Tate-chu-yoko Settings from the Character panel menu or Control panel menu, choose Tate-
chu-yoko in the Tate-chu-yoko dialog box, and click OK.

If multiple instances of tate-chu-yoko appear next to each other, use the Non-joiner character to keep them
separate. Choose Type > Insert Special Character > Other > Non-joiner.

Remove tate-chu-yoko

1. Select the text to which you want to apply tate-chu-yoko.
2. Do one of the following:

Choose and cancel Tate-chu-yoko from the Character panel menu or Control panel menu.

Choose Tate-chu-yoko Settings from the Character panel menu, deselect Tate-chu-yoko in the Tate-
chu-yoko dialog box, and then click OK.

Change tate-chu-yoko settings

1. Choose Tate-chu-yoko Settings from the Character panel menu.
2. Specify a value for moving the text up or down in X Offset. If you specify a plus value, the text will move

up, and if you specify a minus value, it will move down.
3. Specify a value for moving the text left or right in Y Offset. If you specify a plus value, the text will move to

the right, and if you specify a minus value, it will move to the left.

Set Auto Tate-chu-yoko for specific paragraphs

1. Select the text to be set to Auto Tate-chu-yoko, or place the text insertion point in the paragraph.
2. Choose Auto Tate-chu-yoko from the Paragraph panel menu.
3. In KumiNumber, specify the number of successive half-width characters that you want to rotate to vertical

orientation. For example, if this is set to 2, the character string "123" will not rotate, while "12" will.
4. If you want to apply tate-chu-yoko to roman text, select Include Roman Characters, and click OK.

Add Ruby to text

In Japanese, Ruby (also known as furigana) is normally used to show the kanji yomi in hiragana. In Simplified
Chinese, Ruby is called Pinyin, while in Traditional Chinese, Ruby is called Chuyin. InDesign provides full support to
Japanese Ruby and limited support to Chinese Pinyin or Chuyin. You can adjust Ruby settings to specify Ruby
location, size, or color. Furthermore, when the ruby is longer than the parent you can specify the ruby distribution.
You can also apply tate-chu-yoko to Ruby.

Ruby on horizontal text (left), and ruby to the right of vertical text (right)

When the parent to which you want to attach ruby covers two lines, the ruby will follow when the parent moves to
the next line.
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Note:

In some instances, such as when applying a style that includes a variable, Ruby characters may be removed.

1. Select the text to which you want to attach ruby. You cannot attach ruby when there are forced line breaks
in the selected text.

2. Select Ruby > Ruby from the Character panel menu or Control panel menu.
3. Enter the ruby characters in Ruby.
4. Change Ruby settings by clicking an option on the left side of the dialog box and specifying settings.
5. Click OK.

Ruby settings

The following options appear in the different panels of the Ruby dialog box.

Ruby Placement and Spacing

From the Type menu, choose Per-Character or Group Ruby. When Per Character Ruby is selected, enter a
half or full width space when inputting Ruby characters to separate them in line with their parent
characters. For "hakunetsutou" for example, enter as "haku netsu tou" (example of a word composed of
Japanese characters and its phonetic spelling is given).

Ruby

From the Alignment menu, specify the position of the Ruby characters. You can check the position with the
graphic shown in the sample field.

To attach ruby above horizontal text or to the right of vertical text, select Above/Right, and to attach below
horizontal text or to the left of vertical text, select Below/Left in Placement.

Specify the spacing between the ruby and the parent in XOffset and YOffset. When you enter a minus
value, the ruby moves closer to the parent.

Ruby Font and Size

Select a font family and font style in Font.

Specify the size of the ruby characters in Size. The default ruby size is half the size of the parent.

Specify the scale for the height and width of the ruby characters in Horizontal Scale and Vertical Scale.
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Select Use Open Type Pro Ruby Glyphs to use alternate glyphs for ruby (when possible). Specific kana
characters are available for some Open Type Pro fonts. When you select this option, the specific font for
ruby characters, and not the standard kana font, will be used.

In KumiNumber, specify the number of successive half-width characters that you want to rotate to vertical
orientation. For example, if this is set to 2, the character string "123" will not rotate, while "12" will.

Select Include Roman Characters to apply tate-chu-yoko to roman text.

Select Scale to Fit to force the tate-chu-yoko to have the same dimensions (1 em x 1 em) in the ruby
string, either using an OpenType feature or scaling the glyphs.

Adjustment When Ruby Is Longer Than Parent

With Overhang, when the total Ruby width is greater than that of their parent characters, the specified
Ruby will overflow widthways into the space above characters either side of the parents. For Japanese,
character types compatible with Overhang comply with the JISx4051-1995 specification.

Specify the parent character spacing necessary for attaching ruby in Spacing. When you select a different
option, the graphics displayed in the sample field are updated.

To automatically adjust the ruby character width, select Char Width Scaling, and specify the compression
scale for the width of the ruby characters.

Select Auto Align at Line Edges to align the parent with the start and end of the line.

Ruby Color

Select a color swatch in the list box.

Specify the degree of tinting and line weight, as necessary.

Select Overprint Fill or Overprint Stroke to set filling or stroke overprint for ruby characters.

(See Determining when to overprint manually.)

Apply kenten

Kenten (also known as Boten) are points which you attach to text you want to highlight. You can select the type of
points from existing kenten forms, or specify customized kenten characters. You can also specify the position,
scale, and color by adjusting the kenten settings.

Small black circle kenten, black sesame kenten, and small white circle kenten applied to text
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Apply kenten

1. Choose the characters you want to highlight.
2. Choose a kenten character, such as Fisheye or White Circle, from Kenten in the Character panel menu or

Control panel menu.

Change kenten settings and color

1. Choose Kenten > Kenten from the Character panel menu or Control panel menu.
2. For Kenten Settings, specify the options below:

Kenten Type

Select a kenten character, such as Fisheye or White Circ le. Choose Custom to specify a custom character.
You can enter characters directly, or you can specify a character code value for the specified character set.

Position

Specify the spacing between the kenten and characters.

Location

Select Above/Right to attach kenten above horizontal text or to the right of vertical text, and Below/Left to
attach below horizontal text or to the left of vertical text.

Size

Specify the size of the kenten character.

Align

Specify whether the kenten should be displayed in the center (Center) or to the left (Left) (above for
vertical text) of the character's embox.

H/Scale and V/Scale

Specify the scale for the height and width of the kenten character.

3. To change the color of the kenten, choose Kenten Color from the list box, and then specify the options
below:

Select a color swatch from the list box.

Specify the degree of tinting and line weight, as necessary.

Select Overprint Fill or Overprint Stroke to set filling or stroke overprint for kenten characters.

(See Determining when to overprint manually.)

4. Click OK.
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To the topAlign text of different sizes

You can specify how to align text to the largest characters in a line using the Character Alignment option, when
positioning characters of different sizes in 1 line. It is possible to align characters to the top, center or bottom of
the embox (right, center, and left for vertical frames), to the roman baseline, and to the top or bottom of the ICF
box (right or left for vertical frames). ICF (Ideographic Character Face) is the average height and width used by
the font designer to design the ideographic characters which comprise a font.

Align different sizes

A. Align different size letters above full space letters B. Align different size letters in the middle of full space letters C. Align different size
letters below full space letters 

Note:

The Character Alignment option is not effective, even if applied, when all characters are the same size in a line.

1. Select a range of text or lines for the characters you want to align, or select a text frame using the
selection tool.

2. Choose one of the following options from Character Alignment in the Character panel menu or Control panel
menu.

Roman Baseline aligns the small characters in a line to the large character baseline grid.

Embox Top/Right, Center, or Embox Bottom/Left align the small characters in a line to the specified
position of the large characters embox. In vertical text frames, Embox Top/Right aligns the text to
the right of the embox, and Embox Bottom/Left aligns the paragraph to the left of the embox.

ICF Top/Right and ICF Bottom/Left align the small characters in a line to the ICF specified by the
large characters. In vertical text frames, ICF Top/Right aligns the text to the right of the ICF, and
ICF Bottom/Left to the left of the ICF.

Adobe also recommends

Change the text direction
Align paragraphs to a baseline grid
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Reittitekstin luominen

Alkuun

Alkuun

Reittitekstin luominen
Reittitekstin muokkaaminen ja poistaminen
Reittitekstin sijainnin säätäminen
Tehosteen lisääminen reittitekstiin
Ankkuroitujen objektien lisääminen reittitekstiin

Reittitekstin luominen
Tekstin voi määrittää myötäilemään kaikenmuotoisia avoimia ja suljettuja reittejä. Reittitekstille voi valita asetuksia ja tehosteita. Tekstiä voi
esimerkiksi liu'uttaa reittiä pitkin sekä peilata reitin toiselle puolelle tai merkkejä voi vääristää reitin muodon mukaan. Reittitekstissä on sisä- ja
ulkoportti samalla tavoin kuin muissakin tekstikehyksissä, joten tekstin voi ketjuttaa.

Koska reitillä näkyy vain yksi tekstirivi, reitille liian pitkä teksti muuttuu ylijuoksevaksi (ei näy), ellei sitä ole ketjutettu toiseen reittiin tai
tekstikehykseen. Voit lisätä tekstiin sidottuja tai rivin yläpuolella olevia ankkuroituja objekteja reittitekstiin. Reittitekstiä ei voi luoda käyttämällä
yhdistelmäreittejä, jotka on tehty esimerkiksi Luo ääriviivat -komennolla.

Reittiteksti
A. Alkumerkki B. Sisäportti C. Keskimerkki D. Loppumerkki E. Ulkoportti ilmaisee sijoittamattoman tekstin

1. Valitse reittitekstityökalu . (Voit avata reittitekstityökalun sisältävän valikon napsauttamalla tekstityökalua ja pitämällä hiiren painikkeen
alhaalla.)

2. Pidä osoitinta reitillä, kunnes sen viereen tulee pieni plusmerkki . Tee sitten jokin seuraavista:

Jos haluat kirjoittaa käyttämällä oletusasetuksia, napsauta reittiä. Kohdistin on oletusarvoisesti reitin alussa. Jos nykyisissä kappaleen
asetuksissa on määritetty sisennys tai muu kuin vasen tasaus, kohdistin voi olla muuallakin kuin reitin alussa.

Jos haluat kirjoittaa tekstin reitin tiettyyn osaan, napsauta reittiä kohdassa, josta haluat tekstin alkavan. Vedä osoitinta reittiä pitkin
kohtaan, jossa haluat tekstin päättyvän, ja vapauta hiiren painike. (Lisätietoja tekstin alku- ja loppukohdan muuttamisesta on kohdassa
Reittitekstin sijainnin säätäminen.)

Reittitekstin sijainnin muuttaminen

Huomautus: jos napsauttaminen tai vetäminen ei onnistu, tarkista, että reittitekstityökalun vieressä näkyy plusmerkki.

3. Kirjoita haluamasi teksti. Jos reittiä napsautetaan, teksti näkyy koko reitin alueella. Jos osoitinta vedetään reittiä pitkin, teksti sijoittuu vain
tälle reitin osalle.

Huomautus: Näkyvä reitti on näkyvä myös tekstin lisäämisen jälkeen. Voit kätkeä reitin valitsemalla sen valinta- tai suoravalintatyökalulla ja
valitsemalla viivaksi ja täytöksi Ei mitään.

Reittitekstin muokkaaminen ja poistaminen
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Reittitekstissä voi käyttää merkki- ja kappaleasetuksia. Sen sijaan kappaleen viiva- ja väliasetukset eivät vaikuta reittitekstiin. Kappale-paneelista
valittu tasausasetus vaikuttaa reittitekstin tasaukseen.

Reittitekstin merkkien muokkaaminen ja muotoileminen
1. Valitse reittitekstityökalu ja tee jokin seuraavista:

Jos haluat lisätä kohdistimen, napsauta jotakin kohtaa reittitekstin kahden merkin välissä.

Jos haluat valita merkkejä, vedä osoitinta reittitekstissä.

2. Muokkaa ja muotoile tekstiä haluamallasi tavalla.

Tekstin poistaminen reitiltä
1. Valitse vähintään yksi reittitekstiobjekti valintatyökalulla  tai suoravalintatyökalulla .
2. Valitse Teksti > Teksti reitillä > Poista teksti reitiltä.

Ketjutettu reittiteksti siirtyy seuraavaan ketjutettuun tekstikehykseen tai reittitekstiobjektiin. Ketjuttamaton teksti poistetaan. Reitti säilyy, mutta
reittitekstimääritteet (sulkeet, sisä- ja ulkoportit sekä ketjutus) poistetaan.

Huomautus: Jos reitin viivaksi ja täytöksi on valittu Ei mitään, reitti ei näy tekstin poiston jälkeen. Muuta reitti näkyväksi painamalla D-näppäintä
heti, kun olet valinnut Teksti > Teksti reitillä > Poista teksti reitiltä. Valittu reitti muuttuu oletusviivan ja -täytön mukaiseksi.

Merkkivälin pienentäminen jyrkkien käännösten ja terävien kulmien kohdalla
1. Valitse reittiteksti valinta- tai tekstityökalulla.
2. Valitse Teksti > Reittiteksti > Asetukset tai kaksoisnapsauta reittitekstityökalua.
3. Määritä Väli-asetus pisteinä. Mitä suurempi arvo, sitä enemmän poistetaan jyrkissä kaarteissa merkkien väliin jäävää tilaa.

Reittiteksti ennen merkkivälin muuttamista (vasen) ja muuttamisen jälkeen (oikea).

Huomautus: Väli-asetuksella estetään merkkien leviäminen käyrällä tai terävässä kulmassa. Asetus ei vaikuta suoralla viivalla oleviin merkkeihin.
Jos haluat muuttaa reitillä olevien merkkien välejä, valitse merkit ja määritä merkkipariväli tai merkkiväli.

Reittitekstin sijainnin säätäminen
Voit muuttaa reittitekstin alku- ja loppukohtaa, liu'uttaa tekstiä ja vaihtaa reitin sijaintia myös muilla tavoin.

Reittitekstin alku- tai loppukohdan muuttaminen
1. Valitse reittiteksti valintatyökalulla .

2. Pidä osoitinta reittitekstin alku- tai loppumerkin päällä, kunnes sen viereen tulee pieni kuvake . Älä aseta osoitinta merkin sisä- tai
ulkoportin päälle.

Merkin valitseminen on helpompaa, kun lähennät reittinäkymää.

3. Vedä alku- tai loppumerkkiä reittiä pitkin.

Aseta osoitin alku- tai loppumerkin päälle. Siirrä reittitekstin rajaa vetämällä.
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Huomautus: kappaleen sisennys lasketaan alku- tai loppumerkistä.

Reittitekstin liu'uttaminen reittiä pitkin
1. Valitse reittiteksti valintatyökalulla .
2. Pidä osoitinta reittitekstin keskimerkin päällä, kunnes sen viereen tulee keskimerkkikuvake .

Merkin valitseminen on helpompaa, kun lähennät reittinäkymää.

3. Vedä keskimerkkiä reittiä pitkin.

Huomautus: Teksti ei siirry, jos sekä alku- että loppumerkki ovat reitin päissä. Voit varata tilaa tekstin vetämistä varten vetämällä alku- tai
loppumerkin kauemmaksi reitin päästä.

Reittitekstin peilaaminen
1. Napsauta valintatyökalua  ja valitse reittiteksti.
2. Pidä osoitinta reittitekstin keskimerkin päällä, kunnes sen viereen tulee keskimerkkikuvake .
3. Vedä keskimerkki reitin yli.

Vie osoitin keskimerkin kohdalle ja peilaa teksti vetämällä osoitin reitin yli.

Voit peilata reittitekstin myös valintaikkunan avulla. Valitse reittiteksti valinta- tai tekstityökalulla. Valitse Teksti > Teksti reitillä > Asetukset.
Valitse Peilaa-asetus ja sitten OK.

Tehosteen lisääminen reittitekstiin
1. Valitse reittiteksti valinta- tai tekstityökalulla.
2. Valitse Teksti > Reittiteksti > Asetukset tai kaksoisnapsauta reittitekstityökalua.
3. Valitse Tehoste-valikosta ensin jokin seuraavista vaihtoehdoista ja sitten OK:

Jos haluat pitää jokaisen merkin peruslinjan keskikohdan reitin tangentin suuntaisena, valitse Sateenkaari. Tämä on oletusasetus.

Reittitekstin tehosteet
A. Sateenkaari-tehoste B. Viistotus-tehoste C. 3D-nauha-tehoste D. Askelma-tehoste E. Painovoima-tehoste
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Jos haluat pitää merkkien pystyreunat tarkasti pystysuorassa reitin muodosta huolimatta ja kääntää merkkien vaakareunat reitin
suuntaisiksi, valitse Viistotus. Syntyvä vaakavääristymä soveltuu aaltoilevalle tai sylinterin ympärille kierretylle tekstille (kuten juomatölkin
etikettiin).

Jos haluat pitää merkkien vaakareunat tarkasti vaakasuorassa reitin muodosta huolimatta ja kääntää merkkien pystyreunat kohtisuoraan
reittiä vastaan, valitse 3D-nauha.

Jos haluat pitää jokaisen merkin peruslinjan vasemman reunan reitillä kiertämättä merkkejä, valitse Askelma.

Jos haluat pitää jokaisen merkin peruslinjan keskikohdan reitillä ja jokaisen pystyreunan yhdensuuntaisena reitin keskipisteen suhteen,
valitse Painovoima. Voit muuttaa tämän asetuksen perspektiivivaikutelmaa säätämällä reitin kaarta.

Ankkuroitujen objektien lisääminen reittitekstiin
1. Napsauta teksti- tai reittitekstityökalulla tekstiä kohdassa, johon haluat lisätä objektin ankkurin.
2. Lisää ankkuroitu objekti. Voit lisätä reittiin tekstiin sidottuja tai rivin yläpuolelle ankkuroituja objekteja tai kehyksiä. (Lisätietoja: Ankkuroidut

objektit.)

Huomautus: Tekstireitillä olevien ankkuroitujen objektien asetusvaihtoehdot poikkeavat hieman tavallisessa tekstikehyksessä olevien
ankkuroitujen objektien asetuksista. Tasaus-asetus tasaa objektin suhteessa sen ankkurimerkkiin ja Väli ennen -asetus ei ole käytettävissä.

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Kirjoittajan huomautusten lisääminen InDesignissa

Alkuun

Alkuun

Alkuun

Alkuun

Toimitushuomautusten lisääminen
Huomautustilan käyttäminen
Huomautusten hallinta
Huomautusten asetusten muokkaaminen

InDesignin Huomautukset-toiminnon yhteydessä huomautuksen tai jäljitetyn muutoksen tekijä tunnistetaan työnkulun käyttäjänimen avulla.
Huomautuksissa ja jäljitetyissä muutoksissa käytetään käyttäjäkohtaista värikoodia, joka määritetään InDesignin Asetukset-valintaikkunassa tai
InCopyn Käyttäjä-valintaikkunassa (Tiedosto > Käyttäjä).

Huomautuksia voidaan käyttää vain tekstissä. InDesignissa ne voidaan tulostaa vain juttueditorissa, eikä niitä voi viedä PDF-muotoon.

Toimitushuomautusten lisääminen
Kun lisäät toimitushuomautuksia hallittuun sisältöön InDesignissa, ne ovat työnkulun muiden käyttäjien nähtävissä. Huomautukset on tarkoitettu
ensisijaisesti InCopy-työnkulkua varten, mutta voit silti käyttää niitä myös InDesignissa. Voit esimerkiksi sijoittaa huomautuksiin tekstiä, jonka ehkä
haluat lisätä juttuun myöhemmin. Kun sisältö viedään Adobe PDF -muotoon InCopyssa, huomautukset voidaan muuttaa PDF-tiedoston
huomautuksiksi.

1. Napsauta tekstityökalulla kohtaa, johon haluat sijoittaa huomautuksen, ja valitse Teksti > Huomautukset > Uusi huomautus.

Kun muokkaat juttua juttueditorissa, näyttöön tulee päätymerkki. Sivuasettelu-näkymässä näyttöön tulee Huomautukset-paneeli.

2. Kirjoita huomautus päätymerkkien väliin tai Huomautukset-paneeliin.

Voit lisätä niin monta huomautusta kuin haluat mihin tahansa kohtaan. Et kuitenkaan voi lisätä huomautusta toiseen huomautukseen.

Jos haluat näyttää tai kätkeä huomautukset, valitse Näytä > Ekstrat > Näytä huomautukset tai Kätke huomautukset.

Huomautustilan käyttäminen
Huomautustilassa voit lisätä, jakaa ja poistaa huomautuksia helposti sen mukaan, missä kohdistin on tai mitä tekstiä on valittu.

1. Tee jokin seuraavista toimista:

Luo uusi huomautus viemällä kohdistin tekstiin.

Muunna teksti huomautukseksi valitsemalla teksti.

Jaa huomautus viemällä kohdistin huomautukseen.

Muunna huomautus tekstiksi valitsemalla huomautuksen päätymerkit (juttueditorissa).

Siirrä kohdistin pois huomautuksesta viemällä kohdistin huomautuksen alkuun tai loppuun.

2. Valitse Teksti > Huomautukset > Huomautustila.

Huomautusten hallinta
Huomautusankkuri  osoittaa huomautuksen sijainnin. Huomautukset-paneelissa näkyvät huomautuksen sisältö ja huomautuksen tiedot.

Voit muuntaa tekstin huomautukseksi valitsemalla tekstin ja valitsemalla Teksti > Huomautukset > Muunna huomautukseksi. Luodaan uusi
huomautus. Valittu teksti poistetaan jutusta ja liitetään uuteen huomautukseen. Huomautusankkuri tai päätymerkki lisätään kohtaan, josta
valitsemasi teksti poistettiin.

Voit muuntaa huomautuksen tekstiksi valitsemalla julkaisuun lisättävän tekstin Huomautukset-paneelissa. Vaihtoehtoisesti voit valita tekstiin
sidotun huomautuksen tekstin juttueditorissa. Valitse sitten Teksti > Huomautukset > Muunna tekstiksi.

Voit jakaa huomautuksen kahteen osaan sijoittamalla kursorin huomautukseen siihen kohtaan, josta haluat huomautuksen jakaa, ja
valitsemalla sitten Teksti > Huomautukset > Jaa huomautus.

Voit siirtyä huomautuksesta toiseen napsauttamalla tekstiä ja valitsemalla Teksti > Huomautukset > Edellinen huomautus tai Huomautukset >
Seuraava huomautus.

Huomautusten asetusten muokkaaminen
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Voit määrittää asetuksissa huomautusankkureiden, päätymerkkien sekä juttueditorissa tekstiin sidottujen huomautusten värin. Voit myös valita,
näytetäänkö huomautuksen tiedot työkaluvihjeenä ja koskevatko Etsi ja muuta -toiminto ja oikeinkirjoituksen tarkistus huomautusten sisältöä
juttueditorissa.

1. Valitse Muokkaa > Asetukset > Huomautukset (Windows) tai InDesign > Asetukset > Huomautukset (Mac OS).

2. Valitse huomautusankkureiden ja huomautuksen päätymerkkien väri Huomautuksen väri -valikosta. Käytä Käyttäjä-valintaikkunassa
määritettyä väriä valitsemalla [Käyttäjän väri]. Tämä asetus on erityisen hyödyllinen, kun useat henkilöt työstävät tiedostoa.

3. Näytä huomautuksen tiedot ja sisällön osa tai koko sisältö työkaluvihjeenä valitsemalla Näytä huomautustyökaluvihjeet. Vihje näkyy, kun
hiiren osoitin on huomautusankkurin päällä Sivuasettelu-näkymässä tai päätymerkin päällä juttueditorissa.

4. Määritä, haluatko Etsi ja muuta- ja Tarkista oikeinkirjoitus -komentojen koskevan tekstiin sidottujen huomautusten sisältöä (vain
juttueditorissa).

Huomautus: Etsi ja vaihda- ja Tarkista oikeinkirjoitus -komentoja ei voi käyttää huomautusten sisältöön Sivuasettelu-näkymässä huolimatta
siitä, mitä Asetukset-valintaikkunassa on määritetty. Muuta kaikki -komento kuitenkin muuttaa huomautusten sisältöä.

5. Valitse tekstiin sidotun huomautuksen taustaväriksi [Ei mitään] tai [Huomautuksen väri] (vaiheessa 2 valitsemasi väri).

6. Napsauta OK-painiketta.

Lisää ohjeaiheita
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Linkitetyt jutut

Alkuun

Alkuun

Linkitetyn jutun luominen
Linkitetyn jutun asetusten määrittäminen
Linkitetyn jutun päivittäminen
Alkuperäisen jutun muokkaaminen

Sisältöjen kopiointi eri sivuille ei ole mikään helppo tehtävä. Kopioinnissa ja liittämisessä piilee virheiden vaara ja se vie aikaa. Linkitettyjen juttujen
avulla voit hallita samassa dokumentissa olevan jutun tai tekstisisällön eri versioita. Linkitetyt jutut tukevat kehittyviä työnkulkuja, joissa on
suunniteltava esimerkiksi pysty- ja vaakasuuntaisia sivuasetteluita. Linkitetyt jutut toimivat hyvin myös perinteisissä tulostus- ja julkaisutyönkuluissa,
joissa eri sivuilla oleva pohjateksti on mahdollisesti synkronoitava.

Linkitetyt jutut toimivat perinteisten linkkien tapaan. Voit määrittää jutun pääjutuksi ja sitten sijoittaa saman jutun dokumentissa alijuttuina eri
paikkoihin. Kun päivität pääjutun, alijutut merkitään Linkit-paneelissa, ja voit päivittää ne synkronoimalla ne pääjutun kanssa. Voit luoda linkitettyjä
juttuja tavallisten juttujen tai reittitekstijuttujen perusteella. Myös jutussa olevia ankkuroituja objekteja tuetaan.

Linkitettyjen juttujen synkronointi säilyy, kun päivität käytettyjä tyylejä InDesign-tyyleiksi.

Linkitetyt jutut merkitään synkronoimattomiksi Linkit-paneelissa, vaikka näkyviä eroja ei ole. Julkaisun yleiset muutokset, jotka saavat InDesignin
koostamaan jutut uudelleen, merkitsee linkit. Näiden yleisten muutosten syynä voi olla seuraavien asetusten tai määritelmien päivitykset:

Alaviitteet

Tekstimuuttujat

Ehdollinen teksti

Värimallit

XML-nimiöt

Nimetyt ruudukot

Jos korvaat kaikki fontit tai kaikki objektin esiintymät, InDesign koostaa kaikki jutut uudelleen ja merkitsee linkit.

Linkitetyn jutun luominen
1. Valitse juttu valitsemalla tekstikehys tai aseta lisäyskohdistin tekstiin. Voit valita myös useita juttuja vaihtonapsauttamalla, jos olet

valitsemassa tekstikehyksiä.

2. Valitse Muokkaa > Sijoita ja linkitä juttu. Juttu ladataan kohdistimeen.

3. Napsauta olemassa olevaa tyhjää tekstikehystä tai piirrä kehys linkitetyn jutun sijoittamiseksi.

-kuvake näkyy linkitetyn jutun vasemmassa yläkulmassa. Juttu näytetään Linkit-paneelissa linkitettynä juttuna. Oletusarvoisesti Linkit-
paneelissa oleva jutun nimi luodaan alkuperäisen jutun ensimmäisten merkkien perusteella.

Voit muuttaa linkitetyn jutun oletusarvoista nimeä myös Tasot-paneelissa.

Linkitetyn jutun asetusten määrittäminen

1. Valitse linkitetty juttu Linkit-paneelista.

2. Valitse Linkit-paneelin valikosta Paneeli Linkitetyn jutun asetukset.

3. Valitse asetukset tarpeen mukaan:
Päivitä linkki julkaisua tallennettaessa

Varoita, jos linkin päivitys korvaa paikalliset muokkaukset

Poista pakotetut rivinvaihdot

Vihje: Jos haluat määrittää oletusarvoiset juttuasetukset kaikkien julkaisujen ollessa suljettuina, avaa Linkit-paneelin valikko ja valitse Linkitetyn
jutun asetukset.

Vihje: Jos haluat määrittää Linkitetyn jutun asetukset linkitettyjä juttuja luotaessa, paina vaihtonäppäintä, kun valitset Muokkaa > Sijoita ja linkitä
juttu.
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Linkitetyn jutun päivittäminen
Alkuperäistä juttua muokattaessa linkitetyn jutun vieressä olevassa Linkit-paneelissa näkyy .

Päivitä alijuttu kaksoisnapsauttamalla Linkit-paneelissa .

Jos olet muokannut lapsen juttua paikallisesti, muokkaukset korvataan alkuperäisen jutun sisällöllä. Jos valitset Varoita, jos linkin päivitys korvaa
paikalliset muokkaukset, näyttöön tulee varoitus.

Linkkitiedot-ruudussa voit määrittää, onko juttuun tehty paikallisia muokkauksia. Jos jutun tilana on ”Muokattu teksti”, paikallisia muokkauksia on
tehty.

Alkuperäisen jutun muokkaaminen
Jos käsittelet linkitettyä juttua ja haluat siirtyä alkuperäiseen juttuun, toimi seuraavasti:

1. Valitse linkitetty juttu Linkit-paneelista.

2. Valitse  tai valitse Linkit-paneelin valikosta Muokkaa alkuperäistä ( ).

Kohdistus siirtyy alkuperäisen jutun sisältävälle sivulle.
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Working with markers
About markers
View markers
Select markers

About markers

InDesign inserts a marker in text for items such as index entries, XML tags, and hyperlink text and anchors. These
markers have no width and they don’t affect composition of text. However, you can select these markers and cut,
copy, or delete them. InDesign uses the location of the marker to produce an accurate bookmark or page
reference in the table of contents, index, and exported PDF files.

You can view all markers at once, or view hyperlink or tagged text markers only. You can also view markers in
Story Editor, where they are larger and easier to identify.

Note:

When you select a word, all of its markers are also selected. Keep this in mind when you are cutting, copying, or
deleting text.

Types of markers

A. Tagged text B. Index marker C. Hyperlink 

View markers

To display markers, choose Type > Show Hidden Characters.
To view hyperlink markers only, choose View > Extras > Show Hyperlinks.
To view tagged text markers only, choose View > Structure > Show Tag Markers.

Select markers

1. Choose Type > Show Hidden Characters.
2. Place the insertion point next to the marker.
3. Holding down Shift, press the Left Arrow or Right Arrow key to select a marker.

You can also locate markers using different methods. For example, you can locate an index marker by choosing the
Go To Selected Marker option in the Index panel menu.

  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.
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Tyylit

GREP-tyylien käyttäminen (video 4:46)
Michael Ninness  (1.1.2011)
Opastus - video
Tässä video-opastusohjelmassa näytetään, miten voit käyttää haluamaasi merkkityyliä määrittämääsi GREP-ilmausta vastaavassa
tekstissä. Lisää GREP-tyyli osaksi kappaletyyliä.
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Kappale- ja merkkityylit

Alkuun

Tietoja merkki- ja kappaletyyleistä
Tyylipaneelien yleiskuvaus
Kappale- ja merkkityylien lisääminen
Tyylien osoittaminen vientinimiöihin | CC, CS6, CS5.5
Word-tyylien muuntaminen InDesign-tyyleiksi
Tyylien käyttäminen
Merkki- ja kappaletyylien muokkaaminen
Merkki- tai kappaletyylien poistaminen
Merkki- ja kappaletyylien ohittaminen
Tyylin luettelomerkkien ja numeroinnin muuntaminen tekstiksi
Merkki- ja kappaletyylien etsiminen ja korvaaminen

Tietoja merkki- ja kappaletyyleistä

Merkkityyli on kokoelma merkkien muotoilumääritteitä, jotka voidaan lisätä tekstiin kerralla. Kappaletyyli koostuu merkkien ja kappaleiden
muotoiluun käytettävistä määritteistä, ja sitä voidaan käyttää valitussa kappaleessa tai valituissa kappaleissa. Kappaletyylit ja merkkityylit ovat
omissa paneeleissaan. Kappale- ja merkkityylejä kutsutaan toisinaan tekstityyleiksi.

Kehysruudukon muotoiluasetuksissa kehysruudukon asetukseksi voidaan valita nimetty ruudukko. (Katso Nimetyt ruudukot -paneelin yleiskatsaus.)
Voit myös luoda objektityylin ruudukon ominaisuuksilla. (Katso Tietoja objektityyleistä.)

Kun tyylin muotoilua muutetaan, kaikki samalla tyylillä muotoillut tekstit muuttuvat uutta tyyliä vastaaviksi.

Voit luoda, muokata ja poistaa tyylejä erillisistä Adobe InCopy -julkaisuista tai Adobe InDesign -julkaisuun linkitetystä InCopy-sisällöstä. Kun sisältö
päivitetään InDesignissa, uudet tyylit lisätään InDesign-julkaisuun, mutta InDesign-tyyli korvaa InCopyssa tehdyt tyylin muutokset. Linkitetyn
sisällön tyylejä on tavallisesti parasta hallita InDesignissa.

[Peruskappale]-tyylit

Jokainen uusi julkaisu sisältää normaalisti [Peruskappale]-tyylin, jota käytetään kirjoitetussa tekstissä. Tyyliä voi muokata, mutta sitä ei voi poistaa
tai nimetä uudelleen. Voit poistaa tai nimetä uudelleen itse luomasi tyylit. Voit myös valita jonkin muun tekstissä käytettävän oletustyylin.

Merkkityylin määritteet

Kappaletyyleistä poiketen merkkityylit eivät sisällä kaikkia valitun tekstin muotoilumääritteitä. Kun luot merkkityylin, InDesign sisällyttää siihen vain
ne määritteet, jotka ovat erilaiset kuin valitun tekstin muotoilussa. Voit siis luoda merkkityylin, joka tekstiin liittämisen jälkeen muuttaa vain osaa
määritteistä, esimerkiksi kirjasinperhettä ja -kokoa, ja jättää kaikki muut merkkimääritteet ennalleen. Jos haluat sisällyttää tyyliin muita määritteitä,
lisää ne tyyliä muokatessasi.

Seuraava tyyli

Voit lisätä tyylit automaattisesti samalla, kun kirjoitat tekstiä. Jos julkaisusi esimerkiksi edellyttää, että otsikkotyyliä otsikko 1 seuraa tyyli leipäteksti,
voit määrittää otsikko 1 -tyylin Seuraava tyyli -asetukseksi leipäteksti. Kun olet kirjoittanut kappaleen otsikko 1 -tyylillä, Enter- tai Return-näppäimen
painaminen aloittaa uuden kappaleen leipäteksti-tyylillä.

Jos käytät pikavalikkoa liittäessäsi tyyliä vähintään kahteen kappaleeseen, voit aiheuttaa sen, että ensimmäinen kappale käyttää ylätyyliä ja muut
kappaleet Seuraava tyyli -asetusta. (Katso Tyylien käyttäminen.)
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Huomautus:

Voit käyttää Seuraava tyyli -toimintoa valitsemalla tyylin Seuraava tyyli -valikosta, kun luot tai muokkaat tyyliä.

Jeff Witchel on tehnyt opetusvideon Seuraava tyyli -ominaisuudesta. Se on osoitteessa Seuraava tyyli -ominaisuuden käyttäminen.

Tyylipaneelien yleiskuvaus

Käytä Merkkityylit-paneelia, kun luot ja nimeät merkkityylejä ja liität niitä kappaleen tekstiin. Käytä Kappaletyylit-paneelia, kun luot ja nimeät
kappaletyylejä ja liität niitä kokonaisiin kappaleisiin. Tyylit tallentuvat julkaisun mukana ja näkyvät paneelissa aina, kun kyseinen julkaisu avataan.

Kun tekstiä valitaan tai kohdistin sijoitetaan, tekstissä käytetty tyyli näkyy korostettuna jommassakummassa tyylipaneelissa, ellei se ole
supistetussa tyyliryhmässä. Jos valitaan tekstialue, jossa käytetään useita tyylejä, mikään tyyli ei näy korostettuna tyylipaneelissa. Jos valitset
tekstialueen, jossa on käytetty useita tyylejä, tyylipaneelissa näkyy merkintä (Sekoitettu).

Kappaletyylit-paneelin avaaminen

Jos haluat tuoda Kappaletyylit-paneelin esiin, valitse Teksti > Kappaletyylit tai napsauta Kappaletyylit-välilehteä, joka on normaalisti
sovellusikkunan oikeassa reunassa.

Merkkityylit-paneelin avaaminen

Valitse Teksti > Merkkityylit tai napsauta Merkkityylit-välilehteä, joka on normaalisti sovellusikkunan oikeassa reunassa.

Kappale- ja merkkityylien lisääminen

Jos haluamiasi tyylejä on käytetty jossakin toisessa InCopyn, InDesignin tai tekstinkäsittelyohjelman julkaisussa, voit tuoda ne nykyiseen
julkaisuun. Jos käsittelet erillistä juttua, voit määrittää merkki- ja kappaletyylejä InCopyssa.

Kappale- ja merkkityylien määrittäminen

1. Jos haluat käyttää uuden tyylin pohjana jonkin valmiin tekstin muotoilua, valitse teksti tai sijoita kohdistin tekstiin.

Jos tyylipaneelista on valittu ryhmä, uudesta tyylistä tulee ryhmän osa.

2. Valitse Kappaletyylit-paneelivalikosta Uusi kappaletyyli tai Merkkityylit-paneelivalikosta Uusi merkkityyli.

3. Kirjoita Tyylin nimi -ruutuun uuden tyylin nimi.

4. Valitse Perustuu-kohdassa tyyli, johon nykyinen tyyli perustuu.

Perustuu-asetus antaa mahdollisuuden ketjuttaa tyylejä, jotta yhden tyylin muutokset siirtyvät muihin kyseiseen tyyliin
perustuviin tyyleihin. Normaalisti uusien tyylien perustana on kappaletyylien kohdalla [Ei kappaletyyliä] tai merkkityylien kohdalla [Ei mitään]
tai minkä tahansa valitun tekstin tyyli.

5. Määritä Seuraava tyyli -kohdassa (vain Kappaletyylit-paneeli), mitä tyyliä käytetään nykyisen tyylin jälkeen, kun Enter- tai Return-näppäintä
painetaan.

6. Jos haluat lisätä pikanäppäimen, sijoita kohdistin Pikanäppäin-ruutuun ja varmista, että Num Lock on käytössä. Pidä haluamaasi vaihto-, Alt-
ja Ctrl-näppäinten (Windows) tai optio-, vaihto- ja komentonäppäinten (Mac OS) yhdistelmää painettuna ja paina numeronäppäimistön
numeronäppäintä. Tyylien pikanäppäimiksi voidaan määrittää vain numeronäppäimistön numeronäppäimiä (ei kirjaimia tai muita
numeronäppäimiä). Jos näppäimistössäsi ei ole Num Lock -näppäintä, et voi lisätä tyyleihin pikanäppäimiä.

7. Jos haluat käyttää uutta tyyliä valitussa tekstissä, valitse Käytä tyyliä valinnassa.

8. Valitse vasemmasta reunasta haluamasi luokka (esimerkiksi Perusmerkkimuotoilut) ja määritä tyyliin lisättävät muotoilumääritteet.

Kun määrität Tyyliasetukset-valintaikkunassa merkkivärin, voit luoda uuden värin kaksoisnapsauttamalla Täyttö- tai Viiva-ruutua.

9. Jos kyseessä on merkkityyli, määrittämättä jätetyillä määritteillä ei ole merkitystä. Kun tyyliä käytetään, kappaletyylin mukainen tekstin
muotoilu säilyy kyseisen määritteen osalta. Määriteasetuksen poistaminen merkkityylistä:
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Käytä tuotavan tyylin määritystä

Nimeä uudelleen automaattisesti

Valitse asetuksen valikosta (Ohita).

Poista asetuksen teksti tekstiruudusta.

Napsauta valintaruutua niin monta kertaa, että siihen tulee pieni neliö (Windows) tai viiva (-) (Mac OS).

Jos kyseessä on merkin väri, pidä Ctrl-näppäintä (Windows) tai komentonäppäintä (Mac OS) painettuna ja napsauta väriruutua.

10. Kun valinnut kaikki muotoilumääritteet, napsauta OK-painiketta.

Luodut tyylit näkyvät vain nykyisessä julkaisussa. Jos mikään julkaisu ei ole avoinna, luomasi tyylit näkyvät kaikissa uusissa julkaisuissa.

Kappale- tai merkkityylin perustuminen toiseen tyyliin

Monissa julkaisumuotoiluissa on hierarkkinen samoja määritteitä sisältävien tyylien rakenne. Usein otsikoissa ja alaotsikoissa käytetään samaa
kirjasinta. Voit ketjuttaa samankaltaisia tyylejä luomalla perus- eli ylätyylejä. Kun muokkaat ylätyyliä, myös alityylit muuttuvat. Sitten voit muokata
alityylejä, jotta ne erottuvat ylätyylistä.

Jos haluat luoda tyylin, joka on melkein samanlainen kuin jokin toinen tyyli mutta jota ei ole ketjutettu siihen, käytä Monista tyyli -komentoa ja
muokkaa kopiota.

1. Luo uusi tyyli.

2. Valitse ylätyyli Uusi kappaletyyli- tai Uusi merkkityyli -valintaikkunan Perustuu-valikosta. Uutta tyyliä kutsutaan alityyliksi.

Normaalisti uusien tyylien perustana on [Ei kappaletyyliä] tai [Ei mitään] tai minkä tahansa valitun tekstin tyyli.

3. Määritä muotoilu, jotta uusi tyyli erottuu sen perustana olleesta tyylistä. Voit esimerkiksi haluta tehdä alaotsikon kirjasimesta pienemmän kuin
otsikon ylätyylissä käytetystä kirjasimesta.

Jos teet muutoksia alityylin muotoiluun ja haluatkin aloittaa alusta, napsauta Palauta perusta -painiketta. Tämä palauttaa alityylin muotoilun
identtiseksi sen perustana olleen tyylin kanssa. Sitten voit määrittää uuden muotoilun. Jos taas muutat alityylin Perustuu-tyyliä, alityylin määritys
päivittyy vastaamaan uutta ylätyyliä.

Tyylien tuominen muista julkaisuista

Voit tuoda aktiiviseen julkaisuun kappale- ja merkkityylejä toisesta InDesign-julkaisusta (kaikki versiot). Voit määrittää, mitkä tyylit ladataan ja mitä
tapahtuu, jos ladatulla tyylillä on sama nimi kuin jollakin nykyisen julkaisun tyylillä. Voit tuoda tyylejä myös InCopy-julkaisusta.

Voit tuoda kappale- ja merkkityylejä InDesign- tai InCopy-julkaisusta erilliseen InCopy-julkaisuun tai InDesigniin linkitettyyn InCopy-sisältöön. Voit
määrittää, mitkä tyylit ladataan ja mitä tapahtuu, jos ladatulla tyylillä on sama nimi kuin jollakin nykyisen julkaisun tyylillä.

Jos tuot tyylejä linkitettyyn sisältöön, uudet tyylit lisätään InDesign-julkaisuun, kun sisältö päivitetään. Samalla InDesign-tyyli korvaa
sisällössä mahdollisesti olevan toisen samannimisen tyylin.

1. Tee Merkkityyli- tai Kappaletyylit-paneelissa jompikumpi seuraavista:

Valitse Tyylit-paneelivalikosta Lataa merkkityylit tai Lataa kappaletyylit.

Lataa sekä merkki- että kappaletyylit valitsemalla Tyylit-paneelivalikosta Lataa kaikki tyylit.

2. Kaksoisnapsauta sitä InDesign-julkaisua, jossa tuotavat tyylit ovat.

3. Varmista Lataa tyylit -valintaikkunasta, että haluamiesi tyylien vieressä on valintamerkki. Jos jollakin olemassa olevista tyyleistä on sama nimi
kuin tuodulla tyylillä, valitse ensin jokin seuraavista Ristiriita nykyisen tyylin kanssa -kohdan asetuksista ja napauta sitten OK-painiketta:

Korvaa nykyisen tyylin ladatulla tyylillä ja käyttää uusia määritteitä kaikissa nykyisen julkaisun teksteissä,
joissa aikaisemmin käytettiin vanhaa tyyliä. Voit vertailla tyylejä keskenään, sillä tuotavien ja nykyisten tyylien määritykset näkyvät Lataa tyylit
-valintaikkunan alareunassa.

Nimeää ladatun tyylin uudelleen. Jos molemmissa julkaisuissa on esimerkiksi Alaotsikko-tyyli, ladatulle
tyylille annetaan nykyisessä julkaisussa nimi "Alaotsikko kopio".
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Tyylien jakamiseen voidaan käyttää myös Kirjat-toimintoa. (Katso Kirjan julkaisujen synkronoiminen.)

Tyylien osoittaminen vientinimiöihin | CC, CS6, CS5.5

Johdanto vientinimiöihin

Vientinimiöinnin avulla voit määrittää, miten InDesign-tyylien avulla luotu teksti merkitään HTML-, EPUB- tai nimiöidyssä PDF-tulosteessa.

Voit määrittää myös vietyyn sisältöön lisättävät CSS-luokkien nimet. EPUB/HTML-viennissä CSS-luokkien avulla voidaan erottaa lievät
tyylimuunnokset toisistaan. Luokkien nimiä ei tarvitse antaa, sillä InDesign luo nimet automaattisesti tyylin nimen perusteella.

Et voi esikatsella vientinimiöintiä InDesign-asettelussa, koska se vaikuttaa ainoastaan vietävään EPUB-, HTML- tai PDF-tiedostoon.

Muokkaa kaikkia vientinimiöitä -toiminnolla voit kätevästi tarkastella ja muokata tyyliosoituksia yhdessä valintaikkunassa.

Tyylinimiöosoituksen määrittäminen

1. Avaa osoitettavan tyylin kappaleen, merkin tai objektin Tyyliasetukset-valintaikkuna.

2. Valitse vasemmalla olevasta paneelista Vientinimiöinti ja tee jokin seuraavista toimista:

Valitse osoitettava nimiö EPUB- ja HTML-tulostetta varten.

Määritä osoitettava luokka EPUB- ja HTML-tulostetta varten. Luokkien nimien avulla luodaan tyylimääritelmät oletusnimiöitä varten.

Jos haluat sisällyttää tyylin CSS:ään, valitse Käytä CSS:ssä -valintaruutu. Jos valintaruutua ei valita, CSS-luokkaa ei luoda kyseiselle
tyylille. Jos käytössä on vähintään kaksi tyyliä, joille on määritetty sama luokka, InDesign näyttää viennin aikana virhe- tai
varoitussanoman. Tämä asetus on käytettävissä vain InDesign CC:ssä.

Valitse osoitettava nimiö PDF-tulostetta varten. Tämä asetus on käytettävissä vain kappaletyylejä varten.

Muokkaa kaikkia vientinimiöitä

Voit tarkastella ja muokata kaikkia vientinimiöitä yhdessä ikkunassa.

1. Valitse Kappaletyylit-, Merkkityylit- tai Objektin tyylit -paneelivalikosta Muokkaa kaikkia vientinimiöitä.

2. Valitse EPUB ja HTML tai PDF.

3. Valitse tyyliä vastaava nimiö. Se muunnetaan luetteloon. Valitse uusi arvo.

Word-tyylien muuntaminen InDesign-tyyleiksi

Kun Microsoft Word -tiedostoa tuodaan InDesigniin tai InCopyyn, kukin Wordissa käytetty tyyli voidaan osoittaa vastaavaksi InDesignin tai InCopyn
tyyliksi. Tällä tavoin määritetään, mitä tyylejä InCopy käyttää tuodun tekstin muotoilussa. Jokaisen tuodun Word-tyylin vieressä näkyy levykuvake 

, kunnes tyyliä muokataan InDesignissa tai InCopyssa.

1. Tee jokin seuraavista:

Jos haluat lisätä Word-tiedoston InDesignissa tai InCopyssa olevaan tekstiin, valitse Tiedosto > Sijoita. Valitse Näytä tuontiasetukset ja
kaksoisnapsauta Word-tiedostoa.

Jos haluat avata Word-tiedoston erillisenä InCopy-julkaisuna, käynnistä InCopy, valitse Tiedosto > Avaa ja kaksoisnapsauta sitten Word-
tiedostoa.

2. Valitse Säilytä tyylit ja muotoilu tekstistä ja taulukoista -asetus.

3. Valitse Mukautetun tyylin tuonti ja napsauta Tyylin osoittaminen -painiketta.

4. Valitse Tyylin osoittaminen -valintaikkunasta Word-tyyli ja InDesign-tyylin alaisesta valikosta jokin asetus. Voit valita seuraavia asetuksia:
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Jos tyylien nimien välillä ei ole ristiriitaa, valitse Uusi kappaletyyli, Uusi merkkityyli tai jokin InDesign-tyyleistä.

Jos tyylien nimien välillä on ristiriita, valitse Määritä InDesign-tyyli uudelleen ja muotoile tuotu teksti Word-tyylillä. Valitse InDesign-tyyli,
jos haluat muotoilla tuotua tyyliä käyttävän tekstin InDesign-tyylillä. Valitse Automaattinen uudelleen nimeäminen, jos haluat vaihtaa
Word-tyylin nimen.

5. Sulje Tyylin osoittaminen -valintaikkuna napsauttamalla OK-painiketta ja tuo tiedosto napsauttamalla OK-painiketta uudelleen.

Tyylien käyttäminen

Oletuksen mukaan kappaletyylin käyttäminen ei poista nykyisiä merkkimuotoiluja tai -tyylejä, joita on käytetty osassa kappaletta. Voit kuitenkin
halutessasi poistaa muotoilut käyttäessäsi tyylejä. Plusmerkki (+) valitun kappaletyylin vieressä Tyylit-paneelissa ilmaisee, että valitussa tekstissä
käytetään merkki- tai kappaletyyliä sekä lisämuotoiluja, jotka eivät kuulu valittuun tyyliin. Tällaista lisämuotoilua kutsutaan ohitukseksi tai
paikalliseksi muotoiluksi.

Merkkityylit poistavat tai palauttavat nykyisen tekstin merkkimääritteet, jos ne ovat tyylin määrittämiä.

Merkkityylin käyttäminen

1. Valitse merkit, joissa haluat käyttää tyyliä.

2. Tee jokin seuraavista:

Napsauta Merkkityylit-paneelissa näkyvää merkkityylin nimeä.

Valitse Ohjauspaneelin avattavasta luettelosta merkkityylin nimi.

Paina tyylille määrittämääsi pikanäppäintä. (Varmista, että Num Lock on käytössä.)

Kappaletyylin käyttäminen

1. Napsauta kappaleen sisäpuolta tai valitse kaikki kappaleet tai kappaleen osat, joissa haluat käyttää tyyliä.

2. Tee jokin seuraavista:

Napsauta Kappaletyylit-paneelissa näkyvää kappaletyylin nimeä.

Valitse Ohjauspaneelin valikosta kappaletyylin nimi.

Paina tyylille määrittämääsi pikanäppäintä. (Varmista, että Num Lock on käytössä.)

3. Jos tekstiin jää virheellisiä muotoiluja, valitse Kappaletyylit-paneelista Poista ohitukset.

Peräkkäisten tyylien käyttäminen useissa kappaleissa

Seuraava tyyli -asetus määrittää, mikä tyyli otetaan käyttöön sen jälkeen, kun on valittu jokin tyyli tyyliä ja painettu Enter- tai Return-näppäintä.
Lisäksi voi määrittää erilaisia tyylejä kerralla useille kappaleille.

Oletetaan esimerkiksi, että käytettävissä on kolme tyyliä sanomalehtipalstan muotoiluun (Otsikko, Tekijän nimi ja Leipäteksti). Otsikko-tyyli käyttää
seuraavana tyylinä Tekijän nimi -tyyliä, Tekijän nimi -tyyli Leipäteksti-tyyliä ja Leipäteksti-tyyli [Sama tyyli] -asetusta. Jos valitaan koko artikkeli
(otsikko, tekijän nimirivi ja kaikki kappaleet) ja sitten valitaan Otsikko-tyyli pikavalikon erityisellä Seuraava tyyli -komennolla, artikkelin ensimmäinen
kappale muotoillaan Otsikko-tyylillä, toinen kappale Tekijän nimi -tyylillä ja kaikki muut kappaleet Leipäteksti-tyylillä.
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Ennen tyylin määrittämistä Seuraava tyyli -asetuksella ja sen jälkeen

1. Valitse kappaleet, joissa haluat käyttää tyylejä.

2. Napsauta hiiren kakkospainikkeella (Windows) tai Control-osoita (Mac OS) Kappaletyylit-paneelissa näkyvää ylätyyliä ja valitse sitten Käytä
[Tyylin nimi] ja Seuraava tyyli.

Jos tekstissä on muotoiluohituksia tai merkkityylejä, voit pikavalikon avulla poistaa toisen tai molemmat niistä.

Merkki- ja kappaletyylien muokkaaminen

Yksi tyylien käyttämisen eduista on se, että tyylin määritystä muutettaessa kaikki kyseisellä tyylillä muotoillut tekstit muuttuvat uuden
tyylimäärityksen mukaisiksi.

jos muotoilet InDesign-julkaisuun linkitetyn sisällön tyylejä, muutokset korvautuvat linkitettyä sisältöä päivitettäessä.

Tyyliä muokkaaminen valintaikkunan avulla

1. Tee jokin seuraavista:

Jos et halua käyttää tyyliä valitussa tekstissä, napsauta hiiren kakkospainikkeella (Windows) tai Control-osoita (Mac OS) Tyylit-
paneelissa näkyvää tyylin nimeä ja valitse sitten Muokkaa[tyylin nimi].

Kaksoisnapsauta tyylin nimeä Tyylit-paneelissa tai valitse ensin tyyli ja sitten Tyylit-paneelin valikosta Tyyliasetukset. Tyyliä sovelletaan
mihin tahansa valittuun tekstiin tai tekstikehykseen. Jos tekstiä tai tekstikehystä ei ole valittu, tyyli määritetään oletustyyliksi, jota
käytetään kaikissa uusiin kehyksiin kirjoitettavissa teksteissä.

2. Muuta valintaikkunan asetuksia ja napsauta sitten OK-painiketta.

Tyylin määrittäminen uudelleen valittua tekstiä vastaavaksi

Kun olet käyttänyt tyyliä, voit ohittaa minkä tahansa sen asetuksista. Jos pidät tekemistäsi muutoksista, voit määrittää tyylin uudelleen niin, että se
vastaa muutetun tekstin muotoilua.

jos määrität uudelleen InDesign-julkaisuun linkitetyn InCopy-sisällön tyylejä, muutokset korvautuvat linkitettyä sisältöä päivitettäessä.

1. Valitse tekstityökalulla  sillä tyylillä muotoiltu teksti, jonka haluat määrittää uudelleen.

2. Tee haluamasi muutokset kappale- ja merkkimääritteisiin.

3. Valitse Tyylit-paneelivalikosta Määritä tyyli uudelleen.

Merkki- tai kappaletyylien poistaminen

Kun poistat tyylin, voit valita sen tilalle toisen tyylin ja valita, säilytetäänkö muotoilu. Kun poistat tyyliryhmän, kaikki sen sisältämät tyylit katoavat.
Ohjelma kehottaa korvaamaan ryhmän kaikki tyylit yksitellen.

1. Valitse Tyylit-paneelista tyylin nimi.

2. Tee jokin seuraavista:

Valitse paneelivalikosta Poista tyyli tai napsauta paneelin alaosassa olevaa Poista-kuvaketta .

Napsauta hiiren kakkospainikkeella (Windows) tai Control-osoita (Mac OS) tyyliä ja valitse Poista tyyli. Tästä menetelmästä on hyötyä
varsinkin silloin, kun tyyli halutaan poistaa käyttämättä sitä tekstissä.

3. Valitse korvaava tyyli Poista kappaletyyli -valintaikkunasta.
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Alkuun

Huomautus:

Jos korvaat kappaletyylin vaihtoehdolla [Ei kappaletyyliä] tai merkkityylin vaihtoehdolla [Ei mitään], valitse Säilytä muotoilu -asetus
säilyttääksesi tekstin muotoilun. Teksti säilyttää muotoilunsa mutta ei ole enää liitetty tyyliin.

4. Napsauta OK-painiketta.

Jos haluat poistaa kaikki käyttämättömät tyylit, valitse Tyylit-paneelivalikosta Valitse kaikki käyttämättömät ja napsauta sitten Poista-kuvaketta.
Kun poistat käyttämättömän tyylin, ohjelma ei kehota korvaamaan sitä.

Merkki- ja kappaletyylien ohittaminen

Kun lisäät kappaletyylin tekstiin, merkkityylit ja muut aikaisemmat muotoilut jätetään ennalleen. Voit ohittaa minkä tahansa tyylin asetuksista
määrittämällä muotoilun, joka ei kuulu tyyliin. Kun tekstissä käytetään tyylin lisäksi muotoilua, joka ei ole osa tyyliä, kyseessä on ohitus tai
paikallinen muotoilu Kun valitaan teksti, jossa on ohitus, tyylin nimen viereen tulee plusmerkki (+). Merkkityylien kohdalla ohitus näkyy vain, jos
käytetty määrite on osa tyyliä. Jos merkkityyli esimerkiksi muuttaa vain tekstin väriä, tekstin kirjasinkoon muuttaminen ei näy ohituksena.

Merkkityylit ja muotoiluohitukset voidaan poistaa lisättäessä tyyli tekstiin. Ohitukset voidaan poistaa myös kappaleesta, johon tyyli on lisätty.

Jos tyylin vieressä on plusmerkki (+), ohitusmääritteet saadaan näkyviin pitämällä hiiren osoitinta tyylin päällä.

Ohitusten säilyttäminen tai poistaminen kappaletyylejä käytettäessä

Kun haluat käyttää kappaletyyliä ja säilyttää merkkityylit mutta poistaa ohitukset, pidä Alt-napsauta (Windows) tai optio-osoita (Mac OS) tyylin
nimeä Kappaletyylit-paneelissa.
Kun haluat käyttää kappaletyyliä ja poistaa merkkityylit ja ohitukset, pidä Alt+vaihto-napsauta (Windows) tai optio+vaihto-osoita (Mac OS)
tyylin nimeä Kappaletyylit-paneelissa.

Napsauta hiiren kakkospainikkeella (Windows) tai Control-osoita (Mac OS) Kappaletyylit-paneelissa näkyvää tyyliä ja valitse asetus
pikavalikosta. Sitten voit poistaa ohitukset, merkkityylit tai molemmat tyylit lisäämisen yhteydessä.

Kappaletyylin ohitusten poistaminen

1. Valitse ohituksia sisältävä teksti. Voit valita myös useita kappaleita, joissa on eri tyylejä.

2. Tee Kappaletyylit-paneelissa jokin seuraavista toimista:

Poista kappaleen ja merkkien muotoilu napsauttamalla Poista ohitukset -kuvaketta  tai valitsemalla Kappaletyylit-paneelista Poista
ohitukset.

Poista merkkien ohitukset mutta säilytä kappalemuotoilun Ctrl-napsauttamalla (Windows) tai komento-osoittamalla (Mac OS) Poista
ohitukset -kuvaketta.

Poista kappaletason ohitukset mutta säilytä merkkitason ohitukset vaihto+Ctrl-napsauttamalla (Windows) tai vaihto+komento-osoittamalla
(Mac OS) Kappaletyylit-paneelissa näkyvää Poista ohitukset -kuvaketta.

Kun poistat ohituksia, kappaletason ohitukset poistetaan koko kappaleesta, vaikka vain osa kappaleesta olisi valittu.
Merkkitason ohitukset poistetaan vain valinnasta.

Ohitusten poistaminen ei poista merkkityylien muotoilua. Jos haluat poistaa merkkityylin muotoilun, valitse merkkityylin sisältävä teksti ja
napsauta sitten Merkkityylit-paneelissa [Ei mikään].

Tekstin ja sille määritetyn tyylin välisen linkin katkaiseminen

Kun katkaiset tekstin ja sen tyylin välisen linkin, tekstin nykyinen muotoilu säilyy. Myöhemmin tyyliin tehtävät muutokset eivät kuitenkaan näy
tekstissä, joka on erotettu tyylistä.

1. Valitse teksti, johon merkityn tyylin linkin haluat katkaista.

2. Valitse Tyylit-paneelivalikosta Katkaise linkki tyyliin.

Jos tekstiä ei ole valittu ja valitset Katkaise linkki tyyliin -toiminnon, ohjelma muotoilee seuraavaksi kirjoittamasi tekstin valitun tyylin mukaisesti,
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Alkuun

Huomautus:

Alkuun

mutta ei määritä sille tyyliä.

Tyylin luettelomerkkien ja numeroinnin muuntaminen tekstiksi

Voit luoda tyylin, joka lisää kappaleisiin luettelomerkkejä tai numeroinnin. Luettelomerkit ja numerot eivät ehkä säily, jos teksti kopioidaan tai
viedään toiseen sovellukseen. Vältät tämän ongelman muuntamalla tyylin luettelomerkit tai numeroinnin tekstiksi.

jos muunnat InDesign-sivuasetteluun linkitetyn InCopy-jutun tyyliin kuuluvat luettelomerkit, muutos ehkä ohitetaan, kun sisältö
päivitetään InDesignissa.

1. Valitse Kappaletyylit-paneelista tyyli, joka sisältää luettelomerkit ja numeroinnin.

2. Valitse Kappaletyylit-paneelivalikosta Muunna "[tyyli]" luettelomerkit ja numerointi tekstiksi.

Jos muunnat luettelomerkit ja numeroinnin tekstiksi tyylissä, johon jokin toinen tyyli perustuu (ylätyylissä), myös alityylin luettelomerkit ja numerointi
muunnetaan tekstiksi.

Kun olet muuntanut numeroinnin tekstiksi, numerot on ehkä päivitettävä manuaalisesti tekstin muokkaamisen jälkeen.

Merkki- ja kappaletyylien etsiminen ja korvaaminen

Käytä Etsi/Muuta-valintaikkunaa, kun haluat löytää tietyn tyylin esiintymät ja korvata ne toisella.

1. Valitse Muokkaa > Etsi/Muuta.

2. Valitse Etsi-kohdassa Julkaisu, jos haluat vaihtaa tyylin koko julkaisussa.

3. Jätä Etsittävä- ja Korvaava-asetukset tyhjiksi. Jos Etsi muotoilu- tai Muuta muotoilu -kentät eivät näy valintaikkunan alaosassa, napsauta
Lisää asetuksia -vaihtoehtoa.

4. Avaa Etsi muotoiluasetukset -valintaikkuna napsauttamalla Etsi muotoilu -kenttää. Valitse Tyyliasetukset-kohdasta etsittävä merkki- tai
kappaletyyli ja napsauta sitten OK-painiketta.

5. Avaa Muuta muotoiluasetukset -valintaikkuna napsauttamalla Muuta muotoilu -kenttää. Valitse Tyyliasetukset-kohdasta korvaava merkki- tai
kappaletyyli ja napsauta sitten OK-painiketta.

6. Napsauta Etsi-painiketta ja korvaa tyyli napsauttamalla Vaihda-, Muuta/Etsi- tai Muuta kaikki -painiketta.

Lisää ohjeaiheita
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Anfangit ja sisäkkäistyylit

Alkuun

Alkuun

Merkkityylin käyttäminen anfangissa
Sisäkkäistyylien luominen
GREP-tyylien luominen

Voit käyttää Anfangit ja sisäkkäistyylit -toimintoa kolmeen ensisijaiseen tarkoitukseen: merkkityylien käyttämiseen anfangeissa, sisäkkäistyylin
käyttämiseen kappaleen alussa sekä sisäkkäisen rivityylin käyttämiseen vähintään yhdessä kappaleen rivissä.

Merkkityylin käyttäminen anfangissa
Voit käyttää merkkityyliä kappaleen anfangissa. Jos esimerkiksi haluat anfangin värin tai kirjasimen eroavan muusta kappaleesta, voit määrittää
merkkityylin näiden määritteiden mukaan. Sen jälkeen voit käyttää merkkityyliä kappaleessa tai sisäkkäistää merkkityylin kappaletyyliin.

Sisäkkäisellä merkkityylillä automaattisesti muotoiltu anfangi

1. Luo merkkityyli, jossa on anfangissa käytettävä muotoilu.
2. Tee jokin seuraavista:

Jos haluat lisätä anfangin yhteen kappaleeseen, valitse Kappale-paneelivalikosta Anfangit ja sisäkkäistyylit.

Sisäkkäistä merkkityyli kappaletyyliin kaksoisnapsauttamalla kappaletyyliä ja valitsemalla Anfangit ja sisäkkäistyylit.

3. Määritä anfangin rivien ja merkkien määrä ja valitse merkkityyli.
4. Jos anfangi sijoittuu liian kauas vasemmasta reunasta, valitse Tasaa vasen reuna.

Tämä asetus käyttää anfangimerkin alkuperäistä vasenta sivualuetta suuremman arvon sijasta. Siitä on hyötyä varsinkin päätteellisellä
kirjasimella muotoilluissa anfangeissa.

5. Jos anfangi osuu päällekkäin alapuolellaan olevan tekstin kanssa, valitse Alapidennyksen skaalaus.
6. Valitse OK.

Jos haluat käyttää erilaista sisäkkäistyyliä muissa merkeissä anfangin jälkeen, valitse Uusi sisäkkäistyyli -asetus. (Lisätietoja: Sisäkkäistyylien
luominen.)

Sisäkkäistyylien luominen
Voit määrittää kappalemuotoilun yhdelle tai usealle kappaleessa tai rivillä olevalle tekstialueelle. Voit myös määrittää useita yhdessä toimivia
sisäkkäistyylejä, jolloin toinen tyyli alkaa siitä, mihin edellinen loppuu. Jos kappaleiden muotoilu on toistuva ja ennustettava, voit jopa muodostaa
silmukan takaisin sarjan ensimmäiseen tyyliin.

Sisäkkäistyylit sopivat erityisesti jatkuviin otsikoihin. Voit esimerkiksi käyttää yhtä merkkityyliä kappaleen ensimmäisessä kirjaimessa ja jotain toista
tyyliä ensimmäisen kaksoispisteen (:) jälkeen. Voit määrittää kullekin sisäkkäistyylille merkin, johon tyyli päättyy, esimerkiksi sarkainmerkin tai
sanan lopun.
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Tässä esimerkissä Numero-merkkityyli muotoilee ensimmäisen sanan ja Jatkuva-merkkityyli kaiken tekstin ensimmäisen kaksoispisteen jälkeen.

Michael Murphy on kirjoittanut jutun sisäkkäisistä tyyleistä. Se on osoitteessa InDesignin sisäkkäisten tyylien automaattinen muotoilu useille
kappaleille. Hän on tehnyt myös sarjan video-opetusohjelmia, joka alkaa aiheella Sisäkkäiset tyyliarkit.

Yhden tai usean sisäkkäistyylin luominen
1. Voit luoda yhden tai useita merkkityylejä tekstin muotoilua varten.
2. Tee jokin seuraavista:

Jos lisäät sisäkkäistyylejä kappaletyyliin, kaksoisnapsauta kappaletyyliä ja valitse sitten Anfangit ja sisäkkäistyylit.

Jos lisäät sisäkkäistyylejä yhteen kappaleeseen, valitse Kappale-paneelivalikosta Anfangit ja sisäkkäistyylit.

Huomautus: Saat parhaan tuloksen, kun käytät sisäkkäistyylejä kappaletyylien osana. Jos käytät sisäkkäistyylejä kappaleessa
paikallisina ohituksina, myöhemmät sisäkkäisen tyylin muutokset tai muotoilut voivat aiheuttaa tekstiin odottamattomia merkkimuotoiluja.

3. Napsauta Uusi sisäkkäistyyli -painiketta kerran tai useita kertoja.
4. Tee jokin seuraavista toimista ja napsauta sitten OK-painiketta:

Määritä kappaleen osan ulkoasu valitsemalla merkkityylin alue ja sitten merkkityyli. Jos et ole vielä luonut merkkityyliä, valitse Uusi
merkkityyli ja määritä muotoilu, jota haluat käyttää.

Määritä kohde, joka lopettaa merkkityylin muotoilun. Voit myös kirjoittaa merkin, esimerkiksi kaksoispisteen (:) tai tietyn kirjaimen tai
numeron. Et voi kuitenkaan kirjoittaa sanaa.

Määritä, kuinka monta valitun kohteen (esimerkiksi merkin, sanan tai lauseen) esiintymää vaaditaan.

Valitse (–) tai Loppuarvo. Jos valitset (–), sisäkkäistyylin lopettava merkki sisällytetään. Jos valitset Loppuarvo, vain ennen tätä merkkiä
olevat merkit muotoillaan.

Valitse tyyli ja muuta tyylien järjestystä luettelossa napsauttamalla ylänuolipainiketta  tai alanuolipainiketta . Tyylien järjestys määrää
muotoilujärjestyksen. Toisen tyylin mukainen muotoilu alkaa, kun ensimmäisen tyylin muotoilu loppuu. Jos käytät merkkityyliä anfangissa,
anfangin merkkityyli toimii kuten ensimmäinen sisäkkäistyyli.
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Sisäkkäisten rivityylien luominen
Voit käyttää kappaletyyliä tiettyyn määrään kappaleen rivejä. Samoin kuin sisäkkäistyyleissä, voit määrittää yhden tai usean sisäkkäisen rivityylin
toimimaan yhdessä ja voit luoda toistuvan jakson.

Sisäkkäisten rivityylien käyttämät määritteet voivat olla käytössä samanaikaisesti sisäkkäistyylien määritteiden kanssa. Esimerkiksi sisäkkäinen
rivityyli voi määrittää värin, kun sisäkkäistyyli määrittää tekstin kursivoinnin. Jos samalle määritteelle on määritetty kummassakin tyylissä
ristiriitainen asetus (esimerkiksi toisessa sininen ja toisessa punainen väri), noudatetaan ensisijaisesti sisäkkäistyylin asetusta.

1. Voit luoda yhden tai useita merkkityylejä tekstin muotoilua varten.
2. Tee jokin seuraavista:

Jos lisäät sisäkkäisiä rivityylejä kappaletyyliin, kaksoisnapsauta kappaletyyliä ja valitse sitten Anfangit ja sisäkkäistyylit.

Jos lisäät sisäkkäisiä rivityylejä yhteen kappaleeseen, valitse Kappale-paneelivalikosta Anfangit ja sisäkkäistyylit.

3. Napsauta Uusi sisäkkäinen rivityyli -painiketta kerran tai useita kertoja.
4. Määritä osan ulkoasu valitsemalla merkkityylin alue ja sitten merkkityyli. Jos et ole vielä luonut merkkityyliä, valitse Uusi merkkityyli ja

määritä muotoilu, jota haluat käyttää.
5. Määritä, kuinka monessa kappaleen rivissä merkkityyliä käytetään.

Valitse tyyli ja muuta tyylien järjestystä luettelossa napsauttamalla ylänuolipainiketta  tai alanuolipainiketta . Järjestys määrää
muotoilujärjestyksen.

6. Napsauta OK-painiketta.

Sisäkkäistyylien silmukat
Voit toistaa kahden tai useamman sisäkkäistyylin sarjan kappaleessa. Yksinkertainen esimerkki on muuttaa kappaleen sanat vuorotellen punaisiksi
ja vihreiksi. Voit myös määrittää kappaleeseen vuorotellen vihreitä ja punaisia rivejä sisäkkäisten rivityylien avulla. Toistuvuus säilyy, vaikka
kappaleeseen lisätään sanoja tai siitä poistetaan sanoja.

1. Luo tarvittavat merkkityylit.
2. Luo kappaletyyli tai muokkaa sitä tai sijoita kohdistin muotoiltavaan kappaleeseen.
3. Napsauta Anfangit ja sisäkkäistyylit -kohdan tai -valintaikkunan Uusi sisäkkäistyyli (tai Uusi sisäkkäinen rivityyli) -painiketta vähintään kaksi

kertaa ja valitse kunkin tyylin asetukset.
4. Tee jompikumpi seuraavista:

Sisäkkäistyylit: napsauta uudelleen Uusi sisäkkäistyyli -painiketta, valitse merkkityylialueelta [Toista] ja määritä, kuinka monta
sisäkkäistyyliä toistetaan.

Sisäkkäiset rivityylit: napsauta uudelleen Uusi sisäkkäinen rivityyli -painiketta, valitse merkkityylialueelta [Toista] ja määritä, kuinka monta
rivityyliä toistetaan.

Eräissä tapauksissa pitää ohittaa yksi tai useita ensimmäisistä tyyleistä. Esimerkiksi tapahtumakalenterissa voisi olla otsikko "Tämän viikon
tapahtumat" ja sitten viikonpäivät ja niiden tapahtumat. Tässä tilanteessa voitaisiin luoda viisi sisäkkäistyyliä: yksi otsikkoa, yksi päivää, yksi
tapahtumaa ja yksi tapahtuma-aikaa varten sekä lopetustyyli, jossa on [Toista]-arvona 3. Näin ensimmäinen tyyli jää silmukan ulkopuolelle.

Valinnan [Toista] pitäisi olla luettelon viimeisenä. Kaikki valinnan [Toista] alla olevat sisäkkäistyylit ohitetaan.
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Sisäkkäistyylien toistaminen

5. Valitse OK.

Sisäkkäistyylin merkkityyliasetukset
Kun määrität sisäkkäisen merkkityylin päättymisen, voit valita jonkin seuraavista vaihtoehdoista:

Jos et halua merkin sisältyvän muotoiltuun sisäkkäistyyliin, valitse sisäkkäistyyliä määrittäessäsi (–)-asetuksen sijaan Loppuarvo-asetus.

Virkkeet Piste, kysymysmerkki tai huutomerkki osoittaa virkkeen lopun. Välimerkkejä seuraavat lainausmerkit sisältyvät virkkeeseen.
Sanat Mikä tahansa väli tai välilyöntimerkki osoittaa sanan lopun.
Merkit Merkki voi olla mikä tahansa merkki, paitsi merkki, jonka leveys on nolla. (Sitä käytetään esimerkiksi ankkureissa, hakemistoviittauksissa ja
XML-nimiöissä.)
Huomautus: Jos valitset Merkit, voit myös kirjoittaa merkin sisäkkäistyylin lopettamiseksi (esimerkiksi kaksoispiste tai piste). Jos kirjoitat useita
merkkejä, mikä tahansa kyseisistä merkeistä lopettaa tyylin. Jos esimerkiksi jatkuvat otsikot saattavat päättyä yhdysmerkkiin, kaksoispisteeseen tai
kysymysmerkkiin, voit kirjoittaa -:?, jotta sisäkkäistyyli päättyy mihin tahansa näistä merkeistä.
Kirjaimet Mikä tahansa merkki, joka ei ole välimerkki, välilyönti, numero eikä symboli.
Numerot Numero voi olla arabialainen numero 0–9.
Lopeta sisäkkäistyyli -merkki Ulottaa sisäkkäistyylin lisäämääsi sisäkkäistyylin lopetusmerkkiin saakka tai sen yli. Lisää merkki valitsemalla
Teksti > Lisää erikoismerkki > Muu > Lopeta sisäkkäistyyli tähän.
Sarkainmerkit Ulottaa sisäkkäistyylin sarkainmerkkiin ( ei sarkainasetukseen) saakka tai sen yli.
Pakotettu rivinvaihto Ulottaa sisäkkäistyylin pakotettuun rivivaihtoon saakka tai sen yli. (Valitse Teksti > Lisää vaihtomerkki > Pakotettu
rivinvaihto.)
Sisennä tähän -merkki Ulottaa sisäkkäistyylin Sisennä tähän -merkkiin saakka tai sen yli. (Valitse Teksti > Lisää erikoismerkki > Muu > Sisennä
tähän.)
Em-välit, en-välit tai sitovat välilyönnit Ulottaa sisäkkäistyylin välilyöntiin saakka tai sen yli. (Valitse Teksti > Lisää tyhjä tila > [välilyönti].)
Ankkuroidun objektin merkki Ulottaa sisäkkäistyylin tekstiin sijoitettuun grafiikan merkitsimeen saakka tai sen yli.
Automaattinen sivunumero tai Osion merkki Ulottaa sisäkkäistyylin sivunumeron tai osion nimen merkkiin saakka tai sen yli.

Sisäkkäistyylin lopettaminen
Useimmissa tapauksissa sisäkkäistyyli päättyy kohtaan, jossa määritetyn tyylin ehto täyttyy (kuten kolmen sanan jälkeen tai pisteen esiintyessä).
Voit kuitenkin lopettaa sisäkkäistyylin myös ennen ehdon täyttymistä käyttämällä Lopeta sisäkkäistyyli tähän -merkkiä.

1. Sijoita kohdistin paikkaan, johon haluat lopettaa sisäkkäistyylin.
2. Valitse Teksti > Lisää erikoismerkki > Muu > Lopeta sisäkkäistyyli tähän.

Merkki lopettaa sisäkkäistyylin tähän kohtaan sisäkkäistyylin määrityksestä riippumatta.

Sisäkkäistyylin muotoilun poistaminen
Valitse sisäkkäistyyli Anfangit ja sisäkkäistyylit -valintaikkunasta tai Kappaletyyliasetukset-valintaikkunan Anfangit ja sisäkkäistyylit -osasta ja
napsauta Poista-painiketta.

493



 

Alkuun

Käytä eri kappaletyyliä.

GREP-tyylien luominen
GREP on edistynyt kuvioihin perustuva hakutekniikka. Voit lisätä GREP-tyylien avulla merkkityylejä tekstiin, joka vastaa määrittämääsi GREP-
lauseketta. Oletetaan esimerkiksi, että haluat käyttää merkkityyliä kaikissa tekstin puhelinnumeroissa. Kun luot GREP-tyylin, voit valita merkkityylin
ja määrittää GREP-lausekkeen. Kaikki GREP-lauseketta vastaavat kappaleen tekstit muotoillaan käyttämällä merkkityyliä.

Puhelinnumeroiden muotoileminen merkkityyliä käyttämällä GREP-lausekkeen avulla
A. Merkkityyli B. GREP-lauseke

Voit katsella GREP-tyylien luontia käsittelevän videon osoitteessa www.adobe.com/go/lrvid4028_id_fi.

David Blatner on koonnut elävästä elämästä esimerkkejä GREP-tyyleistä. Ne löytyvät osoitteesta Viisi mahtavaa asiaa, jotka voit tehdä GREP-
tyyleillä. Cari Jansen on tehnyt neliosaisen sarjan GREP-tyyleistä. Sarja on osoitteessa Johdanto GREP-tyyleihin.

1. Tee jokin seuraavista:

Voit käyttää GREP-tyyliä yksittäisissä kappaleissa valitsemalla kappaleet ja valitsemalla sitten Kappale- tai Ohjauspaneelin valikosta
GREP-tyylit.

Voit käyttää GREP-tyylejä kappaletyylissä luomalla tai muokkaamalla kappaletyyliä ja valitsemalla GREP-tyylin käyttö -välilehden
Kappaletyyliasetukset-valintaikkunan vasemmasta reunasta.

2. Valitse Uusi GREP-tyyli.

3. Napsauta kohtaa Käytä tyyliä -valinnan oikealla puolella ja määritä merkkityyli. Jos et ole luonut käytettäväksi merkkityyliä, valitse Uusi
merkkityyli ja määritä haluamasi muotoilut.

4. Napsauta kohtaa Tekstiin-valinnan oikealla puolella ja muodosta GREP-lauseke tekemällä jompikumpi seuraavista:

Kirjoita lauseke manuaalisesti. (Lisätietoja: Etsiminen metamerkkien avulla.)

Jos tarvitset apua GREP-lausekkeen luomiseen, napsauta Tekstiin-kentän oikealla puolella olevaa Erikoismerkit Etsi-toiminnossa -
kuvaketta. Valitse haluamasi vaihtoehdot Sijainnit-, Toisto-, Sovita-, Muokkaajat- ja Posix-alivalikoista.

5. Valitse OK.

Lisää ohjeaiheita
GREP-tyylien video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Objektityylit

Alkuun

Alkuun

Tietoja objektityyleistä
Objektityylit-paneelin yleiskuvaus
Objektityylien määrittäminen
Objektityylien käyttäminen
Oletusobjektityylien käyttäminen
Objektityylin ohitusten poistaminen
Objektityylin linkin katkaiseminen
Objektityylin nimen vaihtaminen
Objektityylien muokkaaminen
Objektityylin poistaminen
Objektityylin uudelleen määrittäminen
Objektityylien tuominen

Tietoja objektityyleistä

Samaan tapaan kuin kappale- ja merkkityyleillä voi muotoilla nopeasti tekstiä, objektityyleillä voi muotoilla grafiikkaa ja kehyksiä. Objektityyleissä
on muun muassa viiva-, väri-, läpinäkyvyys-, heittovarjo-, kappaletyyli- ja tekstinkierrätysasetuksia. Voit lisätä objektiin, viivaan, täyttöön ja tekstiin
erilaisia läpinäkyvyystehosteita.

Voit käyttää objektityylejä objekteissa, ryhmissä ja kehyksissä (myös tekstikehyksissä). Tyyli voi poistaa ja korvata kaikki objektiasetukset tai
korvata vain tiettyjä asetuksia, jolloin muut asetukset pysyvät ennallaan. Voit päättää, mihin asetuksiin tyyli vaikuttaa, joko sisällyttämällä
määritykseen asetusluokan tai jättämällä sen määrityksestä pois.

Kehysruudukoissa voi käyttää myös objektityylejä. Oletusarvoisesti kaikissa luoduissa kehysruudukoissa käytetään [Perusruudukko]-objektityyliä.
Voit muokata [Perusruudukko]-tyyliä tai käyttää ruudukossa muita objektityylejä. Kun luot objektityylin kehysruudukkoa varten tai muokkaat sitä,
määritä kirjoitussuunta, kehyksen tyyppi ja nimetty ruudukko Jutun asetukset -osassa.

Saatat tyylejä luodessasi havaita, että useilla eri tyyleillä on joitakin yhteisiä ominaisuuksia. Sinun ei tarvitse erikseen määrittää näitä ominaisuuksia
aina, kun määrität seuraavan tyylin, vaan voit luoda objektityylin toisen tyylin pohjalta. Kun muutat perustyyliä, kaikki ylätyylissä esiintyvät yhteiset
määritteet muuttuvat myös alityylissä.

Objektityylit-paneelin yleiskuvaus

Objektityylit-paneelin avulla luodaan, nimetään ja käytetään objektityylejä. Kun julkaisu luodaan, paneelissa näkyy aluksi objektityylien oletusjoukko.
Objektityylit tallentuvat julkaisun mukana ja näkyvät paneelissa aina, kun kyseinen julkaisu avataan. Tekstikehys-kuvake   ilmaisee tekstikehysten
oletustyylin ja Grafiikkakehys-kuvake  grafiikkakehysten ja piirrettyjen kuvioiden oletustyylin.

Objektityylit-paneelin avulla luodaan, muokataan ja käytetään objektityylejä. Kun julkaisu luodaan, paneelissa näkyy aluksi objektityylien
oletusjoukko. Objektityylit tallentuvat julkaisun mukana ja näkyvät paneelissa aina, kun kyseinen julkaisu avataan. Tekstikehysten oletustyyli on
merkitty Tekstikehys-kuvakkeella ; grafiikkakehysten oletustyyli on merkitty Grafiikkakehys-kuvakkeella ; kehysruudukoiden oletustyyli on
merkitty Ruudukko-kuvakkeella .

Objektityylit-paneelin avaaminen

Valitse Ikkuna > Tyylit > Objektin tyylit.
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Huomautus:

Objektityylien luetteloinnin muuttaminen paneelissa

Valitse paneelivalikosta Pienet paneelin rivit, jos haluat nähdä objektityylien tiivistetyn luettelon.
Vedä objektityyli toiseen paikkaan. Kun haluttuun kohtaan tulee musta viiva, vapauta hiiren painike.
Valitse paneelivalikosta Lajittele nimen mukaan, jos haluat nähdä objektityylit aakkosjärjestyksessä.

Objektityylien määrittäminen

Voit määrittää tyylin, joka perustuu objektissa jo käyttämiisi asetuksiin, tai luoda tyylin alusta lähtien.

1. Valitse objekti tai tekstikehys, joka käyttää objektityylissä tarvitsemiasi asetuksia.

2. Valitse Objektityylit-paneelivalikosta Uusi objektityyli tai Alt-napsauta (Windows) tai Optio-osoita (Mac OS) Luo uusi tyyli -painiketta.

3. Kirjoita tyylin nimi Uusi objektityyli -valintaikkunaan.

4. Jos haluat tyylin perustuvan toiseen tyyliin, valitse kyseinen tyyli Perustuu-kohdasta.

Perustuu-asetus antaa mahdollisuuden ketjuttaa tyylejä, jotta yhden tyylin muutokset siirtyvät muihin kyseiseen tyyliin
perustuviin tyyleihin. Jos teet muutoksia alityylin muotoiluun ja haluatkin aloittaa alusta, napsauta Palauta perusta -painiketta. Tämä palauttaa
alityylin muotoilun identtiseksi sen perustana olleen tyylin kanssa.

5. Jos haluat lisätä pikanäppäimen, sijoita kohdistin Pikanäppäin-ruutuun ja varmista, että Num Lock on käytössä. Pidä haluamaasi vaihto- Alt-
ja Ctrl-näppäinten (Windows) tai optio-, vaihto- ja komentonäppäinten (Mac OS) yhdistelmää painettuna ja paina numeronäppäimistön
numeronäppäintä. Tyylien pikanäppäimiksi voidaan määrittää vain numeronäppäimistön numeronäppäimiä (ei kirjaimia tai muita
numeronäppäimiä).

6. Valitse Perusmääritteet-kohdasta muut luokat, joiden sisältämiä asetuksia haluat muuttaa, ja määritä haluamasi asetukset. Määritä kunkin
luokan vasemmalla puolella olevaa valintaruutua napsauttamalla, sisällytetäänkö luokka tyyliin vai ohitetaanko se.

Määritä ruudukon objektityypin kirjoitussuunta, kehyksen tyyppi ja nimetty ruudukko Jutun asetukset -luokan avulla. Nimettyyn ruudukkoon
on tallennettu kehysruudukon asetukset, joita voidaan käyttää missä tahansa kehysruudukossa.

7. Lisää tehosteita valitsemalla asetus kohdasta Tehosteet: (Objekti, Viiva, Täyttö tai Teksti), valitsemalla tehosteluokat ja määrittämällä niiden
asetukset Voit määrittää erilaiset tehosteet kutakin luokkaa varten. Valitse, mitkä tehosteluokat otetaan käyttöön, poistetaan käytöstä tai
ohitetaan tyylissä.

8. Valitse Vientiasetukset-kohdassa haluttu asetus ja määritä sitten asetukseen liittyvät vientiparametrit. Voit määrittää kuvien ja grafiikan
vaihtoehtoisen tekstin. Voit käyttää nimiöidyissä PDF-tiedostoissa nimiöitä ja todellisia tekstiasetuksia. Voit luoda HTML- ja EPUB-
sivuasetteluissa kullekin objektille erilaisia muunnosasetuksia, jotta ne voidaan muodostaa hyvin näyttökokoon ja pikselitiheyteen katsomatta.
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Alkuun
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Vientiasetukset

Objektin vientiasetusten avulla määritetään vientiparametrit eri muodoissa tapahtuvaa vientiä varten, esimerkiksi EPUB- ja
HTML-muotoa tai helppokäyttöisiä PDF-tiedostoja käytettäessä. Objektin vientiasetuksia sovelletaan tekstikehyksiin, grafiikkakehyksiin ja
ryhmiin. Katso Objektin vientiasetukset.

9. Napsauta OK-painiketta.

Objektityyliluokat

Jos haluat tyyliä käytettävän vain tietyissä määritteissä muiden asetusten jäädessä ennalleen, varmista, että luokat, joita tyylin pitää hallita, ovat
oikeassa tilassa. Kullakin luokalla voi olla kolme tilaa: käytössä, ei käytössä tai ohitettu. Jos esimerkiksi Heittovarjo-valintaruutu valitaan,
heittovarjon muotoilu sisältyy objektityyliin. Kun Heittovarjo-valintaruudun valinta poistetaan, heittovarjo ei ole käytössä tyylin osana – objektiin
lisätty heittovarjo näkyy ohituksena. Kun Heittovarjo-valintaruutu on "ohita"-tilassa (Windowsissa näkyy pieni neliö ja Mac OS:ssä viiva), heittovarjo
jää pois tyylistä. Tyyliin lisätty heittovarjo ei siis näy ohituksena.

Objektityyliluokat

A. Käytössä B. Ohitettu C. Ei käytössä 

Luokissa, joissa asetuksia voidaan ottaa käyttöön tai poistaa käytöstä yksitellen, esimerkiksi Täyttö, Viiva ja Läpinäkyvyys, on vain
kaksi tilaa. Ne voivat olla joko käytössä tai ohitettuja.

Kappaletyylit-luokka on normaalisti poistettu käytöstä, vaikka luotaisiin tekstikehystä. Tämä luokka on käytettävissä vain, jos objekti on
ketjuttamaton tekstikehys.

Objektityylien käyttäminen

Jos käytät objektityyliä objektijoukolle, objektityyliä käytetään kaikissa ryhmän objekteissa. Kun haluat käyttää objektityyliä objektijoukolle, laita
objektit sisäkkäin kehykseen. (Voit liittää objektin kehykseen esimerkiksi komennolla Muokkaa > Liitä kohteeseen).

1. Valitse objekti, kehys tai ryhmä.

2. Lisää tyyli napsauttamalla Ohjauspaneelissa tai Objektityylit-paneelissa näkyvää objektityyliä.

Jos valitset Objektityylit-paneelista Poista ohitukset tyyliä käytettäessä, objektityylin napsauttaminen merkitsee oletuksen mukaan ohitusten
poistamista. Jos tätä asetusta ei ole valittu, voit poistaa ohitukset tyyliä lisätessäsi Alt-napsauttamalla (Windows) tai optio-osoittamalla (Mac OS)
objektityyliä.

Voit myös vetää objektityylin objektiin, kun haluat käyttää tyyliä valitsematta objektia ensin.

Jos ryhmä on valittu ja valitaan tyyli, tyyliä käytetään ryhmän jokaisessa objektissa.

Kun olet valinnut tyylin, voit käyttää objektissa tarpeen mukaan muita asetuksia. Vaikka tyylissä määritetty asetus ohitettaisiin, yhteys tyyliin ei
katkea.

Oletusobjektityylien käyttäminen
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Objektityylit-paneelissa näkyy jokaisen uuden julkaisun objektityylien oletusjoukko. Aina kun luot objektin, siihen liitetään objektityyli. Jos luot
tekstikehyksen, siinä käytetään [Perustekstikehys]-objektityyliä. Jos piirrät reitin tai kuvion, siinä käytetään [Perusgrafiikkakehys]-objektityyliä. Jos
sijoitat kuvan tai piirrät X-merkin sisältävän paikkamerkkikuvion, siinä käytetään [Ei mitään]-objektityyliä. Voit valita tekstikehyksille ja
grafiikkakehyksille eri oletusobjektityylit.

Objektityylit-paneelissa näkyy jokaisen uuden julkaisun objektityylien oletusjoukko. Aina kun luot objektin, siihen liitetään objektityyli. Jos luot
tekstikehyksen, siinä käytetään [Perustekstikehys]-objektityyliä. Jos sijoitat kuvan tai piirrät reitin tai kuvion, siinä käytetään [Perusgrafiikkakehys]-
objektityyliä. Jos luot kehysruudukon, siinä käytetään [Perusruudukko]-objektityyliä. Jos piirrät X-merkin sisältävän paikkamerkkikuvion, siinä
käytetään [Ei mitään] -objektityyliä. Voit valita kullekin objektityypille eri oletusarvoisen objektityylin.

Jos haluat vaihtaa tekstikehyksen oletustyylin, valitse ensin Objektityylit-paneelivalikosta Tekstikehyksen oletustyyli ja sitten objektityyli.
Jos haluat vaihtaa grafiikkakehyksen oletustyylin, valitse ensin Objektityylit-paneelivalikosta Grafiikkakehyksen oletustyyli ja sitten objektityyli.
Graafisten paikkamerkkikehysten (joiden nimessä on X) oletustyylinä on aina [Ei mitään]. Objektityyliä ei voi määrittää oletukseksi.
Jos haluat vaihtaa kehysruudukon oletustyylin, valitse ensin Objektityylit-paneelivalikosta Ruudukon oletustyyli ja sitten objektityyli.
Voit vaihtaa minkä tahansa objektityypin oletustyylin vetämällä oletusobjektityypin ilmaisevan kuvakkeen objektityylistä toiseen.

Jos valitset objektityylin eikä mitään kehystä ei ole valittu, objektityylistä tulee joko tekstin tai grafiikan oletusobjektityyli sen
perusteella, mikä työkalu on valittu työkalupaneelista.

Jos valitset objektityylin eikä mitään kehystä ei ole valittu, objektityylistä tulee joko tekstin, grafiikan tai ruudukkokehysten
oletusobjektityyli sen perusteella, mikä työkalu on valittu työkalupaneelista.

[Perus]-tyylejä voi muokata mutta ei poistaa.

Objektityylin ohitusten poistaminen

Ohitus syntyy, kun objektissa käytetään muotoilua, joka poikkeaa objektissa käytettävän tyylin määrityksestä. Kun valitset ohitukisen sisältävän
objektin, tyylin nimen vieressä on plusmerkki (+).

Poista ohitukset -komennolla voit ohittaa minkä tahansa muotoilun, joka on käytössä tai poistettu käytöstä objektityylissä. Voit poistaa ohitetut
määritteet Poista määritteet, jotka eivät ole tyylin määrittämiä -toiminnolla.

Objektityylin ohitusten poistaminen

1. Valitse objekti tai ryhmä, jota haluat muuttaa.

2. Napsauta Objektityylit-paneelin alareunassa olevaa Poista ohitukset -painiketta .

Ohitus näkyy vain, jos käytetty määrite on osa tyyliä.

Objektityylissä ohitettujen määritteiden poistaminen

Haluat ehkä poistaa määritteet objektista, vaikka kyseiset määritteet ohitetaan tyylissä. Jos esimerkiksi Täyttö-luokka on ohitettu objektityylissä ja
lisäät punaisen täytön kehykseen, jossa objektityyliä käytetään, Poista määritteet, jotka eivät ole tyylin määrittämiä -asetuksen valitseminen poistaa
punaisen täytön.

jos objektityyliluokka on poistettu käytöstä (valitsematta) eikä ohitettu, voit syrjäyttää sen Poista ohitukset -komennolla.

1. Valitse objekti tai ryhmä, jota haluat muuttaa.

2. Napsauta Objektityylit-paneelin alareunassa olevaa Poista määritteet, jotka eivät ole tyylin määrittämiä -painiketta .

Objektityylin linkin katkaiseminen
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Voit katkaista objektin ja siinä käytettävän tyylin välisen linkin. Objekti säilyttää samat määritteet mutta ei enää muutu tyylin muuttuessa.

1. Valitse objekti, jossa käytetään objektityyliä.

2. Valitse Objektityylit-paneelivalikosta Katkaise linkki tyyliin.

Jos et halua säilyttää objektityylin muotoilua, valitse Objektityylit-paneelista [Ei mitään].

Objektityylin nimen vaihtaminen

1. Varmista, ettei mitään objektia ole valittu. Muuten ohjelma lisää tyylin objektiin.

2. Kaksoisnapsauta Objektityylit-paneelissa objektityyliä, jonka nimen haluat vaihtaa.

3. Kirjoita Objektityylit-valintaikkunaan tyylin uusi nimi ja napsauta OK-painiketta.

Voit myös muokata objektityyliä suoraan paneelissa. Napsauta tyyliä, odota hetki ja napsauta sitten uudelleen, jotta voit muokata tyylin nimeä.

Objektityylien muokkaaminen

1. Tee jokin seuraavista:

Jos et halua käyttää tyyliä valitussa kehyksessä tai asettaa sitä oletukseksi, napsauta hiiren kakkospainikkeella (Windows) tai Ctrl-osoita
(Mac OS) Objektityylit-paneelissa näkyvää tyylin nimeä ja valitse Muokkaa [tyylin nimi].

Kaksoisnapsauta tyylin nimeä Objektityylit-paneelissa tai valitse ensin tyyli ja sitten tyylipaneelin valikosta Tyyliasetukset. Huomaa, että
näin tyyliä käytetään missä tahansa valitussa objektissa tai se määritetään oletusobjektityypiksi.

2. Valitse Objektityyliasetukset-valintaikkunasta luokka, jonka sisältämiä asetuksia aiot muuttaa, ja tee asetuksiin haluamasi muutokset.

3. Selvitä, ovatko objektityyliluokat käytössä, pois käytöstä vai ohitettu.

4. Valitse OK.

Objektityylin poistaminen

1. Valitse objektityyli Objektityylit-paneelista.

2. Valitse paneelivalikosta Poista tyyli tai vedä tyyli Objektityylit-paneelin alareunassa olevaan Poista-kuvakkeeseen.

3. Jos poistat tyylin, jota käytetään objekteissa tai johon perustuu muita tyylejä, ohjelma kehottaa valitsemaan korvaavan tyylin Poista objektin
tyyli -valikosta. Tee jokin seuraavista:

Jos haluat määrittää uuden tyylin objekteille, jotka käyttävät poistettua tyyliä, valitse haluamasi tyyli ja napsauta OK-painiketta.

Jos et halua muuttaa objekteja, valitse [Ei mitään] ja varmista, että Säilytä muotoilu -asetus on valittu. Napsauta OK-painiketta. Objektit,
jotka käyttävät poistettua tyyliä, säilyttävät samat määritteet mutta eivät enää ole yhteydessä tyyliin.

Jos haluat poistaa kaikki käyttämäsi määriteasetukset, valitse [Ei mitään], poista Säilytä muotoilu -asetuksen valinta ja napsauta OK-
painiketta.

Jos haluat poistaa kaikki tyylit, joita ei käytetä objekteissa, valitse Objektityylit-paneelivalikosta Valitse kaikki käyttämättömät ja
napsauta sitten Poista-kuvaketta.

Objektityylin uudelleen määrittäminen

Kun olet käyttänyt objektityyliä, voit ohittaa minkä tahansa sen asetuksista. Jos pidät tiettyyn objektiin tekemistäsi muutoksista, voit määrittää tyylin
uudelleen niin, että se vastaa muutetun objektin muotoilua. Huomaa, että Määritä objektityyli uudelleen -komento vaikuttaa vain käytössä oleviin ja
käytöstä poistettuihin luokkiin. Se ei vaikuta ohitettuihin luokkiin. Jos objekti sisältää lisäasetuksia, kyseiset asetukset on lisättävä tyyliin erikseen.
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.
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Huomautus:

Alkuun

Käytä tuotavan tyylin määritystä

Nimeä uudelleen automaattisesti

Voit myös luoda uuden objektityylin.

1. Valitse objekti, joka käyttää muutettavaa tyyliä.

2. Säädä haluamiasi ulkoasumääritteitä.

3. Valitse Objektityylit-paneelivalikosta Määritä tyyli uudelleen.

Objektityylin määritys muuttuu vastaamaan käyttämiäsi ohitusasetuksia. Kaikki objektityylin esiintymät julkaisussa päivittyvät uusien asetusten
mukaisiksi.

Jos Määritä objektityyli uudelleen -asetus ei ole käytettävissä, asettamasi määritteet eivät ole osa objektityylin määritystä. Jos haluat
muuttaa tyylin määritystä suoraan, valitse Objektityyliasetukset tai luo objektista uusi tyyli.

Objektityylien tuominen

Voit tuoda tyylejä toisista julkaisuista. InDesign tuo objektityylien lisäksi tyyleissä käytetyt värimallit, mukautetut viivat, merkkityylit ja kappaletyylit.
Jos tuodulla värimallilla, viivalla tai kappaletyylillä on sama nimi mutta eri arvot kuin olemassa olevalla värimallilla tai tyylillä, InDesign vaihtaa sen
nimen.

Jos tuotavat objektityylit sisältävät nimettyjä ruudukoita, myös nämä ruudukot tuodaan.

1. Valitse Objektityylit-paneelivalikosta Lataa objektityylit.

2. Valitse tiedosto, josta haluat tuoda objektityylit, ja napsauta Avaa-painiketta.

3. Varmista Lataa tyylit -valintaikkunasta, että haluamiesi tyylien vieressä on valintamerkki. Jos tyylien nimissä ilmenee ristiriitoja, valitse jokin
seuraavista Ristiriita nykyisen tyylin kanssa -asetuksista ja napsauta sitten OK-painiketta.

Korvaa nykyisen tyylin ladatulla tyylillä ja käyttää uusia määritteitä kaikissa nykyisen julkaisun
objekteissa, joissa aikaisemmin käytettiin vanhaa tyyliä. Voit vertailla tyylejä keskenään, sillä tuotavien ja nykyisten tyylien määritykset
näkyvät Lataa tyylit -valintaikkunan alareunassa.

Nimeää ladatun tyylin uudelleen.

Objektityylit näkyvät Objektityylit-paneelissa.

Lisää ohjeaiheita
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Tyylien käyttäminen

Alkuun

Alkuun

Alkuun

Tyylien tai tyyliryhmien monistaminen
Tyylien ryhmittäminen
Tyylien siirtäminen ja järjestäminen

Tyylien tai tyyliryhmien monistaminen
 Napsauta hiiren kakkospainikkeella (Windows) tai Control-osoita (Mac OS) tyylipaneelissa näkyvää tyyliä tai tyyliryhmää ja valitse Monista tyyli.

Tyylipaneeliin tulee uusi tyyli tai ryhmä, jolla on sama nimi "kopio"-liitteellä täydennettynä. Jos monistit tyyliryhmän, uuden ryhmän tyylien nimet
pysyvät ennallaan.

Voit monistaa tyylejä myös kopioimalla ne toiseen ryhmään.

Tyylien ryhmittäminen
Voit järjestää tyylejä ryhmittämällä ne eri kansioihin Merkkityylit-, Kappaletyylit-, Objektityylit-, Taulukkotyylit- ja Solutyylit-paneeleissa. Tasoryhmiä
voi olla sisäkkäin. Tyylit ei tarvitse kuulua ryhmään; voit lisätä niitä ryhmään tai paneelin ylimmälle tasolle.

Tyyliryhmän luominen
1. Tee tyylipaneelissa yksi seuraavista:

Jos haluat luoda ryhmän ylimmälle tasolle, poista kaikkien tyylien valinta.

Jos haluat luoda ryhmän sisälle ryhmän, valitse ja avaa ryhmä.

Jos haluat sisällyttää olemassa olevia tyylejä ryhmään, valitse ne.

2. Valitse tyylipaneelivalikosta Uusi tyyliryhmä tai valitse Uusi ryhmä tyyleistä, jotta valitut tyylit siirtyvät uuteen ryhmään.
3. Kirjoita ryhmän nimi ja napsauta OK-painiketta.
4. Jos haluat siirtää tyylin ryhmään, vedä se tyyliryhmän päälle. Kun tyyliryhmä näkyy korostettuna, vapauta hiiren painike.

Tyylien kopioiminen ryhmään
Kun kopioit tyylin toiseen ryhmään, tyylejä ei linkitetä. Vaikka tyyleillä on sama nimi, toisen tyylin muokkaaminen ei vaikuta toisen tyylin
määritteisiin.

1. Valitse kopioitava tyyli tai ryhmä.
2. Valitse tyylipaneelivalikosta Kopioi ryhmään.
3. Valitse ryhmä (tai [Juuri]-taso), johon haluat kopioida tyylin tai ryhmän, ja napsauta sitten OK-painiketta.

Jos ryhmässä on ennestään samannimisiä tyylejä kuin kopioitavat tyylit, tuotavat tyylit nimetään uudelleen.

Tyyliryhmien laajentaminen tai supistaminen
Voit laajentaa tai supistaa yhden ryhmän napsauttamalla sen vieressä olevaa kolmiokuvaketta.
Voit laajentaa tai supistaa ryhmän ja sen kaikki aliryhmät Ctrl-napsauttamalla (Windows) tai komento-osoittamalla (Mac OS) kolmiokuvaketta.

Tyyliryhmien poistaminen
Kun tyyliryhmä poistetaan, sen koko sisältö katoaa, mukaan lukien tyylit ja muut ryhmät.

1. Valitse poistettava ryhmä.
2. Valitse tyylipaneelivalikosta Poista tyyliryhmä ja napsauta sitten Kyllä-painiketta.
3. Määritä ryhmän jokaiselle tyylille korvaava tyyli tai valitse [Ei mitään] ja napsauta sitten OK-painiketta.

Jos haluat käyttää samaa korvaavaa tyyliä kaikissa tyyleissä, valitse Käytä kaikkiin.

Jos peruutat minkä tahansa tyylin korvaamisen, ryhmää ei poisteta. Voit palauttaa poistetut tyylit valitsemalla Muokkaa > Kumoa Poista tyylit.

Tyylien siirtäminen ja järjestäminen
Luomasi tyylit näkyvät normaalisti tyyliryhmän tai paneelin alareunassa.
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Jos haluat asettaa kaikki ryhmät ja niiden sisältämät tyylit aakkosjärjestykseen, valitse tyylipaneelivalikosta Lajittele nimen mukaan.
Voit siirtää yhtä tyyliä vetämällä sen uuteen paikkaan. Musta viiva osoittaa, mihin tyyli siirtyy; korostettu ryhmäkansio tarkoittaa sitä, että tyyli
lisätään kyseiseen ryhmään.

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Typografia

Julkaisun asentamat kirjasimet (video 2:29)
Michael Ninness  (1.1.2011)
Opastus - video
Opi käyttämään julkaisun asentamia kirjaimia InDesign CS5:llä ja sitä uudemmilla versioilla luoduissa sisällöissä.
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Kirjasinten käyttö

Alkuun

Alkuun

Alkuun

Tietoja kirjasimista
Adobe Typekit
Kirjasinten asentaminen
Kirjasimen käyttäminen tekstissä
Kirjasinkoon määrittäminen
Kirjasinten esikatseleminen
OpenType-kirjasimet
OpenType-kirjasinten määritteiden käyttäminen
Puuttuvien kirjasinten käyttäminen
Julkaisun asentamat kirjasimet
Multiple master -kirjasimet

Tietoja kirjasimista

Kirjasin on täydellinen merkkisarja, jonka jokaisella kirjaimella, numerolla ja symbolilla on sama paksuus, leveys ja tyyli. Esimerkki: lihavoitu, 10
pisteen Adobe Garamond.

Kirjasintyypit (eli kirjasinlaji- tai fonttiperheet), kuten Adobe Garamond, ovat kirjasinkokoelmia, joilla on samanlainen ulkoasu ja jotka on tarkoitettu
käytettäviksi yhdessä.

Tekstityyli on kirjasinperheen yhden kirjasimen muunnelma. Yleensä Roman tai Normaali (nimi vaihtelee kirjasinperheen mukaan) on niin sanottu
peruskirjasin, jolla voi olla useita eri tyylejä, kuten normaali, lihavoitu, puolilihavoitu ja lihavoitu kursivoitu.

Adobe Typekit

Kaikkiin InDesign-tilauksiin kuuluu Adobe Typekit Portfolio -tilaus, joka sisältää työpöydälle synkronoitavissa ja InDesignin sekä muiden
työpöytäsovellusten kanssa käytettävissä olevista kirjasimista muodostuvan kirjaston. Lisätietoja työpöytäkirjasimien synkronoinnista Typekitin
kanssa saat napsauttamalla tätä.

Kirjasinten asentaminen

Lisätietoja kaikissa sovelluksissa käytettävien kirjasinten asentamisesta ja käyttöönottamisesta saat järjestelmän tai kirjasinten hallinnan ohjeista.

InDesign mahdollistaa kirjasinten käyttöönoton kopioimalla kirjasintiedostot kiintolevyn InDesign-sovelluskansiossa olevaan Kirjasimet-kansioon.
Tämän Kirjasimet-kansion kirjasimet ovat kuitenkin käytettävissä vain InDesignissa.

Jos InDesign sisältää kaksi aktiivista kirjasinta, joilla on sama kirjasinperheen nimi, mutta eri Adobe PostScript -nimi, kirjasimet ovat käytettävissä
InDesignissa. Samannimiset kirjasimet näkyvät valikossa. Kirjasintekniikat näkyvät lyhennettynä suluissa. Esimerkiksi Helvetica TrueType näkyy
muodossa Helvetica (TT), Helvetica PostScript Type 1 muodossa Helvetica (T1) ja Helvetica OpenType muodossa Helvetica (OTF). Jos kahdella
kirjasimella on sama PostScript-nimi, käyttöön otetaan se kirjasin, jonka nimessä ei ole tunnusta .dfont.

Kirjasinten asennusohjeet

Opi asentamaan kirjasimia tietokoneeseen.
Ohjeita on saatavilla useimpiin Windows- ja
Mac OS -versioihin.... Lue lisää

http://adobe.ly/OSoIB3

tekijä: Adoben kirjasimet 
http://www.adobe.com/fi/ty...

Jaa asiantuntemustasi
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Alkuun

Alkuun

Huomautus:

Alkuun

Kirjasimen käyttäminen tekstissä

Kun määrität kirjasinta, voit valita erikseen kirjasinperheen ja -tyylin. Kun vaihdat kirjasimen toisen kirjasinperheen kirjasimeen, InDesign pyrkii
etsimään uudesta kirjasinperheestä nykyistä kirjasintyyliä vastaavan tyylin. Jos vaikkapa vaihdat kirjasimen Arialista Timesiin, Arial Bold vaihtuu
Times Boldiksi.

Kun muutat tekstin lihavoiduksi tai kursivoiduksi, InDesign käyttää kirjasimen mukaista kirjasintyyliä. Yleensä lihavointi tai kursivointi vastaa
odotuksia. Joissakin kirjasimissa voidaan kuitenkin käyttää lihavointia tai kursivointia, jolle on annettu jokin muu nimi. Joidenkin kirjasinten
suunnittelijat ovat määrittäneet, että lihavoinnissa tai kursivoinnissa käytetään kirjasimen puolilihavoitua versiota.

1. Valitse muutettava teksti.

2. Tee jokin seuraavista:

Valitse Merkki-välilehden Kirjasinperhe-valikosta haluamasi kirjasin tai Tekstityyli-valikosta haluamasi tyyli. (Mac OS -järjestelmässä
kirjasintyylit voidaan valita Kirjasinperhe-alivalikoista.)

Napsauta Merkki- tai Ohjaus-välilehdessä kirjasinperheen tai -tyylin nimen edessä olevaa aluetta tai kaksoisnapsauta nimen
ensimmäistä sanaa. Kirjoita sitten haluamasi nimen ensimmäiset merkit. Kirjoittaessasi InDesign etsii niiden kirjasinperheiden tai -tyylien
nimet, jotka vastaavat antamiasi merkkejä.

Valitse Teksti > Kirjasin -valikosta kirjasin. Huomaa, että kun täytät tätä valikkoa, valitset samalla sekä kirjasinperheen että -tyylin.

Kirjasinkoon määrittäminen

Oletusarvon mukaan kirjasinkoko ilmaistaan pisteinä (yksi piste on 1/72 tuumaa). Voit määrittää kirjasinkooksi 0,1–1 296 pistettä 0,001 pisteen
tarkkuudella.

Fireworksissa kirjasimen koko mitataan oletusarvoisesti pikseleissä.

1. Valitse muokattavat merkit tai tekstiobjektit. Jos et valitse tekstiä, uutta kirjasinkokoa käytetään myöhemmin lisäämässäsi tekstissä.

2. Tee jokin seuraavista:

Määritä Merkki-paneelin Kirjasinkoko-asetus.

Valitse Teksti > Koko -valikosta koko. Jos valitset vaihtoehdon Muu, voit määrittää Merkki-paneeliin uuden koon.

Voit vaihtaa tekstin mittayksikön Oletusarvot-valintaikkunassa. Vaihtoehto ei ole käytettävissä Fireworksissa.

Kirjasinten esikatseleminen

Voit katsella kirjasinmalleja käyttämällä kirjasinperhe- ja kirjasintyylivalikkoja, joita on Merkki-paneelissa ja muissa sen sovelluksen osissa, josta
valitset kirjasimet. Erilaiset kirjasimet on merkitty seuraavilla kuvakkeilla:

OpenType 

Tyyppi 1 

TrueType 

Adobe Community Help
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Alkuun

Alkuun

Multiple Master 

Yhdistelmä 

Voit poistaa esikatselun käytöstä tai muuttaa kirjasinten nimien pistekokoa tekstin oletusarvojen avulla.

OpenType-kirjasimet

OpenType-kirjasimet käyttävät samaa kirjasintiedostoa sekä Windows® ja Macintosh®-tietokoneissa, joten tiedostoja voi siirtää
käyttöjärjestelmästä toiseen tarvitsematta huolehtia kirjasinten muunnoksista ja muista tekstin rivittymisongelmista. Ne voivat sisältää
ominaisuuksia, kuten koristekirjaimia ja harkinnanvaraisia kirjainyhdistelmiä, joita nykyisissä PostScript- ja TrueType-kirjasimissa ei ole.

OpenType-kirjasimet näyttävät -kuvakkeen.

Käyttäessäsi OpenType-kirjasinta voit korvata tekstissä olevat vaihtoehtoiset kuviot, kuten ligatuurit, kapiteelit, murtoluvut ja vanhan tyylin numerot,
automaattisesti.

Normaali kirjasin (vasen) ja OpenType-kirjasin (oikea).

A. Järjestysluvut B. Harkinnanvaraiset kirjainyhdistelmät C. Koristekirjaimet 

OpenType-kirjasimiin voi sisältyä laajennettu merkistö ja asettelutoimintoja, joilla voidaan varmistaa hyvä kielellinen tuki ja tehokas typografinen
ohjaus. Adoben OpenType-kirjasimet, joissa on tuki keskieurooppalaisille kielille, sisältävät sanan "Pro" osana kirjasimen nimeä sovelluksen
kirjasinvalikoissa. OpenType-kirjasinten, jotka eivät tue keskieurooppalaisia kieliä, on merkitty tekstillä "Standard", ja niiden nimi päättyy tekstiin
"Std". Järjestelmään voi asentaa PostScript Type 1- ja TrueType-kirjasinten ohella myös kaikkia erilaisia OpenType-kirjasimia ja käyttää niitä
tulostamisessa.

Lisätietoja OpenType-kirjasimista on osoitteessa www.adobe.com/go/opentype_fi.

OpenType-kirjasinten määritteiden käyttäminen

Voit käyttää tekstissä OpenType-kirjasinmääritteitä, kuten murtolukuja ja koristekirjaimia, Merkki- tai Ohjauspaneelin kautta.

Lisätietoja OpenType-kirjasimista on osoitteessa www.adobe.com/go/opentype_fi.

OpenType-kirjasinten määritteiden käyttäminen

1. Varmista, että OpenType-kirjasin on valittuna Merkki- tai Ohjaus-välilehdessä.

2. Valitse Merkki-välilehden valikosta ensin OpenType ja sitten OpenType-määrite, kuten Harkinnanvaraiset ligatuurit tai Murtoluvut.

Ominaisuudet, joita käytössä oleva kirjasin ei tue, näkyvät hakasulkeissa. Esimerkki: [Koristekirjaimet].

Voit valita OpenType-kirjasinten ominaisuudet myös kappale- tai kirjasintyyliä määritettäessä. Määritteet valitaan Tyyliasetukset-valintaikkunan
OpenType-ominaisuudet-osasta.

OpenType-kirjasinmääritteet
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Huomautus:

Itse määritetyt ligatuurit

Murtoluvut

Järjestysluku

Erikoismerkki

Vaihtoehtoiset otsikkotyylit

Kontekstivaihtoehdot

Kaikki kapiteeleilla

Lävistetty nolla

Tyylijoukot

Sijaintimuodot

Yläindeksi/ylä ja alaindeksi/ala

Osoittaja ja nimittäjä

Taulukon viivat

Suhteutettu vanha tyyli

Suhteutetut viivat

Kun käytät OpenType-kirjasinta, voit valita tiettyjä OpenType-ominaisuuksia Ohjaus- tai Merkki-paneelin valikosta muotoillessasi tekstiä tai
määrittäessäsi tyylejä.

OpenType-kirjasintyylien määrä ja tyyppi vaihtelevat kirjasimen mukaan. Jos OpenType-ominaisuus ei ole käytettävissä, se näkyy
Ohjaus-välilehden valikossa hakasulkeissa (esimerkiksi [Koristekirjain]).

Kirjasinominaisuuksissa luotuja valinnaisia ligatuureja, jotka eivät ole oletuksena käytössä. Jos harkinnanvaraisia
ligatuureja on käytettävissä, tämän asetuksen valitseminen sallii niiden käyttämisen. Lisätietoja ligatuureista on kohdassa Ligatuurien käyttäminen
kirjainpareissa.

Jos murtoluvut ovat käytettävissä, ohjelma muuntaa vinoviivoilla erotetut numerot (kuten 1/2) murtolukumerkeiksi.

Jos englanninkieliset järjestysluvut (kuten 1st ja 2nd) ovat käytettävissä, ohjelma muotoilee ne yläindekseiksi (1 ja 2 ). Myös
espanjankielisissä järjestysluvuissa a ja o muotoillaan yläindekseiksi: segunda (2 ) ja segundo (2 ).

Jos tavallisia tai tilannekohtaisia koristekirjaimia on käytettävissä, niissä voi olla vaihtoehtoisia isoja kirjaimia ja erilaisia sanan
loppuja.

Jos otsikoissa käytettävät isokirjaimiset merkit ovat käytettävissä, ne otetaan käyttöön. Jos tekstissä on sekä isoja
että pieniä kirjaimia, voi asetuksen valitseminen johtaa epätoivottuun tulokseen joitakin kirjasimia käytettäessä.

Jos kontekstiligatuureja ja yhdistelyvaihtoehtoja on käytettävissä, ne otetaan käyttöön. Joissakin kirjoitusjärjestelmissä
kirjasimiin sisältyy vaihtoehtoisia merkkejä, joita käyttämällä kirjaimet liittyvät toisiinsa tyylikkäästi. Esimerkiksi kirjainpari "bl" sanassa "blini" voidaan
yhdistää niin, että se vaikuttaa enemmän käsialalta. Tämä on oletusasetus.

Jos kirjasimissa on aidot kapiteelit, tämän asetuksen valitseminen muuttaa kaikki merkit kapiteeleiksi. Lisätietoja on kohdassa
Tekstin kirjainkoon muuttaminen.

Kun asetus on valittu, numero 0 näkyy muodossa, jossa kehän halkaisee vino viiva. Tietyissä kirjasintyypeissä (etenkin
tiivistetyissä) voi olla vaikea erottaa toisistaan numero 0 ja iso kirjain O.

Joissakin OpenType-kirjasimissa on vaihtoehtoisia kuvioryhmiä. Tyylijoukko on ryhmä vaihtoehtoisia kuvioita, joita voidaan lisätä
merkeittäin tai useita samanaikaisesti tekstialueeseen. Jos valitset eri tyylijoukon, joukossa määritettyjä kuvioita käytetään kirjasimen
oletuskuvioiden sijaan. Jos tyylijoukon kuviomerkkiä käytetään toisen OpenType-asetuksen kanssa, yksittäisen asetuksen kuvio korvaa merkistön
kuvion. Voit tarkastella jokaisen tyylijoukon kuvioita Kuvio-välilehdessä.

Joissakin kursiivityyleissä ja arabian kaltaisissa kielissä merkin ulkoasu vaihtelee sen mukaan, missä kohtaa sanaa se on. Merkin
muoto voi muuttua sen ollessa sanan alussa, keskellä tai lopussa tai sen esiintyessä yksinään (erillään). Valitse merkki ja muotoile se oikein
valitsemalla Sijaintimuodot-asetus. Yleinen muoto -asetus lisää tavallisen merkin. Automaattinen muoto -asetus lisää merkin muodossa, joka
perustuu sen sijaintiin sanassa, tai muodossa, jossa se esiintyy erillään.

Joissakin OpenType-kirjasimissa on nostettuja tai laskettuja kuvioita, joiden koko on mukautettu ympäröiviin
merkkeihin. Jos OpenType-kirjasin ei sisällä näitä ei-vakioisissa murtoluvuissa käytettäviä kuvioita, voit käyttää osoittaja- ja nimittäjämääritteitä.

Jotkin OpenType-kirjasimet muuntavat murtolukukuvioiksi vain perusmurtolukuja (esimerkiksi 1/2 ja 1/4), mutta eivät ei-
vakioisia murtolukuja (esimerkiksi 4/13 tai 99/100). Käytä ei-vakioisissa murtoluvuissa osoittaja- ja nimittäjämääritteitä.

Täyskorkuisissa numeroissa käytetään samoja leveyksiä. Tätä asetusta suositellaan tilanteisiin, joissa numeroiden pitää olla
samassa kohdassa kaikilla riveillä, kuten taulukoissa.

Käyttöön otetaan vaihtelevan levyiset ja vaihtelevan korkuiset numerot. Tätä asetusta suositellaan ulkoasultaan
klassisiin, hienostuneisiin teksteihin, joissa ei käytetä versaalia.

Käyttöön otetaan vaihtelevan levyiset, täysikorkuiset numerot. Tätä asetusta suositellaan versaaliteksteihin.

st nd

a o
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Taulukon vanha tyyli

Luvun oletustyyli

Alkuun

Käyttöön otetaan vaihtelevan korkuiset, kiinteälevyiset numerot. Tätä asetusta suositellaan, kun halutaan vanhan tyylin
numeroiden klassinen ulkoasu, mutta numerot on kuitenkin tasattava sarakkeissa, kuten vuosikertomuksissa.

Numerokuvioissa käytetään nykyisen kirjasimen oletuslukutyyliä.

Puuttuvien kirjasinten käyttäminen

Kun avaat tai sijoitat julkaisuja, joissa on käytetty järjestelmästä puuttuvia kirjasimia, kirjasinten nimet ilmoitetaan näyttöön tulevassa varoituksessa.
Jos valitset tekstin, jossa käytetään puuttuvaa kirjasinta, Merkki- tai Ohjaus-välilehti ilmoittaa kirjasimen puuttuvaksi näyttämällä sen Kirjasintyyli-
valikossa kulmasulkeissa.

InDesign korvaa puuttuvat kirjasimet jollakin käytettävissä olevalla kirjasimella. Kun näin tapahtuu, voit valita tekstin ja käyttää mitä tahansa
käytettävissä olevaan kirjasinta. Toisilla kirjasimilla korvatut puuttuvat kirjasimet näkyvät Teksti > Kirjasin -valikon yläosassa kohdassa Puuttuvat
kirjasimet. Oletusasetuksen mukaan puuttuvalla kirjasimella muotoiltu teksti on merkitty vaaleanpunaisella korostuksella.

Jos asennettuna on TrueType-kirjasin ja julkaisussa on Type 1 (T1) -versio samasta kirjasimesta, kirjasin esitetään puuttuvana.

Voit etsiä ja muuttaa puuttuvat kirjasimet valitsemalla Teksti > Etsi kirjasin. Jos puuttuva kirjasin on osa jotakin tyyliä, voit päivittää kirjasimen
kyseisessä tyylissä muuttamalla sen tyylimääritystä.

InDesignin puuttuvien kirjasimien valintaikkunassa näkyy, onko kirjasimien synkronointi otettu käyttöön tai poistettu käytöstä Creative Cloud -
sovelluksessa. Jos toiminto on poistettu käytöstä, voit ottaa Typekitin käyttöön myös Puuttuvat kirjasimet -valintaikkunassa.

Puuttuvien kirjasinten määrittäminen käytettäviksi

Tee jokin seuraavista:

Typekit-työnkulun avulla voit synkronoida puuttuvat kirjasimet InDesignin ja muiden sovellusten kanssa. Katso Työpöytäkirjasimien
synkronointi.
Asenna puuttuvat kirjasimet järjestelmään.
Sijoita ne InDesign-sovelluskansiossa olevaan Kirjasimet-kansioon. Tämän kansion kirjasimet ovat käytettävissä vain InDesignissa.
Lisätietoja: Kirjasinten asentaminen.
Ota puuttuvat kirjasimet käyttöön käyttämällä kirjasinten hallintaohjelmaa.

 

Puuttuvat kirjasimet
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Jos et saa käyttöösi puuttuvia kirjasimia, etsi ja korvaa puuttuvat kirjasimet Etsi kirjasin -komennolla.

Korvattujen kirjasinten korostaminen julkaisussa

Jos Valitse korvatut kirjasimet -asetus on valittuna, puuttuvia kirjasimia käyttävä teksti on merkitty vaaleanpunaisella korostuksella, jolloin sen
huomaa helposti.

1. Valitse Muokkaa > Asetukset > Koostaminen (Windows®) tai InDesign > Asetukset > Koostaminen (Mac OS®).

2. Valitse Korvatut kirjasimet ja valitse sitten OK.

Julkaisun asentamat kirjasimet

Julkaisun kirjasimet -kansiossa olevat kirjasimet ovat väliaikaisesti asennettuja, kun julkaisu on avattuna. Kansio sijaitsee samassa paikassa kuin
InDesign-julkaisu. Keräily-komennolla voit luoda Julkaisun kirjasimet -kansion, kun haluat jakaa julkaisun tai siirtää sen toiseen tietokoneeseen.
(Varmista ennen julkaisukirjasimien jakamista, että kirjasinohjelmiston käyttöoikeussopimus sallii tämän.) Adobe Typekitistä synkronoituja kirjasimia
ei kopioida Keräily-komennolla. Voit lukea Typekit-kirjasimista ja Keräily-komennosta lisää täältä.

Julkaisun kirjasimet -kansiossa olevat kirjasimet eivät ole samoja kuin kirjasimet, jotka ovat käytettävissä käyttöjärjestelmän standardista
kirjasinsijainnista. Ne asennetaan, kun julkaisu avataan ja ne ohittavat kaikki saman nimiset PostScript-kirjasimet. Ne kuitenkin ohittavat ainoastaan
julkaisun sisäiset kirjasimet. Tiettyyn julkaisuun asennetut kirjasimet eivät ole käytettävissä muissa julkaisuissa. Kun suljet julkaisun, julkaisua
varten asennetut kirjasimet poistetaan. Julkaisun asentamat kirjasimet luetellaan Kirjasin-valikon alivalikossa.

Osa julkaisun Type1-kirjasimista eivät ole käytettävissä. Lisäksi eräät Mac OS -kirjasimet eivät ole käytettävissä, kun InDesignia käytetään
Windowsissa.

Voit katsella julkaisun asentamien kirjasimien käyttöä käsittelevän videon Tiedostojen jakaminen ja julkaisukirjasimien vaivaton käyttö (video).

Multiple master -kirjasimet

Multiple master -kirjasimet ovat muokattavia Type 1 -kirjasimia, joiden kirjasintyyliominaisuudet on kuvattu useilla muokattavilla määritteillä. Näitä
määritteitä ovat esimerkiksi paksuus, leveys, tyyli ja optinen koko.

Joillakin Multiple master -kirjasimilla on lisäksi optinen kokoakseli. Sen avulla joissakin pisteko'oissa voidaan käyttää kirjasinta, joka takaa parhaan
luettavuuden. Yleensä pienten, kuten 10 pisteen, kirjasinten optinen koko on suunniteltu siten, että niiden ylä- ja alakaaret ovat leveämmät. Myös
merkit ovat leveämmät, ohuiden ja paksujen viivojen välillä on vähemmän eroa, ja niiden korkeus on suurempi ja välistys väljempi kuin kirjasimella,
joka on suunniteltu optisesti suuremmaksi, esimerkiksi pistekoolle 72.

1. Valitse Muokkaa > Asetukset > Teksti (Windows) tai InDesign > Asetukset > Teksti (Mac OS).

2. Valitse Käytä automaattisesti oikeaa optista kokoa ja valitse OK.

Lisää ohjeaiheita
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Tekstin tasaaminen tai palstaan sovittaminen
Kappaleiden tasaaminen rivirekisteriin
Tasapainoisen otsikkotekstin luominen
Luo palstoja ylittäviä tai jakavia kappaleita
Tekstin tasaaminen tai sovittaminen palstaan pystysuunnassa tekstikehyksen sisällä

Tekstin tasaaminen tai palstaan sovittaminen
Teksti voidaan tasata yhteen tekstikehyksen reunaan tai kehyksen molempiin reunoihin (tai vieruksiin). Tekstin sanotaan olevan palstaan sovitettu,
kun se on tasattu kehyksen molempiin reunoihin. Sovita kappaleteksti palstaan joko viimeistä riviä lukuun ottamatta (Kohdista vasen/oikea reuna)
tai myös se (Kohdista molemmat reunat). Kun viimeisellä rivillä on vain muutama merkki, voit käyttää erityistä jutun lopetusmerkkiä tai
tasausvälilyöntiä.

Kohdista vasen reuna (vasen) ja Kohdista molemmat reunat (oikea)

Huomautus: Kun pakotat kaikki tekstirivit tasapalstaan Adoben kappalekoostajalla, InDesign siirtää tekstiä siten, että kappaleen tekstin tiheys ja
ulkoasu pysyvät yhtenäisinä. Voit hienosäätää välejä tasatussa tekstissä.

1. Valitse teksti.
2. Napsauta jotakin Kappale- tai Ohjaus-välilehden tasauspainiketta (Tasaa vasemmalle, Keskitä, Tasaa oikealle, Tasapalsta, viimeinen rivi

tasattu vasemmalle, Tasapalsta, viimeinen rivi keskitetty, Tasapalsta, viimeinen rivi tasattu oikealle ja Molemmat reunat tasattu).
3. (Valinnainen) Valitse Tasaa selkää kohti tai Tasaa poispäin selästä.

Kun valitset kappaleen tasaukseksi Tasaa selkää kohti, vasemmanpuoleisen sivun teksti tasataan oikealle, mutta kun teksti siirtyy (tai kehys
siirretään) oikeanpuoleiselle sivulle, se tasataan vasemmalle. Jos taas valitset kappaleen tasaukseksi Tasaa poispäin selästä,
vasemmanpuoleisen sivun teksti tasataan vasemmalle ja oikeanpuoleisen oikealle.

Jos haluat tasata tekstirivin vasemman reunan vasemmalle ja oikean reunan oikealle, vie lisäyskohta siihen kohtaan, johon haluat sijoittaa
oikeanpuoleisen tasauksen. Paina sitten sarkainta ja tasaa loppurivi oikealle.

Kappaleiden tasaaminen rivirekisteriin
Rivirekisteri edustaa julkaisun leipätekstin rivivälistystä. Voit käyttää tämän rivivälistysarvon kertoimia kaikkiin sivun osiin. Tällä varmistetaan se,
että teksti rivittyy oikein palstoihin ja sivuille. Jos julkaisun leipätekstin rivivälistys on vaikkapa 12 pistettä, voit määrittää otsikon rivivälistykseksi 18
pistettä ja lisätä otsikoiden ja kappaleiden väliin 6 pisteen välin.

Rivirekisterin käyttäminen varmistaa tekstin sijoittumisen yhdenmukaisesti jokaiselle sivulle. Säätämällä kappaleen rivivälistystä voit varmistaa, että
kappaleen perusviivat tasataan sivun rivirekisteriin. Tästä on hyötyä silloin, kun haluat tasata useiden palstojen tai peräkkäisten tekstikehysten
perusviivat. Voit muuttaa rivirekisterin asetuksia Asetukset-valintaikkunan Ruudukot-kohdasta.

Voit myös tasata vain kappaleen ensimmäisen rivin rivirekisteriin, jolloin muut rivit noudattavat määritettyjä rivivälistysarvoja.

Jos haluat nähdä rivirekisterin, valitse Näytä > Ruudukot ja apuviivat > Näytä rivirekisteri.

Huomautus: Rivirekisteri näkyy vain, jos julkaisun zoomaustaso on suurempi kuin ruudukon asetuksissa oleva näyttökynnys. Joskus näkymää on
lähennettävä, jotta rivirekisteri näkyisi.

Kappaleiden tasaaminen rivirekisteriin
1. Valitse teksti.
2. Valitse Kappale- tai Ohjaus-välilehdestä Tasaa rivirekisteriin .
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Voit varmistaa, että tekstin rivivälistys ei muutu, kun määrität rivirekisterin rivivälistysarvon samaksi kuin tekstin rivivälistys tai sen kertoimeksi.

Vain ensimmäisen rivin tasaaminen rivirekisteriin
1. Valitse tasattavat kappaleet.
2. Valitse Kappale- tai Ohjaus-välilehden valikosta Tasaa vain ensimmäinen rivi ruudukkoon.
3. Valitse Kappale- tai Ohjaus-välilehdestä Tasaa rivirekisteriin .

Tasapainoisen otsikkotekstin luominen
Voit tasapainottaa epätasaisen tasatun tekstin useille riveille. Tämä ominaisuus sopii erityisen hyvin usealla rivillä oleviin otsikoihin, erotettuihin
lainauksiin ja keskitettyihin kappaleisiin.

Ennen Tasoita epätasaiset rivit -asetuksen käyttämistä otsikossa ja sen jälkeen

1. Napsauta kappaletta, jonka haluat tasoittaa.
2. Valitse Kappale- tai Ohjaus-välilehden valikosta Tasoita epätasaiset rivit.

Ominaisuus toimii vain, jos Adoben kappalekoostaja on valittuna.

Luo palstoja ylittäviä tai jakavia kappaleita
Voit antaa kappaleen ylittää useita palstoja tekstikehyksessä, jos haluat luoda palstoja ylittävän otsikon. Voit valita ylittääkö kappale kaikki palstat
vai määritellyn määrän palstoja. Kun kappale on asetettu ylittämään palstoja usean palstan tekstikehyksessä, kaikki ennen palstoja ylittävää
kappaletta esiintyvät tekstit tasapainotetaan.

Voit myös jakaa kappaleen useisiin palstoihin saman tekstikehyksen sisällä.

Voit katsella palstoja ylittävien tai jakavien kappaleiden luomista käsittelevän opetusvideon osoitteessa www.adobe.com/go/lrvid5151_id_fi tai
http://tv.adobe.com/go/4952/.

Palstat ylittävät kappaleet ja jako useisiin palstoihin
A. Otsikko, joka ylittää palstoja B. Jaettu palsta

Anna kappaleen ylittää palstat

1. Sijoita lisäyskohta kappaleen sisälle.

Voit myös tehdä tästä ominaisuudesta osan kappaletyyliä, kuten otsikkotyyli.

2. valitse Ohjauspaneelista tai Kappale-paneelivalikosta Palstojen jänneväli.

3. Valitse Kappaleasettelu-valikosta Palstojen jänneväli.
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4. Valitse jännevälivalikosta haluamasi palstojen määrä, joka kappaleen tulee ylittää. Valitse Kaikki, jos haluat kappaleen ylittävän kaikki
palstat.

5. Jos haluat lisätä ylimääräistä tilaa ennen ylitettävää palstaa tai sen jälkeen, määritä Väli ennen jänneväliä- ja Väli jännevälin jälkeen -
asetukset ja napsauta sitten OK.

Jaa kappale palstoihin

1. Sijoita lisäyskohta kappaleen sisälle.

Voit myös tehdä tästä ominaisuudesta osan kappaletyyliä, kuten otsikkotyyli.

2. valitse Ohjauspaneelista tai Kappale-paneelivalikosta Palstojen jänneväli.

3. Valitse Kappaleasettelu-valikosta Jaa palstat.

4. Määritä seuraavat asetukset ja valitse sitten OK:

Alipalstat Valitse jännevälivalikosta palstamäärä, johon haluat kappaleen jakaa.

Väli ennen jakoa / Väli jaon jälkeen Lisää tilaa ennen jaettua kappaletta tai sen jälkeen.

Sisäpuolinen palstaväli Määritä ennen jaettua kappaletta tai sen jälkeen oleva tila.

Ulkopuolinen palstaväli Määritä jaettujen kappaleiden ulkopuolen ja reunusten välinen tila.

Tekstin tasaaminen tai sovittaminen palstaan pystysuunnassa tekstikehyksen sisällä
Voit tasata tekstin tai sijoittaa sen tasavälein kehyksen pystyakselilla. Näin teksti pysyy yhdenmukaisena eri kehyksissä ja niiden palstoilla.

Voit myös tasata tekstin kehyksen yläreunaan, keskelle tai alareunaan käyttämällä kunkin kappaleen rivivälistys- ja kappaleväliasetuksia. Voit
sovittaa tekstin palstaan pystysuunnassa siten, että rivit sijoittuvat tasavälein huolimatta niiden rivivälistys- ja kappaleväliasetuksista.

Pystytasaus-Alas (vasemmalle) ja Tasaa (oikealle)

Tekstin pystytasaus ja palstaan sovitus lasketaan kehyksen kunkin tekstirivin perusviivasta. Muista seuraavat asiat, kun muutat pystytasausta:

Kehyksen yläreuna on ensimmäisen ylös tasatun tekstirivin perusviiva. Tekstikehyksen asetukset -valintaikkunan Ensimmäisen perusviivan
siirtymä -asetus vaikuttaa tähän arvoon.

Kehyksen alareuna on viimeisen alas tasatun tekstirivin perusviiva. Alaviitetekstiä ei ole tasattu.

Kun ylös, keskelle tai alas tasatussa kappaleessa käytetään Tasaa rivirekisteriin -asetusta, kaikki rivit tasataan rivirekisteriin. Kun käytetään
Tasattu-asetusta, vain ensimmäinen ja viimeinen rivi tasataan rivirekisteriin.

Jos muutat tekstikehyksen Ylävierus- tai Alavierus-asetusta Tekstikehyksen asetukset -valintaikkunassa, ensimmäisen tai viimeisen
perusviivan sijainti muuttuu.

1. Tee jokin seuraavista:

Valitse tekstikehys valintatyökalulla.

Napsauta tekstikehystä tekstityökalulla .

2. Valitse Objekti > Tekstikehyksen asetukset.
3. Valitse Tekstikehyksen asetukset -valintaikkunan Palstaan sovitus pystysuunnassa -osion Tasaa-valikosta jokin seuraavista vaihtoehdoista:

Jos haluat tasata tekstirivit kehyksen yläreunasta alkaen, valitse Ylä. (Tämä on oletusasetus.)

Jos haluat keskittää tekstirivit kehykseen, valitse Keskitä.

Jos haluat tasata tekstirivit kehyksen alareunasta alkaen, valitse Ala.

Jos haluat sijoittaa tekstirivit kehyksen ylä- ja alareunan väliin, valitse Sovita palstaan.

4. Jos valitset Sovita palstaan ja haluat estää rivivälistyksen muuttuvan merkittävästi kappaleväliä suuremmaksi, määritä kappalevälin raja.
Kappaleiden väli suurenee määrittämääsi arvoon asti. Ellei teksti täytä kehystä, InDesign suurentaa rivien välejä, kunnes kehys täyttyy.
Kappalevälin raja -arvo lasketaan yhteen Kappale-välilehdessä määritettyjen Väli ennen- ja Väli jälkeen -arvojen kanssa.
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Kappalevälin raja on nolla (vasen) tai 1 pica (oikea)

Huomautus: Ole varovainen, kun sovitat monisarakkeisia tekstikehyksiä palstaan pystysuunnassa. Jos viimeisessä sarakkeessa on vain
muutama rivi, rivien väliin voi tulla liikaa tyhjää tilaa.

5. Napsauta OK-painiketta.

Helppo tapa säätää Kappalevälin raja -arvoa on valita esikatselu ja napsauttaa asetuksen vieressä ylä- tai alanuolinäppäintä, kunnes
kappaleväli on tasapainossa rivivälistyksen kanssa.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Kappaleiden välin säätäminen
Anfangien käyttäminen
Viivojen lisääminen kappaleiden ylä- ja alapuolelle
Kappalevaihtojen hallinta
Kappalevaihtojen määrittäminen pitoasetuksin
Riippuvien välimerkkien luominen

Voit katsella kappaleiden muokkaamista käsittelevän videon osoitteessa www.adobe.com/go/lrvid4276_id_fi.

Kappaleiden välin säätäminen
Voit säätää kappaleiden väliin jääviä välejä. Jos kappale alkaa palstan tai kehyksen yläreunasta, InDesign ei noudata Väli ennen -arvoa. Näissä
tapauksissa voit kasvattaa kappaleen ensimmäisen rivin rivivälistystä tai kehyksen ylävierusta InDesignissa.

1. Valitse teksti.

2. Määritä Kappale- tai Ohjaus-välilehdessä arvot kohtiin Väli ennen  ja Väli jälkeen .

Voit varmistaa muotoilun yhdenmukaisuuden muuttamalla kappaleväliä määrittämissäsi kappaletyyleissä.

Anfangien käyttäminen
Voit lisätä anfangeja samalla kertaa yhteen tai useaan kappaleeseen. Anfangin perusviiva sijoittuu yhden tai usean rivin kappaleen ensimmäisen
rivin perusviivaa alemmaksi.

Voit myös luoda merkkityylin, jota voi käyttää anfangimerkeissä. Voit esimerkiksi luoda korkean (korotetun) bison kirjaimen määrittämällä
yksirivisen yhden merkin anfangin ja käyttämällä merkkityyliä, joka suurentaa ensimmäisen kirjaimen kokoa.

Yhden merkin kolmirivinen anfangi (vasen) ja viiden merkin kaksirivinen anfangi (oikea)

Anfangin luominen
1. Kun tekstityökalu  on valittuna, napsauta kappaletta kohdassa, johon haluat lisätä anfangin.
2. Kirjoita Kappale- tai Ohjaus-välilehden Anfangin rivimäärä  -kohtaan luku, joka osoittaa, kuinka monelle riville anfangi sijoitetaan.

3. Kirjoita Anfangin merkkien määrä  -kohtaan luku, joka osoittaa, kuinka monta merkkiä suurennetaan.
4. Käytä merkkityyliä anfangimerkkiin valitsemalla Kappale-paneelin valikosta Anfangit ja sisäkkäistyylit sekä valitsemalla sitten luomasi

merkkityyli.
Anfangit ja sisäkkäistyylit -valintaikkunan avulla voit myös tasata anfangin tekstin reunaan, mikä pienentää väliä anfangin vasemmalla
puolella, ja säätää anfangikirjaimia (esimerkiksi g ja y) alapidennyksellä. Jos haluat muuttaa anfangin kokoa, viistotusta tai kirjasintyyppiä
luodaksesi lisätehosteen, valitse kirjain tai kirjaimet ja tee tarvittavat muotoilumuutokset.

Anfangin poistaminen
1. Kun tekstityökalu  on valittuna, napsauta kappaletta, jossa anfangi on.
2. Kirjoita Kappale- tai Ohjaus-välilehden Anfangin rivimäärä- tai Anfangin merkkien määrä -kohtaan 0.

Viivojen lisääminen kappaleiden ylä- ja alapuolelle
Viivat ovat kappalemääritteitä, jotka liikkuvat ja muuttavat kokoaan sivulla olevan kappaleen mukaan. Jos julkaisun otsikoissa käytetään viivaa, se
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voidaan määrittää kappaletyylin asetusten osaksi. Viivan leveys määräytyy palstan leveyden mukaan.

Kappaleen yläpuolella olevan viivan siirtymä mitataan ylärivin perusviivasta viivan alareunaan. Kappaleen alapuolella olevan viivan siirtymä
mitataan tekstin alimman rivin perusviivasta viivan yläreunaan.

Viivojen sijoittaminen
A. Viiva kappaleen yläpuolella B. Viiva kappaleen alapuolella

Michael Murphy on tehnyt videon erikoistehosteiden luomisesta kappaleviivoilla. Se löytyy osoitteesta Kappaleviivat suoriksi.

Creative Curio sisältää jutun kappaleviivojen luovasta käyttämisestä. Se löytyy osoitteesta Kappaleviivojen luova käyttäminen InDesignissa, osa 1.

Viivan lisääminen kappaleen ylä- tai alapuolelle
1. Valitse teksti.
2. Valitse Kappale- tai Ohjaus-välilehden valikosta Kappaleviivat.
3. Valitse Kappaleviiva-valintaikkunasta Viiva yläpuolelle tai Viiva alapuolella.
4. Valitse Viiva.

Huomautus: jos haluat viivan sekä ylä- että alapuolelle, varmista, että Viiva-kohta on valittu molemmissa asetuksissa.
5. Esikatselu-vaihtoehdolla voit tarkastella, miltä viiva näyttää.
6. Valitse Viivan paksuus -kohdassa jokin esimääritetyistä arvoista tai kirjoita uusi paksuus. Kun käytetään Viiva alapuolella -asetusta,

paksuuden lisääminen laajentaa viivaa ylöspäin. Kun käytetään Viiva yläpuolella -asetusta, paksuuden lisääminen laajentaa viivaa alaspäin.
7. Valitse Viivan päällepainatus, kun haluat varmistaa, että viiva ei peitä alla olevia painovärejä kirjapainossa.
8. Valitse jompikumpi seuraavista tavoista:

Valitse väri. Käytettävissä olevat värit näkyvät Värimalli-välilehdessä. Jos valitset Tekstin väri -vaihtoehdon, viivasta tulee samanvärinen
kuin kappaleen ensimmäinen merkki (Viiva alapuolella -asetus) tai kappaleen viimeinen merkki (Viiva yläpuolella -asetus).

Valitse sävy tai määritä sävyarvo. Sävy perustuu valitsemaasi väriin. Väreistä Ei mitään, Paperi, Kohdistus ja Tekstiväri ei voi luoda
sävyjä.

Jos olet määrittänyt viivan tyypiksi jonkin muun kuin yhtenäisen viivan, voit muuttaa katkoviivojen, pisteiden ja viivojen välisen alueen
ulkoasua valitsemalla välin värin tai sävyn.

9. Valitse viivan leveys. Voit valita joko vaihtoehdon Teksti (tekstin tai palstan vasemmasta reunasta rivin loppuun) tai Palsta (palstan
vasemmasta reunasta oikeaan reunaan). Jos kehyksen vasemmassa reunassa on palstan vierus, viiva alkaa sen kohdalta.

10. Määritä viivan pystysijainti kirjoittamalla Siirtymä-arvo.
11. Varmista, että tekstin yläpuolella oleva viiva piirretään tekstikehyksen leveydelle valitsemalla Pidä kehyksessä. Jos tätä asetusta ei valita,

viiva voi ulottua tekstikehyksen ulkopuolelle.
Varmista, että palstan yläosassa oleva kappaleviiva on tasattu viereisen palstan yläosassa olevan tekstin kanssa valitsemalla Pidä
kehyksessä.

12. Määritä viivan (ei tekstin) vasen ja oikea sisennys määrittämällä arvot kohtiin Vasen sisennys ja Oikea sisennys.
13. Valitse Viivan päällepainatus, jos kappaleviiva tulostetaan toisen värin päälle ja haluat välttää kohdistusvirheet tulostuksessa. Valitse

lopuksi OK.

Kappaleviivan poistaminen
1. Napsauta tekstityökalulla  kappaletta, jossa kappaleviiva on.
2. Valitse Kappale- tai Ohjaus-välilehden valikosta Kappaleviivat.
3. Poista valinta kohdasta Viiva ja valitse OK.
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Kappalevaihtojen hallinta
Voit poistaa kappaleesta erilleen jäävät sanat tai yksittäiset rivit eli orpo- ja leskirivit. Orporivit jäävät palstan tai sivun alareunaan ja leskirivit
palstan tai sivun yläreunaan. Toinen typografinen ongelma, joka täytyy välttää, on yksin sivulla oleva otsikko, kun sitä seuraava kappale siirtyy
seuraavalle sivulle. Leskirivit, orporivit, lyhyet sivun viimeiset rivit ja muut kappaleen vaihto-ongelmat voidaan korjata useilla eri asetuksilla:

Tavutusvihjeet Tavutusvihje (Teksti > Lisää erikoismerkki > Tavuviivat ja viivat > Tavutusvihje) näkyy vain, jos sana katkeaa. Tämä asetus estää
tavallisen tavutettuihin sanoihin liittyvän typografisen ongelman, jossa esimerkiksi "huol-taja" jää rivin keskelle tekstin siirtymisen jälkeen. Voit lisätä
myös rivinvaihtovihjemerkin.
Katkeamaton Valitse Merkki-välilehden valikosta Ei vaihtoa, jos haluat estää valitun tekstin jakautumisen eri riveille.
Sitovat välilyönnit Lisää sitova välilyönti (Teksti > Lisää tyhjä tila > [sitova välilyönti]) yhdessä pidettävien sanojen väliin.
Pitoasetukset Valitsemalla Pitoasetukset-vaihtoehdon Kappale-välilehden valikosta voit määrittää, kuinka monta seuraavan kappaleen riviä jää
yhteen edellisen kappaleen kanssa.
Aloita kappale Pitoasetukset-valintaikkunan Aloita kappale -asetuksen avulla voit pakottaa kappaleen (yleensä otsikon) sivun, sarakkeen tai osan
yläreunaan. Tämä asetus toimii erityisen hyvin otsikkokappaletyylin osana.
Tavutusasetukset Voit muuttaa tavutusasetuksia valitsemalla Kappale-välilehden valikosta Tavutus.
Tekstin muokkaaminen Tekstiä ei ehkä voi muokata käsiteltävän julkaisun tyypistä riippuen. Jos sinulla on uudelleenkirjoitusoikeus, pieni
sanamuodon muutos voi parantaa rivinvaihtoa.
Eri koostajan käyttäminen Käytä yleensä Adoben kappaleiden koostajaa, jotta InDesign koostaa kappaleet automaattisesti. Jos kappale ei
muodostu sellaiseksi kuin haluat, valitse Adoben yksirivinen koostaja Kappale-paneelin valikosta tai Ohjauspaneelin valikosta, ja säädä valittuja
rivejä yksitellen. Lisätietoja Tekstin koostaminen.

Kappalevaihtojen määrittäminen pitoasetuksin
Voit määrittää, kuinka monta seuraavan kappaleen riviä jää yhteen edellisen kappaleen kanssa, kun teksti siirtyy kehyksestä toiseen. Tämä on
kätevä tapa varmistaa, että otsikot eivät jää irralleen leipätekstistä. Tarvittaessa InDesign korostaa ne kappaleet, jotka tavutetaan vastoin
määrittämääsi asetusta.

Pitoasetuksia ei ehkä kannata käyttää, jos julkaisun sarakkeissa ei tarvitse käyttää samaa viimeistä perusviivaa.

Voit korostaa pitoasetuksia rikkovat kappaleet valitsemalla Muokkaa > Asetukset > Koostaminen (Windows) tai InDesign > Asetukset >
Koostaminen (Mac OS). Valitse sitten Riviongelmat ja lopuksi OK.

1. Valitse kappaleet, joita haluat muuttaa.
2. Valitse Kappale- tai Ohjaus-välilehden valikosta Pitoasetukset. (Voit myös muuttaa pitoasetuksia, kun luot tai muokkaat kappaletyyliä.)
3. Valitse jokin vaihtoehdoista ja valitse sitten OK:

Valitse Sido edelliseen, jos haluat pitää nykyisen kappaleen ensimmäisen rivin yhdessä edellisen kappaleen viimeisen rivin kanssa.

Määritä Sido seuraavat _ riviä -kohtaan se seuraavan kappaleen rivien määrä (enintään 5 riviä), joiden haluat seuraavan nykyisen
kappaleen viimeistä riviä. Tällä asetuksella voit varmistaa sen, että otsikko pysyy aina yhdessä sitä seuraavien rivien kanssa.

Valitse Pidä rivit yhdessä -asetus ja valitse Kaikki kappaleen rivit. Tällä asetuksella estetään kappalevaihdot.

Valitse Pidä rivit yhdessä -asetus, valitse Kappaleen alussa/lopussa ja määritä, kuinka monta riviä näkyy kunkin kappaleen alussa ja
lopussa. Tällä estetään orpo- ja leskirivit.

Jos haluat pakottaa InDesignin siirtämään kappaleen seuraavaan sarakkeeseen tai kehykseen tai seuraavalle sivulle, valitse asetus
Aloita kappale -kohdasta. Jos valittuna on Missä tahansa, aloituskohta määrittyy Säilytä riviasetukset -asetuksen perusteella. Muut
asetukset määrittävät kappaleen aloituskohdat.

Luo otsikoiden kappaletyylit Pitoasetukset-ikkunassa, jotta otsikot pysyvät yhdessä niitä seuraavien kappaleiden kanssa.

Riippuvien välimerkkien luominen
Välimerkit ja jotkin kirjaimet, esimerkiksi W, voivat aiheuttaa sen, että sarakkeen vasen tai oikea reuna näyttää tasaamattomalta. Optinen
reunuksen tasauksella säädetään, riippuvatko välimerkit (pisteet, pilkut, lainausmerkit ja tavuviivat) ja kirjainten reunat (kuten W ja A) tekstin
reunusten ulkopuolella. Tällöin tekstikehyksen reunus näyttää tasatulta.

Ennen (vasen) optisen reunuksen tasauksen käyttämistä ja sen jälkeen (oikea)
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1. Valitse tekstikehys tai napsauta juttua.
2. Valitse Teksti > Juttu.
3. Valitse Optinen reunuksen tasaus.
4. Määritä ylimeno valitsemalla kirjasinkoko jutussa käytetyn tekstikoon mukaan. Parhaan tuloksen saat käyttämällä samaa kirjasinkokoa kuin

tekstissä.

Voit poistaa optisen reunuksen tasauksen käytöstä yksittäisestä kappaleesta valitsemalla Kappale- tai Ohjaus-välilehden valikosta Ohita
optinen reunus.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Merkkien muotoileminen
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Perusviivan siirtäminen
Merkkien sijoittaminen ylä- tai alaindeksiin muussa kuin OpenType-kirjasimessa
Tekstin alleviivaaminen tai yliviivaaminen
Ligatuurien käyttäminen kirjainpareissa
Tekstin värin, liukuvärin tai viivan muuttaminen
Läpinäkyvyystehosteiden lisääminen tekstiin
Tekstin kielen määrittäminen
Tekstin kirjainkoon muuttaminen
Kirjasimen skaalaaminen
Kirjasinten viistottaminen

Voit katsella merkkien muokkaamista käsittelevän videon osoitteessa www.adobe.com/go/lrvid4275_id_fi.

Perusviivan siirtäminen
Perusviivan siirto -asetuksella voidaan siirtää valittua merkkiä ylös tai alas suhteessa tekstin perusviivaan. Tämä asetus on erityisen
käyttökelpoinen silloin, kun murtolukujen tai sidotun grafiikan sijaintia säädetään käsin.

Tekstissä käytetään perusviivan siirtoarvoja

1. Valitse teksti.

2. Kirjoita jokin numero Merkki- tai Ohjaus-välilehden kohtaan Perusviivan siirto . Nollaa suuremmat arvot siirtävät merkin peruslinjaa rivin
peruslinjan yläpuolelle ja nollaa pienemmät arvot rivin peruslinjan alapuolelle.

Voit säätää arvoa napsauttamalla Peruslinjan siirto -ruutua ja painamalla sitten ylä- tai alanuolinäppäintä. Jos haluat muuttaa arvoa käyttäen
suurempaa lisäystä, pidä vaihtonäppäin alhaalla samanaikaisesti.

Jos haluat muuttaa perusviivan siirron oletuslisäystä, määritä perusviivan siirron arvo Asetukset-valintaikkunan Yksiköt ja lisäykset -osaan.

Merkkien sijoittaminen ylä- tai alaindeksiin muussa kuin OpenType-kirjasimessa
1. Valitse teksti.
2. Valitse Merkki-välilehden valikosta tai Ohjaus-välilehdestä Yläindeksi tai Alaindeksi.

Kun käytät ylä- tai alaindeksiä, valittuun tekstiin sovelletaan ennalta määritettyä perusviivan siirtoarvoa ja kirjasinkokoa.

Indekseille määritettävät arvot ovat prosentteja nykyisestä kirjasinkoosta ja rivivälistyksestä, ja ne perustuvat Tekstiasetukset-valintaikkunan
asetuksiin. Nämä arvot eivät näy Merkki-välilehden Perusviivan siirto- tai Koko-ruuduissa, kun tekstiä valitaan.

Huomautus: voit muuttaa ylä- ja alaindeksien oletuskokoa ja -sijaintia tekstin lisäasetuksilla.

Tekstin alleviivaaminen tai yliviivaaminen
Alleviivauksen ja yliviivauksen oletuspaksuus määräytyy kirjasimen koon mukaan.

Jeff Witchel on tehnyt alleviivausta käsittelevän videon, joka on osoitteessa InDesignin mukautettu alleviivaus.

Tekstin alleviivaaminen tai yliviivaaminen
1. Valitse teksti.
2. Valitse Merkki-välilehden valikosta tai Ohjaus-välilehdestä Alleviivaus tai Yliviivaus.

Alleviivaus- ja yliviivausasetusten muuttaminen
Mukautettu alleviivaus on hyödyllinen esimerkiksi silloin, kun haluat luoda eri kokoisille merkeille tasaisen alleviivauksen tai kun luot
erityistehosteita, esimerkiksi taustan korostuksen.
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Ennen alleviivausten säätämistä ja säätämisen jälkeen

1. Valitse Merkki- tai Ohjaus-välilehden valikosta Alleviivausasetukset tai Yliviivausasetukset.
2. Voit tehdä seuraavat toiminnot. Valitse lopuksi OK:

Ota alleviivaus tai yliviivaus käyttöön nykyisessä tekstissä valitsemalla Alleviivaus käytössä tai Yliviivaus käytössä.

Määritä paksuus valitsemalla Paksuus-kohdasta jokin esimääritetyistä arvoista tai määritä uusi paksuus.

Valitse Tyyppi-kohdassa jokin alleviivaus- tai yliviivausasetuksista.

Määritä Siirtymä-kohtaan viivan pystysijainti. Siirtymä mitataan perusviivasta. Negatiiviset arvot siirtävät alleviivauksen perusviivan
yläpuolelle ja yliviivauksen perusviivan alapuolelle.

Valitse Viivan päällepainatus, kun haluat varmistaa, että viiva ei peitä alla olevia painovärejä kirjapainossa.

Valitse väri ja sävy. Jos olet määrittänyt viivan tyypiksi jonkin muun kuin yhtenäisen viivan, voit muuttaa katkoviivojen, pisteiden ja
viivojen välisen alueen ulkoasua valitsemalla välin värin tai sävyn.

Valitse Viivan päällepainatus tai Välin päällepainatus, jos alleviivaus tai yliviivaus painetaan toisen värin päälle ja haluat välttää
kohdistusvirheet tulostuksessa.

Voit muuttaa alleviivauksen tai yliviivauksen asetuksia kappale- tai merkkityylissä kyseisen ikkunan Alleviivausasetukset- tai
Yliviivausasetukset-kohdassa. Ikkuna tulee näyttöön, kun luot tai muokkaat tyyliä.

Ligatuurien käyttäminen kirjainpareissa
Jos kirjasimen ominaisuuksissa on ligatuureja, InDesign osaa lisätä ne automaattisesti tekstiin. Ligatuurit ovat tiettyjen kirjainparien, kuten fi ja fl,
typografisia korvausmerkkejä. Kun Ligatuurit-asetus on valittuna, käytettävät merkit näkyvät ja tulostuvat ligatuureina. Niitä voi muokata, eivätkä ne
aiheuta ongelmia oikolukuohjelmassa.

Yksittäiset merkit (ylhäällä) ja ligatuurit (alhaalla)

Kun OpenType-kirjasimet ovat käytössä ja Merkki- tai Ohjaus-välilehden valikosta valitaan Ligatuurit, InDesign tuottaa minkä tahansa
kirjasinominaisuuksissa määritetyn vakioligatuurin. Joissakin kirjasimissa on koristeellisia, valinnaisia ligatuureja, joita voidaan käyttää valitsemalla
Harkinnanvaraiset ligatuurit.

1. Valitse teksti.
2. Valitse Ligatuurit Merkki- tai Ohjaus-välilehden valikosta.

Tekstin värin, liukuvärin tai viivan muuttaminen
Voit käyttää värejä, liukuvärejä ja viivoja merkeissä ja jatkaa tekstin muokkaamista. Voit käyttää Värimallit- ja Viiva-paneelia värien, liukuvärien ja
viivojen lisäämiseen tekstiin tai merkkien väriasetusten muuttamiseen tyylin luonnin tai muokkaamisen aikana.
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Värimallit
A. Värimalli vaikuttaa täyttöön tai viivaan B. Värimalli vaikuttaa säilöön tai tekstiin C. Sävyprosentti

1. Tee jokin seuraavista:

Muuta kehyksessä olevan tekstin väri valitsemalla teksti tekstityökalulla .

Muuta kaiken kehyksessä olevan tekstin väri valitsemalla kehys valintatyökalulla . Kun väriä käytetään tekstiin säilön sijaan, varmista,
että Muotoilu vaikuttaa tekstiin -kuvake  on valittu Työkalut-välilehdestä tai Värimallit-välilehdestä.

2. Valitse Työkalut- tai Värimallit-välilehdestä, haluatko muuttaa täytön vai viivan värin. Jos valitset Viiva-asetuksen, vain merkkien ääriviivan
väri muuttuu.

3. Tee jokin seuraavista toimista:

Valitse Värimallit-välilehdestä väri- tai liukuvärimalli.

Määritä Viiva-paneelissa leveys tai muut viivan asetukset. (Lisätietoja: Viiva-paneelin asetukset.)

Liukuväri voidaan lisätä tekstiin myös vetämällä valitun tekstin poikki joko liukuvärimallityökalulla  tai liukuväripehmennystyökalulla .

Voit luoda negatiivitekstin muuttamalla tekstin täyttövärin valkoiseksi tai paperin väriseksi ja kehyksen täyttövärin tummaksi väriksi.
Negatiiviteksti voidaan luoda myös käyttämällä kappaleviivaa tekstin takana. Jos viiva on musta, teksti täytyy muuttaa valkoiseksi.

Läpinäkyvyystehosteiden lisääminen tekstiin
Tehosteet-paneelista voit lisätä tekstiin läpinäkyvyystehosteita, kuten heittovarjoja.

Mike Rankin on tehnyt esimerkkejä läpinäkyvyystehosteista. Ne löytyvät osoitteesta InDesign-silmäkarkit, osa I.

1. Valitse tekstikehys valintatyökalulla .
2. Valitse Objekti > Tehosteet > [tehoste].
3. Valitse teksti asetusvalikosta.

Voit valita Objekti, jos haluat valitsemiesi tehosteiden vaikuttavan tekstikehyksen viivaan ja täyttöön sen sisällä olevan tekstin lisäksi.

4. Määritä tehostemääritteet ja valitse OK.

Jos haluat muuttaa tekstin sekoitustilaa tai peittävyysasetuksia, tee nämä muutokset Tehosteet-välilehdessä.

Tekstin kielen määrittäminen
Kielen määrittäminen tekstiin määrittää käytettävän oikoluku- ja tavutussanaston. Kielen määrittäminen ei muuta tekstiä.

1. Tee jokin seuraavista toimista:

Jos haluat määrittää vain valitun tekstin kielen, valitse haluamasi teksti.

Varmista ennen InDesignin käyttämän oletussanaston vaihtamista, että julkaisuja ei ole avoinna.

Jos haluat vaihtaa julkaisun oletussanaston, avaa kyseinen julkaisu, valitse Muokkaa > Poista kaikkien valinta, ja valitse sitten kieli.

2. Valitse haluamasi sanasto Merkki-paneelin Kieli-valikosta.

InDesign käyttää oikolukuun ja tavutukseen Proximity-sanastoja sekä joissakin kielissä Windsoft-sanastoja. Näiden sanastojen avulla voit määrittää
eri kielen vaikka yksittäiselle merkille. Jokaisessa sanastossa on satoja tuhansia tavutettuja sanoja. Oletuskielen muuttaminen ei vaikuta nykyisiin
tekstikehyksiin tai julkaisuihin.
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Voit mukauttaa sanastot omien tarpeittesi mukaisiksi lisäämällä niihin sanoja.

Sanastojen vaikutus tavutukseen
A. Glockenspiel englannin mukaan tavutettuna B. Glockenspiel saksan vanhojen oikeinkirjoitussääntöjen mukaan tavutettuna C. Glockenspiel
saksan uusien oikeinkirjoitussääntöjen mukaan tavutettuna

Tekstin kirjainkoon muuttaminen
Versaali- ja Kapiteeli-komennot muuttavat tekstin ulkoasua, mutta eivät itse tekstiä. Sen sijaan Muuta kirjainkokoa -komento muuttaa valitun tekstin
kirjainkokoasetusta. Tämä ero on tärkeä tekstiä etsittäessä tai oikeinkirjoitusta tarkistettaessa. Oletetaan esimerkiksi, että kirjoitat julkaisuun
"hämähäkit" ja käytät sanassa versaalia. Jos Etsi/Muuta-toiminnolla (Sama kirjainkoko -asetus valittuna) etsitään sanaa HÄMÄHÄKIT, toiminto ei
löydä versaalilla kirjoitettuja hämähäkkejä. Etsimis- ja oikeinkirjoituksen tarkistamistuloksia voi parantaa käyttämällä Muuta kirjainkokoa -komentoa
versaalin sijaan.

Anne-Marie Concepcion on kirjoittanut jutun kapiteeleista. Se löytyy osoitteesta Kapiteelit ja OpenTypen kaikki kapiteelit.

Tekstin muuttaminen versaaliksi tai kapiteeliksi
InDesignilla voit muuttaa valitun tekstin kirjainkokoa automaattisesti. Kun määrität, että jossakin tekstissä käytetään kapiteelikirjaimia, InDesign
käyttää automaattisesti kirjaimelle suunniteltuja kapiteeleja, jos ne ovat käytettävissä. Muussa tapauksessa InDesign luo kapiteelit skaalaamalla
isot kirjaimet pienemmiksi. Ohjelman luomien kapiteelien koko määritetään Tekstiasetukset-valintaikkunassa.

BC- ja AD-kirjainyhdistelmät ennen (ylhäällä) ja jälkeen (alhaalla) niiden muuttamista kapiteeleiksi niitä ympäröiviä vanhan tyylin numeroita ja
tekstiä mukaillen

Jos valitset versaalin tai kapiteelin OpenType-kirjasinta käytettäessä, InDesign luo entistä tyylikkäämmän kirjasintyypin. Jos käytät OpenType-
kirjasinta, voit valita Kaikki kapiteeleilla -asetuksen myös Merkki-välilehden valikosta tai Ohjaus-välilehdestä. (Lisätietoja: OpenType-kirjasinten
määritteiden käyttäminen.)

1. Valitse teksti.
2. Valitse Merkki-välilehden valikosta tai Ohjaus-välilehdestä Versaali tai Kapiteeli. Jos teksti on alun perin kirjoitettu versaalikirjaimin, Kapiteeli-

asetuksen valitseminen ei muuta tekstiä.

Kapiteelien koon määrittäminen
1. Valitse Muokkaa > Asetukset> Tekstin lisäasetukset (Windows) tai InDesign > Asetukset > Tekstin lisäasetukset (Mac OS).
2. Määritä kapiteelin koko antamalla prosenttiarvo kapiteelilla muotoiltavan tekstin alkuperäisestä kirjasinkoosta. Valitse lopuksi OK.

Isojen kirjainten käytön muuttaminen
1. Valitse teksti.
2. Valitse jokin seuraavista vaihtoehdoista Teksti > Muuta kirjainkokoa -alivalikosta:

Muuta kaikki merkit pieniksi valitsemalla Pienin kirjaimin.

Muuta jokaisen sanan ensimmäinen kirjain isoksi valitsemalla Sanat Alkavat Isolla Kirjaimella.

Muuta kaikki merkit isoiksi valitsemalla ISOIN KIRJAIMIN.

Muuta jokaisen virkkeen ensimmäinen kirjain isoksi valitsemalla Virke alkaa isolla kirjaimella.
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Huomautus: Virke alkaa isolla kirjaimella -komento olettaa, että piste (.), huutomerkki (!) tai kysymysmerkki (?) päättää virkkeen. Tämä komento
voi aiheuttaa yllätyksiä, kun kirjaimia käytetään poikkeavalla tavalla esimerkiksi lyhenteissä, tiedostonimissä tai URL-osoitteissa. Myös erisnimien
alkukirjaimina voidaan käyttää pieniä kirjaimia, kun niissä pitäisi käyttää isoja.

Kirjasimen skaalaaminen
Voit määrittää kirjasimen korkeuden ja leveyden suhteessa merkkien alkuperäiseen korkeuteen ja leveyteen. Skaalaamattomissa merkeissä suhde
on 100 %. Joihinkin kirjasinperheisiin kuuluu expanded font -kirjasin, joka on normaalia kirjasintyyliä leveämpi. Skaalaus vääristää kirjasintyyppiä.
Jos käytettävissä on kirjasin, joka on alun perin tiivistetty tai laajennettu, käytä sitä.

Kirjasimien vaakaskaalaus
A. Skaalaamaton teksti B. Skaalaamaton teksti tiivistetyllä kirjasimella C. Skaalattu teksti tiivistetyllä kirjasimella

Pysty- ja vaakaskaalauksen säätäminen
1. Valitse teksti, jota haluat skaalata.

2. Kirjoita prosenttiarvo Merkki- tai Ohjaus-välilehden kohtaan Pystyskaalaus  tai Vaakaskaalaus .

Tekstin skaalaaminen tekstikehyksen kokoa muuttamalla InDesignissa
 Tee jokin seuraavista toimista:

Pidä Ctrl- (Windows) tai komentonäppäintä (Mac OS) alhaalla ja muuta kehyksen kokoa vetämällä yhtä sen kulmista valintatyökalulla.

Muuta kehyksen kokoa skaalaustyökalulla .

(Lisätietoja: Objektien skaalaaminen.)

Skaalattujen tekstiarvojen ulkoasun määrittäminen
Kun kehyksen skaalausta muutetaan, myös kehyksen sisällä oleva teksti skaalautuu. Kun tekstikehystä esimerkiksi kaksoisnapsautetaan, myös
tekstin koko kaksinkertaistuu: 20 pisteen teksti suurenee 40 pisteen tekstiksi.

David Blatner on kirjoittanut jutun skaalatuista tekstikehyksistä. Se löytyy osoitteesta Suurennuslasitekstikehyksen tekeminen InDesignissa.

Muuttamalla asetuksia voi määrittää, miten skaalattu teksti näkyy paneeleissa:

Tekstin uusi koko (esimerkiksi 40 pt) näkyy oletusarvoisesti Ohjaus- ja Merkki-paneelien Kirjasinkoko-ruuduissa, kun Käytä sisällössä -asetus
on valittuna. Kun Säädä skaalausprosentti -asetus valitaan, Kirjasinkoko-ruuduissa näkyvät sekä tekstin alkuperäinen että skaalattu koko,
esimerkiksi 20 pt (40).

Muunto-välilehden skaalausarvot osoittavat, kuinka monella prosentilla kehystä skaalattiin vaaka- ja pystysuunnassa. Skaalausarvot ovat
oletusarvoisesti 100 % tekstin skaalaamisen jälkeen, kun Käytä sisällössä -asetus on valittuna. Kun Säädä skaalausprosentti -asetus
valitaan, skaalausarvot osoittavat skaalatun kehyksen. Näin ollen arvo on 200 %, jos kehyksen skaalaus kaksinkertaistetaan.

Skaalausmuutosten jäljittäminen kehyksiin on käytännöllistä, jos kehys ja sen sisältämä teksti täytyy palauttaa alkuperäiseen kokoonsa. Sen avulla
on myös kätevää selvittää, kuinka paljon kehyksen koko muuttui. Jos haluat jäljittää skaalausmuutokset kehyksiin ja niiden sisältämään tekstiin,
toimi seuraavasti:

1. Valitse Muokkaa > Asetukset > Yleiset (Windows) tai InDesign > Asetukset > Yleiset (Mac OS).

2. Valitse Säädä skaalausprosentti ja sitten OK.
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Pidä mielessä seuraavat:

Säädä skaalausprosentti -asetus kohdistuu skaalattaviin kehyksiin, kun asetus on valittu, ei olemassa oleviin kehyksiin.

Säädä skaalausprosentti -asetus pysyy tekstin mukana. Skaalattu pistekoko näkyy edelleen suluissa, vaikka Säädä skaalausprosentti -
asetuksen valinta poistetaan ja kehystä skaalataan uudelleen.

Skaalatun pistekoon voi poistaa Muunto-välilehdestä valitsemalla Muunto-välilehdestä Määritä skaalausarvoksi 100%. Tämän asetuksen
valitseminen ei muuta skaalatun kehyksen ulkoasua.

Jos ketjutettujen kehysten ketjuun kuuluvaa tekstiä muokataan tai tällaista kehystä skaalataan ja Säädä skaalausprosentti -asetus on
valittuna, teksti skaalautuu, vaikka se siirtyisi toiseen kehykseen. Jos Käytä sisällössä -asetus on valittuna, muokkauksen seurauksena
toiseen kehykseen jatkuvaa tekstiä ei enää skaalata.

Kirjasinten viistottaminen
1. Valitse teksti.

2. Kirjoita jokin numero Merkki-välilehden kohtaan Viistotus . Positiiviset arvot viistottavat kirjasimia oikealle, negatiiviset vasemmalle.

Kallistuskulmaa käyttämällä ei voi kuitenkaan tuottaa kursivoituja merkkejä.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Tekstin koostaminen
Tekstin tavuttaminen
Tarpeettomien sanakatkojen estäminen
Palstaan sovituksen asetusten muuttaminen

Tekstin koostaminen
Tekstin ulkoasu sivulla määräytyy monimutkaisissa koostamisprosesseissa. InDesign koostaa valitsemiesi sana- ja kirjainväli- sekä kuvion
skaalaus- ja tavutusasetusten mukaan tekstin tavalla, joka parhaiten tukee määritettyjä parametreja.

InDesign sisältää kaksi koostamismenetelmää: Adoben kappaleiden koostaja (oletus) ja Adoben yksirivinen koostaja (kumpikin on Ohjauspaneelin
valikossa). Voit valita käytettävän koostajan Kappale-paneelin valikosta, Palstaan sovitus -valintaikkunasta tai Ohjauspaneelin valikosta.

Voit katsoa tekstin käsittelemistä käsittelevän videon osoitteessa www.adobe.com/go/vid0075_fi.

InDesign Magazinessa on juttu koostamisongelmien ratkaisemisesta. Se löytyy osoitteesta Vältä välit.

Koostamismenetelmät
InDesign sisältää on kaksi koostamismenetelmää: Adoben kappaleiden koostaja (oletus) ja Adoben yksirivinen koostaja. Molemmat
koostamismenetelmät arvioivat mahdolliset rivinvaihdot ja valitsevat niistä ne, jotka parhaiten soveltuvat kappaleeseen määritettyihin tavutus- ja
sovitusasetuksiin.

Adoben kappalekoostaja
Kappalekoostaja hallitsee samalla kappaleen kaikki rivinvaihtokohdat ja optimoi tarvittaessa kappaleen aiemmat rivit niin, että ei-toivotut
rivinvaihdot voidaan välttää. Kappalekoostajaa käytettäessä sanavälit ovat tasaisempia eikä tavuviivoja tarvita niin paljon.

Kappalekoostaja tunnistaa mahdolliset rivinvaihtokohdat, arvioi ne ja määrittää niille suhteellisen rikearvon, joka perustuu kirjainvälien, sanavälien
ja tavutuksen tasaisuuteen.

Tavutus-valintaikkunassa voit määrittää Parempi välistys- ja Vähemmän tavuviivoja -asetusten välisen suhteen. (Lisätietoja: Tekstin
tavuttaminen.)

Adoben yksirivinen koostaja
Yksirivisellä koostajalla voit koostaa tekstiä rivi kerrallaan. Yksirivinen koostaja on hyödyllinen, kun julkaisu on melkein valmis ja koostajan
tekemien muutosten määrää halutaan rajoittaa.

Kappaleen koostamismenetelmän valitseminen
 Tee jokin seuraavista toimista:

Valitse Kappale-välilehden valikosta Adoben kappalekoostaja (oletus) tai Adoben yksirivinen koostaja.

Valitse ensin Kappale- tai Ohjaus-välilehden valikosta Palstaan sovitus ja sitten asetus Koostaja-valikosta.

Huomautus: Koostamislaajennuksia on saatavissa myös muilta valmistajilta. Joidenkin laajennusten käyttöliittymissä voit mukauttaa moduulin
parametreja.

Koostamisasetusten määrittäminen

1. Valitse Muokkaa > Asetukset > Koostaminen (Windows) tai InDesign > Asetukset > Koostaminen (Mac OS).

2. Jos haluat korostaa mahdolliset koostamisongelmat näytössä, valitse Riviongelmat- ja Tasaus- ja tavutusrikkeet -asetukset.

3. Jos haluat tasata tekstin, joka rivittyy kohteen ympäri, valitse Kohdista kohteen vieressä oleva teksti.

4. Napsauta OK-painiketta.

Tekstin tavuttaminen
Valitsemasi tavutus- ja tasausasetukset vaikuttavat rivien vaakavälistykseen ja sivulla olevan tekstin ulkoasuun. Tavutusasetuksilla määritetään se,
tavutetaanko sanoja vai ei ja mitkä rivivaihdot ovat sallittuja.

Käytetyn tasauksen määrittää valitsemasi tasausvaihtoehto, määrittämäsi sanojen ja kirjainten välit sekä valitsemasi Kuvion skaalaaminen -asetus.

524

http://www.adobe.com/go/vid0075_fi
http://www.creativepro.com/article/indesign-how-to-mind-the-gaps


Alkuun

Voit myös tasata yksittäisiä sanoja tasatun tekstin kapeissa palstoissa.

Eda Warren on kirjoittanut jutun koostamisongelmien välttämisestä. Se löytyy osoitteesta Vältä välit.

Tavutuksen säätäminen manuaalisesti
Voit tavuttaa sanoja käsin tai automaattisesti tai käyttää näiden kahden menetelmän yhdistelmää. Turvallisin tapa tavuttaa käsin on tavutusvihjeen
lisääminen. Tavutusvihje on normaalisti kätketty, ja se tulee näkyviin vain, kun sana pitää tavuttaa rivin lopussa. Kun sijoitat sanan alkuun
tavutusvihjeen, sana ei katkea.

1. Napsauta tekstityökalulla  kohtaa, johon haluat lisätä yhdysmerkin.
2. Tee jokin seuraavista:

Valitse Teksti > Lisää erikoismerkki > Tavuviivat ja viivat > Tavutusvihje.

Lisää tavutusvihje painamalla näppäinyhdistelmää Ctrl+vaihto+- (Windows) tai komento+vaihto+- (Mac OS).

Huomautus: Tavutusvihjeen lisääminen sanaan ei takaa sitä, että sana tavutetaan. Sanan tavuttaminen tavutusvihjeellä merkityssä kohdassa
määräytyy muiden tavutus- ja koostamisasetusten mukaan. Tavutusvihjeen lisääminen sanaan takaa kuitenkin sen, että sana voidaan tavuttaa vain
tavutusvihjeen kohdalta.

Tavutuksen säätäminen manuaalisesti
Tavutuksessa käytetään sanastoja, jotka voidaan tallentaa joko erilliseen Käyttäjän sanasto -tiedostoon tai julkaisun yhteyteen. Voit varmistaa
tavutuksen yhdenmukaisuuden määrittämällä käytettävän sanaston. Tästä on hyötyä erityisesti silloin, kun julkaisu toimitetaan palveluntarjoajalle
tai kun tehdään ryhmätyötä.

 Ota automaattinen tavutus käyttöön kappaleessa valitsemalla Kappale- tai Ohjauspaneelista Tavuta-asetus. Poista tavutus käytöstä poistamalla
asetuksen valinta. (Voit määrittää tämän asetuksen osaksi kappaletyyliä.)
Automaattisen tavutuksen asetuksissa voit määrittää Parempi välistys- ja Vähemmän tavuviivoja -asetusten välisen suhteen. Voit myös määrittää,
että isolla kirjoitettuja sanoja ja kappaleen viimeistä sanaa ei tavuteta.

Kappaleen automaattisen tavutuksen asetusten määrittäminen
1. Napsauta haluamaasi yksittäistä kappaletta tai valitse haluamasi kappaleet.
2. Valitse Kappale-välilehden valikosta Tavutus.
3. Valitse Tavuta-asetus.
4. Muuta seuraavia asetuksia tarpeen mukaan ja valitse sitten OK:

Sanan pituus vähintään _ kirjainta Määrittää tavutettavien sanojen vähimmäismerkkimäärän.

Jätä alkuun _ kirjainta ja Viimeisen jälkeen _ kirjainta Määrittää tavutettavien sanojen alussa tai lopussa tarvittavan
vähimmäismerkkimäärän. Jos esimerkiksi kummankin asetuksen arvo on 3, niskatuki tavutetaan niska- tuki eikä nis- katuki tai niskatu- ki.

Tavutusraja _ Tavuviivat Määrittää tavuviivojen enimmäismäärän, joka peräkkäisillä riveillä voi olla. Nolla tarkoittaa, että tavuviivojen
määrää ei rajoiteta.

Tavutusvyöhyke Määrittää tyhjän tilan määrän, joka sallitaan tasaamattoman tekstirivin lopussa, ennen kuin tavutus aloitetaan. Tätä
asetusta voidaan käyttää vain silloin, kun käytetään yhden rivin koostajaa tasaamattomaan tekstiin.

Parempi välistys/vähemmän tavuviivoja Näiden asetusten välistä suhdetta voidaan säätää valintaikkunan alaosassa olevalla
liukusäätimellä.

Tavuta isolla kirjoitetut sanat Voit estää isolla kirjoitettujen sanojen tavutuksen poistamalla tämän asetuksen valinnan.

Tavuta viimeinen sana Voit estää kappaleiden viimeisten sanojen tavutuksen poistamalla tämän asetuksen valinnan.

Tavuta palstojen välillä Voit estää sanojen tavuttamisen sarakkeiden, kehysten tai sivujen välillä poistamalla tämän asetuksen valinnan.

Tarpeettomien sanakatkojen estäminen
Sanojen tavutus rivin lopussa voidaan estää sitovilla yhdysmerkeillä. Voit esimerkiksi estää erisnimien tavuttamisen, jos sanojen osista voi syntyä
ei-toivottuja merkityksiä. Sitovilla välilyönneillä voit estää sanayhdistelmien katkaisemisen. Voit esimerkiksi estää alkukirjainten ja sukunimen
sijoittamisen eri riveille (A. T. Virtanen).

Tekstin tavutuksen estäminen
1. Valitse teksti, jonka haluat pitää yhdellä rivillä.
2. Valitse Merkki- tai Ohjaus-välilehden valikosta Ei vaihtoa.

Toinen tapa estää sanan tavutus on sijoittaa sanan alkuun tavutusvihje. Lisää tavutusvihje painamalla näppäinyhdistelmää Ctrl+vaihto+-
(Windows) tai komento+vaihto+- (Mac OS).

Sitovan yhdysmerkin luominen
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1. Napsauta tekstityökalulla  kohtaa, johon haluat lisätä yhdysmerkin.
2. Valitse Teksti > Lisää erikoismerkki > Tavuviivat ja viivat > Sitova yhdysmerkki.

Sitovan välilyönnin luominen
1. Napsauta tekstityökalulla  kohtaa, johon haluat lisätä välilyönnin.
2. Valitse Teksti > Lisää tyhjä tila> Sitova välilyönti (tai muu välilyöntimerkki).

Sitovan välilyönnin leveys vaihtelee pistekoon, palstaan sovitus -asetuksen ja sanavälistysasetusten mukaan. Sitova välilyönti (kiinteä leveys) -
merkki on sen sijaan samanlevyinen käyttöyhteydestä riippumatta.

Palstaan sovituksen asetusten muuttaminen
Palstaan sovitus -paneelin avulla voit määrittää sana- ja kirjainvälit sekä kuvioiden skaalauksen tarkasti. Välien säätäminen on erityisen tärkeää
käsiteltäessä tasattua tekstiä, joskin myös tasaamattoman tekstin välejä voidaan säätää.

Sana- ja kirjainvälien säätäminen tasatussa tekstissä
1. Siirrä osoitin muutettavan kappaleen kohdalle tai valitse tekstiobjekti tai kehys, jos haluat muuttaa sen kaikki kappaleet.
2. Valitse Kappale-paneelivalikosta Palstaan sovitus.
3. Määritä Sanaväli-, Kirjainväli- ja Kuvioiden väli -asetusten arvot. Pienin- ja Suurin-arvot tarkoittavat hyväksyttävää välin vaihtelua vain

tasatuissa kappaleissa. Haluttu-arvo tarkoittaa toivottua väliä sekä tasatuissa että tasaamattomissa kappaleissa.
Sanaväli Sanojen välinen tyhjä tila, joka lisätään painamalla välinäppäintä. Sanaväli voi vaihdella 0–1000 %. Arvolla 100 % sanojen väliin ei
lisätä ylimääräistä tilaa.

Kirjainväli Kirjainten etäisyys, joka sisältää parivälistys- ja merkkitiheysarvot. Kirjainväli-arvo voi olla -100–500 %: arvolla 0 % kirjainten
väliin ei lisätä mitään, ja arvolla 100 % kirjainten väliin lisätään kokonainen välilyönti.

Kuvion skaalaus Säätää merkkien leveyttä (kuvio on kirjasimen yksi merkki). Kuvioiden skaalauksen arvo voi olla 50–200 %.
Väliasetukset koskevat aina koko kappaletta. Jos haluat muuttaa vain muutamien merkkien välejä, käytä Merkkitiheys-asetusta.

4. Kun haluat määrittää, kuinka yksisanaiset kappaleet tasataan, määritä Yhden sanan tasaus -asetus.

Kapeilla palstoilla voi joskus olla vain yksi sana. Jos kappaleessa käytetään täydellistä palstaan sovitusta, yksi sana voi näyttää liian
venytetyltä. Palstaan sovituksen sijaan voit käyttää keskitystä tai tasausta vasempaan tai oikeaan reunaan.

Kuvioiden skaalauksen määrittäminen tasatussa tekstissä
1. Napsauta haluamaasi kappaleen kohtaa tai valitse haluamasi kappaleet.
2. Valitse Kappale-paneelivalikosta Palstaan sovitus.
3. Määritä Kuvion skaalaus-, Pienin-, Haluttu- ja Suurin-kohtiin arvo. Valitse lopuksi OK.

Palstaan sovitettu teksti ennen kuvion skaalausta (ylhäällä) ja sen jälkeen (alhaalla)

Kuvion skaalaus voi helpottaa tekstin sovittamista palstaan. Arvot, jotka poikkeavat yli 3% oletusarvosta (100%), voivat kuitenkin vääristää
kirjaimia. Sopivia kuvion skaalausarvoja ovat esimerkiksi 97–100–103, ellet halua luoda erikoistehosteita.

Tasausvälilyönnin käyttäminen tasatussa tekstissä
Jos käytät tasausvälilyöntimerkkiä, täysin palstaan sovitetun kappaleen viimeisen rivin viimeisen sanan ja sitä seuraavan jutunlopetusmerkin, kuten
koristeellisen kirjasimen, väliin lisätään vaihteleva määrä tilaa. Jos tasausvälilyöntimerkkiä käytetään tekstissä, jota ei ole sovitettu palstaan,
tasausvälilyönti näyttää tavalliselta välilyönniltä. Kun teksti tasataan palstaan, merkki laajenee kattamaan kaiken viimeisellä rivillä olevan
ylimääräisen tilan. Tasausvälilyönnillä voidaan saada merkittäviä muutoksia kappaleiden muotoiluun, kun käytetään Adoben kappalekoostajaa.
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Ennen tasausvälilyöntimerkin lisäämistä ja merkin lisäämisen jälkeen

1. Napsauta tekstityökalulla  jutunlopetusmerkin edestä.
2. Valitse Teksti > Lisää tyhjä tila > Tasausvälilyönti.

Huomautus: jos Pakota tasapalstaan -asetusta ei ole valittu, tasausvälilyönnin vaikutus ei ole näkyvä.

Liian väljien tai tiiviiden rivien korostaminen
InDesign ei voi aina noudattaa sana- ja kirjasinväliasetuksia, koska kirjasinrivin koostamiseen vaikuttavat monet asiat kirjasin- ja sanavälistyksen
lisäksi (kuten tavutusasetukset). Tekstirivien koostamisongelmat voidaan kuitenkin korostaa keltaisella värillä, jonka kolmesta sävystä tummin
ilmaisee vakavimmat ongelmat.

1. Valitse Muokkaa > Asetukset > Koostaminen (Windows) tai InDesign > Asetukset > Koostaminen (Mac OS).
2. Valitse Tasaus- ja tavutusrikkeet ja valitse OK.

Lisää ohjeaiheita
Tekstin käsittelyä koskeva video
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Tekstin muotoileminen
Tekstin määritteiden kopioiminen (pipetti)
Nopea käyttö

Tekstin muotoileminen
Muokkaa tekstin ulkoasua Ohjaus-välilehden avulla. Kun valitset tekstiä tai viet lisäyskohdan tekstiin, Ohjaus-välilehdessä näkyvät joko merkkien
tai kappaleen muotoiluohjaimet tai näiden yhdistelmä näytön resoluution mukaan. Samat tekstin muotoiluun käytettävät työkalut näkyvät Merkki-
välilehdessä ja Kappale-välilehdessä. Voit muokata tekstin ulkoasua myös Merkki- ja Kappale-paneelien avulla.

Voit katsella merkkien muokkaamista käsittelevän videon osoitteessa www.adobe.com/go/lrvid4275_id_fi. Voit katsella kappaleiden muokkaamista
käsittelevän videon osoitteessa www.adobe.com/go/lrvid4276_id_fi.

Huomaa seuraavat tekstinmuotoilumenetelmät:

Jos haluat muotoilla merkkejä, valitse merkit tekstityökalulla  tai sijoita kohdistin tekstiin napsauttamalla. Valitse sitten muotoiluasetus ja
kirjoita teksti.

Kun haluat muotoilla kappaleen, koko kappaleen ei tarvitse olla valittuna. Riittää, että kappaleesta on valittu jokin sana tai merkki tai että
lisäyskohta on kappaleessa. Voit myös valita tekstialueen useista kappaleista.

Jos haluat muotoilun koskevan kaikkia nykyiseen julkaisuun luotavia uusia tekstikehyksiä, varmista, että lisäyskohta ei ole aktiivinen eikä
mitään ei ole valittuna, ja määritä sitten tekstin muotoiluasetukset. Jos haluat asettaa oletusarvoisen tekstimuotoilun kaikille uusille julkaisuille,
sulje kaikki julkaisut ja määritä sitten tekstiasetukset. Katso Oletusten määrittäminen.

Valitse kehys, jonka sisällä olevaan tekstiin haluat käyttää muotoilua. Kehys ei voi olla osa ketjua.

Voit muotoilla tekstiä nopeasti ja yhdenmukaisesta kappale- ja merkkityylien avulla.

Voit katsoa tekstin käsittelemistä käsittelevän videon osoitteessa www.adobe.com/go/vid0075_fi.

1. Valitse tekstityökalu .
2. Vie lisäyskohta tekstiin napsauttamalla tai valitse teksti, jota haluat muotoilla.

3. Napsauta Ohjaus-välilehden Merkkien muotoiluohjaimet -kuvaketta  tai Kappaleen muotoiluohjaimet -kuvaketta .

Ohjauspaneeli
A. Merkkimuotoilun hallinta B. Kappalemuotoilun hallinta

4. Määritä muotoiluasetukset.

Tekstin määritteiden kopioiminen (pipetti)
Pipettityökalulla voidaan kopioida tekstin määritteitä, kuten merkki, kappale, täyttö ja viiva, ja käyttää näitä määritteitä jossakin muussa tekstissä.
Normaalisti pipettityökalu kopioi kaikki tekstin määritteet. Jos haluat muuttaa pipettityökalulla kopioitavia määritteitä, käytä Pipetin asetukset -
valintaikkunaa.

Tekstimääritteiden kopioiminen valitsemattomaan tekstiin
1. Napsauta pipettityökalulla  tekstiä, jonka määritteet haluat kopioida. (Teksti voi olla toisessa avoimessa julkaisussa.) Pipettiosoitin vaihtaa

suuntaa ja täyttyy  merkiksi siitä, että kopioimasi määritteet on tallennettu siihen. Kun siirrät pipettityökalun tekstin päälle, täyden
pipettikuvakkeen vieressä näkyy tekstikohdistin .

2. Valitse muotoiltava teksti vetämällä pipettityökalua.

Valittu teksti muuttuu pipettityökaluun tallennettujen määritteiden mukaiseksi. Voit valita muotoiltavia tekstejä niin kauan, kuin pipettityökalu
on valittuna.

3. Poista pipettityökalu käytöstä valitsemalla jokin muu työkalu.

Poista pipettityökaluun ladatut muotoilumääritteet painamalla Alt- (Windows) tai optionäppäintä (Mac OS), kun pipettityökalu on täynnä.
Pipettityökalu vaihtaa suuntaa ja tyhjenee  merkiksi siitä, että voit valita objektista uudet määritteet. Napsauta objektia, joka sisältää kopioitavat
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määritteet, ja pudota uudet määritteet toiseen objektiin.

Pipettiä napsautetaan muotoillussa tekstissä, jolloin sen määritteet kopioidaan (vasen), ja vedetään sitten muotoilemattoman tekstin (keskellä) yli,
jolloin muotoilu lisätään (oikea)

Jos kopioit kappaletyylin julkaisusta toiseen pipettityökalulla ja joillakin kappaletyyleillä on sama nimi mutta erilaiset määritteet, tyylierot näkyvät
kohdetyylissä paikallisina ohituksina.

Tekstimääritteiden kopioiminen valittuun tekstiin
1. Valitse tekstityökalulla  tai reittitekstityökalulla  teksti, johon haluat kopioida määritteet.

2. Napsauta pipettityökalulla  tekstiä, josta haluat kopioida määritteet. (Tekstin, josta määritteet kopioidaan, on oltava samassa InDesign-
julkaisussa kuin muotoiltavan tekstin.) Pipettityökalu vaihtaa suuntaa ja täyttyy  merkiksi siitä, että kopioimasi määritteet on tallennettu
siihen. InDesign lisää määritteet tekstiin, jonka valitsit vaiheessa 1.

Valittuun tekstiin kopioidut tekstimääritteet

Pipettityökalulla kopioitavien tekstin määritteiden muuttaminen
1. Kaksoisnapsauta työkalupaneelin pipettityökalua.
2. Valitse Pipetin asetukset -valintaikkunasta Merkkiasetukset tai Kappaleasetukset.
3. Valitse määritteet, jotka haluat kopioida pipettityökalulla, ja valitse OK.

Jos haluat kopioida tai käyttää vain kappalemääritteitä muuttamatta Pipetin asetukset -valintaikkunan asetuksia, pidä vaihtonäppäin alhaalla,
kun napsautat tekstiä pipettityökalulla.

Nopea käyttö
Nopea käyttö -toiminnolla voit etsiä ja käyttää tyylejä, valikkokomentoja, komentosarjoja, muuttujia ja useimpia muita komentoja, jotka on mainittu
Pikanäppäimet-valintaikkunassa.

1. Valitse teksti tai kehys, jossa haluat käyttää tyyliä, valikkokomentoa, komentosarjaa tai muuttujaa,
2. Valitse Muokkaa > Nopea käyttö tai paina Ctrl+Enter (Windows) tai Return+komentonäppäimiä (Mac OS).
3. Kirjoita käytettävän kohteen alkukirjaimet.

Kirjoittamasi nimen ei tarvitse olla täysin oikein. Jos kirjoitat esimerkiksi ti, ohjelma etsii tyylejä, kuten Tiedote 1 ja Tiedote 2, sekä Tiedosto-
valikon komentoja, kuten Tiedosto > Avaa.
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Nopean käytön avulla voit etsiä tyylejä, valikkokomentoja, komentosarjoja ja muuttujia.

Voit rajoittaa haun yhteen luokkaan kirjoittamalla sopivan etuliitteen; esimerkiksi m: tarkoittaa valikkoa ja p: kappaletyylejä. Saat
etuliitteiden luettelon näkyviin napsauttamalla Nopea käyttö -tekstiruudun vasemmalla puolella olevaa alanuolta. Voit poistaa luettelosta
niiden luokkien valinnan, joita et halua nähdä.

4. Valitse käytettävä kohde ja tee sitten yksi seuraavista:

Jos haluat käyttää tyyliä, valikkokomentoa tai muuttujaa, paina Enter tai Return.

Jos haluat käyttää kappaletyyliä ja poistaa ohitukset, paina Alt+Enter (Windows) tai optio+Return (Mac OS).

Jos haluat käyttää kappaletyyliä sekä poistaa ohitukset ja merkkityylit, paina Alt+vaihto+Enter (Windows) tai optio+vaihto+Return
(Mac OS).

Jos haluat käyttää kohdetta sulkematta Nopea käyttö -luetteloa, paina vaihto+Enter (Windows) tai vaihto+Return (Mac OS).

Jos haluat sulkea Nopea käyttö -luettelon käyttämättä kohdetta, paina Esc tai napsauta mitä tahansa muuta kohtaa julkaisuikkunassa.

Jos haluat muokata tyyliä, paina Ctrl+Enter (Windows) tai Komento+Return (Mac OS).

Kun Nopea käyttö -luettelo on näkyvissä, voit liikkua muokkauskentässä vasemmalla tai oikealla nuolinäppäimellä ja selata tyyliluetteloa ylä- tai
alanuolinäppäimellä.

Lisää ohjeaiheita
Tekstin käsittelyä koskeva video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Luettelomerkit ja numerointi
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Luettelomerkittyjen tai numeroitujen luetteloiden luominen
Luettelomerkityn tai numeroidun luettelon muotoileminen
Luettelomerkin vaihtaminen
Numeroidun luettelon asetusten muuttaminen
Luetteloiden määrittäminen
Kappaletyylin luominen jatkuvia luetteloita varten
Monitasoisten luetteloiden luominen
Jatkuvien kuvatekstien luominen kuville ja taulukoille
Luettelon numeroinnin aloittaminen uudelleen tai jatkaminen
Luettelomerkkien tai numeroiden muuntaminen tekstiksi

Luettelomerkittyjen tai numeroitujen luetteloiden luominen
Luettelomerkityissä luetteloissa jokaisen kappaleen alussa on luettelomerkki. Numeroiduissa luetteloissa kappaleet alkavat ilmaisulla, joka sisältää
numeron tai kirjaimen ja erottimen, kuten pisteen tai sulkumerkin. Numeroidun luettelon numerot päivittyvät automaattisesti, kun luettelon
kappalemäärä muuttuu. Voit muuttaa luettelomerkin tai numeroinnin tyyliä, erotinta, kirjasinmääritteitä ja merkkityylejä sekä sisennyksen tyyliä ja
syvyyttä.

Luettelomerkkejä ja numeroita ei voi valita tekstityökalulla. Voit muokata muotoilua ja sisennystä Luettelomerkit ja numerointi -valintaikkunassa,
Kappale-välilehdessä tai Kappaletyylit-valintaikkunan Luettelomerkit ja numerointi -osassa (jos luettelomerkit tai numerot liittyvät johonkin tyyliin).

Luettelomerkityt ja numeroidut luettelot

Luettelomerkityn tai numeroidun luettelon voi luoda kätevästi kirjoittamalla luettelo, valitsemalla se ja valitsemalla sitten Ohjaus-välilehdestä
Luettelomerkitty luettelo tai Numeroitu luettelo. Näillä painikkeilla voit ottaa luettelon käyttöön tai poistaa sen käytöstä sekä vaihdella
luettelomerkkien ja numeroiden välillä. Voit myös liittää luettelomerkit ja numeroinnit kappaletyyliin ja koota luetteloita määrittämällä tyylejä
kappaleisiin.

Huomautus: Automaattisesti luotuja luettelo- ja numeromerkkejä ei lisätä tekstiin, joten ne eivät näy tekstihakutuloksissa eikä niitä voi valita
tekstityökalulla, ellei niitä muunneta tekstiksi. Luettelomerkit ja numerointi eivät näy myöskään juttueditorissa (paitsi kappaletyylisarakkeessa).
Voit katsoa luettelomerkittyjen ja numeroitujen luetteloiden luomista käsittelevän videon osoitteessa www.adobe.com/go/vid0077_fi.

InDesign-dokumentaatio sisältää joukon juttuja, jotka käsittelevät ääriviivojen, monitasoisten luetteloiden, kuvatekstien, ja numeroitujen vaiheiden
luomista luettelomerkeillä ja numeroinnilla.

1. Valitse luettelon muodostavat kappaleet tai napsauta kohtaa, josta haluat luettelon alkavan.
2. Tee jokin seuraavista toimista:

Napsauta Ohjaus-välilehden Luettelomerkitty luettelo -painiketta  tai Numeroitu luettelo -painiketta  (Kappale-tilassa). Avaa
Luettelomerkit ja numerointi -valintaikkuna pitämällä Alt- (Windows) tai optionäppäin (Mac OS) alhaalla napsauttaessasi painiketta.

Valitse Kappale-välilehdestä tai Komento-paneelista Luettelomerkit ja numerointi. Valitse luettelotyypiksi joko Luettelomerkit tai Numerot.
Määritä haluamasi asetukset ja valitse OK.

Käytä luettelomerkit ja numeroinnin sisältävää kappaletyyliä.
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3. Voit jatkaa luetteloa seuraavaan kappaleeseen siirtämällä lisäyskohdan luettelon loppuun ja painamalla Enter- tai Return-näppäintä.
4. Päätä luettelo (tai luettelon osa, jos luettelon on tarkoitus jatkua jäljempänä jutussa) valitsemalla uudelleen Luettelomerkitty luettelo tai

Numeroitu luettelo Ohjauspaneelista tai valitsemalla Luettelomerkit ja numerointi Kappale-paneelivalikosta.

Luettelomerkityn tai numeroidun luettelon muotoileminen
1. Valitse muokattavat luettelomerkityt tai numeroidut kappaleet tekstityökalulla .
2. Avaa Luettelomerkit ja numerointi -valintaikkuna jollakin seuraavista tavoista:

Valitse Kappale-tilassa olevan Ohjaus-välilehden tai Kappale-välilehden Luettelomerkit ja numerointi.

Napsauta joko Luettelomerkitty luettelo -painiketta  tai Numeroitu luettelo -painiketta  pitäen Alt- (Windows) tai optionäppäintä
(Mac OS) alhaalla.

3. Tee jokin seuraavista toimista Luettelomerkit ja numerointi -valintaikkunassa:

Vaihda luettelomerkki.

Muuta numeroidun luettelon asetusta.

Valitse numero- tai luettelomerkkityyli Merkkityyli-luettelosta.

4. Voit muuttaa luettelomerkin tai numeron paikkaa määrittämällä jonkin seuraavista:
Tasaus Tasaa luettelomerkit tai numerot vasemmalle, keskelle tai oikealle numeroille varatun vaakasuuntaisen tilan puitteissa. (Jos tämä tila
on kapea, näiden kolmen asetuksen välinen ero on mitätön.)

Vasen sisennys Määrittää, miten kauas ensimmäisen rivin jälkeen tulevat rivit sisennetään.

Ensirivin sisennys Määrittää, mihin luettelomerkki tai numero tulee.

Suurenna ensirivin sisennysarvoa, jos haluat pitkien luetteloiden välimerkkien olevan tasattu. Jos haluat esimerkiksi luettelonumeroinnissa
numeroiden 9. ja 10. olevan tasattu pisteeseen, vaihda tasaus oikealle ja kasvata vähitellen ensirivin sisennystä, kunnes numerot on tasattu
haluamallasi tavalla (varmista, että esikatselu on käytössä).

Jos haluat luoda riippuvan sisennystehosteen, määritä positiivinen arvo (kuten 2p0) vasemmalle tasaukselle ja määritä sitten vastaava
negatiivinen arvo (kuten -2p0) ensirivin sisennykselle.

Sijaintiasetukset

A.  Riippuva sisennys B.  Vasemmalle tasattu luettelo

Huomautus: Luettelomerkit ja numerointi -valintaikkunan Vasen sisennys-, Ensirivin sisennys- ja Sarkaimen sijainti -asetukset ovat
kappalemääritteitä. Tämän vuoksi näiden asetusten muuttaminen Kappale-välilehdessä muuttaa myös luettelomerkityn ja numeroidun
luettelon muotoilua.

Sarkaimen sijainti Aktivoi sarkaimen sijainnin ja luo tilan luettelomerkin tai numeron ja luettelokohdan alun välille.

Luettelomerkit ja numerot perivät oletusarvoisesti osan tekstimuotoilustaan sen kappaleen ensimmäisestä merkistä, johon ne liitetään. Jos jonkin
kappaleen ensimmäinen merkki poikkeaa muiden kappaleiden ensimmäisistä merkeistä, numerointi tai luettelomerkki on erilainen kuin muussa
luettelossa. Jos tämä ei ole haluamasi muotoilu, luo numeroille tai luettelomerkeille merkkityyli ja määritä se luetteloon Luettelomerkit ja numerointi
-valintaikkunan kautta.
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Jos vaiheen 3 ensimmäinen sana on kursivoitu, myös numerointi kursivoituu, ellet luo numeroille merkkityyliä ja määritä sitä luetteloon.

Luettelomerkin vaihtaminen
Jos et halua käyttää valmiita luettelomerkkejä, voit lisätä uusia luettelomerkkejä Luettelomerkki-ruudukkoon. Luettelomerkit vaihtelevat
kirjasinlajeittain. Voit määrittää, muistetaanko lisäämäsi luettelomerkin kirjasin.

Jos haluat käyttää luettelomerkissä tiettyä kirjasinta (kuten Dingbat-merkkien osoittavaa kättä), varmista, että luettelomerkki muistaa tämän
kirjasimen. Perusluettelomerkin kirjasinta sen sijaan ei kannata muistaa, koska useimmissa kirjasimissa on oma perusluettelomerkki. Jos valitset
luettelomerkkiasetukseksi Muista kirjasin, lisäämäsi luettelomerkki voi käyttää joko Unicode-arvoa ja tiettyä kirjasinperhettä tai pelkkää Unicode-
arvoa.

Huomautus: vain Unicode-arvoon viittaavien luettelomerkkien (ei muistettua kirjasinta) yhteydessä näkyy punainen "u"-merkki.

Luettelomerkit ja numerointi -valintaikkuna
A. Luettelomerkki, kirjasinta ei muisteta B. Luettelomerkki, kirjasin muistetaan

Luettelomerkin vaihtaminen
1. Valitse Ohjaus- tai Kappale-paneelivalikosta Luettelomerkit ja numerointi.
2. Valitse Luettelomerkit ja numerointi -valintaikkunassa luettelotyypiksi Luettelomerkit.
3. Valitse jokin muu luettelomerkki ja sitten OK.

Luettelomerkin lisääminen
1. Valitse Luettelomerkit ja numerointi -valintaikkunassa luettelotyypiksi Luettelomerkit. Valitse sitten Lisää.
2. Valitse kuvio, jota haluat käyttää luettelomerkkinä. (Eri kirjasinperheet ja kirjasintyylit sisältävät eri kuvioita.)
3. Jos haluat uuden luettelomerkin muistavan valitun kirjasimen ja tyylin, valitse Muista luettelomerkin kirjasin.
4. Valitse Lisää.

Huomautus: Luettelomerkkien luettelo tallennetaan julkaisuun kappale- ja merkkityylien tavoin. Kun liität tai lataat kappaletyylejä toisesta
julkaisusta, näissä tyyleissä käytetyt luettelomerkit näkyvät Luettelomerkit ja numerointi -valintaikkunassa muiden nykyiseen julkaisuun
määritettyjen luettelomerkkien ohella.

Luettelomerkin poistaminen
1. Valitse Luettelomerkit ja numerointi -valintaikkunassa luettelotyypiksi Luettelomerkit.
2. Valitse poistettava luettelomerkki. Valitse Poista. (Ensimmäistä oletusluettelomerkkiä ei voi poistaa.)
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Numeroidun luettelon asetusten muuttaminen
Numeroidun luettelon numerot päivittyvät automaattisesti, kun luettelon kappalemäärä muuttuu. Kappaleet, jotka kuuluvat samaan luetteloon,
numeroidaan järjestyksessä. Näiden kappaleiden ei tarvitse olla peräkkäisiä, kun kappaleille määritetään luettelo.

Voit myös luoda monitasoisia luetteloita, joissa luettelokohdat numeroidaan jäsennysmuodossa ja sisennetään eri asteilla.

1. Avaa Luettelomerkit ja numerointi -valintaikkuna.
2. Valitse haluamasi numerointitapa Numerointityyli-kohdan Muoto-valikosta.
3. Käytä Numero-ruudussa joko oletusilmausta, eli pistettä (.) ja sarkainta (^t), tai koosta oma numeroilmaisu. Jos haluat luoda numeroilmaisun,

poista numeron metamerkin (^#) jäljessä oleva piste ja tee jokin seuraavista:

Kirjoita merkki (esimerkiksi loppusulkumerkki) tai enemmän kuin yksi merkki pisteen tilalle.

Valitse jokin vaihtoehto (kuten Em-viiva tai Ellipsit) Lisää erikoismerkki -valikosta.

Kirjoita sana tai merkki numeron metamerkin edelle. Jos esimerkiksi haluat numeroida kysymyksiä luetteloon, voit lisätä sanan Kysymys.

4. Valitse ilmauksen merkkityyli. (Valitsemaasi tyyliä käytetään koko numeroilmaisussa, ei vain numerossa.)
5. Valitse Tila-kohdasta jokin seuraavista asetuksista:

Jatka edellisestä numerosta Numeroi luettelot järjestyksessä.

Aloita kohdasta Aloittaa numeroinnin tekstikenttään kirjoittamastasi numerosta tai muusta arvosta. Kirjoita numero, älä kirjainta, vaikka
luettelossa käytettäisiin numeroinnissa kirjaimia tai roomalaisia numeroita.

6. Määritä muut haluamasi asetukset ja valitse sitten OK.

Luetteloiden määrittäminen
Määritetty luettelo voidaan keskeyttää muilla kappaleilla tai luetteloilla, ja luettelo voi jatkua eri juttuihin ja eri julkaisuihin kirjassa. Määritettyjen
luetteloiden avulla voit esimerkiksi luoda koko julkaisun kattavan monitasoisen jäsennyksen tai juoksevan luettelon numeroitujen taulukoiden
nimistä. Voit määrittää luetteloita myös keskenään sekoitettaville erikseen numeroiduille tai luettelomerkityille kohteille. Esimerkiksi kysymys- ja
vastausluettelossa voit määrittää yhden luettelon kysymysten numerointia varten ja toisen vastausten numerointia varten.

Määritettyjen luetteloiden avulla seurataan kappaleita numerointitarkoituksessa. Kun luot numeroinnille kappaletyylin, voit määrittää tyylin
määritettyyn luetteloon. Tällöin kappaleet numeroidaan tällä tyylillä sen perusteella, missä ne ovat määritetyssä luettelossa. Ensimmäiseksi
näkyvälle kappaleelle annetaan numero 1 (Taulukko 1) ja seuraavalle kappaleelle annetaan numero 2 (Taulukko 2), vaikka se olisi vasta monen
sivun päässä. Koska kumpikin kappale kuuluu samaan määritettyyn luetteloon, ne voidaan numeroida järjestyksessä riippumatta siitä, kuinka
kaukana toisistaan ne ovat julkaisussa tai kirjassa.

Määritä uusi luettelo jokaiselle numeroitavalle kohdetyypille, esimerkiksi vaiheittaisille ohjeille, taulukoille ja kuville. Määrittämällä useita luetteloita
voit keskeyttää yhden luettelon toisella luettelolla ja säilyttää numeroinnin kummassakin luettelossa.

Jos luettelokohteita esiintyy ketjuttamattomissa kehyksissä samalla sivulla, kohteet numeroidaan siinä järjestyksessä, jossa tekstikehykset
lisätään sivulle. Jos haluat järjestää tekstikehykset uudelleen, leikkaa ja liitä kehykset yksitellen luetteloon haluamassasi järjestyksessä.
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Määritettyjen luetteloiden avulla voit katkaista yhden luettelon toisella.

Voit katsoa luettelomerkittyjen ja numeroitujen luetteloiden luomista käsittelevän videon osoitteessa www.adobe.com/go/vid0077_fi.

Luettelon määrittäminen
1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse Määritä luetteloita -valintaikkunasta Uusi.
3. Anna luettelolle nimi ja valitse, haluatko jatkaa numerointia eri juttujen välillä ja jatkaa numerointia kirjan aiemmista julkaisuista.
4. Valitse OK kaksi kertaa.

Kun olet määrittänyt luettelon, voit käyttää sitä kappaletyylissä, kuten taulukkojen, kuvien tai järjestyksessä olevien luetteloiden tyylissä. Voit
käyttää sitä myös Ohjaus- ja Kappale-välilehtien kautta.

Huomautus: Jotkut luettelot määritetään automaattisesti. Kun esimerkiksi tuot numeroidun luettelon Microsoft Word -asiakirjasta, InDesign
määrittää automaattisesti luettelon julkaisullesi.

Määritetyn luettelon muokkaaminen
1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse luettelo ja sitten Muokkaa.
3. Anna luettelolle uusi nimi tai muuta Jatka numerointia -asetusta.

Luetteloon määritetyt kappaletyylit määritetään luetteloon uudelleen uudella nimellä.

Määritetyn luettelon poistaminen
1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse luettelo.
3. Valitse Poista ja valitse sitten eri luettelo tai [Oletus]-luettelo, jolla luettelo korvataan.

Kappaletyylin luominen jatkuvia luetteloita varten
Jos haluat luoda jatkuvan luettelon (luettelo, jonka muut kappaleet keskeyttävät, tai joka jatkuu useisiin juttuihin tai julkaisuihin), luo kappaletyyli ja
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käytä tätä tyyliä kappaleissa, joiden haluat kuuluvan luetteloon. Kun haluat luoda julkaisuun esimerkiksi jatkuvan taulukkoluettelon, luo kappaletyyli
nimeltä Taulukot, liitä määritetty luettelo osaksi tyyliä ja käytä sitten Taulukko-kappaletyyliä kaikissa kappaleissa, jotka haluat mukaan
taulukkoluetteloon.

InDesign-dokumentaatio sisältää joukon juttuja, jotka käsittelevät kuvatekstien ja numeroitujen vaiheiden luomista luettelomerkeillä ja numeroinnilla.

1. Valitse Kappaletyylit-välilehden valikosta Uusi kappaletyyli.
2. Kirjoita tyylille nimi.
3. Valitse Uusi kappaletyyli -valintaikkunan vasemmasta reunasta Luettelomerkit ja numerointi.
4. Valitse luettelotyypiksi Luettelomerkit tai Numerointi.
5. Jos luot tyyliä numeroituja luetteloita varten, valitse määritetty luettelo Luettelo-valikosta tai valitse Uusi luettelo, ja määritä luettelo.
6. Määritä luettelomerkin tai numeroinnin ominaisuudet.
7. Voit muuttaa sisennystä Uusi kappaletyyli -valintaikkunan Luettelomerkin tai numeron sijainti -osassa. Jos haluat esimerkiksi luoda

negatiivisen sisennyksen, kirjoita vasemmaksi sisennykseksi 2p ja ensirivin sisennykseksi -2p.
8. Määritä tyylin muut kappaletyylimääritteet ja valitse OK.

Monitasoisten luetteloiden luominen
Monitasoinen luettelo on luettelo, jossa on useita kappaleluettelon välisiä suhteita kuvailevia hierarkkisia tasoja. Näitä luetteloita kutsutaan myös
jäsennysluetteloiksi, koska ne muistuttavat hahmotelmia. Luettelon numerointi (ja sisennykset) osoittavat arvoaseman ja sen, miten osat ovat
alistussuhteessa toisiinsa nähden. Luettelosta näkyy, miten kukin kappale sijoittuu luettelossa suhteessa sitä edeltäviin ja sen jäljessä oleviin
kappaleisiin. Monitasoisessa luettelossa voi olla enintään yhdeksän tasoa.

Monitasoinen luettelo, jossa numerot ja kirjaimet osoittavat hierarkiatasot

Jos haluat luoda monitasoisen luettelon, määritä luettelo ja luo sitten kappaletyyli kullekin haluamallesi tasolle. Esimerkiksi nelitasoinen luettelo
vaatii neljä kappaletyyliä (jokainen tyyli määritetään samaan luetteloon). Aina kun luot tyylin, määrität sen numerointimuodon ja kappalemuotoilun.

Gabriel Powell on tehnyt ääriviivojen ja monitasoisten luetteloiden luomista koskevan videon. Se löytyy osoitteesta Automaattisen numeroidun
luettelon luominen.

Bob Bringhurst on kirjoittanut joukon juttuja, jotka käsittelevät ääriviivojen, monitasoisten luetteloiden, kuvatekstien, ja numeroitujen vaiheiden
luomista luettelomerkeillä ja numeroinnilla.

1. Valitse Kappaletyylit-välilehden valikosta Uusi kappaletyyli.
2. Kirjoita tyylille nimi.
3. Jos olet jo luonut tyylin monitasoiseen luetteloosi, valitse Perustuu-valikosta tyyli, jonka haluat määrittää tätä ylemmille tasoille. Valitse

muussa tapauksessa Ei kappaletyyliä tai Peruskappale.
4. Valitse Uusi kappaletyyli -valintaikkunan vasemmasta reunasta Luettelomerkit ja numerointi..
5. Valitse Luettelotyyppi-valikosta Numerot.
6. Valitse määrittämäsi luettelo Luettelo-valikosta. Jos et ole vielä määrittänyt luetteloa, voit määrittää sen nyt valitsemalla valikosta Uusi

luettelo..
7. Kirjoita Taso-ruutuun numero, joka kuvaa mille monitasoisen luettelon tasolle luotava tyyli on tarkoitettu.
8. Valitse haluamasi numerointityyppi Muoto-valikosta.
9. Kuvaile tämän tason luettelokohdissa käytettävä numeromuotoilu kirjoittamalla metamerkkejä Numero-ruutuun tai valitsemalla metamerkkejä

valikoista.
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Jos haluat lisätä numeroinnin etuliitteitä korkeammilta tasoilta, kirjoita teksti tai napsauta Numero-ruudun alkua ja valitse Lisää numeron
paikkamerkki. Valitse sitten Taso-asetus (esimerkiksi Taso 1) tai kirjoita ^ ja sitten luettelotaso (esimerkiksi ^1). Kun luettelossa
ensimmäisten tasojen numerointi on 1, 2, 3, ja niin edelleen, ja toisten tasojen numerointi on a, b, c, ja niin edelleen, ensimmäisen tason
etuliitteen lisääminen toiseen tasoon tuottaa toisen tason numeroinniksi 1a, 1b, 1c; 2a, 2b, 2c; 3a, 3b, 3c..

Jos haluat luoda numeroilmaisun, lisää välimerkit, lisää metamerkkejä tai valitse asetuksia Lisää erikoismerkki -luettelosta.

10. Valitsemalla Aloita tämän tason numerointi uudelleen seuraavan kohdan jälkeen voit aloittaa numeroinnin uudelleen numerosta 1, kun tämän
tason kappale tulee korkeamman tason kappaleen jälkeen. Poista tämän asetuksen valinta, jos haluat numeroida tämän tason kappaleet
peräkkäin koko luettelossa riippumatta siitä, mihin kappaleet sijoittuvat luettelon hierarkiassa.

Jos haluat aloittaa numerot uudelleen tietyn tason tai tasoalueen jälkeen, kirjoita tason numero tai alue (esimerkiksi 2-4) Aloita tämän tason
numerointi uudelleen seuraavan kohdan jälkeen -kenttään.

11. Voit sisentää tämän tason luettelokohdat korkeampien tasojen luettelokohtia syvemmälle valitsemalla Luettelomerkin tai numeron sijainti -
alueelta Sisennyksen tai sarkaimen sijainti -asetuksia. Sisentäminen auttaa erottamaan luettelon alistussuhteiset kohdat.

12. Valitse OK.

Joskus, kuten numeroitujen vaiheiden yhteydessä, saatat joutua aloittamaan numeroinnin uudelleen saman jutun sisällä. Jos haluat välttyä
luettelonumeroinnin aloittamisesta uudelleen manuaalisesti, luo tason 1 tyyliä vastaava erillinen tyyli, jossa on yksi poikkeus. Valitse Tilaksi Aloita
kohdasta ja määritä 1. Anna tyylille nimeksi esimerkiksi Taso 1 aloita uudelleen.

Jatkuvien kuvatekstien luominen kuville ja taulukoille
Jatkuvat kuvatekstit numeroivat kuvat, taulukot ja muut kohteet järjestyksessä julkaisussa. Esimerkiksi ensimmäinen kuvateksti alkaa sanoilla
"Kuva 1", toinen sanoilla "Kuva 2", ja niin edelleen. Voit varmistaa, että kuvat, taulukot ja vastaavat kohteet numeroidaan järjestyksessä,
määrittämällä kohteelle luettelon ja luomalla sitten kappaletyylin, joka sisältää luettelomääritelmän. Voit lisätä kappaletyylin numerointiin myös
kuvaavia sanoja, kuten "Kuva" tai "Taulukko".

Bob Bringhurst on kirjoittanut jutun kuvatekstien luomisesta. Se löytyy osoitteesta Numeroidut luettelot osa III - Kuvatekstit.

Luettelokohteet numeroidaan siinä järjestyksessä, jossa ne lisätään sivulle. Jos haluat järjestää kohteet uudelleen, leikkaa ja liitä kohteet
yksitellen luetteloon haluamassasi järjestyksessä.

1. Luo uusi kappaletyyli ja valitse Kappaletyylit-valintaikkunan Luettelomerkit ja numerointi -osan Luettelotyyppi-valikosta Numerot.
2. Valitse määritetty luettelo Luettelo-valikosta (tai määritä luettelo valitsemalla Uusi luettelo).
3. Valitse haluamasi numerointitapa Numerointityyli-kohdan Muoto-valikosta.

Voit esimerkiksi luoda luettelon "Kuva A", "Kuva B" ja niin edelleen valitsemalla A, B, C, D... -asetuksen.

4. Kirjoita Numero-ruutuun kuvaava sana sekä (tarvittaessa) välilyönnit ja välimerkit sekä numeroinnin metamerkit.

Jos haluat luoda esimerkiksi "Kuva A" -tehosteen, kirjoita sana "Kuva" ja välilyönti numeroinnin metamerkkien edelle (esimerkiksi Kuva ^#.^t).
Tämä lisää sanan "Kuva", jota seuraavat järjestysnumero (^#), piste ja sarkain (^t).

Huomautus: jos haluat lisätä lukujen numeroita jatkuviin kuvateksteihin, valitse Numero-luettelosta Lisää numeron paikkamerkki >
Lukunumero tai kirjoita ^H kohtaan, jossa haluat luvun numeron näkyvän numeroinnissa.

5. Päätä tyylin luominen ja valitse OK.

Kun olet luonut tyylin, käytä sitä kuvateksteissä tai taulukoiden otsikoissa.

Voit luoda taulukko- tai kuvaluettelon Sisällysluettelo-ominaisuuden avulla.

Luettelon numeroinnin aloittaminen uudelleen tai jatkaminen
InDesign sisältää komentoja, joilla voidaan aloittaa luettelo uudelleen tai jatkaa luetteloa:

Numeroidun luettelon aloittaminen uudelleen Aseta lisäyskohta kappaleeseen ja valitse pikavalikosta Aloita numerointi uudelleen tai valitse
Teksti > Luettelomerkityt ja numeroidut luettelot > Aloita numerointi uudelleen. Tavallisissa luetteloissa tämä komento määrittää numeron 1 (tai
kirjaimen A) johonkin kappaleeseen ja tekee siitä luettelon ensimmäisen kappaleen. Monitasoisissa luetteloissa tämä komento määrittää
ensimmäisen alemman tason numeron sisäkkäiseen kappaleeseen.
Numeroidun luettelon jatkaminen Valitse pikavalikosta Jatka numerointia tai valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Jatka
numerointia. Tämä komento jatkaa huomautuksen, kuvan tai sisäkkäisten luettelokohtien katkaiseman luettelon numerointia. InDesign sisältää
myös komentoja, joilla voidaan numeroida luetteloita, jotka alkavat yhdessä jutussa tai kirjassa ja jatkuvat seuraavassa jutussa tai kirjassa.

Aiemman tai nykyisen jutun luettelon numeroiminen
Luettelon numeroinnin jatkuminen aiemmasta jutusta tai numeroinnin alkaminen uudelleen nykyisessä jutussa määräytyy luettelon määritysten
perusteella.

1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse luettelo ja napsauta Muokkaa-painiketta.
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Älä valitse oletusluetteloa, sillä se ei voi jatkua jutusta toiseen.

3. Jos haluat jatkaa luettelon numerointia aiemmasta jutusta, valitse Jatka numerointia juttujen välillä. Jos haluat aloittaa luettelon nykyisessä
jutussa numerosta 1 (tai kirjaimesta A), poista tämän asetuksen valinta.

4. Valitse OK kaksi kertaa.

Luettelon numerointi kirjan aiemmasta tai nykyisestä julkaisusta
Luettelon numeroinnin jatkuminen kirjan aiemmasta julkaisusta tai numeroinnin alkaminen uudelleen nykyisessä julkaisussa määräytyy luettelon
määritysten perusteella.

1. Valitse Teksti > Luettelomerkityt ja numeroidut luettelot > Määritä luetteloita.
2. Valitse luettelo ja napsauta Muokkaa-painiketta.
3. Jos haluat jatkaa luettelon numerointia aiemmasta julkaisusta, valitse Jatka numerointia kirjan edellisestä julkaisusta (tämän asetuksen

käyttö edellyttää, että Jatka numerointia juttujen välillä -asetus on valittuna). Jos haluat aloittaa luettelon nykyisessä julkaisussa numerosta 1
(tai kirjaimesta A), poista tämän asetuksen valinta.

4. Valitse OK kaksi kertaa.

Varmista, että kirjan numerointi päivitetään kunnolla synkronoimalla kirjan sisältämät julkaisut ja valitsemalla Kirjat-paneelivalikosta Päivitä
numerointi > Päivitä kaikki numerot.

Luettelomerkkien tai numeroiden muuntaminen tekstiksi
1. Valitse kappaleet, joissa on luettelomerkittyjä tai numeroituja luetteloita.
2. Tee jokin seuraavista:

Valitse Kappale-välilehden valikosta Muunna numerointi tekstiksi tai Muunna luettelomerkit tekstiksi.

Napsauta valintaa hiiren kakkospainikkeella (Windows) tai Ctrl-näppäin alhaalla (Mac OS) ja valitse Muunna numerointi tekstiksi tai
Muunna luettelomerkit tekstiksi.

Huomautus: jos haluat poistaa luettelon numerot tai luettelomerkit, poista luettelomuotoilu valitusta tekstistä napsauttamalla Numeroitu
luettelo -painiketta tai Luettelomerkitty luettelo -painiketta.

Lisää ohjeaiheita
Luettelomerkittyjä ja numeroituja luetteloita käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Tietoja rivivälistyksestä
Rivivälistyksen muuttaminen

Tietoja rivivälistyksestä
Tekstirivien välistä pystysuoraa tilaa kutsutaan rivivälistykseksi. Rivivälistys mitataan tekstirivin perusviivasta sen yläpuolella olevan tekstirivin
perusviivaan. Perusviiva on se näkymätön viiva, johon useimmat juuripiirrottomat kirjaimet rajautuvat.

Automaattisen rivivälistyksen oletusarvo on 120% kirjasinkoosta. (Rivivälistys 12 pistettä, kirjasin 10 pistettä). Kun automaattinen rivivälistys on
käytössä, InDesign näyttää rivivälistysarvon suluissa Merkki-välilehden Rivivälistys-valikossa.

Rivivälistys
A. Rivivälistys B. Tekstin korkeus C. Kun yhden sanan kirjasinkoko on suurempi kuin muun tekstin, rivin rivivälistys on suurempi.

Rivivälistyksen muuttaminen
Rivivälistys on merkkikohtainen määrite. Sen mukaan samassa kappaleessa voi käyttää useampaa kuin yhtä rivivälistysarvoa. Tekstirivin
rivivälistysarvo määräytyy sen suurimman arvon mukaan. Asetuksen valitsemalla voit kuitenkin määrittää, että rivivälistystä käytetään koko
kappaleessa, ei vain kappaleen tekstissä. Tämä asetus ei vaikuta nykyisten kehysten rivivälistykseen.

Valitun tekstin rivivälistyksen muuttaminen
1. Valitse muutettava teksti.
2. Tee jokin seuraavista toimista:

Valitse haluamasi rivivälistys Merkki- tai Ohjaus-välilehden Rivivälistys-valikosta .

Valitse nykyinen rivivälistysarvo ja kirjoita uusi arvo.

Kun luot kappaletyyliä, muuta rivivälistys Perusmerkkimuotoilut-ikkunassa.

Jos InDesign ohittaa rivinvälistysmuutoksen, pystytasaus tai kohdistus rivirekisteriin on kenties valittuna. Valitse Objekti > Tekstikehyksen
asetukset ja varmista, että pystytasaus on asetettu Ylä-arvoon, ja varmista, että Älä kohdista rivirekisteriin on valittuna Kappale-paneelissa,
Ohjauspaneelissa, tai kappaletyylissä.

Pystysuoraa väliä voi säätää myös tasaamalla tekstin rivirekisteriin. Kun rivirekisteri on määritetty, rivirekisterin asetukset ohittavat
rivivälistysarvon.

Oletusarvoisen rivivälistysprosentin muuttaminen
1. Valitse muokattavat kappaleet.
2. Valitse Kappale- tai Ohjaus-välilehden valikosta Palstaan sovitus.
3. Määritä Automaattinen rivivälistys -kohtaan uusi oletusarvo. Pienin arvo on 0% ja suurin 500%.

Rivivälistyksen käyttäminen koko kappaleissa
1. Valitse Muokkaa > Asetukset > Teksti (Windows) tai InDesign > Asetukset > Teksti (Mac OS)
2. Valitse Käytä rivivälistystä koko kappaleessa ja valitse OK.

Huomautus: jos lisäät rivivälistyksen tekstiin merkkityylin osana, rivivälistys vaikuttaa vain tekstiin, jossa merkkityyliä käytetään (ei koko
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kappaleeseen) riippumatta siitä, onko Käytä rivivälistystä koko kappaleessa -asetus valittu.
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Sarkaimet-valintaikkunan yleiskuvaus
Sarkainten määrittäminen
Sarkaimien toisto
Sarkainasetusten siirtäminen, poistaminen ja muokkaaminen
Desimaalisarkainten merkkien määrittäminen
Sarkaimen täytemerkkien lisääminen
Oikealle tasaavien sarkainten lisääminen
Sisennyksien määrittäminen

Sarkaimet-valintaikkunan yleiskuvaus
Teksti sijoitetaan sarkaimilla kehykseen vaakasuunnassa. Sarkainten oletusasetukset määräytyvät Yksiköt ja lisäykset -valintaikkunan
Vaakaviivain-asetuksen mukaan.

Sarkaimet vaikuttavat koko kappaleeseen. Ensimmäinen sarkain poistaa kaikki sen vasemmalle puolelle jäävät oletussarkaimet. Seuraavat
sarkaimet poistavat kaikki näiden sarkainten väliin jäävät oletussarkaimet. Voit määrittää vasemman, oikean ja keskisarkaimen lisäksi
desimaalisarkaimet.

Sarkaimet asetetaan Sarkaimet-valintaikkunan avulla.

Sarkaimet-valintaikkuna
A. Sarkaimen tasauspainikkeet B. Sarkaimen sijainti C. Sarkaimen täytemerkkiruutu D. Tasauskohta-ruutu E. Sarkainviivain F. Kehyksen
yläpuolelta tarttuminen

Sarkaimet-valintaikkunan avaaminen
1. Napsauta tekstikehystä tekstityökalulla.
2. Valitse Teksti > Sarkaimet.

Jos kehyksen yläosa on näkyvissä, Sarkaimet-valintaikkuna tarttuu aktiiviseen tekstikehykseen ja sovittaa sen leveyden nykyiseen palstaan.

Sarkaimet-valintaikkunan viivaimen tasaaminen tekstiin
1. Tuo tekstikehyksen yläreuna näkyviin vierittämällä julkaisua.
2. Napsauta Sarkaimet-valintaikkunan magneettikuvaketta . Sarkaimet-valintaikkuna tarttuu sen palstan yläreunaan, jossa lisäyskohta on ja

josta tekstiä on valittu.

Sarkainten määrittäminen
Voit määrittää vasemman, oikean ja keskisarkaimen lisäksi desimaalisarkaimet. Kun käytät erikoismerkkisarkainta, voit tasata sarkaimen mihin
tahansa merkkiin, kuten pilkkuun tai dollarimerkkiin.

Bob Bringhurst on kirjoittanut jutun erilaisista sarkain- ja sisennystehosteista. Se löytyy osoitteesta Sarkain- ja sisennysgalleria.

1. Napsauta kappaleeseen kohdistin tekstityökalulla .
2. Paina sarkainnäppäintä. Lisää sarkaimia kappaleisiin, joihin haluat lisätä vaakatilaa. (Sarkaimia voi lisätä myös sarkainasetusten

määrittämisen jälkeen.)
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Tekstin tasaaminen sarkaimilla

3. Avaa Sarkaimet-valintaikkuna valitsemalla Teksti > Sarkaimet.
4. Määritä kappale tai kappaleryhmä, joissa sarkaimia käytetään.
5. Määritä ensimmäisen sarkaimen tasaustapa napsauttamalla Sarkaimet-valintaikkunan tasauspainiketta (vasen, oikea, keskitetty tai

desimaali).
6. Tee jokin seuraavista:

Sijoita uusi sarkain napsauttamalla haluamaasi sarkainviivaimen kohtaa.

Uuden sarkainasetuksen lisääminen

Määritä sarkaimen sijainti X-ruutuun ja paina Enter- tai Return-näppäintä. Jos X:n arvo on määritetty, voit suurentaa tai pienentää
sarkainarvoa yhdellä pisteellä ala- tai ylänuolinäppäimillä.

7. Aseta seuraavat sarkaimet ja niiden tasaukset toistamalla vaiheita 3 ja 4.

Ensimmäinen sarkainasetus on tasattu oikealle, toinen vasemmalle.

Jos haluat lisätä sarkainmerkin taulukkoon, valitse Teksti > Lisää erikoismerkki > Muu > Sarkain.

Sarkaimien toisto
Toista sarkain luo useita sarkaimia, jotka perustuvat sarkaimen ja vasemman sisennyksen tai edellisen sarkaimen väliseen etäisyyteen.

1. Napsauta haluamaasi kappaleen kohtaa.
2. Valitse Sarkaimet-paneelissa viivaimesta sarkaimen paikka.
3. Valitse paneelivalikosta Toista sarkain.

Toistetut sarkaimet
A. Sarkaintasauspainikkeet B. Sarkainkohta viivaimessa C. Välilehden valikko

Sarkainasetusten siirtäminen, poistaminen ja muokkaaminen
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Sarkainasetuksia voi siirtää, poistaa ja muokata Sarkaimet-valintaikkunan avulla.

Sarkainasetuksen siirtäminen
1. Napsauta kappaleeseen kohdistin tekstityökalulla .
2. Valitse sarkaimen paikka Sarkaimet-valintaikkunan sarkainviivaimesta.
3. Tee jokin seuraavista:

Määritä uusi sijainti (X). Paina Enter- tai Return-näppäintä.

Vedä sarkain uuteen paikkaan.

Sarkainasetuksen poistaminen
1. Napsauta haluamaasi kappaleen kohtaa.
2. Tee jokin seuraavista:

Vedä sarkain pois sarkainviivaimesta.

Valitse sarkain ja valitse paneelivalikosta Poista sarkain.

Jos haluat palata oletussarkainkohtiin, valitse paneelivalikosta Poista kaikki.

Sarkaimen tasaustavan vaihtaminen
1. Valitse sarkaimen paikka Sarkaimet-valintaikkunan sarkainviivaimesta.
2. Napsauta sarkaintasauspainiketta.

Voit myös selata tasausvaihtoehtoja painamalla Alt- (Windows) tai optionäppäintä (Mac OS) samalla, kun napsautat sarkainmerkkiä.

Desimaalisarkainten merkkien määrittäminen
Käytä desimaalisarkaimia kohdistamaan teksti määritetyn merkin mukaan. Merkki voi olla esimerkiksi piste tai valuuttasymboli.

1. Luo desimaalisarkain  tai valitse se Sarkaimet-paneelin sarkainviivaimesta.
2. Kirjoita Tasauskohta-ruutuun merkki, johon haluat tasata sarkaimen. Voit kirjoittaa tai liittää minkä tahansa merkin. Varmista, että

kohdistettavat kappaleet sisältävät tämän merkin.

Desimaalisarkainta käyttämällä kohdistettu teksti

Sarkaimen täytemerkkien lisääminen
Sarkaimen täytemerkki on toistuva merkkijono, kuten sarja pisteitä tai viivoja, sarkaimen ja sitä seuraavan tekstin välissä.

1. Valitse Sarkaimet-paneelissa viivaimesta sarkaimen paikka.
2. Kirjoita Täytemerkki-ruutuun enintään kahdeksan merkin sarja ja paina Enter- tai Return-näppäintä. Antamasi merkit toistuvat koko

sarkaimen leveydeltä.
3. Jos haluat muuttaa sarkaimen täytemerkin kirjasinta tai muotoilua, valitse sarkainmerkki tekstikehykseen ja muotoile se Merkki-paneelin tai

Teksti-valikon komennoilla.

Oikealle tasaavien sarkainten lisääminen
Voit lisätä oikean sisennyksen kohdalle oikealle tasaavan sarkaimen, joka helpottaa koko palstan täyttävän taulukkotekstin muotoilemista. Oikealle
tasaavat sarkaimet poikkeavat hieman tavallisista sarkaimista. Oikealle tasaava sarkain:

Tasaa kaiken jäljempänä seuraavan tekstin tekstikehyksen oikeaan reunaan. Jos samassa kappaleessa on muita sarkaimia oikealle tasaavan
sarkaimen jälkeen, ne ja niiden teksti siirtyvät seuraavalle riville.

On erikoismerkki, joka sijaitsee tekstissä eikä Sarkaimet-valintaikkunassa. Lisätään pikavalikosta, ei Sarkaimet-valintaikkunasta. Tästä syystä
oikealle tasaava sarkain ei voi olla osa kappaletyyliä.

On eri asia kuin Kappale-välilehden Oikea sisennys. Oikea sisennys -asetus pitää kappaleen koko oikean reunan erillään tekstikehyksen
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oikeasta reunasta.

Sopii käytettäväksi sarkaimen täytemerkin kanssa. Oikea sisennys -sarkaimet käyttävät ensimmäisen sarkainmerkin täytemerkkiä oikean
reunuksen ohi, tai jos sellaista ei ole, oikeaa reunusta edeltävän viimeisen sarkainmerkin ohi.

1. Napsauta tekstityökalulla  riviä, jolle haluat lisätä oikealle tasaavan sarkaimen.
2. Valitse Teksti > Lisää erikoismerkki > Muu > Oikealle tasaava sarkain.

Sisennyksien määrittäminen
Sisennykset siirtävät tekstiä sisäänpäin kehyksen oikeasta ja vasemmasta reunasta. Käytä kappaleen ensimmäisessä rivissä ensirivin sisennystä,
älä välilyöntiä tai sarkaimia.

Ensirivin sisennys sijoitetaan aina suhteessa vasempaan sisennykseen. Jos kappaleen vasenta reunaa sisennetään yhden pican verran, yhden
pican ensirivin sisennys sisentää kappaleen ensimmäistä riviä kaksi picaa kehyksen tai vieruksen vasemmasta reunasta.

Voit määrittää sisennykset Sarkaimet-valintaikkunan, Kappale-välilehden tai Ohjaus-välilehden avulla. Voit myös määrittää sisennykset, kun luot
luettelomerkittyjä tai numeroituja luetteloita.

Bob Bringhurst on kirjoittanut jutun erilaisista sarkain- ja sisennystehosteista. Se löytyy osoitteesta Sarkain- ja sisennysgalleria.

Sisennyksen määrittäminen Sarkaimet-valintaikkunan avulla
1. Napsauta sisennettävää kappaletta tekstityökalulla .
2. Avaa Sarkaimet-valintaikkuna valitsemalla Teksti > Sarkaimet.

3. Tee jokin seuraavista Sarkaimet-valintaikkunan sisennysmerkeille :

Sisennä ensimmäinen rivi vetämällä ylempää merkkiä. Alempaa merkkiä vedettäessä molemmat liikkuvat ja koko kappale sisentyy.

Ensirivin sisennys (vasen) ja ilman sisennystä (oikea)

Valitse ylempi sisennysmerkki ja kirjoita X:lle arvo, jolla ensimmäistä riviä sisennetään. Valitse alempi sisennysmerkki ja kirjoita X:lle
arvo, jolloin koko kappale sisennetään.

Lisätietoja Sarkain-valintaikkunan käyttämisestä on kohdassa Sarkaimet-valintaikkunan yleiskuvaus.

Sisennysten määrittäminen Kappale- tai Ohjaus-välilehden avulla
1. Napsauta sisennettävää kappaletta tekstityökalulla .
2. Määritä haluamasi sisennysarvot Kappale- tai Ohjaus-välilehdessä. Voit tehdä esimerkiksi seuraavat määritykset:

Voit sisentää kappaletta yhden pican verran kirjoittamalla arvon (kuten 1p) Vasen sisennys -ruutuun .

Voit halutessasi sisentää vain kappaleen ensimmäistä riviä yhden pican verran kirjoittamalla arvon kuten 1p) Ensirivin vasen sisennys -
ruutuun .

Voit luoda yhden pican riippuvan sisennyksen kirjoittamalla positiivisen arvon (kuten 1p) Vasen sisennys -ruutuun ja negatiivisen arvon
(kuten -1p) Ensirivin vasen sisennys -ruutuun. Lisätietoja: Sisennyksien määrittäminen.

Sisennysten palauttaminen
1. Napsauta kappaletta, jossa haluat palauttaa sisennykset nollamerkkiin.
2. Valitse Sarkaimet-valintaikkunan valikosta Palauta sisennykset.

Riippuvan sisennyksen luominen
Riippuvassa sisennyksessä sisennetään kaikki muut kappaleen rivit paitsi ensimmäinen rivi. Riippuva sisennys on kätevä silloin, kun haluat lisätä
kappaleen alkuun sidottua grafiikkaa.
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Ei sisennystä (vasen) ja riippuva sisennys (oikea)

1. Napsauta sisennettävää kappaletta tekstityökalulla .
2. Määritä vasen sisennysarvo nollaa suuremmaksi Sarkaimet-valintaikkunassa tai Ohjaus-välilehdessä.
3. Määritä vasemmalle sisennykselle negatiivinen arvo tekemällä jompikumpi seuraavista:

Jos käytät Ohjaus-välilehteä, määritä negatiivinen arvo ensirivin vasemmalle sisennykselle .

Jos käytät Sarkaimet-valintaikkunaa, vedä ylempi merkki vasemmalle tai valitse merkki ja anna X:lle jokin negatiivinen arvo.

Yleensä X:n arvoksi määritetään vaiheessa 2 annetun arvon vastaluku. Jos määritit vasemmaksi sisennykseksi 2 picaa, ensirivin vasen sisennys
on yleensä –2 picaa.

Kappaleen viimeisen rivin oikea sisennys
Voit lisätä kappaleen viimeisen rivin oikealle puolelle riippuvan sisennyksen Viimeisen rivin oikea sisennys -asetuksen avulla. Toiminto on erityisen
hyödyllinen, kun tuoteluettelon hintoja tasataan oikealle.

Viimeisen rivin oikea sisennys

1. Kirjoita kappaleet. Sijoita jokaisen kappaleen viimeisellä rivillä lisäyskohta sisennettävän tekstin eteen ja valitse Teksti > Lisää
erikoismerkki > Muu > Oikealle tasaava sarkain.

2. Valitse kappaleet.
3. Luo kappaleen oikea sisennys määrittämällä arvo (kuten 2p) Kappale- tai Ohjaus-välilehden Oikea sisennys -kenttään.
4. Määritä sarkainta seuraavan tekstin negatiivinen oikea sisennys kirjoittamalla negatiivinen arvo (kuten -2p) Kappale- tai Ohjaus-välilehden

Viimeisen rivin oikea sisennys -kenttään.

Sisennä tähän -erikoismerkin käyttäminen
Voit sisentää kappaleen rivejä Sisennä tähän -erikoismerkillä riippumatta kappaleen vasemman sisennyksen arvosta. Sisennä tähän -merkki
poikkeaa vasemmasta sisennyksestä seuraavasti:

Sisennä tähän -merkki on tekstin osa aivan kuin se olisi näkyvä merkki. Jos teksti sijoitetaan uudelleen, sisennys siirtyy sen mukana.

Sisennä tähän -merkki vaikuttaa kaikkiin merkin jälkeisiin riveihin. Näin voit sisentää haluamasi rivit kappaleessa.

Kun valitset Teksti > Näytä piilomerkit, näyttöön tulee Sisennä tähän -merkki .
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Sisennä tähän -erikoismerkki

1. Sijoita tekstityökalulla  lisäyskohta sisennyksen haluttuun kohtaan.
2. Valitse Teksti > Lisää erikoismerkki > Muu > Sisennä tähän.

Lisää ohjeaiheita
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Parivälistys ja merkkiväli

Alkuun

Tietoja parivälistyksestä ja merkkivälistä
Parivälistyksen käyttäminen tekstissä
Sanojen välisen parivälistyksen säätäminen

Tietoja parivälistyksestä ja merkkivälistä
Merkkivälin määrittäminen on tietyn kirjainparin välin lisäämistä tai vähentämistä. Merkkiväli-asetuksella voi tiivistää tai väljentää kirjainjoukon
merkkien välejä.

Parivälistystyypit
Kirjainten etäisyyttä toisiinsa nähden voi säätää automaattisesti käyttämällä taulukkoarvoja tai optista parivälistystä. Taulukkoarvoihin perustuvassa
parivälistyksessä käytetään useimpiin kirjasimiin määritettyjä arvoja. Välistyspareissa on tiettyjen merkkiparien välistysarvot. Näitä ovat esimerkiksi
LA, P., To, Tr, Ta, Tu, Te, Ty, Wa, WA, We, Wo, Ya ja Yo.

InDesign käyttää oletuksena taulukkoarvoihin perustuvaa parivälistystä, jolloin välistysparit otetaan huomioon automaattisesti tekstiä tuotaessa tai
kirjoitettaessa. Poista taulukkoarvoihin perustuva parivälistys käytöstä valitsemalla "0".

Optisella parivälistyksellä voi säätää peräkkäisten merkkien väliä niiden ulkoasun perusteella. Joissakin kirjasimissa on tarkkoja
välistyspariasetuksia. Jos kirjasimessa on vain vähän parivälistysarvoja, jos ne puuttuvat kokonaan tai jos samalla rivillä käytetään kahta eri
kirjasinta tai kirjasinkokoa, voidaan käyttää optista parivälistystä.

Kirjainpari W ja a ennen optisen parivälistyksen käyttämistä (ylhäällä) ja jälkeen (alhaalla)

Voit käyttää myös manuaalista parivälistystä, joka sopii kahden kirjaimen välin säätämiseen. Merkkitiheys ja manuaalinen merkkiväli ovat
kumulatiivisia, joten voit ensin säätää kirjainparien välit ja tiivistää tai väljentää merkkijoukkoja muuttamatta kirjainparien suhteellista väliä.

Merkkipariväli ei ole sama kuin Palstaan sovitus -valintaikkunan Sanaväli-asetus, sillä se muuttaa parivälistysarvoa vain sanan ensimmäisen
merkin ja sitä edeltävän välilyönnin välillä.

Parivälistys ja merkkiväli
A. Alkuperäinen B. Parivälistys kirjainparissa W ja a C. Merkkiväli-asetus käytössä

Parivälistyksen ja merkkivälin mittaaminen
Voit käyttää valitussa tekstissä parivälistystä, merkkiväliä tai molempia. Merkkivälin ja parivälistyksen mittayksikkö on 1/1000 em. Tämä
mittayksikkö on suhteessa käytettävään kirjasinkokoon. Kuuden pisteen kirjasimessa 1 em vastaa 6:ta pistettä ja 10 pisteen kirjasimessa 1 em
vastaa 10:tä pistettä. Parivälistys ja merkkiväli suhteutetaan aina käytettyyn kirjasinkokoon.

Merkkitiheys ja manuaalinen merkkiväli ovat kumulatiivisia, joten voit ensin säätää kirjainparien välit ja tiivistää tai väljentää merkkijoukkoja
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muuttamatta kirjainparien suhteellista väliä.

Jos viet lisäyskohdan kahden kirjaimen väliin, InDesign näyttää parivälistysarvot Merkki- ja Ohjaus-välilehdessä. Taulukkoarvoihin perustuvat ja
optiset parivälistysarvot (tai määritetyt välistysparit) näkyvät suluissa. Jos valitset sanan tai tekstialueen, InDesign näyttää merkkiväliarvot Merkki-
ja Ohjaus-välilehdessä.

Parivälistyksen käyttäminen tekstissä
Voit käyttää kumpaa tahansa kahdesta automaattisesta parivälistystyypistä, taulukkoarvoihin perustuvaa parivälistystä tai optista parivälistystä. Voit
myös säätää kirjainten väliä manuaalisesti.

Taulukkoarvoihin perustuvan parivälistyksen käyttäminen
1. Vie lisäyskohta niiden merkkien väliin, joiden parivälistyksen haluat määrittää, tai valitse teksti.

2. Valitse Merkki- tai Ohjaus-välilehden Parivälistys-valikosta  Kirjasimen taulukkoarvot.

Estä kirjasimen sisäisten parivälistysarvojen käyttäminen valitussa tekstissä valitsemalla Parivälistys-valikosta   "0".

Optisen parivälistyksen käyttäminen
1. Vie lisäyskohta niiden merkkien väliin, joiden parivälistyksen haluat määrittää, tai valitse haluamasi teksti.

2. Valitse Merkki- tai Ohjaus-välilehden Parivälistys-valikosta  Optinen.

Parivälistyksen säätäminen manuaalisesti
1. Sijoita kohdistin tekstityökalulla  kahden merkin väliin.

Huomautus: Jos olet valinnut tekstialueen, et voi säätää parivälistystä manuaalisesti (vaihtoehdot ovat Kirjasimen taulukkoarvot, Optinen
tai 0). Säädä sen sijaan merkkitiheyttä.

2. Tee jokin seuraavista toimista:

Kirjoita tai valitse Merkki- tai Ohjaus-välilehden Parivälistys-valikosta numeroarvo.

Voit vähentää ja lisätä kahden merkin välistä parivälistystä näppäinyhdistelmällä Alt+vasen/oikea nuolinäppäin (Windows) tai
Optio+vasen/oikea nuolinäppäin (Mac OS).

Parivälistys muuttuu sen verran kuin Yksiköt ja lisäykset -valintaikkunan Parivälistys-asetuksessa on määritetty. Kun painat pikanäppäintä ja pidät
alhaalla Ctrl- tai komentonäppäintä, parivälistykseksi määritetään Parivälistys-asetusten arvo kerrottuna viidellä.

Parivälistyksen oletuslisäyksen muuttaminen
 Kirjoita Asetukset-valintaikkunan Yksiköt ja lisäykset -osaan uusi parivälistysarvo ja valitse OK.

Parivälistyksen poistaminen käytöstä valitulta tekstiosalta
1. Valitse teksti.
2. Kirjoita tai valitse 0 Merkki- tai Ohjaus-välilehden Parivälistys-valikossa.

Parivälistyksen ja merkkivälin voi palauttaa myös painamalla Alt+Ctrl+Q (Windows) tai optio+komento+Q (Mac OS). Tällöin aiemmin määritetyt
parivälistysarvot korvautuvat kirjasimen taulukkoarvoilla.

Merkkitiheyden säätäminen
1. Valitse merkkijoukko.

2. Kirjoita jokin numero Merkki- tai Ohjaus-välilehden kohtaan Merkkiväli .

Tekstin valitseminen, kun tekstissä on mukautettuja parivälistyksiä ja merkkivälejä
Haluat ehkä joskus merkitä tekstin, jossa on käytetty mukautettua merkkiväliä ja parivälistystä. Jos valitset Mukautettu välistys/parivälistys -
asetuksen, mukautettua välistystä tai parivälistystä käyttävä teksti merkitään vihreällä korostuksella.

1. Valitse Muokkaa > Asetukset > Koostaminen (Windows) tai InDesign > Asetukset > Koostaminen (Mac OS).
2. Valitse Mukautettu välistys/parivälistys ja sitten OK.

Sanojen välisen parivälistyksen säätäminen
 Valitse tekstityökalulla  tekstialue ja tee jokin seuraavista toimista:

Levennä valittujen sanojen välejä painamalla näppäinyhdistelmää Alt+Ctrl+\ (Windows) tai optio+komento+\ (Mac OS).

Kavenna valittujen sanojen välejä painamalla Alt+Ctrl+askelpalautin (Windows) tai optio+komento+Delete (Mac OS).
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Voit kertoa parivälistysarvon viidellä pitämällä vaihtonäppäimen alhaalla.
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Formatting CJK characters
Apply shatai to text
Rotate characters
Adjust aki before and after characters
Use tate-chu-yoko
Add Ruby to text
Apply kenten
Align text of different sizes

Apply shatai to text

In traditional typesetting technology, characters were slanted by using a lens to distort the glyphs when being set
on film. This oblique style is known as shatai. Shatai is distinct from a simple slant of the glyphs, because it also
scales the glyphs. You can adjust the magnification or angle of text you want to slant from the center point,
without changing the height of the glyph, using the shatai feature in InDesign.

Shatai

A. No scale applied B. Magnification 30%, 45 shatai C. Selecting the Adjust Tsume option D. Selecting the Adjust Rotation option 

1. Select text.
2. Select Shatai from the Character panel menu or Control panel menu.
3. Specify the following options, and click OK:

Specify the degree of skew in Magnification (In traditional typesetting technology terms, 10%
magnification is lens 1, and 40% magnification is lens 4).

Set the angle of obliqueness to 30, 45, or 60, in Angle.

Select Adjust Rotation to rotate the glyphs, and display horizontal lines horizontally for horizontal
text, and vertical lines vertically for vertical text.

Select Adjust Tsume to apply jidori.

You can fine tune the rotated oblique effect for individual characters, after applying shatai to text.

Rotate characters

1. Select the characters.
2. In the Character panel, type a value for Character Rotation  Specify a minus value to rotate the character
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to the right (clockwise).

Adjust aki before and after characters

1. Select opening parenthesis or closing parenthesis with the type tool.
2. Choose the amount of aki you want to add from the Mojikumi Before Character  or Mojikumi After

Character  pop-up menu, in the Character panel.

For example, if you specify 2bu, half a full-width space is added, and if you specify 4bu, a quarter of a full-width
space is added. This aki will not be adjusted when the line is set to full justification. Adjusting aki is especially
useful to override Mojikumi Akiryo Settings for certain characters.

Adding aki before opening parenthesis

Use tate-chu-yoko

Using tate-chu-yoko (also known as kumimoji or renmoji) is an option to make a part of the text horizontal, in
vertical text. It is easier to read half-width characters such as numbers, dates, and short foreign words in a vertical
text frame, by rotating the text.

Before and after applying tate-chu-yoko

You can move text left, right, up, and down when you turn on the Tate-chu-yoko option. You can also set Auto
Tate-chu-yoko for special half-width characters. Auto Tate-chu-yoko is set in the paragraph attributes.

Use tsume or tracking in the Character panel to adjust the character spacing for Tate-chu-yoko.

Apply tate-chu-yoko

1. Select the text to which you want to apply tate-chu-yoko.
2. Do one of the following:

Choose Tate-chu-yoko from the Character panel menu or Control panel menu.
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Choose Tate-chu-yoko Settings from the Character panel menu or Control panel menu, choose Tate-
chu-yoko in the Tate-chu-yoko dialog box, and click OK.

If multiple instances of tate-chu-yoko appear next to each other, use the Non-joiner character to keep them
separate. Choose Type > Insert Special Character > Other > Non-joiner.

Remove tate-chu-yoko

1. Select the text to which you want to apply tate-chu-yoko.
2. Do one of the following:

Choose and cancel Tate-chu-yoko from the Character panel menu or Control panel menu.

Choose Tate-chu-yoko Settings from the Character panel menu, deselect Tate-chu-yoko in the Tate-
chu-yoko dialog box, and then click OK.

Change tate-chu-yoko settings

1. Choose Tate-chu-yoko Settings from the Character panel menu.
2. Specify a value for moving the text up or down in X Offset. If you specify a plus value, the text will move

up, and if you specify a minus value, it will move down.
3. Specify a value for moving the text left or right in Y Offset. If you specify a plus value, the text will move to

the right, and if you specify a minus value, it will move to the left.

Set Auto Tate-chu-yoko for specific paragraphs

1. Select the text to be set to Auto Tate-chu-yoko, or place the text insertion point in the paragraph.
2. Choose Auto Tate-chu-yoko from the Paragraph panel menu.
3. In KumiNumber, specify the number of successive half-width characters that you want to rotate to vertical

orientation. For example, if this is set to 2, the character string "123" will not rotate, while "12" will.
4. If you want to apply tate-chu-yoko to roman text, select Include Roman Characters, and click OK.

Add Ruby to text

In Japanese, Ruby (also known as furigana) is normally used to show the kanji yomi in hiragana. In Simplified
Chinese, Ruby is called Pinyin, while in Traditional Chinese, Ruby is called Chuyin. InDesign provides full support to
Japanese Ruby and limited support to Chinese Pinyin or Chuyin. You can adjust Ruby settings to specify Ruby
location, size, or color. Furthermore, when the ruby is longer than the parent you can specify the ruby distribution.
You can also apply tate-chu-yoko to Ruby.

Ruby on horizontal text (left), and ruby to the right of vertical text (right)

When the parent to which you want to attach ruby covers two lines, the ruby will follow when the parent moves to
the next line.
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Note:

In some instances, such as when applying a style that includes a variable, Ruby characters may be removed.

1. Select the text to which you want to attach ruby. You cannot attach ruby when there are forced line breaks
in the selected text.

2. Select Ruby > Ruby from the Character panel menu or Control panel menu.
3. Enter the ruby characters in Ruby.
4. Change Ruby settings by clicking an option on the left side of the dialog box and specifying settings.
5. Click OK.

Ruby settings

The following options appear in the different panels of the Ruby dialog box.

Ruby Placement and Spacing

From the Type menu, choose Per-Character or Group Ruby. When Per Character Ruby is selected, enter a
half or full width space when inputting Ruby characters to separate them in line with their parent
characters. For "hakunetsutou" for example, enter as "haku netsu tou" (example of a word composed of
Japanese characters and its phonetic spelling is given).

Ruby

From the Alignment menu, specify the position of the Ruby characters. You can check the position with the
graphic shown in the sample field.

To attach ruby above horizontal text or to the right of vertical text, select Above/Right, and to attach below
horizontal text or to the left of vertical text, select Below/Left in Placement.

Specify the spacing between the ruby and the parent in XOffset and YOffset. When you enter a minus
value, the ruby moves closer to the parent.

Ruby Font and Size

Select a font family and font style in Font.

Specify the size of the ruby characters in Size. The default ruby size is half the size of the parent.

Specify the scale for the height and width of the ruby characters in Horizontal Scale and Vertical Scale.
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Select Use Open Type Pro Ruby Glyphs to use alternate glyphs for ruby (when possible). Specific kana
characters are available for some Open Type Pro fonts. When you select this option, the specific font for
ruby characters, and not the standard kana font, will be used.

In KumiNumber, specify the number of successive half-width characters that you want to rotate to vertical
orientation. For example, if this is set to 2, the character string "123" will not rotate, while "12" will.

Select Include Roman Characters to apply tate-chu-yoko to roman text.

Select Scale to Fit to force the tate-chu-yoko to have the same dimensions (1 em x 1 em) in the ruby
string, either using an OpenType feature or scaling the glyphs.

Adjustment When Ruby Is Longer Than Parent

With Overhang, when the total Ruby width is greater than that of their parent characters, the specified
Ruby will overflow widthways into the space above characters either side of the parents. For Japanese,
character types compatible with Overhang comply with the JISx4051-1995 specification.

Specify the parent character spacing necessary for attaching ruby in Spacing. When you select a different
option, the graphics displayed in the sample field are updated.

To automatically adjust the ruby character width, select Char Width Scaling, and specify the compression
scale for the width of the ruby characters.

Select Auto Align at Line Edges to align the parent with the start and end of the line.

Ruby Color

Select a color swatch in the list box.

Specify the degree of tinting and line weight, as necessary.

Select Overprint Fill or Overprint Stroke to set filling or stroke overprint for ruby characters.

(See Determining when to overprint manually.)

Apply kenten

Kenten (also known as Boten) are points which you attach to text you want to highlight. You can select the type of
points from existing kenten forms, or specify customized kenten characters. You can also specify the position,
scale, and color by adjusting the kenten settings.

Small black circle kenten, black sesame kenten, and small white circle kenten applied to text
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Apply kenten

1. Choose the characters you want to highlight.
2. Choose a kenten character, such as Fisheye or White Circle, from Kenten in the Character panel menu or

Control panel menu.

Change kenten settings and color

1. Choose Kenten > Kenten from the Character panel menu or Control panel menu.
2. For Kenten Settings, specify the options below:

Kenten Type

Select a kenten character, such as Fisheye or White Circ le. Choose Custom to specify a custom character.
You can enter characters directly, or you can specify a character code value for the specified character set.

Position

Specify the spacing between the kenten and characters.

Location

Select Above/Right to attach kenten above horizontal text or to the right of vertical text, and Below/Left to
attach below horizontal text or to the left of vertical text.

Size

Specify the size of the kenten character.

Align

Specify whether the kenten should be displayed in the center (Center) or to the left (Left) (above for
vertical text) of the character's embox.

H/Scale and V/Scale

Specify the scale for the height and width of the kenten character.

3. To change the color of the kenten, choose Kenten Color from the list box, and then specify the options
below:

Select a color swatch from the list box.

Specify the degree of tinting and line weight, as necessary.

Select Overprint Fill or Overprint Stroke to set filling or stroke overprint for kenten characters.

(See Determining when to overprint manually.)

4. Click OK.
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To the topAlign text of different sizes

You can specify how to align text to the largest characters in a line using the Character Alignment option, when
positioning characters of different sizes in 1 line. It is possible to align characters to the top, center or bottom of
the embox (right, center, and left for vertical frames), to the roman baseline, and to the top or bottom of the ICF
box (right or left for vertical frames). ICF (Ideographic Character Face) is the average height and width used by
the font designer to design the ideographic characters which comprise a font.

Align different sizes

A. Align different size letters above full space letters B. Align different size letters in the middle of full space letters C. Align different size
letters below full space letters 

Note:

The Character Alignment option is not effective, even if applied, when all characters are the same size in a line.

1. Select a range of text or lines for the characters you want to align, or select a text frame using the
selection tool.

2. Choose one of the following options from Character Alignment in the Character panel menu or Control panel
menu.

Roman Baseline aligns the small characters in a line to the large character baseline grid.

Embox Top/Right, Center, or Embox Bottom/Left align the small characters in a line to the specified
position of the large characters embox. In vertical text frames, Embox Top/Right aligns the text to
the right of the embox, and Embox Bottom/Left aligns the paragraph to the left of the embox.

ICF Top/Right and ICF Bottom/Left align the small characters in a line to the ICF specified by the
large characters. In vertical text frames, ICF Top/Right aligns the text to the right of the ICF, and
ICF Bottom/Left to the left of the ICF.

Adobe also recommends

Change the text direction
Align paragraphs to a baseline grid

  Twitter™ and Facebook posts are not covered under the terms of Creative Commons.

Legal Notices   |   Online Privacy Policy
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Taulukot

558



Taulukko- ja solutyylit

Alkuun

Huomautus:

About table and cell styles
Table/Cell Styles panels overview
Define table and cell styles
Load (import) table styles from other documents
Apply table and cell styles
Base one table or cell style on another
Edit table and cell styles
Delete table and cell styles
Redefine table or cell styles based on current formatting
Override table and cell styles
Break the link to table or cell styles

About table and cell styles

Just as you use text styles to format text, you can use table and cell styles to format tables. A table style is a collection of table formatting
attributes, such as table borders and row and column strokes, that can be applied in a single step. A cell style includes formatting such as cell
insets, paragraph styles, and strokes and fills. When you edit a style, all tables or cells to which the style is applied are updated automatically.

There is one important difference between text styles and table styles. While all character styles attributes can be part of a
paragraph style, cell style attributes are not part of the table style. For example, you cannot use a table style to change the border color of interior
cells. Instead, create a cell style and include it in the table style.

[Perustaulukko]- ja [Ei mitään]-tyylit

By default, each new document contains a [Basic Table] style that can be applied to tables you create and a [None] style that can be used to
remove cell styles applied to cells. You can edit the [Basic Table] style, but you can’t rename or delete either [Basic Table] or [None].

Solutyylien käyttäminen taulukkotyyleissä

When you create a table style, you can specify which cell styles are applied to different regions of the table: header and footer rows, left and right
columns, and body rows. For example, for the header row, you can assign a cell style that applies a paragraph style, and for the left and right
columns, you can assign different cell styles that apply shaded backgrounds.

Taulukkotyylin alueilla käytettyjä solutyylejä

A. Kappaletyylin sisältävällä solutyylillä muotoiltu ylätunnisterivi B. Vasen sarake C. Leipätekstisolut D. Oikea sarake 

Solutyylin määritteet
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Table style precedence
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Cell styles do not necessarily include all the formatting attributes of a selected cell. When you create a cell style, you can determine which
attributes are included. That way, applying the cell style changes only the desired attributes, such as cell fill color, and ignores all other cell
attributes.

Muotoilujen prioriteetti tyyleissä

If a conflict occurs in formatting applied to a table cell, the following order of precedence determines which formatting is used:

1. Header/Footer 2. Left column/Right column 3. Body rows. For example, if a cell appears in both the header and the left
column, the formatting from the header cell style is used.

1. Cell overrides 2. Cell style 3. Cell styles applied from a table style 4. Table overrides 5. Table styles. For example, if
you apply one fill using the Cell Options dialog box and another fill using the cell style, the fill from the Cell Options dialog box is used.

Table/Cell Styles panels overview

Use the Table Styles panel (Window > Styles >Table Styles) to create and name table styles, and to apply the styles to existing tables or tables
you create or import. Use the Cell Styles panel (Window > Styles > Cell Styles) to create and name cell styles, and to apply the styles to table
cells. Styles are saved with a document and appear in the panel each time you open that document. You can save table and cell styles in groups
for easier management.

When you position the insertion point in a cell or table, any style that is applied is highlighted in either of the panels. The name of any cell style
that is applied through a table style appears in the lower left corner of the Cell Styles area. If you select a range of cells that contains multiple
styles, no style is highlighted and the Cell Styles panel displays “(Mixed).”

Open the Table Styles or Cell Styles panel

Valitse Ikkuna > Tyylit ja valitse Taulukon tyylit tai Solun tyylit.

Change how styles are listed in the panel

Valitse Pienet paneelin rivit, jos haluat nähdä tyylit tiivistettyinä.
Vedä objektityyli toiseen paikkaan. Voit vetää tyylejä myös luomiisi ryhmiin.
Valitse paneelivalikosta Lajittele nimen mukaan, jos haluat lajitella tyylit aakkosjärjestykseen.

Define table and cell styles

1. Jos haluat uuden tyylin perustuvan taulukon tai solun muotoiluun, siirrä kohdistin soluun.

2. Voit halutessasi määrittää solutyyliä varten kappaletyylin.

3. Valitse Ikkuna > Tyylit > Taulukon tyylit, kun haluat avata Taulukkotyylit-paneelin tai valitse Ikkuna > Tyylit > Solun tyylit, kun haluat avata
Solutyylit-paneelin.

4. Valitse Taulukkotyylit-paneelivalikosta Uusi taulukkotyyli tai Solutyylit-paneelivalikosta Uusi solutyyli.

5. Kirjoita Tyylin nimi -ruutuun nimi.

6. Valitse Perustuu-kohdassa tyyli, johon nykyinen tyyli perustuu.

7. Jos haluat lisätä pikanäppäimen, siirrä kohdistin Pikanäppäin-ruutuun ja varmista, että Num Lock on käytössä. Pidä vaihto- Alt- ja Ctrl-
näppäimiä (Windows) tai vaihto-, optio- ja komentonäppäimiä (Mac OS) painettuina ja paina numeronäppäimistön numeronäppäintä. Tyylien
pikanäppäimiksi voidaan määrittää vain numeronäppäimistön numeronäppäimiä (ei kirjaimia tai muita numeronäppäimiä).

8. Jos haluat määrittää muotoilumääritteet, valitse luokka vasemmalta ja valitse sitten määritteet. Jos esimerkiksi haluat liittää solutyyliin
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kappaletyylin, valitse Yleinen-luokka ja valitse sitten Kappaletyyli-valikosta kappaletyyli.

For cell styles, options that don’t have a setting specified are ignored in the style. If you don’t want a setting to be part of the style, choose
(Ignore) from the setting’s menu, delete the contents of the field, or click a check box until a small box appears in Windows or a hyphen (-)
appears in Mac OS.

9. Jos haluat uuden tyylin näkyvän luomassasi tyyliryhmässä, vedä se tyyliryhmän kansioon.

Load (import) table styles from other documents

You can import table and cell styles from another InDesign document into the active document. During import, you can determine which styles are
loaded and what should occur if a loaded style has the same name as a style in the current document. You can also import styles from an InCopy
document.

1. Valitse Solutyylit- tai Taulukkotyylit-paneelivalikosta Lataa solutyylit, Lataa taulukkotyylit tai Lataa taulukko- ja solutyylit.

2. Kaksoisnapsauta sitä InDesign-julkaisua, jossa tuotavat tyylit ovat.

3. Varmista Lataa tyylit -valintaikkunasta, että haluamiesi tyylien vieressä on valintamerkki. Jos jollakin olemassa olevista tyyleistä on sama nimi
kuin tuodulla tyylillä, valitse ensin jokin seuraavista Ristiriita nykyisen tyylin kanssa -kohdan asetuksista ja napauta sitten OK-painiketta:

Overwrites the existing style with the loaded style and applies its new attributes to all cells in the current
document that used the old style. The definitions of the incoming and existing styles appear at the bottom of the Load Styles dialog box so
you can compare them.

Renames the loaded style. For example, if both documents have a style named “Table Style 1,” the loaded style is renamed
“Table Style 1 copy” in the current document.

Apply table and cell styles

Unlike paragraph and character styles, table and cell styles do not share attributes, so applying a table style does not override cell formatting, and
applying a cell style does not override table formatting. By default, applying a cell style removes formatting applied by any previous cell style, but
does not remove local cell formatting. Similarly, applying a table style removes formatting applied by any previous table style, but does not remove
overrides made using the Table Options dialog box.

In the Styles panel, a plus sign (+) appears next to the current cell or table style if the selected cell or table has additional formatting that isn’t part
of the applied style. Such additional formatting is called an override.

1. Siirrä kohdistin taulukkoon tai valitse solut, joissa haluat käyttää tyyliä.

2. Tee jokin seuraavista:

Napsauta taulukkoa tai solua Taulukkotyylit- tai Solutyylit-paneelissa (valitse Ikkuna > Tyylit > Taulukon tyylit tai Solun tyylit). Jos tyyli on
tyyliryhmässä, laajenna ryhmä, jotta näet tyylin.

Paina tyylille määritettyä pikanäppäintä. (Varmista, että Num Lock on käytössä.)

Base one table or cell style on another

You can create links between similar table or cell styles by creating a base, or parent, style. When you edit the parent style, any changed attribute
that appears in the child styles will change as well. By default, table styles are based on [No Table Style], and cell styles are based on [None].

1. Luo uusi tyyli.

2. Valitse ylätyyli Uusi kappaletyyli- tai Uusi merkkityyli -valintaikkunan Perustuu-valikosta. Uutta tyyliä kutsutaan alityyliksi.

3. Määritä uuden tyylin muotoilu, jotta se eroaa ylätyylistä.
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Edit table and cell styles

One of the advantages of using styles is that when you change the definition of a style, all of the tables or cells formatted with that style change to
match the new style definition.

1. Tee jokin seuraavista:

Jos et halua käyttää tyyliä valitussa taulukossa tai solussa, napsauta hiiren kakkospainikkeella (Windows) tai Control-osoita (Mac OS)
Tyylit-paneelissa näkyvää tyyliä ja valitse sitten Muokkaa[tyylin nimi].

Kaksoisnapsauta tyylin nimeä Tyylit-paneelissa tai valitse ensin tyyli ja sitten Tyylit-paneelivalikosta Tyyliasetukset. Huomaa, että tässä
tapauksessa solutyyliä käytetään valitussa solussa tai taulukkotyyliä valitussa taulukossa. Jos taulukkoa ei ole valittu, napsautettu
taulukkotyyli muuttuu seuraavaksi luotavien taulukkojen oletustyyliksi.

2. Muuta valintaikkunan asetuksia ja napsauta sitten OK-painiketta.

Delete table and cell styles

When you delete a style, you can select a different style to replace it, and you can choose whether to preserve the formatting.

1. Valitse Tyylit-paneelista tyyli.

2. Tee jokin seuraavista:

Valitse paneelivalikosta Poista tyyli.

Napsauta paneelin alaosassa näkyvää Poista-kuvaketta  tai vedä tyyli Poista-kuvakkeeseen.

Napsauta hiiren kakkospainikkeella (Windows) tai Control-osoita (Mac OS) tyyliä ja valitse Poista tyyli. Tästä menetelmästä on hyötyä
varsinkin silloin, kun poistetaan tyyli käyttämättä sitä valitussa solussa tai taulukossa.

3. Valitse korvaava tyyli.

If you select [No Table Style] to replace a table style or [None] to replace a cell style, select Preserve Formatting to keep the formatting of
the table or cell to which the style is applied. The table or cell preserves its formatting but is no longer associated with a style.

4. Napsauta OK-painiketta.

Redefine table or cell styles based on current formatting

After you apply a style, you can override any of its settings. If you decide you like the changes, you can redefine the style to retain the new
formatting.

1. Siirrä kohdistin taulukkoon tai soluun, joka on muotoiltu uudelleenmääritettävällä tyylillä.

2. Tee taulukkoon tai soluun tarvittavat muutokset.

3. Valitse Tyylit-paneelivalikosta Määritä tyyli uudelleen.

For cell styles, changes to only those attributes that are part of the cell style will enable the Redefine Style command. For example,
if the cell style includes a red fill and you override a cell to use a blue fill, you can redefine the style based on that cell. But if you change an
attribute that is ignored in the cell style, you can’t redefine the style with that attribute.

Override table and cell styles

After you apply a table or cell style, you can override any of its settings. To override a table style, you can change options in the Table Options
dialog box. To override a cell, you can change options in the Cell Options dialog box or use other panels to change the stroke or fill. If you select a
table or cell that has an override, a plus sign (+) appears next to the style in the Styles panel.
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You can clear table and cell overrides when you apply a style. You can also clear overrides from a table or cell to which a style has already been
applied.

If a style has a plus sign (+) next to it, hover over the style to view a description of the override attributes.

Preserve or remove overrides while applying a table style

Jos haluat käyttää taulukkotyyliä, säilyttää solutyylit ja poistaa ohitukset, pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS)
painettuna napsauttaessasi Taulukkotyylit-paneelissa näkyvää tyyliä.
Jos haluat käyttää taulukkotyyliä ja poistaa solutyylit ja ohitukset, pidä Alt- ja vaihtonäppäimiä (Windows) tai optio- ja vaihtonäppäimiä
(Mac OS) painettuina napsauttaessasi Taulukkotyylit-paneelissa näkyvää tyyliä.

Right-click (Windows) or Control-click (Mac OS) the style in the Table Styles panel, and then choose Apply [table style], Clear Cell Styles to
apply a style and clear cell styles.

Remove overrides while applying a cell style

Jos haluat käyttää solutyyliä ja poistaa ohitukset, pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) painettuna napsauttaessasi
Solutyylit-paneelissa näkyvää tyyliä.

Only those attributes that are part of the cell style are considered overrides. For example, if the cell style includes a red fill and
all other attributes are ignored, changing a different cell option is not considered an override.

Clear attributes not defined by a cell style

Valitse Solutyylit-paneelin valikosta Poista määritteet, jotka eivät ole tyylin määrittämiä.

Clear table or cell overrides

1. Valitse ohitukset sisältävä taulukko tai solut.

2. Napsauta Tyylit-paneelin Poista valinnan ohitukset -kuvaketta  tai valitse Tyylit-paneelivalikosta Poista ohitukset.

Break the link to table or cell styles

When you break the link between tables or cells and the style applied to them, the tables or cells retain their current formatting. However, future
changes to that style won’t affect them.

1. Valitse solut, joissa tyyliä on käytetty.

2. Valitse Tyylit-paneelivalikosta Katkaise linkki tyyliin.

Lisää ohjeaiheita
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Taulukkojen muotoileminen
Sarakkeiden, rivien ja taulukkojen koon muuttaminen
Taulukon ylä- tai alapuolella olevan välin muuttaminen
Taulukoiden jakaminen kehysten välillä
Tekstin lisääminen taulukon edelle
Taulukon tekstin muotoileminen
Solujen yhdistäminen ja jakaminen
Ylijuoksevien solujen käsitteleminen

Taulukkojen muotoileminen
Voit muotoilla taulukon tekstin taulukon ulkopuolisen tekstin tapaan Ohjauspaneelin tai Merkki-paneelin avulla. Voit käyttää varsinaisen taulukon
muotoilemiseen myös Taulukon asetukset- ja Soluasetukset-valintaikkunoita. Näissä ikkunoissa voit muuttaa rivien ja sarakkeiden määrää, muuttaa
taulukon reunan ja täytön ulkoasua, määrittää välit taulukon ylä- ja alapuolelle, muokata ylä- ja alatunnisterivejä sekä lisätä muita muotoiluja.

Voit muotoilla taulukon rakennetta Taulukko-paneelin, Ohjauspaneelin tai pikavalikon avulla. Valitse vähintään yksi solu ja avaa pikavalikko
napsauttamalla hiiren kakkospainiketta (Windows) tai Control-osoittamalla (Mac OS).

Voit katsoa taulukoiden luomista ja muotoilua käsittelevän videon osoitteessa www.adobe.com/go/vid0081_fi.

Sarakkeiden, rivien ja taulukkojen koon muuttaminen
Voit muuttaa sarakkeiden, rivien ja taulukkojen kokoa useilla eri menetelmillä.

Rivien ja palstojen koon muuttaminen
1. Valitse soluja muotoiltavista sarakkeista tai riveistä.
2. Tee jokin seuraavista:

Määritä Taulukko-paneelissa Sarakkeen leveys- ja Rivikorkeus-asetukset.

Valitse Taulukko > Soluasetukset > Rivit ja sarakkeet, määritä Rivikorkeus- ja Sarakkeen leveys -asetukset ja napsauta sitten OK-
painiketta.

Huomautus: Jos määrität rivin vähimmäiskorkeuden Vähintään-kohdassa, rivikorkeus kasvaa lisätessäsi tekstiä tai suurentaessasi
pistekokoa. Jos määrität rivin vakiokorkeuden valitsemalla Tarkka, rivikorkeus ei muutu lisätessäsi tai poistaessasi tekstiä. Kun
rivikorkeus on vakio, solun sisältö ylittää usein solun rajat. (Lisätietoja: Ylijuoksevien solujen käsitteleminen.)

Siirrä osoitin sarakkeen tai rivin reunan päälle, jotta se muuttuu kaksipäiseksi nuoleksi (  tai ). Muuta sarakkeen leveyttä tai rivin
korkeutta vetämällä reunaa haluamaasi suuntaan.

Ennen rivien koon muuttamista ja sen jälkeen

Rivin oletuskorkeus on käytettävän kirjasimen informaatioalueen korkeus. Rivikorkeus siis muuttuu, kun koko rivin kirjasinkokoa tai
rivikorkeusasetusta muutetaan. Soluasetukset-valintaikkunan Rivit ja sarakkeet -osan Maksimi-asetus määrittää rivin enimmäiskorkeuden.

Rivien ja sarakkeiden koon muuttaminen taulukon leveyttä muuttamatta
Pidä vaihtonäppäintä painettuna ja vedä rivin tai sarakkeen sisäreunaa (ei taulukon reunaa). Yksi riveistä tai sarakkeista suurenee ja muut
pienenevät.
Voit muuttaa kaikkien rivien tai sarakkeiden kokoa samassa suhteessa pitämällä vaihtonäppäintä painettuna vetäessäsi taulukon oikeaa
reunaa tai alareunaa.

Jos painat vaihtonäppäintä ja vedät taulukon oikeaa reunaa, kaikkien sarakkeiden koko muuttuu. Jos painat vaihtonäppäintä ja vedät alareunaa,
kaikkien rivien koko muuttuu.
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Koko taulukon koon muuttaminen
 Valitse tekstityökalu  ja siirrä osoitin taulukon oikean alakulman päälle, jotta se muuttuu nuoleksi  . Suurenna tai pienennä taulukkoa

vetämällä kulmaa. Paina vaihtonäppäintä, jos haluat säilyttää taulukon korkeus- ja leveyssuhteen.
Huomautus: jos taulukko ulottuu useaan jutun kehykseen, koko taulukon kokoa ei voi muuttaa hiirellä.

Sarakkeiden ja rivien jakaminen tasan
1. Valitse soluja sarakkeista tai riveistä, joiden leveyden tai korkeuden haluat yhtenäistää.
2. Valitse Taulukko > Jaa rivit tasan tai Jaa sarakkeet tasan.

Taulukon ylä- tai alapuolella olevan välin muuttaminen
1. Siirrä kohdistin taulukkoon ja valitse Taulukko > Taulukkoasetukset > Taulukon asetukset.
2. Määritä Taulukon välit -kohdassa uudet Väli ennen- ja Väli jälkeen -arvot ja napsauta sitten OK-painiketta.

Kun muutat taulukon yläpuolella olevaa väliä, kehyksen yläreunassa olevan taulukkorivin välistys ei muutu.

Taulukoiden jakaminen kehysten välillä
Määritä Pito-asetuksilla, kuinka monen rivin pitää pysyä yhdessä, tai määritä, missä rivi katkeaa (kuten sarakkeen tai kehyksen alussa).

Kun luot taulukon, joka on kehystä pitempi, kehys ylittyy. Jos ketjutat kehyksen toiseen kehykseen, taulukko jatkuu toisessa kehyksessä. Rivit
siirtyvät ketjutettuihin kehyksiin kokonaisina. Riviä ei voi jakaa useisiin kehyksiin. Määrittämällä ylä- tai alatunnisterivit voit toistaa tietoja uudessa
kehyksessä.

1. Siirrä kohdistin riville tai valitse soluja riveiltä, jotka haluat pitää yhdessä.
2. Valitse Taulukko > Soluasetukset > Rivit ja sarakkeet.
3. Sido valitut solut yhteen valitsemalla Sido seuraava rivi.
4. Katkaise rivi määritetystä kohdasta valitsemalla Aloita rivi -valikosta asetus (kuten Seuraava kehys) ja napsauttamalla sitten OK-painiketta

Jos luot taulukon, joka ulottuu aukeaman kummallekin sivulle, sinun kannattaa ehkä lisätä taulukon keskelle tyhjä sarake sisäreunuksia varten.

Tekstin lisääminen taulukon edelle
Taulukko on ankkuroitu edelliseen ja seuraavaan kappaleeseen. Jos tekstikehyksen alkuun lisätään taulukko, kohdistinta ei voi siirtää sen
yläpuolelle napsauttamalla. Siirrä kohdistin taulukon yläpuolelle nuolinäppäimillä.

 Siirrä kohdistin ensimmäisen solun kappaleen alkuun, paina vasenta nuolinäppäintä ja aloita tekstin kirjoittaminen.

Taulukon tekstin muotoileminen
Yleensä taulukon teksti muotoillaan samalla tavoin kuin taulukon ulkopuolinen teksti.

Sarkaimien lisääminen taulukon soluun
Kun kohdistin on taulukossa, voit siirtää sen seuraavaan soluun sarkainnäppäintä painamalla. Voit lisätä sarkaimia myös taulukon soluun. Määritä
taulukon sarkainasetukset Sarkaimet-paneelissa. Sarkainasetukset vaikuttavat kohdistimen osoittamaan kappaleeseen.

1. Siirrä kohdistin tekstityökalulla  kohtaan, johon haluat lisätä sarkaimen.
2. Valitse Teksti > Lisää erikoismerkki > Muu > Sarkain.

Voit muuttaa sarkainasetuksia valitsemalla haluamasi sarakkeet tai solut ja avaamalla Sarkaimet-paneelin komennolla Teksti > Sarkaimet.

Huomautus: Kun määrität desimaalisarkaimen solulle tai soluryhmälle sarkainviivaimella, soluissa olevan tekstin tasaamiseksi ei tavallisesti
tarvitse painaa sarkainta jokaisen kappaleen alussa. Kappaleet tasataan automaattisesti desimaalimerkin mukaan, ellei kappale sisällä muita
muotoiluja (kuten tasausta keskelle), jotka kumoavat desimaalisarkaimen.

Tekstin tasauksen muuttaminen taulukon solussa
1. Valitse tekstityökalulla  solut, joita haluat muotoilla.
2. Valitse Taulukko > Soluasetukset > Teksti.
3. Valitse Pystytasaus-kohdassa tasausasetus: Tasaa ylös, Keskitä, Tasaa alas tai Kohdista pystysuunnassa.

Jos valitset Kohdista-asetuksen, määritä myös kappaleväli (suurin mahdollinen kappaleiden väliin lisättävä väli). (Lisätietoja: Tekstin
tasaaminen tai sovittaminen palstaan pystysuunnassa tekstikehyksen sisällä.)

4. Valitse Ensimmäinen peruslinja -kohdassa asetus, joka määrittää tekstin siirtymän solun yläreunasta.
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Asetukset ovat samat kuin Tekstikehyksen asetukset -valintaikkunassa. (Lisätietoja: Tekstikehyksen ominaisuuksien muuttaminen.)

5. Napsauta OK-painiketta.

Huomautus: Muuta tekstin vaakatasausta solussa Kappale-paneelin tasausasetuksella. Jos haluat tasata solun tekstin desimaalisarkaimen
mukaan, lisää desimaalisarkainasetus Sarkaimet-paneelin avulla.

Solussa olevan tekstin kiertäminen
1. Siirrä kohdistin kierrettävään soluun tai valitse solut.
2. Valitse Taulukko > Soluasetukset > Teksti tai avaa Taulukko-paneeli.
3. Määritä Kierto-asetuksen arvo ja napsauta OK-painiketta.

Solujen vieruksen leveyden muuttaminen
1. Valitse tekstityökalu  ja siirrä kohdistin haluamaasi soluun tai valitse solut, joita haluat muotoilla.
2. Valitse Taulukko > Soluasetukset > Teksti tai avaa Taulukko-paneeli.
3. Määritä Solun vierukset -kohdassa Ylä-, Ala-, Oikea- ja Vasen-arvot ja napsauta sitten OK-painiketta.

Kun solun vieruksen leveyttä muutetaan, myös rivin korkeus voi muuttua. Jos rivikorkeus on vakio, varmista, että reunukselle jää riittävästi tilaa,
jotta teksti ei ylitä reunoja.

Solujen yhdistäminen ja jakaminen
Voit yhdistää tai jakaa taulukon soluja.

Yhdistä solut
Voit yhdistää vähintään kaksi samalla rivillä tai samassa sarakkeessa olevaa solua. Voit esimerkiksi yhdistää taulukon ylimmän rivin solut
otsikkosoluksi.

1. Valitse yhdistettävät solut tekstityökalulla .
2. Valitse Taulukko > Yhdistä solut.

Kumoa solujen yhdistäminen
 Voit kumota solujen yhdistämisen siirtämällä kohdistimen yhdistettyyn soluun ja valitsemalla Taulukko > Kumoa solujen yhdistäminen.

Solujen jakaminen
Voit jakaa solut vaaka- tai pystysuunnassa. Näin tehdään usein esimerkiksi lomakkeita luotaessa. Voit valita useita soluja ja jakaa ne pysty- tai
vaakasuunnassa.

1. Siirrä kohdistin jaettavaan soluun tai valitse rivi, sarake tai soluryhmä.
2. Valitse Taulukko > Jaa solu pystysuunnassa tai Jaa solu vaakasuunnassa.

Ylijuoksevien solujen käsitteleminen
Yleensä taulukon solu kasvaa pystysuunnassa niin, että teksti ja kuvat mahtuvat siihen. Jos kuitenkin määrität riville vakiokorkeuden ja lisäät
tekstiä tai kuvan, joka ei mahdu soluun, solun oikeaan alakulmaan tulee pieni punainen piste. Se ilmaisee, että solussa on ylijuoksevaa sisältöä.

Ylijuoksevaa tekstiä ei voi jatkaa toiseen soluun. Voit muokata tai muuttaa solun sisältöä tai laajentaa solua tai tekstikehystä, jossa taulukko on.

Jos mukana on sidottua grafiikkaa tai tekstiä, jossa on kiinteät välit, solun sisältö voi ulottua solun reunojen yli. Voit valita Leikkaa sisältö soluun -
asetuksen. Silloin teksti tai sidottu kuva, joka muuten ulottuisi jonkin solun reunan yli, leikataan solun rajojen mukaan. Tämä ei kuitenkaan päde,
jos sidotut kuvat ulottuvat solun alareunan yli (vaakasuunta).

Ylijuoksevan solun sisällön näyttäminen
 Tee jokin seuraavista:

Suurenna solua.

Muuta tekstin muotoilua. Valitse ylijuoksevan solun sisältö napsauttamalla solua ja painamalla Esc-näppäintä. Muotoile sitten teksti
Ohjauspaneelin avulla.

Solussa olevan kuvan leikkaaminen
Jos kuva on liian suuri soluun, se ulottuu solun reunojen yli. Voit leikata kuvan osat, jotka ulottuvat solun reunojen yli.

1. Siirrä kohdistin leikattavaan soluun tai valitse solut.
2. Valitse Taulukko > Soluasetukset > Teksti.
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3. Valitse Leikkaa sisältö soluun ja napsauta sitten OK-painiketta.

Lisää ohjeaiheita
Taulukkojen luomista ja muotoilemista käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Taulukkojen luominen
Taulukkojen luominen
Tekstin lisääminen taulukkoon
Kuvan lisääminen taulukkoon
Taulukkojen ylä- ja alatunnisteiden lisääminen

Taulukko koostuu soluriveistä ja -sarakkeista. Solu on tekstikehys, johon voidaan lisätä tekstiä, ankkuroituja
kehyksiä tai muita taulukoita. Voit luoda taulukoita Adobe InDesign CS5:ssä tai viedä niitä muista sovelluksista.

Huomautus:

Kun haluat luoda, muokata ja muotoilla taulukoita Adobe InCopyssa, varmista, että käytössä on Sivuasettelu-
näkymä.

Taulukkojen luominen

Taulukko koostuu soluriveistä ja -sarakkeista. Solu on tekstikehys, johon voidaan lisätä tekstiä, sidottua grafiikkaa
tai muita taulukoita. Voit luoda taulukkoja alusta asti tai muuntaa tekstiä taulukoiksi. Voit myös upottaa taulukon
toiseen taulukkoon.

Kun luot taulukon, uusi taulukko täyttää tekstikehyksen leveyden. Taulukko lisätään samalle riville, jos kohdistin on
rivin alussa, tai seuraavalle riville, jos kohdistin on rivin keskellä.

Taulukot juoksutetaan ympäröivän tekstin kanssa samoin kuin sidottu grafiikka. Taulukko esimerkiksi siirtyy
ketjutettujen kehysten läpi, kun sen edellä olevan tekstin pistekokoa muutetaan ja kun tekstiä lisätään tai
poistetaan. Reittitekstejä sisältävässä kehyksessä ei voi olla taulukkoa.

Michael Murphy on kirjoittanut taulukoiden luomista ja muotoilua käsittelevän jutun. Se löytyy osoitteesta Taulukot
ojennukseen.

InfiniteSkills.comin Jeff Witchell pitää videoesittelyn aiheesta Taulukkojen määrittämisen perusteet.

Taulukon luominen alusta asti

Kun luot taulukon InDesignissa, voit luoda taulukon olemassa olevaan tekstikehykseen (Lisää taulukko -toiminnon
käyttäminen). Voit myös luoda taulukon ja antaa InDesignin luoda ympäröivä tekstikehys (Luo taulukko -toiminnon
käyttäminen).

Lisää taulukko -toiminnon käyttäminen

1. Jos haluat piirtää taulukon olemassa olevaan tekstikehykseen, siirrä kohdistin tekstityökalulla kohtaan,
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johon haluat lisätä taulukon.

2. Valitse Taulukko > Lisää taulukko.

Huomautus:

Jos kohdistin ei ole tekstikehyksessä, voit käyttää Luo taulukko -toimintoa.

3. Määritä rivien ja sarakkeiden määrä.
4. Jos taulukko ulottuu usean palstan tai kehyksen alueelle, määritä, kuinka monessa ylä- tai alatunnisterivissä

tiedot toistuvat.
5. (Valinnainen) Määritä taulukkotyyli.
6. Napsauta OK-painiketta.

Uusi taulukko täyttää tekstikehyksen leveyden.

Luo taulukko -toiminnon käyttäminen

Kun luot taulukon Luo taulukko -toiminnolla, sinun ei ensin tarvitse luoda tekstikehystä julkaisuun. Kun olet
piirtänyt taulukon julkaisuun, InDesign luo piirtämäsi taulukon kokoisen tekstikehyksen.

1. Valitse Taulukko > Luo taulukko.

Huomautus:

Jos kohdistin on tekstikehyksessä, voit käyttää Lisää taulukko -asetusta.

2. Määritä rivien ja sarakkeiden määrä.
3. Jos taulukko ulottuu usean palstan tai kehyksen alueelle, määritä, kuinka monessa ylä- tai alatunnisterivissä

tiedot toistuvat.
4. (Valinnainen) Määritä taulukkotyyli.
5. Napsauta OK-painiketta.

6. Piirrä haluamasi taulukko Taulukko-kohdistimella.

InDesign luo piirretyn alueen kokoisen tekstikehyksen ja lisää taulukon tekstikehyksen sisälle.

Taulukon rivikorkeus vaihtelee valitun taulukkotyylin mukaan. Taulukkotyyli voi käyttää esimerkiksi solutyylejä
taulukon eri osien muotoilemiseen. Jos jokin solutyyleistä sisältää kappaletyylejä, niiden rivivälistysarvo vaikuttaa
kyseisen alueen rivikorkeuteen. Ellei kappaletyylejä käytetä, julkaisun oletusinformaatioalue määrittää
rivikorkeuden. (Informaatioalue perustuu rivivälistysarvoon. Tässä yhteydessä informaatioalue on korostuksen
summittainen korkeus valitussa tekstissä.)

Taulukon luominen tekstistä

Varmista ennen tekstin muuntamista taulukoksi, että teksti on muotoiltu oikein.

1. Valmistele teksti muuntamista varten lisäämällä sarkaimet, pilkut, kappalemerkit tai muut merkit sarakkeiden
erottimiksi. Lisää sarkaimet, pilkut, kappalemerkit tai muut merkit rivien erottimiksi. (Useissa tapauksissa
teksti voidaan muuttaa taulukoksi sellaisenaan.)

2. Valitse taulukoksi muunnettava teksti tekstityökalulla.
3. Valitse Taulukko > Muunna teksti taulukoksi.
4. Määritä Sarake-erotin- ja Rivierotin-kohdissa, mistä uusien rivien ja sarakkeiden pitää alkaa. Valitse Sarkain,

Pilkku tai Kappale tai kirjoita Sarake-erotin- ja Rivierotin-ruutuihin haluamasi merkit, kuten puolipiste (;).
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(Kirjoittamasi merkit näkyvät valikossa seuraavalla kerralla, kun luot taulukon tekstistä.)
5. Jos valitset saman erotinmerkin sarakkeille ja riveille, määritä taulukon sarakkeiden määrä.
6. (Valinnainen) Valitse taulukkotyyli, jolla taulukko muotoillaan.
7. Napsauta OK-painiketta.

Jos jollakin rivillä on vähemmän osia kuin taulukossa on sarakkeita, rivi täytetään tyhjillä soluilla.

Taulukon upottaminen toiseen taulukkoon

1. Tee jokin seuraavista:

Valitse upotettavat solut tai taulukko ja valitse sitten Muokkaa > Leikkaa tai Kopioi. Siirrä kohdistin
soluun, johon haluat lisätä taulukon, ja valitse Muokkaa > Liitä.

Napsauta solun sisäpuolta, valitse Taulukko > Lisää taulukko, määritä rivien ja sarakkeiden määrä ja
napsauta lopuksi OK-painiketta.

2. Säädä tarvittaessa solun sisennystä. (Katso Taulukon tekstin muotoileminen .)

Kun luot solun sisään taulukon, et voi valita solun rajat ylittävää taulukon osaa hiirellä. Laajenna sen sijaan rivi tai
sarake tai aseta kohdistin taulukon ensimmäiseen osaan ja siirrä kohdistinta ja valitse tekstiä pikanäppäimillä.

Taulukkojen tuominen muista sovelluksista

Kun tuot Sijoita-komennolla Microsoft Word -asiakirjan, joka sisältää taulukkoja, tai Microsoft Excel -
laskentataulukon, tuodut tiedot sijoittuvat muokattavaan taulukkoon. Voit ohjata taulukon muotoilemista
Tuontiasetukset-valintaikkunan toiminnoilla.

Voit myös kopioida tiedot Excel-laskentataulukosta tai Word-taulukosta ja liittää ne InDesign- tai InCopy-julkaisuun.
Leikepöydän käsittely -oletusarvot määrittävät, miten toisesta sovelluksessa liitetty teksti muotoillaan. Jos Vain
teksti -asetus on valittu, tiedot näkyvät muotoilemattomana, sarkainmerkein eroteltuna tekstinä, joka voidaan sitten
muuntaa taulukoksi. Jos Kaikki tiedot -asetus on valittu, liitetty teksti näkyy muotoiltuna taulukkona.

Jos liität tekstin toisesta sovelluksesta valmiiseen taulukkoon, lisää tarpeeksi monta riviä ja saraketta liitettävää
tekstiä varten, valitse Leikepöydän käsittely -oletusarvoissa Vain teksti -asetus ja varmista, että vähintään yksi solu
on valittu (ellet halua upottaa liitettyä taulukkoa soluun).

Jos haluat ohjata tuodun taulukon muotoilua tarkemmin, tai jos haluat säilyttää laskentataulukon muotoiluun, tuo
taulukko Sijoita-komennolla. Jos haluat säilyttää linkin laskentataulukkoon, valitse Luo linkit tekstiä ja
taulukkolaskentatiedostoja sijoitettaessa -asetus Tiedoston käsittelyasetuksista.

Voit myös kopioida ja liittää sarkaintekstiä valituista taulukon soluista. Näin voit kätevästi korvata sisällön mutta
säilyttää muotoilut. Esimerkki: Sinun on päivitettävä kuukausittain julkaistavan lehden muotoilutaulukko. Voit
linkittää julkaisuun Excel-laskentataulukon. Jos sisältö kuitenkin on peräisin toisesta lähteestä, voit kopioida uuden
sisällön sisältävän sarkaintekstin, valita muotoillusta InDesign-taulukosta korvattavat solut ja liittää sisällön soluihin.

Tekstin lisääminen taulukkoon

Voit lisätä taulukon soluihin tekstiä, ankkuroituja objekteja, XML-nimiöitä ja muita taulukoita. Jos et ole määrittänyt
rivin vakiokorkeutta, taulukon rivikorkeus kasvaa, kun tekstiä lisätään. Et voi lisätä alaviitteitä taulukkoihin.
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Valitse tekstityökalu  ja tee jokin seuraavista:

Siirrä kohdistin soluun ja kirjoita teksti. Luo uusi kappale samaan soluun painamalla Enter- tai
Return-näppäintä. Voit siirtyä soluissa eteenpäin sarkainnäppäimellä (sarkainnäppäimen painaminen
viimeisessä solussa lisää uuden rivin). Voit siirtyä soluissa taaksepäin painamalla vaihto- ja
sarkainnäppäimiä.

Leikkaa tai kopioi tekstiä, siirrä kohdistin soluun ja valitse Muokkaa > Liitä.

Siirrä lisäyskohta soluun, johon haluat lisätä tekstiä, valitse Tiedosto > Sijoita ja kaksoisnapsauta
tekstitiedostoa.

Kuvan lisääminen taulukkoon

Tee jokin seuraavista toimista:

Siirrä kohdistin haluamaasi paikkaan, valitse Tiedosto > Sijoita ja kaksoisnapsauta grafiikkatiedostoa.

Siirrä kohdistin haluamaasi paikkaan, valitse Objekti > Ankkuroitu objekti > Lisää ja määritä sitten
asetukset. Voit myöhemmin lisätä kuvan ankkuroituun objektiin.

Kopioi kuva tai kehys, aseta kohdistin ja valitse sitten Muokkaa > Liitä.

Kun lisäät taulukkoon solua suuremman kuvan, solun korkeus kasvaa, mutta leveys ei. Kuva voi ulottua solun
oikean reunan yli. Jos rivikorkeus on vakio, sitä korkeampi kuva tekee solusta ylijuoksevan.

Jos haluat välttää ylijuoksevat solut, lisää kuva ensin taulukon ulkopuolelle, muuta sen kokoa ja liitä se taulukon
soluun.

Taulukkojen ylä- ja alatunnisteiden lisääminen

Kun luot pitkän taulukon, se voi ulottua usean sarakkeen, kehyksen tai sivun alueelle. Ylä- ja alatunnisterivien
avulla voit toistaa haluamasi tiedot kunkin erillisen taulukon osan ylä- ja alareunassa.

Voit lisätä ylä- ja alatunnisterivit luodessasi taulukon. Voit myös lisätä ylä- ja alatunnisterivejä ja muuttaa niiden
ulkoasua Taulukon asetukset -valintaikkunan avulla. Voit muuntaa leipätekstirivejä ylä- tai alatunnisteriveiksi.

Otsikkorivit toistuvat kehyksessä kerran

Lisäämällä muuttujan taulukon ylä- tai alatunnisteeseen voit numeroida taulukot järjestyksessä, esimerkiksi
Taulukko 1A ja Taulukko 1B. (Katso Jatkuvien kuvatekstien luominen kuville ja taulukoille.)

Rivien muuntaminen ylä- tai alatunnisteriveiksi

1. Valitse taulukon yläreunasta rivit, jotka haluat muuntaa ylätunnisteeksi, tai taulukon alareunasta rivit, jotka
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haluat muuntaa alatunnisteeksi.
2. Valitse Taulukko > Muunna rivit > Ylätunnisteeksi tai Alatunnisteeksi.

Ylä- tai alatunnisterivin asetusten muuttaminen

1. Siirrä kohdistin taulukkoon ja valitse Taulukko > Taulukkoasetukset > Ylä- ja alatunnisteet.
2. Määritä ylä- ja alatunnisterivien määrä. Taulukon ylä- ja alareunaan voi lisätä tyhjiä rivejä.
3. Määritä, näkyvätkö ylä- ja alatunnisteen tiedot jokaisessa tekstipalstassa (jos tekstikehyksissä on useita

palstoja), kerran jokaisessa kehyksessä vai kerran jokaisella sivulla.
4. Valitse Ohita ensimmäinen -valintaruutu, jos et halua ylätunnistetietojen näkyvän taulukon ensimmäisellä

rivillä. Valitse Ohita viimeinen -valintaruutu, jos et halua alatunnistetietojen näkyvän taulukon viimeisellä
rivillä.

Ohita ensimmäinen -asetus on erityisen näppärä, jos haluat ilmaista ylä- tai alatunnisteen jatkuvan
edelliseltä sivulta. Esimerkiksi jos taulukkosi kattaa useita sivuja, haluat ehkä luoda ylätunnisteeseen tekstin
"Taulukko 2 (Jatkuu)". Koska et tietenkään halua "(Jatkuu)" -tekstin näkyvän taulukon alussa, valitse Ohita
ensimmäinen ja kirjoita vain Taulukko 2 taulukon ensimmäiselle riville.

5. Napsauta OK-painiketta.

Rivien ja sarakkeiden käyttäminen

Voit luoda samanlaisia rivejä ja sarakkeita tai monistaa ne eri toiminnoilla. 

Ensisijaisesti voit suorittaa taulukon riveille ja sarakkeille seuraavat toiminnot:

vetää ja pudottaa taulukon rivejä ja sarakkeita samassa taulukossa yhdestä paikasta toiseen paikkaan
monistaa rivejä ja sarakkeita
liittää rivit ja sarakkeet ennen toista riviä/saraketta tai sen jälkeen
kopioida rivin sisällön sarakkeeseen tai sarakkeen sisällön riville.

Rivien/sarakkeiden vetäminen ja pudottaminen sekä monistaminen

Voit siirtää taulukon rivejä ja sarakkeita samassa taulukossa yhdestä paikasta toiseen paikkaan. Vedä ja pudota
sekä monista rivit/sarakkeet toimimalla näiden ohjeiden mukaan.

1. Valitse rivi tai sarake, jonka haluat vetää ja pudottaa toiselle riville tai toiseen sarakkeeseen. Varmista, että
koko sarake tai rivi on valittu. Osittain valittuja rivejä tai sarakkeita ei voi vetää ja pudottaa.

2. Siirry valittujen rivien päälle, niin näyttöön tulee kohdistin, joka osoittaa, että valintaa voidaan siirtää.

3. Kohderiviä voidaan siirtää vetämällä ja pudottamalla. Voit vaihtaa sarakkeet ja rivit keskenään. Vedetty rivi
voidaan pudottaa vain rivinä ja vedetty sarake voidaan pudottaa vain sarakkeena.

Rivien ja sarakkeiden vetäminen ja pudottaminen

Kun rivi siirretään yhdestä paikasta toiseen paikkaan, rivien kokonaismäärä pysyy samana eli kolmena.
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Huomautus:

Vetäminen ja pudottaminen on mahdollista vain samassa taulukossa.

4. Jos haluat monistaa rivin tai sarakkeen, pidä sitten Alt- (Windows) tai optio-näppäintä (Mac OS) rivin tai
sarakkeen valitsemisen jälkeen painettuna. Voit vetää ja pudottaa useita peräkkäin valittuja rivejä tai
sarakkeita.

5. Vedä ja pudota valittu rivi tai sarake haluttuun paikkaan. Rivien tai sarakkeiden kokonaismäärä kasvaa, sillä
valittu kohde on monistettu.

Voit myös kopioida ylä- ja alatunnisterivien sisällön leipätekstiriveiksi (painamalla Alt/Optio-näppäintä).
Leipätekstirivejä voidaan samalla tavalla myös monistaa ja muuntaa ylä- ja alatunnisteriveiksi.

Voit vetää ja pudottaa ylätunnisterivejä vain ylätunnisteosassa (vain silloin, jos ylätunnisterivejä on useita), paitsi
jos rivien monistamiseen käytetään Alt- tai optio-näppäintä. Leipätekstirivejä ei voi vetää ja pudottaa
ylätunnisteosaan, paitsi jos rivien monistamiseen käytetään Alt- tai optio-näppäintä.

Rivien/sarakkeiden kopioiminen ja liittäminen eteen/perään

Voit kopioida ja liittää rivit valitun rivin eteen tai sen perään. Liitä ennen seuraavaa / Liitä seuraavan jälkeen -
työnkulun avulla voit kopioida rivejä/sarakkeita taulukosta ja liittää ne myös toiseen taulukkoon.

1. Valitse rivi/sarake.

2. Valitse sarake tai rivi.

3. Valitse Taulukko > Liitä ennen seuraavaa / Liitä seuraavan jälkeen. 

Ylä- tai alatunnisterivien poistaminen

Tee jokin seuraavista toimista:

Siirrä kohdistin ylä- tai alatunnisteriville ja valitse Taulukko > Muunna rivit > Leipätekstiksi.

Valitse Taulukko > Taulukkoasetukset > Ylä- ja alatunnisteet ja muuta ylä- tai alatunnisterivien
määrää.

Lisää ohjeaiheita

Taulukkojen muotoileminen
Tekstin sijoittaminen (tuominen)
Sarakkeiden, rivien ja taulukkojen koon muuttaminen
Ylijuoksevien solujen käsitteleminen
Kohteiden nimiöiminen
Taulukoiden jakaminen kehysten välillä
Muuttujien luominen juokseville ylä- ja alatunnisteille

  Creative Commons -lisenssien ehdot eivät koske Twitter™- ja Facebook-viestejä.
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Taulukkojen valitseminen ja muokkaaminen

Alkuun

Taulukon solujen, rivien ja sarakkeiden valitseminen
Rivien ja sarakkeiden lisääminen
Rivien, sarakkeiden tai taulukkojen poistaminen
Kehyksessä olevan taulukon tasauksen muuttaminen
Siirtyminen taulukossa
Taulukon sisällön leikkaaminen, kopioiminen ja liittäminen
Taulukon siirtäminen tai kopioiminen
Taulukkojen muuntaminen tekstiksi
Taulukkojen yhdistäminen
Taulukoiden käyttäminen juttueditorissa

Taulukon solujen, rivien ja sarakkeiden valitseminen
Kun valitset solun tekstin tai osan siitä, valinta näyttää samalta kuin taulukon ulkopuolelta valittu teksti. Jos valinta ulottuu toiseen soluun, solut ja
niiden koko sisältö valitaan.

Jos taulukko ulottuu usean kehyksen alueelle, näkyviin tulee lukkokuvake, kun hiiriosoitinta pidetään ensimmäistä seuraavien ylä- tai
alatunnisterivien päällä. Se osoittaa, että kyseisen rivin tekstiä tai soluja ei voi valita. Jos haluat valita ylä- tai alatunnisterivin soluja, siirry taulukon
alkuun.

Solujen valitseminen
 Valitse tekstityökalu  ja tee jokin seuraavista:

Voit valita yhden solun napsauttamalla solun sisäpuolta tai valitsemalla tekstin. Valitse sitten Taulukko > Valitse > Solu.

Voit valita useita soluja vetämällä hiiriosoittimen solun rajan yli. Älä vedä sarakkeen tai rivin viivaa, koska silloin taulukon koko muuttuu.

Voit vuorotella solun kaiken tekstin valitsemisen ja solun valitsemisen välillä painamalla Esc-näppäintä.

Kokonaisten sarakkeiden tai rivien valitseminen
 Valitse tekstityökalu  ja tee jokin seuraavista:

Napsauta solun sisäpuolta tai valitse teksti. Valitse sitten Taulukko > Valitse > Sarake tai Rivi.

Siirrä osoitin sarakkeen yläreunan tai vasemman reunan päälle, jotta se muuttuu nuoleksi (  tai ). Valitse sitten koko sarake tai rivi
napsauttamalla.

Ennen rivin valitsemista ja sen jälkeen

Kaikkien leipätekstirivien tai ala- tai ylätunnisterivien valitseminen
1. Napsauta taulukon sisäpuolta tai valitse tekstiä.
2. Valitse Taulukko > Valitse > Ylätunnisterivit, Leipätekstirivit tai Alatunnisterivit.

Koko taulukon valitseminen
 Valitse tekstityökalu  ja tee jokin seuraavista:

Napsauta taulukon sisäpuolta tai valitse tekstiä. Valitse sitten Taulukko > Valitse > Taulukko.

Siirrä osoitin taulukon vasemman yläkulman päälle, jotta se muuttuu nuoleksi . Valitse koko taulukko napsauttamalla.
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Ennen taulukon valitsemista ja sen jälkeen

Vedä tekstityökalu koko taulukon poikki.

Voit valita taulukon myös sidotun kuvan tapaan. Siirrä kohdistin heti taulukon edelle tai jälkeen. Valitse taulukko pitämällä vaihtonäppäintä
painettuna ja painamalla vasenta tai oikeaa nuolinäppäintä.

Rivien ja sarakkeiden lisääminen
Voit lisätä rivejä ja sarakkeita useilla eri menetelmillä.

Rivin lisääminen
1. Sijoita kohdistin sen kohdan ylä- tai alapuolelle, johon haluat lisätä rivin.
2. Valitse Taulukko > Lisää > Rivi.
3. Määritä rivien määrä.
4. Valitse, lisätäänkö rivi tai rivit nykyisen rivin ylä- vai alapuolelle, ja napsauta sitten OK-painiketta.

Uudet solut muotoillaan samalla tavoin kuin teksti kohdistimen osoittamalla rivillä.

Voit luoda uuden rivin myös painamalla sarkainta, kun kohdistin on viimeisessä solussa.

Sarakkeen lisääminen
1. Sijoita kohdistin sarakkeeseen, jonka viereen haluat lisätä uuden sarakkeen.
2. Valitse Taulukko > Lisää > Sarake.
3. Määritä sarakkeiden määrä.
4. Valitse, lisätäänkö sarake tai sarakkeet nykyisen sarakkeen edelle vai jälkeen, ja napsauta sitten OK-painiketta.

Uudet solut muotoillaan samalla tavoin kuin teksti kohdistimen osoittamassa sarakkeessa.

Useiden rivien tai sarakkeiden lisääminen
1. Valitse Taulukko > Taulukkoasetukset > Taulukon asetukset, kun kohdistin on solussa.
2. Määritä uusi rivien ja sarakkeiden määrä ja napsauta sitten OK-painiketta.

Uudet rivit lisätään taulukon loppuun ja uudet sarakkeet taulukon oikealle puolelle.

Voit muuttaa rivien ja sarakkeiden määrää myös Taulukko-paneelissa. Saat Taulukko-paneelin näkyviin valitsemalla Ikkuna > Teksti ja
taulukot > Taulukko.

Rivin tai sarakkeen lisääminen vetämällä
Jos vedät hiirtä yli 1 1/2 kertaa sarakkeen leveyden verran, ohjelma lisää taulukkoon sarakkeita, jotka ovat samanlevyisiä kuin alkuperäinen
sarake. Jos lisäät vain yhden sarakkeen, se voi olla kapeampi tai leveämpi kuin alkuperäinen sarake. Rivit toimivat samoin, jos vedettävän rivin
Rivikorkeus-arvoksi ei ole määritetty Vähintään. Jos näin kuitenkin on ja haluat luoda vain yhden rivin, InDesign muuttaa tarvittaessa seuraavan
rivin kokoa, jotta siihen mahtuu tekstiä.

1. Siirrä tekstityökalu  sarakkeen tai rivin reunan päälle. jotta se muuttuu kaksipäiseksi nuoleksi (  tai ).
2. Paina hiiren painiketta, pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) painettuna ja luo uusi rivi vetämällä alaspäin tai uusi

sarake vetämällä oikealle. (Jos painat ensin Alt- tai optionäppäintä ja vasta sitten hiiren painiketta, käsityökalu tulee näkyviin. Muista aloittaa
hiirellä vetäminen, ennen kuin painat Alt- tai optionäppäintä.)

Huomautus: Rivejä tai sarakkeita ei voi lisätä vetämällä taulukon yläreunaa tai vasenta reunaa. Näitä kohtia käytetään rivien tai sarakkeiden
valitsemiseen.

Rivien, sarakkeiden tai taulukkojen poistaminen
Voit poistaa rivin, sarakkeen tai taulukon siirtämällä kohdistimen taulukkoon tai valitsemalla tekstin taulukosta ja valitsemalla sitten Taulukko >
Poista > Rivi, Sarake tai Taulukko.
Voit poistaa rivejä tai sarakkeita Taulukkoasetukset-valintaikkunassa valitsemalla Taulukko > Taulukkoasetukset > Taulukon määrittely.
Määritä uusi rivien ja sarakkeiden määrä ja napsauta sitten OK-painiketta. Rivit poistetaan taulukon alareunasta ja sarakkeet taulukon
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oikeasta reunasta.
Jos haluat poistaa rivin tai sarakkeen hiirellä, siirrä osoitin taulukon alareunan tai oikean reunan päälle, jotta se muuttuu kaksipäiseksi
nuoleksi (  tai ). Paina hiiren painiketta, pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) painettuna ja poista rivejä vetämällä
ylöspäin tai sarakkeita vetämällä vasemmalle.
Huomautus: Jos painat ensin Alt- tai optionäppäintä ja sitten hiiren painiketta, käsityökalu tulee näkyviin. Muista aloittaa hiirellä vetäminen,
ennen kuin painat Alt- tai optionäppäintä.
Voit poistaa solujen sisällön itse soluja poistamatta valitsemalla solut, joiden tekstin haluat poistaa, tai valitsemalla soluissa olevan tekstin
tekstityökalulla . Paina askelpalautinta tai Delete-näppäintä tai valitse Muokkaa > Tyhjennä.

Kehyksessä olevan taulukon tasauksen muuttaminen
Taulukko noudattaa sen kappaleen tai taulukon solun leveyttä, jonka sisään se luodaan. Tekstikehyksen tai solun leveyttä voi kuitenkin muuttaa
niin, että taulukosta tulee kehystä leveämpi tai kapeampi. Tällöin voidaan päättää, tasataanko taulukko kehykseen.

1. Siirrä kohdistin taulukon oikealle tai vasemmalle puolelle. Varmista, että tekstikohdistin on taulukkokappaleessa eikä taulukon sisällä.
Kohdistimesta tulee kehyksessä olevan taulukon korkuinen.

2. Napsauta Kappale-paneelin tai Ohjauspaneelin tasauspainiketta (esimerkiksi Keskitä).

Siirtyminen taulukossa
Voit siirtyä taulukossa sarkain- tai nuolinäppäimillä. Voit myös siirtyä suoraan tietylle riville; tästä on hyötyä varsinkin pitkissä taulukoissa.

Siirtyminen taulukossa sarkainnäppäimellä
Siirry seuraavaan soluun painamalla sarkainnäppäintä. Jos painat sarkainta taulukon viimeisessä solussa, taulukkoon tulee uusi rivi.
Lisätietoja sarkaimien ja sisennysten lisäämisestä taulukkoon on kohdassa Taulukon tekstin muotoileminen.
Siirry edelliseen soluun painamalla vaihto- ja sarkainnäppäimiä. Jos teet näin taulukon ensimmäisessä solussa, kohdistin siirtyy viimeiseen
soluun.

Siirtyminen taulukossa nuolinäppäimillä
 Siirry taulukon soluissa ja niiden välillä nuolinäppäimillä. Jos kohdistin on rivin viimeisen solun lopussa ja painat oikeaa nuolinäppäintä, kohdistin

siirtyy saman rivin ensimmäisen solun alkuun. Jos kohdistin on sarakkeen viimeisen solun lopussa ja painat alanuolta, kohdistin siirtyy saman
sarakkeen ensimmäisen solun alkuun.

Siirtyminen taulukon tietylle riville
1. Valitse Taulukko > Siirry riville.
2. Tee jokin seuraavista toimista:

Määritä rivin numero ja napsauta OK-painiketta.

Jos taulukkoon on määritetty ylä- tai alatunnisterivi, valitse valikosta Ylätunniste tai Alatunniste ja napsauta sitten OK-painiketta.

Taulukon sisällön leikkaaminen, kopioiminen ja liittäminen
Solusta valittua tekstiä voi leikata, kopioida ja liittää aivan kuten taulukon ulkopuolelta valittua tekstiä. Soluja voidaan myös leikata, kopioida ja
liittää sisältöineen. Jos kohdistin on taulukossa, kun liitetään useita soluja, syntyy taulukon sisäinen taulukko. Myös koko taulukko on mahdollista
siirtää tai kopioida.

1. Valitse kopioitavat solut ja sitten Muokkaa > Leikkaa tai Kopioi.
2. Tee jokin seuraavista toimista:

Upota taulukko siirtämällä kohdistin soluun ja valitsemalla Muokkaa > Liitä.

Korvaa solut valitsemalla solu tai soluja taulukosta (niiden alapuolella ja oikealla puolella pitää olla riittävästi soluja) ja valitsemalla sitten
Muokkaa > Liitä.

Taulukon siirtäminen tai kopioiminen
1. Valitse koko taulukko siirtämällä kohdistin taulukkoon ja valitsemalla Taulukko > Valitse > Taulukko.
2. Valitse Muokkaa > Leikkaa tai Kopioi, siirrä kohdistin paikkaan, johon haluat liittää taulukon, ja valitse Muokkaa > Liitä.

Taulukkojen muuntaminen tekstiksi
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1. Siirrä kohdistin taulukon sisään tekstityökalulla  tai valitse haluamasi teksti taulukosta.
2. Valitse Taulukko > Muunna taulukko tekstiksi.
3. Määritä Sarake-erotin- ja Rivierotin-kohtiin haluamasi erotinmerkit.

Sarakkeiden ja rivien erottimina kannattaa käyttää eri merkkejä, esimerkiksi sarkainmerkkiä sarake-erottimena ja kappalemerkkiä
rivierottimena.

4. Napsauta OK-painiketta.

Kun muunnat taulukon tekstiksi, ohjelma poistaa taulukon viivat ja lisää määrittämäsi erotinmerkin kunkin rivin ja sarakkeen loppuun.

Taulukkojen yhdistäminen
Liitä-komennolla voidaan yhdistää kaksi tai useampia taulukkoja yhteen taulukkoon.

1. Lisää kohdetaulukkoon niin monta tyhjää riviä kuin aiot liittää muista taulukoista. (Jos lisäät vähemmän riviä kuin kopioit, liittäminen ei
onnistu.)

2. Valitse kopioitavat solut lähdetaulukosta. (Jos kopioit enemmän sarakesoluja kuin kohdetaulukossa on, liittäminen ei onnistu.)
3. Valitse vähintään yksi solu, johon haluat lisätä kopioidut rivit, ja valitse sitten Muokkaa > Liitä.

Jos liitetyt rivit on muotoiltu eri tavalla kuin taulukon muut osat, määritä yksi tai useampia solutyylejä ja käytä sitten solutyylejä liitetyissä
soluissa. Pidä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) painettuna solutyyliä napsauttaessasi, jos haluat korvata nykyisen
muotoilun.

Anne-Marie Concepcion on kirjoittanut jutun taulukkojen yhdistämisestä. Se on osoitteessa Taulukkojen yhdistäminen.

Taulukoiden käyttäminen juttueditorissa
Kun valitset Muokkaa > Muokkaa juttueditorissa, taulukot ja niiden sisältö näkyvät juttueditorissa. Voit muokata taulukoita myös juttueditorissa.

Taulukoiden muokkaaminen juttueditorissa
A. Taulukko-kuvake C. Ylijuokseva grafiikka

Laajenna tai kutista juttueditorissa napsauttamalla taulukon yläosassa olevan taulukkokuvakkeen vasemmalla puolella olevaa
kolmiokuvaketta.

Määritä, lajitellaanko taulukko rivien vai sarakkeiden mukaan kaksoisnapsauttamalla (Windows) tai kaksoisosottamalla (Mac OS)
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taulukkokuvaketta ja valitsemalla Järjestä rivien mukaan tai Järjestä sarakkeiden mukaan.

Muokkaa ja muotoile taulukkoa sivuasettelunäkymässä. Et voi valita sarakkeita tai rivejä juttueditorissa.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Taulukkojen täytöt ja viivat
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Tietoja taulukkojen täytöistä ja viivoista
Taulukon reunan muuttaminen
Viivan ja täytön lisääminen soluihin
Lävistäjäviivojen lisääminen soluihin
Taulukon viiva- ja täyttöasetukset
Taulukon viivojen ja täyttöjen vaihteleminen

Tietoja taulukkojen täytöistä ja viivoista
Voit lisätä taulukkoihin viivoja ja täyttöjä usealla tavalla. Muokkaa taulukon reunaviivaa ja lisää sarakkeisiin ja riveihin vuorottelevia täyttöjä ja viivoja
Taulukon asetukset -valintaikkunassa. Yksittäisten solujen täyttöjä ja viivoja voi muuttaa Soluasetukset-valintaikkunassa tai Värimallit-, Viiva- ja
Väri-paneeleissa.

Normaalisti Taulukon asetukset -valintaikkunan asetukset ohittavat kaikki taulukon soluissa aiemmin valitut vastaavat muotoilut. Jos valitset
Taulukon asetukset -valintaikkunassa Säilytä paikallinen muotoilu -asetuksen, yksittäisten solujen täyttö- ja viiva-asetuksia ei ohiteta.

Jos tarvitset usein samaa muotoilua taulukoissa tai soluissa, luo ja käytä taulukko- tai solutyylejä.

Taulukon reunan muuttaminen
Voit muuttaa taulukon reunaa Taulukon asetukset -valintaikkunassa tai Viiva-paneelissa.

1. Valitse Taulukko > Taulukkoasetukset > Taulukon asetukset, kun kohdistin on solussa.
2. Määritä Taulukon raja -kohdassa haluamasi paksuus-, tyyppi-, väri-, sävy- ja väliasetukset. (Lisätietoja: Taulukon viiva- ja täyttöasetukset.)
3. Valitse piirtojärjestys seuraavista vaihtoehdoista Viivojen piirtojärjestys -kohdassa:

Parhaat liitokset Kun tämä vaihtoehto on valittu, rivien viivat näkyvät etummaisina eriväristen viivojen risteämiskohdissa. Kun esimerkiksi
kaksoisviivojen kaltaiset viivat risteävät, viivat liitetään ja risteämiskohdat yhdistetään.

Riviviivat edessä Kun tämä vaihtoehto on valittu, riviviivat näkyvät edessä.

Sarakeviivat edessä Kun tämä vaihtoehto on valittu, sarakeviivat näkyvät edessä.

InDesign 2.0 -yhteensopivuus Kun tämä vaihtoehto on valittu, riviviivat näkyvät edessä. Kun esimerkiksi kaksoisviivojen kaltaiset viivat
risteävät, ne liitetään ja risteämiskohdat yhdistetään vain kohdissa, joissa viivat risteävät T-muodossa.

4. Jos et halua, että yksittäisten solujen viiva-asetukset ohitetaan, valitse Säilytä paikallinen muotoilu.
5. Napsauta OK-painiketta.

Jos poistat taulukon viivan ja täytön, saat taulukon solujen rajat näkyviin valitsemalla Näytä > Ekstrat > Näytä kehyksen reunat.

Viivan ja täytön lisääminen soluihin
Voit lisätä soluihin viivan ja täytön käyttämällä Soluasetukset-valintaikkunaa, Viiva-paneelia tai Värimallit-paneelia.

Viivan ja täytön lisääminen käyttämällä Soluasetukset-valintaikkunaa
Voit määrittää, mitkä solujen reunat muotoillaan viivan tai täytön avulla, valitsemalla viivoja tai poistamalla niiden valinnan Esikatselu-ruudussa. Jos
haluat muuttaa kaikkien taulukon rivien tai sarakkeiden ulkoasun, käytä vuorottelevaa viiva- tai täyttökuviota, jossa toisen kuvion arvoksi on
määritetty 0.

1. Valitse tekstityökalu  ja siirrä kohdistin haluamaasi soluun tai valitse solut, joihin haluat lisätä viivan tai täytön. Jos haluat lisätä viivan tai
täytön ylä- tai alatunnisteriveille, valitse ylä- tai alatunnistesolut taulukon alusta.

2. Valitse Taulukko > Soluasetukset > Viivat ja täytöt.
3. Valitse sijaiskuvan esikatselualueelta viivat, joihin muutokset vaikuttavat. Jos esimerkiksi haluat lisätä paksut viivat valittujen solujen

ulkoreunoihin mutta et sisäreunoihin, poista sisäviivan valinta napsauttamalla sitä. (Valitut viivat ovat sinisiä, valitsemattomat harmaita.)
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Valitse sijaiskuvan esikatselualueelta haluamasi viivat.

Valitse koko ulompi valintasuorakulmio kaksoisnapsauttamalla ulkoviivaa sijaiskuvan esikatselualueella. Valitse sisäviivat
kaksoisnapsauttamalla jotakin niistä. Valitse kaikki viivat tai kumoa niiden valinta kolmoisnapsauttamalla sijaiskuvaa.

4. Määritä Solun viiva -kohdassa haluamasi paksuus-, tyyppi-, väri-, sävy- ja väliasetukset. (Lisätietoja: Taulukon viiva- ja täyttöasetukset.)
5. Määritä Solun täyttö -kohdassa haluamasi väri- ja sävyasetukset.
6. Valitse tarvittaessa Viivan päällepainatus ja Täytön päällepainatus ja napsauta sitten OK-painiketta.

Viivan lisääminen soluihin Viiva-paneelissa
1. Valitse solut, joita haluat muotoilla. Jos haluat käyttää viiva-asetusta ylä- tai alatunnisteeseen, valitse ylä- tai alatunnisterivi.
2. Avaa Viiva-paneeli valitsemalla Ikkuna > Viiva.
3. Valitse sijaiskuvan esikatselualueelta viivat, joihin muutokset vaikuttavat.
4. Varmista, että työkalupaneelista on valittu Objekti-painike . (Jos Teksti-painike  on valittu, viivan muutokset vaikuttavat tekstiin solujen

sijasta.)
5. Määritä paksuus ja viivan tyyppi.

Täytön lisääminen soluihin Värimallit-paneelin käyttö
1. Valitse solut, joita haluat muotoilla. Jos haluat lisätä täytön ylä- tai alatunnisteeseen, valitse ylä- tai alatunnisterivi.
2. Avaa Värimallit-paneeli valitsemalla Ikkuna > Väri > Värimallit.
3. Varmista, että Objekti-painike  on valittu. (Jos Teksti-painike  on valittu, värin muutokset vaikuttavat tekstiin solujen sijasta.)
4. Valitse väriruutu.

Liukuvärin lisääminen soluihin Liukuvärit-paneelin käyttö
1. Valitse solut, joita haluat muotoilla. Jos haluat lisätä liukuvärin ylä- tai alatunnisteeseen, valitse ylä- tai alatunnisterivi.
2. Avaa Liukuväri-paneeli valitsemalla Ikkuna > Väri > Liukuväri.
3. Lisää liukuväri valittuihin soluihin napsauttamalla liukuväripalkkia. Säädä liukuvärin asetuksia tarvittaessa.

Lävistäjäviivojen lisääminen soluihin
1. Valitse tekstityökalu  ja siirrä kohdistin haluamaasi soluun tai valitse solut, joihin haluat lisätä lävistäjäviivat.
2. Valitse Taulukko > Soluasetukset > Lävistäjäviivat.
3. Napsauta sen lävistäjäviivatyypin painiketta, jonka haluat lisätä.
4. Määritä Viivareitti-kohdassa haluamasi paksuus-, tyyppi-, väri- ja väliasetukset. Valitse Sävy-prosentti ja Päällepainatus-asetukset.
5. Valitse Piirrä-valikosta Lävistäjäviivat eteen, jos haluat lävistäjäviivan näkyvän solun sisällön päällä. Jos taas haluat lävistäjäviivan jäävän

solun sisällön alle, valitse Sisältö eteen. Valitse lopuksi OK.

Taulukon viiva- ja täyttöasetukset
Käytä seuraavia asetuksia, kun valitset täyttöjä ja viivoja:

Leveys Tässä määritetään taulukon tai solun reunaviivan paksuus.
Tyyppi Tässä valitaan viivan tyyli, kuten Paksu-Ohut.
Väri Tässä määritetään taulukon tai solun reunan väri. Vaihtoehdot ovat samat kuin Värimallit-paneelissa.
Sävy Tässä määritetään viivassa tai täytössä käytettävän painovärin prosentti.
Välin väri Näillä asetuksilla määritetään katkoviivojen, pisteiden tai viivojen välisten alueiden väri. Tämä asetus ei ole käytettävissä, jos Tyyppi-
asetukseksi on valittu Yhtenäinen.
Välin sävy Näillä asetuksilla määritetään katkoviivojen, pisteiden tai viivojen välisten alueiden sävy. Tämä asetus ei ole käytettävissä, jos Tyyppi-
asetukseksi on valittu Yhtenäinen.
Päällepainatus Valitse tämä, jos haluat käyttää Väri-luetteloruudusta valittua painoväriä muiden värien päällä sen sijaan, että muut värit jätetään
pois.
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AlkuunTaulukon viivojen ja täyttöjen vaihteleminen
Taulukon luettavuutta ja ulkonäköä voi parantaa vuorottelevilla täytöillä ja viivoilla. Taulukon rivien vuorottelevat viivat ja täytöt eivät vaikuta ylä- ja
alatunnisteriveihin. Sarakkeiden vuorottelevat täytöt ja viivat vaikuttavat kuitenkin myös ylä- ja alatunnisteriveihin.

Vuorottelevan täytön ja viivan asetukset ohittavat solun viivan muotoilut, jos Taulukon asetukset -ikkunasta ei ole valittu Säilytä paikallinen muotoilu
-asetusta.

Jos haluat vuorottelevien kuvioiden sijaan lisätä täytön tai viivan taulukon jokaiseen leipätekstisoluun, voit käyttää vuorottelevan täytön ja viivan
asetuksia myös vuorottelemattomien kuvioiden luomiseen. Määritä tällöin Seuraava-asetukseksi 0.

Ennen (vasemmalla) vuorottelevaa täyttöä ja sen jälkeen (oikealla)

Vuorottelevien viivojen lisääminen taulukkoon
1. Siirrä kohdistin soluun ja valitse Taulukko > Taulukkoasetukset > Vuorottelevat riviviivat tai Vuorottelevat sarakeviivat.
2. Valitse Vuorotteleva kuvio -kohdasta käytettävän kuvion tyyppi. Valitse Mukautettu, jos haluat määrittää kuvion, esimerkiksi yhden

sarakkeen, jossa on mustat viivat, ja kolme saraketta, joissa on ohut keltainen viiva.
3. Määritä Vuorotteleva-kohdassa sekä ensimmäisen että seuraavan kuvion täytön asetukset. Ensimmäiseen sarakkeeseen voidaan lisätä

esimerkiksi yhtenäinen viiva ja seuraavaan Paksu-Ohut viiva. Määritä Seuraava-asetukseksi 0, jos haluat viivamääritysten vaikuttavan
jokaiseen riviin tai sarakkeeseen.
Huomautus: Jos taulukko ulottuu useisiin kehyksiin, rivien vuorottelevia viivoja ja täyttöjä ei aloiteta alusta jutun myöhemmissä kehyksissä.
(Lisätietoja: Taulukoiden jakaminen kehysten välillä.)

4. Valitse Säilytä paikallinen muotoilu, jos haluat säilyttää aiemmin taulukkoon lisätyt muotoillut viivat.
5. Määritä Ohita ensimmäinen- ja Ohita viimeinen -asetuksilla, kuinka monessa rivissä tai sarakkeessa taulukon alussa tai lopussa ei käytetä

viivan asetuksia. Napsauta lopuksi OK-painiketta.

Vuorottelevien täyttöjen lisääminen taulukkoon
1. Valitse Taulukko > Taulukkoasetukset > Vuorottelevat täytöt, kun kohdistin on solussa.
2. Valitse Vuorotteleva kuvio -kohdasta käytettävän kuvion tyyppi. Valitse Mukautettu, jos haluat määrittää kuvion, esimerkiksi yhden harmaan

rivin, jonka jälkeen tulee kolme keltaista riviä.
3. Määritä Vuorotteleva-kohdassa sekä ensimmäisen että seuraavan kuvion täytön asetukset. Jos esimerkiksi valitsit Vuorotteleva kuvio -

kohdassa Joka kolmas sarake -asetuksen, haluat ehkä varjostaa kaksi ensimmäistä saraketta harmaalla ja jättää kaksi seuraavaa saraketta
ilman varjostusta. Määritä Seuraava-asetukseksi 0, jos haluat täytön vaikuttavan jokaiseen riviin.

4. Valitse Säilytä paikallinen muotoilu, jos haluat säilyttää aiemmin taulukkoon lisätyt muotoillut täytöt.
5. Määritä Ohita ensimmäinen- ja Ohita viimeinen -kohdissa, kuinka monessa rivissä tai sarakkeessa taulukon alussa tai lopussa ei käytetä

täyttöasetuksia. Napsauta lopuksi OK-painiketta.

Vuorottelevien täyttöjen ja viivojen poistaminen taulukosta
1. Siirrä kohdistin taulukkoon.
2. Valitse Taulukko > Taulukon asetukset> Vuorottelevat riviviivat, Vuorottelevat sarakeviivat tai Vuorottelevat täytöt.
3. Valitse Vuorotteleva kuvio -kohdassa Ei mitään ja napsauta sitten OK-painiketta.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Vuorovaikutteisuus

Liikkeen esimääritysten luominen ja muokkaaminen (video 5:23)
Anne-Marie Concepcion  (1.1.2011)
Opastus - video
Katso, miten voit muokata ja mukauttaa liikeratojen esiasetuksia, joiden avulla voit animoida kuvia tai tekstiä InDesignissa.

Ristiviittausten luominen (video 5:45), CS4–CS6
David Blatner  (1.1.2011)
Opastus - video
Käy ristiviittausten lisäysmenettely läpi. Luo ristiviittauksia, jotka voidaan päivittää nopeasti, kun kohdeteksti tai sivutus muuttuu. Luo
mukautettu ristiviittausmuoto.

Vuorovaikutteisia toimintoja sisältävien julkaisujen luominen (video 8:06)
Anne-Marie Concepcion  (1.1.2011)
Opastus - video
Opi käyttämään Media-, Esikatselu- ja Ajoitus-paneeleita sekä määrittämään, mitä milloinkin tapahtuu.

Vuorovaikutteisten julkaisujen luominen hetkessä (PDF, 201 kt)
Viittaus  (1.1.2011)
Kätevä opastusohjelma, jossa käsitellään vuorovaikutteisuuden lisäämistä julkaisuihin.

Useissa tiloissa olevien objektien luominen (PDF, 203 kt)
Viittaus  (1.1.2011)
Tämän lyhyen opastusohjelman avulla opit luomaan monitilaisia objekteja vuorovaikutteisuuden lisäämiseksi.

Monipuolisten vuorovaikutteisten julkaisujen luominen (PDF, 6,7 Mt)
Viittaus  (1.1.2011)
Opi luomaan monipuolisia vuorovaikutteisia julkaisuja InDesignin avulla.

Tutustuminen uusiin FLA-vientivaihtoehtoihin (video 6:26)
Anne-Marie Concepcion  (1.1.2011)
Opastus - video
Katso, miten voit julkaista InDesign-projektisi erilaisissa Flash-muodoissa InDesign CS5:n ja sitä uudempien versioiden parannetun Vie-
valintaikkunan avulla.

582

http://www.adobe.com/go/lrvid5159_id_fi
http://tv.adobe.com/watch/learn-indesign-cs4/creating-crossreferences/
http://www.adobe.com/go/lrvid5152_id_fi
http://www.adobe.com/support/indesign/gettingstarted/pdfs/indesign_dyk_b_interactive.pdf
http://www.adobe.com/support/indesign/gettingstarted/pdfs/indesign_howto_f_mso.pdf
http://www.adobe.com/support/indesign/gettingstarted/pdfs/indesign_rid_whitepaper.pdf
http://www.adobe.com/go/lrvid5154_id_fi


Lomakkeet | CC, CS6

Alkuun

Alkuun

Käsiteltävät aiheet
Lomaketyönkulku
Lomakekentän lisääminen
Sarkainjärjestyksen määrittäminen

Lomaketyönkulku

InDesignissa voit luoda lomakkeita ja viedä ne suoraan PDF-muotoon. InDesign tukee nyt lomakekenttiä ja muiden lomakkeisiin liittyvien
toimintojen käyttöä. Painikkeet ja lomakkeet -kirjastossa (Ikkuna > Vuorovaikutteinen > Painikkeet ja lomakkeet) on lomakkeita, joita voi käyttää
vuorovaikutteisten lomakkeiden luontiin.

InDesignin avulla voidaan luoda yksinkertaisia lomakkeita InDesignin sisällä, jolloin PDF-asiakirjaa ei tarvitse korjailla Acrobatissa julkaisemisen
jälkeen. Voit lisätä yksinkertaisia lomake-elementtejä asiakirjan eri sivuille. Toiminto tukee tavallisia kenttätyyppejä, kuten tekstikenttiä,
valintapainikkeita, valintaruutuja ja allekirjoituksia. Lomakkeeseen voi lisätä myös toimintoja lomakkeen lähettämiseksi sähköpostitse tai sen
tulostamiseen.

Perusmuotoilun lisäksi lomakkeeseen voidaan lisätä suunnittelijan kädenjälkeä InDesignin luovan työn ominaisuuksilla.

Lisää yhtenäisiä viivoja ja täyttöjä PDF-lomakekenttiin.
Lisää painikkeille, valintaruuduille ja valintapainikkeille niiden käytössäolon ja hiiren kohdistimen sijaintiin perustuvia mukautettuja tiloja.
Valitse tekstikentissä käytettävä kirjasinkoko.

Voit käyttää esimerkiksi luottokorttitietojen keräämiseen luottokorttikuvakkeita valintapainikkeina ja määrittää eri kuvan tilanteisiin, joissa
valintapainike on valittuna.

Edistynyttä lomaketyönkulkua varten voit tuoda peruslomakkeen ja jatkaa sen muokkaamista Adobe Acrobatissa.

Lomakekentän lisääminen

Voit lisätä kenttiä sivuasetteluun Painikkeet ja lomakkeet -paneelin kautta. Vuorovaikutteisia lomakekenttiä lisätään samalla tavalla kuin painikkeita,
joten uusien toimintatapojen opettelu ei ole tarpeen. Voit luoda lomakkeen, joka toimii Adobe Readerissa tai Adobe Acrobatissa. InDesignilla voit
luoda upeita lomakkeita, joiden luonti ei tavallisesti onnistu Acrobatissa.

Painikkeet ja lomakkeet -paneeli

1. Sijoita kehys siihen kohtaan, johon haluat sijoittaa lomakekentän.
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Alkuun

2. Avaa Painikkeet ja lomakkeet -paneeli (Ikkunat > Vuorovaikutteinen > Painikkeet ja lomakkeet).
3. Valitse kehys ja sitten Tyyppi-luettelosta lomake-elementin tyyppi. Toinen vaihtoehto on napsauttaa kehystä hiiren kakkospainikkeella ja

valita Vuorovaikutteinen > Muunna muotoon [...]
4. Anna lomakekentälle nimi. Jos haluat luoda valintapainikeryhmän, kaikilla siihen lisättävillä painikkeilla on oltava sama nimi.
5. Valitse tapahtuma ja lisää siihen liitettävät toiminnot. Esimerkiksi toiminnot Tyhjennä lomake, Tulosta lomake ja Lähetä lomake on lisätty.

Määritä Lähetä lomake -toiminnossa URL-osoitteeksi ”mailto:xyz@example.com”.
6. Valintapainikkeet, valintaruudut tai painikkeet: määritä ulkoasumääritteet eri tiloille. InDesign lisää eri tiloille oletusarvojen mukaiset grafiikat,

mutta omien grafiikoiden lisääminen on mahdollista.
7. PDF-asetusten määrittäminen:

Kuvaus - Annettu arvo näkyy työkaluvihjeenä, ja sitä käytetään helppokäyttöisten lomakkeiden luonnissa
Painikkeen arvo - tämä arvo vastaa Acrobatissa olevaa vientiarvoa, ja sen avulla voidaan myös tunnistaa tietty valintapainike
helppokäyttöisen lomakkeen painikeryhmästä. 

Sarkainjärjestyksen määrittäminen

Jotta luotavasta lomakkeesta saadaan käyttäjäystävällinen ja helppokäyttöinen, sille on määritettävä käytännöllinen sarkainjärjestys. Käyttäjät
voivat siirtyä lomakkeen kentästä toiseen ilman osoitinlaitetta. Painamalla sarkainnäppäintä käyttäjä voi siirtyä järjestyksessä seuraavaan kenttään.

Nimiöidyn PDF-tiedoston sarkainjärjestys voidaan määrittää kahdella eri tavalla:

Voit määrittää mukautetun sarkainjärjestyksen Artikkelit-paneelissa (Ikkunat > Artikkeli).
Valitse Objekti > Vuorovaikutteinen > Määritä sarkainjärjestys.

Sarkainjärjestys voidaan määrittää Artikkelit-paneelissa.

Sarkainjärjestys voidaan määrittää Artikkelit-paneelissa

1. Avaa Artikkelit-paneeli (Ikkuna > Artikkelit).

2. Vedä lomakekentät Artikkelit-paneeliin.

3. Artikkelit-paneelissa kenttien järjestystä voidaan muuttaa vetämällä.

Jotta näytönlukuohjelmat voivat käyttää määritettyä järjestystä, ota Artikkelit-paneelin valikossa oleva asetus Käytä nimiöidyn PDF:n
lukemisjärjestykseen käyttöön. Kun olet viemässä lomaketta PDF:ksi, muista ottaa käyttöön Luo nimiöity PDF -asetus.

Käytä rakennetta sarkainjärjestykseen

1. Valitse Objektit > Vuorovaikutteinen > Määritä sarkainjärjestys.
2. Määritä haluamasi sarkainjärjestys napsauttamalla Siirrä ylös- tai Siirrä alas -painikkeita.

Kun viet vuorovaikutteiseen PDF-muotoon, ota käyttöön PDF-valintaikkunassa oleva Käytä rakennetta sarkainjärjestykseen -asetus.

Katso myös
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Hyperlinkit

Alkuun

Huomautus:

Hyperlinkit-paneelin yleiskuvaus
Hyperlinkkien luominen
Hyperlinkkien hallinta
Wordista tuotujen hyperlinkkien muokkaaminen

Hyperlinkit-paneelin yleiskuvaus

Kun julkaisuun luodaan hyperlinkkejä ja se viedään Adobe PDF- tai SWF-muotoon InDesignissa, lukija voi siirtyä saman julkaisun toiseen kohtaan,
toiseen julkaisuun tai Web-sivustoon napsauttamalla linkkiä. Kun viet julkaisun PDF- tai SWF-muotoon InCopyssa, tiedoston hyperlinkit eivät ole
aktiivisia.

Lähde on teksti, tekstikehys tai grafiikkakehys, jossa on hyperlinkkejä. Kohde on URL-osoite, sähköpostiosoite, sivu, tekstiankkuri tai jaettu kohde,
johon hyperlinkki siirtää lukijan. Lähde voi johtaa vain yhteen kohteeseen, mutta samaan kohteeseen voi päästä useista eri lähteistä.

Lähde on hyperlinkitetty teksti tai grafiikka. Kohde on URL-osoite, sähköpostiosoite, sivu, tekstiankkuri tai jaettu kohde, johon hyperlinkki siirtää
lukijan. Lähde voi johtaa vain yhteen kohteeseen, mutta samaan kohteeseen voi päästä useista eri lähteistä.

Jos haluat, että lähdeteksti luodaan kohdetekstistä, lisää hyperlinkin sijaan ristiviittaus. Katso Ristiviittaukset.

Hyperlinkit-paneeli

A. Nykyisessä dokumentissa olevien hyperlinkkien luettelo B. URL-osoitteen käytettävyydestä välittömän palautteen antavat liikennevalot C.
Sähköpostilinkki D. Napsautettava sivunumero, jonka avulla voit siirtyä linkin sisältävälle sivulle ja valita linkin 

Hyperlinkit-paneelin avaaminen

Valitse Ikkuna > Vuorovaikutteinen > Hyperlinkit.

Hyperlinkkien lajitteleminen Hyperlinkit-paneelissa

Valitse Hyperlinkit-paneelin valikosta Lajittele ja valitse sitten jokin seuraavista:
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Manuaalisesti

Nimen mukaan

Tyypin mukaan

Alkuun

Huomautus:

Huomautus:

Näyttää hyperlinkit siinä järjestyksessä, jossa ne lisättiin julkaisuun.

Näyttää hyperlinkit aakkosjärjestyksessä.

Näyttää hyperlinkit tyypin mukaisissa ryhmissä.

Hyperlinkkien näyttäminen pienemmillä riveillä

Valitse Hyperlinkit-paneelin valikosta Pienet paneelirivit.

Hyperlinkkien luominen

Voit luoda hyperlinkkejä sivuille, URL-osoitteisiin, tekstiankkureihin, sähköpostiosoitteisiin ja tiedostoihin. Jos luot hyperlinkin toisen julkaisun sivulle
tai tekstiankkuriin, varmista, että viedyt tiedostot ovat samassa kansiossa.

Jos haluat näyttää tai kätkeä hyperlinkit, valitse Näytä > Ekstrat > Näytä/Kätke hyperlinkit.

Hyperlinkit sisältyvät vietyihin Adobe PDF -tiedostoihin, kun Hyperlinkit-vaihtoehto valitaan InDesignin Vie Adobe PDF -
valintaikkunasta. Hyperlinkit sisältyvät vietyihin SWF-tiedostoihin, jos Sisällytä Hyperlinkit -vaihtoehto valitaan Vie SWF -valintaikkunasta.

Hyperlinkin luominen Web-sivuun (URL)

Voit luoda hyperlinkkejä URL-osoitteisiin useilla eri tavoilla. Voit URL-osoitetta määrittäessäsi käyttää mitä tahansa Internet-resurssiprotokollaa:
http://, file://, ftp:// tai mailto://.

Web-sivuille voi luoda linkin myös painiketoimintojen avulla. (Katso Painikkeet.)

InDesign CC:ssä hyperlinkit muotoillaan automaattisesti Hyperlinkki-tyylin mukaisesti: alleviivattuna sinisenä tekstinä.

1. Napsauta valittua tekstiä, kehystä tai kuvaa hiiren kakkospainikkeella ja valitse sitten Hyperlinkit > Uusi hyperlinkki. Uusi hyperlinkki -
valintaikkuna avautuu.

2. Määritä haluamasi URL-osoitekohde:

Kirjoita tai liitä URL-osoite (kuten http://www.adobe.com) URL-tekstilaatikkoon. Varmista, että URL-osoiteasetus on valittu avattavasta
Linkki-luettelosta.

-tai-

Valitse avattavasta URL-osoiteluettelosta aiemmin lisätty URL-osoite. Hyperlinkin ulkoasu on sama kuin aiemmin lisätyssä URL-
osoitteessa.
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Huomautus:

3. Valitse OK.

Jos URL-hyperlinkki ei toimi viedyssä PDF-tiedostossa, ongelma saattaa johtua siitä, että hyperlinkki on jaettu kohde. Poista Jaetun
hyperlinkin kohde -valintaruudun valinta ja valitse sitten OK.

Hyperlinkin luominen tiedostoon

Kun luot hyperlinkin tiedostoon ja hyperlinkkiä napsautetaan viedyssä PDF- tai SWF-tiedostossa, tiedosto avataan sen alkuperäisessä
sovelluksessa. Esimerkiksi .doc-tiedostot avataan Microsoft Wordissa.

Varmista, että tiedosto on kaikkien PDF- tai SWF-tiedoston avaavien käytettävissä. Jos esimerkiksi lähetät viedyn PDF-tiedoston työkaverillesi,
määritä tiedosto, joka sijaitsee yhteisessä palvelimessa oman kiintolevysi sijaan.

1. Valitse teksti, kehys tai grafiikka, jonka haluat toimivan hyperlinkin lähteenä.

2. Valitse Hyperlinkit-paneelin valikosta Uusi hyperlinkki tai napsauta paneelin alaosassa olevaa Luo uusi hyperlinkki -painiketta.

3. Valitse Uusi hyperlinkki -valintaikkunan Linkki kohteeseen -valikosta Tiedosto.

4. Kirjoita polku Polku-kohtaan tai napsauta kansiopainiketta, etsi tiedosto ja kaksoisnapsauta sitä.

5. Valitse Jaettu hyperlinkin kohde, jos haluat tallentaa tiedoston Hyperlinkit-paneeliin, josta sitä on helppo käyttää uudelleen.

6. Määritä hyperlinkin lähteen ulkoasu ja valitse sitten OK.

Hyperlinkin luominen sähköpostiviestiin

1. Valitse teksti, kehys tai grafiikka, jonka haluat toimivan hyperlinkin lähteenä.

2. Valitse Hyperlinkit-paneelin valikosta Uusi hyperlinkki tai napsauta paneelin alaosassa olevaa Luo uusi hyperlinkki -painiketta.

3. Valitse Uusi hyperlinkki -valintaikkunan Linkki kohteeseen -valikosta Sähköposti.

4. Kirjoita Osoite-kohtaan sähköpostiosoite, kuten kayttajanimi@yritys.com.

5. Kirjoita Aiherivi-kohtaan teksti, joka näkyy sähköpostiviestin aiherivillä.

6. Valitse Jaettu hyperlinkin kohde, jos haluat, että sähköpostiviesti tallennetaan Hyperlinkit-paneeliin. Tällöin viesti on helposti käytettävissä
uudelleen.

7. Määritä hyperlinkin lähteen ulkoasu ja valitse sitten OK.

Hyperlinkin luominen sivuun

Voit luoda hyperlinkin sivulle luomatta ensin kohdetta. Luomalla sivukohteen voit kuitenkin määrittää sivunumeron ja näyttöasetuksen.

1. Valitse teksti, kehys tai grafiikka, jonka haluat toimivan hyperlinkin lähteenä.

2. Valitse Hyperlinkit-paneelin valikosta Uusi hyperlinkki tai napsauta paneelin alaosassa olevaa Luo uusi hyperlinkki -painiketta.

3. Valitse Uusi hyperlinkki -valintaikkunan Linkki kohteeseen -valikosta Sivu.

4. Valitse Julkaisu-kohdasta julkaisu, joka sisältää linkin kohteen. Kaikki tallennetut avoinna olevat julkaisut näkyvät valikossa. Jos etsimäsi
julkaisu ei ole avoinna, valitse valikosta Selaa, etsi tiedosto ja napsauta sitten Avaa-painiketta.

5. Määritä Sivu-asetukseksi sivunumero, johon haluat linkin viittaavan.

6. Valitse zoomausasetukseksi jokin seuraavista näkymävaihtoehdoista:

Valitse Kiinteä, jos haluat käyttää sitä suurennusta ja sivun sijaintia, jotka olivat käytössä, kun linkki luotiin.

Valitse Sovita näkymä, jos haluat käyttää kohteena nykyisen sivun näkyvää osaa.

Valitse Sovita ikkunaan, jos haluat näyttää nykyisen sivun kohdeikkunassa.

Valitse Sovita leveys tai Sovita korkeus, jos haluat näyttää nykyisen sivun leveyden tai korkeuden kohdeikkunassa.

Valitse Sovita näkyvä, jos haluat näyttää sivun niin, että teksti ja kuvat mahtuvat ikkunaan leveyssuunnassa. Reunuksia ei tällöin yleensä
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näytetä.

Valitse Siirrä zoomaus, jos haluat käyttää kohdeikkunassa sitä suurennustasoa, jota lukija käyttää napsauttaessaan linkkiä.

7. Määritä ulkoasun asetukset ja valitse OK.

Hyperlinkin kohteen luominen

Hyperlinkille on luotava kohde vain, jos luot hyperlinkin tai ristiviittauksen tekstiankkuriin. Tekstiankkuri voi osoittaa tekstivalintaan tai lisäyskohdan
sijaintiin. Tämän jälkeen luot hyperlinkin tai ristiviittauksen, joka osoittaa hyperlinkin kohteeseen. Voit luoda hyperlinkin kohteita myös sivuille ja
URL-osoitteille, mutta se ei ole pakollista.

Luomasi hyperlinkin kohteet eivät näy Hyperlinkit-paneelissa. Ne näkyvät valintaikkunassa, joka tulee näyttöön, kun luot tai muokkaat hyperlinkkejä.

1. Jos luot tekstiankkuria, sijoita lisäyskohta tekstityökalulla tai valitse ankkurina käytettävä tekstialue.

Tekstin ankkurikohdetta ei voi määrittää sivupohjassa.

2. Valitse Hyperlinkit-paneeli valikosta Uusi hyperlinkkikohde.

3. Valitse Tyyppi-valikosta Tekstiankkuri. Kirjoita tekstiankkurin nimi ja napsauta OK-painiketta.

4. Voit tehdä seuraavat toiminnot. Valitse lopuksi OK.

Valitse Tyyppi-valikosta Tekstiankkuri. Määritä tekstiankkurille nimi.

Valitse Tyyppi-valikosta Sivu. Määritä sivunumero, johon haluat siirryttävän. Määritä myös zoomausasetus. Kirjoita sivun nimi. Voit myös
valita Nimi ja sivunumero -asetuksen, jos haluat, että kohteen nimi perustuu automaattisesti määritettyyn sivunumeroon ja
zoomausasetukseen.

Valitse Tyyppi-valikosta URL. Kirjoita tai liitä URL-osoite, kuten http://www.adobe.com. Voit käyttää kaikkia kelvollisia Internet-protokollia:
http://, file://, ftp:// tai mailto://.

Hyperlinkin luominen tekstiankkuriin

1. Valitse teksti, kehys tai grafiikka, jonka haluat toimivan hyperlinkin lähteenä.

2. Valitse Hyperlinkit-paneelin valikosta Uusi hyperlinkki tai napsauta paneelin alaosassa olevaa Luo uusi hyperlinkki -painiketta.

3. Valitse Linkki kohteeseen -valikosta Tekstiankkuri.

4. Valitse Julkaisu-kohdasta julkaisu, joka sisältää linkin kohteen. Kaikki tallennetut avoinna olevat julkaisut näkyvät valikossa. Jos etsimäsi
julkaisu ei ole avoinna, valitse valikosta Selaa, etsi tiedosto ja napsauta sitten Avaa-painiketta.

5. Valitse Tekstiankkuri-valikosta luomasi tekstiankkurin kohde.

6. Määritä hyperlinkin ulkoasun asetukset ja valitse OK.

Hyperlinkin luominen jaettuun kohteeseen

Jos hyperlinkkiä luodessasi valitset Linkki kohteeseen -valikosta Jaettu kohde, voit määrittää minkä tahansa nimetyn kohteen. Kohde on nimetty,
kun lisäät URL-osoitteen kirjoittamalla sen URL-tekstiruutuun tai kun valitset Jaettu hyperlinkin kohde luodessasi hyperlinkkiä URL-osoitteeseen,
tiedostoon tai sähköpostiosoitteeseen.

1. Valitse teksti, kehys tai grafiikka, jonka haluat toimivan hyperlinkin lähteenä.

2. Valitse Hyperlinkit-paneelin valikosta Uusi hyperlinkki tai napsauta paneelin alaosassa olevaa Luo uusi hyperlinkki -painiketta.

3. Valitse Uusi hyperlinkki -valintaikkunan Linkki kohteeseen -valikosta Jaettu kohde.

4. Valitse Julkaisu-kohdasta julkaisu, joka sisältää linkin kohteen. Kaikki tallennetut avoinna olevat julkaisut näkyvät valikossa. Jos etsimäsi
julkaisu ei ole avoinna, valitse valikosta Selaa, etsi tiedosto ja napsauta sitten Avaa-painiketta.

5. Valitse kohde Nimi-valikosta.

6. Määritä hyperlinkin ulkoasun asetukset ja valitse OK.
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Merkkityyli

Tyyppi

Korostus

Väri

Leveys-

Tyyli

Hyperlinkin ulkoasun asetukset

Asetukset määrittävät hyperlinkin tai ristiviittauksen ulkoasun viedyssä PDF- tai SWF-tiedostossa. Nämä ulkoasun asetukset näkyvät myös
InDesign-julkaisussa, jos valitset Näytä > Ekstrat > Näytä hyperlinkit.

Valitse hyperlinkin lähteen merkkityyli. InDesign käyttää valitun tekstin tai objektin kanssa Hyperlinkki-tyyliä. Tekstin tapauksessa voit
helposti valita toisen tyylin Uusi hyperlinkki -valintaikkunan avattavasta Tyyli-luettelosta. Muiden kuin tekstiobjektien tapauksessa InDesign käyttää
linkeissä suunnitteluajan visuaalista tunnistetta: objektin ympärillä olevaa pisteviivaa, jonka väri on peritty tason väristä.
Tekstilinkeissä käytetty merkkityyli

Merkkityyli lisätään julkaisun merkkityylien luetteloon. Tyyli tulostetaan ja viedään.

Objektilinkeissä käytetty visuaalinen tunniste

Linkitetyissä objekteissa käytetään pisteviivalla merkittyä ääriviivaa. Se on vain visuaalinen tunniste, eikä sitä tulosteta tai viedä.

Valitse Näkyvä suorakulmio tai Näkymätön suorakulmio.

Valitse Käänteinen, Ääriviiva, Vierus tai Ei mitään. Nämä asetukset määrittävät hyperlinkin ulkoasun, kun sitä napsautetaan PDF- tai
SWF-tiedostossa.

Valitse näkyvän hyperlinkkisuorakulmion väri.

Valitse hyperlinkkisuorakulmion leveydeksi Ohut, Normaali tai Paksu.

Määritä hyperlinkkisuorakulmion ulkoasu valitsemalla tyyliksi Yhtenäinen tai Katkoviiva.

Muunna URL-osoitteet hyperlinkeiksi

Voit etsiä ja muuntaa URL-osoitteita (kuten www.adobe.com) julkaisussasi ja muuntaa ne hyperlinkeiksi.

1. Valitse Hyperlinkit-paneelivalikosta Muunna URL-osoitteet hyperlinkeiksi.

2. Ilmaise Alueessa haluatko muuntaa koko julkaisun, avoinna olevan jutun vai käytössä olevan valinnan URL-osoitteet.

3. Jos haluat käyttää hyperlinkissä merkkityyliä, valitse merkkityyli Merkkityylit-valikosta.

4. Tee jokin seuraavista vaihtoehdoista ja valitse sitten Valmis.
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Alkuun

Huomautus:

Napsauta Etsi, kun haluat paikantaa seuraavan URL-osoitteen.

Napsauta Muunna, jos haluat muuntaa valitun URL-osoitteen hyperlinkiksi.

Napsauta Muunna kaikki, jos haluat muuntaa kaikki URL-osoitteet hyperlinkiksi.

Hyperlinkkien hallinta

Hyperlinkit-paneelin avulla muokataan, poistetaan, palautetaan tai etsitään hyperlinkkejä. Voit hallita hyperlinkkejä InCopyssa vain, jos juttu on
kirjattu ulos muokattavaksi.

Hyperlinkkien muokkaaminen

1. Napsauta hyperlinkitettyä tekstiä tai objektia hiiren kakkospainikkeella ja valitse sitten Hyperlinkit > Muokkaa hyperlinkkiä.

-tai-

Kaksoisnapsauta muokattavaa kohdetta Hyperlinkit-paneelissa.

2. Muuta hyperlinkkiä Muokkaa hyperlinkkejä -valintaikkunassa tarpeen mukaan ja valitse sitten OK.

voit muokata hyperlinkin URL-osoitetta valitsemalla hyperlinkin, muokkaamalla URL-osoitetta URL-tekstiruudussa ja painamalla
sitten Enter-näppäintä tai sarkainta.

Hyperlinkkien poistaminen

Kun hyperlinkki poistetaan, lähdeteksti tai kuva säilyy.

Valitse yksi tai useita poistettavia kohteita Hyperlinkit-paneelista ja napsauta sitten paneelin alareunassa olevaa Poista-painiketta.

Hyperlinkin lähteen nimeäminen uudelleen

Kun nimeät hyperlinkin lähteen uudelleen, hyperlinkki näkyy eri tavalla Hyperlinkit-paneelissa.

1. Valitse hyperlinkki Hyperlinkit-paneelista.

2. Valitse Hyperlinkit-paneelin valikosta Nimeä hyperlinkki uudelleen ja määritä uusi nimi.

Hyperlinkkien kohteiden muokkaaminen tai poistaminen

1. Avaa kohteen sisältävä julkaisu.

2. Valitse Hyperlinkit-paneelivalikosta Hyperlinkin kohdeasetukset.

3. Valitse Kohde-asetukseksi muokattavan kohteen nimi.

4. Tee jokin seuraavista:

Napsauta Muokkaa-painiketta ja tee kohteeseen tarvittavat muutokset.

Poista kohde napsauttamalla Poista-painiketta.

5. Kun olet muokannut tai poistanut haluamasi kohteet, napsauta OK-painiketta.

Hyperlinkkien palauttaminen ja päivittäminen

1. Valitse uuden hyperlinkin lähteeksi jokin tekstialue, tekstikehys tai grafiikkakehys. Voit esimerkiksi valita lähteeseen sisällytettäväksi lisää
tekstiä.
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Alkuun

2. Valitse linkki Hyperlinkit-paneelista.

3. Tee jompikumpi seuraavista:

Valitse Hyperlinkit-paneelivalikosta Palauta hyperlinkki.

Voit päivittää ulkoisiin julkaisuihin johtavat hyperlinkit valitsemalla Hyperlinkit-paneelivalikosta Päivitä hyperlinkki.

Hyperlinkin lähteeseen tai ankkuriin siirtyminen

Voit etsiä hyperlinkin tai ristiviittauksen lähteen valitsemalla ensin etsittävän kohteen Hyperlinkit-paneelista. Valitse Hyperlinkit-
paneelivalikosta Mene lähteeseen. Teksti tai kehys muuttuu valituksi.
Voit etsiä hyperlinkin tai ristiviittauksen kohteen valitsemalla ensin etsittävän kohteen Hyperlinkit-paneelista. Valitse Hyperlinkit-paneelin
valikosta Mene kohteeseen.

Jos kyseessä on URL-kohde, InDesign käynnistää Web-selaimen, jossa kohde näkyy. Jos kyseessä on tekstiankkuri tai sivukohde, InDesign avaa
oikean kohdan.

Wordista tuotujen hyperlinkkien muokkaaminen

Kun hyperlinkkejä sisältävä Microsoft Word -tiedosto tuodaan InDesign-julkaisuun, saatat huomata laatikon tai rajan hyperlinkin URL:n (kuten
www.adobe.com) ympärillä. InDesign-julkaisu perii sinisen värimallin nimeltään Word_R0_G0_B255. Julkaisu perii myös merkkityylin nimeltään
Hyperlinkki, joka alleviivaa tekstin ja käyttää sinistä väriä.

Jos haluat poistaa laatikon, kaksoisnapsauta hyperlinkkiä Hyperlinkit-paneelissa. Valitse Näkymätön suorakulmio Teksti-valikon kohdasta Ulkoasu
ja napsauta OK.

Voit myös poistaa tuodun värimallin. Näin tehdessäsi voit samalla korvata sen toisella värimallilla. Katso Yksittäisten värimallien poistaminen.

Ennen kuin sijoitat Word-asiakirjan InDesigniin, voit poistaa hyperlinkit Word-asiakirjan URL-osoitteista. Näin muotoilu ei periydy InDesigniin.
Lisätietoja saat Word-dokumentaatiosta. Toinen vaihtoehto on luoda InDesign-julkaisuun merkkityyli nimeltään Hyperlinkki, ennen kuin tuot
asiakirjan. Kun tuot Word-asiakirjan, sen nimistä InDesign-tyyliä käytetään oletuksena.

Lisää ohjeaiheita
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Ristiviittaukset

Alkuun

Huomautus:

Ristiviittausten lisääminen
Ristiviittausten muotojen käyttäminen
Ristiviittausten hallinta

Jos kirjoitat opasta tai viitejulkaisua, voit ristiviittauksen avulla ohjata lukijan julkaisun osasta toiseen. Esimerkki: Lisätietoja on kohdassa
"Peltohiiret" sivulla 249. Voit määrittää, onko ristiviittaus peräisin kappaletyylistä, kuten otsikkotyylistä vai luomastasi tekstiankkurista.
Voit myös määrittää ristiviittauksen muodon, kuten Sivunumero tai Koko kappale ja sivunumero.

Ristiviittausten lisääminen

Lisää julkaisuun ristiviittauksia Ristiviittaukset-paneelissa. Voit avata paneelin valitsemalla Ikkuna > Teksti ja taulukot > Ristiviittaukset.

A. Mene kohteeseen napsauttamalla vihreää visuaalista ilmaisinta. B. Valitse kohde napsauttamalla sivunumeroa. C. Luo ristiviittaus
napsauttamalla kuvaketta. 

Viitattavaa tekstiä kutsutaan kohdetekstiksi. Kohdetekstistä luotua tekstiä kutsutaan lähteen ristiviittaukseksi.

Kun lisäät julkaisuun ristiviittauksen, voit valita useista valmiista muodoista tai voit luoda oman mukautetun muodon. Voit käyttää merkkityyliä koko
ristiviittauksen lähteessä tai ristiviittauksen sisällä olevassa tekstissä. Kirjassa käytettävät ristiviittausten muodot voidaan synkronoida.

Ristiviittauksen lähdeteksti on muokattavissa, ja se voidaan jakaa usealle riville.

Ristiviittaukset sisältyvät vietyihin Adobe PDF -tiedostoihin, kun Hyperlinkit-vaihtoehto valitaan InDesignin Vie Adobe PDF -
valintaikkunasta. Ristiviittaukset sisältyvät vietyihin SWF-tiedostoihin, kun Hyperlinkit-vaihtoehto valitaan InDesignin Vie SWF -valintaikkunasta.
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Alkuun

Ristiviittausten lisääminen

A. Valittu kohdekappale B. Luo ristiviittauksen muoto tai muokkaa sitä napsauttamalla tätä. 

1. Sijoita lisäyskohta paikkaan, johon haluat lisätä ristiviittauksen.

2. Voit avata Uusi ristiviittaus -valintaikkunan millä tahansa seuraavista menetelmistä:

Valitse Tyyppi > Hyperlinkit ja ristiviittaukset > Lisää ristiviittaus.

Valitse Ikkuna > Teksti ja taulukot > Ristiviittaukset ja valitse sitten paneelivalikosta Lisää ristiviittaus.

Napsauta paneelin Luo uusi ristiviittaus -painiketta.

3. Valitse valintaikkunan Linkki kohteeseen -valikosta Kappale tai Tekstiankkuri.

Jos valitset kohteeksi kappaleen, voit luoda ristiviittauksen mihin tahansa julkaisun kappaleeseen.

Jos valitset kohteeksi tekstiankkurin, voit luoda ristiviittauksen mihin tahansa tekstiin, jossa olet luonut hyperlinkin kohteen. (Katso
Hyperlinkkikohteen luominen.) Tekstiankkuri kannattaa luoda erityisesti silloin, kun haluat käyttää eri tekstiä kuin itse kohdekappaleen tekstiä.

4. Valitse Julkaisu-kohdasta julkaisu, joka sisältää viitattavan kohteen. Kaikki tallennetut avoinna olevat julkaisut näkyvät valikossa. Jos
etsimääsi julkaisua ei ole avattu, valitse Selaa, etsi tiedosto ja valitse Avaa.

5. Valitse vasemmalla olevasta ruudusta kappaletyyli, kuten Head1. Näin voit rajoittaa vaihtoehtoja. Valitse sitten kappale, johon haluat viitata.
(Voit myös valita tekstiankkurin, jos Tekstiankkuri on valittuna.)

6. Valitse Muoto-valikosta käytettävä ristiviittauksen muoto.

Voit muokata näitä ristiviittausten muotoja tai luoda omia. Katso Ristiviittausten muotojen käyttäminen.

7. Määritä ristiviittauksen PDF-muotoasetukset.

8. Valitse OK.

Kun lisäät ristiviittauksen, kohdekappaleen alkuun lisätään tekstiankkurin merkki  Voit näyttää tämän merkin, kun valitset Tyyppi > Näytä
piilomerkit. Jos tämä merkki siirretään tai poistetaan, ristiviittaus muuttuu ratkaisemattomaksi.

Ristiviittausten muotojen käyttäminen
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Huomautus:

Uusi ristiviittaus -valintaikkunassa näkyy oletusarvoisesti useita ristiviittausten muotoja Voit muokata ja poistaa näitä oletusmuotoja tai luoda omia
muotoja.

Jos olet poistanut tai muokannut julkaisun ristiviittausten muotoja ja haluat palauttaa ne oletusarvoihin, valitse paneelin valikosta
Lataa ristiviittausten muodot ja valitse muokkaamattomat muodot sisältävä julkaisu. Voit myös synkronoida kirjan ristiviittausten muodot.

Ristiviittausten muotojen luominen ja muokkaaminen

Toisin kuin muita oletusarvoja, ristiviittausten muotoja voi muokata ja poistaa. Kun muokkaat ristiviittauksen muotoa, tätä muotoa käyttävät
lähderistiviittaukset päivitetään automaattisesti.

1. Tee jokin seuraavista toimista:

Valitse Ristiviittaukset-paneelivalikosta Määritä ristiviittausten muodot.

Kun luot ristiviittauksen tai muokkaat sitä, napsauta Luo tai muokkaa ristiviittausten muotoja -painiketta .

2. Tee Ristiviittausten muodot -valintaikkunassa jokin seuraavista toimista:

Muokkaa muotoa valitsemalla muoto vasemmalta.

Muokkaa muotoa valitsemalla muoto uuden muodon pohjaksi ja napsauttamalla sitten Luo muoto -painiketta . Tämä luo valitun
muodon kaksoiskappaleen.

3. Määritä Nimi-kohtaan muodon nimi.

4. Lisää Määritelmä-tekstiruutuun tekstiä tai poista sitä tarpeen mukaan. Lisää elementtejä valikosta napsauttamalla Elementti-kuvaketta. Jos

haluat lisätä ajatusviivoja, välilyöntejä, kysymysmerkkejä tai muita erikoismerkkejä, napsauta Erikoismerkit-kuvaketta.

5. Jos haluat ottaa merkkityylin käyttöön koko ristiviittauksessa, valitse Ristiviittauksen merkkityyli ja valitse tai luo merkkityyli valikosta.

Voit Merkkityyli-elementin avulla ottaa merkkityylin käyttöön ristiviittauksen tekstissä.

6. Tallenna muutokset valitsemalla Tallenna. Valitse OK, kun olet valmis.

Ristiviittauksen elementit

Elementti Kuvaus Esimerkki

Sivunumero Lisää sivunumeron. sivulla <pageNum/>

sivulla 23

Kappaleen numero Lisää numeroituun luetteloon
ristiviittauksen kappaleen numeron.

Katso <paraNum/>

Katso 1

Tässä esimerkissä vain merkintää "1"
käytetään kappaleesta "1. Eläimet."

Kappaleen teksti Lisää numeroituun luetteloon
ristiviittauksen kappaleen tekstin ilman
kappaleen numeroa.

Katso ”<paraText/>”

Katso ”Eläimet”

Tässä esimerkissä vain merkintää
”Eläimet” käytetään kappaleesta ”1.
Eläimet”.

Koko kappale Lisää koko kappaleen; sekä kappaleen
numeron että kappaleen tekstin.

Katso ”<fullPara/>”

Katso ”1 Eläimet”

Osittainen kappale Voit luoda ristiviittauksen kappaleen
ensimmäiseen osaan. Ristiviittauksen
loppukohta määritetään erottimella,
kuten kaksoispisteellä tai pitkällä

Katso <fullPara delim=":"
includeDelim="false"/>

Katso Luku 7
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Ristiviittausten luominen osittaisiin kappaleisiin

Voit suunnitella ristiviittausten muodot niin, että ne sisältävät vain kappaleen ensimmäisen osan. Jos julkaisussasi on esimerkiksi otsikko "Luku 7—
Granadasta Barcelonaan", voit luoda ristiviittauksen, joka viittaa vain otsikon osaan "Luku 7".

Ristiviittaus osittaiseen kappaleeseen

ajatusviivalla. Tässä esimerkissä vain osaa ”Luku 7”
käytetään otsikosta ”Luku 7: Koirat ja
kissat”.

Määritä erotin (tässä esimerkissä
kaksoispiste). Määritä myös,
jätetäänkö erotin lähderistiviittauksen
ulkopuolelle (”false” tai ”0” vai
sisällytetäänkö se lähderistiviittaukseen
(”true” tai ”1”).

Katso Ristiviittausten luominen
osittaisiin kappaleisiin.

Tekstiankkurin nimi Lisää tekstiankkurin nimen. Voit luoda
tekstiankkureita valitsemalla
Hyperlinkit-paneelin valikosta Uusi
hyperlinkkikohde.

Katso <txtAnchrName/>

Katso Kuva 1

Luvun numero Lisää luvun numeron. luvussa <chapNum/>

luvussa 3

Tiedostonimi Lisää kohdejulkaisun tiedostonimen. tiedostossa <fileName/>

tiedostossa newsletter.indd

Merkkityyli Ottaa merkkityylin käyttöön
ristiviittauksen tekstissä.

Katso <cs
name=”bold”><fullPara/></cs> sivulla
<pageNum>

Katso Eläimet sivulla 23.

Määritä merkkityylin nimi ja lisää
tunnisteiden <cs name=””> ja </cs>
väliin teksti, jossa haluat käyttää
merkkityyliä.

Katso Merkkityylien käyttäminen
ristiviittauksissa.
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A. Ristiviittauksen lähde päättyy pitkään ajatusviivaan (^_) B. Arvo "false" jättää pitkän ajatusviivan lähteen ulkopuolelle 

Kun lisäät Osittainen kappale -elementin, muista seuraavat seikat. Määritä ensin erotin lainausmerkkien sisään. Erotin on merkki, joka päättää
kappaleen. Yleisiä erottimia ovat kaksoispiste (Luku 7: Granada), piste (Luku 7. Granada) ja ajatusviiva (Luku 7—Granada). Jos haluat lisätä
erikoismerkin, kuten pitkän ajatusviivan (^_), pitkän välilyönnin (^m) tai luettelomerkin (^8), napsauta Erikoismerkit-kuvaketta ja valitse vaihtoehto
näyttöön tulevasta valikosta.

Määritä seuraavaksi, sisältyykö erotinmerkki elementtiin (Luku 7—) vai ei (Luku 7). includeDelim="false" jättää erotinmerkin pois, ja
includeDelim="true" sisällyttää erotinmerkin mukaan. Merkinnän "false" voi korvata numerolla merkinnällä "0" ja merkinnän "true" merkinnällä "1".

Merkkityylien käyttäminen ristiviittauksissa

Jos haluat korostaa osaa ristiviittauksen tekstistä, käytä Merkkityyli-elementtiä. Tämä elementti kostuu kahdesta tunnisteesta. Tunniste <cs
name="tyylin_nimi"> ilmaisee, mitä tyyliä käytetään, ja tunniste </cs> päättää merkkityylin. Näiden tunnisteiden välissä olevat tekstit ja elementit
muotoillaan määritetyllä tyylillä.

Merkkityylin käyttäminen ristiviittauksen osassa

A. Tämä tunniste käyttää ”Punainen”-nimistä merkkityyliä.  B. Tämä tunniste päättää merkkityylimuotoilun. C. Ristiviittauksen lähteen lopussa on
käytössä "Lihavointi"-niminen merkkityyli. 

1. Luo tarvittava merkkityyli.

2. Luo Ristiviittausten muodot -valintaikkunassa haluamasi muoto tai muokkaa aiemmin luotua muotoa.

3. Valitse Määritelmä-kohdasta teksti ja elementit, joissa haluat käyttää merkkityyliä.

4. Valitse määritelmäluettelon oikealla puolella olevasta valikosta Merkkityyli.

5. Kirjoita merkkityylin nimi lainausmerkkien väliin täsmälleen siinä muodossa, jossa se näkyy Merkkityylit-paneelissa.

Kirjainkoolla on merkitystä merkkityylien nimissä. Jos merkkityyli kuuluu ryhmään, kirjoita ryhmän nimi ja kaksoispiste ennen merkkityyliä.
Esimerkki Tyyliryhmä 1: Punainen.

6. Tallenna muoto valitsemalla Tallenna ja valitse sitten OK.

Ristiviittausten muotojen lataaminen (tuominen)
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Alkuun

Kun lataat ristiviittausten muotoja toisesta julkaisusta, saapuvat muodot korvaavat samannimiset olemassa olevat muodot.

Voit tuoda muotoja InCopyssa vain erillisiin julkaisuihin. Et voi tuoda muotoja InCopy-julkaisusta InDesign-julkaisuun. Jos InCopyn uusi tai
muokattu muoto on ristiriidassa InDesign-julkaisun muodon kanssa, kun juttu kirjataan ulos, InDesign-muotoa pidetään ensisijaisena muotona.

1. Valitse Ristiviittaukset-paneelivalikosta Lataa ristiviittausten muodot.

2. Kaksoisnapsauta julkaisua, joka sisältää tuotavat ristiviittausten muodot.

Synkronoimalla kirjan voit jakaa ristiviittausten muodot julkaisuissa.

Ristiviittausten muotojen poistaminen

Et voi poistaa ristiviittausten muotoja, jotka on otettu käyttöön julkaisun ristiviittauksissa.

1. Valitse Ristiviittausten muodot -valintaikkunasta muoto, jonka haluat poistaa.

2. Napsauta Poista muoto -painiketta.

Ristiviittausten hallinta

Kun lisäät ristiviittauksen, sen tila näkyy Ristiviittaukset-paneelissa. Kuvakkeet ilmaisevat esimerkiksi, näkyykö teksti taittopöydällä , sivupohjassa 
, kätketyllä tasolla , ylijuoksevassa tekstissä  tai kätketyssä tekstissä . Tällaisiin kohdealueisiin viittaavat ristiviittaukset ovat

ratkaisemattomia. Paneelin avulla voit selvittää myös, onko kohdekappaletta muokattu  (eli onko se vanhentunut) tai puuttuuko se .
Kohdeteksti puuttuu, jos kohdetekstiä tai kohdetekstin sisältävää tiedostoa ei löydy. Näet työkaluvihjeen kuvauksen, kun siirrät hiiriosoittimen
kuvakkeen päälle.

Voit hallita ristiviittauksia InCopyssa vain, jos juttu on kirjattu ulos muokattavaksi.

Ristiviittausten päivitys

Päivityskuvake ilmaisee, että ristiviittauksen kohdetekstiä on muutettu tai ristiviittauksen lähdetekstiä on muokattu. Ristiviittauksen päivittäminen on
helppoa. Jos kohde siirtyy toiselle sivulle, ristiviittaus päivitetään automaattisesti.

Kun päivität ristiviittauksen, lähdetekstiin tehdyt muotoilumuutokset poistetaan.

Tulostettaessa ohjelma ilmoittaa, jos mukana on vanhentuneita tai ratkaisemattomia ristiviittauksia.

Voit katsoa myös Esitarkastus-paneelista, ovatko ristiviittaukset vanhentuneita tai ratkaisemattomia. Kun määrität profiilia, valitse Teksti-osasta
Ristiviittaukset. Katso Preflight-profiilien määrittäminen.

1. Valitse haluamasi vanhentuneet ristiviittaukset. Jos haluat päivittää kaikki ristiviittaukset, varmista, ettei yhtään ristiviittausta ole valittuna.

2. Tee jokin seuraavista toimista:

Napsauta Ristiviittaukset-paneelin Päivitä ristiviittaukset -painiketta .

Valitse Ristiviittaukset-paneelivalikosta Päivitä ristiviittaus.

Valitse Teksti > Hyperlinkit ja ristiviittaukset > Päivitä ristiviittaus.

Voit päivittää kirjan kaikki ristiviittaukset valitsemalla Kirja-paneelin valikosta Päivitä kaikki ristiviittaukset. Ohjelma ilmoittaa, jos jokin ristiviittaus on
ratkaisematta.

Ristiviittausten linkittäminen uudelleen

Jos puuttuva kohdeteksti siirretään toiseen julkaisuun tai jos kohdetekstin sisältävä julkaisu nimetään uudelleen, voit linkittää ristiviittauksen
uudelleen. Tällöin lähderistiviittaukseen tehdyt muutokset poistetaan.
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

1. Valitse Ristiviittaukset-paneelista ristiviittaus, jonka haluat linkittää uudelleen.

2. Valitse paneelivalikosta Linkitä ristiviittaus uudelleen.

3. Etsi julkaisu, joka sisältää kohdetekstin, ja valitse Avaa.

Jos tässä julkaisussa on muita kohdetekstejä, voit linkittää myös niiden ristiviittaukset uudelleen.

Ristiviittausten muokkaus

Voit muuttaa lähderistiviittauksen ulkoasua tai määrittää toisen muodon muokkaamalla ristiviittausta. Jos muokkaat toiseen julkaisuun viittaavaa
ristiviittausta, julkaisu aukeaa automaattisesti.

1. Tee jokin seuraavista toimista:

Valitse Tyyppi > Hyperlinkit ja ristiviittaukset > Ristiviittausasetukset.

Kaksoisnapsauta Ristiviittaukset-paneelissa ristiviittausta, jota haluat muokata.

Valitse ristiviittaus ja valitse sitten Ristiviittaukset-paneelivalikosta Ristiviittausasetukset.

2. Muokkaa ristiviittausta ja valitse sitten OK.

Ristiviittausten poistaminen

Kun poistat ristiviittauksen, lähderistiviittaus muunnetaan tekstiksi.

1. Valitse Ristiviittaukset-paneelista ristiviittaus tai ristiviittaukset, jotka haluat poistaa.

2. Napsauta poistokuvaketta tai valitse paneelivalikosta Poista ristiviittaus.

3. Vahvista toiminto valitsemalla Kyllä.

Voit poistaa ristiviittauksen kokonaan myös valitsemalla ristiviittauksen ja poistamalla sen.

Ristiviittauksen lähdetekstin muokkaaminen

Voit muokata ristiviittauksen lähdetekstiä. Ristiviittauksen tekstiä kannattaa muokata, sillä tällöin voit muuttaa merkkiväliä tai sanojen välejä tarpeen
mukaan copyfit-toimintoja varten tai tehdä muita muutoksia. Ota kuitenkin huomioon, että jos päivität ristiviittauksen tai linkität sen uudelleen, kaikki
paikalliset muotoilumuutokset poistetaan.
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Painikkeet

Alkuun

Painikkeiden luominen
Vuorovaikutteisuuden lisääminen painikkeisiin
Painikkeen ulkoasun muuttaminen painikkeen päälle siirryttäessä tai sitä napsautettaessa
Useissa tiloissa olevien objektien luominen
Kohdepisteiden luominen painikkeille
Painikkeiden sarkainjärjestyksen määrittäminen

Painikkeiden luominen

Voit luoda tietyn toiminnon käynnistäviä painikkeita, kun julkaisu viedään kiinteään asetteluun perustuvaan EPUB-, PDF- tai SWF-muotoon. Voit
esimerkiksi luoda painikkeen, joka siirtyy toiselle sivulle tai avaa verkkosivun.

Painike, joka on määritetty toistamaan elokuva viedyssä PDF-tiedostossa

Kun olet luonut painikkeen, voit tehdä seuraavaa:

Voit tehdä painikkeista vuorovaikutteisia Painikkeet-paneelissa. Kun käyttäjä napsauttaa painiketta viedyssä kiinteään asetteluun
perustuvassa EPUB-, PDF- tai SWF-tiedostossa, toiminto suoritetaan. Katso Vuorovaikutteisuuden lisääminen painikkeisiin.

Voit määrittää Painikkeet-paneelin Ulkoasu-osassa, miten painikkeen ulkoasu muuttuu suhteessa tiettyihin hiiren toimintoihin. Katso
Painikkeen ulkoasun muuttaminen painikkeen päälle siirryttäessä tai sitä napsautettaessa.

Voit luoda useissa tiloissa olevia objekteja Objektien tila -paneelin avulla. Katso Useissa tiloissa olevien objektien luominen.

Luo kohdepiste- tai kuuma linkki -tehoste, joka näyttää kuvan, kun hiiri siirtyy painikkeen päälle tai kun painiketta napsautetaan. Katso
Kohdepisteiden luominen painikkeille.

Kun työstät painikkeita ja suunnittelet dynaamisia julkaisuja, valitse Vuorovaikutteisuus-työtila.

Painikkeen luominen

1. Voit piirtää painikkeen muodon kynätyökalulla tai piirtotyökalulla, kuten suorakulmiotyökalulla tai ellipsityökalulla. Tekstityökalulla voit
tarvittaessa lisätä painikkeeseen tekstiä, kuten Seuraava tai Osta.

Jos luot useilla sivuilla näkyviä navigointipainikkeita (kuten Seuraava sivu tai Edellinen sivu), lisää se sivupohjaan. Näin sinun ei tarvitse
luoda uudelleen painikkeita jokaiselle julkaisun sivulle. Nämä painikkeet näkyvät julkaisun kaikilla sivuilla, joissa sivupohja on otettu
käyttöön.

2. Valitse valintatyökalulla kuva, kuvio tai tekstikehys, jonka haluat muuntaa.

Et voi muuntaa elokuvaa, ääntä tai julistetta painikkeeksi.

3. Napsauta Muunna objekti painikkeeksi -kuvaketta Painikkeet-paneelissa (valitse Ikkuna > Vuorovaikutteinen > Painikkeet). Tai valitse
Objekti > Vuorovaikutteinen > Muunna painikkeeksi.

4. Tee Painikkeet-paneelissa jokin seuraavista toimista:
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Alkuun

Määritä painikkeen nimi Nimi-tekstiruutuun, jotta erotat sen muista luomistasi painikkeista.

Määritä painikkeen toiminnot. Näin voit määrittää, mitä tapahtuu, kun painiketta napsautetaan viedyssä kiinteään asetteluun perustuvassa
EPUB-, PDF- tai SWF-tiedostossa. Katso Vuorovaikutteisuuden lisääminen painikkeisiin.

Voit aktivoimalla lisää ulkoasutiloja ja muuttamalla niiden ulkoasua määrittää, miltä painikkeet näyttävät, kun hiiriosoitin siirretään niiden
päälle tai kun niitä napsautetaan viedyssä kiinteään asetteluun perustuvassa EPUB-, PDF- tai SWF-tiedostossa. Katso Painikkeen
ulkoasun muuttaminen painikkeen päälle siirryttäessä tai sitä napsautettaessa.

5. Esikatselu-paneelissa (Ikkuna > Vuorovaikutteisuus > EPUB-julkaisujen vuorovaikutteisuuden esikatselu / SWF-esikatselu) voit kokeilla
painiketta, ennen kuin viet julkaisun vuorovaikutteiseen, kiinteään asetteluun perustuvaan EPUB-, PDF- tai SWF-tiedostoon.

Painikkeen lisääminen Näytepainikkeet-paneelista

Näytepainikkeet-paneeli sisältää valmiita painikkeita, joita voit vetää julkaisuun. Näissä näytepainikkeissa on käytössä tehosteita, kuten
liukuväripehmennyksiä ja heittovarjoja, jotka muuttavat Rollover-ulkoasua jonkin verran. Näytepainikkeet ovat myös määritettyjä toimintoja.
Esimerkiksi näytenuolipainikkeiden oletusarvoina ovat Siirry seuraavalle sivulle- ja Siirry edelliselle sivulle -toiminnot. Voit muokata näitä painikkeita
tarpeen mukaan.

Näytepainikkeet-paneeli on objektikirjasto. Kuten muissakin objektikirjastoissa, voit lisätä paneeliin uusia painikkeita ja poistaa painikkeita, joita et
käytä. (Katso Objektikirjastojen käyttäminen.) Näytepainikkeet tallennetaan ButtonLibrary.indl-tiedostoon, joka sijaitsee InDesign-sovelluksen
kansiossa Presets/Button Library.

1. Avaa Näytepainikkeet-paneeli valitsemalla Painikkeet-paneelin valikosta Näytepainikkeet.

2. Vedä painike Näytepainikkeet-paneelista julkaisuun. Jos haluat navigointipainikkeiden näkyvän jokaisella sivulla, lisää painikkeet
sivupohjaan.

3. Valitse painike valintatyökalulla ja muokkaa painiketta tarpeen mukaan Painikkeet-paneelin avulla.

Pidä seuraavat seikat mielessä, kun muokkaat näytepainikkeita:

Jos lisäät painikkeeseen tekstiä, muista kopioida ja liittää teksti painikkeen Normaali-tilasta Rollover-tilaan. Muutoin lisätty teksti ei näy, kun
hiiren osoitin siirretään painikkeen päälle kiinteään asetteluun perustuvassa EPUB-, PDF- tai SWF-tiedostossa.

Voit muuttaa painikkeiden kokoa. Jos vedät seuraavan ja edellisen sivun nuolipainikkeiden parin, muuta ensimmäisen painikkeen kokoa,
valitse toinen painike ja valitse sitten Objekti > Muunna uudelleen > Muunna uudelleen.

Voit kokeilla painiketta Esikatselu-paneelissa.

Painikkeen muuntaminen objektiksi

Kun muunnat painikkeen objektiksi, painikkeen sisältö säilyy sivulla ilman painikkeen ominaisuuksia. Painikkeen muihin tiloihin liittyvä sisältö
poistetaan.

1. Valitse painike valintatyökalulla. 

2. Valitse Objekti > Vuorovaikutteinen > Muunna objektiksi.

Vuorovaikutteisuuden lisääminen painikkeisiin

Voit luoda, muokata ja hallita vuorovaikutteisia tehosteita InDesignissa. Kun julkaisu on viety kiinteään asetteluun perustuvassa EPUB-, PDF- tai
SWF-muodossa, nämä vuorovaikutteiset toiminnot saattavat olla aktiivisia.

Voit esimerkiksi luoda painikkeen, jonka napsauttaminen käynnistää äänen toistamisen PDF-tiedostossa. Voit sijoittaa äänitiedoston InDesign-
julkaisuun ja luoda painikkeen, jota napsauttamalla ääni toistetaan PDF-julkaisussa.

Tässä esimerkissä hiiren napsauttaminen on tapahtuma ja äänen toistaminen toiminto.

601

http://help.adobe.com/fi_FI/InDesign/CS5/Using/WSB563B522-0E6F-4a26-A5C5-97E84AC9377Ca.html


Huomautus:

Vapautettaessa

Napsautettaessa

Siirryttäessä painikkeen päälle

Siirryttäessä pois painikkeelta

Tämä painike on määritetty toistamaan ääni, kun hiiren painike vapautetaan

Joitakin toimintoja tuetaan sekä PDF- että SWF-/EPUB-muodossa ja joitakin toimintoja tuetaan vain PDF- tai SWF-/EPUB-
muodossa. Kun valitset toiminnon, vältä valitsemasta vain PDF-muotoista toimintoa, jos olet viemässä sisältöä SWF-muodossa tai kiinteään
asetteluun perustuvassa EPUB-muodossa. Vältä myös valitsemasta vain SWF-/EPUB-muotoista toimintoa, jos olet viemässä sisältöä PDF-
muotoon.

Toimintojen lisääminen painikkeisiin

Voit liittää toimintoja erilaisiin tapahtumiin. Voit esimerkiksi määrittää viedyssä PDF-tiedostossa tietyn äänen toistettavaksi, kun hiiriosoitin siirretään
painikkeen alueelle, ja elokuvan toistettavaksi, kun hiiren painiketta napsautetaan ja se vapautetaan. Voit myös liittää useita toimintoja samaan
tapahtumaan. Voit esimerkiksi luoda toiminnon, joka toistaa elokuvan ja määrittää zoomausasetukseksi Todellinen koko -vaihtoehdon.

1. Valitse luomasi painike valintatyökalulla. 

2. Valitse Painikkeet-paneelin valikosta tapahtuma (esimerkiksi Vapautettaessa), joka määrittää, miten toiminnot aktivoidaan.

3. Napsauta Toiminnot-kohdan vieressä olevaa plusmerkkiä  ja valitse tapahtumaan liitettävä toiminto.

4. Määritä toiminnon asetukset.

Jos valitset esimerkiksi toiminnon Siirry ensimmäiselle sivulle, määritä zoomausasetukset. Jos valitset toiminnon Siirry URL-osoitteeseen,
määritä verkkosivun osoite. Tietyillä toiminnoilla (kuten Siirry seuraavaan näkymään) ei ole lisäasetuksia.

5. Voit tarvittaessa lisätä mihin tahansa tapahtumaan lisää toimintoja.

Kun haluat kokeilla painiketta, vie julkaisu kiinteään asetteluun perustuvassa EPUB-, PDF- tai SWF-muodossa ja avaa viety tiedosto. Jos viet
PDF-muotoon, varmista, että Vuorovaikutteiset elementit -asetus on valittuna. Jos viet SWF-muotoon, varmista, että Sisällytä painikkeet -
asetus on valittuna.

Tapahtumatyypit

Tapahtumat määräävät, kuinka painikkeiden toiminnot käynnistyvät, kun julkaisu on viety EPUB-, PDF- tai SWF-muodossa. (Acrobatissa
tapahtumia kutsutaan laukaisimiksi.)

Hiiren painikkeen vapauttaminen napsautuksen jälkeen. Tämä on useimmin käytetty tapahtuma, koska se jättää käyttäjälle
mahdollisuuden perua toiminto napsautuksen jälkeen vetämällä osoitin pois painikkeen kohdalta.

Hiiren painikkeen napsauttaminen (ilman vapauttamista). Jos mitään erityistä syytä Napsautettaessa-tapahtuman käyttöön ei
ole, suositellaan Vapautettaessa-tapahtuman käyttämistä, jotta käyttäjille jää mahdollisuus perua toiminto.

Hiiriosoittimen siirtäminen painikkeen muokkausalueen määrittämälle painikkeen alueelle.

Hiiriosoittimen siirtäminen pois painikkeen alueelta.
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Kohdistettuna

Kohdistamattomana

Mene kohteeseen

Siirry ensimmäiselle/viimeiselle/seuraavalle/edelliselle sivulle

Siirry URL-osoitteeseen

Näytä/kätke painikkeet

Video

Ääni

Animaatio (SWF/EPUB)

Siirry sivulle (SWF/EPUB)

Siirry tilaan (SWF/EPUB)

Siirry seuraavaan/edelliseen tilaan (SWF/EPUB)

Siirry seuraavaan näkymään (PDF)

Siirry edelliseen näkymään (PDF)

Avaa tiedosto (PDF)

Näytä zoomaus (PDF)

Kohdistuksen siirtäminen PDF-tiedoston painikkeeseen hiirellä tai sarkainnäppäimellä.

Kun kohdistus siirtyy eri painikkeeseen tai lomakekenttään PDF-tiedostossa.

Toimintotyypit

Kun luot toiminnon, määrität, mitä tapahtuu tietyn tapahtuman yhteydessä (tavallisesti käyttäjä napsauttaa tällöin painiketta). Voit määrittää
seuraavat toiminnot suoritettaviksi tapahtumatyypin yhteydessä:

Siirtyy määritettyyn tekstiankkuriin, joka on luotu Kirjanmerkit- tai Hyperlinkit-paneelista. Katso Tekstiankkuriin siirtävän
painikkeen luominen.

Siirtyy kiinteään asetteluun perustuvan EPUB-, PDF- tai SWF-tiedoston
ensimmäiselle, viimeiselle, edelliselle tai seuraavalle sivulle. Valitse Zoomaa-valikosta vaihtoehto, joka määrittää, miten sivu näytetään.

Avaa verkkosivun, johon määritetty URL-osoite viittaa.

Näyttää määritetyt painikkeet viedyssä kiinteään asetteluun perustuvassa EPUB-, PDF- tai SWF-tiedostossa tai kätkeä
ne. Jos haluat esimerkiksi yhden painikkeen ilmestyvän, kun hiiri siirtyy toisen painikkeen päälle, voit kätkeä kohdepainikkeen, kunnes se
liipaistaan ja luoda toiminnon, joka näyttää kätketyn painikkeen painikkeen päälle siirryttäessä. Katso Erilaisen kuvan näyttäminen painikkeen
päälle siirryttäessä.

Valitun elokuvan toisto voidaan käynnistää, keskeyttää ja pysäyttää sekä keskeytettyä toistoa voidaan jatkaa. Vain elokuvat, jotka on lisätty
julkaisuun, näkyvät Video-valikossa.

Valitun äänileikkeen toisto voidaan käynnistää, keskeyttää ja pysäyttää sekä keskeytettyä toistoa voidaan jatkaa. Vain äänileikkeet, jotka on
lisätty julkaisuun, näkyvät Ääni-valikossa.

Valitun animaation toisto voidaan käynnistää, keskeyttää ja pysäyttää sekä keskeytettyä toistoa voidaan jatkaa. Vain
animaatiot, jotka on lisätty julkaisuun, näkyvät Animaatio-valikossa.

Siirtyy SWF-tiedostossa määritetylle sivulle.

Siirtyy tiettyyn tilaan useissa tiloissa olevassa objektissa. Jos esimerkiksi useissa tiloissa olevassa objektissa on useita
erilaisia kuvia tiloina, voit käyttää tämä toimintoa, kun haluat näyttää tietyn kuvan.

Siirtyy seuraavaan tai edelliseen tilaan useissa tiloissa olevassa objektissa. Nämä asetukset
ovat erityisen käteviä diaesityksen selaamiseen. Katso Useissa tiloissa olevien objektien luominen.

Jatkaa eteenpäin edelliseen näkymään siirtymisen jälkeen. Samalla tavoin kuin verkkoselaimen Seuraava-
painike on käytettävissä vain Edellinen-painikkeen napsauttamisen jälkeen, tämä valinta on käytettävissä vain, kun käyttäjä on ensin siirtynyt
edelliseen näkymään.

Siirtyy viimeksi tarkastellulle sivulle PDF-julkaisussa tai palaa viimeksi käytettyyn zoomausasetukseen.

Käynnistää ja avaa määritetyn tiedoston. Jos määrität muun kuin PDF-tiedoston, sen avaamiseen tarvitaan
alkuperäissovellus. Määritä suora polkunimi (esimerkiksi c:\docs\sample.pdf).

Näyttää sivun määritetyn zoomausasetuksen mukaisesti. Voit valita sivun zoomausasteen (esimerkiksi Todellinen koko),
sivuasettelun (esimerkiksi Jatkuva - vastakkaiset sivut) tai kiertosuunnan.
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Huomautus:

Huomautus:

Alkuun

Huomautus:

Painikkeen toimintojen muokkaaminen tai poistaminen

1. Valitse painike valintatyökalulla. 

2. Tee Painikkeet-paneelissa jokin seuraavista toimista:

Voit poistaa toimintoja käytöstä poistamalla kohteen vieressä olevan valintaruudun valinnan. Toimintojen käytöstä poistaminen voi olla
hyödyllistä testaustarkoituksessa.

Voit vaihtaa toimintojen järjestystä vetämällä ja pudottamalla.

Voit poistaa toiminnon valitsemalla toiminnon luetteloruudusta ja napsauttamalla Poista valittu toiminto -painiketta .

Jos haluat muokata toimintoa, valitse tapahtuma, jolle toiminto on määritetty, valitse toiminto luetteloruudusta ja muuta sitten asetuksia.
Jos haluat korvata tapahtuman toiminnon, poista kyseinen toiminto ja lisää sitten tapahtumaan uusi toiminto.

Tekstiankkuriin siirtävän painikkeen luominen

Jos luot InDesign-julkaisuun tekstiankkurin, voit määrittää painikkeeseen siirtymisen kyseiseen ankkuriin, vaikka se olisi toisessa InDesign-
julkaisussa. Voit lisätä tekstiankkureita Kirjanmerkit- ja Hyperlinkit-paneelissa. Et voi luoda siirtymiä painikkeista kirjanmerkkeihin, jotka eivät ole
tekstiankkureita.

jos määrität painikkeelle hyperlinkkikohteen, hyperlinkillä ei ole vaikutusta viedyssä kiinteään asetteluun perustuvassa EPUB-, PDF-
tai SWF-tiedostossa.

1. Valitse painike valintatyökalulla. 

2. Valitse Painikkeet-paneelista Vapautettaessa tai muu tapahtuma, joka aktivoi siirtymisen.

3. Napsauta Toiminnot-kohdan vieressä olevaa plusmerkkiä ja valitse Mene kohteeseen.

4. Valitse Julkaisut-valikosta yksi avoimista InDesign-julkaisuista tai napsauta valikon oikealla puolella olevaa kansiokuvaketta ja määritä
tiedosto.

5. Määritä Kirjanmerkit- tai Hyperlinkit-paneelin avulla luotu ankkuri.

6. Valitse Zoomaa-valikosta vaihtoehto, joka määrittää, miten sivu näytetään.

Jos määrität toisessa julkaisussa olevan ankkurin, muista viedä kohdejulkaisu PDF-muotoon ja käyttää samaa tiedostonimeä kuin
InDesign-julkaisussa (INDD-tunniste korvattuna PDF-tunnisteella). Sijoita lisäksi PDF-julkaisut samaan kansioon, jotta linkit varmasti toimivat
Acrobatissa ja Readerissa.

Painikkeen ulkoasun muuttaminen painikkeen päälle siirryttäessä tai sitä napsautettaessa

Painike koostuu ryhmästä erillisiä objekteja, joista kukin edustaa painikkeen ulkoasua (jota kutsutaan joskus tilaksi). Painikkeella voi olla kolme
ulkoasua: Normaali, Rollover ja Napsautus. Viedyssä tiedostossa Normaali-ulkoasu on voimassa, kunnes hiiriosoitin siirretään painikkeen alueelle
(Rollover) tai hiirellä napsautetaan painikkeen alueella (Napsautus). Voit tehdä jokaista ulkoasusta erilaisen ja antaa näin käyttäjälle visuaalista
palautetta.

Oletusarvon mukaan luodun painikkeen teksti tai kuva määritetään painikkeen Normaali-ulkoasuksi. Kun aktivoit uuden ulkoasun, Normaali-ulkoasu
kopioidaan. Voit erottaa ulkoasun muista ulkoasuista muuttamalla väriä tai lisäämällä tekstin tai kuvan.

Painikkeen tilat

A. Osoitin ei ole painikkeen alueella (Normaali) B. Osoitin siirretään painikkeen alueelle (Rollover) C. Osoitin napsauttaa (Napsautus) 

Painikkeen napsautettava alue eli kohdepiste on painikkeen suurimman tilan neliön muotoinen muokkausalue. Esimerkiksi pyöreällä
painikkeella on neliön muotoinen kohdepiste.
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Huomautus:

Alkuun

Painikkeen ulkoasujen muuttaminen

Jos olet luomassa painiketta, jolla on useita ulkoasuja (Normaali, Rollover ja Napsautus), kannattaa viimeistellä painikkeen suunnittelu, ennen kuin
aktivoit muita ulkoasuja. Kun aktivoit Rollover- tai Napsautus-ulkoasun, Normaali-ulkoasu kopioidaan.

Osa muutoksista vaikuttaa vain valittuun ulkoasuun, kun taas osa muutoksista vaikuttaa kaikkiin ulkoasuihin. Jos valitset ulkoasun ja otat eri
taustavärin käyttöön tai muokkaat tekstiä, muutos vaikuttaa vain valittuun ulkoasuun. Jos siirrät painiketta tai muutat sen kokoa valintatyökalulla,
muutos vaikuttaa kaikkiin ulkoasuihin.

1. Avaa Painikkeet-paneeli valitsemalla Ikkuna > Vuorovaikutteinen > Painikkeet.

2. Valitse muokattava painike asettelusta valintatyökalulla .

3. Aktivoi Rollover-ulkoasu valitsemalla [Rollover].

Normaali-ulkoasu kopioidaan Rolloveriin.

4. Kun Rollover on valittuna, muuta painikkeen ulkoasua.

Jos haluat vaihtaa väriä, valitse värimalli Ohjauspaneelin Täyttö- tai Viiva-valikosta.

Asettaaksesi kuvan ulkoasuun valitse nykyinen kuva suoravalintatyökalulla tai kaksoisnapsauta nykyistä painikekuvaa, ja valitse sitten
Tiedosto > Sijoita ja kaksoisnapsauta tiedostoa.

Voit liittää kuvan tekstikehykseen kopioimalla sen leikepöydälle, valitsemalla ulkoasun Painikkeet-paneelista ja valitsemalla sitten
Muokkaa > Liitä kohteeseen.

Voit lisätä tekstiä valitsemalla tekstityökalun, napsauttamalla painiketta ja kirjoittamalla tekstin. Voit myös kopioida liitetyn tekstikehyksen
valitsemalla Muokkaa > Liitä kohteeseen.

5. Jos haluat lisätä Napsautus-ulkoasun, aktivoi ulkoasu valitsemalla [Napsautus] ja noudata ohjeita, jotka koskevat ulkoasun muuttamista.

6. Voit kokeilla painikkeen erilaisia ulkoasuja Esikatselu-paneelissa.

Jos haluat muuttaa Painikkeet-paneelin Tilan ulkoasu -miniatyyreja, valitse Painikkeet-paneelin valikosta Paneeliasetukset, valitse asetus ja
valitse sitten OK.

Ulkoasujen poistaminen kokonaan tai käytöstä

1. Valitse ulkoasu Painikkeet-paneelista.

2. Tee jokin seuraavista toimista:

Jos haluat poistaa Rollover- tai Napsautus-ulkoasun, napsauta paneelin alaosan Poista-kuvaketta. Ulkoasu kannattaa poistaa
esimerkiksi silloin, kun muokkaat Normaali-ulkoasua monin eri tavoin ja haluat käyttää uutta Normaali-ulkoasua Rollover- tai Napsautus-
ulkoasun pohjana.

Voit poistaa ulkoasun käytöstä sitä kokonaan poistamatta napsauttamalla ulkoasun vieressä olevaa silmäkuvaketta. Käytöstä poistettuja
tiloja ei viedä kiinteään asetteluun perustuvaan EPUB-, PDF- tai SWF-tiedostoon.

Normaali-tilaa ei voi poistaa kokonaan tai ottaa pois käytöstä.

Useissa tiloissa olevien objektien luominen

Objektien tila -paneelista voit luoda useita objektiversioita. Tila on sivukohteen versio. Useita tiloja sisältävää objekti tunnetaan nimellä useissa
tiloissa oleva objekti.

Objektin tilat -paneeli ei rajoita objektille luotavien tilojen määrää. Aina luodessasi tilan luot uuden version sivukohteesta. Sivulla näkyy vain yksi
tila kerrallaan. Tulostuksen ja PDF-tulosteen lopputuloksessa näkyy vain aktiivinen tila.

Diaesityksen luominen useissa tiloissa olevalla objektilla

Yksi yleisimmistä useissa tiloissa olevan objektin käyttötavoista on diaesitys, jonka avulla SWF-tiedoston käyttäjä voi selata kuvajoukkoa. Voit
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esimerkiksi luoda 20 kuvan diaesityksen, mutta sinun ei tarvitse sijoittaa kuvia 20 eri sivulle.

1. Sijoita diaesityksessä näytettävät kuvat.

Varmista kuvakehysten olevan saman kokoisia. Näin saat parhaan tuloksen.

Tilan ei tarvitse olla yksittäinen kohde, vaan se voi olla kohdejoukko.

2. Kun haluat pinota kuvat, valitse ne ja napsauta Ohjauspaneelista Tasaa vaakasuunnassa keskelle  ja Tasaa pystysuunnassa keskelle .

3. Kun kuvat ovat edelleen valittuina, avaa Tilat-paneeli (Ikkuna > Vuorovaikutteinen > Objektin tilat) ja napsauta Muunna valinta useissa
tiloissa olevaksi objektiksi -painiketta .

Kuvat näkyvät tiloina Objektin tilat -paneelissa ja valittuja kuvia rajaa katkoviivalla piirretty kehys.

4. Luo navigointipainikkeet, jotka käynnistävät Siirry seuraavaan tilaan- ja Siirry edelliseen tilaan -toiminnot, kun hiiri vapautetaan. Katso
Painikkeiden luominen.

5. Kokeile navigointipainikkeita Esikatselu-paneelissa (Ikkuna > Vuorovaikutteisuus > EPUB-julkaisujen vuorovaikutteisuuden esikatselu / SWF-
esikatselu).

6. Vie julkaisu SWF-muodossa. Katso Vuorovaikutteiset julkaisut.

Useissa tiloissa olevan objektin muokkaaminen

1. Valitse useissa tiloissa oleva objekti.

2. Tee Objektin tilat -paneelissa jokin seuraavista toimista:

Jos haluat muokata tilaa, valitse tila Objektin tilat -paneelista ja muokkaa sitten objektia. Voit esimerkiksi lisätä viivan tai täytön tai
muuttaa objektin kokoa.

Jos haluat lisätä objektin aiemmin luotuun tilaan, valitse sekä objekti että useissa tiloissa oleva objekti ja napsauta sitten Kaikki objektit
näkyvään tilaan -painiketta .

Jos haluat lisätä objektin aiemmin luotuun useissa tiloissa olevaan objektiin, valitse sekä objekti että useissa tiloissa oleva objekti ja
napsauta sitten Muunna valinta useissa tiloissa olevaksi objektiksi -painiketta .

Jos haluat monistaa tilan, valitse tila, johon uusi tila perustuu, ja valitse paneelivalikosta Uusi tila. Lisää, poista tai muokkaa kyseisen tilan
sisältöä.

Jos haluat liittää objekteja aiemmin luotuun tilaan, leikkaa tai kopioi yksi tai useita objekteja, valitse useissa tiloissa oleva objekti, valitse
tila Objektin tilat -paneelista ja valitse Objektin tilat -paneelivalikosta Liitä tilaan.

Jos haluat muuntaa useissa tiloissa olevan objektin takaisin riippumattomiksi objekteiksi, valitse tila Objektin tilat -paneelista ja valitse
paneelivalikosta Vapauta tila objekteiksi. Jos haluat muuntaa useissa tiloissa olevan objektin kaikki tilat objekteiksi, valitse Vapauta kaikki
tilat objekteiksi.

Jos haluat poistaa tilan ja sen sisällön, valitse tila ja valitse paneelivalikosta Poista tila.

Jos haluat kätkeä viedyssä tiedostossa olevan useissa tiloissa olevan objektin, kunnes se käynnistetään painikkeesta, valitse
paneelivalikosta Kätketty kunnes liipaistaan.

Jos haluat nollata kaikki julkaisun useissa tiloissa olevat objektit niiden ensimmäiseen tilaan, valitse paneelivalikosta Nollaa kaikki
useissa tiloissa olevat kohteet niiden ensimmäiseen tilaan. Kun valitset tilan, objekti pysyy kyseisessä tilassa vaikka suljet julkaisun ja
avaat sen uudelleen. Tämä on nopea keino nollata kaikki useissa tiloissa olevat objektit.

Kohdepisteiden luominen painikkeille

Joskus painikealueen (eli kohdepisteen tai kuuman linkin) pitää olla näkymätön, kunnes hiiriosoitin siirretään sen kohdalle. Kun esimerkiksi siirrät
osoittimen kartan painikkeen kohdalle, näyttöön voi avautua aluetta esittävä kuva, ja kuva voi kadota, kun siirrät osoittimen pois alueen kohdalta.

Viedyssä PDF-tiedostossa kuva saadaan näkyviin pitämällä osoitinta kohdepisteen kohdalla.
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Piilotetun kuvan näyttäminen painikkeen päälle siirryttäessä

Eräs tapa kohdepistevaikutuksen luomiseksi on liittää Rollover-tilaan kuva Tilat-paneelissa. Voit tehdä tämän luomalla painikkeen, jonka [Rollover]-
tila näyttää kuvan ja jonka [Normaali]-tila ei näytä kuvaa.

1. Valitse kuva, jota haluat käyttää kohdepisteenä. Varmista, ettei kuvan kehyksellä ole reunusta eikä taustaa.

2. Voit muuntaa valitun kuvan painikkeeksi napsauttamalla [Normaali]-ulkoasua Painikkeet-paneelissa (valitse Ikkuna > Vuorovaikutteinen >
Painikkeet).

3. Aktivoi Rollover-ulkoasu napsauttamalla [Rollover]-ulkoasua Painikkeet-paneelissa.

4. Napsauta [Normaali]-ulkoasua uudelleen. Valitse sitten kuva suoravalintatyökalulla  ja poista kuva.

Varmista, että poistat kuvan (kehyksen sisällön), etkä sekä kehystä että sen sisältöä. Kehyksen poistaminen poistaa koko painikkeen.

5. Voit esikatsella kohdepistetehosteita Esikatselu-paneelissa.

Erilaisen kuvan näyttäminen painikkeen päälle siirryttäessä

Voit luoda kohdepisteen, jossa näytetään toinen objekti, kun sitä napsautetaan tai kun hiiri siirtyy objektin päälle. Jos haluat tehdä tällaisen
kohdepisteen, luo kaksi painiketta, kätke toinen painike ja näytä ja piilota kohdepainike Näytä/Kätke painike -toiminnolla.

1. Luo lähdepainikkeena käytettävä objekti. Napsauta Muunna objekti painikkeeksi -kuvaketta Painikkeet-paneelissa.

2. Sijoita kohdepainikkeeksi haluamasi kuva ja muunna se painikkeeksi.

3. Valitse kohdekuva ja valitse Painikkeet-paneelin alaosasta Kätketty kunnes liipaistaan.

Kuvan täytyy olla kätketty viedyssä julkaisussa, jotta se voidaan näyttää, kun lähdepainiketta napsautetaan tai kun hiiri siirtyy sen päälle.

4. Valitse lähdepainike ja luo kaksi eri toimintoa, yksi näyttämään kohdekuva ja toinen kätkemään se.

Jos haluat kuvan ilmestyvän näkyviin, kun hiiri siirtyy lähdepainikkeen päälle, käytä Siirryttäessä painikkeen päälle- ja Siirryttäessä pois
painikkeelta -tapahtumia. Jos haluat kuvan ilmestyvän näkyviin, kun lähdepainiketta napsautetaan ja katoavan näkyvistä, kun lähdepainike
vapautetaan, käytä Napsautettaessa- ja Vapautettaessa-tapahtumia. Kummassakin tapauksessa voit käyttää Näytä/kätke painikkeet -
toimintoa kohdepainikkeen näyttämiseen ja kätkemiseen. Katso Vuorovaikutteisuuden lisääminen painikkeisiin.

5. Voit kokeilla painikkeita Esikatselu-paneelissa.

Painikkeiden PDF-asetusten muuttaminen

1. Valitse painike valintatyökalulla. 

2. Valitse Painikkeet-paneelin valikosta PDF-asetukset.

3. Kirjoita kuvaus, joka toimii vaihtoehtoisena tekstinä näkörajoitteisille käyttäjille.

4. Määritä tulostetaanko painike PDF-tiedostoon ja valitse OK.

Painikkeiden sarkainjärjestyksen määrittäminen

Sarkainjärjestys määrää seuraavan (tai edellisen) kentän, johon kohdistus siirtyy, kun käyttäjä painaa PDF- tai SWF-tiedostossa sarkainnäppäintä
(tai näppäinyhdistelmää vaihto+sarkain). Sarkainjärjestys sisältää kätkettyjen tasojen painikkeet, mutta ei sivupohjien painikkeita.

1. Siirry painikkeita sisältävälle sivulle.

2. Valitse Objekti > Vuorovaikutteinen > Määritä sarkainjärjestys.

3. Valitse painike, jota haluat siirtää, ja vedä se uuteen paikkaan. Voit myös napsauttaa Siirrä ylös- ja Siirrä alas -painikkeita. Kun olet valmis,
napsauta OK-painiketta.
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Jos muokkaat PDF-tiedostoa ja lisäät sivulle painikkeita tai lomakekenttiä Acrobatissa, voit joutua määrittämään myös uuden sarkainjärjestyksen.

Hyperlinkit-paneelin yleiskuvaus
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Vuorovaikutteiset web-julkaisut Flashille

SWF

FLA

Alkuun

Luo vuorovaikutteisia SWF (Flash) -tiedostoja web-käyttöön
Luo FLA-tiedostoja web-käyttöön
Flash-viennin ongelmat

Kun haluat luoda Flash Playerillä toistettavaa diaesitys-tyyppistä sisältöä, voit viedä sen joko SWF- tai FLA-muotoon. Suurin ero on siinä, että
SWF-tiedostot ovat valmiita katseltaviksi eikä niitä voi muokata siinä missä FLA-tiedostoja täytyy muokata Adobe Flash Professionalissa, jotta niitä
voi katsella Adobe Flash Playerissä.

Viety SWF-tiedosto on valmis katseltavaksi Adobe Flash Playerissä, ja se saattaa sisältää vuorovaikutteisia elementtejä, kuten sivusiirtymiä,
hyperlinkkejä, elokuvia, äänitiedostoja, animaatioita ja navigointipainikkeita.

Viety FLA-tiedosto sisältää vain muutamia vuorovaikutteisia elementtejä. FLA-tiedosto voidaan avata Flash Prossa, missä Flash-kehittäjä voi
lisätä edistyneitä tehosteita, ennen kuin tiedosto viedään SWF-muotoon.

Vieminen Flash-muotoon

A. Vieminen suoraan SWF-muotoon B. Vieminen FLA-muodossa muokattavaksi Flash Professionalissa 

Luo vuorovaikutteisia SWF (Flash) -tiedostoja web-käyttöön

Kun viet SWF-muodossa, luot vuorovaikutteisen tiedoston, jota voit katsella Adobe Flash Playerissä tai web-selaimessa. SWF-tiedosto saattaa
sisältää InDesignissa lisättyjä painikkeita, sivusiirtymiä, elokuva- ja äänitiedostoja, animaatioita ja hyperlinkkejä. SWF-muodossa vieminen on hyvä
tapa luoda InDesign-julkaisuun perustuva vuorovaikutteinen diaesitys tai animaatio.

jos haluat muokata julkaisua Flash Prossa, ennen kuin luot SWF-tiedoston, vie se FLA-muodossa SWF:n sijasta. Katso Luo FLA-tiedostoja web-
käyttöön.
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Vieminen

SWF-vienti

A. Julkaisu InDesignissa ennen SWF-vientiä B. Vuorovaikutteinen SWF-tiedosto Web-selaimessa 

1. Luo tai muokkaa InDesign-julkaisua valmistellaksesi sen Flash-vientiä varten. Lisätietoja asiakirjan valmistelemisesta vientiä varten on
artikkelissa Flash-viennin ongelmat.

Lisää navigointipainikkeet, joilla käyttäjät voivat siirtyä sivulta toiselle viedyssä SWF-tiedostossa. Voit luoda painikkeet piirtämällä
objektin ja muuntamalla sen painikkeeksi Painikkeet-paneelissa (valitse Ikkuna > Vuorovaikutteinen > Painikkeet). Voit myös käyttää
Näytepainikkeet-paneelia ja vetää esimääritettyjä navigointipainikkeita julkaisuun. Katso Painikkeiden luominen.

Sivun siirtymät -paneelista (valitse Ikkuna > Vuorovaikutteinen > Sivusiirtymät) voit lisätä sivusiirtymiä, kuten pyyhkäisyjä ja ristikuvia.
Kun viet SWF-muodossa voit myös valita Sisällytä interaktiivinen sivun kääntö -asetuksen, jolla katselijat voivat voivat kääntää sivua
vetämällä sivun kulmasta.

Animaatio-paneelista (valitse Ikkuna > Vuorovaikutteinen > Animaatio) voit lisätä liikkeen esimäärityksiä. Katso Animaatio.

2. Vie julkaisu SWF-muodossa valitsemalla Tiedosto > Vie. Valitse Tallennusmuoto-luettelosta (Windows) tai Muoto-luettelosta (Mac OS),
Flash Player (SWF) ja napsauta Tallenna-painiketta.

3. Määritä Vie SWF -valintaikkunassa seuraavat asetukset ja valitse sitten OK. Katso SWF-vientiasetukset.

Kun viet SWF-tiedoston, luodaan erilliset HTML- ja SWF-tiedostot. Jos SWF-tiedostossa on videota tai äänileikkeitä, luodaan myös Resurssit-
kansio. Kun siirrät tai lataat tiedostoja Internetiin, muista siirtää kaikki materiaali.

SWF-vientiasetukset

SWF-vientiasetukset-valintaikkunan Yleiset- ja Lisäasetukset-välilehdillä on seuraavat asetukset.

Ilmaisee viedäänkö valinta, kaikki julkaisun sivut vai sivualue. Valinta on erityisen kätevä, jos haluat tallentaa viedyn SWF-tiedoston
käytettäväksi viedyssä PDF-tiedostossa. Jos valitset Alueen, määritä sivualue kuten 1-7, 9, jos haluat tulostaa sivut yhdestä seitsemään ja sivun
yhdeksän. Katso Tulostettavien sivujen määrittäminen.
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Luo HTML-tiedosto

Näytä SWF viennin jälkeen

Koko (pikseleinä)

Tausta

Vuorovaikutteisuus ja väline

Sivun siirtymät

Sisällytä interaktiivinen sivun kääntö

Kuvataajuus

Teksti

Rasteroi sivut

Yhdistä läpinäkyvyys

Pakkaus

JPEG-laatu

Resoluutio

Alkuun

Valitse tämä asetus, kun haluat luoda SWF-tiedoston toistavan HTML-sivun. Tätä asetusta kannattaa käyttää erityisesti
silloin, kun on tarpeen nopeasti esikatsella SWF-tiedosto Web-selaimessa.

Valitse tämä asetus, kun haluat toistaa SWF-tiedoston Web-oletusselaimessa. Tämä asetus on käytettävissä vain,
jos luot HTML-tiedoston.

Määritä, skaalataanko SWF-tiedosto prosenttiosuuden mukaan, sovitetaanko se määritettyyn näytön kokoon vai määritetäänkö
sille leveys- ja korkeusarvo.

Määritä onko SWF:n tausta läpinäkyvä vai käyttääkö se Värimallit-paneelissa valittuna olevaa paperin väriä. Jos valitset Läpinäkyvän,
sivusiirtymät ja interaktiivinen sivun kääntö -asetukset eivät ole käytettävissä.

Jos haluat sallia vuorovaikutteiset elokuvat, äänet, painikkeet ja animaatiot viedyssä SWF-tiedostossa, valitse
Sisällytä kaikki. Jos haluat sisällyttää painikkeiden normaalitilan ja elokuvien julistekuvat pysyvinä elementteinä, valitse Vain ulkoasu. Jos Vain
ulkoasu on valittuna, animaatiot viedään sellaisina, kuin ne näkyvät asettelussa viennin aikana. Vain ulkoasu on valittuna, jos valitset
Lisäasetukset-paneelista Yhdistä läpinäkyvyys -asetuksen.

Määritä jokin sivusiirtymä, jota käytetään kaikissa sivuissa viennin aikana. Jos määrität siirtymät Sivun siirtymät -paneelista, käytä
kyseisiä asetuksia valitsemalla Julkaisusta-vaihtoehdon.

Jos tämä asetus on valittu, käyttäjät voivat SWF-tiedostoa toistaessaan kääntää sivua vetämällä sivun
kulmaa. Tämä toiminto näyttää aivan oikean kirjan sivun kääntämiseltä.

Korkeampi kuvataajuus luo tasaisemman animaation, mutta saattaa kasvattaa tiedoston kokoa. Kuvataajuuden muuttaminen ei
vaikuta toiston kestoon.

Määritä, miten InDesign-teksti tuotetaan. Valitse Flash Classic -teksti, jos haluat luoda haettavaa tekstiä, joka tuottaa pienikokoisen
tiedoston. Valitse Muunna ääriviivoiksi, jos haluat muuntaa tekstin tasoitettujen suorien viivojen sarjaksi, aivan kuten muunnettaessa tekstiä
ääriviivoiksi. Valitse Muunna pikseleiksi, jos haluat muuntaa tekstin bittikarttakuvaksi. Pikseleiksi muunnettu teksti saattaa näyttää rosoiselta
zoomattaessa.

Tämä asetus muuntaa InDesign-sivun kaikki objektit bittikartaksi. Jos valitset tämän asetuksen, SWF-tiedoston koko kasvaa ja
sivun objektit näkyvät rosoisina zoomattaessa lähemmäksi.

Tämä asetus poistaa läpinäkyvyyden SWF-tiedostosta, mutta säilyttää läpinäkyvän ulkoasun. Kaikki vuorovaikutteisuus
kuitenkin poistetaan viedystä SWF-tiedostosta, jos tämä asetus on valittuna.

Jos valitset Automaattinen-asetuksen, InDesign määrittää väri- ja harmaasävykuvien parhaan laadun. Useimmilla tiedostoilla tämä
asetus tuottaa tyydyttävän tuloksen. JPEG (häviöllinen) sopii harmaasävy- ja värikuville. JPEG-pakkaus on häviöllinen eli se poistaa kuvatietoja ja
voi heikentää kuvalaatua. Se kuitenkin pyrkii pienentämään tiedoston kokoa ja minimoimaan tietojen häviämisen. Koska JPEG-pakkaus poistaa
tietoja, tiedosto pakkautuu huomattavasti pienemmäksi. Valitse PNG (häviötön), jos haluat viedä tiedoston ilman häviöllistä pakkausta.

Jos havaitset läpinäkyvien kuvien laadun heikkenemistä vietäessä SWF-muotoon, paranna laatua valitsemalla pakkaustavaksi PNG (häviötön).

Määrittää viedyn kuvan yksityiskohtien määrän. Mitä korkeampi laatu, sitä suurempi tiedosto. Tämä asetus on himmennetty, jos
pakkaustavaksi on valittu PNG (häviötön).

Määritä bittikarttakuvien resoluutio viedyssä SWF-tiedostossa. Korkean resoluution valinta on erityisen tärkeää, jos haluat antaa
katsojien zoomata pikselipohjaista sisältöä viedyssä SWF-tiedostossa. Korkean resoluution valita voi kasvattaa merkittävästi tiedoston kokoa.

Luo FLA-tiedostoja web-käyttöön

Kun viet InDesign-julkaisun FLA-tiedostomuotoon, voit avata tiedoston Adobe Flash® CS5 Professionalissa ja muokata sen sisältöä. FLA-vienti
InDesign CS5 -muodossa korvaa XFL-viennin InDesign CS4:ssä. Voit käyttää Flash-muokkausympäristöä videon, äänen, animaation ja
monimutkaisten vuorovaikutteisuusominaisuuksien lisäämiseen tai muokkaamiseen.
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Vieminen

Rasteroi sivut

Yhdistä läpinäkyvyys

Jos haluat viedä InDesign-julkaisun suoraan sellaiseen muotoon, joka voidaan avata suoraan web-selaimessa, käytä SWF-muotoa FLA:n sijasta.
Katso Luo vuorovaikutteisia SWF (Flash) -tiedostoja web-käyttöön.

FLA-vienti

A. Julkaisu InDesignissa ennen FLA-vientiä B. Flash Prolla avattu FLA-tiedosto 

1. Luo tai muokkaa InDesign-julkaisua valmistellaksesi sen Flash-vientiä varten. Lisätietoja asiakirjan valmistelemisesta vientiä varten on
artikkelissa Flash-viennin ongelmat.

2. Vie julkaisu FLA-muodossa valitsemalla Tiedosto > Vie. Valitse Tallennusmuoto-luettelosta (Windows) tai Muoto-luettelosta (Mac OS), Flash
CS5 Professional (FLA) ja napsauta Tallenna-painiketta.

3. Määritä seuraavat asetukset Vie Flash CS5 Professional (FLA) -tiedostoon -valintaikkunassa ja valitse sitten OK. Lisätietoja vientiasetuksista
on artikkelissa FLA-vientiasetukset.

4. Avaa viety FLA-tiedosto Flash Professionalissa.

FLA-vientiasetukset

Vie Flash CS5 Professional (FLA) -tiedostoon -valintaikkunassa on seuraavat asetukset.

Ilmaisee viedäänkö valinta, kaikki julkaisun sivut vai sivualue. Jos valitset Alueen, määritä sivualue kuten 1-7, 9, jos haluat tulostaa
sivut yhdestä seitsemään ja sivun yhdeksän. Katso Tulostettavien sivujen määrittäminen.

Tämä asetus muuntaa InDesign-sivun kaikki objektit bittikartaksi. Jos valitset tämän asetuksen, FLA-tiedoston koko kasvaa ja
sivun objektit voivat näkyä rosoisina zoomattaessa lähemmäksi.

Jos valitset tämän asetuksen, kaikki objektit yhdistetään ja käytetään läpinäkyvyyttä. Yhdistettyjen objektien animointi voi
olla vaikeaa Adobe Flash Prossa.

612

http://idiom-q-win-1/fi/indesign/using/printing-documents.html#specifying_pages_to_print


Koko (pikseleinä)

Vuorovaikutteisuus ja väline

Teksti

Pakkaus

JPEG-laatu

Resoluutio

Alkuun

InDesign-sivujen muuntaminen

Sivukoko

Painikkeet

Sivun siirtymät

Määritä, skaalataanko FLA-tiedosto prosenttiosuuden mukaan, sovitetaanko se määritettyyn näytön kokoon vai määritetäänkö
sille leveys- ja korkeusarvo.

Jos haluat sallia elokuvien, äänien, painikkeiden ja animaatioiden sisällyttämisen vietyyn FLA-tiedostoon, valitse
Sisällytä kaikki. Jos julkaisu sisältää useissa tiloissa olevan objektin, se muunnetaan elokuvasymboliksi, jossa jokainen tila näkyy omana
kehyksenä aikajanalla.
Jos haluat sisällyttää painikkeiden normaalitilan ja elokuvien julistekuvat pysyvinä elementteinä, valitse Vain ulkoasu. Jos Vain ulkoasu on
valittuna, animaatiot viedään sellaisina, kuin ne näkyvät asettelussa viennin aikana. Vain ulkoasu on valittuna, jos valitset Yhdistä läpinäkyvyys -
asetuksen.

Määritä, miten InDesign-teksti tuotetaan. Valitse Flash TLF -teksti, jos haluat käyttää Flash Professionalin laajaa tekstiasettelun
määrevalikoimaa. Jos tämä asetus on valittu, ota tavutus käyttöön valitsemalla Lisää tavutusvihjepisteet. Valitse Flash Classic -teksti, jos haluat
luoda haettavaa tekstiä, joka tuottaa pienikokoisen tiedoston. Valitse Muunna ääriviivoiksi, jos haluat muuntaa tekstin tasoitettujen suorien viivojen
sarjaksi, aivan kuten muunnettaessa tekstiä ääriviivoiksi. Valitse Muunna pikseleiksi, jos haluat muuntaa tekstin bittikarttakuvaksi. Pikseleiksi
muunnettu teksti saattaa näyttää rosoiselta zoomattaessa.

Jos valitset Automaattinen-asetuksen, InDesign määrittää väri- ja harmaasävykuvien parhaan laadun. Useimmilla tiedostoilla tämä
asetus tuottaa tyydyttävän tuloksen. JPEG (häviöllinen) sopii harmaasävy- ja värikuville. JPEG-pakkaus on häviöllinen eli se poistaa kuvatietoja ja
voi heikentää kuvalaatua. Se kuitenkin pyrkii pienentämään tiedoston kokoa ja minimoimaan tietojen häviämisen. Koska JPEG-pakkaus poistaa
tietoja, tiedosto pakkautuu huomattavasti pienemmäksi. Valitse PNG (häviötön), jos haluat viedä tiedoston ilman häviöllistä pakkausta.

Määrittää viedyn kuvan yksityiskohtien määrän. Mitä korkeampi laatu, sitä suurempi tiedosto. Tämä asetus on himmennetty, jos
pakkaustavaksi on valittu PNG (häviötön).

Määritä bittikarttakuvien resoluutio viedyssä FLA-tiedostossa. Korkean resoluution valinta on erityisen tärkeää, jos haluat antaa
katsojien zoomata pikselipohjaista sisältöä. Korkean resoluution valita voi kasvattaa merkittävästi tiedoston kokoa.

Flash-viennin ongelmat

Ota huomioon seuraavat asiat, kun suunnittelet InDesign-julkaisua SWF- tai FLA-tulostusta varten.

Julkaisun asetukset

Kun viet julkaisun SWF- tai FLA-muotoon, InDesign-aukeamat muunnetaan aikajanan erillisiksi leikkeiksi. Ne
muistuttavat diaesityksen dioja. Kukin aukeama osoittaa uuteen avainkuvaan. Voit Flash Playerissä siirtyä viedyn julkaisun aukeamalta toiselle
painamalla nuolinäppäimiä tai napsauttamalla vuorovaikutteisia painikkeita.

Kun luot web-käyttöön tarkoitetun julkaisun, valitse Uusi julkaisu -valintaikkunan Peruste-valikosta Web.

Kun luot uuden julkaisun, voit Uusi julkaisu -valintaikkunan Sivukoko-valikosta valita haluamasi resoluution, kuten 800 x 600. Voit
viennin aikana säätää SWF- tai FLA-tiedoston skaalausta tai resoluutiota.

Vuorovaikutteisuusominaisuudet

Viedyt SWF- ja FLA-tiedostot saattavat sisältää painikkeita, sivusiirtymiä, hyperlinkkejä, animaatioita ja mediatiedostoja.

Kun katselet vietyä SWF- tai FLA-tiedostoa Flash Playerillä, voit Seuraava sivu- ja Edellinen sivu -toimintojen avulla toistaa tiedoston
sisältöä. Ota huomioon, että osa vuorovaikutteisissa PDF-tiedostoissa toimivista toiminnoista ei näy Flash Playerissä. Kun valitset toimintoa
Painikkeet-paneelista, älä valitse asetusta Vain PDF -osiosta.

Voit lisätä navigointipainikkeita, joille on esimääritetty Siirry seuraavalle sivulle- tai Siirry edelliselle sivulle -toiminto. Valitse Painikkeet-
paneelivalikosta Näytepainikkeet. Katso Painikkeen lisääminen Näytepainikkeet-paneelista.

Kaikki sivun siirtymät toimivat oikein Flash Playerissä. Sivun siirtymät näkyvät, kun käännät sivua. Näiden siirtymien lisäksi voit
sisällyttää vientiin vuorovaikutteisen sivunkäännön. Tällöin voit kääntää sivua vetämällä sivun kulmaa.

613

http://idiom-q-win-1/fi/indesign/using/buttons.html#add_a_button_from_the_sample_buttons_panel


  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Hyperlinkit

Elokuvat ja äänileikkeet

Väri

Teksti

Kuvat

Läpinäkyvyys

3D-määritteet

Luo linkkejä Web-sivustoihin tai julkaisun toisille sivuille. Hyperlinkit eivät toimi FLA-tiedostoissa.

Elokuvat ja äänileikkeet sisällytetään vietyyn SWF-tiedostoon, jos ne ovat tuetussa muodossa, kuten SWF, FLV, F4V ja
MP4 elokuville ja MP3 äänileikkeille.
Kun viet FLA-muodossa, vain julistekuva sisällytetään FLA-tiedostoon. Tuetut mediatiedostot näkyvät resurssikansiossa, joka on tallennettu
samaan kansioon kuin viety FLA-tiedosto.

Muunto-ongelmat

SWF- ja FLA-tiedostot käyttävät RGB-värejä. Kun julkaisu viedään SWF- tai FLA-muotoon, InDesign muuntaa kaikki väriavaruudet (esim.
CMYK ja Lab) sRGB-väriavaruuksiksi. InDesign muuntaa spottivärit vastaaviksi RGB-prosessiväreiksi.
Voit välttää ei-toivotut värinmuutokset läpinäkyvää tekstiä sisältävissä kuvissa valitsemalla Muokkaa > Läpinäkyvyyden sekoitustila > RGB-julkaisu.
Jos haluat välttää ei-toivotut värinmuutokset läpinäkyvyyttä käyttävissä kuvissa, vältä häviöllisen pakkauksen käyttöä viennissä.

Kun viet SWF- tai FLA-muodossa, voit määrittää tulostetaanko teksti Flash-tekstinä vain muunnetaanko se ääriviivoiksi tai pikseleiksi.
Flash-tekstinä vietyä tekstiä voi muokata, kun FLA-tiedosto avataan Adobe Flash CS5 Professionalissa. Kun tällainen teksti tallennetaan SWF-
tiedostoon, tekstiä voidaan hakea Web-selaimissa.

Kun viet kuvia SWF- tai FLA-muotoon, voit muuttaa kuvan pakkauksen, JPEG-laadun ja käyrän laadun asetuksia viennin aikana.
Kun viet kuvia FLA-muotoon, InDesign-julkaisuun useita kertoja sijoitettu kuva tallennetaan yhtenä kuvatiedostona, jolla on jaettu sijainti. Huomaa,
että jos InDesign-julkaisussa on runsaasti vektorikuvia, saatat havaita suorituskykyongelmia viedyssä tiedostossa.
Voit pienentää tiedoston kokoa sijoittamalla toistuvat kuvat sivupohjaan. Tällöin kuvia ei tarvitse kopioida ja liittää. Jos sama kuva sijoitetaan
julkaisuun useita kertoja eikä kuvaa muunneta tai rajata, vain yksi tiedoston kopio viedään FLA-tiedostoon. Kopioituja ja liitettyjä kuvia käsitellään
erillisinä objekteina.
Oletusarvon mukaan sijoitettua Illustrator-tiedostoa käsitellään yksittäisenä kuvana FLA-tiedostossa, kun taas kopioitu ja liitetty Illustrator-tiedosto
luo useita yksittäisiä objekteja. Saat aikaan parhaan tuloksen, kun sijoitat Illustrator-kuvan PDF-tiedostona sen sijaan, että kopioisit ja liittäisit sen
Illustratorista. Kuvien kopioiminen ja liittäminen tuottaa useita muokattavia polkuja.

Voit asetuksia muuttamalla varmistaa, että Illustrator-objektit liitetään yhtenä objektina eikä pienten vektorien kokoelmana. Valitse Illustratorin
tiedoston käsittelyn ja leikepöydän asetuksista PDF ja poista AICB:n valinta (ei läpinäkyvyyden tukea). Valitse InDesignin Leikepöydän käsittely
-asetuksista sekä Käytä sijoitettaessa ensisijaisesti PDF-muotoa että Kopioi PDF leikepöydälle.

Ennen kuin viet julkaisun SWF-muotoon, varmista, että läpinäkyvät objektit eivät ole painikkeiden, hyperlinkkien tai muiden
vuorovaikutteisten elementtien päällä. Jos läpinäkyvyyttä käyttävä objekti on päällekkäin vuorovaikutteisen elementin kanssa, vuorovaikutteisuus
voi kadota viennin aikana. Läpinäkyvyys kannattaa ehkä yhdistää, ennen kuin julkaisu viedään FLA-muotoon.
Joissakin tapauksissa häviöllisen pakkauksen valinta heikentää läpinäkyvyyttä käyttävien kuvien laatua. Jos haluat parantaa laatua, valitse vientiin
PNG (häviötön).

3D-määritteitä ei tueta viedyissä SWF- ja FLA-tiedostoissa.
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Animaatio

Animaatio-paneeli

Suoravalintatyökalu ja reittikynä

Ajoitus-paneeli

Esikatselu-paneeli

Huomautus:

Alkuun

Julkaisun animointi liikkeen esimäärityksillä
Hallitse liikkeen esimäärityksiä
Muokkaa liikkeen polkua
Animaatiojärjestyksen muuttaminen Ajoitus-paneelissa

Animaatiotehosteilla voit tehdä objekteista liikkuvia viedyissä SWF-tiedostoissa. Voit käyttää liikkeen esimääritystä kuvaan, jolloin se esimerkiksi
näyttää lentävän sisään ruudun vasemmasta reunasta samalla kutistuen ja pyörien. Voit animoida julkaisuja seuraavilla työkaluilla ja paneeleilla.

Napsauta Toista-painiketta, jos haluat toistaa animaation.

Käytä liikkeen esimääritystä ja muokkaa asetuksia, kuten kestoa ja nopeutta.

Muokkaa reittiä, jonka animoitu objekti kulkee.

Määritä animoitujen objektien toistojärjestys sivulla.

Katsele animaatiota InDesign-paneelissa.

Samankaltainen animaatiotyyppi, jonka voi lisätä InDesigniin, on painikkeen päälle siirtymisen tehoste. Lisätietoja on artikkelissa
Painikkeiden luominen.

Infiniteskills.comin Jeff Witchel antaa videoyleiskatsauksen aiheesta Taittojen animointi.

Julkaisun animointi liikkeen esimäärityksillä

Liikkeen esimääritykset ovat valmiita animaatioita, joita voit nopeasti käyttää objekteissa. Voit käyttää liikkeen esimäärityksiä ja muokata
animaatioasetuksia, kuten kestoa ja nopeutta, Animaatio-paneelista. Animaatio-paneelista voit myös määrittää, milloin animaatio-objekti toistetaan.

Nämä liikkeen esimääritykset ovat samoja liikkeen esimäärityksiä kuin Adobe Flash CS5 Professionalissa. Voit tuoda kaikkia Flash
Professionalissa luotuja mukautettuja liikkeen esimäärityksiä. Voit myös tallentaa luomiasi liikkeen esimäärityksiä ja käyttää niitä InDesignissa tai
Flash Professionalissa.

Animaatio-ominaisuuksia tuetaan vain, kun viet Adobe Flash Playeriin (.SWF). Niitä ei tueta, kun viet vuorovaikutteiseen PDF-tiedostoon. Jos
haluat lisätä animaatiotehosteita PDF-tiedostoon, vie valinta InDesignista SWF-tiedostoon ja sijoita SWF-tiedosto InDesign-julkaisuun.

1. Sijoita objekti, jonka haluat animoida, julkaisuusi.

2. Valitse Animaatio-paneelista (Ikkuna > Vuorovaikutteinen > Animaatio) liikkeen esimäärityksellä Esimääritys-valikosta.

3. Määritä liikkeen esimääritysasetukset.

4. Voit muokata liikkeen reittiä reittikynällä ja suoravalintatyökalulla.
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Huomautus:

Nimi

Oletusarvo

Tapahtuma(t)

Luo painikeliipaisin

Kesto

Toista

Nopeus

Huomautus:

Animoi

5. Voit määrittää animaatiotehosteiden toistojärjestyksen Ajoitus-paneelissa

6. Voit esikatsella animaatiota InDesignin esikatselu-paneelissa.

Jos haluat poistaa animaation objektista, valitse objekti ja napsauta Animaatio-paneelin Poista-kuvaketta.

Kun tiettyjä animaatiotehosteita, kuten Tulee vähitellen näkyviin, yhdistetään sivun siirtymään tai sivun kääntöön, animaatio ei
välttämättä toimi odotetusti Esikatselu-paneelissa tai viedyssä SWF-tiedostossa. Objektit, jotka on asetettu tulemaan vähitellen näkyviin, saattavat
esimerkiksi näkyä sivua käännettäessä, vaikka niiden kuuluisi olla aluksi kätkettynä. Jos haluat välttää tämän vian, älä käytä sivun siirtymiä
animaatiota sisältävillä sivuilla ja poista Sisällytä interaktiivinen sivun kääntö -asetus Vie SWF -valintaikkunasta. Liikkeen esimääritykset, jotka
eivät välttämättä toimi odotetusti sivun siirtymien ja sivun kääntöjen yhteydessä ovat mm. Ilmestyy, Tulee vähitellen näkyviin, erilaiset Lentää
sisään -esimääritykset, Lähennä (2D) ja Suhahda.

Muunna valitut objektit liikepoluksi

Voit luoda animaation valitsemalla objektin ja reitin ja muuntamalla ne liikepoluksi. Jos valitset kaksi suljettua reittiä, kuten kaksi suorakulmiota,
päällimmäinen reitti valitaan liikepoluksi.

1. Valitse objekti, jonka haluat animoida ja reitti, jota haluat käyttää liikepolkuna.

Et voi muuntaa useampia kuin kaksi valittua objektia.

2. Napsauta Animaatio-paneelissa Muunna liikepoluksi -painiketta .

3. Asetuksien muuttaminen Animaatio-paneelissa.

Liikkeen esimääritysten asetukset

Liikkeen esimääritysten asetukset näkyvät Animaatio-paneelissa. Napsauta Ominaisuudet-vaihtoehtoa, jos haluat nähdä lisäasetukset.

Määritä animaation nimi. Kuvaavan nimen antaminen on erityisen kätevää, kun luot animaation laukaisevaa toimintoa.

Valitse valmiiden liikeasetusten luettelosta.

Sivua ladattaessa -asetus on oletusarvoisesti valittuna, mikä tarkoittaa sitä, että animoitu objekti toistetaan, kun sivu avataan SWF-
tiedostossa. Valitse Sivua napsautettaessa, jos haluat animaation toistuvan, kun sivua napsautetaan. Valitse Napsautettaessa (itse) tai
Siirryttäessä painikkeen päälle (itse), jos haluat käynnistää animaation, kun objektia itseään napsautetaan tai kun hiiri menee sen päälle. Jos luot
animaation käynnistävän painiketoiminnon, valitaan Painikkeen painamistapahtuman yhteydessä. (Katso Toimintojen lisääminen painikkeisiin.) Voit
määrittää animaation käynnistymään useista tapahtumista.
Jos valitset Siirryttäessä painikkeen päälle (itse) -tapahtuman, voit myös valita Toista takaperin siirryttäessä pois painikkeelta -tapahtuman. Tämä
valinta kumoaa animaatiotoiminteen, kun hiiri siirtyy pois objektin päältä.

Tätä painiketta napsauttamalla voit käynnistää animaation olemassa olevasta objektista tai painikkeesta. Kun olet
napsauttanut Luo painikeliipaisinta , napsauta objektia, joka käynnistää animaation. Objekti muunnetaan tarvittaessa painikkeeksi ja Painike-
paneeli avautuu.

Määrittää, kuinka kauan animaatio kestää.

Määritä kuinka monta kertaa animaatio toistetaan tai valitse Silmukka, jos haluat animaation toistuvan, kunnes se pysäytetään.

Valitse jokin vaihtoehto, joka määrittää toistetaanko animaatio tasaisella nopeudella (Ei mitään), alkaako se hitaasti ja nopeutuu (Aloita
hitaasti) vai hidastuuko se loppua kohden (Lopeta hitaasti).

Seuraavat vaihtoehdot ovat käytettävissä, kun Ominaisuudet on laajennettu.

Valitse Nykyisestä ulkoasusta -asetus, jos haluat käyttää valittuna olevan objektin asetuksia (skaalausprosentti, kiertokulma ja sijainti)
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Kierrä

Alkuperä

Skaalaa

Peittävyys

Näkyvyysmuuttuja

Alkuun

animaation ulkoasun pohjana.
Valitse Nykyiseen ulkoasuun -asetus, jos haluat käyttää valittuna olevan objektin asetuksia animaation päättävänä ulkoasuna. Tämän asetuksen
käyttäminen on erityisen kätevää diaesityksissä. Esimerkiksi objektit, jotka lentävät sisään sivun ulkopuolelta voivat näkyä sivulla pikemminkin kuin
taittopöydällä. Tämä parantaa tulostetun julkaisun ulkoasua.
Valitse Nykyiseen sijaintiin, jos haluat käyttää valittuna olevan objektin asetuksia animaation ulkoasun pohjana ja objektin nykyistä sijaintia sen
loppusijaintina. Tämä asetus on samanlainen kuin Nykyisestä ulkoasusta -asetus, paitsi että objekti päätyy nykyiseen sijaintiinsa ja liikepolku on
siirretty sivuun. Tämä asetus on erityisen kätevä tietyissä esimäärityksissä, kuten sumennuksissa ja häivytyksissä, joissa se estää objektia
näkymästä ei-toivotussa tilassa animaation päättyessä.

Jos haluat näyttää sijaiskuvan liikepolun lopussa, napsauta Näytä animaation sijaiskuva -painiketta Animaatio-paneelin alaosassa.

Animaatioasetukset

A. Objekti ja reitti ennen animaatiota B. Nykyisestä ulkoasusta C. Nykyiseen ulkoasuun D. Nykyiseen sijaintiin 

Määritä kiertokulma, jonka objekti toteuttaa animaation aikana.

Sijaiskuvalla voit määrittää animoidun objektin liikepolun alkuperäisen pisteen.

Määritä prosenttiarvo, joka määrää kasvaako objektin koko toiston aikana vai pieneneekö se.

Valitse asetus, joka määrää pysyykö animaatio tasaisena (Ei mitään), tuleeko se vähitellen näkyväksi (Tulee vähitellen näkyviin) vai
häipyykö se vähitellen näkyvistä (Häipyy vähitellen näkyvistä).

Valitse Piilota ennen animaatiota tai Piilota animaation jälkeen, jos haluat objektin muuttuvan näkymättömäksi toiston jälkeen
tai ennen sitä.

Hallitse liikkeen esimäärityksiä

Voit tallettaa animaatioasetukset liikkeen esimäärityksinä, joita voit helposti käyttää uudelleen InDesignissa. Voit myös tuoda esimäärityksiä XML-
tiedostoista, jotka voidaan avata Flash Professionalissa tai jotka on jaettu muille InDesign-käyttäjille.

Liikkeen esimääritysten tallentaminen uudelleen käyttöä varten

Mukautetut esimääritykset ovat Esimääritykset-valikon yläosassa Animaatio-paneelissa.

1. Muuta asetuksia Animaatio-paneelissa tarpeen mukaan.

2. Valitse Animaatio-paneelin valikosta Tallenna.

3. Kirjoita esimäärityksen nimi ja napsauta OK-painiketta.

Poista mukautettu liikkeen oletusarvo

Voit poistaa tallennetun, monistetun tai tuodun liikkeen esimäärityksen Oletusarvojen hallinta -valintaikkunasta. Et voi poistaa suluissa olevia
liikkeen esimäärityksiä, jotka asennettiin InDesignin mukana. Kun poistat liikkeen esimäärityksen, se poistetaan sekä Esimääritykset-valikosta että
tietokoneesta.

1. Valitse Animaatio-paneelin valikosta Oletusarvojen hallinta.
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2. Valitse esimääritys, jonka haluat poistaa ja napsauta Poista-painiketta.

Monista liikkeen esimääritys

1. Valitse Animaatio-paneelin valikosta Oletusarvojen hallinta.

2. Valitse esimääritys, jonka haluat monistaa ja napsauta Monista-painiketta.

Liikkeen esimääritysten tallentaminen XML-tiedostoon

Liikkeen esimääritysten tallentaminen XML-tiedostoon on kätevää, jos haluat jakaa liikkeen esimäärityksen muiden InDesign-käyttäjien kanssa tai
avata liikkeen esimäärityksen Flash Professionalissa.

Kun tallennat liikkeen esimäärityksen XML-tiedostoon, tallennetaan liikepolku sekä kesto-, nopeus-, skaalaus-, kierto- ja läpinäkyvyysasetukset.

1. Valitse Animaatio-paneelin valikosta Oletusarvojen hallinta.

2. Valitse esimääritys ja napsauta Tallenna nimellä -painiketta.

3. Määritä liikkeen esimäärityksen nimi ja sijainti ja valitse Tallenna.

Tuo liikkeen esimääritys

Voit tuoda liikkeen esimäärityksiä, jotka on viety InDesignista tai Flash Professionalista XML-tiedostoina.

1. Valitse Animaatio-paneelin valikosta Oletusarvojen hallinta.

2. Napsauta Lataa-painiketta.

3. Kaksoisnapsauta .xml-tiedostoa, jonka haluat tuoda.

Muokkaa liikkeen polkua

Kun valitset objektin, jossa on animaatiota, liikepolku näkyy objektin vieressä.

Liikepolku

A. Alkupiste B. Päätepiste 

Jos haluat muokata liikepolkua, tee jokin seuraavista:

Voit muokata liikkeen polkua reittikynällä ja suoravalintatyökalulla samalla tavalla kuin reittiäkin. Katso Polkujen muokkaaminen.

Jos haluat luoda liikepolun aiemmin luodusta reitistä, valitse reitti ja objekti ja napsauta Muunna liikepoluksi -painiketta  Animaatio-
paneelissa.

Jos haluat muuttaa polun suuntaa, Ominaisuudet Animaatio-paneelista ja valitse sitten asetus Animoi-valikosta. (Katso Liikkeen
esimääritysten asetukset.) Voit myös valita liikepolun ja valita Objekti > Reitit > Käänteinen reitti. Jos haluat luoda käänteisen reitin
siirtämättä objektia, poista animaatio, luo käänteinen reitti ja tee animaatio uudelleen.

Animaatiojärjestyksen muuttaminen Ajoitus-paneelissa
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Ajoitus-paneelista voit muuttaa objektien toistojärjestyksen animaatiossa. Ajoitus-paneeli luetteloi käytössä olevalla aukeamalla olevat animaatiot
kullekin animaatiolle annetun sivutapahtuman perusteella. Voit esimerkiksi muuttaa tiettyä animaatiojoukkoa, joka käynnistetään sivua ladattaessa
ja muuttaa sitten toista animaatiojoukkoa, joka käynnistetään sivua napsautettaessa.

Animoidut objektit luetellaan niiden luomisjärjestyksessä. Sivua ladattaessa käynnistettävät animaatiot käynnistetään oletusarvoisesti peräkkäin.
Sivua napsautettaessa käynnistettävät animaatiot toistetaan järjestyksessä aina, kun sivua napsautetaan.

Voit muuttaa animaatiojärjestystä, toistaa objektit samaan aikaan tai viivästää animaatiota.

1. Avaa Ajoitus-paneeli valitsemalla Ikkuna > Vuorovaikutteinen > Ajoitus.

2. Voit valita haluatko muokata Sivua ladattaessa- vai Sivua napsautettaessa -tapahtumia valitsemalla vaihtoehdon Tapahtuma-valikosta.

Sivua ladattaessa- ja Sivua napsautettaessa -vaihtoehdot näkyvät vain, jos kyseiselle tapahtumalle on määritetty yksi tai useita kohteita.

3. Jos haluat muokata ajoitusta, tee jokin seuraavista:

Jos haluat muuttaa animaatiojärjestystä, vedä luettelon kohteita ylemmäs tai alemmas. Ylimpänä olevat kohteet animoidaan
ensimmäisenä.

Jos haluat viivästää animaatiota, valitse kohde ja määritä viivästettävä sekuntimäärä.

Jos haluat toistaa useita animoituja objekteja samaan aikaan, valitse kohteet luettelosta ja linkitä kohteet napsauttamalla Toista yhdessä
-painiketta . Paina vaihtonäppäintä osoittamisen aikana, jos haluat valita useita kohteita, ja Ctrl-näppäintä (Windows) tai Komento-
näppäintä (Mac OS) napsauttamisen aikana, jos haluat valita useita ei-vierekkäisiä kohteita.

Jos et halua yhden tai useiden linkitettyjen kohteiden toistuvan samaan aikaan, valitse kohteet ja napsauta Toista erikseen -painiketta 
.

Jos haluat määrittää, kuinka monta kertaa linkitetyt kohteet toistetaan, tai tehdä niistä silmukan, valitse kaikki toisiinsa linkitetyt kohteet ja
määritä sitten, kuinka monta kertaa animaatiot toistetaan, tai valitse Silmukka.

Jos haluat vaihtaa animaation käynnistävän tapahtuman, valitse kohde ja valitse Määritä uudelleen kohteelle sivua ladattaessa tai
Määritä uudelleen kohteelle sivua napsautettaessa.

Jos haluat poistaa kohteen käytössä olevasta tapahtumasta (kuten Sivua ladattaessa tai Sivua napsautettaessa), valitse Poista kohde.
Jos kohdetta ei ole määritetty mihinkään tapahtumaan, se näkyy Määrittämätön-luokassa, jonka voit valita Tapahtuma-valikosta.
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Rakenteen lisääminen PDF-tiedostoihin
Nimiöiden vaikutus uudelleenkäyttöön ja esteettömyyteen
Sijoittaminen ja sen optimointi
Sivukohteiden nimiöiminen
Grafiikan nimiöiminen näytönlukuohjelmaa varten
Sivukohteiden ryhmittäminen artikkelielementiksi

Rakenteen lisääminen PDF-tiedostoihin
Kun viet Adobe PDF -muotoon ja kun Vie Adobe PDF -valintaikkunan Yleiset-asetuksista on valittu Luo nimiöity PDF, vietyihin sivuihin lisätään
automaattisesti sisältöä kuvailevia rakennenimiöitä. Niillä on merkitty sivukohteet, kuten otsikot, jutut ja kuvat. Voit lisätä muita nimiöitä tai
hienosäätää valmiita nimiöitä ennen viemistä InDesignin Nimiöt-paneelissa. Muutokset näkyvät Rakenneruudussa (Näytä > Rakenne > Näytä
rakenne).

Voit parantaa Adobe-julkaisujen esteettömyyttä ja uudelleenkäyttöä lisäämällä InDesign-julkaisuun nimiöitä ennen viemistä. Jos PDF-julkaisut eivät
sisällä nimiöitä, Adobe Reader tai Acrobat voi yrittää automaattisesti lisätä julkaisuun nimiöitä käyttäjän lukiessa tai sijoittaessa julkaisua, mutta
tulokset eivät välttämättä ole hyviä. Jos viety Adobe PDF -tiedosto ei vastaa odotuksiasi, voit muokata nimiöityjen PDF-julkaisujen rakennetta
Acrobat 6.0 Professionalin ja uudempien versioiden työkaluilla. Edistyneimmät työkalut ovat Acrobat 9 Professionalissa.

Kun lisäät rakennenimiöitä julkaisuun PDF-vientiä varten, nimiöt eivät ohjaa PDF-muotoon vietävää sisältöä, toisin kuin XML-viennissä.
Rakennenimiöt antavat Acrobatille lisätietoja julkaisun rakenteellisesta sisällöstä.

Nimiöiden käyttämisen etuja
Kun nimiöitä julkaisuun ennen PDF-muotoon viemistä, voit

liittää InDesign-kappaletyylien nimiä Acrobat-nimiöityihin Adobe PDF -kappaletyyleihin ja luoda sijoitettavan PDF-tiedoston katseltavaksi
kämmentietokoneella tai muilla laitteilla

merkitä ja kätkeä tulostukseen liittyviä elementtejä, tekstiä ja kuvia, jolloin ne eivät näy, kun julkaisu sijoitetaan Acrobatissa. Jos esimerkiksi
lisäät sivukohteeseen Artifact-nimiön, sivukohde ei näy, kun nimiöidyn Adobe PDF -julkaisun sisältö sijoitetaan kämmenlaitteeseen, pieneen
näyttöön tai suurta suurennusta käyttävään vakionäyttöön.

lisätä vaihtoehtoista tekstiä kuviin, jolloin teksti voidaan lukea ääneen näyttölukulaitteen ohjelmistolla

korvata grafiikkakirjaimia, kuten koristeellisia anfangeja, luettavilla kirjaimilla

antaa otsikon artikkelijoukolle tai ryhmittää juttuja ja kuvia artikkeleiksi

järjestää juttuja ja kuvia lukemisjärjestykseen

merkitä taulukot, muotoillut luettelot ja sisällysluettelot merkitä, mitkä sisältölohkot kuuluvat eri juttuihin

sisällyttää tekstin muotoilutietoja, kuten merkkien Unicode-arvoja, sanojen välistysarvoja sekä sitovia yhdysmerkkejä ja tavutusvihjeitä.

Nimiöiden vaikutus uudelleenkäyttöön ja esteettömyyteen
Adobe PDF -julkaisun sisältöä voidaan käyttää uudelleen muihin tarkoituksiin. Voit esimerkiksi luoda Adobe PDF -tiedoston raportista, jossa on
tekstiä, taulukoita ja kuvia, ja sitten jaella sitä eri menetelmillä: tulostaminen tai lukeminen täysikokoisessa näytössä, katseleminen
kämmentietokoneessa, lukeminen ääneen näyttölukulaitteella ja suora käyttö Web-selaimen kautta HTML-sivuina. Julkaisun looginen rakenne
säätelee sitä, miten helposti ja luotettavasti sisältöä voidaan käyttää uudelleen muihin tarkoituksiin.

Lisäämällä nimiöitä Adobe PDF -julkaisuihin voit varmistaa, että voit käyttää julkaisuja luotettavasti ja uudelleen. Nimiöt lisäävät julkaisuun loogisen
rakenteen eli loogisen rakennepuun. Looginen rakennepuu tarkoittaa julkaisun sisällön järjestystä, kuten nimisivua, kappaleita, osioita ja alaosioita.
Se voi ilmaista tarkan lukemisjärjestyksen ja helpottaa liikkumista erityisesti pitkissä ja monimutkaisissa julkaisuissa ilman, että PDF-julkaisun
ulkoasu muuttuu.

Ihmiset, jotka eivät näe tai pysty tulkitsemaan julkaisujen visuaalista ulkoasua, voivat käyttää julkaisun sisältöä luotettavasti apuvälineiden avulla
loogisen rakennepuun ansiosta. Useimmat apuvälineet tarvitsevat rakennetta, jotta ne voivat välittää sisällön ja kuvien merkitykset toisessa
muodossa, esimerkiksi äänenä. Nimiöimättömässä julkaisussa ei ole tällaista rakennetta, ja Acrobatin täytyy päätellä rakenne
lukemisjärjestysasetusten perusteella. Tämä menetelmä ei ole luotettava ja johtaa usein siihen, että sivukohteet luetaan väärässä järjestyksessä tai
jätetään lukematta.

Nimiöt näkyvät Acrobat 6.0:n tai uudempien Nimiöt-välilehdessä, jossa ne on sisennetty nimiöityjen elementtien suhdemääritteiden mukaan.
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Nimiöitä ei voi muokata Acrobat Standardilla. Jos sinun on muokattava nimiöitä suoraan, päivitä ohjelma Adobe Acrobat 9 Professionaliksi.
Lisätietoja on Acrobatin Ohjeessa.

Acrobat 9:n Nimiöt-välilehden looginen rakennepuu

Huomautus: Adobe PDF -tiedostoissa käytettyjä nimiöitä voi verrata HTML- ja XML-nimiöihin. Lisätietoja nimiöiden peruskäsitteistä on
kirjakaupoista, kirjastoista ja Webistä saatavissa hakuteoksissa ja muissa kirjoissa.

Sijoittaminen ja sen optimointi
Voit sijoittaa PDF-julkaisun luettavaksi kämmenlaitteilla, pienistä näytöistä tai vakionäytöistä korkeilla suurennuksilla ilman, että tekstiä tarvitsee
vierittää vaakasuoraan rivi kerrallaan.

Kun sijoitat Adobe PDF -julkaisun, osa sisällöstä siirtyy uudelleenjuoksutettuun·julkaisuun ja osa ei. Useimmissa tapauksissa vain luettava teksti
sijoitetaan uudelleenjuoksutettuun julkaisuun. Luettava teksti sisältää artikkeleita, kappaleita, taulukoita, kuvia ja muotoiltuja luetteloita. Lomakkeita,
kommentteja, digitaalisen allekirjoituksen kenttiä ja sivuelementtejä, kuten sivunumeroita sekä ylä- ja alatunnisteita, sisältävää tekstiä ei juoksuteta.
Sivuja, joilla on sekä luettavaa tekstiä että lomakekenttiä tai digitaalisia allekirjoituskenttiä, ei juoksuteta. Pystysuuntainen teksti juoksutetaan
vaakasuuntaisesti.

Tekijänä voit optimoida PDF-julkaisut uudelleenjuoksuttamista varten lisäämällä niihin nimiöitä. Nimiöt varmistavat, että tekstilohkot juoksutetaan
uudelleen ja että sisältö noudattaa oikeaa järjestystä, jotta lukijat voivat seurata eri sivuille ja palstoille ulottuvaa juttua ilman, että muut jutut
häiritsevät sitä. Lukemisjärjestyksen määrää rakennepuu, jota voi muokata Rakenneruudussa.
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Otsikot ja palstat (yllä) sijoitetaan loogiseen lukemisjärjestykseen (alla).

Sivukohteiden nimiöiminen
Tekstikehyksiä ja grafiikkaa voidaan nimiöidä automaattisesti tai manuaalisesti. Kun sivukohteet on nimiöity, sivun järjestystä voidaan muuttaa
Rakenneruudussa vetämällä kohteita uusiin paikkoihin hierarkiassa. Jos elementtien järjestystä muutetaan Rakenneruudussa, muutokset välitetään
Adobe PDF -tiedostoon. Rakennenäkymän elementtijärjestyksestä on hyötyä, kun PDF-tiedosto tallennetaan Acrobatista HTML- tai XML-
tiedostona. Järjestyksestä on myös hyötyä, kun viet InDesign-julkaisun Dreamweaveriin (XHTML) tai Digital Editions (EPUB) -muotoon.

Sivukohteiden nimiöiminen automaattisesti
Kun valitset Lisää nimiöimättömät kohteet -komennon, InDesign lisää Acrobat-rakennenimiöt Nimiöt-paneeliin sekä käyttää Story- ja Figure-
nimiöitä eräissä nimiöimättömissä sivukohteissa. Story-nimiötä käytetään kaikissa nimiöimättömissä tekstikehyksissä ja Figure-nimiötä
nimiöimättömässä grafiikassa. Sitten voit lisätä manuaalisesti muut nimiöt tekstin osiin. Sivukohteiden nimiöiminen ei kuitenkaan takaa, että kohteet
jäsentyvät vastaavasti viedyssä PDF-tiedostossa.

1. Avaa Nimiöt-paneeli valitsemalla Ikkuna > Apuohjelmat > Nimiöt.
2. Valitse Näytä > Rakenne > Näytä rakenne, jotta Rakenneruutu tulee näkyviin julkaisuikkunan vasemmalle puolelle.
3. Valitse Rakenneruudusta Lisää nimiöimättömät kohteet.
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Nimiöt Rakenneruudussa ja Nimiöt-paneelissa

Sivukohteiden nimiöiminen manuaalisesti
1. Avaa Nimiöt-paneeli valitsemalla Ikkuna > Apuohjelmat > Nimiöt.
2. Valitse Näytä > Rakenne > Näytä rakenne, jotta Rakenneruutu tulee näkyviin julkaisuikkunan vasemmalle puolelle.
3. Valitse Rakenneruudusta Lisää nimiöimättömät kohteet.
4. Valitse julkaisusta sivukohde.
5. Valitse Nimiöt-paneelista nimiö. Tutustu seuraaviin tuotuja nimiöitä koskeviin suosituksiin:

Artifact Artifact-nimiöllä voit kätkeä sivukohteita, kuten sivunumeroita tai merkityksettömiä objekteja, kun katselet vietyä PDF-tiedostoa
Sijoitus-näkymässä, joka näyttää vain nimiöidyt kohteet. Lisätietoja on Adobe Acrobat -oppaissa. Tämä on kätevää etenkin, kun PDF-
tiedostoja katsellaan kämmenlaitteella tai muilla PDF-lukulaitteilla.

Cell Käytä tätä nimiötä taulukoiden soluissa.

Figure Käytä tätä nimiötä sijoitetussa grafiikassa. Figure-nimiö liitetään kaikkeen julkaisun nimiöimättömään grafiikkaan, kun valitset Lisää
nimiöimättömät kohteet.

Kappalenimiöt (P, H, H1–H6) Nämä nimiöt eivät vaikuta vietyyn PDF-tekstiin Sijoitus-näkymässä. Ne voivat kuitenkin olla hyödyllisiä joskus,
kun PDF-tiedosto viedään HTML-muotoon.

Juttu Käytä tätä nimiötä jutuissa. Story-nimiö liitetään kaikkiin nimiöimättömiin tekstikehyksiin, kun valitset Lisää nimiöimättömät kohteet.
Oletetaan, että kyseessä on InDesign-julkaisu, jonka muotoilussa on kolme kappaletyyliä: Otsikko1, Otsikko2 ja Leipäteksti. Liitä ensin nämä
kappaletyylit H1-, H2- ja P-nimiöihin. Vie seuraavaksi PDF-muotoon. Kun viet PDF-julkaisun HTML- tai XML-muotoon Acrobatissa,
kappaleet, joiden nimiöt ovat H1, H2 ja P, näkyvät Web-selaimessa oikein (esimerkiksi suuret lihavoidut kirjaimet H1-nimiössä). Lisätietoja
PDF-julkaisun viemisestä HTML- tai XML-muotoon on Adobe Acrobat -oppaissa.

Grafiikan nimiöiminen näytönlukuohjelmaa varten
Jos haluat näyttölukuohjelman kuvailevan grafiikkaelementtejä, jotka havainnollistavat julkaisussa esiintyviä tärkeitä käsitteitä, sinun on kirjoitettava
kuvaukset. Näyttölukuohjelma ei tunnista kuvia ja multimediaa, jos et lisää vaihtoehtoista tekstiä nimiön ominaisuuksiin.

Vaihtoehtoinen teksti -määritteellä lisätään vaihtoehtoinen teksti, joka luetaan kuvan näyttämisen sijasta. Todellinen teksti vastaa vaihtoehtoista
tekstiä ja näkyy kuvan sijasta. Todellinen teksti -määritteellä voit korvata sanan osana olevan kuvan esimerkiksi silloin, kun kuvaa käytetään
anfangina. Tässä esimerkissä Todellinen teksti -määrite mahdollistaa anfangin lukemisen sanan osana.

Kun viet Adobe PDF -muotoon, Alt- ja ActualText-määritearvot tallentuvat PDF-tiedostoon ja niitä voi katsella Acrobat 6.0:lla ja uudemmilla
versioilla. Vaihtoehtoisia tekstitietoja voi käyttää, kun PDF-tiedosto tallennetaan Acrobatista HTML- tai XML-tiedostoksi. Lisätietoja on Adobe
Acrobat -oppaissa.

1. Avaa tarvittaessa Rakenneruutu valitsemalla Näytä > Rakenne > Näytä rakenne. Avaa Nimiöt-paneeli valitsemalla Ikkuna > Apuohjelmat >
Nimiöt.

2. Valitse Rakenneruudusta Lisää nimiöimättömät kohteet.
3. Valitse kuva ja sitten Nimiöt-paneelista Figure, kun haluat varmistaa, että kuvan nimiö on Figure.
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4. Valitse Rakenneruudusta kuvaelementti ja sitten Rakenneruutuvalikosta uusi määrite.
5. Kirjoita nimeksi Alt tai ActualText (isot ja pienet kirjaimet erotellaan).
6. Kirjoita arvoksi kuvan sijasta näytettävä teksti.

Sivukohteiden ryhmittäminen artikkelielementiksi
Ryhmitä sivukohteet loogisesti artikkelielementiksi käyttämällä Rakenneruutua. Jos esimerkiksi juttujoukko ulottuu useille sivuille, voit luoda
yläelementin, joka sisältää jutut yhdessä ryhmässä. Näitä elementtejä kutsutaan rakenne-elementeiksi. Voit myös nimetä ryhmitettyjä artikkeleita.
Huomautus: ryhmitettyihin sivukohteisiin ei voi lisätä nimiöitä.

Jos haluat ryhmittää sivukohteita, valitse ensin Rakenneruudun valikosta Uusi elementti ja sitten Nimiöt-paneelista artikkelielementti ja vedä
lopuksi sen alla olevat sivuelementit Rakenneruutuun.
Jos haluat nimetä ryhmitettyjä kohteita, napsauta Rakenneruudussa näkyvää artikkelielementtiä hiiren kakkospainikkeella ja valitse Uusi
määrite. Kirjoita nimeksi Otsikko. Kirjoita arvoksi käytettävän artikkelin nimi.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Sivun siirtymien käyttäminen
Siirtymien poistaminen
PDF-tiedoston sivun siirtymien näyttäminen

Sivun siirtymät näyttävät tehosteen, kuten ristikuvan tai pyyhkäisyn, kun käännät sivuja SWF- tai PDF-muotoon viedyssä julkaisussa. Voit käyttää
eri siirtymiä eri sivuilla tai samaa siirtymää kaikissa sivuissa. Sivusiirtymät ovat käteviä, kun haluat luoda PDF- tai SWF-muotoisen diaesityksen.

Sivun siirtymien käyttäminen
Voit käyttää sivun siirtymiä yksittäisellä aukeamalla tai julkaisun kaikilla aukeamilla. Sivusiirtymät näkyvät, kun viet InDesign-julkaisun PDF- tai
SWF-muodossa. Et voi käyttää siirtymää saman aukeaman eri sivuilla tai sivupohjassa.

1. Valitse Sivut-paneelista aukeamat, joilla haluat käyttää sivun siirtymää.

Varmista, että aukeama on valittuna eikä vain kohdistettuna. Sivut-paneelin sivujen alla näkyvän luvun pitäisi olla korostettuna.

2. Avaa Sivun siirtymät -paneeli valitsemalla Ikkuna > Vuorovaikutteinen > Sivun siirtymät.

3. Valitse siirtymä Siirtymä-valikosta.

Voit näyttää valitun siirtymän animoidun esikatselun pitämällä hiiriosoitinta miniatyyrikuvan päällä.

Saatat ihmetellä, onko tarpeen valita Sivun kääntö (vain SWF) -siirtymä, kun halutaan luoda sivun kääntötehoste SWF-tiedostossa. Tätä
siirtymää ei tarvitse käyttää, jos sivuja halutaan kääntää manuaalisesti SWF-tiedostossa. Jos valitset Vie SWF -valintaikkunasta Sisällytä
interaktiivinen sivun kääntö, voit kääntää sivut manuaalisesti vetämällä sivun kulmaa viedyssä SWF-tiedostossa tai voit aktivoida kunkin
sivun siirtymän nuolinäppäimillä tai siirtymispainikkeilla.

4. Voit mukauttaa siirtymää tarpeen mukaan valitsemalla haluamasi asetukset Suunta- ja Nopeus-valikoista.

5. (Valinnainen) Voit ottaa valitun siirtymän käyttöön kaikilla aukeamilla napsauttamalla Käytä kaikilla aukeamilla -kuvaketta  tai valitsemalla
Sivun siirtymät -paneelin valikosta Käytä kaikilla aukeamilla.

6. (Valinnainen) Valitse toinen aukeama Sivut-paneelista ja ota toinen sivun siirtymä käyttöön.

Kun otat sivun siirtymän käyttöön aukeamalla, sivun siirtymän kuvake  näkyy aukeaman vieressä Sivut-paneelissa. Voit kätkeä nämä kuvakkeet
Sivut-paneelissa poistamalla Sivun siirtymät -asetuksen käytöstä Paneeliasetukset-valintaikkunassa.

Jos haluat esikatsella sivusiirtymiä, vie julkaisu joko PDF- tai SWF-muodossa.

Siirtymien poistaminen
Valitse Sivut-paneelista aukeama, josta haluat poistaa siirtymän. Valitse sitten Sivun siirtymät -paneelin Siirtymä-valikosta Ei mitään.

Jos haluat poistaa siirtymät kaikilta aukeamilta, valitse Sivun siirtymät -paneelin valikosta Poista kaikki.

PDF-tiedoston sivun siirtymien näyttäminen
Jos haluat sisällyttää sivun siirtymät viedessäsi PDF-julkaisua, valitse sivun siirtymä Vie vuorovaikutteisessa PDF-muodossa -valintaikkunan
Sivujen siirtymät -valikosta.

Voit näyttää viedyn PDF-tiedoston sivun siirtymät painamalla näppäinyhdistelmää Ctrl+L (Windows) tai komento+L (Mac OS) Adobe Acrobatissa tai
Adobe Readerissa. Siirryt tällöin koko näytön tilaan. Voit poistua koko näytön tilasta painamalla Esc-näppäintä.

Lisää ohjeaiheita
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Elokuvat ja äänet

Alkuun

Elokuvien ja äänitiedostojen lisääminen julkaisuihin
Elokuvaobjektien, julisteiden tai kehysten koon muuttaminen
Vanhojen mediatiedostojen linkittäminen uudelleen

Elokuvien ja äänitiedostojen lisääminen julkaisuihin
Julkaisuun lisäämäsi elokuvat ja äänileikkeet voidaan toistaa, kun julkaisu viedään Adobe PDF- tai SWF-muotoon, tai kun viet julkaisun XML-
muotoon ja määrittelet nimiöiden tarkoituksen uudelleen.

Voit tuoda videotiedostoja Flash Video -muodossa (.FLV ja .F4V), H.264-koodattuja tiedostoja (kuten MP4) ja SWF-tiedostoja. Voit tuoda
äänitiedostoja MP3-muodossa. Mediatiedostot, kuten QuickTime (.MOV), AVI ja MPEG, ovat tuettuja viedyissä vuorovaikutteisissa PDF-
tiedostoissa, mutta eivät viedyissä SWF- tai FLA-tiedostoissa. Suosittelemme käyttämään tiedostomuotoja, kuten FLV, F4V, SWF, MP4 ja MP3,
niin saat kaiken hyödyn viimeisimpien Acrobat 9-, Adobe Reader 9- ja Adobe Flash Player 10-versioiden ja uudempien versioiden rikkaasta
mediatuesta.

Pidä kirjaa mediatiedostoista, jotka lisäät InDesign-julkaisuun tuotantojakson aikana. Jos siirrät medialeikkeen lisättyäsi sen julkaisuun, linkitä se
uudelleen Linkit-paneelin avulla. Jos lähetät InDesign-julkaisun toiselle henkilölle, liitä mukaan kaikki lisäämäsi mediatiedostot.

Elokuvan tai äänitiedoston lisääminen

1. Valitse Tiedosto > Sijoita ja kaksoisnapsauta elokuvaa tai äänitiedostoa. Napsauta kohtaa, jossa haluat elokuvan näkyvän. (Jos luot
mediakehyksen vetämällä, elokuvan reuna voi näyttää leikatulta tai vinolta.)

Kun sijoitat elokuva- tai äänitiedoston, mediaobjekti näkyy kehyksessä. Tämä mediaobjekti on linkitetty mediatiedostoon. Voit määrittää
toistoalueen koon muuttamalla mediaobjektin kokoa.

Jos elokuvan keskikohta on sivun ulkopuolella, elokuvaa ei viedä.

2. Voit esikatsella mediatiedostoa ja muokata sen asetuksia Media-paneelissa (valitse Ikkuna > Vuorovaikutteinen > Media).

3. Vie julkaisu Adobe-PDF- tai SWF-muodossa.

Jos viet Adobe PDF -muodossa, valitse Adobe PDF (vuorovaikutteinen) -asetus, ei Adobe PDF (tulostus) -asetusta. Katso Luo
vuorovaikutteisia PDF-julkaisuja.

Muuta elokuva-asetuksia
Elokuva-asetusten muuttaminen Mediapaneelissa.

1. Valitse julkaisussa oleva elokuva.

2. Tee Mediapaneelissa jokin seuraavista toimista:

Toista sivua ladattaessa Valitse tämä asetus, jos haluat, että elokuva toistetaan, kun käyttäjä siirtyy sille sivulle, jolla elokuva sijaitsee. jos
muita sivukohteita on asetettu toistettavaksi sivua ladattaessa, voit määrittää järjestyksen Ajoitus-paneelissa.

Silmukka Toista elokuva yhä uudelleen. Jos lähdetiedosto on Flash Video -muodossa, silmukka toimii vain viedyissä SWF-tiedostoissa, ei
PDF-tiedostoissa.

Juliste Määritä toistoalueella näytettävän kuvan tyyppi. Katso Julisteasetukset.

Ohjain Jos elokuvatiedosto on Flash Video (FLV tai F4V) -tiedosto tai H.264-koodattu tiedosto, voit määrittää sille valmiita ohjainolemuksia,
joilla käyttäjät voivat keskeyttää, käynnistää ja pysäyttää elokuvan eri tavoilla. Jos valitset Näytä ohjain siirryttäessä painikkeen päälle -
asetuksen, ohjaimet ilmestyvät, kun hiiri siirtyy mediaobjektin päälle. Voit esikatsella valittua ohjainolemusta Esikatselu-paneelissa.

Jos elokuvatiedosto on vanha tiedosto (kuten .AVI tai .MPEG), voit valita Ei mitään- tai Näytä ohjain -asetuksen, joka näyttää perusohjaimet,
joilla käyttäjät voivat keskeyttää, käynnistää ja pysäyttää elokuvan.

Sijoittamillasi SWF-tiedostoilla voi olla omat ohjainolemukset. Voit kokeilla valittuja ohjainasetuksia Esikatselu-paneelissa.

Navigointipisteet Jos haluat luoda navigointipisteen, siirry videossa tiettyyn ruutuun ja napsauta sitten plus-kuvaketta. Navigointipisteet ovat
käteviä, jos haluat toistaa elokuvan jostakin toisesta aloituspisteestä. Kun luot videon toistavan painikkeen, voit käyttää Toista
navigointipisteestä -asetusta, jos haluat videon toistuvan lisäämästäsi navigointipisteestä.

Muuta ääniasetuksia
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Ääniasetusten muuttaminen Mediapaneelissa.

1. Valitse julkaisussa oleva ääniobjekti.

2. Tee Mediapaneelissa jokin seuraavista toimista:

Toista sivua ladattaessa Valitse tämä asetus, jos haluat, että äänitiedosto toistetaan, kun käyttäjä siirtyy sille sivulle, jolla ääniobjekti
sijaitsee. jos muita sivukohteita on asetettu toistettavaksi sivua ladattaessa, voit määrittää järjestyksen Ajoitus-paneelissa.

Pysäytä sivua käännettäessä Lopeta MP3-äänitiedoston toisto, kun käyttäjä siirtyy toiselle sivulle. Jos äänitiedosto ei ole MP3-tiedosto,
tämä asetus on himmennetty.

Silmukka Toista MP3-ääni yhä uudelleen. Jos lähdetiedosto ei ole MP3-tiedosto, tämä asetus on himmennetty.

Juliste Määritä toistoalueella näytettävän kuvan tyyppi. Katso Julisteasetukset.

Julisteasetukset
Juliste on medialeikettä esittävä kuva. Kaikki elokuvat tai äänet voivat esiintyä julisteen kanssa tai ilman. Jos juliste on InDesigissa suurempi kuin
elokuva, se rajataan elokuvan kokoiseksi viedyssä PDF- tai SWF-tiedostossa. Määritä Mediapaneelissa jokin seuraavista julistekuvatyyppi:

Ei mikään Ei näytä julistetta elokuvan tai äänileikkeen yhteydessä. Tämä vaihtoehto on hyödyllinen, jos et halua elokuvan tai äänileikkeen
näkyvän sivulla. Haluat ehkä mediasisällön toistuvan vain silloin, kun sivu avataan, tai voit luoda monimutkaisemman suunnitteluelementin
näytettäväksi julisteen sijasta.
Vakio Näyttää yleisen elokuva- tai äänijulisteen, joka ei perustu tiedoston sisältöön.

Jos haluat käyttää toista vakiojulistetta, tallenna kuva nimellä StandardMoviePoster.jpg tai StandardSoundPoster.jpg ja korvaa sillä
samanniminen tiedosto. Tämä tiedosto sijaitsee sovelluksen Esimääritykset/Multimedia-kansiossa.

Nykyisestä kehyksestä Valitse tämä asetus, jos haluat käytössä olevan ruudun näkyvän Mediapaneelin esikatselualueella. Jos haluat valita
jonkin toisen ruudun, siirrä esikatseluliukusäädintä ja napsauta Juliste-valikon oikealla puolella olevaa kuvaketta. Tämä asetus ei ole käytettävissä
vanhoille elokuvamuodoille, kuten AVI ja MPEG.
Valitse kuva Voit valita julisteena käytettävän kuvan. Kaksoisnapsauta kuvaa, jota haluat käyttää. Voit valita julisteeksi bittikarttakuvia, mutta et
vektorigrafiikkaa.
[Videosta] Tämä asetus on valittuna muunnetuille CS4-julkaisuille, joilla on medialeikkeitä asetettuna tiettyyn ruutuun.

Muuta vuorovaikutteisten PDF-tiedostojen media-asetuksia

1. Valitse Mediapaneelin valikosta PDF-asetukset.

2. Määritä seuraavat asetukset ja valitse OK.

Kuvaus Kirjoita kuvausteksti, joka näkyy, jos mediatiedostoa ei voi toistaa Acrobatissa. Tämä kuvaus toimii samalla vaihtoehtoisena tekstinä
näkörajoitteisille käyttäjille.

Toista video kelluvassa ikkunassa Tällä asetuksella voit toistaa elokuvan erillisessä ikkunassa. Jos valitset tämän asetuksen, määritä
ikkunan kokosuhde ja sijainti näytössä. Kelluvan ikkunan koon kasvattaminen voi heikentää kuvan laatua. Kelluvan ikkunan kokosuhde
perustuu alkuperäisen elokuvan kokoon, ei julkaisun asetteluikkunan skaalatun elokuvan kokoon. Tämä asetus ei ole käytettävissä SWF-
tiedostoille eikä äänitiedostoille.

Tuo videotiedosto URL-osoitteesta
Tuo videotiedosto kelvollisesta URL-osoitteesta, jos haluat toistaa virtautetun videon viedyssä PDF- tai SWF-tiedostossa. Videon täytyy olla
kelvollinen Flash Video -tiedosto (FLV tai F4V) tai H.264-koodattu tiedosto (kuten MP4).

1. Valitse tyhjä kehys tai video-objekti, joka sisältää videon, jonka haluat korvata.

2. Valitse Mediapaneelin valikosta Video URL-osoitteesta.

3. Määritä URL-osoite ja valitse OK.

Elokuvaobjektien, julisteiden tai kehysten koon muuttaminen
Kun lisäät elokuvan InDesign-julkaisuun, elokuvaobjekti ja juliste näkyvät kehyksessä. Kun viet julkaisun PDF-muotoon, elokuvaobjektin raja
määrää elokuvan koon PDF-julkaisussa kehyksen koon tai julisteen koon sijasta.

Parhaan tuloksen saamiseksi julisteen koko ja mittasuhteet kannattaa pitää elokuvaa vastaavina. Jos käytät rajaavaa reittiä tai muutat kuvan
kokoa, nämä muutokset eivät välttämättä sisälly vietyyn PDF-julkaisuun.

Elokuvat näytetään PDF-julkaisun ylimmällä tasolla. Jos peität elokuvan toisella objektilla InDesignissa, tämä objekti näkyy elokuvan alla viedyssä
PDF-julkaisussa.

Jos haluat PDF-julkaisun sisältävän toistoalueen, jossa on käytetty pehmennystä tai muita tehosteita ja joiden vieminen ei ehkä onnistu hyvin
julisteessa käytettynä, voit käyttää toistoalueena sijoitettua kuvaa ja sijoittaa elokuvan (ilman julistetta) sijoitetun kuvan päälle.
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Elokuvaobjektin koon muuttaminen
A. Juliste B. Elokuvaobjekti C. Kehys

 Tee jokin seuraavista toimista:

Jos haluat muuttaa elokuvaobjektin, julisteen ja kehyksen kokoa, valitse skaalaustyökalu  ja vedä jostakin kulmakahvasta. (Kun pidät
vaihtonäppäintä painettuna, mittasuhteet säilyvät.)

Jos haluat muuttaa vain kehyksen kokoa, vedä kulmakahvaa valintatyökalulla .

Jos haluat muuttaa julisteen tai mediaobjektin kokoa, valitse juliste suoravalintatyökalulla . Valitse sitten valintatyökalu ja vedä
kulmakahvaa.

Voit muuttaa kehyksen sisällä olevan julisteen kokoa myös Sovitus-komennoilla (Objekti > Sovitus).

Vanhojen mediatiedostojen linkittäminen uudelleen
FLV- ja F4V-kuvamuodot ja MP3-äänimuodot toimivat parhaiten vietäessä vuorovaikutteisia InDesign-julkaisuja. Vaikka MOV-, AVI- ja MPG-
äänimuotoja voidaankin viedä PDF-muotoon, niitä ei voi viedä Flash-pohjaisiin muotoihin, kuten SWF.

Muunna videomuodot FLV-, F4V- tai MP4-muotoon Adobe Media Encoderilla. Adobe Media Encoder ei muunna äänitiedostomuotoja MP3-
muotoon, mutta voit tehdä muunnoksen jollakin sovelluksella, kuten Apple iTunes.

1. Avaa Adobe Media Encoder, lisää muunnettavat videotiedostot ja muunna ne FLV- tai F4V-muotoon.

Lisätietoja on Adobe Media Encoderin ohjeessa.

2. Tee jokin seuraavista toimista:

Sijoita mediatiedosto InDesign-julkaisuun. Katso Elokuvien ja äänitiedostojen lisääminen julkaisuihin.

Jos videotiedosto on jo sijoitettu InDesign-julkaisuun, linkitä tiedostot uusiin versioihin Linkit-paneelista. Lisätietoja: Linkkien
päivittäminen, palauttaminen ja korvaaminen.

Lisää ohjeaiheita
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Dynaamiset PDF-julkaisut

Alkuun

Luo vuorovaikutteisia PDF-julkaisuja
Luodaan PDF-lomakkeita (CS5.5 ja CS5)
Vuorovaikutteisten julkaisujen esikatseleminen
Käytä esitystilaa

Dynaamisen PDF-julkaisun luominen on hyvä tapa luoda vuorovaikutteinen diaesitys. Voit luoda vuorovaikutteisia elementtejä, kuten painikkeita,
elokuvia ja äänileikkeitä, hyperlinkkejä, kirjanmerkkejä ja sivun siirtymiä, sisältäviä julkaisuja. InDesignissa voit myös luoda julkaisuja, jotka voidaan
muuntaa lomakkeiksi Acrobatissa.

Luo vuorovaikutteisia PDF-julkaisuja
Voit viedä Adobe PDF -julkaisuja, jotka sisältävät seuraavia interaktiivisia toimintoja.

Kirjanmerkit InDesign-julkaisuun luodut kirjanmerkit näkyvät Adobe Acrobat- tai Adobe Reader -ikkunan vasemmalla puolella olevassa
Kirjanmerkit-välilehdessä. Kukin kirjanmerkki siirtää viedyn PDF-tiedoston sivulle, tekstiin tai grafiikkaan. Katso Kirjanmerkit.
Elokuvat ja äänileikkeet Voit lisätä julkaisuun elokuvia ja äänileikkeitä tai luoda linkkejä Internetissä oleviin suoratoistovideotiedostoihin. Nämä
elokuvat ja äänileikkeet voidaan toistaa viedyssä PDF-tiedostossa. Katso Elokuvat ja äänet.
Hyperlinkit Kun napsautat hyperlinkkiä viedyssä PDF-julkaisussa, siirryt saman julkaisun toiseen kohtaan, toiseen julkaisuun tai Web-sivustoon.
Lisätietoja: Hyperlinkit.
Ristiviittaukset Ristiviittaus opastaa lukijat viedyn PDF-julkaisun osasta toiseen. Ristiviittaukset ovat erityisen käytännöllisiä käyttöoppaissa ja
muissa oppaissa. Kun ristiviittauksia sisältävä julkaisu viedään PDF-muotoon, ristiviittaukset toimivat vuorovaikutteisina hyperlinkkeinä. Lisätietoja:
Ristiviittaukset.
Sivun siirtymät Sivun siirtymät käyttävät koristeellisia tehosteita, kuten ristikuvaa tai pyyhkäisyä, kun viedyn PDF-julkaisun sivua vaihdetaan koko
näytön tilassa. Lisätietoja: Sivun siirtymät.

1. Valitse Tiedosto > Vie.

2. Määritä tiedoston nimi ja sijainti.

3. Valitse Tallennusmuoto-luettelosta (Windows) tai Muoto-luettelosta (Mac OS), Adobe PDF (vuorovaikutteinen) ja napsauta Tallenna-
painiketta.

4. Määritä Vie vuorovaikutteisessa PDF-muodossa -valintaikkunassa asetukset ja valitse sitten OK.

Vie vuorovaikutteisessa PDF-muodossa asetukset
Vie vuorovaikutteisessa PDF-muodossa -valintaikkunassa on seuraavat asetukset.

Sivut Ilmaisee viedäänkö kaikki julkaisun sivut vai sivualue. Jos valitset Alueen, määritä sivualue kuten 1-7, 9, jos haluat tulostaa sivut yhdestä
seitsemään ja sivun yhdeksän. Lisätietoja: Tulostettavien sivujen määrittäminen.
Näytä viennin jälkeen Avaa luodun PDF-tiedoston oletuskatselusovelluksessa.
Upota sivun miniatyyrit  Upottaa PDF-tiedostoon jokaisesta sivusta miniatyyriesikatselukuvan, mikä lisää tiedostokokoa. Poista tämän asetuksen
valinta, kun PDF-tiedostoa tarkastellaan ja se tulostetaan Acrobat 5.0:lla tai sitä uudemmalla versiolla. Nämä versiot luovat dynaamisesti
miniatyyrikuvan aina, kun napsautat PDF-tiedoston Sivut-paneelia.
Luo Acrobat-tasot Tallentaa jokaisen InDesign-tason PDF-tiedostoon Acrobat-tasoksi. Tasoja voi selata, joten Adobe Acrobat 6.0:n ja sitä
uudempien versioiden käyttäjät voivat luoda yhdestä PDF-tiedostosta useita julkaisun versioita.
Luo nimiöity PDF Nimiöi jutun elementit viemisen aikana automaattisesti niiden Acrobat -nimiöiden perusteella, joita InDesign tukee. Niihin
kuuluvat kappaleiden, tekstin perusmuotoilun, luetteloiden ja taulukoiden tunnistus. (Voit lisätä ja muokata nimiöitä julkaisussa ennen viemistä PDF-
muotoon.) Lisätietoja: Rakenteen lisääminen PDF-tiedostoihin.)
Käytä rakennetta sarkainjärjestykseen Käyttää viennin aikana kohdassa Objekti > Vuorovaikutteinen > Määritä sarkainjärjestys määritettyä
sarkainjärjestystä. Tämä asetus on käytettävissä vain nimiöidyissä PDF-tiedostoissa.
Näytä PDF-tiedoston alkunäkymäasetus, kun se avataan.
Sivuasettelun PDF-tiedoston alkusivuasettelu, kun se avataan.
Esitys Valitse Avaa Koko näyttö -tilassa, jos haluat näyttää PDF-tiedoston Adobe Acrobatissa tai Adobe Readerissa ilman valikoita ja paneeleita.
Jos haluat kääntää sivuja automaattisesti, valitse Vaihda sivua joka -asetus ja määritä sekuntimäärä sivunvaihtojen välissä.
Sivun siirtymät Määritä jokin sivusiirtymä, jota käytetään kaikissa sivuissa viennin aikana. Jos määrität siirtymät Sivun siirtymät -paneelista, käytä
kyseisiä asetuksia valitsemalla Julkaisusta-vaihtoehdon.
Painikkeet ja media Jos haluat sallia vuorovaikutteiset elokuvat, äänet ja painikkeet viedyssä PDF-tiedostossa, valitse Sisällytä kaikki. Jos haluat
sisällyttää painikkeiden normaalitilan ja elokuvien julistekuvat pysyvinä elementteinä, valitse Vain ulkoasu.
Pakkaus Valitse JPEG (häviöllinen), jos haluat poistaa kuvan tietoja ja mahdollisesti heikentää kuvan laatua. Tiedostokoko pienenee, vaikka
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tietoja katoaa vain vähäinen määrä. Valitse JPEG 2000 (häviötön), jos haluat viedä tiedoston ilman häviöllistä pakkausta. Jos valitset
Automaattinen-asetuksen, InDesign määrittää väri- ja harmaasävykuvien parhaan laadun.
JPEG-laatu Määrittää viedyn kuvan yksityiskohtien määrän. Mitä korkeampi laatu, sitä suurempi tiedosto. Tämä asetus on himmennetty, jos
pakkaustavaksi on valittu JPEG 2000 (häviötön).
Resoluutio Määritä bittikarttakuvien resoluutio viedyssä PDF-tiedostossa. Korkean resoluution valinta on erityisen tärkeää, jos haluat antaa
katsojien zoomata pikselipohjaista sisältöä viedyssä PDF-tiedostossa. Korkean resoluution valita voi kasvattaa merkittävästi tiedoston kokoa.

Luodaan PDF-lomakkeita (CS5.5 ja CS5)
Vaikka InDesign ei sisällä työkaluja lomakekenttien lisäämiseksi, Adobe Acrobat sisältää. Voit luoda InDesignissa lomakkeen, joka sisältää
paikkamerkit kohteille, kuten valintapainikkeet, valintaruudut ja tekstikentät. Voit sitten viedä PDF-muodossa ja muuntaa paikkamerkit
lomakekentiksi Acrobatissa.

1. Luo InDesignissa julkaisu, jota haluat käyttää lomakkeena. Luo paikkamerkit kentille taulukoilla ja tekstilaatikoilla.

Voit myös lisätä vuorovaikutteisia painikkeita InDesignissa.

2. Vie julkaisu Adobe PDF -muotoon.

3. Käynnistä lomakkeiden ohjattu toiminto ja muunna paikkamerkit lomakekentiksi. Voit lisätä kenttiä ja muokata lomaketta lomaketyökaluilla.
Lisätietoja on Adobe Acrobat -oppaissa.

Käynnistä lomakkeiden ohjattu toiminto Acrobat X:ssä valitsemalla Työkalut > Lomakkeet > Luo.

Valitse Adobe Acrobat 9:ssä Työkalut > Käynnistä lomakkeiden ohjattu toiminto.

Lisäresurssit
Gabriel Powell on tehnyt PDF-lomakkeiden luomista InDesignissa ja viimeistelyä Adobe Acrobatissa käsittelevän videon. Se on osoitteessa
InDesignin ja Acrobatin lomaketyönkulku.

Acrobat-ryhmä on kirjoittanut jutun nimeltään Automaattista kenttätunnista käyttävien lomakkeiden suunnittelu Adobe Acrobatissa.

Michael Murphy on tehnyt lomakkeiden luomista käsittelevän videon. Se on osoitteessa Acrobat-ystävällisten lomakkeiden suunnittelu.

Bob Bringhurst on kirjoittanut lomakesuunnittelua käsittelevän artikkelin osoitteessa PDF-lomakkeiden luominen InDesignissa.

Vuorovaikutteisten julkaisujen esikatseleminen
Esikatselu-paneelissa voit esikatsella käytössä olevan valinnan, aukeaman tai koko julkaisun vuorovaikutteisuutta ja animointia. Voit muuttaa
kokoa, kiinnittää tai kelluttaa Esikatselu-paneelia, tai siirtää sen toiselle näytölle.

1. Valitse Ikkuna > Vuorovaikutteinen > Esikatselu.

2. Jos haluat esikatsella vuorovaikutteisuutta ja animaatiota, tee jokin seuraavista toimista:

Jos haluat esikatsella käytössä olevaa valintaa, napsauta Aseta valinnan esikatselutila -painiketta .

Jos haluat esikatsella käytössä olevaa aukeamaa, napsauta Aseta aukeaman esikatselutila -painiketta .

Jos haluat esikatsella käytössä olevaa julkaisua, napsauta Aseta julkaisun esikatselutila -painiketta .

3. Jos haluat esikatsella valintaa, aukeamaa tai julkaisua, napsauta Toista esikatselu -painiketta . Napsauta tarvittaessa vuorovaikutteisia
kohteita, kuten painikkeita, Esikatselu-paneelissa kokeillaksesi niitä.

Jos esikatselet julkaisua, voit napsauttaa paneelin alaosassa olevia Siirry edelliselle sivulle- ja Siirry seuraavalle sivulle -painikkeita, jos
haluat siirtyä eri sivulle.

Jos muokkaat julkaisua, voit päivittää esikatselun napsauttamalla Esikatselu-paneelin Toista esikatselu -painiketta.

Julkaisun esikatselu selaimessa

1. Valitse Esikatselu-paneelin valikosta Kokeile selaimessa.

2. Testaa julkaisun vuorovaikutteisia kohteita napsauttamalla niitä.

Muokkaa esikatseluasetuksia

1. Valitse Esikatselu-paneelin valikosta Muokkaa esikatseluasetuksia.

Esikatseluasetukset -valintaikkunassa näkyvät Vie SWF -valintaikkunan käytössä olevat asetukset.

2. Muokkaa asetuksia tarpeen mukaan. Katso SWF-vientiasetukset.

Käytä esitystilaa

630

http://www.adobe.com/designcenter/cs4/articles/lrvid4434_ds.html
http://www.acrobatusers.com/tutorials/designing-forms-auto-field-detection-adobe-acrobat
http://www.theindesigner.com/blog/episode-52-acrobat-friendly-form-design
http://blogs.adobe.com/indesigndocs/2009/05/creating_pdf_forms_in_indesign.html


 

Esitystilassa näet käytössä olevan InDesign-julkaisun esityksenä. Esitystilassa sovelluksen valikko, paneelit, apuviivat ja kehyksen reunat ovat
kätkettynä. Jos julkaisun kokosuhde poikkeaa käytössä olevan näytön mitoista, tausta-alue näytetään oletusarvoisesti harmaana.

Esitystila on Adobe Connect -ominaisuuden hyödyllinen apuominaisuus. Voit käynnistää web-kokouksen komennolla Tiedosto > Jaa näyttö. Kun
näytön jakaminen on aloitettu, voit laittaa InDesign-julkaisun esitystilaan.

1. Valitse Näkymä > Näyttötila > Esitys.

2. Käytä jotakin seuraavista näppäinpainalluksista:

Toiminto Kuvaus

Hiiren painikkeen painaminen, oikea nuolinäppäin tai Page
Down

Seuraava aukeama

Vaihtonäppäin napsautuksen aikana, kakkospainikkeen
napsautus, vasen nuolinäppäin tai Page Up

Edellinen aukeama

Esc Poistu esitystilasta

Alkusivu Ensimmäinen aukeama

Loppu Viimeinen aukeama

M Muuta taustaväri mustaksi

V Muuta taustaväri valkoiseksi

H Muuta taustaväri harmaaksi

Et voi muokata julkaisua esitystilassa. Jos sinulla on kaksiruutuinen näyttö, voit tosin pitää julkaisua auki kahdessa ikkunassa samaan aikaan ja
laittaa toisen niistä esitystilaan. Näin voit muokata julkaisua normaalinäkymään asetetussa ikkunassa ja näet välittömästi tulokset esitystilassa
olevassa ikkunassa.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma

631

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://helpx.adobe.com/fi/legal/legal-notices.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fi


Kirjanmerkit

Alkuun

Alkuun

Kirjanmerkkien luominen PDF-tiedostoon
Kirjanmerkkien hallinta

Kirjanmerkkien luominen PDF-tiedostoon
Kirjanmerkit ovat eräänlaisia linkkejä, jotka sisältävät kuvaavan tekstin ja helpottavat Adobe PDF -muotoon vietyjen julkaisujen selaamista.
InDesign-julkaisuun luodut kirjanmerkit näkyvät Acrobat- tai Adobe Reader -ikkunan vasemmalla puolella olevassa Kirjanmerkit-välilehdessä.
Jokainen kirjanmerkki hyppää sivulla olevaan tekstiankkuriin.

Muodostetun sisällysluettelon merkinnät lisätään automaattisesti Kirjanmerkit-paneeliin. Kirjanmerkeillä voidaan myös mukauttaa julkaisua ja ohjata
lukijan huomio tiettyihin kohtiin tai helpottaa julkaisun selaamista. Kirjanmerkkejä voi olla muiden kirjanmerkkien sisällä.

Haluat ehkä kirjanmerkkien näkyvän PDF-julkaisun Kirjanmerkit-välilehdellä, mutta et halua sisällysluettelon näkyvän PDF-julkaisussa. Luo
tässä tapauksessa sisällysluettelo julkaisun viimeiselle sivulle. Kun viet PDF-muodossa, älä sisällytä viimeistä sivua. Tai jos sisällytät viimeisen
sivun vietyyn PDF-julkaisuun, poista se Acrobatissa.

1. Avaa Kirjanmerkin-paneeli valitsemalla Ikkuna > Vuorovaikutteinen > Kirjanmerkit.
2. Napsauta sitä kirjanmerkkiä, jonka alapuolelle haluat sijoittaa uuden kirjanmerkin. Jos et valitse kirjanmerkkiä, uusi kirjanmerkki lisätään

luettelon loppuun.
3. Määritä kirjanmerkin kohde jollakin seuraavista tavoista:

Napsauta haluamaasi tekstin kohtaa.

Valitse teksti. (Valitsemastasi tekstistä tulee oletusarvoisesti kirjanmerkin otsikko.)

Avaa sivu julkaisuikkunaan kaksoisnapsauttamalla sitä Sivut-paneelissa.

4. Voit luoda kirjanmerkin seuraavilla tavoilla:

Napsauta Kirjanmerkit-paneelin Luo uusi kirjanmerkki -kuvaketta.

Valitse paneelivalikosta Uusi kirjanmerkki.

Kirjanmerkit näkyvät Kirjanmerkit-välilehdellä, kun avaat viedyn PDF-tiedoston Adobe Readerissa tai Acrobatissa.

Huomautus: Kun päivität sisällysluettelon, kirjanmerkit järjestetään uudelleen. Mahdolliset sisällysluettelosta luodut kirjanmerkit tulevat luettelon
loppuun.

Kirjanmerkkien hallinta
Kirjanmerkit-paneelin avulla nimetään uudelleen, poistetaan ja järjestetään kirjanmerkkejä.

Kirjanmerkin nimeäminen uudelleen
 Valitse ensin kirjanmerkki Kirjanmerkit-paneelista ja sitten paneelivalikosta Nimeä kirjanmerkki uudelleen.

Kirjanmerkin poistaminen
 Valitse ensin kirjanmerkki Kirjanmerkit-paneelista ja sitten paneelivalikosta Poista kirjanmerkki.

Kirjanmerkkien järjestäminen, ryhmittäminen ja lajitteleminen
Voit sisentää kirjanmerkkiluettelon aiheiden välisten suhteiden ilmaisemiseksi. Sisentäminen siirtää kirjanmerkkejä alemmalle tasolle toisiin
kirjanmerkkeihin nähden. Voit laajentaa ja supistaa näin syntyvää hierarkkista luetteloa tarpeen mukaan. Kirjanmerkkien järjestyksen tai
sisentämisen muuttaminen ei vaikuta varsinaiseen julkaisuun.

 Tee jokin seuraavista:

Voit laajentaa tai kutistaa kirjanmerkkihierarkiaa napsauttamalla kirjanmerkkikuvakkeen vieressä olevaa kolmiota, jolloin voit näyttää tai
piilottaa sen sisältämät alemman tason kirjanmerkit.

Voit sisentää kirjanmerkin toisen kirjanmerkin alle valitsemalla sisennettävän kirjanmerkin tai kirjanmerkkijoukon ja vetämällä kuvakkeen tai
kuvakkeet ylemmän tason kirjanmerkin päälle. Vapauta kirjanmerkki.

Vetämäsi kirjanmerkki tai kirjanmerkit sisennetään ylemmän tason kirjanmerkin alle. Varsinainen sivu säilyy kuitenkin alkuperäisellä paikallaan
julkaisussa.
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Kirjanmerkit-paneeli, jossa näkyy toisen kirjanmerkin alle sijoitettuja kirjanmerkkejä

Voit poistaa kirjanmerkin sisennyksen valitsemalla siirrettävän kirjanmerkin tai kirjanmerkkijoukon. Vedä kuvake tai kuvakkeet ylemmän tason
kirjanmerkin alapuolelle ja vasemmalle puolelle. Musta palkki ilmaisee kohdan, johon kirjanmerkki siirtyy. Vapauta kirjanmerkki.

Voit muuttaa kirjanmerkkien järjestystä valitsemalla kirjanmerkin ja siirtämällä sen uuteen kohtaan. Musta palkki ilmaisee kohdan, johon
kirjanmerkki sijoitetaan.

Voit lajitella kirjanmerkkejä valitsemalla Kirjanmerkit-paneelivalikosta Lajittele kirjanmerkit. Kirjanmerkit näkyvät samassa järjestyksessä kuin
sivut, joihin ne viittaavat.

Lisää ohjeaiheita
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Piirtäminen ja maalaaminen
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Reitit ja muodot

Alkuun

Yksinkertaiset reitit

Yhdistelmäreitit

Yhdistelmämuodot

Alkuun

Reitti- ja muototyypit
Tietoja reiteistä
Tietoja suuntaviivoista ja suuntapisteistä

Reitti- ja muototyypit

Voit luoda reittejä ja yhdistää niitä eri tavoin InDesignissa. InDesign luo seuraavan tyyppisiä reittejä ja muotoja:

Yksinkertaisia reittejä käytetään yhdistelmäreittien ja -muotojen luomiseen. Ne koostuvat yhdestä avoimesta tai suljetusta
reitistä, joka saattaa leikata oman ratansa.

Yhdistelmäreitit koostuvat vähintään kahdesta yksinkertaisesta reitistä, jotka vaikuttavat toisiinsa tai leikkaavat toisensa. Nämä
reitit ovat yksinkertaisempia kuin yhdistelmämuodot, ja kaikki PostScript-yhteensopivat sovellukset tunnistavat ne. Yhdistelmäreitiksi yhdistetyt reitit
käyttäytyvät yksittäisen objektin tavoin, ja ne käyttävät samoja määritteitä (kuten värejä ja viivatyylejä).

Yhdistelmämuodot koostuvat vähintään kahdesta reitistä, yhdistelmäreitistä, ryhmästä, sekoiteväristä, tekstin ääriviivasta,
tekstikehyksestä tai muusta muodosta, jotka vaikuttavat toisiinsa tai leikkaavat toisensa ja luovat näin uusia, muokattavia muotoja. Jotkin
yhdistelmämuodot näyttävät yhdistelmäreiteiltä, mutta niiden sisältämiä osareittejä voidaan muokata erillisinä, eivätkä ne käytä yhteisiä määritteitä.

Reitti- ja muototyypit

A. Kolme yksinkertaista reittiä B. Yhdistelmäreitti C. Yhdistelmämuoto 

Tietoja reiteistä

Piirtäessäsi ohjelma muodostaa reitiksi kutsutun viivan. Reitti koostuu vähintään yhdestä suorasta tai käyrästä segmentistä. Kunkin segmentin
alussa ja lopussa on ankkuripiste, jotka toimivat lankaa paikallaan pitävien neulojen tavoin. Reitti voi olla suljettu (esimerkiksi ympyrä) tai avoin
(esimerkiksi aaltoviiva), jolloin sillä on erilliset päätepisteet.

Reitin muotoa muutetaan vetämällä sen tukipisteitä, tukipisteissä näkyvien suuntaviivojen päissä olevia suuntapisteitä tai reitin segmenttiä.

Reitin osat
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Huomautus:

Alkuun

A. Valittu (musta) päätepiste B. Valittu tukipiste C. Valitsematon tukipiste D. Käyrä reitin segmentti E. Suuntaviiva F. Suuntapiste 

Reitillä voi olla kahdenlaisia tukipisteitä: kulmapisteitä ja tasoituspisteitä. Kulmapisteessä reitti muuttaa suuntaa äkillisesti. Tasoituspisteessä reitin
segmentit yhdistyvät yhtenäiseksi käyräksi. Voit muodostaa reitin mistä tahansa kulma- ja tasoituspisteiden yhdistelmästä. Jos pisteen tyyppi on
väärä, se voidaan vaihtaa milloin tahansa.

Pisteitä reitillä

A. Neljä kulmapistettä B. Neljä tasoituspistettä C. Kulma- ja tasoituspisteiden yhdistelmä 

Kulmapiste voi yhdistää kaksi suoraa tai käyrää segmenttiä, kun taas tasoituspiste yhdistää aina kaksi käyrää segmenttiä.

Kulmapiste voi yhdistää suoria ja käyriä segmenttejä.

Älä sekoita kulma- ja tasoituspisteitä suorien ja käyrien segmenttien yhteydessä.

Reitin ääriviivaa kutsutaan viivaksi. Avoimen tai suljetun reitin sisälle lisättyä väriä tai liukuväriä kutsutaan täytöksi. Viivalla voi olla paino (leveys),
väri sekä viivakuviointi (Illustrator ja InDesign) tai tyylitelty viivakuviointi (InDesign). Kun olet luonut reitin tai muodon, voit muuttaa sen viivaa ja
täyttöä.

InDesignissa jokaisella reitillä näkyy myös keskipiste, joka osoittaa kuvion keskikohdan, mutta ei ole osa varsinaista reittiä. Tämän pisteen avulla
voit vetää reittiä, tasata reitin muihin elementteihin tai valita kaikki reitin ankkuripisteet. Keskipiste on aina näkyvissä. Sitä ei voi piilottaa eikä
poistaa.

Tietoja suuntaviivoista ja suuntapisteistä

Kun valitaan tukipiste, joka yhdistää käyriä segmenttejä (tai valitaan itse segmentti), yhdistettyjen segmenttien tukipisteet näyttävät suuntakahvat,
jotka koostuvat suuntaviivoista, jotka päättyvät suuntapisteisiin. Suuntaviivojen kulma ja pituus määrittävät käyrien segmenttien muodon ja koon.
Suuntapisteiden siirtäminen vaikuttaa käyrien muotoon. Suuntaviivat eivät näy lopullisessa tulosteessa.

Ankkuripisteen valitsemisen jälkeen (vasen) ankkuripisteen yhdistämissä käyrissä segmenteissä on suuntaviivat (oikea)
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Huomautus:

Tasoituspisteessä on aina kaksi suuntaviivaa, jotka siirtyvät yhdessä yhtenä suorana yksikkönä. Kun tasoituspisteen suuntaviivaa siirretään,
pisteen kummallakin puolella olevat käyrät segmentit muuttuvat samanaikaisesti ja käyrä pysyy jatkuvana tukipisteen kohdalla.

Sen sijaan kulmapisteessä voi olla kaksi, yksi tai ei yhtään suuntaviivaa sen mukaan, yhdistääkö se kahta, yhtä vai ei yhtään käyrää segmenttiä.
Kulmapisteen suuntaviivat säilyttävät kulmikkuuden käyttämällä erikokoisia kulmia. Kun kulmapisteen suuntaviivaa siirretään, vain suuntaviivan
puoleinen käyrän segmentti muuttuu.

Ankkuripisteen valitsemisen jälkeen (vasen) ankkuripisteen yhdistämissä käyrissä segmenteissä on suuntaviivat (oikea)

Tasoituspisteen (vasen) ja kulmapisteen (oikea) suuntaviivojen säätö

Suuntaviivat ovat ankkuripisteissä aina kohtisuorassa käyrään nähden. Kunkin suuntaviivan kulma määrittää käyrän kaltevuuden ja pituus käyrän
korkeuden tai syvyyden.

Suuntaviivojen siirto ja muokkaus vaikuttaa käyrien kaltevuuteen.

Illustratorissa voidaan näyttää tai piilottaa tukipisteet, suuntaviivat ja suuntapisteet valitsemalla Näytä > Näytä reunat tai Näytä >
Piilota reunat.
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Piirtäminen kynätyökalulla

Alkuun

Alkuun

Suorien viivasegmenttien piirtäminen kynätyökalulla
Käyrien piirtäminen kynätyökalulla
Tukipisteiden siirtäminen piirrettäessä
Reitin päättäminen
Käyrien piirtäminen suorien viivojen jälkeen
Suorien viivojen piirtäminen käyrien perään
Kahden kulmalla yhdistetyn käyrän segmentin piirtäminen

Suorien viivasegmenttien piirtäminen kynätyökalulla
Yksinkertaisin kynätyökalulla piirrettävä reitti on suora viiva: luo kaksi ankkuripistettä kynätyökalua napsauttamalla. Jatkamalla napsauttamista voit
luoda reitin, joka koostuu kulmapisteiden yhdistämistä suorista viivasegmenteistä.

Voit luoda suoria segmenttejä napsauttamalla kynätyökalulla

1. Valitse kynätyökalu.
2. Siirrä kynätyökalu kohtaan, josta haluat suoran segmentin alkavan, ja aseta ensimmäinen tukipiste napsauttamalla (älä vedä).

Huomautus: Ensimmäinen segmentti näkyy vasta, kun napsautat toisen ankkuripisteen paikalleen. (Valitse Photoshopissa Kuminauha-
asetus, jos haluat esikatsella reitin segmenttejä.) Jos näkyviin tulee suuntaviivoja, olet vahingossa vetänyt kynätyökalua. Valitse Muokkaa >
Kumoa ja napsauta uudelleen.

3. Napsauta kohtaa, johon segmentin pitää päättyä. Vaihto-napsauta, jos haluat segmentin kulman olevan 45°:n monikerta.
4. Aseta seuraavien suorien segmenttien tukipisteet napsauttamalla.

Viimeksi lisäämäsi tukipiste näkyy aina mustana eli se on valittu. Aiemmin sijoitetut tukipisteet muuttuvat valkoisiksi eli valitsemattomiksi
neliöiksi, kun luot lisää tukipisteitä.

5. Tee reitti valmiiksi jollakin seuraavista tavoista:

Jos haluat sulkea reitin, vie kynätyökalu ensimmäisen (valkoisen) ankkuripisteen päälle. Kynätyökalun osoittimen vieressä näkyy pieni
ympyrä , kun työkalu on oikeassa kohdassa. Sulje reitti napsauttamalla tai vetämällä.

Huomautus: InDesignissa voit sulkea reitin myös valitsemalla ensin objektin ja sitten Objekti > Reitit > Sulje reitti.

Jos haluat jättää reitin avoimeksi, Ctrl-napsauta (Windows) tai Komento-osoita (Mac OS) mitä tahansa kohtaa, jossa ei ole objekteja.

Voit jättää reitin avoimeksi myös valitsemalla jonkin toisen työkalun tai valitsemalla Illustratorissa Valitse > Kumoa valinta tai
InDesignissa Muokkaa > Kumoa kaikki valinnat. InDesignissa tai Illustratorissa voit jättää reitin avoimeksi myös painamalla vain Enter tai
Return.

Käyrien piirtäminen kynätyökalulla
Käyrä luodaan lisäämällä tukipiste kohtaan, jossa käyrän suunta muuttuu, ja vetämällä käyrää muotoilevia suuntaviivoja. Suuntaviivojen pituus ja
kaltevuus vaikuttavat käyrän muotoon.

Käyriä on helpompi muokata ja niiden näyttäminen ja tulostaminen nopeutuvat, kun ne piirretään käyttäen mahdollisimman vähän tukipisteitä. Liian
monet pisteet voivat myös tehdä käyrään ikäviä muhkuroita. Sinun kannattaakin sijoittaa tukipisteet etäälle toisistaan ja harjoitella käyrien
muotoilemista säätämällä suuntaviivojen pituutta ja kulmaa.

1. Valitse kynätyökalu.
2. Siirrä kynätyökalu paikkaan, josta haluat käyrän alkavan, ja pidä hiiren painiketta painettuna.
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Ensimmäinen tukipiste tulee näkyviin, ja kynätyökalun osoitin muuttuu nuoleksi. (Photoshopissa osoitin muuttuu vasta sitten, kun vetäminen
aloitetaan.)

3. Määritä piirrettävän käyrän segmentin kaltevuus vetämällä hiirtä ja vapauta sitten hiiren painike.

Yleensä suuntaviiva kannattaa ulottaa noin kolmanneksen matkan päähän seuraavasta tukipisteestä. (Voit siirtää suuntaviivan toista puolta
tai molempia puolia myöhemmin.)

Pitämällä vaihtonäppäintä painettuna voit rajoittaa työkalun suunnan 45°:n kulmiin.

Käyrän ensimmäisen pisteen piirtäminen
A. Kynätyökalun sijoittaminen B. Vedon aloittaminen (hiiren painike painettuna) C. Suuntaviivojen jatkaminen vetämällä

4. Aseta kynätyökalu kohtaan, johon haluat päättää käyrän segmentin, ja tee yksi seuraavista toimista:

Jos haluat luoda C-käyrän, vedä vastakkaiseen suuntaan edelliseen suuntaviivaan nähden. Vapauta sitten hiiren painike.

Käyrän toisen pisteen piirtäminen
A. Toisen tasoituspisteen vedon aloittaminen B. Vetäminen poispäin edellisestä suuntaviivasta, jotta syntyy C-käyrä C. Tulos hiiren
painikkeen vapautuksen jälkeen

Jos haluat luoda S-käyrän, vedä edellisen suuntaviivan suuntaan. Vapauta sitten hiiren painike.

S-käyrän piirtäminen
A. Uuden tasoituspisteen vedon aloittaminen B. Vetäminen samaan suuntaan kuin edellinen suuntaviiva, jotta syntyy S-käyrä C. Tulos
hiiren painikkeen vapautuksen jälkeen

(Vain Photoshop) Jos haluat käyrän suunnan muuttuvan terävästi, vapauta hiiren painike ja Alt-vedä (Windows) tai Optio-vedä (Mac
OS) suuntapistettä käyrän suuntaan. Vapauta Alt-näppäin (Windows) tai Optio-näppäin (Mac OS) ja hiiren painike. Siirrä osoitin
paikkaan, johon haluat segmentin päättyvän, ja täydennä käyrän segmentti vetämällä vastakkaiseen suuntaan.

5. Muodosta joukko tasaisia käyriä vetämällä kynätyökalua eri paikoista alkaen. Huomaa, että tukipisteet sijoittuvat kunkin käyrän alkuun ja
loppuun eikä käyrän huipulle.

Alt-vedä (Windows) tai Optio-vedä (Mac OS) tukipisteen suuntaviivoja, jotta ne eroavat toisistaan.

6. Tee reitti valmiiksi jollakin seuraavista tavoista:

Jos haluat sulkea reitin, vie kynätyökalu ensimmäisen (valkoisen) ankkuripisteen päälle. Kynätyökalun osoittimen vieressä näkyy pieni
ympyrä , kun työkalu on oikeassa kohdassa. Sulje reitti napsauttamalla tai vetämällä.

Huomautus: InDesignissa voit sulkea reitin myös valitsemalla ensin objektin ja sitten Objekti > Reitit > Sulje reitti.

Jos haluat jättää reitin avoimeksi, Ctrl-napsauta (Windows) tai Komento-osoita (Mac OS) mitä tahansa kohtaa, jossa ei ole objekteja.
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Voit jättää reitin avoimeksi myös valitsemalla jonkin toisen työkalun tai valitsemalla Illustratorissa Valitse > Kumoa valinta tai
InDesignissa Muokkaa > Kumoa kaikki valinnat.

Voit katsoa Illustratorin kynätyökalulla piirtämistä käsittelevän videon osoitteessa www.adobe.com/go/vid0037_fi.

Tukipisteiden siirtäminen piirrettäessä
 Kun olet lisännyt tukipisteen napsauttamalla, pidä hiiren painiketta painettuna, pidä myös välinäppäintä painettuna ja siirrä tukipistettä vetämällä.

Reitin päättäminen
 Päätä reitti yhdellä seuraavista menetelmistä:

Jos haluat sulkea reitin, siirrä kynätyökalu ensimmäisen (valkoisen) tukipisteen päälle. Kynätyökalun osoittimen vieressä näkyy pieni ympyrä 
, kun työkalu on oikeassa kohdassa. Sulje reitti napsauttamalla tai vetämällä.

Huomautus: InDesignissa voit sulkea reitin myös valitsemalla ensin objektin ja sitten Objekti > Reitit > Sulje reitti.

Jos haluat jättää reitin avoimeksi, Ctrl-napsauta (Windows) tai Komento-osoita (Mac OS) mitä tahansa kohtaa, jossa ei ole objekteja.

Voit jättää reitin avoimeksi myös valitsemalla jonkin toisen työkalun tai valitsemalla Illustratorissa Valitse > Kumoa valinta tai InDesignissa
Muokkaa > Kumoa kaikki valinnat. InDesignissa voit jättää reitin avoimeksi myös painamalla vain Enter tai Return.

Käyrien piirtäminen suorien viivojen jälkeen
1. Luo suora segmentti napsauttamalla kynätyökalulla kulmapisteitä kahdessa kohdassa.
2. Aseta kynätyökalu valitun päätepisteen päälle. Illustratorissa ja InDesignissa kynätyökalun vieressä näkyy pisteenmuuntokuvake, kun

kynätyökalu on oikeassa kohdassa. (Photoshopissa kynätyökalun vieressä näkyy pieni vinoviiva.) Jos haluat määrittää seuraavan käyrän
segmentin kaltevuuden, napsauta tukipistettä ja vedä näkyviin tulevaa suuntaviivaa.

Suoran segmentin ja sitten käyrän segmentin piirtäminen (osa 1)
A. Valmis suora segmentti B. Kynätyökalun siirtäminen päätepisteen päälle (pisteenmuuntokuvake näkyy vain Illustratorissa ja
InDesignissa) C. Suuntapisteen veto

3. Aseta kynä kohtaan, johon haluat lisätä seuraavan tukipisteen. Lopeta käyrä napsauttamalla (ja tarvittaessa vetämällä) uutta tukipistettä.

Suoran segmentin ja sitten käyrän segmentin piirtäminen (osa 2)
A. Kynätyökalun sijoittaminen B. Suuntaviivan vetäminen C. Uusi käyräsegmentti on valmis

Suorien viivojen piirtäminen käyrien perään
1. Valitse kynätyökalu, luo käyrän segmentin ensimmäinen tasainen piste vetämällä hiirtä ja vapauta hiiren painike.
2. Aseta kynätyökalu kohtaan, johon haluat päättää käyrän segmentin, lopeta käyrä vetämällä ja vapauta hiiren painike.
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Käyrän segmentin ja sitten suoran segmentin piirtäminen (osa 1)
A. Käyrän segmentin ensimmäinen tasoituspiste valmiina ja kynätyökalu päätepisteen päällä B. Käyrän piirtäminen loppuun vetämällä

3. Aseta kynätyökalu valitun päätepisteen päälle. Kynätyökalun vieressä näkyy pisteenmuuntokuvake, kun työkalu on oikeassa kohdassa.
Muunna tasoituspiste kulmapisteeksi napsauttamalla ankkuripistettä.

4. Siirrä kynätyökalu kohtaan, johon haluat suoran segmentin päättyvän, ja päätä segmentti napsauttamalla.

Käyrän segmentin ja sitten suoran segmentin piirtäminen (osa 2)
C. Kynätyökalun siirtäminen päätepisteen päälle D. Päätepisteen napsauttaminen E. Seuraavan kulmapisteen napsauttaminen

Kahden kulmalla yhdistetyn käyrän segmentin piirtäminen
1. Luo käyrän segmentin ensimmäinen tasoituspiste vetämällä kynätyökalua.
2. Siirrä kynätyökalua ja luo käyrän toinen tasoituspiste vetämällä. Määritä seuraavan käyrän kaltevuus painamalla Alt- (Windows) tai Optio-

näppäintä (Mac OS) samalla, kun vedät suuntaviivaa vastakkaista päätä kohti. Vapauta näppäin ja hiiren painike.

Tasoituspiste muunnetaan kulmapisteeksi jakamalla suuntaviivat.

3. Aseta kynätyökalu kohtaan, johon haluat päättää toisen käyrän segmentin, ja lopeta se vetämällä uusi tasoituspiste paikalleen.

Kahden käyrän piirtäminen
A. Uuden tasoituspisteen vetäminen B. Suuntaviivojen jakaminen Alt- tai Optio-vetämällä ja suuntaviivan kääntäminen ylös C. Uudelleen
kohdistamisen ja kolmannen vedon tulos

Lisää ohjeaiheita
Illustratorin kynätyökalua käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Piirtäminen lyijykynätyökalulla
Reittien muokkaaminen lyijykynätyökalulla
Lyijykynätyökalun asetukset

Piirtäminen lyijykynätyökalulla
Lyijykynätyökalu toimii Adobe Illustratorissa ja InDesignissa melkein samalla tavalla. Sillä piirretään avoimia ja suljettuja reittejä aivan kuin
lyijykynällä paperille. Käytä sitä nopeita luonnoksia ja käsintehdyn näköisiä töitä tehdessäsi. Kun reitti on piirretty, siihen voidaan heti tehdä
muutoksia.

Ohjelma asettaa tukipisteet sitä mukaa kuin lyijykynätyökalulla piirretään; niiden sijaintiin ei voi vaikuttaa. Tukipisteitä voidaan kuitenkin siirtää, kun
reitti on valmis. Lisättyjen tukipisteiden määrä riippuu reitin pituudesta ja mutkikkuudesta sekä Lyijykynätyökalun oletusarvot -valintaikkunassa
määritetyistä toleranssiasetuksista. Nämä asetukset vaikuttavat siihen, kuinka herkkä lyijykynätyökalu on hiiren tai digitointipöydän kynän liikkeille.

Voit katsoa Illustratorin lyijykynätyökalulla piirtämistä käsittelevän videon osoitteessa www.adobe.com/go/vid0039_fi.

Vapaamuotoisten kuvioiden piirtäminen lyijykynätyökalulla
1. Valitse kynätyökalu .

2. Siirrä työkalu kohtaan, josta haluat reitin alkavan, ja piirrä reitti vetämällä. Lyijykynätyökalussa  näkyy pieni x-kirjain vapaamuotoisen reitin
piirtämisen merkkinä.

Kun vedät osoitinta, sen perässä kulkee pisteviiva. Ohjelma lisää tukipisteet reitin kumpaankin päähän ja eri kohtiin reitillä. Reitti saa
voimassa olevat viiva- ja täyttömääritteet ja pysyy oletusarvoisesti valittuna.

Suljettujen reittien piirtäminen lyijykynätyökalulla
1. Valitse kynätyökalu.
2. Siirrä työkalu kohtaan, josta haluat reitin alkavan, ja piirrä reitti vetämällä.
3. Aloitettuasi vetämisen pidä Alt-näppäintä (Windows) tai Optio-näppäintä (Mac OS) painettuna. Lyijykynätyökalussa näkyy pieni ympyrä (ja

InDesignissa musta pyyhekumi) merkiksi siitä, että luodaan suljettua reittiä.
4. Kun reitin koko ja muoto ovat sopivat, vapauta hiiren painike (mutta älä Alt- tai Optio-näppäintä). Kun reitti on sulkeutunut, vapauta Alt- tai

optionäppäin.

Sinun ei tarvitse siirtää osoitinta reitin alkupisteen päälle reitin sulkemista varten; jos vapautat hiiren painikkeen jossain muualla,
lyijykynätyökalu sulkee kuvion piirtämällä lyhimmän mahdollisen viivan takaisin alkupisteeseen.

Reittien muokkaaminen lyijykynätyökalulla
Voit muokata mitä tahansa reittiä lyijykynätyökalulla sekä lisätä mihin tahansa kuvioon vapaamuotoisia viivoja ja kuvioita.

Lisäyksen tekeminen reittiin lyijykynätyökalulla
1. Valitse kuvasta reitti.
2. Valitse kynätyökalu.
3. Aseta lyijykynän kärki reitin päätepisteen päälle.

Lyijykynän kärki on riittävän lähellä päätepistettä, kun sen vieressä oleva pieni x-kirjain katoaa.

4. Jatka reittiä vetämällä hiirtä.

Kahden reitin yhdistäminen lyijykynätyökalulla
1. Valitse molemmat reitit (vaihto-napsauta tai vedä valintatyökalu reittien ympäri).
2. Valitse kynätyökalu.
3. Siirrä osoitin toisen reitin kohtaan, josta haluat aloittaa piirtämisen, ja vedä osoitinta toista reittiä kohti.
4. Aloitettuasi vetämisen pidä Ctrl-näppäintä (Windows) tai Komento-näppäintä (Mac OS) painettuna. Lyijykynätyökalussa näkyy pieni

yhdistämissymboli merkiksi siitä, että teet reittiin lisäyksen.
5. Vedä osoitin toisen reitin päätepisteeseen, vapauta hiiren painike ja vapauta sitten Ctrl- tai Komento-näppäin.
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Huomautus: Saat parhaat tulokset, kun vedät osoittimen reitistä toiseen aivan kuin jatkaisit reittejä samassa suunnassa kuin ne on luotu.

Reittien muodon muuttaminen lyijykynätyökalulla
1. Valitse muokattava reitti.
2. Siirrä lyijykynätyökalu muokattavan reitin päälle tai lähelle.

Työkalu on riittävän lähellä reittiä, kun sen vieressä oleva pieni x-kirjain katoaa.

3. Vedä työkalua, kunnes reitin muoto on sopiva.

Suljetun kuvion muokkaaminen lyijykynätyökalulla

Huomautus: Tulokset voivat vaihdella yllättävästi sen mukaan, mistä aloitat reitin muokkaamisen ja mihin suuntaan vedät työkalua. Saatat
esimerkiksi tahattomasti muuttaa suljetun reitin avoimeksi tai avoimen reitin suljetuksi tai poistaa kuviosta osan.

Lyijykynätyökalun asetukset
Kaksoisnapsauta lyijykynätyökalua, jotta voit määrittää seuraavat asetukset:

Tarkkuus Tämä asetus määrittää, kuinka kauas hiiri tai kynä on siirrettävä, ennen kuin ohjelma lisää reitille uuden tukipisteen. Mitä suurempi arvo,
sitä tasaisempi ja yksinkertaisempi reitistä tulee. Mitä pienempi arvo, sitä tarkemmin käyrät vastaavat osoittimen liikkeitä ja sitä terävämpiä kulmat
ovat. Tarkkuus voi olla 0,5–20 pikseliä.
Tasaisuus Tämä asetus vaikuttaa työkalulla luodun reitin tasoitukseen. Tasaisuus voi olla 0–100 %. Mitä suurempi arvo, sitä tasaisempi reitistä
tulee. Mitä pienempi arvo, sitä enemmän tukipisteitä ohjelma lisää ja sitä paremmin käyrän epäsäännöllisyydet säilyvät.
Täytä uudet kynän viivat (Vain Illustrator) Tämä asetus lisää täytteen lyijykynäviivoihin, jotka lisätään asetuksen valitsemisen jälkeen, mutta ei
aiemmin lisättyihin viivoihin. Muista valita täyte ennen lyijykynällä piirtämistä.
Pidä valittuna Tämä asetus määrittää, onko reitti valittu piirtämisen jälkeen. Tämä on oletusasetus.
Muokkaa valittuja reittejä Määrittää, voiko valittua reittiä muuttaa tai voiko sen yhdistää, kun etäisyys siihen on tietynsuuruinen (tämän määrittää
seuraava asetus).
Etäisyys: _ pikseliä Tämä asetus määrittää, kuinka lähellä reittiä hiiren tai kynän täytyy olla, jotta reittiä voitaisiin muokata lyijykynätyökalulla. Se
on käytettävissä vain, jos Muokkaa valittuja reittejä -asetus on valittu.
Lisää ohjeaiheita
Illustratorin lyijykynätyökalua käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Reittien, segmenttien ja tukipisteiden valitseminen
Reitin segmenttien muokkaaminen
Tukipisteiden lisääminen tai poistaminen
Tasoituspisteiden ja kulmapisteiden muuntaminen
Reitin katkaiseminen
Reittien tasoittaminen
Suljettujen reittien tai objektien muodon muuttaminen
Tietoja sijoitustyökalusta

Reittien, segmenttien ja tukipisteiden valitseminen
Ennen kuin reittiä voidaan muokata tai muotoilla, siltä pitää valita tukipisteitä, segmenttejä tai molempia.

Tukipisteiden valitseminen
Jos näet pisteet, voit valita ne napsauttamalla niitä suoravalintatyökalulla . Voit valita useita pisteitä vaihto-napsauttamalla.
Valitse suoravalintatyökalu ja vedä viiva tukipisteiden ympärille. Valitse lisää tukipisteitä vaihto-napsauttamalla.
Varmista, että tukipisteet sisältävää reittiä ei ole valittu. Siirrä suoravalintatyökalu tukipisteen päälle, jotta osoitin muuttuu valkoiseksi neliöksi,
ja napsauta sitten tukipistettä. Valitse lisää tukipisteitä vaihto-napsauttamalla.
(Vain Illustrator) Valitse lassotyökalu ja vedä se tukipisteiden ympäri. Valitse lisää tukipisteitä vaihto-napsauttamalla.

Reitin segmenttien valitseminen
Tee jokin seuraavista toimista:

Valitse suoravalintatyökalu  ja napsauta segmenttiä enintään 2 pikselin etäisyydeltä tai vedä työkalu segmentin osan yli. Valitse lisää reitin
segmenttejä vaihto-napsauttamalla tai vaihto-vetämällä.

(Vain Illustrator) Valitse lassotyökalu  ja vedä se reitin segmentin ympäri. Valitse lisää reitin segmenttejä vaihto-vetämällä.

Reitin kaikkien tukipisteiden ja segmenttien valitseminen
1. Valitse suoravalintatyökalu  tai Illustratorissa lassotyökalu.
2. Vedä työkalu koko reitin ympäri.

Jos reitti on täytetty, voit valita kaikki tukipisteet myös napsauttamalla reitin sisäpuolta suoravalintatyökalulla.

Reitin kopioiminen
 Valitse reitti tai segmentti valinta- tai suoravalintatyökalulla ja tee yksi seuraavista toimista:

Kopioi ja liitä reittejä sovelluksessa tai sovellusten välillä tavanomaisilla valikkotoiminnoilla.

Pidä Alt-näppäintä (Windows) tai Optio-näppäintä (Mac OS) painettuna, vedä reitti haluamaasi paikkaan ja vapauta sitten hiiren painike ja
näppäin.

Reitin segmenttien muokkaaminen
Reitin segmenttiä voi muokata milloin tahansa, mutta segmenttien muokkaaminen poikkeaa hieman niiden piirtämisestä. Muista seuraavat ohjeet
segmenttejä muokatessasi:

Jos ankkuripiste yhdistää kahta segmenttiä, sen siirtäminen vaikuttaa aina kumpaankin segmenttiin.

Kun piirrät kynätyökalulla, voit tilapäisesti aktivoida suoravalintatyökalun (InDesign ja Photoshop) aiemmin piirrettyjen segmenttien
muokkaamista varten; pidä Ctrl-näppäintä (Windows) tai Komento-näppäintä painettuna (Mac OS) piirtämisen aikana. Illustratorissa Ctrl- tai
Komento-näppäimen painaminen piirtämisen aikana aktivoi viimeksi käytetyn valintatyökalun.

Kun piirrät kynätyökalulla tasoituspisteen, suuntapisteen vetäminen muuttaa suuntaviivan pituutta pisteen kummallakin puolella. Kun
muokkaat olemassa olevaa tasoituspistettä suoravalintatyökalulla, voit muuttaa suuntaviivan pituutta vain vedettävällä puolella.

Suorien segmenttien siirtäminen
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1. Valitse suoravalintatyökalu  ja muokattava segmentti.
2. Vedä segmentti uuteen paikkaan.

Suorien segmenttien pituuden tai kulman muuttaminen
1. Valitse suoravalintatyökalulla  tukipiste segmentistä, jota haluat muokata.
2. Vedä tukipiste haluamaasi paikkaan. Jos haluat kulman muuttuvan 45 asteen välein, paina vaihtonäppäintä vetäessäsi.

Jos yrität leventää tai kaventaa suorakulmiota Illustratorissa tai InDesignissa, sinun kannattaa valita se valintatyökalulla ja sitten muuttaa
sen kokoa käyttämällä muokkausalueen reunoissa olevia kahvoja.

Käyrien segmenttien sijainnin tai muodon muuttaminen
1. Valitse suoravalintatyökalulla käyrä segmentti tai tukipiste käyrän segmentin jommastakummasta päästä. Jos tukipisteissä on suuntaviivat,

ne tulevat esiin. (Joissakin käyrissä segmenteissä on vain yksi suuntaviiva.)
2. Tee jokin seuraavista toimista:

Jos haluat muuttaa segmentin sijaintia, vedä segmenttiä. Jos haluat kulman muuttuvan 45 asteen välein, paina vaihtonäppäintä
vetäessäsi.

Valitse käyrä segmentti napsauttamalla. Siirrä segmenttiä vetämällä.

Jos haluat muuttaa segmentin muotoa valitun tukipisteen toiselta puolelta, vedä tukipistettä tai suuntapistettä. Jos haluat kulman
muuttuvan 45 asteen välein, paina vaihtonäppäintä vetäessäsi.

Vedä tukipistettä tai suuntapistettä.

Huomautus: Voit myös muuntaa segmentin tai tukipisteen esimerkiksi skaalaamalla tai kääntämällä.

Segmentin poistaminen
1. Valitse suoravalintatyökalu  ja poistettava segmentti.
2. Poista valittu segmentti painamalla askelpalautinta (Windows) tai Delete-näppäintä (Mac OS). Jos painat askelpalautinta tai Delete-näppäintä

uudelleen, reitin muut osat katoavat.

Tukipisteen kahvan poistaminen
Napsauta kahvan tukipistettä, kun käytössä on Convert Anchor Point Tool -työkalu (Illustrator) tai Muunna suuntapiste -työkalu (InDesign).
Vedä suuntapistettä ja pudota se ankkuripisteeseen.

Avoimen reitin jatkaminen
1. Valitse kynätyökalu ja siirrä osoitin jatkettavan avoimen reitin päätepisteen päälle. Osoitin muuttuu, kun se on tarkasti päätepisteen päällä.
2. Napsauta päätepistettä.
3. Tee jokin seuraavista toimista:

Jos haluat luoda kulmapisteen, siirrä kynätyökalu kohtaan, johon haluat uuden segmentin päättyvän, ja napsauta. Jos jatkat reittiä, joka
päättyy tasoituspisteeseen, olemassa oleva suuntaviiva käyristää uuden segmentin.

Huomautus: Jos Illustratorissa jatketaan tasoituspisteeseen päättyvää reittiä, uudesta segmentistä tulee suora.
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Jos haluat luoda tasoituspisteen, siirrä kynätyökalu kohtaan, johon haluat päättää uuden käyrän segmentin, ja vedä.

Kahden avoimen reitin yhdistäminen
1. Valitse kynätyökalu ja siirrä osoitin sen avoimen reitin päätepisteen päälle, johon haluat yhdistää toisen reitin. Osoitin muuttuu, kun se on

tarkasti päätepisteen päällä.
2. Napsauta päätepistettä.
3. Tee jokin seuraavista toimista:

Jos haluat yhdistää reitin toiseen avoimeen reittiin, napsauta toisen reitin päätepistettä. Osoittimen vieressä näkyy pieni
yhdistämismerkki , kun työkalu on toisen reitin päätepisteen päällä.

Jos haluat yhdistää uuden reitin aiempaan reittiin, piirrä uusi reitti aiemman reitin lähelle ja siirrä sitten kynätyökalu aiemman reitin
(valitsemattomaan) päätepisteeseen. Napsauta päätepistettä, kun osoittimen vieressä näkyy pieni yhdistämissymboli.

InDesignissa voit yhdistää reitit myös Reittietsin-paneelissa. Voit sulkea avoimeen reittiin kuuluvan reitin valitsemalla reitin Valintatyökalulla ja
valitsemalla Reittietsin-paneelissa Sulje reitti. Voit sulkea kahden reitin välissä olevat päätepisteet valitsemalla reitit ja valitsemalla Liitä reitit.
Voit yhdistää toisen päätepisteen valitsemalla Liitä reitit -vaihtoehdon uudelleen.

Tukipisteiden tai segmenttien siirtäminen tai hivuttaminen näppäimillä
1. Valitse tukipiste tai reitin segmentti.

Huomautus: Photoshopissa voidaan siirtää tällä tavalla vain tukipisteitä.
2. Paina tai pidä painettuna näppäimistön mitä tahansa nuolinäppäintä, jotta kohde siirtyy nuolen suuntaan pikselin verran kerrallaan

Voit siirtää kohdetta 10 pikseliä kerrallaan pitämällä nuolinäppäimen lisäksi vaihtonäppäintä painettuna.

Huomautus: Illustratorissa ja InDesignissa voidaan säätää hivutusetäisyyttä muuttamalla näppäinsiirron oletusarvoa. Jos muutat siirron
oletusarvoa, vaihtonäppäin siirtää kohdetta 10 kertaa määritetyn etäisyyden verran.

Tukipisteiden lisääminen tai poistaminen
Voit hallita reittiä paremmin tai jatkaa avointa reittiä lisäämällä ankkuripisteitä. Pisteitä ei kuitenkaan kannata lisätä enemmän kuin on tarpeen. Mitä
vähemmän reitissä on pisteitä, sitä helpompaa sen muokkaus, näyttäminen ja tulostus on. Reitistä tulee yksinkertaisempi, kun tarpeettomat pisteet
poistetaan.

Työkalupaletissa on kolme työkalua pisteiden lisäämistä tai poistamista varten: kynätyökalu , tukipisteen lisäystyökalu  ja tukipisteen
poistotyökalu .

Kynätyökalu muuttuu normaalisti tukipisteen lisäystyökaluksi, kun se asetetaan valitun reitin päälle, tai tukipisteen poistotyökaluksi, kun se
asetetaan tukipisteen päälle. (Photoshopissa täytyy valita Asetukset-palkista Automaattinen lisäys/poisto, jotta kynätyökalu muuttuisi
automaattisesti tukipisteen lisäys- tai poistotyökaluksi.)

Photoshopissa ja InDesignissa on mahdollista valita ja muokata useita reittejä samanaikaisesti, mutta Illustratorissa voidaan lisätä tai poistaa vain
yhden reitin pisteitä kerrallaan. Photoshopissa ja InDesignissa voidaan muuttaa reitin muotoa tukipisteitä lisättäessä napsauttamalla ja vetämällä
lisäämisen aikana.

Huomautus: Älä poista tukipisteitä Delete-näppäimellä, askelpalauttimella, Tyhjennä-näppäimellä tai komennolla Muokkaa > Leikkaa tai Muokkaa
> Tyhjennä; nämä näppäimet ja komennot poistavat pisteen ja siihen liittyvät viivasegmentit.

Tukipisteiden lisääminen tai poistaminen
1. Valitse muokattava reitti.
2. Valitse kynä-, tukipisteen lisäys- tai tukipisteen poistotyökalu.
3. Jos haluat lisätä tukipisteen, siirrä osoitin reitin segmentin päälle ja napsauta. Jos haluat poistaa tukipisteen, siirrä osoitin sen päälle ja

napsauta.

Illustratorissa voidaan lisätä reitille tukipisteitä valitsemalla objekti ja komento Objekti > Reitti > Lisää tukipisteitä.

Automaattisen kynätyökalun vaihdon estäminen tai tilapäinen ohittaminen
Voit estää kynätyökalun automaattisen vaihtamisen tukipisteen lisäys- tai tukipisteen poistotyökaluksi. Tästä on hyötyä, jos haluat aloittaa uuden
reitin vanhan reitin päältä.

Valitse Photoshopissa Asetukset-palkista Automaattinen lisäys/poisto.
Pidä Illustratorissa vaihtonäppäintä painettuna ja siirrä kynätyökalu valitun reitin tai tukipisteen päälle. (Jotta vaihtonäppäin ei rajoittaisi
kynätyökalun liikkeitä, vapauta se ennen hiiren painikkeen vapauttamista.)
Valitse Illustratorissa Muokkaa > Oletusarvot > Yleiset (Windows) tai Illustrator > Oletusarvot > Yleiset (Mac OS) ja sitten Estä automaattinen
lisäys/poisto.
InDesignissa voit painaa mitä tahansa pikanäppäintä, tehdä tarvittavat muutokset ja vapauttaa hiiren painikkeen. Jos sinulla on esimerkiksi
kynätyökalu valittuna, voit avata suoravalintatyökalun pitämällä A-painiketta painettuna, muokata pisteitä, ja kynätyökalu on valittuna, kun
vapautat A-painikkeen.
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Tasoituspisteiden ja kulmapisteiden muuntaminen
Reiteillä voi olla kahdenlaisia ankkuripisteitä: kulmapisteitä ja tasoituspisteitä. Kulmapisteessä reitti muuttaa suuntaa äkillisesti. Tasoituspisteessä
reitin segmentit yhdistyvät yhtenäiseksi käyräksi. Muunna suuntapiste -työkalu . Voit muuttaa työkalulla ankkuripisteen kulmapisteestä
tasoituspisteeksi ja päinvastoin.

1. Valitse muokattava reitti suoravalintatyökalulla .
2. Valitse muunna suuntapiste -työkalu . (Siirrä tarvittaessa osoitin kynätyökalun päälle ja valitse muunna suuntapiste -työkalu vetämällä.)

Jos haluat muuttaa muunna suuntapiste -työkalun tilapäisesti suoravalintatyökaluksi, paina Ctrl- (Windows) tai komentonäppäintä
(Mac OS).

3. Vie työkalu muunnettavan ankkuripisteen päälle ja valitse jokin seuraavista toiminnoista:

Jos haluat muuntaa kulmapisteen tasoituspisteeksi, vedä suuntaviivat pois kulmapisteestä.

Tasoituspisteen luonti vetämällä suuntaviivat pois kulmapisteestä

Jos haluat muuntaa tasoituspisteen kulmapisteeksi ilman suuntaviivoja, napsauta tasoituspistettä.

Kulmapisteen luonti tasoituspistettä napsauttamalla

Jos haluat muuntaa kulmapisteen suuntaviivoja käyttämättä kulmapisteeksi, jolla on itsenäiset suuntaviivat, vedä suuntaviivat ensin pois
kulmapisteestä (muuttuu tasoituspisteeksi). Vapauta hiiren painike ja vedä jompaakumpaa suuntaviivaa.

Jos haluat muuntaa pisteen, avaa Reittietsin-paneeli (valitse Ikkuna > Objektin asettelu > Reittietsin) ja napsauta Normaali-, Kulma- tai
Symmetrinen-painiketta Muunna piste -osiossa.

Jos haluat muuntaa tasoituspisteen kulmapisteeksi, jolla on itsenäiset suuntaviivat, vedä jompaakumpaa viivaa.

Tasoituspisteen muuntaminen kulmapisteeksi

Voit muuntaa pisteitä myös valitsemalla pisteen suoravalintatyökalulla ja valitsemalla sitten komento Objekti > Muunna piste -valikosta. Voit
esimerkiksi valita tasoituspisteen U-kuvion alaosasta ja valita sitten Objekti > Muunna piste > Normaali. Tällöin suuntaviivat poistetaan ja U-
kuvio muuttuu V-kuvioksi. Valitse Kulma, jos haluat luoda pisteen, jonka suuntaviivoja voi siirtää erikseen. Valitse Tasainen, jos haluat luoda
pisteen, jonka kahvat voivat olla erimittaiset. Valitse Symmetrinen, jos haluat luoda pisteen, jonka kahvat ovat saman mittaiset.

Reitin katkaiseminen
Voit jakaa reitin, grafiikkakehyksen tai tyhjän tekstikehyksen ankkuripisteestä tai reitin mukaisesti. Kun jaat reitin, ota huomioon seuraavat seikat:

647



Alkuun

Alkuun

Jos haluat jakaa suljetun reitin kahdeksi avoimeksi reitiksi, reitti on katkaistava kahdesta kohdasta. Jos katkaiset reitin vain kerran, tuloksena
on yksi reitti, jossa on väli.

Jaon seurauksena syntyvät reitit perivät alkuperäisen reitin asetukset, kuten viivan paksuuden ja täytön värin. Viivan tasaus on ehkä
vaihdettava sisäpuolelta ulkopuolelle.

Reitin jakaminen saksityökalulla
1. (Valinnainen) Valitse reitti, jos haluat nähdä sen nykyiset ankkuripisteet.
2. Valitse saksityökalu ja napsauta reittiä kohdassa, josta haluat jakaa reitin. Kun jaat reitin segmentin keskeltä, kaksi uutta lopetuspistettä

näkyvät päällekkäin ja yksi lopetuspiste valitaan.
3. Säädä uutta ankkuripistettä tai segmenttiä suoravalintatyökalulla.

Reitin avaaminen Reittietsin-paneelin avulla
1. Valitse suljettu reitti.
2. Voit avata Reittietsin-paneelin valitsemalla Ikkuna > Objektin asettelu > Reittietsin.
3. Napsauta Reittietsin-paneelin Avaa reitti -painiketta.

Reittien tasoittaminen
Tasoitustyökalun avulla voit poistaa ylimääräiset kulmat reitistä tai sen osasta. Työkalu säilyttää reitin alkuperäisen muodon mahdollisimman
tarkasti. Tasoitetulla reitillä on yleensä vähemmän pisteitä kuin vapaamuotoisella reitillä, joten sen muokkaaminen, näyttäminen ja tulostaminen on
helpompaa.

Reitti ennen Tasoitustyökalun käyttämistä ja sen jälkeen

1. Valitse reitti.
2. Valitse tasoitustyökalu.

Huomautus: jos lyijykynätyökalu on valittu, vaihda se tilapäisesti tasoitustyökaluksi pitämällä Alt-näppäintä (Windows) tai optionäppäintä
(Mac OS) painettuna.

3. Vedä työkalua reitin tasoitettavaa segmenttiä pitkin.
4. Jatka tasoittamista, kunnes viiva tai reitti on riittävän tasainen.
5. Jos haluat säätää tasoitusta, kaksoisnapsauta tasoitustyökalua ja määritä seuraavat asetukset:

Tarkkuus Määrittää, kuinka kaukana kaaret voivat olla, ennen kuin reittiä on muokattava. Mitä pienempi arvo, sitä tarkemmin käyrät
vastaavat osoittimen liikkeitä ja sitä terävämpiä kulmat ovat. Jos arvo on suuri, reitti ei reagoi osoittimen pieniin liikkeisiin ja käyristä tulee
tasaisempia. Pikseliarvoalue on 0,5–20.

Tasaisuus Tämä asetus vaikuttaa työkalulla luodun reitin tasoitukseen. Tasaisuusarvo voi olla 0–100 %; suurempi arvo merkitsee
tasaisempaa reittiä.

Pidä valittuna Tämä asetus määrittää, onko reitti valittu sen tasoittamisen jälkeen.

Suljettujen reittien tai objektien muodon muuttaminen

1. Valitse suoravalintatyökalu  ja tee jokin seuraavista:

Vedä kohdistin valittavien ankkuripisteiden ympäri.

Pidä vaihtonäppäintä alhaalla ja napsauta valittavia ankkuripisteitä.

2. Aseta osoitin sen ankkuripisteen tai segmentin päälle, jonka haluat toimivan keskuspisteenä (valittuja segmenttejä vetävänä pisteenä), ja
napsauta sitten ankkuripistettä tai segmenttiä.

3. Säädä reittiä vetämällä valittuja ankkuripisteitä. Segmentin liikkeen määrä on suhteessa sen etäisyyteen valitusta pisteestä:

Keskuspisteinä toimivat valitut pisteet siirtyvät valintatyökalun mukana sitä vedettäessä.

Muut valitut pisteet siirtyvät yhdessä vedettävän keskuspisteen kanssa.
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Muodonmuutos ei vaikuta ankkuripisteisiin, joita ei ole valittu.

Tietoja sijoitustyökalusta

Sijoitustyökalu  ei ole käytettävissä InDesign CS5:ssä. Voit sen sijaan valita ja muokata valintatyökalulla joko kehystä tai sen sisältöä. Katso
Objektien valitseminen.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Piirtäminen viiva- ja muototyökaluilla
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Perusviivojen ja -muotojen piirtäminen
Useiden objektien piirtäminen ruudukkona
Paikkamerkkimuodon piirtäminen
Monikulmion asetusten määrittäminen
Reitin muodon muuttaminen automaattisesti

Perusviivojen ja -muotojen piirtäminen
1. Valitse jokin seuraavista työkaluista:

Piirrä viiva tai muoto valitsemalla viivatyökalu , ellipsityökalu , suorakulmiotyökalu  tai monikulmiotyökalu . (Voit valita ellipsi-
tai monikulmiotyökalun napsauttamalla suorakulmiotyökalua ja pitämällä hiiren painikkeen alhaalla.)

Jos haluat piirtää paikkamerkkinä toimivan (tyhjän) grafiikkakehyksen, valitse ellipsikehys- , suorakulmiokehys-  tai
monikulmiokehystyökalu .

2. Luo reitti tai kehys vetämällä työkalu julkaisuikkunaan.

Jos haluat piirtää keskipisteestä lähtien, pidä Alt- (Windows) tai optionäppäintä (Mac OS).

Jos haluat rajoittaa suoran suunnan 45 asteen kulmiin tai reitin tai kehyksen leveyden ja korkeuden yhtä suureksi, pidä vaihtonäppäintä
alhaalla vetäessäsi.

Jos haluat luoda ruudukkoon useita muotoja, paina nuolinäppäimiä samalla, kun pidät hiiren näppäintä alhaalla. Katso Useiden objektien
piirtäminen ruudukkona.

Jos haluat muuttaa monikulmion sivujen määrää, aloita vetäminen, paina välilyöntinäppäintä ja paina sitten ylä- ja alanuolinäppäimiä.
Voit muuttaa tähtiupotusta vasemman- ja oikeanpuoleisella nuolinäppäimellä. Paina välilyöntinäppäintä uudelleen, jos haluat palata
ruudukkotilaan.

Perusympyrän luominen vetämällä

Huomautus: Edellä olevassa kuvassa näkyy reitin ympärillä muokkausalue. Jos käytössä on viimeksi ollut valintatyökalu , näkyvissä on
muokkausalue. Jos käytössä on viimeksi ollut suoravalintatyökalu , näkyvissä ovat reitin ankkuripisteet.

Useiden objektien piirtäminen ruudukkona
Kun käytät kehyksen luontityökaluja, kuten suorakulmiotyökalua tai tekstityökalua, muokkausnäppäimiä painamalla voit luoda ruudukon, jossa on
yhtä kaukana toisistaan olevia kehyksiä.

Voit katsella objektien piirtämistä ruudukkoon käsittelevän videon osoitteessa http://tv.adobe.com/go/4949/.

1. Valitse työkalu, jolla voit piirtää kehyksen.

2. Aloita vetäminen. Pidä hiiren painiketta painettuja ja tee jokin seuraavista toimenpiteistä:

Voit muuttaa palstojen määrää vasemman- ja oikeanpuoleisella nuolinäppäimellä. Voit muuttaa rivien määrää ylä- ja alanuolinäppäimellä.

Muuttaa kehysten väliä pitämällä Ctrl-painiketta (Windows) tai Komentopainiketta (Mac OS) painettuna samalla, kun painat
nuolinäppäimiä.

3. Vapauta hiiren painike.

Jos haluat muuttaa tähtiupotuksen sivujen määrää nuolinäppäimillä käyttäessäsi Monikulmiotyökalua, paina välilyöntinäppäintä samalla, kun pidät
hiiren näppäintä painettuna.
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Paikkamerkkimuodon piirtäminen
Paikkamerkkimuoto on ellipsi, suorakulmio tai monikulmio, joka sisältää julkaisuikkunassa X-merkin. Tämä osoittaa, että kohta korvataan
myöhemmin tekstillä tai kuvalla.

1. Valitse työkalupaneelista ellipsikehystyökalu , suorakulmiokehystyökalu  tai monikulmiokehystyökalu .
2. Luo reitti tai kehys vetämällä työkalu julkaisuikkunaan. Pakota kehyksen leveys ja korkeus tiettyyn mittaan pitämällä vaihtonäppäintä alhaalla.

Voit muuttaa rajauksen määrää, viitepistettä ja muita paikkamerkkikehyksen sovittamisasetuksia valitsemalla Objekti > Sovitus > Kehyksen
sovittamisasetukset.

Monikulmion asetusten määrittäminen
1. Jos haluat käyttää monikulmion asetuksia aiemmin luoduissa muodoissa, valitse monikulmiot.

2. Kaksoisnapsauta monikulmiotyökalua , määritä seuraavat asetukset ja valitse OK:

Kirjoita Sivumäärä-kohtaan monikulmion sivujen määrä.

Kirjoita Tähtiupotus-kohtaan prosenttiarvo, joka määrittää tähden sakaroiden pituuden. Sakaroiden kärjet koskettavat monikulmion
muokkausalueen ulkoreunaa, ja prosenttiarvo määrittää sakaroiden välisen painanteen syvyyden. Mitä suurempi prosenttiarvo, sitä
pidemmät ja ohuemmat sakarat.

Reitin muodon muuttaminen automaattisesti
Voit muuntaa mikä tahansa reitin haluamaasi muotoon. Voit esimerkiksi muuntaa suorakulmion kolmioksi. Alkuperäisen reitin viiva-asetukset
säilyvät uudessa reitissä. Jos uusi reitti on monikulmio, sen muoto määrittyy Monikulmion asetukset -valintaikkunan asetusten mukaan. Jos
uudessa reitissä on kulmatehoste, sen säde perustuu Kulma-asetukset-valintaikkunassa määritettyyn kokoasetukseen.

1. Valitse reitti.
2. Tee jokin seuraavista toimista:

Valitse Objekti > Muunna muoto > [uusi muoto].

Napsauta yhtä Reittietsin-paneelin (Ikkuna > Objektin asettelu > Reittietsin) Muunna muoto -alueen muotopainikkeista.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Tietoja yhdistelmäreiteistä
Yhdistelmäreittien parhaat muokkauskäytännöt
Yhdistelmäreitin luominen
Reikien muuttaminen täytöiksi yhdistelmäreitissä
Yhdistelmäreitin purkaminen
Yhdistelmäreitin reikien muuttaminen
Yhdistelmämuotojen luominen
Reittien luominen tekstin ääriviivoista

Tietoja yhdistelmäreiteistä
Voit yhdistää useita reittejä yhdeksi objektiksi eli yhdistelmäreitiksi. Luo yhdistelmäreitti seuraavissa tapauksissa:

Haluat lisätä reittiin läpinäkyviä reikiä.

Haluat säilyttää läpinäkyvät reiät joissakin kirjainmerkeissä, kuten o:ssa ja e:ssä, kun muunnat merkkejä muokattavaksi kirjainmuodoiksi Luo
ääriviivat -komennolla. Tämän komennon käyttäminen luo aina yhdistelmäreitin.

Haluat liittää reittiin liukuvärin tai useille reiteille ulottuvan sisällön. Voit liittää liukuvärin useisiin objekteihin myös liukuvärityökalulla, mutta
useimmiten se kannattaa liittää yhdistelmäreittiin, sillä tällöin voit myöhemmin muokata koko liukuväriä valitsemalla jonkin alireiteistä. Jos
käytät liukuvärityökalua, joudut myöhemmin muokatessasi valitsemaan kaikki alun perin valittuna olleet reitit.

Yhdistelmäreittien parhaat muokkauskäytännöt
Muista seuraavat seikat, kun muokkaat yhdistelmäreittejä:

Reitin määritteiden (kuten viivan ja täytön) muutokset vaikuttavat aina kaikkiin yhdistelmäreitin alireitteihin riippumatta siitä, mitä
valintatyökalua käytät tai montako alireittiä valitset. Jos haluat säilyttää yhdistettävien reittien yksilölliset viiva- ja täyttömääritteet, ryhmitä
reitit.

Kaikki reitin tehosteet, jotka on sijoitettu suhteessa reitin muokkausalueeseen (kuten liukuväri tai alueen sisäpuolelle liitetty kuva), sijoitetaan
itse asiassa suhteessa koko yhdistelmäreitin (eli kaikki alireitit sisältävän reitin) muokkausalueeseen.

Jos luot yhdistelmäreitin, muutat sitten sen ominaisuuksia ja vapautat sen Vapauta-komennolla, vapautetut reitit perivät yhdistelmäreitin
ominaisuudet alkuperäisten ominaisuuksien palautumisen sijaan.

Jos julkaisussa on yhdistelmäreittejä, joissa on useita tasoituspisteitä, joissakin tulostimissa voi esiintyä häiriöitä. Jos näin, sinun kannattaa
yksinkertaistaa tai poistaa yhdistelmäreitit tai muuntaa ne bittikartoiksi esimerkiksi Adobe Photoshopin avulla.

Jos liität yhdistelmäreittiin täytön, reiät saattavat näkyä yllättävissä paikoissa. Yksinkertaisten reittien, kuten suorakulmioiden, sisäpuoli eli
täytettävä alue on helppo havaita: kyseessä on suljetun reitin sisäpuolinen alue. Sen sijaan yhdistelmäreiteille InDesignin on määritettävä,
ovatko yhdistelmäreitin alireittien leikkauskohdat reitin sisäpuolella (täytetyt alueet) vai ulkopuolella (reiät). Kunkin alireitin suunta (pisteiden
luontijärjestys) määrittää, onko sen määrittämä alue reitin sisä- vai ulkopuolella. Jos alireitti on täytetty, kun haluat sen muodostavan reiän, tai
päinvastoin, voit muuttaa alireitin suuntaa napsauttamalla Reittietsin-paneelin Käänteinen reitti -painiketta.

Kaksi samansuuntaista alireittiä sisältävä yhdistelmäreitti (vasen) ja kaksi vastakkaissuuntaista alireittiä sisältävä yhdistelmäreitti (oikea)

Yhdistelmäreitin luominen
Yhdistelmäreitti luodaan vähintään kahdesta avoimesta tai suljetusta reitistä. Kaikista alun perin valittuna olleista reiteistä tulee uuden luotavan
yhdistelmäreitin alireittejä. Valitut reitit perivät pinossa alimmaisena olevan objektin viivan ja täytön asetukset.
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Huomautus: Jos vähintään yhdessä objektissa on sisältöä, kuten tekstiä tai tuotuja kuvia, kauimmaisen objektin määritteet ja sisältö määrittävät
yhdistelmäreitin määritteet ja sisällön. Kauempana olevat valitut objektit, joissa ei ole sisältöä, eivät vaikuta yhdistelmäreittiin.

Voit muuttaa yhdistelmäreitin minkä tahansa osan muotoa valitsemalla alireitin ankkuripisteen suoravalintatyökalulla .

1. Valitse valintatyökalulla  kaikki yhdistelmäreittiin sisällytettävät reitit.
2. Valitse Objekti > Reitit > Tee yhdistelmäreitti. Paikoissa, joissa valitut reitit menevät päällekkäin, on reikä.

Voit täyttää alireitin luoman reiän tai muuttaa alireitin reiäksi. Valitse suoravalintatyökalulla jokin muutettavan alireitin pisteistä. Valitse sitten
Objekti > Reitit > Käänteinen reitti tai napsauta Reittietsin-paneelin Käänteinen reitti -painiketta.

Reikien muuttaminen täytöiksi yhdistelmäreitissä
Kunkin alireitin suunta (pisteiden luontijärjestys) määrittää, onko sen määrittämä alue reitin sisä- (täytetyt alueet) vai ulkopuolella (tyhjä). Jos reiät
eivät joskus näy yhdistelmäreitilläsi oikeissa kohdissa, voit kääntää kyseisen alireitin suuntaa.

Kaksi erillistä suljettua reittiä (vasen) ja kaksi saman yhdistelmäreitin alireittiä (oikea) – yhdistelmäreitissä keskiympyrä on reikä

1. Valitse käännettävä yhdistelmäreitin osa (tai osalla oleva piste) suoravalintatyökalulla . Älä valitse koko yhdistelmäreittiä.
2. Tee jokin seuraavista:

Valitse Objekti > Reitit > Käänteinen reitti.

Napsauta Reittietsin-paneelin Käänteinen reitti -painiketta.

Yhdistelmäreitin purkaminen
Voit purkaa yhdistelmäreitin vapauttamalla sen, jolloin kaikista sen alireiteistä tulee itsenäisiä.

1. Valitse yhdistelmäreitti valintatyökalulla .
2. Valitse Objekti > Reitit > Vapauta yhdistelmäreitti.

Huomautus: Vapauta-komento ei ole käytettävissä, jos valittu yhdistelmäreitti on kehyksessä tai jos se sisältää tekstiä.

Yhdistelmäreitin reikien muuttaminen
Voit poistaa alireitin luoman reiän tai täyttää reiän luoneen alireitin kääntämällä sen suunnan.

1. Valitse suoravalintatyökalulla  jokin käännettävän alireitin pisteistä. Älä valitse koko yhdistelmäreittiä.
2. Valitse Objekti > Reitit > Käänteinen reitti tai napsauta Reittietsin-paneelin Käänteinen reitti -painiketta.

Yhdistelmämuotojen luominen
Voit luoda yhdistelmämuotoja Reittietsin-paneelissa (Ikkuna > Objektin asettelu > Reittietsin). Yhdistelmämuodot voivat koostua yksinkertaisista
reiteistä tai yhdistelmäreiteistä, tekstikehyksistä, tekstin ääriviivoista tai muista muodoista. Yhdistelmämuodon ulkoasu vaihtelee valitun Reittietsin-
painikkeen mukaan.
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Reittietsin-paneeli
A. Alkuperäiset objektit B. Lisää C. Vähennä D. Päällekkäinen E. Ohita limittäiset F. Vähennä taaimmainen

Lisää Luo yksittäisen muodon seuraamalla kaikkien objektien ääriviivaa.
Vähennä Etualalla olevat objektit tekevät "reikiä" niiden takana oleviin objekteihin.
Päällekkäinen Luo muodon päällekkäisistä alueista.
Ohita limittäiset Luo muodon alueista, jotka eivät osu päällekkäin.
Vähennä taaimmainen Taka-alalla olevat objektit tekevät "reikiä" niiden edessä oleviin objekteihin.
Useimmissa tapauksissa tuloksena syntyvässä muodossa käytetään etummaisen objektin määritteitä (esimerkiksi täyttöä, viivaa, läpinäkyvyyttä tai
tasoa). Kun vähennät muotoja, edessä olevat objektit kuitenkin poistetaan. Tällöin tuloksena saadussa muodossa käytetään taimmaisen objektin
määritteitä.

Kun yhdistelmämuotoon sisältyy tekstikehys, tekstikehyksen muoto muuttuu, mutta teksti pysyy samana. Jos haluat muuttaa tekstiä, luo
yhdistelmäreitti tekstin ääriviivoja käyttäen.

Tekstikehyksenä käytettyä yhdistelmämuotoa (vasen) verrataan tekstin ääriviivoista luotuun muotoon (oikea)

Yhdistelmämuodon luominen
Voit käsitellä yhdistelmämuotoa yhtenä yksikkönä tai vapauttaa sen osareitit ja käsitellä niitä erillisinä. Voit esimerkiksi määrittää liukuväritäytön
yhdistelmämuodon osalle ja jättää muodon loppuosan täyttämättä.

Yhdistelmämuotoon käytettyä liukuväriä (vasen) verrataan yhdistelmämuodon yhteen osaan käytettyyn liukuväriin (oikea)

1. Avaa paneeli valitsemalla Ikkuna > Objektin asettelu > Reittietsin.
2. Valitse objektit, jotka haluat yhdistää yhdistelmämuodoksi.
3. Napsauta Reittietsin-paneelin Reittietsin-kohdassa haluamaasi painiketta (kuten Lisää).

Voit valita komennon myös Objekti > Reittietsin-alivalikosta.
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Yhdistelmämuodon reittien vapauttaminen
 Valitse yhdistelmäreitti. Valitse Objekti > Reitit > Vapauta yhdistelmäreitti. Yhdistelmäreitti erotetaan osareiteiksi.

Jos haluat ryhmitellä osareitit uudelleen menettämättä yksittäisiin reitteihin tekemiäsi muutoksia, valitse Objekti-valikosta Ryhmitä
(Yhdistelmäreitit > Tee -komennon sijasta).

Reittien luominen tekstin ääriviivoista
Luo ääriviivat -komennolla voit muuntaa valitut kirjainmerkit yhdistelmäreiteiksi, joita voit muokata ja käsitellä muiden reittien tavoin. Luo ääriviivat -
komento on hyödyllinen, kun luot tehosteita ja kirjainkoko on suuri. Sitä ei yleensä kannata käyttää leipätekstin eikä muiden pienten kirjainkokojen
kanssa.

Jos haluat vain käyttää värillistä viivaa tai lisätä kirjainmerkkeihin liukuväritäytön tai viivan, tekstiä ei tarvitse muuntaa ääriviivoiksi. Voit liittää
suoraan värejä ja liukuvärejä valittujen merkkien viivoihin ja täyttöihin työkalupaneelia sekä Värimallit-, Väri- ja Liukuväri-paneeleja käyttämällä.

Luo ääriviivat -komento saa kirjasimien ääriviivoja koskevat tiedot Type1-, TrueType- tai OpenType-tiedostoista. Kun luot ääriviivat, muunnettavat
merkit pysyvät entisissä paikoissaan ja säilyttävät kaikki grafiikka-asetukset, kuten viivan ja täytön.

Huomautus: Jotkin kirjasinvalmistajat salaavat ääriviivojen luonnissa tarvittavat tiedot. Jos käytät tällä tavalla suojattua kirjasinta ja valitset
Teksti > Luo ääriviivat, näkyviin tuleva sanoma ilmoittaa, ettei kirjasinta voi muuntaa.
Kun muunnat tekstin ääriviivoiksi, menetät tekstin vihjeet eli ääriviivakirjasimiin liitetyt muotojen säätöohjeet, joita järjestelmä tarvitsee näyttääkseen
ja tulostaakseen muodot optimaalisesti pienessä koossa. Siksi ääriviivoiksi muunnettu teksti ei välttämättä näy virheettömästi pienessä koossa tai
alhaisella resoluutiolla.

Kun olet muuntanut tekstin ääriviivoiksi, voit toimia seuraavasti:

Voit muuttaa kirjainmuotoja vetämällä yksittäisiä ankkuripisteitä suoravalintatyökalulla .

Voit peittää kuvan ja liittää sen muunnettuihin ääriviivoihin kopioimalla ääriviivat ja valitsemalla Muokkaa > Liitä kohteeseen.

Voit käyttää muunnettuja ääriviivoja tekstikehyksinä, joihin voit kirjoittaa tai sijoittaa tekstiä.

Voit muuttaa viivan määritteitä tai kirjainmuotoja.

Voit luoda yhdistelmämuotoja tekstin ääriviivojen avulla.

Tekstin ääriviivojen käsitteleminen
A. Tekstimerkki ennen muuntamista tekstin ääriviivaksi B. Tekstin ääriviivaan liitetty kuva C. Tekstikehyksenä käytetty tekstikehys

Muunnetuista tekstin ääriviivoista tulee yhdistelmäreittejä, joten voit muokata muunnettujen ääriviivojen yksittäisiä alireittejä
suoravalintatyökalun avulla. Voit myös purkaa ääriviivat itsenäisiksi reiteiksi vapauttamalla ne yhdistelmäreitistä.

Tekstin ääriviivojen muuntaminen reiteiksi
Oletusarvoisesti tekstin muunto ääriviivoiksi poistaa alkuperäisen tekstin. Halutessasi voit kuitenkin määrittää ääriviivat näkymään alkuperäisen
tekstin päällä, jolloin teksti ei katoa.

Kun valitset tekstikehyksessä kirjainmerkkejä ja muunnat ne ääriviivoiksi, luotavat ääriviivat ovat ankkuroitua (tekstiin sidottua) grafiikkaa. Koska
muunnettu teksti ei ole enää oikeaa tekstiä, et voi enää valita ja muokata merkkejä tekstityökalulla. Myöskään typografiset komennot eivät enää
koske sitä, Varmista, että olet tyytyväinen ääriviivoiksi muunnettavan tekstin typografisiin asetuksiin. Muista myös kopioida alkuperäinen teksti.

1. Valitse tekstikehys valintatyökalulla  tai valitse vähintään yksi merkki tekstityökalulla.
2. Valitse Teksti > Luo ääriviivat.

Tekstin ääriviivojen kopion muuntaminen reiteiksi
1. Valitse tekstikehys valintatyökalulla  tai valitse vähintään yksi merkki tekstityökalulla.
2. Pidä Alt- (Windows) tai optionäppäintä (Mac OS) alhaalla ja valitse Teksti > Luo ääriviivat. Kopio sijoitetaan alkuperäisen tekstin päälle. Voit

halutessasi vetää sen valintatyökalulla muualle.

Lisää ohjeaiheita
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Kulman ulkoasun muuttaminen

Alkuun

Alkuun

Alkuun

Kulmamuotojen käyttäminen Kulma-asetukset-valintaikkunasta
Käytössä olevien kulmien käyttäminen
Ohjeita kulmamuotojen käyttämisestä

Kulma-asetukset-komennolla voit nopeasti liittää kulmatehosteita reitteihin. Kulman tehosteet vaihtelevat yksinkertaisista pyöristyksistä
monimuotoisiin koristeisiin.

Viivan paksuuden vaikutus kulman muotoihin
A. Monimuotoinen kulmatehoste, ei viivaa B. Sama tehoste, 1 pisteen viiva C. Sama tehoste, 4 pisteen viiva

Voit katsella kulmatehosteiden käyttöä käsittelevän videon osoitteessa http://tv.adobe.com/go/4948/.

Kulmamuotojen käyttäminen Kulma-asetukset-valintaikkunasta
1. Valitse reitti valintatyökalulla.

2. Valitse Objekti > Kulma-asetukset.

3. Jos haluat käyttää kulmatehostetta kaikissa suorakulmion kulmissa, napsauta Määritä kaikki asetukset samoiksi -kuvaketta . Kun asetusta
ei ole valittu, kuvakkeen molemmilla puolilla näkyy pisteitä (kuin rikkinäinen ketjun rengas).

4. Valitse kulmatehoste ja määritä koko yhdelle tai usealle kulmalle.

Tämä kokoarvo määrittää säteen, jolla kulmatehoste laajenee kustakin kulmapisteestä.

5. Valitse Esikatselu, jos haluat nähdä tehosteen vaikutuksen ennen sen käyttöä. Valitse lopuksi OK.

Käytössä olevien kulmien käyttäminen
Käytössä olevilla kulmilla voit käyttää kulmatehosteita suorakulmaisissa kehyksissä napsauttamalla kehyksessä olevaa keltaista laatikkoa ja
vetämällä. Lisäksi voit käyttää erilaisia kulmatehosteita ja erilaisia kulmasäteitä eri kulmissa.

1. Valitse suorakulmainen kehys ja napsauta keltaista laatikkoa.

Neljä keltaista timanttia ilmestyy valittuun kehykseen. Tämä ilmaisee Käytössä olevat kulmat -tilan. Jos keltaista laatikkoa ei näy valitussa
kehyksessä, valitse Näytä > Ekstrat > Näytä Käytössä olevat kulmat.

2. Jos haluat lisätä kulmatehosteita, tee jokin seuraavista toimista:

Jos haluat säätää kaikkien neljän kulman sädettä samalla kertaa, vedä yhtä timanteista kohti kehyksen keskikohtaa.

Jos haluat säätää yhtä kulmaa, pidä vaihtonäppäin painettuna vetäessäsi timanttia.

Jos haluat selata eri tehosteita, napsauta keltaista timanttia Alt-näppäin (Windows) tai Optionäppäin (Mac OS) alhaalla.

3. Jos haluat lopettaa kulmien muokkaamisen, napsauta valitun kehyksen ulkopuolelle.

Jos haluat poistaa kulmatehosteita, valitse Objekti > Kulma-asetukset ja valitse sitten Ei mitään.

Jos et halua keltaisen laatikon ilmestyvän, kun valitset kehyksen, valitse Näytä > Ekstrat > Piilota Käytössä olevat kulmat.

Ohjeita kulmamuotojen käyttämisestä
Pidä mielessä seuraavat:
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Jos olet hankkinut lisätehosteita sisältävän laajennusohjelmiston, Viiva-paneelin Kulma-asetukset-komento voi sisältää ylimääräisiä muotoja.

Kulmatehosteet näkyvät kaikissa reitin kulmapisteissä, mutta eivät tasoituspisteissä. Tehosteiden kulmat muuttuvat automaattisesti, kun siirrät
reitin kulmapisteitä.

Jos kulmatehoste muuttaa reittiä huomattavasti esimerkiksi pullistumalla sisään- tai ulospäin, se voi vaikuttaa siihen, miten kehys vaikuttaa
sisältöönsä tai muuhun sivuasetteluun. Jos suurennat kulmatehostetta, tekstinkierrätys tai kehyksen vierus voi loitontua kehyksestä.

Kulmatehostetta ei voi muokata, mutta sen ulkoasua voi muuttaa muuttamalla kulman sädettä tai muokkaamalla viivaa.

Jos olet käyttänyt kulmatehosteita mutta et näe niitä, varmista, että reitissä on kulmapisteitä ja että siihen on liitetty viivaväri tai liukuväri.
Suurenna sitten Kulma-asetukset-valintaikkunan Koko-kohdan arvoa tai lisää viivan paksuutta Viiva-paneelissa.
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Viiva-asetusten käyttäminen

Alkuun

Alkuun

Viivojen määrittäminen
Viiva-paneelin asetukset
Alku- ja loppumuotojen lisääminen
Mukautettujen viivatyylien määrittäminen
Mukautettujen viivatyylien tallentaminen

Viivojen määrittäminen
Voit käyttää viivoja tai viiva-asetuksia reiteissä, muodoissa, tekstikehyksissä ja tekstin ääriviivoissa. Viivan paksuutta ja ulkoasua,
segmenttiliitoksia, alku- ja loppumuotoja sekä kulma-asetuksia voi hallita Viiva-paneelissa. Voit valita viiva-asetuksia myös Ohjauspaneelista, kun
reitti tai kehys on valittuna.

Viivojen käyttäminen
A. Tekstikehyksessä käytetty viiva B. Tekstin ääriviivassa käytetty viiva C. Ympyrässä käytetty viiva

Jos käytät usein samoja viiva-asetuksia, voit tallentaa asetukset objektin tyyliin ja käyttää helposti samoja asetuksia missä tahansa objektissa.
Lisätietoja on kohdassa Objektityylit.

1. Valitse reitti, jonka viivaa haluat muuttaa.
Huomautus: Kun valitset reitin valintatyökalulla , aktivoit koko reittiä ympäröivän muokkausalueen. Jos haluat nähdä pelkän reitin, valitse
reitti sen sijaan suoravalintatyökalulla .

2. Avaa Viiva-paneeli valitsemalla Ikkuna > Viiva.
3. Valitse Paksuus-kohtaan valikosta haluamasi viivan paksuus tai kirjoita arvo ja paina Enter- tai Return-näppäintä.

Huomautus: Jos viivan paksuus on alle 0,25 pistettä, se ei ehkä näy valolatomakoneella tai muulla teräväpiirtotulostimella tulostettuna. Voit
poistaa viivan antamalla sen arvoksi 0 (nolla).

4. Jos lisäasetukset eivät ole näkyvissä, näytä muut viivan määritteet valitsemalla paneelivalikosta Näytä asetukset.
5. Muuta muita viivan asetuksia tarpeen mukaan.

Huomautus: Jos haluat muuttaa viivan väriä, käytä työkalupaneelia ja Värimallit-paneelia. Lisätietoja: Värin lisääminen.

Viiva-paneelin asetukset
Viisteraja Määrittää pisteen pituuden ja viivan leveyden välisen suhteen rajan, jossa terävä kulmaliitos muuttuu suoristetuksi viisteliitokseksi. Jos
arvo on esimerkiksi 9, pisteen pituuden on oltava 9 kertaa viivan leveys, ennen kuin kulmaliitos muuttuu suoristetuksi viisteliitokseksi. Määritä arvo
(1–500) ja paina Enter- tai Return-näppäintä. Viisteraja-asetus ei koske pyöristettyjä liitoksia.

Voit sisällyttää viisterajan ja viivan tasausasetukset kappale- tai merkkityyliin. Napsauta Merkin väri -kohtaa ja ota sitten asetukset käyttöön
napsauttamalla viivakuvaketta.

Pää Valitse pään tyyli avoimen reitin kummallekin päälle:

Suora pää  Luo suorakulmaiset päät, jotka päättyvät loppupisteisiin.
Pyöristetty pää  Luo puolipyöreät päät, jotka jatkuvat puolen viivanpaksuuden verran loppupisteen ulkopuolelle.
Ulkoneva pää  Luo suorakulmaiset päät, jotka jatkuvat puolen viivanpaksuuden verran loppupisteen ulkopuolelle. Kun tämä asetus on
valittuna, viiva on yhtä paksu kaikissa suunnissa reitin ympärillä.
Huomautus: Voit määrittää päätyylin suljetulle reitille, mutta pää tulee näkyviin vain, jos reitti avataan (esimerkiksi saksityökalulla).
Päätyylit näkyvät helpommin, kun viiva on kohtalaisen paksu.

Liitos Määritä viivan ulkoasu kulmapisteissä:

Kulmaliitos  Luo terävät kulmat, jotka jatkuvat loppupisteen ulkopuolelle, kun viisteen pituus on viisterajan mukainen.
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Pyöristetty liitos  Luo pyöristetyt kulmat, jotka jatkuvat puolen viivanpaksuuden verran loppupisteen ulkopuolelle.
Viisteliitos  Luo suorakulmaiset kulmat, jotka päättyvät loppupisteisiin.
Huomautus: Voit määrittää viisteasetukset myös reitille, jossa ei ole kulmapisteitä. Viisteasetukset tulevat voimaan vasta, kun lisäät
reitille kulmapisteitä tai muunnat tasoituspisteitä kulmapisteiksi. Viisteet näkyvät helpommin, kun viiva on kohtalaisen paksu.

Tasaa viiva Määritä viivan sijainti suhteessa reittiin napsauttamalla haluamaasi kuvaketta.
Tyyppi Valitse viivan tyyppi valikosta. Jos valitset Katkoviiva-vaihtoehdon, joukko uusia asetuksia tulee näkyviin.
Alku Valitse vaihtoehto reitin alkua varten.
Loppu Valitse vaihtoehto reitin loppua varten.
Välin väri Määritä kuvioidun viivan katkoviivojen, pisteiden tai viivojen välissä näkyvä väri.
Välin sävy Määritä sävy (kun välin väri on määritetty).

Vaikka katkoviivan voikin määrittää Viiva-paneelissa, katkoviiva on helpompi luoda käyttämällä mukautettua viivatyyliä.

Alku- ja loppumuotojen lisääminen
Muista seuraavat seikat, kun käsittelet alku- ja loppumuotoja:

Käytettävissä olevia alku- ja loppumuotoja ei voi muokata, mutta jos olet hankkinut vaihtoehtoja lisäävän laajennusohjelmiston, Viiva-paneelin
Alku- ja Loppu-valikoissa voi olla ylimääräisiä muotoja.

Alku- ja loppumuotojen koko määräytyy suhteessa viivan paksuuteen. Alku- tai loppumuodon lisääminen ei muuta reitin pituutta.

Alku- ja loppumuodot kiertyvät automaattisesti vastaamaan loppupisteen suuntaviivan kulmaa.

Alku- ja loppumuodot näkyvät vain avointen reittien loppupisteissä, eivät katkoviivan yksittäisissä viivoissa.

Jos käytät alku- ja loppumuotoja avoimia alireittejä sisältävässä yhdistelmäreitissä, kaikilla avoimilla alireiteillä on sama alku- ja loppumuoto.

Voit määrittää alku- ja loppumuodot suljetulle reitille, mutta ne näkyvät vain, jos avaat reitin.

Alku- ja loppumuotomalleja

Luo nuolia alku- ja loppumuodoista
Viiva-paneelin Alku- ja Loppu-valikoissa voit lisätä avoimen reitin päähän nuolen tai muun muodon.

1. Viivatyökalulla voit piirtää viivan tai luoda avoimen reitin.
2. Kun viiva tai reitti on valittuna, avaa Viiva-paneeli ja valitse tyyli Alku- ja Loppu-valikoista. Alku-valikon asetukset koskevat reitin

ensimmäisen (ensimmäisenä piirretyn) loppupisteen muotoa ja Loppu-valikon asetukset viimeisen loppupisteen muotoa.

Reitin alku- ja loppumuotojen vaihtaminen
1. Valitse reitti suoravalintatyökalulla .
2. Valitse Objekti > Reitit > Käänteinen reitti tai napsauta Reittietsin-paneelin Käänteinen reitti -painiketta.

Mukautettujen viivatyylien määrittäminen
Voit luoda mukautetun viivatyylin Viiva-paneelissa. Mukautettu viivatyyli voi koostua katkoviivasta, pisteviivasta tai apuviivasta. Voit määrittää
tyyliin viivan kuvion, päiden tyylin ja kulmien ulkoasun. Voit määrittää muita viivan ominaisuuksia, kuten paksuuden, välin värin sekä alku- ja
loppumuodot, kun mukautettu viivatyyli on määritetty objektille.

Mukautetut viivatyylit
A. Katkoviiva B. Pisteviiva C. Apuviiva
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Mukautettuja viivatyylejä voidaan tallentaa ja ladata muihin InDesign-julkaisuihin.

1. Avaa Viiva-paneeli valitsemalla Ikkuna > Viiva.
2. Valitse paneelivalikosta Viivatyylit.
3. Valitse Uusi.
4. Kirjoita viivatyylin nimi.
5. Valitse Tyyppi-kohdassa jokin seuraavista vaihtoehdoista:

Katkoviiva, jos haluat määrittää tyylin, jossa on katkoviivoja säännöllisin tai vaihtelevin välein.

Apuviiva, jos haluat määrittää tyylin, jossa on samansuuntaisia viivoja.

Pisteviiva, jos haluat määrittää tyylin, jossa on pisteitä säännöllisin tai vaihtelevin välein.

Valintaikkunan vaihtoehdot muuttuvat valinnan mukaisesti.

6. Määritä Kuvion pituus -kohtaan toistuvan kuvion pituus (vain katkoviiva- tai pistetyylit). Viivain päivittyy vastaamaan määrittämääsi pituutta.
7. Määritä viivakuvio seuraavasti:

Lisää uusi katkoviiva, piste tai apuviiva napsauttamalla viivainta.

Siirrä katkoviivaa, pistettä tai apuviivaa vetämällä sitä.

Säädä katkoviivan leveyttä siirtämällä sen viivainmerkkejä . Voit myös valita katkoviivan ja määrittää arvot Alku- (katkoviivan alkukohta
viivaimessa) ja Pituus-kohtiin.

Säädä pisteen sijaintia siirtämällä sen viivainmerkkiä . Voit myös valita pisteen ja määrittää arvon Keskitetty-kohtaan (pisteen
keskikohdan sijainti).

Säädä apuviivan paksuutta siirtämällä sen viivainmerkkejä . Voit myös valita apuviivan ja määrittää arvot Alku- ja Leveys-kohtiin.
Molemmat ilmaistaan osuutena viivan paksuudesta.

Voit poistaa katkoviivan, pisteen tai apuviivan vetämällä sen ulos viivainikkunasta. (Mukautetun viivatyylin on kuitenkin sisällettävä
ainakin yksi katkoviiva, piste tai apuviiva.)

Katkoviivan luominen Uusi viivatyyli -valintaikkunassa
A. Katkoviivan lisääminen kuvioon napsauttamalla B. Katkoviivan leventäminen merkkiä vetämällä C. Katkoviivojen välissä olevan
tyhjän tilan muokkaaminen vetämällä katkoviivaa

8. Voit esikatsella viivaa eripaksuisena määrittämällä viivan paksuuden Esikatselupaksuus-kohtaan.
9. Määritä katkoviiva- ja pistekuvioihin Kulmat-asetuksen avulla, miten katkoviivat tai pisteet sijoitetaan, jotta kuvio tasataan kulman ympäri.

10. Valitse katkoviivakuvioiden Pää-kohtaan tyyli katkoviivojen muodon määrittämiseksi. Tämä asetus ohittaa Viiva-paneelin Pää-asetuksen.
11. Tee jokin seuraavista:

Tallenna viivatyyli valitsemalla Lisää ja määritä uusi tyyli. Sulje valintaikkuna valitsemalla Valmis.

Tallenna viivatyyli ja sulje valintaikkuna valitsemalla OK.

Mukautettujen viivatyylien tallentaminen
Voit tallentaa mukautettuja viivatyylejä muita InDesign-julkaisuja varten.

Mukautetun viivatyylin tallentaminen
1. Valitse Viiva-paneelivalikosta Viivatyylit.
2. Valitse mukautettu viivatyyli ja valitse sitten Tallenna.
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Huomautus: oletusviivatyylejä (merkitty hakasulkeilla) ei voi tallentaa tai muokata.
3. Määritä viivatyylitiedoston (.inst) nimi ja sijainti ja valitse OK.

Mukautetun viivatyylin lataaminen
1. Valitse Viiva-paneelivalikosta Viivatyylit.
2. Napsauta Lataa-painiketta.
3. Valitse tuotavan viivatyylin sisältävä viivatyylitiedosto (.inst) ja valitse sitten OK.

Mukautetun viivatyylin käyttöön ottaminen
 Kun reitti tai kehys on valittuna, valitse mukautettu viivatyyli Viiva-paneelin Tyyppi-valikosta.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Värin käyttäminen

Alkuun

Värin käyttö
Värin valitseminen värinvalitsimella
Viimeksi käytetyn värin käyttäminen
Täyttö- tai viivavärin poistaminen
Värien käyttäminen vetämällä ja pudottamalla
Väri- tai liukuvärimallin käyttäminen
Värin käyttäminen Väri-paneelia käyttämällä
Värimallin luominen Väri-paneelin väristä
Väritilojen selaaminen
Väriteemojen luominen Color-teematyökalulla
Värien lisääminen pipettityökalulla
Värien käyttö harmaasävykuvissa
Väriryhmien lisääminen ja hallinta
Väriryhmän luominen valituilla sivukohteilla 
Värimallien lataaminen ja tallentaminen .ASE-tiedostosta
Teemojen tuominen Color-sovelluksesta

Värin käyttö

Adobe InDesignissa värejä voi ottaa käyttöön useilla eri tavoilla. Käytä esimerkiksi työkalupaneelia, Värimallit-paneelia, Väri-paneelia,
Värinvalitsinta tai Ohjauspaneelia.

Kun käytät väriä, voit määrittää, koskeeko värivalinta objektin viivaa vai täyttöä. Viiva tarkoittaa objektin reunusta tai kehystä, kun taas täyttö on
objektin tausta. Kun käytät väriä tekstikehyksessä, voit määrittää, koskeeko värivalinta tekstikehystä vai sen sisällä olevaa tekstiä.

1. Valitse väritettävä objekti jollakin seuraavista tavoista:

Valitse reitti tai kehys tarpeen mukaan valinta-  tai suoravalintatyökalulla .

Napsauta kuvan sisällön tartuntatyökalua tai käytä suoravalintatyökalua harmaasävy- tai mustavalkokuvalle (1-bittinen). Voit lisätä vain
kahta väriä harmaasävy- tai mustavalkokuvaan.

Muuta tekstimerkkien väriä tekstityökalulla.  Voit muuttaa kehyksessä yhden sanan tai koko tekstin värin.

Kun viivatyyppinä on katkoviiva, pisteviiva tai apuviiva, voit muuttaa viivan välien väriä Viiva-paneelissa.

2. Määritä, käytetäänkö väriä tekstissä vai tekstikehyksessä valitsemalla työkalupaneelista tai Väri- tai Värimallit-paneelista Muotoilu vaikuttaa
tekstiin tai Muotoilu vaikuttaa säilöön.

3. Määritä objektin täyttö tai viiva valitsemalla työkalupaneelista tai Väri- tai Värimallit-paneelista Täyttö- tai Viiva-ruutu. (Jos valitsit kuvan,
Viiva-ruudulla ei ole vaikutusta.)

Määritä värin käyttötapa työkalupaneelin avulla.

A. Täyttö-ruutu B. Muotoilu vaikuttaa säilöön C. Viiva-ruutu D. Muotoilu vaikuttaa tekstiin 

4. Tee jokin seuraavista:

Valitse väri, sävy tai liukuväri Värimallit- tai Liukuväri-paneelista.

Valitse väri, sävy tai liukuväri Ohjauspaneelin Täyttö- tai Viiva-valikosta.

Avaa Värinvalitsin kaksoisnapsauttamalla joko Täyttö- tai Viiva-ruutua työkalupaneelissa tai Väri-paneelissa. Valitse haluamasi väri ja
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valitse OK.

Voit käyttää värejä kaikissa harmaasävykuvissa, jos kuvissa ei ole alfa- tai spottikanavia. Jos tuot rajaavan reitin sisältävän kuvan, voit käyttää
väriä vain rajatulla alueella valitsemalla rajaavan reitin suoravalintatyökalulla.

Värin valitseminen värinvalitsimella

Värinvalitsimessa voit valita värin värikentästä tai määrittää värin numeeriset arvot. Voit määrittää värin RGB-, LAB- tai CMYK-värimallin
mukaisesti.

1. Avaa Värinvalitsin kaksoisnapsauttamalla joko Täyttö- tai Viiva-ruutua työkalupaneelissa tai Väri-paneelissa.

2. Vaihda Värinvalitsimessa näkyvä värispektri napsauttamalla kirjainta R (punainen), G (vihreä), B (sininen), L (kirkkaus), a (vihreä–punainen-
akseli) tai b (sininen–keltainen-akseli).

Värimuokkain

A. Alkuperäinen väri B. Uusi väri C. Värikenttä D. Väriliukusäätimen kolmiot E. Värispektri 

3. Määritä väri jollakin seuraavista tavoista:

Napsauta tai vedä osoitinta värikentässä. Tähtäin osoittaa värin sijainnin värikentässä.

Vedä väriliukusäätimen kolmioita värispektrissä tai valitse haluamasi kohta värispektristä napsauttamalla.

Kirjoita arvot ruutuihin.

4. Tallenna väri värimallina valitsemalla Lisää CMYK-värimalli, Lisää RGB-värimalli tai Lisää Lab-värimalli. InDesign lisää värin Värimallit-
paneeliin ja nimeää sen väriarvojen mukaan.

5. Napsauta OK-painiketta.

Viimeksi käytetyn värin käyttäminen

Viimeksi käyttämäsi väri tai liukuväri näkyy työkalupaneelissa. Voit käyttää tätä väriä tai liukuväriä suoraan työkalupaneelista.

1. Valitse objekti tai teksti, jonka haluat värittää.

2. Napsauta työkalupaneelin Täyttö- tai Viiva-painiketta sen mukaan, minkä osan tekstistä tai objektista haluat värittää.

3. Valitse jokin seuraavista työkaluista:

Napsauta Väri-painiketta , kun haluat käyttää Värimallit- tai Väri-paneelista viimeksi valittua tasaista väriä.
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Napsauta Liukuväri-painiketta,  kun haluat käyttää Värimallit- tai Liukuväri-paneelista viimeksi valittua liukuväriä.

Poista objektin täyttö tai viiva napsauttamalla Ei mitään -painiketta. 

Täyttö- tai viivavärin poistaminen

1. Valitse objekti tai teksti, jonka värin haluat poistaa.

2. Napsauta työkalupaneelin Täyttö- tai Viiva-painiketta sen mukaan, minkä osan tekstistä tai objektista haluat muuttaa.

3. Poista objektin täyttö tai viiva napsauttamalla Ei mitään -painiketta. 

Värien käyttäminen vetämällä ja pudottamalla

Värejä tai liukuvärejä on helppo käyttää vetämällä ne värilähteestä objektiin tai paneeliin. Voit käyttää värejä tai liukuvärejä objekteissa vetämällä ja
pudottamalla, jolloin niitä ei tarvitse valita ensin. Voit vetää

työkalupaneelin tai paneelin Täyttö- tai Viiva-ruutuja

Liukuväri-paneelin Liukuväri-ruutua

värimalleja Värimallit-paneelista

viimeksi käytettyä toistoalalla olevaa värimallia, joka sijaitsee paneelin toistoalavaroituksen kuvakkeen  vieressä.

Voit pudottaa värejä tai liukuvärejä seuraaviin objekteihin ja paneeleihin:

Reitin täyttöön tai viivaan. Kun pudotat värin täyttöön tai viivaan, sijoita vetokuvakkeen keskipiste tarkasti reitin täytön tai viivan päälle ja
vapauta hiiren painike.

Värimallit-paneeli.

 

Jos vedät vähintään yhtä Värimallit-paneelin värimallia tai toistoalavaroituksen kuvakkeen vieressä olevaa värimallia, voit pudottaa ne myös
toiseen InDesign-julkaisuikkunaan. Tällöin InDesign lisää värimallit kyseisen julkaisun Värimallit-paneeliin.

Väri- tai liukuvärimallin käyttäminen

1. Valitse tekstin tai objektin kehys valintatyökalulla  tai valitse tekstialue tekstityökalulla .

2. Jos Värimallit-paneeli ei ole näkyvissä, valitse Ikkuna > Väri > Värimallit.

3. Valitse Värimallit-paneelista Täyttö- tai Viiva-ruutu.

4. Tee jokin seuraavista:

Käytä väriä valitussa tekstissä valitsemalla Teksti .

Käytä väriä valitussa objekti- tai tekstisäilössä (kuten kehyksessä tai taulukossa) valitsemalla Objekti .

5. Napsauta väri- tai liukuvärimallia. Valittua väriä tai liukuväriä käytetään valitussa tekstissä tai objektissa, ja se näkyy Väri-paneelissa sekä
työkalupaneelin Täyttö- tai Viiva-ruuduissa.

Täytön ja viivan oletusvärit asetetaan muiden InDesign-oletusten tavoin. Varmista valitsemalla Muokkaa > Poista kaikkien valinta, että objekteja
ei ole valittu. Valitse sitten väri.

Värin käyttäminen Väri-paneelia käyttämällä
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Vaikka Värimallit-paneelin käyttöä suositellaan värejä käytettäessä, voit sekoittaa värejä myös Väri-paneelissa. Voit lisätä käytössä olevan Väri-
paneelin värin Värimallit-paneeliin aina, kun haluat. Väri-paneeli on hyödyllisin nimettömien värien sekoittamisessa.

Jos valitset nimettyä värimallia käyttävän objektin, värin muokkaaminen Väri-paneelissa muuttaa vain kyseisen objektin väriä. Jos
haluat muokata kyseistä väriä koko julkaisussa, kaksoisnapsauta sen värimallia Värimallit-paneelissa.

Täyttö- ja viivavärin muokkaaminen

1. Valitse objekti tai teksti, jota haluat muokata.

2. Jos Väri-paneeli ei ole näkyvissä, valitse Ikkuna > Väri.

3. Valitse Väri-paneelista Täyttö- tai Viiva-ruutu.

Väri-paneeli

A. Täyttö-ruutu B. Viiva-ruutu C. Muotoilu vaikuttaa säilöön D. Muotoilu vaikuttaa tekstiin 

4. Jos valitsit tekstikehyksen, muuta joko kehyksen täytön tai tekstin väri valitsemalla Säilö tai Teksti.

5. Tee jokin seuraavista:

Säädä Sävy-liukusäädintä, joka näkyy automaattisesti, jos objekti käyttää Värimallit-paneelin värimallia.

Valitse Lab-, CMYK- tai RGB-värimalli Väri-paneelivalikosta ja muuta väriarvoja liukusäätimillä. Voit myös kirjoittaa väriliukusäädinten
vieressä oleviin tekstiruutuihin numeron.

Aseta osoitin väripalkin päälle ja napsauta.

Kaksoisnapsauta Täyttö- tai Viiva-ruutua ja valitse väri Värinvalitsimessa. Valitse lopuksi OK.

6. Jos toistoalavaroituksen kuvake tulee näkyviin ja haluat käyttää alkuperäistä lähinnä vastaavaa CMYK-väriarvoa, napsauta pientä väriruutua
varoituskuvakkeen  vieressä.

Värimallin luominen Väri-paneelin väristä

1. Varmista, että Väri-paneelin aktiivisessa Täyttö- tai Viiva-ruudussa on väri, jonka haluat lisätä.

2. Valitse paneelivalikosta Lisää värimalleihin.

Väritilojen selaaminen

Tee jokin seuraavista:

Napsauta Väri-paneelin alaosassa näkyvää väripalkkia vaihtonäppäin alhaalla.

Napsauta Uusi värimalli- tai Värimalliasetukset-valintaikkunan väriruutua vaihtonäppäin alhaalla.

Valitse Uusi liukuväri- tai Liukuväriasetukset-valintaikkunasta liukuvärin lopetusmerkki. Varmista, että Lopetusväri-valikosta on valittu
RGB, LAB tai CMYK, ja napsauta väriruutua vaihtonäppäin alhaalla.

Väriteemojen luominen Color-teematyökalulla

Voit poimia väriteemoja InDesign-dokumentin valituilta alueilta, kuvista tai objekteista. Voit myös valita värin kuvasta, koko kuvasta tai koko
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sivuasettelusta. Periaatteessa voit luoda väriteemoja kuvasi kaikista väreistä. Color-teematyökalulla voit valita yksittäisen värin tai teeman ja lisätä
väriteeman värimallipaneeliin. 

Lisää nämä värit sivuasetteluun, lisää ne Värimallit-paneeliin. Voit tallentaa ne Adobe Color -sovellukseen ja käyttää niitä Adoben muissa työpöytä-
ja mobiilisovelluksissa.

1. Napsauta työkalupaneelin Color-teematyökalua. Voit vaihtaa Color-teematyökalun ja pipettityökalun välillä pikakuvakkeella I.

Väriteematyökalu

2. Valitse väri napsauttamalla mitä tahansa sivuasettelun osaa. Voit myös hyödyntää Adobe Photoshopiin, Illustratoriin tai mihin tahansa
muuhun tiedostoon lisätyn kuvan värejä.

Teematyökalulla valittu väri säilytetään. Jos vaihdat työkalua värien valitsemisen jälkeen jonkin toisen tehtävän suorittamista varten,
esimerkiksi piirtääksesi objektin, ja sitten valitset Color-teematyökalun uudelleen, aikaisemmin valittu teema säilytetään. Valittu teema on
käytettävissä, kunnes suljet paneelin painamalla ESC-näppäintä. ESC-näppäintä painettaessa kaikki tiedot poistetaan.

3. Vierittämällä hiirtä voit tarkistaa InDesignin automaattisesti merkitsemät alueet, joilta voit luoda väriteeman. Napsauta haluamaasi osaa, niin
InDesign luo väriteeman.

4. Väriteema muodostuu viidestä eri väristä. Voit tarkastella muita luotuja värejä napsauttamalla pikavalikkoa.

5. 
Color-teematyökalu – asetukset

A. Näytä kaikki teemat napsauttamalla tätä B. Lisää nykyinen väriteema värimalleihin C. Lähetä Adobe Coloriin 

Väriteema muodostuu viidestä eri väristä. Napsauta pikavalikkoa (kuvassa A), jos haluat tarkastella samasta väriteemasta luotuja muita
teemavaihtoehtoja, kuten Värikäs, Kirkas, Syvä ja Hillitty.

Jos et halua luoda väriteemaa, paina Esc-näppäintä ja yritä uudelleen tai paina Alt-näppäintä, niin voit tilapäisesti siirtyä valintatilaan uuden
teeman keräämistä varten.

Paina Vaihto-näppäintä ja napsauta hiirtä, jos haluat valita yhden (tarkan) värin teeman perusväriksi. Color-teemat luodaan Adobe Color -
sääntöjen perusteella, jotka ovat Analoginen, Monokromaattinen, Kolmikko, Vastaväri, Yhdistelmä ja Varjot.

6. Voit ottaa värit käyttöön napsauttamalla yhtä väriä Color-teematyökalussa. Siirry hiirellä sivukohteeseen. Pipetti ilmestyy näyttöön puoliksi
täynnä, voit muuttaa täyttöä tai viivaa napsauttamalla.

Kun siirrät hiiren tekstin päälle, pipetti muuttuu tekstiksi. Voit ottaa Color-teematyökalulla luodun värin tekstissä käyttöön.

7. Kaksoisnapsauta Color-teematyökalua. Valitut ja värimalleihin lisätyt värit ottavat julkaisun käyttötarkoituksen huomioon, ja ne muunnetaan
automaattisesti oikeaan väriavaruuteen, ennen kuin ne lisätään värimalleihin tai pudotetaan toisten objektien päälle. Voit valita kolmesta
vaihtoehdosta:

a. Muunna julkaisun käyttötarkoituksen mukaan
b. Muunna CMYK-kuvaksi
c. Muunna RGB-kuvaksi.

Colorin teema-asetukset
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8. 
Color-teematyökalu – asetukset

A. Näytä kaikki teemat napsauttamalla tätä B. Lisää nykyinen väriteema värimalleihin C. Lähetä Adobe Coloriin 

Valitsemalla B voit lisätä nämä värit Värimallit-paneeliin. Väriteema lisätään Värimallit-paneeliin kansiona.

Jos haluat lisätä tietyn värin Värimallit-paneeliin, paina Alt-näppäintä ja napsauta Lisää nykyinen väriteema värimalleihin -painiketta.

9. 
Väriteema

Tätä painiketta napsautettaessa paneelista valittu teema ladataan kohteeseen Cloud > Adobe Color(xKuler) > Omat teemat. Voit tämän
jälkeen kirjautua Adobe Coloriin ja muokata teemaa, julkaista sen verkossa tai ladata sen myöhemmin mihin tahansa julkaisuun.

10. Voit käyttää heksadesimaalimuotoiseen RGB-koodiin perustuvia väriarvoja Värimuokkain-, Uusi värimalli- ja Muokkaa värimallia -
työnkuluissa. Voit käyttää myös heksadesimaalimuotoiseen RGB-koodiin perustuvia väriarvoja. Voit käyttää heksadesimaalimuotoista
väriarvoa kolmella tavalla:

Värimuokkaimella uudesta värimallista: Avaa pikavalikko napsauttamalla Värimallit-paneelista ja valitse Uusi värimalli. Valitse Uusi
värimalli -valintaikkunasta Väritila-asetukseksi RGB.
Napsauttamalla näyttökuvan ottotoimintoa, pitämällä hiiren painiketta painettuna ja napsauttamalla mitä tahansa näytön kohtaa voit
näyttää minkä tahansa lähteen heksadesimaalimuotoisen väriarvon. Lisää värimalli valitsemalla Lisää.

Uusi värimalli – heksadesimaaliarvo

Muokkaa värimallia: Voit myös muokata värimallia ja muuttaa sen heksadesimaaliarvon. Kaksoisnapsauta värimallia avattavassa Väritila-
valikossa ja valitse RGB.
Sijaisväri: Kaksoisnapsauta sijaisväriä työkalupaneelissa. Voit valita heksadesimaaliarvon täältä.

Värien lisääminen pipettityökalulla

Pipettityökalulla  voit kopioida täyttö- ja viivamääritteitä, kuten värejä, InDesign-tiedoston mistä tahansa objektista, mukaan lukien tuotu
grafiikka. Pipettityökalu lukee objektista normaalisti kaikki käytettävissä olevat täyttö- ja viivamääritteet ja käyttää niitä piirrettyjen uusien objektien
oletusmääritteinä. Pipettityökalulla kopioitavia määritteitä voit muuttaa Pipetin asetukset -valintaikkunassa. Pipettityökalulla voi kopioida myös
kirjasin- ja läpinäkyvyysmääritteitä.

Jos määritettä ei ole mainittu Pipetin asetukset -valintaikkunassa, sitä ei voi kopioida pipettityökalulla.

Värien lisääminen pipettityökalulla

1. Valitse vähintään yksi objekti, jonka täyttö- ja viivamääritteitä aiot muuttaa.
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2. Valitse pipettityökalu .

3. Napsauta objektia, josta haluat kopioida täyttö- ja viivamääritteet. Pipetti muuttuu täytetyn näköiseksi , ja valitsemasi objektit muuttuvat
automaattisesti äsken napsauttamasi objektin täyttö- ja viivamääritteiden mukaisiksi.

4. Jos haluat muuttaa muita objekteja samanlaisiksi, napsauta niitä täytetyllä pipettityökalulla. Jos objektissa on viiva mutta ei täyttöä, muista
napsauttaa sen ääriviivaa.

Uusien määritteiden valitseminen, kun pipettityökalu on täynnä

1. Paina Alt- (Windows) tai optionäppäintä (Mac OS), kun määritteet on tallennettu pipettityökaluun . Pipettityökalu vaihtaa suuntaa ja
näyttää tyhjältä . Tämä osoittaa, että voit valita uudet määritteet.

2. Napsauta kopioitavat määritteet sisältävää objektia, mutta älä vapauta Alt- tai optionäppäintä. Vapauta tämän jälkeen Alt- tai optionäppäin ja
pudota uudet määritteet toiseen objektiin.

Pipettityökalun asetusten muuttaminen

1. Kaksoisnapsauta työkalupaneelin pipettityökalua .

2. Valitse pipettityökalulla kopioitavat määreet täyttö-asetuksista ja viiva-asetuksista ja napsauta OK.

Jos haluat valita vain objektin täyttö- tai viivamääritteet, mutta et muita määritteitä, paina vaihtonäppäintä napsauttaessasi objektia
pipettityökalulla. Kun lisäät värin toiseen objektiin, vain täyttö- tai viivaväri lisätään sen mukaan, kumpi on ylimmäisenä työkalurivillä.

Värien käyttö harmaasävykuvissa

InDesignissa voit lisätä väriä sijoitettuun harmaasävykuvaan.

PSD-muodossa olevassa kuvassa voi olla useita tasoja, mutta alatason on oltava läpinäkymätön. InDesignissa et voi käyttää väriä PSD-kuvassa,
jolla on on läpinäkyvä tausta. Lisäksi harmaasävykuva ei saa sisältää alfa- eikä spottikanavia.

1. Varmista, että kuva on tallennettu harmaasävy- tai bittikarttakuvana ja että se on tallennettu PSD-, TIFF-, BMP- tai JPG-muodossa.

Photoshopissa voit valita Kuva > Tila > Bittikartta tai Kuva > Tila > Harmaasävy.

2. Valitse kuva napsauttamalla kuvan sisällön tartuntatyökalua tai käyttämällä suoravalintatyökalua .

3. Valitse väri Värimallit-paneelista tai Väripaneelista.

Väriryhmien lisääminen ja hallinta

Väriryhmien avulla voit järjestellä värimallit entistä paremmin ja vaihtaa usein käytettyjä värimalleja sovellusten kesken. Väriryhmien avulla voit

järjestellä värimalleja
ladata värimalleja Illustrator-projektista.

Väriryhmien lisääminen

1. Jos haluat luoda väriryhmän, napsauta Värimallit-paneelissa olevaa Väriryhmä-kuvaketta. Voit luoda väriryhmän myös avattavasta valikosta
ja pikavalikosta.
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Uusi väriryhmä

2. Anna väriryhmän nimi.
Valitse väriryhmämallin luontiasetus:

Valitut värimallit:  Valitse tämä asetus, jos haluat siirtää värimallit luontihetkellä väriryhmään. Voit valita useita värimalleja ennen
Uusi väriryhmä -asetuksen valitsemista pitämällä Ctrl-näppäintä (Windows) tai optionäppäintä (Mac) painettuna. Jos värimalleja ei
valita, luodaan tyhjä väriryhmä.
Valitut sivukohteet:  Valittujen sivukohteiden tai kuvien värimallit lisätään luotuun väriryhmään. Tämä on oletusasetus, jos valittuna
on kuva.

Jos haluat antaa väriryhmälle nimen sitä luotaessa, voit tehdä sen pitämällä Alt-näppäintä (Windows) tai optionäppäintä (Mac)
painettuna, kun napsautat uuden väriryhmän painiketta.

3. Voit vetää ja pudottaa juuri luotuun väriryhmään useita pääkansiossa tai muissa väriryhmissä olevia värimalleja.

4. Napsauttamalla värimallia hiiren kakkospainikkeella voi kokeilla muita toimintoja. Voit siirtyä väriryhmänäkymään ja käsitellä väriryhmiä
monipuolisesti. Napsauta paneelin alaosassa olevaa suodinkuvaketta ja valitse Näytä väriryhmät. Näin voit käsitellä väriryhmiä
monipuolisesti. Pääkansiossa olevat värimallit ja liukuvärit eivät näy tässä näkymässä.

Näytä väriryhmät

Väriryhmien hallintaan liittyvät toiminnot

Voit hallita väriryhmiä seuraavilla toiminnoilla.

Lisää värimalli väriryhmään: Valitse väriryhmä. Valitse värimalli ja siirrä se vetämällä ja pudottamalla väriryhmään.
Monista väriryhmä: Voit monistaa sekä pikavalikosta että avattavasta valikosta. Napsauta väriryhmää hiiren kakkospainikkeella ja valitse
Monista väriryhmä. Kaikki väriryhmässä olevat värimallit monistetaan yhdessä väriryhmän kanssa. Eri väriryhmissä oleville värimalleille ei
ristiriitojen välttämiseksi anneta samaa nimeä.
Pura väriryhmän ryhmittely: Ryhmän ryhmittelyn voi purkaa sekä pikavalikosta että avattavasta valikosta. Napsauta väriryhmää hiiren
kakkospainikkeella ja valitse Pura väriryhmän ryhmittely. Ryhmän ryhmittelyä purettaessa kaikki ryhmässä olevat värimallit siirretään
väriryhmän ulkopuolella olevaan pääkansioon.
Nimeä väriryhmä uudelleen: Väriryhmät voidaan nimetä uudelleen pikavalikon tai avattavan valikon Väriryhmän asetukset -toiminnolla. Voit
muokata väriryhmän nimeä kaksoisnapsauttamalla ryhmää. Voit muokata väriryhmää myös tekstiin sidottuna.
Poista väriryhmä: Valitse väriryhmä, napsauta hiiren kakkospainiketta ja valitse Poista väriryhmä. Voit myös valita väriryhmän ja valita
avattavasta valikosta Poista väriryhmä -asetuksen.

Kun poistat väriryhmän, kaikki väriryhmässä olevat värimallit poistetaan.
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Väriryhmän luominen valituilla sivukohteilla 

Voit valita julkaisussa olevan sivukohteen kuvan ja luoda väriryhmän sivukohteessa olevista värimalleista. Voit lisätä sivukohteesta värimalleja
väriryhmään.

1. Valitse julkaisusta sivukohteet.

2. Valitse avattavasta valikosta tai pikavalikosta Uusi väriryhmä.

3. Valitse Uusi väriryhmä -valintaikkunasta Valitut sivukohteet. Jos värimallipaneelista valitaan useita värimalleja, oletusvalintana on Valitut värimallit.

4. Väriryhmät toimivat kaikissa luettelonäkymissä (nimi, pieni nimi), kuten myös ruudukkonäkymissä (pieni värimalli, suuri värimalli). Kaikki
toiminnot, kuten värimallien ja väriryhmien luominen ja vetäminen, voidaan suorittaa Värimallit-paneelin kaikissa eri näkymissä.

Värimallien lataaminen ja tallentaminen .ASE-tiedostosta

ASE-tiedostot helpottavat värimallien tuontia ja vientiä eri sovelluksissa, kuten Adobe Illustratorissa. Voit tuoda .ase-tiedostoja väriryhmien
lataamiseksi Värimallit-paneeliin. Väriryhmät voidaan myös tallentaa .ase-tiedostoina avattavasta Värimallit-valikosta. Jos väriryhmät on tallennettu
Illustratorista, voit ladata ne InDesigniin.

Värimallien lataaminen

1. Valitse Värimallit-paneelivalikosta Lataa värimallit.

2. Valitse tallennettu .ase-tiedosto. Valitse Avaa.

Värimallien tallentaminen

Voit tallentaa värimallin tai väriryhmän .ase-tiedostona.

1. Valitse väriryhmä tai värimalli.

2. Valitse avattavasta valikosta Tallenna värimallit.

3. Anna .ase-tiedoston nimi. Valitse Tallenna.

Teemojen tuominen Color-sovelluksesta

Voit lisätä Color-paneelista teemoja InDesignin väriryhminä Värimallit-paneeliin. Nämä teemat luodaan väriryhmänä teeman nimellä.

1. Valitse Ikkuna > Väri.

2. Valitse Selaa-ikkunasta teema.

Voit viedä teeman InDesigniin toimimalla seuraavien ohjeiden mukaan:

Napsauta teeman vieressä olevaa nuolta ja valitse Lisää värimallipaneeliin.                       

Tuo teema Värimallit-paneeliin napsauttamalla Lisää valittu teema -kuvaketta.

 

Värimallien lisäyskuvake/-toiminto

672



  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

3. Voit myös siirtyä Colorin Luo-välilehteen, valita säännön Valitse sääntö -kohdasta ja napsauttaa Lisää tämä teema värimalleihin -kuvaketta.

Teeman lisääminen Värimallit-valikkoon

Vanhan toiminnan tuki

Jos avaat väriryhmätietoja sisältävän .idml-tiedoston sovelluksen aikaisemmissa versioissa, Väriryhmät-paneelissa olevassa värimallien luettelossa
ei ole väriryhmiä, sillä väriryhmät eivät ole käytettävissä aikaisemmissa versioissa.
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Värimallien käyttäminen

Alkuun

Yleistä Värimallit-paneelista
Värimallien luominen
Värimallien hallinta
Värimallien tuonti

Yleistä Värimallit-paneelista
Värimallit-paneelissa (Ikkuna > Väri > Värimallit) voit luoda ja nimetä värejä, liukuvärejä ja sävyjä ja lisätä niitä nopeasti julkaisuun. Värimallit
muistuttavat kappale- ja merkkityylejä. Värimalliin tehdyt muutokset vaikuttavat kaikkiin objekteihin, joissa värimallia on käytetty. Värimalleilla
väriyhdistelmiä on helpompi muokata, sillä objekteja ei tarvitse etsiä ja muuttaa erikseen.

Kun valitun tekstin tai objektin täyttö tai viiva sisältää Värimallit-paneelin värin tai liukuvärin, käytetty värimalli on korostettu paneelissa. Luotuja
värimalleja käytetään vain nykyisessä julkaisussa. Jokaiseen julkaisuun voi luoda erilaisia värimalleja, jotka tallentuvat Värimallit-paneeliin.

Tulostuspalvelua käytettäessä spottivärit voidaan määrittää tarkasti värimallien avulla. Voit myös määrittää väriasetukset esitarkastusprofiiliin,
jos haluat määrittää, mitkä väriasetukset toimivat tulostimesi kanssa.

Oletuksen mukaisessa Värimallit-paneelissa on kuusi CMYK-värimallin väriä (syaani, magenta, keltainen, punainen, vihreä ja sininen).

Huomautus: Jos kirjan lukujen värimallit ovat ristiriidassa keskenään, voit opastaa InDesignia synkronoimaan asetukset sivupohjan mukaisiksi.
(Lisätietoja: Kirjan julkaisujen synkronoiminen.)

Värimallityypit
Värimallit-paneeliin voi tallentaa seuraavia värimallityyppejä:

Värit Värimallit-paneelin kuvakkeet näyttävät spottivärityypin  ja prosessivärityypin  sekä väritilat LAB , RGB , CMYK  ja sekoiteväri .
Sävyt Prosenttiarvo värimallin vieressä Värimallit-paneelissa näyttää spotti- tai prosessivärin sävyn.

Liukuvärit Värimallit-paneelin kuvake näyttää, onko liukuväri säteittäinen  vai lineaarinen .
Ei mikään Ei mitään -värimalli poistaa objektin viivan tai täytön. Tätä värimallia ei voi muokata tai poistaa.
Paperi Paperi on väri, joka simuloi tulostuspaperin väriä. Paperin värisen objektin takana sijaitsevat objektit eivät tulostu, jos ne limittyvät paperin
värisen kohteen kanssa. Sen sijaan tulostuspaperin väri näkyy objektin läpi. Voit muuttaa Paperi-asetuksen värin vastaamaan käyttämääsi paperia
kaksoisnapsauttamalla sitä Värimallit-paneelissa. Käytä Paperi-asetuksen väriä vain esikatseluun – väri ei tulostu tietokoneen tulostimelta tai
värierottelussa. Tätä väriä ei voi poistaa. Älä käytä Paperi-väriä värin poistamiseen objektista. Käytä sen sijaan Ei mitään -väriä.
Huomautus: jos Paperi-asetuksen väri ei toimi kuvatulla tavalla muuta kuin PostScript-tulostinta käytettäessä, vaihda tulostinohjaimen tilaksi
rasterigrafiikka.
Musta Musta on valmis 100 %:n prosessivärimusta, joka on määritetty CMYK-värimallilla. Tätä väriä ei voi muokata tai poistaa. Musta painetaan
automaattisesti alla olevien painovärien sekä kaikenkokoisten tekstimerkkien päälle. Toiminnon voi poistaa käytöstä.
Rekisteröinti Rekisteröinti  on valmis väri, jonka avulla objektien värierottelu tulostuu PostScript-tulostimella. Kohdistusmerkit käyttävät
kohdistusväriä, joten esimerkiksi painolevyt voidaan kohdistaa tarkasti. Tätä väriä ei voi muokata tai poistaa.
Värejä voidaan lisätä kaikista värikirjastoista Värimallit-paneeliin niin, että ne tallentuvat julkaisun mukana.

Värimallinäytön mukauttaminen
Voit muokata värimallien kokoa ja määrittää, näkyvätkö niiden nimet.

1. Valitse Värimallit-paneelivalikosta jokin seuraavista:

Nimi tarkoittaa, että värimallin nimen vieressä näkyy pieni värimalli. Nimen oikealla puolella oleva kuvake ilmaisee värimallin (CMYK,
RGB jne.) ja sen, onko kyseessä spottiväri, prosessiväri, rekisteröintiväri vai ei mikään näistä.

Pieni nimi näyttää tiivistetyt värimallipaneelirivit.

Pieni värimalli tai Suuri värimalli näyttää pelkän värimallin. Värimallin kulmassa oleva pisteellinen kolmio ilmaisee, että kyseessä on
spottiväri. Pisteetön kolmio tarkoittaa prosessiväriä.

2. Määritä näytettävien värimallien tyyppi napsauttamalla yhtä seuraavista painikkeista Värimallit-paneelin alareunassa:

Näytä kaikentyyppiset värimallit  näyttää kaikki väri-, sävy- ja liukuvärimallit.

Näytä kaikki värimallit  näyttää vain prosessi-, spotti-, sekoiteväri- ja sävymallit.

Näytä liukuvärimallit  näyttää vain liukuvärimallit.

Huomautus: Ei mitään -värimalli näkyy aina riippumatta siitä, mitä painiketta painat.
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Värimallien luominen
Värimallissa voi olla spotti- ja prosessivärejä, sekoitevärejä (prosessivärejä, joihin on sekoitettu spottivärejä), RGB- ja Lab-värejä, liukuvärejä tai
sävyjä.

Kun sijoitat spottivärejä sisältävän kuvan, värit lisätään automaattisesti värimalleina Värimallit-paneeliin. Voit käyttää näitä värimalleja julkaisun
objekteissa. Et voi kuitenkaan poistaa niitä tai määrittää niitä uudelleen.

Selvitä ennen värimallien luomista, mitkä asetukset tulostinpalveluntoimittajasi hyväksyy. Voit määrittää väriasetukset esitarkastusprofiiliin, jos
haluat ilmaista, mitkä väriasetukset eivät toimi tulostimesi kanssa.

Uuden värin luominen
1. Valitse Värimallit-paneelivalikosta Uusi värimalli.
2. Valitse julkaisun värien painotapa Värityyppi-kohdassa.
3. Valitse värimallin nimi jollakin seuraavista tavoista:

Jos värityyppivalintasi on Prosessi ja haluat nimen kuvaavan aina väriarvoja, varmista, että Nimeä väriarvojen mukaan on valittu.

Jos värityyppivalintasi on Prosessi ja haluat valita nimen itse, varmista, että Nimeä väriarvojen mukaan ei ole valittu, ja kirjoita värimallin
nimi.

Jos valintasi on Spottiväri, kirjoita värimallin nimi.

4. Valitse Väritila-kohdassa tila, jota haluat käyttää värin määrityksessä. Vältä tilan muuttamista värin määrittämisen jälkeen.
5. Tee jokin seuraavista:

Muuta väriarvoja vetämällä liukusäädintä. Voit myös kirjoittaa väriliukusäädinten vieressä oleviin tekstiruutuihin numeron.

Valitse spottiväreille sopivat arvot Väritila-valikon värikirjastoista.

6. Jos toistoalavaroituksen kuvake  tulee näkyviin ja haluat käyttää alkuperäistä lähinnä vastaavaa toistoalalla olevaa väriä, napsauta
varoituskuvakkeen vieressä olevaa pientä väriruutua.

7. Tee jokin seuraavista:

Lisää värimalli valitsemalla Lisää ja määritä seuraava väri. Valitse Valmis.

Lisää värimalli ja sulje valintaikkuna valitsemalla OK.

Voit määrittää spottivärin suoraan napsauttamalla Värimallit-paneelin Uusi värimalli -painiketta. Varmista, että mitään värimallia ei ole valittu, ja
pidä Alt- ja Ctrl-näppäintä (Windows) tai optio- ja komentonäppäintä (Mac OS) alhaalla ja napsauta Uusi värimalli -painiketta .

Värimallin luominen objektin värin perusteella
1. Valitse objekti.
2. Valitse työkalupaneelista tai Värimallit-paneelista Täyttö- tai Viiva-ruutu.
3. Tee Värimallit-paneelissa jokin seuraavista:

Napsauta Uusi värimalli -painiketta . Kun uusi värimalli on luotu, kaksoisnapsauta sitä.

Valitse Värimallit-paneelivalikosta Uusi värimalli.

Valittu väri tai liukuväri näkyy Värimallit-paneelissa ja työkalupaneelin Täyttö- tai Viiva-ruudussa, ja se lisätään kaikkien valittujen objektien täyttöön
tai viivaan.

Nimettömän värin lisääminen Värimallit-paneeliin
Vaikka voit luoda värejä Väri-paneelin tai Värinvalitsimen avulla, nimettömien värien muokkaaminen ja johdonmukainen käyttö voi olla hankalaa.
Käytä Lisää nimettömiä värejä -asetusta julkaisun objektien nimettömien värien etsimiseen ja lisää värit sitten Värimallit-paneeliin. Värit nimetään
automaattisesti niiden sisältämien CMYK-, RGB- tai Lab-osien mukaan.

 Valitse Värimallit-paneelista Lisää nimettömiä värejä.

Värimallien hallinta
Värimallit-paneelissa voit muokata, kopioida ja poistaa värimalleja.

Oletusvärien muokkaaminen Värimallit-paneelissa
Voit muuttaa uusien julkaisujen oletusvärimalleja

1. Sulje kaikki avatut julkaisut.
2. Muokkaa haluamiasi värimalleja Värimallit-paneelissa.
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Värimallin monistaminen
Värimallien monistamisesta voi olla hyötyä, kun haluat luoda lämpimämmän tai viileämmän muunnelman nykyisestä väristä. Huomaa, että
spottivärin monistaminen tarkoittaa uuden spottivärin painolevyn lisäämistä.

 Tee jokin seuraavista:

Valitse värimalli ja valitse sitten Värimallit-paneelivalikosta Monista värimalli.

Valitse värimalli ja napsauta Uusi värimalli -painiketta  paneelin alareunassa.

Vedä värimalli Uusi värimalli -painikkeeseen paneelin alareunaan.

Värimallin muokkaaminen
Voit muuttaa värimallin määritteitä Värimalliasetukset-valintaikkunassa. Myös muita asetuksia on käytettävissä, kun muokkaat sekoitevärimalleja ja
-ryhmiä.

1. Valitse värimalli Värimallit-paneelista ja tee jokin seuraavista:

Kaksoisnapsauta värimallia.

Valitse Värimallit-paneelivalikosta Värimalliasetukset.

2. Muokkaa haluamiasi asetuksia ja valitse OK.

Värimallien nimien hallinta
Prosessivärimallin nimi johdetaan värin osien arvoista automaattisesti. Jos esimerkiksi määrität punaisen värin, jossa on 10 % syaania, 75 %
magentaa, 100 % keltaista ja 0 % mustaa, värimallin nimeksi tulee automaattisesti C=10 M=75 Y=100 K=0. Nimi helpottaa prosessivärien
koostumuksen tunnistamista.

Oletusarvoisesti prosessivärin nimi päivittyy automaattisesti, kun sen CMYK-arvoja muutetaan. Voit poistaa tämän asetuksen käytöstä tai ottaa sen
käyttöön eri värimallissa tarpeen mukaan. Voit vaihtaa prosessivärimallien ja muidenkin määrittämiesi värien nimiä milloin tahansa.

1. Kaksoisnapsauta Värimallit-paneelissa näkyvää prosessiväriä.
2. Tee jokin seuraavista ja valitse OK:

Jos haluat InDesignin vaihtavan värimallin nimen muuttaessasi CMYK-arvoja, varmista, että Nimeä väriarvojen mukaan on valittu.

Jos vaihdat värimallin nimen muuttaessasi CMYK-arvoja, varmista, että Nimeä väriarvojen mukaan ei ole valittu.

Huomautus: Uudelle värimallille annetaan automaattisesti nimi Uusi värimalli (sekä numero, jos uusia värimalleja on monta), jos tätä asetusta ei
ole valittu. Voit muuttaa nimen manuaalisesti.

Yksittäisten värimallien poistaminen
Kun poistat julkaisun objektissa käytetyn värimallin, InDesign kehottaa korvaamaan värimallin. Voit määrittää olemassa olevan tai nimettömän
värimallin. Jos poistat värimallin, jota on käytetty sävyn tai sekoitevärin pohjana, sinua pyydetään valitsemaan korvaava värimalli.

1. Valitse vähintään yksi väri.
2. Tee jokin seuraavista:

Valitse Värimallit-paneelivalikosta Poista värimalli.

Napsauta Värimallit-paneelin alaosassa Poista-kuvaketta.

Huomautus: Spottivärejä, joita on käytetty julkaisun sijoitetussa grafiikassa, ei voi poistaa. Jos haluat poistaa tällaisen värin, sinun on
ensin poistettava grafiikka. Joskus harvoin spottiväriä ei kuitenkaan voi poistaa, vaikka grafiikka olisi poistettu. Luo tällöin InDesign
Markup (IDML) -tiedosto valitsemalla Tiedosto > Vie. Avaa sitten luomasi tiedosto InDesignissa.

3. InDesign kysyy, miten poistettava värimalli korvataan. Tee jokin seuraavista ja valitse OK:

Korvaa värimalli koko julkaisussa toisella valitsemalla Määritetty värimalli ja valitsemalla värimalli valikosta.

Korvaa värimalli koko julkaisussa vastaavalla nimettömällä värillä valitsemalla Nimetön värimalli.

Kaikkien käyttämättömien värimallien poistaminen
1. Valitse Värimallit-paneelivalikosta Valitse kaikki käyttämättömät. Asetuksella valitaan värimallit, joita ei käytetä parhaillaan muokattavassa

julkaisussa.
2. Napsauta Poista-kuvaketta.

Värimallien yhdistäminen
Kun tuot värimalleja tai kopioit kohteita muista julkaisuista, sinulle saattaa tulla käyttöön moneen kertaan esiintyviä samoja värimalleja, joita
käytetään eri objekteissa. Voit yhdistää tällaiset värimallit käyttämällä Yhdistä värimallit -komentoa.

1. Valitse Värimallit-paneelista ainakin kaksi samaa värimallia.
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Ensimmäinen valitsemasi värimalli on se, joka yhdistetään.

2. Valitse Värimallit-paneelivalikosta Yhdistä värimallit.

Värimallien tallentaminen käytettäväksi muissa julkaisuissa
Jos haluat käyttää värimalleja muissa tiedostoissa tai jakaa niitä toisille suunnittelijoille, voit tallentaa värimallit .ase (Adobe Swatch Exchange) -
tiedostoina. InDesign, Illustrator ja Adobe Photoshop voivat tuoda värimalleja Colorbook-tiedostoista.

1. Valitse Värimallit-paneelista tallennettavat värimallit.
2. Valitse Värimallit-paneelivalikosta Tallenna värimallit.
3. Määritä tiedoston nimi ja sijainti. Valitse lopuksi Tallenna.

Värimallien jakaminen sovellusten välillä
Voit jakaa Photoshopissa, Illustratorissa ja InDesignissa luomasi tasaisia värejä sisältävät värimallit tallentamalla värimallikirjaston vaihtoa varten.
Värit näkyvät täsmälleen samanlaisina kaikissa sovelluksissa, kunhan väriasetukset on synkronoitu.

1. Luo Värimallit-paneelissa prosessi- ja spottivärien luettelot yhteiskäyttöä varten ja poista sellaiset värimallit, joita ei ole tarkoitus käyttää
useissa sovelluksissa.
Huomautus: Seuraavantyyppisiä värimalleja ei voi käyttää useissa sovelluksissa: Illustratorin ja InDesignin kuviot, liukuvärit, sekoitevärit ja
sävyt sekä rekisteröinti-värimalli sekä Photoshopin värimallikirjat ja HSB-, XYZ-, kaksiväri-, peittävyys-, musteenkäyttö- ja webRGB-
värimallit. Nämä värimallit ohitetaan automaattisesti, kun värimalleja tallennetaan.

2. Valitse Värimallit-paneelivalikosta Tallenna värimallit ja tallenna värimallikirjastot paikkaan, josta ne ovat helposti haettavissa.
3. Lataa värimallikirjasto Photoshopin, Illustratorin tai InDesignin Värimallit-paneeliin.

Värimallien tuonti
Voit tuoda värejä ja liukuvärejä muista julkaisuista sekä lisätä joko kaikki värimallit tai osan niistä Värimallit-paneeliin. Voit ladata värimalleja
InDesign-tiedostoista (.indd), InDesign-malleista (.indt), Illustrator-tiedostoista (.ai tai .eps) ja Adobe Swatch Exchange -tiedostoista (.ase), jotka on
luotu InDesignissa, Illustratorissa tai Photoshopissa. Adobe Swatch Exchange -tiedostojen värimallit on tallennettu Adobe Swatch Exchange -
muodossa.

InDesignissa on myös värikirjastoja muista värijärjestelmistä, kuten PANTONE Process Color System® -järjestelmästä.

Huomautus: Värimallit-paneeliin lisätään myös spottivärit, joita on käytetty tuoduissa EPS-, PDF-, TIFF- ja Adobe Photoshop (PSD) -tiedostoissa.

Valittujen värimallien tuominen tiedostosta
1. Valitse Värimallit-paneelivalikosta Uusi värimalli.
2. Valitse ensin Väritila > Muu kirjasto ja sitten tiedosto, josta haluat tuoda värimalleja.
3. Valitse Avaa.
4. Valitse tuotavat värimallit.
5. Napsauta OK-painiketta.

Kaikkien värimallien tuominen tiedostosta
1. Valitse Värimallit-paneelivalikosta Lataa värimallit.
2. Kaksoisnapsauta InDesign-julkaisua.

Värimallien kopioiminen InDesign-julkaisusta toiseen
Voit kopioida tai vetää värimallin (tai objektin, johon värimallia on käytetty) julkaisusta toiseen. Tällöin värimalli lisätään kohdejulkaisun Värimallit-
paneeliin. Jos haluat kopioida myös värimallin sävyt ja liukuvärit, sinun on kopioitava alkuperäinen objekti, ei vain värimallia.

 Tee jokin seuraavista:

Kopioi objekti avoinna olevaan julkaisuun vetämällä ja pudottamalla tai kopioimalla ja liittämällä.

Valitse kopioitavat värimallit ja vedä ne Värimallit-paneelista toisen InDesign-julkaisun julkaisuikkunaan.

Huomautus: jos vedät värimallin, jonka nimi on täysin sama kuin olemassa olevan värimallin (myös isojen kirjainten osalta), mutta jolla on
eri väriarvot, InDesign antaa värimallille nimen[alkuperäinen värimallin nimi] 2.

Värimallien lataaminen valmiista ja mukautetuista värikirjastoista
Valittavana on useita värikirjastoja, kuten PANTONE Process Color System, Toyo™ Ink Electronic Color Finder™ 1050, Focoltone® -
värijärjestelmä, Trumatch™ -värimallijärjestelmä, DIC Process Color Note ja erityisesti Web-käyttöä varten luodut kirjastot. Ennen kuin käytät
värinsovitusjärjestelmän värimalleja, varmista tulostuspalvelusta, mitä värimalleja he tukevat.

1. Valitse Värimallit-paneelivalikosta Uusi värimalli.
2. Tee jokin seuraavista:

677



 

Valitse kirjastotiedosto Väritila-luettelosta.

Valitse Väritila-luettelosta Muu kirjasto, paikanna kirjastotiedosto ja valitse sitten Avaa.

3. Valitse kirjastosta vähintään yksi värimalli ja valitse sitten Lisää. (Jos haluat sulkea ikkunan lisäämättä värimalleja, valitse OK.)
4. Kun olet lisännyt haluamasi värimallit, valitse Valmis.

InDesigniin asennetut värikirjastot
InDesign asentaa värikirjastot seuraaviin väriensovitusjärjestelmiin. Voit asentaa uusia värikirjastoja ja ladata niistä värimalleja InDesigniin.

ANPA-väri Koostuu 300 ANPAn (American Newspaper Publishers Association) valitsemasta väristä. Tämän kirjaston värejä käytetään
ensisijaisesti spottiväreinä sanomalehdissä.
DIC Color Sisältää 1280 CMYK-spottiväriä DIC Process Color Note -järjestelmästä. Värit voidaan sovittaa DIC Color Guide -oppaan mukaisesti.
Oppaan julkaisija on Dainippon Ink & Chemicals, Inc. Lisätietoja antaa Dainippon Ink & Chemicals, Inc., Tokio, Japani.
Focoltone Järjestelmä sisältää 763 CMYK-väriä. Focoltone-värien käytöllä voidaan välttää esivalmistuslihotuksen ja kohdistuksen ongelmia.
Focoltone-kartat näyttävät päällepainatukset, jotka muodostavat värit.
Focoltonella on värimallikirja, jossa on prosessi- ja spottivärien tekniset tiedot, päällepainatuskarttoja ja kirja sivuasettelujen merkitsemiseen.
Lisätietoja antaa Focoltone International, Ltd., Stafford, United Kingdom.

HKS Käytä tätä järjestelmää, jos työ vaatii Euroopassa käytössä olevia HKS-värijärjestelmän värejä.
PANTONE® PANTONE®-spottivärit edustavat värintoisto-ominaisuuksien maailmanlaajuisia standardeja. Vuonna 2000 PANTONE MATCHING
SYSTEM® -värioppaisiin tehtiin huomattava parannus. Kun järjestelmään lisättiin 147 uutta tasaista väriä ja seitsemän uutta metalliväriä, värejä on
nyt yhteensä 1114. PANTONE-värioppaat ja -kirjat on nyt painettu päällystetylle ja päällystämättömälle paperille sekä mattapaperille. Näin
varmistetaan painojulkaisun visuaalinen tarkkuus ja parempi painatuksen hallinta.
Tasaisen PANTONE-värin voi tulostaa CMYK-värinä. Kun vertaat tasaista PANTONE-väriä sitä lähinnä olevaan prosessiväriin, käytä PANTONE
Solid to Process Guide -opasta. Kullekin värille tulostetaan CMYK-näytön sävyprosentit. Tämä opas painetaan nyt kirkkaammalle päällystetylle
paperille, ja se sisältää 147 uuden tasavärin vertailut CMYK-väreihin.

PANTONE Process Guide -oppaat on painettu päällystetylle ja päällystämättömälle paperille. Oppaassa on valittavana 3000
prosessiväriyhdistelmää. Värien valinta ja CMYK-rasteriarvot on helppo määrittää, koska värit on esitetty viuhkan muodossa kromaattisessa
järjestyksessä.

Lisätietoja antaa Pantone, Inc., Carlstadt, New Jersey, Yhdysvallat.

Järjestelmä (Windows) Sisältää 256 väriä Windowsin 8-bittisestä oletuspaneelista, joka perustuu RGB-värien yhtenäiseen näytteistykseen.
Järjestelmä (Mac OS) Sisältää 256 väriä Mac OS-järjestelmän 8-bittisestä oletuspaneelista, joka perustuu RGB-värien yhtenäiseen
näytteistykseen.
Toyo Color Finder Sisältää 1050 väriä, jotka perustuvat yleisimpiin Japanissa käytettyihin painoväreihin. Voit käyttää Toyo 94 Color Finderia tai
uudempaa Toyo Color Finderia. Käytä väriopasta, joka sisältää painettuja Toyo Ink -malleja. Opas on saatavana painotuotteiden julkaisijoilta ja
graafisen alan tarvikeliikkeistä. Lisätietoja antaa Toyo Ink Manufacturing Co., Ltd., Tokio, Japani.
Trumatch Sisältää CMYK-väriensovituksen, jossa on yli 2000 käyttökelpoista tietokoneella luotua väriä. Trumatch-värit kattavat CMYK-toistoalan
spektrin asteittain. Trumatch Color Finder näyttää jokaisesta eri värisävystä yli 40 sävyä ja varjostusta, jotka on luotu neliväriprosessissa ja jotka
voidaan luoda nelivärisinä sähköisissä kuvankäsittelylaitteissa. Mukana on myös nelivärisiä harmaita, joissa on eri sävyjä. Lisätietoja antaa
Trumatch Inc., New York, Yhdysvallat.
Web Sisältää 216 RGB-väriä Web-käyttöön. Web-selaimet käyttävät näitä värejä useimmiten 8-bittisten kuvien näyttämiseen. Kirjasto auttaa Web-
grafiikan ja kuvien luomisessa väreillä, jotka säilyvät samoina sekä Windows- että Macintosh-järjestelmissä.
Lisää ohjeaiheita
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Tuodun grafiikan värien käyttäminen

Alkuun

Alkuun

Alkuun

Alkuun

Alkuun

Tuodun grafiikan värien käyttäminen
Värinäytteiden ottaminen pipettityökalulla
Adobe Photoshop (PSD) -tiedoston spottivärikanavien käyttäminen
EPS- tai PDF-tiedostojen värien käyttäminen
Tuodun spottivärin muuttaminen prosessiväriksi

Tuodun grafiikan värien käyttäminen
InDesigniin tuodun grafiikan värejä voi kopioida ja määrittää usealla eri tavalla. Sijoitettujen PDF- tai EPS-tiedostojen spottivärit sekä Adobe
Photoshop (PSD)- ja TIFF-tiedostojen spottivärikanavat näkyvät Värimallit-paneelissa spottiväreinä. Voit lisätä näitä värejä julkaisun objekteihin tai
muuntaa niitä prosessiväreiksi. Et voi kuitenkaan määrittää väriarvoja uudelleen tai poistaa tuotuja värimalleja. Jos poistat sijoitettua grafiikkaa,
värit säilyvät, mutta ne muunnetaan alkuperäisiksi InDesign-väreiksi, joita voi muokata tai poistaa.

Värinäytteiden ottaminen pipettityökalulla

Voit siirtää värejä tuodusta grafiikasta julkaisuun tai lisätä värejä julkaisun objekteihin pipettityökalulla . Tästä on hyötyä, kun haluat muuttaa
asettelun värit kuvien värien mukaisiksi.

Jotta saisit parhaat mahdolliset värierottelut, sinun kannattaa varmistaa, että InDesignilla ottamiesi värinäytteiden nimet, tyypit (esimerkiksi spotti-
ja prosessivärit) ja mallit (esimerkiksi RGB ja CMYK) ovat yhdenmukaiset tuodun grafiikan värimääritysten kanssa. Jos et ole varma parhaista
asetuksista, kysy neuvoa tulostuspalvelusta.

Adobe Photoshop (PSD) -tiedoston spottivärikanavien käyttäminen
Kun sijoitat alkuperäisen Photoshop (PSD) -tiedoston tai TIFF-tiedoston InDesigniin, kaikki tiedoston sisältämät spottivärikanavat näkyvät
Värimallit-paneelissa spottiväreinä. Voit valita ja lisätä näitä värimalleja julkaisun muihin objekteihin. Jos haluat poistaa värimalleja, sijoitettu kuva
on poistettava ensin.

Jos tuot tiedoston, jonka spottivärikanavalla on sama nimi kuin julkaisun spottivärillä, mutta jonka väriarvot ovat erilaisia, ohjelma kysyy, haluatko
käyttää sijoitetun tiedoston vai julkaisun väriarvoja.

EPS- tai PDF-tiedostojen värien käyttäminen
Kun sijoitat julkaisuun PDF-tiedoston, EPS-grafiikkaa tai Adobe Illustrator (.AI) -tiedoston, grafiikan spottivärien nimet lisätään julkaisun Värimallit-
paneeliin. Tämä osoittaa, että painatukseen voi sisältyä lisäkustannuksia ja että voit käyttää spottivärejä julkaisussa.

Jos tuomasi kuva sisältää spottivärin, jolla on sama nimi mutta eri väriarvot kuin julkaisussasi olevalla spottivärillä, käytetään julkaisun väriarvoja.

Tuodun spottivärin muuttaminen prosessiväriksi
Kun tuot EPS-, PSD-, TIFF- tai PDF-grafiikkaa, jossa on spottiväri (tai spottivärikanava), InDesign lisää spottivärin nimen ja määrityksen Värimallit-
paneeliin. Voit muuttaa luetun spottivärimallin prosessivärimalliksi, jolloin värejä, myös tuodun grafiikan värejä, voi muuttaa joustavammin
vastaamaan tulostusvaatimuksia.

1. Kaksoisnapsauta Värimallit-paneelissa värimallia, jota haluat muokata.
2. Valitse Värimalliasetukset-valintaikkunassa värityypiksi Prosessi.

Huomautus: Tämä muutos vaikuttaa värityyppiin vain InDesign-julkaisussa. Voit muuttaa grafiikan värien värityypin pysyvästi avaamalla grafiikan
ja muokkaamalla sitä siinä ohjelmassa, jossa se luotiin.
Lisää ohjeaiheita
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Spotti- ja prosessivärit

Alkuun

Alkuun

Alkuun

Tietoja spotti- ja prosessiväreistä
Tietoja spottiväreistä
Tietoja prosessiväreistä
Spotti- ja prosessivärien käyttäminen yhdessä
Värien vertaaminen InDesignissa ja Illustratorissa

Tietoja spotti- ja prosessiväreistä

Voit valita joko spotti- tai prosessivärejä, jotka ovat painoissa käytettävät päävärityypit. Näet värityypin Värimallit-paneelin kuvakkeessa värin nimen
vieressä.

Julkaisutyyppi vaikuttaa reitteihin ja kehyksiin lisättävään väriin, sillä väritilan on oltava sopiva julkaisua varten.

Jos värityönkulussa siirretään julkaisuja laitteesta toiseen, värien ylläpitoa ja hallintaa voi helpottaa värienhallintajärjestelmällä (CMS).

Tietoja spottiväreistä

Spottiväri on erityinen valmiiksi sekoitettu väriaine, jota käytetään prosessivärien asemesta tai lisäksi ja joka edellyttää painokoneessa omaa
painolevyä. Spottivärejä käytetään, kun vain muutamia värejä on määritetty ja kun värien tarkkuus on tärkeää. Spottivärien painovärit tuottavat
tarkkoja sävyjä, jotka ovat prosessivärien toistoalan ulkopuolella. Painetun spottivärin tarkan sävyn määrää kuitenkin se, miten painovärit
sekoitetaan painossa ja millaista paperia käytetään, eikä siihen eivät vaikuta määritetyt väriarvot tai värienhallinta. Kun määrität spottiväriarvoja,
kuvailet ainoastaan värien simuloituja sävyjä näyttöä ja tulostinta varten (simuloidut sävyt riippuvat laitteiden toistoalarajoituksista).

Noudata seuraavia ohjeita, kun määrität spottiväriä:

Painojulkaisuja varten spottivärit on parasta määrittää samalla värinsovitusjärjestelmällä, jota painokin käyttää. Ohjelmassa on useita
värinsovituskirjastoja.

Minimoi käytettävien spottivärien määrä. Painossa jokaista spottiväriä varten tarvitaan erillinen painolevy, mikä kasvattaa painokustannuksia.
Jos arvelet tarvitsevasi useampaa kuin neljää väriä, harkitse prosessivärien käyttöä.

Kun spottivärejä sisältävä objekti limitetään läpinäkyviä ominaisuuksia sisältävän objektin kanssa, virheitä saattaa esiintyä, jos objekti viedään
EPS-muotoon, spottivärejä muunnetaan prosessiväreiksi Tulosta-ikkunassa tai värierottelu tehdään muussa kuin Illustrator- tai InDesign-
sovelluksessa. Saat parhaat tulokset tarkistamalla läpinäkyvyyden yhdistämisen vaikutukset Yhdistämisen esikatselun tai Erottelujen
esikatselun avulla ennen tulostamista. Voit myös muuntaa spottivärit prosessiväreiksi käyttämällä InDesignissä Painovärin hallintaa ennen
tulostusta tai vientiä.

Voit käyttää spottivärien painolevyjä lakan lisäämiseen prosessivärien päälle. Tässä tapauksessa painamiseen tarvitaan viittä painoväriä –
neljää prosessiväriä ja yhtä spottilakkaa.

Tietoja prosessiväreistä

Prosessiväri painetaan käyttämällä neljää vakioprosessipainoväriä: syaania, magentaa, keltaista ja mustaa (CMYK). Käytä prosessivärejä silloin,
kun julkaisuun tarvitaan niin paljon värejä, että yksittäisten spottipainovärien käyttäminen olisi liian kallista tai epäkäytännöllistä, esimerkiksi
värivalokuvia painettaessa.

Noudata seuraavia ohjeita, kun määrität prosessiväriä:

Laadukkaaseen painojulkaisuun saadaan parhaat värit määrittämällä prosessivärit värikartan CMYK-arvojen mukaisesti. Värikarttoja on
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saatavana esimerkiksi painotaloista.

Prosessivärin lopulliset väriarvot ovat CMYK-arvoja, joten jos prosessiväri määritetään RGB-arvoina (tai LAB-arvoina InDesignissä), ne
muuntuvat vastaaviksi CMYK-arvoiksi värierottelussa. Nämä muunnokset ovat erilaisia värinhallinta-asetusten ja dokumentin profiilin mukaan.

Määritä prosessiväri sen mukaan, miltä väri näyttää tietokoneen näytössä, vain jos olet varma siitä, että värienhallintajärjestelmä toimii oikein
ja tiedät, miten näyttö rajoittaa värien esikatselua.

Vältä prosessivärien käyttöä ainoastaan näytössä katseltavissa julkaisuissa, sillä CMYK-mallin toistoala on suppeampi kuin tavallisen näytön.

Illustratorissa ja InDesignissa prosessiväri voidaan määrittää yleiseksi tai tavalliseksi. Illustratorissa yleinen prosessiväri säilyy Väriviuhkat-
paneelin väriruutuun liitettynä, joten yleisen prosessivärin väriruudun muokkaaminen vaikuttaa kaikkiin tätä väriä käyttäviin objekteihin.
Tavalliset prosessivärit eivät päivity automaattisesti koko julkaisussa, kun väriä muokataan. Prosessivärit ovat oletusarvoisesti tavallisia.
InDesignissa objektiin liitetty värimalli säilyy automaattisesti yleisenä prosessivärinä. Ei-yleiset värimallit ovat nimettömiä värejä ja niitä voi
mukata Väri-paneelissa.

Yleiset ja tavalliset prosessivärit vaikuttavat vain siihen, miten värejä käytetään objekteissa. Ne eivät vaikuta värierottelun
tekemiseen tai värien käyttäytymiseen sovelluksesta toiseen siirryttäessä.

Spotti- ja prosessivärien käyttäminen yhdessä

Joskus on käytännöllistä sovittaa spotti- ja prosessivärejä samaan työhön. Voit esimerkiksi käyttää yhtä tarkkaa spottiväriä logon painamiseen
yrityksen toimintakertomukseen ja painaa samalla sivulla olevat valokuvat prosessiväreillä. Voit myös käyttää spottivärien painolevyjä lakan
lisäämiseen prosessivärien päälle. Kummassakin tapauksessa painamiseen tarvitaan viittä painoväriä – neljää prosessiväriä ja yhtä spottiväriä tai
lakkaa.

InDesignissa voit sekoittaa prosessi- ja spottivärejä ja luoda näin sekoitevärejä.

Värien vertaaminen InDesignissa ja Illustratorissa

Adobe InDesign ja Adobe Illustrator lisäävät nimettyjä värejä hieman eri tavalla. Illustratorissa nimetty väri voidaan määrittää yleiseksi tai
tavalliseksi, mutta InDesign käsittelee kaikkia nimettömiä värejä tavallisina prosessiväreinä.

InDesignin värimallit vastaavat yleisiä värejä. Värimalleilla väriyhdistelmiä on helpompi muokata, sillä objekteja ei tarvitse etsiä ja muuttaa erikseen.
Ominaisuus on erityisen kätevä painettaessa aikakauslehtiä tai muita vakioituja ja nopeasti tuotettavia julkaisuja. InDesignin värit on liitetty
Värimallit-paneelin värimalleihin, joten värimalliin tehty muutos vaikuttaa kaikkiin objekteihin, joissa väriä on käytetty.

InDesignin nimettömät prosessivärit vastaavat tavallisia värimalleja. Nimettömät värit eivät näy Värimallit-paneelissa eivätkä päivity automaattisesti
koko julkaisussa, kun väriä muokataan Väri-paneelissa. Voit halutessasi lisätä nimettömän värin myöhemmin Värimallit-paneeliin.

Nimetyt ja nimettömät prosessivärit vaikuttavat vain siihen, miten väriä lisätään julkaisuun. Ne eivät vaikuta värierottelun tekemiseen tai värien
käyttäytymiseen sovelluksesta toiseen siirryttäessä.

Lisää ohjeaiheita

682

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/fi_FI/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fi


Sävyt

Alkuun

Alkuun

Tietoja sävyistä
Sävyjen luominen ja muokkaaminen

Tietoja sävyistä
Sävy on värin vaaleampi versio. Sävyttäminen on edullinen keino tehdä uusia spottivärien sävyjä maksamatta spottivärien lisäpainoväreistä.
Sävyttäminen on myös nopea tapa luoda vaaleampia versiota prosessiväreistä, vaikka se ei vähennäkään prosessivärien painokuluja. Sekä
sävyttämättömät värit että sävyt kannattaa nimetä ja tallentaa Värimalli-paneeliin. Siten niiden muokkaaminen koko julkaisussa on helppoa.

Spottiväri ja sävyt

Spottivärin sävy painetaan samalle painolevylle kuin spottiväri. Prosessivärin sävy muuttaa CMYK-prosessipainoväriä sävytysprosentilla:
esimerkiksi C10 M20 Y40 K10:n 80 %:n sävystä tulee C8 M16 Y32 K8.

Värit ja sävyt päivitetään yhdessä, joten jos muokkaat värimallia, kaikki luettelon sävyä käyttävät objektit päivittyvät. Voit myös muokata nimetyn
sävyn perusvärimallia valitsemalla Värimallit-paneelivalikosta Värimalliasetukset. Tämä päivittää kaikki samaan värimalliin perustuvat sävyt.

Adobe Creative Suite 3:ssa sävyalue on 0–100 %: mitä pienempi numero, sitä vaaleampi sävy.

Sävyjen luominen ja muokkaaminen
Voit säätää yksittäisen objektin sävyä tai luoda sävyjä käyttämällä Sävy-liukusäädintä Värimallit-paneelissa tai Väri-paneelissa. Sävyalue on 0 -
100 %: mitä pienempi numero, sitä vaaleampi sävy.

Värit ja sävyt päivitetään yhdessä, joten jos muokkaat värimallia, kaikki luettelon sävyä käyttävät objektit päivittyvät. Voit myös muokata nimetyn
sävyn perusvärimallia valitsemalla Värimallit-paneelivalikosta Värimalliasetukset. Tämä päivittää kaikki samaan värimalliin perustuvat sävyt.

Sävymallin luominen Värimallit-paneelissa

1. Valitse värimalli Värimallit-paneelista.

2. Valitse Sävy-ruudun vieressä oleva nuoli.

3. Vedä Sävy-liukusäädintä ja napsauta Uusi värimalli -painiketta  tai valitse Värimallit-paneelivalikosta Uusi sävymalli.

Sävy näkyy Värimallit-paneelissa perusvärin ja sävyprosentin kanssa.

Sävymallin luominen Väri-paneelissa

1. Valitse värimalli Värimallit-paneelista.

2. Vedä Sävy-liukusäädintä Väri-paneelissa tai kirjoita sävyarvo Prosentti-ruutuun.

3. Valitse Väri-paneelivalikosta Lisää värimalleihin.
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Vedä Sävy-liukusäädintä ja valitse Lisää värimalleihin.

Nimettömän sävyn luominen

1. Valitse Värimallit-paneelista Täyttö- tai Viiva-ruutu.

2. Vedä Sävy-liukusäädintä tai kirjoita sävyarvo prosenttiruutuun.

Sävyn tai sen perusvärimallin muokkaaminen

1. Kaksoisnapsauta sävymallia Värimallit-paneelissa.

2. Tee jokin seuraavista ja valitse OK:

Muokkaa sävyä muuttamalla sävyn arvoa. Tällöin kaikki sävymallia käyttävät objektit päivittyvät.

Muokkaa sävyn perusvärimallia muuttamalla väritilaa tai väritilan arvoja. Tällöin kaikki samaan värimalliin perustuvat sävyt päivittyvät.
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Värien sekoittaminen

Alkuun

Sekoitevärimallien luominen ja muokkaaminen
Sekoiteväriryhmien hallinta

Sekoitevärimallien luominen ja muokkaaminen
Kun haluat luoda mahdollisimman monta painettua väriä mahdollisimman pienellä värimäärällä, voit luoda uusia värimalleja sekoittamalla kaksi
spottiväriä tai sekoittamalla spottivärin vähintään yhteen prosessiväriin. Sekoitevärejä käyttämällä voit lisätä käytettävien värien määrää
kasvattamatta erottelujen määrää tulostuksessa.

Voit luoda yhden sekoitevärimallin tai useita värimalleja käyttämällä sekoiteväriryhmää. Sekoiteväriryhmässä on värejä, jotka on luotu eri prosessi-
ja spottivärien kasvavista prosenttimääristä. Jos esimerkiksi neljä syaanin prosessivärisävyä (20 %, 40 %, 60 % ja 80 %) sekoitetaan viiden
spottivärin sävyn kanssa (10 %, 20 %, 30 %, 40 % ja 50 %), lopputuloksena on sekoiteväriryhmä, jossa on 20 eri värimallia.

Värimallit-paneeli ja sekoitevärimallit
A. Sekoitevärien pääryhmä B. Sekoitevärien aliryhmä C. Sekoitevärimalli (itsenäinen)

Ennen kuin voit luoda sekoitevärimallin tai sekoiteväriryhmän, Värimallit-paneeliin on lisättävä ainakin yksi spottiväri.

Sekoitevärimallin luominen
1. Valitse Värimallit-paneelivalikosta Uusi sekoitevärimalli. (Valinta näkyy himmeänä, kunnes Värimallit-paneeliin on lisätty spottiväri.)
2. Kirjoita värimallin nimi.
3. Lisää väri sekoitevärimalliin napsauttamalla tyhjää ruutua värin nimen vieressä. Näyttöön tulee värikuvake . Sekoitevärimallissa on oltava

vähintään yksi spottiväri.
4. Säädä kunkin värin prosenttimäärää vetämällä liukusäädintä tai kirjoittamalla arvo prosenttiruutuun.
5. Lisää sekoiteväri Värimallit-paneeliin valitsemalla Lisää tai OK.

Värit näyttävät usein tulostettuna erilaisilta kuin näytössä. Saat parhaan tuloksen, kun pyydät painotalolta näytteen haluamistasi
sekoiteväreistä.

Sekoiteväriryhmän luominen
1. Valitse Värimallit-paneelivalikosta Uusi sekoiteväriryhmä. (Valinta näkyy himmeänä, kunnes Värimallit-paneeliin on lisätty spottiväri.)
2. Kirjoita sekoiteväriryhmän nimi. Ryhmän värien nimet muodostuvat tästä nimestä ja kasvavasta Värimalli-jälkiliitteestä (Värimalli 1, Värimalli

2 jne.).
3. Lisää väri sekoiteväriryhmään napsauttamalla värin nimen vieressä olevaa tyhjää ruutua.
4. Tee valitsemillesi väreille seuraavat määritykset:

Määritä Alku-kohtaan ryhmän luontia varten sekoitettava väri (prosentteina).

Määritä Toisto-kohtaan, kuinka monta kertaa haluat lisätä väriä (prosentteina).

Määritä Vaiheittainen lisäys -kohtaan toistossa lisättävä väri (prosentteina).

5. Valitse Värimallien esikatselu, jos haluat luoda värimalleja sulkematta ikkunaa. Näin voit tarkistaa, tuottavatko valitut värit ja arvot haluamasi
lopputuloksen, ja tehdä tarvittavat korjaukset.
Huomautus: Näyttöön tulee varoitus, jos yhden värin määrä Alku-, Toisto- ja Lisäys-kohdissa ylittää 100 %. Jos haluat jatkaa, InDesign
rajoittaa prosenttimäärän 100 prosenttiin.

6. Lisää kaikki värit Värimallit-paneelin sekoiteväriryhmään valitsemalla OK.

Sekoitevärimallien muokkaaminen
Sekoitevärimallia muokataan samalla tavalla kuin muitakin värimalleja. Kun muokkaat sekoitevärimallia tai -ryhmää, ota huomioon seuraavat asiat:
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Jos poistat sekoitevärimallissa käytettävän värin Värimallit-paneelista, InDesign kehottaa korvaamaan värin. Sekoitevärissä on oltava
vähintään yksi spottiväri. Muutoin se muunnetaan prosessiväriksi.

Sekoiteväriryhmän pääryhmään  tekemäsi muutokset koskevat kaikkia ryhmään kuuluvia sekoitevärejä. (Sekoiteväriryhmän värimalliin
tehdyt muutokset koskevat vain kyseistä värimallia.)

Jos sekoiteväri muunnetaan prosessi- tai spottiväriksi, se ei kuulu enää aikaisempaan sekoiteväriryhmäänsä.

Jos sekoiteväriryhmän pääryhmä poistetaan, kaikki ryhmän värimallit poistetaan.

1. Kaksoisnapsauta Värimallit-paneelissa olevaa muutettavan sekoiteväriryhmän pääryhmää .
2. Tee jokin seuraavista toimista:

Korvaa nykyinen komponenttiväri valitsemalla uusi väri.

Lisää tai poista sekoiteväriryhmän osia napsauttamalla värin vieressä olevaa ruutua.

Huomautus: sekoiteväriryhmän luomisessa käytettyjä alkuperäisiä prosenttimääriä, toistoja ja lisäyksiä ei voi muuttaa.

3. Napsauta OK-painiketta.

Sekoiteväriryhmien hallinta
Värimallit-paneelissa voit poistaa sekoiteväriryhmiä, lisätä värimalleja ja muuntaa sekoitevärimalleja prosessiväreiksi.

Sekoiteväriryhmien poistaminen
 Valitse poistettavan sekoiteväriryhmän pääryhmä Värimallit-paneelista ja napsauta Poista-painiketta.

Värimallin lisääminen sekoiteväriryhmään
1. Valitse Värimallit-paneelista sekoiteväriryhmän pääryhmä.
2. Valitse paneelivalikosta Uusi värimalli.
3. Määritä tarvittaessa värimallille nimi.
4. Määritä sekoitevärimalliin kullekin värille haluamasi prosenttimäärä. (Värejä ei voi lisätä tai poistaa.)
5. Napsauta OK-painiketta.

Yhden sekoitevärimallin muuntaminen prosessiväreiksi
Muuntamalla sekoitevärejä prosessiväreiksi voi alentaa painokuluja. Kun muunnat sekoiteväriryhmän pääryhmän prosessiväreiksi, pääryhmä
poistetaan ja muut sekoiteväriryhmän värimallit muunnetaan prosessiväreiksi.

1. Kaksoisnapsauta muunnettavaa sekoitevärimallia.
2. Valitse värityypiksi Prosessi ja valitse OK.

Sekoiteväriryhmän kaikkien värien muuntaminen prosessiväreiksi
 Kaksoisnapsauta sekoiteväriryhmän pääryhmää  ja valitse näyttöön tulevasta ikkunasta Muunna sekoitevärimallit prosessiin.

Lisää ohjeaiheita
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Alkuun

Alkuun

Tietoja liukuväreistä
Liukuvärimallin luominen
Nimettömän liukuvärin lisääminen Liukuväri-paneelia käyttämällä
Liukuvärien muokkaaminen
Liukuvärin säätäminen liukuvärityökaluilla
Liukuvärin lisääminen useisiin objekteihin
Liukuvärien lisääminen tekstiin

Tietoja liukuväreistä
Liukuväri on vähintään kahden värin tai saman värin sävyn asteittainen sekoitus. Käytetty tulostusväline vaikuttaa siihen, miten liukuvärien värit
erottuvat toisistaan.

Liukuvärit voivat sisältää paperi- prosessi-, spotti- tai sekoitevärejä missä tahansa väritilassa. Liukuvärit määritetään käyttämällä useita
liukuväripalkin lopetusvärejä. Lopetusväri on kohta, jossa liukuväri vaihtuu väristä toiseen. Kohtaa osoittaa värineliö liukuväripalkin alapuolella.
Liukuväri alkaa kahdella värillä, ja sen keskikohta on automaattisesti 50 %:n kohdassa.

Huomautus: Kun olet luonut liukuvärin eri tilojen väreistä ja tulostat tai teet värierottelun, kaikki värit muuntuvat CMYK-prosessiväreiksi. Väritilan
muuttumisen vuoksi värit voivat vaihdella. Saat parhaat tulokset määrittämällä liukuvärit CMYK-väreinä.

Liukuvärimallin luominen
Voit luoda, nimetä ja muokata liukuvärejä samassa Värimallit-paneelissa kuin tasaisia värejä ja sävyjä. Liukuväri-paneelia käyttämällä voit myös
luoda nimettömiä liukuvärejä.

1. Valitse Värimallit-paneelivalikosta Uusi liukuvärimalli.
2. Kirjoita liukuvärin nimi Värimallin nimi -kohtaan.
3. Valitse tyypiksi lineaarinen tai säteittäinen.
4. Valitse ensimmäinen lopetusväri.

Ensimmäinen lopetusväri

5. Valitse spottivärin nimi jollakin seuraavista tavoista:

Jos haluat valita Värimallit-paneelissa olevan värin, valitse ensin Värimallit ja sitten väri luettelosta.

Sekoita uusi nimetön väri liukuväriä varten valitsemalla väritila ja kirjoittamalla väriarvo tai vetämällä liukusäädintä.

Ensimmäinen lopetusväri on oletusarvoisesti valkoinen. Jos haluat siitä läpinäkyvän, käytä Paperi-värimallia.

6. Vaihda liukuvärin viimeinen lopetusväri valitsemalla viimeinen lopetusväri ja toistamalla vaihe 5.
7. Säädä liukuvärien paikkaa käyttämällä yhtä seuraavista tavoista:
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Vedä palkin alla olevia lopetusvärejä.

Valitse lopetusväri palkin alta ja määritä sen paikka kirjoittamalla sijainnin arvo. Tämä paikka on edellisen ja seuraavan värin etäisyys
prosentteina.

8. Säädä kahden liukuvärin välistä keskikohtaa (kohtaa, jossa värit ovat 50 %:ssa) jollakin seuraavista tavoista:

Vedä palkin yläpuolella olevaa vinoneliötä.

Valitse vinoneliö palkin yläpuolelta ja määritä värin paikka kirjoittamalla sijainnin arvo. Tämä paikka on edellisen ja seuraavan värin
etäisyys prosentteina.

9. Valitse OK tai Lisää. Liukuväri on tallennettu Värimallit-paneeliin omalla nimellään.

Nimettömän liukuvärin lisääminen Liukuväri-paneelia käyttämällä
Vaikka Värimallit-paneelia suositellaan liukuvärien luomiseen ja tallentamiseen, voit sekoittaa liukuvärejä myös Liukuväri-paneelissa (Ikkuna > Väri
> Liukuväri). Samaa paneelia käytetään myös Adobe Illustratorissa. Voit lisätä käytössä olevan liukuvärin Värimallit-paneeliin aina, kun haluat.
Liukuväri-paneeli on hyödyllinen luotaessa harvoin käytettäviä nimettömiä liukuvärejä.

Liukuväri-paneeli
A. Liukuväritäyttö B. Liukuvärityypin valikko C. Käänteinen-painike D. Aloitusväripiste E. Keskipiste F. Lopetusväripiste

Huomautus: Jos valitset nimettyä liukuväriä käyttävän objektin, värin muokkaaminen Liukuväri-paneelissa muuttaa vain kyseisen objektin väriä.
Jos haluat muokata väriä koko julkaisussa, kaksoisnapsauta sen värimallia Värimallit-paneelissa.

1. Valitse vähintään yksi muokattava objekti.
2. Napsauta Värimallit-paneelin tai työkalupaneelin Täyttö- tai Viiva-ruutua. (Jos Liukuvärin Täyttö-ruutu ei ole näkyvissä, valitse Liukuväri-

paneelivalikosta Näytä asetukset.)

3. Avaa Liukuväri-paneeli valitsemalla Ikkuna > Väri > Liukuväri tai kaksoisnapsauttamalla työkalupaneelin liukuvärityökalua .
4. Määritä liukuvärin aloitusväri napsauttamalla liukuväripalkin alapuolella vasenta lopetusväripistettä. Tee jokin seuraavista:

Vedä värimalli Värimallit-paneelista ja pudota se pisteeseen.

Napsauta Värimallit-paneelissa värimallia Alt- (Windows) tai optionäppäin (Mac OS) alhaalla.

Luo Väri-paneelissa väri käyttämällä liukusäätimiä tai väripalkkia.

5. Määritä liukuvärin lopetusväri napsauttamalla oikeaa lopetusväripistettä liukuväripalkin alapuolella. Valitse sitten haluamasi väri edellisessä
vaiheessa kuvatulla tavalla.

6. Valitse Tyyppi-valikosta asetukseksi lineaarinen tai säteittäinen, ja säädä väriä sekä keskikohtia kohdassa Liukuvärimallin luominen kuvatulla
tavalla.

7. Säädä liukuvärin kulmaa muuttamalla kulma-arvoa.

Liukuvärien muokkaaminen
Liukuvärejä voi muokata lisäämällä värejä monivärisiin liukuväreihin ja säätämällä lopetusvärejä ja keskikohtia. Objekti kannattaa täyttää
muokattavalla liukuvärillä. Tällöin voit esikatsella väriä säätäessäsi liukuväriä objektissa.

Voit muokata Adobe Illustratorista liitettyjä liukuvärejä, jos liukuväri on liitetty AICB (Adobe Illustrator Clipboard) -muodossa. (Lisätietoja:
Illustrator-kuvien liittäminen InDesigniin.) Valitse liukuväri suoravalintatyökalulla.

Huomautus: jos muokkaat värimallia, sitä käyttävät liukuvärin lopetusvärit päivittyvät automaattisesti ja muuttavat liukuväriä.

Välivärien lisääminen liukuväriin
1. Kaksoisnapsauta liukuvärimallia Värimallit-paneelissa tai tuo Liukuväri-paneeli näkyviin.
2. Määritä uusi lopetuspiste napsauttamalla jotakin kohtaa liukuväripalkin alapuolella. Uusi lopetusväri määritetään automaattisesti kohdan

väriarvojen mukaan käytössä olevassa liukuvärissä.
3. Säädä uutta lopetusväriä.

Voit määrittää uuden lopetusvärin vetämällä värimallin Värimallit-paneelista Liukuväri-paneelin palkkiin.
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Välivärin poistaminen liukuväristä
 Valitse väliväripiste ja vedä se paneelin reunaan.

Liukuvärin asteikon muuttaminen käänteiseksi
1. Valitse liukuväri.

2. Napsauta Liukuväri-paneelin Käänteinen -painiketta .

Liukuvärin säätäminen liukuvärityökaluilla
Kun olet täyttänyt objektin liukuvärillä, voit muokata liukuväriä liukuvärimallityökalulla  tai liukuväripehmennystyökalulla  ja "maalata" täytön
uudelleen vetämällä kuvitteellista viivaa. Liukuvärityökaluilla voit muuttaa liukuvärin suuntaa ja aloitus- ja lopetuspistettä sekä lisätä liukuväriä
useisiin objekteihin. Liukuväripehmennystyökalulla voit pehmentää liukuväriä vetämääsi suuntaan.

1. Valitse Värimallit-paneelista tai työkalupaneelista Täyttö- tai Viiva-ruutu sen mukaan, missä alkuperäinen liukuväri lisättiin.
2. Valitse liukuvärimalli- tai liukuväripehmennystyökalu ja aseta se haluamaasi liukuvärin aloituspisteeseen. Vedä objektin läpi siihen suuntaan,

johon haluat lisätä liukuväriä. Pakota työkalu 45 asteen kulmiin pitämällä vaihtonäppäintä alhaalla.

Kun vedät liukuväripehmennystyökalua liukuvärissä, värit pehmenevät vetämälläsi alueella.

3. Vapauta hiiren painike kohdassa, johon haluat määrittää liukuvärin lopetuspisteen.

Liukuvärin lisääminen useisiin objekteihin
1. Varmista, että kaikissa valituissa objekteissa on jo liukuväri.
2. Valitse työkalupaneelista Täyttö- tai Viiva-ruutu.

3. Valitse liukuvärityökalu  ja aseta se haluamaasi liukuvärin aloituspisteeseen. Vedä objektin läpi siihen suuntaan, johon haluat lisätä
liukuväriä. Pakota työkalu 45 asteen kulmiin pitämällä vaihtonäppäintä alhaalla.

4. Vapauta hiiren painike kohdassa, johon haluat määrittää liukuvärin lopetuspisteen.

Oletusliukuväritäyttö (vasen) ja useisiin objekteihin lisätty liukuväri (oikea)

Jos olet valinnut liukuväriä sisältävän yhdistelmäreitin, voit muokata liukuväriä yhdistelmän kaikissa reiteissä käyttämällä suoraan Liukuväri-
paneelia ilman liukuvärityökalua.

Liukuvärien lisääminen tekstiin
Voit luoda yhteen tekstikehykseen useita liukuvärillisiä tekstejä mustan oletustekstin ja värillisen tekstin ohella.

Liukuvärien lopetuspisteet on aina ankkuroitu liukuvärin reitin tai tekstikehyksen muokkausalueeseen. Yksittäiset tekstimerkit osoittavat liukuvärin
sitä osaa, jonka päälle ne on asetettu. Jos muutat tekstikehyksen kokoa tai teet muita muutoksia, joiden vuoksi tekstimerkit siirtyvät, merkit
sijoitetaan liukuvärille uudelleen ja yksittäisten merkkien värit muuttuvat.

Liukuvärejä sisältävien tekstimerkkien käyttäminen
A. Liukuväritäyttö B. Tekstimerkkejä, joihin on lisätty liukuväri C. Lisätty teksti ja tekstin siirtymäkohta suhteessa liukuväriin
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Voit säätää liukuväriä kahdella eri tavalla niin, että koko väriasteikko kattaa määritetyt tekstimerkit:

Siirrä liukuvärin lopetuspisteet liukuvärityökalulla niin, että ne kattavat vain ne merkit, jotka valitsit liukuväriä lisätessäsi.

Valitse teksti ja muunna se ääriviivoiksi (muokattaviksi reiteiksi) ja lisää sitten liukuväri ääriviivoihin. Tämä on paras vaihtoehto, jos kyseessä
on lyhyt teksti omassa tekstikehyksessään. Liukuväri ankkuroituu pysyvästi ääriviivoihin mutta ei tekstikehykseen. Ääriviivat siirtyvät tekstin
mukana, mutta ne toimivat yhtenä sidottuna grafiikkana tekstikehyksessä, joten tekstiä ei voi enää muokata. Myöskään typografiset asetukset
eivät toimi, eikä esimerkiksi ääriviivoiksi muunnettua tekstiä voi tavuttaa.

Siirtyvä teksti muuttuu oletusarvoisesti liukuvärin mukaisesti (vasen). Kun teksti on muutettu ääriviivoiksi, liukuväri siirtyy tekstin mukana (oikea).

Jos haluat lisätietoja tekstin ääriviivojen muuntamisesta reiteiksi, tutustu kohtaan Reittien luominen tekstin ääriviivoista.

Useita liukuvärejä yhdessä tekstikehyksessä
Voit valita useita tekstialueita yhdessä tekstikehyksessä ja lisätä kuhunkin alueeseen eri liukuvärin. Jokainen liukuväri lisätään niihin tekstikehyksen
merkkeihin, jotka valitsit liukuväriä lisätessä. Liukuvärien lopetuspisteet on kuitenkin ankkuroitu tekstikehyksen muokkausalueeseen eikä
tekstialueisiin.

Lisää ohjeaiheita
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Läpinäkyvyystehosteiden lisääminen

Alkuun

Alkuun

Tietoja läpinäkyvyydestä
Tehosteet-paneelin yleiskuvaus
Läpinäkyvyystehosteiden lisääminen
Läpinäkyvyystehosteet
Käytä yleistä valoa
Objektin peittävyyden määrittäminen
Läpinäkyvyyden käyttäminen ryhmissä
Läpinäkyvien kuvien näyttöasun muuttaminen
Läpinäkyvyyden näyttämisen estäminen
Valkoinen laatikko -ilmiön poistaminen läpinäkyvästä julkaisusta

Kun luot objektin Adobe InDesignissa, se on oletusarvoisesti yhtenäinen eli sen peitto on 100 %. Voit liittää objekteihin tehosteita käyttäen
peittävyyttä ja sekoituksia. Voit limittää objekteja, lisätä objekteihin läpinäkyvyystehosteita tai rajata muotoja objektien takana.

Tietoja läpinäkyvyydestä

Kun luot objektin tai viivan, kun lisäät täytön tai kun kirjoitat tekstin, nämä kaikki kohteet ovat normaalisti läpinäkymättömiä eli niiden peittävyys on
100 %. Voit muuttaa nämä kohteet läpinäkyviksi monella eri tavalla. Voit esimerkiksi säätää peittävyyttä arvosta 100 % (täysin peittävä) arvoon
0 % (täysin läpinäkyvä). Kun vähennät peittävyyttä, sen alla olevat kuvat näkyvät objektin, viivan, täytön tai tekstin pinnan läpi.

Tehosteet-paneelin avulla voit määrittää objektin tai sen viivan, täytön tai tekstin peittävyyden. Voit päättää, kuinka objekti itse ja sen viiva, täyttö
tai teksti sekoittuvat alla oleviin objekteihin. Jos käsittelet objekteja, voit eristää sekoittamisen tiettyihin objekteihin, jotta vain osa ryhmän objekteista
sekoittuu takana oleviin objekteihin. Voit myös määrittää, että tietyt objektit rajaavat ryhmän objektit eivätkä sulaudu niihin.

 

Alla olevien objektien alueet erottuvat läpinäkyvän objektin läpi.

Tehosteet-paneelin yleiskuvaus

Käytä Tehosteet-paneelia (Ikkuna > Tehosteet), kun haluat määrittää objektien ja ryhmien peittävyyden ja sekoitustilan, eristää sekoituksen tiettyyn
ryhmään, rajata objektit ryhmän sisältä tai lisätä läpinäkyvyystehosteen.
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Objekti

Grafiikka

Läpinäkyvyystehosteiden lisääminen ja muokkaaminen Tehosteet-paneelissa

A. Sekoitustila B. Tasot C. FX-kuvake D. Poista tehosteet E. FX-painike 

Sekoitustila

Määrittää, miten läpinäkyvien objektien värit vuorovaikuttavat takana olevien objektien kanssa. (Katso Värien sekoittamisen määrittäminen.)

Peittävyys

Määrittää objektin, viivan, täytön tai tekstin peittävyyden. (Katso Objektin peittävyyden määrittäminen.)

Tasaus

Ilmaisee objektin Objekti-, Viiva-, Täyttö- ja Teksti-peittävyysasetukset ja sen, onko läpinäkyvyystehosteita käytetty. Voit näyttää tai kätkeä nämä
tasoasetukset napsauttamalla Objekti-sanan (tai Ryhmä tai Grafiikka) vasemmalla puolella olevaa kolmiota. FX-kuvake näkyy tason kohdalla, kun
läpinäkyvyysasetuksia on lisätty. Kuvaketta napsauttamalla voit muokata näitä asetuksia.

Eristä sekoitus

Soveltaa sekoitustilaa valittuun objektiryhmään. (Katso Eristetyt sekoitustilat.)

Rajaava ryhmä

Muuttaa ryhmän jokaisen objektin läpinäkyvyys- ja sekoitusmääritteet sellaisiksi, että ryhmän alla olevat objektit rajautuvat. (Katso Ryhmän
objektien rajaaminen.)

Poista kaikki -painike

Poistaa objektista tehosteet (viivan, täytön tai tekstin), valitsee Normaali-sekoitustilan ja muuttaa koko objektin Peittävyys-asetukseksi 100 %.

FX-painike

Avaa läpinäkyvyystehosteiden luettelon. (Katso Läpinäkyvyystehosteiden lisääminen.)

Näytä Tehosteet-paneelin asetukset

Valitse Ikkuna > Tehosteet ja avaa sitten tarvittaessa Tehosteet-paneelivalikko ja valitse Näytä asetukset.

Tehosteet -paneelin asetukset voidaan valita myös Tehosteet-valintaikkunasta (valitse objekti ja sitten Objekti > Tehosteet > Läpinäkyvyys).
Osa niistä näkyy myös Ohjauspaneelissa.

Läpinäkyvyystehosteiden lisääminen

1. Valitse objekti. Jos haluat lisätä tehosteita kuvaan, valitse kuva suoravalintatyökalulla.

2. Näytä Tehosteet-paneeli valitsemalla Ikkuna > Tehosteet.

3. Määritä objektin muokattava osa tai osat valitsemalla taso:

Vaikuttaa koko objektiin – viivaan, täyttöön ja tekstiin.

Vaikuttaa vain suoravalintatyökalulla valittuun grafiikkaan. Kuvaan lisätyt tehosteet säilyvät, kun kuva liitetään toiseen kehykseen.
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Ryhmä

Viiva

Täyttö

Teksti

Vaikuttaa kaikkiin ryhmän objekteihin ja kaikkeen tekstiin. (Suoravalintatyökalun avulla voit lisätä tehosteita tietyn ryhmän
objekteihin.))

Vaikuttaa vain objektin viivaan (myös välin väriin).

Vaikuttaa vain objektin täyttöön.

Vaikuttaa vain objektin sisällä olevaan tekstiin, ei tekstikehykseen. Tekstiin lisätyt tehosteet vaikuttavat objektin koko tekstiin;
tehostetta ei voi kohdistaa erillisiin sanoihin tai kirjaimiin.

Voit valita tasoasetuksen myös Ohjauspaneelista: napsauta Lisää tehoste objektiin -painiketta 

4. Avaa Tehosteet-valintaikkuna yhdellä seuraavista tavoista:

Napsauta Tehosteet-paneelissa tai Ohjauspaneelissa olevaa FX-painiketta 

Valitse Tehosteet-paneelivalikosta Tehosteet ja sitten tehosteen nimi.

Valitse pikavalikosta Tehosteet ja sitten tehosteen nimi.

Valitse Objekti > Tehosteet ja sitten tehosteen nimi.

Napsauta Tehosteet-paneelissa olevaa kolmiota, jotta näet tasoasetukset, ja kaksoisnapsauta sitten Tehosteet-paneelissa olevaa
tasoasetusta (Objekti, Viiva, Täyttö tai Teksti). Kaksoisnapsauttamalla voit sekä avata Tehosteet-valintaikkunan että valita tasoasetuksen.

5. Valitse tehosteen asetukset. (Katso Yleiset läpinäkyvyysasetukset.)

6. Valitse OK.

Läpinäkyvyystehosteen muokkaaminen

1. Valitse ainakin yksi objekti, jossa tehostetta on käytetty.

2. Avaa Tehosteet-valintaikkuna yhdellä seuraavista tavoista:

Kaksoisnapsauta Tehosteet-paneelin FX-kuvaketta Objekti-kohdan oikealla puolella (ei paneelin alareunassa). Sinun pitää ehkä tuoda
FX-kuvake näkyviin napsauttamalla Objekti-sanan vieressä olevaa kolmiota.

Valitse taso, jonka tehostetta haluat muokata, napsauta Tehosteet-paneelissa olevaa FX-kuvaketta  ja valitse tehosteen nimi.

3. Muokkaa tehostetta.

Läpinäkyvyystehosteiden kopioiminen

Voit kopioida läpinäkyvyystehosteita seuraavilla menetelmillä:

Jos haluat kopioida tehosteet objektista toiseen, valitse kopioitavan tehosteen sisältävä objekti, valitse saman objektin FX-kuvake 
Tehosteita voi vetää ja pudottaa vain saman tason objektien välillä.

Jos haluat kopioida osan objektin tehosteista, käytä pipettityökalua . Jos haluat määrittää, mitkä viivan, täytön ja objektin
läpinäkyvyysasetukset kopioituvat pipettityökalulla, kaksoisnapsauta työkalua, jotta Pipettityökalun asetukset -valintaikkuna avautuu.
Määritä sitten asetukset Viiva-asetukset-, Täyttöasetukset- ja Objektiasetukset-alueilla.

Jos haluat kopioida tehosteita samassa objektissa tasolta toiselle, Alt-vedä (Windows) tai optio-vedä (Mac OS) FX-kuvake tasolta toiselle
(Viiva, Täyttö tai Teksti) Tehosteet-paneelissa.

Voit siirtää tehosteita saman objektin tasolta toiselle vetämällä FX-kuvaketta.

Läpinäkyvyystehosteiden poistaminen objektista

Tee jokin seuraavista toimista:

Jos haluat poistaa objektista kaikki tehosteet, valita Normaali-sekoitustilan ja muuttaa Peittävyys-asetukseksi 100 %, napsauta
Tehosteet-paneelissa olevaa Poista kaikki tehosteet -painiketta  tai valitse Tehosteet-paneelivalikosta Poista kaikki läpinäkyvyys.

Jos haluat poistaa kaikki tehosteet ja säilyttää sekoitus- ja peittävyysasetukset, valitse taso ja valitse Tehosteet-paneelivalikosta Poista
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Alkuun

Heittovarjo

Sisäreunan varjo

Ulkoreunan hehku ja sisäreunan hehku

Viisto ja kohokuvio

Satiini

Tavallinen pehmennys, pehmennys suuntaan ja liukuväripehmennys

Huomautus:

Kulma ja Korkeus

tehosteet tai vedä FX-kuvake  Tehosteet-paneelin Viiva-, Täyttö- tai Teksti-tasolta Roskakori-kuvakkeeseen.

Voit poistaa tehosteen useita tasoja (Viiva, Täyttö tai Teksti) valitsemalla tasot ja napsauttamalla roskakorikuvaketta.

Jos haluat poistaa yhden tehosteen objektista, avaa Tehosteet-valintaikkuna ja poista läpinäkyvyystehosteen valinta.

Läpinäkyvyystehosteet

InDesignissa on yhdeksän läpinäkyvyystehostetta. Monet niiden asetuksista ovat samankaltaisia.

Tehosteet

A. Heittovarjo B. Sisäreunan varjo C. Ulkoreunan hehku D. Sisäreunan hehku E. Viisto ja kohokuvio F. Satiini G. Tavallinen pehmennys H.
Pehmennys suuntaan I. Liukuväripehmennys 

Lisää varjon, joka jää objektin, viivan, täytön tai tekstin taakse.

Lisää varjon, joka on hieman objektin, viivan, täytön tai tekstin reunojen sisäpuolella ja muuttaa kohteen sisäänpainetun
näköiseksi.

Lisää hehkun, joka säteilee objektin, viivan, täytön tai tekstin ulko- tai sisäreunoista.

Lisää erilaisia valojen ja varjojen yhdistelmiä, jotka muuttavat tekstin ja kuvat kolmiulotteisen näköisiksi.

Lisää sisävarjostuksen, joka muuttaa pinnan satiinimaiseksi.

Voit pehmentää objektin reunat häivyttämällä ne läpinäkyviksi.

Katso edellä käsiteltyjen kuvausten lisäksi myös Yleiset läpinäkyvyysasetukset.

Yleiset läpinäkyvyysasetukset

Monet läpinäkyvyystehosteiden asetukset ovat samat eri tehosteissa. Yleisiä läpinäkyvyysasetuksia ovat esimerkiksi seuraavat:

Määrittävät kulman, jossa valaistustehoste lisätään. Asetus 0 merkitsee pinnan tasoa ja asetus 90 paikkaa suoraan objektin
yläpuolella. Napsauta kulmasädettä tai kirjoita kulma asteina. Valitse Käytä yleistä valoa, jos haluat valaista kaikki objektit samasta kulmasta. Tätä
asetusta käyttävät heittovarjo-, sisäinen varjo-, viisto ja kohokuvio-, satiini- ja pehmennystehosteet.
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Sekoitustila

Kutistus

Etäisyys

Kohina

Peittävyys

Koko

Aukeama

Tekniikka

Pehmeämpi

Tarkka

Käytä yleistä valoa

X-siirto ja Y-siirto

Objekti syrjäyttää varjon

Varjo sallii muut tehosteet

Määrittää, miten läpinäkyvien objektien värit vuorovaikuttavat takana olevien objektien kanssa. Tätä asetusta käyttävät heittovarjo-,
sisäinen varjo-, ulkoreunan hehku-, sisäreunan hehku- ja satiinitehosteet. (Katso Värien sekoittamisen määrittäminen.)

Tämä asetus ja Koko-asetus määrittävät, kuinka suuri osa varjosta tai hehkusta on peittävää ja kuinka suuri osa läpinäkyvää. Suuri
asetus suurentaa peittävyyttä ja pieni asetus läpinäkyvyyttä. Tätä asetusta käyttävät sisäinen varjo-, sisäreunan hehku- ja pehmennystehosteet.

Määrittää heittovarjo-, sisäinen varjo- tai satiinitehosteen siirtoetäisyyden.

Tämä asetus määrittää hehku- tai varjotehosteen satunnaisten elementtien määrän, kun annetaan arvo tai vedetään liukusäädintä. Tätä
asetusta käyttävät heittovarjo-, sisäinen varjo-, ulkoreunan hehku-, sisäreunan hehku- ja pehmennystehosteet.

Määrittää tehosteen peittävyyden; vedä liukusäädintä tai kirjoita prosenttiarvo. (Katso Objektin peittävyyden määrittäminen.) Käytössä
Heittovarjo-, Sisäreunan varjo-, Ulkoreunan hehku-, Sisäreunan hehku-, Liukuväripehmennys-, Viisto ja kohokuvio- sekä Satiini-tehosteissa.

Määrittää varjon tai hehkun koon. Tätä asetusta käyttävät heittovarjo-, sisäinen varjo-, ulkoreunan hehku-, sisäreunan hehku- ja
satiinitehosteet.

Määrittää sumennuksen läpinäkyvyyden varjo- tai hehkutehosteessa, joka on määritetty käyttämällä Koko-asetusta. Suuri prosenttiarvo
muuttaa sumennuksen peittävämmäksi. Tätä asetusta käyttävät Heittovarjo- ja Ulkoreunan hehku -tehosteet.

Nämä asetukset määrittävät, miten läpinäkyvyystehosteen reuna vaikuttaa taustaväreihin. Pehmeämpi- ja Tarkka-asetukset koskevat
ulkoreunan hehku- ja sisäreunan hehku -tehosteita:

Lisää tehosteen reunaan sumennuksen. Suurikokoisen kohteen yksityiskohdat eivät säily.

Säilyttää tehosteen reunat, myös kulmat ja muut terävät yksityiskohdat. Toiminto säilyttää ominaisuudet Pehmeämpi-tekniikkaa
paremmin.

Käyttää varjossa yleistä valaistusasetusta. Tätä asetusta käyttävät heittovarjo-, viisto ja kohokuvio- ja sisäinen varjo -
tehosteet.

Siirtävät varjoa x- tai y-akselilla määritetyn etäisyyden verran. Tätä asetusta käyttävät heittovarjo- ja sisäinen varjo -tehosteet.

Heittovarjo

Heittovarjotehoste muodostaa kolmiulotteisen varjon. Voit siirtää heittovarjoa x- tai y-akselilla sekä muuttaa heittovarjon sekoitustilaa, väriä,
peittävyyttä, etäisyyttä, kulmaa ja kokoa. Määritä seuraavilla asetuksilla, miten heittovarjo vaikuttaa objekteihin ja läpinäkyvyystehosteisiin:

Objekti näkyy heittämänsä varjon edessä.

Heittovarjo ottaa muut läpinäkyvyystehosteet huomioon. Jos esimerkiksi objekti on häivytetty toiselta puolelta, voit
valita, jätetäänkö heittovarjo häivyttämättä vai häivytetäänkö se samalla tavoin kuin objekti.

Napsauta Ohjauspaneelin Heittovarjo-painiketta 

Jos haluat valita heittovarjon värin, napsauta Aseta varjon väri -painiketta (Sekoitustila-valikon vieressä) ja valitse väri.

Sisäreunan varjo

Sisävarjotehoste sijoittaa varjon objektin sisäpuolelle, jotta objekti muuttuu sisäänpainuneen näköiseksi. Voit siirtää sisävarjoa eri akseleiden
suuntiin sekä muuttaa sisävarjon sekoitustilaa, peittävyyttä, etäisyyttä, kulmaa, kokoa, kohinaa ja kutistusta.
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Lähde

Tyyli

Koko

Tekniikka

Pehmennys

Suunta

Syvyys

Kulma ja Korkeus

Käytä yleistä valoa

Valo ja Varjo

Käänteinen

Ulkoreunan hehku

Ulkoreunan hehku -tehoste lisää hehkun, joka säteilee objektin alta. Voit valita sekoitustilan, peittävyyden, tekniikan, kohinan, koon ja ulottuvuuden.

Sisäreunan hehku

Sisäreunan hehku -tehoste muuttaa objektin sisältä ulospäin hehkuvaksi. Valitse sekoitustila-, peittävyys-, tekniikka-, koko-, kohina- ja
kutistusasetukset sekä Lähde-asetus:

Määrittää hehkun lähteen. Keskiosa-asetus lisää keskeltä säteilevän hehkun, ja Reuna-asetus lisää objektin reunoilta säteilevän hehkun.

Viisto ja kohokuvio

Viisto ja kohokuvio -tehoste antaa objekteille realistisen, kolmiulotteisen ulkoasun. Rakenne-asetukset vaikuttavat objektin kokoon ja muotoon:

Määrittää viistetyylin: Ulkoinen viiste lisää viisteen objektin ulkoreunoihin, Sinen viiste lisää viisteen sisäreunoihin, Korkokuva jäljittelee
objektin muuttamista korkokuvaksi alla oleviin objekteihin nähden ja Pyöreäreunainen korkokuva jäljittelee objektin reunojen painamista alla oleviin
objekteihin.

Määrittää viiste- tai korkokuvatehosteen koon.

Määrittää, miten viiste- tai korkokuvatehosteen reuna vaikuttaa taustaväreihin: Tasainen sumentaa reunoja hieman (eikä säilytä suurten
objektien yksityiskohtia), Pehmeä kaiverrus sumentaa reunoja hieman vähemmän (se säilyttää yksityiskohdat paremmin kuin Tasainen-tekniikka
mutta ei yhtä hyvin kuin Kova kaiverrus -tekniikka) ja Kova kaiverrus muuttaa reunan kovemmaksi ja paremmin erottuvaksi (se säilyttää
yksityiskohdat paremmin kuin kaksi edellistä tekniikkaa).

Korostaa Tekniikka-asetusta sumentamalla tehostetta, jotta virheet ja rosoiset reunat eivät näy.

Valitse Ylös tai Alas sen mukaan, pitääkö tehosteen näyttää ylös vai alas painetulta.

Määrittää korkokuvatehosteen syvyyden.

Varjostus-asetus määrittää, miten valo vaikuttaa objektiin.

Määrittävät valonlähteen korkeuden. Asetus 0 merkitsee pinnan tasoa ja asetus 90 paikkaa suoraan objektin yläpuolella.

Lisää yleisen valonlähteen, joka on määritetty kaikille läpinäkyvyystehosteille. Tämä asetus ohittaa Kulma- ja Korkeus-
asetukset.

Määrittää viisteen tai korkokuvan valojen ja varjojen sekoitustilan.

Satiini

Satiini-tehoste muuttaa objektin pinnan satiinimaisen sileäksi. Valitse sekoitustila-, peittävyys-, kulma-, etäisyys- ja kokoasetukset ja valitse,
muutetaanko värit ja läpinäkyvyydet käänteisiksi:

Valitse tämä asetus, jos haluat muuttaa objektin värilliset ja läpinäkyvät alueet käänteisiksi.
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Tavallinen pehmennys

Häivytys-tehoste pehmentää (häivyttää) objektin reunat määritetyllä matkalla:

Reunan pehmennyksen leveys

Määrittää etäisyyden, jolla objekti muuttuu peittävästä läpinäkyväksi

 

Kutistus

Määrittää Häivytyksen leveys -asetuksen ohella, kuinka suuri osa pehmentävästä hehkusta on peittävää ja kuinka suuri osa läpinäkyvää. Suuri
asetus lisää peittävyyttä ja pieni asetus läpinäkyvyyttä

 

Kulmat

Valitse Terävä, Pyöristetty tai Sekoitettu:

 Terävä  Seuraa kuvion ulkoreunaa, myös teräviä kulmia. Tämä asetus sopii tähtimäisille objekteille ja suorakulmaisten muotojen
erikoistehosteeksi.

Pyöristetty  Pyöristää kulmat häivytyssäteen mukaisiksi. Kuviota siirretään ensin sisään- ja sitten ulospäin, jolloin muodostuu kaksi rajaviivaa.
Tämä asetus sopii hyvin suorakulmioihin.

Sekoitettu  Käyttää Adobe Illustratorin menetelmää, joka häivyttää objektin reunat peittävistä läpinäkyviksi.

Kohina

Määrittää pehmentävän hehkun satunnaisten osien määrän. Tällä asetuksella voidaan pehmentää hehkua.

Pehmennys suuntaan

Pehmennys suuntaan -tehoste pehmentää objektin reunoja häivyttämällä reunat läpinäkyviksi määritetyissä suunnissa. Häivytys voi esimerkiksi
vaikuttaa objektin ylä- ja alareunaan mutta ei vasempaan eikä oikeaan reunaan.

Pehmennysleveydet

Määritä etäisyys, jolla objektin ylä-, ala-, vasen ja oikea reuna muuttuvat läpinäkyviksi. Valitse Lukitse-asetus, jos haluat häivyttää objektin jokaisen
reunan samalla etäisyydellä.

Kohina

Määrittää pehmentävän hehkun satunnaisten osien määrän. Tällä asetuksella luodaan pehmeämpi hehku.

Kutistus

Tämä asetus määrittää Leveys-asetusten tavoin, kuinka suuri osa hehkusta on peittävää ja kuinka suuri osa läpinäkyvää. Suuret asetukset lisäävät
peittävyyttä ja pienet asetukset läpinäkyvyyttä.

Muoto

Valitse objektin alkuperäistä muotoa vastaava asetus: Vain ensimmäinen reuna, Johtavat reunat tai Kaikki reunat.

Kulma

Muuttaa häivytystehosteen kulmaa. Ellei kulma ole 90 asteen monikerta, häivytetyt reunat eivät ole samansuuntaiset objektin kanssa, vaan
vinossa.

Liukuväripehmennys

Liukuväripehmennystehoste pehmentää objektin alueita häivyttämällä ne läpinäkyviksi.

Liukuvärin päätearvot

Luo yksi liukuväriraja objektiin lisättävän läpinäkyvyyden jokaista astetta varten.

Jos haluat lisätä liukuvärirajan, napsauta liukuvärisäätimen alapuolta. (Voit poistaa liukuvärirajan vetämällä sen pois liukusäätimestä.)

Jos haluat siirtää rajaa, vedä sitä vasemmalle tai oikealle tai valitse se ja vedä Sijainti-liukusäädintä.

Jos haluat siirtää kahden peittävyysrajan välistä keskipistettä, vedä liukuvärisäätimen yläpuolella olevaa vinoneliötä. Vinoneilön sijainti
vaikuttaa siihen, kuinka jyrkkä tai loiva rajojen välisestä siirtymästä tulee.
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Alkuun

Alkuun

Huomautus:

Alkuun

Käänteinen liukuväri

Tätä napsauttamalla voit muuttaa liukuvärien suunnan käänteiseksi. Tämä ruutu on liukuvärisäätimen oikealla puolella.

Peittävyys

Määrittää liukuväripisteiden välisen läpinäkyvyyden. Valitse piste ja vedä Peittävyys-liukusäädintä.

Sijainti

Muuttaa liukuvärirajan sijaintia. Valitse liukuväriraja ja vedä liukusäädintä tai kirjoita mitta.

Teksti

Lineaarinen varjostaa suoraviivaisesti liukuvärin alkupisteestä loppupisteeseen. Säteittäinen varjostaa ympyrämäisesti alkupisteestä
loppupisteeseen.

Kulma

Lineaarisessa liukuvärissä tämä asetus vaikuttaa liukuvärin viivojen kulmaan. Esimerkiksi arvo 90 astetta muodostaa vaakasuorat viivat ja arvo
180 pystysuorat viivat.

Käytä yleistä valoa

Voit määrittää yleisen valaistuskulman läpinäkyvyystehosteisiin, joissa varjostus on merkittävä. Ne ovat heittovarjo, sisäinen varjo sekä viisto ja
kohokuvio. Kun valitset näiden tehosteiden yhteydessä Käytä yleistä valaistusta -asetuksen, Yleinen valo -valintaikkunan yleinen valaistusasetus
määrittää valaistuksen.

1. Voit avata Yleinen valo -valintaikkunan millä tahansa seuraavista menetelmistä:

Valitse Tehosteet-paneelivalikosta Yleinen valo.

Valitse Objekti > Tehosteet > Yleinen valo.

2. Kirjoita Yleinen valo -valintaikkunaan arvo tai määritä Kulma- ja Korkeus-asetukset vetämällä kulmasädettä. Napsauta sitten OK-painiketta.

Objektin peittävyyden määrittäminen

Läpinäkyvyys voidaan lisätä yhteen objektiin tai valittuihin objekteihin (myös grafiikka- ja tekstikehyksiin), mutta ei yksittäisiin tekstin merkkeihin tai
tasoihin. Tällaisen läpinäkyvyystehosteen sisältävät tuodut kuvat kuitenkin näkyvät ja tulostuvat oikein.

1. Valitse yksi tai useita objekteja.

Jos valitset useita objekteja ja niiden peittävyysasetukset ovat erilaiset, Tehosteet-paneelissa näkyy sana sekoitettu. Jos esimerkiksi
valittujen objektien Täyttö-peittävyysasetukset ovat erilaiset, Läpinäkyvyys-paneelissa lukee "Täyttö: Peittävyys (sekoitettu)".

2. Valitse Objekti, Viiva, Täyttö tai Teksti millä tahansa seuraavista menetelmistä:

Napsauta Ohjauspaneelin Käytä tehosteita -painiketta  ja valitse asetus.

Valitse asetus Tehosteet-paneelista (napsauta tarvittaessa Objekti-sanan vieressä olevaa kolmiota, jotta näet asetukset).

3. Kirjoita Ohjauspaneeliin tai Tehosteet-paneeliin Peittävyys-asetuksen arvo tai napsauta Peittävyys-asetuksen vieressä olevaa nuolta ja vedä
liukusäädintä. Kun objektien peittävyysarvoa pienennetään, läpinäkyvyys lisääntyy.

jos suoravalitset ja leikkaat tai kopioit objektin läpinäkyvästä ryhmästä InDesignissa ja sitten liität sen muualle julkaisuun, objekti on
läpinäkyvä vain, jos läpinäkyvyys on liitetty siihen erikseen.

Läpinäkyvyyden käyttäminen ryhmissä

Voit lisätä läpinäkyvyystehosteita yksittäisten objektien lisäksi ryhmiin.

Jos vain valitset objekteja ja muutat niiden peittävyysasetuksia, valittujen objektien peittävyys muuttuu suhteessa muiden objektien peittävyyteen.
Limittäisten alueiden peittävyys näkyy kertautuneena.

Jos taas valitset Ryhmitä-komennolla luodun ryhmän ja sitten muutat peittävyyttä, ryhmää käsitellään Tehosteet-paneelissa yhtenä objektina
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(Tehoste-paneelissa näkyy vain yksi tasoasetus, nimittäin Ryhmä) ja ryhmän sisäiset peittävyydet eivät muutu. Ryhmän objektit eivät siis vaikuta
toistensa läpinäkyvyyteen.

Objekteja, joiden peittävyys on 50 %, (vasemmalla), ja ryhmä, jonka peittävyys on 50 % (oikeammalla)

Läpinäkyvien kuvien näyttöasun muuttaminen

Määritä läpinäkyvyysasetukset Näytä suoritus -valintaikkunassa (näyttölaatu). Nämä asetukset määrittävät läpinäkyvien objektien näyttölaadun
uusissa julkaisuissa ja julkaisuissa, joille on tallennettu muokatut asetukset. Voit myös määrittää asetukset, joilla julkaisun läpinäkyvyys otetaan
käyttöön tai poistetaan käytöstä. Vaikka poistaisit läpinäkyvyyden käytöstä näyttöasetuksissa, sitä käytetään edelleen tiedostoa tulostettaessa ja
vietäessä.

Muista tarkistaa läpinäkyvyysasetukset ennen läpinäkyvyystehosteita sisältävän tiedoston tulostamista. Tulostus yhdistää kuvat
automaattisesti ja voi vaikuttaa tehosteiden ulkoasuun.

1. Valitse Muokkaa > Asetukset > Näytä suoritus (Windows) tai Adobe InDesign > Asetukset > Näytä suoritus (Mac OS).

2. Määritä julkaisun kaikkien tehosteiden näyttötarkkuus valitsemalla asetus (Nopea, Tyypillinen, Laadukas) Säädä näkymäasetuksia -
kohdasta. Valittu asetus koskee vain tässä valittua toimintoa:

Nopea-asetus poistaa läpinäkyvyyden käytöstä ja valitsee resoluutioksi 24 dpi.

Tyypillinen-asetus näyttää pienen resoluution tehosteet ja valitsee resoluutioksi 72 dpi.

Laadukas-asetus parantaa tehosteiden näyttämistä erityisesti PDF- ja EPS-tiedostoissa ja valitsee resoluutioksi 144 dpi.

3. Vedä Läpinäkyvyys-liukusäädintä. Oletusasetus on Normaali laatu, joka näyttää heittovarjot ja reunojen pehmennykset.

4. Napsauta OK-painiketta.

5. Jos spottiväri ja sekoitustilat limittyvät, valitse Näytä > Päällepainatuksen esikatselu. Näin varmistat, että näet näytöstä, miten painovärit
vaikuttavat läpinäkyvyyteen.

Näytä-valikossa voit nopeasti valita läpinäkyvyysnäytöksi Nopea näyttö, Tyypillinen näyttö tai Laadukas näyttö.

Läpinäkyvyyden näyttämisen estäminen

Jos haluat parantaa näytön suorituskykyä, voit estää läpinäkyvyyttä näkymästä näytöllä. Vaikka poistaisit läpinäkyvyyden näkyvistä, tehostetta
käytetään edelleen tiedostoa tulostettaessa ja vietäessä.

Valitse Näytä > Näytön suorituskyky > Nopea näyttö.

Valkoinen laatikko -ilmiön poistaminen läpinäkyvästä julkaisusta

Kun käytetään läpinäkyvyystehostetta, siinä saattaa joskus näkyä valkoinen laatikko tai haamu. Tämä tapahtuu yleensä julkaisussa, joka sisältää
heittovarjoja tai liukuvärejä. Tämä ongelma voi esiintyä, jos läpinäkyvyystehoste joutuu tekemisiin spottivärin kanssa.

Jos haluat estää ongelman, älä käytä spottivärejä läpinäkyvyyden kanssa, tai voit poistaa päällepainatuksen käytöstä.

Kun haluat avata ja tulostaa PDF-julkaisun ilman valkoista laatikkoa, ota Acrobatissa Simuloi päällepainatus -toiminto käyttöön. Valitse Acrobat
9:ssä Lisäasetukset > Tulostustuotanto > Tulosteen esikatselu. Valitse Acrobat X:ssä Työkalut > Tulostustuotanto > Tulosteen esikatselu.

Jos lähetät julkaisun tulostajalle ja valkoinen laatikko -ilmiö esiintyy, pyydä palveluntarjoajaa ottamaan käyttöön RIPin PostScript-päällepainatus -
asetus. Jos tämä ei toimi, voit litistää läpinäkyvyyden ja valita Simuloi päällepainatus -asetuksen, ennen kuin lähetät tiedoston. InDesignissa tämä
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Tietoja yhdistämisestä
Tietoja läpinäkyvyyden yhdistämisen oletusarvoista
Yhdistämisoletusarvon käyttäminen tulosteessa
Läpinäkyvyyden yhdistämisen esimäärityksen luominen tai muokkaaminen
Läpinäkyvyyden yhdistämisen mukautettujen esimääritysten vieminen ja tuominen
Mukautetun läpinäkyvyyden yhdistämisen esimäärityksen nimeäminen uudelleen tai poistaminen
Yksittäisen aukeaman yhdistäminen
Yhdistämisoletusarvojen ohittaminen yksittäisellä aukeamalla
Läpinäkyvyyden yhdistämisasetukset
Esikatselu piirroksen yhdistettävistä alueista
Esikatselun päivittäminen Yhdistämisen esikatselu- paneelissa
Parhaita käytäntöjä läpinäkyvyyttä luotaessa

Tietoja yhdistämisestä
Jos dokumentti tai kuva sisältää läpinäkyviä objekteja, sen tulostaminen edellyttää yleensä yhdistämiseksi kutsutun toimenpiteen suorittamista.
Yhdistäminen jakaa läpinäkyvän kuvan vektoripohjaisiksi alueiksi ja rasteroiduiksi alueiksi. Grafiikan monimutkaistuessa (esimerkiksi kuvia,
vektoreita, tekstiä, spottivärejä ja päällepainatusta yhdistettäessä) myös yhdistäminen ja sen tulokset mutkistuvat.

Yhdistäminen voi olla tarpeen tulostettaessa sekä tallennettaessa tai muunnettaessa tiedosto muuhun muotoon, joka ei tue läpinäkyvyyttä. Voit
säilyttää läpinäkyvyyden ilman yhdistämistä tallentamalla luotavat PDF-tiedostot Adobe PDF 1.4 (Acrobat 5.0) -muodossa tai myöhempien
versioiden muodossa.

Voit määrittää yhdistämisasetuksia, tallentaa ne ja sitten käyttää niitä läpinäkyvyyden yhdistämisen esimäärityksinä. Läpinäkyvät objektit
yhdistetään valitun yhdistämisen esimäärityksen asetusten mukaisesti.

Huomautus: Läpinäkyvyyden yhdistämistä ei voi kumota tiedoston tallentamisen jälkeen.

Limittäiset kuvat on jaettu yhdistettäessä.

Lisätietoja läpinäkyvien alueiden tulostamisesta on Adobe Solutions Networkin (ASN) Print Service Provider Resources -sivulla (vain
englanniksi), joka kuuluu Adoben Web-sivustoon.

Tietoja läpinäkyvyyden yhdistämisen oletusarvoista
Jos tulostat tai viet usein läpinäkyvyyksiä sisältäviä julkaisuja, voit automatisoida yhdistämisen tallentamalla yhdistämisasetukset läpinäkyvyyden
yhdistämisoletusarvoiksi. Sitten voit käyttää näitä asetuksia, kun tulostat tiedostoja tai tallennat ja viet tiedostoja PDF 1.3 (Acrobat 4.0)-, EPS- ja
PostScript-muotoihin. Illustratorissa voit käyttää niitä myös tallentaessasi tiedostoja Illustratorin aiempia versioita varten tai kopioidessasi tietoja
leikepöydälle. Acrobatissa ne soveltuvat PDF-tiedostojen optimoimiseen.

Nämä asetukset vaikuttavat myös siihen, miten yhdistäminen tapahtuu, kun tiedosto tallennetaan muotoon, joka ei tue läpinäkyvyyttä.

Voit valita yhdistämisen esimäärityksen Lisäasetukset-paneelista, joka on Tulosta-valintaikkunassa tai tiedostomuotokohtaisessa valintaikkunassa,
joka avautuu Vie- tai Tallenna nimellä -valintaikkunan jälkeen. Voit luoda omia yhdistämisen esimäärityksiä tai valita ohjelmiston mukana
toimitettuja oletusasetuksia. Kunkin esimäärityksen asetukset on suunniteltu sovittamaan yhdistämislaatu ja -nopeus rasteroitujen läpinäkyvien
alueiden sopivaan resoluutioon julkaisun käyttötarkoituksen mukaan.

[Korkea resoluutio] Sopii lopullisille tulosteille ja laadukkaille vedoksille, kuten erottelupohjaisille värivedoksille.
[Normaali resoluutio] Sopii työpöytävedoksille ja tarvejulkaisuille, jotka tulostetaan PostScript-väritulostimella.
[Matala resoluutio] Sopii nopeille vedoksille, jotka tulostetaan mustavalkotyöpöytätulostimella, sekä Webissä julkaistaville tai SVG-muotoon
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vietäville julkaisuille.

Yhdistämisoletusarvon käyttäminen tulosteessa
Voit valita yhdistämisoletusarvon Tulosta-valintaikkunassa tai muotokohtaisessa valintaikkunassa, joka tulee näkyviin Vie-valintaikkunan jälkeen.

Jos viet tai tulostat usein läpinäkyvyyttä sisältäviä julkaisuja, voit automatisoida yhdistämisen tallentamalla yhdistämisasetukset läpinäkyvyyden
yhdistämisn oletusarvoksi. Sitten voit käyttää näitä asetuksia, kun tulostat tai viet tiedostoja PDF 1.3 (Acrobat 4.0)- tai EPS-muotoon.

 Valitse Tulosta-, Vie EPS- tai Vie Adobe PDF -valintaikkunan Lisäasetukset-paneelissa joko mukautettu oletusarvo tai yksi seuraavista
oletusarvoista:
[Matala resoluutio] Sopii nopeille vedoksille, jotka tulostetaan mustavalkotyöpöytätulostimella, sekä Webissä julkaistaville julkaisuille.
[Normaali resoluutio] Sopii työpöytävedoksille ja tarvejulkaisuille, jotka tulostetaan Adobe PostScript -väritulostimella.
[Korkea resoluutio] Sopii lopullisille tulosteille ja laadukkaille vedoksille, kuten erotteluperustaisille värivedoksille.
Huomautus: yhdistämisasetuksia käytetään vain, jos kuva sisältää läpinäkyvyyttä tai jos Simuloi päällepainatus on valittu Vie Adobe PDF -
valintaikkunan Tuloste-alueelta.

Läpinäkyvyyden yhdistämisen esimäärityksen luominen tai muokkaaminen
Voit tallentaa läpinäkyvyyden yhdistämisoletusarvoja erilliseen tiedostoon, mikä helpottaa niiden varmuuskopiointia ja jakamista tulostuspalvelulle,
asiakkaille tai työryhmäsi muille jäsenille. InDesignissa läpinäkyvyyden yhdistämisoletusarvotiedostoilla on flst-tunniste.

1. Valitse Muokkaa > Läpinäkyvyyden yhdistämisoletusarvot.
2. Tee jokin seuraavista toimista:

Luo uusi oletusarvo valitsemalla Uusi.

Jos haluat käyttää pohjana valmiiksi määritettyjä oletusarvoja, valitse ne luettelosta ja valitse sitten Uusi.

Jos haluat muokata nykyistä oletusarvoa, valitse oletusarvo ja napsauta Muokkaa.

Huomautus: Voit muokata vain mukautettuja yhdistämisoletusarvoja.
3. Valitse yhdistämisen asetukset.
4. Valitse OK ja palaa takaisin Läpinäkyvyyden yhdistämisoletusarvot -valintaikkunaan ja valitse sitten uudelleen OK.

Läpinäkyvyyden yhdistämisen mukautettujen esimääritysten vieminen ja tuominen
Voit tallentaa läpinäkyvyyden yhdistämisoletusarvot ja jakaa ne tulostuspalvelulle, asiakkaille tai työryhmäsi muille jäsenille.

1. Valitse Muokkaa > Läpinäkyvyyden yhdistämisoletusarvot.
2. Valitse oletusarvo luettelosta.
3. Tee jokin seuraavista toimista:

Jos haluat tallentaa oletusarvot erilliseen tiedostoon, valitse Tallenna (InDesign) tai Vie (Illustrator), määritä nimi ja sijainti ja valitse
Tallenna.

On suositeltavaa tallentaa esimääritykset muualle kuin sovelluksen oletusarvojen kansioon. Siten esimäärityksiä ei menetetä, jos joskus
poistat tehtyjä oletusarvoja.

Tuo esimääritykset tiedostosta valitsemalla Lataa (InDesign) tai Tuo (Illustrator). Etsi ja valitse ladattavat oletusarvot sisältävä tiedosto ja
valitse Avaa.

Mukautetun läpinäkyvyyden yhdistämisen esimäärityksen nimeäminen uudelleen tai
poistaminen

1. Valitse Muokkaa > Läpinäkyvyyden yhdistämisoletusarvot.
2. Valitse oletusarvo luettelosta.
3. Tee jokin seuraavista toimista:

Jos haluat nimetä aiemmin luodun oletusarvon uudelleen, valitse Muokkaa, kirjoita uusi nimi ja valitse OK.

Poista esimääritykset napsauttamalla Poista ja vahvista poistaminen napsauttamalla OK.
Huomautus: (Et voi poistaa oletusesimäärityksiä.)

Yksittäisen aukeaman yhdistäminen
Voit liittää yhdistämisasetukset julkaisun yksittäisiin aukeamiin ohittaen koko julkaisulle tai kirjalle määrittämäsi yhdistämisoletusarvot. Näin voit
hallita yhdistämislaatua julkaisuissa, joissa on paljon läpinäkyvyyttä sisältäviä suuren resoluution kuvia sekä toisaalta pienen resoluution kuvia.
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Tällöin voit yhdistää monimutkaiset aukeamat laadukkaalla asetuksella ja käyttää nopeampia ja matalampilaatuisia yhdistämisoletusarvoja muilla
aukeamilla.

Tulostaessasi tai viedessäsi tiedostoa voit palauttaa julkaisun tai kirjan yleiset yhdistämisasetukset.

1. Avaa aukeama julkaisuikkunaan.
2. Valitse Sivut-paneelivalikosta Aukeaman yhdistäminen.
3. Valitse jokin seuraavista vaihtoehdoista ja napsauta sitten OK-painiketta:

Oletus Käyttää aukeamassa julkaisun yhdistämisoletusarvoa.

Ei mitään (ohita läpinäkyvyys) Ohittaa aukeaman läpinäkyvyyden. Tulostuspalvelu voi käyttää tätä asetusta ongelmia ratkaistessaan.

Mukautettu Avaa Mukautetun aukeaman yhdistämisasetukset -valintaikkunan asetusten määritystä varten.

Yhdistämisoletusarvojen ohittaminen yksittäisellä aukeamalla
 Valitse Ohita aukeaman ohitukset jostakin seuraavista InDesignin kohteista:

Yhdistämisen esikatselu -paneeli (Ikkuna > Tuloste > Yhdistämisen esikatselu).

Tulosta- tai Vie Adobe PDF -valintaikkunan Lisäasetukset-alue.

Läpinäkyvyyden yhdistämisasetukset
Voit määrittää läpinäkyvyyden yhdistämisasetuksia Illustratorissa, InDesignissa tai Acrobatissa yhdistämisen esimääritysten luomisen,
muokkaamisen tai esikatselemisen aikana.

Asetusten korostaminen (esikatseleminen)
Ei mitään (Värien esikatselu) Poistaa esikatselun käytöstä.
Rasteroidut monimutkaiset alueet Korostaa alueet, jotka rasteroidaan suorituskyvyn vuoksi (Rasteri/Vektorit-liukusäätimellä määritetyllä tavalla).
Muista, että korostetun alueen rajalla on tavallista suurempi todennäköisyys aiheuttaa värirajaongelmia (tulostinohjaimen asetusten ja
rasterointitarkkuuden mukaan). Voit estää värirajaongelmia valitsemalla Leikkaa monimutkaiset alueet.
Läpinäkyvät objektit Korostaa läpinäkyvyyden lähteinä olevat objektit, esimerkiksi osittain peittävät objektit (mukaan lukien kuvat, joissa on
alfakanavia), sekoitustiloja sisältävät objektit ja peittävyyspeitteitä sisältävät objektit. Ota myös huomioon, että tyylit ja tehosteet voivat sisältää
läpinäkyvyyttä ja päälletulostettuja objekteja voidaan käsitellä läpinäkyvyyden lähteinä, jos niihin liittyy läpinäkyvyyttä tai jos päälletulostus pitää
yhdistää.
Kaikki asiaankuuluvat objektit Korostaa kaikki objektit, joissa on läpinäkyvyyttä, mukaan lukien läpinäkyvät objektit ja objektit, jotka ovat
päällekkäisiä läpinäkyvien objektien kanssa. Yhdistäminen vaikuttaa korostettuihin objekteihin. Niiden viivat tai kuviot laajenevat, niiden osia
voidaan rasteroida ja niin edelleen.
Liittyvät linkitetyt EPS-tiedostot (vain Illustrator) Korostaa kaikki linkitetyt EPS-tiedostot, joihin läpinäkyvyys vaikuttaa.
Liittyvä grafiikka (vain InDesign) Korostaa kaiken sijoitetun sisällön, johon läpinäkyvyys tai läpinäkyvyystehosteet vaikuttavat. Tämä asetus sopii
palveluntarjoajille, joiden täytyy tulostusta varten nähdä toimenpiteitä vaativa grafiikka.
Laajennetut kuviot (Illustrator ja Acrobat) Korostaa kaikki kuviot, jotka laajennetaan, jos niihin liittyy läpinäkyvyyttä.
Ääriviivat Korostaa kaikki ääriviivoiksi muunnettavat viivat, jos niihin liittyy läpinäkyvyyttä tai koska Muunna viivat ääriviivoiksi -asetus on valittu.
Ääriviivateksti (Illustrator ja InDesign) Korostaa kaiken ääriviivoiksi muunnettavan tekstin, jos siihen liittyy läpinäkyvyyttä tai koska Muunna teksti
ääriviivoiksi -asetus on valittu.
Huomautus: Lopullisessa tulosteessa ääriviivoiksi muunnetut viivat ja teksti voivat hieman poiketa alkuperäisistä, varsinkin, jos viivat ovat erittäin
ohuita tai teksti erittäin pientä. Yhdistämisen esikatselussa ei kuitenkaan korosteta näitä muutoksia.
Rasteritäytteinen teksti ja viivat (vain InDesign) Korostaa tekstin ja viivat, joissa on rasteroituja täyttöjä yhdistämisen seurauksena.
Kaikki rasteroidut alueet (Illustrator ja InDesign) Korostaa objektit ja objektien leikkauskohdat, jotka rasteroidaan, koska niitä ei voi esittää
muuten PostScript-muodossa tai koska ne ovat Rasterit/Vektorit-liukusäätimellä määritettyä kynnystä monimutkaisempia. Esimerkiksi kahden
läpinäkyvän liukuvärin leikkauskohta rasteroidaan aina, vaikka Rasterit/Vektorit-arvo olisi 100. Kaikki rasteroidut alueet -asetus näyttää myös
läpinäkyvyyteen liittyvän rasterigrafiikan (kuten Photoshop-tiedostot) ja rasteritehosteet, kuten heittovarjot ja reunojen pehmennykset. Huomaa, että
tällä asetuksella tiedoston käsitteleminen kestää tavallista kauemmin.

Läpinäkyvyyden yhdistämisen esimääritysten vaihtoehdot
Nimi/Esimääritys Määrittää esimäärityksen nimen. Valintaikkunan mukaan voit kirjoittaa nimen Nimi-ruutuun tai hyväksyä oletusnimen. Voit
kirjoittaa valmiin oletusarvon nimen ja muokata oletusarvoa. Vain mukautettuja oletusarvoja voi muokata.
Rasterin/vektorin suhde Määrittää säilytettävien vektoritietojen määrän. Kun asetusta suurennetaan, säilytetään useampia vektoriobjekteja, kun
taas asetusta pienennettäessä rasteroidaan useampia vektoriobjekteja. Keskisuurta asetusta käytettäessä säilytetään yksinkertaiset alueet
vektorimuodossa ja rasteroidaan monimutkaiset alueet. Voit rasteroida koko kuvat valitsemalla pienimmän asetuksen.
Huomautus: Rasteroinnin määrä määräytyy sivun monimutkaisuuden ja päällekkäisten objektien mukaan.
Viivapiirrosten ja tekstin resoluutio Rasteroi kaikki objektit, myös kuvat, vektoripiirrokset, tekstin ja liukuvärit, määritettyyn resoluutioon.
Acrobatin ja InDesignin sallima suurin resoluutio on 9 600 pikseliä tuumalla (ppi) viivapiirroksissa ja 1 200 ppi liukuväriverkoissa. Illustrator sallii
enintään 9 600 ppi sekä viivapiirroksissa että liukuväriverkoissa. Yhdistetyn kuvan resoluutio vaikuttaa leikkauskohtien tarkkuuteen. Viivapiirrosten
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ja tekstin resoluutio -asetuksen pitäisi yleensä olla 600–1 200, jotta rasteroinnin tulos olisi hyvälaatuinen, varsinkin jos tekstissä käytetään
päätteellisiä kirjasimia tai pientä pistekokoa.
Liukuvärin ja verkon resoluutio Määrittää yhdistämisen tuloksena rasteroitavien liukuvärien ja Illustratorin verkko-objektien resoluution välillä 72–
2 400 ppi. Yhdistetyn kuvan resoluutio vaikuttaa leikkauskohtien tarkkuuteen. Liukuvärin ja verkon resoluution tulisi tavallisesti olla 150–300 ppi,
koska liukuvärien, heittovarjojen ja reunojen pehmennysten laatu ei parane korkeammalla resoluutiolla, mutta tulostusaika ja tiedostokoko
kasvavat.
Muunna teksti ääriviivoiksi Muuntaa kaikentyyppiset objektit (pistetyyppi, aluetyyppi ja reittiteksti) ääriviivoiksi ja hylkää kaikki tyypin kuviotiedot
sivuilla, joissa on läpinäkyvyyttä. Tämä asetus takaa, että tekstin leveys säilyy yhdenmukaisena yhdistämisen aikana. Huomaa, että tämä asetus
saa pienet fontit näkymään hieman tavallista paksumpina, kun niitä katsellaan Acrobatilla tai tulostetaan matalaresoluutioisella tulostimella. Asetus
ei vaikuta tekstin laatuun, kun se tulostetaan korkearesoluutioisella tulostimella tai valolatomakoneella.
Muunna viivat ääriviivoiksi Muuntaa kaikki viivat yksinkertaisiksi täytetyiksi reiteiksi sivuilla, joissa on läpinäkyvyyttä. Tämä asetus takaa, että
viivojen leveys säilyy yhdenmukaisena yhdistämisen aikana. Ota huomioon, että tämän asetuksen ottaminen käyttöön saa ohuet viivat näyttämään
hieman paksummilta ja että se voi huonontaa yhdistämisen suorituskykyä.
Leikkaa monimutkaiset alueet Takaa, että vektori- ja rasterikuvien rajat noudattavat objektien reittejä. Tämä asetus vähentää värirajoja, joita
syntyy, kun osa objektista rasteroidaan toisen osan jäädessä vektorimuotoon. Asetuksen valitseminen voi kuitenkin johtaa niin monimutkaisiin
reitteihin, ettei tulostin voi käsitellä niitä.

Epätasaiset värirajat, jossa rasterit ja vektorit kohtaavat.

Huomautus: Eräät tulostinohjaimet käsittelevät rasteri- ja vektorikuvat eri tavoin, mikä aiheuttaa toisinaan värirajoja. Voit ehkä minimoida
värirajaongelmat poistamalla käytöstä joitakin tulostinohjainkohtaisia värienhallinta-asetuksia. Koska nämä asetukset vaihtelevat tulostimen mallin
mukaan, katso lisätietoja tulostimen käyttöohjeista.
(vain Illustrator) Valitse Säilytä alfaläpinäkyvyys (vain Yhdistä läpinäkyvyys -valintaikkuna) Säilyttää yhdistettyjen objektien yleisen
peittävyyden. Kun tämä asetus on valittu, sekoitustilat ja päälletulostukset katoavat, mutta niiden ulkoasu ja alfaläpinäkyvyyden taso säilyvät
käsitellyssä kuvassa (samoin kuin rasteroitaessa grafiikkaa käyttämällä läpinäkyvää taustaa) Säilytä alfaläpinäkyvyys -asetuksen käyttäminen voi
olla hyödyllistä SWF- tai SVG-viennin yhteydessä, koska nämä molemmat muodot tukevat alfaläpinäkyvyyttä.
(Vain Illustrator) Valitse Säilytä spottivärit ja päälletulostukset (vain Yhdistä läpinäkyvyys -valintaikkuna) Yleisesti säilyttää spottivärit.
Lisäksi se säilyttää päälletulostuksen objekteissa, joihin ei liity läpinäkyvyyttä. Valitse tämä vaihtoehto, jos tulostat värierotteluita ja dokumentti
sisältää spottivärejä ja päälletulostettuja objekteja. Poista tämän vaihtoehdon valinta, kun tallennat tiedostoja käytettäväksi taittosovelluksissa. Kun
tämä vaihtoehto on valittuna, läpinäkyvyyteen vaikuttavat päälletulostusalueet yhdistetään, kun taas päälletulostus säilytetään muilla alueilla.
Tulokset ovat ennustamattomia silloin, kun tiedosto tulostetaan taittosovelluksesta.
Säilytä päälletulostus (vain Acrobat) Sekoittaa läpinäkyvän grafiikan värin taustavärin kanssa, jolloin muodostuu päälletulostusvaikutus.

Esikatselu piirroksen yhdistettävistä alueista
Yhdistämisen esikatselun esikatseluasetuksilla voit korostaa alueet, joihin yhdistäminen vaikuttaa. Voit säätää yhdistämisasetuksia näiden
värikoodattujen tietojen avulla.

Huomautus: Yhdistämisen esikatselua ei ole tarkoitettu spottivärien, päällepainatusten ja sekoitustilojen esikatselua varten. Käytä näihin
tarkoituksiin Päällepainatuksen esikatselu -tilaa.

1. Litistyksen esikatselu -paneeli (tai -valintaikkuna):

Valitse Illustratorissa Ikkuna > Litistyksen esikatselu.

Valitse Acrobatissa Työkalut > Painotyö > Yhdistämisen esikatselu.

Valitse InDesignissa Ikkuna > Tuloste > Yhdistämisen esikatselu.

2. Valitse Korostus-valikosta korostettavien alueiden laji. Käytettävissä olevat vaihtoehdot vaihtelevat grafiikan sisällön mukaan.
3. Valitse yhdistämisasetukset, joita haluat käyttää. Valitse esimääritys tai määritä asetukset yksitellen, jos se on mahdollista.

Huomautus: (Illustrator) Jos yhdistämisasetukset eivät näy, näytä ne valitsemalla paneelivalikosta Näytä asetukset.
4. Jos grafiikka sisältää päälletulostusobjekteja, jotka ovat vuorovaikutuksessa läpinäkyvien objektien kanssa, valitse Illustratorissa vaihtoehto

Päälletulostukset-valikosta. Voit säilyttää tai hylätä päälletulostukset tai simuloida niitä. Voit sekoittaa läpinäkyvän grafiikan värin taustaväriin
ja luoda näin päälletulostusvaikutuksen valitsemalla Acrobatissa Säilytä päälletulostus.

5. Voit milloin tahansa näyttää asetusten mukaan päivitetyn version valitsemalla Päivitä. Grafiikan mutkikkuuden mukaan esikatselukuvan
tuominen näyttöön voi kestää joitakin sekunteja. InDesignissa voi myös valita Päivitä korostus automaattisesti -vaihtoehdon.

Voit suurentaa esikatselukuvaa Illustratorissa ja Acrobatissa napsauttamalla esikatselualuetta. Voit loitontaa näkymää pitämällä Alt-
näppäintä painettuna ja napsauttamalla tai Optio-osoittamalla esikatselualuetta. Voit panoroida esikatselukuvaa pitämällä välinäppäintä
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painettuna ja vetämällä esikatselualueessa.

Esikatselun päivittäminen Yhdistämisen esikatselu- paneelissa
Päivitä näyttö automaattisesti valitsemalla Päivitä korostus automaattisesti.
Päivitä näyttö manuaalisesti napsauttamalla Päivitä-painiketta.

Molemmissa tapauksissa näyttö päivitetään julkaisuikkunassa valittujen läpinäkyvyyden yhdistämisasetusten mukaisesti.

Parhaita käytäntöjä läpinäkyvyyttä luotaessa
Useimmissa tapauksissa yhdistäminen tuottaa erinomaisen tuloksen, kun käytät sopivia valmiiksi määritettyjä yhdistämisoletusarvoja tai luot omat
oletusarvot, joiden asetukset sopivat lopulliseen tulosteeseen. Lisätietoja läpinäkyvyyden vaikutuksista tulostukseen on Adoben Web-sivuston
julkaisussa Achieving Reliable Print Output with Transparency (vain englanniksi).

Jos julkaisusi kuitenkin sisältää monimutkaisia limittyviä alueita ja tulosteen on oltava laadukas, voit varmistaa tulostuslaadun noudattamalla
seuraavia ohjeita:

Tärkeää: Jos liität läpinäkyvyystehosteita julkaisuun, joka on tarkoitus tulostaa laadukkaasti, neuvottele asiasta tulostuspalvelun kanssa. Näin voit
taata parhaan mahdollisen lopputuloksen.

Objektien päällepainatus
Vaikka yhdistetyt objektit voivat näyttää läpinäkyviltä, ne ovat peittäviä eivätkä niiden alla olevat objektit näy läpi. Vaikka et käyttäisi
päällepainatuksen simulointia, läpinäkyvyyden yhdistäminen voi ehkä säilyttää objektien päällepainatuksen, kun julkaisu viedään PDF-muotoon tai
tulostetaan. Tässä tapauksessa PDF-tiedoston vastaanottajien tulee valita Päällepainatuksen esikatselu Acrobat 5.0:ssa tai uudemmassa, jotta
päällepainatus näkyy oikein.

Sen sijaan, jos käytät päällepainatuksen simulointia, läpinäkyvyyden yhdistäminen luo simulaation päällepainatuksen ulkoasusta tehden kaikista
peittäviä objekteja. PDF-tulosteissa tämä simulaatio muuntaa spottivärit vastaaviksi prosessiväreiksi. Tämän vuoksi Simuloi päällepainatus -
asetusta ei tule valita tulosteille, jotka värierotellaan myöhemmin.

Spottivärit ja sekoitustilat
Spottivärien käyttö joidenkin sekoitustilojen kanssa voi joskus tuottaa yllättäviä tuloksia. Syy on se, että InDesign käyttää näytöllä
prosessivärivastineita, mutta tulosteissa spottivärejä. Lisäksi tuodun kuvan eristetty sekoitus voi rajata kuvia aktiivisessa julkaisussa.

Jos käytät sekoitusta, tarkista julkaisu ajoittain Näytä-valikon Päällepainatuksen esikatselu -komennolla. Päällepainatuksen esikatselu antaa
summittaisen kuvan läpinäkyvien objektien päälle painettavista tai niihin vaikuttavista spottiväreistä. Jos tulos ei tyydytä, valitse jompikumpi
seuraavista vaihtoehdoista:

Käytä toista sekoitustilaa tai älä käytä sekoitustilaa lainkaan. Spottivärejä käytettäessä on hyvä välttää Erottava-, Poistava-, Sävy-,
Kylläisyys-, Väri- ja Kirkkaus-tiloja.

Käytä mahdollisuuksien mukaan prosessiväriä.

Sekoitusväli
Jos liität aukeaman objekteihin läpinäkyvyyden, kaikki aukeaman värit muunnetaan valitsemasi läpinäkyvyyden sekoitustilan mukaisiksi
(Muokkaa > Läpinäkyvyyden sekoitustila). Vaihtoehdot ovat RGB-julkaisu ja CMYK-julkaisu, vaikka ne eivät liity läpinäkyvyyteen. Kaikkien värien
muuntaminen yhdenmukaistaa kaikki aukeaman samanväriset objektit. Näin vältetään myös merkittävät värimuutokset läpinäkyvyyden reunoissa.
Värit muunnetaan samalla, kun piirrät objekteja. Läpinäkyvyyteen vaikuttavien sijoitettujen kuvien värit muunnetaan myös. Tämä vaikuttaa siihen,
kuinka värit näkyvät näytöllä ja tulostuvat, mutta ei värien määrittelyyn julkaisussa.

Käytä yhtä seuraavista tavoista työnkulun mukaan:

Jos julkaisu on tarkoitus tulostaa, valitse sekoitusväliksi CMYK-julkaisu.

Jos julkaisu on tarkoitus julkaista Webissä, valitse RGB-julkaisu.

Jos julkaisu on tarkoitus sekä tulostaa että julkaista Webissä, päätä, kumpi muoto on tärkeämpi, ja valitse sitten sopiva sekoitusväli.

Jos kyseessä on suuren resoluution tuloste, jonka aiot myös julkaista Webissä laadukkaana PDF-julkaisuna, sekoitustilaa on ehkä
vaihdettava ennen lopullista tulostusta. Tällöin kaikkien läpinäkyvyyksiä sisältävien aukeamien värit on hyvä tarkistaa ja julkaisussa välttää
Erottava- ja Poistava-sekoitustiloja, sillä ne voivat muuttaa ulkoasua huomattavasti.

Tyyppi
Kun teksti on lähellä läpinäkyviä objekteja, se voi käyttäytyä odottamattomalla tavalla. Esimerkiksi läpinäkyvän objektin ympärille kiertyvä teksti ei
välttämättä limity objektin kanssa, mutta kuviot voivat olla riittävän lähellä vaikuttaakseen läpinäkyvyyteen. Tällöin yhdistämistoiminto voi muuntaa
kuviot ääriviivoiksi, mikä paksuntaa kuvioiden viivoja.

Jos näin käy, tee toinen seuraavista:

Siirrä teksti pinoamisjärjestyksessä päällimmäiseksi. Valitse tekstikehys valintatyökalulla ja valitse Objekti > Järjestä > Tuo eteen.
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Laajenna kaikki teksti ääriviivoiksi, jotta tehoste on yhdenmukainen koko julkaisussa. Laajenna kaikki teksti ääriviivoiksi ja valitse Muunna
teksti ääriviivoiksi -asetus Läpinäkyvyyden yhdistämisen oletusarvot -valintaikkunassa. Asetuksen valitseminen voi vaikuttaa
käsittelynopeuteen.

Kuvien korvaaminen
Yhdistämistoiminto vaatii suuren resoluution tietoja käsitelläkseen läpinäkyvyyksiä sisältäviä julkaisuja virheettömästi. OPI-valitsimen työnkulussa
käytetään kuitenkin paikkamerkkejä tai valitsinkuvia, jotka OPI-palvelin myöhemmin korvaa suuren resoluution kuvilla. Jos yhdistämistoiminto ei voi
käyttää suuren resoluution tietoja, OPI-kommentteja ei luoda ja vain lopulliseen tulosteeseen päätyvät pienen resoluution sijaiskuvat tulostetaan.

Jos käytät OPI-työnkulkua, korvaa kuvat InDesignissa, ennen kuin tallennat julkaisun PostScript-muotoon. Tällöin asetukset täytyy määrittää, kun
sijoitat EPS-kuvan ja kun tulostat sen. Kun sijoitat EPS-kuvan, valitse EPS-tuontiasetukset -valintaikkunasta Lue upotetut OPI-kuvalinkit. Kun
tulostat, valitse Tulosta- tai Vie EPS -valintaikkunan Lisäasetukset-alueelta OPI-kuvien korvaus.

Värimuunnokset
Jos läpinäkyvä objekti limittyy spottiväriobjektin kanssa, tulokset voivat yllättää, kun viet julkaisun EPS-muotoon ja muunnat sitten spottivärit
prosessiväreiksi tulostaessasi tai luodessasi värierotteluja jossakin muussa sovelluksessa.

Ehkäise näitä ongelmia ja muunna spottivärit vastaaviksi prosessiväreiksi Painovärin hallinnalla ennen viemistä InDesignista. Toinen tapa estää
ongelmien synty on varmistaa, että spottivärit ovat yhdenmukaisia sekä alkuperäisessä sovelluksessa (esimerkiksi Adobe Illustrator) että
InDesignissa. Joudut ehkä avaamaan Illustrator-julkaisun, muuntamaan spottivärit prosessiväreiksi, viemään julkaisun takaisin EPS-muotoon ja
sijoittamaan EPS-tiedoston lopuksi InDesigniin.

Adobe PDF -tiedostot
Vienti Acrobat 4.0:aan (Adobe PDF 1.3:een) yhdistää läpinäkyvyyttä sisältävän julkaisun, mikä voi vaikuttaa läpinäkyvien objektien ulkoasuun.
Läpinäkymätöntä sisältöä ei yhdistetä, ellei Vie Adobe PDF -valintaikkunan Tuloste-alueen Simuloi päällepainatus -asetusta ole valittu. Valitse siksi
jokin seuraavista vaihtoehdoista, kun viet läpinäkyvyyttä sisältävän InDesign-julkaisun Adobe PDF -muotoon:

Aina kun mahdollista, valitse Acrobat 5.0- (Adobe PDF 1.4), Acrobat 6.0- (Adobe PDF 1.5) tai Acrobat 7.0 (Adobe PDF 1.6) -yhteensopivuus
Vie Adobe PDF -valintaikkunasta, jotta läpinäkyvyys säilyy toimivassa ja täysin muokattavassa muodossa. Varmista, että palveluntarjoajasi
voi käsitellä Acrobat 5.0-, Acrobat 6.0- tai Acrobat 7.0 -tiedostoja.

Jos sinun on käytettävä Acrobat 4.0 -yhteensopivuutta, julkaisussa on spottivärejä. Jos haluat luoda PDF-tiedoston näytöstä katselemista
varten (esimerkiksi asiakkaalle tarkistettavaksi), sinun kannattaa valita Vie Adobe PDF -valintaikkunan Tuloste-alueelta Simuloi päällepainatus
-asetus. Tällä toiminnolla voit simuloida spotti- ja läpinäkyvyysalueita. PDF-tiedoston vastaanottajien ei tarvitse valita Päällepainatuksen
esikatselu -asetusta Acrobatissa, jotta he voivat nähdä, miltä tulostettu julkaisu näyttää. Simuloi päällepainatus -asetus muuntaa tehtävään
PDF-tiedostoon kaikki spottivärit vastaaviksi prosessiväreiksi. Muista siis poistaa asetuksen valinta, kun luot lopullista PDF-tiedostoa.

Harkitse valmiiksi määritetyn [Painolaatu] Adobe PDF -oletusarvon käyttämistä. Oletusarvo sisältää yhdistämisasetukset, jotka sopivat
laadukkaasti tulostettaville monimutkaisille julkaisuille.

Lihotus
Yhdistämistoiminto voi muuntaa vektorit rasterialueiksi. Kuviin Adobe Illustratorissa viivojen avulla liitetyt lihotustehosteet säilyvät, kun kuvat
sijoitetaan InDesigniin. InDesignissa piirrettyihin vektorikuviin liitettyjä rasteroituja lihotustehosteita ei välttämättä voi säilyttää.

Jos haluat säilyttää mahdollisimman monta objektia vektorimuodossa, valitse Tulosta- tai Vie Adobe PDF -valintaikkunan Lisäasetukset-alueelta
[Korkea resoluutio] -yhdistämisoletusarvo.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Värien sekoittaminen

Alkuun

Normaali

Kertova

Rasteri

Peittävä

Sulauttava

Kova valo

Värivarjostus

Värilisävalotus

Värien sekoittamisen määrittäminen
Eristetyt sekoitustilat
Ryhmän objektien rajaaminen
Väriavaruuden määrittäminen läpinäkyvien objektien sekoitusta varten

Värien sekoittamisen määrittäminen

Voit sekoittaa kahden limittäisen objektin värit käyttämällä sekoitustiloja. Sekoitustilojen avulla muutetaan tapoja, joilla pinottujen objektien värit
sekoittuvat toisiinsa.

1. Valitse vähintään yksi objekti tai ryhmä.

2. Tee jokin seuraavista:

Valitse Tehosteet-paneelivalikosta sekoitustila, esimerkiksi Normaali tai Peittävä.

Valitse Tehosteet-valintaikkunan Läpinäkyvyys-alueen valikosta sekoitustila

Sekoitustilojen asetukset

Sekoitustilat määrittävät, miten perusväri (kuvan pohjalla oleva väri) toimii sekoitusvärin (valitun objektin tai objektiryhmän väri) kanssa.
Sekoituksen tuottamaa väriä kutsutaan tulosväriksi.

Värittää valinnan sekoitusvärillä vaikuttamatta perusväriin. Tämä on oletustila.

Kertoo perusvärin sekoitusvärillä. Tulosväri on aina muita tummempi väri. Kun mikä tahansa väri kerrotaan mustalla, tulos on musta. Kun
mikä tahansa väri kerrotaan valkoisella, tulos on alkuperäinen väri. Vaikutus on sama kuin piirtäisit useilla värittömillä huopakynillä.

Kertoo sekoitus- ja perusvärin käänteisvärin. Tulosväri on aina muita vaaleampi väri. Kun rasteroidaan mustalla, väri jää ennalleen. Kun
rasteroidaan valkoisella, tulosväri on valkoinen. Vaikutus on sama kuin heijastaisit useita dioja päällekkäin.

Kertoo tai rasteroi värit sen mukaan, millainen perusväri on. Kuviot tai värit peittävät kuvat säilyttäen perusvärin korostukset ja varjot
mutta sekoittaen mukaan sekoitusväriä, joka heijastaa alkuperäisen värin vaaleutta tai tummuutta.

Tummentaa tai vaalentaa värejä sekoitusvärin mukaan. Vaikutus on sama kuin heijastaisit kuvaan hajanaisen valokeilan.
Jos sekoitusväri (valonlähde) on vaaleampi kuin 50 % harmaa, kuva vaalenee ikään kuin sitä lisävalotettaisiin. Jos sekoitusväri on tummempi kuin
50 % harmaa, kuva tummenee ikään kuin sitä varjostettaisiin. Puhdas musta tai valkoinen tuottaa selvästi tummemman tai vaaleamman alueen,
mutta ei tee siitä puhtaan mustaa tai valkoista.

Kertoo tai rasteroi värit sen mukaan, millainen sekoitusväri on. Vaikutus on sama kuin heijastaisit kuvaan räikeän valokeilan.
Jos sekoitusväri (valonlähde) on vaaleampi kuin 50 % harmaa, kuva vaalenee ikään kuin sitä rasteroitaisiin. Näin voit lisätä kuviin korostuksia. Jos
sekoitusväri on tummempi kuin 50 % harmaa, kuva tummenee ikään kuin sitä kerrottaisiin. Näin voit lisätä kuviin varjoja. Jos maalataan puhtaalla
mustalla tai valkoisella, tuloskin on puhdas musta tai valkoinen.

Heijastaa sekoitusvärin kirkastamalla perusväriä. Jos sekoitetaan mustaa, väri ei muutu.

Heijastaa sekoitusvärin tummentamalla perusväriä. Jos sekoitetaan valkoista, väri ei muutu.
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Tummentava

Vaalentava

Erottava

Poistava

Sävy

Kylläisyys

Väri

Kirkkaus

Huomautus:

Alkuun

Alkuun

Valitsee tulosväriksi perus- ja sekoitusväristä tummemman. Sekoitusväriä vaaleammat alueet korvataan uudella värillä. Sitä
tummemmat alueet eivät muutu.

Valitsee tulosväriksi perus- ja sekoitusväristä vaaleamman. Sekoitusväriä tummemmat alueet korvataan uudella värillä. Sitä
vaaleammat alueet eivät muutu.

Vähentää sekoitusvärin perusväristä tai päinvastoin sen mukaan, kumman kirkkausarvo on suurempi. Jos sekoitetaan valkoista,
perusvärin arvot muuttuvat käänteisiksi. Jos sekoitetaan mustaa, perusväri ei muutu.

Vaikutus on samankaltainen mutta kontrasti pienempi kuin Erottava-tilassa. Valkoisella sekoitus kääntää perusvärin osat päinvastaisiksi.
Jos sekoitetaan mustaa, väri ei muutu.

Luo värin, jolla on perusvärin kirkkaus ja kylläisyys sekä sekoitusvärin sävy.

Luo värin, jolla on perusvärin kirkkaus ja sävy sekä sekoitusvärin kylläisyys. Tämä tila ei vaikuta alueisiin, joilla ei ole kylläisyyttä
(harmaa).

Luo värin, jolla on perusvärin kirkkaus sekä sekoitusvärin sävy ja kylläisyys. Tämä tila säilyttää kuvan harmaatasot. Se sopii
mustavalkokuvien väritykseen ja värikuvien sävytykseen.

Luo värin, jolla on perusvärin sävy ja kylläisyys sekä sekoitusvärin kirkkaus. Tulosväri on käänteinen verrattuna Väri-tilan tulosväriin.

Vältä käyttämästä Erottava-, Poistava-, Sävy-, Kylläisyys-, Väri- ja Kirkkaus-sekoitustiloja spottiväriobjekteihin. Muutoin julkaisuun voi
tulla ei-toivottuja värejä. Lisätietoja on artikkelissa Parhaita käytäntöjä läpinäkyvyyttä luotaessa.

Eristetyt sekoitustilat

Kun käytät sekoitustilaa objektissa, värit sekoittuvat kaikkiin objektin alla oleviin objekteihin. Jos haluat rajata sekoituksen tiettyihin objekteihin, voit
ryhmittää haluamasi objektit ja käyttää ryhmään Eristä sekoitus -asetusta. Eristä sekoitus -asetus rajaa sekoituksen ryhmän sisälle ja estää
vaikutuksen leviämisen ryhmän alla oleviin objekteihin. (Tämä on hyödyllinen ratkaisu objekteille, joissa on käytetty jotakin muuta kuin Normaali-
sekoitustilaa.)

Ryhmä (tähti ja ympyrä), jossa ei ole valittu Eristä sekoitus -asetusta (vasemmalla), ja ryhmä, jossa se on valittu (oikealla)

On tärkeää ymmärtää, että sekoitustiloja käytetään yksittäisiin objekteihin mutta Eristä sekoitus -asetusta ryhmään. Asetus eristää sekoituksen
vaikutukset ryhmän sisälle. Se ei vaikuta sekoitustiloihin, joita käytetään suoraan itse ryhmään.

1. Käytä sekoitustiloja ja peittävyysasetuksia yksittäisiin objekteihin, joiden sekoituksen haluat eristää.

2. Valitse eristettävät objektit valintatyökalulla.

3. Valitse Objekti > Ryhmitä.

4. Valitse Tehosteet-paneelista Eristä sekoitus. (Jos asetusta ei näy, valitse Tehosteet-paneelivalikosta Näytä asetukset.)

Voit eristää objektien sekoituksen PDF-tiedostossa, joka sisältää sekoitustiloja. Sijoita PDF-tiedosto, kun Sijoita PDF -valintaikkunaan
Läpinäkyvä tausta -asetus on valittu. Käytä sitten Eristä sekoitus -asetusta.
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Alkuun

Huomautus:

Ryhmän objektien rajaaminen

Voit rajata valitun ryhmän kaikkien objektien peittävyys- ja sekoitusmääritteitä Tehosteet-paneelin Rajaava ryhmä -asetuksella. Rajaaminen
tarkoittaa ryhmässä alla olevien objektien näkymisen estämistä. Vain valitun ryhmän sisällä olevat objektit rajataan. Valitun ryhmän sisäisiin
objekteihin käytettävät sekoitus- ja peittävyysmääritteet vaikuttavat myös ryhmän alla oleviin objekteihin.

On tärkeää ymmärtää, että sekoitustiloja ja peittävyyttä käytetään yksittäisiin objekteihin mutta Rajaava ryhmä -asetusta ryhmään.

Ryhmä, jossa Rajaava ryhmä -asetusta ei ole valittu (vasemmalla), ja ryhmä, jossa se on valittu (oikealla)

1. Käytä sekoitustiloja ja peittävyysasetuksia objekteissa, jotka haluat rajata.

2. Valitse rajattavat objektit valintatyökalulla.

3. Valitse Objekti > Ryhmitä.

4. Valitse Tehosteet-paneelista Rajaa ryhmä. (Jos asetusta ei näy, valitse Tehosteet-paneelivalikosta Näytä asetukset.)

Väriavaruuden määrittäminen läpinäkyvien objektien sekoitusta varten

Sekoittaessaan aukeaman läpinäkyvien objektien värit InDesign muuntaa kaikkien objektien värit yhteiseen väriavaruuteen käyttämällä julkaisun
CMYK- tai RGB-väriprofiilia. Tässä sekoitustilassa useiden väriavaruuksien objektit sekoittuvat, kun läpinäkyvyydet vaikuttavat toisiinsa. Jotta
objektien eri alueiden värit eivät olisi ristiriidassa näytössä ja tulosteissa, sekoitustilaa käytetään sekä näytössä että yhdistettäessä.

Sekoitustila liitetään vain läpinäkyvyyden sisältäviin aukeamiin.

Valitse Muokkaa > Läpinäkyvyyden sekoitustila ja sitten jokin julkaisun väriavaruuksista.

tyypillisissä tulostustöissä kannattaa valita CMYK-julkaisun väriavaruus.

Lisää ohjeaiheita
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Vieminen ja julkaiseminen

Luo digitaalisia aikakauslehtiä InDesign CS5.5:llä ja Adobe Digital Publishing Suitella (video 09:06)
Terry White  (7.5.2012)
Opastus - video
Tässä videossa näet, miten voit luoda vaikuttavia digitaalisia aikakauslehtiä InDesignilla kämmenlaitteita varten.

Audio- ja videosisällön lisääminen EPUBiin (video 02:46)
Colin Fleming  (1.1.2011)
Opastus - video
Tässä video-opastusohjelmassa näytetään, kuinka yksinkertaista on lisätä ääni- ja videosisältöä InDesign CS5.5:een tai sitä uudempiin
versioihin EPUB-muodossa tapahtuvaa vientiä varten.

Sisällön viennin hallinta InDesignista EPUBiin sivuasettelua muuttamatta (video 04:54)
Colin Fleming  (1.1.2011)
Opastus - video
Opi luomaan ja järjestelemään artikkeleita Artikkelit-paneelissa EPUB-muodossa tapahtuvaa vientiä varten sivuasettelua muuttamatta tai
koodia kirjoittamatta.

Kansien ja otsikkosivujen luominen EPUBia varten (video 05:50)
Colin Fleming  (1.1.2011)
Opastus - video
Opi luomaan kansia ja otsikkosivuja EPUB-julkaisuillesi.

Tutustuminen uusiin FLA-vientivaihtoehtoihin (video 6:26)
Anne-Marie Concepcion  (1.1.2011)
Opastus - video
Katso, miten voit julkaista InDesign-projektisi erilaisissa Flash-muodoissa InDesign CS5:n ja sitä uudempien versioiden parannetun Vie-
valintaikkunan avulla.

Asiakirjojen vienti EPUB-muodossa (PDF, 265 kt)
Viittaus  (1.1.2011)
Lyhyt ja nopea yleiskatsaus siitä, miten voit viedä sivuasettelut EPUB-muodossa InDesign CS5:ssä.

Vienti EPUB-muodossa Apple iBookstorea varten (PDF, 2,5 Mt)
Viittaus  (1.1.2011)
Opi luomaan EPUB-julkaisu Apple iBook -kauppaa varten.

Objektin vientiasetusten määrittäminen (PDF, 160 kt), CS5.5 ja uudemmat
Viittaus  (1.1.2011)
Opi yksinkertaistamaan vientityönkulkua objektin vientiasetusten avulla.

EPUB-julkaisujen viennin parantaminen InDesignin nimiöihin osoitettujen tyylien avulla (video 05:13)
Colin Fleming  (1.1.2011)
Opastus - video
InDesign CS5.5:ssä ja sitä uudemmissa versioissa voit osoittaa kappale- ja merkkityylit suoraan EPUB-, HTML- ja PDF-nimiöihin
varmistaaksesi, että InDesignissa määrittämäsi tyylit viedään oikein. Voit myös lisätä CSS-luokkien nimet ja tyypit omiin mukautettuihin
nimiöihisi.

EPUB-julkaisuun vietävien objektien ja kuvien vientitavan mukauttaminen objektin vientiasetusten avulla ( video 05:18)
Colin Fleming  (1.1.2011)
Opastus - video
Objektin vientiasetusten avulla voit määrittää, miten objektit ja kuvat viedään EPUB-muotoon parhaan katselutuloksen saavuttamiseksi
missä tahansa näytössä – kokoon katsomatta.
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Sisällön vieminen EPUB-muotoon

Alkuun

Alkuun

Yleistä
Tekstin tuki
Hyperlinkkien tuki
Navigoinnin tuki
Kirjan CSS-tiedoston luominen
Vieminen EPUB-muotoon
Kiinteän asettelun vientiasetukset
Uudelleenjuoksutettavan asettelun vientiasetukset
Objektin vientiasetukset
EPUB-resurssit

Yleistä

Voit viedä InDesign-julkaisun EPUB-muotoon, jotta käyttäjät voivat tarkastella tulostetta EPUB-lukuohjelmassa.

Voit viedä julkaisun uudelleenjuoksutettavassa EPUB-muodossa. Uudelleenjuoksutettavaa EPUB-julkaisua käytettäessä EPUB-lukuohjelma pystyy
optimoimaan sisällön näyttölaitteen mukaan.

Uudelleenjuoksutettava muoto sopii paremmin käyttötarkoitukseen, jos julkaisu on tarkoitettu eInk-laitteiden käyttäjille. Uudelleenjuoksutettavaa
muotoa kannattaa käyttää myös silloin, jos haluat antaa mahdollisuuden kirjasin- ja tekstikoon muuttamiseen lukuohjelmassa.

Voit viedä julkaisut kiinteään asetteluun perustuvassa muodossa. Kiinteään asetteluun perustuvaa muotoa käytettäessä voit lisätä julkaisuihin
ääntä, videoita ja Edge-sisältöjä.

Voit viedä kiinteään asetteluun perustuvaan muotoon myös vuorovaikutteisia julkaisuja, joissa on erilaisia säätimiä, kuten navigointipainikkeita,
sivusiirtymiä, animaatioita ja hyperlinkkejä.

Kiinteään asetteluun perustuva muoto sopii paremmin julkaisuihin, joissa on paljon grafiikka-, ääni- ja videosisältöä. Tämä muoto sopii paremmin
lastenkirjoihin, keittokirjoihin, tekstikirjoihin ja sarjakuviin.

Tekstin tuki

Kiinteään asetteluun perustuvaan muotoon vietäviä julkaisuja luotaessa tuetaan seuraavia tekstivaihtoehtoja:

Tekstiä ei rasteroida. Tämä tarkoittaa, että elävä teksti on haettavissa ja valittavissa.

Elävää tekstiä voidaan skaalata pysty- ja vaakasuunnassa.

Täytemerkkejä voidaan käyttää.

Kielimääritteet on merkitty nimiöihin.

Nimiöihin on merkitty CSS-luokat.

Tekstissä olevat hyperlinkit ja ristiviittaukset URL-osoitteisiin, tekstiankkureihin ja sivuihin ovat tuettuja.

Ota myös seuraavat rajoitukset huomioon, kun lisäät tekstiä EPUB-muodossa vietäviin julkaisuihin:

Kirjainparivälistystä ei tueta yksittäisissä merkeissä, sen sijaan sanan kaikkien kirjainten välillä käytetään merkkien välistystä.

OpenType-toiminnolla luotuja vaihtoehtoisia merkkejä, kuten kapiteeleja, kokonaan isojen kirjainten käyttöä ja murtolukuja, ei tueta laitteiden rajoitetun tuen vuoksi.

Lähi-idän oikealta vasemmalle luettavia tekstikehyksiä ei vieläkään tueta oikein.
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Alkuun

Alkuun

NAV-maamerkit

EPUB 2

NAV-sivuluettelo

Alkuun

Alkuun

Japaninkielisen tekstin tuki

Sisältöä kiinteään asetteluun perustuvassa muodossa vietäessä käytettävissä ovat seuraavat japanilaiset toiminnot:

Ruby-teksti on elävää, eikä sitä rasteroida tulosteessa.
Warichua tuetaan elävässä tekstissä.
Merkkien kiertoa tuetaan elävässä tekstissä.
Yhdistelmäkirjasimet ovat tuettuja
Pystysuuntaiset tekstikehykset, myös kierretyt merkit, ovat tuettuja.

Ota seuraavat rajoitukset huomioon, kun lisäät japaninkielistä tekstiä EPUB-muodossa vietäviin julkaisuihin:

Japanilaista Tate-Chu-Yokoa ei tueta pystysuuntaisissa tekstikehyksissä.

Japanilaisten ideografisten merkkien paikka muuttuu TrueType-kirjasimia käytettäessä.

Japanilainen Kenten-kirjasin rasteroidaan elävässä tekstissä.

Hyperlinkkien tuki

Kiinteään asetteluun perustuvaan muotoon vietäviä julkaisuja luotaessa tuetaan seuraavia hyperlinkkivaihtoehtoja:

Tekstipohjaiset hyperlinkit ja ristiviittaukset

Objektipohjaiset hyperlinkit

Hyperlinkit Pagesiin sekä teksti- että objektipohjaisia hyperlinkkejä käytettäessä

Navigoinnin tuki

Vientiprosessissa voidaan hyödyntää seuraavia EPUB-julkaisujen navigointitoimintoja:

NAV-maamerkit luodaan sekä kiinteään asetteluun perustuvia että uudelleenjuoksutettavia muotoja varten Objektin
vientiasetukset -valintaikkunassa määritetyn epub:type-parametrin arvojen perusteella.

Maamerkkeihin lisätään vain arvon ensimmäinen esiintymä.

InDesign tukee OPF-tiedoston EPUB 2 -osaa. InDesign tunnistaa automaattisesti kannen ja Tulosta sisällysluettelo -toiminnon.
InDesign käyttää tekstityypin määrittämiseen Objektin vientiasetukset -valintaikkunassa määritettyjä epub:type-parametrin arvoja.

(kiinteään asetteluun perustuva muoto). InDesign luo sivuluettelon liittämällä sivunumeromerkkijonot kyseisestä sivusta luotuihin
XHTML-tiedostoihin.

Kirjan CSS-tiedoston luominen

Kun viet kirjan EPUB-muodossa, vientiprosessi luo CSS-tiedoston kirjan jokaisesta julkaisusta. Jokaisen julkaisun CSS-tiedostossa on määritetty
julkaisun yksilölliset tyylit. Prosessi luo myös CSS-perustyylitiedoston, joka sisältää kirjan julkaisuissa käytettävät yleiset tyylit.

Vieminen EPUB-muotoon
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Alkuun

Versio

EPUB 3.0

Kansi

Ei mikään

Rasteroi ensimmäinen sivu

Valitse kuva

Siirtymisen sisällysluettelo

Tiedostonimi

Monitasoinen (sisällysluettelon tyyli)

Voit viedä julkaisun tai kirjan uudelleenjuoksutettavassa tai kiinteään asetteluun perustuvassa EPUB-muodossa.

1. Tee jokin seuraavista:

Avaa julkaisu ja valitse Tiedosto > Vie.

Avaa kirja ja valitse Kirja-paneelivalikosta Vie kirja EPUBiin.

2. Määritä tiedoston nimi ja sijainti.

3. Valitse Tallennusmuoto-luettelosta EPUB (kiinteä asettelu) tai EPUB (uudelleenjuoksutettava) ja sitten Tallenna.

4. Määritä haluamasi asetukset EPUB-vientiasetukset-valintaikkunassa ja valitse OK.

Lisätietoja on artikkelissa Kiinteän asettelun vientiasetukset tai Uudelleenjuoksutettavan asettelun vientiasetukset.

InDesign luo yhden .epub-tiedoston, joka sisältää XHTML-sisällön. Tiedoston katselemista varten tarvitset EPUB-lukuohjelmiston. Voit myös
käyttää Adobe Digital Editions -lukuohjelmistoa, jonka voit ladata ilmaiseksi Adoben sivustosta.

.epub-tiedosto on .zip-tiedosto. Voit tarkastella ja muokata .EPUB-tiedoston sisältöä vaihtamalla tiedostotunnisteeksi .zip ja purkamalla sisällön.
Tämä on kätevää esimerkiksi CSS-tiedoston muokkaamista varten.

Vietävä .epub-tiedosto voi sisältää kansikuvan. Voit valita kantena käytettävän kuvan. Voit myös antaa InDesignin rasteroida viedyn julkaisun
ensimmäisen sivun, tyylilähdejulkaisun tai viedyn kirjan. Pienoiskuva näytetään EPUB-lukuohjelmistoissa tai Digital Editions Reader -
kirjastonäkymässä.

Kiinteän asettelun vientiasetukset

Yleinen osa

EPUB-versio. 

Tukee ääntä, videota, Javascriptiä ja japaninkielistä pystysuuntaista tekstiä.
Sitä ei kuitenkaan tueta laitteissa, jotka eivät tue EPUB 3.0 -standardia.
EPUB 3.0 on hyväksytty standardi (IDPF, 2011).

eKirjan kansikuva. Valitse yksi seuraavista:

Kansikuvaa ei lisätä.

Valitse tämä asetus, jos haluat antaa InDesignin luoda kuva rasteroimalla eKirjan ensimmäinen sivu ja
käyttämällä sitä kantena.

Valitse kantena käytettävä kuvatiedosto tietokoneesta.

Määritä navigointiasetus EPUB-katseluohjelman sisällysluetteloa varten.
Luo navigoinnin sivupalkki monitasoisen sisällysluettelon tyylin avulla tai käytä tiedostonimeä.

Luo tiedostonimiin perustuva sisällysluettelo.

Luo valittuun sisällysluettelon tyyliin perustuva sisällysluettelo.
Määritä Sisällysluettelon tyyli -valikossa eKirjan sisällysluettelon luontiin käytettävä sisällysluettelon tyyli.
Voit luoda eKirjalle yksilöllisen sisällysluettelon tyylin valitsemalla Sivuasettelu > Sisällysluettelon tyylit.
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Kirjanmerkit

Asetukset

Asiakirjan määrittelyn mukaan

Muunna aukeama vaakasivuksi

Ota synteettiset aukeamat käyttöön

Poista aukeamat käytöstä

Muoto

Automaattinen

PNG

Tarkkuus (PPI)

GIF-asetukset (paletti)

Sovitettu (ei sirontaa)

Web

Järjestelmä (Win) tai Järjestelmä (Mac)

Lomita

JPEG-asetukset > Muotoilumenetelmä

Etenevä

(EPUB 3) Luo sisällysluettelo InDesign-julkaisussa luotujen kirjanmerkkien perusteella.
InDesign tukee paikallisia tai ulkoisia tekstiankkureita ja sivuja (eKirjasta). Jälkimmäinen voidaan luoda luomalla sisällysluettelo
InDesignissa ja määrittämällä Luo PDF-kirjanmerkit -asetus.
Lisätietoja on artikkelissa Kirjanmerkit.

Määritä sivuelementtien vientijärjestys.

InDesign määrittää aukeaman hallinnan Asiakirjan määrittely -valintaikkunassa (Tiedosto > Asiakirjan
määrittely) määritettyjen asetusten perusteella.

Muuntaa aukeaman vaakasuuntaiseksi.

Ota synteettiset aukeamat vietävässä julkaisussa käyttöön.

Yhtäkään aukeamaa ei viedä EPUB-muodossa.

Muunnosasetukset-osa

Määritä Kuvien muuntaminen -valikossa, miten kuvat viedään EPUB-muotoon.

Valitse, muunnetaanko julkaisussa olevat optimoidut kuvat GIF-, JPEG- tai PNG-muotoon.

Anna InDesignin päättää, mitä muotoa kussakin tapauksessa käytetään.

Poista kuvien pakkausasetukset käytöstä. Käytä PNG-asetusta häviöttömiin tai läpinäkyviin kuviin.

Valitse kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi, mobiililaitteissa
tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). 
Voit valita kullekin valitulle objektille ppi-arvon. Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.

Luo paletti käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla.

Luo paletti verkkokäyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -järjestelmävärien osajoukko.

Luo paletti käyttämällä järjestelmän omaa väripalettia. Tämä asetus voi aiheuttaa
odottamattomia tuloksia.

Lataa kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta ja
selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määritä, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
selaimessa.

Anna JPEG-kuvien avautua vähitellen ja tarkentua verkkoselaimen ladatessa niitä.
Tällä asetuksella luodut tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.
Valitse Peruslinja, jos haluat kunkin JPEG-tiedoston tulevan näyttöön vasta silloin, kun se on ladattu. Näytössä näkyy paikkamerkki,
kunnes kuva on ladattu.
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Peruslinja

JPEG-asetukset > Kuvan laatu

Näytä EPUB viennin jälkeen

Tunniste

Otsikko

Tekijä

Päiväys

Kuvaus

Julkaisija

Tuo kukin JPEG-tiedosto näyttöön vasta silloin, kun se on ladattu.
Näytössä näkyy paikkamerkki, kunnes kuva on ladattu.

Valitse tulosteen kunkin JPEG-kuvan toivottu kuvan laatu.
Valitse Matala, jos haluat tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.

EPUB – Kiinteän asettelun vientiasetukset -valintaikkunan Katselusovellukset-valintaikkuna sisältää seuraavat asetukset:

EPUB avautuu EPUB-tiedostojen lukemiseen valitussa oletussovelluksessa, jos sellainen on käytettävissä.
Koskee sekä Uudelleenjuoksutettavan asettelun vientiasetukset- että Kiinteän asettelun vientiasetukset -valintaikkunaa.

Metatiedot-osa

Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon.

(Vain luku) Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Ohjelmisto luo ja näyttää automaattisesti ainutkertaisen
tunnisteen.

Anna EPUB-tiedoston nimi.

Anna EPUB-tiedoston tekijän nimi.

Määritä EPUB-tiedoston luontipäivä.

Anna EPUB-tiedoston kuvaus.

Määritä tässä eKirjan metatietoihin sisällytettävät julkaisijatiedot. Voit esimerkiksi määrittää julkaisijan URL-osoitteen.

EPUB-sovellus  Versio  Tuettu Ei tuettu

Mac

Apple iBooks 1.0.1 Kyllä  

Oxygen 14.1 Kyllä  

Kindle Previewer 2.92 Kyllä  

Sigil 0.7.4 Kyllä  

Kindle 1.10.6  Ei

VitalSource Bookshelf 6.2  Ei

Apple Book Proofer 1.0.1 Ei tue upotettuja kirjasimia sisältäviä EPUB-julkaisuja.

Windows

Sigil 0.7.4 Kyllä  

Kindle Previewer 2.92 Kyllä  

Adobe Digital Editions 3.0.86137 Kyllä  

Calibre 1.26 Kyllä  

Oxygen 15 Kyllä  

Azardi 2.0 Kyllä  

Kobo 3.6.0  Ei
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Oikeudet

Aihe

Lisää tyyliarkki

Poista

JavaScript

Alkuun

Versio

EPUB 2.0.1

EPUB 3.0

Kansi

Ei mikään

Rasteroi ensimmäinen sivu

Valitse kuva

Siirtymisen sisällysluettelo

Tiedostonimi

Monitasoinen (sisällysluettelon tyyli)

Järjestys

Sivuasettelun perusteella

Kirjoita tekijänoikeustiedot tänne.

Anna EPUB-tiedoston aihe.

CSS-osa

Määritä EPUB-julkaisun viennissä käytettävän, olemassa olevan CSS-tyyliarkin URL-osoite.
InDesign ei tarkista, onko CSS olemassa tai kelvollinen. Dreamweaverin avulla voit vahvistaa ulkoisen CSS-tyyliarkin määritykset.

Poista valittu tyyliarkki

Javascript-osa

Määritä olemassa olevan JavaScriptin URL-osoite. InDesign ei tarkista, onko JavaScript olemassa tai kelvollinen, joten vahvista
ulkoisen JavaScriptin asetukset.

Uudelleenjuoksutettavan asettelun vientiasetukset

Yleinen osa

Määritä EPUB-versio. 

EPUB 2.0.1 on IDPF:n standardi (hyväksytty vuonna 2007). Tätä muotoa tuetaan erilaisissa mobiililaitteissa.

EPUB 3.0 on IDPF:n standardi (hyväksytty vuonna 2011). Tämä muoto tukee myös ääntä, videota, Javascriptiä ja
japaninkielistä pystysuuntaista tekstiä. Se ei kuitenkaan toimi lukuohjelmissa ja laitteissa, jotka eivät tue EPUB 3.0 -standardia.

Määrittää eKirjan kansikuvan. Valitse yksi seuraavista:

Kansikuvaa ei lisätä.

Valitse tämä asetus, jos haluat antaa InDesignin luoda kuva rasteroimalla eKirjan ensimmäinen sivu ja
käyttämällä sitä kantena.

Valitse kantena käytettävä kuvatiedosto tietokoneesta.

Määritä navigointiasetus EPUB-katseluohjelman sisällysluetteloa varten.
Luo navigoinnin sivupalkki monitasoisen sisällysluettelon tyylin avulla tai käytä tiedostonimeä.

Luo tiedostonimiin perustuva sisällysluettelo.

Luo valittuun sisällysluettelon tyyliin perustuva sisällysluettelo. Määritä Sisällysluettelon tyyli -
valikossa eKirjan sisällysluettelon luontiin käytettävä sisällysluettelon tyyli. Voit luoda eKirjalle yksilöllisen sisällysluettelon tyylin valitsemalla
Sivuasettelu > Sisällysluettelon tyylit.

Määritä sivuelementtien vientijärjestys.

Lukemisjärjestys määräytyy sivulla olevien kohteiden sijainnin perusteella.
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Sama kuin XML-rakenne

Sama kuin artikkelipaneelissa

Alaviitteet

Asetukset > Poista pakotetut rivinvaihdot

Luettelot > Luettelomerkit

Luettelot > Numerot

Osoita järjestettyihin luetteloihin

Muunna tekstiksi

Säilytä sivuasettelun ulkoasu

Muunnosasetukset > Tarkkuus (ppi)

CSS > Asettelu

CSS > Lisää sivunvaihto

Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä
alas. Joissakin tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, muotoiluelementit eivät aina ole halutussa
lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
(Vain aasialaiset versiot) Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen julkaisun sidonnan
mukaan (vasemmalta oikealle tai oikealta vasemmalle). Joissakin tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, viedyt
muotoiluelementit eivät ole halutussa lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.

Lukemisjärjestys määräytyy rakennenäkymässä olevien nimiöiden järjestyksen perusteella. Katso Sivukohteiden
nimiöiminen.

Lukemisjärjestys määräytyy Artikkelit-paneelissa olevien elementtien järjestyksen perusteella. Vain valitut
artikkelit viedään. Katso Artikkeleiden sisällyttäminen vientiä varten.

Teksti-osa

Valitse alaviitteiden paikka seuraavista vaihtoehdoista.
Kappaleen jälkeen: Valitse tämä vaihtoehto, jos haluat sijoittaa alaviitteet kappaleen jälkeen.
Osan lopussa (loppuviitteinä): Valitse tämä vaihtoehto, jos haluat muuntaa alaviitteet loppuviitteiksi.
Ponnahdusikkunassa (EPUB3): Valitse tämä vaihtoehto, jos haluat sijoittaa alaviitteen ponnahdusikkunaan.

Jos lisäät alaviitteen julkaisun alaviitetoiminnolla ja määrität säännön, esimerkiksi paksuudeksi 10 pistettä, tätä vaakasuuntaista sääntöä tuetaan
uudelleenjuoksutettavia EPB-tiedostoja vietäessä.

Poista viedystä eKirjasta kaikki pakotetut rivinvaihdot.

Valitse Osoita järjestämättömiin luetteloihin, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohde-elementeiksi,
jotka muotoillaan HTML-muotoon <ul>-nimiöllä.
Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä. Jos olet käyttänyt InDesignin alkuperäisiä automaattisia
luettelomerkkejä, myös aliluettelomerkit sisällytetään.

Määrittää, kuinka numerot muunnetaan HTML-tiedostossa. Jos olet käyttänyt InDesignin alkuperäistä automaattista
numerointia, myös aliluettelomerkit sisällytetään.

Muunna numeroidut luettelot luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.

Muunna numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

Objekti-osa

Määritä Kuvien muuntaminen -valikossa, kuinka kuvat viedään HTML-muotoon.

Valitse tämä vaihtoehto, jos haluat käyttää sivuasettelussa olevia kuvaobjektien määritteitä.

Valitse kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi,
mobiililaitteissa tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). Voit valita kullekin valitulle objektille
ppi-arvon. Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Määritä kuvan tasaus: vasemmalle, keskelle tai ylös. Voit myös määrittää tasauksen ylös tai alas.

Lisää kuviin sivunvaihtoja. Sivunvaihtoja voidaan lisätä Ennen kuvaa-, Kuvan jälkeen- tai Ennen kuvaa ja kuvan jälkeen
-asetusten avulla.

718

http://idiom-q-win-1/fi/indesign/using/structuring-pdfs.html#tag_page_items
http://idiom-q-win-1/fi/indesign/using/structuring-pdfs.html#tag_page_items
http://idiom-q-win-1/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html


Muoto

GIF-asetukset (paletti)

Sovitettu (ei sirontaa)

Web

Järjestelmä (Win) tai Järjestelmä (Mac)

Lomita

JPEG-asetukset > Muotoilumenetelmä

Etenevä

Peruslinja

JPEG-asetukset > Kuvan laatu

Ohita objektin vientiasetukset

Tunniste

Otsikko

Tekijä

Päiväys

Kuvaus

Muunnosasetukset -osa

Voit valita, muunnetaanko julkaisun optimoidut kuvat GIF-, JPEG- tai PNG-muotoon. Valitse Automaattinen, jos haluat, että InDesign
päättää, mitä muotoa kussakin tapauksessa käytetään. PNG-asetuksen valinta poistaa kuvien pakkausasetukset käytöstä. Käytä PNG-asetusta
häviöttömiin tai läpinäkyviin kuviin.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.

Luo paletti käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla.

Luo paletti verkkokäyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -järjestelmävärien osajoukko.

Luo paletti käyttämällä järjestelmän omaa väripalettia. Tämä asetus voi aiheuttaa
odottamattomia tuloksia.

Lataa kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta ja
selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määritä, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
selaimessa.

Anna JPEG-kuvien avautua vähitellen ja tarkentua verkkoselaimen ladatessa niitä.
Tällä asetuksella luodut tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.
Valitse Peruslinja, jos haluat kunkin JPEG-tiedoston tulevan näyttöön vasta silloin, kun se on ladattu. Näytössä näkyy paikkamerkki,
kunnes kuva on ladattu.

Tuo kukin JPEG-tiedosto näyttöön vasta silloin, kun se on ladattu.
Näytössä näkyy paikkamerkki, kunnes kuva on ladattu.

Valitse tulosteen kunkin JPEG-kuvan toivottu kuvan laatu.
Valitse Matala, jos haluat tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.

Ohittaa yksittäisiin kuviin käytetyt objektin vientiasetukset. Katso Objektin vientiasetusten käyttäminen.

Metatiedot-osa

Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon. EPUB – Uudelleenjuoksutettavan asettelun
vientiasetukset -valintaikkunan Metatiedot-osa sisältää seuraavat asetukset:

(Vain luku) Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Ohjelmisto luo ja näyttää automaattisesti ainutkertaisen
tunnisteen.

Anna EPUB-tiedoston nimi.

Anna kiinteään asetteluun perustuvan EPUB-tiedoston tekijän nimi.

Määritä EPUB-tiedoston luontipäivä.

Anna EPUB-tiedoston kuvaus.
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Julkaisija

Oikeudet

Aihe

Luo CSS

Säilytä paikalliset ohitukset

Sisällytä upotettavat kirjasimet

Lisää tyyliarkki

JavaScript

Alkuun

Oletus

Käytä graafisissa objekteissa aiemmin luotua kuvaa

Rasteroi säilö

Rasteroi sisältö

Anna julkaisijan tiedot, kuten julkaisijan URL-osoite.

Anna EPUB-tiedoston tekijänoikeustiedot.

Anna EPUB-tiedoston aihe.

CSS-osa

CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun verkkosivulla. Kun käytät sivun
muotoiluun CSS:ää, erotat sisällön esityksestä. EPUB – Uudelleenjuoksutettavan asettelun vientiasetukset -valintaikkunan CSS-osa sisältää
seuraavat asetukset:

Määritä, haluatko InDesignin luovan vientitiedostolle ulkoisen CSS-tyyliarkin. Jos julkaisu/kirja viedään EPUB-muotoon ilman
CSS-tyyliarkin luomista, ainoastaan tyyleihin liitetyt luokat merkitään HTML-nimiöihin. Ohittavia luokkia ei luoda.

Sisällytä paikallinen muotoilu, kuten kursivoitu tai lihavoitu.

Sisällytä kaikki upotettavat kirjasimet eBook-kirjaan. Kirjasimissa on upotusbitit, jotka määrittävät,
voidaanko kirjasin upottaa.

Määritä olemassa olevan CSS-tyyliarkin URL-osoite. InDesign ei tarkista, onko CSS olemassa tai kelvollinen.
Dreamweaverin avulla voit vahvistaa ulkoisen CSS-tyyliarkin määritykset.

JavaScript -osa

Määritä olemassa olevan JavaScriptin URL-osoite. InDesign ei tarkista, onko JavaScript olemassa tai kelvollinen, joten vahvista
ulkoisen JavaScriptin asetukset.

Objektin vientiasetukset

Määritä Objektin vientiasetukset -valintaikkunan asetusten avulla, kuinka julkaisun objekteja käsitellään EPUB-viennin aikana.

1. Avaa Objektin vientiasetukset-valintaikkuna (Objekti > Vientiasetukset) ja siirry EPUB- ja HTML-osaan.

2. Valitse jokin seuraavista Säilytä sivuasettelun ulkoasu -luettelon asetuksista:

Objektin käsittelytapa määräytyy Vie-valintaikkunan asetusten perusteella.
Uudelleenjuoksutettavan muodon tapauksessa tätä hallitaan Muunnos-välilehden asetuksilla.

Jos objekti sisältää kuvan ja EPUB-vienti tukee kuvaa (JPG, PNG, GIF), säilön tyyli
määritetään CSS-tiedoston perusteella, eikä kuvaa käsitellä.

Tämä toiminto vastaa Uudelleenjuoksutettavan asettelun vienti/muunnos -osan Säilytä sivuasettelun ulkoasu -toimintoa.
Koko objekti rasteroidaan, joten sen ulkoasu säilyy.
Jos objekti on tekstikehys, teksti ei enää ole elävä.

Objektin sisältö rasteroidaan, joten objektin tai säilön tyyliä ei enää hallita CSS-tyyliarkilla, eikä objekti ehkä näy kokonaan
samalla tavalla kuin InDesignissa.

3. (Uudelleenjuoksutettava EPUB) Valitse jokin seuraavista Koko-luettelon asetuksista, jos haluat säilyttää sisäistä kiinteää sisältöä sisältämättömän objektin, kuten

kuvan, kuvasuhteen:
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Ei mikään

Oletus

Kiinteä

Suhteessa tekstijuoksutukseen

Suhteessa tekstin kokoon

Mukautettu leveys/korkeus

Huomautus:

Huomautus:

Alkuun

Objektin perusteella määritetylle nimiölle ei luoda CSS-tiedoston mukaista leveyttä tai korkeutta. Objektin koko määräytyy
sisäisen sisällön perusteella CSS-sääntöjen mukaan, kuvasuhdetta ei säilytetä.

CSS-tiedoston koko määräytyy Vie-valintaikkunan Objekti-välilehden asetusten perusteella.

CSS-tiedoston koko määritetään laskemalla objektin koko pisteinä ja antamalla samat mitat CSS-tiedostossa kuvapisteinä. Objektin
kuvasuhde säilytetään.

CSS-tiedoston leveys määritetään mittaamalla objektin leveys ja ilmaisemalla se prosentteina suhteessa
tekstijuoksutuksen sisältävän tekstikehyksen leveyteen. Objektin kuvasuhde säilytetään.

CSS-tiedoston korkeus määritetään mittaamalla objektin korkeus pisteinä ja muuntamalla se em-väliksi
kertoimella 12 pistettä / em-väli. Objektin kuvasuhde säilytetään.

Kelvollisia CSS-yksiköitä ovat cm, mm, in, pt, %, px, vh, vw, vmin ja vmax. Objektin kuvasuhde säilytetään.

Nämä asetukset eivät koske pääjuoksutuksen tekstikehyksiä.

Edge Animaten sisältävät objektit eivät tue suhteellisia mittoja.

EPUB-resurssit

Seuraavia linkkejä napsauttamalla voit perehtyä EPUB-muotoon.

Lisätietoja EPUB-määrityksestä on sivustossa www.idpf.org.

Lataa ilmainen Digital Editions -lukuohjelmisto osoitteesta www.adobe.com/fi/products/digital-editions.html.

Lisätietoja Digital Editionsista löytyy Digital Editions -blogista.

Lisätietoja viennistä Kindleen on julkaisussa InDesignista Kindleen (PDF).

Opi muuntamaan InDesign-tiedostot EPUB-muotoon ja aloita Apple iPadilla katseltavissa olevien sähköisten kirjojesi myynti. Lisätietoa on white paper -julkaisussa.

Perehdy White paper -julkaisuun InDesignista iPadiin.
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Sisällön vieminen HTML-muotoon

Vietävät kohteet

Viemättä jäävät kohteet

Vieminen

Sisällön järjestys

HTML-muotoon vieminen on helppo tapa saada InDesign-sisältö internetvalmiiseen muotoon. Kun viet sisältöä XHTML-muotoon, voit valita, miten
teksti ja kuvat viedään. InDesign säilyttää viedyssä sisällössä käytettyjen kappale-, merkki-, objekti-, taulukko- ja solutyylien nimet merkitsemällä
HTML-sisällön samannimisillä CSS-tyyliluokilla. Adobe Dreamweaverillä tai muulla CSS-yhteensopivalla HTML-editorilla voit nopeasti ottaa
sisällössä käyttöön muotoiluja sekä asetteluja.

InDesign vie kaikki jutut, linkitetyt ja upotetut kuvat, SWF-elokuvatiedostot, alaviitteet, tekstimuuttujat (tekstinä), luettelomerkityt
ja numeroidut luettelot, sisäiset ristiviittaukset sekä tekstiin tai verkkosivuille siirtävät hyperlinkit.
Taulukot voidaan viedä myös HTML-muodossa. InDesign säilyttää taulukon muotoilun, kuten taulukon ja solun viivat. Taulukoille annetaan
yksilöivät tunnisteet, ja niihin voidaan viitata Spry-tietojoukkoina Dreamweaverissa. Sijoitetut audio- ja h.264-videotiedostot sisällytetään HTML5
<audio>- ja <video>-nimiöihin. InDesign vie myös piirtämäsi objektit (kuten suorakulmiot, soikiot ja monikulmiot), liitetyt objektit (myös liitetyt
Illustrator-kuvat) ja ääriviivoiksi muunnetun tekstin.

InDesign ei vie hyperlinkkejä (paitsi verkkosivujen linkkejä ja tekstilinkkejä, jotka siirtävät saman julkaisun
tekstiankkureihin), XML-nimiöitä, kirjoja, kirjanmerkkejä, SING-glyyfejä, sivun siirtymiä, hakemistomerkkejä, taittopöydän kohteita, joita ei ole valittu
ja jotka eivät koske sivua, eikä sivupohjakohteita (ellei niitä korvata tai valita ennen vientiä).

1. Jos et aio viedä koko julkaisua, valitse vietävät tekstikehykset, tekstialue, taulukkosolut tai grafiikka.

2. Valitse Tiedosto > Vie ja valitse sitten HTML Tallenna nimellä -luettelosta.

3. Määritä HTML-julkaisun nimi ja sijainti ja valitse Tallenna.

4. Määritä haluamasi asetukset HTML-vientiasetukset-valintaikkunan Yleiset-, Kuva- ja Lisäasetukset-kohdissa ja valitse sitten OK.

Ohjelma luo julkaisun käyttämällä määritettyä nimeä sekä .html-tunnistetta (kuten uutiskirje.html). Jos verkkokuvien alikansio (kuten
uutiskirjeen_verkkokuvat) on määritetty, se tallennetaan samaan sijaintiin.

HTML-vientiasetukset

Määritä HTML-valintaikkunaan seuraavat asetukset.

Yleiset asetukset

Yleiset-alue sisältää seuraavat asetukset.

Määrittää, viedäänkö koko julkaisu vai vain valitut kohteet. Jos valittuna on tekstikehys, koko juttu, mukaan lukien ylijuokseva teksti,
viedään.
Jos valitset julkaisun, viedään kaikkien aukeamien kaikki sivukohteet lukuun ottamatta näkymättömien tasojen sivukohteita sekä sivupohjakohteita,
joita ei ole ohitettu. Myös XML-nimiöt ja luodut hakemistot ja sisällysluettelot ohitetaan.

Voit määrittää sivuobjektien lukemisjärjestyksen.
Sivuasettelun perusteella
Lukemisjärjestys määräytyy sivulla olevien kohteiden sijainnin perusteella.
Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä
alas. Joissakin tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, muotoiluelementit eivät aina ole halutussa
lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
(Vain aasialaiset versiot) Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen julkaisun sidonnan
mukaan (vasemmalta oikealle tai oikealta vasemmalle).
Sama kuin XML-rakenne
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Muotoiluasetukset

Luettelomerkit

Numerot

Näytä HTML viennin jälkeen

Kuvien kopiointi

Alkuperäinen

Optimoitu

Palvelinpolun linkki

Säilytä sivuasettelun ulkoasu

Tarkkuus (ppi)

Kuvan koko

Kuvan tasaus ja välistys

Kuvan muuntaminen

GIF-asetukset (paletti)

Jos valitset Sama kuin XML-rakenne, XML-rakennepaneeli määrää viedyn sisällön järjestyksen ja sen, mitä sisältöä viedään. Jos sisältö on
jo nimiöity, voit vain vetää nimiöitä XML-rakenne-paneeliin ja asettaa XHTML:n vientijärjestyksen. Jos sisältöä ei ole nimiöity, voit valita
Lisää nimiöimättömät kohteet Rakenne-paneelista ja tuottaa nimiöt, jotka voit sitten järjestää uudelleen. Jos haluat ohittaa viennissä jonkin
tietyn kohteen, voit vain poistaa nimiön XML-rakenne-paneelista. (Nimiön poistaminen ei poista sisältöä INDD-tiedostosta.) Katso
Sivukohteiden nimiöiminen.
Sama kuin artikkelipaneelissa
Lukemisjärjestys määräytyy Artikkelit-paneelissa olevien elementtien järjestyksen perusteella. Vain valitut artikkelit viedään. Katso
Artikkeleiden sisällyttäminen vientiä varten.

Valitse luettelomerkkien ja numeroinnin muotoiluasetukset.

Valitse Osoita järjestämättömiin luetteloihin, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohde-elementeiksi,
jotka muotoillaan HTML-muotoon nimiöllä. Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi nimiöllä. Jos olet käyttänyt
InDesignin alkuperäisiä automaattisia luettelomerkkejä, myös aliluettelomerkit sisällytetään.

Määrittää, kuinka numerot muunnetaan HTML-tiedostossa. Jos olet käyttänyt InDesignin alkuperäistä automaattista numerointia,
myös aliluettelomerkit sisällytetään..

Osoita järjestettyihin luetteloihin: Muuntaa numeroidut luettelot luettelokohteiksi, jotka muotoillaan HTML-muotoon nimiöllä.
Muunna tekstiksi: Muuntaa numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

Käynnistää selaimen, jos käytettävissä.

Kuva-asetukset

Määritä, miten kuvat viedään HTML-muotoon.

Vie alkuperäisen kuvan <document_name>-web-images -alikansioon. Kun tämä asetus on valittuna, muita asetuksia ei voi
valita.

Voit asetuksia muuttamalla määrittää, kuinka kuva viedään.

Tällä asetuksella kuvia ei viedä alikansioon, vaan niille annetaan paikallinen URL-osoite (esimerkiksi "kuvat/"), joka
näkyy kuvatiedoston edessä. Linkkimäärite näyttää määrittämäsi reitin ja tunnisteen HTML-koodissa. Tämä asetus on erityisen tehokas,
kun olet itse muuntamassa kuvia internetyhteensopiviksi kuviksi.

Valitse tämä vaihtoehto, jos haluat käyttää sivuasettelussa olevia kuvaobjektien määritteitä.

Valitse kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi, mobiililaitteissa
tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). Voit valita kullekin valitulle objektille ppi-arvon.
Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Määritä, käytetäänkö kiinteää kuvakokoa vai suhteutetaanko se sivulla olevaan tekstiin. Suhteessa tekstijuoksutukseen -asetus
määrittää suhteellisen prosenttiarvon InDesign-sivuleveyteen suhteutetun tekstijuoksutuksen perusteella. Tätä asetusta käytettäessä kuvat
skaalataan suhteessa lukualueen tekstiin.

Määritä kuvan tasaus: vasemmalle, keskelle tai ylös. Voit myös määrittää tasauksen ylös tai alas.

Voit valita, muunnetaanko dokumentin optimoidut kuvat GIF-, JPEG- tai PNG-muotoon. Valitse Automaattinen, jos haluat,
että InDesign päättää, mitä muotoa kussakin tapauksessa käytetään. PNG-asetuksen valinta poistaa kuvien pakkausasetukset käytöstä.Käytä
PNG-asetusta häviöttömiin tai läpinäkyviin kuviin.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.
Valitse Sovitettu (ei sirontaa), jos haluat luoda paletin käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia
pieniä väripisteitä sekoittamalla. Valitse Web, jos haluat muodostaa paletin Web-käyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

JPEG-asetukset (kuvan laatu)

JPEG-asetukset (muotoilumenetelmä)

Ohita objektin vientiasetukset

CSS-asetukset

Luo CSS

Lisää tyyliarkki

JavaScript-asetukset

järjestelmävärien osajoukko. Valitse Järjestelmä (Win) tai Järjestelmä (Mac), jos haluat luoda paletin käyttämällä järjestelmän omaa väripalettia.
Tämä valinta voi aiheuttaa odottamattomia tuloksia.
Valitse Lomita, jos haluat ladata kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta
ja selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määrittää kullekin JPEG-kuvalle tilanteeseen parhaiten sopivan pakkauksen (pienemmät tiedostokoot) ja kuvan
laadun. Matala-asetus tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.

Määrittää, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
verkkosivulla. Valitse Etenevä, jos haluat JPEG-kuvien avautuvan vähitellen ja tarkentuvan Web-selaimen ladatessa niitä. (Tällä asetuksella luodut
tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.) Valitse Perusviiva, jos haluat, että kukin JPEG-tiedosto näkyy
vasta latauksen päätyttyä. Tiedoston paikalla on latauksen aikana paikkamerkki.

Ohittaa yksittäisiin kuviin käytetyt objektin vientiasetukset. Katso Objektin vientiasetusten käyttäminen.

Lisäasetukset

Määritä CSS- ja JavaScript-asetukset Lisäasetukset-kohdassa.

CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun verkkosivulla. Kun
käytät sivun muotoiluun CSS:ää, erotat sisällön esityksestä. Sivun sisältö (HTML-koodi) sijaitsee itse HTML-tiedostossa ja koodin esityksen
määrittävät CSS-säännöt puolestaan sijaitsevat toisessa tiedostossa (ulkoisessa tyyliarkissa) tai HTML-julkaisun sisällä (tavallisesti Otsikko-
osiossa). Voit esimerkiksi määrittää valitulle tekstille eri kirjasinkokoja ja käyttää CSS:ää määrittämään Web-sivun lohkotason elementtien muodon
ja sijoittelun.

Määritä, haluatko InDesignin luovan vientitiedostolle CSS-tyyliarkin. Jos valitset Luo CSS -asetuksen, voit myös valita Säilytä
paikalliset ohitukset -asetuksen, jos haluat sisällyttää paikalliset muotoilut, kuten kursivoinnin ja lihavoinnin.

Määritä olemassa olevan CSS-tyyliarkin URL-osoite (yleensä suhteellinen URL-osoite, esimerkiksi "/styles/style.css").
InDesign ei tarkista, onko CSS olemassa tai kelvollinen. Dreamweaverin avulla voit vahvistaa ulkoisen CSS-tyyliarkin määritykset.

Valitse Lisää komentosarja, jos haluat suorittaa JavaScript-komentosarjan, kun HTML-sivu avataan. InDesign ei tarkista,
onko JavaScript olemassa tai kelvollinen.
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Vieminen Adobe PDF -muotoon

Alkuun

Alkuun

Tietoja Adobe PDF -tiedostoista
Vieminen PDF-muotoon tulostamista varten
Adobe PDF -esimääritykset
Adobe PDF -esimääritysten mukauttaminen
Adobe PDF -esimääritysten lataaminen
Taustatehtäväpaneeli

Tietoja Adobe PDF -tiedostoista

PDF (Portable Document Format) on yleistiedostomuoto, joka säilyttää useilla eri sovelluksilla ja monissa käyttöympäristöissä luotujen
lähdejulkaisujen kirjasimet, kuvat ja sivuasettelun. Adobe PDF on turvallisten ja luotettavien sähköisten julkaisujen ja muotojen jakelustandardi
kaikkialla maailmassa. Adobe PDF -tiedostot ovat pienikokoisia ja käyttövalmiita, ja kuka tahansa maksutonta Adobe Reader® -ohjelmaa käyttävä
henkilö voi jakaa, katsoa ja tulostaa niitä.

Adobe PDF on erittäin tehokas työnkulkujen tulostamisessa. Tallentamalla yhdistelmän kuvasta Adobe PDF -tiedostona luot pienikokoisen ja
luotettavan tiedoston, jota sinä ja tulostuspalvelusi voitte tarkastella, muokata, järjestää ja tarkistaa. Sitten tulostuspalvelu voi sopivassa työnkulun
vaiheessa tulostaa Adobe PDF -tiedoston suoraan tai käsitellä sitä tarvittavilla työkaluilla esimerkiksi esitarkastusta, lihotusta, asemointia ja
värierottelua varten.

Kun tallennat Adobe PDF -muodossa, voit halutessasi luoda PDF/X-yhteensopivan tiedoston. PDF/X (Portable Document Format Exchange) on
Adobe PDF -osajoukko, joka jättää pois monia väri-, kirjasin- ja lihotusmuuttujia, jotka aiheuttavat tulostusongelmia. PDF/X-standardia voi käyttää,
kun PDF-tiedostoja vaihdetaan digitaalisina sivupohjina tulostusta varten työnkulun luomis- tai tulostusvaiheessa, kun sovellukset ja tulostuslaitteet
tukevat PDF/X-standardia.

Adobe PDF -asiakirjoilla voidaan ratkaista seuraavia sähköisiin asiakirjoihin liittyviä ongelmia:

Vieminen PDF-muotoon tulostamista varten

Voit viedä julkaisun tai kirjan Adobe PDF -muotoon helposti käyttäen laadukkaan tulostuksen oletusasetuksia tai työhösi soveltuvia, mukautettuja
asetuksia. Määritetyt Adobe PDF -vientiasetukset tallentuvat sovellukseen ja koskevat kaikkia uusia Adobe PDF -muotoon vietävä InDesign-
julkaisuja ja -kirjoja, kunnes niitä muutetaan uudelleen. Voit käyttää mukautettuja asetuksia Adobe PDF -tiedostoissa nopeasti oletusarvojen avulla.

Yleinen ongelma Adobe PDF -ratkaisu

Vastaanottajat eivät pysty avaamaan tiedostoja, koska heillä
ei ole tiedostojen luomisessa käytettyjä sovelluksia.

PDF-tiedoston voi avata kuka tahansa missä tahansa.
Tarvitaan vain ilmainen Adobe Reader -ohjelmisto.

Yhdistetyistä paperien ja sähköisen materiaalin arkistoista
etsiminen on vaikeaa, ne vievät tilaa ja vaativat sovelluksen,
jolla asiakirja luotiin.

PDF-tiedostot ovat pienikokoisia, niissä voi suorittaa
sanahakuja ja niitä voi käyttää milloin tahansa Adobe
Readerilla. Siirtyminen PDF-dokumentissa on helppoa ja
nopeaa linkkien avulla.

Dokumenttien näyttäminen kämmentietokoneissa ei onnistu. Koodimerkittyjen PDF-tiedostojen teksti voidaan juoksuttaa
uudelleen näytettäväksi mobiiliympäristöissä, kuten Palm
OS®-, Symbian™- ja Pocket PC® -laitteissa.

Heikkonäköiset eivät pysty lukemaan monimutkaisia
muotoiluja sisältäviä asiakirjoja.

Koodimerkityt PDF-tiedostot sisältävät sisältö- ja
rakennetietoja, joiden avulla näytönlukulaitteet voivat käyttää
niitä.
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Huomautus:

Voit viedä julkaisun, kirjan tai kirjasta valitut julkaisut samaan PDF-tiedostoon. Voit myös kopioida tietoja InDesign-asettelusta leikepöydälle ja
luoda niistä automaattisesti Adobe PDF -tiedoston. (Näin voit helposti liittää PDF-tiedoston toiseen sovellukseen, kuten Adobe Illustratoriin.)

Kun viet InDesign-tiedoston PDF-muotoon, voit säilyttää navigointiosat, kuten sisällysluettelo- ja hakemistotekstit, sekä vuorovaikutteiset osat,
kuten hyperlinkit, kirjanmerkit, medialeikkeet ja painikkeet. Voit viedä PDF-tiedostoon myös kätketyt tasot, tulostumattomat tasot ja tulostumattomat
objektit. Jos viet kirjan, voit yhdistää samannimiset tasot Kirja-paneelin avulla.

Lisätietoja käytettävien PDF-julkaisujen luomisesta on osoitteessa Adobe InDesign -käytettävyys.

Avoimen julkaisun vieminen PDF-muotoon tulostusta varten

1. Valitse Tiedosto > Vie.

2. Määritä tiedoston nimi ja sijainti.

3. Valitse Tallennusmuoto-luettelosta (Windows) tai Muoto-luettelosta (Mac OS), Adobe PDF (Tulostus) ja napsauta Tallenna-painiketta.

Kun valitset Adobe PDF (tulostus) -asetuksen, et voi sisällyttää PDF-tiedostoon vuorovaikutteisia elementtejä. Jos haluat viedä
vuorovaikutteisen julkaisun PDF-muodossa, katso Luo vuorovaikutteisia PDF-julkaisuja.

4. Tee jokin seuraavista:

Jos haluat käyttää valmiiksi määritettyä työasetusjoukkoa, valitse Adobe PDF -oletusarvot -valikosta oletusarvo.

Jos haluat luoda PDF/X-tiedoston, valitse Adobe PDF -oletusarvot -valikosta PDF/X-oletusarvo tai valitse Vakio-valikosta valmiiksi
määritetty PDF/X-muoto.

Jos haluat mukauttaa asetuksia, valitse luokka vasemmalla olevasta luettelosta ja määritä asetukset.

5. Valitse Yhteensopivuus-asetukseksi varhaisin PDF-versio, joka tarvitaan luomiesi tiedostojen avaamiseen.

6. Napsauta Vie-painiketta (Windows) tai Tallenna-painiketta (Mac OS).

Voit palauttaa Adobe PDF -valintaikkunan asetukset oletusarvoihinsa pitämällä Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) painettuna
ja napsauttamalla Palauta-painiketta. (Peruuta-painike muuttuu Palauta-painikkeeksi.)

Tasojen valmisteleminen ennen kirjan viemistä PDF-tiedostoon

Kun viet kirjan PDF-muotoon, voit valita, mitkä InDesign-tasot näkyvät PDF-tiedostossa. Voit yhdistää tasot viemisen aikana, jotta PDF-tiedostoon
ei tule samannimisiä tasoja.

Jos Yhdistä samannimiset tasot viennin yhteydessä -asetus on valittu, tasojen nimet näkyvät saman kirjan nimen alapuolella Acrobatissa tai
Readerissa. Jos tätä asetusta ei ole valittu, tasojen nimet näkyvät erikseen kunkin julkaisun nimen alapuolella.

1. Jos et halua tiettyjä tasoja yhdistettävän, anna niille yksilölliset nimet kirjan jokaisessa julkaisussa.

Isoilla ja pienillä kirjaimilla on eroa, joten tasoja nimeltä "Kuvat" ja "kuvat" ei yhdistetä.

2. Valitse Kirja-paneelivalikosta Yhdistä samannimiset tasot viennin yhteydessä.

Kun viet kirjan PDF-muotoon, varmista, että Luo Acrobat-tasot -asetus on valittu. Tämä asetus on käytettävissä, jos
yhteensopivuudeksi on valittu Acrobat 6 (PDF 1.5) tai uudempi.

Kirjan vieminen PDF-tiedostoon

1. Tee jokin seuraavista:

Kun haluat luoda koko kirjasta PDF-tiedoston, napsauta Kirja-paneelin tyhjää aluetta, jotta julkaisujen valinnat kumoutuvat. Valitse sitten
Kirja-paneelivalikosta Vie kirja PDF-muotoon.

Kun haluat luoda kirjan julkaisuista PDF-tiedoston, valitse julkaisu tai julkaisut Kirja-paneelista ja valitse sitten Kirja-paneelivalikosta Vie
valitut julkaisut PDF-muotoon.

2. Määritä XML-tiedoston nimi ja sijainti ja napsauta sitten Tallenna-painiketta.

3. Valitse oletusarvo Adobe PDF -oletus -valikosta tai valitse luokka Vie Adobe PDF -valintaikkunan vasemman reunan luettelosta ja muuta
sitten asetuksia.
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Alkuun

Korkealaatuinen tulostus

Illustratorin oletusarvo (vain Illustrator)

Ylikokoiset sivut (vain Acrobat)

PDF/A-1b: 2005 (CMYK ja RGB) (vain Acrobat)

PDF/X-1a (2001 ja 2003)

4. Napsauta Vie-painiketta (Windows) tai Tallenna-painiketta (Mac OS).

PDF-tiedostojen pienentäminen

Vain tarkasteltaviksi jaettavien PDF-tiedostojen kokoa kannattaa pienentää vietäessä tiedostoja InDesignista. Vie Adobe PDF -valintaikkunassa on
käytettävissä seuraavat koon pienentämistekniikat:

Valitse Adobe PDF -oletusarvo -luettelosta [Pienin tiedostokoko].

Määritä Pakkaus-alueella kuvien interpoloinniksi 72 pikseliä tuumalla, valitse automaattinen pakkaaminen ja valitse väri- ja harmaasävykuville
joko huonompi tai normaali laatu. Kun käsittelet valokuvamaisia kuvia, valitse Automaattinen (JPEG) -pakkaus. Kun käsittelet enimmäkseen
tasavärisiä kuvia, kuten kaavioita ja kuvaajia, valitse ZIP-pakkaus.

Muunna spottivärit prosessiväreiksi valitsemalla Tulostus-alueelta Painovärin hallinta.

Kun haluat pienentää PDF-tiedostojen kokoa, avaa PDF-tiedosto Acrobat 8.0:ssa tai uudemmassa, valitse Julkaisu > Pienennä tiedoston kokoa
ja määritä sitten vastaavuustaso. Voit käyttää tarkempia hallintaominaisuuksia valitsemalla Lisäasetukset > PDF-optimoija.

Lisätietoja PDF-tiedostojen koon pienentämisestä on Acrobatin Ohjeessa ja Adoben verkkosivustossa.

Adobe PDF -esimääritykset

PDF-dokumentin esimääritys on joukko PDF-tiedoston luomisessa käytettäviä asetuksia. Näillä asetuksilla pyritään luomaan mahdollisimman pieni
ja samalla laadukas tiedosto sen mukaan, kuinka PDF-tiedostoa tullaan käyttämään. Useimmat esimääritykset ovat yhteisiä kaikille Adobe
Creative Suite -sovelluksille, mukaan lukien InDesign, Illustrator, Photoshop ja Acrobat. Käyttäjät voivat myös luoda ja jakaa omia,
tapauskohtaisesti mukautettuja esimäärityksiään.

Osa alla luetelluista oletusarvoista ei ole käytettävissä, ennen kuin siirrät ne - tarvittaessa - Extrat-kansiosta (jonne ne on oletusarvoisesti
asennettu) Asetukset-kansioon. Tavallisesti Lisäosat- ja Asetukset-kansiot sijaitsevat kohteessa ProgramData\Adobe\AdobePDF (Windows Vista ja
Windows 7), Documents and Settings\All Users\Application Data\Adobe\Adobe PDF (Windows XP) tai Kirjasto/Application Support/Adobe PDF
(Mac OS). Osa esimäärityksistä ei ole käytettävissä joissakin Creative Suite -sovelluksissa.

Mukautetut asetukset sijaitsevat kansiossa (Windows XP) Documents and Settings/[käyttäjänimi]/Application Data/Adobe/Adobe PDF/Settings,
(Windows Vista ja Windows 7) Users/[käyttäjänimi]/AppData/Roaming/Adobe/Adobe PDF/Settings tai (Mac OS)
Käyttäjät/[käyttäjänimi]/Kirjasto/Application Support/Adobe/Adobe PDF/Settings.

Käy PDF-asetukset läpi määräajoin. Asetuksia ei palauteta automaattisesti oletusasetuksiksi. Sovellukset ja apuohjelmat, joilla PDF-
dokumentteja luodaan, käyttävät viimeksi määritettyä tai valittua PDF-asetusten joukkoa.

Luo PDF-dokumentteja tarkkuustulostusta varten työpöytätulostimille ja vedostuslaitteille. Tämä oletusarvo käyttää
PDF-versiota 1.4, pienentää väri- ja harmaasävykuvien tarkkuuden arvoon 300 ppi ja mustavalkokuvien tarkkuuden arvoon 1200 ppi, sisällyttää
kaikkien kirjasinten alijoukot, ei muuta värejä eikä litistä läpinäkyvyyttä (niissä tiedostotyypeissä, joissa läpinäkyvyyttä voi käyttää). Nämä PDF-
tiedostot voidaan avata Acrobat 5.0:ssa ja Acrobat Reader 5.0:ssa ja uudemmissa. InDesignissa tämä oletusarvo luo myös nimiöityjä PDF-
tiedostoja.

Luo PDF-tiedoston, jossa kaikki Illustratorin tiedot ovat tallella. Tällä oletusarvolla luodut PDF-tiedostot
voidaan avata uudelleen Illustratorissa ilman tietojen katoamista.

Luo PDF-dokumentteja, joilla voi tarkastella ja tulostaa teknisiä asiakirjoja, joiden koko yli 508 x 508 cm. Näitä
PDF-dokumentteja voi avata Acrobat 7.0- ja Acrobat Reader 7.0 -ohjelmissa ja niitä uudemmissa.

Käytetään sähköisten dokumenttien pitkäaikaiseen arkistointiin. PDF/A-1b käyttää PDF 1.4:ää ja
muuntaa kaikki värit käytössä olevasta standardista riippuen joko CMYK- tai RGB-väreiksi. Näitä PDF-dokumentteja voi avata Acrobat 5.0:lla ja
Acrobat Reader 5.0:lla sekä uudemmilla versioilla.

PDF/X-1a edellyttää, että kaikki kirjasimet on sisällytetty, että asianmukaiset merkit ja leikkausvarat on määritetty ja että
värit ovat CMYK-värejä, spottivärejä tai molempia. Yhteensopivassa tiedostossa täytyy olla tulostusolosuhteita kuvaavat tiedot. PDF/X-1-
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PDF/X-3

PDF/X-4 (2008)

Painolaatu

Pienin tiedostokoko

Lehtimainokset vuonna 2006 (Japani)

Vakio (vain Acrobat)

Alkuun

yhteensopivia PDF-tiedostoja voidaan avata Acrobat 4.0:lla ja Acrobat Reader 4.0:lla sekä uudemmilla versioilla.
PDF/X-1a käyttää PDF-versiota 1.3, pienentää väri- ja harmaasävykuvien tarkkuuden arvoon 300 pikseliä tuumalla (ppi) ja mustavalkokuvien
tarkkuuden arvoon 1200 ppi, sisällyttää kaikkien kirjasinten alijoukot, luo nimiöimättömän PDF-tiedoston ja litistää läpinäkyvyyden korkea tarkkuus -
asetuksella.
Huomautus: PDF/X1-a:2003- ja PDF/X-3 (2003) -esimääritykset asennetaan tietokoneeseen asennuksen yhteydessä, mutta ne eivät ole
käytettävissä ennen kuin siirrät ne Ekstrat-kansiosta Asetukset-kansioon.

Tämä esimääritys luo ISO-standardin PDF/X-3:2002 perustuvan PDF-tiedoston. Tällä asetuksella luotu PDF-tiedosto voidaan avata
Acrobat 4.0:lla ja Acrobat Reader 4.0:lla sekä uudemmilla versioilla.

Tämä ISO PDF/X-4:2008 -tiedostoja luova esiasetus tukee liikkuvaa läpinäkyvyyttä (läpinäkyvyyttä ei ole yhdistetty) ja ICC-
värinhallintaa. Tällä esiasetuksella viedyt PDF-tiedostot ovat PDF 1.4 -muodossa CS5:ssä ja PDF 1.6 -muodossa CS5.5:ssä ja sitä uudemmissa
versioissa. Kuvien tarkkuutta pienennetään ja ne pakataan ja kirjasimet upotetaan samalla tavalla kuin PDF/X-1a- ja PDF/X-3-asetusten
yhteydessä. Creative Suite 4- ja 5-sovelluksilla, mukaan lukien Illustrator, InDesign ja Photoshop, voidaan suoraan luoda PDF/X-4:2008-
yhteensopivia PDF-tiedostoja. Acrobat 9 Prossa on työkalut, joilla voidaan vahvistaa ja esitarkastaa PDF-tiedostojen PDF/X-4:2008-
yhteensopivuutta sekä muuntaa muussa kuin PDF/X-muodossa olevia tiedostoja PDF/X-4:2008-muotoon, jos mahdollista.
Adobe suosittelee PDF/X-4:2008-muotoa parhaana PDF-tiedostomuotona luotettaviin PDF-tulostustyönkulkuihin.

Luo PDF-tiedostoja korkealaatuista painotuotantoa varten (esimerkiksi digitaalista tulostusta tai latomakoneen tai painolevytulostimen
värierottelua varten), mutta ei luo PDF/X-yhteensopivia tiedostoja. Tässä tapauksessa sisällön laatu on ensisijainen ominaisuus. Tavoitteena on
säilyttää kaikki PDF-tiedoston tiedot, joita paino- tai tulostuspalvelu tarvitsee tulostaakseen julkaisun virheettömästi. Tämä asetusjoukko käyttää
PDF-versiota 1.4, muuntaa värit CMYK-muotoon, pienentää väri- ja harmaasävykuvien tarkkuuden arvoon 300 ppi ja mustavalkokuvien tarkkuuden
arvoon 1200 ppi, sisällyttää kaikkien kirjasinten alijoukot ja säilyttää läpinäkyvyyden (niissä tiedostotyypeissä, joissa läpinäkyvyyttä voi käyttää).
Nämä PDF-tiedostot voidaan avata Acrobat 5.0:ssa ja Acrobat Reader 5.0:ssa ja uudemmissa.
Huomautus: Ennen kuin luot Adobe PDF -tiedoston lähetettäväksi paino- tai tulostuspalveluun, selvitä, mitä tulostustarkkuutta ja muita asetuksia
tulisi käyttää, tai voit myös pyytää palvelusta .joboptions-tiedoston, joka sisältää suositeltavat asetukset. Joudut ehkä mukauttamaan Adobe PDF -
asetukset tietylle tulostuspalvelulle ja antamaan sinne oman .joboptions-tiedoston.

Luo PDF-tiedostoja Internet- tai intranet-käyttöön tai sähköpostijakeluun. Tämä asetusjoukko käyttää pakkausta, alaspäin
interpolointia ja melko pientä resoluutiota. Muuntaa kaikki värit sRGB-väreiksi ja sisällyttää kirjasimet. Se myös optimoi tiedostot tavujakelua
varten. Jos aiot tulostaa PDF-tiedoston, vältä tätä esiasetusta parhaiden tulosten varmistamiseksi.
Nämä PDF-tiedostot voidaan avata Acrobat 5.0:ssa ja Acrobat Reader 5.0:ssa ja uudemmissa.

Tämä esimääritys luo Digital Data Delivery -komitean laatimiin luomissääntöihin perustuvan PDF-
tiedoston.

Luo PDF-tiedostoja, joita voi tulostaa pöytätulostimilla tai digitaalisilla kopiokoneilla, julkaista CD-levyllä tai lähettää
asiakkaalle julkaisun vedoksena. Tämä asetusjoukko pitää tiedoston koon pienenä käyttämällä pakkausta ja interpolointia. Se kuitenkin sisällyttää
myös kaikkien tiedostossa käytettyjen (sallittujen) kirjasinten osajoukot, muuntaa kaikki värit sRGB-muotoon ja tulostaa keskitarkkuudella. Huomaa,
että Windowsin kirjasinten osajoukkoja ei sisällytetä oletuksena. Tätä asetustiedostoa käyttäen luotuja PDF-tiedostoja voidaan avata Acrobat
6.0:lla ja Acrobat Reader 6.0:lla sekä uudemmilla versioilla.

Adobe PDF -esimääritysten mukauttaminen

Vaikka PDF-oletusarvot perustuvat käytännön kokemuksiin, sinun työmenetelmäsi tai mahdollisesti kirjapainon työmenetelmät edellyttävät ehkä
erikoisia PDF-asetuksia, jotka eivät kuulu mihinkään valmiisiin oletusarvoihin. Tässä tilanteessa sinä tai tulostuspalvelu voi luoda mukautettuja
oletusarvoja. Adobe PDF -oletusarvot tallentuvat .joboptions-tiedostoihin.

1. Valitse Tiedosto > Adobe PDF -oletusarvot > Määritä.

2. Tee jokin seuraavista:

Luo uusi oletusarvo napsauttamalla Uusi-painiketta. Jos haluat uuden oletusarvon perustuvan aiemmin luotuun oletusarvoon, valitse
tämä ensin. Määritä PDF-asetukset ja napsauta sitten OK-painiketta. (Katso Adobe PDF -asetukset.)

Muokkaa mukautettua oletusarvoa valitsemalla se ja napsauttamalla Muokkaa-painiketta. (Et voi muokata valmiita oletusarvoja.) Määritä
PDF-asetukset ja napsauta sitten OK-painiketta.

Poista oletusarvo valitsemalla se ja napsauttamalla Poista-painiketta.
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Alkuun

Windows XP

Windows Vista ja Windows 7

Mac OS

Alkuun

Tallenna oletusarvo muualle kuin Adobe PDF -kansion Settings-kansioon valitsemalla oletusarvo ja napsauttamalla Tallenna nimellä -
painiketta. Määritä sijainti ja napsauta Tallenna-painiketta.

Voit luoda mukautetun esimäärityksen myös PDF-tiedostoa tallentaessasi napsauttamalla Vie Adobe PDF -valintaikkunan alareunassa olevaa
Tallenna oletusarvo -painiketta. Kirjoita oletusarvon nimi ja napsauta OK-painiketta.

Adobe PDF -esimääritysten lataaminen

Luomasi uudet PDF-esimääritykset (.joboptions-tiedostot) tallennetaan Settings-kansioon seuraaviin kohteisiin:

Documents and Settings\[käyttäjätunnus]\Application Data\Adobe\Adobe PDF

Users\[käyttäjätunnus]\AppData\Roaming\Adobe\Adobe PDF

Käyttäjät/[käyttäjätunnus]/Kirjasto/Application Support/Adobe/Adobe PDF

Nämä oletusarvot näkyvät automaattisesti Adobe PDF -oletusarvot -valikossa.

InDesignin muut PDF-oletusarvot asennetaan järjestelmän Adobe PDF\Extras-kansioon. Voit etsiä lisää .joboptions-tiedostoja järjestelmän
etsintätoiminnolla. Voit saada mukautettuja PDF-oletusarvoja myös tulostuspalveluista ja työtovereilta. Nämä oletusarvot näkyvät Adobe PDF -
oletusarvot -valikossa vain, jos ne siirretään Settings-kansioon joko manuaalisesti tai Lataa-komennolla.

PDF-oletusarvojen lataaminen

Lataa-komennosta on hyötyä, jos haluat ladata sinulle lähetetyt PDF-oletusarvot tai ladata PDF-oletusarvoja InDesign CS2:sta.

1. Valitse Tiedosto > Adobe PDF -oletusarvot > Määritä.

2. Napsauta Lataa-painiketta ja valitse ladattava .joboptions-tiedosto.

.joboptions-tiedosto kopioituu Settings-kansioon, johon uudet PDF-oletusarvot tallentuvat.

Jos haluat .joboptions-tiedoston näkyvän Adobe PDF -oletusarvot -valikossa, voit myös vetää sen PDF-oletusarvot sisältävään Settings-
kansioon.

PDF-oletusarvojen muuntaminen InDesign CS:stä

InDesign CS ja aiemmat versiot vievät PDF-oletusarvot .pdfs-tiedostotunnisteilla, kun taas InDesign CS2 ja uudemmat versiot vievät PDF-
oletusarvot .joboptions-tiedostotunnisteilla. Tuotu PDFS-tiedosto muunnetaan .joboptions-tiedostoksi, ja se ohittaa asetuksia tarvittaessa. Jos
esimerkiksi InDesign CS:n Tulostus-paneelista oli valittu kohdeprofiiliksi Näytön RGB, se muuttuu InDesign CS4:ssa automaattisesti Julkaisun
RGB -profiiliksi.

1. Valitse Tiedosto > Adobe PDF -oletusarvot > Määritä.

2. Napsauta Lataa-painiketta.

3. Valitse Tiedostotyypit-valikosta Aiemman version PDF-asetustiedostot (.pdfs) (Windows) tai Ota käyttöön -valikosta Kaikki tiedostot
(Macintosh).

4. Kaksoisnapsauta muunnettavaa tiedostoa.

Tiedosto muuttuu valituksi Adobe PDF -oletusarvojen luettelossa.
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Taustatehtäväpaneeli

Koska PDF-tiedostoja voi viedä taustalla, voit jatkaa työskentelyä julkaisun parissa sen sijaan että odottaisit, kunnes InDesign on saanut viennin
tehtyä. Voit myös jonouttaa useita PDF-vientejä taustalle. Käytä Taustatehtävät-paneelia, jos haluat seurata vientien etenemistä.

1. Yhden tai useiden julkaisujen vieminen Adobe PDF -muotoon.

2. Jos haluat seurata vientien etenemistä, valitse Ikkuna > Apuohjelmat > Taustatehtävät.

Adobe PDF -asetukset

PDF-yhteensopivuustasot

Luo vuorovaikutteisia PDF-julkaisuja
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JPEG-muotoon vieminen

Valinta

Alue

Valitse kaikki

Aukeamat

Upota väriprofiili

Käytä julkaisun leikkausvara-asetuksia

Pehmennys

Simuloi päällepainatus

JPEG pakkaa väri- tai harmaasävykuvat näyttöä varten käyttämällä standardoitua kuvanpakkausmenetelmää. Vie sivu, aukeama tai valittu objekti
JPEG-muodossa käyttämällä Vie-komentoa.

1. Valitse halutessasi vietävä objekti. (Jos viet sivun tai aukeaman, mitään ei tarvitse valita.)

2. Valitse Tiedosto > Vie.

3. Määritä kohde ja tiedostonimi.

4. Valitse Tallennusmuoto- (Windows) tai Muoto-kohdasta (Mac OS) JPEG ja valitse sitten Tallenna.

Näyttöön tulee Vie JPEG -ikkuna.

5. Valitse Vie-osasta jokin seuraavista vaihtoehdoista:

Vie valittuna oleva objekti.

Syötä vietävän sivun tai vietävien sivujen numerot. Erota alueen sivunumerot yhdysmerkillä. Erota sivualueet pilkuilla.

Vie kaikki julkaisun sivut.

Vie aukeaman vastakkaiset sivut yhteen JPEG-tiedostoon. Jos viet aukeaman sivut erillisinä JPEG-tiedostoina, poista tämä
valinta.

6. Määritä Laatu-kohtaan pakkauksen (pienemmän tiedostokoon) ja kuvan laadun suhde valitsemalla jokin seuraavista vaihtoehdoista:

Maksimi: Sisällyttää vientitiedostoon kaikki korkearesoluutiokuvatiedot ja vaatii eniten levytilaa. Valitse tämä asetus, jos tiedosto
tulostetaan korkearesoluutiotulostimella.

Matala: Sisällyttää vietävään tiedostoon vain sijoitettujen bittikarttakuvien näyttöresoluutioversiot (72 dpi). Valitse tämä asetus, jos
tiedosto näytetään vain näytössä.

Normaali ja Korkea: sisällyttävät vietävään tiedostoon enemmän kuvatietoja kuin Matala, mutta käyttävät eri pakkaustasoja tiedostokoon
pienentämiseksi.

7. Valitse muotoilumenetelmäksi jompikumpi seuraavista vaihtoehdoista:

Etenevä: JPEG-kuva näkyy vähitellen, ja sen yksityiskohdat tarkentuvat, kun Web-selain lataa niitä.

Perusviiva: JPEG-kuva näkyy vasta latautumisen jälkeen.

8. Valitse tai kirjoita viedyn JPEG-kuvan resoluutio.

9. Määritä viedyn tiedoston väriavaruus. Voit viedä RGB-, CMYK- tai harmaasävymuodossa.

10. Valitse jokin seuraavista vaihtoehdoista ja valitse sitten Vie.

Kun tämä asetus on valittu, julkaisun väriprofiili upotetaan vietyyn JPEG-tiedostoon. Väriprofiilin nimi näytetään pienellä
tekstillä asetuksen oikealla puolella. Voit valita halutun profiilin julkaisulle valitsemalla Muokkaa > Määritä profiilit, ennen kuin viet JPEG-
muodossa.

Jos valitset Väriavaruus-valikosta arvon Harmaa, Upota väriprofiili -asetus ei ole käytettävissä.

Jos tämä asetus valitaan, julkaisun asetuksissa määritetty leikkausvara-alue näkyy tuloksena
olevassa JPEG-kuvassa. Tämä asetus ei ole käytössä, jos Valinta-asetus on valittu.

Pehmennys tasoittaa tekstin ja bittikarttakuvien rosoisia reunoja.

Tämä asetus vastaa Päällepainatuksen esikatselu -ominaisuutta, mutta toimii vain valituissa väriavaruuksissa. Jos
asetus on valittu, InDesignin viemä JPEG-tiedosto simuloi päällepainatuksen spottimusteita erilaisilla neutraaleilla tiheysarvoilla muuntamalla
spottivärit prosessiväreiksi tulostusta varten.

JPEG (.jpg) -tiedostot
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Sisällön vieminen EPUB-muotoon | CS6

Alkuun

Alkuun

Huomautus:

Alkuun

Yleistä
Vieminen EPUB-muotoon
EPUB-vientiasetukset

Yleiset EPUB-vientiasetukset
EPUB-kuva-asetukset
EPUB-lisäasetukset

EPUB-resurssit

Yleistä

Ennen sivuasettelun viemistä EPUB-muodossa voit tehdä muutamia säätöjä ja varmistaa, että sivuasettelu viedään oikein.

Ankkuroidun grafiikan lisääminen – Ankkuroi grafiikka tekstityönkulkuihin, niin voit hallita sen paikkaa vietyyn tekstiin nähden. Katso
Ankkuroidut objektit.
Objektien vientiasetukset – Määritä sijoitettujen objektien vientiasetukset. Katso Objektien vientiasetukset.
Tyylien osoittaminen vientinimiöihin – Osoita merkki- ja kappaletyylit HTML-nimiöihin ja -luokkiin. Katso Tyylien osoittaminen
vientinimiöihin.
Sisällön ja järjestyksen valitseminen – Valitse vietävät sisällöt ja niiden järjestys Artikkelit-paneelissa. Katso Artikkelit. Voit järjestää sisällön
myös sivuasettelun tai XML-rakenteen perusteella.

Vieminen EPUB-muotoon

Voit viedä julkaisun tai kirjan sijoitettavana EPUB-muotoisena e-kirjana, joka on yhteensopiva eBook-lukuohjelmiston kanssa.

1. Tee jokin seuraavista:

Avaa dokumentti ja valitse Tiedosto > Vie.

Avaa kirja ja valitse Kirja-paneelin valikosta Vie kirja EPUB-muotoon.

2. Määritä tiedoston nimi ja sijainti.

3. Valitse Tallennusmuoto-luettelosta EPUB ja sitten Tallenna.

4. Määritä haluamasi asetukset EBOOK-vientiasetukset-valintaikkunan Yleiset-, Kuva- ja Lisäasetukset-alueilla.

InDesign luo yhden .epub-tiedoston, joka sisältää XHTML-sisällön. Vietävä tiedosto voi sisältää kansikuvan, mikäli se on määritetty. Kansikuva
luodaan kuvasta tai rasteroimalla määritetyn julkaisun ensimmäinen sivu (tai tyylilähdejulkaisu, jos valittiin kirja). EKirja yksilöidään miniatyyrikuvan
avulla EPUB-lukuohjelmistoissa tai Digital Editions Reader -kirjastonäkymässä. Tiedoston katselemista varten tarvitset EPUB-lukuohjelmiston. Voit
myös käyttää Adobe Digital Editions -ohjelmistoa, jonka voi ladata ilmaiseksi Adoben sivustosta.

.epub-tiedosto on käytännössä .zip-tiedosto. Voit tarkastella ja muokata .EPUB-tiedoston sisältöä vaihtamalla tiedostotunnisteeksi .zip ja
purkamalla sisällön. Tämä on erityisen kätevää esimerkiksi CSS-tiedoston muokkaamista varten.

InDesign-objektit, kuten tekstikehykset ja sijoitettuja kuvia sisältävät objektit, viedään aina, kun valitset Sivuasettelun perusteella -
järjestysasetuksen. Tyhjiä objekteja ei viedä, paitsi jos olet määrittänyt InDesign-objektin Objektin vientiasetukset -kohdassa vietäväksi JPEG-,
GIF- tai PNG-muodossa.

EPUB-vientiasetukset
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Versio

EPUB 2.0.1

EPUB 3.0

EPUB 3.0 sivuasettelulla

Kansi

Ei mikään

Rasteroi ensimmäinen sivu

Valitse kuva

Sisällysluettelon tyyli

Reunukset

Sisällön järjestys

Sivuasettelun perusteella

Sama kuin XML-rakenne

Sama kuin artikkelipaneelissa

Sijoita alaviite kappaleen jälkeen

Poista pakotetut rivinvaihdot

Yleiset EPUB-vientiasetukset

EPUB-vientiasetukset-valintaikkunan Yleiset-osa sisältää seuraavat asetukset.

Määritä EPUB-versio. 

EPUB 2.0.1 on IDPF:n vuonna 2007 hyväksymä standardi. Tätä muotoa tuetaan erilaisissa mobiililaitteissa.

EPUB 3.0 on IDPF:n vuonna 2011 hyväksymä standardi. Tämä muoto tukee myös ääntä, videota, Javascriptiä ja japaninkielistä
pystysuuntaista tekstiä. Uudet toiminnot eivät kuitenkaan toimi lukuohjelmissa ja laitteissa, jotka eivät tue EPUB 3.0 -standardia.

Tämä on Adobe Systemsin kehittämä kokeellinen muoto. Se tukee useita sarakkeita, tekstinkierrätystä ja muita
ohjausobjekteja, joiden ansiosta sivuasettelusi näyttävät hyviltä kaikissa sivuasetteluissa. Tämä toiminto toimii vain tiettyjen
katseluohjelmateknologioiden kanssa.

Määrittää eKirjan kansikuvan. Valitse yksi seuraavista:

Jos tämä asetus on valittuna, eKirjaan ei lisätä kansikuvaa.

Jos tämä asetus on valittuna, eKirjan ensimmäinen sivu rasteroidaan ja siitä luodaan kuvatiedosto, jota
käytetään kantena.

Jos tämä asetus on valittuna, voit valita tietokoneesta kuvan, jota käytetään kantena.

Valitse tämä asetus, jos haluat luoda valittuun sisällysluettelon tyyliin perustuvan sisällysluettelon. Määritä Sisällysluettelon
tyyli -luettelossa eKirjan sisällysluettelon luontiin käytettävä sisällysluettelon tyyli. Voit luoda eKirjalle yksilöllisen sisällysluettelon tyylin valitsemalla
Sivuasettelu > Sisällysluettelon tyylit.

Määritä Ylä-, Ala-, Vasen- ja Oikea-reunusten arvot pikseleinä. Jos haluat käyttää samaa arvoa kullekin reunukselle, valitse Rajoita-
kuvake. 

Määritä sivuelementtien vientijärjestys.

Lukemisjärjestys määräytyy sivulla olevien kohteiden sijainnin perusteella.
Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä
alas. Muotoiluelementit eivät välttämättä ole kaikissa tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, halutussa
lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
(Vain aasialaiset versiot) Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen julkaisun sidonnan
mukaan (vasemmalta oikealle tai oikealta vasemmalle). Viedyt muotoiluelementit eivät välttämättä ole halutussa lukujärjestyksessä kaikissa
tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.

Lukemisjärjestys määräytyy rakennenäkymässä olevien nimiöiden järjestyksen perusteella. Katso Sivukohteiden
nimiöiminen.

Lukemisjärjestys määräytyy Artikkelit-paneelissa olevien elementtien järjestyksen perusteella. Vain valitut
artikkelit viedään. Katso Artikkeleiden sisällyttäminen vientiä varten.

Valitse tämä vaihtoehto, jos haluat sijoittaa alaviitteet kappaleen jälkeen. Jos valinta poistetaan, alaviitteet
muunnetaan loppuviitteiksi.

Valitse tämä vaihtoehto, jos haluat viedystä eKirjasta kaikki pakotetut rivinvaihdot.

734

http://help.adobe.com/fi_FI/indesign/cs/using/WSa285fff53dea4f8617383751001ea8cb3f-70aba.html
http://help.adobe.com/fi_FI/indesign/cs/using/WSa285fff53dea4f8617383751001ea8cb3f-70aba.html
http://idiom-q-win-1/fi/indesign/urlpointers/help.adobe.com/using/WS8c5bc4f64c7a4a3d78b7a8b312dbccaf5b2-8000.html


Luettelomerkit

Numerot

Osoita järjestettyyn luetteloon

Osoita kiinteään järjestettyyn luetteloon

Tekstiksi muuntaminen

Näytä EPUB viennin jälkeen

Säilytä sivuasettelun ulkoasu

Tarkkuus (ppi)

Kuvan koko

Kuvan tasaus ja välistys

Lisää sivunvaihto

Asetukset koskevat ankkuroituja objekteja

Kuvan muuntaminen

GIF-asetukset (Paletti)

JPEG-asetukset (kuvan laatu)

Valitse Osoita järjestämättömään luetteloon, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohteiksi, jotka muotoillaan
HTML-muotoon <ul>-nimiöllä. Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä. Jos olet käyttänyt InDesignin
alkuperäisiä automaattisia luettelomerkkejä, myös aliluettelomerkit sisällytetään.

Määrittää, kuinka numerot muunnetaan HTML-tiedostossa. Jos olet käyttänyt InDesignin alkuperäistä automaattista numerointia, myös
aliluettelomerkit sisällytetään.

Muuntaa numeroidut luettelot Luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.

Muuntaa numeroidut luettelot Luettelokohteiksi ja liittää <value>-määritteen, joka perustuu
kappaleen nykyiseen numeroon InDesignissa.

Muuntaa numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

EPUB avautuu EPUB-tiedostojen lukemiseen valitussa oletussovelluksessa, jos sellainen on käytettävissä.

EPUB-kuva-asetukset

EPUB-vientiasetukset-valintaikkunan Kuvat-osa sisältää seuraavat asetukset. Määritä Kuvien muuntaminen -valikossa, miten kuvat viedään HTML-
muotoon.

Valitse tämä vaihtoehto, jos haluat käyttää sivuasettelussa olevia kuvaobjektien määritteitä.

Valitse kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi, mobiililaitteissa
tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). Voit valita kullekin valitulle objektille ppi-arvon.
Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Määritä, käytetäänkö kiinteää kuvakokoa vai suhteutetaanko se sivukokoon. Sivukokoon suhteutettu asetus määrittää suhteellisen
prosenttiarvon InDesign-sivuleveyteen suhteutetun kuvakoon perusteella. Tätä asetusta käytettäessä kuvat skaalataan suhteessa lukualueen
leveyteen.

Määritä kuvan tasaus, täyttö vasemmalle, keskelle ja oikealle sekä välilyönti ennen ja jälkeen.

Valitse tämä vaihtoehto, jos haluat lisätä kuviin sivunvaihtoja. Sivunvaihtoja voidaan lisätä ennen kuvaa, kuvan jälkeen tai
ennen kuvaa ja kuvan jälkeen.

Valitse tämä vaihtoehto, jos haluat käyttää näitä asetuksia kaikkien ankkuroitujen objektien kanssa.

Voit valita, muunnetaanko dokumentin optimoidut kuvat GIF-, JPEG- tai PNG-muotoon. Valitse Automaattinen, jos haluat,
että InDesign päättää, mitä muotoa kussakin tapauksessa käytetään. PNG-asetuksen valinta poistaa kuvien pakkausasetukset käytöstä. Käytä
PNG-asetusta häviöttömiin tai läpinäkyviin kuviin.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.
Valitse Sovitettu, jos haluat luoda paletin käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla. Valitse Verkko, jos haluat muodostaa paletin verkkokäyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -
järjestelmävärien osajoukko. Valitse Järjestelmä (Win) tai Järjestelmä (Mac), jos haluat luoda paletin käyttämällä järjestelmän omaa väripalettia.
Tämä valinta voi aiheuttaa odottamattomia tuloksia.
Valitse Lomita, jos haluat ladata kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta
ja selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määrittää kullekin JPEG-kuvalle tilanteeseen parhaiten sopivan pakkauksen (pienemmät tiedostokoot) ja kuvan
laadun. Matala-asetus tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.
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JPEG-asetukset (muotoilumenetelmä)

Ohita objektin muunnosasetukset

Jaa dokumentti

Sisällytä dokumentin metatiedot

Julkaisija

Yksilöllinen tunnus

CSS-asetukset

Sisällytä tyylimääritykset

Säilytä paikalliset ohitukset

Sisällytä upotettavat kirjasimet

Lisää tyyliarkki

Lisää komentosarja

Alkuun

Määrittää, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
verkkosivulla. Valitse Etenevä, jos haluat JPEG-kuvien avautuvan vähitellen ja tarkentuvan verkkoselaimen ladatessa niitä. (Tällä asetuksella
luodut tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.) Valitse Peruslinja, jos haluat, että kukin JPEG-tiedosto
näkyy vasta latauksen päätyttyä. Tiedoston paikalla on latauksen aikana paikkamerkki.

Ohittaa yksittäisiin kuviin käytetyt objektin vientiasetukset. Katso Objektin vientiasetusten käyttäminen.

EPUB-lisäasetukset

EPUB-asetukset-valintaikkunan Sisältö-osa sisältää seuraavat asetukset.

Voit jakaa eKirjan määritetyn kappaletyylin perusteella. Jakamisen seurauksena EPUB-paketti sisältää enemmän HTML-
tiedostoja, mutta pitkien tiedostojen jakaminen voi olla hyödyllistä, ja se lisää EPUB-lukuohjelmistojen suorituskykyä.

Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon.

Määritä tässä eKirjan metatietoihin sisällytettävät julkaisijatiedot. Voit määrittää esimerkiksi julkaisijan URL-osoitteen, jotta
eKirjan vastaanottaja voi siirtyä julkaisijan sivustoon ja ostaa eKirjan.

Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Ohjelmisto luo ja näyttää automaattisesti ainutkertaisen
tunnisteen. Voit poistaa sen ja määrittää ainutkertaisen tunnisteen.

CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun verkkosivulla. Kun
käytät sivun muotoiluun CSS:ää, erotat sisällön esityksestä.

Kun viet EPUB-muodossa, voit luoda muokattavan luettelon CSS-tyyleistä.

Jos tämä asetus on valittu, paikalliset muotoilut, kuten kursiivi ja lihavointi, on sisällytetty.

Sisällytä kaikki upotettavat kirjasimet eBook-kirjaan. Kirjasimissa on upotusbitit, jotka määrittävät,
voidaanko kirjasin upottaa.

Määritä olemassa olevan CSS-tyyliarkin URL-osoite (yleensä suhteellinen URL, esimerkiksi "/tyylit/tyyli.css"). InDesign ei
tarkista, onko CSS olemassa tai kelvollinen, joten vahvista ulkoisen CSS:n asetukset.

Määritä olemassa olevan JavaScriptin URL-osoite. InDesign ei tarkista, onko JavaScript olemassa tai kelvollinen, joten
vahvista ulkoisen JavaScriptin asetukset.

EPUB-resurssit

Seuraavia linkkejä napsauttamalla voit perehtyä EPUB-muotoon.

Lisätietoja EPUB-määrityksestä on sivustossa www.idpf.org.

Lataa ilmainen Digital Editions -lukuohjelmisto osoitteesta www.adobe.com/fi/products/digitaleditions.

Lisätietoja Digital Editionsista löytyy Digital Editions -blogista.

Lisätietoja viennistä Kindleen on julkaisussa InDesignista Kindleen (PDF).

Opi muuntamaan InDesign-tiedostot EPUB-muotoon ja aloita Apple iPadilla katseltavissa olevien sähköisten kirjojesi myynti. Lisätietoa on
white paper -julkaisussa. Perehdy White paper -julkaisuun InDesignista iPadiin.
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Sisällön vieminen HTML-muotoon | CS6 & CS5.5

Vietävät kohteet

Viemättä jäävät kohteet

Vieminen

Sisällön järjestys / Järjestäminen

HTML-muotoon vieminen on helppo tapa saada InDesign-sisältö internetvalmiiseen muotoon. Kun viet sisältöä XHTML-muotoon, voit valita, miten
teksti ja kuvat viedään. InDesign säilyttää viedyssä sisällössä käytettyjen kappale-, merkki-, objekti-, taulukko- ja solutyylien nimet merkitsemällä
HTML-sisällön samannimisillä CSS-tyyliluokilla. Adobe Dreamweaverillä tai muulla CSS-yhteensopivalla HTML-editorilla voit nopeasti ottaa
sisällössä käyttöön muotoiluja sekä asetteluja.

InDesign vie kaikki jutut, linkitetyt ja upotetut kuvat, SWF-elokuvatiedostot, alaviitteet, tekstimuuttujat (tekstinä), luettelomerkityt
ja numeroidut luettelot, sisäiset ristiviittaukset sekä tekstiin tai verkkosivuille siirtävät hyperlinkit. Myös taulukot viedään, mutta tiettyjä muotoiluja,
kuten taulukon ja solun viivoja, ei viedä. Taulukoille annetaan yksilöivät tunnisteet, jotta niihin voidaan viitata Spry-tietojoukkoina Dreamweaverissa.
Sijoitetut audio- ja h.264-videotiedostot sisällytetään HTML5 <audio>- ja <video>-nimiöihin.

InDesign ei vie itse piirtämiäsi kohteita (kuten suorakulmioita, ellipsejä ja monikulmioita), hyperlinkkejä (muut kuin
verkkosivujen linkit sekä tekstilinkit, jotka siirtävät saman julkaisun tekstiankkureihin), liitettyjä objekteja (myös liitetyt Illustrator-kuvat), ääriviivoiksi
muunnettua tekstiä, XML-nimiöitä, kirjoja, kirjanmerkkejä, SING-glyyfejä, sivun siirtymiä, hakemistomerkkejä, taittopöydän kohteita, joita ei ole
valittu ja jotka eivät koske sivua, eikä sivupohjakohteita (ellei niitä korvata tai valita ennen vientiä).

1. Jos et aio viedä koko julkaisua, valitse vietävät tekstikehykset, tekstialue, taulukkosolut tai grafiikka.

2. Valitse Tiedosto > Vie ja valitse sitten HTML Tallenna nimellä -luettelosta.

3. Määritä HTML-julkaisun nimi ja sijainti ja valitse Tallenna.

4. Määritä haluamasi asetukset HTML-vientiasetukset-valintaikkunan Yleiset-, Kuva- ja Lisäasetukset-kohdissa ja valitse sitten OK.

Ohjelma luo julkaisun käyttämällä määritettyä nimeä sekä .html-tunnistetta (kuten uutiskirje.html). Jos verkkokuvien alikansio (kuten
uutiskirjeen_verkkokuvat) on määritetty, se tallennetaan samaan sijaintiin.

HTML-vientiasetukset

Määritä HTML-valintaikkunaan seuraavat asetukset.

Yleiset asetukset

Yleiset-alue sisältää seuraavat asetukset.

Määrittää, viedäänkö koko julkaisu vai vain valitut kohteet. Jos valittuna on tekstikehys, viedään koko juttu, mukaan lukien ylijuokseva
teksti.
Jos valitset julkaisun, viedään kaikkien aukeamien kaikki sivukohteet lukuun ottamatta näkymättömien tasojen sivukohteita sekä sivupohjakohteita,
joita ei ole ohitettu. Myös XML-nimiöt ja luodut hakemistot ja sisällysluettelot ohitetaan.

Voit määrittää sivuobjektien lukemisjärjestyksen.
Sivuasettelun perusteella
Lukemisjärjestys määräytyy sivulla olevien kohteiden sijainnin perusteella.
Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä
alas. Muotoiluelementit eivät välttämättä ole kaikissa tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, halutussa
lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
(Vain aasialaiset versiot) Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen julkaisun sidonnan
mukaan (vasemmalta oikealle tai oikealta vasemmalle). Viedyt muotoiluelementit eivät välttämättä ole kaikissa tapauksissa, kuten
monimutkaisissa monipalstaisissa julkaisuissa, halutussa lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
Sama kuin XML-rakenne
Jos valitset Sama kuin XML-rakenne, XML-rakennepaneeli määrää viedyn sisällön järjestyksen ja sen, mitä sisältöä viedään. Jos sisältö on
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Reunus

Luettelomerkit

Numerot

Osoita järjestettyyn luetteloon

Osoita kiinteään järjestettyyn luetteloon

Tekstiksi muuntaminen

Näytä HTML viennin jälkeen

Kuvien kopiointi

Alkuperäinen

Optimoitu

Palvelinpolun linkki

Säilytä sivuasettelun ulkoasu

Tarkkuus (ppi)

Kuvan koko

Kuvan tasaus ja välistys

Asetukset koskevat ankkuroituja objekteja

jo nimiöity, voit vain vetää nimiöitä XML-rakennepaneeliin ja asettaa XHTML:n vientijärjestyksen. Jos sisältöä ei ole nimiöity, voit valita Lisää
nimiöimättömät kohteet XML-rakennepaneelista ja tuottaa nimiöt, jotka voit sitten järjestää uudelleen. Jos et halua kohdetta sisällytettävän
vientiin, voit vain poistaa nimiön XML-rakennepaneelista. (Nimiön poistaminen ei poista sisältöä INDD-tiedostosta.) Katso Sivukohteiden
nimiöiminen.
Sama kuin artikkelipaneelissa
Lukemisjärjestys määräytyy Artikkelit-paneelissa olevien elementtien järjestyksen perusteella. Vain valitut artikkelit viedään. Katso
Artikkeleiden sisällyttäminen vientiä varten.

Määritä yksinkertainen reunus Ems- tai pikselimuodossa. Reunusten määrittäminen Ems-muodossa takaa yhteensopivuuden useiden
näyttöjen kanssa paremmin. Samaa arvoa käytetään kaikkiin reunuksiin: ylös, alas, vasemmalle ja oikealle.

Valitse Osoita järjestämättömään luetteloon, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohteiksi, jotka muotoillaan
HTML-muotoon <ul>-nimiöllä. Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä. Jos olet käyttänyt InDesignin
alkuperäisiä automaattisia luettelomerkkejä, myös aliluettelomerkit sisällytetään.

Määrittää, kuinka numerot muunnetaan HTML-tiedostossa. Jos olet käyttänyt InDesignin alkuperäistä automaattista numerointia, myös
aliluettelomerkit sisällytetään.

Muuntaa numeroidut luettelot Luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.

Muuntaa numeroidut luettelot Luettelokohteiksi ja liittää <value>-määritteen, joka perustuu
kappaleen nykyiseen numeroon InDesignissa.

Muuntaa numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

Käynnistää selaimen, jos käytettävissä.

Kuva-asetukset

Määritä, miten kuvat viedään HTML-muotoon.

Vie alkuperäisen kuvan <document_name>-web-images -alikansioon. Kun tämä asetus on valittuna, muita asetuksia ei voi
valita.

Voit asetuksia muuttamalla määrittää, kuinka kuva viedään.

Tällä asetuksella kuvia ei viedä alikansioon, vaan niille annetaan paikallinen URL-osoite (esimerkiksi "kuvat/"), joka
näkyy kuvatiedoston edessä. Linkkimäärite näyttää määrittämäsi reitin ja tunnisteen HTML-koodissa. Tämä asetus on erityisen tehokas,
kun olet itse muuntamassa kuvia internetyhteensopiviksi kuviksi.

Valitse tämä vaihtoehto, jos haluat käyttää sivuasettelussa olevia kuvaobjektien määritteitä.

Määritä kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi, mobiililaitteissa
tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). Voit määrittää kullekin valitulle objektille ppi-arvon.
Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Määritä, käytetäänkö kiinteää kuvakokoa vai suhteutetaanko se sivukokoon. Sivukokoon suhteutettu asetus määrittää suhteellisen
prosenttiarvon InDesign-sivuleveyteen suhteutetun kuvakoon perusteella. Tätä asetusta käytettäessä kuvat skaalataan suhteessa lukualueen
leveyteen.

Määritä kuvan tasaus, täyttö vasemmalle, keskelle ja oikealle sekä välilyönti ennen ja jälkeen.

Valitse tämä vaihtoehto, jos haluat käyttää näitä asetuksia kaikkien ankkuroitujen objektien kanssa.
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Kuvan muuntaminen

GIF-asetukset (Paletti)

JPEG-asetukset (kuvan laatu)

JPEG-asetukset (muotoilumenetelmä)

Ohita objektin muunnosasetukset

CSS-asetukset

Upotettu CSS

Ei CSS-määrittelyä

Ulkoinen CSS (CS5.5)

Ylimääräinen CSS (CS6)

JavaScript-asetukset

Voit valita, muunnetaanko dokumentin optimoidut kuvat GIF-, JPEG- tai PNG-muotoon. Valitse Automaattinen, jos haluat,
että InDesign päättää, mitä muotoa kussakin tapauksessa käytetään. PNG-asetuksen valinta poistaa kuvien pakkausasetukset käytöstä.Käytä
PNG-asetusta häviöttömiin tai läpinäkyviin kuviin.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.
Valitse Sovitettu, jos haluat luoda paletin käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla. Valitse Verkko, jos haluat muodostaa paletin verkkokäyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -
järjestelmävärien osajoukko. Valitse Järjestelmä (Win) tai Järjestelmä (Mac), jos haluat luoda paletin käyttämällä järjestelmän omaa väripalettia.
Tämä valinta voi aiheuttaa odottamattomia tuloksia.
Valitse Lomita, jos haluat ladata kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta
ja selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määrittää kullekin JPEG-kuvalle tilanteeseen parhaiten sopivan pakkauksen (pienemmät tiedostokoot) ja kuvan
laadun. Matala-asetus tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.

Määrittää, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
verkkosivulla. Valitse Etenevä, jos haluat JPEG-kuvien avautuvan vähitellen ja tarkentuvan verkkoselaimen ladatessa niitä. (Tällä asetuksella
luodut tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.) Valitse Perusviiva, jos haluat, että kukin JPEG-tiedosto
näkyy vasta latauksen päätyttyä. Tiedoston paikalla on latauksen aikana paikkamerkki.

Ohittaa yksittäisiin kuviin käytetyt objektin vientiasetukset. Katso Objektin vientiasetusten käyttäminen.

Lisäasetukset

Määritä CSS- ja JavaScript-asetukset Lisäasetukset-kohdassa.

CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun verkkosivulla. Kun
käytät sivun muotoiluun CSS:ää, erotat sisällön esityksestä. Sivun sisältö (HTML-koodi) sijaitsee itse HTML-tiedostossa ja koodin esityksen
määrittävät CSS-säännöt puolestaan sijaitsevat toisessa tiedostossa (ulkoisessa tyyliarkissa) tai HTML-julkaisun sisällä (tavallisesti Otsikko-
osiossa). Voit esimerkiksi määrittää valitulle tekstille eri kirjasinkokoja ja käyttää CSS:ää määrittämään Web-sivun lohkotason elementtien muodon
ja sijoittelun.

XHTML-muotoon vietäessä voit luoda CSS-tyylien luettelon, joka näkyy HTML-tiedoston Otsikko-osiossa määritteiden
kanssa.
Jos Sisällytä tyylimääritykset on valittu, InDesign yrittää muodostaa InDesingin tekstimuotoilua vastaavat CSS-määritteet. Jos tätä asetusta
ei ole valittu, HTML-tiedostossa on tyhjät määritteet. Voit muokata näitä määritteitä myöhemmin Dreamweaverissa.
Jos Säilytä paikalliset ohitukset on valittu, paikalliset muotoilut, kuten kursiivi ja lihavointi on sisällytetty.

Jos valitset tämän asetuksen, HTML-tiedostoon ei luoda CSS-osiota.

Määritä olemassa olevan CSS-tyyliarkin URL-osoite (yleensä suhteellinen URL, esimerkiksi "/styles/tyyli.css").
InDesign ei tarkista, onko CSS olemassa tai kelvollinen, joten vahvista ulkoisen CSS:n asetukset Dreamweaverissa.

Määritä CSS Lisää tyyliarkki -painikkeella.

Valitse Linkitä ulkoiseen JavaScriptiin, jos haluat suorittaa JavaScript-komentosarjan, kun HTML-sivu avataan. Määritä
JavaScriptin URL-osoite (yleensä suhteellinen URL). InDesign ei tarkista, onko JavaScript olemassa tai kelvollinen.
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Sisällön vieminen EPUB-muotoon | CS5.5

Huomautus:

Alkuun

Alkuun

Sisällytä dokumentin metatiedot

Lisää julkaisijan kirjaus

Ainutkertainen tunniste

EPUB-kansi

Ei kansikuvaa

EPUB-resurssit
Yleiset EPUB-vientiasetukset
EPUB-kuvien asetukset
EPUB-sisältöasetukset

Voit viedä julkaisun tai kirjan sijoitettavana EPUB-muotoisena eKirjana, joka on yhteensopiva Adobe Digital Editions -lukuohjelmiston ja muiden
eKirjojen lukuohjelmistojen kanssa.

1. Tee jokin seuraavista:

Avaa dokumentti ja valitse Tiedosto > Vie.

Avaa kirja ja valitse Kirja-paneelin valikosta Vie kirja EPUB-muotoon.

2. Määritä tiedoston nimi ja sijainti.

3. Valitse Tallennusmuoto-luettelosta EPUB ja sitten Tallenna.

4. Määritä haluamasi asetukset EPUB-vientiasetukset -valintaikkunan Yleiset-, Kuva- ja Sisältö-kohdissa.

InDesign luo yhden .epub-tiedoston, joka sisältää XHTML-sisällön. Vietävä tiedosto voi sisältää kansikuvan, mikäli se on määritetty. Kansikuva
luodaan kuvasta tai rasteroimalla määritetyn julkaisun ensimmäinen sivu (tai tyylilähdejulkaisu, jos valittiin kirja). EKirja yksilöidään miniatyyrikuvan
avulla EPUB-lukuohjelmistoissa tai Digital Editions Reader -kirjastonäkymässä. Tiedoston katselemista varten tarvitset EPUB-lukuohjelmiston. Voit
myös käyttää Adobe Digital Editions -ohjelmistoa, jonka voi ladata ilmaiseksi Adoben sivustosta.

.epub-tiedosto on käytännössä .zip-tiedosto. Voit tarkastella ja muokata .EPUB-tiedoston sisältöä vaihtamalla tiedostotunnisteeksi .zip ja
purkamalla sisällön. Tämä on erityisen kätevää esimerkiksi CSS-tiedoston muokkaamista varten.

InDesign-objektit, kuten tekstikehykset ja sijoitettuja kuvia sisältävät objektit, viedään aina, kun valitset Sivuasettelun perusteella -
järjestysasetuksen. Tyhjiä objekteja ei viedä, paitsi jos olet määrittänyt InDesign-objektin Objektin vientiasetukset -kohdassa vietäväksi JPEG-,
GIF- tai PNG-muodossa.

EPUB-resurssit
Seuraavia linkkejä napsauttamalla voit perehtyä EPUB-muotoon.

Lisätietoja EPUB-muodosta on sivustossa www.idpf.org.

Lataa ilmainen Digital Editions -lukuohjelmisto osoitteesta www.adobe.com/fi/products/digitaleditions.

Lisätietoja Digital Editionsista löytyy Digital Editions -blogista.

Lisätietoja viennistä Kindleen on julkaisussa InDesignista Kindleen.

Opi muuntamaan InDesign-tiedostot EPUB-muotoon ja aloita Apple iPadilla katseltavissa olevien sähköisten kirjojesi myynti. Lisätietoa on
white paper -julkaisussa. Perehdy White paper -julkaisuun InDesignista iPadiin.

Yleiset EPUB-vientiasetukset
EPUB-vientiasetukset-valintaikkunan Yleiset-osa sisältää seuraavat asetukset.

Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon.

Määritä tässä eKirjan metatietoihin sisällytettävät julkaisijatiedot. Voit määrittää esimerkiksi julkaisijan URL-osoitteen,
jotta eKirjan vastaanottaja voi siirtyä julkaisijan sivustoon ja ostaa eKirjan.

Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Voit määrittää ainutkertaisen tunnisteen määreen. Jos jätät
tämän kentän tyhjäksi, ainutkertainen tunniste luodaan automaattisesti.

Määrittää eKirjan kansikuvan. Valitse yksi seuraavista:

Jos tämä asetus on valittuna, eKirjaan ei lisätä kansikuvaa.
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Rasteroi ensimmäinen sivu

Käytä aiemmin luotua kuvatiedostoa

Tilaaminen

Kirjan reunus

Luettelomerkit

Numerot

Osoita järjestettyyn luetteloon

Osoita kiinteään järjestettyyn luetteloon

Tekstiksi muuntaminen

Näytä EPUB viennin jälkeen

Alkuun

Säilytä sivuasettelun ulkoasu

Tarkkuus (ppi)

Kuvan koko

Kuvan tasaus ja välistys

Lisää sivunvaihto

Asetukset koskevat ankkuroituja objekteja

Kuvan muuntaminen

GIF-asetukset (Paletti)

Jos tämä asetus on valittuna, eKirjan ensimmäinen sivu rasteroidaan ja siitä luodaan kuvatiedosto, jota
käytetään kantena.

Jos tämä asetus on valittuna, voit valita tietokoneesta kuvan, jota käytetään kantena.

antaa sinun määrittää sivuelementtien viestijärjestyksen.
Perusta sivuasetteluun
Lukemisjärjestys määräytyy sivulla olevien kohteiden sijainnin perusteella.
Jos valitset Perusta sivuasetteluun, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä alas.
Muotoiluelementit eivät välttämättä ole kaikissa tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, halutussa lukujärjestyksessä.
Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
(Vain aasialaiset versiot) Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen julkaisun sidonnan mukaan
(vasemmalta oikealle tai oikealta vasemmalle). Viedyt muotoiluelementit eivät välttämättä ole halutussa lukujärjestyksessä kaikissa tapauksissa,
kuten monimutkaisissa monipalstaisissa julkaisuissa. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
Sama kuin XML-rakenne
Lukemisjärjestys määräytyy rakennenäkymässä olevien nimiöiden järjestyksen perusteella. Katso Sivukohteiden nimiöiminen.
Sama kuin artikkelipaneelissa
Lukemisjärjestys määräytyy Artikkelit-paneelissa olevien elementtien järjestyksen perusteella. Vain valitut artikkelit viedään. Katso Artikkeleiden
sisällyttäminen vientiä varten.

Määritä yksinkertainen reunus Ems- tai pikselimuodossa. Reunusten määrittäminen Ems-muodossa takaa yhteensopivuuden
useiden näyttöjen kanssa paremmin. Samaa arvoa käytetään kaikkiin reunuksiin: ylös, alas, vasemmalle ja oikealle.

Valitse Osoita järjestämättömään luetteloon, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohteiksi, jotka muotoillaan
HTML-muotoon <ul>-nimiöllä. Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä. Jos olet käyttänyt InDesignin
alkuperäisiä automaattisia luettelomerkkejä, myös aliluettelomerkit sisällytetään.

Määrittää, kuinka numerot muunnetaan HTML-tiedostossa. Jos olet käyttänyt InDesignin alkuperäistä automaattista numerointia, myös
aliluettelomerkit sisällytetään.

Muuntaa numeroidut luettelot Luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.

Muuntaa numeroidut luettelot Luettelokohteiksi ja liittää <value>-määritteen, joka perustuu
kappaleen nykyiseen numeroon InDesignissa.

Muuntaa numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

Käynnistää Adobe Digital Editions -ohjelmiston, jos se on asennettu.

EPUB-kuvien asetukset
Digital Editions -vientiasetukset -valintaikkunan Kuvat-osa sisältää seuraavat asetukset. Määritä Kuvien muuntaminen -valikossa, kuinka kuvat
viedään HTML-muotoon.

Valitse tämä vaihtoehto, jos haluat käyttää sivuasettelussa olevia kuvaobjektien määritteitä.

Määritä kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi, mobiililaitteissa
tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). Voit määrittää kullekin valitulle objektille ppi-arvon.
Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Määritä, käytetäänkö kiinteää kuvakokoa vai suhteutetaanko se sivukokoon. Sivukokoon suhteutettu asetus määrittää suhteellisen
prosenttiarvon InDesign-sivuleveyteen suhteutetun kuvakoon perusteella. Tätä asetusta käytettäessä kuvat skaalataan suhteessa lukualueen
leveyteen.

Määritä kuvan tasaus, täyttö vasemmalle, keskelle, oikealle, ylös ja alas.

Valitse tämä vaihtoehto, jos haluat lisätä kuviin sivunvaihtoja. Sivunvaihtoja voidaan lisätä ennen kuvaa, kuvan jälkeen tai
ennen kuvaa ja kuvan jälkeen.

Valitse tämä vaihtoehto, jos haluat käyttää näitä asetuksia kaikkien ankkuroitujen objektien kanssa.

Voit valita, muunnetaanko dokumentin optimoidut kuvat GIF-, JPEG- tai PNG-muotoon. Valitse Automaattinen, jos haluat,
että InDesign päättää, mitä muotoa kussakin tapauksessa käytetään. PNG-asetuksen valinta poistaa kuvien pakkausasetukset käytöstä. Käytä
PNG-asetusta häviöttömiin tai läpinäkyviin kuviin.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.
Valitse Sovitettu, jos haluat luoda paletin käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla. Valitse Web, jos haluat muodostaa paletin Web-käyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

JPEG-asetukset (kuvan laatu)

JPEG-asetukset (muotoilumenetelmä)

Ohita objektin muunnosasetukset

Alkuun

EPUB-sisällönmuoto

Käytä InDesignin sisällysluettelon tyyliä

Jaottele dokumentti kappaletyylin perusteella

Sijoita alaviite kappaleen jälkeen

Poista pakotetut rivinvaihdot

Luo CSS

Sisällytä tyylimääritykset

Säilytä paikalliset ohitukset

Sisällytä upotettavat kirjasimet

Vain tyylinimet

Käytä aiemmin luotua CSS-tiedostoa

järjestelmävärien osajoukko. Valitse Järjestelmä (Win) tai Järjestelmä (Mac), jos haluat luoda paletin käyttämällä järjestelmän omaa väripalettia.
Tämä valinta voi aiheuttaa odottamattomia tuloksia.
Valitse Lomita, jos haluat ladata kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta
ja selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määrittää kullekin JPEG-kuvalle tilanteeseen parhaiten sopivan pakkauksen (pienemmät tiedostokoot) ja kuvan
laadun. Matala-asetus tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.

Määrittää, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan Web-
sivulla. Valitse Etenevä, jos haluat JPEG-kuvien avautuvan vähitellen ja tarkentuvan Web-selaimen ladatessa niitä. (Tällä asetuksella luodut
tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.) Valitse Perusviiva, jos haluat, että kukin JPEG-tiedosto näkyy
vasta latauksen päätyttyä. Tiedoston paikalla on latauksen aikana paikkamerkki.

Ohittaa yksittäisiin kuviin käytetyt objektin vientiasetukset. Katso Objektin vientiasetusten käyttäminen.

EPUB-sisältöasetukset
EPUB-asetukset-valintaikkunan Sisältö-osa sisältää seuraavat asetukset.

Määritä, haluatko käyttää XHTML- vai DTBook-muotoa. DTBook on erikoismuoto, joka on tarkoitettu näkövammaisille
lukijoille.

Valitse tämä asetus, jos haluat luoda valittuun sisällysluettelon tyyliin perustuvan sisällysluettelon.
Määritä Sisällysluettelon tyyli -luettelossa eKirjan sisällysluettelon luontiin käytettävä sisällysluettelon tyyli. Voit luoda eKirjalle yksilöllisen
sisällysluettelon tyylin valitsemalla Sivuasettelu > Sisällysluettelon tyylit.

Voit jakaa eKirjan määritetyn kappaletyylin perusteella. Jakamisen seurauksena EPUB-paketti
sisältää enemmän HTML-tiedostoja, mutta pitkien tiedostojen jakaminen voi olla hyödyllistä, ja se lisää EPUB-lukuohjelmistojen suorituskykyä.

Valitse tämä vaihtoehto, jos haluat sijoittaa alaviitteet kappaleen jälkeen. Jos valinta poistetaan, alaviitteet
muunnetaan loppuviitteiksi.

Valitse tämä vaihtoehto, jos haluat viedystä eKirjasta kaikki pakotetut rivinvaihdot.

CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun Web-sivulla. Kun käytät
sivun muotoiluun CSS:ää, erotat sisällön esityksestä.

Kun viet EPUB-muodossa, voit luoda muokattavan luettelon CSS-tyyleistä.

Jos tämä asetus on valittu, paikalliset muotoilut, kuten kursiivi ja lihavointi, on sisällytetty.

Sisällytä kaikki upotettavat kirjasimet eBook-kirjaan. Kirjasimiin sisältyy upotusmääritys, joka määrittää,
onko kirjasimen upottaminen sallittu.

Sisällyttää vain määrittämättömät tyylinimet EPUB-tyyliarkkiin.

Määritä olemassa olevan CSS-tyyliarkin URL-osoite (yleensä suhteellinen URL, esimerkiksi
"/tyylit/tyyli.css"). InDesign ei tarkista, onko CSS olemassa tai kelvollinen, joten vahvista ulkoisen CSS:n asetukset.
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Vieminen

Alkuun

Alkuun

Alkuun

Tekstin vieminen
Sisällön vieminen Web-käyttöön
Sisällön vieminen Dreamweaveriin (CS5)
Sisällön vieminen EPUB-muotoon (CS 5)
Sisällön vieminen Buzzwordiin
Web-värimallikirjaston käyttäminen

Tekstin vieminen
InDesign-jutun voi tallentaa kokonaan tai osittain sellaisissa tiedostomuodoissa, jotka voi avata muissa ohjelmissa. Kukin juttu viedään erilliseen
tiedostoon.

InDesign voi viedä tekstiä eri muodoissa. Vaihtoehdot näkyvät Vie-valintaikkunan luettelossa. Tiedostomuodot ovat muiden ohjelmien mukaisia. Ne
saattavat säilyttää julkaisun tekstimääritteet, sisennykset ja sarkaimet.

Voit tallentaa yleisesti käytettyjen tekstin ja sivuasettelun kohteiden osia katkelmina.

1. Napsauta vietävässä jutussa tekstityökalulla .
2. Valitse Tiedosto > Vie.
3. Määritä vietävän jutun nimi ja sijainti ja valitse Tallennusmuoto- (Windows) tai Muoto-kohdassa (Mac OS) tekstitiedostomuoto.

Jos käyttämäsi tekstinkäsittelyohjelma ei ole luettelossa, voit tallentaa julkaisun muotoon, jonka voi tuoda ohjelmaan (esimerkiksi RTF-
muoto). Jos tekstinkäsittelyohjelma ei tue muita InDesignin vientimuotoja, käytä vain teksti -muotoa. Vain teksti -muodossa viedystä
tiedostosta poistetaan kaikki merkkimääritteet.

4. Vie tiedosto valitussa muodossa valitsemalla Tallenna.

Jos haluat säilyttää kaikki muotoilut, käytä Adobe InDesignin nimiöity teksti -vientisuodinta. Lisätietoja on nimiöityä tekstiä käsittelevässä PDF-
tiedostossa osoitteessa www.adobe.com/go/learn_id_taggedtext_cs5_fi (PDF).

Sisällön vieminen Web-käyttöön
Jos haluat muuntaa InDesign-sisällön Web-käyttöön, käytössäsi on useita vaihtoehtoja:

Dreamweaver (XHTML) Vie koko julkaisun tai osia siitä muotoilemattomaan HTML-perusjulkaisuun. Voit muodostaa linkkejä palvelimella oleviin
kuviin tai luoda kuville erillisen kansion. Voit muotoilla sisällön Web-käyttöön millä tahansa HTML-editorilla, kuten Adobe Dreamweaver® -
ohjelmalla. Lisätietoja: Sisällön vieminen Dreamweaveriin (CS5).
Kopioiminen ja liittäminen Kopioi tekstin tai kuvat InDesign-julkaisusta ja liittää ne HTML-editoriin.
Adobe PDF Vie julkaisu Adobe PDF -muotoon ja julkaise PDF-tiedosto Webissä. PDF voi sisältää vuorovaikutteisia elementtejä, kuten elokuvia,
äänileikkeitä, painikkeita ja sivun siirtymiä. Lisätietoja: Dynaamiset PDF-julkaisut.
Flash (SWF) Vie SWF-tiedostoon, jota voi välittömästi katsella Flash Playerissä tai Internetissä. SWF-tiedosto voi sisältää painikkeita,
hyperlinkkejä ja sivun siirtymiä, kuten pyyhkäisy, ristikuva ja sivun kääntö. Lisätietoja: Luo vuorovaikutteisia SWF (Flash) -tiedostoja web-
käyttöön.
Flash (FLA) Vie FLA-tiedostoon, jota voi muokata Adobe Flash Professionalissa. Lisätietoja: Luo FLA-tiedostoja web-käyttöön.
Digital Editions (EPUB) Vie julkaisu tai kirja sijoitettavana XHTML-pohjaisena e-kirjana, joka on yhteensopiva Adobe Digital Editions -ohjelmiston
kanssa. Katso Sisällön vieminen EPUB-muotoon (CS 5).
XML Jos haluat käyttää edistyneempiä muuntamistyönkulkuja, vie sisältö InDesignista XML-muodossa, jonka voit sitten tuoda HTML-editoriin
(esimerkiksi Dreamweaveriin). Lisätietoja: XML:n käyttäminen.

Sisällön vieminen Dreamweaveriin (CS5)
XHTML:ään vieminen on helppo tapa saada InDesign-sisältö Web-valmiiseen muotoon. Kun viet sisältöä XHTML-muodossa, voit valita kuinka
teksti ja kuvat viedään. InDesign säilyttää viedyssä sisällössä käytettyjen kappale-, merkki-, objekti-, taulukko- ja solutyylien nimet merkitsemällä
XHTML-sisällön samannimisillä CSS-tyyliluokilla. Adobe Dreamweaverillä tai muulla CSS-yhteensopivalla HTML-editorilla voit nopeasti ottaa
sisällössä käyttöön muotoiluja sekä asetteluja.

Vietävät kohteet InDesign vie kaikki jutut, linkitetyt ja upotetut kuvat, SWF-elokuvatiedostot, alaviitteet, tekstimuuttuja (tekstinä), luettelomerkityt ja
numeroidut luettelot, sisäiset ristiviittaukset sekä tekstiin tai Web-sivuille siirtävät hyperlinkit. Myös taulukot viedään, mutta tiettyjä muotoiluja, kuten
taulukon ja solun viivoja, ei viedä. Taulukoille annetaan yksilöivät tunnisteet, jotta niihin voidaan viitata Spry-tietojoukkoina Dreamweaverissa.
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Viemättä jäävät kohteet InDesign ei vie itse piirtämiäsi kohteita (kuten suorakulmioita, ellipsejä ja monikulmioita), elokuvatiedostoja (muut kuin
SWF), hyperlinkkejä (muut kuin Web-sivujen linkit sekä tekstilinkit, jotka siirtävät saman julkaisun tekstiankkureihin), liitettyjä objekteja (myös liitetyt
Illustrator-kuvat), ääriviivoiksi muunnettua tekstiä, XML-nimiöitä, kirjoja, kirjanmerkkejä, SING-glyyfejä, sivun siirtymiä, hakemistomerkkejä,
taittopöydän kohteita, joita ei ole valittu ja jotka eivät koske sivua, eikä sivupohjakohteita (ellei niitä korvata tai valita ennen vientiä).

1. Jos et aio viedä koko julkaisua, valitse vietävät tekstikehykset, tekstialue, taulukkosolut tai grafiikka.
2. Valitse Tiedosto > Vie > Dreamweaver-ohjelmaan.
3. Määritä HTML-julkaisun nimi ja sijainti ja valitse Tallenna.
4. Määritä haluamasi asetukset XHTML-vientiasetukset-valintaikkunan Yleiset-, Kuvat- ja Lisäasetukset-kohdissa ja valitse Vie.

Ohjelma luo julkaisun käyttämällä määritettyä nimeä sekä .html-tunnistetta (kuten uutiskirje.html). Jos Web-kuvien alikansio (kuten
uutiskirjeen_Web-kuvat) on määritetty, se tallennetaan samaan sijaintiin.

XHTML-vientiasetukset
Määritä seuraavat asetukset XHTML-valintaikkunassa (Tiedosto > Vie > Dreamweaver-ohjelmaan).

Yleiset asetukset
Yleiset-kohta sisältää seuraavat asetukset.

Vieminen Määrittää, viedäänkö koko julkaisu vai vain valitut kohteet. Jos valittuna on tekstikehys, koko juttu, mukaan lukien ylijuokseva teksti,
viedään.
Jos valitset julkaisun, kaikkien aukeamien kaikki sivukohteet viedään, lukuun ottamatta näkymättömien tasojen sivukohteita sekä sivupohjakohteita,
joita ei ole ohitettu. Myös XML-nimiöt ja luodut hakemistot ja sisällysluettelot ohitetaan.

Luettelomerkit Valitse Osoita järjestämättömään luetteloon, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohteiksi, jotka muotoillaan
HTML-muotoon <ul>-nimiöllä. Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä.
Tilaaminen Käytä joko sivujärjestystä tai XML-rakennetta sivuobjektien lukemisjärjestyksen määritykseen.
Jos valitset Perusta sivuasetteluun, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä alas.
Muotoiluelementit eivät välttämättä ole kaikissa tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, halutussa lukujärjestyksessä.
Voit muotoilla ja järjestää sisältöä Dreamweaverissa.

Jos valitset Sama kuin XML-rakenne, XML-rakennepaneeli määrää viedyn sisällön järjestyksen ja sen, mitä sisältöä viedään. Jos sisältö on jo
nimiöity, voit vain vetää nimiöitä XML-rakennepaneeliin ja asettaa XHTML:n vientijärjestyksen. Jos sisältöä ei ole nimiöity, voit valita Lisää
nimiöimättömät kohteet XML-rakennepaneelista ja tuottaa nimiöt, jotka voit sitten järjestää uudelleen. Jos et halua kohdetta sisällytettävän vientiin,
voit vain poistaa nimiön XML-rakennepaneelista. (Nimiön poistaminen ei poista sisältöä INDD-tiedostosta.) Lisätietoja: Sivukohteiden nimiöiminen.

Numerot Määrittää, miten numerot muunnetaan HTML-tiedostossa.

Osoita järjestettyyn luetteloon  Muuntaa numeroidut luettelot Luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.
Osoita kiinteään järjestettyyn luetteloon  Muuntaa numeroidut luettelot Luettelokohteiksi ja liittää <value>-määritteen, joka perustuu
kappaleen nykyiseen numeroon InDesignissa.
Tekstiksi muuntaminen  Muuntaa numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

Kuvien asetukset
Määritä Kopioi kuvat -valikossa, kuinka kuvat viedään HTML-muotoon.

Alkuperäinen Vie alkuperäisen kuvan Web-kuvien alikansioon. Kun tämä asetus on valittuna, muita asetuksia ei voi valita.
Optimoitu Voit asetuksia muuttamalla määrittää, kuinka kuva viedään.

Muotoiltu  Säilyttää InDesign-muotoilun (esimerkiksi kierron ja skaalauksen) mahdollisimman hyvin Web-kuvissa.
Kuvan muuntaminen  Voit valita, muunnetaanko julkaisun kuvat GIF- tai JPEG-muotoon. Valitse Automaattinen, jos haluat, että InDesign
päättää, mitä muotoa kussakin tapauksessa käytetään.
GIF-asetukset (Paletti)  Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään
rajoitettua väripalettia, jossa voi olla enintään 256 väriä.
Valitse Sovitettu (ei sirontaa), jos haluat luoda paletin käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien
simulointia pieniä väripisteitä sekoittamalla. Valitse Web, jos haluat muodostaa paletin Web-käyttöön sopivista väreistä, jotka ovat
Windows- ja Mac OS -järjestelmävärien osajoukko. Valitse Järjestelmä (Win) tai Järjestelmä (Mac), jos haluat luoda paletin käyttämällä
järjestelmän omaa väripalettia. Tämä valinta voi aiheuttaa odottamattomia tuloksia.

JPEG-asetukset (kuvan laatu)  Määrittää kullekin JPEG-kuvalle tilanteeseen parhaiten sopivan pakkauksen (pienemmät tiedostokoot) ja
kuvan laadun. Matala-asetus tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.
JPEG-asetukset (muotoilumenetelmä)  Määrittää, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
Web-sivulla. Valitse Etenevä, jos haluat JPEG-kuvien avautuvan vähitellen ja tarkentuvan Web-selaimen ladatessa niitä. (Tällä asetuksella
luodut tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.) Valitse Perusviiva, jos haluat, että kukin JPEG-
tiedosto näkyy vasta latauksen päätyttyä. Tiedoston paikalla on latauksen aikana paikkamerkki.

Palvelinpolun linkki Tällä asetuksella kuvia ei viedä alikansioon, vaan niille annetaan paikallinen URL-osoite (esimerkiksi "kuvat/"), joka näkyy
kuvatiedoston edessä. Linkkimäärite näyttää määrittämäsi reitin ja tunnisteen HTML-koodissa. Tämä asetus on erityisen tehokas, kun olet itse
muuntamassa kuvia Web-yhteensopiviksi kuviksi.
Huomautus: InDesign ei tarkista Java™-komentosarjoille, ulkoisille CSS-tyyleille tai kuvakansioille määrittämääsi reittiä, joten vahvista reitit
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Dreamweaverissa.

Lisäasetukset
Määritä CSS- ja JavaScript-asetukset Lisäasetukset-kohdassa.

CSS-asetukset CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun Web-sivulla. Kun
käytät sivun muotoiluun CSS:ää, erotat sisällön esityksestä. Sivun sisältö (HTML-koodi) sijaitsee itse HTML-tiedostossa ja koodin esityksen
määrittävät CSS-säännöt puolestaan sijaitsevat toisessa tiedostossa (ulkoisessa tyyliarkissa) tai HTML-julkaisun sisällä (tavallisesti Otsikko-
osiossa). Voit esimerkiksi määrittää valitulle tekstille eri kirjasinkokoja ja käyttää CSS:ää määrittämään Web-sivun lohkotason elementtien muodon
ja sijoittelun.

Upotettu CSS  XHTML-muotoon vietäessä voit luoda CSS-tyylien luettelon, joka näkyy HTML-tiedoston Otsikko-osiossa määritteiden
kanssa.
Jos Sisällytä tyylimääritykset on valittu, InDesign yrittää muodostaa InDesingin tekstimuotoilua vastaavat CSS-määritteet. Jos tätä asetusta
ei ole valittu, HTML-tiedostossa on tyhjät määritteet. Voit muokata näitä määritteitä myöhemmin Dreamweaverissa.

Jos Säilytä paikalliset ohitukset on valittu, paikalliset muotoilut, kuten kursiivi ja lihavointi on sisällytetty.

Ei CSS-määrittelyä  Jos valitset tämän asetuksen, HTML-tiedostoon ei luoda CSS-osiota.
Ulkoinen CSS-tiedosto  Määritä olemassa olevan CSS-tyyliarkin URL-osoite (yleensä suhteellinen URL, esimerkiksi "/styles/tyyli.css").
InDesign ei tarkista, onko CSS olemassa tai kelvollinen, joten vahvista ulkoisen CSS:n asetukset Dreamweaverissa.

JavaScript-asetukset Valitse Linkitä ulkoiseen JavaScriptiin, jos haluat suorittaa JavaScript-komentosarjan, kun HTML-sivu avataan. Määritä
JavaScriptin URL-osoite (yleensä suhteellinen URL). InDesign ei tarkista, onko JavaScript olemassa tai kelvollinen.

Sisällön vieminen EPUB-muotoon (CS 5)
Voit viedä julkaisun tai kirjan sijoitettavana EPUB-muotoisena e-kirjana, joka on yhteensopiva Adobe Digital Editions -lukuohjelmiston kanssa.

1. Kun haluat viedä julkaisun, avaa vietävä julkaisu ja valitse Tiedosto > Vie > EPUB.
2. Määritä tiedoston nimi ja sijainti ja valitse Tallenna.
3. Määritä haluamasi asetukset Digital Editions -vientiasetukset -valintaikkunan Yleiset-, Kuvat- ja Sisältö-kohdissa ja valitse OK.

InDesign luo yhden .epub-tiedoston, joka sisältää XHTML-sisällön. Vientitiedosto sisältää JPEG-miniatyyrikuvan määritetyn julkaisun
ensimmäisestä sivusta (tai tyylilähdejulkaisusta, jos valittiin kirja). Kirja yksilöidään tämän miniatyyrikuvan avulla Digital Editions Reader -
kirjastonäkymässä. Tiedoston tarkasteluun tarvitaan Digital Editions -ohjelma, jonka voi ladata ilmaiseksi Adoben sivustosta.

.epub-tiedosto on käytännössä .zip-tiedosto. Voit tarkastella ja muokata .epub-tiedoston sisältöä vaihtamalla tiedostotunnisteeksi .zip ja
purkamalla sisällön. Tämä on erityisen kätevää esimerkiksi CSS-tiedoston muokkaamista varten.

EPUB-resurssit
Luettelo EPUB-jutuista ja resursseista on osoitteessa www.adobe.com/go/learn_id_epub_fi.

Lisätietoja EPUB-muodosta on sivustossa www.idpf.org.

Lataa ilmainen Digital Editions -lukuohjelmisto osoitteesta www.adobe.com/fi/products/digitaleditions.

Lisätietoja Digital Editionsista löytyy Digital Editions -blogista.

Lisätietoja viennistä Kindleen löytyy ratkaisukuvauksesta InDesignista Kindleen.

Digital Editionsin Yleiset-vientiasetukset
Digital Editions -vientiasetukset -valintaikkunan Yleiset-osa sisältää seuraavat asetukset.

Sisällytä dokumentin metatiedot Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon.
Lisää julkaisijan kirjaus Määritä tässä eKirjan metatietoihin sisällytettävät julkaisijatiedot. Voit määrittää esimerkiksi julkaisijan URL-osoitteen,
jotta eKirjan vastaanottaja voi siirtyä Internet-sivulle ja ostaa eKirjan.
Ainutkertainen tunniste Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Voit määrittää ainutkertaisen tunnisteen määreen. Jos jätät
tämän kentän tyhjäksi, ainutkertainen tunniste luodaan automaattisesti.
Lukemisjärjestys Jos valitset Perusta sivuasetteluun, EPUB-julkaisun sivukohteiden lukemisjärjestys päätellään niiden sijainnin perusteella.
InDesign lukee vasemmalta oikealle ja ylhäältä alas. Jos haluat määrittää lukemisjärjestyksen tarkemmin, nimiöi sivukohteesi XML-
nimiöpaneelista. Jos valitset Sama kuin XML-rakenne, nimiöiden järjestys rakennenäkymässä määrää lukemisjärjestyksen. Lisätietoja:
Sivukohteiden nimiöiminen.
Luettelomerkit Valitse Osoita järjestämättömään luetteloon, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohteiksi, jotka muotoillaan
HTML-muotoon <ul>-nimiöllä. Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä.
Numerot Määrittää, miten numerot muunnetaan HTML-tiedostossa.

Osoita järjestettyyn luetteloon  Muuntaa numeroidut luettelot Luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.
Osoita kiinteään järjestettyyn luetteloon  Muuntaa numeroidut luettelot Luettelokohteiksi ja liittää <value>-määritteen, joka perustuu
kappaleen nykyiseen numeroon InDesignissa.
Tekstiksi muuntaminen  Muuntaa numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.
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Näytä eKirja viennin jälkeen Käynnistää Adobe Digital Editions -ohjelmiston, jos se on asennettu. Näyttöön tulee varoitus, jos järjestelmässä ei
ole lukuohjelmistoa, jossa voi tarkastella .epub-julkaisuja.

Digital Editionsin Kuvat-vientiasetukset
Digital Editions -vientiasetukset -valintaikkunan Kuvat-osa sisältää seuraavat asetukset. Määritä Kuvien muuntaminen -valikossa, kuinka kuvat
viedään HTML-muotoon.

Muotoiltu Säilyttää InDesign-muotoilun (esimerkiksi kierron ja skaalauksen) mahdollisimman hyvin Web-kuvissa.
Kuvan muuntaminen Voit valita, muunnetaanko julkaisun kuvat GIF- tai JPEG-muotoon. Valitse Automaattinen, jos haluat, että InDesign päättää,
mitä muotoa kussakin tapauksessa käytetään.
GIF-asetukset (Paletti) Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.
Valitse Sovitettu, jos haluat luoda paletin käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla. Valitse Web, jos haluat muodostaa paletin Web-käyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -
järjestelmävärien osajoukko. Valitse Järjestelmä (Win) tai Järjestelmä (Mac), jos haluat luoda paletin käyttämällä järjestelmän omaa väripalettia.
Tämä valinta voi aiheuttaa odottamattomia tuloksia.

Valitse Lomita, jos haluat luoda hitaasti latautuvan kuvan, jonka rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta
ja selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

JPEG-asetukset (kuvan laatu) Määrittää kullekin JPEG-kuvalle tilanteeseen parhaiten sopivan pakkauksen (pienemmät tiedostokoot) ja kuvan
laadun. Matala-asetus tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.
JPEG-asetukset (muotoilumenetelmä) Määrittää, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan Web-
sivulla. Valitse Etenevä, jos haluat JPEG-kuvien avautuvan vähitellen ja tarkentuvan Web-selaimen ladatessa niitä. (Tällä asetuksella luodut
tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.) Valitse Perusviiva, jos haluat, että kukin JPEG-tiedosto näkyy
vasta latauksen päätyttyä. Tiedoston paikalla on latauksen aikana paikkamerkki.

Digital Editionsin Sisältö-vientiasetukset
Digital Editions -vientiasetukset -valintaikkunan Sisältö-osa sisältää seuraavat asetukset.

EPUB-sisällön muoto Määritä, haluatko käyttää XHTML- vai DTBook-muotoa.
Sisällytä InDesignin sisällysluettelokohteet Valitse tämä asetus, jos haluat luoda sisällysluettelon eKirjan vasempaan reunaan. Valitse
eKirjassa käytettävä sisällysluettelon tyyli Sisällysluettelon tyyli -valikosta. Voit luoda eKirjalle yksilöllisen sisällysluettelon tyylin valitsemalla
Sivuasettelu > Sisällysluettelon tyylit.
Estä julkaisujen automaattiset kirjaukset Valitse tämä asetus, jos et halua julkaisujen nimien näkyvän eKirjan sisällysluettelossa. Tämä asetus
on erityisen hyödyllinen, kun luot eKirjan kirjasta.
Käytä ensimmäisen tason merkkejä kappaleenvaihtoina Valitse tämä asetus, jos haluat jakaa e-kirjan useisiin tiedostoihin siten, että jokainen
tiedosto alkaa ensimmäisen tason sisällysluettelomerkinnästä. Jos sisältötiedoston koko ylittää 260 kb, uusi tiedosto aloitetaan ensimmäisen tason
merkintöjen välissä olevasta kappaleesta, jotta vältetään 300 kb:n raja.
Luo CSS CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun Web-sivulla. Kun käytät
sivun muotoiluun CSS:ää, erotat sisällön esityksestä.

Sisällytä tyylimääritykset  Kun viet EPUB-muodossa, voit luoda muokattavan luettelon CSS-tyyleistä.
Säilytä paikalliset ohitukset  Jos tämä asetus on valittu, paikalliset muotoilut, kuten kursiivi ja lihavointi on sisällytetty.
Sisällytä upotettavat kirjasimet  Valinta sisällyttää eKirjaan kaikki kirjasimet, jotka voidaan upottaa. Kirjasimiin sisältyy upotusmääritys,
joka määrittää, onko kirjasimen upottaminen sallittu.

Vain tyylinimet Tämän asetuksen valinta sisällyttää vain määrittämättömät tyylinimet EPUB-tyyliarkkiin.
Käytä aiemmin luotua CSS-tiedostoa Määritä olemassa olevan CSS-tyyliarkin URL-osoite (yleensä suhteellinen URL, esimerkiksi
"/styles/tyyli.css"). InDesign ei tarkista, onko CSS olemassa tai kelvollinen, joten vahvista ulkoisen CSS:n asetukset.

Sisällön vieminen Buzzwordiin
Buzzword on web-pohjainen tekstieditori, jolla voi luoda ja tallentaa tekstitiedostoja web-palvelimelle. Kun viet jutun Buzzwordiin, luot
tekstitiedoston Buzzword-palvelimelle.

1. Valitse teksti tai sijoita lisäyskohta tekstikehykseen, joka kuuluu vietävään juttuun.

2. Tee jokin seuraavista:

Valitse InDesignissa Tiedosto > Vie > Buzzwordiin.

Valitse InCopyssa Tiedosto > Vie Buzzwordiin.

3. Jos et ole vielä kirjautunut CS Liveen, napsauta Kirjaudu, anna sähköpostiosoitteesi ja salasanasi ja valitse Kirjaudu.

4. Määritä Vie juttu Buzzwordiin -valintaikkunassa luotavan Buzzword-julkaisun nimi ja valitse sitten OK.

Buzzword-julkaisu avataan Acrobat.com-sivustolla. Voit siirtää julkaisun toiseen työtilaan ja jakaa sen muiden kanssa.
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InDesignissa on Web-värimallikirjasto. Se sisältää värejä, joita useimmat Web-selaimet käyttävät tekstin ja grafiikan esittämiseen. Kirjaston 216:ta
väriä kutsutaan usein nimellä Web-turvalliset värit. Ne näkyvät samanlaisina eri ympäristöissä, sillä selaimet käyttävät niitä sekä Windows- että
Mac OS -järjestelmässä. InDesignin Web-turvalliset-värit ovat samoja kuin Adobe Photoshopin Web-turvallisten värien paletin ja Adobe Illustratorin
selainväripaletin värit.

Jokaiselle paletin uudelle värille annetaan nimi RGB-arvon mukaan. Kullakin värillä on kuusidesimaalinen koodi, jota HTML käyttää värien
määrittelyyn. Koodi on tallennettu värimalliin.

1. Valitse Värimallit-paneelivalikosta Uusi värimalli.
2. Valitse Väritilaksi Web.
3. Valitse ensin Web-turvallinen väri ja sitten OK.

Lisää ohjeaiheita
  Sisällön lisääminen sivuille

  Sivujen luominen CSS:n kanssa

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Julkaisun sisällön vieminen XML:ään
Optimoitujen kuvien vientiasetukset
Nimiöiden tallentaminen vain XML-muodossa
Viedyn XML-tiedoston muokkaaminen

Julkaisun sisällön vieminen XML:ään
Seuraavat toimenpiteet on tehtävä ennen kuin sisältöä voi viedä InDesign-julkaisusta XML:ään:

luoda ja ladata elementtinimiöt

lisätä nimiöt julkaisun sivuilla oleviin eri kohteisiin

säätää tarvittaessa nimiöityjen elementtien hierarkiaa Rakenne-ruudussa.

Voit viedä kaikki tai osan julkaisun XML-sisällöstä. Vain nimiöidyn sisältö voidaan viedä.

Tärkeää: Vietäessä taulukoita sisältävää julkaisua, taulukot täytyy nimiöidä. Muussa tapauksessa InDesign ei vie niitä osana XML:ää.
1. Jos haluat viedä vain osa julkaisusta, valitse rakenneruudusta elementti, josta haluat viennin alkavan.
2. Valitse Tiedosto > Vie.
3. Valitse Tallennusmuoto- (Windows) tai Muoto-kohdasta (Mac OS) XML.
4. Määritä XML-tiedoston nimi ja sijainti ja valitse Tallenna.
5. Valitse jokin seuraavista Vie XML -valintaikkunan Yleiset-välilehdestä:

Sisällytä DTD-määrite Vie viitteen DTD-tiedostoon XML-tiedoston mukana. Tämä asetus on käytettävissä vain, jos Rakenne-ruudussa on
DOCTYPE-elementti.

Näytä XML käyttämällä Avaa viedyn tiedoston selaimessa, XML-muokkaussovelluksessa tai tekstinkäsittelyohjelmassa. Valitse selain tai
ohjelma luettelosta.

Vie valitusta elementistä Aloittaa viennin Rakenne-ruudussa valitusta elementistä. Tämä asetus on käytettävissä vain, jos elementti on
valittu ennen kuin Tiedosto > Vie valitaan.

Vie nimiöimättömät taulukot CALS XML -tiedostoina Vie nimiöimättömät taulukot CALS XML -muodossa. Taulukon on oltava
nimiöimätön ja nimiöidyssä kehyksessä, jotta sen voi viedä.

Osoita uudelleen vaihdot, tyhjät tilat ja erikoismerkit Vie vaihdot, tyhjät tilat ja erikoismerkit desimaalimerkkikokonaisuuksina pelkkien
merkkien sijaan.

Käytä XSLT:tä Lisää tyylitiedoston, jolla määritetään tuodun XML-tiedoston muuntaminen esimerkiksi muokatuksi XML-puuksi tai HTML-
tiedostoksi. Valitse Selaa (Windows) tai Valitse (Mac OS) ja valitse XSLT tiedostojärjestelmästä. Oletusasetus Käytä XML-tyylilomaketta
käyttää XSLT-muunnosohjetta, jos viennissä käytettävässä XML-tiedostossa viitataan tällaiseen ohjeeseen.

6. Valitse koodaustyyppi Koodaus-valikosta.
7. Jos haluat määrittää kuvien vientiasetukset, valitse Kuvat-välilehti ja vähintään yksi seuraavista vaihtoehdoista:

Alkuperäiset kuvat Sijoittaa kopion alkuperäisistä kuvatiedostoista Kuvat-alikansioon.

Optimoidut alkuperäiset kuvat Optimoi ja pakkaa alkuperäiset kuvatiedostot ja sijoittaa tiedostojen kopiot Kuvat-alikansioon.

Optimoidut muotoillut kuvat Optimoi alkuperäiset kuvatiedostot, jotka sisältävät muunnoksia (esimerkiksi kiertoa tai skaalausta), ja sijoittaa
ne Kuvat-alikansioon. Jos julkaisussa on esimerkiksi kaksi kuvaa, joista toinen on rajattu ja toinen ei, vain rajattu kuva optimoidaan ja
kopioidaan Kuvat-alikansioon.

8. Jos valitsit edellisessä vaiheessa Optimoidut alkuperäiset kuvat- tai Optimoidut muotoillut kuvat -asetuksen, valitse asetukset kuvien
optimoimista varten.

9. Valitse Vie.

Huomautus: XML ei tue kaikkia erikoismerkkejä (kuten automaattisen sivunumeron merkkiä). InDesign varoittaa, jos merkkiä ei voi sisällyttää
vietyyn XML-tiedostoon. Tämä varoitus tulee näkyviin myös, jos et ole nimiöinyt taulukkoa.

Optimoitujen kuvien vientiasetukset
Voit käyttää seuraavia asetuksia, kun valitset Vie XML -valintaikkunan Kuvat-välilehdestä Optimoidut alkuperäiset kuvat- tai Optimoidut muotoillut
kuvat -asetuksen.
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Kuvan muuntaminen Määrittää muunnettavassa kuvassa käytettävän tiedostomuodon. Jos valitset Automaattinen, InDesign valitsee kuvan
perusteella parhaan tiedostotyypin. Haluat ehkä määrittää sekä GIF- että JPEG-asetukset.
GIF-asetukset Määritä XML-viennissä GIF-muotoon muunnettavien kuvien muotoilu. Voit määrittää seuraavat asetukset:

Paletti  Määrittää väripaneelin, jota muunnettavan kuvan pitää noudattaa. Valitse XML-sisällön lopullisen näyttömuodon paneeli. Sovitettu
(ei sirontaa) -vaihtoehto toimii hyvin pääasiassa tasaisia värejä käyttävien kuvien kanssa, ja sitä voidaan käyttää, kun lopullinen tulostus
tehdään useisiin muotoihin.
Lomita  Kuvasta ladataan kullakin läpikäynnillä joka toinen rivi sen sijaan, että koko kuva ladattaisiin kerralla yhdellä läpikäynnillä.
Esikatselukuva latautuu lomituksen ansiosta nopeasti – jokainen peräkkäinen läpikäynti kasvattaa resoluutiota, kunnes lopullinen laatutaso
on saavutettu.

JPEG-asetukset Määritä XML-viennissä JPEG-muotoon muunnettavien kuvien muotoilu. Voit määrittää seuraavat asetukset:

Kuvan laatu  Määrittää muunnettavan kuvan laadun. Mitä suuremmaksi laatuasetus säädetään, sitä suurempi tiedostosta tulee ja sitä
kauemmin lataaminen kestää.
Muotoilumenetelmä  Määrittää JPEG-kuvan muodon latausta varten. Perusviiva lataa lopullista laatutasoa edustavan kuvan yhdellä
läpikäynnillä, joten tiedosto näkyy heti avauduttuaan laadullisesti valmiissa ulkoasussaan. Lataaminen voi kuitenkin kestää kauemmin kuin
Etenevä-muotoilua noudattavan kuvan kohdalla. Etenevä-asetus lataa kuvan läpikäyntien sarjoina. Ensimmäinen versio on resoluutioltaan
matala, mutta jokainen seuraava läpikäynti kasvattaa tasaisesti kuvan resoluutiota, kunnes lopullinen laatutaso on saavutettu.

Nimiöiden tallentaminen vain XML-muodossa
Tallenna nimiöt vain sitä varten, että voit ladata ne InDesignjulkaisuun ja käyttää niitä siinä.

1. Valitse Nimiöt-paneelin valikosta Tallenna nimiöt.
2. Kirjoita nimiön nimi, määritä sijainti ja napsauta sitten Tallenna-painiketta.

Julkaisun nimiöt ja niille annetut värit tallentuvat XML-tiedostoon.

Viedyn XML-tiedoston muokkaaminen
Kun olet luonut ja vienyt XML-tiedoston InDesignilla, voit tehdä siihen muutoksia seuraavilla menetelmillä:

Jos haluat muokata XML-tiedostoa suoraan, avaa se teksti- tai XML-editorilla.
Jos haluat muutosten säilyvän lähdejulkaisussa, avaa InDesign-tiedosto, josta XML-tiedosto vietiin. Kun olet tehnyt sisältöön muutoksia
InDesignilla, voit viedä sisällön uudelleen XML-tiedostoon. Käytä alkuperäistä XML-tiedoston nimeä, jos haluat korvata tiedoston.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Adobe PDF -asetusten luokat
Tietoja PDF/X-standardeista
PDF-yhteensopivuustasot
PDF-tiedostojen yleiset asetukset
Adobe PDF -tiedostojen pakkaus- ja interpolointiasetukset
Adobe PDF -tiedoston merkit ja leikkausvara-asetukset
Adobe PDF -tiedoston värienhallinta ja PDF/X-asetukset
Adobe PDF -tiedostojen kirjasin-, OPI- ja yhdistämisasetukset
Suojauksen lisääminen PDF-tiedostoihin
PDF-tiedostojen suojausasetukset
Kirjasimien upottaminen ja korvaaminen
Julkaisun valmisteleminen näytössä katseltavaksi

Adobe PDF -asetusten luokat
Voit määrittää PDF-asetuksia, kun viet tiedoston PDF-muotoon tai kun luota tai muokkaat PDF-oletusarvoja. PDF-asetukset on jaettu luokkiin.
Luokat on lueteltu Vie Adobe PDF -valintaikkunan vasemmassa reunassa lukuun ottamatta Vakio- ja Yhteensopivuus-asetuksia, jotka ovat
valintaikkunan yläreunassa. Kun viet tiedostoa PDF-muotoon ja muutat yhdenkin asetuksen, oletusarvon nimen jälkeen tulee liite "muokattu".

Vakio Määrittää tiedostolle PDF/X-muodon.
Yhteensopivuus Määrittää tiedostolle PDF-version.
Yleiset Määrittää tiedoston perusasetukset.
Pakkaus Määrittää, pakataanko ja interpoloidaanko kuva ja mitä menetelmää ja asetuksia siinä tapauksessa käytetään.
Merkit ja leikkausvarat Määrittää tulostusmerkit sekä leikkausvara- ja informaatioalueet. Asetukset ovat samat kuin Tulosta-valintaikkunassa,
mutta laskutoimituksissa on eroja, koska PDF-tuloste ei vastaa tiettyä sivukokoa.
Tulostus Määrittää, miten värit ja PDF/X-tulostusperusteprofiilit tallennetaan PDF-tiedostoon.
Lisäasetukset Määrittää, miten kirjasimet, OPI-määritykset, läpinäkyvyyden yhdistäminen ja JDF-ohjeet tallentuvat PDF-tiedostoon.
Suojaus Suojaa PDF-tiedoston. Suojausasetukset eivät ole käytettävissä PDF-oletusarvoja luotaessa tai muokattaessa.
Yhteenveto Näyttää nykyisten PDF-asetusten yhteenvedon. Saat kaikki asetukset näkyviin napsauttamalla luokan (esimerkiksi Yleiset) vieressä
olevaa nuolta. Jos haluat tallentaa yhteenvedon ASCII-tekstitiedostona, napsauta Tallenna yhteenveto -painiketta. Näyttöön tulee varoituskuvake 

 ja selitysteksti, jos valittuun oletusarvoon kuuluvaa asetusta ei voida noudattaa ja sitä täytyy muuttaa. Jos oletusarvo esimerkiksi määrittää
väriprofiileja, jotka eivät vastaa nykyistä väriasetustiedostoa, väriasetustiedoston mukaiset profiilit otetaan käyttöön.

Tietoja PDF/X-standardeista
PDF/X-standardit määrittää kansainvälinen standardoimisjärjestö (International Organization for Standardization, ISO). PDF/X-standardit koskevat
graafisen sisällön siirtämistä. PDF-muunnoksen aikana käsiteltävää tiedostoa verrataan määritettyyn standardiin. Jos PDF-tiedosto ei täytä valittua
ISO-standardia, näyttöön tulee kysymys, keskeytetäänkö muuntaminen vai luodaanko standardista poikkeava tiedosto. PDF/X-muodot, kuten
PDF/X-1a, ovat laajasti käytössä olevia painojulkaisutyönkulkujen standardeja.

PDF/X-4-muoto on luetettava muoto käytössä olevaa läpinäkyvyyttä ja värinhallintaa ajatellen. Tämä on ihanteellinen muoto RIP-prosessointiin,
Adobe PDF -tulostusta käyttäville digitaalisille tulostimille, sekä mille tahansa Acrobatista tulostettavalle PDF-tiedostolle.

Huomautus: lisätietoja PDF/X- ja PDF/A-standardeista on ISO-sivustossa ja Adobe-sivustossa.

PDF-yhteensopivuustasot
Luodessasi PDF-tiedostoja sinun on päätettävä, mitä PDF-versiota käytät. Voit vaihtaa PDF-version vaihtamalla toiseen esimääritykseen tai
valitsemalla tietyn yhteensopivuusasetuksen tallentaessasi PDF-tiedostoa tai muokatessasi PDF-esimääritystä.

Yleisesti ottaen on suositeltavaa käyttää uusinta versiota (tässä tapauksessa versiota 1.7), ellei erityistä tarvetta taaksepäin yhteensopivuuteen
ole. Uusin versio sisältää kaikkein uusimmat ominaisuudet ja toiminnot. Jos luotavia dokumentteja on tarkoitus jaella laajalti, kannattaa kuitenkin
käyttää Acrobat 5.0 (PDF 1.4)- tai Acrobat 6.0 (PDF 1.5) -muotoa. Näin varmistat, että kaikki käyttäjät voivat tulostaa dokumentin.

Seuraavassa taulukossa verrataan joitakin eri yhteensopivuusasetuksilla luotujen Adoben PDF-tiedostojen toimintoja.

Huomautus: Acrobat 8.0 ja 9.0 käyttävät myös PDF 1.7:ää.

Acrobat 3.0 (PDF 1.3) Acrobat 5.0 (PDF 1.4) Acrobat 6.0 (PDF 1.5) Acrobat 7.0 (PDF 1.6) ja
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Acrobat X (PDF 1.7)

PDF-tiedostoja voi avata
Acrobat 3.0:lla ja Acrobat
Reader 3.0:lla sekä
uudemmilla.

PDF-tiedostoja voi avata
Acrobat 3.0:lla ja Acrobat
Reader 3.0:lla sekä
uudemmilla. Uudempien
versioiden ominaisuudet voivat
kuitenkin kadota tai eivät ehkä
näy.

Useimmat PDF-tiedostot voi
avata Acrobat 4.0:lla ja
Acrobat Reader 4.0:lla sekä
uudemmilla. Uudempien
versioiden ominaisuudet voivat
kuitenkin kadota tai eivät ehkä
näy.

Useimmat PDF-tiedostot voi
avata Acrobat 4.0:lla ja
Acrobat Reader 4.0:lla sekä
uudemmilla. Uudempien
versioiden ominaisuudet voivat
kuitenkin kadota tai eivät ehkä
näy.

Ei voi sisältää kuvaa, jossa
käytetään liikkuvia
läpinäkyvyystehosteita.
Läpinäkyvyys on yhdistettävä
muihin tasoihin ennen
muuntamista PDF 1.3 -
muotoon.

Tukee liikkuvan
läpinäkyvyyden käyttämistä
kuvassa. (Acrobat Distiller -
toiminto yhdistää
läpinäkyvyyden.)

Tukee liikkuvan
läpinäkyvyyden käyttämistä
kuvassa. (Acrobat Distiller -
toiminto yhdistää
läpinäkyvyyden.)

Tukee liikkuvan
läpinäkyvyyden käyttämistä
kuvassa. (Acrobat Distiller -
toiminto yhdistää
läpinäkyvyyden.)

Tasoja ei tueta. Tasoja ei tueta. Säilyttää tasot luotaessa PDF-
tiedostoja sellaisista
sovelluksista, jotka tukevat
monitasoisten PDF-
dokumenttien luomista, kuten
Illustrator CS tai InDesign CS.

Säilyttää tasot luotaessa PDF-
tiedostoja sellaisista
sovelluksista, jotka tukevat
monitasoisten PDF-
dokumenttien luomista, kuten
Illustrator CS tai InDesign CS.

DeviceN-väritila ja kahdeksan
väriä ovat tuettuja.

DeviceN-väritila ja kahdeksan
väriä ovat tuettuja.

DeviceN-väritilaa ja jopa 31
väriä tuetaan.

DeviceN-väritilaa ja jopa 31
väriä tuetaan.

Monitavuisia kirjasimia voidaan
sisällyttää. (Distiller muuntaa
kirjasimet sisällytyksen
yhteydessä.)

Monitavuisia kirjasimia voidaan
sisällyttää.

Monitavuisia kirjasimia voidaan
sisällyttää.

Monitavuisia kirjasimia voidaan
sisällyttää.

40-bittistä RC4-suojausta
tuetaan.

128-bittistä RC4-suojausta
tuetaan.

128-bittistä RC4-suojausta
tuetaan.

128-bittistä RC4-suojausta ja
128-bittistä AES-suojausta
(Advanced Encryption
Standard) tuetaan.

PDF-tiedostojen yleiset asetukset
Valitse Vie Adobe PDF -valintaikkunasta Yleiset-luokka, kun haluat määrittää seuraavia asetuksia:

Kuvaus Näyttää valitun oletusarvon kuvauksen ja sisältää alueen, jossa voit muokata kuvausta. Voit liittää kuvauksen leikepöydältä.
Kaikki Vie kaikki nykyisen julkaisun tai kirjan sivut.
Alue Määrittää nykyisestä julkaisusta vietävän sivualueen. Voit määrittää alueen yhdysmerkin avulla ja erottaa sivut tai alueet pilkuin. Tämä asetus
ei ole käytettävissä, kun viedään kirjoja tai luodaan oletusarvoja.
Aukeamat Vie sivut yhdessä aivan kuin ne olisi tulostettu samalle arkille.
Tärkeää: Älä valitse Aukeamat-komentoa kaupalliseen tulostukseen. Muuten tulostuspalvelu ei pysty asemoimaan sivuja.
Upota sivun miniatyyrit  Upottaa PDF-tiedostoon jokaisesta sivusta miniatyyriesikatselukuvan, mikä lisää tiedostokokoa. Poista tämän asetuksen
valinta, kun PDF-tiedostoa tarkastellaan ja se tulostetaan Acrobat 5.0:lla tai sitä uudemmalla versiolla. Nämä versiot luovat dynaamisesti
miniatyyrikuvan aina, kun napsautat PDF-tiedoston Sivut-paneelia.
Optimoi nopeaan verkkotarkasteluun Pienentää PDF-tiedostoa ja optimoi PDF-tiedoston nopeampaa Web-selaimella katselua varten
muotoilemalla tiedoston siten, että se ladataan sivu kerrallaan. Tämä asetus pakkaa tekstin ja viivapiirrokset riippumatta Vie Adobe PDF -
valintaikkunan Pakkaus-alueella valituista pakkausasetuksista.
Luo nimiöity PDF Nimiöi jutun elementit viemisen aikana automaattisesti niiden Acrobat -nimiöiden perusteella, joita InDesign tukee. Niihin
kuuluvat kappaleiden, tekstin perusmuotoilun, luetteloiden ja taulukoiden tunnistus. (Voit lisätä ja muokata nimiöitä julkaisussa ennen viemistä PDF-
muotoon.) Lisätietoja: Rakenteen lisääminen PDF-tiedostoihin.)
Huomautus: Jos Yhteensopivuus-asetukseksi on valittu Acrobat 6 (PDF 1.5) tai uudempi, nimiöt pakataan tiedoston pienentämiseksi. Jos
tällainen tiedosto avataan Acrobat 4.0.lla tai Acrobat 5.0:lla, nimiöt eivät näy, koska kyseiset Acrobat-versiot eivät pysty purkamaan niitä.
Näytä PDF viennin jälkeen Avaa luodun PDF-tiedoston oletuskatselusovelluksessa.
Luo Acrobat-tasot Tallentaa jokaisen InDesign-tason PDF-tiedostoon Acrobat-tasoksi. Asetus vie myös kaikki tulostusmerkit, jotka on sisällytetty
erilliselle merkki- ja leikkausvaratasolle. Tasoja voi selata, joten Adobe Acrobat 6.0:n ja sitä uudempien versioiden käyttäjät voivat luoda yhdestä
PDF-tiedostosta useita julkaisun versioita. Jos julkaisu esimerkiksi julkaistaan useilla kielillä, voit sijoittaa jokaisen kielen tekstin eri tasolle. Sitten
tulostuspalvelu voi tehdä julkaisusta erilaisia versioita näyttämällä ja kätkemällä tasoja.
Jos valitset Luo Acrobat-tasot -asetuksen ja viet kirjan PDF-muotoon, samannimiset tasot yhdistetään.

Huomautus: Luo Acrobat-tasot -asetus on käytettävissä vain, jos Yhteensopivuus-asetukseksi on valittu Acrobat 6 (PDF 1.5) tai uudempi.
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Vientitasot Määrittää, sisällytetäänkö näkyvät tasot ja tulostumattomat tasot PDF-tiedostoon. Voit määrittää tasoasetuksilla, mitkä tasot ovat
kätkettyjä ja mitä tasoja ei tulosteta. Kun tallennat PDF-tiedostoa, valitse, viedäänkö kaikki tasot (myös kätketyt ja tulostumattomat tasot), näkyvät
tasot (myös tulostumattomat tasot) vai näkyvät ja tulostuvat tasot.
Kirjanmerkit Luo kirjanmerkit sisällysluetteloviitteitä varten säilyttäen sisällysluettelotasot. Kirjanmerkit luodaan Kirjanmerkit-paneelissa
määritetyistä tiedoista.
Hyperlinkit Luo Adobe PDF -hyperlinkkikommentit InDesignin hyperlinkeille sekä sisällysluettelo- ja hakemistoviitteille.
Näkyvät apuviivat ja ruudukot Vie näkyvissä olevat reunusten apuviivat, viivainlinjat, palstojen apuviivat ja perusviivaruudukot. Ruudukot ja
apuviivat viedään käyttäen samaa väriä kuin julkaisussa.
Objektit, joita ei voi tulostaa Vie objektit, joihin on liitetty Tulostumaton-asetus Määritteet-paneelissa.
Vuorovaikutteiset elementit Valitse Sisällytä ulkoasu, jos haluat sisällyttää PDF-tiedostoon kohteita, kuten painikkeita tai elokuvien julisteita. Jos
haluat luoda PDF-tiedoston, jossa on vuorovaikutteisia elementtejä, valitse Adobe PDF (vuorovaikutteinen) -asetus Adobe PDF (tulostus) -
asetuksen sijaan. Katso Vie vuorovaikutteisessa PDF-muodossa asetukset.

Adobe PDF -tiedostojen pakkaus- ja interpolointiasetukset
Kun viet julkaisuja Adobe PDF -muotoon, voit pakata tekstin ja viivapiirrokset sekä pakata ja interpoloida bittikarttakuvat. Valittujen asetusten
mukaan pakkaus ja interpolointi voivat pienentää PDF-tiedostoa huomattavasti vähentämättä juuri lainkaan yksityiskohtia ja tarkkuutta.

Vie Adobe PDF -valintaikkunan Pakkaus-alue jakautuu kolmeen osaan. Jokaisessa osassa on seuraavat väri-, harmaasävy- tai mustavalkokuvien
pakkaus- ja interpolointiasetukset.

Interpolointi alempaan arvoon Jos PDF-tiedosto on tarkoitettu Webiin, valitse interpolointi alempaan arvoon, jotta tiedosto voidaan pakata
tehokkaammin Jos PDF-tiedosto on tarkoitus tulostaa suurella resoluutiolla, kysy neuvoa tulostuspalvelusta, ennen kuin määrität pakkaus- ja
interpolointiasetukset.
Kannattaa myös selvittää, pitääkö käyttäjien pystyä suurentamaan sivu. Jos esimerkiksi teet kartan sisältävää PDF-tiedostoa, valitse suuri
resoluutio, jotta käyttäjät voivat suurentaa karttaa näytössä.

Alempaan arvoon interpoloiminen tarkoittaa kuvan pikselimäärän vähentämistä. Kun interpoloit väri-, harmaasävy- tai mustavalkokuvan alempaan
arvoon, valitse interpolointimenetelmä – keskiarvo-, painotettu keskiarvo- tai keskusinterpolointi – ja määritä haluttu resoluutio (pikseleinä tuumalla).
Kirjoita sitten resoluutio Kuville, joiden arvo on yli -tekstiruutuun. Kaikki kuvat, joiden resoluutio ylittää tämän arvon, interpoloidaan alempaan
arvoon.

Valittu interpolointitapa määrittää, kuinka pikseleitä poistetaan:

Keskiarvointerpolaatio arvoon  Laskee valitun alueen keskiarvon ja korvaa sitten koko alueen keskiarvoisella pikselivärillä käyttäen
määritettyä resoluutiota.
Keskusinterpolaatio arvoon  Valitsee valitun alueen keskellä olevan pikselin ja korvaa koko alueen kyseisellä pikselivärillä. Tämä
lyhentää muunnosaikaa huomattavasti verrattuna keskiarvointerpolointiin, mutta kuvat eivät ole yhtä tasaisia.
Painotettu keskiarvointerpolaatio arvoon  Valitsee pikselin väriksi painotetun keskiarvon, jolloin tulos on yleensä parempi kuin
keskiarvointerpoloinnissa. Tämä on hitain mutta tarkin menetelmä ja tuottaa tasaisimmat liukuvärit.

Pakkaus Määrittää käytettävän pakkaustyypin:

Automaattinen (JPEG)  Määrittää automaattisesti parhaan laadun väri- ja harmaasävykuvia varten. Useimmilla tiedostoilla tämä asetus
tuottaa tyydyttävän tuloksen.
JPEG  Sopii harmaasävy- ja värikuville. JPEG-pakkaus on häviöllinen eli se poistaa kuvatietoja ja voi heikentää kuvalaatua. Se kuitenkin
pyrkii pienentämään tiedoston kokoa ja minimoimaan tietojen häviämisen. Koska JPEG-pakkaus poistaa tietoja, tiedosto pakkautuu
huomattavasti pienemmäksi kuin ZIP-pakkauksessa.
ZIP  Sopii hyvin suuria yksivärisiä alueita ja toistuvia kuvioita sisältäville kuville sekä toistuvia kuvioita sisältäville mustavalkokuville. ZIP-
pakkaus voi olla häviötön tai häviöllinen Kuvan laatu -asetuksen mukaan.
JPEG 2000  JPEG 2000 on uusi kansainvälinen kuvatietojen pakkausstandardi. Se sopii JPEG-pakkauksen tavoin harmaasävy- ja
värikuville. Siinä on myös lisäetuja, kuten etenevä näyttö. Automaattinen (JPEG) -asetus on käytettävissä vain, kun Yhteensopivuus-
asetukseksi on valittu Acrobat 6 (PDF 1.5) tai uudempi.
Automaattinen (JPEG 2000)  Määrittää automaattisesti parhaan laadun väri- ja harmaasävykuvia varten. Automaattinen (JPEG) -asetus
on käytettävissä vain, kun Yhteensopivuus-asetukseksi on valittu Acrobat 6 (PDF 1.5) tai uudempi
CCITT ja Run Length  Nämä koskevat vain mustavalkoisia bittikarttakuvia. CCITT-pakkaus (Consultative Committee on International
Telegraphy and Telephony) sopii mustavalkokuville ja mille tahansa kuville, joita skannattaessa on valittu bittisyvyydeksi 1. Ryhmä 4 on
yleismenetelmä, joka pakkaa moitteettomasti useimmat mustavalkokuvat. Ryhmä 3, jota useimmat faksit käyttävät, pakkaa
mustavalkobittikartat rivi kerrallaan. Run Length -pakkaus tuottaa parhaat tulokset kuvissa, jotka sisältävät suuria yhtenäisiä mustia tai
valkoisia alueita.
Huomautus: InDesignilla väritetyissä harmaasävykuvissa käytetään värikuvien pakkausasetuksia. Spottivärillä väritetyissä
harmaasävykuvissa (kun kehyksissä on käytössä [Ei mitään]) käytetään harmaasävykuvien pakkausasetuksia.

Kuvan laatu Määrittää käytettävän pakkauksen määrän. JPEG- tai JPEG 2000 -pakkauksessa vaihtoehdot ovat Minimilaatu, Huonompi laatu,
Normaali laatu, Laadukas tai Maksimilaatu. ZIP-pakkauksessa on käytettävissä vain 8 bittiä. Koska InDesign käyttää häviötöntä ZIP-menetelmää,
tietoja ei poisteta tiedoston pienentämiseksi ja kuvan laatu säilyy.
Ruutukoko Määrittää etenevän näytön ruutujen koon. Tämä asetus on käytettävissä vain, kun Yhteensopivuus-asetukseksi on valittu Acrobat 6
(1.5) ja uudempi ja Pakkaus-asetukseksi JPEG 2000.
Pakkaa teksti ja viivapiirrokset Käyttää Flate-pakkausta (joka muistuttaa kuvien ZIP-pakkausta) julkaisun kaikissa teksteissä ja viivapiirroksissa.
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Niiden yksityiskohdat ja laatu säilyvät.
Rajaa kuvatiedot kehyksiin Voi pienentää tiedostoa viemällä vain kehyksen näkyvässä osassa olevat kuvatiedot. Älä valitse tätä asetusta, jos
jälkikäsittelyssä tarvitaan lisätietoja (esimerkiksi kuvan uudelleensijoituksen tai leikkausvaran vuoksi).

Adobe PDF -tiedoston merkit ja leikkausvara-asetukset
Leikkausvara on alue, joka ulottuu tulostuksen muokkausalueen ulkopuolelle tai leikkaus- ja viimeistelymerkkien ulkopuolelle. Voit sisällyttää kuviin
leikkausvaran virheiden varalta, kun haluat varmistaa, että painoväri ulottuu sivun reunaan asti viimeistelyn jälkeen tai että kuva voidaan asemoida
julkaisun apuviivoihin.

Voit määrittää leikkausvaran leveyden ja lisätä tiedostoon erilaisia tulostusmerkkejä.

Adobe PDF -tiedoston värienhallinta ja PDF/X-asetukset
Voit määrittää seuraavat asetukset Vie Adobe PDF -valintaikkunan Tuloste-alueella. Tuloste-asetusten väliset vuorovaikutukset vaihtelevat sen
mukaan, onko värienhallinta käytössä, onko julkaisuun nimiöity väriprofiileja ja mikä PDF-profiili on valittu

Huomautus: voit nähdä Tuloste-asetusten suppeat kuvaukset valintaikkunan Kuvaus-tekstiruudussa, kun siirrät osoittimen asetuksen päälle.
Värimuunnos Määrittää, kuinka väritiedot näytetään viedyssä Adobe PDF -tiedostossa. Kaikki spottiväritiedot säilytetään värinmuunnossa; vain
prosessivärit muunnetaan valittuun väriavaruuteen.

Ei värimuunnosta Säilyttää väritiedot ennallaan. Tämä on oletusarvo, kun PDF/X-3 on valittu.
Muunna kohteeksi Muuntaa kaikki värit Kohde-asetuksella valittuun profiiliin. Profiilin sisällytyskäytäntö määrää, sisällytetäänkö profiili.
Muunna kohteeksi (säilytä numerot)  Muuntaa värit kohdeprofiiliavaruuteen vain, jos niillä on kohdeprofiilista eroavat upotetut profiilit (tai
jos ne ovat RGB-värejä ja kohdeprofiili on CMYK tai päinvastoin) Nimiöimättömiä väriobjekteja, joilla ei ole upotettuja profiileja, ja
alkuperäisiä väriobjekteja, kuten viivapiirroksia tai tekstiä, ei muunneta Tämä asetus ei ole valittavissa, jos värienhallinta ei ole käytössä.
Profiilin sisällytyskäytäntö määrää, sisällytetäänkö profiili.

Kohde Kuvaa lopullisen RGB- tai CMYK-tulostimen, kuten näytön tai SWOP-standardin, värintoistoalaa. Tämän profiilin avulla InDesign muuntaa
julkaisun väritiedot (jotka on määritetty Väriasetukset-valintaikkunan Työtilat-kohdan lähdeprofiilissa) kohdetulostimen väriavaruuteen.
Profiilin sisällytyskäytäntö Määrää, sisällytetäänkö tiedostoon väriprofiili. Asetukset vaihtelevat Värimuunnos-valikon asetuksen mukaan sekä
sen mukaan, onko jokin PDF/X-standardeista valittu ja onko värienhallinta käytössä.

Älä sisällytä profiileja  Ei luo värienhallintaa käyttävää julkaisua, jossa on upotettuja väriprofiileja.
Sisällytä kaikki profiilit  Luo värienhallintaa käyttävän julkaisun. Jos Adobe PDF -tiedostoa käyttävän sovelluksen tai tulostimen on
muunnettava värit toiseen väriavaruuteen, se käyttää upotettuja profiilitietoja. Ota käyttöön värinhallinta ja määritä profiilitiedot ennen tämän
asetuksen valitsemista.
Sisällytä nimiöidyt lähdeprofiilit  Jättää laiteriippuvaiset värit ennalleen ja säilyttää ne mahdollisimman lähellä alkuperäistä väriä PDF-
tiedostossa. Tämä asetus sopii tulostuspalveluille, jotka ovat kalibroineet kaikki laitteensa, määritelleet tiedoston värit saamiensa tietojen
perusteella ja tulostavat vain kyseisillä laitteilla.
Sisällytä kaikki RGB- ja nimiöidyt lähde-CMYK-profiilit  Sisällyttää profiilit nimiöidyille RGB- ja CMYK-objekteille, kuten sijoitetuille
objekteille, joissa on upotettuja profiileja. Tämä asetus sisällyttää myös julkaisun RGB-profiilit nimiöimättömille RGB-objekteille.
Sisällytä kohdeprofiili  Määrittää kohdeprofiilin kaikille objekteille. Jos Muunna kohteeksi (Säilytä värinumerot) -asetus on valittu, saman
väriavaruuden nimiöimätön sisältö määritetään kohdeprofiiliksi, jotta värinumerot eivät muutu.

Simuloi päällepainatus Simuloi tulostuserottelujen ulkoasua säilyttämällä päällepainatuksen ulkoasun yhdistelmätulosteessa. Kun Simuloi
päällepainatus -asetusta ei ole valittu, Acrobatissa täytyy valita Päällepainatuksen esikatselu -asetus, jotta limittyvien värien vaikutukset näkyvät.
Kun Simuloi päällepainatus -asetus on valittu, spottivärit muuttuvat vastaaviksi prosessiväreiksi ja limittyvät värit näkyvät ja tulostuvat oikein, vaikka
Päällepainatuksen esikatselu -asetusta ei ole valittu Acrobatissa. Kun Simuloi päällepainatus -asetus on valittu ja Yhteensopivuus-asetukset
(valintaikkunan Yleiset-alueella) on määritetty Acrobat 4 (PDF 1.3), julkaisun värien ohjelmallinen tarkistus voidaan suorittaa suoraan näytössä,
ennen kuin kuvat tulostetaan valitulla tulostimella.
Painovärin hallinta Ohjaa, muunnetaanko spottivärit prosessiväreiksi, ja määrittää muita painoväriasetuksia. Jos teet julkaisuun muutoksia
Painovärin hallinnan avulla (esimerkiksi muutat kaikki spottivärit prosessiväreiksi), muutokset näkyvät viedyssä tiedostossa ja tallennetussa
julkaisussa, mutta niitä ei tallenneta Adobe PDF -oletusarvoihin.
Tulosteen perusteprofiilin nimi Määrittää julkaisun luonnehditun tulostusehdon. Tulosteen perusteprofiili vaaditaan PDF/X-yhteensopivia
tiedostoja luotaessa. Tämä valikko on käytettävissä vain, jos PDF/X-standardi (tai oletusarvo) on valittu Vie Adobe PDF -valintaikkunan Yleiset-
alueelta. Käytettävissä olevat asetukset vaihtelevat sen mukaan, onko värinhallinta käytössä. Jos värienhallinta ei ole käytössä, valikossa on
luettelo vain kohdeprofiilin väriavaruutta vastaavista tulostusprofiileista. Jos värienhallinta on käytössä, tulosteen perusprofiili on sama kuin valittu
kohdeprofiili (CMYK-tulostinta käytettäessä).
Tulostusehtojen nimi Kuvaa haluttua tulostusehtoa. Tämä tieto voi olla hyödyllinen PDF-julkaisun tulevalle vastaanottajalle.
Tulostustilan tunnus Lisää vihjeen, joka viittaa lisätietoon halutusta tulostusehdosta. Tunniste sisältyy automaattisesti ICC-rekisterin
tulostusehtoihin. Tämä asetus ei ole käytettävissä, jos käytössä on jompikumpi PDF/X-3-oletusarvo tai -standardi, koska tiedoston yhteensopivuus
katoaisi, kun tiedostoa tutkittaisiin Acrobat 7.0 Professionalin tai uudemman version Preflight-toiminnolla tai Enfocus PitStop -sovelluksella (Acrobat
6.0:n laajennus).
Rekisterin nimi Ilmaisee Web-osoitteen, jossa on lisätietoja rekisteristä. URL-osoite lisätään automaattisesti ICC-rekisterinimiin. Tämä asetus ei
ole käytettävissä, jos käytössä on jompikumpi PDF/X-3-oletusarvo tai -standardi, koska tiedoston yhteensopivuus katoaisi, kun tiedostoa tutkittaisiin
Acrobat 7.0 Professionalin tai uudemman version Preflight-toiminnolla tai Enfocus PitStop -sovelluksella (Acrobat 6.0:n laajennus).
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Adobe PDF -tiedostojen kirjasin-, OPI- ja yhdistämisasetukset
Voit määrittää seuraavat asetukset Vie Adobe PDF -valintaikkunan Lisäasetukset-alueella.

Jaa kirjasimet osajoukkoihin, kun käytettyjen merkkien prosentuaalinen osuus on pienempi kuin Määrittää kirjasinten upotuskynnyksen sen
perusteella, kuinka monia kirjasimen merkkejä julkaisussa on käytetty. Jos tietyn kirjasimen julkaisussa käytettyjen merkkien prosentuaalinen
osuus ylittyy, kyseinen kirjasin upotetaan täysin. Muussa tapauksessa kirjasin jaetaan osajoukkoihin. Kirjasinten upottaminen suurentaa tiedostoa.
Jos haluat upottaa kaikki kirjasimet täysin, kirjoita arvoksi 0 (nolla). Voit myös määrittää kynnyksen Asetukset-valintaikkunan Yleiset-alueella,
jolloin kirjasinten jakaminen osajoukkoihin käynnistyy kirjasimen sisältämien kuvioiden määrän mukaan.
OPI Asetus mahdollistaa tiettyjen tuotujen kuvatyyppien ohituksen, kun tulostimeen tai tiedostoon lähetetään kuvatietoja. Jäljelle jäävät vain OPI-
linkit (kommentit) OPI-palvelimen myöhempää käyttöä varten.
Oletusarvo Jos Yhteensopivuus-asetukseksi (valintaikkunan Yleiset-alueella) on määritetty Acrobat 4 (PDF 1.3), voit määrittää oletusarvon (tai
asetusjoukon) läpinäkyvyyden yhdistämiselle. Näitä asetuksia käytetään vain, kun viedään aukeamia, joiden kuvissa on läpinäkyvyyttä.
Huomautus: Acrobat 5 (PDF 1.4) ja uudemmat säilyttävät automaattisesti kuvien läpinäkyvyyden. Oletusarvo- ja Mukautettu-asetukset eivät
tämän vuoksi ole käytettävissä näillä yhteensopivuustasoilla.
Ohita aukeaman ohitukset Käyttää yhdistämisasetuksia kaikissa julkaisun tai kirjan aukeamissa ja ohittaa yksittäisen aukeaman
yhdistämisoletusarvon.
Luo JDF-tiedosto Acrobatin avulla Luo JDF (Job Definition Format) -tiedoston ja käynnistää Acrobat Professionalin JDF-tiedoston käsittelyä
varten. Acrobatin työmäärityksessä on viittauksia tulostettaviin tiedostoihin sekä ohjeita ja tietoja tulostuspalvelulle. Tämä asetus on käytettävissä
vain, jos järjestelmään on asennettu Acrobat 7.0 Professional tai uudempi. Lisätietoja on Acrobatin Ohjeessa.

Suojauksen lisääminen PDF-tiedostoihin
Kun tallennat tiedoston PDF-muodossa, voit suojata sen salasanalla ja erilaisilla suojausrajoituksilla, joilla voit muun muassa määrittää sen, kuka
saa avata tiedoston, kopioida ja lainata sisältöä sekä tulostaa dokumentin.

PDF-tiedosto voi vaatia salasanaa julkaisua avattaessa (dokumentin avauksen salasana) ja suojausasetuksia muutettaessa (käyttöoikeuksien
salasana). Jos määrität tiedostolle suojausasetuksia, määritä molemmat salasanat. Muuten kuka tahansa tiedoston avaava käyttäjä voi poistaa
asetukset käytöstä. Jos tiedosto avataan käyttöoikeuksien salasanalla, suojausasetukset poistetaan käytöstä tilapäisesti.

PDF-tiedostojen salasanasuojauksessa käytetään RSA Corporation -yrityksen RC4-suojausmenetelmää. Salaustaso on korkea tai matala Yleinen-
välilehden Yhteensopivuus-asetuksen mukaan.

Huomautus: Adobe PDF -oletusarvot eivät tue salasanoja eivätkä suojausasetuksia. Jos määrität salasanoja ja suojausasetuksia Vie PDF -
valintaikkunassa ja valitset sitten Tallenna oletusarvo -vaihtoehdon, salasanoja ja suojausasetuksia ei tallenneta.

PDF-tiedostojen suojausasetukset
Voit määrittää seuraavat asetukset luodessasi PDF-tiedostoa tai lisätessäsi PDF-tiedostoon salasanasuojauksen. Asetukset vaihtelevat
Yhteensopivuus-asetuksen mukaan. Suojausasetukset eivät ole käytettävissä PDF/X-standardeissa tai -oletusarvoissa.

Yhteensopivuus Määrittää salaustyypin salasanalla suojatun julkaisun avaamista varten. Acrobat 4 (PDF 1.3) -asetuksessa käytetään heikkoa
salausta (40-bittinen RC4), kun taas muissa asetuksissa käytetään vahvaa salausta (128-bittinen RC4 tai AES).
Huomaa, että aiempien Acrobat-versioiden käyttäjät eivät pysty avaamaan PDF-tiedostoa, jolla on korkeampi yhteensopivuusasetus. Jos
esimerkiksi valitset Acrobat 7 (PDF 1.6) -vaihtoehdon, tiedostoa ei voi avata Acrobat 6.0:lla tai vanhemmalla versiolla.

Edellytä salasanaa julkaisun avaamiseen Valitse tämä asetus, jos haluat, että käyttäjien on annettava määrittämäsi salasana julkaisun
avaamista varten.
Julkaisun avaussalasana Määritä salasana, joka käyttäjien on annettava, jotta PDF-tiedosto avautuu.
Huomautus: Jos unohdat salasanan, sitä ei voi palauttaa julkaisusta. Salasanat on hyvä säilyttää turvallisessa paikassa.
Rajoita dokumentin muokkaamista ja käsittelemistä salasanalla Rajoittaa PDF-tiedoston suojausasetusten käyttöä. Jos tiedosto avataan
Adobe Acrobatilla, käyttäjä voi katsella tiedostoa. Tiedoston suojaus- ja käyttöoikeusasetuksien muuttamiseen vaaditaan käyttöoikeuksien
salasana. Jos tiedosto avataan Illustrator-, Adobe Photoshop- tai Adobe InDesign-ohjelmassa käyttäjän pitää antaa käyttöoikeuksien salasana,
koska tiedostoa ei voi avata vain katselu -tilassa.
Käyttöoikeuksien salasana Määritä salasana, joka tarvitaan käyttöoikeusasetusten muuttamiseen. Tämä toiminto on käytettävissä vain jos
edellinen vaihtoehto on valittuna.
Tulostus sallittu Määrittää PDF-tiedoston käyttäjille sallitun tulostustason.

Ei mikään  Estää käyttäjiä tulostamasta tiedostoa.
Matala resoluutio (150 dpi)  Antaa käyttäjien tulostaa enintään150 dpi:n resoluutiolla. Tulostus saattaa hidastua, koska kukin sivu tulostuu
bittikarttakuvana. Tämä asetus on käytettävissä vain, jos Yhteensopivuus-asetus on Acrobat 5 (PDF 1.4) tai uudempi.
Korkea resoluutio  Antaa käyttäjien tulostaa millä tahansa resoluutiolla sekä lähettää tarkat vektoritiedot Adobe PostScript-tulostimeen tai
muuhun laitteeseen, joka tukee vaativaa tarkkuustulostusta.

Sallitut muutokset Määrittää, miten PDF-tiedostoa saa muokata.

Ei mikään  Estää käyttäjiä tekemästä tiedostoon muutoksia, jotka luetellaan Sallitut muutokset -valikossa. Näitä ovat esimerkiksi
lomakekenttien täyttäminen ja kommenttien lisääminen.
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Sivujen lisääminen, poistaminen ja kiertäminen  Antaa käyttäjien lisätä, poistaa ja kiertää sivuja sekä luoda kirjanmerkkejä ja
miniatyyreja. Tämä asetus on käytettävissä vain korkealla salaustasolla (128-bittinen RC4 tai AES).
Lomakekenttien täyttäminen ja allekirjoittaminen  Käyttäjät voivat täyttää lomakkeita ja lisätä digitaalisia allekirjoituksia. Käyttäjät eivät
voi lisätä kommentteja tai luoda lomakekenttiä. Tämä asetus on käytettävissä vain korkealla salaustasolla (128-bittinen RC4 tai AES).
Kommenttien lisääminen, lomakekenttien täyttäminen ja allekirjoittaminen  Käyttäjät voivat lisätä kommentteja ja digitaalisia
allekirjoituksia sekä täyttää lomakkeita. Käyttäjät eivät voi siirtää sivun objekteja tai luoda lomakekenttiä.
Sivuasettelu, lomakekenttien täyttäminen ja allekirjoittaminen  Antaa käyttäjien lisätä, poistaa ja kiertää sivuja, luoda kirjanmerkkejä ja
miniatyyreja, täyttää lomakkeita sekä lisätä digitaalisia allekirjoituksia. Tämä asetus ei salli lomakekenttien luomista. Tämä asetus on
käytettävissä vain matalalla salaustasolla (40-bittinen RC4).
Kaikki paitsi sivujen purkaminen  Käyttäjät voivat muokata julkaisua, luoda ja täyttää lomakekenttiä sekä lisätä kommentteja ja
digitaalisia allekirjoituksia.

Salli tekstin, kuvien ja muun sisällön kopioiminen Käyttäjät voivat valita ja kopioida sisältöä PDF-tiedostosta.
Ota sisällön kopiointi sekä heikkonäköisille tarkoitetut toiminnot käyttöön. Näkörajoitteiset käyttäjät voivat lukea ja kopioida julkaisun
näyttölukuohjelmien avulla. Tämä asetus on käytettävissä vain matalalla salaustasolla (40-bittinen RC4).
Salli tekstin siirtäminen näytönlukulaitteeseen näkövammaisia varten Näkövammaiset käyttäjät voivat lukea tiedoston sisältöä
näytönlukuohjelmilla, mutta sisältöä ei voi kopioida eikä erottaa leikepöydälle. Tämä asetus on käytettävissä vain korkealla salaustasolla (128-
bittinen RC4 tai AES).
Ota tekstimuodossa olevat metatiedot käyttöön Käyttäjät voivat kopioida ja erottaa sisältöä PDF-tiedostosta. Tämä asetus on käytettävissä
vain, kun Yhteensopivuus-asetukseksi on valittu Acrobat 6 (PDF 1.5) tai uudempi. Tämän asetuksen avulla tallennus- ja hakujärjestelmät sekä
hakukoneet voivat analysoida julkaisun metatietoja.

Kirjasimien upottaminen ja korvaaminen
Kirjasimen voi upottaa vain, jos kirjasimen toimittaja on määrittänyt sen sallituksi. Upotettuja kirjasimia ei voi korvata tiedostoa luettaessa ja
tulostettaessa eli lukijat näkevät tekstin alkuperäisen kirjasimen. Sisällyttäminen kasvattaa tiedostoa vain hiukan, ellei julkaisussa käytetä CID-
kirjasimia, jotka ovat tavallisia aasialaisissa kielissä. Kirjasimia voi upottaa tai korvata Acrobatissa tai vietäessä InDesign-julkaisu PDF-muotoon.

Voit upottaa koko kirjasimen tai ainoastaan tiedostossa käytettävien merkkien osajoukon.

Jos kirjasinta ei voida upottaa kirjasimen toimittajan asetusten vuoksi, eikä PDF:n avaajalla tai tulostajalla ole oikeuksia käyttää alkuperäistä
kirjasinta, kirjasin korvataan väliaikaisesti toisella kirjasimella. Tulosta ongelmien välttämiseksi vain sellaisia PDF-tiedostoja, joihin kirjasimet
voidaan upottaa.

Multiple Master -kirjasin sovitetaan tarvittavaan tilaan. Näin varmistetaan, että alkuperäisen julkaisun rivin- ja sivunvaihdot säilyvät ennallaan.
Korvaava kirjasin ei kuitenkaan aina vastaa tarkasti alkuperäisten merkkien muotoa. Tämä koskee etenkin epätavallisia merkkejä, kuten
kaunokirjoitusta.

Jos merkit ovat epätavallisia (vasemmalla), korvaava kirjasin ei vastaa niitä tarkasti (oikealla).

Julkaisun valmisteleminen näytössä katseltavaksi
Koska Adobe PDF -tiedostot ovat pieniä, laiteympäristöstä riippumattomia ja online-yhteensopivia, ne sopivat erinomaisesti julkaisujen sähköiseen
jakeluun ja katseluun. Voit lähettää Adobe PDF -tiedostoja muille käyttäjille sähköpostiliitteinä tai jakaa niitä Webin tai intranetin välityksellä.

Lisätietoja käytettävien PDF-julkaisujen luomisesta on osoitteessa Adobe InDesign CS4 -käytettävyys.

Seuraavat ohjeet koskevat Adobe PDF -tiedostojen sähköistä jakelua:

Ennen kuin julkaiset Adobe PDF -julkaisun Webissä, tarkista, että julkaisun teksti, grafiikka ja sivuasettelu ovat täydelliset ja virheettömät.

Varmista, että sisällysluetteloviitteet, hyperlinkit ja kirjanmerkit on luotu oikein. Ohjelma luo sisällysluetteloviitteet automaattisesti Kirjanmerkit-
paneelin tiedoista.

Määritä salasanat ja muut suojausasetukset.

Määritä tiedostonimi, jossa on enintään kahdeksan merkkiä sekä enintään kolmemerkkinen tunniste. Monet verkot ja sähköpostiohjelmat
lyhentävät pitkät tiedostonimet.

Varmista, että tiedostonimen tunniste on .PDF, jos tiedostoa luetaan Windows-tietokoneessa tai Internetissä.

Jos haluat käyttää valmiiksi määritettyjä Adobe PDF -vientiasetuksia näytössä katselemiseen, valitse Pienin tiedostokoko.

Huomautus: InDesign-julkaisuista luotuja Adobe PDF -tiedostoja, joissa on päällepainatuksia tai läpinäkyvyystehosteita, voidaan lukea
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parhaiten Acrobat 5.0:lla tai uudemmalla ja Adobe Reader 7.0:lla tai uudemmalla, kun Päällepainatuksen esikatselu-asetus on valittu.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Tulostaminen
 

Lisätietoja saat perehtymällä näihin suositeltuihin resursseihin verkossa.

Kirjasten tulostaminen pöytätulostimella

Jeff Witchel  (15.10.2012)

strContentType_Video_tutorial

Opi luomaan kirjanen ja tulostamaan se pöytätulostimella.

Adobe Creative Suite 5/5.5 -tulostusopas (PDF, 21 Mt)

Artikkeli  (1.1.2011)

Lataa tämä opas, jossa perehdytään Adobe-julkaisujen määrittämiseen tulostusta varten. Löydät kaikki
ammattitasoiseen tulostamiseen tarvittavat tiedot yhdestä paikasta.
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PDF-tiedostojen valmisteleminen tulostuspalvelua varten
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Tietoja tulostustyökaluista
Julkaisun tarkistaminen ennen viemistä
PDF-tiedostojen läpivientitulostus
Tulostusvalmiin Adobe PDF -tiedoston luominen

Tietoja tulostustyökaluista

Eräissä tulostustöissä julkaisut jaetaan lähdesovelluksen käyttämässä muodossa (eli alkuperäisessä muodossa). Kun tiedostot on hyväksytty, ne
tallennetaan PostScript- tai muussa muodossa esivalmistelua ja lopullista tulostusta varten. Koska sovellusten PostScript-toiminnot vaihtelevat,
PostScript-tiedostot voivat olla erittäin suuria ja monimutkaisia. Lisäksi tulostuksen yhteydessä voi ilmetä luotettavuusongelmia, kuten puuttuvia
kirjasimia, vaurioituneita tiedostoja, puuttuvia grafiikkaelementtejä ja tuntemattomia ominaisuuksia. Tämän vuoksi Adobe ja sen yhteistyökumppanit
kehittävät jatkuvasti luotettavia, PDF-perustaisia tulostusratkaisuja.

InDesignissa voidaan viedä julkaisu Adobe PDF -yhdistelmätiedostoon eli digitaaliseen sivupohjaan. Digitaaliset sivupohjat ovat pienikokoisia,
luotettavia tiedostoja, joita sinä ja tulostuspalvelu voitte tarkastella, muokata, järjestää ja vedostaa. Sitten tulostuspalvelu voi sopivassa työnkulun
vaiheessa tulostaa Adobe PDF -tiedoston suoraan tai käsitellä sitä tarvittavilla työkaluilla esimerkiksi esitarkastusta, lihotusta, asemointia ja
värierottelua varten.

PDF-tiedostot työnkulussa

Monet kustantamot ovat tehostaneet tarkistus- ja tuotantoprosessiaan PDF-tiedostoilla. Esimerkiksi monet lehtitalot ovat valinneet PDF:n
vakiomuodoksi, jossa mainokset toimitetaan paikallisiin toimipisteisiin satelliitti- tai ISDN-yhteyden kautta. Tämän ansiosta paikalliset julkaisijat
näkevät mainoksen heti oikeassa muodossa ja voivat tehdä siihen viime hetken muutoksia sekä tulostaa sen luotettavasti millä tahansa laitteella.

PDF-työnkulun tekniikat ja vaatimukset

Adobe pyrkii jatkuvasti vastaamaan tulostuspalveluiden tarpeisiin ja suosittelee uusimpien tietojen tarkastamista sivustosta www.adobe.com/fi.
Tällä hetkellä Adobe tarjoaa julkaisutöihin ratkaisuksi järjestelmän, johon on integroitu useita tekniikoita:

Adobe Acrobat 9, jossa on Adobe PDF:n version 1.7 tuki.

Adobe PostScript 3 -tulostustekniikka, joka sisältää laiteriippumattoman tuen, lihotuksen ja värierottelun rasteroinnin yhteydessä sekä tasaiset
sekoitukset

Adobe InDesign CS4, jossa on suuren resoluution sivuasettelutoiminnot sekä suora PDF-käsittely.

PDF/X, grafiikkasisällön siirtämiseen sopiva ISO-standardi, joka poistaa useita tulostusongelmia aiheuttavia väri-, kirjasin- ja lihotusmuuttujia.

Suuren resoluution PDF-yhdistelmätyönkulussa on yleensä PostScript 3 -tulostin, jonka rasterointiprosessori tukee erottelua rasteroinnin
yhteydessä. Jos tulostin käyttää PostScript-tasoa 2 tai ei tue erottelua rasteroinnin yhteydessä, käytä valmiiksi eroteltua PostScript-tulostusta.

Julkaisun tarkistaminen ennen viemistä

Ennen kuin luot PDF-tiedoston tulostuspalvelua varten, varmista, että InDesign-julkaisu on tulostuspalvelun ilmoittamien määritysten mukainen.
Seuraavassa luettelossa on suosituksia:

Varmista InDesignin Esitarkastelu-toiminnolla esimerkiksi se, että kuvan resoluutio ja väriavaruudet ovat oikeat, että kirjasimet ovat
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Alkuun

Alkuun

käytettävissä ja upotettavissa ja että kuvat ovat ajan tasalla.

Tarkista Adobe PDF -vientiasetukset ennen vientiä ja tee tarvittavat muutokset. Yhteenveto-paneelissa on varoitusosa, jossa on kerrottu,
milloin oletusarvoja ei voida noudattaa.

Jos kuvassa on läpinäkyvyyttä (esimerkiksi päällepainatuksia ja heittovarjoja) ja tarvitset suuriresoluutioisia tulosteita, sinun kannattaa
esikatsella yhdistämisen vaikutuksia ennen tiedoston tallentamista.

Jos kuvat sisältävät läpinäkyvyyttä, kysy tulostuspalvelusta, pitääkö PDF-tiedostojen tasojen olla yhdistettyjä vai ei. Parhaimmassa
tapauksessa tulostuspalvelu yhdistää tasot työnkulun mahdollisimman myöhäisessä vaiheessa. Jos tulostuspalvelu kuitenkin haluaa, että
yhdistät läpinäkyvyyden, toimita PDF/X-1a-yhteensopiva tiedosto.

Jos julkaisussa on värierotteluja, voit esikatsella erotteluja ja värinpeiton rajoja Erottelujen esikatselu -paneelissa.

Käytä julkaisussa vain korkearesoluutiokuvia.

Saavutat parhaan tuloksen, kun käytät nelivärityössä vain CMYK-kuvia. Voit myös valita RGB-kuvien muuntamisen CMYK-muotoon Vie
Adobe PDF -valintaikkunassa (Tulostus-luokassa).

Voit jättää kätketyt tai tulostumattomat tasot pois viedystä PDF-tiedostosta. (Lisätietoja: Tulostettavien tai PDF-tiedostoon vietävien tasojen
valitseminen.)

Tarkat tiedot InDesign-julkaisujen valmistelemisesta suuren resoluution PDF-tulostusta varten ovat Adobe InDesign CS Printing Guide for Prepress
Service Providers -oppaassa.

PDF-tiedostojen läpivientitulostus

PDF Print Engine -tulostimien valmistajat julkaisevat Adobe PDFDriver SDK -pakettiin perustuvia uusia ohjaimia, jotka pystyvät käsittelemään PDF-
tiedostot läpivientitilassa. Kun tällainen tulostin valitaan InDesignilla, sen PPD pystyy osoittamaan, että kyseessä on PDF-tulostin (vaihtelee
tulostimen valmistajan mukaan).

Koska InDesign pystyy luomaan laadukkaita PDF-tiedostoja PDF-tiedostojen vientitoiminnolla, PDF-tulostimella tulostettaessa hyödynnetään tätä
ominaisuutta, ja laadukas PDF-tiedosto siirretään PostScriptin käytön sijaan suoraan tulostimeen.
Yleensä ottaen PDF Driverilla tulostettujen tiedostojen laatu vastaa PostScript-tulostusta (tai on sitä parempi). PDF-tiedostoja Adobe PDF -
tulostimen kautta tulostettaessa tuetaan myös reaaliaikaisen läpinäkyvyyden ja ICC-värinhallinnan käyttöä. InDesignin tulostusvalintaikkunassa
värinhallintaan, värierotteluun ja grafiikkaan liittyvät asetukset on poistettu käytöstä, sillä kaikki värinhallintatoiminnot suoritetaan laitteessa
tulostuslaadun parantamiseksi.

Tulostusvalintaikkuna

Jätä yhdistelmä ennalleen -asetus valitaan oletusarvoisesti, eikä sitä voi muuttaa.

Tulostusvalmiin Adobe PDF -tiedoston luominen

Tulostuspalvelu voi suorittaa esitarkastukset ja värierottelut Acrobat 7.0 Professionalilla. Acrobat Professionalin uusissa versioissa on
kehittyneemmät esitarkastustyökalut, kuten mahdollisuus tehdä tietyt korjaukset automaattisesti. Myös erilaisilla esivalmistelusovelluksilla ja
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Huomautus:

rasterointiprosessoreilla voidaan tehdä esitarkistuksia, lihottaa ja taittaa sekä tehdä sivujen värierotteluita digitaalisissa sivupohjissa.

Jos jätät kuvat pois Adobe PDF -tiedostoa luodessasi, muista varmistaa, että tulostuspalvelu saa käyttöönsä alkuperäiset suuren resoluution kuvat
lopullisessa tulostusvaiheessa. Varmista myös, että tulostuspalvelu käyttää Acrobat Reader 7.0:aa tai uudempaa versiota tekstin ja värikuvien
tarkistukseen. Parhaan katseluelämyksen saat käyttämällä Acrobat 8 Professionalia tai sitä uudempaa versiota.

Jos käytät värinhallintatyönkulkua, voit esikatsella työtä näytössä väriprofiilien avulla (ohjelmallinen tarkistus). Voit tutkia, miltä julkaisun värit
näyttävät tietyllä tulostimella tuotettuina.

Jos et käytä värinhallintajärjestelmää (CMS) ja tarkasti kalibroituja ICC-profiileja sekä oikein kalibroitua näyttöä, sinun ei kannata
luottaa näytössä esitettäviin väreihin.

1. Valmistele julkaisu Adobe PDF -vientiä varten.

2. Vie julkaisu käyttämällä tulostuspalvelun toimittamaa .joboptions-tiedostoa. Jos sinulla ei ole suositeltua .joboptions-tiedostoa, käytä PDF/X-
oletusarvoa.

3. Tee PDF-tiedoston esitarkistus Acrobat 7,0 Professionalilla tai uudemmalla.

4. Vedosta Adobe PDF -tiedosto ja tee tarvittavat korjaukset.

5. Toimita tulostusvalmis PDF-tiedosto tulostuspalveluun.

Lisää ohjeaiheita
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Tiedostojen esitarkastus ennen toimitusta

Alkuun

Alkuun

Esitarkistus-paneelin yleiskatsaus
Esitarkastus-profiilien määrittäminen
Esitarkastusvirheiden tarkasteleminen ja ratkaiseminen
Kirjojen esitarkastaminen
Tiedostojen keräily

Katso lisätietoja ja ohjeita napsauttamalla seuraavia linkkejä.

Esitarkistus-paneelin yleiskatsaus

Voit tarkistaa julkaisun laadun ennen julkaisun tulostamista tai lähettämistä palveluntarjoajalle. Tätä kutsutaan esitarkastukseksi. Kun muokkaat
julkaisua, Esitarkastus-paneeli varoittaa ongelmista, jotka vaikuttavat julkaisun tai kirjan tulostamiseen tai painamiseen ei-toivotulla tavalla. Tällaisia
ongelmia ovat puuttuvat tiedostot ja kirjasimet, matalan resoluution kuvat, ylijuokseva teksti sekä useat muut tilanteet.

Esitarkastusasetukset määrittämällä voit määrittää, mitkä tilanteet havaitaan. Nämä esitarkastusasetukset tallennetaan esitarkastusprofiileihin,
joten niitä on helppo käyttää uudelleen. Voit luoda omia esitarkastusprofiileja tai tuoda niitä muista lähteistä.

Voit hyödyntää käytönaikaista esitarkastusta luomalla tai määrittämällä esitarkastusprofiilin julkaisun luomisen alkuvaiheessa. Jos esitarkastus on
käytössä ja InDesign havaitsee ongelmia, tilarivillä näkyy punainen ympyräkuvio. Voit avata Esitarkastus-paneelin ja tarkistaa Tietoja-osasta
virheiden korjaamiseen liittyviä perusohjeita.

Esitarkastus-paneeli

A. Valittu virhe. B. Näytä sivukohde napsauttamalla sivunumeroa. C. Tietoalue sisältää ehdotuksia valitun virheen korjaamiseen. D. Rajoita
virheiden tarkistusta määrittämällä sivualue. 

Esitarkastus-paneelin avaaminen

Valitse Ikkuna > Tulostus > Esitarkastus.

Kaksoisnapsauta julkaisuikkunan alaosan Esitarkastus-kuvaketta. Esitarkastus-kuvake on vihreä, jos virheitä ei havaittu. Jos virheitä
havaittiin, kuvake on punainen.

Esitarkastus-profiilien määrittäminen

Oletusarvon mukaan uusissa ja muunnetuissa julkaisuissa käytetään [Perus]-profiilia. Tämä profiili merkitsee puuttuvat tai muokatut linkit,
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Linkit

Väri

Kuvat ja objektit

Teksti

Julkaisu

ylijuoksevan tekstin sekä puuttuvat kirjasimet. Vaikka et voi muokata tai poistaa [Perus]-profiilia, voit luoda ja käyttää useita profiileja. Voit vaihtaa
profiilia esimerkiksi eri julkaisuja tai eri tulostuspalveluja käyttäessäsi tai käyttäessäsi yhtä julkaisuja useissa tuotantovaiheissa.

Pyydä profiili esivalmistuspalvelun tarjoajalta tai ota selvää, mitä esitarkastusprofiilin asetuksia on käytettävä. 

Esitarkastus-profiilin määrittäminen

1. Valitse Esitarkastus-paneelin valikosta tai julkaisuikkunan alaosan Esitarkastus-valikosta Määritä profiilit.

2. Napsauta Uusi esitarkastusprofiili -kuvaketta ja määritä profiilin nimi.

3. Määritä kunkin luokan esitarkastusasetukset. Jos ruudussa on valintamerkki, kaikki asetukset ovat valittuina. Tyhjä ruutu ilmaisee, että
mitään asetuksia ei ole sisällytetty.

Määritä, näytetäänkö puuttuvat ja muokatut linkit virheinä.

Määritä, mitä läpinäkyvyyden sekoitustilaa tarvitaan ja sallitaanko CMY-värit, väriavaruudet, päällepainatus ja muut vastaavat kohteet.

Määritä kuvan resoluution, läpinäkyvyyden, viivan paksuuden ja muiden kohteiden vaatimukset.

Teksti-luokassa näkyvät kohteiden virheet, kuten puuttuvat kirjasimet ja ylijuokseva teksti.

Määritä sivun koon ja suunnan, sivumäärän, tyhjien sivujen sekä leikkausvaran ja informaatioalueen asetusten vaatimukset.

4. Tallenna profiilin muutokset valitsemalla Tallenna, ennen kuin aloitat toisen profiilin käyttämisen. Tai sulje valintaikkuna ja tallenna kaikki
muutokset valitsemalla OK.

Profiilien upottaminen ja upotuksen poistaminen

Kun upotat profiilin, profiilista tulee julkaisun osa. Profiilien upottaminen on hyödyllinen toiminto, kun aiot lähettää tiedoston toiselle käyttäjälle.
Upotettua profiilia ei ole pakko käyttää. Jos esimerkiksi lähetät upotetun profiilin sisältävän julkaisun tulostuspalveluun, tulostin voi valita toisen
profiilin julkaisussa käytettäväksi.

Voit upottaa vain yhden profiilin. [Perus]-profiilia ei voi upottaa.

1. Upota profiili valitsemalla se Profiili-luettelosta ja napsauttamalla sitten Profiili-luettelon oikealla puolella olevaa Upota-kuvaketta .

Voit upottaa profiilin myös Määritä profiilit -valintaikkunassa.

2. Voit upottaa profiilin valitsemalla Esitarkastus-paneelin valikosta Määritä profiili, valitsemalla profiilin ja valitsemalla sitten valintaikkunan
vasemmanpuoleisen osan Esitarkastusprofiili-valikosta Upota profiili.

Profiilien vieminen ja lataaminen

Voit viedä profiilin, jolloin myös muut voivat käyttää sitä. Viedyt profiilit tallennetaan .idpp-tiedostotunnisteella.

Voit tallentaa käyttämäsi profiiliasetukset viemällä profiilin. Kun palautat asetukset, profiilin tiedot nollataan. Voit palauttaa asetukset lataamalla
viedyn profiilin.

Voit ladata myös toisen käyttäjän luoman profiilin. Voit ladata *.idpp-tiedoston tai voit ladata upotetun profiilin määrittämääsi julkaisuun.

Vie profiili valitsemalla Esitarkastus-valikosta Määritä profiilit. Valitse Esitarkastusprofiili-valikosta Vie profiili, määritä nimi sekä sijainti ja
valitse sitten Tallenna.
Lataa (vie) valitsemalla Esitarkastus-valikosta Määritä profiilit. Valitse Esitarkastusprofiili-valikosta Lataa profiili, valitse *.idpp-tiedosto tai
käytettävän upotetun profiilin sisältävä julkaisu ja valitse Avaa.
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Profiilin poistaminen

1. Valitse Esitarkastus-valikosta Määritä profiilit.

2. Valitse poistettava profiili ja napsauta sitten Poista esitarkastusprofiili -kuvaketta .

3. Poista profiili valitsemalla OK.

Esitarkastusvirheiden tarkasteleminen ja ratkaiseminen

Virheluettelo sisältää vain ne luokat, jotka sisältävät virheitä. Voit laajentaa tai kutistaa kohteet napsauttamalla kohteen vieressä olevaa nuolta.

Ota huomioon seuraavat seikat virheluetteloa tarkastellessasi:

Joissakin tapauksissa värimallit, kappaletyylit tai muut suunnitteluelementit voivat aiheuttaa ongelman. Itse suunnitteluelementtiä ei raportoida
virheenä. Sen sijaan virheluettelossa näkyvät kaikki sivukohteet, joissa suunnitteluelementti on käytössä. Varmista tällöin, että ratkaiset
suunnitteluelementin ongelman.

Luettelo ei sisällä ylijuoksevan tekstin, piilotettujen ehtojen tai huomautusten virheitä. Jäljitettyjen muutosten sisältämät poistetut tekstit
ohitetaan.

Ongelmallinen sivupohjakohde ei näy luettelossa, jos sivupohja ei ole käytössä tai jos alueella ei ole sivupohjaa käyttävää sivua. Jos
sivupohjassa on virhe, virhe näkyy Esitarkastus-paneelissa vain kerran, vaikka virhe esiintyisikin kaikilla sivupohjaa käyttävillä sivuilla.

Virheluetteloon lisätään muissa kuin tulostettavissa sivukohteissa, taittopöydän sivukohteissa tai piilotetuilla sekä muilla kuin tulostettavilla
tasoilla esiintyvät virheet vain, jos oikeat asetukset ovat valittuina Esitarkistusasetukset-valintaikkunassa.

Jos haluat tulostaa vain tietyt sivut, voit määrittää esitarkastukselle sivualueen. Määritä sivualue Esitarkastus-paneelin alaosassa.

Käytönaikaisen esitarkastuksen ottaminen käyttöön tai poistaminen käytöstä

Oletusarvon mukaan esitarkastus on käytössä kaikissa julkaisuissa.

1. Voit ottaa esitarkastuksen käyttöön aktiivisessa julkaisussa tai poistaa sen käytöstä valitsemalla Esitarkastus-paneelin vasemmasta
yläkulmasta Käytössä tai poistamalla sen käytöstä. Voit myös valita julkaisuikkunan alaosan Esitarkastus-valikosta Esitarkastusjulkaisu.

2. Voit ottaa esitarkastuksen käyttöön kaikissa julkaisuissa tai poistaa sen käytöstä kaikista julkaisuista valitsemalla Esitarkastus-paneelin
valikosta Ota kaikkien julkaisujen esitarkastus käyttöön tai poistamalla sen valinnan.

Virheiden ratkaiseminen

1. Kaksoisnapsauta virheluettelon riviä tai napsauta sivunumeroa Sivu-sarakkeessa, niin sivukohde aukeaa.

2. Näytä valitun rivin tiedot napsauttamalla Tietoja-kohdan vasemmalla puolella olevaa nuolta.

Tietoja-paneeli sisältää ongelman kuvauksen sekä usein myös ehdotuksia sen korjaamiseksi.

3. Korjaa virhe.

Eri profiilin valitseminen

Eri profiileista on hyötyä useissa työnkuluissa. Voit esimerkiksi valita eri profiilit samaan aikaan muokkaamillesi julkaisuille tai voit aloittaa uuden
tuotantovaiheen valitsemalla uuden profiilin. Kun valitset toisen profiilin, julkaisu tutkitaan uudelleen.

1. Avaa julkaisu.

2. Valitse profiili Esitarkastus-paneelin Profiili-valikosta.
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Työtilaprofiili

Käytä upotettua profiilia / Käytä työtilaprofiilia

Tasot

Objektit, joita ei voi tulostaa

Taittopöydän objektit

Alkuun

Jos haluat käyttää tätä profiilia aina tätä julkaisua käyttäessäsi, upota profiili. Muutoin julkaisu aukeaa ja käyttöön otetaan oletustyötilaprofiili.

Sivualueen valitseminen esitarkastusta varten

Määritä sivualue Esitarkastus-paneelin alaosassa (esimerkiksi 1-8).

Sivualueiden määrittämisen säännöt ovat samat kuin Tulosta-valintaikkunassa. Virheluetteloon ei lisätä tämän sivualueen ulkopuolella esiintyviä
virheitä.

Esitarkastus-asetusten määrittäminen

1. Valitse Kirja-paneelin valikosta Esitarkastusasetukset.

2. Määritä seuraavat asetukset ja valitse OK.

Valitse uusien julkaisujen oletusprofiilina käytettävä profiili. Jos haluat, että työtilaprofiili upottaa uudet julkaisut, valitse Upota
työtilaprofiili uusiin julkaisuihin. Katso Preflight-profiilien määrittäminen.

Kun avaat julkaisun, määritä, käytetäänkö esitarkastuksessa upotettua profiilia vai
määritettyä työtilaprofiilia.

Määritä, sisällytetäänkö esitarkastukseen kaikkien tasojen, näkyvien tasojen vai näkyvien ja tulostettavien tasojen kohteet. Jos kohde
on esimerkiksi piilotettu taso, voit estää kyseisen kohteen virheiden raportoimisen.

Valitse tämä asetus, jos haluat raportoida niiden objektien virheet, jotka on merkitty ei-tulostettaviksi
Määritteet-paneelissa, tai jos haluat raportoida sivupohjan virheet niiltä sivuilta, joilla on käytössä Kätke sivupohjan kohteet.

Valitse tämä asetus, jos haluat raportoida taittopöydälle sijoitettujen objektien virheet.

Virhekohtaisen rivimäärän rajoittaminen

Voit helpottaa virheluettelon hallittavuutta rajoittamalla virhekohtaista rivien määrää. Jos julkaisussa käytetään esimerkiksi TrueType-kirjasimia ja
läpi julkaisun käytössä on yksi TrueType-kirjasin, virheitä voi syntyä tuhansia. Jos määritit virhekohtaisten rivien enimmäismääräksi 25, luettelossa
näytetään vain ensimmäiset 25 virhettä ja virheen vieressä näkyy (25+).

Valitse Esitarkastus-paneelin valikosta Rajoita virhekohtaisten rivien määrää ja valitse luku.

Virheraportin tallentaminen

Voit luoda tekstitiedoston tai PDF-tiedoston, joka sisältää Esitarkastus-paneelissa näkyvät virheet. Raportti sisältää myös muita tilastoja, kuten
kellonajan, julkaisun nimen sekä profiilin nimen.

Näet julkaisun täydellisen sisällön luomalla raportin Keräily-toiminnolla. Sisältö käsittää kaikki kirjasimet, painovärit, linkit ja muut käytössä
olevat kohteet.

1. Valitse Esitarkastus-paneelin valikosta Tallenna raportti.

2. Määritä Tallennusmuoto (Windows)- tai Muoto (Mac OS) -valikosta, tallennetaanko tiedosto PDF-muodossa vai tekstitiedostona.

3. Määritä raportin nimi ja sijainti ja valitse Tallenna.
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Tasot

Taittopöydän objektit

Objektit, joita ei voi tulostaa

Alkuun

Kirjojen esitarkastaminen

Jos valitset Kirja-paneelin valikosta Esitarkasta kirja, virheitä etsitään kaikista julkaisuista (tai kaikista valituista julkaisuista). Voit käyttää kunkin
julkaisun upotettua profiilia tai voit määrittää käytettävän profiilin. Vihreä tai punainen kuvake tai kysymysmerkkikuvake ilmaisee kunkin julkaisun
esitarkastustilan. Vihreä ilmaisee, ettei julkaisulla ole raportoituja virheitä. Punainen ilmaisee, että virheitä havaittiin. Kysymysmerkki ilmaisee
tuntemattoman tilan. Julkaisu voi esimerkiksi olla suljettuna, esitarkastus on ehkä poistettu käytöstä tai käyttöön on saatettu ottaa toinen
esitarkastusprofiili.

Kirjan esitarkastusasetusten määrittäminen

1. Valitse Kirja-paneelin valikosta Esitarkasta kirja.

2. Määritä Kirjan esitarkastusasetukset -valintaikkunassa, käytetäänkö esitarkastusasetuksia koko kirjassa vai vain valituissa julkaisuissa.

3. Määritä Esitarkastusprofiili-kohdassa, käytetäänkö Käytä profiilia -valikossa määritettyä profiilia vai kunkin julkaisun upotettua profiilia.

Kukin julkaisu käyttää määritettyä profiilia väliaikaisesti. Kun suljet ja avaat yksittäisen julkaisun, työtilaprofiili tai upotettu profiili otetaan
käyttöön. Käytettävä profiili määräytyy Esitarkastusasetukset-valintaikkunassa määritettyjen asetusten mukaan.

4. Määritä Sisällytä-kohdassa, mitkä kohteet sisällytetään virheluetteloon.

Määritä, sisällytetäänkö esitarkastukseen kaikkien tasojen, näkyvien tasojen vai näkyvien ja tulostettavien tasojen kohteet. Jos kohde
on esimerkiksi piilotettu taso, voit valita, ettei kyseisen kohteen virheitä näytetä.

Valitse tämä asetus, jos haluat raportoida taittopöydälle sijoitettujen objektien virheet.

Valitse tämä asetus, jos haluat raportoida niiden objektien virheet, jotka on merkitty ei-tulostettaviksi
Määritteet-paneelissa.

5. Luo virheet sisältävä tekstitiedosto tai PDF-tiedosto valitsemalla Luo raportti. Luotu raportti sisältää kirjan kaikkien virheiden luettelon.

6. Valitse Esitarkastus.

Kirjan esitarkastusongelmien ratkaiseminen

Jos Kirja-paneelissa näkyy punainen piste julkaisun nimen oikealla puolella, julkaisu sisältää esitarkastusvirheitä.

1. Kaksoisnapsauta virheitä sisältävää julkaisua Kirja-paneelissa.

2. Esitarkastus-paneelissa voit tarkastella kunkin julkaisun virheitä ja korjata niitä tarvittaessa.

Tyylit, värimallit ja muut suunnitteluelementit voivat aiheuttaa virheitä. Tällöin on varmistettava, että tyylien tai värimallien virheet korjataan tyylin
lähdejulkaisussa. Tämän jälkeen kirja on synkronoitava.

Jos määritit kirjan esitarkastusta varten profiilin, joka ei ole upotetun julkaisun profiili, muista, että ohjelma voi valita toisen profiilin, kun julkaisu
avataan uudelleen. Toisen profiilin käyttäminen voi johtaa toisenlaisten esitarkastusvirheiden havaitsemiseen.

Tiedostojen keräily

Voit kerätä yhteen käytetyt tiedostot, myös kirjasimet ja linkitetyn grafiikan, jolloin ne on helppo lähettää palveluntarjoajalle. Kun keräät tiedoston,
luot kansion, joka sisältää InDesign-julkaisun (tai kirjastotiedoston julkaisut), tarvittavat kirjasimet, linkitetyn grafiikan, tekstitiedostot ja mukautetun
raportin. Raportti tallennetaan tekstitiedostona, ja siinä on Tulostusohjeet-valintaikkunan tiedot, luettelo kaikista kirjasimista, linkeistä ja
painoväreistä sekä tulostusasetukset.

InDesign suorittaa päivitetyn esitarkastuksen. Kaikki havaitut ongelma-alueet näkyvät Pakkauksen sisältö -valintaikkunassa. Voit toimittaa
palveluntarjoajalle myös julkaisusta tehdyn PDF-yhdistelmätiedoston tai PostScript-tiedoston.

1. Avaa Keräily-valintaikkuna käyttämällä yhtä seuraavista menetelmistä:
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Kopioi kirjasimet

Kopioi linkitetty grafiikka

Päivitä pakkauksen grafiikkalinkit

Käytä vain julkaisun tavutuksen poikkeuksia

Sisällytä kätketyn ja tulostumattoman sisällön kirjasimet ja linkit

Sisällytä IDML

Sisällytä PDF (tulostus)

Huomautus:

Valitse Tiedosto > Keräily. (Jos Keräily ei näy Tiedosto-valikossa, valitse jokin toinen työtila, kuten Ikkuna > Työtila > Lisäasetukset.)

Valitse Kirja-välilehden valikosta Keräile kirja tai Keräile valitut julkaisut sen mukaan, onko julkaisuista valittu Kirja-välilehdessä kaikki,
jotkin vai ei yhtään.

Varoituskuvake  osoittaa ongelmat.

2. Tee Keräily-valintaikkunassa jokin seuraavista toimista:

Jos ohjelma ilmoittaa ongelmista, valitse Peruuta ja ratkaise ongelma-alueet Esitarkastus-paneelin avulla.

Valitse ongelma-alue (kuten Kirjasimet) ja korjaa ongelma. Kun julkaisu on valmis, aloita keräily uudelleen.

Aloita keräily valitsemalla Keräily.

3. Anna tulostusohjeet. Tiedostonimi on kaikkien muiden keräilytiedostojen mukana seuraavan raportin nimi.

4. Valitse Jatka ja määritä sitten sijainti, johon kaikki keräilytiedostot tallennetaan.

5. Valitse tarvittaessa seuraavista:

Kopioi kaikki tarvittavat kirjasintiedostot, ei koko kirjasintyyliä.

Kopioi linkitetyt grafiikkatiedostot keräilykansioon.

Muuttaa grafiikkalinkit keräilykansioon.

Jos tämä asetus valitaan, InDesign merkitsee tämän julkaisun niin, että sitä ei juoksuteta
uudelleen, kun toinen käyttäjä avaa sen tai muokkaa sitä tietokoneessa, joka käyttää toisia tavutus- ja sanastoasetuksia. Voit ottaa tämän
asetuksen käyttöön, kun tiedosto lähetetään palveluntarjoajalle.

Kerää kätkettyjen tasojen ja ehtojen objektit sekä sellaisten tasojen
objektit, joissa Tulosta taso -asetus ei ole valittuna. Kun tämä asetus ei ole valittuna, keräilyyn sisällytetään vain paketin luontihetkellä
julkaisussa näkyvät ja tulostuvat kohteet.

IDML-asetusten valitseminen

Pakkaa IDML-tiedoston paketin kanssa. Näin InDesign-julkaisu tai -kirja voidaan avata InDesignin aikaisemmissa versioissa.

Valitse tämä toiminto, jos haluat pakata PDF (tulostus) -tiedoston. Pakkaamiseen voidaan käyttää kaikkia
käytettävissä olevia PDF-esimäärityksiä. Viimeksi käytetty PDF-esimääritys on oletus-PDF, joka on esimääritetty PDF-esimääritysten
avattavassa valikossa.

 

PDF-tiedoston luonti onnistuu, vaikka PDF-tiedoston aikana annetaan varoitus. Näyttöön tulee kuitenkin varoitussanoma. 
Jos PDF- tai IDML-tiedoston luonnin tai pakkaamisen aikana ilmenee virhe, toiminto kumotaan eikä mitään luoda.
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Näytä raportti

Puuttuvat kirjasimet

Puutteelliset kirjasimet

Suojatut kirjasimet

Huomautus:

Luodulle IDML- ja PDF-tiedostolle annetaan sama nimi kuin .INDD-julkaisulle.

Avaa tulostusohjeet tekstinkäsittelyohjelmassa heti keräilyn jälkeen. Muokkaa tulostusohjeita ennen keräilyn lopettamista
valitsemalla Ohjeet.

6. Jatka keräilyä valitsemalla Keräile.

Kirjasinvirheiden korjaaminen

Pakkauksen sisältö -valintaikkunan Kirjasimet-alueella on luettelo kaikista julkaisussa käytetyistä kirjasimista. Luettelossa mainitaan myös
ylijuoksevassa·tekstissä tai taittopöydällä olevassa tekstissä käytetyt kirjasimet ja EPS-tiedostoihin upotetut kirjasimet sekä alkuperäisissä Adobe
Illustrator -tiedostoissa käytetyt ja PDF-sivuille sijoitetut kirjasimet. Asetus tarkastaa, onko tarvittavat kirjasimet asennettu tietokoneeseen. Kun
Näytä vain ongelmat -asetus on valittu, näytössä näkyvät ne kirjasimet, jotka kuuluvat seuraaviin luokkiin:

Luetteloi julkaisussa käytetyt kirjasimet, joita ei ole asennettu käytössä olevaan tietokoneeseen tai jotka eivät ole
käytettävissä julkaisun asennettuina kirjasimina.

Luettelo tietokoneen näyttökirjasimista, joita vastaavia tulostinkirjasimia ei ole.

Luetteloi kirjasimet, joita ei voida upottaa PDF- tai EPS-tiedostoihin tai käyttää julkaisun asennettuina kirjasimina
käyttöoikeusrajoitusten vuoksi.

Tee jompikumpi seuraavista:

Sulje Esitarkastus-valintaikkuna ja asenna kirjasimet tietokoneen.

Voit etsiä, luetteloida ja korvata julkaisussa käytetyt kirjasimet valitsemalla Esitarkastus-valintaikkunan Kirjasimet-alueelta Etsi kirjasin.

Varmista, että julkaisussa käytetyt kirjasimet ovat luvallisia ja että ne on asennettu ja aktivoitu joko tietokoneeseen tai tulostimeen.

Linkkien ja kuvien korjaaminen

Pakkauksen sisältö -valintaikkunan Linkit ja kuvat -alueella on luetteloitu kaikki julkaisun linkit, upotetut kuvat ja sijoitetut InDesign-tiedostot,
mukaan luettuina DCS- ja OPI-linkit linkitetystä EPS-grafiikasta. Esitarkastusraportti ei sisällä EPS-grafiikkaan ja sijoitettuihin InDesign-tiedostoihin
upotettuja kuvia linkkeinä. Esitarkastus osoittaa puuttuvat tai vanhentuneet linkit ja RGB-kuvat (jotka eivät erotu oikein, ellei värinhallinta ole
käytössä ja asennettu oikein).

Pakkauksen sisältö -valintaikkuna ei tunnista sijoitettuihin EPS-, Adobe Illustrator-, Adobe PDF- ja FreeHand-tiedostoihin upotettuja
RGB-kuvia eikä sijoitettuja .INDD-tiedostoja. Varmista erinomainen lopputulos tarkistamalla sijoitettujen grafiikoiden väritiedot alkuperäisissä
sovelluksissa tai Esitarkastus-paneelin toiminnoilla.

1. Näytä vain ongelmalliset kuvat valitsemalla Paketin sisältö -valintaikkunan Linkit ja kuvat -alueelta Näytä vain ongelmat.

2. Korjaa linkki jollakin seuraavista tavoista:

Valitse ongelmallinen kuva ja valitse joko Päivitä tai Linkitä uudelleen.

Valitse Korjaa kaikki.

3. Etsi oikea kuvatiedosto ja valitse Avaa.

Lisää ohjeaiheita
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Erottelujen tulostuksen valmisteleminen

Alkuun

Alkuun

Erottelujen luominen
Julkaisun valmistelu värierottelua varten
Spottivärien tulostaminen
Spottiväriä vastaavien prosessivärien näyttäminen
Objektin painaminen kaikille levyille
Liukuvärien tulostaminen erotteluina
Yhdistelmän tulostaminen
Värierottelujen esikatselu

Katso lisätietoja ja ohjeita napsauttamalla seuraavia linkkejä.

Erottelujen luominen
Väri- ja sävykuvien toistamista varten painokoneet erottavat jokaisen kuvan neljään osaan: syaani (C), magenta (M), keltainen (Y) ja musta (K)
erotetaan kukin omalle levylleen. Kun niihin lisätään oikea painoväri ja ne kohdistetaan toinen toistensa kanssa, värit toistavat alkuperäisen
kuvituksen. Kuvan jakamista kahteen tai useampaan väriin kutsutaan värierotteluksi. Filmejä, joista levyt luodaan, kutsutaan erotteluiksi.

Yhdistelmä (vasen) ja erottelut (oikea)

Erottelun työnkulut
Adobe InDesign tukee kahta yleistä PostScript-työnkulkua. Suurin ero on paikassa, jossa erottelut luodaan: tietokoneella (InDesignia ja
tulostinajuria käyttävä järjestelmä) tai tulostimen rasterointiprosessorilla. Vaihtoehtona on PDF-työnkulku.

Erottelut tietokoneella Perinteisessä tietokoneella suoritettavassa työnkulussa InDesign luo PostScript-tiedot julkaisun erotteluja varten ja lähettää
ne tulostimeen.
Erottelut rasteroinnin yhteydessä Uudessa rasterointiprosessin työnkulussa PostScript-rasterointiprosessien uudet versiot tekevät värierottelut,
lihotuksen ja jopa värienhallinnan, joten tietokone on vapaa suorittamaan muita tehtäviä. Tällöin InDesign tarvitsee vähemmän aikaa tiedoston
luomiseen ja tietoja siirretään kussakin tulostustyössä mahdollisimman vähän. Tietokoneessa suoritettavaa värierottelua varten InDesign
esimerkiksi lähettää yli neljä sivua PostScript-tietoja. Rasterointiprosessiin InDesignin ei tarvitse lähettää kuin yksi PostScript-yhdistelmätiedosto.
Voit katsoa tiedostojen valmistelua tulostusta varten koskevan video-opetusohjelman osoitteessa www.adobe.com/go/vid0089_fi.
Tulostuspalveluiden tulostusopas (PDF) on saatavilla osoitteessa www.adobe.com/go/learn_id_prepress_wp_fi.

Julkaisun valmistelu värierottelua varten
1. Korjaa kaikki värivirheet.
2. Määritä päällepainatusasetukset.
3. Luo lihotusohjeet, joilla kohdistusvirheet korjataan painamisen aikana.
4. Esikatsele värierottelua näytössä.

Huomautus: vaiheita 1–4 suositellaan, mutta ne eivät ole pakollisia.
5. Avaa Tulosta-valintaikkuna valitsemalla Tiedosto > Tulosta.
6. Jos tulostuksen oletusarvon erotteluasetukset ovat sopivat, valitse tyyli Tulosta-valintaikkunan yläreunan Tulostuksen oletusarvo -valikosta.
7. Valitse Tulostin-valikosta tulostin tai PostScript-tiedosto.
8. Jos tulostat PostScript-tiedostoon, valitse PPD-tiedosto värierottelut tulostavaa laitetta varten.

769

http://www.adobe.com/go/vid0089_fi
http://www.adobe.com/go/learn_id_prepress_wp_fi


Alkuun

Alkuun

Alkuun

Alkuun

Alkuun

9. Voit näyttää tulostusasetukset tai muuttaa niitä napsauttamalla Tulosta-valintaikkunan vasemmassa reunassa osion nimeä.
10. Ennen kuin lähetät julkaisun tulostuspalveluun, vedosta erottelut.
11. Tallenna tai tulosta erottelut.

Spottivärien tulostaminen
Voit käyttää myös mukautettuja painovärejä, joita kutsutaan spottiväreiksi. Näitä voi käyttää prosessivärien sijasta tai niiden ohella. Neljän
prosessivärin sijasta voit esimerkiksi painaa mustaa tekstiä ja sinivihreää viivagrafiikkaa sisältävän julkaisun kahdella spottivärillä – mustalla ja
toisella värillä, joka toistaa vihreän sävyn tarkasti. Voit myös käyttää spottipainovärejä esimerkiksi lakkoihin, fluoresoiviin väreihin ja metalliväreihin,
joita ei voi toistaa CMYK-painoväreillä. Lisäksi voit sekoittaa spottivärejä keskenään tai prosessivärien kanssa sekoiteväreiksi.

Kuviin voi lisätä prosessivärejä, spottivärejä tai molempia. Erotteluja tulostettaessa spottivärit voi muuntaa vastaaviksi prosessiväreiksi, jolloin ne
painetaan CMYK-levyille.

Spottiväriä vastaavien prosessivärien näyttäminen
1. Valitse spottiväri Värimallit-paneelista.
2. Valitse Väri-paneelin valikosta CMYK.

Spottivärin CMYK-arvot näkyvät Väri-paneelissa.

Voit myös pitää osoitinta spottivärin päällä Värimallit-paneelissa. Värin arvo näkyy työkaluvihjeessä.

Objektin painaminen kaikille levyille
Jos haluat painaa objektin kaikille levyille, mukaan luettuina spottivärilevyille, voit lisätä objektiin rekisteröintivärin. Rekisteröintiväriä käytetään
leikkaus- ja viimeistelymerkkejä tulostettaessa. Yhdistelmätulosteessa näiden objektien arvot ovat C100, M100, Y100 ja K100. Erottelussa objektit
tulostuvat kokonaisuudessaan jokaiselle levylle.

1. Valitse objektit, joihin haluat lisätä rekisteröintivärin.
2. Valitse Ikkuna > Värimallit.
3. Valitse Värimallit-paneelista Rekisteröinti-värimalli .

Liukuvärien tulostaminen erotteluina
Ota huomioon seuraavat seikat, kun teet liukuvärien värierottelun:

InDesignissa luotu spotti- ja prosessivärejä sisältävä liukuväri erotellaan sekä prosessi- että spottilevyille.

Prosessivärejä sisältävä liukuväri erotellaan prosessilevylle.

Saman spottivärin kahta sävyä sisältävä liukuväri erotellaan yhdelle spottivärilevylle.

Jos haluat luoda liukuvärin, joka erotellaan yhdelle filmille spottivärin ja valkoisen väliin, luo liukuväritäyttö spottivärin ja Paperi-värin väliin
Värimallit-paneelissa.

Jos luot liukuvärin kahden spottivärin väliin, sinun pitää määrittää niille erilaiset rasterikulmat. Jos kahdella spottivärillä on sama
rasterointikulma, ne tulostuvat päällekkäin. Jos et ole varma kulmista, kysy neuvoa tulostuspalvelusta.

Yhdistelmän tulostaminen
Voit tulostaa väri- tai harmaasävy-yhdistelmävedoksen ja tarkastaa julkaisun värit. Yhdistelmäkuva voi auttaa suunnittelussa ja vedostuksessa
ennen värierottelujen lopullista (ja kallista) tulostusta.

Kun InDesign tulostaa yhdistelmän, se tulostaa kaikki tiedoston värit yhdelle levylle riippumatta siitä, onko yksittäisiä värejä valittu vai ei.

Seuraavat asiat on otettava huomioon yhdistelmiä tulostettaessa:

Vaikka lopullisen tulosteen ulkoasua ei voikaan täysin ennustaa, voit parantaa sen tarkkuutta huomattavasti kalibroimalla kaikki laitteet, joita
julkaisun luomiseen käytetään (kuten skannerit, näytöt ja tulostimet). Jos laitteet on kalibroitu, värienhallintajärjestelmä takaa hyvin
ennakoitavat ja tasaiset värit.

Kaikki valitut päällepainatusasetukset tulostuvat oikein tulostimella, joka tukee päällepainatusta. Useimmat toimistotulostimet eivät tue
päällepainatusta, mutta voit simuloida päällepainatusta valitsemalla Tulosta-valintaikkunassa Tuloste-asetukseksi Simuloi päällepainatus.

Tärkeää: Jos valitset Simuloi päällepainatus -asetuksen, spottivärit muunnetaan prosessiväreiksi tulostusta varten. Jos aiot käyttää tiedostoa
rasterointiprosessorilla erottelua tai lopullista tulostusta varten, älä valitse tätä asetusta.

Kun tulostat mustavalkotulostimella, InDesign tuottaa sivuista harmaasävy-yhdistelmän. Jos julkaisussa on värejä, InDesign simuloi värejä
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tulostamalla visuaalisesti oikeat harmaat. Esimerkiksi keltaisen 20 %:n sävyä simuloiva harmaa on vaaleampi kuin mustan 20 %:n sävy, sillä
keltainen on mustaa vaaleampi väri.

Jos kirjan lukujen spottivärit tai lihotustyylit ovat ristiriidassa, voit opastaa InDesignia synkronoimaan tulostettavan kirjan asetukset sivupohjan
mukaisiksi.

Jos käytät värinhallintaa Kirja-toiminnon kanssa, kirjan jokaisen julkaisun on käytettävä samoja värinhallinta-asetuksia Väriasetukset-
valintaikkunassa.

Huomautus: Muista, että näyttöjen tapaan väritulostimien värintoistolaatu vaihtelee. Siksi lopputulos kannattaa tarkastaa tulostuspalvelun
vedoksista.

Värierottelujen esikatselu
Voit esikatsella värierotteluja, värinpeiton rajoja ja päällepainatusta Erottelujen esikatselu -paneelissa. Kun esikatselet erottelua näytöstä, voit
tarkistaa seuraavat kohdat:

Lakat ja muut päällysteet Koska lakat ovat läpinäkyviä, niitä on ehkä vaikea esikatsella näytössä. Kun esikatselet pelkkää lakan erottelua, lakatut
alueet näkyvät mustina.
Syvä musta Erottelujen esikatselussa voit erottaa alueet, jotka tulostuvat syvän mustana tai värilliseen painomusteeseen sekoitettuna
prosessimustana (K), joka on peittävämpi ja väriltään syvempi.
Värinpeitto Liian suuri mustemäärä voi aiheuttaa kuivumisongelmia. Lisätietoja tulostuksessa käytettävän painon enimmäisvärinpeitosta saat
painotalosta. Voit esikatsella julkaisua ja tarkistaa alueet, joissa värinpeitto ylittää painon rajoitukset.
Päällepainatus Voit esikatsella, miltä sekoitus, läpinäkyvyys ja päällepainatus näyttävät värierotellussa tulosteessa.
Huomautus: Voit tarkistaa päällepainatuksen vaikutukset yhdistelmätulostuslaitteella. Tämä on hyödyllistä värierotteluita vedostettaessa.
Näytössä tapahtuvassa erottelujen esikatselussa ongelmat havaitaan ilman tulostettavien erittelyjen kustannuksia. Et voi kuitenkaan esikatsella
lihotusta, emulsioasetuksia, tulostimen merkkejä, rasterointia tai resoluutiota. Tarkista nämä asetukset painotalossa vedoksista.

Huomautus: kätkettyjen tasojen objektit eivät näy näytön esikatselussa.

Erottelulevyjen esikatselu
1. Valitse Ikkuna > Tuloste > Erottelujen esikatselut.
2. Valitse näkymäksi Erottelut.
3. Tee jokin seuraavista toimista:

Voit katsella yksittäistä erottelua ja kätkeä muut napsauttamalla katseltavan erottelun nimeä. Peittoalueet näkyvät normaalisti mustina.
Voit muuttaa tätä poistamalla paneelivalikon Näytä yksittäiset levyt mustina -asetuksen valinnan.

Voit katsella erotteluja napsauttamalla erottelun nimen vasemmalla puolella olevaa tyhjää ruutua. Kukin erottelu näkyy sen värisenä kuin
sille on määritetty.

Voit kätkeä erotteluja napsauttamalla erottelun nimen vasemmalla puolella olevaa silmäkuvaketta .

Voit katsella kaikkia prosessilevyjä kerralla napsauttamalla CMYK-kuvaketta .

Voit katsella kaikkia erotteluja kerralla napsauttamalla ja vetämällä osoittimen kaikkien erottelujen nimien vieressä olevien
silmäkuvakkeiden (tai tyhjien ruutujen) yli.

Erottelujen esikatselu -paneelia voi ohjata myös pikanäppäimillä.

Yhden erottelun (vasemmalla) ja useiden erottelujen (oikealla) esikatselu

Värinpeiton erikatselu
1. Valitse Ikkuna > Tuloste > Erottelujen esikatselut.
2. Valitse näkymäksi Painovärirajoitus. Kirjoita Näytä-valikon vieressä olevaan ruutuun enimmäisvärinpeiton arvo. (Arvon saat painotalosta.)
3. Tarkista värinpeitto julkaisun esikatselusta. Värinpeiton rajan ylittävät alueet näkyvät punasävyisinä. (Tummanpunaiset alueet ylittävät

värinpeiton rajan enemmän kuin vaaleanpunaiset alueet.) Muut alueet näkyvän harmaasävyisinä.
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Alueet, joilla määritetty värinpeitto ylittyy, näkyvät punaisina.

4. Voit tarkistaa tietyn alueen värinpeiton siirtämällä osoittimen alueen päälle julkaisuikkunassa. Värinpeiton prosenttimäärä näkyy kunkin
painovärin nimen vieressä olevassa paneelissa.

Voit säätää värinpeittoa muuntamalla spottivärejä prosessiväreiksi. Voit säätää sijoitetun kuvan värinpeittoa muokkaamalla kuvaa
lähdesovelluksessa.

Palaaminen normaaliin näyttötilaan
1. Valitse Ikkuna > Tuloste > Erottelujen esikatselut.
2. Valitse näkymäksi Ei käytössä.

Lisää ohjeaiheita
Tiedostojen tulostamista varten valmistelemista käsittelevä video

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Julkaisujen tulostaminen
Tietoja tulostamisesta
Julkaisun tai kirjan tulostaminen
Tulostaminen Sivut-paneelista
Sivun tulostusasetukset
Tulostettavien objektien tulostusasetukset
Useita sivukokoja sisältävien julkaisujen tulostaminen
Tulostettavien sivujen määrittäminen
Sivukoon ja sivun suunnan määrittäminen
Sivukoon ja suunnan määrittäminen
Mukautetun paperikoon määrittäminen
Tulostettavien tai PDF-tiedostoksi vietävien tasojen valitseminen
Tulostaminen ei-PostScript-kielisiin tulostimiin
Tulostaminen bittikarttakuvana
Julkaisujen esikatselu
Tulostimen asentaminen
Tietoja tulostinohjaimista
Tulostinohjaimen ominaisuuksien käyttäminen
PPD-tiedoston valitseminen
Tulostusoletusarvojen käyttäminen
Tulostuksen esimäärityksien luominen
Tulostuksen esimääritysten käyttäminen
Tulostuksen esimääritysten muokkaaminen
Tulostuksen esimääritysten poistaminen

Tietoja tulostamisesta

Olipa kyseessä monivärijulkaisun tulostaminen ulkopuoliselle palveluntarjoajalle tai vedoksen lähettäminen
mustesuihku- tai lasertulostimeen, voit varmistaa työn sujuvuuden ja oikean lopputuloksen opettelemalla
tulostamisen perustiedot.

Tulostusmenetelmät

Kun tulostat tiedoston, Adobe InDesign lähettää sen tulostimeen tulostettavaksi joko suoraan paperille tai
digitaaliseen painokoneeseen tai muunnettavaksi positiivi- tai negatiivikuvaksi filmille. Jälkimmäisessä tapauksessa
filmistä luodaan painokoneen painolevy.

Kuvatyypit

Yksinkertaisimmat kuvat ovat esimerkiksi tekstiä, jossa käytetään vain yhtä harmaan tasoa. Vaikeammin
tulostettava on kuva, jonka värisävyt vaihtelevat kuvan sisällä. Tällaista kuvaa kutsutaan sävykuvaksi. Esimerkiksi
valokuva on sävykuva.
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Rasterointi

Sävykuvat saadaan aikaan rikkomalla kuva pistesarjoiksi. Tätä prosessia kutsutaan rasteroinniksi. Rasteroinnin
pisteiden koon ja syvyyden vaihtelu luo tulosteeseen optisen harhan useista harmaan sävyistä tai värisävyistä.

Värierottelu

Kaupallisesti tuotettava monivärinen kuvamateriaali on painettava erillisille painolevyille, ja jokaiselle värille on
omansa. Tätä prosessia kutsutaan värierotteluksi.

Yksityiskohtien muodostaminen

Tulostetun kuvan yksityiskohdat muodostuvat tarkkuuden ja linjatiheyden yhdistelmästä. Mitä korkeampi tulostimen
resoluutio on, sitä tarkempaa (tiheämpää) rasteritiheyttä voidaan käyttää.

Kaksipuolinen tulostus

Tulostinkohtaiset ominaisuudet, kuten kaksipuolinen tulostus, ovat käytettävissä Tulostin-painikkeen kautta
Tulosta-valintaikkunassa. Kaksipuolinen tulostus on käytettävissä vain jos tulostin tukee sitä. Lisätietoja
kaksipuolisesta tulostuksesta on tulostimen käyttöoppaassa.

Läpinäkyvät objektit

Kuvissa voi olla läpinäkyviä objekteja, jotka on lisätty niihin käyttämällä Tehosteet-paneelia tai heittovarjo- tai
pehmennyskomentoja. Läpinäkyvä kuva yhdistetään yhdistämisoletusarvojen mukaan. Voit muuttaa kuvituksen
rasterikuvien ja vektorikuvien suhteellista määrää.

Lisätietoja tulostamisesta on saatavilla Adobe Print Resource Centeristä osoitteesta
www.adobe.com/go/print_resource_fi. Tulostusongelmien vianmääritysapua on saatavilla osoitteessa
www.adobe.com/go/learn_id_printtrouble_fi.

Julkaisun tai kirjan tulostaminen

1. Varmista, että tulostimeen on asennettu oikea ohjain ja PPD.
2. Avaa Tulosta-valintaikkuna:

Jos ohjelmassa on avoimia julkaisuja, valitse Tiedosto > Tulosta. Tulosta-valintaikkuna nykyisessä
julkaisussa.

Jos Kirja-välilehdestä ei ole valittu yhtään julkaisua tai kaikki julkaisut on valittu, valitse Kirja-
välilehden valikosta Tulosta kirja. Kaikki kirjan julkaisut tulostuvat.
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Jos Kirja-välilehdestä on valittu julkaisuja, valitse Kirja-välilehden valikosta Tulosta valitut julkaisut.

3. Määritä käytettävä tulostin Tulostin-valikossa. Jos tulostimen oletusarvo on haluamasi, valitse se Tulostuksen
oletusarvo -valikosta.

4. Kirjoita Yleiset-kohtaan tulosteiden määrä, valitse haluatko lajitella sivut tai tulostaa ne käänteisessä
järjestyksessä, ja määritä tulostettavat sivut.

Sivualue-asetus ei ole valittavissa, jos tulostat kirjan.

Jos tulostat eri sivukokoa käyttäviä sivuja sisältävää julkaisua, valitse alue, jonka kaikilla sivuilla on sama
sivukoko käyttämällä Alueen yläpuolella olevia ohjaimia. Katso Useita sivukokoja sisältävien julkaisujen
tulostaminen.

5. Määritä, haluatko tulostaa tulostumattomat objektit, tyhjät sivut tai näkyvät apuviivat ja rivirekisterit.
6. Muuta Tulosta-valintaikkunan asetuksia tarpeen mukaan.
7. Valitse Tulosta.

Valitsemasi asetukset tallentuvat julkaisun mukana.

Tulostaminen Sivut-paneelista

Voit käyttää myös Sivut-paneelissa olevia tulostustoimintoja.

1. Tee Sivu-paneelissa jokin seuraavista valinnoista:

Valitse yksi sivu
Valitse useita sivuja
Valitse sivupohja
Valitse aukeama

2. Napsauta valintaa hiiren kakkospainikkeella ja valitse Tulosta sivu tai Tulosta aukeama (valintasi mukaan).

Voit valita Tulosta sivu tai Tulosta aukeama myös Sivut-paneelin avattavasta valikosta.

Näyttöön tulee Tulosta-valintaikkuna, jossa näkyy valittu sivu tai alue.

3. Valitse Tulosta.

Sivun tulostusasetukset

Voit tulostaa kaikki sivut, vain parilliset tai parittomat sivut, sarjan yksittäisiä sivuja tai yhtenäisen alueen.

Alue

Määrittää tulostettavan sivualueen. Määritä alueen määrittävät sivunumerot viivalla. Määritä sivualueet pilkulla tai
välilyönnillä. (Katso Tulostettavien sivujen määrittäminen.)

Jos julkaisussa on eri sivukokoa käyttäviä sivuja, voit valita alueen, jolla kaikilla sivuilla on sama sivukoko,
käyttämällä Alue-kentän yläpuolella olevia asetuksia. (Katso Useita sivukokoja sisältävien julkaisujen tulostaminen.)

Nykyinen sivu
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Tulosta nykyisen julkaisun nykyinen sivu.

Huomautus:

Nykyisen sivun sivunumero määritetään seuraavassa muodossa: Nykyinen sivu: nimi>:

Jakso

Tulosta julkaisun kaikki sivut valitsemalla Kaikki sivut. Tulosta määritetyt alueet valitsemalla Vain parittomat sivut
tai Vain parilliset sivut. Näitä asetuksia ei voi käyttää, jos valitset Aukeamat- tai Tulosta sivupohjat -asetuksen.

Aukeamat

Tulostaa sivut yhdessä (aivan kuin ne olisi sidottu) tai tulostaa ne samalle arkille. Voit tulostaa vain yhden
aukeaman yhdelle arkille. Jos uusi sivu on suurempi kuin valittu paperikoko, InDesign tulostaa alueesta
mahdollisimman paljon, mutta se ei voi automaattisesti skaalata sivua kuva-alueeseen sopivaksi. Valitse sitä varten
Tulosta-valintaikkunan Asetukset-kohdasta Skaalaa sopivaksi. Voit myös valita vaakasuunnan.

Huomautus:

Jos aukeaman sivuissa käytetään erilaisia lihotuksia, InDesign selvittää erot.

Tulosta sivupohjat

Tulostaa sivupohjat julkaisun sivujen sijasta. Tätä asetusta ei voi käyttää, jos valitset Alueet.

Esimerkkejä sivualueista

Sivualue Tulostettavat sivut

11- Sivulta 11 julkaisun viimeiselle sivulle.

-11 Sivu 11 ja kaikki sitä edeltävät sivut.

+11 Vain sivu 11.

-+11 Sivu 11 ja kaikki sitä edeltävät sivut.

+11- Kaikki sivut yhdenneltätoista sivulta julkaisun
loppuun.

1, 3-8, Sivu 1 ja sivut 3-8.

+1, +3-+8, Sivu 1 ja sivut 3-8.
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Osa1 Kaikki sivut osiosta Osa1.

Osa2:7 Sivu numero 7 (ei välttämättä osion seitsemäs sivu)
osiosta Osa2.

OsaB:7- Osion OsaB sivulta numero 7 osion viimeiselle sivulle.

Osa2:7-Osa3 Osion Osa2 sivulta 7 osion Osa3 loppuun.

Osa4:3-Osa4:6, Osa3:7 Sivut 3-6 osiosta Osa4 ja sivu 7 osiosta Osa3.

Tulostettavien objektien tulostusasetukset

Tulosta-valintaikkunan Yleiset-asetuksilla voi tulostaa myös ne elementit, jotka yleensä näkyvät vain näytöllä
(esimerkiksi ruudukot ja apuviivat). Valittavana on seuraavat asetukset:

Tulosta tasot

Määritä tulostettavat tasot. (Katso Tulostettavien tai PDF-tiedostoon vietävien tasojen valitseminen.)

Tulosta tulostumattomat objektit

Tulostaa kaikki objektit riippumatta siitä, onko jotkin niistä määritetty tulostumattomiksi.

Tulosta tyhjät sivut

Tulostaa kaikki sivut määritetyllä alueella, vaikka sivulla ei ole tekstiä eikä objekteja. Tämä asetus ei ole käytössä,
jos tulostat erittelyjä. Jos käytät kirjasen tulostusta yhdistelmätulostusta varten, voit täyttää
yhdistelmäallekirjoitukset tulostamalla lisätyt tyhjät aukeamat valitsemalla Tulosta tyhjät tulostusaukeamat -
asetuksen.

Tulosta näkyvät apuviivat ja rivirekisterit

Tulostaa näkyvät apuviivat ja ruudukot samalla värillä kuin julkaisussa. Voit valita Näytä-valikosta, mitkä linjat ja
ruudukot näytetään. Tämä asetus ei ole käytössä, jos tulostat erittelyjä.

Useita sivukokoja sisältävien julkaisujen tulostaminen

Saatat haluta tulostaa erikokoiset sivut erikseen. Tulosta-valintaikkunassa olevalla asetuksella on helppo valita alue,
joka valitsee koko julkaisusta saman kokoiset sivut.

Kysy tulostustoimittajalta tietoja erityisvaatimuksista, ennen kuin lähetät eri kokoisia sivuja sisältävän julkaisun
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tulostettavaksi. Jos sinulla on vaikeuksia tulostaa eri kokoisia sivuja sisältävä julkaisu, harkitse sen jakamista
erillisiksi julkaisuiksi.

1. Valitse Tiedosto > Tulosta.

2. Valitse tai jätä valitsematta yleisikkunan Aukeamat, kun haluat määrittää tulostetaanko sivut vai aukeamat.

Jos aukeamalla on eri kokoisia sivuja, aukeaman suurin leveys ja korkeus määrittää aukeaman koon.

3. Jos haluat tulostaa vain samaa sivukokoa käyttävät sivut, voit käyttää Alue-kentän yläpuolella olevia
asetuksia ja valita jonkin sivun tai aukeaman ja napsauttaa sitten Sivut-kuvaketta .

Alue-kentässä näkyvät kaikki kyseisen kokoiset sivut tai aukeamat.

4. Kun olet tulostanut yhden sivukokoalueen, toista vaiheet ja tulosta seuraava sivukokoalue.

Tulostettavien sivujen määrittäminen

Voit määrittää sivualueen käyttämällä absoluuttista numerointia (sivun paikka nykyisessä julkaisussa) tai
sivun/osion numerointia (sivulle määritetty osion tai sivun numero). InDesign-valintaikkunat noudattavat
oletusarvoisesti Asetukset-valintaikkunassa määritettyä Sivunumerointi-asetusta.

Kun absoluuttinen numerointi on käytössä, määrittämäsi sivunumerot tai sivualueet vastaavat sivujen
absoluuttista sijaintia julkaisussa. Voit esimerkiksi tulostaa julkaisun kolmannen sivun kirjoittamalla Tulosta-
valintaikkunan Alue-kohtaan 3.

Kun Asetukset-valintaikkunasta on valittu Osion numerointi, voit määrittää sivut ja sivualueet täsmälleen
siten, kuin ne näkyvät sivuasettelussa. Voit myös käyttää absoluuttista numerointia. Jos esimerkiksi OsaA:5
on julkaisun viidestoista sivu, voit tulostaa sivun kirjoittamalla Tulosta-valintaikkunaan OsaA:5 tai +15. (+)-
merkki osoittaa, että haluat ohittaa normaalin osio- tai sivunumeroinnin ja käyttää absoluuttista
sivunumerointia.

Jos et tiedä, kumpaa muotoa Tulosta-valintaikkunan sivunumeroinnissa pitäisi käyttää, käytä julkaisuikkunan
alareunan sivuruudussa käytettyä muotoa.

Sivukoon ja sivun suunnan määrittäminen

On tärkeää erottaa toisistaan sivun koko (määritetty Julkaisun asetukset -valintaikkunassa) ja paperikoko
(paperiarkki, filmi tai painolevyn alue). Sivun koko voi olla US Letter (8,5x11 tuumaa), mutta saatat tarvita
suuremman paperin tai filmin painotalon leikkausvara- ja informaatioalueeseen merkitsemiä tietoja varten.

InDesignin paperikokojen luettelo on peräisin PPD-tiedostosta (PostScript-tulostimissa) tai tulostinohjaimesta (ei-
PostScript-tulostimissa). Jos tulostin ja PostScript-tulostuksessa käytettävä PPD tukevat mukautettuja paperikokoja,
Paperikoko-valikossa on Mukautettu-asetus.

Useimmat valolatomakoneet käyttävät tavallisia paperikokoja, kuten Letter- ja Tabloid-kokoja sekä käänteistä
suuntaa, jossa tavallinen paperi käännetään tulostuksen aikana 90 astetta. Käänteinen suunta toimii usein
tehokkaammin valolatomakoneiden tulostusmateriaaleissa.
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Sivukoko ja suunnat valolatomakoneita varten

A. Letter (korkea suunta) B. Mukautettu sivukoko (korkea suunta) C. Letter (käänteinen suunta) 

Paperikoot käyttävät yleisesti käytettyjä nimiä (kuten Letter). Mittasuhteet määrittävät kuva-alueen. Kuva-alue on
paperin todellinen koko, josta on vähennetty tulostimen tai valolatomakoneen tarvitsemat reunukset. Useimmat
lasertulostimet eivät voi tulostaa paperin reunaan saakka.

Jos valitset erilaisen paperikoon (esimerkiksi vaihdat Letter-koon Legal-kooksi), julkaisu skaalautuu
esikatseluikkunassa. Esikatseluikkuna näyttää valitun sivun koko kuva-alueen. Kun esikatselukokoa muutetaan,
esikatseluikkuna muuttuu niin, että kuva-alue mahtuu siihen kokonaisuudessaan.

Huomautus:

Kuva-alue vaihtelee PPD-tiedoston mukaan jopa saman paperikoon kohdalla (esimerkiksi Letter), sillä eri tulostimet
ja valolatomakoneet määrittävät kuva-alueet eri tavalla.

Letter-kokoisen sivun tulostuksen erot Letter-, Letter.extra- ja Tabloid-paperilla

Huomautus:

Tulosta-valintaikkunan vasemman alakulman esikatseluikkunasta näkee, onko paperilla tarpeeksi tilaa tulostimen
merkeille sekä leikkausvara- ja informaatioalueille.

Sivukoon ja suunnan määrittäminen

1. Valitse Tiedosto > Tulosta.
2. Valitse Tulosta-valintaikkunan Asetukset-kohdan Paperikoko-valikosta haluamasi asetus.

Varmista, että paperikoko on riittävän suuri, jotta julkaisu, leikkausvara- ja informaatioalueet (jos tarpeen)
sekä tulostimen merkit mahtuvat siihen. Säästä valolatomakoneen filmiä tai paperia valitsemalla pienin
mahdollinen paperikoko, johon mahtuvat sekä julkaisu että tulostustiedot.

3. Kierrä julkaisua tulostusmateriaalilla suuntapainiketta napsauttamalla.
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Useimmissa tapauksissa Julkaisun asetukset -kohdassa (Tiedosto > Julkaisun asetukset) määritetyn sivun
suunnan on oltava sama (pysty tai vaaka) kuin Tulosta-valintaikkunan Asetukset-kohdassa määritetyn
tulosteen suunta, olipa kyseessä sitten normaali tai käänteinenkin tulostus. Aukeamia tulostettaessa voit
valita erilaisen paperikoon ja suunnan (kuten vaakasuunnan), jos haluat sovittaa kaikki sivut yhdelle arkille.
Jos olet kääntänyt aukeamanäkymää, suuntausta kannattaa ehkä muuttaa, jotta aukeama voidaan tulostaa
oikein.

Suuntapainikkeet

A. Pysty B. Vaaka C. Käänteinen pysty D. Käänteinen vaaka 

Mukautetun paperikoon määrittäminen

Jos käytössäsi on tulostin, joka osaa hyödyntää useita eri paperikokoja (esimerkiksi korkearesoluutioinen
valolatomakone), voit määrittää ennen tulostamista mukautetun paperikoon. Mukautettu asetus on käytettävissä
InDesignissa vain, jos valittu PPD tukee mukautettuja paperikokoja.

Suurin paperikoko määräytyy valolatomakoneen enimmäiskuva-alueen mukaan. Lisätietoja on tulostimen oppaissa.

Huomautus:

Muiden kuin PostScript-tulostimien mukautetun paperikoon asetuksia ei voi käyttää InDesignin Tulosta-
valintaikkunasta. Määritä tulostinkohtaiset ominaisuudet valitsemalla Asetukset (Windows), Tulostin (Mac OS) tai
Sivun määrittely (Mac OS) InDesignin Tulosta-valintaikkunassa. Katso lisätietoja ei-PostScript-tulostinohjaimen
oppaasta.

1. Valitse Tiedosto > Tulosta.
2. Jos tulostat PostScript-tiedostoa, valitse Tulosta-valintaikkunan Yleiset-kohdassa tulostimeksi PostScript.

Valitse sitten mukautettuja paperikokoja tukeva PPD.
3. Valitse Tulosta-valintaikkunan Asetukset-kohdan Paperikoko-valikosta Mukautettu.

Huomautus:

jos Mukautettu-vaihtoehto ei ole käytettävissä, tulostimen asennuksen yhteydessä valitsemasi PPD ei tue
mukautettuja paperikokoja.

4. Määritä leveys ja korkeus jommallakummalla seuraavista tavoista:

Jos haluat, että InDesignin määrittää julkaisun sisällön, leikkausvara- ja/tai informaatioalueiden sekä
mahdollisten tulostimen merkkien tulostamiseen tarvittavan pienimmän mahdollisen paperikoon,
valitse Leveys- ja Korkeus-asetukseksi Automaattinen. Oletusasetus Automaattinen on hyödyllinen
myös silloin, jos kirjassa on erikokoisia sivuja mutta tulostusmateriaali on jatkuva, kuten filmirulla tai
valokuvapaperi.

780



Alkuun

Määritä oletusarvoa suurempi paperikoko kirjoittamalla uudet mitat Leveys- ja Korkeus-ruutuihin.
Suurenna arvoja, sillä oletusarvojen pienentäminen voi pienentää julkaisua liikaa.

5. Muuta sivun paikkaa filmillä kirjoittamalla arvo Siirtymä-kohtaan.

Siirtymä määrittää kuva-alueen vasemmanpuoleisen reunan leveyden. Jos arvo on esimerkiksi 30 pistettä,
sivu siirtyy 30 pistettä oikealle.

6. Kierrä tulostusmateriaalia ja sivun sisältöä valitsemalla ensin Käänteinen ja sitten OK.

Voit säästää huomattavasti filmiä ja paperia käyttämällä Käänteinen- ja Siirtymä-asetuksia yhdessä. Vertaa
seuraavia esimerkkejä InDesignilla tulostetusta kuvasta, kun Käänteinen-asetus on käytössä ja poistettu
käytöstä.

Käänteinen pois käytöstä (vasen), Käänteinen käytössä (oikea)

A. Siirtymän arvo B. Väli C. Säästynyt filmi 

7. Tulostettaessa jatkuvalle tulostusmateriaalille määritä sivujen väliin jäävä väli kirjoittamalla arvo kohtaan
Väli.

Tulostettavien tai PDF-tiedostoksi vietävien tasojen
valitseminen

1. Voit tarkistaa tai muuttaa julkaisun Näytä taso- ja Tulosta taso -asetuksia valitsemalla tason Tasot-
välilehdestä ja valitsemalla sitten Tason asetukset -vaihtoehdon välilehden valikosta. Määritä tasoasetukset
ja valitse OK.

2. Tee jokin seuraavista:

Valitse Tiedosto > Tulosta ja valitse sitten Tulosta-valintaikkunan vasemmasta reunasta Yleiset.

Valitse Tiedosto > Vie, määritä Adobe PDF ja valitse sitten Tallenna. Valitse Vie Adobe PDF -
valintaikkunan vasemmasta reunasta Yleiset.

3. Valitse Tulosta tasot- tai Vientitasot-valikosta tasot, jotka haluat tulostaa tai sisällyttää PDF-tiedostoon:

Kaikki tasot

Tulostaa kaikki julkaisun tasot, vaikka ne olisivat kätkettyjä tai määritetty tulostumattomiksi.

Näkyvät tasot
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Tulostaa kaikki näkyvät tasot, vaikka ne olisi määritetty tulostumattomiksi tasoasetuksissa.

Näkyvät ja tulostettavat tasot

Tulostaa vain sekä näkyviksi että tulostettaviksi määritetyt tasot.

Tulostaminen ei-PostScript-kielisiin tulostimiin

Voit tulostaa julkaisun ei-PostScript-tulostimella. PostScript on painoalan sivunkuvauskielistandardi. Monia tarkkoja
väri- ja grafiikkaominaisuuksia, kuten rasteritiheyksiä tai värierotteluita, voi tulostaa vain PostScript-tulostimilla.
Useimmat tuodut grafiikkatiedostot tulostuvat hyvin. Yleisesti ottaen ei-PostScript-tulostimella tehtävän julkaisun
painoasun pitäisi vastata esikatselutilassa näkyvää kuvaa.

Jälleenmyyjiltä on saatavana ohjelmistoja, jotka lisäävät PostScript-kielen ei-PostScript-tulostimeen. Kysy
jälleenmyyjältä ohjelmistoista ja niiden yhteensopivuudesta tulostimesi kanssa.

Tulostaminen bittikarttakuvana

Ei-PostScript-tulostimelle tulostettaessa kaikki piirrokset voidaan rasteroida tulostettaessa. Tämä on kätevää
tulostettaessa monimutkaisia kohteita (esimerkiksi tasaisia sävyjä tai liukuvärejä) sisältäviä asiakirjoja, koska tällöin
virheiden esiintyminen vähenee.

1. Valitse Tiedosto > Tulosta.
2. Valitse Tulosta-valintaikkunan vasemmasta reunasta Lisäasetukset.
3. Valitse Tulosta bittikarttana.

Tämä asetus on käytettävissä vain, jos tulostinohjain tunnistaa tulostimen ei-PostScript-tulostimeksi. Jos
tämä asetus valitaan ei-PostScript-tulostimille Mac OS 10,3- tai uudemmassa käyttöjärjestelmässä, InDesign
tulostaa PostScript-tiedostoon, jota Mac OS käyttää, ja ohjain muodostaa sivukuvat. Windowsissa tarkat
väri- ja grafiikkaominaisuudet eivät ehkä muunnu oikein, jos tätä asetusta ei valita.

4. Määritä resoluutio bittikarttatulostusta varten.

Tulostinohjaimen resoluutio voi rajoittaa tulostusresoluutiota. Parhaan tulostuslaadun voit saavuttaa
asettamalla ei-PostScript-tulostimen ohjaimen resoluution samaksi tai suuremmaksi kuin InDesignin Tulosta-
valintaikkunassa määritetty resoluutio.

Julkaisujen esikatselu

Voit tarkistaa ennen PostScript-tulostimella tulostamista, miten hyvin julkaisu mahtuu valitulle paperille. Esikatselu
Tulosta-valintaikkunan vasemmassa alakulmassa näyttää, sopivatko paperi- ja suunta-asetukset sivun kokoon. Kun
valitset eri asetuksia Tulosta-valintaikkunasta, esikatselu näyttää heti uusien asetusten vaikutukset.

1. Valitse Tiedosto > Tulosta.
2. Napsauta esikatselukuvaa Tulosta-valintaikkunan vasemmassa alakulmassa.

Esikatselussa on kolme näkymää:
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Vakionäkymä

Näyttää julkaisun sivun suhteessa tulostusmateriaaliin. Se näyttää esimerkiksi paperin koon vaikutuksen kuva-
alueeseen, leikkausvara- ja informaatioalueet, sivun merkinnät sekä osituksen ja miniatyyrien vaikutukset.

Neljä erilaista sivun sovitusasetusta vakionäkymässä.

A. Oletus B. Aukeamat C. Suunta D. 2x2-miniatyyrit 

Tekstinäkymä

Luetteloi tiettyjen tulostusasetusten numeroarvot.

Mukautettu sivunäkymä tai irtoarkkinäkymä

Näyttää eri tulostusasetusten vaikutukset sivun kokoon suhteutettuna. Mukautettujen sivujen esikatselu näyttää
tulostusmateriaalin suhteessa mukautettuun tulostimeen, tulostusvälineen tukemat suurimmat
tulostusmateriaalikoot sekä siirtymän, välin ja käänteisen arvot. Letter- ja Tabloid-arkkien sekä muiden irtoarkkien
esikatselu näyttää kuva-alueen suhteessa tulostusmateriaalin kokoon.

Sekä mukautetun sivun että irtoarkin näkymissä esikatselu näyttää myös tulostusvälineen tilakuvakkeen: erottelut 
, yhdistelmäharmaa , yhdistelmä-CMYK  tai yhdistelmä-RGB .
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Alkuun

Mukautettu sivunäkymä (vasen) ja irtoarkin näkymä (oikea).

A. Tietovälineen kulkusuunta B. Käänteinen pois käytöstä C. Paperikoko D. Väline E. Kuva-alue F. Väline 

Tulostimen asentaminen

InDesign tukee tulostusta sekä PostScript® (Level 2 ja 3)- että ei-PostScript-tulostimilla ja käyttää uusimpia
tulostinohjaimia. PostScript-tulostimella tulostettaessa InDesign määrittää Tulosta-valintaikkunassa näkyvät
asetukset PPD (PostScript Printer Description) -tiedoston tietojen mukaan.

Asenna tulostin toimimalla seuraavasti:

Asenna tulostimeen uusin tulostinohjain. Lisätietoja on käyttöjärjestelmän oppaissa.

Kun käytössä on PostScript-tulostin, valitse PPD-tiedosto.

Tietoja tulostinohjaimista

Tulostinohjaimen avulla voit käyttää tulostimen ominaisuuksia suoraan tietokoneen sovelluksilla. Kun käytössä on
oikea ohjain, voit käyttää kaikkia tietyn tulostimen ominaisuuksia.

Adobe suosittelee uusimman ohjaimen päivittämistä käyttöjärjestelmään.

Tulostinohjaimen ominaisuuksien käyttäminen

Tulostinohjaimet saattavat tukea ominaisuuksia, joita ei ole InDesignissa. Tällainen on esimerkiksi kaksipuolinen
tulostus. Näiden ominaisuuksien tuki vaihtelee tulostinohjaimen mukaan. Saat lisätietoja tulostimen valmistajalta.

Jos haluat määrittää tietyn tulostimen asetukset, pääset käsittelemään tulostinohjainta seuraavilla InDesignin
Tulosta-valintaikkunaan painikkeilla. (Nämä asetukset eivät ole käytettävissä PostScript-tiedostoon tulostettaessa.)

Asetukset
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Alkuun

(Windows) Tämä painike avaa Windowsin Tulosta-valintaikkunan.

Sivun määrittely

(Mac OS) Tämä painike avaa Mac OS -järjestelmän Arkin määrittely -valintaikkunan.

Tulostin

(Mac OS) Tämä painike avaa Mac OS -järjestelmän Arkin määrittely -valintaikkunan.

Huomautus:

Jotkin InDesignin tulostusominaisuudet näkyvät sekä tulostinohjaimen valintaikkunoissa että InDesignin Tulosta-
ikkunassa. Saat parhaat tulokset määrittämällä asetukset vain InDesignin Tulosta-valintaikkunassa. Jos asetukset
menevät päällekkäin, InDesign yrittää synkronoida ne tai ohittaa ohjaimen asetukset. Eräät tulostinohjaimen
ominaisuudet (kuten kuvan tulostaminen useaan kertaan samalle sivulle) eivät toimi kaikkien InDesign-
ominaisuuksien (kuten erotteluiden) kanssa vaan tulostuvat virheellisesti.

PPD-tiedoston valitseminen

PDF-tiedosto (PostScript Printer Description -tiedosto) mukauttaa valitun PostScript-tulostimen ohjaimen toimintaa.
PPD-tiedostossa on tietoa tulostuslaitteesta, kuten tulostimen kirjasimista, tulostusmateriaalien koosta ja suunnasta,
optimoiduista rasteritiheyksistä, rasterointikulmista, resoluutiosta sekä väritulostustoiminnoista. Oikean PPD:n
määrittäminen ennen tulostamista on tärkeää. Jos PPD-tiedosto vastaa käyttämääsi PostScript-tulostinta tai
kirjapainotulostinta, tulostimen asetukset voi valita Tulosta-valintaikkunasta. Voit vaihtaa tilalle toisen tiedoston
tarpeidesi mukaan. Sovellukset käyttävät PPD-tiedostoja määrittämään, mitä PostScript-tietoja lähetetään
tulostimeen.

Adobe suosittelee, että hankit tulostimeen uusimman version PPD-tiedostosta, jotta tulostusjälki on paras
mahdollinen. Monilla tulostuspalveluilla ja painotaloilla on PPD-tiedostot omia painokoneitaan varten. Tallenna PPD
käyttöjärjestelmän määrittämään kohteeseen. Lisätietoja on käyttöjärjestelmän ohjeissa.

Windows- ja Mac OS -käyttöjärjestelmissä PPD-tiedosto valitaan samalla tavalla kuin tulostin lisätään. PPD-
tiedosto valitaan eri tavoin käyttöjärjestelmästä riippuen. Lisätietoja on käyttöjärjestelmän oppaissa.

Tulostusoletusarvojen käyttäminen

Jos tulostat säännöllisesti eri tulostimilla tai tulostat erilaisia tehtäviä, voit helpottaa työtäsi tallentamalla kaikki
tulostusasetukset esimäärityksiksi. Tulostuksen esimääritysten käyttäminen on nopea ja luotettava keino tulostaa
töitä, jotka vaativat monien täsmällisten asetusten määrittämistä Tulosta-valintaikkunassa.

Voit tallentaa ja ladata tulostuksen esimäärityksiä, joista on sitten helppo tehdä varmuuskopioita tai joita voidaan
jakaa tulostuspalvelulle, asiakkaille tai työryhmän muille jäsenille.

Tulostuksen esimäärityksiä luodaan ja tarkastellaan Tulostuksen esimääritykset -valintaikkunassa.

Tulostuksen esimäärityksien luominen

Tee jokin seuraavista:
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Valitse Tiedosto > Tulosta, säädä tulostusasetuksia ja napsauta Tallenna esimääritys. Kirjoita nimi tai
hyväksy oletusnimi ja napsauta sitten OK. Tällä menetelmällä esimääritys tallentuu
oletusarvotiedostoon.

Valitse Tiedosto > Tulostusoletusarvot > Määritä, ja valitse sitten Uusi. Kirjoita avautuvassa
valintaikkunassa uusi nimi tai hyväksy oletusnimi, säädä tulostusasetuksia ja napsauta sitten OK.
Tulostuksen esimääritykset -valintaikkuna palaa näkyviin. Napsauta sitten uudelleen OK.

Tulostuksen esimääritysten käyttäminen

1. Valitse Tiedosto > Tulosta.
2. Valitse Tulostuksen esimääritykset -valikosta esimääritys. Halutessasi voit vahvistaa tulostusasetukset

Tulosta-valintaikkunassa.
3. Valitse Tulosta.

Huomautus:

InDesignissa voidaan myös valita tulostuksessa käytettävä esimääritys Tiedosto > Tulostuksen esimääritykset -
valikosta.

Tulostuksen esimääritysten muokkaaminen

Tee jokin seuraavista:

Valitse Tiedosto > Tulosta, säädä tulostusasetuksia ja napsauta Tallenna esimääritys. Kun Tallenna
esimääritys -valintaikkuna avautuu, voit joko kirjoittaa nimen tekstiruutuun tai käyttää siinä näkyvää
nimeä. (Jos tekstiruudussa näkyvä nimi on jo käytössä esimäärityksen nimenä ja tallennat
esimäärityksen, aiemmat asetukset korvautuvat.) Napsauta OK-painiketta.

Valitse Tiedosto > Tulostusoletusarvot > Määritä, valitse sitten oletusarvo luettelosta ja valitse sitten
Muokkaa. Säädä tulostusasetuksia ja palaa Tulostuksen esimääritykset -valintaikkunaan
napsauttamalla OK. Napsauta sitten uudelleen OK.

Oletusesimääritystä voidaan muokata muiden esimääritysten tavoin edellä kuvatulla tavalla.

Tulostuksen esimääritysten poistaminen

1. Valitse Tiedosto > Tulostusoletusarvot > Määritä.
2. Valitse luettelosta vähintään yksi esimääritys ja napsauta Poista. Voit valita peräkkäisiä esimäärityksiä

vaihto-napsauttamalla. Voit valita muita kuin peräkkäisiä esimäärityksiä Ctrl-napsauttamalla (Windows) tai
Komento-osoittamalla (Mac OS).

Lisää ohjeaiheita

Rasteritiheyden ja resoluution määrittäminen
Adobe Print Resource Center
Sivujen vieminen EPS-muotoon
Tulostimen merkkien määrittäminen
Vieminen PDF-muotoon tulostamista varten

  Creative Commons -lisenssien ehdot eivät koske Twitter™- ja Facebook-viestejä.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö
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Kirjasten tulostaminen

Alkuun

Huomautus:

Huomautus:

Huomautus:

Julkaisun asemointi kirjasen tulostusta varten
Levitys
Kirjasen tulostuksen esikatselu tai katselu yhteenvetona
Kirjasen tulostamisen vianmääritys

Julkaisun asemointi kirjasen tulostusta varten

Tulosta kirjanen -ominaisuuden avulla voidaan luoda tulostusaukeamia ammattimaista tulostusta varten. Jos esimerkiksi muokkaat 8-sivuista
kirjasta, sivut näkyvät järjestyksessä asetteluikkunassa. Tulostusaukeamalla sivu 2 sijoittuu sivun 7 viereen, jolloin samalla arkilla tulostetut, taitetut
ja lajitellut sivut ovat oikeassa järjestyksessä.

Sivut ovat asetteluikkunassa numerojärjestyksessä, mutta ne tulostetaan eri järjestyksessä, jotta kokonaisuus näyttää oikealta taiton ja sidonnan
jälkeen.

Tulostusaukeamien luomista asetteluaukeamista kutsutaan asemoinniksi. Sivuja asemoitaessa voidaan säätää sivujen välistä tilaa, reunuksia,
leikkausvaraa ja levitystä asetuksia muuttamalla. InDesign-julkaisun asettelu ei muutu, koska asemointi tehdään tulostuksen yhteydessä. Julkaisun
sivuja ei sekoiteta tai kierretä.

Infiniteskills.comin Jeff Witchel pitää esittelyn aiheesta Vihkojen tulostaminen pöytätulostimella.

Asemoitujen sivujen perusteella ei voi luoda uutta julkaisua. Lisäksi jos julkaisu sisältää useita sivukokoja, et voi käyttää Tulosta
kirjanen -ominaisuutta valittuun julkaisuun.

1. Valitse Tiedosto > Tulosta kirjanen.

2. Jos tulostimen oletusarvo on haluamasi, valitse se Tulostuksen oletusarvo -valikosta.

Jos haluat käyttää nykyisen julkaisun tulostusasetuksia (Tulosta-valintaikkunassa näkyviä asetuksia), valitse Tulostuksen oletusarvo -
valikosta Julkaisun nykyiset asetukset.

3. Jos et halua asemoida koko julkaisua, valitse Asetukset-alueelta Alue, ja määritä asemoitavat sivut.

Erota peräkkäiset sivunumerot yhdysmerkillä ja toisistaan erillä olevat sivunumerot pilkulla. Jos esimerkiksi kirjoitat 3-7, 16, asemoidaan
sivut kolmesta seitsemään sekä sivu 16.

jos olet jakanut julkaisut sivunumeroituihin osiin, kirjoita osion sivunumero (kuten Osa2:11) Alue-kenttään.

4. Valitse Tulostusasetukset, jos haluat muuttaa asetuksia, kuten tulostimen merkkejä ja väritulostusasetuksia. Muuta asetuksia tarpeen
mukaan vasemmalla olevien asetusten avulla ja valitse sitten OK.

5. Määritä Tulosta kirjanen -valintaikkunassa muut tarvittavat kirjasen asetukset ja valitse sitten Tulosta.

Kirjasessa olevien sivujen määrä on aina neljän monikerta. Jos tulostat PDF-tulostimelle, kirjasta luotaessa PDF-tiedostoon lisätään
tyhjiä sivuja.
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2-osainen satulasidonta

2-osainen liimasidonta

Kirjasen tyypit

Valittavissa on kolme asemointityyppiä: 2-osainen satulasidonta, 2-osainen liimasidonta ja Jatkuva taitto.

Luo kaksisivuisia vierekkäisiä tulostusaukeamia. Nämä tulostusaukeamat soveltuvat kaksipuoliseen tulostukseen,
lajitteluun, taittoon ja nitomiseen. InDesign lisää tarvittavan määrän tyhjiä sivuja julkaisun loppuun. Sivujen välinen tila-, Sivujen välinen
leikkausvara- ja Sig-koko-asetukset eivät ole käytettävissä, kun 2-osainen satulasidonta on valittuna.
Tulosta kirjanen -toiminto asemoi sivut sidonta-asetuksen mukaan. Jos julkaisun sidonta-asetuksena on Oikealta vasemmalle, Tulosta kirjanen -
toiminto asemoi sivut sen mukaan. Voit tarkistaa julkaisun sidonta-asetuksen valitsemalla Tiedosto > Julkaisun asetukset.

24-sivuisen mustavalkoisen tiedotteen tulostusaukeamien luominen, kun käytössä on 12 arkin 2-osainen satulasidonta

Luo kaksisivuisia vierekkäisiä tulostusaukeamia, jotka sopivat määritettyyn kokoon. Nämä tulostusaukeamat soveltuvat
kaksipuoliseen tulostukseen, leikkaamiseen ja liimasidontaan. Jos asemoitavat sivut eivät ole jaollisia Sig-koolla, InDesign lisää tarvittavan määrän
tyhjiä sivuja julkaisun loppuun.

2-osainen liimasidonta, jaollinen neljällä

Jos kirjasen kansi on värillinen ja sisältö mustavalkoinen, voit luoda samaan julkaisuun kaksi asemointia: toinen etukantta, etukannen sisäkantta,
etukannen takakantta ja takakantta varten sekä toinen kirjasen 24 sisäsivua varten. Voit luoda värillisen kannen valitsemalla Alue-asetuksen
Asetukset-alueen Sivut-alueelta ja kirjoittamalla 1-2, 27-28 (eli osion sivunumerot). Luo mustavalkoiset sisäsivut kirjoittamalla Alue-tekstiruutuun 3-
26.
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Jatkuva taitto

Sivujen välinen tila

28-sivuinen kirjanen värillisellä kannella

A. Kannessa värimääritys B. Mustavalkoiset sisäsivut 

Luo kirjaseen tai esitteeseen sopivia kaksi-, kolme- tai neliosaisia asetteluja. Sivujen välinen leikkausvara, Levitys ja Sig-koko eivät
ole käytettävissä, kun jokin Jatkuva taitto -asetus on valittuna.
Jos haluat esimerkiksi luoda tulostusaukeamia perinteisiä kuusiosaisia kolmitaitteisia esitteitä varten, valitse 3-osainen jatkuva taitto. Olet ehkä
tottunut luomaan kolmeen osaan taitettavat julkaisut määrittämällä sivulle kolme palstaa. InDesign-asemoinnissa luot yksinkertaisesti kunkin osan
kokoisia sivuja.

3-osainen jatkuva taitto

Väli-, leikkausvara- ja reunusasetukset kirjasen tulostuksessa

Seuraavia asetuksia voi muuttaa Tulosta kirjanen -valintaikkunan Asetukset-alueella.

Määrittää sivujen välissä olevan tilan (vasemman sivun oikealla puolella ja oikean sivun vasemmalla puolella). Sivujen
välinen tila -arvon voi määrittää kaikissa muissa kirjasen tyypeissä paitsi satulasidonnassa.
Jos käytät liimasidontajulkaisuissa levitystä, jolla on negatiivinen arvo, sivujen välisen tilan vähimmäisarvo on levitysarvon leveys. Jos luot Sig-koon
manuaalisesti esimerkiksi silloin, kun samassa julkaisussa käytetään erilaista paperia, voit määrittää eri Sig-kokoihin kuuluvien aukeamien
levityksen aloituksen antamalla sivujen välisen tilan arvon.
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Sivujen välinen leikkausvara

Levitys

Sig-koko

Säädä automaattisesti sovitusmerkkeihin ja leikkausvaroihin

Reunukset

Tulosta tyhjät tulostusaukeamat

Alkuun

Alkuun

Määrittää, miten paljon sivuelementit voivat käyttää liimasidontatulostusaukeaman väliä. Tätä asetusta kutsutaan
toisinaan päällekkäisyydeksi.) Kenttään voi syöttää arvon väliltä 0 - puolet Sivujen välinen tila -arvosta. Tämän asetuksen voi määrittää vain silloin,
kun valittuna on 2-osainen liimasidonta.

Määrittää tilan, joka ottaa huomioon paperin paksuuteen ja kunkin nidottavan arkin taittoon liittyvät seikat. Useimmissa tapauksissa
kannattaa määrittää negatiivinen arvo, joka luo sisennysvaikutuksen. Levityksen voi määrittää kirjasen tyypeille 2-osainen satulasidonta ja 2-
osainen liimasidonta. (Katso Levitys.)

Määrittää sivujen määrän kussakin 2-osaisen liimasidontajulkaisun nidottavassa arkissa. Jos asemoitavat sivut eivät ole jaollisia Sig-
koolla, julkaisun loppuun lisätään tarvittava määrä tyhjiä sivuja.

Antaa InDesignin laskea reunukset leikkausvarojen ja muiden määritettyjen
tulostimen merkkiasetusten mukaisesti. Reunukset-kohdan kentät eivät ole käytettävissä, kun tämä asetus valitaan. Kentissä näkyvät kuitenkin
merkkien ja leikkausvarojen mukaisesti käytettävät arvot. Jos poistat tämän vaihtoehdon valinnan, voit säätää reunusarvoja manuaalisesti.

Määrittää tulostusaukeaman ympärillä viimeistelyn jälkeen olevan tilan. Jos haluat määrittää erikseen Ylä-, Ala-, Vasen- ja Oikea-
arvot, poista Säädä automaattisesti sovitusmerkkeihin ja leikkausvaroihin -vaihtoehdon valinta. Voit lisätä oletusmerkkejä ja -leikkausvaroja
suuremmat tilat suurentamalla arvoja. (Arvojen pienentäminen voi aiheuttaa merkkien ja leikkausvarojen leikkautumisen.) Reunusarvot voi
määrittää kaikissa kirjasen tulostustyypeissä.

Jos asemoitavat sivut eivät ole jaollisia Sig-koolla, julkaisun loppuun lisätään tyhjiä sivuja tai aukeamia. Tämän
asetuksen avulla voit määrittää, tulostetaanko nämä tyhjät aukeamat julkaisun lopussa. Huomaa, että julkaisun muiden tyhjien sivujen tulostamisen
määrittää Tulosta-valintaikkunan Tulosta tyhjät sivut -asetus.

Levitys

Levitys määrittää satula- ja liimasidontajulkaisuissa sivujen siirtymän selästä paperin paksuuden ja taiton vuoksi. InDesignissa lopullisen version
"kansi" on uloimmainen tulostusaukeama ja "keskiaukeama" sisimmäinen tulostusaukeama. Arkki viittaa kahteen tulostusaukeamaan: arkin etu- ja
taustapuoleen. Levityslisäys lasketaan jakamalla tietty levitysarvo kokonaisarkkimäärällä, josta vähennetään yksi.

Kun annat positiivisen levitysarvon, keskiaukeamaa ei säädetä, mutta ulommilla arkeilla olevia sivuja siirretään selästä poispäin. Kun annat
negatiivisen levitysarvon, kantta ei säädetä, mutta sisemmillä arkeilla olevia sivuja siirretään selkään päin.

Esimerkiksi 16-sivuinen InDesign-julkaisu voi koostua kahdeksasta tulostusaukeamasta eli neljästä arkista. Ensimmäisen arkin etupuoli koostuu
ensimmäisestä tulostusaukeamasta (sivut 16 ja 1) ja taustapuoli toisesta tulostusaukeamasta (sivut 2 ja 15).

Jos tämän esimerkin levitysarvo on 24 pistettä (liioiteltu määrä esimerkin selvyyden vuoksi), levityslisäys arkkia kohden on 8 pistettä (24 jaettuna
kolmella). Uloimmassa arkissa käytetään 24 pisteen levitystä, kolmannessa arkissa käytetään 16 pisteen levitystä ja toisessa arkissa 8 pisteen
levitystä. Ensimmäisessä uloimmassa arkissa ei käytetä levitystä.

Peräkkäisissä arkeissa käytettävä levitys vähenee levityslisäyksen verran. Toisin sanoen sisimmän arkin sivuja siirretään 12 pistettä (puolet arkin
24 pisteen levityslisäyksestä) selästä poispäin, kolmannen arkin sivuja siirretään 8 pistettä (puolet arkin 16 pisteen levitysarvosta) selästä poispäin
ja toisen arkin sivuja siirretään 4 pistettä (puolet arkin 8 pisteen levitysarvosta) selästä poispäin.

Kirjasen tulostuksen esikatselu tai katselu yhteenvetona

Tulosta kirjanen -valintaikkunan esikatselussa voit katsoa valitsemallasi asemointityylillä luotujen tulostusaukeamien värillisiä miniatyyrejä. Siinä
näkyvät myös Tulosta-valintaikkunassa määrittämäsi tulostimen merkit.

1. Valitse Tiedosto > Tulosta kirjanen.

2. Tee jokin seuraavista toimista:

Valitse valintaikkunan vasemmasta reunasta Esikatselu. Voit selata tulostusaukeamia selausnuolilla. Voit siirtyä edellisiin aukeamiin
vasemmalla selausnuolella. Voit vaihtaa tulostusaukeamia vetämällä selausruutua.

Voit katsoa voimassa olevat kirjasen asetukset valitsemalla Yhteenveto-vaihtoehdon Tulosta kirjanen -valintaikkunan vasemmasta
reunasta. Tarkista Yhteenveto-alueen alareunasta, ettei ristiriitaisia asetuksia ole.
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Alkuun

Uutta julkaisua ei voida luoda

Tyhjiä sivuja ei sisällytetä

Kaksipuolisten sivujen tulostaminen ilman kaksipuolista tulostinta

Jos valitset Tulostusasetukset ja muutat Tulosta-valintaikkunan asetuksia, voit nähdä muutettujen asetusten vaikutuksen esikatselussa.

Kirjasen tulostamisen vianmääritys

Seuraavat ongelmat kannattaa ottaa huomioon kirjasia tulostettaessa.

Valitettavasti et voi luoda uutta InDesign-julkaisua valituista sivuista. Voit tulostaa valitun julkaisun tai luoda PDF-
tiedoston.

Voit lisätä tyhjiä sivuja julkaisun keskelle, jos haluat varmistaa, että jokaiselle tulostinaukeamalle on riittävästi sivuja.
Jos näillä sivuilla ei ole kuitenkaan tekstiä eikä objekteja, niitä ei välttämättä tunnisteta, jolloin lisätyt tyhjät sivut lisätään julkaisun loppuun. Jos
haluat varmistaa, että lisäämäsi tyhjät sivut sisällytetään valittuun julkaisuun, valitse Tulosta kirjanen -valintaikkunasta Tulostusasetukset ja valitse
sitten Tulosta tyhjät sivut ja valitse OK.

Käytä Vain parittomat sivut- ja Vain parilliset sivut -asetuksia joko Adobe
Acrobatissa or InDesignissa. Kun ensimmäisen asetuksen tulosteet on tulostettu, käännä paperit toisin päin ja tulosta loput sivut. Tulosta
testijulkaisu, jotta näet missä suunnassa ja järjestyksessä sivut tulisi lisätä tulostimeen. Näin saat parhaan tuloksen.
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Tulostimen merkit ja leikkausvarat

Alkuun

Alkuun

Tulostimen merkkien määrittäminen
Leikkausvara- tai informaatioalueiden tulostaminen
Sivun sijainnin muuttaminen tulostusalueella

Tulostimen merkkien määrittäminen
Kun valmistelet julkaisua tulostusta varten, tulostin tarvitsee useita merkkejä esimerkiksi paperin viimeistelyyn, erottelufilmien kohdistamiseen
vedosten tulostamista varten sekä filmin mittaukseen oikeaa kalibrointia ja pistetiheyttä varten. Sivumerkkiasetuksen valitseminen laajentaa sivun
rajoja niin, että tulostimen merkit, leikkausvara (viimeistelyn yhteydessä sivun rajojen ulkopuolelle pienen epätarkkuuden vuoksi jäävät alueet) tai
informaatioalue (sivun ulkopuolella oleva alue, jossa on tulostusohjeita tai työn hyväksymistietoja) mahtuvat arkille.

Jos määrität leikkausmerkkejä ja haluat kuvituksen sisältävän leikkausvaran tai informaatioalueen, varmista, että kuvitus ylittää leikkausmerkit.
Tällöin leikkausvara ja informaatioalue mahtuvat tulostusalueeseen. Varmista, että tulostusalueelle mahtuvat sekä sivu että tulostimen merkit,
leikkausvarat tai informaatioalue. Jos julkaisu ei mahdu tulostusmateriaalille, voit määrittää leikkauskohdat valitsemalla Tulosta-valintaikkunan
Asetukset-alueelta Sivun paikka -asetuksen.

Jos valitset Leikkausmerkit-vaihtoehdon, taittomerkit tulostetaan yhtenäisinä viivoina aukeamia tulostettaessa.

Tulostimen merkit
A. Leikkausmerkit B. Kohdistusmerkki C. Sivun tiedot D. Väririvit E. Leikkausvaramerkit F. Informaatioalue

1. Valitse Tiedosto > Tulosta.
2. Valitse Tulosta-valintaikkunan vasemmasta reunasta Merkit ja leikkausvara.
3. Valitse joko Kaikki tulostimen ohjausmerkit tai yksittäiset merkit.

Leikkausvara- tai informaatioalueiden tulostaminen
Määritä leikkausvara- ja informaatioalueet Julkaisun asetukset -valintaikkunassa. Leikkausvara- ja informaatioalueet poistetaan, kun julkaisu
viimeistellään lopulliseen sivukokoon. Leikkausvara- ja informaatioalueiden ulkopuolella olevat objektit (sen mukaan, kumpi ulottuu kauemmaksi)
eivät tulostu.

Voit tulostettaessa ohittaa leikkausvaramerkkien oletussijainnin valitsemalla Merkit ja leikkausvara -kohdassa Leikkausvara- ja informaatioalue.

Jälkikäsittelyohjelmat voivat lisätä oman vaihtelevan leikkausvaransa PostScript-tiedostoihin.

1. Valitse Tiedosto > Tulosta.
2. Valitse Tulosta-valintaikkunan vasemmasta reunasta Merkit ja leikkausvara.
3. Valitse joko Kaikki tulostimen ohjausmerkit tai yksittäiset merkit.
4. Ohita Julkaisun asetukset -valintaikkunan leikkausvara-asetukset poistamalla Käytä julkaisun leikkausvara-asetuksia -valinta ja kirjoittamalla

haluamasi arvot Ylä-, Ala-, Vasen- ja Oikea-ruutuihin (yksipuolisissa julkaisuissa) tai Ylä-, Ala-, Sisä- ja Ulko-ruutuihin (kaksipuolisissa
julkaisuissa, joissa on vastakkaiset sivut). Voit laajentaa siirtymää tasaisesti sivun kaikille puolille napsauttamalla Määritä kaikki asetukset
samoiksi -kuvaketta .

5. Valitse Sisällytä informaatioalue, kun haluat tulostaa objekteja käyttämällä Julkaisun asetukset -valintaikkunassa määritettyä
informaatioaluetta.
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Voit esikatsella leikkausvara- ja informaatioalueita ennen tulostusta napsauttamalla työkalupaneelin alaosassa Leikkausvara-esikatselutilan
kuvaketta  tai Informaatioalue-esikatselutilan kuvaketta . (Niiden edessä voi olla Esikatselutilan kuvake .)

Merkit ja leikkausvara -asetukset
Voit määrittää seuraavat asetukset Merkit ja leikkausvarat -alueella:

Kaikki tulostimen ohjausmerkit Valitsee kaikki tulostimen merkit, myös leikkausmerkit, leikkausvaramerkit, kohdistusmerkit, väripalkit ja sivun
tiedot.
Leikkausmerkit Lisää ohuita vaaka- ja pystyviivoja (hiusviivoja) leikkauskohtiin. Leikkausmerkit voivat myös helpottaa värierottelujen kohdistusta.
Jos käytät leikkausmerkkejä yhdessä leikkausvaramerkkien kanssa, voit valita limittäisiä merkkejä.
Leikkausvaramerkit Lisää arkkiin ohuita viivoja (hiusviivoja), jotka määrittävät kuva-alueen sivun alueen ulkopuolella.
Kohdistusmerkit Lisää pieniä "kohteita" sivun ulkopuolelle, jotta erilaiset värijulkaisun erottelut voidaan kohdistaa.
Väripalkit Lisää pieniä värineliöitä merkitsemään CMYK-painovärejä ja harmaan sävyjä (10 %:n välein). Tulostuspalvelu käyttää merkkejä
painoväritiheyden säätämiseen painokoneessa.
Sivun tiedot Tulostaa tiedostonimen, sivunumeron, päiväyksen ja ajan sekä värierottelun nimen kuuden pisteen Helvetica-kirjasimella arkin tai
filmin vasempaan alakulmaan. Sivun tiedot vaativat 0,5 tuumaa (13 mm) tilaa arkin vaakareunaan.
Tyyppi Voit valita oletustulostimen merkit tai mukautetut merkit (esimerkiksi japanilaisille sivuille). Voit luoda mukautettuja tulostimen merkkejä tai
käyttää muun yrityksen luomia mukautettuja merkkejä.
Leveys Näyttää leikkausmerkkien ja leikkausvaran viivojen paksuuden.
Siirtymä Määrittää, miten kauas paperin reunasta (ei leikkausvarasta) InDesign asettaa tulostimen merkit. InDesign asettaa tulostimen merkit
oletusarvoisesti 6 pisteen päähän sivun reunasta. Siirtymän on oltava leikkausvaraa suurempi, jotta tulostimen merkit eivät joudu leikkausvara-
alueelle.

Sivun sijainnin muuttaminen tulostusalueella
Kun tulostat julkaisun sen kokoa suuremmalle irtoarkille, voit määrittää leikkausvara- ja informaatioalueen, tulostimen merkit ja sivun paikan arkilla
käyttämällä Tulosta-valintaikkunan Asetukset-alueen Sivun sijainti -asetuksia. Jos julkaisu ei sovi tulostusalueelle ja sitä on leikattava, voit
määrittää julkaisun leikattavat osat. Vaikutukset näkyvät Tulosta-valintaikkunan esikatselussa.

Huomautus: Jos haluat nähdä kaikki leikkausvara- ja informaatioalueet sekä tulostimen merkit, käytä Sivun sijainti -asetuksen sijasta Skaalaa
sopivaksi -asetusta. Tällöin skaalatut sivut ovat aina arkin keskellä. Sivun sijainti -asetukset eivät ole käytettävissä, jos Skaalaa sopivaksi,
Miniatyyrit tai Vierekkäin on valittu.

 Valitse Tulosta-valintaikkunasta Asetukset-alueen Sivun sijainti -valikosta sijainti.
Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Lihotuksen esimääritykset

Alkuun

Alkuun

Alkuun

Lihotusoletusarvot-paneelin yleiskuvaus
Lihotuksen esimäärityksen luominen tai muokkaaminen
Lihotuksen esimääritysten hallinta
Lihotusesimäärityksen liittäminen sivuihin
Lihotussivualueiden määrittäminen
Lihotuksen esimäärityksen asetukset
Liukuvien lihotusten määrittäminen
Tietoja mustan lihotuksesta
Mustan vierusvärien lihotusleveyden määrittäminen
Kirjan painaminen, kun lihotusoletusarvot ovat ristiriidassa

Lihotusoletusarvot-paneelin yleiskuvaus
Lihotusoletusarvot ovat lihotusasetuksia, jotka voidaan valita tietylle julkaisun sivulle tai sivualueelle. Lihotusoletusarvot-paneeli toimii
käyttöliittymänä lihotusasetusten määrittämistä ja lihotusoletusarvojen tallentamista varten. Voit liittää lihotusoletusarvoja joihinkin tai kaikkiin
julkaisun sivuihin tai tuoda oletusarvoja toisesta InDesign-julkaisusta. Jos et liitä lihotusoletusarvoa lihotussivualueeseen, alueesta tulee [Oletus]-
asetuksen mukainen.

Lihotusoletusarvojen näyttäminen
1. Jos Lihotusoletusarvot-paneeli ei ole auki, valitse Ikkuna > Tuloste > Lihotusoletusarvot.
2. Tee Lihotusoletusarvot-paneelissa yksi seuraavista:

Kaksoisnapsauta oletusarvoa.

Valitse oletusarvo ja valitse sitten paneelin valikosta Oletusarvojen asetukset.

Lihotusoletusarvot-luettelon tiivistäminen
 Valitse Lihotusoletusarvot-paneelivalikosta Pienet paneelin rivit.

Käyttämättömien lihotusoletusarvojen tunnistaminen
 Valitse Lihotusoletusarvot-paneelivalikosta Valitse kaikki käyttämättömät. Lihotusohjelma korostaa kaikki oletusasetukset (lukuun ottamatta

[Oletus]- ja [Ei lihotusoletusarvoa] -vaihtoehtoja), joita ei ole liitetty muokattavaan julkaisuun. Voit poistaa nämä oletusasetukset helposti.

Lihotuksen esimäärityksen luominen tai muokkaaminen
1. Jos Lihotusoletusarvot-paneeli ei ole auki, valitse Ikkuna > Tuloste > Lihotusoletusarvot.
2. Valitse paneelivalikosta Uusi oletusarvo, jos haluat luoda oletusarvon. Kaksoisnapsauta oletusarvoa, jos haluat muokata sitä.

Huomautus: Lihotusoletusarvot-paneelin alareunassa olevan Luo uusi lihotusoletusarvo -painikkeen napsauttaminen luo uuden [Oletus]-
lihotusasetuksiin perustuvan oletusarvon.

3. Määritä seuraavat asetukset ja napsauta sitten OK-painiketta:
Nimi Kirjoita esimäärityksen nimi. [Oletus]-asetuksen nimeä ei voi vaihtaa.

Lihotuksen leveys Kirjoita painovärien päällekkäisyyden määrittävät arvot.

Lihotuksen ulkoasu Määritä lihotusten muotoa säätelevät asetukset.

Kuva Määritä tuotujen bittikarttakuvien lihotustavan asetukset.

Lihotuksen kynnykset Kirjoita arvot, jotka määrittävät, milloin lihotusta käytetään. Useat seikat vaikuttavat tähän kohtaan merkittäviin
arvoihin. Kysy lisätietoja tulostuspalvelusta.

Lihotuksen esimääritysten hallinta
Voit kopioida, poistaa, tuoda ja mukauttaa lihotusoletusarvoja.

Lihotusoletusarvon monistaminen
 Tee jokin seuraavista:
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Valitse ensin oletusarvo Lihotusoletusarvot-paneelista ja valitse sitten paneelivalikosta Monista oletusarvo.

Vedä oletusarvo paneelin alareunassa olevaan Luo uusi lihotusoletusarvo -painikkeeseen.

Lihotuksen esimäärityksen poistaminen
1. Valitse Lihotusoletusarvot-paneelista haluamasi oletusarvo ja tee yksi seuraavista:

Napsauta Poista-painiketta.

Valitse paneelivalikosta Poista oletusarvot.

2. Jos ohjelma kehottaa korvaamaan lihotusoletusarvon, valitse oletusarvo avautuvasta Poista lihotusoletusarvo -valintaikkunasta. Valintaikkuna
avautuu, jos vähintään yksi valituista tyyleistä on liitetty johonkin sivuun.

3. Vahvista poistaminen valitsemalla Kyllä.

Huomautus: yhdysrakenteisia oletusarvoja [Oletus] ja [Ei lihotusoletusarvoa] ei voi poistaa.

Oletusarvojen tuominen toisesta InDesign-julkaisusta
1. Valitse Lihotusoletusarvot-paneelivalikosta Lataa lihotusoletusarvot.
2. Valitse InDesign-tiedosto ja napsauta Avaa-painiketta.

Lihotusesimäärityksen liittäminen sivuihin
Voit liittää lihotusoletusarvon julkaisuun tai sen sivualueeseen. Esimerkiksi sivut, joilla ei ole vierekkäisiä värejä, tulostuvat nopeammin, jos poistat
lihotuksen käytöstä. Lihotus tehdään vasta julkaisua tulostettaessa.

Lihotustehtävät luetteloivat eri sivuihin liitetyt oletusarvot. Lihotustehtävät päivittyvät, kun valitset Liitä.

1. Valitse Lihotusoletusarvot-paneelivalikosta Määritä lihotusoletusarvo.
2. Määritä Lihotusoletusarvo-kohtaan haluamasi oletusarvo.
3. Valitse sivut, joihin haluat lisätä lihotusoletusarvon.
4. Napsauta Liitä-painiketta ja sitten Valmis-painiketta.

Huomautus: Jos napsautat vain Valmis-painiketta, valintaikkuna sulkeutuu eikä lihotustehtäviin tehdä muutoksia. Liitä-painikkeella aiemmin
vahvistetut lihotustehtävät pysyvät tallessa.

Lihotussivualueiden määrittäminen
1. Valitse Lihotusoletusarvot-paneelivalikosta Määritä lihotusoletusarvo.
2. Määritä Lihotusoletusarvo-kohtaan oletusarvo, jonka haluat liittää sivualueeseen.
3. Valitse Alue ja määritä vähintään yksi alue nousevassa järjestyksessä. Käytä yhdysmerkkiä alueiden muodostamiseen ja erota sivut ja alueet

toisistaan pilkulla tai pilkulla ja välilyönnillä. Esimerkiksi 2-4, 6, 9-10, 12- on sallittu alue.
4. Napsauta Liitä-painiketta ja sitten Valmis-painiketta.

Voit poistaa lihotussivualueen käytöstä valitsemalla paneelivalikosta Määritä lihotusoletusarvo, määrittämällä sivualueen ja valitsemalla
Lihotusoletusarvo-valikosta [Ei lihotusoletusarvoa]. Napsauta Liitä-painiketta ja sitten Valmis-painiketta.

Lihotuksen esimäärityksen asetukset
Voit muuttaa lihotuksen esimäärityksen asetuksia joka kerta kun luot lihotuksen esimäärityksen tai muokkaat sellaista. Samat lihotuksen
esimääritykset ovat käytettävissä Acrobatissa ja InDesignissa. Acrobatissa voidaan tarkastella lihotuksen esimäärityksiä valitsemalla Työkalut >
Painotyö > Lihotuksen esimääritykset. Valitse InDesignissa Ikkuna > Tulostus > Lihotuksen esimääritykset.

Lihotusleveydet
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Lihotusleveys on kunkin lihotuksen päällekkäisyyden määrä. Erot paperien ominaisuuksissa, rasteritiheyksissä ja painokoneen toiminnoissa
edellyttävät eri lihotusleveyksiä. Kysy tulostustyöhön sopivimmat lihotusleveydet painotalosta.

Oletus Määrittää lihotusleveyden kaikille muille väreille paitsi tasaiselle mustalle. Oletusarvo on 0p0,25.
Musta Määrittää alueen, jolle painovärit leviävät tasaisen mustan päällä, tai esteleveyden (alue mustien reunojen ja alla olevien painovärien välillä,
kun kylläisiä mustia lihotetaan). Oletusarvo on 0p0,5. Täksi arvoksi valitaan usein 1,5–2 kertaa oletuslihotusleveys.
InDesignissa Musta väri -arvon asetus määrää arvot, jotka annetaan tasaiselle mustalle tai kylläiselle mustalle eli prosessimustalle (K) painovärille,
johon on sekoitettu värimusteita peittävyyden lisäämiseksi ja värikylläisyyden parantamiseksi.

Huomautus: (InDesign) Jos valitset lihotuksen sovelluksessa ja määrität lihotuksen oletusleveydeksi tai mustan leveydeksi yli 4 pistettä,
tuloksena on 4 pisteen leveys. Asetuksessa näkyy kuitenkin määrittämäsi arvo, koska jos valitset lihotuksen Adobe-rasterointiprosessorilla, neljää
pistettä leveämpi lihotus on mahdollinen.

Lihotuksen ulkoasu
Liitos on kohta, jossa on kahden lihotusreunan yhteinen lopetuspiste. Voit säätää kahden lihotusosan ulkoliitosta ja kolmen lihotusosan
kohtauspistettä.

Liitoksen tyyli Säätää kahden lihotusosan ulkoliitoksen muotoa. Valitse viiste, pyöreä tai kohotettu. Oletusasetus on Viiste, joka vastaa aiempia
lihotustuloksia niin, että uudet tulokset ovat yhdenmukaisia Adoben lihotusohjelman kanssa.

Esimerkkejä lihotusliitoksista vasemmalta oikealle: viiste, pyöreä ja kohotettu

Lopetustyyli Määrittää kolmisuuntaisten lihotusten leikkauspisteen. Viiste (oletus) muotoilee lihotuksen lopetuskohtaa niin, että se ei kosketa
leikkaavaa kohdetta. Limitys vaikuttaa lihotukseen, joka on luotu vaaleimmalla neutraalin tiheyden objektilla ja joka leikkaa vähintään kahta
tummempaa objektia. Vaaleimman lihotuksen lopetuskohta on kierretty kolmen objektin leikkauspisteen ympärille.

Lihotuksen suurennos ja esimerkkejä: viiste (vasen) ja limitys (oikea)

Lihotuksen kynnykset
Vaihe Määrittää värinmuutoskynnyksen, jolla lihotusohjelma tuottaa lihotuksen. Eräissä töissä täytyy lihottaa vain äärimmäiset värimuutokset, kun
taas toiset edellyttävät hienovaraistenkin värimuutosten lihottamista. Vaihe-arvo ilmaisee, kuinka paljon toisiaan koskettavien värien osien (kuten
CMYK-arvojen) on vaihdeltava ennen kuin lihotusta käytetään.
Jos haluat määrittää, kuinka paljon vierekkäisten värien komponenttiväriaineet saavat vaihdella, ennen kuin nämä värit lihotetaan, suurenna tai
pienennä Vaihe-asetusta Uusi lihotusoletusarvo- tai Muokkaa lihotusoletusarvon asetuksia -valintaikkunassa. Oletusasetus on 10 %. Saat
parhaimmat tulokset valitsemalla arvoksi 8–20 %. Pieni prosenttiluku merkitsee suurta herkkyyttä värieroille ja useampia lihotuksia.

Musta väri Ilmaisee, miten paljon mustaa painoväriä on vähintään oltava, jotta mustan värin lihotusleveyden asetus otetaan käyttöön. Oletusarvo
on 100 %. Saat parhaimmat tulokset käyttämällä arvoa, joka on vähintään 70 %.
Mustan tiheys Ilmaisee neutraalin tiheyden arvon, joka painovärillä on oltava, jotta lihotusohjelma tulkitsisi sen mustaksi. Jos esimerkiksi haluat
tumman spottivärin käyttävän mustan värin lihotusleveyden asetusta, määritä neutraalin tiheyden arvo tähän. Täksi arvoksi asetetaan yleensä
lähellä oletusarvoa 1,6 oleva arvo.
Liukuva lihotus  Määrittää, milloin lihotusohjelma alkaa siirtää värirajan keskiviivaa. Arvo tarkoittaa vaaleamman värin neutraalin tiheyden
suhdetta tummemman, vierekkäisen värin neutraaliin tiheyteen. Jos asetus on esimerkiksi 70 %, lihotusohjelma alkaa siirtää keskiviivaa, kun
vaaleamman värin neutraali tiheys ylittää 70 % tummemman värin neutraalista tiheydestä (vaaleamman värin neutraali tiheys jaettuna tummemman
värin neutraalilla tiheydellä on > 0,70). Jos värien neutraalit tiheydet ovat täsmälleen samat, lihotus sijoittuu tarkasti puoliväliin, ellei Liukuva lihotus
ole 100 %.
Lihotusvärin vähennys Osoittaa astetta, johon saakka käytetään viereisten värien komponentteja lihotusvärin vähentämiseen. Tämä asetus on
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hyödyllinen tapa estää tiettyjen vierekkäisten värien (kuten pastellivärien) muuttuminen rumaksi lihotukseksi, joka on tummempi kuin kumpikaan
väri. Jos Lihotuksen värin vähennys -arvo on pienempi kuin 100 %, lihotuksen väri vaalenee. Jos arvo on 0 %, lihotuksen neutraali tiheys on yhtä
suuri kuin tummemman värin neutraali tiheys.

Tuodun grafiikan lihottaminen
Voit luoda lihotusoletusarvon, jolla säädetään kuviin sisältyvää lihotusta sekä bittikarttakuvien (kuten valokuvien ja PDF-rasterikuvien) ja
vektoriobjektien (kuten piirto-ohjelmassa tallennettujen kuvien ja PDF-vektoritiedostojen) välistä lihotusta. Jokainen lihotusohjelma käsittelee tuotua
grafiikkaa eri tavalla. On tärkeää, että olet tietoinen näistä eroista lihotusasetuksia tehdessäsi.

Lihotuksen sijoittelu Asetukset, joilla määrätään, mihin lihotus sijoitetaan lihotettaessa vektoriobjekteja (kuten InDesignilla piirrettyjä objekteja)
bittikarttakuviin. Kaikki muut asetukset paitsi Neutraali tiheys tuottavat visuaalisesti yhdenmukaisen reunan. Keskitetty tuottaa lihotuksen, joka on
tarkasti objektien ja kuvien välisellä reunalla. Kuristus aiheuttaa sen, että objektit tulevat osittain vierekkäisen kuvan päälle. Neutraali tiheys
tarkoittaa julkaisun yleisiä lihotussääntöjä. Objektin lihottaminen valokuvaan Neutraali tiheys -asetuksella voi tuottaa selvästi epätasaiset reunat,
sillä lihotus voi siirtyä reunan puolelta toiselle. Levitys aiheuttaa sen, että bittikarttakuva limittyy osittain viereisen objektin kanssa.
Objektien lihottaminen kuviin Varmistaa, että vektoriobjektit (kuten apuviivoina käytetyt kehykset) lihotetaan kuviin käyttäen Lihotuksen sijoittelu -
asetuksia. Jos vektoriobjektit eivät osu kuvien päälle lihotussivualueella, tämä asetus kannattaa poistaa käytöstä sivualueen lihottamisen
nopeuttamiseksi.
Kuvien lihottaminen kuviin Ottaa käyttöön limittyvien tai vierekkäisten bittikarttakuvien reunojen lihotuksen. Ominaisuus on käytössä
automaattisesti.
Lihota kuvat sisäisesti Ottaa lihotuksen käyttöön kunkin bittikarttakuvan kaikissa väreissä eikä vain kohdissa, joissa värit koskettavat
vektorigrafiikkaa tai tekstiä. Käytä tätä asetusta vain silloin, kun sivualueilla on yksinkertaisia ja jyrkkäkontrastisia kuvia, kuten näyttökuvia tai
sarjakuvia. Älä valitse asetusta, jos julkaisussa on sävykuvia tai muita monimutkaisia kuvia, sillä niiden lihotus onnistuu huonosti. Lihottaminen
toimii nopeammin, kun tätä asetusta ei ole valittu.
Lihota 1-bittiset kuvat Varmistaa, että 1-bittiset kuvat lihotetaan viereisiin objekteihin. Tämä asetus ei käytä Kuvan lihotuksen sijoittelu -asetuksia,
koska 1-bittisissä kuvissa on vain yksi väri. Useimmiten tämän asetuksen valinta on järkevää. Tämä asetus saattaa tummentaa kuvaa ja hidastaa
lihottamista eräissä tapauksissa, kuten 1-bittisessä kuvassa, jonka pikseleiden välit ovat suuret.

Liukuvien lihotusten määrittäminen
1. Valitse paneelivalikosta Uusi oletusarvo, jos haluat luoda oletusarvon. Kaksoisnapsauta oletusarvoa, jos haluat muokata sitä.
2. Kirjoita Lihota kynnykset -kohdassa Liukuvan lihotuksen prosenttiarvoksi 0–100 tai käytä oletusarvoa 70 %. Kaikki lihotukset päättyvät

puoliväliin, jos arvo on 0 %. Jos arvo on 100 %, liukuva lihotus poistuu käytöstä, jolloin yksi väri leviää täysin toisen päälle riippumatta
vierekkäisten värien neutraalin tiheyden suhteesta.

Tietoja mustan lihotuksesta
Esimäärityksiä luotaessa tai muokattaessa Musta väri -arvon asetus määrää arvot, jotka annetaan tasaiselle mustalle tai kylläiselle mustalle.
Kylläinen musta on mikä tahansa musta väri, jossa käytetään tukirasteria prosessivärien lisäämiseen mustan värin vahvistamiseksi.

Musta väri -asetuksesta on hyötyä, kun pitää huomioida erittäin voimakas pisteen kasvaminen (kuten heikkolaatuista paperia käytettäessä). Näissä
tilanteissa musta väri, jonka prosenttiarvo on alle 100 %, tulostuu tasaisena mustana. Kun harvennat mustan tai syvän mustan rasteria (käyttämällä
tasaisen mustan sävyjä) ja pienennät Musta väri -asetusta oletusarvosta 100 %, voit kompensoida pisteen kasvamisen ja varmistaa, että
lihotusohjelma käyttää mustissa objekteissa oikeaa lihotuksen leveyttä ja sijoittelua.

Kun väri saavuttaa Musta-arvon, lihotuksen leveyden Musta-arvoa käytetään kaikkiin sen vieressä oleviin väreihin ja sen mukaiset erotuslihotukset
lisätään syvän mustiin alueisiin.

Jos tukirasterit ulottuvat mustan alueen reunaan asti, pienikin kohdistusvirhe tuo tukirasterien reunat esiin, jolloin syntyy häiritsevä valokehä tai
objektien reunat vääristyvät. Lihotusohjelma käyttää kylläisen mustan sijoittamiseen erotuslihotusta eli esteleveyttä, jotta tukirasterit pysyvät
määritetyllä etäisyydellä edustan käänteisten tai vaaleiden kohteiden reunoista ja kohteet säilyvät terävinä. Tukirasterien etäisyys mustien alueiden
reunoista määritetään lihotusleveyden Musta-asetuksella.

Huomautus: jos lihotettava kohde on kapea, esimerkiksi musta ääriviiva grafiikan ympärillä, lihotusohjelma ohittaa lihotusleveyden Musta-
asetuksen ja rajoittaa lihotuksen puoleen kapean kohteen leveydestä.

Mustan vierusvärien lihotusleveyden määrittäminen
1. Valitse paneelivalikosta Uusi oletusarvo, jos haluat luoda oletusarvon. Kaksoisnapsauta oletusarvoa, jos haluat muokata sitä.
2. Kirjoita Lihotuksen leveys -kohdan Musta-ruutuun leveys (pisteinä), jonka haluat muiden värien leviävän mustan päälle eli miten paljon

haluat tukirasterien kutistuvan mustan alla. Mustan lihotuksen leveydeksi valitaan usein 1,5–2 kertaa oletuslihotusleveys.
3. Määritä Musta väri- ja Mustan tiheys -asetukset.

Huomautus: Voit käyttää mustan lihotusominaisuuksia, jos värialueen painovärin neutraali tiheys on suurempi tai yhtä suuri kuin Mustan tiheys.
Painoväriprosentin on oltava suurempi tai yhtä suuri kuin Musta väri -asetuksen.
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Kirjan painaminen, kun lihotusoletusarvot ovat ristiriidassa
Voit käyttää vain yhtä lihotusoletusarvoa kullakin tulostettavalla arkilla, esimerkiksi yhdellä sivulla. Yleensä tämä ei aiheuta ongelmia. Jos painat
useita kirjan julkaisuja ja jokaisessa julkaisussa tai jokaisella sivulla on erilainen lihotusoletusarvo, InDesign voi ratkaista ristiriitoja synkronoimalla
asiakirjojen oletusarvot:

Jos kirjan julkaisuissa on erilaisia mutta samannimisiä lihotusoletusarvoja, InDesign liittää julkaisuun sivupohjan lihotusoletusarvon, jos
Lihotusoletusarvo-vaihtoehto on valittu Synkronointiasetukset-valintaikkunassa.

Synkronointiominaisuuden ansiosta kaikki sivupohjan oletusarvot ovat valittavissa myös kirjan muissa julkaisuissa, mutta niitä ei ole liitetty.
Jokaiseen julkaisuun on liitettävä erikseen lihotusoletusarvo, tai on käytettävä [Oletus]-arvoa. Tyylit näkyvät julkaisun Määritä
lihotusoletusarvot -valintaikkunan Lihotusoletusarvo-valikossa.

Huomautus: jos aukeaman sivuihin liitetään erilaiset lihotusoletusarvot, InDesign noudattaa kunkin sivun arvoa.
Lisää ohjeaiheita
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Automaattisen lihotuksen vaatimukset
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Lihotuksen nopeuttaminen
Sisäisen lihotusohjelman levytila
Julkaisun tai kirjan lihottaminen

Tietoja painovärin lihotuksesta
Jos offset-painojulkaisussa on käytetty useita painovärejä samalla sivulla, painovärit on kohdistettava muiden painovärien kanssa niin, että niiden
rajalle ei jää saumaa. Tarkkaa kohdistusta ei kuitenkaan voi suorittaa jokaisella painokoneen läpi kulkevalla arkilla, joten kohdistusvirheitä saattaa
esiintyä. Kohdistusvirheen vuoksi painovärien rajalle jää sauma.

Kohdistusvirheet voi korjata laajentamalla objektia niin, että se limittyy erivärisen objektin kanssa. Tätä kutsutaan lihotukseksi. Kun painovärejä
sijoitetaan päällekkäin, yleensä päällimmäinen painoväri syrjäyttää eli poistaa alla olevat automaattisesti, jotta värit eivät sekoittuisi. Lihotuksessa
on kuitenkin käytettävä painovärien päällepainatusta, jossa värit painetaan toisensa päälle niin, että ne limittyvät ainakin osittain.

Lihotettu kohdistusvirhe (vasen) ja lihottamaton kohdistusvirhe (oikea)

Usein lihotuksessa käytetään levitystä eli vaalean objektin laajentamista tumman objektin päälle. Kahdesta vierekkäisestä väristä tummempi
määrittää objektin tai tekstin reunan, joten vaalean värin laajentaminen tumman rajan päälle säilyttää objektien rajan.

Lihotustavat
Julkaisu voidaan lihottaa käyttämällä seuraavia menetelmiä eri tavoin yhdistettyinä:

Käytä prosessivärejä, joita ei tarvitse lihottaa.

Päällepaina musta.

Päällepaina viivat ja täytöt manuaalisesti.

Käytä Adobe InDesign CS4:n yhdysrakenteista lihotusta tai Adoben erottelua rasteroinnin yhteydessä.

Lihota tuotu kuva käyttämällä sen kuvitusohjelman ominaisuuksia, jolla kuva on tehty. Lisätietoja on sovellusten käyttöoppaissa.

Valitse lihotusmenetelmä, joka täydentää käyttämääsi väritulostuksen työnkulkua, esimerkiksi Adobe PostScriptiä tai PDF:ää.

Voit välttää lihotustarpeen poistamalla kohdistusvirheiden mahdollisuuden värien käytössä. Estä kohdistusvirheet varmistamalla, että vierekkäiset
prosessivärit käyttävät samoja painovärejä. Jos esimerkiksi määrität tummanvioletin viivan, jossa on kirkkaanpunainen täyttö, molemmat värit
sisältävät paljon magentaa. Viivan ja täytön yhteinen magenta painetaan yhtenä alueena, joten jos muissa prosessiväreissä tapahtuu
kohdistusvirheitä, magentan painolevyn ansiosta niiden välit eivät näy selvästi.

Tietoja automaattisesta lihotuksesta
InDesign pystyy lihottamaan värilliset julkaisut automaattisesti yhdysrakenteisella ohjelmalla tai käyttämään samankaltaista mutta tehokkaampaa
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Adobe-rasterointiprosessoria. Se toimii Adobe PostScript -tulostimissa, jotka tukevat Adobe-rasterointiprosessoria.

Kumpikin lihotusohjelma osaa laskea tarkasti, millaisia muutoksia julkaisun tekstin ja kuvien reunoihin on tehtävä. Ne soveltavat lihotusmenetelmiä
saman objektin eri osiin, vaikka tekstin tai InDesign-objektin takana olisi useita eri värejä. Lihotuksen säädöt ovat automaattisia, ja voit luoda
lihotuksen oletusarvoja eri sivualueita koskevien vaatimusten mukaan. Lihotuksen vaikutukset näkyvät ainoastaan lihotusohjelman tuottamissa
värierotteluissa, eivät InDesignin näytössä.

Ohjelma havaitsee värikontrastit ja sitten luo lihotukset vierekkäisten värien neutraalin tiheyden (vaaleuden tai tummuuden) perusteella.
Useimmiten ohjelma levittää vaaleampia värejä vierekkäisten tummempien värien päälle. Lihotusoletusarvot-paneelissa määritetyt lihotusasetukset
vaikuttavat lihotusohjelman tuloksiin.

Automaattisen lihotuksen vaatimukset
Julkaisujen lihottamiseen InDesignin yhdysrakenteisella ohjelmalla tarvitaan erotteluja tukeva PPD-tiedosto.

Tarvitset seuraavat laitteet ja ohjelmat julkaisujen lihottamiseen Adobe-rasterointiprosessorilla:

Adobe PostScript Level 2 -tulostimen tai uudemman, jonka rasterointiprosessori tukee Adobe-rasterointia. Kysy laitteen valmistajalta tai
tulostuspalvelusta, tukeeko PostScript-tulostin lihottamista Adobe-rasterointiprosessorilla.

PPD (PostScript Printer Description) -tiedosto Adobe-rasterointiprosessoria tukevaa tulostinta varten. Tämä PPD-tiedosto on valittava
tulostimen asennuksen yhteydessä.

Sisäänrakennetun lihotuksen ja Adobe-rasterointiprosessorin eroja
Yhdistelmävärien työnkulku Jos käytät yhdysrakenteista lihotusta, voit tehdä värierottelun InDesignilla tai Adobe-rasterointiprosessorilla. Adobe-
rasterointiprosessorilla lihottaminen edellyttää, että teet erottelutkin Adobe-rasterointiprosessorilla.
Lihotusleveydet Yhdysrakenteiset lihotusleveydet rajoittuvat 4 pisteeseen riippumatta lihotusleveydelle annetusta arvosta. Suurempi lihotusleveys
edellyttää Adobe-rasterointiprosessorin käyttämistä.
EPS-vektorikuvat Yhdysrakenteisella lihotusohjelmalla ei voi lihottaa sijoitettuja EPS-vektorikuvia. Adobe-rasterointiprosessorilla voidaan lihottaa
kaikki tuodut kuvat.

Tuotujen bittikarttakuvien lihottaminen
Sisäisellä lihotusohjelmalla voidaan lihottaa valokuvat ja muut kuvat tekstiin ja grafiikkaan. Bittikarttakuvat on tallennettava aidosti
pikselipohjaisessa tiedostomuodossa, joka tukee painoalan värivaatimuksia. PSD (Photoshop) ja TIFF ovat sopivimmat muodot painettaviin
julkaisuihin. Kysy neuvoja tulostuspalvelusta, ennen kuin käytät muita muotoja.

Jos käytät OPI (Open Prepress Interface) -palvelinta, varmista, että se luo vain sijoittelemiseen tarkoitetut FPO-kuvat TIFF- tai PSD-muotoisina.
Jos kuvat ovat TIFF- tai PSD-muotoisia, voit ehkä käyttää sisäistä lihotusohjelmaa, kunhan et valitse Jätä pois (OPI) -asetusta tulostettaessa. (Jätä
pois (OPI) -asetukset näkyvät Tulosta-valintaikkunan Lisäasetukset-kohdassa, jos PostScript-tulostin on valittu.)

Huomautus: Lihotuksen toiminta ja tarkkuus OPI-työnkulussa riippuu monista tekijöistä, kuten interpolointimenetelmästä, jolla OPI-palvelin
tuottaa sijoittelemiseen tarkoitetut FPO-kuvat. Kun haluat saada parhaat mahdolliset tulokset, neuvottele OPI-toimittajan kanssa Adobe-
lihotustoimintojen integroimisesta OPI-palvelimeen.

Tuodun vektorigrafiikan lihottaminen
Sekä Adobe-rasterointiprosessorilla että yhdysrakenteisella lihotusohjelmalla voidaan lihottaa InDesign-työkaluilla luotu teksti ja grafiikka sekä
sijoitetut PDF-vektoritiedostot. Yhdysrakenteisella lihotusohjelmalla ei kuitenkaan voi lihottaa sijoitettuja EPS-vektorikuvia.

InDesignissa luodut tekstit, reitit ja kehykset eivät lihotu oikein, jos ne limittyvät sellaista sijoitettua grafiikkaa sisältävien kehysten kanssa, joita ei
voi lihottaa yhdysrakenteisella ohjelmalla. Tällaisia ovat esimerkiksi EPS-vektorikuvat. (Nämä objektit lihottuvat kuitenkin oikein Adobe-
rasterointiprosessorilla.) Yhdysrakenteisen lihotusohjelman käyttäminen EPS-vektorikuvia sisältävissä julkaisuissa voi onnistua kuvan kehystä
säätämällä. Jos sijoitettu EPS-kuva ei ole nelikulmio, yritä lähentää sen kehystä kuvaa kohti ja kauemmaksi muista objekteista. Voit sovittaa
grafiikkakehyksen tarkemmin grafiikan ympärille valitsemalla Objekti > Rajaava reitti.

Jos InDesignin teksti ja grafiikka limittyvät sijoitetun EPS-grafiikan kanssa, ne eivät lihotu oikein (vasemmalla), joten kehystä on muokattava niin,
että se ei kosketa muita objekteja (oikealla)
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Tekstin lihotus
Sekä Adobe-rasterointiprosessorilla että yhdysrakenteisella lihotusohjelmalla voidaan lihottaa tekstimerkkejä muihin teksteihin ja kuviin.
(Yhdysrakenteinen lihotus vaatii, että teksti ja kuvat luodaan InDesignissa. Ne eivät siis saa sisältyä tuotuihin kuviin.) Useiden eri taustavärien
päälle ulottuva tekstimerkki lihottuu oikein kaikkiin väreihin.

Adobe-rasterointiprosessorilla voidaan lihottaa kaikentyyppisiä kirjasimia. Yhdysrakenteinen lihotustoiminto taas toimii parhaiten vain Type 1-,
OpenType- ja Multiple Master -kirjasimia käytettäessä. TrueType-kirjasimien käyttäminen voi aiheuttaa epätasaisen lihotuksen. Jos julkaisussa
tarvitaan TrueType-kirjasimia ja haluat käyttää yhdysrakenteista lihotusohjelmaa, muunna TrueType-teksti ääriviivoiksi valitsemalla se ja sen
jälkeen Teksti > Luo ääriviivat. Teksti muuttuu InDesign-objekteiksi, joiden lihottaminen onnistuu luotettavasti. Muista, että ääriviivoiksi muunnettua
tekstiä ei voi enää muokata.

Lihotuksen nopeuttaminen
Käytitpä sitten Adobe-rasterointiprosessoria tai sisäistä lihotusohjelmaa, voit säästää aikaa jättämällä käsittelemättä ne sivut, joita ei tarvitse
lihottaa. Tällainen sivu sisältää esimerkiksi vain mustaa tekstiä. Voit käyttää lihotuksen esimäärityksiä, jotka toimivat vain lihotusta vaativilla sivuilla.

Sisäisen lihotuksen nopeus määräytyy·tietokoneen nopeuden mukaan. Jos lihotat pitkän julkaisun jokaisen sivun, valitse nopein käytettävissä oleva
tietokonejärjestelmä. Lihotusohjelma käyttää tietokoneen kiintolevyä erittäin paljon, joten myös nopeasta kiintolevystä ja väylästä on etua.

Jos haluat tietokoneiden olevan käytettävissä muihin tehtäviin mahdollisimman suuren osan ajasta, käytä Adobe-rasterointiprosessoria, joka
lihottaa kaikki sivut rasterointiprosessorissa tietokoneen sijasta.

Sisäisen lihotusohjelman levytila
Kun lihotusohjelma käsittelee kaikkien lihottamista vaativien värialueiden reunat, se luo hyvin monta reittiä, joita ainoastaan tulostin käyttää (ne
eivät tallennu julkaisuun). Adobe-rasterointiprosessori käsittelee ja tallentaa nämä lisäreitit itse, kun taas sisäinen lihotusohjelma käyttää
tietokoneen kiintolevyä lihotusreittien tilapäisenä tallennusalueena. Vapauta mahdollisimman paljon kiintolevytilaa ennen lihotusta.

Levytilavaatimukset riippuvat useista asioista, joten tietyn lihotustyön vaatimuksia ei voi ennustaa. Lihotusohjelman levytilavaatimukset
todennäköisesti kasvavat, kun seuraavat ominaisuudet suurenevat julkaisussa:

lihotussivualueille kuuluvien sivujen määrä

limittäisten värillisten objektien määrä

lihotettavien kuvien määrä

lihotettavan tekstin määrä

lopullisen tulosteen resoluutio.

Jos sisäistä lihotusohjelmaa käyttävä tulostustyö keskeytetään tai siltä loppuu levytila, kiintolevylle voi jäädä lihotustietoja. Voit tarvittaessa
sulkea sovelluksen ja etsiä ja poistaa tilapäiset tiedot kansiosta C:\Temp (Windows). Käynnistä Mac OS-järjestelmässä tietokone uudelleen.

Julkaisun tai kirjan lihottaminen
Älä muuta lihotuksen oletusasetuksia, ennen kuin olet neuvotellut tulostuspalvelun kanssa ja ymmärrät, miten lihotusasetusten vaikutus muuttuu
julkaisun ja tulostustilanteen mukaan.

Kun lihotat yhteen kirjaan kuuluvia useita julkaisuja, liitä mukautetut lihotusoletusarvot kirjan julkaisujen eri sivualueisiin. Lihotusasetuksia ei voi
liittää kokonaiseen kirjaan. Ristiriitaiset oletusarvot voi kuitenkin korjata julkaisusta.

1. Luo tarvittaessa mukautettu lihotusoletusarvo julkaisua ja painoa varten.
2. Liitä lihotusoletusarvo sivualueeseen.
3. Avaa Tulosta-valintaikkuna valitsemalla Tiedosto > Tulosta.
4. Valitse vasemmalla olevasta luettelosta Tuloste.
5. Valitse Väri-kohdassa joko Erottelut tai Erottelut rasteroinnin yhteydessä sen mukaan, luotko erottelut isäntätietokoneella vai

rasterointiprosessorilla.
6. Valitse Lihotus-asetukseksi jompikumpi seuraavista:

Jos valitset asetukseksi Sisäänrakennettu sovellus, käytät InDesignin lihotusohjelmaa.

Adobe-rasterointiprosessori Tämä asetus voidaan valita vain, jos tulostin tukee Adobe-rasterointiprosessorilla lihottamista.

7. Jos tulostuspalvelu suosittelee painoväriasetusten muuttamista, napsauta Painovärin hallinta -painiketta. Valitse painoväri, määritä
tulostuspalvelun ilmoittamat asetukset ja napsauta lopuksi OK-painiketta.

8. Määritä muut tulostusasetukset ja tulosta julkaisu napsauttamalla Tulosta-painiketta.
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Miniatyyrien ja suurikokoisten julkaisujen tulostaminen

Alkuun

Huomautus:

Alkuun

Alkuun

Miniatyyrien tulostaminen
Suurikokoisten julkaisujen tulostaminen
Julkaisun osittaminen
Julkaisujen skaalaaminen

Miniatyyrien tulostaminen

Voit sovittaa monta sivua yhdelle arkille luomalla miniatyyrejä eli pieniä esikatseluversioita julkaisusta. Miniatyyrit sopivat hyvin sisällön ja
järjestyksen tarkistamiseen. InDesign muuttaa tarvittaessa paperin suuntaa automaattisesti niin, että sivu sopii paperille parhaiten. Alkuperäinen
suunta on kuitenkin määritettävä uudelleen, jos Miniatyyrit poistetaan käytöstä.

Kun tulostat miniatyyrejä, tulostimen merkit ja leikkausvara- ja/tai informaatioalueiden merkinnät ohitetaan.

1. Valitse Tulosta-valintaikkunassa Asetukset-alueelta Miniatyyrit.

2. Valitse miniatyyrien määrä sivua kohden valikosta.

Suurikokoisten julkaisujen tulostaminen

InDesignin suurin julkaisukoko on 18x1 jalkaa (5,49x5,49 metriä), mutta useimmat toimistotulostimet eivät voi tulostaa näin suuria sivuja.

Jos sivu on liian suuri toimistotulostimen käsiteltäväksi, tulosta julkaisun sivut osina. Voit sitten viimeistellä sivut ja koota palat yhteen. Voit
halutessasi skaalata julkaisun käytettävään paperikokoon sopivaksi.

Julkaisun osittaminen

Julkaisun mitat eivät aina vastaa tulostimen käyttämiä paperikokoja. Siksi InDesign voi jakaa suuren julkaisun neliön muotoisiin osiin, jotka sopivat
tulostimen käyttämälle paperille. Voit sitten koota julkaisun limittyvistä paloista.

InDesign pystyy osittamaan julkaisun automaattisesti. Voit myös määrittää osien koon itse. Jos ositat julkaisun itse, voit säätää osan vasemmasta
yläkulmasta sivun asettelua paperilla.

Suuret sivut jaetaan tulostettaviin osiin (vasen) ja lopuksi limittyvät osat kootaan yhteen (oikea)

Julkaisun automaattinen osittaminen

1. Valitse Tiedosto > Tulosta.

2. Valitse Tulosta-valintaikkunassa Asetukset-alueelta Vierekkäin.
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3. Valitse Vierekkäin-valikosta jokin seuraavista asetuksista:

Laskee automaattisesti vaadittavien osien määrän ja limitykseen tarvittavan alueen.

Lisää limitykseen tarvittavaa aluetta niin, että oikeanpuoleisessa rivissä olevien osien oikeat reunat kohdistetaan
julkaisun sivun oikean reunan kanssa ja alarivissä olevien osien alareunat kohdistetaan julkaisun sivun alareunan kanssa.

4. Kirjoita Limitys-kohtaan kapein limitysalue, jonka haluat tulostuvan kunkin osan reunaan niin, että osat voidaan kohdistaa oikein. Limitys
käyttää julkaisun määritettyä mittayksikköä. Arvon on oltava suurempi kuin tulostimen pienin tulostamaton reunus. Voit määrittää limitykseksi
korkeintaan puolet lyhimmän sivun pituudesta. Jos sivun mitat ovat esimerkiksi 11x17 tuumaa (279,4x431,8 mm), limitettävän alueen leveys
voi olla korkeintaan 5,5 tuumaa (139,7 mm).

Julkaisun manuaalinen osittaminen

Julkaisun automaattinen osittaminen tulostaa kaikki osat kerralla. Ositettaessa julkaisu manuaalisesti on jokainen osa tulostettava erikseen.

1. Jos haluat näyttää viivaimet, valitse Näytä > Näytä viivaimet.

2. Aseta nollakohta tulostettavan osan vasempaan yläkulmaan vetämällä viivainta. Muista jättää tilaa limitykselle ja tulostimen merkeille.

Käytettävän paperin koko ja suunta määrittää InDesignin tulostaman alueen koon ja muodon.

3. Valitse Tiedosto > Tulosta ja sitten vasemmalta Asetukset.

4. Valitse Asetukset-alueelta Vierekkäin. Valitse sitten Vierekkäin-valikosta Manuaalinen.

Julkaisujen skaalaaminen

Jos haluat sovittaa julkaisun sitä pienempään paperikokoon, voit skaalata julkaisun leveyden ja korkeuden joko symmetrisesti tai epäsymmetrisesti.
Epäsymmetristä skaalausta käytetään esimerkiksi silloin, kun tulostetaan filmille fleksopainokonetta varten: jos tiedät, missä suunnassa levy
sijoitetaan painokoneen rumpuun, skaalaus voi kompensoida 2-3 prosentin venymää levyssä. Skaalaus ei vaikuta julkaisun sivukokoon.

Kun tulostat aukeamia, jokainen aukeama skaalataan erikseen.

Julkaisun manuaalinen skaalaaminen

1. Valitse Tiedosto > Tulosta.

2. Valitse Tulosta-valintaikkunassa Asetukset-alueelta Leveys, jolloin Leveys- ja Korkeus-ruudut aktivoituvat.

3. Säilytä julkaisun leveys- ja pituussuhteet valitsemalla Pakota mittasuhteet. Muussa tapauksessa varmista, että asetusta ei ole valittu.

4. Kirjoita Leveys- ja Korkeus-ruutuihin prosenttiluvuksi 1-1000. Jos valitsit Pakota mittasuhteet, kirjoita vain yksi arvo, sillä toinen päivittyy
automaattisesti.

Julkaisun automaattinen skaalaaminen

1. Varmista, että Tulosta-valintaikkunan Asetukset-alueen Vierekkäin- ja Miniatyyrit-asetuksia ei ole valittu. (Kun nämä asetukset on valittu,
Skaalaa sopivaksi -asetus ei ole käytettävissä.)

2. Valitse Skaalaa sopivaksi. Valitun PPD:n kuva-alue määrittää skaalausprosentin. Luku näkyy Skaalaa sopivaksi -asetuksen vieressä.

Lisää ohjeaiheita
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Grafiikan tulostusasetukset
Määritä, miten grafiikkaa käsitellään tulostuksen aikana valitsemalla haluamasi asetus seuraavista Tulosta-valintaikkunan Grafiikka-asetuksista.

Lähetä tiedot Ohjaa sitä, miten paljon sijoitetun bittikarttatiedoston kuvatietoja lähetetään tulostimeen tai tiedostoon.
Kaikki Lähettää kaikki tiedot, joita tarvitaan korkean resoluution tai suurikontrastisten harmaasävy- ja värikuvien tulostamiseen. Suurikontrastisia
kuvia ovat esimerkiksi yhden spottivärin sisältävät mustavalkoiset tekstit. Tämä asetus vaatii tavallista enemmän levytilaa.
Optimoitu keskusinterpolaatio Lähettää tarpeeksi tietoja kuvan tulostamiseen tulostimen parhaalla mahdollisella resoluutiolla. (Korkean
resoluution tulostin käyttää enemmän tietoa kuin matalan resoluution toimistotulostin.) Valitse tämä asetus, jos käsittelet korkean resoluution kuvia,
mutta tulostat vedoksia toimistotulostimella.
Huomautus: InDesign ei interpoloi EPS- tai PDF-grafiikkaa, vaikka Optimoitu keskusinterpolaatio -asetus olisi valittu.
Sijaiskuva Lyhentää tulostusaikaa lähettämällä sijoitetuista bittikarttakuvista näytössä esiintyvän resoluutioversion (72 dpi).
Ei mikään Lyhentää tulostusaikaa poistamalla väliaikaisesti kaiken grafiikan tulostettaessa ja korvaamalla sen grafiikkakehyksiin sijoitetuilla
väliviivoilla. Grafiikkakehyksien mitat ovat samat kuin tuodun grafiikan ja rajaavat reitit on säilytetty, joten kuvien koon ja sijoittelun voi tarkistaa
tulosteesta. Tuodun grafiikan voi poistaa esimerkiksi silloin, kun toimittajat ja oikolukijat tarkastavat tekstivedoksia. Tulostaminen ilman grafiikkaa on
hyödyllistä myös silloin, kun yritetään paikantaa tulostuksen ongelmia.

Asetukset kirjasinten lataamiselle tulostimeen
Tulostimen kirjasimet on tallennettu tulostimen muistiin tai tulostimeen liittyvään kiintolevyyn. Type 1- ja TrueType-kirjasimet voi tallentaa joko
tulostimeen tai tietokoneelle. Bittikarttakirjasimet tallennetaan vain tietokoneelle. InDesign lataa kirjasimet tarvittaessa, jos ne on asennettu
tietokoneen kiintolevylle.

Määritä, miten kirjasimet ladataan tulostimeen, valitsemalla haluamasi asetus seuraavista Tulosta-valintaikkunan Grafiikka-alueen asetuksista.

Ei mikään Lisää viitteen PostScript-tiedoston kirjasimeen. Se kertoo rasterointiprosessorille tai jälkiprosessorille, mihin kirjasin liitetään. Valitse
asetus, jos kirjasimet sijaitsevat tulostimessa. Varmista kuitenkin kirjasinten oikea tulkinta käyttämällä jotakin kirjasinten muuta latausasetusta,
kuten Osajoukko tai Lataa PPD-kirjasimet.
Kaikki Lataa kaikki julkaisun vaatimat kirjasimet tulostustehtävän alussa. Kaikki kirjasimen kuviot ja merkit tulevat mukaan, vaikka niitä ei käytetä
julkaisussa. InDesign jakaa automaattisesti osajoukkoihin sellaiset kirjasimet, joiden kuviomäärä (merkit) ylittää Asetukset-valintaikkunassa
määritetyn enimmäismäärän.
Osajoukko Lataa vain julkaisussa käytettävät merkit (kuviot). Kuviot ladataan kerran sivua kohti. Tämä tuottaa yleensä nopeimmat ja pienimmät
PostScript-tiedostot, jos julkaisu on yksisivuinen tai lyhyt ja sisältää vain vähän tekstiä.
Lataa PPD-kirjasimet Lataa kaikki julkaisussa käytettävät kirjasimet, vaikka ne olisi tallennettu tulostimeen. Tällä asetuksella voit varmistaa, että
InDesign käyttää tietokoneessa olevia kirjasinten ääriviivoja Helvetican, Timesin ja muiden tavallisten kirjasinten tulostamiseen. Tämän asetuksen
valitseminen voi ratkaista kirjasinversioiden ongelmat, kuten tulostimen ja tietokoneen erilaiset merkistöt tai lihotuksen ääriviivojen vaihtelut. Jos
käytät lisämerkistöjä usein, älä käytä tätä asetusta vedosten tulostamiseen toimistokoneella.

PostScript-tulostusasetukset
Määritä, miten kirjasimet ladataan tulostimeen, valitsemalla haluamasi asetus seuraavista Tulosta-valintaikkunan Grafiikka-alueen asetuksista.

PostScript Määrittää PostScript-tulostimien tulkkien vastaavuustason.
Tiedon muoto Määrittää tavan, jolla InDesign lähettää kuvatietoja tietokoneelta tulostimeen. ASCII-asetus lähetetään ASCII-tekstinä, joka sopii
vanhoille verkoille. Tämä on paras ratkaisu, jos kuvia käytetään useissa ympäristöissä. Binaari-asetus vie tiedot binaarikoodina, joka vie
vähemmän tilaa kuin ASCII mutta ei sovi kaikkiin järjestelmiin.
Huomautus: InDesign ei voi aina muuttaa EPS- tai DCS-grafiikkatiedostoissa käytettyä muotoa. Jos tietojen lähettäminen binaarimuodossa ei
onnistu, kokeile EPS- tai DCS-grafiikkatiedostojen muodon muuttamista lähdesovelluksessa.

Kuvien poisjättämisasetukset
Kun lähetät kuvatietoja tulostimeen tai tiedostoon, voit poistaa tuotuja grafiikkatyyppejä Lisäasetukset-alueella OPI-asetuksilla niin, että vain OPI-
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linkit (kommentit) jätetään tiedostoon myöhemmin OPI-palvelimella käsiteltäviksi.

OPI-kuvien korvaus InDesign korvaa tulostettaessa matalan resoluution EPS-grafiikkasijaiskuvat korkean resoluution grafiikalla. Tällöin EPS-
tiedostossa on oltava OPI-kommentteja, jotka linkittävät matalan resoluution sijaiskuvan korkearesoluutiokuvaan. InDesignilla on oltava
mahdollisuus käyttää OPI-kommenttien linkittämiä kuvia. Jos korkearesoluutioversiot eivät ole käytettävissä, InDesign säilyttää OPI-linkit ja
sisällyttää vietävään tiedostoon matalan resoluution sijaiskuvan. Poista tämän asetuksen valinta, jos haluat, että OPI-palvelin korvaa OPI-linkitetyt
kuvat myöhemmässä vaiheessa.
Jätä pois (OPI) Tämä asetus mahdollistaa tiettyjen tuotujen kuvatyyppien (EPS, PDF ja bittikarttakuvat) ohituksen lähetettäessä kuvatietoja
tulostimeen tai tiedostoon, jolloin jäljelle jäävät vain OPI-linkit (kommentit) OPI-palvelimen myöhempää käyttöä varten. Kommenteissa on tietoja,
joita tarvitaan OPI-palvelimessa olevan korkearesoluutiokuvan etsimisessä. InDesign sisällyttää vain kommentit. Tulostuspalvelulla on oltava
mahdollisuus käyttää alkuperäisiä korkearesoluutiokuvia. Jätä pois (OPI) -asetus ei koske upotettuja kuvia.
Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Tietoja päällepainatuksesta

Jos et ole muuttanut Läpinäkyvyys-paneelissa kuvituksen läpinäkyvyyttä, kuvituksen täyttö ja viivat ovat läpinäkymättömiä, sillä päällä oleva väri
syrjäyttää eli rajaa pois alla olevan värin. Voit estää värien katoamisen Määritteet-paneelin Päällepainatus-asetuksilla. Kun olet määrittänyt
päällepainatusasetukset, voit esikatsella niiden vaikutuksia näytössä.

Kolme limittyvää ympyrää ilman päällepainatusta (vasemmalla) verrattuna kolmeen limittyvään ympyrään, jossa käytetään päällepainatusta
(oikealla)

InDesignissa on myös päällepainatuksen simulointi, jolla voidaan simuloida spotti- ja prosessivärien päällepainatuksen vaikutuksia, kun käytössä
on yhdistelmätulostuslaite.

Tekstissä tai alkuperäisissä InDesign-objekteissa käytetty musta painoväri painetaan normaalisti päälle. Näin estetään värialueiden päälle
sijoitettujen pienten mustien merkkien ja mustalla viivalla ympäröityjen värialueiden kohdistusvirheet. Voit muuttaa mustan painovärin asetuksia
Mustan värin käsittely -valikossa.

Suunnittelun työnkulku saattaa edellyttää tietyn värin määrittämistä päällepainettavaksi. Oletetaan, että haluat tulostaa julkaisun kaiken tekstin
tietyllä värillä. Noudata seuraavia ohjeita:

Luo objektityyli, joka käyttää spottiväriä täytteessä tai viivassa, jossa on vastaava täytön tai viivan päällepainatus.

Luo erillinen taso objekteille, jotka sisältävät spottiväriä, ja määritä ne mustiksi.

Luo PDF-yhdistelmätiedosto ja muuta siinä olevia päällepainatusasetuksia.

Määritä päällepainatusasetukset rasterointiprosessorilla.

Käytä päällepainatusasetuksia kuvassa tai objektissa ja lisää se kirjastoon tai muokkaa sijoitettua tiedostoa alkuperäisellä sovelluksella.

Päällepainamisen määrittäminen

Koska InDesignissa on automaattinen lihotus – yhdysrakenteinen lihotus tai Adobe-rasterointiprosessori – päällepainatusta ei tarvitse tehdä
manuaalisesti juuri lainkaan. Manuaalinen päällepainatus voi olla tarpeen niissä harvoissa tilanteissa, kun automaattista lihotusta ei voi käyttää.

Seuraavat ohjeet auttavat päättämään, tarvitsetko päällepainatusta:

Kysy tulostuspalvelusta, tukevatko heidän tulostuslaitteensa manuaalista päällepainatusta.

Päällepainatusta käytetään silloin, kun kuvassa on erilaisia painovärejä ja painoväreihin halutaan lihotus tai limitys. Kun päällepainetaan
prosessivärisekoituksia tai mukautettuja värejä, jotka eivät käytä samoja painovärejä, päällepainatusväri lisätään taustaväriin. Jos esimerkiksi
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painat 100 %:n magentatäytön 100 %:n syaanitäytön päälle, limittyvät täytöt näyttävät violetilta eivätkä magentalta.

Älä käytä päällepainatusta, kun käytät viivaa kahden prosessivärin lihotukseen. Määritä sen sijaan CMYK-viivaväriä vastaava painoväri
käyttämään alkuperäisen värin korkeampaa arvoa.

Sovi tulostuspalvelun kanssa päällepainatuksen käyttämisestä, sillä se vaikuttaa Tulosta-valintaikkunan lihotusasetuksiin. Lähes kaikki
PostScript Level 2- ja PostScript 3 -laitteet tukevat manuaalista päällepainatusta.

Sivukohteiden päällepainatus

Voit päällepainaa viivoja tai täyttöjä, kappaleviivoja ja alaviitteiden yläpuolella olevia viivoja. Voit myös simuloida spottivärien päällepainatusta.

Viivan tai täytön päällepainaminen

Voit painaa valittujen reittien viivojen tai täyttöjen päälle käyttämällä Määritteet-paneelia. Päällepainettua viivaa tai täyttöä ei tarvitse lihottaa, sillä
päällepainatus peittää vierekkäisten värien välit. Voit myös simuloida lihotusta painamalla viivan päälle. Päällepainettavan värin on oltava kahden
vierekkäisen värin oikea sekoitus. Väri on laskettava manuaalisesti.

Noudata seuraavia ohjeita käyttäessäsi manuaalista päällepainatusta:

Jos käytät Täytön päällepainatus -asetusta 100 %:n mustan viivan tai täytön kanssa, musta painoväri ei välttämättä ole tarpeeksi peittävä
estämään alla olevien painovärien näkymistä. Estä värien läpikuultaminen käyttämällä neljän värin (syvää) mustaa 100 %:n mustan sijasta.
Kysy tulostuspalvelusta mustaan lisättävien värien tarkat prosentit.

Kun käytät viivaa objektien (ei tekstimerkkien) lihotukseen, säädä viivan tasaus siten, että viiva on reitin tai objektin ulkopuolella (ei reitin
sisäpuolella tai keskitetty).

Kun viivalla lihotetaan kahta spottiväriä tai spotti- ja prosessiväriä, vaaleampaa näistä lisätään viivaan ja painetaan viivan päälle.

Tarkista Erottelujen esikatselu -paneelista, miten värien päällepainatus toimii.

1. Valitse vähintään yksi reitti valintatyökalulla  tai suoravalintatyökalulla  tai valitse tekstimerkit tekstityökalulla. Kun painat kehyksen sisällä
olevan reitin viivan päälle, valitse sisempi reitti suoravalintatyökalulla.

Täyttöjen ja viivojen päällepainatus

A. Syaani (alin taso) B. Magenta (keskimmäinen taso) C. Keltainen (ylin taso) 

2. Valitse Ikkuna > Tuloste > Määritteet.

3. Tee Määritteet-paneelissa jokin seuraavista toimista:

Paina valittujen objektien täytön päälle tai viivaa käyttämättömän tekstin päälle valitsemalla Täytön päällepainatus.

Paina valittujen objektien viivan päälle valitsemalla Viivan päällepainatus.

Paina katko-, piste- tai muun viivan väleissä olevan värin päälle valitsemalla Välin päällepainatus.

Kappaleviivan päällepainaminen

1. Varmista, että päällepainatusvärille on olemassa väriruutu.

2. Napsauta haluamaasi kappaletta tekstityökalulla.
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3. Valitse Kappale-paneelivalikosta Kappaleviivat.

4. Valitse valintaikkunan yläreunan valikosta kappaleviiva, jonka päälle haluat painaa.

5. Valitse jompikumpi seuraavista ja napsauta sitten OK-painiketta.

Paina viivan päälle valitsemalla Viivan päällepainatus.

Paina katko-, piste- tai muun viivan väleissä olevan värin päälle valitsemalla Välin päällepainatus.

Kappaleviivat-valintaikkunan Viivan päällepainatus- ja Välin päällepainatus -asetukset voi tallentaa osana kappaletyyliä.

Viivojen painaminen alaviitteiden yläpuolelle

InDesign voi erottaa alaviitteet julkaisun leipätekstistä painamalla sivulle viivan. Voit päällepainaa viivan.

1. Varmista, että päällepainatusvärille on olemassa väriruutu.

2. Valitse Teksti > Julkaisun alaviiteasetukset.

3. Valitse Alaviiteasetukset-valintaikkunan Sivuasettelu-välilehti.

4. Valitse Viivan päällepainatus ja napsauta OK-painiketta.

Spottivärien päällepainatuksen simulointi

Päällepainatuksen simulointi kannattaa silloin, kun simuloidaan spottivärejä, joiden neutraalitiheyden arvot ovat erilaisia (kuten punainen ja sininen).
Kun tulostat yhdistelmätulostimeen käyttämällä päällepainatuksen simulointia, voit tarkistaa, onko tulostettava väri päällepainettava vai pitääkö se
syrjäyttää.

1. Valitse Tulosta-valintaikkunasta Tuloste ja valitse sitten asetus Väri-valikosta.

päällepainatusta ei voi simuloida, kun Jätä yhdistelmä ennalleen -asetus on valittu.

2. Valitse Simuloi päällepainatus.

Mustan päällepainatusasetuksen muuttaminen

Jos haluat syrjäyttää mustat objektit InDesignissa, sinun on estettävä mustan väriruudun päällepainatus. Muissa väriruuduissa on oletuksena
syrjäytys, mutta mustassa väriruudussa on oletuksena päällepainatus. Se koskee kaikkia mustia viivoja, täyttöjä ja tekstimerkkejä. 100 %
prosessimusta näkyy Värimallit-paneelissa nimellä [Musta]. Syrjäytä mustat objektit joko poistamalla päällepainatusoletus Oletusarvoissa tai
monistamalla musta oletusväriruutu ja liittämällä monistettu väriruutu syrjäyttäviin värillisiin objekteihin. Jos Asetukset-valintaikkunan
päällepainatusasetusta ei ole valittu, musta syrjäyttää (poistaa) alla olevat värit.

Helpompaa ja edullisempaa on antaa tulostuspalvelun painaa prosessimustan päälle.

1. Valitse Muokkaa > Asetukset > Mustan ulkoasu (Windows) tai InDesign > Asetukset > Mustan ulkoasu (Mac OS).

2. Valitse Värimallin musta päällepainatus 100 % -asetus tai poista valinta.

Värimallin musta päällepainatus 100 % -asetus ei vaikuta mustiin sävyihin, nimeämättömiin mustiin väreihin tai objekteihin, jotka
näyttävät mustilta läpinäkyvyysasetuksen tai tyylin takia. Musta päällepainatus -asetus vaikuttaa vain värimallin mustalla värjättyihin objekteihin tai
tekstiin.

Lisää ohjeaiheita
CMYK-mustan ulkoasun muuttaminen (Illustrator, InDesign)
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Värienhallinnan käyttäminen tulostuksessa
Yhdistelmien väritulostusasetukset
Koevedoksen tulostaminen
Liukuvärien ja sekoitevärien tulostuksen parantaminen
Tietoja rasteri- ja tulostinpisteistä

Katso lisätietoja ja ohjeita napsauttamalla seuraavia linkkejä.

Värienhallinnan käyttäminen tulostuksessa
Kun tulostat värienhallintaa käyttävän julkaisun, voit säilyttää tulosteen värien tasalaatuisuuden määrittämällä värienhallinnan lisäasetukset.
Julkaisu voi esimerkiksi sisältää profiilin, joka on räätälöity tulostuspalvelun tulosteita varten, mutta jonka haluat tarkistaa julkaisun värit
toimistotulostimella. Voit muuntaa julkaisun värit toimistotulostimen väriavaruuteen Tulosta-valintaikkunassa, jolloin tulostimen profiilia käytetään
nykyisen julkaisun profiilin sijasta. Jos valitset Vedos-väriavaruuden ja kohteeksi RGB-tulostimen, InDesign muuntaa väritiedot RGB-arvoiksi
valittujen väriprofiilien avulla.

Kun tulostat PostScript-tulostimella, voit käyttää myös PostScript-värienhallintaa. Tässä tapauksessa InDesign lähettää julkaisun väritiedot
alkuperäisen väriavaruuden kalibroituna versiona suoraan PostScript-tulostimeen julkaisun profiilin kanssa ja antaa tulostimen muuntaa julkaisun
tulostimen väriavaruuteen. Tulostimen väriavaruus on tallennettu laitteeseen CRD:nä. Siten tulostaminen on laitteista riippumatonta. CRD-tiedostot
ovat PostScriptin väriprofiileja. Värimuunnosten tarkat tulokset voivat vaihdella tulostimen mukaan. Voit käyttää PostScript-värienhallintaa, jos
tulostin käyttää vähintään PostScript Level2 -versiota. Tulostimen ICC-profiilia ei tarvitse asentaa järjestelmään.

Huomautus: värienhallintaa käyttävää julkaisua käsiteltäessä voi käyttää Esitarkistus-paneelia sen varmistamiseen, että värit vastaavat
määrittämiäsi väriasetuksia.

1. Varmista, että tulostimeen on asennettu oikea ohjain ja PPD.
2. Valitse Tiedosto > Tulosta.
3. Jos tulostimen oletusarvo on haluamasi, valitse se Tulosta-valintaikkunan yläreunassa Tulostuksen oletusarvo -valikosta.
4. Säädä julkaisun asetukset haluamallasi tavalla.
5. Valitse Tulosta-valintaikkunan vasemmasta reunasta Värinhallinta.
6. Valitse Tulosta-kohdasta Julkaisu.
7. Valitse Värinkäsittely-asetukseksi Anna InDesignin määrittää värit.
8. Valitse Tulostimen profiili -kohdassa tulostimen profiili.

Mitä tarkemmin profiili kuvaa tulostinta ja tulostusehtoja (esimerkiksi paperityyppiä), sitä tarkemmin värienhallintajärjestelmä voi kääntää
julkaisun oikeiden värien numeroarvot.

9. Valitse Säilytä RGB-numerot tai Säilytä CMYK-numerot.

Tämä asetus määrittää, miten InDesign käsittelee värejä, joihin ei ole liitetty väriprofiilia (esimerkiksi tuodut kuvat ilman upotettuja profiileja).
Kun tämä asetus on valittu, InDesign lähettää värinumerot suoraan tulostimeen. Jos asetusta ei ole valittu, InDesign muuntaa ensin
värinumerot tulostimen väriavaruuteen.

Numeroiden säilyttämistä on suositellaan, kun noudatat turvallista CMYK-työnkulkua. Numeroiden säilyttämistä ei ole suositella RGB-
julkaisujen tulostuksessa.

10. Avaa tulostinohjaimen valintaikkuna valitsemalla joko Asetukset (Windows) tai Kirjoitin (Mac OS).
11. Poista tulostimen värienhallinta käytöstä ja palaa InDesignin Tulosta-valintaikkunaan valitsemalla Tulosta.

Jokaisella tulostinohjaimella on omat värienhallinta-asetukset. Jos et ole varma, kuinka värienhallinta poistetaan käytöstä, katso ohjeita
tulostimen käyttöoppaasta.

12. Valitse Tulosta.

Yhdistelmien väritulostusasetukset
Tulosta-valintaikkunan Tuloste-alueella voit määrittää, miten yhdistelmäväri lähetetään tulostimeen. Kun värienhallinta on käytössä (oletus),
väriasetusten oletusarvot tuottavat kalibroidun värilaadun. Spottiväritiedot säilytetään värinmuunnossa, ja vain prosessivärit muunnetaan valittuun
väriavaruuteen. Voit tarvittaessa pyytää lisäohjeita tulostuspalvelusta.

Yhdistelmätilat vaikuttavat vain InDesignilla luotuihin rasterikuviin ja -objekteihin. Sijoitettuun grafiikkaan (kuten EPS- ja Adoben PDF-tiedostoihin)
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ne eivät vaikuta, elleivät tiedostot limity läpinäkyvien objektien kanssa.

Lisätietoja yhdistelmätulostamisesta on saatavilla Adobe Print Resource Centeristä osoitteesta www.adobe.com/go/print_resource_fi.

Huomautus: ei-PostScript-tulostuksen asetukset riippuvat tulostimen käyttämästä värimallista, joka on yleensä RGB.
Kun tulostat yhdistelmän, automaattinen lihotus ei ole käytössä. Voit kuitenkin tarkistaa tekstin, viivojen tai täyttöjen päällepainatuksen valitsemalla
Simuloi päällepainatus.

Tulosta-valintaikkunan Tuloste-alueella on seuraavat väriasetukset. Joissakin tulostimissa voi olla käytettävissä muitakin asetuksia.

Jätä yhdistelmä ennalleen Lähettää valittujen sivujen väriversion tulostimeen. Tällöin kaikki alkuperäisen julkaisun väriarvot säilytetään. Kun
tämä asetus on valittu, Simuloi päällepainatus ei ole käytössä.
Yhdistelmäharmaa Jos tulostat esimerkiksi mustavalkotulostimella ilman värierotteluja, asetus lähettää tulostimeen harmaasävyversion valituista
sivuista.
Yhdistelmä-RGB Lähettää valittujen sivujen väriversion tulostimeen, jos tulostat esimerkiksi RGB-väritulostimella ilman värierotteluja.
Yhdistelmä-CMYK Lähettää valittujen sivujen väriversion tulostimeen, jos tulostat esimerkiksi CMYK-väritulostimella ilman värierotteluja. (Tämä
asetus on käytössä vain PostScript-tulostimissa.)
Erottelut Luo PostScript-tiedot kullekin dokumentin edellyttämälle erottelulle ja lähettää sen tulostuslaitteeseen. (Tämä asetus on käytössä vain
PostScript-tulostimissa.)
Erottelu rasteroinnin yhteydessä Lähettää erotteluasetukset tulostuslaitteen rasterointiprosessorille. (Tämä asetus on käytössä vain PostScript-
tulostimissa.)
Teksti mustana Valitse tämä vaihtoehto, jos haluat tulostaa kaikki InDesignissa luodut tekstit mustana, ellei väriksi ole määritetty Ei mitään,
Paperi tai valkoista vastaava väriarvo. Tämä asetus sopii sisältöihin, jotka luodaan sekä tulostusta että PDF-jakelua varten. Jos esimerkiksi
hyperlinkit ovat sinisiä PDF-versiossa, ne tulostuvat mustana harmaasävytulostimella eikä lukemista vaikeuttavaa rasterointimallia käytetä.

Koevedoksen tulostaminen
Koevedos (kutsutaan myös nimillä vedostuloste ja vedos) on tulostettu jäljitelmä siitä, miltä lopullinen tuloste valmiina näyttää. Koevedos tuotetaan
tulostimessa, joka on halvempi kuin lopullisen tulosteen tuottamisessa käytettävä painokone. Viime vuosina joidenkin mustesuihkutulostimien
resoluutio on riittänyt tuottamaan tällaisia edullisia tulosteita, joita voidaan käyttää koevedoksina.

1. Valitse Näytä > Vedosasetukset > Mukauta.
2. Valitse Mukauta vedoksen ehdot -valintaikkunassa ensin simuloitava tulostin ja sitten OK.
3. Valitse ensin Säilytä RGB-numerot tai Säilytä CMYK-numerot ja sitten OK.

Tämä asetus määrittää, miten InDesign käsittelee värejä, joihin ei ole liitetty väriprofiilia (esimerkiksi tuodut kuvat ilman upotettuja profiileja).
Kun tämä asetus on valittu, InDesign lähettää värinumerot suoraan tulostimeen. Jos asetusta ei ole valittu, InDesign muuntaa ensin
värinumerot tulostimen väriavaruuteen.

Numeroiden säilyttämistä on suositellaan, kun noudatat turvallista CMYK-työnkulkua. Numeroiden säilyttämistä ei ole suositella RGB-
julkaisujen tulostuksessa.

4. Valitse Tiedosto > Tulosta.
5. Jos tulostimen oletusarvo on haluamasi, valitse se Tulosta-valintaikkunan yläreunassa Tulostuksen oletusarvo -valikosta.
6. Säädä julkaisun asetukset haluamallasi tavalla.
7. Valitse Tulosta-valintaikkunan vasemmasta reunasta Värinhallinta.
8. Valitse Tulosta-kohdasta Vedos. Profiilin on vastattava määrittämääsi vedostusasetusta.
9. Valitse Värinkäsittely-asetukseksi Anna InDesignin määrittää värit.

10. Valitse Simuloi paperin väriä, kun haluat simuloida tulostusmateriaalin tiettyä valkoisen sävyä julkaisun profiilin mukaisesti (absoluuttinen
värijärjestelmä -muodostusperuste). Tämä asetus ei ole käytettävissä kaikissa profiileissa.

11. Avaa tulostinohjaimen valintaikkuna valitsemalla joko Asetukset (Windows) tai Kirjoitin (Mac OS).
12. Poista tulostimen värienhallinta käytöstä ja palaa InDesignin Tulosta-valintaikkunaan valitsemalla Tulosta.

Jokaisella tulostinohjaimella on omat värienhallinta-asetukset. Jos et ole varma, kuinka värienhallinta poistetaan käytöstä, katso ohjeita
tulostimen käyttöoppaasta.

13. Valitse Tulosta.

Liukuvärien ja sekoitevärien tulostuksen parantaminen
PostScript Level2- ja PostScript 3 -tulostimet voivat tulostaa korkeintaan 256 harmaasävyä, ja useimmat PostScript-lasertulostimet voivat tulostaa
32-64 sävyä laitteen resoluution, määritetyn rasteritiheyden ja rasterointimenetelmän mukaan. Raja näkyy silloin, kun kukin sävy kattaa niin laajan
alueen, että sävyt voi erottaa toisistaan. Jos määrität liukuvärin käyttämällä kahta prosenttiarvoa, jotka eroavat toisistaan alle 50 %, määrität
kapean sävyalueen, joka saattaa näkyä rajana. Jos liukuvärejä on vaikea tulostaa tasaisesti ilman rajoja, kokeile näitä tekniikoita:

Käytä liukuväriä, joka muuttuu vähintään 50 % kahden tai useamman prosessivärin osan välillä.

Vaalenna värejä tai lyhennä tummien liukuvärien pituutta. Rajoja näkyy useimmiten hyvien tummien värien ja valkoisen välillä.
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Kasvata liukuvärin muutoksen prosenttiarvoa.

Pienennä julkaisun rasteritiheyttä (PostScript-tulostimissa).

Jos rajoja esiintyy tuodussa grafiikassa, kuten Adobe Illustrator® -tiedostossa, alkuperäistä grafiikkaa on ehkä säädettävä.

Tulosta PostScript® 3 -tulostimeen, joka pystyy tuottamaan pehmeämmin vaihtuvia liukuvärejä.

Käytä lyhempiä liukuvärejä. Optimaalinen pituus vaihtelee liukuvärin värien mukaan, mutta yritä pitää liukuväri lyhempänä kuin 7,5 tuumaa
(19,05 cm).

Tietoja rasteri- ja tulostinpisteistä
Useimmat tulostimet simuloivat harmaata käyttämällä ruudukkoon tulostettuja rasteripisteitä. Ruudukon soluja kutsutaan rasterisoluiksi, kun taas
ruudukon viivoja kutsutaan viivoiksi tai viivarastereiksi. Yksi rasteripiste muodostuu tulostinpisteistä. Kun rasterisolu täyttyy tulostinpisteistä,
rasteripiste suurenee ja harmaan sävy tummenee.

Tulostimen resoluutio määrittää pistemäärän, jolla rasteripiste muodostetaan. Mitä pienempiä tulostinpisteet ovat, sitä enemmän rasteripisteen
kokoja ja harmaan sävyjä tulostin tuottaa. Myös rasteritiheydellä on vaikutusta: kun tiheys kasvaa, rasterisolut pienenevät ja sisältävät vähemmän
tulostinpisteitä, joten harmaasävyjen määrä pienenee. Tämän vuoksi joudutaan tekemään valintoja harmaasävyjen mahdollisen määrän ja kuvan
karkeuden suhteen.

Sävykuvan simulointi tulostinpisteillä
A. Sävyä simuloiva viivarasteri B. Rasteripisteitä riveittäin viivarasterissa C. Rasteripisteen tulostinpisteet

Lisää ohjeaiheita
  Värinhallinta

  Väriprofiilien käyttäminen

Adobe Print Resource Center

  Tuotujen kuvien värinhallinta

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Painovärit, erottelut ja rasteritiheys
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Huomautus:

Painovärienhallinnan yleiskuvaus
Erotettavien värien määrittäminen
Spottivärien erotteleminen prosessiväreinä
Spottivärin aliaksen luominen
Spottivärien näyttäminen tai tulostaminen käyttämällä Lab-arvoja
Tietoja rasteritiheydestä
Rasteritiheyden ja resoluution määrittäminen
Tietoja emulsiosta ja kuvan valotuksesta
Emulsion määrittäminen
Kuvan valotuksen määrittäminen
Erottelu- ja julkaisuasetusten tarkistaminen
Värierottelujen tarkistaminen
Erottelut rasteroinnin yhteydessä
Erottelujen tallentaminen tai tulostaminen

Painovärienhallinnan yleiskuvaus

Painovärienhallinnan avulla tulosteen painovärejä voi hallita julkaisua muuttamatta. Painovärienhallinnassa tehdyt muutokset vaikuttavat
tulosteeseen. Ne eivät muuta julkaisun määritettyjä värejä.

Painovärienhallinta-asetukset ovat käteviä varsinkin tulostuspalveluille. Jos esimerkiksi prosessityö sisältää spottivärin, tulostuspalvelu voi avata
julkaisun ja muuttaa spottivärin vastaaviksi CMYK-prosessiväreiksi. Jos julkaisu sisältää kaksi samanlaista spottiväriä, joista tarvitaan vain yhtä, tai
jos julkaisussa on liian monta spottiväriä, tulostuspalvelu voi yhdistää molemmat yhdeksi aliakseksi.

Lihotustyönkulussa Painovärin hallinnan avulla voi määrittää painovärin tiheyden ja hallita lihotusta sekä värien määrää ja jaksotusta.

InDesign ja Acrobat käyttävät samaa painovärienhallintatekniikkaa. Kuitenkin vain InDesign-ohjelmassa on Käytä LAB-vakioarvoja
spottiväreissä -asetus

Painovärin hallinta

A. Prosessiväri B. Spottivärin alias C. Spottiväri 

Avaa Painovärin hallinta

Tee jokin seuraavista:

Valitse Erottelujen esikatselu -paneelin valikosta (Ikkuna > Tuloste > Erottelujen esikatselu) Painovärinhallinta.
Valitse Tiedosto > Tulosta ja valitse sitten Tulostus. Valitse Tulostus-osasta Painovärinhallinta.
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Huomautus:

Erotettavien värien määrittäminen

Jokainen erottelu nimetään värinimellä, jonka InDesign on sille antanut. Jos tulostinkuvake näkyy värin nimen vieressä, InDesign luo värille
erottelun. Kaikki spottipainovärit, mukaan lukien tuoduissa PDF-tiedostoissa ja EPS-kuvissa määritetyt ja käytetyt painovärit, näkyvät myös
painovärimallissa.

1. Valitse Tulosta-valintaikkunan Tuloste-alueelta Erottelut. Jos käytät erottelua rasteroinnin yhteydessä tukevaa PPD-tiedostoa, valitse
Erottelut rasteroinnin yhteydessä.

2. Tee jokin seuraavista:

Varmista, että painovärimallissa värin nimen vieressä on tulostinkuvake.

Jos et haluat luoda erottelua, napsauta tulostinkuvaketta. Tulostinkuvake katoaa.

Spottivärien erotteleminen prosessiväreinä

Painovärienhallinnalla voit muuntaa spottivärit prosessiväreiksi. Kun spottivärit muunnetaan vastaaviksi prosessiväreiksi, ne tulostetaan eroteltuina
eikä yhdellä levyllä. Spottivärin muuntaminen kannattaa silloin, jos olet lisännyt spottivärin vahingossa prosessivärijulkaisuun tai jos julkaisussa on
liikaa spottivärejä tulostuksen kannalta.

1. Tee Painovärienhallinnassa jokin seuraavista toimista:

Voit erotella yksittäiset spottivärit napsauttamalla spottivärin tai spottivärin aliaksen vasemmalla puolella olevaa painovärityypin kuvaketta.
Prosessivärikuvake tulee näyttöön. Voit muuttaa värin spottiväriksi napsauttamalla kuvaketta uudelleen.

Voit erotella kaikki spottivärit valitsemalla Kaikki prosessiväreiksi. Spottivärien vasemmalla puolella olevat kuvakkeet muuttuvat
prosessivärikuvakkeiksi. Palauta spottivärit poistamalla Kaikki prosessiväreiksi -ruudun valinta.

Tällä asetuksella poistetaan kaikki Painovärienhallinnassa määritetyt aliakset. Valinta voi myös vaikuttaa päällepainatukseen ja
julkaisun lihotusasetuksiin.

2. (Vain InDesign) Jos haluat käyttää spottivärien LAB-arvoja CMYK-määritysten sijasta, valitse Käytä LAB-vakioarvoja spottiväreissä.

Spottivärin aliaksen luominen

Voit yhdistää spottivärin toiseen spotti- tai prosessiväriin luomalla aliaksen. Alias on hyödyllinen, jos julkaisu sisältää kaksi samanlaista spottiväriä,
joista tarvitaan vain yhtä, tai jos julkaisussa on liian monta spottiväriä. Värialiakset näkyvät sekä tulosteessa että näytöllä, jos Päällepainatuksen
esikatselu on käytössä.

1. Valitse Painovärienhallinnassa spottivärimuste, jolle haluat luoda aliaksen.

2. Valitse Painovärialias-valikosta asetus. Samalla muuttuu painovärityypin kuvake ja sen kuvaus.

Spottivärien näyttäminen tai tulostaminen käyttämällä Lab-arvoja

Jotkin esimääritetyt spottivärit, kuten TOYO-, PANTONE-, DIC- ja HKS-kirjastojen värit, määritetään Lab-arvoina. Näiden kirjastojen värit sisältävät
myös CMYK-määritykset vanhojen InDesign-versioiden yhteensopivuuden vuoksi. Kun Lab-arvoja käytetään oikeiden laiteprofiilien yhteydessä,
kaikilla laitteilla saadaan tarkin mahdollinen tuloste. Jos värienhallinta on keskeinen seikka projektissa, spottivärit kannattaa ehkä näyttää, viedä ja
tulostaa käyttämällä niiden Lab-arvoja. Painovärin hallinnan Käytä Lab-vakioarvoja spottiväreissä -asetuksella voidaan määrätä, mitä väritilaa
InDesignissa käytetään näiden esimääritettyjen spottivärien yhteydessä. Vaihtoehdot ovat Lab ja CMYK. Jos tulosteen on vastattava aikaisempien
InDesign-versioiden tulosteita, käytä CMYK-arvoja.

Lab-arvoja käytetään InDesignissa automaattisesti näyttötarkkuuden parantamiseksi, jos Päällepainatuksen esikatselu on käytössä.
Lab-arvoja käytetään InDesignissa myös tulostuksen tai viennin yhteydessä, jos Tulosta- tai Vie Adobe PDF -valintaikkunan Tuloste-alueelta on
valittu Simuloi päällepainatus.
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1. Valitse Erottelujen esikatselu -paneelista Painovärin hallinta.

2. Tee jokin seuraavista:

Jos haluat käyttää Lab-arvoja, valitse Käytä Lab-vakioarvoja spottiväreissä.

Jos haluat käyttää CMYK-arvoja, poista Käytä Lab-vakioarvoja spottiväreissä -asetuksen valinta.

Tietoja rasteritiheydestä

Painokoneissa sävykuvia simuloivat pisteet (joita kutsutaan rasteripisteiksi). Ne painetaan riveihin (joita kutsutaan linjoiksi tai viivarasteriksi). Viivat
tulostetaan eri kulmiin, jolloin rivejä on vaikeampi huomata. Suositellut viivarasterijoukot näkyvät Tulosta-valintaikkunan Tuloste-kohdan Rasterointi-
valikossa linjoina tuumalla (lpi) ja suositeltu resoluutio näkyy pisteinä tuumalla (dpi). Molemmat perustuvat valittuun PPD-tiedostoon. Kun valitset
painovärejä painoväriluettelosta, Tiheys- ja Kulma-ruudut muuttuvat ja näyttävät rasteritiheyden sekä painovärin kulman.

Korkea viivarasteritiheys (esimerkiksi 150 lpi) sijoittaa pisteet tiiviisti yhteen, jolloin ne toistavat kuvan selkeästi. Matala viivarasteritiheys (60–85 lpi)
sijoittaa pisteet kauemmaksi toisistaan, jolloin kuvasta tulee karkeampi. Viivarasteri määrittää myös pisteiden koon. Korkeassa
viivarasteritiheydessä on käytössä pienet pisteet, kun taas matalassa tiheydessä on käytössä suuret pisteet. Viivarasteria valittaessa tärkein seikka
on käytettävän painokoneen tyyppi. Kysy tulostuspalvelulta, miten hienoa viivarasteria painokone pystyy käsittelemään, ja säädä asetukset sen
mukaan.

Viivarasterit

A. 65 lpi: Karkea rasteri uutislehtisiin ja elintarvikkeiden mainoslehtisiin B. 85 lpi normaali rasteri sanomalehtiin C. 133 lpi laadukas rasteri
neliväriaikakauslehtien painamiseen D. 177 lpi erittäin hieno rasteri vuosikertomusten ja taidekirjojen kuvituksen painamiseen 

Korkean resoluution kirjapainotulostinten PPD-tiedostot tarjoavat useita rasteritiheyksiä sekä niihin liittyviä kirjapainotulostimen resoluutioita.
Matalan resoluution tulostinten PPD-tiedostoissa on yleensä vain muutamia viivarasterivaihtoehtoja. Ne ovat yleensä karkeita 53–85 lpi:n
rastereita. Karkeilla rastereilla saadaan kuitenkin parhaat tulokset matalan resoluution tulostimilla. Esimerkiksi 100 lpi:n hienon rasterin käyttö itse
asiassa huonontaa kuvan laatua, jos sitä käytetään matalan resoluution tulostimessa.

Rasteritiheyden ja resoluution määrittäminen

Valitse Tulosta-valintaikkunan Tuloste-osasta jompikumpi seuraavista asetuksista:

Jos haluat valmiin rasteritiheyden ja tulostimen resoluution yhdistelmän, valitse asetus Rasterointi-valikosta.

Jos haluat määrittää mukautetun rasteritiheyden, valitse mukautettava levy ja kirjoita sitten lpi-arvo Tiheys-tekstiruutuun ja rasterin
kulman arvo Kulma-ruutuun.

Ennen kuin luot omia rastereita, kysy tulostuspalvelusta oikeat tiheydet ja kulmat. Muista myös, että jotkin tulostuslaitteet ohittavat
oletustiheydet ja -kulmat.

Tietoja emulsiosta ja kuvan valotuksesta

Sen mukaan, millainen painokone on käytössä ja miten tieto siirretään filmiltä painolevyille, tulostuspalvelu pyytää sinulta filminegatiiveja tai -
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positiiveja, joiden emulsiopuoli on ylös- tai alaspäin. Emulsio tarkoittaa valolle herkkää kerrosta filmin tai paperin päällä. Tulostuspalvelut käyttävät
yleensä negatiivia Yhdysvalloissa ja positiivia Euroopassa ja Japanissa. Pyydä tulostuspalvelua määrittämään, millä puolella emulsion on oltava.

Saat selville emulsiopuolen tarkastamalla lopullisen filmin hyvässä valossa. Emulsiota sisältämätöntä puolta kutsutaan myös pohjaksi. Toinen
puolista kiiltää enemmän kuin toinen. Mattapuoli on emulsiopuoli ja kiiltävä puoli on pohja.

Emulsioasetukset

A. Positiivi B. Negatiivi C. Negatiivi emulsiopuoli alaspäin 

Tulosta-valintaikkunan emulsion ja kuvan valotuksen asetukset ohittavat tulostinohjaimen asetukset. Määritä aina tulostusasetukset
Tulosta-valintaikkunassa.

Emulsion määrittäminen

1. Valitse Tulosta-valintaikkunan Tuloste-osan Väri-asetukseksi Yhdistelmäharmaa tai erotteluasetus.

2. Valitse Peilaa-asetukseksi jokin seuraavista:

Ei muuta tulostettavan alueen suuntaa. Teksti on luettavissa (vasemmalta oikealle), kun valoherkkä kerros osoittaa
itseesi päin.

Peilaa kuva-alueen pystyakselin suhteen niin, että teksti etenee väärään suuntaan.

Peilaa kuva-alueen vaaka-akselin suhteen niin, että kuva-alue on ylösalaisin.

Peilaa kuva-alueen vaaka- ja pystyakselin suhteen niin, että kuva näkyy väärin. Teksti on luettavissa, kun valolle
herkkä kerros osoittaa poispäin itsestäsi. Filmille painetut kuvat on usein painettu Vaaka- ja pystysuunta -asetuksella.

Kuvan valotuksen määrittäminen

1. Valitse Tulosta-valintaikkunan Tuloste-osan Väri-asetukseksi Yhdistelmäharmaa tai erotteluasetus.

2. Valitse Negatiivi-asetus tai poista sen valinta.

Erottelu- ja julkaisuasetusten tarkistaminen

Tulosta-valintaikkunan Yhteenveto-alueella näkyy yhteenveto julkaisun värienhallinnasta, tulostinmerkkien koosta ja leikkausvaroista. Se näyttää
myös, onko lihotus käytössä.

Voit tarkastaa laadun ennen julkaisun tulostamista tai lähettämistä tulostuspalveluun.

Värierottelujen tarkistaminen

Voit tehdä koevedoksen, kun haluat varmistaa värien oikea erottelun tulostettaessa. Ohjelmallisessa tarkistuksessa tarkastetaan, miltä värit
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näyttävät, kun ne tulostetaan valitulla tulostuslaitteella.

Vaikka lopullisen tulosteen ulkoasua ei voikaan täysin ennustaa, voit parantaa sen tarkkuutta huomattavasti kalibroimalla kaikki
laitteet, joita julkaisun luomiseen käytetään (kuten skannerit, näytöt ja tulostimet). Jos laitteet on kalibroitu, värienhallintajärjestelmä takaa hyvin
ennakoitavat ja tasaiset värit.

Koevedos ilmaisee lopullisen erottelun ulkoasun ja auttaa tulostuspalvelua varmistamaan oikean tuloksen. Tulosta vedokset PostScript-tulostimella,
sillä värierottelut voi tarkistaa luotettavasti vain sillä.

Voit varmistaa tiedoston oikean tulostumisen tallentamalla erottelut PostScript-tiedostona, muuntamalla PostScript-tiedoston Acrobat 8 PDF -
tiedostoksi käyttämällä Acrobat Distilleriä ja tarkistamalla sitten PDF-julkaisun Acrobatissa. Katselemalla PDF-julkaisua Acrobatissa voit tutkia
tasokasta PostScript-tulostetta yksityiskohtaisesti näytössä.

Erottelut rasteroinnin yhteydessä

Rasteroinnin yhteydessä erottelua varten tarvitaan seuraavat ohjelmat ja laitteet:

PPD-tiedosto, joka tukee erottelua rasteroinnin yhteydessä.

PostScript 3 -tulostuslaite tai PostScript Level 2 -laite, jonka rasterointiprosessori tukee erottelua rasteroinnin yhteydessä. Jos julkaisussa on
Photoshop 5.0:n tai sitä uudemman version kaksivärikuvia, PostScript 3 -laite tarvitaan erottelujen tuottamiseen rasteroinnin yhteydessä.

Tulostuspalvelun ohjelmistojen mukaan palveluntarjoaja voi tehdä lihotuksen, taiton, erottelut ja OPI-kuvien korvaamisen
tulostuslaitteen rasterointiprosessorilla. Siksi tulostuspalvelu saattaa haluta erottelun yhteydessä tehtävään rasterointiin optimoidun PostScript-
yhdistelmätiedoston eikä valmiiksi eroteltua PostScript-tiedostoa.

Erottelujen tallentaminen tai tulostaminen

1. Valitse Tulosta-valintaikkunan yläreunan Tulostuksen oletusarvo -valikosta oletusarvo, jos oikeat erotteluasetukset on jo tehty siihen
valmiiksi.

2. Tee jokin seuraavista:

Tulosta laitteeseen valitsemalla Tulostin-valikosta laite.

Tulosta tiedostoon valitsemalla Tulostin-valikosta PostScript®-tiedosto. Valitse sitten PPD, joka tukee tulostuslaitetta.

3. Valitse Yleiset ja määritä eroteltavat sivut.

4. Valitse Tuloste ja tee jokin seuraavista:

Tulosta tulostuslaitteeseen valitsemalla Erottelut. Tällöin erottelut luodaan InDesignissa.

Tulosta tiedostoon valitsemalla joko Erottelut tai Erottelut rasteroinnin yhteydessä, jos haluat tallentaa erotteluasetukset PostScript-
yhdistelmätiedostoon rasteroinnin yhteydessä tehtävää erottelua varten.

Jos aiot käyttää Adobe-rasterointiprosessoria, sinun täytyy valita erottelu rasteroinnin yhteydessä eikä erottelu tietokoneella.
Muutoin lihotusominaisuus ei voi käyttää kaikkia värejä kerralla eikä lihotusta tehdä.

5. Valitse Grafiikka ja tee jokin seuraavista:

Valitse Lähetä tiedot -asetukseksi Kaikki.

Valitse Lataa-asetukseksi Kaikki tai Osajoukko, ellei kirjasimia lisätä myöhemmin (esimerkiksi erottelussa rasteroinnin yhteydessä tai
jälkikäsittelysovelluksessa).

Valitse PostScript®-asetukseksi tulostuslaitteen PostScript-taso: Level 2 tai Level 3.

6. Valitse Lisäasetukset ja tee jokin seuraavista:

Jos haluat korvata sijoitettuihin EPS-tiedostoihin upotetut pienen resoluution kuvat suuren resoluution kuvilla tulostusvaiheessa, varmista,
että Lue upotetut OPI-linkit -asetus valittiin sijoitettaessa EPS-tiedostoa InDesign-julkaisuun. Valitse sitten Tulosta-valintaikkunan
Lisäasetukset-alueelta OPI-kuvien korvaus.

Anna OPI-palvelimen korvata tuodut grafiikkatyypit valitsemalla jokin Jätä pois (OPI) -asetus.
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Huomautus:

Valitse Läpinäkyvyyden yhdistämisen oletusarvoksi [Korkea resoluutio] tai mukautettu tyyli, jossa on suuren resoluution asetukset.

7. Valitse muut tulostusasetukset.

8. Tee jokin seuraavista:

Tulosta tulostuslaitteeseen napsauttamalla Tulosta-painiketta.

Tulosta tiedostoon napsauttamalla Tallenna-painiketta ja hyväksymällä oletustiedostonimi tai kirjoittamalla toinen nimi. Napsauta
uudelleen Tallenna-painiketta.

Kun olet luonut InDesign-julkaisun erottelut, Tulosta-valintaikkunasta valitut asetukset tallentuvat eroteltuun tiedostoon. Tiedosto
sisältää erotteluasetukset, PPD-tiedot ja Tulosta-valintaikkunassa määritellyt värimuunnokset.

Lisää ohjeaiheita
Värien tarkastaminen
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PostScript- ja EPS-tiedostojen luominen

Alkuun

Alkuun

***

**

PostScript- tai EPS-tiedoston luominen
PostScript-tiedoston luominen oikein
Tietoja laitteesta ja ohjaimesta riippuvaisista PostScript-tiedostoista
Laiteriippumattoman PostScript-tiedoston luominen
Laitteesta riippuvaisen PostScript-tiedoston luominen InDesignissa
PostScript-tiedoston luominen PostScript-tulostinohjainta käyttämällä (Windows)
PostScript-tiedoston luominen PostScript-tulostinohjainta käyttämällä (Mac OS)
Sivujen vieminen EPS-muotoon

PostScript- tai EPS-tiedoston luominen

Julkaisua ei tarvitse tulostaa suoraan tulostimelle, vaan voit tallentaa julkaisun PostScript-kielen kuvauksen .PS-tiedostoksi esimerkiksi
tulostuspalvelun etätulostusta varten. Palveluntarjoaja voi lähettää .PS-tiedoston suoraan valolatomakoneelle. PostScript-tiedoston koko on yleensä
suurempi kuin alkuperäinen InDesign-julkaisu, sillä grafiikka ja kirjasimet on upotettu julkaisuun.

Voit myös viedä julkaisun sivun tai aukeaman EPS (Encapsulated PostScript) -tiedostoon ja käyttää sitä muissa sovelluksissa.

PostScript-tiedoston luominen oikein

Voit tallentaa InDesign-julkaisun tai -kirjan kolmenlaisena PostScript-tiedostona: laiteriippumattomana, laitteesta riippuvaisena tai laitteesta ja
ohjaimesta riippuvaisena.

Seuraavassa taulukossa luetellaan suositellut tulostinohjaimet ja tulostusmenetelmät, joilla saadaan parhaat tulokset InDesignissa ja
jälkikäsittelysovelluksissa. Valitse InDesignin Tulosta-valintaikkunassa Tulostin-valikosta PostScript®-tiedosto, jos julkaisu käsitellään OPI-
palvelimessa, taitto- tai lihotussovelluksessa tai muussa tulostuspalvelusovelluksessa, ennen kuin se tulostetaan rasterointiprosessorilla. Siten
InDesign pystyy ohjamaan DSC-tulostusta. Käytä toimistotulostimena mitä tahansa tuettua PostScript-tulostinohjainta.

Taulukoissa on ilmaistu tähtimerkein kunkin menetelmän sopivuus esivalmistukseen:

PostScript-tiedosto on täysin DSC-yhteensopiva ja erittäin sopiva monenlaisten jälkikäsittelysovellusten, rasterointiprosessoreiden ja
työnkulkujen käyttöön. Tämä menetelmä on paras yleisvalinta DSC-sääntöjä noudattaville sovelluksille.

PostScript-tiedosto on lähes täysin DSC-yhteensopiva ja yleensä sopiva monenlaisten jälkikäsittelysovellusten, rasterointiprosessoreiden ja
työnkulkujen käyttöön. Yhteensopivuusongelmia saattaa ilmetä joidenkin sellaisten sovellusten kanssa, jotka noudattavat tarkasti DSC-sääntöjä.

Tulostinohjainta ei käytetä, kun tulostinvalinta on PostScript® -tiedosto.

Tulostinvalinta: PostScript®-tiedosto

Käyttöjärjestelmä PPD Sopivuus esivalmistukseen

Kaikki käyttöympäristöt Laiteriippumaton ***

Laitteesta riippuvainen ***
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Tulostimelle valittu PPD-tiedosto näkyy Tulosta-valintaikkunan yläreunassa PPD-ruudussa.

Tietoja laitteesta ja ohjaimesta riippuvaisista PostScript-tiedostoista

Valitse tulostin ja sitä tukeva ohjain Tulostin-valikosta. Laitteesta ja ohjaimesta riippuvaisella PostScript-tiedostolla on seuraavat ominaisuudet:

Se on riippuvainen ohjaimesta. PostScript-tiedosto sisältää InDesignin ja ohjaimen luoman koodin. InDesign-koodi vastaa lähinnä sivun
sisällöstä, mukaan lukien kirjasimen lataaminen ja tulostusmateriaalin koon, resoluution, rasteroinnin ja muiden peruslaitetietojen
määrittäminen. Ohjain vastaa lähinnä vesileimojen ja muiden erityisten ohjainominaisuuksien määrittämisestä ja laitteen erityisominaisuuksien
ohjaamisesta. InDesign ei ohjaa täysin PostScript-tiedoston luomista, joten DSC-yhteensopivuuden taso ei ole aivan yhtä korkea kuin
ohjainriippumattomissa PostScript-tiedostoissa. DSC-yhteensopivuuden taso ja siten PostScript-tiedoston sopivuus tulostuspalvelun tehtäviin
riippuvat käytetystä tulostinohjaimesta.

Se on laitteesta riippuvainen. Siinä on koodi, joka sallii erityiset laiteominaisuudet ja ohjaa niitä. Kohdelaitetta lukuun ottamatta sen
yhteensopivuus laitteiden kanssa on huonompi kuin muiden.

Se voi olla yhdistelmä tai erotettu (kaikki InDesignin tukemat väritulostusmenetelmät ovat käytössä).

InDesign voi lihottaa sen (joko käyttämällä sisäistä lihotusta tai Adobe-rasterointiprosessoria).

Sen voi tulostaa suoraan laitteeseen tai tiedostoon.

Laitteesta ja ohjaimesta riippuvainen PostScript-tiedosto sopii (suunnittelijan tekemään) vedostukseen PostScript-toimistotulostimilla. Sitä voivat
käyttää myös sellaiset palveluntarjoajat, jotka tekevät ainoastaan InDesign- tai rasterointiprosessoritehtäviä. Jos lihotus siis tehdään, sen tekee
joko InDesign tai rasterointiprosessori.

Laiteriippumattoman PostScript-tiedoston luominen

Valitse Tulostin-valikosta PostScript-tiedosto. Valitse PPD-valikosta Laiteriippumaton. Laiteriippumattomalla PostScript-tiedostolla on seuraavat
ominaisuudet:

Se on täysin DSC-yhteensopiva, joten se sopii hyvin lihotukseen, taittoon ja muihin jälkikäsittelytehtäviin.

Kaikki laite- ja ohjainriippuvuudet poistetaan, joten tiedoston voi tulostaa lähes mistä tahansa tulostimesta. Erityiset PPD-tiedostojen
tulostinominaisuudet, kuten kuvan valotus, tulostusmateriaalikoot ja optimoidut rasteritiheydet, eivät ole käytettävissä laiteriippumattomassa
tulostuksessa.

Värituloste on aina yhdistelmä-CMYK, mutta siihen sisältyy myös spottivärejä. Siksi se on erotettava jälkikäsittelyohjelmassa tai
rasterointiprosessorissa, joka erottelee rasteroinnin yhteydessä.

InDesign ei voi lihottaa sitä, vaan lihotus on tehtävä rasterointiprosessorissa tai jälkikäsittelyohjelmassa.

Se voidaan tulostaa InDesignista vain tiedostoon (ei suoraan laitteeseen tai ohjelmaan).

Laiteriippumaton PostScript-tiedosto on paras valinta tulostuspalvelun yhdistelmätyönkuluissa, joissa tiedosto lihotetaan ja erotellaan
myöhemmin tuotantoprosessissa esimerkiksi taiton ja lihotuksen aikana tai rasterointiprosessorissa (jos tulostin tukee erottelua rasteroinnin
yhteydessä).

1. Valitse Tiedosto > Tulosta.

Tulostinvalinta: <asennettu tulostin>

Käyttöjärjestelmä Tulostinohjain Sopivuus esivalmistukseen

Mac OS 10.2 Sisäinen PS-ohjain Mac OS X -
käyttöjärjestelmää varten

**

Windows 2000/XP Pscript 5 **
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2. Valitse Tulosta-valintaikkunassa tulostimeksi PostScript-tiedosto.

3. Valitse PPD:ksi Laiteriippumaton.

4. Näytä tai muuta tulostusasetukset. InDesign käyttää valittua sivualuetta PostScript-tiedoston luomiseen.

5. Valitse Tallenna.

6. Määritä nimi ja sijainti. Valitse Tallenna.

Laitteesta riippuvaisen PostScript-tiedoston luominen InDesignissa

Valitse Tulostin-valikosta PostScript-tiedosto ja sitten PPD. Laitteesta riippuvaisella PostScript-tiedostolla on seuraavat ominaisuudet:

Se on täysin DSC-yhteensopiva, joten se sopii hyvin lihotukseen, taittoon ja muihin jälkikäsittelytehtäviin.

Se sisältää kuvauksen julkaisun kaikista tiedoista, mukaan lukien tiedot linkitetyistä tiedostoista, optimoidusta rasteritiheydestä, resoluutiosta
ja valittua tulostinta varten mukautetusta tulostusmateriaalikoosta.

Kaikki ohjainriippuvuudet poistetaan.

Se voi olla yhdistelmä tai erotettu. Kaikki InDesignin tukemat väritulostusmenetelmät ovat käytössä. (Erottelu rasteroidessa on käytössä, jos
PPD ja tulostin tukevat sitä.)

InDesign voi lihottaa sen (joko käyttämällä sisäistä lihotusta tai Adobe-rasterointiprosessoria).

Se voidaan tulostaa InDesignista vain tiedostoon (ei suoraan laitteeseen tai ohjelmaan).

Laitteesta riippuvainen PostScript-tiedosto sopii esierottelu- tai lihotustyönkulkuihin, joissa tiedosto lihotetaan käyttämällä automaattista InDesignin
lihotusta tai Adobe-rasterointiprosessoria.

1. Valitse Tiedosto > Tulosta.

2. Valitse Tulosta-valintaikkunassa tulostimeksi PostScript-tiedosto.

3. Valitse lopullisen tulostimen PPD.

4. Näytä tai muuta tulostusasetukset. InDesign käyttää valittua sivualuetta PostScript-tiedoston luomiseen.

5. Valitse Tallenna.

6. Määritä nimi ja sijainti. Valitse Tallenna.

PostScript-tiedoston luominen PostScript-tulostinohjainta käyttämällä (Windows)

1. Valitse Tiedosto > Tulosta.

2. Napsauta InDesignin Tulosta-valintaikkunan alareunassa olevaa Asetukset-painiketta.

3. Valitse tulostinohjaimen valintaikkunassa Tulosta tiedostoon.

4. Valitse Sivuasettelu ja sitten Lisäasetukset.

5. Valitse ensin Julkaisun asetukset, PostScript-asetukset ja sitten PostScript-tulostusasetukset-valikosta Optimoi siirrettävyys. Napsauta OK-
painiketta.

6. Valitsemalla OK tai Tulosta pääset takaisin InDesignin Tulosta-valintaikkunaan.

7. Valitse InDesignin Tulosta-valintaikkunassa Tulosta.

8. Määritä nimi ja sijainti. Valitse Tallenna.

PostScript-tiedoston luominen PostScript-tulostinohjainta käyttämällä (Mac OS)
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Harmaa

RGB

PostScript®-värinhallinta

Esikatselu

1. Valitse Tiedosto > Tulosta.

2. Valitse Tulosta-valintaikkunassa PostScript-tiedosto Tulostin-valikosta ja valitse sitten Tallenna.

3. Määritä PostScript-tiedoston nimi ja sijainti (.ps) Tallenna PostScript-tiedosto -valintaikkunassa. Valitse lopuksi Tallenna.

Sivujen vieminen EPS-muotoon

Vie-komennolla voit viedä InDesign-sivuja EPS-muotoon, jonka voit sitten tuoda johonkin toiseen ohjelmaan. Jos viet useita sivuja, kukin sivu
viedään erillisenä tiedostona ja tiedostonimen perään lisätään sivunumero. Jos esimerkiksi viet sivut 3, 6 ja 12 ja määrität tiedostonimeksi
Uutiset.eps, InDesign luo kolme tiedostoa, joiden nimet ovat Uutiset_3.eps, Uutiset_6.eps ja Uutiset_12.eps.

Jos haluat avata InDesign-sivut Illustratorissa tai Adobe Photoshopissa, vie ne PDF- tai EPS-tiedostoina.

1. Valitse Tiedosto > Vie.

2. Määritä kohde ja tiedostonimi. Muista käyttää EPS-tunnistetta.

3. Valitse Tallennusmuoto-kohdasta (Windows) tai Muoto-kohdasta (Mac OS) EPS ja valitse sitten Tallenna.

4. Tee jokin seuraavista toimenpiteistä Vie EPS -valintaikkunan Sivut-kohdassa:

Valitse Kaikki sivut, jos haluat viedä julkaisun kaikki sivut.

Valitse Alueet ja määritä sivualue. Voit ilmoittaa alueen yhdysmerkin avulla ja erottaa sivut tai alueet pilkuin.

Valitse Aukeamat, jos haluat viedä aukeaman yhtenä EPS-tiedostona (yksi aukeama EPS-tiedostoa kohti).

5. Määritä tarvittaessa lisäasetuksia.

6. Kirjoita Leikkausvara-kohtaan arvo 0p0-36p0. Tämä arvo määrittää sivun tai viimeistelyalueen reunan ulkopuolella sijaitsevien kuvien
tarvitseman lisätilan.

7. Valitse Vie.

EPS-vientiasetukset

EPS-tiedoston viennin yhteydessä voit määrittää seuraavia asetuksia:

Määrittää PostScript-tulostimien tulkkien vastaavuustason. Taso 2 parantaa usein tulostusnopeutta ja -laatua, jos kuvia tulostetaan
vain PostScript-taso 2:n tai sitä ylemmän tason laitteilla. Level 3 takaa parhaan nopeuden ja laadun, mutta edellyttää PostScript 3 -laitetta.

Määrittää, miten värit esitetään vietävässä tiedostossa. Alla olevat asetukset ovat samat kuin Tulosta-valintaikkunan väriasetukset.

Jättää kunkin kuvan alkuperäiseen väriavaruuteensa. Jos julkaisu sisältää esimerkiksi kolme RGB-kuvaa ja neljä CMYK-
kuvaa, EPS-tiedosto sisältää samat RGB- ja CMYK-kuvat.

Luo erillisen tiedoston esittämällä kaikki väriarvot syaanin, magentan, keltaisen ja mustan prosessipainovärin toistoalan avulla.

Muuntaa kaikki väriarvot laadukkaiksi mustavalkokuviksi. Muunnettujen objektien harmaasävyt edustavat alkuperäisten objektien
kirkkautta.

Esittää kaikki väriarvot punaisen, vihreän ja sinisen väriavaruuden avulla. RGB-värimääritetty EPS -tiedosto sopii parhaiten näytössä
katseltavaksi.

Käyttää julkaisun väritietoja sen alkuperäisen väriavaruuden kalibroidussa versiossa.

Määrittävät tiedostoon tallennetun esikatselukuvan ominaisuudet. Esikatselukuva näytetään sovelluksissa, jotka eivät voi suoraan
näyttää EPS-kuvia. Jos et halua luoda esikatselukuvaa, valitse Muoto-valikosta Ei mitään.
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Upota kirjasimet

Ei mikään

Kaikki

Osajoukko

Tiedon muoto

Kuvat

Kaikki

Sijaiskuva

OPI-kuvien korvaus

Jätä pois (OPI)

Läpinäkyvyyden yhdistäminen

Painovärin hallinta

Määrittää, miten vietävien sivujen kirjasimet sisällytetään tietoihin.

Lisää PostScript-tiedoston kirjasimeen viitteen, joka kertoo rasterointiprosessorille tai jälkiprosessorille, mihin kirjasin liitetään.

Lataa kaikki julkaisun vaatimat kirjasimet tulostustehtävän alussa. Kaikki kirjasimen kuviot ja merkit ladataan, vaikka niitä ei esiinny
julkaisussa. InDesign jakaa automaattisesti osajoukkoihin sellaiset kirjasimet, joiden kuviomäärä (merkit) ylittää Asetukset-valintaikkunassa
määritetyn enimmäismäärän.

Lataa vain julkaisussa käytettävät merkit (kuviot).

Määrittää tavan (ASCII- tai binaari-muoto), jolla InDesign lähettää kuvatietoja tietokoneelta tulostimeen.

Määrittää, miten suuri osa sijoitettujen bittikarttakuvien kuvatiedoista sisällytetään vientitiedostoon.

Sisällyttää vientitiedostoon kaikki korkearesoluutiokuvatiedot ja vaatii eniten levytilaa. Valitse tämä asetus, jos tiedosto tulostetaan
korkearesoluutiotulostimella.

Sisällyttää vietävään tiedostoon vain sijoitettujen bittikarttakuvien näyttöresoluutioversiot (72 dpi). Valitse tämä asetus, jos
käytät myös OPI-kuvan korvaus -asetusta tai jos luotavaa PDF-tiedostoa katsotaan näytössä.

InDesign korvaa tulostettaessa matalan resoluution EPS-grafiikkasijaiskuvat korkean resoluution grafiikalla.

Poistaa tuodun grafiikan lähetettäessä tietoja tulostimeen tai tiedostoon ja jättää vain OPI-linkit (kommentit) myöhempää OPI-
palvelimella käsittelyä varten.

Määritä läpinäkyvien objektien näkyvyys vietävässä tiedostossa valitsemalla Oletusarvo-valikosta
yhdistämisoletusarvo. Tämä asetus on sama kuin Tulosta-valintaikkunan lisäasetusten Läpinäkyvyyden yhdistäminen -asetus.

Korjaa painoväriasetukset muuttamatta julkaisun määrityksiä.

Lisää ohjeaiheita
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Lihotuksen painoväriasetusten säätäminen

Alkuun

Alkuun

Alkuun

Painovärin neutraalin tiheyden säätäminen
Erikoispainovärien lihotuksen mukauttaminen
Lihotusjakson säätäminen

Painovärin neutraalin tiheyden säätäminen
Voit säätää valitun lihotusohjelman käyttämiä painovärin neutraalin tiheyden arvoja, kun haluat määrittää lihotusten sijainnin täsmällisesti.
Prosessivärien neutraalin tiheyden arvot perustuvat prosessiväriluetteloiden neutraalin tiheyden arvoihin, jotka vastaavat alan standardeja eri
puolilla maailmaa. Kieliversiosta riippuu, minkä standardin ohjelma valitsee. Esimerkiksi Yhdysvaltojen ja Kanadan versioiden neutraalin tiheyden
arvot vastaavat Specifications for Web Offset Publications (SWOP) -määrityksen tasaisen painovärin tiheysarvoja. Määrityksen julkaisija on
Graphic Arts Technical Foundation of North America. Prosessivärien neutraalia tiheyttä on mahdollista säätää eri maiden standardien mukaisiksi.

Lihotusohjelma määrittää spottivärin neutraalin tiheyden vastaavasta CMYK-väristä. Useimpien spottivärien CMYK-vastineista johdetut neutraalin
tiheyden arvot ovat riittävän tarkat hyväksyttävien lihotusten luomiseen. Jos käytät metallipainovärejä, lakkoja ja muita spottivärejä, joita on vaikea
simuloida prosessiväreillä, neutraalin tiheyden arvoja on ehkä säädettävä, jotta ohjelma lihottaa ne oikein. Näppäilemällä uudet arvot voit
varmistaa, että jos muste nähdään tummana tai vaaleana, myös ohjelma näkee sen samalla tavalla ja valitsee lihotukselle sopivan sijainnin
automaattisesti.

Voit kysyä tietyn painovärin oikean neutraalin tiheyden arvon painotalosta. Painovärin neutraalin tiheyden voi tarkimmin määrittää mittaamalla
densitometrillä painoväriluettelon. Lue V eli painovärin visuaalinen tiheys (älä käytä prosessivärisuotimia). Jos arvo poikkeaa oletusasetuksesta,
kirjoita uusi arvo neutraalin tiheyden tekstiruutuun.

Huomautus: Spottivärin neutraalin tiheyden muuttaminen vaikuttaa vain värin lihotukseen. Se ei muuta värin ulkoasua julkaisussa.
Noudata seuraavia ohjeita, kun säädät neutraalin tiheyden arvoja:

Metallivärit ja peittävät painovärit Metallivärit ovat yleensä tummempia kuin vastaavat CMYK-värit, kun taas peittävät painovärit peittävät allaan
olevat painovärit. Sekä metallivärien että peittävien spottivärien neutraalin tiheyden arvot on tavallisesti muutettava paljon oletusarvoja
suuremmiksi, jotta värit eivät leviä.
Huomautus: kun määrität painoväriksi Peittävä tai PeittäväOhita Painovärin hallinnan Teksti-valikossa, peittävä painoväri leviää muihin väreihin
vain, jos toisen peittävän painovärin neutraalin tiheyden arvo on suurempi.
Pastellivärit Pastellivärit ovat tavallisesti vastaavia prosessivärejä vaaleampia. Näiden painovärien neutraalin tiheyden arvot kannattaa ehkä
muuttaa oletusarvoja pienemmiksi, jotta ne leviävät viereisiin tummempiin väreihin.
Muut spottivärit Eräät spottivärit, kuten turkoosi ja neonoranssi, ovat huomattavasti tummempia tai vaaleampia kuin vastaavat CMYK-värit. Voit
tutkia asiaa vertaamalla oikeiden spottivärien painettuja näytteitä vastaavien CMYK-värien painettuihin luetteloihin. Suurenna tai pienennä
spottivärin neutraalin tiheyden arvoa tarvittaessa.

Erikoispainovärien lihotuksen mukauttaminen
Jotkin painovärit vaativat lihotuksen erityisasetuksia. Esimerkiksi lakan käyttäminen julkaisussa ei saa vaikuttaa lihottamiseen. Jos taas painat
tietyille alueille täysin peittävää painoväriä, sen alla olevia alueita ei tarvitse lihottaa. Painoväriasetukset ovat näitä tilanteita varten.
Oletusasetukset kannattaa tavallisesti hyväksyä, ellei tulostuspalvelu suosittele niiden muuttamista.

Huomautus: Julkaisussa käytetyt erikoispainovärit ja lakat on ehkä luotu sekoittamalla kaksi spottiväriä tai sekoittamalla spottiväri prosessiväriin
tai useisiin prosessiväreihin.

1. Avaa Painovärin hallinta ja valitse erikoisasetuksia vaativa painoväri.
2. Valitse tyypiksi jokin seuraavista vaihtoehdoista ja valitse sitten OK:

Normaali Valitse tämä, jos käytät perinteisiä prosessivärejä tai tavanomaisia spottivärejä.

Läpinäkyvä Valitse tämä, jos käytät vaaleita painovärejä ja haluat varmistaa, että niiden alla olevat alueet lihotetaan. Tämä asetus sopii
lakoille ja koristeväreille.

Läpinäkymätön Valitse tämä, jos kyseessä on raskas, läpinäkymätön painoväri ja haluat estää alla olevien värien lihotuksen ja sallia
lihotuksen painovärialueen reunoilla. Tämä asetus sopii metallipainoväreille.

PeittäväOhita Valitse tämä, jos kyseessä on raskas, läpinäkymätön painoväri ja haluat estää alla olevien värien lihotuksen sekä lihotuksen
painovärialueen reunoilla. Käytä asetusta metalliväreille, lakoille ja muille painoväreille, joiden yhteisvaikutus muiden painovärien kanssa voi
aiheuttaa ongelmia.

Lihotusjakson säätäminen
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Lihotusjakso (myös nimitystä lihotusjärjestys käytetään) on järjestys, jossa painovärit painetaan, mutta se ei vastaa tulostuslaitteen
värinerottelujärjestystä.

Lihotusjakso on erityisen tärkeä, kun tulostat useita läpinäkymättömiä värejä, kuten metallipainovärejä. Järjestysnumeroltaan pienet
läpinäkymättömät painovärit levitetään järjestysnumeroltaan suurempien läpinäkymättömien painovärien alle. Tämä estää viimeksi käytetyn
painovärin leviämisen ja tuottaa silti saumattomat lihotukset.

Huomautus: Älä muuta painovärien oletusjärjestystä, ennen kuin olet keskustellut tulostuspalvelun kanssa.
1. Avaa Painovärin hallinta. Käytössä oleva lihotusjakso näkyy painoväriluettelon Jakso-sarakkeessa.
2. Valitse painoväri, kirjoita Lihotusjakso-kohtaan uusi arvo ja paina sitten sarkainta. Valitun painovärin järjestysnumero vaihtuu, ja muut

järjestysnumerot muuttuvat sen mukaisesti.
3. Toista edellinen vaihe haluamillesi painoväreille ja valitse sitten OK.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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Digitaaliset julkaisut

Apuviivapohjaisten joustavien sivuasettelusääntöjen käyttäminen
Anne-Marie Concepcion  (15.5.2012)
Opastus - video
Ota selvää, miten apuviivapohjaiset joustavat sivuasettelut toimivat sekä perehdy joustavien apuviivojen ja viivainoppaiden käyttöön.

Objektipohjaisten joustavien sivuasettelusääntöjen käyttäminen
Anne-Marie Concepcion  (15.5.2012)
Opastus - video
Tutustu objektipohjaisten joustavien sivuasettelusääntöjen toimintaan, sekä objektin päällä että Joustava sivuasettelu -paneelissa.

Joustavien sivuasettelusääntöjen toimintatapa
Anne-Marie Concepcion  (15.5.2012)
Opastus - video
Tässä opastusohjelmassa määritellään ja esitellään joustava sivuasettelu sekä käydään joustavaan sivuasetteluun liittyvät komennot ja
valintaikkunat läpi.

Perustason joustavien sivuasettelusääntöjen käyttäminen: Skaalaa, Keskitä ja Sivupohjan perusteella
Anne-Marie Concepcion  (15.5.2012)
Opastus - video
Katso, miten voit käyttää Ei mitään-, Skaalaa- ja Keskitä uudelleen -sääntöjä sivuasettelun kokoa muutettaessa. Selvitä myös, mitä
”sivupohjan perusteella” tarkoittaa.

Vaihtoehtoisten sivuasetteluiden käyttäminen
Anne-Marie Concepcion  (15.5.2012)
Opastus - video
Opi käyttämään vaihtoehtoisia sivuasetteluita painotuotteissa ja digitaalisissa julkaisuissa.

Adobe-tunnukseen liittyvän sähköpostiosoitteen muuttaminen
WHB III  (24.4.2012)
Vianmääritys
Adobe-tunnuksena käytettävän sähköpostiosoitteen muuttaminen: DPS

Sisällön viennin hallinta InDesignista EPUBiin sivuasettelua muuttamatta (video 04:54)
Colin Fleming  (1.1.2011)
Opastus - video
Opi luomaan ja järjestelemään artikkeleita Artikkelit-paneelissa EPUB-muodossa tapahtuvaa vientiä varten sivuasettelua muuttamatta tai
koodia kirjoittamatta.

Kansien ja otsikkosivujen luominen EPUBia varten (video 05:50)
Colin Fleming  (1.1.2011)
Opastus - video
Opi luomaan kansia ja otsikkosivuja EPUB-julkaisuillesi.

Asiakirjojen vienti EPUB-muodossa (PDF, 265 kt)
Viittaus  (1.1.2011)
Lyhyt ja nopea yleiskatsaus siitä, miten voit viedä sivuasettelut EPUB-muodossa InDesign CS5:ssä.

Vienti EPUB-muodossa Apple iBookstorea varten (PDF, 2,5 Mt)
Viittaus  (1.1.2011)
Opi luomaan EPUB-julkaisu Apple iBook -kauppaa varten.

Folio Producerin työkalut (video 1:04)
Opastus - video  (1.1.2011)
Erittäin lyhyt yleiskatsaus digitaalisessa julkaisutoiminnassa käytettävistä Folio Producerin työkaluista.
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Sisällön vieminen EPUB-muotoon

Alkuun

Alkuun

Yleistä
Tekstin tuki
Hyperlinkkien tuki
Navigoinnin tuki
Kirjan CSS-tiedoston luominen
Vieminen EPUB-muotoon
Kiinteän asettelun vientiasetukset
Uudelleenjuoksutettavan asettelun vientiasetukset
Objektin vientiasetukset
EPUB-resurssit

Yleistä

Voit viedä InDesign-julkaisun EPUB-muotoon, jotta käyttäjät voivat tarkastella tulostetta EPUB-lukuohjelmassa.

Voit viedä julkaisun uudelleenjuoksutettavassa EPUB-muodossa. Uudelleenjuoksutettavaa EPUB-julkaisua käytettäessä EPUB-lukuohjelma pystyy
optimoimaan sisällön näyttölaitteen mukaan.

Uudelleenjuoksutettava muoto sopii paremmin käyttötarkoitukseen, jos julkaisu on tarkoitettu eInk-laitteiden käyttäjille. Uudelleenjuoksutettavaa
muotoa kannattaa käyttää myös silloin, jos haluat antaa mahdollisuuden kirjasin- ja tekstikoon muuttamiseen lukuohjelmassa.

Voit viedä julkaisut kiinteään asetteluun perustuvassa muodossa. Kiinteään asetteluun perustuvaa muotoa käytettäessä voit lisätä julkaisuihin
ääntä, videoita ja Edge-sisältöjä.

Voit viedä kiinteään asetteluun perustuvaan muotoon myös vuorovaikutteisia julkaisuja, joissa on erilaisia säätimiä, kuten navigointipainikkeita,
sivusiirtymiä, animaatioita ja hyperlinkkejä.

Kiinteään asetteluun perustuva muoto sopii paremmin julkaisuihin, joissa on paljon grafiikka-, ääni- ja videosisältöä. Tämä muoto sopii paremmin
lastenkirjoihin, keittokirjoihin, tekstikirjoihin ja sarjakuviin.

Tekstin tuki

Kiinteään asetteluun perustuvaan muotoon vietäviä julkaisuja luotaessa tuetaan seuraavia tekstivaihtoehtoja:

Tekstiä ei rasteroida. Tämä tarkoittaa, että elävä teksti on haettavissa ja valittavissa.

Elävää tekstiä voidaan skaalata pysty- ja vaakasuunnassa.

Täytemerkkejä voidaan käyttää.

Kielimääritteet on merkitty nimiöihin.

Nimiöihin on merkitty CSS-luokat.

Tekstissä olevat hyperlinkit ja ristiviittaukset URL-osoitteisiin, tekstiankkureihin ja sivuihin ovat tuettuja.

Ota myös seuraavat rajoitukset huomioon, kun lisäät tekstiä EPUB-muodossa vietäviin julkaisuihin:

Kirjainparivälistystä ei tueta yksittäisissä merkeissä, sen sijaan sanan kaikkien kirjainten välillä käytetään merkkien välistystä.

OpenType-toiminnolla luotuja vaihtoehtoisia merkkejä, kuten kapiteeleja, kokonaan isojen kirjainten käyttöä ja murtolukuja, ei tueta laitteiden rajoitetun tuen vuoksi.

Lähi-idän oikealta vasemmalle luettavia tekstikehyksiä ei vieläkään tueta oikein.

830



Alkuun

Alkuun

NAV-maamerkit

EPUB 2

NAV-sivuluettelo

Alkuun

Alkuun

Japaninkielisen tekstin tuki

Sisältöä kiinteään asetteluun perustuvassa muodossa vietäessä käytettävissä ovat seuraavat japanilaiset toiminnot:

Ruby-teksti on elävää, eikä sitä rasteroida tulosteessa.
Warichua tuetaan elävässä tekstissä.
Merkkien kiertoa tuetaan elävässä tekstissä.
Yhdistelmäkirjasimet ovat tuettuja
Pystysuuntaiset tekstikehykset, myös kierretyt merkit, ovat tuettuja.

Ota seuraavat rajoitukset huomioon, kun lisäät japaninkielistä tekstiä EPUB-muodossa vietäviin julkaisuihin:

Japanilaista Tate-Chu-Yokoa ei tueta pystysuuntaisissa tekstikehyksissä.

Japanilaisten ideografisten merkkien paikka muuttuu TrueType-kirjasimia käytettäessä.

Japanilainen Kenten-kirjasin rasteroidaan elävässä tekstissä.

Hyperlinkkien tuki

Kiinteään asetteluun perustuvaan muotoon vietäviä julkaisuja luotaessa tuetaan seuraavia hyperlinkkivaihtoehtoja:

Tekstipohjaiset hyperlinkit ja ristiviittaukset

Objektipohjaiset hyperlinkit

Hyperlinkit Pagesiin sekä teksti- että objektipohjaisia hyperlinkkejä käytettäessä

Navigoinnin tuki

Vientiprosessissa voidaan hyödyntää seuraavia EPUB-julkaisujen navigointitoimintoja:

NAV-maamerkit luodaan sekä kiinteään asetteluun perustuvia että uudelleenjuoksutettavia muotoja varten Objektin
vientiasetukset -valintaikkunassa määritetyn epub:type-parametrin arvojen perusteella.

Maamerkkeihin lisätään vain arvon ensimmäinen esiintymä.

InDesign tukee OPF-tiedoston EPUB 2 -osaa. InDesign tunnistaa automaattisesti kannen ja Tulosta sisällysluettelo -toiminnon.
InDesign käyttää tekstityypin määrittämiseen Objektin vientiasetukset -valintaikkunassa määritettyjä epub:type-parametrin arvoja.

(kiinteään asetteluun perustuva muoto). InDesign luo sivuluettelon liittämällä sivunumeromerkkijonot kyseisestä sivusta luotuihin
XHTML-tiedostoihin.

Kirjan CSS-tiedoston luominen

Kun viet kirjan EPUB-muodossa, vientiprosessi luo CSS-tiedoston kirjan jokaisesta julkaisusta. Jokaisen julkaisun CSS-tiedostossa on määritetty
julkaisun yksilölliset tyylit. Prosessi luo myös CSS-perustyylitiedoston, joka sisältää kirjan julkaisuissa käytettävät yleiset tyylit.

Vieminen EPUB-muotoon
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Alkuun

Versio

EPUB 3.0

Kansi

Ei mikään

Rasteroi ensimmäinen sivu

Valitse kuva

Siirtymisen sisällysluettelo

Tiedostonimi

Monitasoinen (sisällysluettelon tyyli)

Voit viedä julkaisun tai kirjan uudelleenjuoksutettavassa tai kiinteään asetteluun perustuvassa EPUB-muodossa.

1. Tee jokin seuraavista:

Avaa julkaisu ja valitse Tiedosto > Vie.

Avaa kirja ja valitse Kirja-paneelivalikosta Vie kirja EPUBiin.

2. Määritä tiedoston nimi ja sijainti.

3. Valitse Tallennusmuoto-luettelosta EPUB (kiinteä asettelu) tai EPUB (uudelleenjuoksutettava) ja sitten Tallenna.

4. Määritä haluamasi asetukset EPUB-vientiasetukset-valintaikkunassa ja valitse OK.

Lisätietoja on artikkelissa Kiinteän asettelun vientiasetukset tai Uudelleenjuoksutettavan asettelun vientiasetukset.

InDesign luo yhden .epub-tiedoston, joka sisältää XHTML-sisällön. Tiedoston katselemista varten tarvitset EPUB-lukuohjelmiston. Voit myös
käyttää Adobe Digital Editions -lukuohjelmistoa, jonka voit ladata ilmaiseksi Adoben sivustosta.

.epub-tiedosto on .zip-tiedosto. Voit tarkastella ja muokata .EPUB-tiedoston sisältöä vaihtamalla tiedostotunnisteeksi .zip ja purkamalla sisällön.
Tämä on kätevää esimerkiksi CSS-tiedoston muokkaamista varten.

Vietävä .epub-tiedosto voi sisältää kansikuvan. Voit valita kantena käytettävän kuvan. Voit myös antaa InDesignin rasteroida viedyn julkaisun
ensimmäisen sivun, tyylilähdejulkaisun tai viedyn kirjan. Pienoiskuva näytetään EPUB-lukuohjelmistoissa tai Digital Editions Reader -
kirjastonäkymässä.

Kiinteän asettelun vientiasetukset

Yleinen osa

EPUB-versio. 

Tukee ääntä, videota, Javascriptiä ja japaninkielistä pystysuuntaista tekstiä.
Sitä ei kuitenkaan tueta laitteissa, jotka eivät tue EPUB 3.0 -standardia.
EPUB 3.0 on hyväksytty standardi (IDPF, 2011).

eKirjan kansikuva. Valitse yksi seuraavista:

Kansikuvaa ei lisätä.

Valitse tämä asetus, jos haluat antaa InDesignin luoda kuva rasteroimalla eKirjan ensimmäinen sivu ja
käyttämällä sitä kantena.

Valitse kantena käytettävä kuvatiedosto tietokoneesta.

Määritä navigointiasetus EPUB-katseluohjelman sisällysluetteloa varten.
Luo navigoinnin sivupalkki monitasoisen sisällysluettelon tyylin avulla tai käytä tiedostonimeä.

Luo tiedostonimiin perustuva sisällysluettelo.

Luo valittuun sisällysluettelon tyyliin perustuva sisällysluettelo.
Määritä Sisällysluettelon tyyli -valikossa eKirjan sisällysluettelon luontiin käytettävä sisällysluettelon tyyli.
Voit luoda eKirjalle yksilöllisen sisällysluettelon tyylin valitsemalla Sivuasettelu > Sisällysluettelon tyylit.
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Kirjanmerkit

Asetukset

Asiakirjan määrittelyn mukaan

Muunna aukeama vaakasivuksi

Ota synteettiset aukeamat käyttöön

Poista aukeamat käytöstä

Muoto

Automaattinen

PNG

Tarkkuus (PPI)

GIF-asetukset (paletti)

Sovitettu (ei sirontaa)

Web

Järjestelmä (Win) tai Järjestelmä (Mac)

Lomita

JPEG-asetukset > Muotoilumenetelmä

Etenevä

(EPUB 3) Luo sisällysluettelo InDesign-julkaisussa luotujen kirjanmerkkien perusteella.
InDesign tukee paikallisia tai ulkoisia tekstiankkureita ja sivuja (eKirjasta). Jälkimmäinen voidaan luoda luomalla sisällysluettelo
InDesignissa ja määrittämällä Luo PDF-kirjanmerkit -asetus.
Lisätietoja on artikkelissa Kirjanmerkit.

Määritä sivuelementtien vientijärjestys.

InDesign määrittää aukeaman hallinnan Asiakirjan määrittely -valintaikkunassa (Tiedosto > Asiakirjan
määrittely) määritettyjen asetusten perusteella.

Muuntaa aukeaman vaakasuuntaiseksi.

Ota synteettiset aukeamat vietävässä julkaisussa käyttöön.

Yhtäkään aukeamaa ei viedä EPUB-muodossa.

Muunnosasetukset-osa

Määritä Kuvien muuntaminen -valikossa, miten kuvat viedään EPUB-muotoon.

Valitse, muunnetaanko julkaisussa olevat optimoidut kuvat GIF-, JPEG- tai PNG-muotoon.

Anna InDesignin päättää, mitä muotoa kussakin tapauksessa käytetään.

Poista kuvien pakkausasetukset käytöstä. Käytä PNG-asetusta häviöttömiin tai läpinäkyviin kuviin.

Valitse kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi, mobiililaitteissa
tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). 
Voit valita kullekin valitulle objektille ppi-arvon. Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.

Luo paletti käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla.

Luo paletti verkkokäyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -järjestelmävärien osajoukko.

Luo paletti käyttämällä järjestelmän omaa väripalettia. Tämä asetus voi aiheuttaa
odottamattomia tuloksia.

Lataa kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta ja
selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määritä, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
selaimessa.

Anna JPEG-kuvien avautua vähitellen ja tarkentua verkkoselaimen ladatessa niitä.
Tällä asetuksella luodut tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.
Valitse Peruslinja, jos haluat kunkin JPEG-tiedoston tulevan näyttöön vasta silloin, kun se on ladattu. Näytössä näkyy paikkamerkki,
kunnes kuva on ladattu.
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Peruslinja

JPEG-asetukset > Kuvan laatu

Näytä EPUB viennin jälkeen

Tunniste

Otsikko

Tekijä

Päiväys

Kuvaus

Julkaisija

Tuo kukin JPEG-tiedosto näyttöön vasta silloin, kun se on ladattu.
Näytössä näkyy paikkamerkki, kunnes kuva on ladattu.

Valitse tulosteen kunkin JPEG-kuvan toivottu kuvan laatu.
Valitse Matala, jos haluat tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.

EPUB – Kiinteän asettelun vientiasetukset -valintaikkunan Katselusovellukset-valintaikkuna sisältää seuraavat asetukset:

EPUB avautuu EPUB-tiedostojen lukemiseen valitussa oletussovelluksessa, jos sellainen on käytettävissä.
Koskee sekä Uudelleenjuoksutettavan asettelun vientiasetukset- että Kiinteän asettelun vientiasetukset -valintaikkunaa.

Metatiedot-osa

Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon.

(Vain luku) Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Ohjelmisto luo ja näyttää automaattisesti ainutkertaisen
tunnisteen.

Anna EPUB-tiedoston nimi.

Anna EPUB-tiedoston tekijän nimi.

Määritä EPUB-tiedoston luontipäivä.

Anna EPUB-tiedoston kuvaus.

Määritä tässä eKirjan metatietoihin sisällytettävät julkaisijatiedot. Voit esimerkiksi määrittää julkaisijan URL-osoitteen.

EPUB-sovellus  Versio  Tuettu Ei tuettu

Mac

Apple iBooks 1.0.1 Kyllä  

Oxygen 14.1 Kyllä  

Kindle Previewer 2.92 Kyllä  

Sigil 0.7.4 Kyllä  

Kindle 1.10.6  Ei

VitalSource Bookshelf 6.2  Ei

Apple Book Proofer 1.0.1 Ei tue upotettuja kirjasimia sisältäviä EPUB-julkaisuja.

Windows

Sigil 0.7.4 Kyllä  

Kindle Previewer 2.92 Kyllä  

Adobe Digital Editions 3.0.86137 Kyllä  

Calibre 1.26 Kyllä  

Oxygen 15 Kyllä  

Azardi 2.0 Kyllä  

Kobo 3.6.0  Ei
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Oikeudet

Aihe

Lisää tyyliarkki

Poista

JavaScript

Alkuun

Versio

EPUB 2.0.1

EPUB 3.0

Kansi

Ei mikään

Rasteroi ensimmäinen sivu

Valitse kuva

Siirtymisen sisällysluettelo

Tiedostonimi

Monitasoinen (sisällysluettelon tyyli)

Järjestys

Sivuasettelun perusteella

Kirjoita tekijänoikeustiedot tänne.

Anna EPUB-tiedoston aihe.

CSS-osa

Määritä EPUB-julkaisun viennissä käytettävän, olemassa olevan CSS-tyyliarkin URL-osoite.
InDesign ei tarkista, onko CSS olemassa tai kelvollinen. Dreamweaverin avulla voit vahvistaa ulkoisen CSS-tyyliarkin määritykset.

Poista valittu tyyliarkki

Javascript-osa

Määritä olemassa olevan JavaScriptin URL-osoite. InDesign ei tarkista, onko JavaScript olemassa tai kelvollinen, joten vahvista
ulkoisen JavaScriptin asetukset.

Uudelleenjuoksutettavan asettelun vientiasetukset

Yleinen osa

Määritä EPUB-versio. 

EPUB 2.0.1 on IDPF:n standardi (hyväksytty vuonna 2007). Tätä muotoa tuetaan erilaisissa mobiililaitteissa.

EPUB 3.0 on IDPF:n standardi (hyväksytty vuonna 2011). Tämä muoto tukee myös ääntä, videota, Javascriptiä ja
japaninkielistä pystysuuntaista tekstiä. Se ei kuitenkaan toimi lukuohjelmissa ja laitteissa, jotka eivät tue EPUB 3.0 -standardia.

Määrittää eKirjan kansikuvan. Valitse yksi seuraavista:

Kansikuvaa ei lisätä.

Valitse tämä asetus, jos haluat antaa InDesignin luoda kuva rasteroimalla eKirjan ensimmäinen sivu ja
käyttämällä sitä kantena.

Valitse kantena käytettävä kuvatiedosto tietokoneesta.

Määritä navigointiasetus EPUB-katseluohjelman sisällysluetteloa varten.
Luo navigoinnin sivupalkki monitasoisen sisällysluettelon tyylin avulla tai käytä tiedostonimeä.

Luo tiedostonimiin perustuva sisällysluettelo.

Luo valittuun sisällysluettelon tyyliin perustuva sisällysluettelo. Määritä Sisällysluettelon tyyli -
valikossa eKirjan sisällysluettelon luontiin käytettävä sisällysluettelon tyyli. Voit luoda eKirjalle yksilöllisen sisällysluettelon tyylin valitsemalla
Sivuasettelu > Sisällysluettelon tyylit.

Määritä sivuelementtien vientijärjestys.

Lukemisjärjestys määräytyy sivulla olevien kohteiden sijainnin perusteella.
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Sama kuin XML-rakenne

Sama kuin artikkelipaneelissa

Alaviitteet

Asetukset > Poista pakotetut rivinvaihdot

Luettelot > Luettelomerkit

Luettelot > Numerot

Osoita järjestettyihin luetteloihin

Muunna tekstiksi

Säilytä sivuasettelun ulkoasu

Muunnosasetukset > Tarkkuus (ppi)

CSS > Asettelu

CSS > Lisää sivunvaihto

Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä
alas. Joissakin tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, muotoiluelementit eivät aina ole halutussa
lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
(Vain aasialaiset versiot) Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen julkaisun sidonnan
mukaan (vasemmalta oikealle tai oikealta vasemmalle). Joissakin tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, viedyt
muotoiluelementit eivät ole halutussa lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.

Lukemisjärjestys määräytyy rakennenäkymässä olevien nimiöiden järjestyksen perusteella. Katso Sivukohteiden
nimiöiminen.

Lukemisjärjestys määräytyy Artikkelit-paneelissa olevien elementtien järjestyksen perusteella. Vain valitut
artikkelit viedään. Katso Artikkeleiden sisällyttäminen vientiä varten.

Teksti-osa

Valitse alaviitteiden paikka seuraavista vaihtoehdoista.
Kappaleen jälkeen: Valitse tämä vaihtoehto, jos haluat sijoittaa alaviitteet kappaleen jälkeen.
Osan lopussa (loppuviitteinä): Valitse tämä vaihtoehto, jos haluat muuntaa alaviitteet loppuviitteiksi.
Ponnahdusikkunassa (EPUB3): Valitse tämä vaihtoehto, jos haluat sijoittaa alaviitteen ponnahdusikkunaan.

Jos lisäät alaviitteen julkaisun alaviitetoiminnolla ja määrität säännön, esimerkiksi paksuudeksi 10 pistettä, tätä vaakasuuntaista sääntöä tuetaan
uudelleenjuoksutettavia EPB-tiedostoja vietäessä.

Poista viedystä eKirjasta kaikki pakotetut rivinvaihdot.

Valitse Osoita järjestämättömiin luetteloihin, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohde-elementeiksi,
jotka muotoillaan HTML-muotoon <ul>-nimiöllä.
Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä. Jos olet käyttänyt InDesignin alkuperäisiä automaattisia
luettelomerkkejä, myös aliluettelomerkit sisällytetään.

Määrittää, kuinka numerot muunnetaan HTML-tiedostossa. Jos olet käyttänyt InDesignin alkuperäistä automaattista
numerointia, myös aliluettelomerkit sisällytetään.

Muunna numeroidut luettelot luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.

Muunna numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

Objekti-osa

Määritä Kuvien muuntaminen -valikossa, kuinka kuvat viedään HTML-muotoon.

Valitse tämä vaihtoehto, jos haluat käyttää sivuasettelussa olevia kuvaobjektien määritteitä.

Valitse kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi,
mobiililaitteissa tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). Voit valita kullekin valitulle objektille
ppi-arvon. Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Määritä kuvan tasaus: vasemmalle, keskelle tai ylös. Voit myös määrittää tasauksen ylös tai alas.

Lisää kuviin sivunvaihtoja. Sivunvaihtoja voidaan lisätä Ennen kuvaa-, Kuvan jälkeen- tai Ennen kuvaa ja kuvan jälkeen
-asetusten avulla.
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Muoto

GIF-asetukset (paletti)

Sovitettu (ei sirontaa)

Web

Järjestelmä (Win) tai Järjestelmä (Mac)

Lomita

JPEG-asetukset > Muotoilumenetelmä

Etenevä

Peruslinja

JPEG-asetukset > Kuvan laatu

Ohita objektin vientiasetukset

Tunniste

Otsikko

Tekijä

Päiväys

Kuvaus

Muunnosasetukset -osa

Voit valita, muunnetaanko julkaisun optimoidut kuvat GIF-, JPEG- tai PNG-muotoon. Valitse Automaattinen, jos haluat, että InDesign
päättää, mitä muotoa kussakin tapauksessa käytetään. PNG-asetuksen valinta poistaa kuvien pakkausasetukset käytöstä. Käytä PNG-asetusta
häviöttömiin tai läpinäkyviin kuviin.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.

Luo paletti käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla.

Luo paletti verkkokäyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -järjestelmävärien osajoukko.

Luo paletti käyttämällä järjestelmän omaa väripalettia. Tämä asetus voi aiheuttaa
odottamattomia tuloksia.

Lataa kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta ja
selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määritä, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
selaimessa.

Anna JPEG-kuvien avautua vähitellen ja tarkentua verkkoselaimen ladatessa niitä.
Tällä asetuksella luodut tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.
Valitse Peruslinja, jos haluat kunkin JPEG-tiedoston tulevan näyttöön vasta silloin, kun se on ladattu. Näytössä näkyy paikkamerkki,
kunnes kuva on ladattu.

Tuo kukin JPEG-tiedosto näyttöön vasta silloin, kun se on ladattu.
Näytössä näkyy paikkamerkki, kunnes kuva on ladattu.

Valitse tulosteen kunkin JPEG-kuvan toivottu kuvan laatu.
Valitse Matala, jos haluat tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.

Ohittaa yksittäisiin kuviin käytetyt objektin vientiasetukset. Katso Objektin vientiasetusten käyttäminen.

Metatiedot-osa

Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon. EPUB – Uudelleenjuoksutettavan asettelun
vientiasetukset -valintaikkunan Metatiedot-osa sisältää seuraavat asetukset:

(Vain luku) Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Ohjelmisto luo ja näyttää automaattisesti ainutkertaisen
tunnisteen.

Anna EPUB-tiedoston nimi.

Anna kiinteään asetteluun perustuvan EPUB-tiedoston tekijän nimi.

Määritä EPUB-tiedoston luontipäivä.

Anna EPUB-tiedoston kuvaus.
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Julkaisija

Oikeudet

Aihe

Luo CSS

Säilytä paikalliset ohitukset

Sisällytä upotettavat kirjasimet

Lisää tyyliarkki

JavaScript

Alkuun

Oletus

Käytä graafisissa objekteissa aiemmin luotua kuvaa

Rasteroi säilö

Rasteroi sisältö

Anna julkaisijan tiedot, kuten julkaisijan URL-osoite.

Anna EPUB-tiedoston tekijänoikeustiedot.

Anna EPUB-tiedoston aihe.

CSS-osa

CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun verkkosivulla. Kun käytät sivun
muotoiluun CSS:ää, erotat sisällön esityksestä. EPUB – Uudelleenjuoksutettavan asettelun vientiasetukset -valintaikkunan CSS-osa sisältää
seuraavat asetukset:

Määritä, haluatko InDesignin luovan vientitiedostolle ulkoisen CSS-tyyliarkin. Jos julkaisu/kirja viedään EPUB-muotoon ilman
CSS-tyyliarkin luomista, ainoastaan tyyleihin liitetyt luokat merkitään HTML-nimiöihin. Ohittavia luokkia ei luoda.

Sisällytä paikallinen muotoilu, kuten kursivoitu tai lihavoitu.

Sisällytä kaikki upotettavat kirjasimet eBook-kirjaan. Kirjasimissa on upotusbitit, jotka määrittävät,
voidaanko kirjasin upottaa.

Määritä olemassa olevan CSS-tyyliarkin URL-osoite. InDesign ei tarkista, onko CSS olemassa tai kelvollinen.
Dreamweaverin avulla voit vahvistaa ulkoisen CSS-tyyliarkin määritykset.

JavaScript -osa

Määritä olemassa olevan JavaScriptin URL-osoite. InDesign ei tarkista, onko JavaScript olemassa tai kelvollinen, joten vahvista
ulkoisen JavaScriptin asetukset.

Objektin vientiasetukset

Määritä Objektin vientiasetukset -valintaikkunan asetusten avulla, kuinka julkaisun objekteja käsitellään EPUB-viennin aikana.

1. Avaa Objektin vientiasetukset-valintaikkuna (Objekti > Vientiasetukset) ja siirry EPUB- ja HTML-osaan.

2. Valitse jokin seuraavista Säilytä sivuasettelun ulkoasu -luettelon asetuksista:

Objektin käsittelytapa määräytyy Vie-valintaikkunan asetusten perusteella.
Uudelleenjuoksutettavan muodon tapauksessa tätä hallitaan Muunnos-välilehden asetuksilla.

Jos objekti sisältää kuvan ja EPUB-vienti tukee kuvaa (JPG, PNG, GIF), säilön tyyli
määritetään CSS-tiedoston perusteella, eikä kuvaa käsitellä.

Tämä toiminto vastaa Uudelleenjuoksutettavan asettelun vienti/muunnos -osan Säilytä sivuasettelun ulkoasu -toimintoa.
Koko objekti rasteroidaan, joten sen ulkoasu säilyy.
Jos objekti on tekstikehys, teksti ei enää ole elävä.

Objektin sisältö rasteroidaan, joten objektin tai säilön tyyliä ei enää hallita CSS-tyyliarkilla, eikä objekti ehkä näy kokonaan
samalla tavalla kuin InDesignissa.

3. (Uudelleenjuoksutettava EPUB) Valitse jokin seuraavista Koko-luettelon asetuksista, jos haluat säilyttää sisäistä kiinteää sisältöä sisältämättömän objektin, kuten

kuvan, kuvasuhteen:
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Ei mikään

Oletus

Kiinteä

Suhteessa tekstijuoksutukseen

Suhteessa tekstin kokoon

Mukautettu leveys/korkeus

Huomautus:

Huomautus:

Alkuun

Objektin perusteella määritetylle nimiölle ei luoda CSS-tiedoston mukaista leveyttä tai korkeutta. Objektin koko määräytyy
sisäisen sisällön perusteella CSS-sääntöjen mukaan, kuvasuhdetta ei säilytetä.

CSS-tiedoston koko määräytyy Vie-valintaikkunan Objekti-välilehden asetusten perusteella.

CSS-tiedoston koko määritetään laskemalla objektin koko pisteinä ja antamalla samat mitat CSS-tiedostossa kuvapisteinä. Objektin
kuvasuhde säilytetään.

CSS-tiedoston leveys määritetään mittaamalla objektin leveys ja ilmaisemalla se prosentteina suhteessa
tekstijuoksutuksen sisältävän tekstikehyksen leveyteen. Objektin kuvasuhde säilytetään.

CSS-tiedoston korkeus määritetään mittaamalla objektin korkeus pisteinä ja muuntamalla se em-väliksi
kertoimella 12 pistettä / em-väli. Objektin kuvasuhde säilytetään.

Kelvollisia CSS-yksiköitä ovat cm, mm, in, pt, %, px, vh, vw, vmin ja vmax. Objektin kuvasuhde säilytetään.

Nämä asetukset eivät koske pääjuoksutuksen tekstikehyksiä.

Edge Animaten sisältävät objektit eivät tue suhteellisia mittoja.

EPUB-resurssit

Seuraavia linkkejä napsauttamalla voit perehtyä EPUB-muotoon.

Lisätietoja EPUB-määrityksestä on sivustossa www.idpf.org.

Lataa ilmainen Digital Editions -lukuohjelmisto osoitteesta www.adobe.com/fi/products/digital-editions.html.

Lisätietoja Digital Editionsista löytyy Digital Editions -blogista.

Lisätietoja viennistä Kindleen on julkaisussa InDesignista Kindleen (PDF).

Opi muuntamaan InDesign-tiedostot EPUB-muotoon ja aloita Apple iPadilla katseltavissa olevien sähköisten kirjojesi myynti. Lisätietoa on white paper -julkaisussa.

Perehdy White paper -julkaisuun InDesignista iPadiin.
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Joustavat sivuasettelut ja vaihtoehtoiset sivuasettelut | CC, CS6

Huomautus:

Alkuun

Alkuun

Käsiteltävät aiheet
Suositeltu työnkulku
Joustavat sivuasettelut

Joustavat sivusäännöt
Vaihtoehtoiset sivuasettelut

Vaihtoehtoisten sivuasetteluiden luominen

Vaihtoehtoisten sivuasettelujen ja joustavien sivuasettelujen sivusääntöjen avulla voidaan tehokkaasti suunnitella useita sivukokoja, sivun suuntia
tai sivusuhteita.

Kun halutaan julkaista useisiin muotoihin ja kokoihin, voidaan valita kuhunkin projektiin parhaiten sopiva suunnittelustrategia: käsityö,
puoliautomaattisuus tai täysi automaattisuus. Oma suunnittelun hallinta vähenee käytettäessä automaattisia työnkulkuja. InDesign sisältää useita
parannuksia kustannusten ja hallinnan tasapainottamiseen.

Automaattinen joustaviin sivuasetteluihin perustuva julkaiseminen ei ole vielä mahdollista, koska sopivia katselutekniikoita ei ole vielä
käytettävissä. 

Suositeltu työnkulku

 
A. Vaihtoehtoisen sivuasettelun työnkulku B. Vaihtoehtoiset sivuasettelut ja joustavat sivusäännöt 

VAIHE 1: Valitse kohdelaite ja sen vastaava mitta ja suunta. Luo sitten ensisijainen sivuasettelu kaikkia sivuja varten.

VAIHE 2: Toinen vaihtoehto on lisätä Adoben joustavien sivupohjien sivusäännöt, jotka helpottavat sisällön sovittamista eri sivusuhteisiin ja
kokoihin. Joustavista sivusäännöistä on hyötyä, jos teet sisältöä useille erilaisille laitteille. Ellet käytä joustavia sivusääntöjä, joudut manuaalisesti
luomaan eri sivuasettelun jokaiselle mahdolliselle koolle ja suunnalle. Katso Joustavat sivuasettelut.

VAIHE 3: Luo julkaisuun uusia sivuja Luo vaihtoehtoinen sivuasettelu -toiminnon avulla. Sivuasettelua on ehkä hienosäädettävä manuaalisesti
ensisijaisen sivuasettelun ja joustavien sivusääntöjen mukaan. Toista tämä vaihe jokaiselle uudelle koolle ja suunnalle. Katso Vaihtoehtoiset
sivuasettelut.

Joustavat sivuasettelut
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Skaalaa

 
Joustavat sivuasettelut

Joustavat sivuasettelut helpottavat sisällön suunnittelua useita sivukokoja, suuntia tai laitteita varten. Käyttämällä joustavia sivusääntöjä voit
määrittää, miten sivulla olevia objekteja mukautetaan, kun luot vaihtoehtoisia sivuasetteluja ja muutat kokoa, suuntaa tai sivusuhteita.

Voit käyttää eri sivuille eri sääntöjä sivuasettelun ja tavoitteiden mukaan. Sivulla voidaan käyttää kerralla vain yhtä joustavaa sivusääntöä.
Joustava sivuasettelu on yleinen termi, joka kattaa joustavien sivusääntöjen sarjan: skaalaus-, uudelleenkeskitys-, apuviivapohjaiset ja
objektipohjaiset säännöt.

Joustavien sivusääntöjen avulla sisältö voidaan sovittaa tulostuskokoja varten.

Voit sovittaa sivuasettelut luodessasi julkaisuun uusia sivuja vaihtoehtoisten sivuasettelujen avulla.
Voit sovittaa sivuasettelut tehdessäsi muutoksia olemassa oleviin sivukokoihin. Tämä on tehokkaampi menetelmä kuin aiempi Sivuasettelun
säätö -toiminto.

Voit käyttää joustavaa sivusääntöä valitsemalla Sivu-työkalun  ja napsauttamalla sivua. Valitse sen jälkeen joustava sivusääntö säätöpalkista.
Toinen vaihtoehto on valita Sivuasettelu > Joustavat sivuasettelut.

Jos haluat esikatsella käytetyn säännön vaikutuksia, muuta sivun kokoa vetämällä sivun kulmia Sivu-työkalun avulla. Sivu palautuu takaisin
alkuperäiseen kokoonsa, kun vapautat hiiren.

Jos haluat muuttaa sivun kokoa, paina Alt-näppäintä (Windows) tai optionäppäintä (Mac OS) ja vedä. Sivun koon muuttaminen hiirellä on
kuitenkin tapa, jolla sivuista voi tulla hieman eri kokoisia kuin on tarkoitettu. Tarkempi tapa on muuttaa sivun kokoa säätöpalkin korkeus- ja
leveysasetusten avulla.

 
Joustavat sivusäännöt 
A. Sivu-työkalu B. Joustavat sivusäännöt säätöpalkin kautta C. Sivun kulmat D. Nastat objektipohjaisia sääntöjä varten E. Joustavan sivuasettelun
paneeli 

Joustavat sivusäännöt
Voit käyttää eri sivuilla eri sääntöjä. Sivulla voidaan käyttää kerralla vain yhtä joustavaa sivusääntöä.

Katso tämä video ja ota selvää, miten voit käyttää Ei mitään-, Skaalaa- ja Keskitä-sääntöjä sivuasettelun kokoa muutettaessa. Selvitä myös, mitä
”sivupohjan perusteella” tarkoittaa. Perustason joustavien sivuasettelusääntöjen käyttäminen: Skaalaa, Keskitä ja Sivupohjan perusteella.

Kaikkea sivun sisältöä käsitellään ryhmänä. Kun sivun koko muuttuu, kaikkien elementtien kokoa muutetaan samassa suhteessa. Tämä
vastaa mustien palkkien näyttämistä HD-televisioruudun reunoissa.
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Keskitä uudelleen

Apuviivapohjainen

 
Joustavat sivusäännöt: skaalaus

Kaikki sivun sisältö keskitetään automaattisesti leveydestä riippumatta. Toisin kuin skaalauksessa, sisältö pysyy
alkuperäisessä koossaan. Saat saman tuloksen kuin videotuotannon turva-alueilla, kun suunnittelet uudelleenkeskityssäännön käytön huolellisesti
ja käytät sivuasettelua.

 
Joustavat sivusäännöt: keskitä uudelleen

Apuviivat muodostavat suoran linjan sivun poikki ja osoittavat alueen, jonne sisältö voidaan sovittaa.
Tyhjän tilan lisääminen on mahdollista.
Tekstikehysten koko muutetaan ja teksti juoksutetaan uudelleen (mutta skaalausta ei tehdä).
Sijoitettujen kuvakehysten koko muutetaan, samoin niitä ympäröivän kehyksen rajausreunojen mitat.

Jos haluat lisätä joustavan apuviivan, valitse ensin Sivu-työkalu ja vedä apuviivat ulos viivaimesta.
Apuviivapohjaiset säännöt vastaavat 3- ja 9-osaista skaalausta Illustratorissa, Fireworksissa ja Flashissa. Katso tämä video, jonka aiheena
on Apuviivapohjaisten joustavien sivuasettelusääntöjen käyttäminen.

Jos haluat muuntaa viivainlinjan joustavaksi apuviivaksi, valitse Sivu-työkalu ja napsauta Muunna joustavaksi apuviivaksi -kuvaketta apuviivan
kohdalla. Joustava apuviiva näkyy katkoviivana, kun taas viivainlinja on yhtenäinen viiva.

 
Joustavat sivusäännöt: apuviivapohjainen
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Objektipohjainen

Alkuun

Voit määrittää joustavan käyttäytymisen (kiinteä tai suhteellinen) kunkin objektin koolle ja sijainnille suhteessa sivun reunaan.
Objektin muokkausalueen tai kehyksen kukin reuna voi olla määritelty kiinteästi tai suhteessa sivun reunaan. Esimerkiksi kehyksen
vasemmalle reunalle voidaan haluttaessa määritellä suhde vain sivun vasempaan reunaan.
Korkeus ja leveys voivat olla kiinteitä tai sivun koon mukaan mukautuvia. 

Katso tämä video, jonka aiheena on Objektipohjaisten joustavien sivuasettelusääntöjen käyttäminen.

 
Joustavat sivusäännöt: objektipohjainen

Vaihtoehtoiset sivuasettelut
Käytä vaihtoehtoisia sivuasetteluita, jos tarvitset painotuote- tai digitaalijulkaisuissa eri sivukokoja saman julkaisun sisällä. Vaihtoehtoisten
sivuasettelujen avulla painettavasta mainoksesta voidaan luoda useita eri kokoja. Niitä voidaan käyttää myös esimerkiksi Apple iPad- tai Android-
tablet-laitteiden vaaka- tai pystyasettelujen suunnitteluun.

 
Vaihtoehtoiset sivuasettelut ja Sivut-paneeli

Joustavan sivuasettelun avulla voit merkittävästi vähentää sisällön uudelleenasetteluun liittyvää manuaalista työtä uusia sivukokoja ja suuntia
käytettäessä.

Jos haluat lyhyen yleiskatsauksen, katso Lynda.comin Vaihtoehtoiset sivuasettelut -video.

Vaihtoehtoisten sivuasetteluiden luominen
Vaihtoehtoinen sivuasettelu voidaan luoda seuraavilla tavoilla:

Valitse Sivuasettelu > Luo vaihtoehtoinen sivuasettelu
Valitse Sivut-paneelivalikosta Luo vaihtoehtoinen sivuasettelu
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  Creative Commons -lisenssien ehdot eivät koske Twitter™- ja Facebook-viestejä.

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma

Nimi

Lähdesivuilta

Sivukoko

Leveys ja korkeus

Suunta

Joustava sivusääntö

Linkitä jutut

Kopioi tekstityylit uuteen tyyliryhmään

Älykäs tekstin sijoittelu

 
Vaihtoehtoisten sivuasetteluiden luominen

Määritä Luo vaihtoehtoisia sivuasetteluita -valintaikkunassa seuraavat asetukset:

Anna vaihtoehtoiselle sivuasettelulle nimi.

Valitse lähteenä käytettävä sivuasettelu, joka sisältää haluamasi sisällöt.

Valitse sivukoko tai anna vaihtoehtoiselle sivuasettelulle haluamasi koko.

Nämä kentät näyttävät vaihtoehtoisen sivuasettelun koon. Voit muuttaa arvot, mutta silloin sivun koko muuttuu mukautetuksi.

Valitse vaihtoehtoiselle sivuasettelulle suunta. Jos siirryt pysty- ja vaakasuunnan välillä, korkeus ja leveys päivitetään.

Valitse vaihtoehtoiseen sivuasetteluun käytettävä joustava sivusääntö. Valitse Säilytä nykyinen, jos haluat käyttää
lähdesivuihin käytettyjä joustavia sivusääntöjä. Valitse toinen sääntö, jos haluat käyttää uusia joustavia sivusääntöjä.

Ota tämä asetus käyttöön, jos haluat sijoittaa objekteja ja linkittää ne lähteenä käytettävän sivuasettelun alkuperäisiin objekteihin.
Kun päivität alkuperäisen objektin, on helpompi hallita linkitettyjen objektien päivityksiä. Katso Linkitetty sisältö.

Ota tämä asetus käyttöön, jos haluat kopioida kaikki tekstityylit ja tehdä niistä uuden ryhmän. Asetus on
hyödyllinen myös silloin, jos on tarve tehdä eri sivuasetteluille erilaisia tekstityylejä.

Ota tämä asetus käyttöön, jos haluat poistaa tekstin pakotetut rivinvaihdot ja muut tyylien ohitukset.  
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Digital Publishing Suite -yleiskatsaus

  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Alkuun

Overlay Creator

Folio Builder

Digital Publishing Suite -yleiskatsaus

Digital Publishing Suite -yleiskatsaus

Adobe Digital Publishing Suite on kokoelma työkaluja ja ylläpidettyjä palveluja, joiden avulla voidaan luoda ja jakaa julkaisuja tablettilaitteisiin,
kuten Apple iPadiin. Näitä digitaalisia julkaisuja kutsutaan folioiksi.

InDesignin avulla voit luoda folioida ja esikatsella niitä tablettilaitteessa ja työpöydän esikatselutoiminnossa. Mukautetun katselutoiminnon luominen
edellyttää rekisteröitymistä Digital Publishing Suiteen. Julkaisijat voivat jakaa digitaalisia julkaisujaan lähettämällä ne Apple Storeen tai Android
Marketiin. Voit tuoda foliot saataville julkaisijalle, joka on rekisteröitynyt Digital Publishing Suiteen.

Folio Builder- ja Overlay Creator -paneelien avulla voit luoda digitaalisia julkaisuja tablettilaitteille.

Voit avata paneelit seuraavasti:

Valitse Ikkuna > Laajennukset > Overlay Creator.

Valitse Ikkuna > Laajennukset > Folio Builder.

Lisätietoja tablettilaitteiden digitaalisten julkaisujen luomisesta on sivulla www.adobe.com/go/learn_dps_help_fi.
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Artikkelit (CS 5.5)

Alkuun

Huomautus:

Alkuun

Alkuun

Johdanto artikkeleihin
Artikkelin luominen ja sisällön lisääminen siihen
Julkaisun kaikkien sivukohteiden lisääminen artikkeliin
Artikkeleiden hallinta
Artikkeleiden sisällyttäminen vientiä varten

Johdanto artikkeleihin

Artikkelit tarjoavat helpon tavan luoda sivukohteiden välisiä suhteita. Näiden suhteiden avulla voidaan määrittää EPUB- ja HTML-muotoon tai
helppokäyttöisiin PDF-tiedostoihin vietävä sisältö ja sisällön järjestys. Voit luoda artikkeleita sivuasettelussa olevista sivukohteista, kuten kuvista,
grafiikasta tai tekstistä. Artikkelin luonnin jälkeen sivukohteita voidaan lisätä, poistaa tai järjestellä. Artikkeleita voidaan luoda manuaalisesti
vetämällä yksi tai useampi sivukohde Artikkelit-paneelissa olevaan artikkeliin.

Voit myös lisätä sisältöjoukon artikkeliin. Artikkeliin voidaan lisätä valikoitua sisältöä tai dokumentin koko sisältö.

XML-rakennepaneeli sisältää toisen mekanismin EPUB- ja HTML-muotoisiin tai helppokäyttöisiin PDF-tiedostoihin vietävän sisällön
järjestyksen määrittämiseen. Artikkelit-paneeli on suunniteltu XML:ään perehtymättömiä käyttäjiä ajatellen entistä yksinkertaisemmaksi,
helppokäyttöisemmäksi ja helppopääsyisemmäksi. XML-rakennepaneelin käyttömahdollisuutta ei ole poistettu, mutta se on nyt valinnainen toiminto,
kuten artikkelipaneelin käyttö vientiprosessin aikana. Katso Julkaisun jäsenteleminen XML-muotoon.

Artikkelin luominen ja sisällön lisääminen siihen

1. Avaa Artikkelit-paneeli valitsemalla Ikkuna > Artikkelit.

2. Valitse artikkeliin lisättävät sivukohteet.

Jos haluat luoda tyhjän artikkelin, älä valitse sivuasettelusta sivukohdetta.

3. Tee jokin seuraavista:

Valitse Artikkelit-paneelin valikosta Uusi artikkeli.

Napsauta Artikkelit-paneelin alaosassa Luo uusi artikkeli -painiketta.

Vedä juttu tai sivuelementti Artikkelit-paneeliin.

4. Kirjoita Uusi Artikkeli -valintaikkunaan artikkelin nimi.

5. Valitse Sisällytä vietäessä, jos haluat lisätä artikkelin EPUB/HTML-vientitiedostoon.

Julkaisun kaikkien sivukohteiden lisääminen artikkeliin

Lisää kaikki sivukohteet artikkeliin seuraavasti:

1. Avaa Artikkelit-paneeli valitsemalla Ikkuna > Artikkelit.

2. Valitse artikkeli, johon haluat lisätä kohteet. Jos et valitse artikkelia, luodaan uusi artikkeli.

3. Paina Command (Mac OS) tai Ctrl (Windows) ja valitse sitten Artikkelit-paneelista .

4. Jos Uusi Artikkeli -valintaikkuna avautuu, anna artikkelin nimi.

5. Valitse Sisällytä vietäessä, jos haluat lisätä artikkelin EPUB/HTML-vientitiedostoon.

Jos olet valinnut artikkelin, valitse Artikkelit-paneelin valikosta Lisää julkaisun sisältö valittuihin artikkeleihin.
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  Twitter™- ja Facebook-julkaisut eivät kuulu Creative Commons -lisenssien soveltamisalaan.

Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

Alkuun

Alkuun

Artikkeleiden hallinta

Voit hallita artikkeleita Artikkelit-paneelissa. Voit lisätä sivuelementtejä artikkeliin vetämällä ne Artikkelit-paneeliin. Vedä kohteet Artikkelit-paneeliin,
jos haluat muuttaa niiden järjestystä tai siirtää ne yhdestä artikkelista toiseen.

Artikkelit-ponnahdusvalikko sisältää myös sisällön hallintaan tarkoitettuja toimintoja.

Artikkeleiden sisällyttäminen vientiä varten

Voit luoda artikkeleita ja valita, mitkä niistä sisällytetään EPUB- tai HTML-muotoon vietäessä. Oletusarvoisesti kaikki artikkelit valitaan vientiä
varten.

Jos haluat sisällyttää artikkelin vientiin, valitse artikkeli Artikkelit-paneelista ja tee jokin seuraavista toimista:

Valitse artikkelin vieressä oleva valintaruutu.

Valitse Artikkelit-paneeliponnahdusvalikosta Artikkelin asetukset ja sitten Sisällytä vietäessä.
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Sisällön vieminen EPUB-muotoon | CS5.5

Huomautus:

Alkuun

Alkuun

Sisällytä dokumentin metatiedot

Lisää julkaisijan kirjaus

Ainutkertainen tunniste

EPUB-kansi

Ei kansikuvaa

EPUB-resurssit
Yleiset EPUB-vientiasetukset
EPUB-kuvien asetukset
EPUB-sisältöasetukset

Voit viedä julkaisun tai kirjan sijoitettavana EPUB-muotoisena eKirjana, joka on yhteensopiva Adobe Digital Editions -lukuohjelmiston ja muiden
eKirjojen lukuohjelmistojen kanssa.

1. Tee jokin seuraavista:

Avaa dokumentti ja valitse Tiedosto > Vie.

Avaa kirja ja valitse Kirja-paneelin valikosta Vie kirja EPUB-muotoon.

2. Määritä tiedoston nimi ja sijainti.

3. Valitse Tallennusmuoto-luettelosta EPUB ja sitten Tallenna.

4. Määritä haluamasi asetukset EPUB-vientiasetukset -valintaikkunan Yleiset-, Kuva- ja Sisältö-kohdissa.

InDesign luo yhden .epub-tiedoston, joka sisältää XHTML-sisällön. Vietävä tiedosto voi sisältää kansikuvan, mikäli se on määritetty. Kansikuva
luodaan kuvasta tai rasteroimalla määritetyn julkaisun ensimmäinen sivu (tai tyylilähdejulkaisu, jos valittiin kirja). EKirja yksilöidään miniatyyrikuvan
avulla EPUB-lukuohjelmistoissa tai Digital Editions Reader -kirjastonäkymässä. Tiedoston katselemista varten tarvitset EPUB-lukuohjelmiston. Voit
myös käyttää Adobe Digital Editions -ohjelmistoa, jonka voi ladata ilmaiseksi Adoben sivustosta.

.epub-tiedosto on käytännössä .zip-tiedosto. Voit tarkastella ja muokata .EPUB-tiedoston sisältöä vaihtamalla tiedostotunnisteeksi .zip ja
purkamalla sisällön. Tämä on erityisen kätevää esimerkiksi CSS-tiedoston muokkaamista varten.

InDesign-objektit, kuten tekstikehykset ja sijoitettuja kuvia sisältävät objektit, viedään aina, kun valitset Sivuasettelun perusteella -
järjestysasetuksen. Tyhjiä objekteja ei viedä, paitsi jos olet määrittänyt InDesign-objektin Objektin vientiasetukset -kohdassa vietäväksi JPEG-,
GIF- tai PNG-muodossa.

EPUB-resurssit
Seuraavia linkkejä napsauttamalla voit perehtyä EPUB-muotoon.

Lisätietoja EPUB-muodosta on sivustossa www.idpf.org.

Lataa ilmainen Digital Editions -lukuohjelmisto osoitteesta www.adobe.com/fi/products/digitaleditions.

Lisätietoja Digital Editionsista löytyy Digital Editions -blogista.

Lisätietoja viennistä Kindleen on julkaisussa InDesignista Kindleen.

Opi muuntamaan InDesign-tiedostot EPUB-muotoon ja aloita Apple iPadilla katseltavissa olevien sähköisten kirjojesi myynti. Lisätietoa on
white paper -julkaisussa. Perehdy White paper -julkaisuun InDesignista iPadiin.

Yleiset EPUB-vientiasetukset
EPUB-vientiasetukset-valintaikkunan Yleiset-osa sisältää seuraavat asetukset.

Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon.

Määritä tässä eKirjan metatietoihin sisällytettävät julkaisijatiedot. Voit määrittää esimerkiksi julkaisijan URL-osoitteen,
jotta eKirjan vastaanottaja voi siirtyä julkaisijan sivustoon ja ostaa eKirjan.

Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Voit määrittää ainutkertaisen tunnisteen määreen. Jos jätät
tämän kentän tyhjäksi, ainutkertainen tunniste luodaan automaattisesti.

Määrittää eKirjan kansikuvan. Valitse yksi seuraavista:

Jos tämä asetus on valittuna, eKirjaan ei lisätä kansikuvaa.
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Rasteroi ensimmäinen sivu

Käytä aiemmin luotua kuvatiedostoa

Tilaaminen

Kirjan reunus

Luettelomerkit

Numerot

Osoita järjestettyyn luetteloon

Osoita kiinteään järjestettyyn luetteloon

Tekstiksi muuntaminen

Näytä EPUB viennin jälkeen

Alkuun

Säilytä sivuasettelun ulkoasu

Tarkkuus (ppi)

Kuvan koko

Kuvan tasaus ja välistys

Lisää sivunvaihto

Asetukset koskevat ankkuroituja objekteja

Kuvan muuntaminen

GIF-asetukset (Paletti)

Jos tämä asetus on valittuna, eKirjan ensimmäinen sivu rasteroidaan ja siitä luodaan kuvatiedosto, jota
käytetään kantena.

Jos tämä asetus on valittuna, voit valita tietokoneesta kuvan, jota käytetään kantena.

antaa sinun määrittää sivuelementtien viestijärjestyksen.
Perusta sivuasetteluun
Lukemisjärjestys määräytyy sivulla olevien kohteiden sijainnin perusteella.
Jos valitset Perusta sivuasetteluun, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä alas.
Muotoiluelementit eivät välttämättä ole kaikissa tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, halutussa lukujärjestyksessä.
Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
(Vain aasialaiset versiot) Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen julkaisun sidonnan mukaan
(vasemmalta oikealle tai oikealta vasemmalle). Viedyt muotoiluelementit eivät välttämättä ole halutussa lukujärjestyksessä kaikissa tapauksissa,
kuten monimutkaisissa monipalstaisissa julkaisuissa. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
Sama kuin XML-rakenne
Lukemisjärjestys määräytyy rakennenäkymässä olevien nimiöiden järjestyksen perusteella. Katso Sivukohteiden nimiöiminen.
Sama kuin artikkelipaneelissa
Lukemisjärjestys määräytyy Artikkelit-paneelissa olevien elementtien järjestyksen perusteella. Vain valitut artikkelit viedään. Katso Artikkeleiden
sisällyttäminen vientiä varten.

Määritä yksinkertainen reunus Ems- tai pikselimuodossa. Reunusten määrittäminen Ems-muodossa takaa yhteensopivuuden
useiden näyttöjen kanssa paremmin. Samaa arvoa käytetään kaikkiin reunuksiin: ylös, alas, vasemmalle ja oikealle.

Valitse Osoita järjestämättömään luetteloon, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohteiksi, jotka muotoillaan
HTML-muotoon <ul>-nimiöllä. Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä. Jos olet käyttänyt InDesignin
alkuperäisiä automaattisia luettelomerkkejä, myös aliluettelomerkit sisällytetään.

Määrittää, kuinka numerot muunnetaan HTML-tiedostossa. Jos olet käyttänyt InDesignin alkuperäistä automaattista numerointia, myös
aliluettelomerkit sisällytetään.

Muuntaa numeroidut luettelot Luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.

Muuntaa numeroidut luettelot Luettelokohteiksi ja liittää <value>-määritteen, joka perustuu
kappaleen nykyiseen numeroon InDesignissa.

Muuntaa numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

Käynnistää Adobe Digital Editions -ohjelmiston, jos se on asennettu.

EPUB-kuvien asetukset
Digital Editions -vientiasetukset -valintaikkunan Kuvat-osa sisältää seuraavat asetukset. Määritä Kuvien muuntaminen -valikossa, kuinka kuvat
viedään HTML-muotoon.

Valitse tämä vaihtoehto, jos haluat käyttää sivuasettelussa olevia kuvaobjektien määritteitä.

Määritä kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi, mobiililaitteissa
tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). Voit määrittää kullekin valitulle objektille ppi-arvon.
Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Määritä, käytetäänkö kiinteää kuvakokoa vai suhteutetaanko se sivukokoon. Sivukokoon suhteutettu asetus määrittää suhteellisen
prosenttiarvon InDesign-sivuleveyteen suhteutetun kuvakoon perusteella. Tätä asetusta käytettäessä kuvat skaalataan suhteessa lukualueen
leveyteen.

Määritä kuvan tasaus, täyttö vasemmalle, keskelle, oikealle, ylös ja alas.

Valitse tämä vaihtoehto, jos haluat lisätä kuviin sivunvaihtoja. Sivunvaihtoja voidaan lisätä ennen kuvaa, kuvan jälkeen tai
ennen kuvaa ja kuvan jälkeen.

Valitse tämä vaihtoehto, jos haluat käyttää näitä asetuksia kaikkien ankkuroitujen objektien kanssa.

Voit valita, muunnetaanko dokumentin optimoidut kuvat GIF-, JPEG- tai PNG-muotoon. Valitse Automaattinen, jos haluat,
että InDesign päättää, mitä muotoa kussakin tapauksessa käytetään. PNG-asetuksen valinta poistaa kuvien pakkausasetukset käytöstä. Käytä
PNG-asetusta häviöttömiin tai läpinäkyviin kuviin.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.
Valitse Sovitettu, jos haluat luoda paletin käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla. Valitse Web, jos haluat muodostaa paletin Web-käyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -
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Laillisuusilmoitukset   |   Online-tietosuojakäytäntö

JPEG-asetukset (kuvan laatu)

JPEG-asetukset (muotoilumenetelmä)

Ohita objektin muunnosasetukset

Alkuun

EPUB-sisällönmuoto

Käytä InDesignin sisällysluettelon tyyliä

Jaottele dokumentti kappaletyylin perusteella

Sijoita alaviite kappaleen jälkeen

Poista pakotetut rivinvaihdot

Luo CSS

Sisällytä tyylimääritykset

Säilytä paikalliset ohitukset

Sisällytä upotettavat kirjasimet

Vain tyylinimet

Käytä aiemmin luotua CSS-tiedostoa

järjestelmävärien osajoukko. Valitse Järjestelmä (Win) tai Järjestelmä (Mac), jos haluat luoda paletin käyttämällä järjestelmän omaa väripalettia.
Tämä valinta voi aiheuttaa odottamattomia tuloksia.
Valitse Lomita, jos haluat ladata kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta
ja selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määrittää kullekin JPEG-kuvalle tilanteeseen parhaiten sopivan pakkauksen (pienemmät tiedostokoot) ja kuvan
laadun. Matala-asetus tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.

Määrittää, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan Web-
sivulla. Valitse Etenevä, jos haluat JPEG-kuvien avautuvan vähitellen ja tarkentuvan Web-selaimen ladatessa niitä. (Tällä asetuksella luodut
tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.) Valitse Perusviiva, jos haluat, että kukin JPEG-tiedosto näkyy
vasta latauksen päätyttyä. Tiedoston paikalla on latauksen aikana paikkamerkki.

Ohittaa yksittäisiin kuviin käytetyt objektin vientiasetukset. Katso Objektin vientiasetusten käyttäminen.

EPUB-sisältöasetukset
EPUB-asetukset-valintaikkunan Sisältö-osa sisältää seuraavat asetukset.

Määritä, haluatko käyttää XHTML- vai DTBook-muotoa. DTBook on erikoismuoto, joka on tarkoitettu näkövammaisille
lukijoille.

Valitse tämä asetus, jos haluat luoda valittuun sisällysluettelon tyyliin perustuvan sisällysluettelon.
Määritä Sisällysluettelon tyyli -luettelossa eKirjan sisällysluettelon luontiin käytettävä sisällysluettelon tyyli. Voit luoda eKirjalle yksilöllisen
sisällysluettelon tyylin valitsemalla Sivuasettelu > Sisällysluettelon tyylit.

Voit jakaa eKirjan määritetyn kappaletyylin perusteella. Jakamisen seurauksena EPUB-paketti
sisältää enemmän HTML-tiedostoja, mutta pitkien tiedostojen jakaminen voi olla hyödyllistä, ja se lisää EPUB-lukuohjelmistojen suorituskykyä.

Valitse tämä vaihtoehto, jos haluat sijoittaa alaviitteet kappaleen jälkeen. Jos valinta poistetaan, alaviitteet
muunnetaan loppuviitteiksi.

Valitse tämä vaihtoehto, jos haluat viedystä eKirjasta kaikki pakotetut rivinvaihdot.

CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun Web-sivulla. Kun käytät
sivun muotoiluun CSS:ää, erotat sisällön esityksestä.

Kun viet EPUB-muodossa, voit luoda muokattavan luettelon CSS-tyyleistä.

Jos tämä asetus on valittu, paikalliset muotoilut, kuten kursiivi ja lihavointi, on sisällytetty.

Sisällytä kaikki upotettavat kirjasimet eBook-kirjaan. Kirjasimiin sisältyy upotusmääritys, joka määrittää,
onko kirjasimen upottaminen sallittu.

Sisällyttää vain määrittämättömät tyylinimet EPUB-tyyliarkkiin.

Määritä olemassa olevan CSS-tyyliarkin URL-osoite (yleensä suhteellinen URL, esimerkiksi
"/tyylit/tyyli.css"). InDesign ei tarkista, onko CSS olemassa tai kelvollinen, joten vahvista ulkoisen CSS:n asetukset.
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Sisällön vieminen EPUB-muotoon | CS6

Alkuun

Alkuun

Huomautus:

Alkuun

Yleistä
Vieminen EPUB-muotoon
EPUB-vientiasetukset

Yleiset EPUB-vientiasetukset
EPUB-kuva-asetukset
EPUB-lisäasetukset

EPUB-resurssit

Yleistä

Ennen sivuasettelun viemistä EPUB-muodossa voit tehdä muutamia säätöjä ja varmistaa, että sivuasettelu viedään oikein.

Ankkuroidun grafiikan lisääminen – Ankkuroi grafiikka tekstityönkulkuihin, niin voit hallita sen paikkaa vietyyn tekstiin nähden. Katso
Ankkuroidut objektit.
Objektien vientiasetukset – Määritä sijoitettujen objektien vientiasetukset. Katso Objektien vientiasetukset.
Tyylien osoittaminen vientinimiöihin – Osoita merkki- ja kappaletyylit HTML-nimiöihin ja -luokkiin. Katso Tyylien osoittaminen
vientinimiöihin.
Sisällön ja järjestyksen valitseminen – Valitse vietävät sisällöt ja niiden järjestys Artikkelit-paneelissa. Katso Artikkelit. Voit järjestää sisällön
myös sivuasettelun tai XML-rakenteen perusteella.

Vieminen EPUB-muotoon

Voit viedä julkaisun tai kirjan sijoitettavana EPUB-muotoisena e-kirjana, joka on yhteensopiva eBook-lukuohjelmiston kanssa.

1. Tee jokin seuraavista:

Avaa dokumentti ja valitse Tiedosto > Vie.

Avaa kirja ja valitse Kirja-paneelin valikosta Vie kirja EPUB-muotoon.

2. Määritä tiedoston nimi ja sijainti.

3. Valitse Tallennusmuoto-luettelosta EPUB ja sitten Tallenna.

4. Määritä haluamasi asetukset EBOOK-vientiasetukset-valintaikkunan Yleiset-, Kuva- ja Lisäasetukset-alueilla.

InDesign luo yhden .epub-tiedoston, joka sisältää XHTML-sisällön. Vietävä tiedosto voi sisältää kansikuvan, mikäli se on määritetty. Kansikuva
luodaan kuvasta tai rasteroimalla määritetyn julkaisun ensimmäinen sivu (tai tyylilähdejulkaisu, jos valittiin kirja). EKirja yksilöidään miniatyyrikuvan
avulla EPUB-lukuohjelmistoissa tai Digital Editions Reader -kirjastonäkymässä. Tiedoston katselemista varten tarvitset EPUB-lukuohjelmiston. Voit
myös käyttää Adobe Digital Editions -ohjelmistoa, jonka voi ladata ilmaiseksi Adoben sivustosta.

.epub-tiedosto on käytännössä .zip-tiedosto. Voit tarkastella ja muokata .EPUB-tiedoston sisältöä vaihtamalla tiedostotunnisteeksi .zip ja
purkamalla sisällön. Tämä on erityisen kätevää esimerkiksi CSS-tiedoston muokkaamista varten.

InDesign-objektit, kuten tekstikehykset ja sijoitettuja kuvia sisältävät objektit, viedään aina, kun valitset Sivuasettelun perusteella -
järjestysasetuksen. Tyhjiä objekteja ei viedä, paitsi jos olet määrittänyt InDesign-objektin Objektin vientiasetukset -kohdassa vietäväksi JPEG-,
GIF- tai PNG-muodossa.

EPUB-vientiasetukset
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Versio

EPUB 2.0.1

EPUB 3.0

EPUB 3.0 sivuasettelulla

Kansi

Ei mikään

Rasteroi ensimmäinen sivu

Valitse kuva

Sisällysluettelon tyyli

Reunukset

Sisällön järjestys

Sivuasettelun perusteella

Sama kuin XML-rakenne

Sama kuin artikkelipaneelissa

Sijoita alaviite kappaleen jälkeen

Poista pakotetut rivinvaihdot

Yleiset EPUB-vientiasetukset

EPUB-vientiasetukset-valintaikkunan Yleiset-osa sisältää seuraavat asetukset.

Määritä EPUB-versio. 

EPUB 2.0.1 on IDPF:n vuonna 2007 hyväksymä standardi. Tätä muotoa tuetaan erilaisissa mobiililaitteissa.

EPUB 3.0 on IDPF:n vuonna 2011 hyväksymä standardi. Tämä muoto tukee myös ääntä, videota, Javascriptiä ja japaninkielistä
pystysuuntaista tekstiä. Uudet toiminnot eivät kuitenkaan toimi lukuohjelmissa ja laitteissa, jotka eivät tue EPUB 3.0 -standardia.

Tämä on Adobe Systemsin kehittämä kokeellinen muoto. Se tukee useita sarakkeita, tekstinkierrätystä ja muita
ohjausobjekteja, joiden ansiosta sivuasettelusi näyttävät hyviltä kaikissa sivuasetteluissa. Tämä toiminto toimii vain tiettyjen
katseluohjelmateknologioiden kanssa.

Määrittää eKirjan kansikuvan. Valitse yksi seuraavista:

Jos tämä asetus on valittuna, eKirjaan ei lisätä kansikuvaa.

Jos tämä asetus on valittuna, eKirjan ensimmäinen sivu rasteroidaan ja siitä luodaan kuvatiedosto, jota
käytetään kantena.

Jos tämä asetus on valittuna, voit valita tietokoneesta kuvan, jota käytetään kantena.

Valitse tämä asetus, jos haluat luoda valittuun sisällysluettelon tyyliin perustuvan sisällysluettelon. Määritä Sisällysluettelon
tyyli -luettelossa eKirjan sisällysluettelon luontiin käytettävä sisällysluettelon tyyli. Voit luoda eKirjalle yksilöllisen sisällysluettelon tyylin valitsemalla
Sivuasettelu > Sisällysluettelon tyylit.

Määritä Ylä-, Ala-, Vasen- ja Oikea-reunusten arvot pikseleinä. Jos haluat käyttää samaa arvoa kullekin reunukselle, valitse Rajoita-
kuvake. 

Määritä sivuelementtien vientijärjestys.

Lukemisjärjestys määräytyy sivulla olevien kohteiden sijainnin perusteella.
Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen lukemalla sivun vasemmalta oikealle ja ylhäältä
alas. Muotoiluelementit eivät välttämättä ole kaikissa tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa, halutussa
lukujärjestyksessä. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.
(Vain aasialaiset versiot) Jos valitset Sivuasettelun perusteella, InDesign päättelee sivuobjektien lukemisjärjestyksen julkaisun sidonnan
mukaan (vasemmalta oikealle tai oikealta vasemmalle). Viedyt muotoiluelementit eivät välttämättä ole halutussa lukujärjestyksessä kaikissa
tapauksissa, kuten monimutkaisissa monipalstaisissa julkaisuissa. Voit muotoilla ja järjestää sisältöä Dreamweaverissa.

Lukemisjärjestys määräytyy rakennenäkymässä olevien nimiöiden järjestyksen perusteella. Katso Sivukohteiden
nimiöiminen.

Lukemisjärjestys määräytyy Artikkelit-paneelissa olevien elementtien järjestyksen perusteella. Vain valitut
artikkelit viedään. Katso Artikkeleiden sisällyttäminen vientiä varten.

Valitse tämä vaihtoehto, jos haluat sijoittaa alaviitteet kappaleen jälkeen. Jos valinta poistetaan, alaviitteet
muunnetaan loppuviitteiksi.

Valitse tämä vaihtoehto, jos haluat viedystä eKirjasta kaikki pakotetut rivinvaihdot.
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Luettelomerkit

Numerot

Osoita järjestettyyn luetteloon

Osoita kiinteään järjestettyyn luetteloon

Tekstiksi muuntaminen

Näytä EPUB viennin jälkeen

Säilytä sivuasettelun ulkoasu

Tarkkuus (ppi)

Kuvan koko

Kuvan tasaus ja välistys

Lisää sivunvaihto

Asetukset koskevat ankkuroituja objekteja

Kuvan muuntaminen

GIF-asetukset (Paletti)

JPEG-asetukset (kuvan laatu)

Valitse Osoita järjestämättömään luetteloon, jos haluat muuntaa luettelomerkityt kappaleet Luettelokohteiksi, jotka muotoillaan
HTML-muotoon <ul>-nimiöllä. Valitse Muunna tekstiksi, jos haluat muotoilla luettelomerkit tekstiksi <p>-nimiöllä. Jos olet käyttänyt InDesignin
alkuperäisiä automaattisia luettelomerkkejä, myös aliluettelomerkit sisällytetään.

Määrittää, kuinka numerot muunnetaan HTML-tiedostossa. Jos olet käyttänyt InDesignin alkuperäistä automaattista numerointia, myös
aliluettelomerkit sisällytetään.

Muuntaa numeroidut luettelot Luettelokohteiksi, jotka muotoillaan HTML-muotoon <ol>-nimiöllä.

Muuntaa numeroidut luettelot Luettelokohteiksi ja liittää <value>-määritteen, joka perustuu
kappaleen nykyiseen numeroon InDesignissa.

Muuntaa numeroidut luettelot kappaleiksi, joiden alussa on kappaleen nykyinen numero tekstinä.

EPUB avautuu EPUB-tiedostojen lukemiseen valitussa oletussovelluksessa, jos sellainen on käytettävissä.

EPUB-kuva-asetukset

EPUB-vientiasetukset-valintaikkunan Kuvat-osa sisältää seuraavat asetukset. Määritä Kuvien muuntaminen -valikossa, miten kuvat viedään HTML-
muotoon.

Valitse tämä vaihtoehto, jos haluat käyttää sivuasettelussa olevia kuvaobjektien määritteitä.

Valitse kuvien tarkkuus pikseleinä tuumalla (ppi). Käyttöjärjestelmien vakiotarkkuutena on 72 ppi tai 96 ppi, mobiililaitteissa
tarkkuus vaihtelee 132 ppi:stä (iPad) 172 ppi:hin (Sony Reader) ja jopa 300 ppi:hin (iPhone 4). Voit valita kullekin valitulle objektille ppi-arvon.
Arvona voi olla 72, 96, 150 (tänä päivänä kaikkien eBook-laitteiden keskiarvo) ja 300.

Määritä, käytetäänkö kiinteää kuvakokoa vai suhteutetaanko se sivukokoon. Sivukokoon suhteutettu asetus määrittää suhteellisen
prosenttiarvon InDesign-sivuleveyteen suhteutetun kuvakoon perusteella. Tätä asetusta käytettäessä kuvat skaalataan suhteessa lukualueen
leveyteen.

Määritä kuvan tasaus, täyttö vasemmalle, keskelle ja oikealle sekä välilyönti ennen ja jälkeen.

Valitse tämä vaihtoehto, jos haluat lisätä kuviin sivunvaihtoja. Sivunvaihtoja voidaan lisätä ennen kuvaa, kuvan jälkeen tai
ennen kuvaa ja kuvan jälkeen.

Valitse tämä vaihtoehto, jos haluat käyttää näitä asetuksia kaikkien ankkuroitujen objektien kanssa.

Voit valita, muunnetaanko dokumentin optimoidut kuvat GIF-, JPEG- tai PNG-muotoon. Valitse Automaattinen, jos haluat,
että InDesign päättää, mitä muotoa kussakin tapauksessa käytetään. PNG-asetuksen valinta poistaa kuvien pakkausasetukset käytöstä. Käytä
PNG-asetusta häviöttömiin tai läpinäkyviin kuviin.

Voit määrittää, kuinka InDesign käsittelee värejä GIF-tiedostoja optimoitaessa. GIF-muodossa käytetään rajoitettua
väripalettia, jossa voi olla enintään 256 väriä.
Valitse Sovitettu, jos haluat luoda paletin käyttämällä edustavaa näytettä grafiikan väreistä ilman rasterointia eli lisävärien simulointia pieniä
väripisteitä sekoittamalla. Valitse Verkko, jos haluat muodostaa paletin verkkokäyttöön sopivista väreistä, jotka ovat Windows- ja Mac OS -
järjestelmävärien osajoukko. Valitse Järjestelmä (Win) tai Järjestelmä (Mac), jos haluat luoda paletin käyttämällä järjestelmän omaa väripalettia.
Tämä valinta voi aiheuttaa odottamattomia tuloksia.
Valitse Lomita, jos haluat ladata kuvat progressiivisesti niin, että rivit ilmestyvät yksitellen. Jos tätä asetusta ei ole valittu, kuva näyttää epätarkalta
ja selkenee hitaasti kuvan saavuttaessa täyden tarkkuutensa.

Määrittää kullekin JPEG-kuvalle tilanteeseen parhaiten sopivan pakkauksen (pienemmät tiedostokoot) ja kuvan
laadun. Matala-asetus tuottaa pienimmän tiedostokoon ja heikoimman kuvan laadun.
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JPEG-asetukset (muotoilumenetelmä)

Ohita objektin muunnosasetukset

Jaa dokumentti

Sisällytä dokumentin metatiedot

Julkaisija

Yksilöllinen tunnus

CSS-asetukset

Sisällytä tyylimääritykset

Säilytä paikalliset ohitukset

Sisällytä upotettavat kirjasimet

Lisää tyyliarkki

Lisää komentosarja

Alkuun

Määrittää, kuinka nopeasti JPEG-grafiikka tulee näkyviin, kun kuvan sisältämä tiedosto avataan
verkkosivulla. Valitse Etenevä, jos haluat JPEG-kuvien avautuvan vähitellen ja tarkentuvan verkkoselaimen ladatessa niitä. (Tällä asetuksella
luodut tiedostot ovat hieman suurempia ja vaativat katseluun enemmän RAM-muistia.) Valitse Peruslinja, jos haluat, että kukin JPEG-tiedosto
näkyy vasta latauksen päätyttyä. Tiedoston paikalla on latauksen aikana paikkamerkki.

Ohittaa yksittäisiin kuviin käytetyt objektin vientiasetukset. Katso Objektin vientiasetusten käyttäminen.

EPUB-lisäasetukset

EPUB-asetukset-valintaikkunan Sisältö-osa sisältää seuraavat asetukset.

Voit jakaa eKirjan määritetyn kappaletyylin perusteella. Jakamisen seurauksena EPUB-paketti sisältää enemmän HTML-
tiedostoja, mutta pitkien tiedostojen jakaminen voi olla hyödyllistä, ja se lisää EPUB-lukuohjelmistojen suorituskykyä.

Julkaisun (tai tyylilähdejulkaisun, jos valittiin kirja) metatiedot sisällytetään vientitiedostoon.

Määritä tässä eKirjan metatietoihin sisällytettävät julkaisijatiedot. Voit määrittää esimerkiksi julkaisijan URL-osoitteen, jotta
eKirjan vastaanottaja voi siirtyä julkaisijan sivustoon ja ostaa eKirjan.

Jokainen EPUB-julkaisu tarvitsee ainutkertaisen tunnisteen. Ohjelmisto luo ja näyttää automaattisesti ainutkertaisen
tunnisteen. Voit poistaa sen ja määrittää ainutkertaisen tunnisteen.

CSS (Cascading Style Sheet) -tyyliarkit ovat kokoelma muotoilusääntöjä, jotka määrittävät sisällön ulkoasun verkkosivulla. Kun
käytät sivun muotoiluun CSS:ää, erotat sisällön esityksestä.

Kun viet EPUB-muodossa, voit luoda muokattavan luettelon CSS-tyyleistä.

Jos tämä asetus on valittu, paikalliset muotoilut, kuten kursiivi ja lihavointi, on sisällytetty.

Sisällytä kaikki upotettavat kirjasimet eBook-kirjaan. Kirjasimissa on upotusbitit, jotka määrittävät,
voidaanko kirjasin upottaa.

Määritä olemassa olevan CSS-tyyliarkin URL-osoite (yleensä suhteellinen URL, esimerkiksi "/tyylit/tyyli.css"). InDesign ei
tarkista, onko CSS olemassa tai kelvollinen, joten vahvista ulkoisen CSS:n asetukset.

Määritä olemassa olevan JavaScriptin URL-osoite. InDesign ei tarkista, onko JavaScript olemassa tai kelvollinen, joten
vahvista ulkoisen JavaScriptin asetukset.

EPUB-resurssit

Seuraavia linkkejä napsauttamalla voit perehtyä EPUB-muotoon.

Lisätietoja EPUB-määrityksestä on sivustossa www.idpf.org.

Lataa ilmainen Digital Editions -lukuohjelmisto osoitteesta www.adobe.com/fi/products/digitaleditions.

Lisätietoja Digital Editionsista löytyy Digital Editions -blogista.

Lisätietoja viennistä Kindleen on julkaisussa InDesignista Kindleen (PDF).

Opi muuntamaan InDesign-tiedostot EPUB-muotoon ja aloita Apple iPadilla katseltavissa olevien sähköisten kirjojesi myynti. Lisätietoa on
white paper -julkaisussa. Perehdy White paper -julkaisuun InDesignista iPadiin.
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Komentosarjat

Alkuun

Alkuun

Mac OS

Windows XP

Windows Vista ja Windows 7

InDesignin komentosarjat
Yleistä Komentosarjat- ja Komentosarjan nimi -paneeleista
Esimerkkikomentosarjojen suorittaminen

InDesignin komentosarjat

Komentosarjat ovat erinomainen työkalu eri tehtävien suorittamiseen. Komentosarja voi esimerkiksi olla yksinkertainen automaattinen tehtävä tai
monimutkainen uusi ominaisuus. Voit luoda omia komentosarjojasi ja suorittaa toisten luomia komentosarjoja. Lisätietoja komentosarjoista saat
komentosarjaoppaasta, komentosarjojen vaatimuksista ja muista kehittäjäresursseista osoitteesta
http://www.adobe.com/devnet/indesign/documentation.html.

Komentosarjaopas sisältää johdannon komentosarjoihin ja opastusohjelmia. Löydät myös useita hyödyllisiä komentosarjoja, kuten valitun objektin
ympärille apuviivoja piirtävän komentosarjan. Osa näistä komentosarjoista näkyy oletusarvoisesti Komentosarjat-paneelissa.

Yleistä Komentosarjat- ja Komentosarjan nimi -paneeleista

InDesign sisältää kaksi komentosarjoihin liittyvää paneelia: Komentosarjat- ja Komentosarjan nimi -paneelin.

Komentosarjat-paneelissa voit suorittaa komentosarjoja poistumatta InDesignista. Komentosarjat-paneeli näyttää komentosarjat, jotka sijaitsevat
InDesign-sovelluskansion Komentosarjat-kansioissa ja Asetukset-kansioissasi. Jos luot tai vastaanotat komentosarjan, voit sijoittaa sen
Komentosarjat-paneelin kansioon, jolloin se näkyy Komentosarjat-paneelissa.

Käyttäjät/[käyttäjätunnus]/Kirjasto/Preferences/Adobe InDesign/[versio]/[kieli]/Scripts/Scripts Panel

Documents and Settings\[käyttäjätunnus]\Application Data\Adobe\InDesign\[versio]\[kieli]\Scripts\Scripts Panel

Käyttäjät\[käyttäjätunnus]\AppData\Roaming\Adobe\InDesign\[versio]\[kieli]\Scripts\Scripts Panel
Nopea keino paikantaa Komentosarjat-paneelin kansio on napsauttaa komentosarjaa hiiren kakkospainikkeella (Windows) tai painaa Ctrl-
näppäintä napsauttamisen aikana (Mac OS) Komentosarjat-paneelissa ja valita Näytä Resurssienhallinnassa (Windows) tai Näytä Finderissa
(Mac OS).

Voit suorittaa komentosarjan kaksoisnapsauttamalla sitä Komentosarjat-paneelissa. Komentosarjoja voi suorittaa myös Nopea käyttö -toiminnolla.

Komentosarjan nimi -paneelissa voit määrittää nimen sivukohteelle, kuten tekstikehykselle tai muodolle. Sivukohteiden nimien määrittäminen on
erityisen hyödyllistä kirjoitettaessa komentosarjoja, joissa täytyy tunnistaa objekti.

Lisätietoja komentosarjojen lisäämisestä, suorittamisesta ja muokkaamisesta on komentosarjaoppaassa, jonka löydät Adoben sivustosta
osoitteesta http://www.adobe.com/devnet/indesign/documentation.html.

Komentosarjat-paneelin avaaminen

Valitse Ikkuna > Apuohjelmat > Komentosarjat.

Komentosarjan nimi -paneelin avaaminen

Valitse Ikkuna > Apuohjelmat > Komentosarjan nimi.
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AddGuides

AddPoints

AdjustLayout

AlignToPage

AnimationEncyclopedia

BreakFrame

CornerEffects

CreateCharacterStyles

CropMarks

ExportAllStories

FindChangeByList

ImageCatalog

MakeGrid

Neon

PathEffects

PlaceMultipagePDF

SelectObjects

SortParagraphs

SplitStory

TabUtilities

Esimerkkikomentosarjojen suorittaminen

Voit suorittaa seuraavia komentosarjoja InDesignissa:

Lisää apuviivat valitun objektin tai objektien ympärille.

Lisää pisteet valitun objektin tai objektien reiteille.

Siirtää objekteja määritetyille etäisyyksille vasemman- tai oikeanpuoleisilla sivuilla.

Tasaa sivun objektit määritettyihin paikkoihin.

Luo automaattisesti painikkeita, joissa on erilaisia animaatio-ominaisuuksia.

Poistaa valitun tekstikehyksen ja sen sisällön jutusta.

Piirtää valitun kohteen tai kohteiden reitin uudelleen käyttäen erilaisia kulmatehosteita. Kulmatehosteita voidaan käyttää valituissa
reitin pisteissä.

Määrittää valittuun tekstiin perustuvan kokonaisen merkkityylin.

Lisää leikkausmerkit ja/tai kohdistusmerkit valitun objektin tai objektien ympärille.

Vie kaikki julkaisun jutut joukoksi tekstitiedostoja.

Suorittaa sarjan yleisiä tekstin etsi/korvaa-toimintoja lukemalla sarkainerotellun tekstitiedoston.

Sijoittaa kaikki kuvat määriteltyyn sisältöarkkisivuasettelun kansioon.

Luo ruudukon alijakamalla tai monistamalla valitun objektin tai objektit.

Käyttää sekoitustehostetta valitussa objektissa tai objekteissa.

Muuttaa valitun kohteen tai kohteiden reittipisteiden sijaintia. Tämä tehoste näyttää luovalta.

Sijoittaa kaikki PDF-sivut.

Valitsee käytössä olevan aukeaman objektit niiden objektityypin perusteella.

Järjestää valinnan kappaleet aakkosjärjestykseen.

Jakaa valitun jutun tekstikehykset erillisiksi linkittämättömiksi tekstikehyksiksi.

Käyttää valitussa tekstissä sarkainkohtia ja sisennyksiä.

Lisätietoja näiden esimerkkikomentosarjojen asennuksesta ja käytöstä on osoitteessa www.adobe.com/go/learn_id_scripting_readme_cs5_fi (PDF).

Lisää ohjeaiheita
Komentosarjojen käyttö InDesignissa
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Huomautus:
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Laajennusten asentaminen
Määritä laajennukset Extension Managerilla
Integrointi Creative Cloudin lisäosien kanssa Selaa lisäosia -valikon kautta 

Laajennusten asentaminen

InDesign-laajennusmoduulit ovat Adobe Systemsin ja muiden ohjelmistovalmistajien Adoben kanssa yhteistyössä kehittämiä ohjelmia, jotka
lisäävät toimintoja Adobe-ohjelmistoihin. Ohjelmaasi sisältyy useita tuonti-, vienti-, automatisointi- ja erikoistehostelaajennuksia. Nämä laajennukset
asennetaan automaattisesti Plug-Ins-kansioon. Useimmat InDesign-toiminnoista liittyvätkin laajennuksiin.

Kun laajennusmoduulit on asennettu, ne näkyvät valikoiden, valintaikkunoiden ja paneelien vaihtoehtoina.

1. Asenna laajennusmoduuli asennusohjelmalla, jos sellainen on toimitettu laajennuksen mukana. Muussa tapauksessa vedä moduulin kopio
Laajennukset-kansioon, joka sijaitsee InDesign-sovelluskansiossa.

2. Noudata laajennuksen mukana toimitettuja asennusohjeita.

Voit käyttää mitä tahansa kaupallista InDesign-yhteensopivaa laajennusta. Adoben tekninen tuki auttaa sinua tunnistamaan
laajennuksiin liittyvät ongelmat. Jos ongelma kuitenkin liittyy suoraan jonkin muun yrityksen toimittamaan laajennukseen, ota yhteys kyseiseen
yritykseen ongelman ratkaisemiseksi.

Määritä laajennukset Extension Managerilla

Extension Manager -sovelluksella voit tarkastella ja mukauttaa asennettujen laajennusten joukkoa. Saat tarkkoja tietoja asennetuista
laajennuksista, voit mukauttaa laajennusryhmiä eri tehtäviä tai työryhmiä varten ja voit eristää laajennuksia, kun etsit ratkaisuja mahdollisiin
ongelmiin. Voit myös poistaa laajennukset käytöstä.

Valitse Ohje > Hallitse laajennuksia (Windows) tai InDesign > Hallitse laajennuksia (Mac OS).

Jos tarvitset lisätietoja Extension Managerin käytöstä, valitse Extension Manager -sovelluksessa Ohje.

Integrointi Creative Cloudin lisäosien kanssa Selaa lisäosia -valikon kautta 

Voit hakea ja asentaa Adobe InDesigniin ja muihin tuotteisiin muun muassa plug-inejä ja laajennuksia Adoben lisäosat -sivustosta.

Voit lisätä InDesigniin lisäosan ja siihen liittyvän plug-inin valitsemalla Ikkuna > Selaa lisäosia. Lisäosat voivat olla maksuttomia tai
maksullisia. Kaikki Creative Cloud -sovelluksesta InDesigniin asennetut ja hankitut plug-init synkronoidaan InDesigniin tästä työnkulusta. Se
siirtää sinut Selaa lisäosia -verkkosivulle.
Nämä lisäosat näkyvät myöhemmin kohdassa Ikkuna > Laajennukset, ladattavissa tiedostoissa tai paikassa, josta lisäosan kuvaus löytyy. Jos
haluat tarkastella ladattuja lisäosia, siirry Selaa lisäosia -sivulle, niin näet sen vasemmassa sivuruudussa Näytä omat lisäosat -vaihtoehdon.
Siinä on lueteltu myös näitä lisäosia tukevat tuotteet ja niiden versiot.

Kun tiedostojen synkronointi on käytössä, selaamalla haetut lisäosat synkronoidaan Creative Cloud -tilille.
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Tietojen yhdistäminen

Alkuun

Alkuun

Tietoja tietojen yhdistämisestä
Tietojen yhdistämisen vaiheet
Tietoja tietolähdetiedostoista
Kuvakenttien lisääminen tietolähdetiedostoon
Tietoja kohdejulkaisuista
Tietolähteen valitseminen
Tietokenttien lisääminen
Tietokenttien paikkamerkkien lisääminen sivupohjiin
Tietolähdetiedostojen päivittäminen, poistaminen tai korvaaminen
Kohdejulkaisun tietueiden esikatselu
Esikatselun käyttöön ottaminen ja käytöstä poistaminen vuorotellen
Tietokenttien paikkamerkkien muokkaaminen
Sisällön sijoitusasetusten määrittäminen
Tietueiden yhdistäminen
Tietokenttien päivittäminen
Sijoittamattoman tekstin raportit
Sisällön sijoitusasetukset
Parannettu tietojen yhdistäminen

Tietoja tietojen yhdistämisestä

Kirjepohjia, kirjekuoria tai osoitetarroja luotaessa tietolähdetiedosto yhdistetään kohdejulkaisun kanssa. Tietojen yhdistämistä kutsutaan myös
postitietojen yhdistämiseksi.

Tietolähdetiedostossa on kohdejulkaisun esiintymissä vaihtelevat tiedot, kuten kirjeen vastaanottajan nimi ja osoite. Tietolähdetiedosto koostuu
kentistä ja tietueista. Kentät ovat ryhmitettyjä tietoja, kuten yritysten nimiä tai postinumeroita, kun taas tietueet ovat täydellisten tietojoukkojen
rivejä, joihin voi sisältyä esimerkiksi yrityksen nimi, katuosoite, postinumero ja postitoimipaikka. Tietolähdetiedostot ovat tekstitiedostoja, joiden
erottimena voi olla pilkku (.csv) tai sarkainmerkki (.txt). Toisin sanoen kyseisessä tietomuodossa yksittäiset tiedot erotetaan toisistaan pilkulla tai
sarkaimella.

Kohdejulkaisu on InDesign-julkaisu, jossa tietokentän paikalla on paikkamerkki. Julkaisussa on myös pohjateksti ja muut yhdistetyssä julkaisussa
muuttumattomana pysyvät tiedot.

Yhdistetty julkaisu on InDesign-julkaisu, jossa on kohdejulkaisun pohjatekstitiedot toistettuna yhtä monta kertaa kuin tietolähteessä on tietueita.

Tietojen yhdistäminen

A. Tietolähdetiedosto B. Kohdejulkaisu C. Yhdistetty julkaisu 

Tietojen yhdistämisen vaiheet
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1. Päätä, mitä tietokenttiä käytät lähde- ja kohdejulkaisuissa.

Päätä, miltä haluat lopullisen julkaisun näyttävän, jotta saat selville, mitkä kentät on yhdistettävä. Jos esimerkiksi luot asiakkaille lähettävän
postikortin, voit käyttää seuraavia kenttiä:

<<Yrityksen nimi>><<Osoite>><<Kaupunki>>, <<Osavaltio>><<Postinumero>>

Laskentataulukko tai tietokanta voi näyttää esimerkiksi tältä:

Mallitiedosto

2. Tallenna tietolähdetiedosto, joka on tavallisesti laskentataulukko tai tietokantatiedosto, pilkku- (.csv) tai sarkaineroteltuna (txt)
tekstitiedostona.

Varmista, että tietolähdetiedoston rakenne vastaa kohdejulkaisun kenttiä. Esimerkki: Laskentataulukon ensimmäisellä rivillä ovat kentät, joita käytät
kohdejulkaisussa. Näitä kenttiä ovat esimerkiksi Yritys ja Katuosoite.

Lisätietoja on ohjeaiheessa Tietoja tietolähdetiedostoista.

3. Luo kohdejulkaisu, jossa on kaikissa lähdejulkaisuissa muuttumattomina säilyvät teksti ja muut kohdat.

Lisätietoja on ohjeaiheessa Tietoja tietolähdetiedostoista.

4. Valitse tietolähde Tietojen yhdistäminen -paneelista.

Lisätietoja on ohjeaiheessa Tietolähteen valitseminen.

5. Lisää Tietojen yhdistäminen -paneelista kentät kohdejulkaisuun.

Voit lisätä tietokenttiä joko julkaisun sivulle tai sivupohjaan. Jos lisäät tietokenttiä sivupohjaan, saat lisää vaihtoehtoja.

Lisätietoja on ohjeaiheissa Tietokenttien lisääminen ja Tietokenttien paikkamerkkien lisääminen sivupohjiin.

6. Varmista esikatselussa, että tietueet asettuvat kohdejulkaisuun oikein.

Lisätietoja on ohjeaiheessa Kohdejulkaisun tietueiden esikatselu.

7. Yhdistä kohdejulkaisu tietolähdetiedoston kanssa tai vie se PDF-muotoon.

Lisätietoja on ohjeaiheessa Tietueiden yhdistäminen.

Tietoja tietolähdetiedostoista

Tietolähteet on tavallisesti luotu laskentataulukko- tai tietokantasovelluksella, mutta voit luoda oman tietolähdetiedoston InDesignilla tai millä
tahansa tekstieditorilla. Tietolähdetiedostot on tallennettava pilkku- (.csv) tai sarkainerotellussa (.txt) tekstimuodossa. Lisätietoja tiedostojen
viemisestä näihin muotoihin on lähdesovelluksen käyttöoppaassa.

Tietueet erotellaan pilkku- ja sarkainerotelluissa tekstitiedostoissa kappaleenjakomerkein ja kentät pilkuin tai sarkaimin. Tietolähdetiedostoon voi
sisältyä myös levyllä oleviin kuviin viittaavaa tekstiä tai polkuja.
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Esimerkki pilkkuerotellusta tietolähdetiedostosta

Nimi,yrityksen nimi,osavaltio Bill Tucker,CoreVent Labs,Nevada Dat Nguyen,”Brady, Hunt, and Baxter, Inc”,Delaware Maria Ruiz,”Brinquist 
Enterprises, Inc.”,Kalifornia

Jos haluat käyttää pilkkua tai lainausmerkkiä pilkkuerotellussa tiedostossa, käytä tekstin ympärillä lainausmerkkejä. Esimerkki: "Sallinen, Pesola
Oyj". Ilman lainausmerkkiä jokaista nimeä käsitellään erillisenä kenttänä.

Et voi lisätä rivinvaihtoa tietolähdetiedoston kenttään. Jos kenttä on jaettava eri riveille, luo kaksi erillistä kenttää, kuten <<Osoite1>> ja
<<Osoite2>>.

Voit estää tyhjien rivien syntymisen yhdistettävään julkaisuun valitsemalla Poista tyhjien kenttien tyhjät rivit. Jos rivillä on mitä tahansa merkkejä,
mukaan lukien välilyönnit, riviä ei kuitenkaan poisteta.

Kuvakenttien lisääminen tietolähdetiedostoon

Saat eri kuvan näkymään jokaisessa yhdistetyssä tietueessa lisäämällä tietolähdetiedostoon kuvakenttiä. Kun yhdistät esimerkiksi julkaisuja, joissa
on tietoa eri yrityksistä, voit liittää mukaan kuvan jokaisen yrityksen logosta.

1. Avaa tietolähdetiedosto.

2. Lisää kuvatiedostoihin viittaava teksti tai polku kirjoittamalla tietokentän nimen alkuun @-merkki.

@-merkki kirjoitetaan vain ensimmäiselle riville, muille riveille kirjoitetaan kuvan polut. Polkujen kirjoitusasussa on noudatettava sen
käyttöjärjestelmän käytäntöjä, jossa ne on tallennettu. Ison ja pienen kirjaimen ero otetaan huomioon.

Jos näyttöön tulee virheilmoitus, kun kirjoitat kentän alkuun @-merkin, @-merkin eteen täytyy kirjoittaa heittomerkki ('), jotta toimintoa voi
käyttää (esimerkiksi '@Kuvat). Joissakin sovelluksissa (esimerkiksi Microsoft Excelissä) @-merkki on varattu toiminnoille.

(Windows) Esimerkki tietolähdetiedoston kuvaviittauksista

Nimi Ikä @Kuvat

Matti Tuominen 36 C:\Kuvat\MattiTuominen.jpg

Jan Nylund 53 C:\Omat tiedostot\jan.gif

Maria Reitala 26 C:\Kuvat\Reitala.psd

(Mac OS) Esimerkki tietolähdetiedoston kuvaviittauksista

Nimi Ikä @Kuvat

Matti Tuominen 36 Mac HD:Kuvat:MattiTuominen.jpg

Jan Nylund 53 Työpöytä:Perhe:jan.gif

Maria Reitala 26 Mac HD:Kuvat:Reitala.psd

Voit tarkastella kuvan käyttöjärjestelmäpolkua InDesignissa. Sijoita kuva InDesign-julkaisuun ja katso kuvan sijainti Linkit-paneelin avulla. Kun
kuva on valittuna, valitse Linkit-paneelin valikosta Kopioi Info > Kopioi koko polku. Polkua on ehkä muokattava sen jälkeen, kun se on liitetty
tietolähteeseen. Tämä menetelmä on erityisen hyödyllinen käytettäessä palvelimeen tallennettuja kuvia.

Tietoja kohdejulkaisuista

Kun tietolähdetiedosto on luotu, on määritettävä kohdejulkaisu, johon tietolähdetiedoston kentät lisätään. Kohdejulkaisussa on tietokentän
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paikkamerkkiteksti ja -kuva. Se voi olla esimerkiksi kuva, jonka haluat näkyvän jokaisessa postikortissa. Kun valitset tietolähteen, nämä kentät ovat
lisättävissä.

Tietolähteen kentät näkyvät kohdejulkaisussa paikkamerkkiteksteineen.

Kun yhdistät tiedot, InDesign luo uuden julkaisun, jossa kenttien tilalla on tietolähdetiedostossa määrittämäsi kentät. Voit sijoittaa tietokenttiä joko
julkaisun sivulle tai sivupohjaan.

Tietolähteen valitseminen

Valitse tietolähde Tietojen yhdistäminen -paneelista, ennen kuin lisäät kenttiä kohdejulkaisuun. Julkaisuun voi valita vain yhden tietolähdetiedoston.

1. Luo tai avaa julkaisu, jota käytät kohdejulkaisuna.

2. Valitse Ikkuna > Apuohjelmat > Tietojen yhdistäminen.

3. Valitse Tietojen yhdistäminen -paneelivalikosta Valitse tietolähde.

4. Voit muuttaa erotellun tekstin asetuksia valitsemalla Näytä tuontiasetukset.

InDesign havaitsee erottelumerkin tyypin ja tietolähdetiedoston koodauksen automaattisesti, joten tuontiasetuksia ei yleensä tarvitse näyttää.
Voit kuitenkin muuttaa koodauksen ja erottelumerkkien asetuksia, jos ne eivät mielestäsi ole oikein määritetty.

5. Etsi tietolähdetiedosto ja valitse Avaa.

6. Jos valitsit Näytä tuontiasetukset, muuta erottelumerkkien ja koodauksen asetuksia tarpeen mukaan ja valitse OK. Tietokentät tulevat
näkyviin Tietojen yhdistäminen -paneeliin.

jos näkyviin tulee viesti, että tiedostoa ei voida avata, tai jos luetteloruudussa näkyy vääriä kenttiä, laskentataulukkoa tai
tietokantatiedostoa kannattaa muokata ja tallentaa se sitten pilkku- tai sarkaineroteltuna tiedostona.

Kun tietolähde on valittu ja kentät ladattu Tietojen yhdistäminen -paneeliin, tietolähteeseen mahdollisesti tehtävät muutokset eivät näy
kohdejulkaisussa, ennen kuin päivität tietolähteen.

Tietokenttien lisääminen

Kun valitset tietolähteen, tietokenttien nimiluettelo tulee näkyviin Tietojen yhdistäminen -paneeliin. Nämä nimet vastaavat tietolähdetiedoston
sarakkeiden otsikoita. Kuvakkeet osoittavat, onko kyseessä teksti- vai kuvakenttä. Kun lisäät tietokenttiä julkaisuun, niistä tulee kenttien
paikkamerkkejä, kuten <<Yritys>>. Voit valita ja muotoilla paikkamerkkejä kuten muutakin tekstiä tai kuvia.

Voit määrittää kuvakentän olemassa olevaan kehykseen tai luoda kelluvan kuvan. Jos kuvakenttää lisätessä kohdistin on tekstikehyksessä tai jos
tekstiä on valittuna, pieni paikkamerkki lisätään sidottuna kehyksenä. Voit määrittää kuvapaikkamerkkiä muokkaamalla yhdistettävien kuvien koon.

Kun olet lisännyt tietokentän, InDesign muistaa sen tietolähteen. Kenttäluettelossa olevat virheet, kuten kirjoitusvirheet, tyhjät kentät ja vahingossa
luodut kentät, on korjattava lähdesovelluksessa ja päivitettävä Tietojen yhdistäminen -paneelissa.

Tekstitietokentän lisääminen kohdejulkaisuun

1. Luo tekstikehys julkaisun sivulle tai sivupohjaan.

Jos lisäät tietokenttiä sivupohjaan, katso kohta Tietokenttien paikkamerkkien lisääminen sivupohjiin.

2. Vie kohdistin tekstikehykseen, johon haluat lisätä kentän paikkamerkin, tai valitse teksti, jonka haluat korvata.

3. Lisää kentän paikkamerkki jommallakummalla tavalla:
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Valitse kenttä Tietojen yhdistäminen -paneelin luettelosta.

Lisää paikkamerkki vetämällä kentän nimi Tietojen yhdistäminen -paneelista ja pudottamalla se tekstikehykseen. Jos vedät tekstikentän
tyhjään kehykseen, kehys muuttuu tekstikehykseksi.

Tekstikentän paikkamerkki näkyy kohdejulkaisussa kaksinkertaisissa kulmasuluissa (esimerkiksi <<Nimi>>). Niiden muotoilu (kuten kirjasin ja koko)
noudattaa nykyisiä määreitä.

Kelvollista kenttää ei voi luoda kirjoittamalla kentän nimi tai muokkaamalla valmista kenttää. Kenttä on lisättävä Tietojen
yhdistäminen -paneelista.

Kuvatietokentän lisääminen kohdejulkaisuun

Lisää uusi tekstiin sijoitetun grafiikan paikkamerkki vetämällä kuvakenttä tekstikehykseen tai viemällä kohdistin tekstikehykseen ja
napsauttamalla kuvakenttää.
Lisää uusi kelluva kuva vetämällä kuvakenttä tyhjään grafiikkakehykseen. Jos vedät kuvakentän tyhjään kehykseen, kehys muuttuu
grafiikkakehykseksi.
Lisää kenttä ryhmitettyihin kohteisiin, taulukon soluihin tai sisäkkäisiin kohteisiin vetämällä kuva kohteeseen.

Kuvakentän paikkamerkit näkyvät kehyksinä, joissa on kentän nimi.

Tietokenttien paikkamerkkien lisääminen sivupohjiin

Tietokenttien paikkamerkit kannattaa lisätä sivupohjaan eikä julkaisun sivuille:

Alkuperäiset paikkamerkit ovat yhdistetyn julkaisun sivupohjassa ja yhdistämisen tulokset näkyvät julkaisun sivuilla ohitettuina
sivupohjakohteina.

Yhdistetyn julkaisun yhteys tietolähteeseen säilyy, joten jos tietolähteen tietueita muokataan, voit päivittää yhdistetyn julkaisun sisällön
valitsemalla Päivitä tietokenttien sisältö. Tämä asetus on erityisen hyödyllinen silloin, jos muutat yhdistetyn julkaisun asettelua ja haluat
myöhemmin lisätä uusia tietoja tietolähteestä.

Luo yhdistetty julkaisu -valintaikkunan asetukset ovat samat kuin kohdejulkaisussa, joten voit luoda nykyisen julkaisun nopeasti uudelleen
ulkoasultaan samanlaisena. Näiden jaettujen asetusten avulla voit luoda myös samanlaisen julkaisun eri tietolähteistä tai uuden julkaisun,
jonka asettelua on muokattu jonkin verran.

Jos lisäät tietokenttiä sivupohjaan, varmista, että sivupohjan kohteiden ohitukset on sallittu tietokentät sisältävässä tekstikehyksessä.
Valitse sivupohjan tekstikehys ja valitse Sivut-paneelivalikosta asetus Salli sivupohjan kohteiden ohitukset valitulla alueella. Jos tämä asetus ei ole
valittuna, tietoja ei yhdistetä. (Katso Sivupohjien luominen.)

Tietokenttiä ei voi sijoittaa sekä sivupohjaan että julkaisun sivuille. Jotta yhdistäminen tapahtuisi oikein, julkaisun ensimmäisellä sivulla on
käytettävä tietokentät sisältävää sivupohjaa.

Jos näyttöön tuleva virheviesti ilmoittaa, että InDesign ei voi yhdistää julkaisua, koska siinä ei ole paikkamerkkejä, olet saattanut
lisätä paikkamerkit yksisivuisen julkaisun vasemmalle sivupohjalle. Sivu 1 perustuu oikeanpuoleiseen sivupohjaan, joten lisää paikkamerkit oikeaan
sivupohjaan.

Tietolähdetiedostojen päivittäminen, poistaminen tai korvaaminen

Kun haluat päivittää tietolähdetiedostoja, muokkaa pilkku- tai sarkaineroteltua tietolähdetiedostoa, tallenna se ja valitse Tietojen yhdistäminen
-paneelista Päivitä tietolähde.

Muutokset näkyvät Tietojen yhdistäminen -paneelissa. Jos muutokset eivät näy julkaisussa päivittämisen jälkeen, ota esikatseluasetus pois
käytöstä poistamalla sen valinta ja ota se uudelleen käyttöön valitsemalla se toistamiseen.

Voit poistaa yhteyden tietolähdetiedostoon valitsemalla Tietojen yhdistäminen -paneelivalikosta Poista tietolähde.
Voit vaihtaa uuteen tietolähdetiedostoon valitsemalla Tietojen yhdistäminen -paneelivalikosta Valitse tietolähde ja määrittämällä sitten uuden
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tietolähdetiedoston. InDesign ei ehkä tunnista kaikkia kenttiä. Tässä tapauksessa on järkevintä poistaa paikkamerkkikentät ja lisätä ne
uudelleen.

Voit päivittää yhdistetyn julkaisun tietokentät, jos luot yhdistetyn julkaisun kohdejulkaisusta, jossa tietokentät on sijoitettu sivupohjiin.

Kohdejulkaisun tietueiden esikatselu

Tietueet kannattaa esikatsella ennen kohdejulkaisun ja tietolähdetiedoston yhdistämistä. Tällä tavoin voit varmistaa, että kenttien tiedot näkyvät
oikein, kun tiedot yhdistetään. Tietueita esikatseltaessa Tietojen yhdistäminen -paneelissa näkyy tietolähdetiedostojen varsinaisia tietoja kenttien
paikkamerkkien sijaan. Esimerkiksi paikkamerkin <<Yritys>> sijaan voi näkyä nimi Adobe Systems, Inc. Voit selata tietueita Tietojen yhdistäminen -
paneelin navigointipainikkeilla.

Jos havaitset tietueissa typografisia virheitä, ylimääräisiä välilyöntejä tai muita virheitä, muokkaa lähdetiedostoa alkuperäissovelluksessa. (Katso
Tietoja tietolähdetiedostoista.)

1. Valitse Tietojen yhdistäminen -paneelin alaosasta Esikatselu tai valitse Tietojen yhdistäminen -paneelivalikosta Esikatselu.

2. Selaa tietueiden tietoja navigointipainikkeilla.

Voit siirtyä haluamaasi tietueeseen paneelin alaosan navigointipainikkeilla. Voit myös kirjoittaa haluamasi tietueen numeron paneelin alaosan
navigointiruutuun. Paina sitten Enter- tai Return-näppäintä.

Esikatselun käyttöön ottaminen ja käytöstä poistaminen vuorotellen

Tiettyjä seikkoja voi tulla esiin tai ne voivat poistua, kun vaihtelet esikatselutilojen välillä. Muista seuraavat ohjeet:

Paikkamerkit korvaavat esikatselusisällön, kun Tietueiden esikatselu -asetus ei ole valittuna. Jos poistat kuvan kehyksineen tai koko
tekstijonon tai kun poistat Tietueiden esikatselu -asetuksen valinnan, vastaavat paikkamerkit eivät enää näy, sillä myös ne on poistettu.

Sisällön sijoitusasetukset -valintaikkunassa tehdyt muutokset tulevat näkyviin, kun valitset OK. Jos Tietueiden esikatselu -asetus on valittuna,
tiedot eivät vastaa päivitettyjä sijoitusasetuksia, ennen kuin olet ensin poistanut asetuksen valinnan ja valinnut sen sitten uudelleen.

Jos yrität tallentaa julkaisun esikatselutilassa, saat viestin, jossa sinua pyydetään poistumaan esikatselutilasta ennen julkaisun tallentamista.

Tietokenttien paikkamerkkien muokkaaminen

Kun lisäät tekstitietokentän julkaisuun, lisättävän kentän paikkamerkkiteksti käyttää lisäyskohdassa käytettyjä aktiivisia muotoilumääreitä (kuten
kirjasinta ja kokoa). Voit muokata paikkamerkkitekstin määritteitä ja määrittää tällä tavoin tietojen ulkoasun.

Tee jokin seuraavista:

Voit muuttaa paikkamerkkien määritteitä valitsemalla ensin paikkamerkkitekstin ja muuttamalla sitten muotoilumääritteitä samaan tapaan
kuin muidenkin tekstien kohdalla.

Jos haluat vaihtaa paikkamerkin, valitse ensin paikkamerkki tai varsinaiset tiedot ja sitten uusi kenttänimi Tietojen yhdistäminen -
paneelista.

Voit poistaa paikkamerkin valitsemalla sen ja painamalla askelpalautinta tai Delete-näppäintä.

Tekstin paikkamerkit näkyvät juttueditorinäkymässä hyperlinkkien tavoin. Kaikkia Tietojen yhdistäminen -paneelin asetuksia ei voi
käyttää juttueditorinäkymässä.

Sisällön sijoitusasetusten määrittäminen

Voit määrittää nykyisen julkaisun tai kaikkien uusien tietojen yhdistämisprojektien oletusasetukset Sisällön sijoitusasetukset -valintaikkunassa. Voit
määrittää, miten kuvat sijoitetaan, liitetäänkö kuvat linkkeinä vai upotettuina, poistetaanko tyhjien kenttien tyhjät rivit ja mikä on yhdistettävien
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julkaisujen tietueiden enimmäismäärä.

1. Tee jokin seuraavista:

Jos haluat asetusten vaikuttavan vain nykyiseen julkaisuun, avaa kohdejulkaisu.

Jos haluat asetusten vaikuttavan kaikkiin uusiin julkaisuihin, sulje kaikki julkaisut.

2. Valitse Ikkuna > Apuohjelmat > Tietojen yhdistäminen.

3. Valitse Tietojen yhdistäminen -paneelivalikosta Sisällön sijoitusasetukset.

4. Muuta sisällön sijoitusasetuksia. (Katso Sisällön sijoitusasetukset.)

5. Napsauta OK-painiketta.

Tietueiden yhdistäminen

Kun olet muotoillut kohdejulkaisun ja lisännyt kentät tietolähdetiedostosta, voit yhdistää tietolähteen tiedot kohdejulkaisuun. Voit yhdistää tietueet
toiseen InDesign-julkaisuun tai suoraan PDF-julkaisuun. InDesign luo yhdistämisen aikana uuden julkaisun tai PDF-julkaisun, joka perustuu
kohdejulkaisuun ja joka korvaa kohdejulkaisun kentät vastaavilla tietolähdetiedoston tiedoilla.

Sivupohjien kohteet kopioidaan luotavan julkaisun sivupohjiin, kun yhdistät julkaisun, jonka sivupohjissa on tietokenttien paikkamerkkejä.

Yhden tai usean tietueen yhdistäminen

1. Kun kohdejulkaisu on avoinna, tee jokin seuraavista:

Valitse Tietojen yhdistäminen -paneelin valikosta Luo yhdistetty julkaisu tai napsauta Luo yhdistetty julkaisu -painiketta .

Valitse Tietojen yhdistäminen -paneelin valikosta Vie PDF-tiedostoksi.

2. Valitse Tietueet-välilehdessä Yhdistettävät tietueet -asetukseksi Kaikki tietueet (kaikki tietolähdetiedoston tietueet yhdistetään), Yksi tietue
(tietyn tietueen yhdistäminen) tai määritä yhdistettävien tietueiden alue.

3. Määritä Tietueita julkaisun sivulla -asetus valitsemalla jompikumpi seuraavista:

Valitse Yksi tietue, jolloin kukin tietue alkaa seuraavan sivun yläosasta.

Valitse Useita tietueita, jos haluat luoda sivulla vähintään kaksi tietuetta. (Esimerkiksi osoitetarrojen tulostamista varten.)

Et voi yhdistää useita tietueita, jos tietokentät näkyvät monisivuisen julkaisun sivulla tai jos tietokentät näkyvät useilla sivupohjilla.

4. Valitsemalla Luo raportti ylijuoksevasta tekstistä julkaisun luonnin yhteydessä -asetuksen avaat automaattisesti raportin, joka jäljittää tietojen
yhdistämisessä InDesign-julkaisuun syntyneen ylijuoksevan tekstin tilannetta. (Katso Sijoittamattoman tekstin raportit.)

5. Valitse Varoita puuttuvista kuvista, kun haluat ilmoituksen puuttuvasta linkistä tilanteissa, joissa vähintään yhtä kuvaa ei voi käyttää.

6. Jos valitsit Tietueet-välilehdessä Useita tietueita, napsauta Usean tietueen asettelu -välilehteä. Määritä sitten seuraavat asetukset:

Kirjoita Reunukset-kohtaan arvot, jotka määrittävät reunusten apuviivojen etäisyyden sivun reunoista.

Valitse Tietueiden asettelu -asetukseksi Rivit ensin tai Palstat ensin. Määritä sitten palstojen ja rivien välinen etäisyys.

7. Jos olet valinnut Useita tietueita -asetuksen, voit tarkastella Luo yhdistämistietueita -valintaikkunassa tehtyjä muutoksia valitsemalla Monen
tietueen asettelun esikatselu. Voit selata tietueita sivupainikkeilla.

8. Napsauta Asetukset-välilehteä ja määritä sijoitusasetukset. (Katso Sisällön sijoitusasetukset.)

9. Valitse lopuksi OK.

10. Jos viet suoraan PDF-muotoon, määritä PDF-asetukset ja valitse Vie. Määritä sitten tiedoston nimi sekä sijainti ja valitse Tallenna. (Katso
Adobe PDF -asetukset.)

Jos tietolähdetiedosto viittaa tiedostomuotoihin, joita ei tueta, tai kuviin, joita ei voi käyttää, tietolähdetiedostoa on muokattava siten, että se viittaa
tuettuun tiedostoon. Myös puuttuvien tiedostojen polut on poistettava. Tiedoston voi myös siirtää oikeaan kansioon, jotta InDesign löytää sen ja voi
sijoittaa sen.
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Sovita kuvat suhteessa

Sovita kuvat kehyksiin

Usean tietueen yhdistämisen rajoitukset

Valitse Useita tietueita, jos haluat luoda sivua kohden vähintään kaksi tietuetta. Jos esimerkiksi tulostat osoitetarroja, samalle sivulle kannattaa
tulostaa useita osoitteita. Tapa, jolla tietueet näkyvät yhdistetyssä julkaisussa, määräytyy pääasiassa asetteluasetusten mukaan. Tässä on luettelo
rajoituksista, joita saattaa esiintyä käyttäessäsi Useita tietueita -asetusta:

Et voi yhdistää useita tietueita, jos tietokentät näkyvät monisivuisen julkaisun sivulla tai jos tietokentät näkyvät useilla sivupohjilla.

Tietojen yhdistäminen sallii vain yhdenkokoisen paikkamerkin.

Tietueen poistaminen yhdistetystä julkaisusta ei siirrä jäljelle jääviä tietueita tyhjään paikkamerkkiin.

Yhdistäminen PDF-tiedostoon

PDF-tiedostoon yhdistettäessä käytetään samoja asetuksia kuin yhdistettyä InDesign-julkaisua luotaessa. Tuloksena saatava PDF-tiedosto
hyödyntää PDF XObject -rakenteita sivun staattisissa osissa. Näin PDF-tiedoston koko pienenee ja tiedostosta tulee tehokkaampi.

Tietokenttien päivittäminen

Voit muuttaa yhdistetyn julkaisun asettelua ja päivittää edelleen tietolähteen tietokenttien arvoja yhdistettyäsi julkaisun, jonka sivupojissa on
tietojen paikkamerkkejä. Voit päivittää tietokentät julkaisun asettelua muuttamatta valitsemalla Päivitä tietokentät. Tätä asetusta voi käyttää vain
yhdistetyssä julkaisussa, jossa paikkamerkit näkyvät sivupohjissa.

1. Tee haluamasi muutokset tietolähdetiedostoon ja tallenna ja sulje sitten tietolähdetiedosto.

2. Valitse yhdistetystä julkaisusta Päivitä tietokentät.

Tietokenttien päivittämisen aiheuttamat muutokset näkyvät lokitiedostossa.

Tämä asetus toimii parhaiten, kun vain muokkaat tai lisäät tietueita tietolähdetiedostossa. Jos lisäät uusia paikkamerkkikenttiä tai uusia kenttiä
tietolähteeseen tai muutat Luo yhdistetty julkaisu -valintaikkunan asetuksia, luo uusi yhdistetty julkaisu Luo yhdistetty julkaisu -toiminnon avulla.

Sijoittamattoman tekstin raportit

Sijoittamattoman tekstin raportti tulee näkyviin, jos Luo sijoittamattoman tekstin raportti -asetus on valittuna Luo yhdistetty julkaisu -
valintaikkunassa ja jos vähintään yhdessä kentässä on sijoittamatonta tekstiä tietojen yhdistämisen jälkeen.

Raportissa on numeroitu luettelo, jossa on tietoja sijoittamattomasta tekstistä: kyseisen tekstin sisältävän sivun numero, sijoittamattoman tekstin
merkki- tai sanamäärä ja katkelma kyseisestä tekstistä.

Jos näyttöön tulee raportti, kun luot yhdistetyn julkaisun, korjaa ylijuokseva teksti raportin tietojen avulla. Voit esimerkiksi lisätä tekstikehyksen
kokoa, pienentää fonttia tai muokata tekstiä.

Sisällön sijoitusasetukset

Seuraavat asetukset näkyvät Sisällön sijoitusasetukset -valintaikkunassa:

Säilyttää kuvan mittasuhteet ja skaalaa kuvan sopimaan kehykseen (oletus).

Skaalaa kuvan siten, että kuvan ja kehyksen mittasuhteet ovat yhtenevät.
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Sovita kehykset kuviin

Säilytä kehyksen ja kuvan koot

Täytä kehykset suhteessa

Keskitä kehykseen

Linkitä kuvat

Poista tyhjien kenttien tyhjät rivit

Julkaisun tietuerajoitus

Julkaisun sivurajoitus

Alkuun

Säilyttää kuvan koon ja muuttaa kehyksen kokoa kuvaan sopivaksi.

Sijoittaa kuvan luonnollisessa koossa kehyksen vasempaan yläkulmaan. Kuvaa leikataan, jos se ei sovi
kehykseen.

Sijoittaa kuvan siten, että sen korkeus tai leveys täyttää kehyksen, ja leikkaa kehyksen ulkopuolelle jäävät osat.

Sijoittaa kuvan keskikohdan kehyksen keskikohtaan.

Luo linkin tai tiedostopolun alkuperäiseen kuvatiedostoon. Jos tätä asetusta ei ole valittu, kaikki kuvatiedot upotetaan InDesign-
julkaisuun.

Poista tyhjiin kenttiin lisätyt kappalemerkit. Tämä on kätevää etenkin, kun teet postituksia, joissa on
valinnainen osoitekenttä. Tämä asetus ohittaa pakotetut rivinvaihdot. Jos rivillä on mitä tahansa merkkejä, mukaan lukien välilyönnit, riviä ei
poisteta.

Määrittää tietueiden enimmäismäärän kussakin yhdistetyssä julkaisussa. Kun yläraja saavutetaan, luodaan uusi julkaisu.
Tässä julkaisussa on tarvittava määrä sivuja jäljellä olevien tietueiden yhdistämiseen (tietuerajoitusmäärään saakka). Tämä asetus on käytettävissä
vain, kun Yksi tietue on valittuna.

Määrittää sivujen enimmäismäärän kussakin julkaisussa. Kun yläraja saavutetaan, luodaan uusi julkaisu, jossa on
tarvittava määrä sivuja jäljellä olevien tietueiden yhdistämiseen (sivurajoitusmäärään saakka). Tämä asetus on valittavissa vain, kun Tietueita
julkaisun sivulla -valikosta on yhdistettäessä valittu Useita tietueita.

Parannettu tietojen yhdistäminen

Voit integroida QR-koodin yhdistettyyn julkaisuun. Tietojen yhdistämistyönkulun kautta voidaan lisätä seuraavan tyyppisiä QR-koodikenttiä:

Vain teksti
Web-hyperlinkki
Tekstiviesti
Sähköposti
Käyntikortti

Tietolähteenä käytettävissä .txt- tai .csv-tiedostoissa olevat tiedot ovat QR-koodien luontia varten seuraavassa muodossa:

Vain teksti: kirjoita teksti QR-koodin sarakkeeseen sellaisenaan.
Verkon hyperlinkki: URL:<url> (esimerkiksi ”URL:http://www.google.com”)
Tekstiviesti: SMSTO:<Puhelinnumero>:<Viesti> (esimerkiksi ”SMSTO:9818143551:Hi”)
Sähköposti: MATMSG:\nVastaanottaja:<sähköpostiosoite> (esimerkki: ”MATMSG:\nTO:johndoe@adobe.com\nSUB:Hi;\nBODY:;;”)
Käyntikortti: BEGIN:VCARD\nVERSION:2.1\nN:Smith;John\nFN:John Smith\nORG:Adobe
Systems\nTITLE:Engineer\nTEL;CELL:+919876543210\nTEL;WORK;VOICE:123456789\nADR;WORK:;;Street
ABC;Seattle;Washington;98101;US\nEMAIL;WORK;INTERNET:abc@adobe.com\nURL:www.adobe.com\nEND:VCARD

Tiedoissa voi olla sähköpostiviestejä, tekstiviestejä, hyperlinkkejä ja pelkkää tekstiä. Kirjoita ne edellä mainitussa muodossa .csv- ja txt-kenttiin
lisäämällä niiden sarakkeen nimeen merkin #. Luo QR-koodit toimimalla seuraavien ohjeiden mukaan:

1. Valitse Windows > Apuohjelmat > Tietojen yhdistäminen.

2. Valitse avattavasta valikosta Valitse tietolähde.

3. Valitse QR-kentän tiedot sisältävä datatiedosto. Valitse Avaa.

4. Valitse paikkamerkki julkaisusta.

5. Luo yhdistetty julkaisu napsauttamalla Luo yhdistetty julkaisu -kuvaketta.
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Käytettävyys

Helppokäyttöisten PDF-asiakirjojen luominen (PDF, 2,6 Mt)
Artikkeli  (1.1.2011)
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Lomakkeet | CC, CS6

Alkuun

Alkuun

Käsiteltävät aiheet
Lomaketyönkulku
Lomakekentän lisääminen
Sarkainjärjestyksen määrittäminen

Lomaketyönkulku

InDesignissa voit luoda lomakkeita ja viedä ne suoraan PDF-muotoon. InDesign tukee nyt lomakekenttiä ja muiden lomakkeisiin liittyvien
toimintojen käyttöä. Painikkeet ja lomakkeet -kirjastossa (Ikkuna > Vuorovaikutteinen > Painikkeet ja lomakkeet) on lomakkeita, joita voi käyttää
vuorovaikutteisten lomakkeiden luontiin.

InDesignin avulla voidaan luoda yksinkertaisia lomakkeita InDesignin sisällä, jolloin PDF-asiakirjaa ei tarvitse korjailla Acrobatissa julkaisemisen
jälkeen. Voit lisätä yksinkertaisia lomake-elementtejä asiakirjan eri sivuille. Toiminto tukee tavallisia kenttätyyppejä, kuten tekstikenttiä,
valintapainikkeita, valintaruutuja ja allekirjoituksia. Lomakkeeseen voi lisätä myös toimintoja lomakkeen lähettämiseksi sähköpostitse tai sen
tulostamiseen.

Perusmuotoilun lisäksi lomakkeeseen voidaan lisätä suunnittelijan kädenjälkeä InDesignin luovan työn ominaisuuksilla.

Lisää yhtenäisiä viivoja ja täyttöjä PDF-lomakekenttiin.
Lisää painikkeille, valintaruuduille ja valintapainikkeille niiden käytössäolon ja hiiren kohdistimen sijaintiin perustuvia mukautettuja tiloja.
Valitse tekstikentissä käytettävä kirjasinkoko.

Voit käyttää esimerkiksi luottokorttitietojen keräämiseen luottokorttikuvakkeita valintapainikkeina ja määrittää eri kuvan tilanteisiin, joissa
valintapainike on valittuna.

Edistynyttä lomaketyönkulkua varten voit tuoda peruslomakkeen ja jatkaa sen muokkaamista Adobe Acrobatissa.

Lomakekentän lisääminen

Voit lisätä kenttiä sivuasetteluun Painikkeet ja lomakkeet -paneelin kautta. Vuorovaikutteisia lomakekenttiä lisätään samalla tavalla kuin painikkeita,
joten uusien toimintatapojen opettelu ei ole tarpeen. Voit luoda lomakkeen, joka toimii Adobe Readerissa tai Adobe Acrobatissa. InDesignilla voit
luoda upeita lomakkeita, joiden luonti ei tavallisesti onnistu Acrobatissa.

Painikkeet ja lomakkeet -paneeli

1. Sijoita kehys siihen kohtaan, johon haluat sijoittaa lomakekentän.
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2. Avaa Painikkeet ja lomakkeet -paneeli (Ikkunat > Vuorovaikutteinen > Painikkeet ja lomakkeet).
3. Valitse kehys ja sitten Tyyppi-luettelosta lomake-elementin tyyppi. Toinen vaihtoehto on napsauttaa kehystä hiiren kakkospainikkeella ja

valita Vuorovaikutteinen > Muunna muotoon [...]
4. Anna lomakekentälle nimi. Jos haluat luoda valintapainikeryhmän, kaikilla siihen lisättävillä painikkeilla on oltava sama nimi.
5. Valitse tapahtuma ja lisää siihen liitettävät toiminnot. Esimerkiksi toiminnot Tyhjennä lomake, Tulosta lomake ja Lähetä lomake on lisätty.

Määritä Lähetä lomake -toiminnossa URL-osoitteeksi ”mailto:xyz@example.com”.
6. Valintapainikkeet, valintaruudut tai painikkeet: määritä ulkoasumääritteet eri tiloille. InDesign lisää eri tiloille oletusarvojen mukaiset grafiikat,

mutta omien grafiikoiden lisääminen on mahdollista.
7. PDF-asetusten määrittäminen:

Kuvaus - Annettu arvo näkyy työkaluvihjeenä, ja sitä käytetään helppokäyttöisten lomakkeiden luonnissa
Painikkeen arvo - tämä arvo vastaa Acrobatissa olevaa vientiarvoa, ja sen avulla voidaan myös tunnistaa tietty valintapainike
helppokäyttöisen lomakkeen painikeryhmästä. 

Sarkainjärjestyksen määrittäminen

Jotta luotavasta lomakkeesta saadaan käyttäjäystävällinen ja helppokäyttöinen, sille on määritettävä käytännöllinen sarkainjärjestys. Käyttäjät
voivat siirtyä lomakkeen kentästä toiseen ilman osoitinlaitetta. Painamalla sarkainnäppäintä käyttäjä voi siirtyä järjestyksessä seuraavaan kenttään.

Nimiöidyn PDF-tiedoston sarkainjärjestys voidaan määrittää kahdella eri tavalla:

Voit määrittää mukautetun sarkainjärjestyksen Artikkelit-paneelissa (Ikkunat > Artikkeli).
Valitse Objekti > Vuorovaikutteinen > Määritä sarkainjärjestys.

Sarkainjärjestys voidaan määrittää Artikkelit-paneelissa.

Sarkainjärjestys voidaan määrittää Artikkelit-paneelissa

1. Avaa Artikkelit-paneeli (Ikkuna > Artikkelit).

2. Vedä lomakekentät Artikkelit-paneeliin.

3. Artikkelit-paneelissa kenttien järjestystä voidaan muuttaa vetämällä.

Jotta näytönlukuohjelmat voivat käyttää määritettyä järjestystä, ota Artikkelit-paneelin valikossa oleva asetus Käytä nimiöidyn PDF:n
lukemisjärjestykseen käyttöön. Kun olet viemässä lomaketta PDF:ksi, muista ottaa käyttöön Luo nimiöity PDF -asetus.

Käytä rakennetta sarkainjärjestykseen

1. Valitse Objektit > Vuorovaikutteinen > Määritä sarkainjärjestys.
2. Määritä haluamasi sarkainjärjestys napsauttamalla Siirrä ylös- tai Siirrä alas -painikkeita.

Kun viet vuorovaikutteiseen PDF-muotoon, ota käyttöön PDF-valintaikkunassa oleva Käytä rakennetta sarkainjärjestykseen -asetus.

Katso myös
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Artikkelit (CS 5.5)

Alkuun

Huomautus:

Alkuun

Alkuun

Johdanto artikkeleihin
Artikkelin luominen ja sisällön lisääminen siihen
Julkaisun kaikkien sivukohteiden lisääminen artikkeliin
Artikkeleiden hallinta
Artikkeleiden sisällyttäminen vientiä varten

Johdanto artikkeleihin

Artikkelit tarjoavat helpon tavan luoda sivukohteiden välisiä suhteita. Näiden suhteiden avulla voidaan määrittää EPUB- ja HTML-muotoon tai
helppokäyttöisiin PDF-tiedostoihin vietävä sisältö ja sisällön järjestys. Voit luoda artikkeleita sivuasettelussa olevista sivukohteista, kuten kuvista,
grafiikasta tai tekstistä. Artikkelin luonnin jälkeen sivukohteita voidaan lisätä, poistaa tai järjestellä. Artikkeleita voidaan luoda manuaalisesti
vetämällä yksi tai useampi sivukohde Artikkelit-paneelissa olevaan artikkeliin.

Voit myös lisätä sisältöjoukon artikkeliin. Artikkeliin voidaan lisätä valikoitua sisältöä tai dokumentin koko sisältö.

XML-rakennepaneeli sisältää toisen mekanismin EPUB- ja HTML-muotoisiin tai helppokäyttöisiin PDF-tiedostoihin vietävän sisällön
järjestyksen määrittämiseen. Artikkelit-paneeli on suunniteltu XML:ään perehtymättömiä käyttäjiä ajatellen entistä yksinkertaisemmaksi,
helppokäyttöisemmäksi ja helppopääsyisemmäksi. XML-rakennepaneelin käyttömahdollisuutta ei ole poistettu, mutta se on nyt valinnainen toiminto,
kuten artikkelipaneelin käyttö vientiprosessin aikana. Katso Julkaisun jäsenteleminen XML-muotoon.

Artikkelin luominen ja sisällön lisääminen siihen

1. Avaa Artikkelit-paneeli valitsemalla Ikkuna > Artikkelit.

2. Valitse artikkeliin lisättävät sivukohteet.

Jos haluat luoda tyhjän artikkelin, älä valitse sivuasettelusta sivukohdetta.

3. Tee jokin seuraavista:

Valitse Artikkelit-paneelin valikosta Uusi artikkeli.

Napsauta Artikkelit-paneelin alaosassa Luo uusi artikkeli -painiketta.

Vedä juttu tai sivuelementti Artikkelit-paneeliin.

4. Kirjoita Uusi Artikkeli -valintaikkunaan artikkelin nimi.

5. Valitse Sisällytä vietäessä, jos haluat lisätä artikkelin EPUB/HTML-vientitiedostoon.

Julkaisun kaikkien sivukohteiden lisääminen artikkeliin

Lisää kaikki sivukohteet artikkeliin seuraavasti:

1. Avaa Artikkelit-paneeli valitsemalla Ikkuna > Artikkelit.

2. Valitse artikkeli, johon haluat lisätä kohteet. Jos et valitse artikkelia, luodaan uusi artikkeli.

3. Paina Command (Mac OS) tai Ctrl (Windows) ja valitse sitten Artikkelit-paneelista .

4. Jos Uusi Artikkeli -valintaikkuna avautuu, anna artikkelin nimi.

5. Valitse Sisällytä vietäessä, jos haluat lisätä artikkelin EPUB/HTML-vientitiedostoon.

Jos olet valinnut artikkelin, valitse Artikkelit-paneelin valikosta Lisää julkaisun sisältö valittuihin artikkeleihin.
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Artikkeleiden hallinta

Voit hallita artikkeleita Artikkelit-paneelissa. Voit lisätä sivuelementtejä artikkeliin vetämällä ne Artikkelit-paneeliin. Vedä kohteet Artikkelit-paneeliin,
jos haluat muuttaa niiden järjestystä tai siirtää ne yhdestä artikkelista toiseen.

Artikkelit-ponnahdusvalikko sisältää myös sisällön hallintaan tarkoitettuja toimintoja.

Artikkeleiden sisällyttäminen vientiä varten

Voit luoda artikkeleita ja valita, mitkä niistä sisällytetään EPUB- tai HTML-muotoon vietäessä. Oletusarvoisesti kaikki artikkelit valitaan vientiä
varten.

Jos haluat sisällyttää artikkelin vientiin, valitse artikkeli Artikkelit-paneelista ja tee jokin seuraavista toimista:

Valitse artikkelin vieressä oleva valintaruutu.

Valitse Artikkelit-paneeliponnahdusvalikosta Artikkelin asetukset ja sitten Sisällytä vietäessä.
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Rakenteiset PDF-tiedostot
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Rakenteen lisääminen PDF-tiedostoihin
Nimiöiden vaikutus uudelleenkäyttöön ja esteettömyyteen
Sijoittaminen ja sen optimointi
Sivukohteiden nimiöiminen
Grafiikan nimiöiminen näytönlukuohjelmaa varten
Sivukohteiden ryhmittäminen artikkelielementiksi

Rakenteen lisääminen PDF-tiedostoihin
Kun viet Adobe PDF -muotoon ja kun Vie Adobe PDF -valintaikkunan Yleiset-asetuksista on valittu Luo nimiöity PDF, vietyihin sivuihin lisätään
automaattisesti sisältöä kuvailevia rakennenimiöitä. Niillä on merkitty sivukohteet, kuten otsikot, jutut ja kuvat. Voit lisätä muita nimiöitä tai
hienosäätää valmiita nimiöitä ennen viemistä InDesignin Nimiöt-paneelissa. Muutokset näkyvät Rakenneruudussa (Näytä > Rakenne > Näytä
rakenne).

Voit parantaa Adobe-julkaisujen esteettömyyttä ja uudelleenkäyttöä lisäämällä InDesign-julkaisuun nimiöitä ennen viemistä. Jos PDF-julkaisut eivät
sisällä nimiöitä, Adobe Reader tai Acrobat voi yrittää automaattisesti lisätä julkaisuun nimiöitä käyttäjän lukiessa tai sijoittaessa julkaisua, mutta
tulokset eivät välttämättä ole hyviä. Jos viety Adobe PDF -tiedosto ei vastaa odotuksiasi, voit muokata nimiöityjen PDF-julkaisujen rakennetta
Acrobat 6.0 Professionalin ja uudempien versioiden työkaluilla. Edistyneimmät työkalut ovat Acrobat 9 Professionalissa.

Kun lisäät rakennenimiöitä julkaisuun PDF-vientiä varten, nimiöt eivät ohjaa PDF-muotoon vietävää sisältöä, toisin kuin XML-viennissä.
Rakennenimiöt antavat Acrobatille lisätietoja julkaisun rakenteellisesta sisällöstä.

Nimiöiden käyttämisen etuja
Kun nimiöitä julkaisuun ennen PDF-muotoon viemistä, voit

liittää InDesign-kappaletyylien nimiä Acrobat-nimiöityihin Adobe PDF -kappaletyyleihin ja luoda sijoitettavan PDF-tiedoston katseltavaksi
kämmentietokoneella tai muilla laitteilla

merkitä ja kätkeä tulostukseen liittyviä elementtejä, tekstiä ja kuvia, jolloin ne eivät näy, kun julkaisu sijoitetaan Acrobatissa. Jos esimerkiksi
lisäät sivukohteeseen Artifact-nimiön, sivukohde ei näy, kun nimiöidyn Adobe PDF -julkaisun sisältö sijoitetaan kämmenlaitteeseen, pieneen
näyttöön tai suurta suurennusta käyttävään vakionäyttöön.

lisätä vaihtoehtoista tekstiä kuviin, jolloin teksti voidaan lukea ääneen näyttölukulaitteen ohjelmistolla

korvata grafiikkakirjaimia, kuten koristeellisia anfangeja, luettavilla kirjaimilla

antaa otsikon artikkelijoukolle tai ryhmittää juttuja ja kuvia artikkeleiksi

järjestää juttuja ja kuvia lukemisjärjestykseen

merkitä taulukot, muotoillut luettelot ja sisällysluettelot merkitä, mitkä sisältölohkot kuuluvat eri juttuihin

sisällyttää tekstin muotoilutietoja, kuten merkkien Unicode-arvoja, sanojen välistysarvoja sekä sitovia yhdysmerkkejä ja tavutusvihjeitä.

Nimiöiden vaikutus uudelleenkäyttöön ja esteettömyyteen
Adobe PDF -julkaisun sisältöä voidaan käyttää uudelleen muihin tarkoituksiin. Voit esimerkiksi luoda Adobe PDF -tiedoston raportista, jossa on
tekstiä, taulukoita ja kuvia, ja sitten jaella sitä eri menetelmillä: tulostaminen tai lukeminen täysikokoisessa näytössä, katseleminen
kämmentietokoneessa, lukeminen ääneen näyttölukulaitteella ja suora käyttö Web-selaimen kautta HTML-sivuina. Julkaisun looginen rakenne
säätelee sitä, miten helposti ja luotettavasti sisältöä voidaan käyttää uudelleen muihin tarkoituksiin.

Lisäämällä nimiöitä Adobe PDF -julkaisuihin voit varmistaa, että voit käyttää julkaisuja luotettavasti ja uudelleen. Nimiöt lisäävät julkaisuun loogisen
rakenteen eli loogisen rakennepuun. Looginen rakennepuu tarkoittaa julkaisun sisällön järjestystä, kuten nimisivua, kappaleita, osioita ja alaosioita.
Se voi ilmaista tarkan lukemisjärjestyksen ja helpottaa liikkumista erityisesti pitkissä ja monimutkaisissa julkaisuissa ilman, että PDF-julkaisun
ulkoasu muuttuu.

Ihmiset, jotka eivät näe tai pysty tulkitsemaan julkaisujen visuaalista ulkoasua, voivat käyttää julkaisun sisältöä luotettavasti apuvälineiden avulla
loogisen rakennepuun ansiosta. Useimmat apuvälineet tarvitsevat rakennetta, jotta ne voivat välittää sisällön ja kuvien merkitykset toisessa
muodossa, esimerkiksi äänenä. Nimiöimättömässä julkaisussa ei ole tällaista rakennetta, ja Acrobatin täytyy päätellä rakenne
lukemisjärjestysasetusten perusteella. Tämä menetelmä ei ole luotettava ja johtaa usein siihen, että sivukohteet luetaan väärässä järjestyksessä tai
jätetään lukematta.

Nimiöt näkyvät Acrobat 6.0:n tai uudempien Nimiöt-välilehdessä, jossa ne on sisennetty nimiöityjen elementtien suhdemääritteiden mukaan.
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Nimiöitä ei voi muokata Acrobat Standardilla. Jos sinun on muokattava nimiöitä suoraan, päivitä ohjelma Adobe Acrobat 9 Professionaliksi.
Lisätietoja on Acrobatin Ohjeessa.

Acrobat 9:n Nimiöt-välilehden looginen rakennepuu

Huomautus: Adobe PDF -tiedostoissa käytettyjä nimiöitä voi verrata HTML- ja XML-nimiöihin. Lisätietoja nimiöiden peruskäsitteistä on
kirjakaupoista, kirjastoista ja Webistä saatavissa hakuteoksissa ja muissa kirjoissa.

Sijoittaminen ja sen optimointi
Voit sijoittaa PDF-julkaisun luettavaksi kämmenlaitteilla, pienistä näytöistä tai vakionäytöistä korkeilla suurennuksilla ilman, että tekstiä tarvitsee
vierittää vaakasuoraan rivi kerrallaan.

Kun sijoitat Adobe PDF -julkaisun, osa sisällöstä siirtyy uudelleenjuoksutettuun·julkaisuun ja osa ei. Useimmissa tapauksissa vain luettava teksti
sijoitetaan uudelleenjuoksutettuun julkaisuun. Luettava teksti sisältää artikkeleita, kappaleita, taulukoita, kuvia ja muotoiltuja luetteloita. Lomakkeita,
kommentteja, digitaalisen allekirjoituksen kenttiä ja sivuelementtejä, kuten sivunumeroita sekä ylä- ja alatunnisteita, sisältävää tekstiä ei juoksuteta.
Sivuja, joilla on sekä luettavaa tekstiä että lomakekenttiä tai digitaalisia allekirjoituskenttiä, ei juoksuteta. Pystysuuntainen teksti juoksutetaan
vaakasuuntaisesti.

Tekijänä voit optimoida PDF-julkaisut uudelleenjuoksuttamista varten lisäämällä niihin nimiöitä. Nimiöt varmistavat, että tekstilohkot juoksutetaan
uudelleen ja että sisältö noudattaa oikeaa järjestystä, jotta lukijat voivat seurata eri sivuille ja palstoille ulottuvaa juttua ilman, että muut jutut
häiritsevät sitä. Lukemisjärjestyksen määrää rakennepuu, jota voi muokata Rakenneruudussa.
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Otsikot ja palstat (yllä) sijoitetaan loogiseen lukemisjärjestykseen (alla).

Sivukohteiden nimiöiminen
Tekstikehyksiä ja grafiikkaa voidaan nimiöidä automaattisesti tai manuaalisesti. Kun sivukohteet on nimiöity, sivun järjestystä voidaan muuttaa
Rakenneruudussa vetämällä kohteita uusiin paikkoihin hierarkiassa. Jos elementtien järjestystä muutetaan Rakenneruudussa, muutokset välitetään
Adobe PDF -tiedostoon. Rakennenäkymän elementtijärjestyksestä on hyötyä, kun PDF-tiedosto tallennetaan Acrobatista HTML- tai XML-
tiedostona. Järjestyksestä on myös hyötyä, kun viet InDesign-julkaisun Dreamweaveriin (XHTML) tai Digital Editions (EPUB) -muotoon.

Sivukohteiden nimiöiminen automaattisesti
Kun valitset Lisää nimiöimättömät kohteet -komennon, InDesign lisää Acrobat-rakennenimiöt Nimiöt-paneeliin sekä käyttää Story- ja Figure-
nimiöitä eräissä nimiöimättömissä sivukohteissa. Story-nimiötä käytetään kaikissa nimiöimättömissä tekstikehyksissä ja Figure-nimiötä
nimiöimättömässä grafiikassa. Sitten voit lisätä manuaalisesti muut nimiöt tekstin osiin. Sivukohteiden nimiöiminen ei kuitenkaan takaa, että kohteet
jäsentyvät vastaavasti viedyssä PDF-tiedostossa.

1. Avaa Nimiöt-paneeli valitsemalla Ikkuna > Apuohjelmat > Nimiöt.
2. Valitse Näytä > Rakenne > Näytä rakenne, jotta Rakenneruutu tulee näkyviin julkaisuikkunan vasemmalle puolelle.
3. Valitse Rakenneruudusta Lisää nimiöimättömät kohteet.
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Nimiöt Rakenneruudussa ja Nimiöt-paneelissa

Sivukohteiden nimiöiminen manuaalisesti
1. Avaa Nimiöt-paneeli valitsemalla Ikkuna > Apuohjelmat > Nimiöt.
2. Valitse Näytä > Rakenne > Näytä rakenne, jotta Rakenneruutu tulee näkyviin julkaisuikkunan vasemmalle puolelle.
3. Valitse Rakenneruudusta Lisää nimiöimättömät kohteet.
4. Valitse julkaisusta sivukohde.
5. Valitse Nimiöt-paneelista nimiö. Tutustu seuraaviin tuotuja nimiöitä koskeviin suosituksiin:

Artifact Artifact-nimiöllä voit kätkeä sivukohteita, kuten sivunumeroita tai merkityksettömiä objekteja, kun katselet vietyä PDF-tiedostoa
Sijoitus-näkymässä, joka näyttää vain nimiöidyt kohteet. Lisätietoja on Adobe Acrobat -oppaissa. Tämä on kätevää etenkin, kun PDF-
tiedostoja katsellaan kämmenlaitteella tai muilla PDF-lukulaitteilla.

Cell Käytä tätä nimiötä taulukoiden soluissa.

Figure Käytä tätä nimiötä sijoitetussa grafiikassa. Figure-nimiö liitetään kaikkeen julkaisun nimiöimättömään grafiikkaan, kun valitset Lisää
nimiöimättömät kohteet.

Kappalenimiöt (P, H, H1–H6) Nämä nimiöt eivät vaikuta vietyyn PDF-tekstiin Sijoitus-näkymässä. Ne voivat kuitenkin olla hyödyllisiä joskus,
kun PDF-tiedosto viedään HTML-muotoon.

Juttu Käytä tätä nimiötä jutuissa. Story-nimiö liitetään kaikkiin nimiöimättömiin tekstikehyksiin, kun valitset Lisää nimiöimättömät kohteet.
Oletetaan, että kyseessä on InDesign-julkaisu, jonka muotoilussa on kolme kappaletyyliä: Otsikko1, Otsikko2 ja Leipäteksti. Liitä ensin nämä
kappaletyylit H1-, H2- ja P-nimiöihin. Vie seuraavaksi PDF-muotoon. Kun viet PDF-julkaisun HTML- tai XML-muotoon Acrobatissa,
kappaleet, joiden nimiöt ovat H1, H2 ja P, näkyvät Web-selaimessa oikein (esimerkiksi suuret lihavoidut kirjaimet H1-nimiössä). Lisätietoja
PDF-julkaisun viemisestä HTML- tai XML-muotoon on Adobe Acrobat -oppaissa.

Grafiikan nimiöiminen näytönlukuohjelmaa varten
Jos haluat näyttölukuohjelman kuvailevan grafiikkaelementtejä, jotka havainnollistavat julkaisussa esiintyviä tärkeitä käsitteitä, sinun on kirjoitettava
kuvaukset. Näyttölukuohjelma ei tunnista kuvia ja multimediaa, jos et lisää vaihtoehtoista tekstiä nimiön ominaisuuksiin.

Vaihtoehtoinen teksti -määritteellä lisätään vaihtoehtoinen teksti, joka luetaan kuvan näyttämisen sijasta. Todellinen teksti vastaa vaihtoehtoista
tekstiä ja näkyy kuvan sijasta. Todellinen teksti -määritteellä voit korvata sanan osana olevan kuvan esimerkiksi silloin, kun kuvaa käytetään
anfangina. Tässä esimerkissä Todellinen teksti -määrite mahdollistaa anfangin lukemisen sanan osana.

Kun viet Adobe PDF -muotoon, Alt- ja ActualText-määritearvot tallentuvat PDF-tiedostoon ja niitä voi katsella Acrobat 6.0:lla ja uudemmilla
versioilla. Vaihtoehtoisia tekstitietoja voi käyttää, kun PDF-tiedosto tallennetaan Acrobatista HTML- tai XML-tiedostoksi. Lisätietoja on Adobe
Acrobat -oppaissa.

1. Avaa tarvittaessa Rakenneruutu valitsemalla Näytä > Rakenne > Näytä rakenne. Avaa Nimiöt-paneeli valitsemalla Ikkuna > Apuohjelmat >
Nimiöt.

2. Valitse Rakenneruudusta Lisää nimiöimättömät kohteet.
3. Valitse kuva ja sitten Nimiöt-paneelista Figure, kun haluat varmistaa, että kuvan nimiö on Figure.
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4. Valitse Rakenneruudusta kuvaelementti ja sitten Rakenneruutuvalikosta uusi määrite.
5. Kirjoita nimeksi Alt tai ActualText (isot ja pienet kirjaimet erotellaan).
6. Kirjoita arvoksi kuvan sijasta näytettävä teksti.

Sivukohteiden ryhmittäminen artikkelielementiksi
Ryhmitä sivukohteet loogisesti artikkelielementiksi käyttämällä Rakenneruutua. Jos esimerkiksi juttujoukko ulottuu useille sivuille, voit luoda
yläelementin, joka sisältää jutut yhdessä ryhmässä. Näitä elementtejä kutsutaan rakenne-elementeiksi. Voit myös nimetä ryhmitettyjä artikkeleita.
Huomautus: ryhmitettyihin sivukohteisiin ei voi lisätä nimiöitä.

Jos haluat ryhmittää sivukohteita, valitse ensin Rakenneruudun valikosta Uusi elementti ja sitten Nimiöt-paneelista artikkelielementti ja vedä
lopuksi sen alla olevat sivuelementit Rakenneruutuun.
Jos haluat nimetä ryhmitettyjä kohteita, napsauta Rakenneruudussa näkyvää artikkelielementtiä hiiren kakkospainikkeella ja valitse Uusi
määrite. Kirjoita nimeksi Otsikko. Kirjoita arvoksi käytettävän artikkelin nimi.

Lisää ohjeaiheita

Lakisääteiset ilmoitukset   |   Yksityisyyttä koskeva Online-toimintaohjelma
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